This product includes software developed by the Apache Software Foundation (http://www.apache.org/).

© DevelopMentor

This product may include the JCifs library, for which the following notice applies:

JCifs © Copyright 2004, The JCIFS Project, is licensed under LGPL (http://jcifs.samba.org/). See the LGPL.txt file in the Third Party Software directory on the installation CD.

Avid Interplay contains components licensed from LavanTech. These components may only be used as part of and in connection with Avid Interplay.

Attn. Government User(s). Restricted Rights Legend

U.S. GOVERNMENT RESTRICTED RIGHTS. This Software and its documentation are “commercial computer software” or “commercial computer software documentation.” In the event that such Software or documentation is acquired by or on behalf of a unit or agency of the U.S. Government, all rights with respect to this Software and documentation are subject to the terms of the License Agreement, pursuant to FAR §12.212(a) and/or DFARS §227.7202-1(a), as applicable.

Trademarks


Adobe and Photoshop are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries. Apple and Macintosh are trademarks of Apple Computer, Inc., registered in the U.S. and other countries. Windows is either a registered trademark or trademark of Microsoft Corporation in the United States and/or other countries. All other trademarks contained herein are the property of their respective owners.

Footage

Arri — Courtesy of Arri/Fauer — John Fauer, Inc.
Bell South “Anticipation” — Courtesy of Two Headed Monster — Tucker/Wayne Atlanta/GMS.
Canyonlands — Courtesy of the National Park Service/Department of the Interior.
Eco Challenge British Columbia — Courtesy of Eco Challenge Lifestyles, Inc., All Rights Reserved.
Eco Challenge Morocco — Courtesy of Discovery Communications, Inc.
It's Shuttletime — Courtesy of BCP & Canadian Airlines.
Nestlé Coffee Crisp — Courtesy of MacLaren McCann Canada.
Saturn “Calvin Egg” — Courtesy of Cossette Communications.
“The Big Swell” — Courtesy of Swell Pictures, Inc.
Windhorse — Courtesy of Paul Wagner Productions.

Arizona Images — KNTV Production — Courtesy of Granite Broadcasting, Inc.,
Editor/Producer Bryan Foote.
Canyonlands — Courtesy of the National Park Service/Department of the Interior.
Ice Island — Courtesy of Kurtis Productions, Ltd.
Tornados + Belle Isle footage — Courtesy of KWTV News 9.
WCAU Fire Story — Courtesy of NBC-10, Philadelphia, PA.
Women in Sports – Paragliding — Courtesy of Legendary Entertainment, Inc.

Avid Media Composer Editing Guide • 0130-07971-01-G • December 2014
# Contents

Symbols and Conventions ................................................................. 50
If You Need Help. ................................................................. 51
Avid Training Services ................................................................. 51

## Chapter 1

**Editing Overview** ................................................................. 52
Editing Workflow ................................................................. 52
Starting a Project ................................................................. 53
Preparing to Edit ................................................................. 54
Editing a Sequence ................................................................. 55
Outputting a Sequence ................................................................. 57

## Chapter 2

**Starting a Project** ................................................................. 59
Turning on Your Equipment ................................................................. 59
Working with the Desktop ................................................................. 60
  - Using the Windows Taskbar (Windows Only) ................................................................. 60
  - Using the Macintosh Dock (Macintosh Only) ................................................................. 61
  - Using Shortcut Menus ................................................................. 61
  - Using the Keyboard for Navigating in Dialog Boxes and Menus ................................................................. 61
  - Using the Mouse Scroll Wheel for Navigating ................................................................. 62
  - Customizing Mouse Functions ................................................................. 62
  - Optimum Performance (Windows 7) ................................................................. 63
  - Optimum Performance (Macintosh) ................................................................. 65
  - Antivirus Applications ................................................................. 66
Starting Your Avid Editing Application (Windows) ................................................................. 66
Starting Your Avid Editing Application (Macintosh) ................................................................. 66
Application Manager ................................................................. 67
  - Licensing the Editing Application through Application Manager ................................................................. 68
Working with Projects ................................................................. 69
<table>
<thead>
<tr>
<th>Chapter 4</th>
<th>Using Tools</th>
<th>126</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Using the Tools Menu</td>
<td>126</td>
</tr>
<tr>
<td></td>
<td>Using Tabs</td>
<td>126</td>
</tr>
<tr>
<td></td>
<td>Using a Deck Controller</td>
<td>127</td>
</tr>
<tr>
<td></td>
<td>Deck Controller Window Reference</td>
<td>128</td>
</tr>
<tr>
<td></td>
<td>The Command Palette</td>
<td>129</td>
</tr>
<tr>
<td></td>
<td>Understanding Button Mapping</td>
<td>129</td>
</tr>
<tr>
<td></td>
<td>Mapping User-Selectable Buttons</td>
<td>131</td>
</tr>
<tr>
<td></td>
<td>Mapping Menu Commands</td>
<td>132</td>
</tr>
<tr>
<td></td>
<td>Activating Commands from the Command Palette</td>
<td>133</td>
</tr>
<tr>
<td></td>
<td>Using the Avid Calculator</td>
<td>133</td>
</tr>
<tr>
<td></td>
<td>Using The Console Window</td>
<td>134</td>
</tr>
<tr>
<td></td>
<td>Using the Hardware Tool</td>
<td>135</td>
</tr>
<tr>
<td></td>
<td>External Controllers as Editing Control Surfaces</td>
<td>136</td>
</tr>
<tr>
<td>Chapter 5</td>
<td>Logging</td>
<td>137</td>
</tr>
<tr>
<td></td>
<td>Avid Log Specifications</td>
<td>137</td>
</tr>
</tbody>
</table>
Chapter 7 Capturing Media

Capturing and Logging at the Same Time

Naming Clips and Adding Comments in the Capture Tool

Capturing by Setting Both Marks

Capturing by Setting Only One Mark

Capturing On-the-Fly

Preparing to Autocapture

Autocapturing

Capturing from a Non-Avid-Controlled Deck

Capturing with Time-of-Day Timecode

Capturing Directly from a DV Device

Capturing DV 25 Media

Capturing DV 50, DVCPro HD, or HDV Media

Selecting a DV Device

Understanding DV Capture Offset

Capturing DV Material with Offset

Capturing Audio from a Music CD

Frame Chase Capture
Chapter 8 Importing Files

Preparing to Import Files .................................................. 298
Creating and Modifying Import Settings ......................... 298
Importing Media Files .................................................... 301
Importing with Multichannel Audio ............................... 305
Importing Audio Files from a Music CD ........................... 307
Adjusting Gain Before Importing Audio Files ................. 308
Sample Rate Conversion and Audio Import ...................... 309
Setting Sample Rate Conversion Options Before Importing Audio Files .................. 310
Photoshop Graphics Import ............................................. 311
    Support for Multilayered Photoshop Graphics Import .... 313
    Importing Photoshop Files ........................................... 314
Digital Bars and Tone .................................................... 316
Importing Color Bars and Other Test Patterns ................ 316
Importing Editcam Files ................................................ 318
Setting XDCAM Import Options ...................................... 319
Importing XDCAM Media ................................................. 320
Importing XDCAM EX Media .......................................... 321
Automatically Importing Proxy Media from an XDCAM Device ........................................ 323
Importing Proxy Media from an XDCAM Disk .................. 325
Copying XDCAM Proxy Media to a Local Drive or a Server .......................................... 326
Manually Importing XDCAM Media from the XDCAM Disk ........................................ 326
Importing Essence Marks as Markers in XDCAM Media ..... 327
Editing XDCAM Proxy Media ......................................... 328
Batch Importing High-Resolution XDCAM Media from the XDCAM Disk ................................. 329
Editing and Finishing High-Resolution XDCAM Media .... 332
Importing P2 Clips and Media .......................................... 332
## Chapter 9 Working with Bins

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Importing Sequences from Pro Tools through Interplay</td>
<td>333</td>
</tr>
<tr>
<td>Using the Drag-and-Drop Method to Import Files</td>
<td>333</td>
</tr>
<tr>
<td>Reimporting Files</td>
<td>334</td>
</tr>
<tr>
<td>Batch Import Dialog Box</td>
<td>336</td>
</tr>
<tr>
<td>Object Icons in Bins</td>
<td>339</td>
</tr>
<tr>
<td>Bin Views</td>
<td>341</td>
</tr>
<tr>
<td>Using Text View</td>
<td>341</td>
</tr>
<tr>
<td>Sorting in Bins</td>
<td>342</td>
</tr>
<tr>
<td>Sorting Clips and Sequences</td>
<td>343</td>
</tr>
<tr>
<td>Understanding Bin Views</td>
<td>344</td>
</tr>
<tr>
<td>Saving a Custom Bin View</td>
<td>345</td>
</tr>
<tr>
<td>Using Frame View</td>
<td>346</td>
</tr>
<tr>
<td>Using Script View</td>
<td>348</td>
</tr>
<tr>
<td>Bin Procedures</td>
<td>350</td>
</tr>
<tr>
<td>Using Bin Tabs</td>
<td>350</td>
</tr>
<tr>
<td>Using the Bin Fast Menu</td>
<td>351</td>
</tr>
<tr>
<td>Selecting Clips and Sequences</td>
<td>351</td>
</tr>
<tr>
<td>Duplicating, Copying, and Moving Clips and Sequences</td>
<td>352</td>
</tr>
<tr>
<td>Copying Clips and Sequences</td>
<td>353</td>
</tr>
<tr>
<td>Deleting Items from a Bin</td>
<td>354</td>
</tr>
<tr>
<td>Changing the Bin Background Color</td>
<td>356</td>
</tr>
<tr>
<td>Assigning Colors to Objects in a Bin</td>
<td>357</td>
</tr>
<tr>
<td>Locking and Unlocking Items in a Bin</td>
<td>358</td>
</tr>
<tr>
<td>Selecting Offline Items in a Bin</td>
<td>359</td>
</tr>
<tr>
<td>Selecting Media Relatives for an Object in a Bin</td>
<td>360</td>
</tr>
<tr>
<td>Selecting Sources Used by an Object in a Bin</td>
<td>361</td>
</tr>
<tr>
<td>Selecting Unreferenced Items in a Bin</td>
<td>361</td>
</tr>
<tr>
<td>Working with Bin Columns</td>
<td>361</td>
</tr>
<tr>
<td>Moving, Aligning, and Deleting Bin Columns</td>
<td>362</td>
</tr>
<tr>
<td>Duplicating Bin Columns with Timecode Information</td>
<td>363</td>
</tr>
<tr>
<td>Adding Customized Columns to a Bin</td>
<td>363</td>
</tr>
<tr>
<td>Changing a Custom Bin Column Heading</td>
<td>364</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Adding a Metadata Bin Column Heading</td>
<td>364</td>
</tr>
<tr>
<td>Moving Within Column Cells</td>
<td>365</td>
</tr>
<tr>
<td>Copying Information Between Columns</td>
<td>366</td>
</tr>
<tr>
<td>Displaying Timecodes in a 24p or 25p Project</td>
<td>366</td>
</tr>
<tr>
<td>Adding Timecode Columns to a Bin or the Media Tool</td>
<td>367</td>
</tr>
<tr>
<td>Frame Counting for Timecodes</td>
<td>367</td>
</tr>
<tr>
<td>Adding Timecode Values to the Timecode Columns</td>
<td>367</td>
</tr>
<tr>
<td>Modifying Clip Information</td>
<td>368</td>
</tr>
<tr>
<td>Bin Column Headings</td>
<td>368</td>
</tr>
<tr>
<td>Modifying Data in Bins</td>
<td>375</td>
</tr>
<tr>
<td>Modify Command Options</td>
<td>377</td>
</tr>
<tr>
<td>Copying Information from Another Cell in a Custom Bin Column</td>
<td>379</td>
</tr>
<tr>
<td>Applying the Same Text to a Custom Column for Multiple Items</td>
<td>379</td>
</tr>
<tr>
<td>Working with Film Information in Bins</td>
<td>379</td>
</tr>
<tr>
<td>Film Scene Workflow</td>
<td>379</td>
</tr>
<tr>
<td>Tracking Frames Based on File Name</td>
<td>380</td>
</tr>
<tr>
<td>Selecting a Film Gauge</td>
<td>381</td>
</tr>
<tr>
<td>Tracking 3-Perf Counts</td>
<td>381</td>
</tr>
<tr>
<td>Selecting an Edgecode Type</td>
<td>382</td>
</tr>
<tr>
<td>Creating a Storyboard</td>
<td>382</td>
</tr>
<tr>
<td>Setting the Bin Display</td>
<td>383</td>
</tr>
<tr>
<td>Sifting Clips and Sequences</td>
<td>383</td>
</tr>
<tr>
<td>Understanding Sifting Timecodes or Keycode Ranges</td>
<td>385</td>
</tr>
<tr>
<td>Sifting Timecodes or Keycode Ranges</td>
<td>388</td>
</tr>
<tr>
<td>Working with Restricted Material</td>
<td>388</td>
</tr>
<tr>
<td>Printing Bins</td>
<td>390</td>
</tr>
<tr>
<td>Favorite Bins</td>
<td>390</td>
</tr>
<tr>
<td>Filtering Items in the Bin</td>
<td>392</td>
</tr>
<tr>
<td><strong>Chapter 10</strong> <em>Acquisition of File-Based Media (AMA)</em></td>
<td>394</td>
</tr>
<tr>
<td>The Avid Media Access (AMA) Workflow</td>
<td>394</td>
</tr>
<tr>
<td>Considerations and Limitations for AMA</td>
<td>397</td>
</tr>
<tr>
<td>Viewing Installed AMA Plug-ins</td>
<td>397</td>
</tr>
<tr>
<td>Selecting the AMA Settings</td>
<td>398</td>
</tr>
</tbody>
</table>
Chapter 11 AMA Plug-ins

Using XDCAM and XDCAM EX and XDCAM SR AMA Plug-Ins

Using XDCAM Multiple Resolution Clips with AMA

Switching Between Multiple Resolution Media

Consolidating Multiple Resolution Media

Using the P2 AMA Plug-In

Using the AVCHD AMA Plug-In

Using the Canon XF AMA Plug-In.
Chapter 12  Managing Media Files ................................. 467

Working with Media Files in an Avid Interplay Environment .................. 468
Using Avid Editing Systems in an Avid LANshare Workgroup ................. 469
Viewing Media with a 100Base-T Connection to Avid ISIS ..................... 470
Understanding Drive Mounting .................................. 470
Mounting and Unmounting Drives ................................ 471
Using the Media Tool ............................................. 471
  Basic Media Tool Features ..................................... 472
  Using the Media Tool in an Avid Interplay Environment .................... 473
  Opening the Media Tool ....................................... 473
  Deleting Media Files with the Media Tool .................................. 475
Consolidating Media .............................................. 477
Using the Consolidate Command ................................ 479
Using the Transcode Command ................................ 483
Consolidate or Transcode AMA Clips Only .................................. 486
Background Consolidate and Transcode ............................. 486
  The Background Queue Window .................................. 487
  Using Background Consolidate and Transcode .................................. 489
Loading the Media Database .................................... 490
Refreshing Media Directories ....................................... 491
Deleting Unreferenced Clips and Media .................................. 492
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backing Up Media Files</td>
<td>493</td>
</tr>
<tr>
<td>Finding a Related Media File</td>
<td>493</td>
</tr>
<tr>
<td>Relinking Media Files</td>
<td>494</td>
</tr>
<tr>
<td>Relinking by Resolution</td>
<td>499</td>
</tr>
<tr>
<td>Relinking to Selected Clips</td>
<td>500</td>
</tr>
<tr>
<td>Relinking Tape and File Based Media</td>
<td>500</td>
</tr>
<tr>
<td>Relinking Consolidated Clips</td>
<td>501</td>
</tr>
<tr>
<td>Relinking Moved Projects</td>
<td>502</td>
</tr>
<tr>
<td>Unlinking Media Files</td>
<td>502</td>
</tr>
<tr>
<td>Archiving and Restoring Media Files to Videotape</td>
<td>503</td>
</tr>
<tr>
<td>Archiving Media Files</td>
<td>504</td>
</tr>
<tr>
<td>Restoring an Archive from Videotape</td>
<td>507</td>
</tr>
<tr>
<td>Sequence and Clip Information Summary</td>
<td>508</td>
</tr>
<tr>
<td>Creating a Summary of Effects and Source Information</td>
<td>509</td>
</tr>
<tr>
<td>Summary Information Options</td>
<td>511</td>
</tr>
<tr>
<td>Chapter 13 Viewing and Marking Footage</td>
<td>513</td>
</tr>
<tr>
<td>Viewing Methods</td>
<td>514</td>
</tr>
<tr>
<td>Customizing the Composer Window and Monitors</td>
<td>515</td>
</tr>
<tr>
<td>Resizing the Composer Window and Monitors</td>
<td>516</td>
</tr>
<tr>
<td>Displaying a Second Row of Buttons</td>
<td>517</td>
</tr>
<tr>
<td>Displaying Tracking Information</td>
<td>518</td>
</tr>
<tr>
<td>Tracking Format Options</td>
<td>519</td>
</tr>
<tr>
<td>Using the Info Window</td>
<td>522</td>
</tr>
<tr>
<td>Using the Timecode Window</td>
<td>523</td>
</tr>
<tr>
<td>Playing Video to the Client Monitor</td>
<td>524</td>
</tr>
<tr>
<td>Activating and Deactivating the Client Monitor Display</td>
<td>525</td>
</tr>
<tr>
<td>Selecting the Video Display Settings</td>
<td>526</td>
</tr>
<tr>
<td>Playing Video to a Full-Screen Monitor</td>
<td>527</td>
</tr>
<tr>
<td>Adjusting the Play Delay Offset</td>
<td>528</td>
</tr>
<tr>
<td>Using the Tool Palette</td>
<td>529</td>
</tr>
<tr>
<td>Playing Selected Clips in a Loop</td>
<td>530</td>
</tr>
<tr>
<td>Loading and Clearing Footage</td>
<td>530</td>
</tr>
<tr>
<td>Loading Clips or Sequences into Monitors</td>
<td>530</td>
</tr>
</tbody>
</table>
Chapter 14 Creating and Editing Sequences

Creating and Editing Sequences

- Entering Source/Record Mode
- Creating a New Sequence
- Changing the Name and Timecode for a Sequence
- Track Display for New Sequences
- User Preferences for Creating Tracks
- Adding Filler
- Making a First Edit
- Creating an Instant Rough Cut
- Undoing or Redoing Edits
- Editing Additional Clips into the Sequence
- Performing an Insert or Splice-in Edit
- Performing an Overwrite Edit
- Performing a Replace Edit
Chapter 15 Script-Based Editing

Resyncing Audio for a Selected Subclip
Working with Phantom Marks
Creating Video and Audio Leaders

Chapter 15 Script-Based Editing

Understanding Lined Scripts
Script Integration — Lining in the Digital Realm
Understanding the Script Window
Working with the Script Window
Working with Script Text
Working with Page or Scene Numbers and Searching in a Script
Linking Clips to a Script
Interpolating Position for Script Integration
Working with Slates in the Script Window
Working with Takes in the Script Window
Indicating Off-Screen Dialog in a Script
Using Color Indicators in the Script Window
Script Marks
- Placing Script Marks Manually
- Using Real-Time Screening and Marking
- Loading and Playing Marked Segments
- Moving or Deleting a Script Mark
Finding Clips and Script
Editing From the Script Window
- Assembling a Rough Cut From the Script Window
- Splicing a Script Range

Chapter 16 Using the Timeline

Customizing Timeline Views
- Examples of Customized Timeline Views
- Using the Timeline Fast Menu
- Timeline Fast Menu Options
- Enlarging and Reducing Timeline Tracks
- Moving Timeline Tracks
- Displaying Clip Colors in the Timeline
Chapter 17  Working with Trim Edits ................................................................. 731
  Trimming with the Timeline Palette ............................................................ 732
  Understanding Trim Displays ........................................................................ 732
  Setting Small Trim Display .......................................................................... 734
  Trim Settings Overview .................................................................................. 735
  Timeline Trim States ...................................................................................... 735
  Selecting Trim Sides ....................................................................................... 736
    Selecting Video Tracks for Trimming ............................................................ 738
    Selecting Additional Transitions ................................................................. 739
  Soloing Audio while Trimming ...................................................................... 740
  Overwrite Trimming ....................................................................................... 740
  Ripple Trimming ............................................................................................ 742
  Dual-Roller Trimming ..................................................................................... 743
  Refining Trims ............................................................................................... 744
  Reviewing Trim Edits ..................................................................................... 745
  Trimming with the J-K-L Keys ...................................................................... 746
  Trimming On-the-Fly ..................................................................................... 746
  End of Trim Indicators ................................................................................... 747
  Using Dual-Image Playback During Trims ..................................................... 748
  Trimming During a Playback Loop ............................................................... 749
  Creating Overlap Edits .................................................................................. 749
  Extending an Edit ........................................................................................... 750
  Maintaining Sync While Trimming ............................................................... 751
  Slipping or Sliding Segments ........................................................................ 753
    Selecting Segments for Slip or Slide Trimming .......................................... 754
    Performing a Slip or Slide Trim .................................................................. 755
  Trimming in Two Directions ........................................................................ 756
  Using the Transition Corner Display ............................................................ 757

Chapter 18  Working with Audio ................................................................. 759
  Overview of Audio Tools ............................................................................... 760
Accessing Audio Effect Tools ............................................................... 760
Using Audio Timecode ........................................................................ 761
Working with Multichannel Audio Tracks ........................................... 762
Displaying Track Formats in Bins ....................................................... 763
Modifying Track Formats in Bins ....................................................... 763
The Track Control Panel ................................................................. 765
Using the Track Control Panel ........................................................ 766
Soloing Audio Tracks ........................................................................ 767
Making Tracks Inactive ....................................................................... 767
Using Audio Scrub ............................................................................ 768
Selecting Tracks for Audio Scrubbing ............................................... 769
Performing Smooth Audio Scrub ..................................................... 770
Adjusting Digital Scrub Parameters ............................................... 770
Performing Digital Audio Scrub ....................................................... 771
Audio Displays in the Timeline ........................................................ 772
Displaying Audio Waveforms ......................................................... 773
Displaying Volume and Pan Values ............................................... 775
Identifying Sample Rates by Color ............................................... 776
Using Audio Meters in the Timeline ............................................... 777
Adjusting Volume ................................................................................ 777
Displaying Audio Formats in Bins ..................................................... 779
Working with Surround Sound Audio .............................................. 779
Surround Mixing ................................................................................ 781
Surround Monitoring ........................................................................ 782
Assigning Surround Sound Mix Output ......................................... 784
Setting Up the Analog Audio Output for Surround Sound Audio (Avid Nitris DX and Avid Mojo DX Only) ...................................................... 785
Setting Up the Audio Output with HDMI (Avid Nitris DX and Avid Mojo DX Only) ................................................................. 786
Adjusting the Play Buffer Size for Audio (Software-only Models) .... 787
Using the Audio Mixer Tool .............................................................. 788
Accessing the Audio Mixer and Audio Mixer Modes ....................... 789
Audio Mixer Tool Controls .............................................................. 789
Resizing the Audio Mixer Tool ........................................................ 793
Chapter 19 Using External Audio Devices

Entering Live Mix Mode .................................................. 827
Using Live Mix Mode with an External Controller .................. 827
Using Live Mix Mode Without an External Controller ............. 828
Switching Between Live Mix Mode and Other Audio Mixer Modes 828
Audio Mixer Tool Fast Menu: Live Mix Mode ....................... 828
Live Mix Mode Example .................................................. 829
Fading and Dipping Audio .............................................. 831
Adjusting Audio Clip Gain in the Timeline .......................... 833
Audio Sample Rate Conversion ...................................... 835
Changing the Audio Sample Rate for Sequences and Audio Clips . 835
Mixing Down Audio Tracks ............................................ 836
Mixing Down Multiple Audio Tracks ................................ 838
Splitting Multichannel Tracks to Mono Tracks ..................... 840
Using the Audio EQ Tool ................................................ 842
Audio EQ Tool Features ................................................ 842
Applying Audio EQ Effects ............................................ 846
Saving Audio EQ Effects ................................................ 847
Removing Audio EQ Effects with the Fast Menu ..................... 848
Removing Audio EQ Effects with the Remove Effect Button .... 849
Audio EQ Examples ...................................................... 849
Using Audio EQ Templates ............................................. 851
Adjusting EQ While Playing an Audio Effect ....................... 854
Recording Voice-Over Narration .................................... 854
Recording Voice-Over Narration Using the Capture Tool ........ 855
Audio Punch-in Tool Features ....................................... 856
Audio Punch-in Tool Scenarios ..................................... 859
Recording Voice-Over Narration Using Audio Punch-in .......... 859
Monitoring Previously Recorded Tracks While Recording Voice-Over Narration 861
Audio Punch-In Support for Open I/O Devices ..................... 862
Using Peak Hold While Recording Voice-Over Narration .......... 862
Using Automatic Voice-Over .......................................... 863
Configuring an External Controller .................................. 867
Chapter 20  Using Avid Artist Series Controllers ................................. 897
<table>
<thead>
<tr>
<th>Chapter 21</th>
<th>Using Audio Plug-Ins</th>
<th>925</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Audio Effects Plug-Ins Installation</td>
<td>925</td>
</tr>
<tr>
<td></td>
<td>Audio Track Effect Plug-Ins</td>
<td>925</td>
</tr>
<tr>
<td></td>
<td>Inserting an Audio Track Effect Plug-In on a Track in the Timeline</td>
<td>926</td>
</tr>
<tr>
<td></td>
<td>Editing an Audio Track Effect Plug-In on a Track in the Timeline</td>
<td>928</td>
</tr>
<tr>
<td></td>
<td>Moving and Copying Audio Track Effect Inserts</td>
<td>930</td>
</tr>
<tr>
<td></td>
<td>Ordering Audio Track Effect Inserts on a Track</td>
<td>930</td>
</tr>
<tr>
<td></td>
<td>Removing Audio Track Effect Inserts on a Track</td>
<td>931</td>
</tr>
<tr>
<td></td>
<td>Using Audio Track Effect Templates</td>
<td>931</td>
</tr>
<tr>
<td></td>
<td>Avid AudioSuite Plug-Ins</td>
<td>932</td>
</tr>
<tr>
<td></td>
<td>Using Avid AudioSuite Plug-Ins</td>
<td>932</td>
</tr>
<tr>
<td></td>
<td>Applying an AudioSuite Plug-in to a Clip in the Timeline</td>
<td>933</td>
</tr>
<tr>
<td></td>
<td>Common Buttons in the AudioSuite Plug-In Dialog Box</td>
<td>934</td>
</tr>
<tr>
<td></td>
<td>AudioSuite Fast Menu</td>
<td>935</td>
</tr>
<tr>
<td></td>
<td>Rendering AudioSuite Plug-in Effects</td>
<td>936</td>
</tr>
<tr>
<td></td>
<td>Creating New Master Clips with AudioSuite Plug-Ins</td>
<td>936</td>
</tr>
<tr>
<td></td>
<td>AudioSuite Controls for Creating New Master Clips</td>
<td>936</td>
</tr>
</tbody>
</table>
Exporting Projects and Bins Using AFE Files (Windows Only) ........................................ 1036
  Exporting the AFE File to Avid DS ................................................................. 1037
Exporting QuickTime Movies ................................................................. 1038
Installing or Copying the Avid Codecs for QuickTime on Other Systems .......... 1041
Exporting from a Third-Party QuickTime or AVI Application .......................... 1042
Exporting as Windows Media (Windows Only) ............................................. 1043
Creating a Custom Profile for Windows Media Export (Windows Only) .......... 1043
Exporting Media to XDCAM Devices ......................................................... 1045
Exporting to XDCAM .................................................................................. 1045
Exporting XDCAM OP1a Media ................................................................. 1047
Exporting MXF OP1a ................................................................................. 1048
Exporting a Simplified AAF ..................................................................... 1050
Exporting Your Clip or Sequence to a P2 Card ......................................... 1052
Using Avid Interplay Media Services ....................................................... 1053

Chapter 23 Generating Output ................................................................. 1054
Preparing for Output: Overview ............................................................... 1054
Selecting the Device for Output ................................................................. 1055
Selecting the Sync Source for Output ........................................................ 1055
  Sync Options for HD Formats ................................................................. 1056
  Using LTC Timecode for Output ............................................................. 1057
  Adding LTC Out During Preroll ............................................................... 1057
  LTC Output During Digital Scrub (When Using Nitris DX only) ................. 1058
Selecting a Video Output Signal ................................................................. 1059
Calibrating for Video Output ................................................................. 1059
  Using the Factory Preset Buttons in the Video Output Tool ...................... 1060
  Basic Video Output Calibration ............................................................... 1061
  Using Test Patterns ................................................................................. 1064
  Calibrating the System with Passthrough Signals .................................... 1064
  Luminance Settings for Video Output ..................................................... 1065
  Adjusting Phase Controls ...................................................................... 1066
Preparing for Converting HD Formats ...................................................... 1066
  Crossconversion and Downconversion Formats ....................................... 1068
  Considerations for Crossconversion and Downconversion ....................... 1069
Preparing for Audio Output .......................................................... 1069
  Setting the Calibration Tone .................................................. 1069
  Calibrating Global Output Levels .......................................... 1070
  Setting Audio Output Options .............................................. 1072
  Enabling 16-Channel Audio Output ....................................... 1074
  Embedded Audio and Output Sample Rate Conversion ................. 1074
  Using an XLR Adapter for Consumer-Level Analog Output .......... 1075
Preparing Record Tapes .......................................................... 1075
  Striping Record Tapes (Recording Black with Timecode) ............ 1076
  Recording Bars and Tone ..................................................... 1076
  Enabling Assemble-Edit Recording ....................................... 1077
Using ExpertRender to Prepare Effects for a Digital Cut ............ 1078
Using the Digital Cut Tool ..................................................... 1079
  Selecting a Deck in the Digital Cut Tool ............................... 1081
  Previewing a Digital Cut .................................................... 1081
  Recording a Digital Cut to Tape (Remote Mode) ....................... 1082
  Crash Recording Through Remote Deck Control ....................... 1085
  Recording a Digital Cut to Tape (Local Mode) ....................... 1086
Output Mode Resolution Options ............................................. 1087
Outputting DV 50 and DVCPRO HD Media Directly to a DV Device .... 1089
Selecting Output and Timecode Formats for 23.976p, 24p, and 25p Projects ... 1089
Selecting Output Formats for 23.976p, 24p, and 25p Projects ....... 1090
Output Format Reference for 23.976p, 24p, and 25p Projects ........ 1091
Selecting the Timecode Format for Output ............................... 1093
Outputting Drop-Frame and Non-Drop-Frame Timecode Simultaneously for Downstream Encoding ........................................... 1094
Indicating the Destination Timecode Rate ............................... 1094
Selecting the Video Pulldown Cadence ................................... 1095
Performing an Insert Edit with Pulldown ................................ 1095
Digital Cuts and Audio .......................................................... 1096
Changing the Default Pulldown Phase for Sequences ................ 1097
Understanding DV Digital Cut Delay ....................................... 1098
Delaying the Sequence for a Digital Cut ................................. 1099
Understanding Passthrough .......................................................... 1099
Using the Lists Tool ................................................................. 1100
  Input Tab .................................................................................. 1101
  List Options Tab ....................................................................... 1101
  Formatting Tab ........................................................................ 1102
  Preview Pane ............................................................................ 1103
Creating a List ........................................................................... 1103
Editing a List .............................................................................. 1105
Importing an EDL ....................................................................... 1106
EDL: List Options ...................................................................... 1107
EDL: Formatting Options ............................................................ 1107
Cut List: List Options ................................................................. 1110
Change List: List Options ............................................................ 1113
Cut List or Change List: Formatting Options ............................... 1115
Cut List and Change List Icons .................................................. 1116
Change List Icons ...................................................................... 1117
Understanding Matchback .......................................................... 1117
Vertical Blanking Information .................................................... 1119
  Vertical Blanking Interval Line Ranges ...................................... 1119
  Displaying and Preserving Vertical Blanking Information .......... 1119
  Editing a Sequence with Vertical Blanking Information .......... 1121
  Effects of Preserving Vertical Blanking Information on Compressed Video Quality ......................................................... 1122
Preserving HD Closed Captioning and Ancillary Data ............... 1123
  Data Track Method .................................................................. 1124
  Adding a Data Track .................................................................. 1125
  Adding the Active Format Description to the Data Track .......... 1126
Ancillary Data and AMA ............................................................... 1128
  Moving from Legacy Method to Data Track Method ............... 1129
Ancillary Data and Avid Editing Functions .................................. 1130
Legacy Method ........................................................................... 1131
  Controlling Ancillary Data through a Settings Window - Data Track Method ................................................................. 1132
  Controlling Ancillary Data through a Settings Window - Legacy Method ................................................................. 1133
Chapter 24  **Conforming and Transferring Projects**  

Understanding Conforming  ..................................................... 1139
Preparations for Conforming .................................................. 1140
Delivery Requirements for Final Masters  ................................ 1140
Offline Formats for HD ......................................................... 1140
File Transfer for the Online Session ....................................... 1141
System Compatibility for the Online Session ............................. 1141
Preparing Graphics for the Online Session ................................. 1143
Preparing Effects for the Online Session ................................... 1144
(Symphony Option) Preparing Titles for the Online Session .......... 1144
Preparing Audio for the Online Session .................................... 1144

Conforming Workflow ............................................................ 1145
Step 1: Transfer Files ............................................................ 1145
Step 2: Open the Project ........................................................ 1146
Step 3: Measure the Video Signal ............................................. 1147
Step 4: Recapture Media ........................................................ 1148
Step 5: Import and Lay in the Final Audio Mix ........................... 1149
Step 6: Batch Import Graphics ............................................... 1149
Step 7: Re-create Title Media .................................................. 1150
Redefining a Font Replacement ............................................... 1151
Step 8: Refine Effects and Perform Color Correction ................... 1152
Step 9: Render Effects as Needed ............................................. 1153
Step 10: Create the Final Masters ............................................ 1153

Conforming Sequences with Color Correction ............................ 1154
Conforming Color Correction Sequences with Media Composer or Avid Xpress Pro Systems .................................................. 1154
Transferring Color Corrections with Color Correction Templates ........ 1154
Transferring Project and Media Files Between Avid Editing Systems 1155
Transferring Audio Files ......................................................... 1156
Chapter 25 Using the NRCS Tool
(Media Composer | NewsCutter Option) 1161

Configuring the NRCS Tool ........................................... 1162
  Configuring the ENPS Server for Avid Clients .................. 1162
  Configuring the NRCS Settings .................................. 1163
Starting the NRCS Tool .............................................. 1167
NRCS Tool Components ............................................. 1168
Using the Directory Panel ........................................... 1172
  Opening a Story .................................................... 1172
  Using Shortcuts with Directories (iNEWS Only) ................ 1173
  Deleting a Story (iNEWS Only) ................................ 1174
Changing the Text Display .......................................... 1174
Editing Story Text (iNEWS Only) .................................. 1175
  Rearranging Text in a Story (iNEWS Only) ...................... 1175
  Marking Text (iNEWS Only) ..................................... 1176
  Formatting Text (iNEWS Only) .................................. 1177
  Adding a Production Cue (iNEWS Only) ......................... 1177
  Using Loaded Cues (iNEWS Only) ............................... 1178
Finding the Read Time of a Story .................................. 1180
Sequences and Stories .............................................. 1181
  Building a Sequence from a Story ............................... 1182
  Script-Based IN and OUT Points ................................ 1183
  Setting Timeline IN and OUT Points Based on Story Timing 1184
Associating a Sequence with a Story .............................. 1185
Adjusting the Story Timing (iNEWS Only) ....................... 1186
  Adjusting the Story Timing with a Time Marker (iNEWS Only) 1186
  Adjusting the Story Timing with a Time Pad (iNEWS Only) 1186
Using Associated Sequences ....................................... 1188
### Chapter 29 Using Interplay Transfer to Export Media

- Installing the Interplay Transfer Client Software .................................................. 1311
- Setting Transfer Settings in the Avid Editing Application ..................................... 1312
- Send to Playback with Multichannel Audio Tracks .............................................. 1316
- Mapping Audio Tracks to Output Channels ......................................................... 1316
- Transferring Avid Assets from an Avid Editing Application ................................. 1320
- Transferring Avid Assets to a Playback Device .................................................... 1320
- Working with Rundowns (NewsCutter Option) .................................................... 1322
- Creating a Rundown Schedule File (NewsCutter Option) ..................................... 1323
- Transcoding of Mixed Resolution Clips During a Send to Playback ....................... 1323
- Monitoring Transfers from Within the Avid Editing Application ......................... 1324
- Transfer Status Window Options ........................................................................ 1325
- Sorting the Transfer Status Columns ................................................................ 1325
- Clearing the Transfer Status Window .................................................................. 1326

### Chapter 30 Using MultiRez and Dynamic Relink

- Understanding MultiRez and Proxy Editing .......................................................... 1327
- Acquiring Media at Multiple Resolutions .............................................................. 1329
- Batch Capturing Media at a Different Resolution ............................................... 1329
- Batch Importing File-Based Media at Different Resolutions ............................... 1331
- Transcoding Media to Low-Res Proxies .............................................................. 1332
- Understanding How Clips are Associated with Multiple Resolutions ................. 1333
- Options for Clip and Media Association ............................................................... 1335
- Understanding Dynamic Relink ........................................................................... 1338
- Using Dynamic Relink with Media Composer | Cloud Editing Systems .............. 1341
- Workflow: Editing a Film or HD Project using MultiRez ...................................... 1342
- Considerations When Working with Dynamic Relink ......................................... 1348
- Using the Dynamic Relink Settings Dialog Box ................................................. 1348
- Opening the Dynamic Relink Settings Dialog Box .............................................. 1348
- Enabling Dynamic Relink .................................................................................... 1349
- Applying Working and Target Settings for Dynamic Relink ............................... 1349
Examples of Working and Target Settings for Dynamic Relink ................................ 1350
Dynamically Relinking to the Target Settings ............................................................. 1353
Using Dynamic Relink with Mixed Rate Clips ......................................................... 1354
Relinking in Frame Chase Editing .............................................................................. 1355
Using the Relink Dialog Box in an Avid Interplay Environment .............................. 1356
Displaying Whether Media Is Available for Dynamic Relinking .............................. 1356
Using the MultiRez Button to Show Available Media .............................................. 1356
Using Clip Coloring to Show Available Resolutions .............................................. 1357
Examples of MultiRez Clip Coloring ........................................................................ 1359
MultiRez Button Menu ............................................................................................... 1361
MultiRez Bin Headings ............................................................................................... 1363
Understanding Options for Deleting MultiRez Clips and Media ............................ 1364
Deleting MultiRez Clips and Media from a Bin ......................................................... 1365
Working with Partially Online Files .......................................................................... 1366
Consolidating and Transcoding a Portion of a Clip ................................................ 1366
Viewing a Source Clip in the Timeline ...................................................................... 1367
Consolidating and Deleting Original Media ............................................................. 1368
Partially Restoring from an Archive .......................................................................... 1368
Quality Matching ...................................................................................................... 1369
Quality Matching Reference ...................................................................................... 1371
Example of Quality Matching .................................................................................. 1373

Chapter 31 MultiCamera Editing .............................................................................. 1374
Understanding Grouping and Multigrouping Clips ................................................ 1374
Creating Group Clips ................................................................................................. 1375
Grouping Stereoscopic Clips .................................................................................... 1376
Creating Multigroup Clips ......................................................................................... 1377
MultiCamera Displays .............................................................................................. 1377
Real-time Playback in MultiCamera Mode ............................................................... 1382
Limitations on Playback of MultiCamera Media .................................................... 1383
MultiCamera Editing Techniques ............................................................................. 1383
Switching Clips with the Arrow Keys During Multicamera Editing ........................ 1383
Numeric Keypad and Mouse Support for MultiCamera Editing ............................. 1384
Editing and Playing Back a Linecut in MultiCamera Mode ..................................... 1384
Chapter 32  The Avid Marketplace

Avid Marketplace Media Libraries
Avid Marketplace Media Libraries Quick Start
Creating a User Sign In and Password
Licensing Options
About the Stock Footage Clips
Searching through Stock Footage
  Performing a Search
  Basic Search Terms
  Modifying a Search
  Creating an Online Stock Footage Bin
Managing Your Bins

Downloading Stock Footage Clips to Your Avid Bin
  Adding Vendor Columns to your Avid Bin
  Getting Comp Clips into Your Avid Bin
Creating a Stock Footage Report
Stock Footage Report Information
Purchasing Your Stock Footage
Downloading your High Resolution Stock Footage
Relinking High Resolution Media to Your Sequence
Avid Marketplace Plug-ins
Purchasing and Downloading a Plug-in from the Avid Marketplace

Chapter 33  Settings

Understanding Settings
Working with Settings
  Viewing and Modifying Settings
  Filtering the Settings List
<table>
<thead>
<tr>
<th>Setting</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Export Settings: QuickTime Reference Options</td>
<td>1476</td>
</tr>
<tr>
<td>Export Settings: QuickTime Movie Export Options</td>
<td>1478</td>
</tr>
<tr>
<td>Export Settings: QuickTime Movie Settings</td>
<td>1480</td>
</tr>
<tr>
<td>Export Settings: QuickTime Compression Settings</td>
<td>1481</td>
</tr>
<tr>
<td>Export Settings: HDV</td>
<td>1482</td>
</tr>
<tr>
<td>Export Settings: DV Stream</td>
<td>1483</td>
</tr>
<tr>
<td>Export Settings: AVI Through QuickTime</td>
<td>1484</td>
</tr>
<tr>
<td>Export Settings: AVI Video Compression</td>
<td>1484</td>
</tr>
<tr>
<td>Export Settings: Windows Media (Windows Only)</td>
<td>1485</td>
</tr>
<tr>
<td>Export Settings: Audio</td>
<td>1489</td>
</tr>
<tr>
<td>Export Settings: Graphic</td>
<td>1489</td>
</tr>
<tr>
<td>Export Settings: Graphic Format</td>
<td>1490</td>
</tr>
<tr>
<td>Export Settings: P2</td>
<td>1493</td>
</tr>
<tr>
<td>Export Settings: XDCAM</td>
<td>1494</td>
</tr>
<tr>
<td>Film and 24P Settings</td>
<td>1494</td>
</tr>
<tr>
<td>Full Screen Playback Settings</td>
<td>1495</td>
</tr>
<tr>
<td>General Settings</td>
<td>1499</td>
</tr>
<tr>
<td>Grid Settings</td>
<td>1500</td>
</tr>
<tr>
<td>Import Settings</td>
<td>1502</td>
</tr>
<tr>
<td>Interface Settings</td>
<td>1508</td>
</tr>
<tr>
<td>Interplay Folder, Interplay Server, and Interplay User Settings</td>
<td>1509</td>
</tr>
<tr>
<td>Keyboard Settings</td>
<td>1510</td>
</tr>
<tr>
<td>Marquee Title Settings</td>
<td>1511</td>
</tr>
<tr>
<td>Media Creation Settings</td>
<td>1512</td>
</tr>
<tr>
<td>Media Services Settings (Windows Only)</td>
<td>1515</td>
</tr>
<tr>
<td>Mouse Settings</td>
<td>1515</td>
</tr>
<tr>
<td>NRCS Settings</td>
<td>1516</td>
</tr>
<tr>
<td>(Media Composer</td>
<td>NewsCutter Option)</td>
</tr>
<tr>
<td>Passthrough Mix Tool</td>
<td>1518</td>
</tr>
<tr>
<td>PortServer Settings</td>
<td>1518</td>
</tr>
<tr>
<td>Remote Play and Capture Settings</td>
<td>1519</td>
</tr>
<tr>
<td>Render Settings</td>
<td>1520</td>
</tr>
<tr>
<td>S3D Settings</td>
<td>1522</td>
</tr>
</tbody>
</table>
Safe Colors Settings ................................................................. 1523
Script Settings ........................................................................... 1524
Sound Card Configuration Settings
   (Windows Only) ..................................................................... 1525
Timeline Settings ................................................................. 1525
Transfer Settings ................................................................. 1528
Trim Settings ............................................................................. 1530
Video Display Settings ......................................................... 1531
Video Input Tool Settings .................................................... 1532
Video Output Tool Settings .................................................. 1533
Video Satellite Settings .......................................................... 1538
Workspace Linking Settings ................................................... 1539

Chapter 34 File Format Specifications ........................................ 1540
Specifications for Graphics (Image) Files .................................. 1540
Specifications for Animation Files .......................................... 1545
Specifications for Importing OMFI Files .................................. 1547
Working with BWF Files ........................................................... 1548
   Preparing Custom BWF Information .................................... 1548
   Importing, Syncing, and Reimporting BWF Files ................ 1550
   Importing Multichannel Broadcast Wave (BWF) Files .......... 1551
   iXML Metadata in Broadcast Wave and AIFF Files ................ 1552
Field Ordering in Graphic Imports and Exports ......................... 1554

Chapter 35 Resolutions and Storage Requirements ...................... 1557
Compression and Avid Editing Applications ................................. 1557
Monitor Display Resolutions .................................................... 1558
Resolution Specifications .......................................................... 1559
   Higher than HD Formats Supported by Media Composer .... 1559
   Resolution Specifications: HD .............................................. 1559
   Resolution Specifications SD: J2K ....................................... 1566
   Resolution Specifications: AVC-Intra with AVC-I Codec Module .... 1566
   Resolution Specifications: JFIF Interlaced ............................ 1567
   Resolution Specifications: JFIF Progressive ........................ 1568
   Resolution Specifications: Multicam .................................... 1569
Chapter 36 Working in HD and High-Resolution Projects

Resolution Specifications: Digital Video (DV) ........................................ 1569
Resolution Specifications: MPEG ......................................................... 1570
Resolution Specifications SD: Apple ProRes .................................... 1571
Proxy Resolutions .............................................................................. 1571
Support for Uncompressed HD Media .............................................. 1573
Mixing Resolutions ........................................................................... 1573
Resolution Groups and Image Quality .............................................. 1574
Estimating Drive Space Requirements ............................................. 1574
Storage Requirements ..................................................................... 1575
  Estimated Storage Requirements: HD .............................................. 1575
  Estimated Storage Requirements: JFIF Interlaced ......................... 1580
  Estimated Storage Requirements: JFIF Progressive ..................... 1583
  Estimated Storage Requirements: DV ............................................. 1585
  Estimated Storage Requirements: MPEG ........................................ 1586
Considerations for Managing Storage ............................................. 1586

Working in HD and High-Resolution Projects ................................. 1588

Delivery Methods for Cinema and Television ................................. 1588
Transferring Film to Tape ................................................................. 1589
  Transfer of 24-fps Film to NTSC Video ........................................ 1593
  Transfer of 24-fps Film to PAL Video ........................................... 1595
Viewing Video Dailies ....................................................................... 1597
HD Workflow: Video-Based Television ............................................ 1598
Producing Graphics for Broadcast .................................................... 1600
Creating a Film-Based Project ......................................................... 1600
  Selecting a Project Format during Capture .................................. 1603
  Selecting a Project Format during Output ..................................... 1603
Changing the Project Format ............................................................ 1604
Changing the Sequence Format ....................................................... 1605

(Media Composer | Symphony Option) Converting a 24p NTSC Sequence to 1080p/23.976 1607
Converting a 23.976p NTSC Sequence to 720p/23.976 ...................... 1608
Editing at 60 fps .............................................................................. 1608
Displaying 24p and 25p Media ......................................................... 1609
Using This Guide

This guide contains the task-oriented instructions, conceptual information, and reference information you need to use the features of your Avid editing application. The contents of this guide is also available in the Help.

This guide is intended for all users, from beginning to advanced.

Symbols and Conventions

Avid documentation uses the following symbols and conventions:

<table>
<thead>
<tr>
<th>Symbol or Convention</th>
<th>Meaning or Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>A note provides important related information, reminders, recommendations, and strong suggestions.</td>
<td></td>
</tr>
<tr>
<td>A caution means that a specific action you take could cause harm to your computer or cause you to lose data.</td>
<td></td>
</tr>
<tr>
<td>A warning describes an action that could cause you physical harm. Follow the guidelines in this document or on the unit itself when handling electrical equipment.</td>
<td></td>
</tr>
<tr>
<td>This symbol indicates menu commands (and subcommands) in the order you select them. For example, File &gt; Import means to open the File menu and then select the Import command.</td>
<td></td>
</tr>
<tr>
<td>This symbol indicates a single-step procedure. Multiple arrows in a list indicate that you perform one of the actions listed.</td>
<td></td>
</tr>
<tr>
<td>This text indicates that the information applies only to the specified operating system, either Windows or Macintosh OS X.</td>
<td></td>
</tr>
<tr>
<td>Bold font is primarily used in task instructions to identify user interface items and keyboard sequences.</td>
<td></td>
</tr>
<tr>
<td>Italic font is used to emphasize certain words and to indicate variables.</td>
<td></td>
</tr>
</tbody>
</table>
If You Need Help

If you are having trouble using your Avid product:

1. Retry the action, carefully following the instructions given for that task in this guide. It is especially important to check each step of your workflow.

2. Check the latest information that might have become available after the documentation was published. You should always check online for the most up-to-date release notes or ReadMe because the online version is updated whenever new information becomes available. To view these online versions, select ReadMe from the Help menu, or visit the Knowledge Base at www.avid.com/support.

3. Check the documentation that came with your Avid application or your hardware for maintenance or hardware-related issues.

4. Visit the online Knowledge Base at www.avid.com/support. Online services are available 24 hours per day, 7 days per week. Search this online Knowledge Base to find answers, to view error messages, to access troubleshooting tips, to download updates, and to read or join online message-board discussions.

Avid Training Services

Avid makes lifelong learning, career advancement, and personal development easy and convenient. Avid understands that the knowledge you need to differentiate yourself is always changing, and Avid continually updates course content and offers new training delivery methods that accommodate your pressured and competitive work environment.

For information on courses/schedules, training centers, certifications, courseware, and books, please visit www.avid.com/support and follow the Training links, or call Avid Sales at 800-949-AVID (800-949-2843).
The topics in this chapter provide an overview of the editing workflow:

- Editing Workflow
- Starting a Project
- Preparing to Edit
- Editing a Sequence
- Outputting a Sequence

**Editing Workflow**

Your editing workflow depends on a variety of factors. For example, you might work on a standard-definition video project, a film project, or an HD project.

The following procedure lists the basic steps for editing a sequence and refers you to sections of the documentation for more information.

1. Create or open a project.
   
   For more information, see “Starting a Project” on page 59.

2. Set the appropriate Project settings and create a bin structure.
   
   For more information, see “Working with the Project Window” on page 87.

3. Capture or import the media.
   
   For more information, see “Preparing for Capture” on page 168, “Capturing Media” on page 232, and “Importing Files” on page 297.

4. Organize your bins to suit your project’s needs.
   
   For more information, see “Working with Bins” on page 339.

5. View your clips in advance and mark IN and OUT points, or create subclips based on selected portions of your master clips.
   
   For more information, see “Viewing and Marking Footage” on page 513.

6. Build your sequence in the Timeline.
Starting a Project

Whenever you start to work on a new project, follow these basic steps:

1. Turn on your equipment in a prescribed order and start your Avid editing application.
   For more information, see “Turning on Your Equipment” on page 59.
2. Select or create a new project
   For more information, see “Starting a Project” on page 59.
3. Select the Project settings from the Settings list.
   For more information, see “Working with the Project Window” on page 87.
4. Create and organize bins.
   For more information, see “Working with Bins” on page 339.
5. Back up your project on a regular basis.
   For more information, see “Starting a Project” on page 59.
Preparing to Edit

When you capture and organize footage before you edit, follow these basic steps:

1. Batch capture, log and capture, or capture on-the-fly your source material into your Avid editing application.
   
   For more information, see “Preparing for Capture” on page 168 and “Capturing Media” on page 232.
2. Use bins to organize your project items.
   For more information, see “Working with Bins” on page 339.
3. Use the Media tool to manage media files.
   For more information, see “Managing Media Files” on page 467.
4. Use the bins to create storyboards.
   For more information, see “Creating a Storyboard” on page 382.

**Editing a Sequence**

When you edit your video and audio, follow these basic steps:

1. View your clips and mark IN and OUT points, or create subclips based on selected portions of your master clips.
   For more information, see “Viewing and Marking Footage” on page 513.
2. Build your sequence in Source/Record mode in the Timeline. See “Creating and Editing Sequences” on page 582.

3. Use Segment, Trim, and Effect modes to fine-tune your edits and effects.
   For more information, see “Using the Timeline” on page 662, “Working with Trim Edits” on page 731, and the Effects and Color Correction Guide for your Avid editing application.

4. Use the Audio tool to adjust and mix multiple audio tracks and prepare for final playback or output.
   For more information, see “Working with Audio” on page 759.

5. Continue to edit if further adjustments are required.
Outputting a Sequence

When your sequence is finished, you can output it in any of the following ways:

- Export as a file or a series of files.
  
  For more information, see “Exporting Frames, Clips, or Sequences” on page 1019.
- Output a digital cut in one or more formats.
  
  For more information, see “Generating Output” on page 1054.
- Generate a cut list through the Lists Tool.
- Generate an EDL through the Lists Tool.
  
  See “Using the Lists Tool” on page 1100.
Finished sequence. Output options include:

**Export a file**

**Output to tape**

**Generate a cut list**

**Generate an EDL**
Starting a Project

Your work begins when you turn on your system, start your Avid editing application, and open an existing project or create a new project. The following topics describe procedures for starting your work, as well as several techniques to safeguard and restore your work if necessary:

- Turning on Your Equipment
- Working with the Desktop
- Starting Your Avid Editing Application (Windows)
- Starting Your Avid Editing Application (Macintosh)
- Application Manager
- Working with Projects
- Quitting and Turning Off Equipment
- Avid Projects and Avid Users Folders
- Changing Project and User Names
- Backing Up Your Project Information
- Avid Attic Folder

Turning on Your Equipment

Avid recommends that you turn on your equipment in the following order:

1. Storage devices.
2. Peripheral devices (such as monitors and speakers).
3. Computer system.
4. Avid input/output hardware device.

*Do not disconnect devices while you run your Avid editing application. Before you start your Avid editing application, make sure you connect all your devices first.*
Working with the Desktop

You can use some of the desktop navigation features of your operating system to speed your work or customize for your convenience while you edit. You can:

- Control how the Windows taskbar appears on the screen (Windows only).
- Use the Macintosh Dock as a quick way to launch your Avid editing application (Macintosh only).
- Use shortcut menus (also sometimes known as context menus) to quickly access editing commands.
- Use standard keyboard shortcuts to navigate and select options in dialog boxes and menus.
- Use the mouse scroll wheel for navigation and customize mouse button functions.

You also use the desktop for backups and transferring projects, as described in “Backing Up Your Project Information” on page 81 and “Avid Projects and Avid Users Folders” on page 72.

For information on the Windows desktop and icons, see your Microsoft® documentation. For information on the System Folder and the desktop and icons, see your Macintosh documentation.

Using the Windows Taskbar (Windows Only)

By default, the Windows taskbar always appears on the bottom of your screen, on top of your Avid editing application. You have two other choices:

- Keep the taskbar hidden behind your Avid editing application
- Set the taskbar to appear only when you drag the mouse pointer to it

If you keep the taskbar hidden while you run your Avid editing application and you minimize an application such as Help, you do not see the minimized icon in the taskbar.

For more information about the taskbar, see the Windows Help.

You can also drag the taskbar to the top, bottom, or either side of the monitor.

When you work in your Avid editing application, you can minimize windows (such as the Project window and bins). The icons appear in your Avid editing application window, not in the taskbar.

To see the taskbar and minimized icons:
- Minimize your Avid editing application.
To change the taskbar settings:

1. Right-click an unused part of the taskbar, and select Properties.
   The Taskbar and Start Menu Properties dialog box opens.

2. Select the options you want:
   - To keep the taskbar hidden, deselect “Keep the task bar on top of other windows” and “Auto hide the task bar.”
   - To set the taskbar to appear when you want, select “Keep the task bar on top of other windows” and “Auto hide the task bar.”

3. Click OK.

Using the Macintosh Dock (Macintosh Only)

You can place an application icon alias on the Dock for easy access to your Avid editing application. The Dock is hidden when your Avid editing application is active. For full information on using the Dock, see the Macintosh documentation.

To display the Dock:
- Move the mouse pointer to the edge of the screen where the Dock is hidden.

Using Shortcut Menus

In addition to standard menus to find a command you need, you can use shortcut menus. Shortcut menus show the most frequently used commands for a window or a screen object.

Most shortcut menus contain a What’s This? command to access Help for the window or the object.

To use a shortcut menu:
- Right-click a window or a screen object.

Using the Keyboard for Navigating in Dialog Boxes and Menus

To navigate in dialog boxes and menus and to select and deselect options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>To move from tabbed page to tabbed page</td>
<td>Press Page Up or Page Down.</td>
</tr>
<tr>
<td>within a dialog box.</td>
<td></td>
</tr>
<tr>
<td>To move from check box to check box or from</td>
<td>Press Tab.</td>
</tr>
<tr>
<td>option to option in a dialog box.</td>
<td></td>
</tr>
</tbody>
</table>
Using the Mouse Scroll Wheel for Navigating

You can use the mouse scroll wheel to navigate in your Avid editing application, as described in the following table. You can also set the speed to scroll with the mouse wheel, and assign functions to three additional mouse buttons, as described in “Customizing Mouse Functions” on page 62.

<table>
<thead>
<tr>
<th>Option</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>To select or deselect a check box or an option in a dialog box.</td>
<td>Press Right Arrow, Left Arrow, or the space bar.</td>
</tr>
<tr>
<td>To move up or down in a menu, or increment a numeric value.</td>
<td>Press Up Arrow or Down Arrow.</td>
</tr>
</tbody>
</table>

Customizing Mouse Functions

Your Avid editing application lets you set the speed of scrolling with the mouse wheel, and lets you assign functions to three additional mouse buttons.

*When you map mouse buttons, make sure that the modifier key that you assign to the button and command does not already have an alternate function.*

*You cannot assign functions to the standard left and right mouse buttons.*

**To set the mouse scroll speed:**

1. In the Project window, click the Settings tab, and then double-click Mouse.
   
   The Mouse Settings dialog box opens.
2. Select a speed from the Vertical Scroll Speed menu.
   Normal is the default setting. Normal scrolls one item at a time. Moderate scrolls two items at a time, and Fast scrolls four items at a time.

To assign functions to additional mouse buttons:
1. In the Project window, click the Settings tab, and then double-click Mouse.
   The Mouse Settings dialog box opens.
2. Select Tools > Command Palette.
   The Command palette opens.
3. Select Button to Button Reassignment at the bottom of the Command palette.
4. Click the tab from which you want to select a user-selectable button.
5. Click the mouse, and drag the button from the Command palette to a button location on the Mouse Settings dialog box.

**Optimum Performance (Windows 7)**

The following list contains suggestions for ensuring optimum performance when working with your Avid editing application on a Windows 7 system:

- It is required to turn off File Sharing. If you do not do this, you might receive Access Denied errors after you move files.
  
  In Control Panel > Network and Sharing Center > File Sharing, select Turn off File Sharing.
- Disable CPU throttling.
  
  In Control Panel > Hardware and Sound > Power Options, select High Performance.
- Do not enable the Windows Display setting “Show window contents while dragging.” This setting hinders redraw performance on your Avid editing system.
In Control Panel > Appearance and Personalization > Personalization > Window Color and Appearance > Effects, deselect Show window contents while dragging.

- Enable setting to adjust for best performance.


- Disable Desktop compositing.

In Control Panel > System and Maintenance > System > System Protection > Advanced tab > Performance Setting, deselect Enable desktop composition.

- Disable Windows Defender.

In Control Panel > Security > Windows Defender > Tools > Options > Administrator Options, deselect Use Windows Defender > Save.

- Disable Sidebar.

Right-click the Sidebar or Sidebar icon on your desktop > Properties > Deselect Start Sidebar when Windows starts > Right click icon and select Exit.

- Disable Hibernation in the Power options.

In Control Panel > Performance Information and Tools > Power Options > Change when the computer sleeps > Put the computer to sleep, select Never.

- Change Advanced Power Settings.

In Control Panel > Performance Information and Tools > Power Options > Change when the computer sleeps > Change advanced power settings > High Performance (instead of Balanced) Hard disk > Turn off hard disk after Setting: Never.

In Control Panel > Performance Information and Tools > Power Options > Change when the computer sleeps > Change advanced power settings > High Performance (instead of Balanced) Sleep > Sleep after Setting: Never.

- Set automatic updates to Notify you but don’t automatically download.

In Control Panel > System and Maintenance > Windows Updates > Change settings, select “Notify me but don’t automatically download them or install them.”

- Turn off the firewall for Avid Interplay.

In Control Panel > Security > Windows Firewall, select Turn Windows Firewall on or off.

- Do not leave the Console window open when you edit. The performance of your Avid editing system slows considerably when the Console window is open.

- Do not leave a Windows Explorer window open. Windows Explorer attempts to update file information.

- Do not leave an e-mail application open if it is set to do periodic checks for mail.

- Do not run any application that periodically “wakes up” and performs an action.
• Disable screen savers.
• Do not keep media on the same partition where you install your Avid editing application. Avid recommends external media drives.
• Always use small fonts with the display driver to avoid missing characters in the dialog boxes in your Avid editing application.
• After you move a drive from one system to another, restart your system. Windows does not recognize the drive until you restart.
• Ensure you do not accidentally delete locked items from your desktop.
  Right-click the Recycle Bin icon on your desktop > Properties > General tab > Display delete confirmation dialog.
• When you advance by single frames through the Timeline, deselect Render On-the-Fly to enable faster response time.
  In your Avid editing application, deselect Clip > Render On-the-Fly
• Do not name files with special characters (\ : “ ” < > | *). Windows does not recognize special characters in file names. Bin names are limited to 64 characters (not including the four characters reserved for the file name extension).
• Do not schedule automatic backups at times when your Avid editing system might be in use.
• Do not run any application that includes prescheduled or automatically scheduled activities, such as a calendar program.
• Do not leave other applications running. Some applications, such as Microsoft Office, run background processes.
• Do not allow the Find Fast background process (find.exe) to run. The process tries to update its cache of file and folder locations. Check your Startup folder, and delete the file if it is there. To locate the find.exe, select Start > Search > find.exe.

**Optimum Performance (Macintosh)**

The following list contains suggestions for ensuring optimum performance when working with your Avid editing application on a Macintosh system:

• Do not select the option that puts the hard disk to sleep when possible.
  In System Preferences > Hardware Energy Saver, deselect Put the hard disk(s) to sleep when possible.
• Set sleep options to Never in Energy Saver preference.
  In System Preferences > Hardware Energy Saver, select Never.
• Disable screensavers.
  In System Preferences > Personal Desktop & Screen Saver > Screen Saver, select Never.
Antivirus Applications

Antivirus programs that contain autoscanning features can interfere with the operation of your Avid editing application. Since virus scanning is a processor-and disk-intensive activity, it can interfere with capturing and playing real-time effects in your Avid editing application.

Avid recommends you do not scan files or schedule any background tasks such as virus scanning when you use your Avid editing application.

File deletion protection utilities also consume system resources and could interfere with the proper operation of your Avid editing application. These utilities automatically back up any files that you delete, even temporary files that you create and delete with your Avid editing application. This consumes a large amount of disk space.

Starting Your Avid Editing Application (Windows)

By default, your Avid editing application is located in the following folder:

\drive\Program Files\Avid\Avid editing application

The installation process adds a desktop icon and a pointer to your Avid editing application in the Start menu.

Your Avid editing application does not start properly if you move the application file from the Avid editing application folder.

If you install your Avid editing application on a laptop computer, a dialog box might open with a message about incompatible power management schemes. Avid recommends you use the “High Performance” power option for Windows 7 when you work with Avid editing applications. Other power schemes might affect performance of editing functions (for example, capture and digital cuts).

To start your Avid editing application, do one of the following:

- Click Start > All Programs > Avid > Avid editing application.
- Double-click the Avid editing application desktop icon.

After your Avid editing application starts, the Select Project dialog box opens. For more information on the Select Project dialog box, see “Working with Projects” on page 69.

Starting Your Avid Editing Application (Macintosh)

Your Avid editing application is in the following location:
Macintosh HD/Applications/Avid editing application

For most users, the desktop or Dock is a more convenient location to start your Avid editing application. The installation process places a shortcut alias icon for your Avid editing application on the desktop.

*For more information to make an alias and use the Dock, see your Macintosh documentation.*

*Your Avid editing application does not start properly if you move the application file from the Avid editing application folder. You can drag it onto the Dock, and an alias appears on the Dock.*

*When you start your Avid editing application, you might see a message box which indicates there is no input or output signal. Check to ensure that your Avid input/output hardware is connected to the system with the cables secured and that it is turned on.*

**To start your Avid editing application, do one of the following:**

- Double-click the alias icon for your Avid editing application on the desktop.
- Double-click the alias icon for your Avid editing application on the Dock.
- Select Go > Applications, and then double-click the Avid editing application folder. Then double-click the Avid editing application file.

You might see a license agreement. After your Avid editing application starts, the Select Project dialog box opens. For more information on the Select Project dialog box, see “Working with Projects” on page 69.

**Application Manager**

The Application Manager is a tool that allows you to manage your Avid Applications. The Application Manager is installed with your editing application. The tool is provided to give you easy access to view your installed applications, license the application, and to be notified if an update is available. You can also get promotional information and Customer Support information from this tool.

**To view installed Applications or Applications available for trial or purchase:**

1. Click the Application Manager icon in your Toolbar (Windows) or Dock (Macintosh).
2. With the Application Manager open, click the Apps tab.
   
The installed applications appear with their current status.
   
You can also see the list of applications available for trial or purchase. From this window, you can see the status of your application, and when available, update to the latest version, renew a subscription, or buy the product if you have been using the trial version.
To view product promotions and 3rd party news:

1. Click the Application Manager icon in your Toolbar (Windows) or Dock (Macintosh).
2. With the Application Manager open, click the Feeds tab.

   The feeds are displayed in the chronological order. The most recent feed is displayed at top. Links to promotional information and news are listed. Click the link to access the desired information. You can filter the feeds you want displayed by clicking the category drop down list and selecting from the list.

To view your current support plan:

1. Click the Application Manager icon in your Toolbar (Windows) or Dock (Macintosh).
2. With the Application Manager open, click the Support tab.

   From this window, you can see your current support plan, choose to upgrade the support plan, access support phone numbers, contact the Avid Community, manage support cases, and access the Avid Knowledge Base.

To enable and disable Notifications:

1. Click the Application Manager icon in your Toolbar (Windows) or Dock (Macintosh).
2. With the Application Manager open, click the Settings pulldown menu.
3. Select Notifications.

   If you deselect Show Apps, you no longer receive notifications when an update is available. If you deselect Show Feeds, you no longer receive notifications of Avid news.

**Licensing the Editing Application through Application Manager**

The Licensing tab displays all the licensed products, the activation status, the type of ownership (trial, subscription, or permanent) and the renewal date. From this tab, you can activate and deactivate your product. You can activate with an Internet connection, without an Internet connection, or with a floating license. For details on Licensing the editing application, see the *Installation Guide for Avid Editing Applications*. 
You can also checkout a floating license if you want to work on your system while not being connected to the Internet. This might be useful if you are working on a laptop and then want to take the laptop home to finish working on your project. For details on checking out a floating license, search for “Checking Out a Floating License” in the *Installation Guide for Avid Editing Applications*.

## Working with Projects

When you start the editing application, the system displays the project log in window. Amongst other settings, you can determine the location of the project. Media Composer allows you work with projects in a private location or one that can be shared with other users.

The best choices for a shared structure are either Shared or External. These types of projects are created in a common location, making it easier for the Administrator to locate and delete old projects.

If you work in an Interplay environment, you can also share a synced project. For more information, see “Interplay Synced Projects” on page 1273.

*If you will be working in a shared project environment, you should carefully consider the location of your projects and media. This will make for a much more efficient working environment in terms of time and disk storage space.*

If you are working with projects created on local drives, then note the following:

- A local project resides on the C: drive of the Avid editing system.
- If the connection between the Avid editing system and shared storage is lost, the project and its contents are unlikely to become corrupt as a by-product.
- You cannot login to the project from another workstation. The exception is if you are in an Interplay environment. In this case, you (or other users) must go to the Interplay Projects folder to locate the contents created in this project.
- From an administration standpoint, you must clean these projects up or archive them from each editing system. At a large site this can become time consuming and needs to become part of the Administrator’s workflow.

For information on the files and folders that your Avid editing application creates as part of a project, see “Avid Projects and Avid Users Folders” on page 72.

You should also back up your project information regularly to a separate storage device, as described in “Backing Up Your Project Information” on page 81.
Private

A Private Project is stored locally. It can be accessed only by the user currently logged on to the editing machine. On a Windows system, a Private Project is always stored under the user’s Documents directory. An administrator may be able to access this project if they have read/write permission to the user’s directory.

Shared

A Shared Project is stored locally. It can be accessed by any user that can log on the editing machine. On a Windows system, a Shared Project is always stored in the machine’s Shared Documents directory.

External

An External Project can be saved to any directory, either local or remote. Depending on the file-system permissions set on the selected folder, other users or an administrator may or may not be able to access the project. The external option is particularly useful when you want to save the project on shared network drive to make project maintenance easier. Select the folder icon and choose the location to store the project.

Avid does not support sharing bins in an Interplay environment. If you create projects on shared storage, do not allow editors to work in the same bin at the same time. This can result in data loss or media corruption. Instead of sharing bins, editors should use the Interplay Window to collaborate and share material.
Synced

A Synced Project is stored locally and in your Interplay database. It can be accessed by any user who has permissions for the project. On a Windows system, a Synced Project is always stored in the machine’s Shared Documents directory and in a corresponding project folder on Interplay.

Setting Project-Naming Conventions

The system limits bins and project names to 64 characters, not including the period and 3-character extension that the system automatically adds to a file name. If you plan to move bins and projects from one platform to another, do not use the characters / \ : * ? “ < > | or leading spaces, trailing spaces, or trailing periods, when you name a project, bin, and user.
(Macintosh only) If you use your Avid editing application as a standalone editor (and don’t plan to move your bins or projects to another platform), you can extend bin and project names to 31 characters. You can also choose to accept or not accept the Windows compatible file naming convention of special characters and spacing.

**To use Windows compatible file names**

1. Click the Settings tab in the Project window.
   
   The Settings list appears.

2. Double-click General Settings.

3. Select Use Windows compatible file names.

   This prevents your Avid editing application from accepting the restricted characters in a bin, project, or user name.

**To extend project and bin names to 31 characters (Macintosh only)**

1. Click the Settings tab in the Project window.

   The Settings list appears.

2. Double-click General Settings.

3. Select Allow files names to extend 27 characters.

   This extends the names of projects and bins to 31 characters.

**Avid Projects and Avid Users Folders**

When you create a new project or user profile, your Avid editing application creates files and folders in the Avid Projects and the Avid Users folders.

**Locations of Avid Project Folders**

By default, the system installs two Avid Projects folders:

<table>
<thead>
<tr>
<th>Private</th>
<th>Shared</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows drive:\Documents and Settings\Windows login name\Documents\Avid Projects</td>
<td>drive:\Documents and Settings\All Users\Shared Documents\Shared Avid Projects</td>
</tr>
<tr>
<td>Macintosh Macintosh HD/Users/Mac login name/Documents/Avid Projects</td>
<td>Macintosh HD/Users/Shared/Shared Avid editing application/Shared Avid Projects</td>
</tr>
</tbody>
</table>

**Locations of Avid Users Folders**

The Avid Users folder is located in the application folder:
The location of the Avid Users folder depends on the installation path for your Avid editing application.

Files and Folders Created For Projects

When you create a new project, your Avid editing application creates a folder with the name that you entered when you created the project. The following three files are stored within the project folder:

- A project file (.avp)
- A project settings file (.xml)
- A bin file (.avb)

The project folder and the three files all use the project name you provide. The project folder is stored in the Avid Projects folder.

Your project settings are initially set to the default values. As you create additional bins for the project (see “Creating a New Bin” on page 89), additional bin (.avb) files are added to the project folder.

Files and Folders Created For User Profiles

When you create a new user profile, your Avid editing application creates a folder for the user and two files that are stored within the user folder:

- A user profile file (.ave)
- A user settings file (.xml)

The user folder and the two files all use the user profile name you provide. The new folder is stored in the Avid Users folder.

Select Project Dialog Box

The Select Project dialog box lets you find and open a project, create a new project, or establish user profiles.
<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 User</td>
<td>Displays the login name of the user currently logged into the system. To change to a different user, log out and log in as that user.</td>
</tr>
<tr>
<td>2 User Profile</td>
<td>Displays the name associated with the current settings. By default your Avid editing application uses the login name. The list button changes profiles or creates a new one. For more information, see “Understanding User Profiles” on page 104.</td>
</tr>
</tbody>
</table>
| 3 Folder buttons | The button you select will set the location where you can browse or create projects.   
Private: Local folder for the user currently logged in. 
Shared: Local folder that is visible to all users that have accounts on this system. 
External: Local or remote folder that any other users may have access to depending on the file permissions set on this folder. 
Synced: (Interplay only) Local and Interplay folder that other users may have access to depending on permissions.  
For more information, see “Working with Projects” on page 69. |
| 4 Browse button | Lets you navigate to a different folder. The projects in this folder appear in the project list. See “Opening and Closing Projects” on page 76. |

You cannot type into the User or Folder text boxes.

| 5 Project list | Displays a list of the Avid projects in the currently selected folder. Double-click a project to open it. |
| 6 Folder       | Displays the path of the current folder. This path determines which projects appear in the project list and where a new project is created. |
**Project Types**

The following table lists the format options available for your project. Depending on the model of your Avid editing application, your format options might not include all items listed here. For Higher than HD Projects, see “Media and Sequence Formats” on page 114.

<table>
<thead>
<tr>
<th>Project Type</th>
<th>Source Footage Transfer</th>
<th>Color Space</th>
</tr>
</thead>
<tbody>
<tr>
<td>23.976p NTSC</td>
<td>For film-originated or video-originated footage that has been shot at 23.976 fps or film-originated footage transferred on digital videotape (such as Digital Betacam™)</td>
<td>YCbCr</td>
</tr>
<tr>
<td>24p NTSC</td>
<td>For film-originated or other 24-fps footage transferred to NTSC videotape</td>
<td>YCbCr</td>
</tr>
<tr>
<td>24p PAL</td>
<td>For film-originated or other 24-fps footage transferred to PAL videotape at 25 fps</td>
<td>YCbCr</td>
</tr>
<tr>
<td>25i PAL</td>
<td>For PAL video-originated footage (25 fps)</td>
<td>YCbCr</td>
</tr>
<tr>
<td>25p PAL</td>
<td>For 25-fps film footage transferred to PAL videotape</td>
<td>YCbCr</td>
</tr>
<tr>
<td>30i NTSC</td>
<td>For NTSC video-originated or other 30-fps footage transferred to NTSC videotape</td>
<td>YCbCr</td>
</tr>
<tr>
<td>720p/23.976</td>
<td>For film-originated material transferred to videotape.</td>
<td>YCbCr</td>
</tr>
<tr>
<td>720p/25</td>
<td>For video-originated material that can be captured, edited and output for HD broadcast. It can also be captured in DVCProHD format.</td>
<td>YCbCr</td>
</tr>
<tr>
<td>720p/29.97</td>
<td>For video-originated material. Can be directly captured, edited, and output for HD broadcast.</td>
<td>YCbCr</td>
</tr>
<tr>
<td>720p/50</td>
<td>For HDV broadcast (European broadcast).</td>
<td>YCbCr</td>
</tr>
<tr>
<td>720p/59.94</td>
<td>For video-originated material. Can be directly captured, edited, and output for HD broadcast.</td>
<td>YCbCr</td>
</tr>
<tr>
<td>1080p/23.976</td>
<td>For film footage transferred to videotape, or high-resolution files from digital film cameras.</td>
<td>YCbCr</td>
</tr>
<tr>
<td>1080p/24</td>
<td>For film footage transferred to videotape, or high-resolution files from digital film cameras. True 24-fps editing.</td>
<td>YCbCr</td>
</tr>
</tbody>
</table>

75
Opening and Closing Projects

You can open a project from the Select Project dialog box, and navigate from the Select Project dialog box to find any project on your system.

If you have already created a project, when you enter your Avid editing application you can bypass the Select Project dialog box and have your last project open automatically.

If you choose to install the sample startup project and media when you install your Avid editing application, you can open this project from the Select Project dialog box. The startup project, called Avid Boston Project DV25, contains a complete sequence with rendered effects and titles, as well as all the video and audio clips used in the sequence.

Use the startup project to learn how to edit with your Avid editing application, before you capture any media of your own. You can explore the sequence in the Timeline to learn how it is assembled, and use the clips to practice viewing and editing techniques described in this guide.

If a sequence that was created in an older version of an Avid editing application contains effects or color corrections, you might need to update the sequence. If a sequence requires updating, the Update Sequence dialog box might open when you load the sequence. For more information, see “Updating and Reverting Existing Effects in Sequences” in the Help.

<table>
<thead>
<tr>
<th>Project Type</th>
<th>Source Footage Transfer (Continued)</th>
<th>Color Space</th>
</tr>
</thead>
<tbody>
<tr>
<td>1080p/25</td>
<td>For film footage transferred to videotape, or high-resolution files from digital film cameras.</td>
<td>YCbCr RGB</td>
</tr>
<tr>
<td>1080p/29.97</td>
<td>For film footage transferred to videotape, or high-resolution files from digital film cameras.</td>
<td>YCbCr RGB</td>
</tr>
<tr>
<td>1080i/50</td>
<td>For video-originated material, or high-resolution files from digital film cameras. Can be directly captured, edited, and output for HD broadcast.</td>
<td>YCbCr RGB</td>
</tr>
<tr>
<td>1080i/59.94</td>
<td>For video-originated material, or high-resolution files from digital film cameras. Can be directly captured, edited, and output for HD broadcast.</td>
<td>YCbCr RGB</td>
</tr>
</tbody>
</table>

Some older versions of Avid editing applications provided HD project types based on HDV requirements. In current versions of Avid editing applications, these are replaced by standard HD projects that let you specify the raster dimensions for editing and playback.

Set film preferences in the Film and 24P Settings dialog box immediately after you create a project to provide your Avid editing application with important information about the type of film and audio transfer you used for your project.
To open an existing project:

1. In the Select Project dialog box, select the folder in which the project is located: Private, Shared, or External.

   For more information, see “Select Project Dialog Box” on page 73.

2. Do one of the following:
   - Select a project in the Select Project dialog box, and then click OK.
   - Double-click a project name in the Projects list.

   The Project window, the Composer window, and the Timeline open with the User settings loaded. The title bar of the Project window contains the project name and the user profile selected in the Select Project dialog box.

To browse for a project in a location other than the default Shared and Private folders:

1. Start your Avid editing application.

   The Select Project dialog box opens.

2. Click the Browse button.

   The Browse for Folder (Windows) or Project Directory (Macintosh) dialog box opens.

3. Navigate to the folder that contains the project you want.

4. Click OK (Windows) or Choose (Macintosh).

5. Select a project in the Projects list.

6. Click OK.

   The Project window, the Composer window, and the Timeline open with the User settings loaded. The title bar of the Project window contains the project name and the user profile selected in the Select Project dialog box.

   The next time you open the Select Project dialog box, the path you selected will be displayed when you click the External button.

To open a project automatically:

1. Click the Settings tab in the Project window.

   The Settings list appears.

2. Double-click any Interface setting.

   The Interface Settings dialog box opens.

3. Click the General tab, select “Automatically Launch Last Project at Startup,” and then click OK.

   The next time you start your Avid editing application, it opens your last project.
To turn off the automatic opening of projects so that you can select another project when
you start your Avid editing application:

1. Deselect “Automatically Launch Last Project at Startup,” and then click OK.
2. Quit your Avid editing application and restart it.

   The Select Project dialog box opens.
3. Select a project and click OK.

   The Project window, the Composer window, and the Timeline open with the User settings
   loaded.

To open the startup project:

1. In the Select Project dialog box, click the Shared folder button.
2. Double-click Avid Boston Project DV25 in the Project list.

   The Avid Boston Project DV25 project opens.

   The footage in the Avid Boston Project DV25 project is shot in 16:9 aspect ratio. To view the
   footage correctly in monitors, click the Format tab in the Project Window and set aspect ratio to
   16:9.

3. In the Format tab of the Project window, ensure that Aspect Ratio is set to 16:9.

   The footage in the Avid Boston Project DV25 project is shot in 16:9 aspect ratio.
4. Use the Bins tab in the Project window to open one or both of the bins in the project:
   - Boston Seq DV25 contains a complete sequence
   - Boston Project source contains all the video and audio clips in the project

   For more information on opening bins, see “Opening and Closing Bins” on page 90.

To close the current project, do one of the following:

- With the Project window active, select File > Close Project.
- Click the Close button in the Project window.

Deleting a Project

To delete a project:

1. Start your Avid editing application.

   The Select Project dialog box opens.
2. Click the project you want to delete.
3. Press the Delete key.
4. If you see a message asking if you want to delete the selected project and associated bins, click OK.

   The deleted project no longer appears in the Select Project dialog box.

Deleting a project also deletes any bins that are in that project.

Media related to a deleted project is not deleted with the project folder. For more information on deleting media files, see “Deleting Items from a Bin” on page 354 and “Deleting Media Files with the Media Tool” on page 475.

**Quitting and Turning Off Equipment**

**To quit your Avid editing application and leave it immediately:**

- (Macintosh) Select **Avid editing application > Quit Avid editing application.**
- (Windows) Select File > Exit.

   The project closes and your Avid editing application quits.

**To quit your Avid editing application and view the Select Project dialog box:**

1. Click the Close button at the far right (Windows) or at the far left (Macintosh) of the Project window’s title bar.

   The Select Project dialog box opens.

2. Click Quit.

   A message box opens.

3. Do one of the following:

   - Click Leave to quit your Avid editing application.
   - Click Cancel to return to the Select Project dialog box and select another project.

**To view remaining storage on your media drives:**

1. Click the Info tab in the Project window, and then click Hardware.

   The Hardware tool opens.

2. Click the appropriate drive tab.

   For more information, see “Using the Hardware Tool” on page 135.

**Quit your Avid editing application before you turn off your equipment.**
To turn off your equipment:

1. Turn off the system by doing the following:
   
   For a Windows system:
   
   a. Click the Start button, and select Shut Down.
   The Shut Down Windows dialog box opens.
   
   b. Click the menu, and select Shut down.
   
   c. Click OK.
   
   For a Macintosh system:
   
   ▶ Select Apple menu > Shut Down.

2. If you have an Avid input/output device attached to your system, turn it off.

3. Turn off peripheral devices (such as monitors and speakers).

4. Turn off external storage devices.

Never remove media drives from your Avid system when it is turned on. Shut down the computer, and then remove the drives.

5. Turn off all other hardware.

Changing Project and User Names

You cannot change project or user names from within your Avid editing application. You must change the names from your desktop before you start your Avid editing application. For information about the location of the Avid Projects and Avid Users folders, see “Avid Projects and Avid Users Folders” on page 72.

When you change a user name or a project name, make sure you change the name of the folder and all the files in the folder that have the old name. Your Avid editing application does not automatically change the names of corresponding files in the folder.

To change a project name or user name:

1. Navigate to the Avid Projects or Avid Users folder, and then double-click the folder to open it.

2. Click the name of the folder you want to change.

   The name highlights.

3. Type the new name of the folder.

4. Double-click the folder with the new name to open it.
Backing Up Your Project Information

The folder contains profile, settings, and project files with the old name.

5. Change the old name of each file to the new name.

Do not change the name of the file MCState in the Avid Users folder.

6. Close the windows, and restart your Avid editing application.

The new project name or user name appears in the Select Project dialog box.

Backing Up Your Project Information

Although your Avid editing application automatically saves your bins, projects, and settings, you should back up these items frequently. Because the storage requirements are minimal, you can back up these files to a variety of storage devices, such as:

- USB (thumb) drive
- CD-ROM or DVD-ROM
- Network storage device (such as a file server)
- Mass-storage device

To back up the larger media files created when you capture footage, use a high-capacity storage device. For information on backing up media files, see “Backing Up Media Files” on page 493.

To save your work on a drive or on removable media:

1. Mount the drive or insert the storage media (USB drive, CD-ROM, or DVD-ROM).
2. (Windows only) From the Windows desktop, double-click the My Computer icon.
3. Double-click the icon for the destination storage drive or storage media to open it.
   Double-click any additional folders to target the appropriate storage location.
4. Navigate to the folder that contains the project folder or the user folder you want to save.
5. Drag a project folder or a user folder to the targeted storage location.
6. When the system finishes copying the files, unmount the drive or eject the media and store it.

To restore a project or user information from a backup storage device:

1. Mount the drive or insert the removable media that contains the backup copies you want to restore.
2. From the desktop, double-click the icons for the drive or storage media and for the internal hard drive (Windows) or for the Macintosh HD (Macintosh).
3. Drag the copies from the storage device to the appropriate folder on the internal hard drive (Windows) or Macintosh HD/Users/Shared (Macintosh).
When you start your Avid editing application, the restored project and user profile appear in the Select Project dialog box.

If you restore a single bin or bins, you must relink them to the project from within the Project window. For more information, see “Opening and Closing Bins” on page 90.

**Avid Attic Folder**

The Avid Attic folder contains backup files of each bin in a project. You retrieve files from the Avid Attic folder in the following circumstances:

- When you want to replace current changes to a sequence or clip with a previous version
- When the current bin file becomes corrupted

For information on retrieving files from the Avid Attic folder, see “Retrieving Files from the Avid Attic Folder (Windows)” on page 82 and “Retrieving Files from the Avid Attic Folder (Macintosh)” on page 85.

For information on setting automatic save features, see “Saving Bins” on page 93.

(Macintosh only) If you deselected the “Allow filenames to exceed 27 characters” option in the General Settings dialog box, you cannot retrieve a backup file with a file name larger than the 27-character limit. You must rename the file before you retrieve it.

The Avid Attic folder contains a folder for each project. Each project folder contains a Bins folder. When a bin is saved, a folder with the bin’s name is created in the Bins folder and a copy of the bin file is stored in the folder with the bin name. The system adds the file name extension .bak plus a version number to the bin’s file name. The bin file with the highest version number represents the latest copy of the bin file.

When you view a bin folder in Details view (Windows) or List view (Macintosh), you can also identify the most recent backup file based on the timestamp of creation displayed in the Modified column (Windows) or Date Modified column (Macintosh).

The oldest backup file is overwritten only if the second-oldest backup file is more than 2 hours old.

**Retrieving Files from the Avid Attic Folder (Windows)**

To retrieve a file from the Avid Attic folder:

1. Minimize your Avid editing application.
2. From the desktop, double-click the Avid Attic folder, located in:
Avid Attic Folder

(Windows XP) drive:\Documents and Settings\All Users\Shared Documents\Avid editing application.

(Windows Vista or Windows 7) drive:/Users/Public/Public Documents/Avid editing application.

The Avid Attic folder opens and displays a folder for each project.

3. Double-click a project folder, and then double-click the Bins folder.

   The Bins folder opens and displays a folder for each bin in the project.

4. Double-click the folder for the bin you want to retrieve.

5. If the bin folder is not already in the Details view, select View > Details.

   The bin folder displays the backup bin files and their creation dates. A backup bin file has the same name as the bin, with a number appended. For example, a bin named Source Clips might have backup bin files named Source Clips.1 and Source Clips.2.

6. Select the backup bin file or files you want to retrieve.

7. Ctrl+drag the selected backup bin files to the desktop.

   This makes a copy of the files, leaving the original files in the Avid Attic folder.
To copy backup files to a new bin:

1. Click the taskbar item for your Avid editing application to restore it.

If the taskbar is hidden, see “Using the Windows Taskbar (Windows Only)” on page 60.

2. Click the Project window to activate it, and click the Bins tab to display the Bins list.
3. Select File > Open Bin.
4. From the Files of Type list, select All Files (*.*)
5. Navigate to the desktop, select one of the backup bin files you copied, and click Open.

The backup bin opens. When you open a backup bin, a link to the backup bin on the desktop is created in the Other Bins folder.

Your Avid editing application does not allow a bin and a copy of a bin to be open at the same time. You must keep all other bins closed and open the backup bins one at a time.

6. Create a new bin.

For example, if you are retrieving clips from a backup bin called Audio.2, you can call the new bin Audio New.
7. Select the material you want to keep from the backup bin, and drag the files to the new bin.
8. Repeat steps 3 through 7 for any other backup bin files you copied to the desktop.
9. Select and delete the backup bins in the Other Bins folder.
10. Drag the backup bin files on the desktop to the Recycle Bin.

Retrieving Files from the Avid Attic Folder (Macintosh)

To retrieve a file from the Avid Attic folder:

1. Minimize your Avid editing application.
2. From the desktop, double-click the Macintosh HD/Users/Shared/Avid editing application/Avid Attic folder.
   The Avid Attic folder opens and displays a folder for each project.
3. Double-click a project folder, and then double-click the Bins folder.
   The Bins folder opens and displays a folder for each bin in the project.
4. Double-click the folder for the bin you want to retrieve.
5. Select View > as List, if the bin folder is not already in the List view.
   
   The bin folder displays the backup bin files and their creation dates. A backup bin file has the same name as the bin, with a number appended. For example, a bin named Source Clips might have backup bin files named Source Clips.1 and Source Clips.2.

6. Command+click the files you want to retrieve.

7. Option+drag the selected backup bin files to the desktop.
   
   This makes a copy of the files, leaving the original files in the Avid Attic folder.

To copy backup files to a new bin:

1. Click the icon for your Avid editing application on the Dock to activate your Avid editing application.

2. Click the Project window to activate it, and click Bins to display the Bins list.

3. Select File > Open Bin.

4. Navigate to the desktop, select one of the backup bin files you copied, and click Open.
   
   The backup bin opens. When you open a backup bin, a link to the backup bin on the desktop is created in the Other Bins folder.

Your Avid editing application does not allow a bin and copy of a bin to be open at the same time. You must keep all other bins closed and open the backup bins one at a time.

5. Create a new bin.
   
   For example, if you are retrieving clips from a backup bin called Source Clips.2, you can call the new bin Source Clips New.

6. Open the new bin and open the backup bin in the Other Bins folder.

7. Select the material you want to keep from the backup bin, and drag the files to the new bin.

8. Repeat steps 3 through 7 for any other backup bin files you copied to the desktop.

9. Select and delete the backup bins in the Other Bins folder.

10. Drag the backup bin files on the desktop to the Trash.
Working with the Project Window

The Project window provides controls for structuring and viewing important information about your current project. You can also modify User, Project, and Site settings from the Project window and display a list of effects.

The following topics describe features of the Project window:

- Overview of the Project Window
- Using the Bins Tab
- Using the Settings Tab
- Using the Format Tab
- Using the Usage Tab
- Using the Info Tab
- Managing Bins and Memory
- Understanding User Profiles
- Managing User Profiles
- Customizing the Avid User Interface
- Using Workspaces
- Working with Bins and Projects in an Avid Shared Storage Environment
- Working with Export Volumes

Overview of the Project Window

The Project window is a central location for important information and tools that you need as you work on your project.
Project window information is organized in tabs.

<table>
<thead>
<tr>
<th>Tab</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bins</td>
<td>Lets you create and open bins. See “Using the Bins Tab” on page 88.</td>
</tr>
<tr>
<td>Settings</td>
<td>Lets you view and modify settings. See “Using the Settings Tab” on page 96.</td>
</tr>
<tr>
<td>Effects</td>
<td>Lets you access a library of effects. See “Applying Effects” in the Help.</td>
</tr>
<tr>
<td>Format</td>
<td>Lets you view information about the format of the project. See “Using the Format Tab” on page 97.</td>
</tr>
<tr>
<td>Usage</td>
<td>Lets you view information about the work session usage.</td>
</tr>
<tr>
<td>Info</td>
<td>Lets you view information about system memory usage and system hardware configuration.</td>
</tr>
</tbody>
</table>

**Using the Bins Tab**

When you create a project, your Avid editing application automatically creates a bin with the name of the new project, which displays in the Bins tab. You can rename this bin and create additional bins as you work in your project.

The word *bin* is a movie industry term that refers to a container that holds pieces of film. In your Avid editing application, bins contain master clips that are created when you capture source material. Bins also contain the sequences, subclips, group clips, and effect clips that you create.
during a project. From the Project window, you can view a list of bins associated with the project, and open, close, and create bins. You can also open bins that you create for other projects.

**Viewing a List of Bins**

You can view a list of bins in the Project window. The Bins list displays the number, names, sizes, and location of the bins. Bins from other projects appear in the Project window in italic.

**To view a list of bins associated with the project:**

- Click the Bins tab in the Project window.

![Image](image.png)

Fast menu button (top) and Bins list with bin icons (bottom) in the Bins tab of the Project window.

**Creating a New Bin**

**To create a new bin from the Project window:**

1. Do one of the following:
   - Select File > New Bin.
   - Click the New Bin button in the Project window.

   A new (empty) bin opens and is given the name of the project as displayed in the title bar of the Project window. The new bin appears in the Bins list in the Project window with a default name highlighted and a number appended to it.

2. In the Project window, click the new bin name and type in a new name.

3. Press Enter (Windows) or Return (Macintosh).

   A corresponding bin file is placed in the Avid Projects folder, and a backup copy is placed in the Avid Attic folder. For more information, see “Avid Projects and Avid Users Folders” on page 72 and “Avid Attic Folder” on page 82.
To place a bin in a folder:
- Drag the bin to the folder icon.

Renaming a Bin

Each new bin that you create takes the name of the project that appears in the title bar of the Project window and is numbered incrementally.

- *If you plan to move bins and projects from one platform to another, do not use the characters / \ : * ? “ < > / or leading spaces, trailing spaces, or trailing periods, when you name a project, bin, and user. Bin and project names are limited to 27 characters, not including the period and 3-character extension that the system automatically adds to a file name.*

(Macintosh only) You can set the Use Windows compatible File Names option in your Avid editing application’s General Settings dialog box to prevent your Avid editing application from accepting these restricted characters in a bin, project, or user name. If you use your Avid editing application as a standalone editing application (and don’t plan to move your bins or projects to another platform), you have the option to extend bin and project names to 31 characters.

To change the name of a bin:
1. Click the bin name in the Bins list.
2. Type a new name.

Opening and Closing Bins

You can open a single bin or open multiple bins at once. You can also open a bin from another project.

- Never open a bin that is stored on a removable disk or equivalent device; otherwise, your Avid editing application cannot save your work. Always copy the bin to a project folder on the system drive before you open it.

To open a bin directly:
1. Click the Bins tab.
2. Double-click the Bin icon next to the bin name.

   The bin opens in a separate window. The Bin icon appears dimmed in the Bins list, indicating the bin is open.

- You can also open a bin by dragging it from the Bins tab in the Project window to an open bin. The bin opens as a tab in the existing bin.
To open several bins at once from the Project window:

1. Click a Bin icon in the Bins list.
2. Ctrl+click (Windows) or Command+click (Macintosh) each additional bin you want to open.
3. Do one of the following:
   - To open each bin in a separate window, select File > Open Selected Bins.
   - To open all bins as tabs in a single bin, select File > Open Selected Bins In One Window.

The selected bins open either in separate windows or in a single window with tabs indicating the bins.

You can also open multiple bins by dragging them from the Bins tab in the Project window to an open bin. The bins open as tabs in the existing bin.

To open a bin from another project:

1. Select File > Open Bin.
   
The Open a Bin dialog box opens.
2. Find and select the bin you want.
   
   Bins have the file name extension .avb.
3. Click Open.
   
The bin appears in the Bins list in a folder called Other Bins. The name Other Bins appears in italic. You can rename this folder. This option is useful when you want to open a bin not currently displayed in the Project window.

The Other Bins folder disappears from the Bins list when you delete all the bins in the Other Bins folder. Deleting bins from the Other Bins folder does not remove the bins from your system; only the pointers to the bins are removed.

To close a bin, do one of the following:

- Click the Close button.
- Select File > Close Bin.

Displaying Folders of Bins in the Bins List

You can add folders to the Bins list to help organize your project. You can drag bins into folders or drag folders into folders.
To create a folder in a project:
1. Click the Fast menu button, and select New Folder.
   A new untitled folder appears.
2. Click the untitled folder name in the Bins list and rename it.

To show or hide the folder's contents in the Bins list in the Project window:
- Click the arrow next to a folder icon.

To view a list of only the folder contents and not the folders:
- Click the Fast Menu button, and select Flat View.
  The Trash icon and its contents disappear until Flat View is deselected.

Creating a Folder

To create a folder in a project:
1. Click the Bins tab in the Project window.
2. Click the Fast Menu button, and select New Folder.
   A new untitled folder appears.
3. Click the untitled folder name in the Bins list and rename it.

Deleting a Bin or Folder

You can delete bins and folders along with their contents from the Bins list. Deleted bins and folders are moved to a Trash folder in the Bins list until you empty the Trash. If you need a deleted bin or folder, you can retrieve it from the Trash. For more information, see “Viewing and Emptying the Trash” on page 93.

Only bins and folders appear in the Trash. If you select a clip, subclip, or effect directly in a bin and press the Delete key, the item is permanently deleted and does not appear in the Trash.

To delete a bin or folder from the Project window, do the following:
- Select the bin or the folder you want to delete in the Bins list, and press the Delete key.
  A Trash icon appears in the Bins list in the Project window. The Trash contains the deleted item.

The Trash is not visible in the Project window until you delete your first item.
Viewing and Emptying the Trash

If you need to view the contents in the Trash or decide you do not want to delete those items, you must first move the bins and folders from the Trash.

Emptying the trash permanently removes the bins or folders from the drive.

If you change the name of the Trash icon, you cannot empty the Trash.

To view items in the Trash:

1. Click the arrow next to the Trash icon in the Bins list.
2. Click the bins or folders you want to keep (or view), and drag them from the Trash to the Bins list in the Project window.
3. Double-click the bin or folder to view it.

To empty the Trash in the Bins list:

1. Click the Fast Menu button, and select Empty Trash.

   A message box opens.

2. Click Empty Trash to delete the bins or folders from the Trash and from your hard drive.

Saving Bins

Your Avid editing application automatically saves changes to your work on a regular basis. You can modify the frequency of the automatic backups.

You can also manually save a specific bin, selected bins, or all bins. You might want to do this immediately after performing an important edit.

When you work with bins, an asterisk appears before the bin name in the bin’s title bar. The asterisk indicates that the changes to the bin have not been saved. After you save the bin, your Avid editing application removes the asterisk.

When an autosave occurs, any open bins update with changes made since the last autosave, and copies of these bins are placed in the project’s backup bin folder:

<table>
<thead>
<tr>
<th>Platform</th>
<th>Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 7</td>
<td>drive:\Users\Public\Public Documents\Avid editing application\Avid Attic folder</td>
</tr>
<tr>
<td>Macintosh</td>
<td>/Users/Shared/Avid editing application/Avid Attic folder</td>
</tr>
</tbody>
</table>
Your Avid editing application automatically saves copies of all bins into the Avid Attic folder at regular intervals for backup. When your work is lost, or when you want to recover an earlier version of a bin or sequence, you can retrieve files from the Avid Attic folder.

To adjust the frequency of automatic saves:
1. In the Project window, click the Settings tab, and then double-click Bin.
   The Bin Settings dialog box opens.
2. Type a number in the Auto-Save interval text box.
3. Click OK.

Setting to zero the maximum number of files stored in the Avid Attic folder as well as the maximum number of versions of a bin deletes existing files in the project folder in the Avid Attic folder and prevents any backup bins from being saved. For more information about backup options, see “Bin Settings” on page 1444.

Saving Bins Manually

To save a specific bin:
1. Click the bin to activate it.
2. Select File > Save Bin.

To save selected bins:
1. In the Bins tab, click a Bin icon to select it, and then Ctrl+click any additional bins.
2. Select File > Save All.
   The system saves all the selected bins.

The Save Bin command appears dimmed if there were no changes since the last time the active bin was saved.

To save all the bins:
1. Click the Bins tab in the Project window.
2. Select File > Save All.
   The system saves all the bins for the project.

Filtering Bins in the Project Window

The Project window includes a quick filter text box. This allows you to quickly filter out bins in the Project window leaving only those bins in a flattened view that match the filter criteria.
To filter bins in the Project Window:

1. Open the Project Window and click the Bins tab.
2. Enter text in the filter text box.
The search will display only those bins that match the search criteria.

**Using the Settings Tab**

From the Settings tab in the Project window, you can view, select, open, and alter various User, Project, and Site settings. Each setting either displays information about that specific tool or window or lets you select options or preferences associated with that tool or window. For more information, see “Viewing and Modifying Settings” on page 1421.

**To view the Settings list:**

- Click the Settings tab in the Project window.

![Settings Tab Screenshot](image)

**To open a setting:**

- Double-click the setting in the Settings list.

**To view Help for a setting:**

- Open a setting and press the F1 key (Windows) or the Help key (Macintosh).
Using the Format Tab

The Format tab in the Project window lets you view basic project information, such as the video format (NTSC, for example). The information lists the options you selected in the New Project dialog box when you created the project.

For some project formats, the Project Type list lets you change the format of the project to another format that shares the same frame rate. For example, if you are working in a 1080i/59.94 HD project, you can change the project format to 30i NTSC.

If you switch from one project type, aspect ratio, color space, or raster dimension to another during the course of your workflow, you might create precomputed clips that have not rendered with the quality that you need for your final output. You might need to manually purge the precomputed clips and re-render effects. For more information, see “Ensuring the Quality Level of Precomputed Clips” in the Help.

For 24p PAL projects, the Format tab shows the audio transfer rate you selected when you created the project. The actual audio transfer rate might be different from the display if you used the Film and 24P Settings dialog box to change the audio transfer rate.

To open the Format tab:

- Click the Format tab.
Using the Usage Tab

The Statistics feature gathers and reports information on system usage. You can use this information to support business functions such as resource management.

All statistics are gathered and reported by project. The file that contains this information is formatted so you can use it as input to software programs such as analysis applications, spreadsheets, or report generators.

⚠️ Do not rely on the Statistics feature for billing or other financial purposes.

To view and update statistics for an open project:

» Click the Usage tab in the Project window.

To print the Statistics file:

» Select File > Print Usage.

Statistics File Structure and Layout

A new Statistics file is created each time you open the project. The files are stored in a Statistics folder inside each project folder.

The file name has the following format:

Statistics.yymmdd.HHMMSS

where:

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>yy</td>
<td>Indicates the last two digits of the year</td>
</tr>
<tr>
<td>mm</td>
<td>Indicates the month</td>
</tr>
<tr>
<td>dd</td>
<td>Indicates the day</td>
</tr>
<tr>
<td>HH</td>
<td>Indicates the hour</td>
</tr>
<tr>
<td>MM</td>
<td>Indicates the minutes</td>
</tr>
<tr>
<td>SS</td>
<td>Indicates the seconds</td>
</tr>
</tbody>
</table>
The statistics file is formatted as comma-separated ASCII text, so it can be accepted by a variety of software programs. Each line in the file is tagged with indicators for identifying content and data type to assist in programming custom applications. The following illustration shows a sample Statistics file.

| 01,01, | Project Name: Flower Show,,,Statistics as of: Aug 24 11:30:58 2002 |
| 02,01, | Project created: Tue Aug 19 13:50:00 2002,,,Last Session Started: Aug 24 11:13:04 |
| 117,04, | |
| 03,04, | Elapsed Time:,---,Total:,---,---,Last Session,--- |
| 03,04, | Hours,Minutes,Seconds,Hours,Minutes,Seconds |
| 101,02, | Time Project Open ,124,10,43,0,25,54 |
| 03,04, | |
| 102,02, | Capture Tool open ,0,00,00,0,00,00 |
| 104,02, | Capture Tool active ,0,00,00,0,00,00 |
| 116,02, | Capture Tool logging ,2,43,18,0,21,47 |
| 115,02, | Capture Tool capturing ,0,02,42,0,01,11 |
| 03,04, | |
| 111,02, | Title Tool open ,2,35,30,0,03,41 |
| 113,02, | Title Tool active ,2,54,18,0,05,47 |
| 114,02, | Title Tool rendering ,0,00,00,0,00,00 |
| 03,04, | |
| 110,02, | Effects rendering ,0,22,08,0,03,16 |
| 03,04, | |
| 03,04, | Disk Space Used:,K Files,m Bytes Used |
| 105,03, | Captured Media ,0,0,0 |
| 106,03, | Rendered Effects ,0,0,0 |
| 03,04, | |
| 03,04, | * Items marked by asterisk may show less than actual usage |

The values in the first column indicate the content of the line:
Using the Usage Tab

The values in the second column indicate the type of data in the line:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>01</td>
<td>title1</td>
</tr>
<tr>
<td>02</td>
<td>title2</td>
</tr>
<tr>
<td>03</td>
<td>Title Only</td>
</tr>
<tr>
<td>100</td>
<td>project info</td>
</tr>
<tr>
<td>101</td>
<td>Time Project open</td>
</tr>
<tr>
<td>102</td>
<td>Capture tool open</td>
</tr>
<tr>
<td>104</td>
<td>Capture tool active</td>
</tr>
<tr>
<td>105</td>
<td>Captured Media bytes used</td>
</tr>
<tr>
<td>106</td>
<td>Rendered Effects bytes used</td>
</tr>
<tr>
<td>110</td>
<td>Effects rendering time</td>
</tr>
<tr>
<td>111</td>
<td>Title tool open</td>
</tr>
<tr>
<td>113</td>
<td>Title tool active</td>
</tr>
<tr>
<td>114</td>
<td>Title tool rendering</td>
</tr>
<tr>
<td>115</td>
<td>Capture tool capturing</td>
</tr>
<tr>
<td>116</td>
<td>Capture tool logging</td>
</tr>
<tr>
<td>117</td>
<td>user comments</td>
</tr>
</tbody>
</table>

The values in the second column indicate the type of data in the line:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>01</td>
<td>project info</td>
</tr>
<tr>
<td>02</td>
<td>time used</td>
</tr>
<tr>
<td>03</td>
<td>bytes used</td>
</tr>
<tr>
<td>04</td>
<td>text string</td>
</tr>
</tbody>
</table>

**Importing the Statistics File into a Spreadsheet**

You can import the Statistics file into a spreadsheet or other program as an ASCII file and use your Avid editing application to set up the proper format.

**To import a Statistics file into Microsoft Excel:**

1. Start Microsoft Excel.
2. Select File > Open, and navigate to the Statistics file you want to import.
   (Windows only) Make sure All Files (*.*) is selected in the Files of Type list.
3. Click Open.
Using the Usage Tab

The Text Import wizard starts.

4. Select Delimited for the Original Data Type, and click Next.
5. Select Comma for Delimiters, and click Next.
7. Click Finish.

The statistics file appears in spreadsheet format.

The following illustration is the sample file from the previous section as it appears when you import it into a spreadsheet.

![Image of sample file]

Displaying Disk Space Statistics

You must use a Console command to calculate and display statistics for disk space in the Usage window.

To display disk space statistics in the Usage window:
1. Select Tools > Console.
2. In the command entry text box, type:

   `toggleStatSpace`
3. Press Enter (Windows) or Return (Macintosh).
4. Select File > Load Media Database.

   After the media database is loaded, the Usage window displays the number of files and disk space used for captured media and rendered effects.

**To update the display:**
- Click the Usage tab in the Project window.

**To prevent recalculation:**
- Reenter the `toggleStatSpace` command.

---

**Using the Info Tab**

The Info display in the Project window lets you view system memory information and access the Hardware tool. The items listed in this display are for information only and cannot be changed. The Hardware tool gives a visual representation of usage for each drive and provides operating system information.

**To open the Info display:**
- In the Project window, click the Info tab.

**To display system memory information:**
- In the Project window, click the Info tab, and then click the Memory button.

   The Memory window opens with the following information:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Objects</td>
<td>The total number of memory handles currently used by your Avid editing application. Objects include memory requirements of your Avid editing application, such as windows, clips, sequences, and other items associated with a project.</td>
</tr>
</tbody>
</table>

> You can improve the performance of large projects when you reduce the number of objects. To do this, close unused bins, unmount unused media drives, consolidate finished elements, eliminate old material from the project, or divide the project into separate projects. Then quit and restart your Avid editing application. If performance is still slow, restart your system.

- Total physical memory (Windows) or Total Mem (Macintosh)
- Available physical memory (Windows) or Free Mem (Macintosh)

The amount of RAM available for allocation by the Windows or Macintosh system.
Managing Bins and Memory

System memory usage increases depending on how many bins you have open, the number of sequences in a bin, the number of tools that are open, and the size of a sequence. Using more memory can slow system performance.

In the Bin tab of the Project window, a memory usage indicator increases and updates as you open and close bins. Avid recommends that you keep memory usage below 80-85%. If you exceed the recommended usage, a dialog box opens informing you that your memory usage is high and recommends that you close some bins and save your project.

If your system is running low on memory and you need to free up memory, you can either close your bins or use the Clear Memory button. If you close your bins, some of your memory remains unavailable until you exit your Avid editing application because the online master clips remain in memory. The Clear Memory button, however, closes and saves all of your open bins and clears out any cached data of the online master clips.

Bins containing sequences use more memory than bins containing master clips. For bins that contain a large number of sequences, you can free up memory and still keep your old sequences. Create an archive bin and move older sequences that you do not use anymore to the archive bin. Keep the archive bin closed.

To free up memory:

1. Click the Info tab of the Project window.
2. Click the Clear Memory button.

To open the Hardware tool, do one of the following:

- In the Project window, click the Info tab, and then click the Hardware button.
- Select Tools > Hardware.

The Hardware tool opens.

For more information about the Hardware tool, see “Using the Hardware Tool” on page 135.

Managing Bins and Memory

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total page file</td>
<td>The total number of bytes stored in the paging file. The paging file is used as virtual memory by the Windows system.</td>
</tr>
<tr>
<td>Available page file</td>
<td>The total number of bytes available in the paging files.</td>
</tr>
<tr>
<td>Working set (minimum and maximum)</td>
<td>The set of memory pages currently available to your Avid editing application in RAM.</td>
</tr>
</tbody>
</table>
A dialog box opens asking if you want to close and save all opened bins.

3. Click OK.

This operation deletes cached data for the online master clips only. Memory might also be used by other parts of your Avid editing application and will not be reduced by using the Clear Memory button.

**Understanding User Profiles**

User profiles let you switch between settings without having to log out of your system and log back in under a different user name.

User profiles let you establish separate settings for different editing functions. User “Jane,” for example, can have separate profiles for “Audio editor,” “Film editor,” or for “Assistant 1,” “Assistant 2,” and so on.

User profile folders are kept in the following folder:

- **Windows XP**
  - `\Documents and Settings\All Users\Shared Documents\Avid editing application\Avid Users\UserName`
- **Windows Vista and Windows 7**
  - `\Users\Public\Public Documents\Avid editing application\Avid Users\UserName`
- **Macintosh**
  - `/Users/Shared/Avid editing application/Avid Users/UserName`

You can do the following with user profiles:

- Create new user profiles
- Switch between user profiles
- Return to the original user profile
- Import settings from another user or user profile
- Create a user profile on one system, export it to a server, and then import the same user profile from another system to the new system.

When you export a user profile, you can select either a Personal or Group profile.

- When you select Personal, the user profile performs an auto-load and an auto-save every time you open a project. Every time the user profile is updated, it saves the new profile information. For example, you can create the user profile Jennie on one system, export it...
Managing User Profiles

- When you select Group, the user profile auto-loads but it does not auto-save. Changes made to the user profile only affect the system where you made the change. The changes do not update to the server.

- When you export User Profiles in an Avid shared storage environment, make sure the workspace containing the user profile has the same drive letter on all systems.

- You can not share user profiles across platforms (Macintosh to Windows or Windows to Macintosh).

- Update a user profile to add user settings to an existing Settings list.

  For example, if you upgrade to a version of your Avid editing application that contains the Send To option from a version that did not have that option, you can choose the Update User Profile option to make sure the Send To settings templates appear in your Settings list.

  For step-by-step procedures, see “Managing User Profiles” on page 105.

Managing User Profiles

To create a user profile:

1. Click the Settings tab in the Project window.

The User Profile Selection menu in the Settings tab of the Project window
2. Click the User Profile Selection menu, and select Create User Profile.
   The Create User Profile dialog box opens.
3. Type a name in the Profile Name text box, and then click OK.
   The new user profile appears selected in the menu, and the user profile name appears in the Project window title bar.

To import user settings from another user or user profile:
1. Click the Settings tab.
2. Click the User Profile Selection menu, and select another user profile.
3. The new user profile name appears in the Project window title bar.

To return to the original user profile:
1. Click the Settings tab.
2. Click the User Profile Selection menu, and select the default user profile.

If you use a user profile other than the default and you change to another project, the default user settings load, even though the Project window displays your non-default user profile name. You must reselect the user profile.

To import user settings from another user or user profile:
1. Click the Settings tab.
2. Click the User Profile Selection menu, and select Import User or User Profile.
3. Navigate to the user or user profile you want to import.

To export user settings to another user or user profile:
1. Click the Settings tab.
2. Click the User Profile Selection menu, and select Export User or User Profile.
3. Select Personal or Group.
4. Navigate to the location where you want to place the user or user profile.
5. Click OK.

To update user profiles:
1. Click the Settings tab.
2. Click the User Profile Selection menu, and select Update User Profiles.
   Any new settings added to the upgraded version of your Avid editing application appear in the Settings list.
To delete a user profile from your desktop:

1. Navigate to the Avid Users folder, and then select the user folder you want to delete.
   
   For information about the location of the Avid folders, see “Avid Projects and Avid Users Folders” on page 72.

2. Do one of the following:
   
   - (Windows) Press the Delete key, then click OK in the dialog box.
   - (Macintosh) Drag the folder to the Trash.

3. Empty the Recycle Bin (Windows) or the Trash (Macintosh) to remove the files from the system.

4. Close the windows, and restart your Avid editing application.
   
   The deleted user no longer appears in the Select Project dialog box.

Customizing the Avid User Interface

The Interface Settings dialog box provides you with controls for customizing the brightness and the colors of the Avid user interface. For complete reference information on the Interface Settings dialog box, see “Interface Settings” on page 1508.

The Interface Settings dialog box allows you to set the highlight color for buttons. You can also control the brightness of the user interface, which includes the following components:

- Application, tool, toolbar, and dialog box backgrounds
- Buttons and button contents
- Project background

The Avid editing application lets you modify the colors of some interface components using controls not included in the Interface Settings dialog box:

- Bin media object color — see “Assigning Colors to Objects in a Bin” on page 357.
- Timeline clip color — see “Displaying Clip Colors in the Timeline” on page 667.
- Timeline track colors — see “Changing the Track Color” on page 671.
- Bin background color — see “Changing the Bin Background Color” on page 356.

Changing Interface Component Colors

You can use a brightness selection slider and selection buttons to change the appearance of some interface components.
When you use the selection slider to modify interface settings, it overwrites any previous user settings. Avid recommends you save a copy of your user settings before you use the selection slider.

To set the brightness and color of interface components:

1. In the Project window, click the Settings tab, and then double-click Interface.

   The Interface dialog box opens.

   ![Interface dialog box](image)

2. Click a highlight color to change button highlight colors.

3. Click the Interface Brightness slider to adjust the brightness of the user interface. The Avid editing application provides several presets on the slider.

4. (Option) If you want to set the color of the video, audio, or timecode tracks to the default, select the appropriate option.
5. (Option) If you want to be able to set custom background colors for bins, select Allow Custom Bin Backgrounds.

For more information, see “Changing the Bin Background Color” on page 356.

6. Do one of the following:
   - Click Apply to apply the changes you selected.
     If you click Cancel after you click Apply, interface components retain the colors you applied.
   - Click OK to close the dialog box and put the new setting into effect.
   - Click Cancel to close the dialog box.
     The changes you select do not take effect.

**Changing Font and Point Size**

You can change the default font and point sizes of the Project, Bin, Composer monitor, Script, and Timeline windows. You can vary the fonts and point sizes across these windows. For example, you can set the Project window to Helvetica, 13 pt.; set one Bin window to Times Roman, 11 pt.; and set another Bin window to Arial, 12 pt.

The table describes the windows you can change, and where these changes are saved.

<table>
<thead>
<tr>
<th>Window</th>
<th>Location of Changes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project</td>
<td>Changes the font and point size of the text in the Project window; saves as a Project setting.</td>
</tr>
<tr>
<td>Bin</td>
<td>Changes the font and point size of the text in the Bin window; saves as a Bin setting (not a Bin View setting).</td>
</tr>
<tr>
<td>Composer monitor</td>
<td>Changes the font and point size of the sequence or source clip name text; saves as a Composer setting.</td>
</tr>
<tr>
<td>Script</td>
<td>Changes the font and point size of the text in the Script window; saves as a Script setting.</td>
</tr>
<tr>
<td>Timeline</td>
<td>Changes the font and point size of clip text; saves as a Timeline View setting.</td>
</tr>
</tbody>
</table>

**To change the font in the Project, Bin, Composer monitor, Script, or Timeline window:**

1. Click the Project, Bin, Composer monitor, Script, or Timeline window to make it active.
2. Select Edit > Set Font.
   The Set Font dialog box opens.
3. Click the Font menu, and select a font.
Any font installed on the Avid system appears in the list. For information on adding fonts to your system, see the documentation for your operating system.

4. Type another point size for the font in the Size text box.
5. Click OK.
   
The new font and point size appear in the active window.
   
When you close the window, the last font and point size applied are saved with the window.

**Image Cache Setting**

Media Composer allows you to establish how much memory can be utilized for caching thumbnails in memory as well as disk. Caching images in memory allows thumbnails to quickly be recalled as you load or scroll in bins or sequences. Saving them to the disk cache allows them to be recalled after relaunching the application and can avoid the need for the application to have to create them again.

**Setting the Media Cache**

To specify the size of the Disk cache and Memory cache perform the following.

**To set the Media Cache:**

1. In the Settings list in the Project window, select Media Cache.
   
The Media Cache dialog box opens.

   ![Media Cache dialog box]

2. If you want to change the default location of the Cache folder, click the Set button and choose the location for the Cache folder.

3. Enter a value for the Disk Cache Size and Memory Cache Size.

4. Click OK.
Using Workspaces

Your Avid editing application provides default layouts of windows and tools designed to utilize the application interface efficiently. These layouts are organized as workspaces, and the default workspaces include the following:

- Audio Editing
- NRCS (NewsCutter Option)
- Color Correction
- Source/Record Editing
- Full Screen Playback
- Effects Editing
- Capture

If you are accustomed to working with a particular group of windows arranged and sized in a particular setup, you can assign them to a workspace setting that you can then recall with a workspace button.

For example, during capture you might want to display the Capture tool and Video Input tool in specific locations. During effects editing, you might want to display the Effect Palette and Effect Editor in particular locations and sizes.

While in a workspace, you can move tool windows or open and close tool windows. The next time you select that workspace, the tool windows appear with the arrangement you set for the workspace.

You can assign up to 12 buttons that let you switch between workspaces. Workspace settings are user settings, so different users can have separate workspace arrangements. This is useful if there is more than one user accessing the same Avid system. Each user can assign up to 12 workspaces. You can also link the mode buttons in the Timeline palette to specific workspaces. And you can map the Workspace buttons in the Command palette to toolbars in the Timeline; in the Tool palette, or to a keyboard setting.

You cannot assign certain tool windows to a workspace, such as the Hardware tool, the Communication (Serial) Ports tool, and the Media tool.

To select a workspace, do the following:

- Select Windows > Workspaces > workspacename.
To customize the workspace:

1. For the workspace you want to customize, select Windows > Workspaces > workspacename.
2. Open other tools with which you want to work, and position them where you want them.
4. Type a name for the new workspace in the Workspace Name text box.
5. (Option) Select Based on Workspace, and then select a different workspace from the active one.
6. Click OK.

The new workspace appears in the Workspaces menu.

To remove your customizations:

1. Select Windows > Workspaces > Restore Current to Default.
   A message box warns you that the action deletes your custom workspace settings.
2. Click OK.

The workspace settings revert to the default settings on which you based the customizations.

To link a mode button in the Timeline palette to a workspace:

1. In the Settings list of the Project window, double-click Workspace Linking.
   The Workspace Linking Settings dialog box opens.
2. Click one of the following, and then select a workspace to which you want to link a mode button:
   - Source/Record mode
   - Effects mode
   - Color Correction mode
   The mode button is linked to the workspace.
3. Click OK.

When you click the mode button in the Timeline palette, the assigned workspace opens.

To delete a custom workspace:

1. Select Windows > Workspaces > Delete Workspace.
   The Delete Workspace dialog box opens.
2. Click OK.

The active workspace is deleted.
Linking User Settings and Workspaces

You can link User settings to a workspace. You can create a customized workspace, set up specific options in any Settings dialog box, and link them together by name.

For example, you can create an Audio workspace that opens the Audio Mixer tool and Audio tool. This workspace can also open a customized Timeline (with enlarged audio tracks and rubberbanding displays).

To link a workspace to another setting:

1. Select Windows > Workspaces > workspacename for the workspace you want to link.

2. In the Settings list of the Project window, create a new setting for any setting you want to link to your workspace. For information on creating custom settings, see “Duplicating Settings” on page 1425.

3. Double-click a setting that you want to link to your workspace, and change the settings you want to customize — for example, click Timeline and then select the Timeline settings you want.

4. Name this setting with the same name of your workspace. For more information, see “Naming Settings” on page 1425.

5. Double-click another setting. Select the options you want, close the dialog box.

6. Name this setting with the same name of your workspace.
7. In the Settings list of the Project window, double-click the workspace you want to link. The Workspace View Setting dialog box opens.

8. Select Link to Named settings.

9. Type the name of the custom settings to which you want to link the workspace.
For more information about creating and naming custom settings, see “Working with Settings” on page 1421.

You can link workspaces only to User settings.

10. (Option) Click the Bin Layout menu and select a layout you want to link to the workspace. For more information, see “Using Bin Layouts” on page 116.

11. Click OK.

The workspace is linked to the custom setting you specified.

To link a workspace to an unnamed setting:

1. Do one of the following:
   - For the workspace you want to link, select Windows > Workspaces > workspace.
   - In the Settings list of the Project window, double-click the workspace you want to link.
   The Workspace View Setting dialog box opens.

2. Select Link to Named settings and make sure there is nothing entered in the text box below it.

3. Click OK.

The workspace is linked to all the unnamed settings in the Settings list.

Assigning a Workspace or Bin Layout Button

When you assign a workspace or bin layout to a button, the button displays the first two characters of the workspace or layout name. If the assigned workspace or layout is not available — for example, if you deleted the workspace or the bin layout — the button remains visible but the label displays italicized characters.

To assign a workspace button:

1. Select Tools > Command Palette.

2. Click the Workspaces tab.

Workspaces buttons in the Workspaces tab of the Command Palette
3. Select Button to Button Reassignment.

4. Click a workspace button and drag the button to a location on another palette (for example, the Tool palette) or the Keyboard setting. The workspace button appears in the new location.

To assign a bin layout button:

1. Select Tools > Command Palette.

2. Click the Workspaces tab.

3. Click the workspace menu next to the button you want to assign.

   Bin layouts appear in the menu below the divider line.

   Bin Layout menu in the Workspaces tab of the Command Palette

4. Select Button to Button Reassignment.

5. Click a bin layout button and drag the button to a location on another palette (for example, the Tool palette) or the Keyboard setting.

   The bin layout button appears in the new location.

Using Bin Layouts

You can arrange and save bin window configurations independently of workspaces, including the contents of bin windows containing tabbed bins. You can also link a specific bin layout to a workspace. This allows you to open bin layouts at any time to customize the interface of your Avid editing application.

When you open a bin layout, the Avid editing application opens all bins saved in the bin layout and places them in the position configured in the layout. If you close the application, the position of bins in your current configuration is saved but not the bin layout setting. To save a custom bin layout, you must use the Bin Layout menu.
Keyboard settings and toolbar button mappings for workspaces are user settings. Bin layouts are project settings. When you link bin layouts to workspaces, to keyboard settings, or to toolbar buttons, you can access these layout assignments only when you work in a project containing a bin layout with the same name as when you created the link. For this reason, you should be careful to maintain a consistent bin layout naming convention for your projects.

If you delete a bin layout, the layout is deleted from your project. If you have an identical bin layout in another project, the layout is deleted only from the open project.

If you assign a bin layout button to a toolbar or a keyboard setting, deleting the bin layout does not remove the bin layout button. To remove the bin layout button, you must either assign a different button or a blank button to the toolbar or keyboard setting.

To open a bin layout, do the following:

- Select Windows > Bin Layout > bin layout.

To save a custom bin layout:

   The New Bin Layout dialog box opens.
2. Type a name for the bin layout, and then click OK.
   The application saves the bin layout, and the layout appears in the Bin Layout menu and in the Settings tab of the Project window.

To link a bin layout to a workspace view:

1. Do one of the following:
   - Select Windows > Workspaces > Properties.
   - In the Settings tab of the Project window, double-click the Workspace View you want to link.
   The Workspace View Setting dialog box opens.
2. Click the Bin Layout menu and select a bin.
3. Click OK.

To modify a bin layout:

1. Arrange and size your bins.
2. Select Windows > Bin Layout > Save Current.

To delete a bin layout:

   The Delete Bin Layout dialog box opens.
2. Click OK.

Working with Bins and Projects in an Avid Shared Storage Environment

Avid ISIS let you share bins and projects across the network. When you place your bins and projects on Avid Workspaces (drive volumes), several users can work on the same project at the same time.

For example, an editor creates sequences in one bin while an assistant recaptures media in another bin. At the same time, other users add audio effects or titles to other bins in the project.

Each user performs tasks from their own computer. Your Avid editing application provides a locking mechanism to help you keep track of who is currently working in a bin. The method allows one user to write to a bin; multiple users can read the files in that bin.

⚠️ The lock does not prevent you from deleting the media in a locked bin if you have write access to the workspace. It ensures only that you do not overwrite changes to the bin.

In an Avid shared storage environment, your Avid editing application creates and stores projects and bins on the client’s internal drive. If you move or save these projects and bins to the workspace, only one client can work on the project at a time. If two or more users work simultaneously on the same project, only one user can update the files. Other users can open and play sequences but cannot make any changes to them.

For information on managing workspaces, see the clients’ Quick Start cards.

You can also use an asset manager such as Avid Interplay to collaborate on projects. For more details, refer to “Working with Interplay / Production from an Avid Editing System” on page 1204.
Sharing Bins and Projects in Avid Shared Storage

**Sharing Only Bins**

If you share only bins, you store the project on your local system and store bins and media files on the shared workspace. This method allows users in a shared environment to share only selected bins with other users. The system identifies the shared bins as follows:

- Stores the bin in an ISIS Bins folder in the Project window. This folder is similar to the Other Bins folder.
- Displays a second column of information for the bin that identifies the computer that currently has the bin locked.
- Uses bold text to identify bins that are locked by another user.

**Sharing Both Bins and Projects**

If you share bins and projects, you create and store the project folder and bins on the shared workspace (or copy an existing project, bins, and the related media files). Your Avid editing application identifies information from each computer using the shared workspace as follows:

- Creates a project folder for each computer that accesses the project. Your Avid editing application adds the computer’s name to the folder name to create a unique name and stores any project-specific information in the folder. This prevents users from overwriting the project-specific data for other users.
- Displays an extra column in the Project window that identifies the computer that has the bin locked.
- Uses bold text to identify bins that are locked by other users.
- Creates a folder at the top level of the shared workspace called Unity Attic. This folder contains backup files for each project on the shared volume.

*Depending on the number of users sharing a workspace, you might want to increase the number of files that your Avid editing application stores in the Unity Attic folder.*

The following illustration shows the Project window for a shared project.
Opening a Shared Project

To open an existing project on the shared volume:

1. Start your Avid editing application.
2. In the Select Project dialog box, navigate to the project on Avid shared storage.
   
   The Project window opens. For a description of the elements specific to Avid shared storage in the Project window, see “Sharing Bins and Projects in Avid Shared Storage” on page 119.

3. Double-click a Bin icon to open one of the bins.

   The bin appears with a Bin Lock Status button. You can click the red (locked) or green (unlocked) Bin Lock Status button to view a history file that shows which computers and users have modified the bin and the date and time of the modifications.
Working with Bins and Projects in an Avid Shared Storage Environment

The Bin Lock Status button. When the button is green (top), the bin is unlocked. When the button is red (bottom) the bin is locked.

When a bin is unlocked, you have permission to make changes. You should not make changes to a locked bin. See “Considerations for Working with Shared Bins and Projects” on page 122.

The Bin Lock Status button does not appear if the bin is not on Avid shared storage.

Working with Locks and Shared Bins

Your Avid editing application uses a locking mechanism to help you keep track of who is currently working in a shared bin. Only one user can write to the bin, but multiple users can read the files in the bin.

The user who opens the bin first controls the lock and obtains write access to the bin. Bold text in the Project window also identifies bins that are locked by another user. When the person who controls the lock closes the bin, it becomes available for another user to open and control the lock.

If one user has the lock and another user has the same bin open, when the first user closes the bin, the second user must close and reopen the bin to control the lock.

You can instruct your Avid editing application to keep a bin locked even after you close it.

You can click the red or green Bin Lock Status button in the bin to view a history file that shows which computers and users have modified the bin.

To open a bin without controlling the lock:

Alt+double-click (Windows) or Option+double-click (Macintosh) the bin in the Project window.
To permanently lock a bin:

1. Select one or more bins in the Project window.
2. Right-click the Bin icon, and select Lock Project Bin.

An asterisk appears next to the user name in the Project window. In this case, the bin remains locked even after you close it.

To unlock the bin:

- Right-click the bin in the Project window, and select Unlock Project Bin.

The Lock Project Bin and Unlock Project Bin commands are also available from the Clip menu.

Considerations for Working with Shared Bins and Projects

Suggestions for Improving Performance When Working with Shared Bins

The following information is provided to improve performance when working with shared bins in an Avid shared storage environment.

- Do not use the same name for your editing system machine name and your user name. Do not use the same name for security objects such as machine names, user names, group names, and domain names. If any two security objects have the same name, Windows might become confused and sharing might not work properly.

- Do not use the same prefix for machine names in a shared environment. No full name can be a prefix of another name. If one of the systems has a machine name that is the full name, and others in the environment have the prefix as part of their machine name, problems can occur. For example, if an editing system has a machine name ABC and additional editing systems in the shared environment have machine names ABCnn, ABCxx, the following problems could occur:
  - When the system with the machine name ABC is writing to a directory, the systems whose machine names have the same prefix (ABCnn and ABCxx) might not be able to access the directory.
  - When the system with the machine name ABC is rendering, systems whose machine names have the same prefix (ABCnn and ABCxx) might be unable to launch.
Avid recommends that you do not use a common prefix for machine names. If you must use a common prefix, make sure all the names are the same length (ABC01, ABC02, ABC03, etc.).

- Do not use Windows Explorer to examine, copy, or manipulate shared bin files or shared project folders or their contents when you use those files or folders. If you do, when you attempt to access those shared bins or projects you might experience delays accompanied by a progress dialog that says, “Filesystem busy, retrying (MESSAGE).”

If the busy condition persists, a failure message appears. Make sure that you are not using Windows Explorer for the shared bins you are trying to access, and then try the operation again.

- When you have an environment where more than five users are sharing bins on Avid shared storage, Avid recommends using an Avid Interplay server in the workgroup environment.

- When an Avid Interplay server is available in an Avid workgroup environment, Avid does not recommend sharing bins or projects. Use the Avid Interplay server and the Interplay Window to share media. All editing systems in a workgroup environment that includes an Avid Interplay server must have the Avid shared storage client software installed. The Media Tool might become unreliable if an editor in the Avid shared storage workgroup environment does not have the Avid shared storage client software installed.

**Limitations When Working with Shared Bins and Projects**

If an editor other than the creator deletes a media file, other editors cannot see that media file go offline immediately. If an editor tries to play that file, a “media file not found” message might appear in a monitor window, and an access violation error might occur.

Each editing application maintains a PMR file in its machine name folder inside the OMFI MediaFiles folder or the Avid MediaFiles folder. The PMR file lists all the online media files. Every editing application consults all the PMR files in all the machine name folders to find out which media files are online. Whenever a media file is created, its name is immediately added to the creating editor application's PMR file, and whenever a media file is deleted by its creator, its name is immediately removed from the PMR file.

However, if an editing application other than the creator deletes a media file, the PMR file that contains the deleted file is NOT updated immediately. Once the creating editor encounters an event that causes its PMR to be updated, then all editing systems know that the deleted media file has gone offline.

There are several ways to force an editing application to update its PMR. The simplest is to switch to the desktop and back.
Avid recommends that you institute policies where media files are deleted by the editor who created them, or if necessary, the deleting editors notify the editor who created the media files that a deletion has occurred. This editor can then switch to the desktop and back, and all other editors can see the deleted file go offline.

**Restrictions and Limitations for Locked Bins**

The following restrictions apply to bins that are locked by another user:

- You cannot select a locked bin for operations such as capture, title creation, and import. This helps to minimize the problems of modifying a locked bin.
- You cannot drag an item to a locked bin.
- If you drag an item from a locked bin to a writable bin, the Avid system creates a duplicate (not a copy) of the selection in the writable bin. The original item is not removed from the locked bin. This operation is the equivalent of duplicating a selection and then drag the duplicate to another bin.
- You cannot move a bin that is locked by another user.
- If you modify a locked bin, your Avid editing application does not let you save the bin to the same name, but it lets you save the bin to another name. However, this causes duplicate bin IDs and might cause system-level conflicts with the contents of the two bins. Your Avid editing application sees the duplicate contents of these bins and resolves the conflicts by newest modifications.

Avoid creating duplicate bins when you modify a locked bin. If you do create a duplicate bin, you should manually merge the changes into the original bin and delete the duplicate bin.

⚠️ The lock does not prevent you from deleting the media in a locked bin if you have write access to the workspace. It ensures only that you don’t overwrite changes to the bin.

**Limitation When Using the Shared Bin Lock Icon**

Occasionally, when two editors attempt to open a shared bin at the same time, both editors get the green lock icon. However, only one editor really has the lock, and that editor's machine name appears beside the bin name in both Project windows.

Both editors can modify their copies of the bin, but only the editor that controls the lock, as indicated in the Project window, can save that bin. The other editor is warned that the bin is locked but is allowed to save a copy of the changed bin.

Avid recommends that you use the “Save Bin Copy As...” button and continue working.
Drive Filtering in Networked Workflows

The Drive Filtering and Indexing tab of the Media Creation Settings dialog box includes three options:

- Filter by Resolution
- Filter by System Drive
- Filter by Launch Drive

Depending on the version of your Avid editing system, the drive filtering options could be on or off by default. Avid recommends that all drive filtering options should be on by default.

Any project brought into a networked workflow that was created with any of the filtering selections off might have problems with networked media creation, such as “Audio and/or Video Mixdown” and “Send To Playback,” because their Media Creation Settings are still configured for standalone usage.

There are several ways to work around this issue. First, adjust the drive filtering settings when you switch environments. You can open the Media Creation Setting and switch the drive filtering settings or create multiple Media Creation Settings and switch the active setting whenever you shift environments. If you always work in an environment that differs from the defaults, you can create a Media Creation setting that fits your workflow and add it to your Site Settings so you create new projects with the desired defaults. For more information, see “Using Site Settings” on page 1429.
The Tools menu provides quick access to essential tools that you can use in your projects. In addition to the tools available from the Tools menu, you can also add a controller to your system that you can use as an alternative to your keyboard and mouse for editing footage. These tools are described in the following sections:

- Using the Tools Menu
- Using a Deck Controller
- Deck Controller Window Reference
- The Command Palette
- Using the Avid Calculator
- Using The Console Window
- Using the Hardware Tool
- External Controllers as Editing Control Surfaces

### Using the Tools Menu

**To open a tool:**

- Select Tools > tool name.

### Using Tabs

When you open a tool, it opens in a separate window by default. However, you can drag tools to a single tab window to conserve space within your Avid editing application, and you can move tools between tab windows.

> You can move tools into tab windows that contain other tools. You cannot move tools into tab windows used for bins. For more information on using bin tabs, see “Using Bin Tabs” on page 350.

**To move a tool into a window:**

- Click the tab in the tool you want to move, and drag it to the target window.
The tab bar in the target tab window displays all tool tabs.

**To move a tool into separate window:**
- Click the tab for the tool you want to move, and drag it to a clear region of the application interface.
  
  The tool displays in a separate window.

**To view tool tabs that do not display in the tab bar, do one of the following:**
- Click the Previous Tab button or the Next Tab button to shift the tab view to the left or the right.
  
  The tab display adjusts to display the next tool either on the left or the right.
- Click the Tab menu, and then select the name of the tool you want to view.
  
  The selected tool displays in the tab window.

**To organize tools by changing the order of tabs:**
- Click the tab of a tool you want to move, and drag it to a new position in the tab row.

**To close a tool tab:**
- Click the Close button in the tab.

### Using a Deck Controller

A deck controller provides direct serial or VLXi® V-LAN® control of an Avid-compatible tape deck at any time while you edit. You can cue and screen footage from source tapes in various edit modes, or when you record a digital cut, without opening the Capture tool.

**To open a deck controller:**
- Select Tools > New Deck Controller.
  
  A new Deck Controller window opens.
Deck Controller Window Reference

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1 Timecode display | Provides information about the control status of the tape deck:  
  - If the deck is properly connected and power is on, the deck controller displays timecode when you mount a tape.  
  - If a deck is not properly connected to the system or power is off when you open the controller, the indicator displays the message “NO DECK.”  
  - If you turn the deck power off with the deck controller open, the indicator displays the message “Power Off.”  
  - If you switch the deck control to Local on the VTR, the indicator displays the message “Local.”  
  
  Information on connecting decks and cabling varies depending on the Avid input/output hardware device you use. For more information, see “Connecting Cameras, Decks, and Monitors” in the Help. |
| 2 Timecode indicator | Flashes green during playback or capture to indicate that the system is receiving valid timecode from the source tape. If the indicator remains unlit, the system is not receiving timecode. |
| 3 Deck controls | Provide a standard range of playback capabilities, including fast forward and rewind, stop and play, step backward and step forward, pause, and eject. |
| 4 Deck Selection menu | Lets you specify a deck with deck control parameters that you can customize. For more information, see “Deck Configuration Settings” on page 1460. |
| 5 Tape Name button | Lets you associate a tape name with the controller and select a tape. For more information, see “Selecting a Source Tape” on page 197. |
The Command Palette

The Command palette provides a central location for all user-selectable buttons that you can map to various locations for ease of use. User-selectable buttons let you perform a wide range of commands with a single click of the mouse.

The Command palette organizes buttons by editing function. Tabs display each editing function and the buttons that perform those functions display in each tab. The functions include: Move, Play, Edit, Trim, FX (Effects), 3D, CC (Color Correction), MCam (MultiCamera), Other, More, and Smart Tool.

You can use the Command palette to:

- Map buttons to any Tool palette or the keyboard. See “Mapping User-Selectable Buttons” on page 131.
- Map menu commands to various buttons and keys. See “Mapping Menu Commands” on page 132.
- Directly activate a command. See “Activating Commands from the Command Palette” on page 133.

For information about each button in the Command palette, right-click a button and select What’s This? from the menu.

Understanding Button Mapping

Mapping user-selectable buttons lets you reconfigure Tool palettes, toolbars, or the keyboard in various combinations to suit different editing needs.
When you map buttons to the keyboard, the mapping might be specific to the current editing mode. For example, buttons mapped to the Page Up key or the Page Down key revert to the default key functions when you enter Effect mode. After you exit Effect mode, the keys return to the mapped function.

The following are examples of buttons you might want to map:

Buttons you use to subcatalog clips. Left to right: Make Subclip, Find Bin, and Add Marker.

Buttons you use for complex layering and effects. Top, left to right: Motion Effect, Remove Effect, Transition Corner Display, and Fade Effect. Bottom, left to right: Render Effect, Cycle Picture/Sound, Quick Transition, Grid (available on some Avid editing applications).

Buttons you use for MultiCamera editing. Left to right: Quad Split, Swap Cam Bank, and Group.

When you remap buttons or commands, the system immediately saves your new configuration in one of the default settings that you open from the Project window. You can also save, rename, and recall multiple versions of any of these settings to serve various purposes.

For more information on multiple settings, see “Selecting Among Multiple Settings” on page 1426.

Your Avid editing application saves button configurations as follows:

- Changes to the Keyboard palette are saved in the Keyboard settings.
- Changes to Tool palette in the Composer window are saved with the Composer settings.
- Changes to Command palettes while trimming are saved with Trim settings.
- Changes to the Tool palette are saved in the Interface settings.

To change the appearance of the buttons in the Tool palette in the Interface settings, see “Customizing the Avid User Interface” on page 107. To identify a button’s function with only an icon or with an icon and letters, see “Interface Settings” on page 1508.
The Blank Button

The Blank button in the Other tab of the Command palette lets you replace a defined button with an undefined button. If you do not need a specific button on the Tool palette, you can replace this button with a Blank button.

For more information on mapping the Blank button to a new location, see “Mapping User-Selectable Buttons” on page 131.

Modifier Keys

You can add modifier keys to functions already associated with keys and buttons. The Other tab in the Command palette contains the following modifier key buttons:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="#" alt="alt" /></td>
<td>(Windows) Add Alt Key button</td>
</tr>
<tr>
<td><img src="#" alt="ctrl" /></td>
<td>(Macintosh) Add Control Key button</td>
</tr>
<tr>
<td><img src="#" alt="option" /></td>
<td>(Macintosh) Add Option Key button</td>
</tr>
</tbody>
</table>

For example, on a Windows system, if you map the Add Alt Key button to the Mark IN key (I key), the function of the I key changes to Go to IN Point (which is equivalent to pressing Alt+I). For a list of other functions that use modifier keys, select Help > Shortcuts.

After you modify a key or button with a modifier key button, you can use the default function of the key or button if you press and hold the appropriate modifier key while you press the key, or press and hold the modifier key while you click the button.

Mapping User-Selectable Buttons

To map buttons or keys on the keyboard by using the Command palette:

1. Do one of the following to open a window that has a user-selectable button:
   - Activate the Playback, Source, or Record monitor in the Composer window.
   - Click a Fast Menu button, and drag the Tool palette to open it.
   - Activate the Source/Record monitor or the pop-up monitor, click the Fast Menu button, and drag to tear off the Tool palette.
   - Open a clip in a pop-up monitor.
   - Open the Keyboard palette from the Settings list in the Project window.
Open the Mouse Settings dialog box from the Settings list in the Project window.

2. Select Tools > Command Palette.
   The Command palette opens.

3. Select Button to Button Reassignment at the bottom of the Command palette.

4. Click the tab from which you want to select a user-selectable button.

5. Drag the button from the Command palette to a button location on the other palette.

## Mapping Menu Commands

You can also map menu commands directly onto any mappable button location or onto the keyboard. In some cases, you can avoid using menus altogether.

> Before you map some commands, you must first establish the condition that enables the command. For example, before you map the Render In/Out command from the Clip menu, you must first mark IN and OUT points in the Timeline so that the menu command appears.

**To map menu commands:**

1. Do one of the following to open a window that has user-selectable buttons:
   - Activate a monitor in the Composer window.
   - Click a Fast Menu button, and drag the Tool palette to open it.
   - Open a clip in a pop-up monitor.
   - Open the Keyboard palette from the Settings list in the Project window.

2. Select Tools > Command Palette.
   The Command palette opens.

3. Select Menu to Button Reassignment.

4. Click a target button in the Keyboard palette or other palette (for example, the Command palette under a monitor).

5. Select the menu command you want to map to the target button.
   The initials for the menu command appear on the target button.

Example of a menu command — Special > MultiCamera Mode (MM) — mapped to a button in the Tool Palette.
**Activating Commands from the Command Palette**

You can perform a command function directly from the Command palette. For example, you can click the Play button in the Command palette to play the material in the Source monitor.

**To activate a command from the Command palette:**
1. Select Tools > Command Palette.
   
   The Command palette opens.
2. Select Active Palette at the bottom of the Command palette.
3. Click the tab from which you want to select a command function.
4. Click the button in the Command palette for the function you want to perform.

**Using the Avid Calculator**

The Avid Calculator helps you calculate video and film durations, and convert timecode and film key numbers to different formats.

For example, you can:
- Convert drop-frame to non-drop-frame timecode values.
- Convert timecode durations between 30-fps and 25-fps projects.
- Convert a duration in video to the corresponding length in footage and frames for measuring 35mm film.

**To use the Avid Calculator:**
1. Select Tools > Calculator.
   
   The Avid Calculator opens.
2. Click the Format menu, and select a format.
3. Make calculations in one of the following ways:
   - Click numbers and functions in the Avid Calculator.
   - Enter numbers and functions using the numeric keypad.
   - Enter numbers and functions using the top row of numbers on the keyboard.
     
     You do not need to enter leading zeros, colons, or semicolons for timecode.
4. **To convert your totals at any time to another format:**
   - Click the Format menu, and select a different frame code or key number format.
If you enter drop-frame timecode into the calculator while non-drop-frame timecode is selected in the format menu, the calculator converts the entered timecode to a non-drop-frame equivalent (and vice-versa).

**Using The Console Window**

The Console window provides a number of features including, finding your system ID number, viewing log error messages, getting information about your sequence, displaying your networked drives, and information after you capture or import.

*Do not use the programming features of the Console without guidance from Avid. Contact your Avid Reseller with specific questions. (In North America, you can contact Avid Customer Support.)*

The Console window provides quick access to bin information such as total duration of selected clips or total items in a bin including hidden items. You can also use the Console window to display information about a clip, segment, or sequence in the Timeline.

You can access network drives that you have mapped to your Avid editing system. Once you map your network drives, you can type the appropriate console command to display the mapped drive letter in the appropriate tools in your Avid editing application.

*For information about mapping dives to your computer, see your Windows or Macintosh documentation.*

You do not need to use this feature to access Avid shared storage network drives.

When the feature is turned on, the mapped drive letter appears in the Target Drive menu. When you turn the feature off, the mapped drive letter is dimmed. If you quit and restart your Avid editing application, the mapped drive letter does not appear in the Target Drive menu.

**To display current system information:**

1. Select Tools > Console.
   
   The Console window opens.

2. Scroll in the Console window to view your system information and ID.
   
   Your system ID is on a line beginning **System ID:**

**To review errors logged to the Console window:**

1. When an error occurs, close the message box and select Tools > Console.

2. Scroll through the Console window to find a log of the error to use when you contact your Avid Reseller or Avid Customer Support.
To get information with the Console window:

1. Select Tools > Console.
   
   The Console window opens.

2. Select the item about which you want information, for example:

   - In the Timeline, move the position indicator to the selected clip or segment and select File > Get Position Info.
   - In the bin, right-click and select Get Bin Info.

   Information about the clip appears in the Console window.

To make your mapped network drives available:

1. Open the Console window by selecting Tools > Console.

2. In the Console command line, type:

   `alldrives 1`

3. Press Enter (Windows) or Return (Macintosh).

   Network drives are now visible in your Avid editing application.

   Typing `alldrives` in the Console window turns this feature on and off. Typing `alldrives 2` restores the default behavior where only media drives are available.

   By default, network drives are filtered by resolution when the option Filter Network Drives Based on Resolution option is selected in the Media Creation settings. For more information, see “Media Creation Settings” on page 1512.

Using the Hardware Tool

The Hardware tool provides the following information about the system’s hardware configuration:

- The Drives tab lists each online drive. The shaded portion of the bar graph to the right of each drive shows the amount of storage space currently filled. The number in the bar graph indicates the amount of available drive storage space for each drive.

- If your system is connected to an Avid shared storage network, you see two drives tabs, Local Drives and Avid shared storage Drives.

  - (Windows) The System tab lists the operating system, its version, service pack, and build, and the physical memory.
  - (Macintosh) The System tab lists the operating system, its version, and the physical memory.
To check the hardware configuration of your Avid system, do one of the following:
- Select Tools > Hardware.
- Click the Info tab in the Project window, and then click Hardware.
  The Hardware tool opens.

External Controllers as Editing Control Surfaces

Adding a controller to your Avid system provides an alternative to using the keyboard and mouse for editing your sequence. Avid supports the following controllers for this purpose:
- Avid Command8™
- Avid 002 (Windows only)
- JL Cooper MCS3

For information about these controllers, see “Using External Audio Devices” on page 865.
Logging

When you import shot log files or log directly into a bin, you provide your Avid editing application with frame-accurate clip information that it uses to capture the source footage. The logs you create form the foundation for organizing, tracking, storing, retrieving, and generating lists of edit information throughout your project. The following topics provide information for preparing log information:

- Avid Log Specifications
- Creating an Avid Log
- Double-Checking Log Files
- Logging Directly into a Bin
- Understanding the Pulldown Phase
- Setting the Pulldown Phase
- Film-Related Log Information

Avid Log Specifications

Use a word processing application or a text editor to prepare an Avid log on any Windows or Macintosh computer. You can use the file name extension .txt, but it is not required.

To ensure accuracy, you must follow the Avid log specifications described in this section.

An Avid log is composed of three sections, in this order:

- Global Titles
- Standard and custom column Titles
- Data Titles

When you create an Avid log, you must follow the order precisely. The tables in these topics follow this order.
The tables use the following conventions:

- A Title appears in the first column, without angled brackets or square brackets. For example, FIELD_DELIM is the first global Title.
- A `<supported value>` is surrounded by angled brackets. `<Alternative supported values>` appear underneath, also in angled brackets. You must enter one of these values. For example, `<29.97>` is one of the supported values for the FPS Title; to specify that value, type `29.97`.
- A `<variable data value>` is also surrounded by angled brackets, but it is italicized. For example, `<timecode>` is the data entry for the Start Title; type the correct timecode, in the format `08:19:10:00` (or `08;19;10;00`, for drop-frame timecode).
- `[Tab]` and `[Enter]` (Windows) or `[Return]` (Macintosh) keys are surrounded by standard brackets.
- A column contains the word “Required” if the Title must be included in the log.
- The final column contains notes about the Title or values.

You can decide not to display a defined Title (including a required Title), except for `Name`. `Name` must always be displayed.

The maximum number of combined global, standard, and custom Titles in a log file is 64.

For an example of a simple log file, see “Sample Avid Log” on page 144.

**Global Titles**

The global Titles must come first in an Avid log file, and you must enter one value for each Title.

<table>
<thead>
<tr>
<th>Title</th>
<th>[Enter] or [Return]</th>
<th>Required</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>FIELD_DELIM</td>
<td>[Tab] &lt;TABS&gt;</td>
<td></td>
<td>This marks the start of the global Titles.</td>
</tr>
<tr>
<td>VIDEO_FORMAT</td>
<td>[Tab] &lt;NTSC&gt;</td>
<td></td>
<td>Enter TABS to show that the file is Tab delimited.</td>
</tr>
<tr>
<td></td>
<td>[Tab] &lt;PAL&gt;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>FILM_FORMAT</td>
<td>[Tab] &lt;16mm&gt;</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>[Tab] &lt;35mm,3perf&gt;</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>[Tab] &lt;35mm,4perf&gt;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Column Title</td>
<td>Value Options</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>----------------------</td>
<td>--------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>AUDIO_FORMAT</td>
<td>&lt;22kHz&gt; &lt;24kHz&gt; &lt;44kHz&gt; &lt;48kHz&gt;</td>
<td>Audio sampling rate for capture. You can override this for individual clips.</td>
<td></td>
</tr>
<tr>
<td>TAPE</td>
<td>tape name</td>
<td>Name of the videotape reel you log. If you omit this Title, the file name becomes the global tape name. You can override this for individual clips.</td>
<td></td>
</tr>
<tr>
<td>FPS</td>
<td>&lt;23.98&gt; &lt;24&gt; &lt;25&gt; &lt;29.97&gt;</td>
<td>Capture rate is 23.98 fps (23.978 fps) for NTSC, 24 fps for NTSC or PAL, 25 fps for PAL, or 29.97 fps for NTSC.</td>
<td></td>
</tr>
<tr>
<td>SOUNDTC_FPS</td>
<td>&lt;23&gt; &lt;24&gt;</td>
<td>Defines the number of frames per second for Sound TC in the ALE.</td>
<td></td>
</tr>
</tbody>
</table>

**Column Titles**

The standard column Titles appear after the global Titles in the Avid log file.

You do not enter the data for a column Title along with the Title. You enter the data later, in a separate data section.

You must include the five required standard column Titles; they are listed first in the table.

You can create your own custom column Titles. Enter them after the standard Titles (see the last Title in the table). To create a custom Title, substitute the custom Title name for `<Your_Title>`. You can create several custom Titles, as long as the total of global, standard, and custom Titles does not exceed 64.

COLUMN Titles: Column Titles are case sensitive and must be spelled exactly as shown. Note that the first five Titles are required. Other Titles are optional but might be necessary for your project. This table lists only the column Titles that are relevant to shot log files. Some data, such as Creation Date, is gathered by the system. The table does not include Titles for such data. The maximum number of combined global, standard, and custom Titles in a log file is 64.
<table>
<thead>
<tr>
<th>Column</th>
<th>[Enter] or [Return]</th>
<th>Required</th>
<th>Indicates the start of the column Titles.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>[Tab]</td>
<td>Required</td>
<td>Title for clip name.</td>
</tr>
<tr>
<td>Tracks</td>
<td>[Tab]</td>
<td>Required</td>
<td>Title for tracks you select for capture.</td>
</tr>
<tr>
<td>Start</td>
<td>[Tab]</td>
<td>Required</td>
<td>Title for video timecode of sync point — the timecode IN for clip. From address track of video.</td>
</tr>
<tr>
<td>End</td>
<td>[Tab]</td>
<td>Required</td>
<td>Title for timecode OUT for clip. From address track of video.</td>
</tr>
<tr>
<td>Audio</td>
<td>[Tab]</td>
<td></td>
<td>Title for the audio resolution (sample rate). If omitted, the global entry for AUDIO_FORMAT applies.</td>
</tr>
<tr>
<td>Auxiliary Ink</td>
<td>[Tab]</td>
<td></td>
<td>Title for a second ink number used for the clip.</td>
</tr>
<tr>
<td>Auxiliary TC1</td>
<td>[Tab]</td>
<td></td>
<td>Title for auxiliary timecode.</td>
</tr>
<tr>
<td>Auxiliary TC2</td>
<td>[Tab]</td>
<td></td>
<td>Title for auxiliary timecode.</td>
</tr>
<tr>
<td>Auxiliary TC3</td>
<td>[Tab]</td>
<td></td>
<td>Title for auxiliary timecode.</td>
</tr>
<tr>
<td>Auxiliary TC4</td>
<td>[Tab]</td>
<td></td>
<td>Title for auxiliary timecode.</td>
</tr>
<tr>
<td>Auxiliary TC5</td>
<td>[Tab]</td>
<td></td>
<td>Title for auxiliary timecode.</td>
</tr>
<tr>
<td>Camera</td>
<td>[Tab]</td>
<td></td>
<td>Title for the camera used to film this clip. This feature is used in multicamera shoots.</td>
</tr>
<tr>
<td>Camroll</td>
<td>[Tab]</td>
<td></td>
<td>Title for the camera roll ID containing this clip.</td>
</tr>
<tr>
<td>Duration</td>
<td>[Tab]</td>
<td></td>
<td>Title for timecode Start to timecode End, the length of the video clip.</td>
</tr>
<tr>
<td>FPS</td>
<td>[Tab]</td>
<td></td>
<td>Title for video frames per second rate for capturing the individual clip. If omitted, the global entry applies.</td>
</tr>
<tr>
<td>Film TC</td>
<td>[Tab]</td>
<td></td>
<td>Title for the timecode used on the film.</td>
</tr>
<tr>
<td>Ink Number</td>
<td>[Tab]</td>
<td></td>
<td>Title for the ink number used for the clip.</td>
</tr>
<tr>
<td>KN Duration</td>
<td>[Tab]</td>
<td></td>
<td>Title for the length of the clip, expressed in feet and frames.</td>
</tr>
<tr>
<td>KN End</td>
<td>[Tab]</td>
<td></td>
<td>Title for the ending key number for the clip.</td>
</tr>
</tbody>
</table>
### Avid Log Specifications

<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>KN Start</td>
<td>Title for the starting key number for the clip.</td>
</tr>
<tr>
<td>Labroll</td>
<td>Title for the lab roll ID for the clip. Lab rolls are a combination of several camera rolls.</td>
</tr>
<tr>
<td>Perf</td>
<td>Title for the film-edge perforations format used for 3-perf projects.</td>
</tr>
<tr>
<td>Pullin</td>
<td>Title for the telecine pulldown of the first frame of the clip (pulldown phase). Pullin can have the values A, B, C, or D.</td>
</tr>
<tr>
<td>Pullout</td>
<td>Title for the telecine pulldown of the last frame of the clip (pulldown phase). Pullout can have the values A, B, C, or D.</td>
</tr>
<tr>
<td>Reel #</td>
<td>Title for the source reel number.</td>
</tr>
<tr>
<td>Scene</td>
<td>Title for the scene number of the clip.</td>
</tr>
<tr>
<td>Shoot date</td>
<td>Title for the date the footage was shot.</td>
</tr>
<tr>
<td>Sound TC</td>
<td>Title for Nagra timecode, Arri® code, and so on, at the sync point. Syncs with the Start timecode. Required if tracking the sync sound. Capture rate can be 25 or 30 fps.</td>
</tr>
<tr>
<td>Soundroll</td>
<td>Title for sound roll ID for clip.</td>
</tr>
<tr>
<td>TC 24</td>
<td>Title for 24-fps timecode.</td>
</tr>
<tr>
<td>TC 25P</td>
<td>Title for 25-fps timecode with pulldown.</td>
</tr>
<tr>
<td>TC 25</td>
<td>Title for 25-fps timecode.</td>
</tr>
<tr>
<td>TC 30</td>
<td>Title for 30-fps timecode.</td>
</tr>
<tr>
<td>Take</td>
<td>Title for take ID for clip.</td>
</tr>
<tr>
<td>Tape</td>
<td>Title for source tape ID for the individual clip. If omitted, the global entry applies.</td>
</tr>
<tr>
<td>DESCRIPT</td>
<td>Title for description of clip.</td>
</tr>
<tr>
<td>COMMENTS</td>
<td>Title for comments about clip.</td>
</tr>
<tr>
<td>&lt;Your_Title&gt;</td>
<td>Add any category of information you want. Add as many Titles as you want, but do not use more than a total of 64 global and column Titles in the file. Press the Tab key between each Title. Do not press the Tab key after the last Title.</td>
</tr>
</tbody>
</table>

Add as many Titles as you want, but do not use more than a total of 64 global and column Titles in the file. Press the Tab key between each Title. Do not press the Tab key after the last Title.
Data Entries

The data entries come after the Custom column Titles. The table shows the format for entering data. Enter a line of data in this format for every clip. Be sure to start the data section for each clip with the word Data [Enter] (Windows) or Data [Return] (Macintosh).

| DATA Titles: The word Data marks the start of the data for each clip. |
|---|---|---|
| Data | [Enter] or [Return] | Required |
| Enter the word Data to mark the start of the logged clip entries. |

DATA FOR EACH CLIP: Enter a line of data for each clip. Enter the data so it aligns with its column Title. (The data that goes with the ninth column Title must be the ninth data entry.) Be sure to enter data for all the required values. To leave a data position unfilled, press the Tab key instead of typing data. Press Enter (Windows) or Return (Macintosh) at the end of each line. Your Avid system supports up to four audio tracks in imported and exported logs.

<table>
<thead>
<tr>
<th>&lt;clip name&gt;</th>
<th>[Tab]</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Under Name Title. Enter a clip identifier (32 characters maximum).</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&lt;V&gt;</th>
<th>[Tab]</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Under Tracks Title. Enter the tracks you want captured for the clip. Enter V for MOS takes. Enter A1, A2, or A1A2 for wild sound. Enter D for a data track.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&lt;timecode&gt;</th>
<th>[Tab]</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Under Start Title. Enter the video timecode for the sync point, the first frame of the clip. Use colons for non-drop-frame (for example, 01:00:12:20). Use one or more semicolons for drop-frame (for example, 01;18;00;02).</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&lt;timecode&gt;</th>
<th>[Tab]</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Under End Title. Enter the video timecode for the last frame of the clip.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&lt;22kHz&gt;</th>
<th>[Tab]</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Under Audio Title. Enter the audio sampling rate for this clip only. If omitted, global entry applies.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tag</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>-----------------</td>
<td>-------------------------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td><code>&lt;inknumber&gt;</code></td>
<td>Under Auxiliary Ink Number Title. Identify a second ink number for the start of the clip.</td>
<td></td>
</tr>
<tr>
<td><code>&lt;timecode&gt;</code></td>
<td>Under Auxiliary TC Title. Enter a Nagra timecode, Arri code, and so on, for the sync point. Syncs with the Start timecode.</td>
<td></td>
</tr>
<tr>
<td><code>&lt;camera ID&gt;</code></td>
<td>Under Camera Title. Identify the camera, using letters or numbers. For multicamera shoots.</td>
<td></td>
</tr>
<tr>
<td><code>&lt;camera roll ID&gt;</code></td>
<td>Under Camroll Title. Identify the camera roll, using letters and numbers.</td>
<td></td>
</tr>
<tr>
<td><code>&lt;timecode&gt;</code></td>
<td>Under Duration Title. Enter the length of the video clip, Start to End.</td>
<td></td>
</tr>
<tr>
<td><code>&lt;timecode&gt;</code></td>
<td>Under Film TC Title. Identify the timecode used for the film, usually at 24 fps.</td>
<td></td>
</tr>
<tr>
<td><code>&lt;inknumber&gt;</code></td>
<td>Under Ink Number Title. Identify the ink number for the start of the clip.</td>
<td></td>
</tr>
<tr>
<td><code>&lt;keynumber&gt;</code></td>
<td>Under KN Start Title. Identify the complete key number for the start of the clip, for example, KU 31 2636-8903&amp;12.</td>
<td></td>
</tr>
<tr>
<td><code>&lt;keynumber&gt;</code></td>
<td>Under KN End Title. Identify the key number for the end of the clip. Identify only feet and frames, for example, 0342&amp;07.</td>
<td></td>
</tr>
<tr>
<td><code>&lt;keynumber&gt;</code></td>
<td>Under KN Duration Title. Identify the length of the clip, in feet and frames.</td>
<td></td>
</tr>
<tr>
<td><code>&lt;lab roll ID&gt;</code></td>
<td>Under Labroll Title. Identify the lab roll, use letters and numbers.</td>
<td></td>
</tr>
<tr>
<td><code>&lt;1&gt;</code></td>
<td>Under Perf Title. Edit the perf for this clip only.</td>
<td></td>
</tr>
<tr>
<td><code>&lt;2&gt;</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>&lt;3&gt;</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>&lt;A&gt;</code></td>
<td>Under Pullin Title. Identify the telecine pulldown of the first frame of the clip (pulldown phase). NTSC only.</td>
<td></td>
</tr>
<tr>
<td><code>&lt;B&gt;</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>&lt;X&gt;</code> (matchback only)</td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>&lt;C&gt;</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>&lt;D&gt;</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Tab</td>
<td>Description</td>
</tr>
<tr>
<td>-----</td>
<td>----------------------------</td>
<td>--------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>&lt;A&gt;</td>
<td>Tab</td>
<td>Under Pullout Title. Identify the telecine pulldown of the last frame of the clip. NTSC only.</td>
</tr>
<tr>
<td>&lt;B&gt;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;X&gt;</td>
<td>(matchback only)</td>
<td></td>
</tr>
<tr>
<td>&lt;C&gt;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;D&gt;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;reel ID&gt;</td>
<td>Tab</td>
<td>Under Reel # Title. Identify the reel, use numbers.</td>
</tr>
<tr>
<td>&lt;scene ID&gt;</td>
<td>Tab</td>
<td>Under Scene Title. Identify the scene, use letters and numbers.</td>
</tr>
<tr>
<td>&lt;shoot date&gt;</td>
<td>Tab</td>
<td>Under Shoot Date Title. Identify the date the footage was shot, use numbers or letters and numbers.</td>
</tr>
<tr>
<td>&lt;timecode&gt;</td>
<td>Tab</td>
<td>Under Sound TC Title. Identify the sound timecode at the sync point. Syncs with the Start timecode.</td>
</tr>
<tr>
<td>&lt;sound roll ID&gt;</td>
<td>Tab</td>
<td>Under Soundroll Title. Identify the sound roll, use letters and numbers.</td>
</tr>
<tr>
<td>&lt;timecode&gt;</td>
<td>Tab</td>
<td>Under TC 24 Title. Identify the start of the clip for 24p timecode.</td>
</tr>
<tr>
<td>&lt;timecode&gt;</td>
<td>Tab</td>
<td>Under TC 25p Title. Identify the start of the clip for 25p timecode (PAL pulldown).</td>
</tr>
<tr>
<td>&lt;timecode&gt;</td>
<td>Tab</td>
<td>Under TC 25 Title. Identify the start of the clip for 25-fps timecode (PAL).</td>
</tr>
<tr>
<td>&lt;timecode&gt;</td>
<td>Tab</td>
<td>Under TC 30 Title. Identify the start of the clip for 30-fps timecode.</td>
</tr>
<tr>
<td>&lt;take ID&gt;</td>
<td>Tab</td>
<td>Under Take Title. Identify the take, use letters and numbers.</td>
</tr>
<tr>
<td>&lt;source tape ID&gt;</td>
<td>Tab</td>
<td>Under Tape Title. Enter the source videotape ID for this clip only.</td>
</tr>
<tr>
<td>&lt;clip description&gt;</td>
<td>Tab</td>
<td>Under DESCRIP Title. Describe the clip.</td>
</tr>
<tr>
<td>&lt;clip comments&gt;</td>
<td>Tab</td>
<td>Under COMMENTS Title. Comment on the clip.</td>
</tr>
<tr>
<td>&lt;information&gt;</td>
<td>Tab</td>
<td>Under the Titles you create, type the appropriate information.</td>
</tr>
<tr>
<td></td>
<td>Enter] or [Return]</td>
<td>Press Enter (Windows) or Return (Macintosh) after the last entry for the clip.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Do not press Tab after the last entry for the clip.</td>
</tr>
</tbody>
</table>

Enter an additional line of data for each remaining clip.

**Sample Avid Log**

This is a sample Avid log for an NTSC video project.
Formatting keys (such as [Tab] and [Enter] (Windows) or [Return] (Macintosh)) display in brackets.

<table>
<thead>
<tr>
<th>Heading [Enter]</th>
</tr>
</thead>
<tbody>
<tr>
<td>FIELD_DELIM [Tab] TABS [Enter]</td>
</tr>
<tr>
<td>VIDEO_FORMAT [Tab] NTSC [Enter]</td>
</tr>
<tr>
<td>AUDIO_FORMAT [Tab] 44kHz [Enter]</td>
</tr>
<tr>
<td>TAPE [Tab] 001 [Enter]</td>
</tr>
<tr>
<td>FPS [Tab] 29.97 [Enter]</td>
</tr>
<tr>
<td>[Enter]</td>
</tr>
<tr>
<td>Column [Enter]</td>
</tr>
<tr>
<td>Name [Tab] Tracks [Tab] Start [Tab] End [Enter]</td>
</tr>
<tr>
<td>[Enter]</td>
</tr>
<tr>
<td>Data [Enter]</td>
</tr>
<tr>
<td>CU Josh &amp; Mary [Tab] V [Tab] 01:00:00:00 [Tab] 01:15:05:00 [Enter]</td>
</tr>
<tr>
<td>CU Josh [Tab] VA1 [Tab] 01:15:06:00 [Tab] 01:20:00:00 [Enter]</td>
</tr>
</tbody>
</table>

Sample Avid log (Windows)

<table>
<thead>
<tr>
<th>Heading [Return]</th>
</tr>
</thead>
<tbody>
<tr>
<td>FIELD_DELIM [Tab] TABS [Return]</td>
</tr>
<tr>
<td>VIDEO_FORMAT [Tab] NTSC [Return]</td>
</tr>
<tr>
<td>AUDIO_FORMAT [Tab] 44kHz [Return]</td>
</tr>
<tr>
<td>TAPE [Tab] 001 [Return]</td>
</tr>
<tr>
<td>FPS [Tab] 29.97 [Return]</td>
</tr>
<tr>
<td>[Return]</td>
</tr>
<tr>
<td>Column [Return]</td>
</tr>
<tr>
<td>Name [Tab] Tracks [Tab] Start [Tab] End [Return]</td>
</tr>
<tr>
<td>[Return]</td>
</tr>
<tr>
<td>Data [Return]</td>
</tr>
<tr>
<td>CU Josh &amp; Mary [Tab] V [Tab] 01:00:00:00 [Tab] 01:15:05:00 [Return]</td>
</tr>
<tr>
<td>CU Josh [Tab] VA1 [Tab] 01:15:06:00 [Tab] 01:20:00:00 [Return]</td>
</tr>
</tbody>
</table>

Sample Avid log (Macintosh)
Creating an Avid Log

You can use any word processing application or text editor to create Avid logs. However, you must save the file as a text document (ASCII format).

When log manually, you should do the following:

- Identify the source tape for each shot.
- Document each clip’s name, start timecode, and end timecode.
- For NTSC transfer tapes for film projects, you must supply pulldown information in the Pullin column of the bin before you capture.

This is the minimum information required to capture successfully. You can also add other information such as comments, auxiliary timecodes, or key numbers for film projects. You can make a separate log file for each videotape, or log clips from several different videotapes in one log.

Windows systems ship with a text editor called WordPad. Mac OS® X systems ship with a text editor called TextEdit.

To open WordPad:
- Click the Start button, and select All Programs > Accessories > WordPad.

To open Text Edit:
- Select Go > Applications, and double-click TextEdit.

To create a text document in TextEdit:
- Select Format > Make Plain Text.

To create an Avid Log by using a word processor or text editor:

1. Enter shot log information according to the specifications described in “Avid Log Specifications” on page 137.
2. Save your file as a text file in the Save As dialog box.
   - You can use the file name extension .txt, but it is not required.

Your Avid editing application only accepts text files (ASCII format).

After you double-check the log, import it into your Avid editing application. For more information, see “Importing Shot Log Files” on page 169.
Double-Checking Log Files

When you import shot logs for video, your Avid editing application compares the video duration to the video out minus the video in. When you import film shot logs, the system compares the key number out minus the key number in.

If the system detects a discrepancy, it reports the error to the Console and does not bring the clip into the bin. The best way to ensure that the system does not discard clips on import is to double-check the logs for discrepancies in duration and marks.

Select Tools > Console to open the Console window. For more information, see “Using The Console Window” on page 134.

Logging Directly into a Bin

To log clips directly into a bin use the Capture tool in one of two ways:

- Log directly into a bin with an Avid-controlled deck for semiautomated data entry.
- Log manually during or after you view footage offline with a non-Avid-controlled deck or other source.

Before you capture, observe the following important guidelines for preroll, timecode formats, and naming of tapes when you log.

Logging Preroll

Leave adequate preroll with continuous timecode prior to IN points when you log your tapes. The recommended minimum preroll is 2 seconds for Betacam® playback, 5 seconds for 3/4-inch U-matic® playback, and 6 seconds for DV playback.

Use the Preroll menu in the Deck Settings dialog box to set the default preroll for tape playback. For more information, see “Deck Settings” on page 1461.

Logging Timecode

Within an NTSC project, check the timecode format of each tape (drop-frame versus non-drop-frame timecode) when you log without a tape in the deck. Log drop-frame timecode with semicolons (;) between the hours, minutes, seconds, and frames. Log non-drop-frame timecode with colons (:). You can set the timecode format to use in the Deck Preferences Settings dialog box. For more information, see “Deck Preferences Settings” on page 1462.

To change the logged timecode format, select Clip > Modify. For more information, see “Modifying Clip Information” on page 368.
Naming Tapes

When you enter tape names in the Capture tool, consider the following:

- Tape names must be alphanumeric characters (A to Z, 0 to 9). They can include uppercase and lowercase characters. The maximum length of a name is 32 characters.
- It is possible to have a single tape listed as several different tapes if you alter the case of the letters. For example, if you type a single name as TAPE, Tape, and tape on three different occasions, all three names appear. This can cause significant problems in keeping track of clips when you batch capture, recapture, and generate an EDL. Select a case convention and maintain it throughout a project.

If you want your Avid editing application to consider master clips as coming from the exact same tape, you should try to select that tape name from the Select Tape dialog box. If you do not see the tape, but know you have online media from that tape, you should click the Scan for Tapes button. For more information, see “Logging with Avid-Controlled Decks” on page 148.

- It is important that you create a naming scheme for your tapes. For example, you can easily sort and view tapes with similar names together in a bin. However, it can be difficult to distinguish among numerous tapes with similar names when you try to locate a specific tape quickly. Name tapes based upon the amount and complexity of your source material.

If you modify tape names and timecodes, it can affect any key numbers you enter for selected clips.

- If you plan to generate an edit decision list (EDL) to import into an edit controller for online editing, double-check the controller’s specifications. Some edit controllers truncate source tape names to as few as six characters, while others eliminate characters and truncate to three numbers. Alterations like these at the EDL stage might cause the system to identify different source tapes with similar names, which could cause you to lose track of source material.

Logging with Avid-Controlled Decks

When you log with a compatible tape deck controlled from your Avid editing application, you can enter frame-accurate timecode information from the deck to automate part of the logging process. This method is more accurate than manual entry because you transfer timecodes directly from tape to the bin.

For information about connecting a compatible deck to your system, see “Connecting Cameras, Decks, and Monitors” in the Help.
To log clips directly into a bin from an Avid-controlled deck:

1. Make sure the deck is properly connected and turned on.
2. Open the bin where you want to store the clips.

   The Capture tool opens. The Client monitor displays your video.

4. If the Capture tool is not in Log mode, click the Capture/Log Mode button until the LOG icon appears.

If you forget to connect and turn on the power to the deck before you open the Capture tool, click the Deck Selection menu and select Check Decks to reinitialize the deck control.

4. If the Capture tool is not in Log mode, click the Capture/Log Mode button until the LOG icon appears.
5. Click the Deck Selection menu, and select a deck.
   For more information, see “Selecting a Deck in the Capture Tool” on page 196.

6. Insert your tape into the deck.
   The Select Tape dialog box opens.
   Select “Show other project’s tapes” to display the tape names and associated project names for all bins.

   ![Select Tape dialog box](image)

   Select Tape dialog box. Top: New tape name button. Center: list of tapes. Bottom: Show other projects option.

   Because the media file database does not open when you start your Avid editing application, tape names of all online media files do not appear automatically.

   If the tape name does not appear in the Select Tape dialog box, click the Scan for Tapes button. The system displays tape and project names.

7. Provide the system with a tape name in one of the following ways:
   - Select the name of the tape from the list in the Select Tape dialog box and click OK.
   - Click New if the tape is not in the list. A new tape name line appears in the dialog box. Type the new name and click OK.

   The tape name displays in the Capture tool.

   For guidelines to name tapes, see “Naming Tapes” on page 148.

   A message that the system is waiting for you to mark an IN point displays in the message bar.
8. Use one of the following methods to set either an IN point or an OUT point for the clip you want to log:

- To keep the deck running while you log: Start the deck. At the point where you want to start the clip, click the Mark IN button or press the F4 key. The deck continues to play.

If you want to pause the deck while you enter a clip name and comments, see “Pausing the Deck While Logging” on page 152.

- To cue your source tape: Use the deck controls in the Capture tool to cue your source tape to the start or end point. Click the Mark IN button or the Mark OUT button in the Capture tool.

- To log using timecode: If the footage starts at an IN point or ends at an OUT point, type the timecode in the text box next to the Mark IN button or the Mark OUT button. Then press the Go to IN button or the Go to OUT button to scan the tape forward to the mark.

After you set the mark, the Mark IN button changes to the Mark OUT and Log button or the Mark IN and Log button, depending on the first mark you set.

For NTSC film-to-tape transfer or footage downconverted from 1080p/24, you must log the correct pulldown phase. See “Setting the Pulldown Phase” on page 158 and “Entering Pulldown Information” on page 160.

9. (Option) Enter a clip name and comment in the corresponding text boxes in the Capture tool.

10. To finish logging the clip, do one of the following:

- If the deck is running: Click the Mark OUT and Log button or press the F4 key. The clip logs into the bin and the deck continues to play.
To cue the remaining start or end point: Use the deck controls to locate the start or end point. Click the Mark OUT and Log button or the Mark IN and Log button to set the remaining IN point or OUT points. The clip logs into the bin.

To log using timecode: Type a timecode for the clip’s IN point, OUT point, or duration in the timecode text boxes next to the corresponding icon. Then press the Go to IN button or the Go to OUT button to scan the tape forward to the mark. To log the clip into the bin, click the Log Clip button in the Capture tool.

The clip name highlights in the bin. The system automatically names and numbers the clip, you can rename the clip.

11. (Option) Type a new name in the highlighted area to rename the clip.

You can accept the clip name and proceed with the logging process and change the clip names in the bin at a later time.

12. Repeat these steps until you log all your clips.

While you view the footage, you can continue to update your marks on-the-fly. Click the Mark IN button or the Mark OUT button repeatedly to enter the second mark.

pausing the deck while logging

If the deck is playing while you log clips, you can direct your Avid editing application to pause the deck after you set an IN point and an OUT point. You can then enter the name and comment for the clip you want to log.

To pause the deck while logging:

1. In the General tab of the Capture Settings dialog box, select the “Pause deck while logging” option.

2. Set up your deck and the Capture tool as described in “Logging with Avid-Controlled Decks” on page 148.

3. When you reach the point where you want to start the clip, click the Mark IN button in the Capture tool or press the F4 key. The Mark IN button changes to the Mark OUT button and the deck continues to play.

4. When you reach the point where you want to end the clip, click the Mark OUT button in or press the F4 key again. The Mark OUT button changes to the Log Clip button, and the deck pauses.
5. Type a clip name and comment in the corresponding text boxes in the Capture tool.

6. Click the Log Clip button or press the F4 key.

Your Avid editing application logs the clip in a bin, and the deck starts playing again.

**Using a Memory Mark When Logging**

You can add a memory mark to a particular location on a tape, then use the Go to Memory button to move through the tape to the marked location.

**To use a memory mark for a particular location on a tape:**

- Click the Mark Memory button in the Capture tool to mark the location.
- Click the Go to Memory button to move through the tape to the marked location.
- Click the Clear Memory button to clear the memory mark.

You can add one mark per tape. The memory mark is not stored on the tape. When you remove the tape from the deck and insert another tape into the deck, the mark clears.

**Logging with Non-Avid-Controlled Decks**

You can use the Capture tool to log clips directly into a bin from a source that is not controlled by your Avid editing application. For example, you can log clips from a deck that is not connected to the system, or from handwritten or printed log information for a tape that was previously logged but is not currently available.

For NTSC projects, when you log within the Capture tool, you should leave the deck empty. If a tape remains in the deck, the system determines drop-frame or non-drop-frame from that tape whether or not it matches your tape’s timecode format.

**To log clips directly into a bin from a non-Avid-controlled deck:**

1. If there is a deck connected to the system, eject the tape from the deck.
2. Double-click Deck Preferences in the Settings list of the Project window.

   The Deck Preferences dialog box opens.
3. For NTSC projects, click “When no tape in deck log as” menu, and select Non-Drop-Frame or Drop-Frame.

4. Click OK to close the dialog box.

5. Open the bin where you want to store the clips.


The Capture tool opens.

1. Capture/Log Mode button
2. Channel Selection buttons
3. Message bar
4. Clip Name text box
5. Clip Comment text box
6. Timecode display
7. Generate/Select Device - NTSC
8. Deck Selection menu
9. Source Tape Display button
10. Mark Memory button
11. Go to Memory button
12. Clear Memory button
13. Clear IN and OUT buttons
7. Click the Capture/Log Mode button until the LOG icon appears.

8. Click the Source Tape Display button. A dialog box opens.

9. Click Yes to open the Select Tape dialog box.

10. Double-click the name of the tape in the dialog box, or click New and enter the name of the tape.

11. Click OK.

12. Use the Channel Selection buttons to select the tracks you want to log.

13. Type the start timecode in the Mark IN text box.

14. (Option) Enter a clip name and comment in the corresponding text boxes.

15. Type the end timecode in the Mark OUT text box.

For NTSC film-to-tape transfer or footage downconverted from 1080p/24, you must log the correct pulldown phase. See “Setting the Pulldown Phase” on page 158 and “Entering Pulldown Information” on page 160.

16. Click the Log Clip button.

The clip name highlights in the bin. The system automatically names and numbers the clip, you can rename the clip.

17. (Option) Type a new name in the highlighted area to rename the clip.

You can accept the clip name and proceed with the logging process and change the clip names in the bin at a later time.

18. Repeat these steps until you have logged all your clips.

Understanding the Pulldown Phase

If you log or capture 24-fps sources (film-to-tape transfers, media downconverted from 1080p/24 footage, or both), you can set the pulldown-to-timecode relationship for a transferred tape in the Film and 24p Settings dialog box.

For information about the pulldown process, see “Transfer of 24-fps Film to NTSC Video” on page 1593.
Set Pulldown Phase option in the Film and 24P Settings dialog box

You set this relationship when you select the pulldown phase (sometimes called the pulldown frame or pullin frame), which is the video frame at which the master clip starts. The pulldown phase is designated A, B, X, C, or D. Film labs and transfer houses typically use the A frame to start the transfer.

The illustration shows the relationship between film frames and video frames.
Understanding the Pulldown Phase

Relationship between four film frames (left) and five NTSC video frames (right). On the right, .1 indicates an odd field and .2 indicates an even field.

This setting is not available in matchback projects. However, you can modify the pulldown phase after you log it. See “Entering Pulldown Information” on page 160.

The Set Pulldown Phase setting lets you log, batch capture, and capture-on-the-fly more easily, because the correct pulldown phase of any IN point for a particular tape is automatically determined. Setting the correct pulldown phase prevents inaccuracies in cut lists and matchback EDLs. It also prevents incorrectly captured clips that stutter when you play it in 24p NTSC projects.

For example, if you set the pulldown phase of 00:00:00:00 as A (indicating that the A frame is located at timecodes ending in 0 or 5), any timecode you log calculates its pulldown phase based on the same sync point, regardless of where you set the IN point. If you use the Capture tool to log a clip that starts at 01:00:10:01, your Avid editing application automatically enters B in the Pullin column of the bin. If you capture on-the-fly starting at 01:00:10:01 (a B frame), the system begins to capture at the next A frame, in this case, 01:00:10:05.

The Set Pulldown Phase feature does not work if you capture from a mark IN.

The pulldown-to-timecode relationship might vary from tape to tape, or within the same tape, depending on how the footage was transferred. If you find that a tape requires a different pulldown phase, you can change the setting in the Film and 24p Setting dialog box, or use the Modify Pulldown Phase dialog box before you capture. See “Modifying the Pulldown Phase Before Capturing” on page 163.

For information about fixing an incorrectly logged sync point, see “Modifying the Pulldown Phase After Capturing” on page 292.
Setting the Pulldown Phase

**To set the pulldown phase:**

1. Determine the correct pulldown phase for 00:00:00:00 in one of the following ways:
   - If you capture film-to-tape transfers, check the transfer log.
   - If you capture tapes that have been downconverted from 1080p/24, check what pulldown frame was set for 00:00:00:00 on the deck that performed the conversion.
   - If you still cannot determine the pulldown phase, see “Determining the Pulldown Phase” on page 161.

2. Double-click Film and 24p in the Settings list of the Project window.

3. Select Set Pulldown Phase of Timecode 00:00:00:00 and then click the menu, and select the correct pulldown phase (A, B, X, C, D).

4. Click OK.

Film-Related Log Information

Once you enter or import the basic log information into a bin, you might want to add film-related log information before you capture.

The following are some important requirements for film-based projects:

- The minimum information required for capturing is the data recorded in the Start and End video timecode columns, and the pulldown phase for NTSC transfers, which is noted in the Pullin column (24-fps capture only).

- You can log each reel of film as a separate clip, which corresponds to a single master clip, only if the video transfer of the film reel has continuous pulldown (NTSC format), and continuous timecode (NTSC and PAL). If the film reels for your project do not meet this condition, then you must log each take on a reel of film as a separate clip, which corresponds to a single master clip.

If you log each reel as a separate clip, you can use the F1 and F2 keys to create subclips for each take. See “Creating Subclips While Capturing” on page 267.

- If you want to produce a cut list, or use film-tape-film-tape to recapture, you must log key numbers. You can add key numbers after you capture, before you create the cut list.

- All film and video reference numbers must be in ascending order.

- Continue to log additional film data into the Labroll, Camroll, Soundroll, Scene, and Take columns, or into your own custom columns, as necessary. You can include the information in these columns on the cut lists you create for your edited sequence.
Displaying Film Columns

To display film columns in the bin:

1. Click the Bin View menu at the bottom of the Bin window, and select Film to display all the required film column Titles.

   ![Location of the Bin View menu]

2. To log data under optional Titles (such as Ink Number, Auxiliary TC1-Auxiliary TC5, or Film TC), do the following:
   a. Select Bin > Choose Columns.

      The Bin Column Selection dialog box opens.
   b. Ctrl+click (Windows) or Command+click (Macintosh) the specific Titles you want to add.
   c. Click OK.
3. Create a custom Title to track custom information for the job. To create a new Title, type a name that describes the information in the Titles bar at the top of the bin.

For more information on customizing bin views, see “Saving a Custom Bin View” on page 345.

**Entering Pulldown Information**

To accurately capture NTSC transfer tapes in 24p projects, you need to enter pulldown information into the bin. (This information is not required for PAL transfer tapes.) Setting the correct pulldown phase prevents inaccuracies in cut lists and matchback EDLs. If you import a log generated during the telecine transfer, the pulldown information is automatically included in the bin.

*To import a log file, see “Setting the Pulldown Phase” on page 158.*

If you do not have a transfer log, or if the transfer log is incorrect, you need to add the information manually. If you use the Capture tool to log clips, your Avid editing application uses the A frame as the default pulldown phase. You might need to edit this value.
For 24p projects, you can set a default pulldown phase in the Film and 24p Settings dialog box. See “Setting the Pulldown Phase” on page 158 (24p projects only).

For matchback projects, you need to log key-number information before you can log pulldown information.

If you specify the pulldown phase in the Pullin column, you accomplish the following:

- You ensure that clips start with the correct frame for the pulldown. Otherwise, you might experience inaccuracies in key-number tracking and in the cut lists.
- You indicate where the pulldown fields are located so your Avid editing application can accurately eliminate the pulldown fields during capture. This leaves you with a frame-to-frame correspondence between your digital media and the original 24-fps footage (24p projects only).

To do this, you must indicate whether the sync point at the start of each film clip transferred to tape is an A, B, C, or D frame, as described in “Determining the Pulldown Phase” on page 161 and “Modifying the Pulldown Phase Before Capturing” on page 163.

In most cases, the sync point is the A frame.

![Start timecode column (left) and Pullin column (right) in the bin](image)

**Determining the Pulldown Phase**

It is easiest to determine the pulldown of a sync point (or pulldown phase) if you ask your film lab to keypunch (cut a small hole in) the sync frame at the zero frame in the original film footage before you transfer the film to video. Many film labs or transfer houses can also provide a pulldown frame indicator which displays at the far right of the burn-in key numbers, depending on the equipment available. The A-frame pulldown coincides with timecode ending in 0 and 5 (:00, :05, :10, and so on).
If you have not keypunched your footage, you can determine pulldown according to clapsticks or any other distinctive frame at the beginning of the clip. It is easier to determine the pulldown if the frames depict motion.

For instructions on how to modify the pulldown phase, see “Modifying the Pulldown Phase After Capturing” on page 292.

To determine the pulldown phase:

1. While you view the video transfer on a monitor, go to the keypunched (or clapsticks) sync point for the beginning frame of the clip you logged.

2. Use the step wheel on the tape deck to step (jog) past the sync point frame field-by-field. You will see either two or three keypunched fields. If the footage is not keypunched, look for two or three fields with little or no motion.

3. If there are two fields, the pulldown is either A or C. Step through the fields again, and note where the timecode changes:
   - If the timecode does not change from the first to the second field, the fields came from an A frame.
   - If the timecode changes from the first to the second field, the fields came from a C frame.

The illustration shows a keypunch on the A frame. Notice where the timecode changes.

4. If there are three keypunched fields, or fields without motion, the pulldown is either B or D. Step through the fields again and note where the timecode changes:
   - If the timecode changes from the second to the third field, the fields came from a B frame.
- If the timecode changes from the first to the second field, the fields came from a D frame.

5. Enter or edit the information in the Pullin column in the appropriate bin, as described in “Modifying the Pulldown Phase Before Capturing” on page 163.

**Modifying the Pulldown Phase Before Capturing**

After you determine the correct pulldown phase (as described in “Determining the Pulldown Phase” on page 161) you can modify the pulldown phase before you capture in one of the following ways.

**To modify the pulldown phase directly in the Pullin column:**
1. In the Bin, click the Text tab to display all bin information.
2. Click the cell you want to modify.
3. Click the cell again.
   The pointer changes to an I-beam.
4. Type the pulldown phase and press Enter (Windows) or Return (Macintosh).

**To modify the pulldown phase for multiple clips:**
1. Ctrl+click (Windows) or Command+click (Macintosh) the clips you want to modify.
2. Select Clip > Modify.
3. Click the Modify Options menu, and select Set Pull-in.
4. Select A, B, C, or D.
5. Click OK.
   The pullin for all selected clips changes, based on the pulldown phase you select.

**To modify the pulldown phase for multiple clips that have the same pulldown-to-timecode relationship:**
1. Ctrl+click (Windows) or Command+click (Macintosh) the clips you want to modify.
2. Select Clip > Modify Pulldown Phase.
   The Modify Pulldown Phase dialog box opens.
3. Click the menu, and select the correct pulldown phase for timecodes ending in 0 or 5.

4. Click OK.

   The pulldown phase for each selected clip changes, based on the pulldown phase you select for 00:00:00:00.

   The Pulldown Phase setting also appears in the Film and 24p Settings dialog box (24p projects only). You can override that setting with the Modify Pulldown Phase dialog box. The selection in the Film and 24p Settings dialog box remains the same. For more information, see “Setting the Pulldown Phase” on page 158.

   If you want to modify the pulldown phase after you capture, you must first unlink the clips. See “Modifying the Pulldown Phase After Capturing” on page 292.

   After you capture an NTSC transfer, the timecode shows a loss of every fifth frame of video. For example, if you find that your timecode jumps at one point from 1:00:14:15 to 1:00:14:17, you haven’t lost a frame, just an extra pulldown field.

**Entering Frames-per-Second Rates for PAL Transfers**

When you log in advance for PAL film-to-tape transfers, you must log the footage as clips that have a 25-fps play rate, as listed in the FPS column of the bin. You can capture the footage on-the-fly, without logging the clips first. The minimum information required to capture the footage is the data logged in the Start and End video timecode columns.

**Entering Key Numbers**

You can enter your own custom key numbers for all clips (including captured, imported, and file-based clips) in the KN Start column in the bin.

*To add key numbers:*

- Highlight the KN Start column. Use one of the following formats and type the key number for the sync point at the start of the clip:

  - **Keykode™ Format:** Type a two-character manufacturer and film-type code, a six-digit prefix for identifying the film roll, a four-digit footage count, a two-digit frame offset, and then press Enter (Windows) or Return (Macintosh).

    Your Avid editing application adds a space, hyphen, and either a plus sign (for 35mm projects) or an ampersand (for 16mm projects) to format the number. For example, in a 35mm project, to enter KJ 23 6892-1234+15, type KJ236892123415. In a 16mm project, if you type the same number results in the code KJ 23 6892-1234&15.

  - **Other Formats:** Enter other key-number formats in the Ink Number column. Type up to eight characters for the prefix, up to five characters for the footage count, two digits as the frame count, and then press Enter (Windows) or Return (Macintosh).
The Avid editing application automatically calculates the ending key number (KN End), based on the timecode duration.

⚠️ Make sure the correct number appears when you press Enter (Windows) or Return (Macintosh). For key-number formats other than Keykode, you might need to type the space, hyphen (-), and plus sign (+) or ampersand (&) to format the number correctly.

⚠️ Modifying tape names and timecodes affect any key numbers you enter for the selected clips.

### Entering Additional Timecodes

You can enter custom timecodes for all clips (including captured, imported, and file-based clips) in the Auxiliary TC and Sound TC columns in the bin.

**To enter additional timecodes:**

1. In one of the Aux TC columns (Aux TC1 through Aux TC5), type an auxiliary timecode that syncs with the video timecode logged in the Start column.

   You can enter up to five auxiliary timecodes. Supported timecodes depend on your project: 30-fps for NTSC (drop-frame or non-drop-frame) and 25-fps for PAL. Use one of the following formats:
   - Enter a two-digit format for hours, minutes, seconds, and frames. You do not need to enter a leading zero. (For example, to enter 01:23:02:00, type 1230200.)
   - When you work with drop-frame timecode in the NTSC format, enter a semicolon to indicate drop-frame timecode (for example, to enter 01;23;02;00, type 01;230200).

2. In the Sound TC column, enter the Nagra or DAT timecode for the original audio for the start of the clip.

   The timecode should sync with the video timecode logged in the Start column in the bin.

3. Enter the source sound-roll identifier in the Soundroll column.

   Supported timecodes depend on your project: 30-fps for NTSC (drop-frame or non-drop-frame) and 25-fps for PAL. The clip you capture must contain an audio track.

4. In the Film TC column, enter timecode generated by a film camera (using Aaton or Arri timecode) for tracking the picture at the start of the clip.

   The film timecode should sync with the video timecode logged in the Start column. Avid supports only 24-fps timecode. The clip you capture must contain a video track.

5. In the TC24 column, enter timecode for original HDTV sources (1080p/24) or audio DATs created for PAL feature film productions that use in-camera timecode.

You can use the Duplicate command to convert timecodes from one format to another. For more information, see “Duplicating Bin Columns with Timecode Information” on page 363.
**Entering Ink Numbers**

**To enter ink numbers:**

1. In the Project window, click the Settings tab.
2. Double-click Film and 24p.
   The Film and 24p Settings dialog box opens.
3. Make sure the correct options are selected for ink number format and ink number display, and click OK.
   You can log different ink number formats in the same project as long as you change the ink number setting to the appropriate format before you log each type. Changing the ink number setting affects only the next ink numbers you log, not numbers you already logged.
4. Return to the bin and enter numbers under the Ink Number Title.

   For example, use Keykode format or use a two-digit prefix to identify the roll, a hyphen, a four- or five-digit footage count, a plus sign, and a two-digit frame count (for example, AA-00924+00).

**Exporting Shot Log Files**

You can export a shot log file from your Avid editing application in one of two formats to make adjustments in a text editor or to import into another system.

**To export a shot log based on clip information in a bin:**

1. Open the bin which contains the clips you want to export. If necessary, click the Text tab to display all clip information.
2. Click a Clip icon to select it.
3. Ctrl+click (Windows) or Command+click (Macintosh) each additional clip you want to export.
4. Select File > Export.
   The Export As dialog box (Windows) or Destination dialog box (Macintosh) opens with a default file name in the File name text box (Windows) or Export As text box (Macintosh), based on the file type.
5. Do one of the following to select the Export setting:
   - If you previously created an Export setting for exporting shot log files, click the Export menu, and select the setting. Then, go to step 10.
   - If you want to review or edit Export settings, go to step 6.

For information on creating Export settings, see “Customizing Export Settings” on page 1032.
6. Click Options.
   The Export Settings dialog box opens.

7. Click the Export As menu, and select one of the following:
   - Select Avid Log Exchange to export the selected bin as a shot log file that complies with ALE specifications.
   - Select Tab Delimited to export the selected bin as a tab-delimited ASCII text file.
   ALE and tab-delimited files include information for master clips and subclips only. Information for other objects, such as group clips, sequences, and precomputes, is not included.

8. To modify an existing setting, select Save.

9. To save the setting with a new name, select Save As and type a name in the dialog box that opens.
   The system adds the Export Setting name to the list of formats available from the Export dialog box.

10. Click Save to close the Export As dialog box (Windows) or the Destination dialog box (Macintosh).

11. (Option) Change the file name. In most cases, keep the default file name extension.

12. Select the destination folder for the file and click Save.
   The file exports and appears at the selected destination.

**To export an entire bin:**

1. Ctrl+click selected clips to deselect them, so that nothing is selected in the bin.

2. Select File > Export.
   The Export Bin As dialog box opens.

3. Click the Export Bin As menu, select the appropriate option, and click OK.
   The system creates a shot log of only the master clips in the bin.
The chapter provides information on preparing your Avid editing application and your capture hardware before you capture media.

- Logging and Shot Logs
- Importing Shot Log Files
- Preparing the Hardware for Capture
- Selecting Settings for Capture
- Configuring Decks
- Connecting a DV Device
- Setting Up the Capture Tool
- Preparing to Capture Audio
- Preparing to Capture Video
- Capture Preparations Check List

## Logging and Shot Logs

Logging is the process of entering information about source material into bins at the beginning of the editing workflow. A shot log is a text file that lists information about a roll of film or a videotape, usually in chronological order.

You can get information into your bins either by importing a shot log file or by entering the information directly. You can log automatically or manually, either before capturing or while capturing.

Logging provides your Avid editing application with frame-accurate clip information (such as starting and ending timecodes). Your Avid editing application uses this information to capture the source footage and as the foundation for organizing, tracking, storing, retrieving, and generating lists of edit information throughout your project.

You can import any shot log that meets Avid log specifications. You can also combine or merge events while importing a log so that fewer master tapes require capturing. Your system imports any additional information logged with each clip. For more information, see “Avid Log Specifications” on page 137 and “Importing Shot Log Files” on page 169.
For film projects, most telecine and other film-to-tape transfer systems generate a log that you can import directly to the bin.

For information about logging into a bin, see “Logging Directly into a Bin” on page 147. For information about logging and capturing at the same time, see “Capturing and Logging at the Same Time” on page 233.

Importing Shot Log Files

You can import a shot log file into a bin to make clip information such as start and end timecode available to your Avid editing application. For more information, see “Logging and Shot Logs” on page 168.

To import shot log files into a bin:

1. If you have created Import settings for importing shot log files, select the Import setting you want to use from the Settings list.

   For more information, see “Creating and Modifying Import Settings” on page 298.

2. Do one of the following to identify the bin in which you want to store the imported files:
   - Open a bin from the Project window.
   - Click anywhere in an open bin to select it.
   - Create a new bin.

   For more information, see “Opening and Closing Bins” on page 90 and “Creating a New Bin” on page 89.

3. Select File > Import.

   The Select Files to Import dialog box opens.
Look in menu (top) and Files of type menu (bottom) in the Select files to import dialog box on Windows.
Enable menu (top) and From menu (bottom) in the Select files to import dialog box on Macintosh.

4. (Option) If you want to select options for combining events on import, click Options to open the Import Settings dialog box. Select the appropriate options from the Shot Log tab, and then click OK to close the Import Settings dialog box and return to the Select Files to Import dialog box.

For information on Import settings, see “Import Settings” on page 1502. You can also view this information by clicking the dialog box and pressing the F1 key (Windows) or the Help key (Macintosh).

5. Do one of the following:
   - If you are importing an .ale file, click the Files of type menu and select Shot Log (Windows), or click the Enable menu and select Shot Log Documents (Macintosh).
   - If you are importing a text file or batch importing multiple file types, click the Files of type menu and select All Files (Windows), or click the Enable menu and select Any Documents (Macintosh).

   When batch importing multiple files and file types, you should establish global Import settings in advance. See “Creating and Modifying Import Settings” on page 298.

6. Use the Look in menu (Windows) or the From menu (Macintosh) to locate the folder containing the source file.

7. Select the source file from the list and click the Open button.
Preparing the Hardware for Capture

Your source material can originate from a videotape (or other recording media such as P2 memory cards), a digital audiotape (DAT), a compact disc (CD), an in-house router, a tuner, or straight off-the-air, with the proper hardware configuration.

For information on connecting your equipment, see one of the following topics in the Help:

- Using Avid Input/Output Hardware
- Setting Up Your Software-Only Avid Editing System

For information on connecting your equipment, see “Using the Avid Input/Output Hardware” in the Help.

You should check the items described in the following table before capturing:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sync source</td>
<td>An external sync source is not required for capturing video or audio with video. Avid recommends using an external sync source for output. For more information, see “Selecting the Sync Source for Output” on page 1055. Avid Nitris DX or Avid Mojo DX requires that the deck and the input/output hardware are genlocked to the same timing source when capturing or outputting a digital cut using the Avid Nitris DX or Avid Mojo DX.</td>
</tr>
<tr>
<td>Audio-only input</td>
<td>Sync is needed for audio-only input. For more information, see “Establishing Sync for Audio-Only Input” on page 174.</td>
</tr>
<tr>
<td>Client monitor</td>
<td>Before you begin capturing and editing, set up your NTSC or PAL Client monitor by using a color-bar generator (or house pattern) and lock in those settings, if you have not done so already. See “Connecting Cameras, Decks, and Monitors” and “Playing Video to the Client Monitor” in the Help.</td>
</tr>
<tr>
<td>16:9 format</td>
<td>You can edit with video in the 16:9 aspect ratio for display of wide-screen formats. To view the footage on a Client monitor, you must have a 16:9-compatible Client monitor.</td>
</tr>
<tr>
<td>Remote switch</td>
<td>You must set the deck control switch on the front of the source deck to Remote rather than Local to control the deck with the Capture tool.</td>
</tr>
<tr>
<td>DAT (digital audiotape)</td>
<td>When capturing from DAT, you might need to select an appropriate sync setting. For more information, see “Establishing Sync for Audio-Only Input” on page 174.</td>
</tr>
</tbody>
</table>
Preparing the Hardware for Capture

Getting Information About Striped Drives

Avid maintains information about striping drives that is available through Avid online support. For more information, see “Storage Options and Drive Striping” in the Help.

To get information about striped drives:
2. Search for “Drive Striping Tables.”

Selecting the Sync Source for Capture

Avid Nitris DX requires that the deck and the AvidNitris input/output hardware are genlocked to the same timing source when capturing using the Avid Nitris DX. You can use one of the following sources as sync, depending on your project format:

- Black burst or house sync through the reference input (REF) of the Nitris hardware
- Tri-level sync through the HD TRILEVEL SYNC input of the Nitris hardware

If the source you select is not correctly connected, or if the sync generator is set to an incorrect frame rate, your Avid editing application might end the capture with an error message. Also, the start frame might be inaccurate when capturing using serial deck control and the resulting clip will be off by one frame.

For a list of sync options for each format, see “Sync Options for HD Formats” on page 1056.

For information on selecting the sync source in preparation for output, see “Selecting the Sync Source for Output” on page 1055.

To select the sync source:
1. Select Tools > Video Output Tool.
2. Select the sync source from the Sync Lock menu: Reference or Tri-Level.
   - Tri-Level appears only if you are working in an HD project.

Striped drives

If you are capturing media at high resolution, you must use striped drives. See “Storage Options and Drive Striping” in the Help and “Getting Information About Striped Drives” on page 173.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description (Continued)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Striped drives</td>
<td>If you are capturing media at high resolution, you must use striped drives. See “Storage Options and Drive Striping” in the Help and “Getting Information About Striped Drives” on page 173.</td>
</tr>
</tbody>
</table>
Preparing the Hardware for Capture

To check the sync source, do one or both of the following:

1. Check the lights on the front of the Avid Nitris.
   If the Avid Nitris is locked to a valid sync signal, the Lock light and either the HD REF or SD REF light are constantly on. For more information, see “Avid Nitris Front Panel” in the Help.

2. Check the Video Lock icon or the Ref Lock icon in the Capture tool.
   For more information, see “Setting the Video and Audio Input in the Capture Tool” on page 200.

Establishing Sync for Audio-Only Input

When you capture audio with video, the video input signal provides the timing reference for capturing analog audio. This ensures that the audio and video remain in synchronization.

When you capture audio only, the audio timing reference is taken from the same source as the video output timing. You set the sync source for capture and output timing through the Video Output tool. For more information about connecting a reference signal, see “Selecting the Sync Source for Output” on page 1055.

If you are capturing audio only, and the audio must be resynchronized with video, you must make sure that the audio captured remains synchronized with the associated video. There are several cases to consider, depending on whether the input is analog or digital, and (in the case of digital input with some Avid input/output hardware) whether sample rate conversion is involved.

Analog Audio Input

If you are capturing audio-only from an analog source, sync is taken from the sync source, either black burst or tri-level, depending on the selection in the Video Output tool. If no sync source is connected, sync is generated from internal timing.

With some Avid input/output hardware, you can view the selected sync source in the Hardware tab of the Audio Project settings dialog box, in the Sync Mode field. To be sure you see the correct sync source, view the Audio Project settings with the Capture tool active, or with channels armed for passthrough in the Audio tool.

If you need to synchronize audio with video clips captured separately, Avid recommends that you connect a sync source to both your Avid input/output hardware device and the audio deck. Otherwise you might experience drifting of the audio during editing.
Digital Audio Input

Digital audio inputs (ADAT, AES/EBU, S/PDIF, and SDI Embedded Audio) provide their own timing reference. If sample rate conversion is not available on your system, or you have disallowed it by selecting “Never” in the Input tab of the Audio Project settings, no other connections are required to achieve sync, so long as the source deck is genlocked.

When using the AES/EBU inputs, your system uses the lowest numbered channel that is enabled for input in either the Capture tool or the Audio tool as the timing reference. When sample rate conversion is not in use, it is important that you lock all AES/EBU inputs that are used simultaneously to the same timing reference.

If the digital media sample rate is different from the project sample rate, and sample rate conversion is available on your system, and you have allowed sample rate conversion by selecting “When Needed” in the Input tab of the Audio Project settings, then sample rate conversion is running in your Avid input/output hardware. In this case, the output of the sample rate conversion uses a sync source under the same rules described above for analog capture.

If you need to synchronize audio with video clips captured separately, Avid recommends that you connect a sync source to both your Avid input/output hardware and the audio deck to prevent drifting of the audio during editing, even when capturing digitally. This will ensure synchronization even if sample rate conversion is required.

If sample rate conversion is available on your system, the background color of the I (IN) button in the Audio Tool informs you of the status of each digital input. If the background color is yellow, the input is not connected (no valid clock is detected). If the background is blue, the input is valid and no sample rate conversion is in use. If the background is green, the input is valid but a sample rate converter is in use. If you mouse over the I button, a reminder of how to interpret the color appears.

For more information about sample rate conversion, see “Selecting the Audio Sample Rate and Controlling Audio Sample Rate Conversion” on page 208 and “Audio Sample Rate Conversion” on page 835.

When using the AES/EBU inputs, if channels 1 and 2 do not require sample rate conversion, none of the other inputs have sample rate conversion applied. However, if channels 1 and 2 are not in use, you can convert higher numbered channels to match the rate of the lowest numbered channel, if the Audio Project settings allow sample rate conversion.
Selecting Settings for Capture

Capture settings include options for capturing, batch capturing, auto capturing, capturing to multiple media files, DV or HDV scene extraction, and setting key commands. Several settings directly affect the capturing process. This section includes information on Media Creation settings.

For reference information about all settings in the Capture Settings dialog box, see “Capture Settings” on page 1446. For information about locating and modifying settings, see “Viewing and Modifying Settings” on page 1421. You can also view information about settings by clicking a window or dialog box and pressing the F1 key (Windows) or the Help key (Macintosh).

In the MXF Media Type tab or the OMF Media Type tab of the Capture Settings dialog box, review the setting for “Maximum (default) capture time.” This setting limits the length of capture-on-the-fly and capture from an IN point without an OUT point. The default setting is 30 minutes. For more information, see “Capture Settings” on page 1446.

Selecting Video Resolutions and Media Drives

The Media Creation dialog box lets you set the video resolution and select drives for capturing, creating titles and motion effects, importing, and performing audio, video and data mixdowns.

For detailed resolution specifications, see “Resolution Specifications” on page 1559.

You can also select a video resolution and select drives directly in the Capture tool, the Save Title dialog box, the Select Files to Import dialog box, the Audio Mixdown dialog box, the Data Mixdown dialog box and the Video Mixdown dialog box. The Media Creation settings automatically change to the resolution and drives you select.

To select a video resolution and media drives:

1. Do one of the following:
   - Double-click Media Creation in the Settings list.
   - Select Tools > Media Creation.

   The Media Creation dialog box opens.

2. Click the Media Type tab, and select either OMF or MXF file format.

   If your project uses an HD resolution, you cannot select OMF as a file format. MXF is selected by default.

   For more information on the media file formats, see “Using the MXF AMA Plug-In” on page 464 and “Specifications for Importing OMFI Files” on page 1547.
Symphony Option performs substantially better with Avid Nitris input/output hardware when it uses MXF 1:1 video instead of OMF 1:1. The video format used in MXF 1:1 video files is the same as the native format used by the Nitris hardware, which allows the system to play more streams of video and render effects faster.

3. Click the Capture tab.

4. Click the Video Resolution menu, and select a video resolution.

   The Video Resolution menu contains a list of the available resolutions, which depend on such factors as the model of your Avid editing application, your Avid input/output hardware, and your project format.

   For HDV projects, no video resolutions are available for capture, because your Avid editing application automatically selects the correct resolution. For 720p HDV projects, Avid DNxHD and DVCPro HD resolutions are listed for other media creation. For 1080 HDV projects, DNxHD-TR resolutions are available for other media creation.

   You can restrict the number of video resolutions available to simplify this step. For more information, see “Disabling Video Resolutions” on page 178.

5. Select a video drive and an audio drive. To select the same drive for both video and audio, click the Single/Dual Drives Mode button until only a single drive menu opens.

The drive that appears in boldface type has the most available space.
6. (Option) You can select drives and create a drive group. Click the Target Drive menu, and select Change Group. For more information on selecting a drive group, see “Selecting the Target Drives” on page 204.

Because no audio is associated with titles or motion effects, you can select only a video drive in the Titles or the Motion Effects tab of the Media Creation dialog box.

7. To apply your video resolution and drive selection to all the Media Creation tabs and the rest of your Avid editing application, click Apply to All.

This sets your selected video and audio drives for all the Media Creation tabs. It also sets them for any place in your Avid editing application where you select drives. Your settings are not saved until you click OK.

8. Click OK to save your settings.

For more information about options, see “Media Creation Settings” on page 1512. You can also view this information by clicking the dialog box and pressing the F1 key (Windows) or the Help key (Macintosh).

**Disabling Video Resolutions**

To simplify the options for media creation, you can use a text file to restrict the resolutions available for capturing, rendering, or importing. If you disable resolutions for media creation, you can still play, export, or perform a digital cut in those resolutions.

**To disable resolutions:**

1. Select Tools > Media Creation.

   The Media Creation dialog box opens.

2. Click one of the tabs that includes a Resolutions menu, and note the exact spelling of each resolution you want to disable.
3. Open a text file by doing one of the following:

- (Windows) Click the Start menu, and then select All Programs > Accessories > Notepad.
- (Macintosh) Click Go > Applications, and double-click TextEdit.

![This file must be a plain text file. On a Windows system, use Notepad. Do not use Wordpad. On a Macintosh system, select TextEdit > Preference > Plain Text. Other files might introduce characters that your Avid editing application cannot recognize.](image)

4. Type each resolution you want to disable on a separate line. Do not include OMF or MXF.

![DisabledRes.txt examples on Windows (left) and on Macintosh (right)](image)
The text of the resolution must exactly match the text in the Media Creation dialog box. To disable DV 25, for example, type \texttt{DV 25 411} with DV in capital letters. Do not disable all resolutions supported by your Avid editing application. You need to keep one resolution available.

5. (Windows) Name and save the file:
   a. Select File > Save As.
   b. Type DisabledRes in the File Name text box.
   c. Navigate to Program Files > Avid > Avid editing application.
   d. Click Save and close Notepad.

6. (Macintosh) Name and save the file:
   a. Select File > Save As.
   b. Type DisabledRes.txt in the File Name text box.
   c. Navigate to Applications > Avid editing application.
   d. Click Save and close TextEdit.

7. If a project is open, close the Project window and open the project again.

   Your Avid editing application reads the DisabledRes.txt file when it opens a project and removes the listed resolutions for all projects and all users.

To enable the resolutions you disabled:

- Navigate to the location of the DisabledRes.txt file and delete it.

**Setting Drive Filtering**

Your Avid editing application lets you select any drive on your system to use for media storage. However, high-quality resolutions require striped drives.

Because media files are very large, you can filter drives that are not suitable for media storage out of the list of available drives. Filtering drives in this way provides you with a convenient way to store media only on drives with sufficient space.

*If you are working in a network environment, see “Drive Filtering in Networked Workflows” on page 125.*

*Your Avid editing application does not prevent you from using non-Avid drives, but Avid cannot ensure their reliability.*
To set drive filtering in the Media Creation dialog box:

1. Do one of the following:
   - Double-click Media Creation in the Settings list.
   - Select Tools > Media Creation.
   The Media Creation dialog box opens.

2. (Option) Click the Drive Filtering & Indexing tab.

   **Options for indexing local drives apply only in an Avid Interplay™ environment. For more information, see the Avid Interplay Software Installation Guide.**

3. Select one or more drives to filter out:
   - Select Filter Network Drives Based on Resolution to remove those network drives that cannot support, or handle playback of, the selected resolution.
   - Select Filter Out System Drive to remove the drive on which the operating system resides.
   - Select Filter Out Launch Drive to remove the drive on which your Avid editing application resides.

   The drive or drives you filter out do not appear in the other Media Creation tabs as possible locations where you can store media. They also do not appear in other drive selection menus in your Avid editing application except for the Import, Export, and Relink dialog boxes.

   **Your settings are not saved until you click OK.**

4. Click OK to save your settings.
For more information about options, see “Media Creation Settings” on page 1512. You can also view this information by clicking the dialog box and pressing the F1 key (Windows) or the Help key (Macintosh).

### Selecting Settings for Preroll Method and for Capturing Across Timecode Breaks

If the tape you are capturing contains breaks in the timecode, you can use two settings in the General tab of the Capture Settings dialog box to capture across the timecode breaks.

**To select settings for capturing across timecode breaks:**

1. Double-click Capture in the Settings list of the Project window.
   
The Capture Settings dialog box opens.
2. Click the General tab.
3. Click the Preroll Method menu, and select one of the following methods.

<table>
<thead>
<tr>
<th>Preroll Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Best Available</strong></td>
<td>Your Avid editing application first checks the tape for timecode to use for preroll. If there is no timecode, or not enough timecode, your Avid editing application uses the control track for preroll. If there is not enough control track for preroll, your Avid editing application adjusts the specified preroll time to accommodate the amount of valid control track available. If the adjusted preroll time is too short to sync lock at the IN point, your Avid editing application does not capture the shot and displays an error message. After your Avid editing application adjusts the preroll to the individual shot, it returns to using the user-specified preroll time until it needs to adjust the time again. Use this method to capture material as automatically as possible. As the system makes multiple attempts to preroll, this method is slower at times but almost always performs the preroll without interruption. This is the default setting.</td>
</tr>
<tr>
<td><strong>Standard Timecode</strong></td>
<td>Your Avid editing application uses timecode to determine the preroll point. If there is not enough consecutive timecode (for example, if there is a break in the timecode), your Avid editing application does not capture the shot and displays an error message. Use this method if you know the timecode is consecutive or if you want to determine if there are timecode breaks.</td>
</tr>
</tbody>
</table>
Selecting Settings for Capture

4. Select or deselect “Capture across timecode breaks.”

When you select this option, your Avid editing application begins capturing a new master clip at each timecode break. Select this option when you are performing an unattended batch capture or autocapture. Deselect this option if you plan to capture the entire tape as a single clip by capturing to multiple media files. See “Capturing to Multiple Media Files” on page 183.

5. Click OK.

Capturing to Multiple Media Files

You can capture video and audio to multiple media files across multiple drives. MXF is automatically captured to multiple files. OMF® is captured to multiple files when you set an option in the Capture Settings dialog box.
Selecting Settings for Capture

Capturing to multiple media files has the following advantages:

- You can create longer clips whose media files would otherwise exceed the file size limitation of 2 GB.
- You can group all drives with the multiple file options. This enables your Avid editing application to capture long clips continuously, for example, satellite feeds.
- Your Avid editing application makes more efficient use of drive space, particularly when capturing long clips.

For media file management purposes, any clip whose media exceeds the 2-GB limit has more than one media file associated with it.

For more information on managing media files, see “Managing Media Files” on page 467.

To capture video or audio to multiple OMF media files:

1. Verify that OMF is selected in the Media Type tab of the Media Creation dialog box.
2. Double-click Capture in the Settings list of the Project window.
3. Click the OMF Media Files tab.
4. Select “Capture to multiple files.”
   
   For information about other options, see “Capture Settings: OMF Media Files Tab” on page 1449.
5. Click OK.
   
   The Capture tool opens.
7. To capture to multiple files across drives, click the Target Drive menu in the Capture tool, and select Change Group.
   
   The Drive Group dialog box opens.
8. Ctrl+click (Windows) or Command+click (Macintosh) multiple drives to include in the capturing session, or click the All button to select all drives.

   If you click Clear, your Avid editing application removes all selections. You must select at least one drive before you can click OK to exit the dialog box.
9. Click OK.
10. Proceed with capturing.

General Settings for Capture

The General Settings dialog box includes the following options that are relevant to capture.
Capture-Related Settings for Film and 24p Projects

The following settings are important when you are capturing video transferred from film or capturing 24p video. You should specify these settings for film or 24p projects immediately after you create a new project and before capturing. For information about other film settings, see “Film and 24P Settings” on page 1494.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Type</td>
<td>The top portion of the dialog box displays the project type (NTSC or PAL) and other useful information such as the type of film used as source media.</td>
</tr>
<tr>
<td>NTSC Has Setup</td>
<td>This option applies to standard NTSC format and is selected by default. If the source footage is in the NTSC-EIAJ format standard (used primarily in Japan), deselect NTSC Has Setup.</td>
</tr>
</tbody>
</table>

For information about other settings in the General Settings dialog box, see “General Settings” on page 1499. For information on opening the General Settings and other settings dialog boxes, see “Viewing and Modifying Settings” on page 1421.
### Film and 24P Setting - Current

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit Play Rate</td>
<td>24 fps</td>
</tr>
<tr>
<td>Master Default Film Type</td>
<td>35mm, 4 perf (16 frames/ftun)</td>
</tr>
<tr>
<td>Master Default Edge Type</td>
<td>Edgecode (4+2 format)</td>
</tr>
<tr>
<td>Ink Number Default Film Type</td>
<td>35mm, 4 perf (16 frames/ftun)</td>
</tr>
<tr>
<td>Ink Number Default Edge Type</td>
<td>Edgecode (4+2 format)</td>
</tr>
<tr>
<td>Auxiliary Ink Default Film Type</td>
<td>35mm, 4 perf (16 frames/ftun)</td>
</tr>
<tr>
<td>Auxiliary Ink Default Edge Type</td>
<td>Edgecode (4+2 format)</td>
</tr>
</tbody>
</table>

### Audio Transfer Rate

- **Audio Transfer Rate**: Film Rate (100%)

Use this mode when your 24 fps film footage has been trans
Selecting Settings for Capture

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video Pulldown Cadence</td>
<td>Lets you specify how your Avid editing application handles pulldown frames:</td>
</tr>
<tr>
<td></td>
<td>- Video rate, no pulldown: Select this option when capturing 24-fps footage that was transferred MOS (roughly translated as “without sound”) to 30 fps by speeding up the film, and the audio was brought into your Avid system separately at 100 percent of the actual speed.</td>
</tr>
<tr>
<td></td>
<td>- Standard 2:3:2:3 pulldown: Select this option when capturing 24-fps footage that was transferred to 30 fps by duplicating frames (pulldown) and the audio is synchronized to the picture.</td>
</tr>
<tr>
<td></td>
<td>- Advanced 2:3:3:2 pulldown: Select this option when capturing 24-fps footage that was recorded to 60 fields (NTSC) using Advanced Pulldown and the audio is synchronized to the picture. Select this option when using native DV editing with capture over Firewire.</td>
</tr>
</tbody>
</table>

If you are capturing sound that was created during an NTSC film-to-tape transfer, set the pulldown switch before you begin capturing. See “Setting the Pulldown Switch” on page 201.

For NTSC projects, you can mix footage transferred with pulldown and footage transferred without pulldown (video rate). You can also mix sound transferred at 0.99 (with pulldown) and 1.00 (without pulldown).

Audio Transfer Rate

When you create a 24p PAL film project, you define the audio transfer rate in the New Project dialog box. (You do not need to do this for a 25p PAL project because there is no film speedup during the transfer.) You need to keep the audio transfer rate constant for the project. However, if there is a specific element that you need to capture at a different rate, you can change the rate to one of the following options:

- Film Rate (100%): Select this option when your 24-fps film footage was transferred MOS to 25 fps by speeding up the film, and the audio comes in separately at 100 percent of the actual speed (PAL Method 2).
- Video Rate (100%+): Select this option when your 24-fps film footage was transferred to 25 fps by speeding up the film, and the audio is synchronized to the video picture. This means that the audio speed is increased by 4.1 percent (PAL Method 1).

For PAL 24p projects, you can mix audio that has been transferred at 4.1 percent speedup (video rate, PAL Method 1) with audio that has not been transferred (film rate, PAL Method 2). However, Avid does not recommend this. See “Audio Transfer Options for 24p PAL Projects” on page 1596.

*The Info tab in the Project window lets you view the audio transfer rate you selected when you created the project. The actual audio transfer rate might be different from the display if you change the audio transfer rate in the Film and 24p Settings dialog box.*
Configuring Decks

Deck Configuration settings let you establish deck control parameters for a single deck or for multiple decks. You can create multiple versions, allowing you to select among them for frequent changes in hardware configurations.

Deck Configuration settings and global deck control preferences appear as separate items (Deck Configuration and Deck Preferences) in the Settings list in the Project window.

For information on setting Deck Preferences, see “Deck Preferences Settings” on page 1462. You can also view this information by clicking the dialog box and pressing the F1 key (Windows) or the Help key (Macintosh).

### Configuring Decks

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio Source TC Rate</td>
<td>Lets you specify the digital audiotape (DAT) timecode format: either 30 fps or 29.97 fps (NTSC only). This timecode format must conform to the timecode format on your original DAT tapes. This setting is active when capturing audio only. This setting does not appear in 23.976 projects.</td>
</tr>
<tr>
<td>Set Pulldown Phase of Timecode</td>
<td>Lets you set a default pulldown phase for a 24p NTSC project. See “Setting the Pulldown Phase” on page 158.</td>
</tr>
</tbody>
</table>

### Configuring a Deck or Multiple Decks

**To configure a deck or multiple decks:**

1. Verify that you have manually configured the appropriate hardware connections for the deck or decks.
2. Double-click Deck Configuration in the Settings list in the Project window. The Deck Configuration dialog box opens.
3. Click the Add Channel button.

The Channel dialog box opens.

Channel refers to the signal path for deck control, whether directly through a serial port, through a V-LAN® VLXi system connected to a serial port, or through a FireWire® connection. A direct serial port or FireWire connection allows one deck for each channel, while a V-LAN VLXi system allows multiple decks.

4. Click the Channel Type menu, and select one of the following items, depending upon your system configuration:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FireWire</td>
<td>Use if you are controlling a DV camera or deck through a FireWire connection.</td>
</tr>
<tr>
<td>Direct</td>
<td>Use if you are controlling a deck through an RS-422 connection to the serial port.</td>
</tr>
</tbody>
</table>
5. Click the Port menu, and select one of the following items:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>VLAN VLX</td>
<td>Use if you are controlling decks through a V-LAN/VLX connection</td>
</tr>
</tbody>
</table>

6. Click OK to close the Channel dialog box.

A dialog box asks if you want to automatically configure the channel now.

7. Click Yes if you want to automatically configure the channel.

A new channel appears in the display area of the Deck Configuration dialog box, along with the autoconfigured deck.

Do not autoconfigure a DV camera or deck. Not all DV devices respond to the Auto-configure command. Due to this limitation, Auto-configure selects only a generic device template. When a digital camera is attached to your system, click the Deck Type menu, and select the proper device (described later in this procedure). When a deck is attached, click the Deck Type menu, and select the applicable deck.
You can reopen the Channel settings to change the options at any time by double-clicking the channel box in the Deck Configuration dialog box.

8. If you did not autoconfigure the deck, click the channel box to select it.
9. Click the Add Deck button to open the Deck Settings dialog box.

When a deck is already connected to the system, you can click the Auto-configure button to bypass the Deck Settings dialog box and automatically configure a deck with the default settings.

10. Select the manufacturer and model number of your deck or other device.

    Selecting a model opens a template of settings for the device you selected. You can change these settings based on your device.

    For more information, see “Deck Settings” on page 1461. You can also view this information by clicking the dialog box and pressing the F1 key (Windows) or the Help key (Macintosh).

11. Click OK to close the Deck Settings dialog box and return to the Deck Configuration dialog box.

You can reopen the Deck Settings dialog box to change the options at any time by double-clicking the deck box in the Deck Configuration dialog box.
12. Repeat the channel and deck setup process for each additional channel or deck you want to configure.

13. (Option) If you want your Avid editing application to check the deck configuration against the decks physically connected to the system, select “Verify configuration against actual decks.”

Your Avid editing application checks the deck configuration after you click the Apply button in the Deck Configuration dialog box and when you start a work session. A message box warns you if the configuration does not match the deck.

14. Type a name in the Configuration name text box to name the deck configuration.

The new deck configuration appears in the Settings list in the Project window.

15. Click the Apply button to complete the configurations and close the Deck Configuration dialog box.

16. Double-click Deck Preferences in the Settings list in the Project window to review and if necessary adjust global deck control options.

For information about these controls, see “Deck Preferences Settings” on page 1462. You can also view this information by clicking the dialog box and pressing the F1 key (Windows) or the Help key (Macintosh).

**Deleting Deck Configuration Elements**

You can delete deck configuration elements to remove or replace them.

**To delete deck configuration elements:**

1. Double-click Deck Configuration in the Settings list in the Project window.

   The Deck Configuration dialog box opens.

2. Click a channel box, a deck box, or the entire configuration to select it.

3. Click the Delete button.

4. Click the Apply button to complete the changes and close the dialog box.

**Understanding Timecode**

Timecode is an electronic indexing method that denotes hours, minutes, seconds, and frames that have elapsed in video material. For example, a timecode of 01:03:30:10 denotes a frame that is marked at 1 hour, 3 minutes, 30 seconds, and 10 frames.

Most video formats, including PAL and HD formats, use non-drop-frame timecode, where every frame of the video material is counted in sequence.
NTSC video, however, might use either of the following two formats:

- Drop-frame timecode matches the NTSC scan rate of 29.97 frames per second (fps) by dropping two frames of timecode every minute except for the tenth minute. This does not drop any of the video frames themselves. Drop-frame timecode is indicated by semicolons between the digits, for example, 01;00;00;00.

- Non-drop-frame timecode tracks NTSC video at a rate of 30 fps and is indicated by colons between the digits, for example, 01:00:00:00. Non-drop-frame timecode is easier to work with, but does not provide accurate timing for NTSC broadcast.

For example, if you work on a 1-hour show that uses 52 minutes of video, the program ends at 01:52:00:00 (non-drop-frame). If it is broadcast at 29.97 fps, it will last 94 frames too long (approximately 3 seconds).

The following illustration compares the two types of timecode at the 1-minute mark. Remember that no frames are actually dropped when drop-frame timecode is used. Drop-frame timecode simply skips timecode numbers as necessary to match the actual NTSC scan rate.

![Comparison of non-drop-frame timecode (top) and drop-frame timecode (bottom)](image)

You set the default timecode format for logging clips in the Deck Preferences dialog box. You set the default starting timecode in the General Settings dialog box. In both cases, you can select either drop or non-drop. For more information, see “Deck Preferences Settings” on page 1462 and “General Settings” on page 1499.

You can also change the starting timecode or, for NTSC projects, the timecode format, of a sequence. See “Changing the Name and Timecode for a Sequence” on page 584.

**Connecting a DV Device**

You can capture DV 25, DV 50, DVCPRO HD, and HDV media directly from a DV camera or deck (a DV device). For more information, see “Capturing Directly from a DV Device” on page 243. You can also play and output directly to the DV device. To use a DV device, you must connect it to your system correctly.
You can connect a DV device to a 1394 port on your computer (Host 1394).

For HDV media, playback directly to an HDV device is not supported. You need to export a transport stream. For more information, see “Outputting HDV” on page 1619.

**Setting Up the Capture Tool**

The Capture tool provides controls for cueing, marking, and logging footage, and specifies capturing parameters such as source and target locations. The topics in this section describe how to open and set up the Capture tool.

*In Capture mode, the Client monitor displays the playback footage whenever the video track is selected in the Capture tool.*

The following illustrations show the Capture tool for an HD project. Some items might not be available or might have minor differences in your Avid editing application model.
When you are working in a 24p NTSC project, the Capture tool includes a pulldown button. For more information, see “Setting the Pulldown Switch” on page 201.

When you are working in an Avid Interplay environment, the Capture tool lets you select either Local Bins or Remote Bins. See “Selecting a Target Bin” on page 203.

When you install your Avid editing application, an Incompatible Power Scheme warning button might appear in the top right corner of the Capture tool. Some Windows power schemes might affect the performance of your Avid editing application, including capturing media. Avid recommends the “Always On” power scheme for Windows XP and the “High Performance” power option for Windows Vista when working with Avid editing applications. For more information on Windows power schemes, see the Windows documentation.
Opening the Capture Tool

To open the Capture tool:

1. Ensure the deck or other playback device is properly connected to the system and is turned on.

2. Do one of the following:
   - Click a bin to activate it and select Bin > Go To Capture Mode.
   - Select Tools > Capture.

3. Set the Capture tool to either Log or Capture mode by clicking the Capture/Log Mode button until the correct mode displays.

Selecting a Deck in the Capture Tool

The Deck Selection menu in the Capture tool contains a list of any decks that are connected to the system, powered up, and initialized when you enter Capture mode.

Device templates from Meridien-based Avid editing applications are not compatible with current Avid editing systems. Do not copy Meridien device templates to current Avid editing systems, and do not copy current Avid editing application device templates to Meridien systems.

The Deck Selection menu also lists the following three commands:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adjust Deck</td>
<td>Opens the Deck Settings dialog box. Changes you make apply to the selected deck. For information on Deck settings, see “Deck Settings” on page 1461.</td>
</tr>
<tr>
<td>Auto-configure</td>
<td>Lets you automatically configure the selected deck with the default deck settings for that deck.</td>
</tr>
<tr>
<td>Check Decks</td>
<td>Helps to reestablish deck control if the power to your decks was turned off or the decks were disconnected when you first entered Capture mode.</td>
</tr>
</tbody>
</table>

If “No Deck” appears in the Deck Selection menu, you need to configure a deck in the Deck Configuration dialog box. See “Configuring Decks” on page 188.

If a deck name appears in italics in the Deck Selection menu, the deck has lost power or has been disconnected. Click the menu, and select Check Decks to reestablish deck control.
After deck control has been properly initialized, it remains active for all deck controllers throughout the session until you quit your Avid editing application.

You must have V-LAN VLXi hardware to manage more than one deck at a time. For more information on V-LAN equipment, contact your Avid sales representative.

Activating Playback from an Available Deck

To activate playback from an available deck:
- Click the Deck Selection menu, and select the deck.

Selecting a Source Tape

To select a source tape:

1. Do one of the following:
   - If a tape is already in the deck, click the Source Tape Display button in the Capture tool.
   - If there is no tape in the deck, insert a tape into the deck.
   The Select Tape dialog box opens.

2. If you are working in an NTSC project, play the tape for a few seconds so your system can detect the timecode format of the tape (drop-frame or non-drop-frame).
   Otherwise, the system maintains the timecode format set in the Deck Preferences dialog box, regardless of the format on the tape, and you might receive a message indicating a wrong tape.
Drop-frame timecode appears in the Timecode indicator with semicolons between hours, minutes, seconds, and frames. Non-drop-frame timecode appears with colons. For more information, see “Understanding Timecode” on page 192.

3. Provide the system with a tape name in one of the following ways:
   - Select the name of the tape from the list in the Select Tape dialog box and click OK.
   - Expand the list by selecting the “Show other projects” option or by clicking the Scan for tapes button.
   - Click New if the tape is not in the list. A new tape name line appears in the dialog box. Type the new name, press Enter (Windows) or Return (Macintosh), and click OK.

For information on tape naming conventions, see “Naming Tapes” on page 148. If you are working with MultiRez in an Avid Interplay environment, see “Guidelines for MultiRez Tape Management” on page 1335.

Selecting Source Tracks and Audio Channels

You can select the tracks to capture from the source tape, and you can set the audio channel groupings if you capture stereo audio source media.

When you group audio tracks for multichannel capture or batch capture, your Avid editing application saves the grouping as a capture setting, independent of the hardware channels you select. The resulting clip uses the grouping setting and the used channels. For more information on audio channel groupings, see “Working with Multichannel Audio Tracks” on page 762.

When you batch capture, if the tracks are already logged into the bin then channel selection is made automatically unless you deselect the option “Capture the tracks logged for each clip” in the Batch tab of the Capture Settings dialog box. For more information on Batch Capture settings, see “Batch Capturing Clips” on page 251.

Batch capture uses the audio channel groupings currently specified on the master clip, not the groupings that display in the Capture tool when you batch capture previously-logged clips.

To select only those tracks you want to capture:
   - Click the Channel Selection buttons in the Capture tool.
Setting Up the Capture Tool

Channel Selection buttons in the Capture tool

If you do not see source video or hear source audio in Capture mode, click the Channel Selection buttons to ensure they are not the cause.

When you use an Avid-controlled deck, the TC (timecode) track is selected by default, and the system captures the timecode from the source tape. If you deselect the TC button, the system captures with time-of-day timecode. For more information, see “Capturing with Time-of-Day Timecode” on page 242.

To group tracks for multichannel capture:

- Click the Audio Channel Grouping buttons in the Capture tool for those tracks you want to capture as stereo audio tracks.

  The Audio Channel Grouping button turns green when you group tracks.
Setting Up the Capture Tool

When you capture stereo audio, you can view the multichannel audio format in the bin in the Track Formats column.

**Setting the Video and Audio Input in the Capture Tool**

The Video and Audio menus show you the current input settings for the Video Input tool and the Input tab in the Audio Project Settings dialog box. The menus also provide a convenient way to change the settings if necessary.

*The Video Input tool is not available on all models. If your model does not have the Video Input tool, your Avid editing application sets the default input options automatically.*

For more information, see “Preparing to Capture Audio” on page 207 and “Preparing to Capture Video” on page 221.

*If you change the settings, the settings in the Video Input tool or in the Audio Project Settings dialog box automatically change to the settings you select.*
Detecting a Valid or Locked Sync Signal

On systems using Avid input/output hardware, the Capture tool uses an icon to indicate if the sync source you are using is valid and locked. The icon appears in the message bar of the Capture tool.

- **Video Lock icon:** When you select a video track in the Capture tool, the Video Lock icon is displayed. If the current source has a valid video signal and your Avid input/output hardware can lock to it, the icon is displayed in green. If there is no valid signal, the icon is displayed in black.

- **Ref Lock icon:** When you select only audio tracks (or if no tracks are selected) in the Capture tool, the Ref Lock icon is displayed. If there is a valid reference signal and your Avid input/output hardware can lock to it, the icon is displayed as a green ring. If there is no valid signal, the icon is displayed in black.

The Ref Lock icon also appears in the Digital Cut tool.

For more information, see Selecting the Sync Source for Output.

Setting the Pulldown Switch

If you are capturing sound created during an NTSC film-to-tape transfer, you need to set the pulldown switch before you begin capturing. If you are capturing picture only, you do not need to set the switch.

If you are working in a 23.976p project, the pulldown switch is not necessary and does not appear.

Ensure your film preferences are set properly. For more information, see “Film Project Pulldown and Transfer Settings” on page 202 and “Capturing Digital Audio in Film Projects” on page 203.

To set the pulldown switch:

- Click the Pulldown button in the Capture tool.

  When the pulldown switch is off, the button is inactive (gray), and a label explains that audio will be captured (sampled) at the same speed at which it was recorded (1.00).
Setting Up the Capture Tool

When the pulldown switch is on a label explains that you can capture audio sampled at 0.99 percent of its recorded speed (referenced to NTSC video), to match the slowdown rate at which the footage was transferred.

Film Project Pulldown and Transfer Settings

The following table explains how you should set the pulldown switch and transfer settings, depending on your input media.

<table>
<thead>
<tr>
<th>Type of Input Media</th>
<th>Project</th>
<th>Pulldown Switch Setting</th>
<th>Source Playback Speed</th>
<th>Film to Video Transfer Settings (Set in Film Settings Dialog Box)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Original sound source synced to NTSC during transfer. For capturing picture and sound from NTSC tape, or sound-only from simul-DAT tapes created during telecine transfer.</td>
<td>24p NTSC</td>
<td>On (0.99)</td>
<td>29.97 fps</td>
<td>Picture Transfer Rate: With 2:3 pulldown</td>
</tr>
<tr>
<td>NTSC MOS film-to-tape transfer with separate audio. Digital audio (DAT) or analog audio (Nagra) to sync with video in your Avid system. For direct input of separately recorded audio.</td>
<td>24p NTSC</td>
<td>Off (1.00)</td>
<td>Audio: 30.00 fps, Picture: 29.97 fps</td>
<td>Picture Transfer Rate: With 2:3 pulldown, Audio Source Tape TC Rate: 30.00</td>
</tr>
<tr>
<td>FTFT transfer or retransferring an effect. This method lets you save time because no audio is involved in the transfer.</td>
<td>24p NTSC</td>
<td>Not applicable</td>
<td>29.97 fps</td>
<td>Picture Transfer Rate: Without pulldown</td>
</tr>
</tbody>
</table>
Capturing Digital Audio in Film Projects

You must capture audio created during an NTSC file-to-tape transfer at a pulldown sample rate. When capturing from a digital source (such as AES/EBU, ADAT, or Embedded SDI), you must either configure the deck to transfer at the pulldown rate (as is possible with some audio decks) or capture the digital source as analog.

Selecting a Resolution in the Capture Tool

The Res (Resolution) menu contains a list of the available resolutions, depending on your project and the model of your Avid editing application. You can select the resolution in the Capture tool or in the Media Creation dialog box (see “Selecting Video Resolutions and Media Drives” on page 176). If you select a resolution in the Capture tool, the Media Creation settings change to the resolution you selected.

For detailed information on available resolutions in Avid editing applications, see “Resolution Specifications” on page 1559

To select a resolution in the Capture tool:

- Click the Res (Resolution) menu, and make a selection.

Selecting a Target Bin

You select a target bin as the destination for the master clips that you create when you capture and log at the same time.
In an Avid Interplay environment, the Capture tool includes an option to capture to a local bin or a remote folder.

**To select a target bin:**

1. (Option — systems in an Avid Interplay environment only) Do one of the following:
   - If you are capturing to a local bin, select Local Bins.
   - If you are capturing to a remote project folder in an Avid Interplay environment, select Interplay Folders.

   For more information about capturing to an Interplay project folder, see “Capturing Media to Interplay Folders” on page 1263.

2. In the Capture tool, click the Bin menu and make a selection.

   Only open bins (and open Interplay folders if you are in an Interplay environment) appear in the Bin menu. For information on opening a bin, see “Opening and Closing Bins” on page 90.

   Interplay folders are available only in Avid workgroups configurations. If the Interplay folder you want to use is not open, click the folder name in the Interplay Window.

**Selecting the Target Drives**

You select one or more target drives as the destination for audio and video media files that you create when you capture.

By default, the Capture tool targets a single media drive volume for capturing the audio and video for each clip. You can also:

- Target separate physical drives for audio and video tracks.
  You might want to target separate drives for media management, such as sending audio files to a Pro Tools® system for audio sweetening. Capturing audio and video to separate drives is not necessary for performance.

- Target a drive group (a group of media drives).
  This is especially useful when you are capturing long clips to multiple media files. For more information, see “Capturing to Multiple Media Files” on page 183.

After you create a drive group, it appears in the Target Drive menu for the project.
If you are capturing high-quality resolutions, you need to select striped drives. For more information, see “Getting Information About Striped Drives” on page 173 and “Storage Options and Drive Striping” in the Help.

You can filter some drives out of the available drive list. For more information, see “Setting Drive Filtering” on page 180.

You can set target drives in the Media Creation dialog box. See “Selecting Video Resolutions and Media Drives” on page 176.

For tips on targeting media drives for effective storage and playback, see “Storage Requirements” on page 1575.

**To target a single drive:**

1. If the Capture tool is not already open, select Tools > Capture.
   
   The Capture tool opens.

2. Click the Single/Dual Drive Mode button to display the Single Drive icon.

3. Click the Target Drive menu, and select a drive volume.
   
   The name in bold in the menu has the most storage available. The time remaining on the selected drive, displayed to the right of the menu, is calculated based on your resolution selection.

**To target separate drives for audio and video:**

1. If the Capture tool is not already open, select Tools > Capture.
   
   The Capture tool opens.

2. Click the Single/Dual Drive Mode button to display the Dual Drive icon.
   
   Two Target Drive menus appear. The top one is targeted for video and the bottom one is targeted for audio.

3. Click each Target Drive menu, and select separate drives for audio and video.
   
   The names in bold in the menus have the most storage available. The time remaining on each selected drive, displayed to the right of each menu, is calculated based on your resolution selection.
To create and target a drive group:

1. Click the Target Drive menu, and select Change Group.
   
The Drive Group dialog box opens.

2. Ctrl+click (Windows) or Command+click (Macintosh) to select multiple drives to include in the capturing session, or click the All button to select all drives.

3. Click OK.
   
   Your Avid editing application creates the drive group, and it appears in the Target Drive menu.
   
   When you capture, any clip that exceeds the capacity of a drive (whether that drive is empty or already contains media files) continues capturing onto another drive in the group.

Selecting a Custom Preroll

The Custom Preroll option and menu in the Capture tool lets you select how many seconds the tape rolls before the capturing starts. This option overrides the global preroll setting in the Deck Settings dialog box.
Preparing to Capture Audio

Your Avid editing application provides you with a wide range of options for audio input: capturing audio with video from tape, capturing audio from a digital or analog deck, capturing through a microphone, or capturing through an external audio device such as an Mbox device, and in various formats and at various sample rates.

The topics in this section describe preparations you might need to take before capturing audio.

Audio Project Settings for Capture

You can use the Audio Project Settings dialog box to choose various input and output options and check the current configuration of your audio hardware. You need to set the following audio project settings for capture:

<table>
<thead>
<tr>
<th>Setting</th>
<th>For more information, see</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio sample rate</td>
<td>“Selecting the Audio Sample Rate and Controlling Audio Sample Rate Conversion” on page 208.</td>
</tr>
<tr>
<td>Audio file format</td>
<td>“Selecting the Audio File Format” on page 209.</td>
</tr>
<tr>
<td>Audio input source</td>
<td>“Selecting the Audio Input Source” on page 210.</td>
</tr>
</tbody>
</table>

Some options depend on the audio configuration of your Avid editing system, so your system might not contain certain features and hardware that are covered in the documentation.

The values you set in the Audio Project Settings dialog box are saved as Project settings. You can also save the Audio Project settings as Site settings so that all projects open with the same audio settings. See “Using Site Settings” on page 1429.

For information on all Audio Project settings, see “Audio Multiple Mix Settings” on page 1444. You can also view this information by clicking the dialog box and pressing the F1 key (Windows) or the Help key (Macintosh).
Selecting the Audio Sample Rate and Controlling Audio Sample Rate Conversion

Selecting the audio sample rate in the Audio Project settings dialog box sets the audio sample rate for capturing audio and for sequences that you create in the project. You can change the sample rate for individual sequences and audio clips.

When you are using some Avid input/output hardware devices, you can also control how your Avid editing application handles audio sample rate conversion during capture.

Sample rate conversion on input applies to the following digital inputs: SDI embedded, AES/EBU, SPDIF, and ADAT.

**To select the audio sample rate:**

1. In the Project window, click the Settings tab.
   The Settings list appears.
2. Double-click Audio Project.
   The Audio Project Settings dialog box opens.
3. Click the Main tab.
4. Click the Sample Rate menu, and select a sample rate.
5. Close the Audio Project Settings dialog box.

**To set a preference for audio sample rate conversion during capture:**

1. In the Project window, click the Settings tab.
2. Double-click Audio Project.
   The Audio Project Settings dialog box opens.
3. Click the Input tab.
4. Click the Sample Rate Conversion menu, and select one of the following:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Never</td>
<td>When this option is set, your Avid editing application displays a warning message if the sample rate of the incoming media does not match the project sample rate. This is the default option. The Never option is useful when capturing from different sources. The system reminds you that the material that you are capturing is at a different sample rate than the project. Then you can decide whether to convert the audio to match the project sample rate or change the project sample rate to match the incoming audio.</td>
</tr>
</tbody>
</table>
Preparing to Capture Audio

5. Close the Audio Project Settings dialog box.

Selecting the Audio File Format

You create audio files when you:

- Record audio tracks in Capture mode.
- Create tone media by using the Audio tool.
- Mix down audio tracks by using the Audio Mixdown tool.
- Import files by using the Import dialog box.
- Apply an AudioSuite plug-in that creates new source audio.

You select the file format that your Avid editing application uses when creating audio files by selecting from the Audio File Format menu in the Audio Project Settings dialog box.

You should be aware of the following:

- You can mix AIFF-C and WAVE audio media files within a project.
- You should elect AIFF-C or WAVE when you need to transfer media files directly to a Pro Tools system for audio sweetening. For more information, see “Transferring Audio Files” on page 1156.
- Media Composer has limited support for Sound Designer II™ audio. See “Transferring and Working with Sound Designer II Audio Files from Macintosh Systems” on page 1157.
- If you switch the audio format in the middle of a project, all new audio media files are written in the new format with the following exceptions:
  - When your Avid editing application renders audio effects, it uses the file type of the outgoing (A-side) audio media for a transition. For example, if the A-side of an audio dissolve is in AIFF-C format and the B-side (incoming) is in WAVE format, the rendered file is AIFF-C.
  - Media files that your Avid editing application copies or creates during a Consolidate procedure retain their original file types.

To select the audio file format:

1. In the Project window, click the Settings tab.

   The Settings list appears.
Preparing to Capture Audio

2. Double-click Audio Project.
   The Audio Project Settings dialog box opens.
3. Click the Main tab.
4. Click the Audio File Format menu, and select WAVE (OMF), AIFF-C (OMF), or PCM (MXF).
   The default file format is AIFF-C (OMF). For more information on audio file formats, see “Audio Projects Settings: Main Tab” on page 1438.
5. Close the Audio Project Settings dialog box.

Selecting the Audio Input Source

You can connect one or more audio devices to your Avid hardware or to your computer. Use the Audio Project settings to select the device you want to use as the source for capture. The choices available depend on your system configuration. For more information, see “Audio Project Settings: Input Tab” on page 1440.

- If you select IEEE 1394 as your input device, the input source is automatically set to Host-1394. For more information, see “Connecting a DV Device” on page 193.
- (Macintosh only) If you use the one of the Mbox family of audio devices to capture audio, the S/PDIF inputs appear in the Capture tool as Tracks 3-4.

To select the audio input source:
1. In the Project window, click the Settings tab.
2. Double-click Audio Project.
   The Audio Project Settings dialog box opens.
3. Click the Input tab.
4. Click the Input Source menu and select the source for the audio you want to capture.
5. Close the Audio Project Settings dialog box.
   The source you selected is displayed in the Capture tool. You can change the source in the Audio Project Settings dialog box or in the Capture tool.

Configuring the Sound Card (Software-Only Systems)

Depending on the sound card installed on your Avid system, you might need to customize the configuration of audio input and output. Usually this configuration occurs automatically when you install your Avid editing application, but some sound cards require further customization to
ensure full compatibility between your Avid editing application and your audio hardware. In these cases, you can use the Sound Card Configuration dialog box to map audio input sources to specific audio output sources.

If your system has a surround sound audio chip installed, your Avid editing application might not be able to configure the Windows Mixer properly for audio output. By default, your Avid editing application mutes all output sources except the primary audio, which typically is a WAVE source. Some surround sound devices require that other audio output sources, such as Front Speakers, not be muted. To prevent your Avid editing application from muting these outputs, you can override the Sound Card Configuration setting.

**Improper configuration of your audio hardware can cause the audio input and output features of your Avid editing application to function incorrectly. Use the Sound Card Configuration dialog box only if you experience problems with your audio output.**

**Configuring your sound card to ensure compatibility is necessary only if your Avid editing application is not using Avid input/output hardware (software-only). If Sound Card Configuration does not appear in the Settings scroll list, you do not have to configure your sound card.**

**To customize the sound card configuration:**

1. In the Project window, click the Settings tab.
   
   The Settings list appears.

2. Double-click Sound Card Configuration.
   
   The Sound Card Configuration dialog box opens.

3. For each input source in the Record/Input list that you want to map, click the matching Output Source menu from the Playback/Output list and select an output source.

   *You can map an input source to only one output source at a time. The options available for mapping depend on your audio hardware.*

4. (Option) If you do not want an input source mapped to an output source, select *<No Match>* from the corresponding Output Source menu. You might need to do this, for example, if your system lists more input sources than output sources.

5. Click OK.

**To reconfigure the sound card to the original application settings:**

- Click the Default button.

**Clicking the Default button applies the default settings immediately. You cannot cancel the reconfiguration once you reset the default options.**
**Preparing to Capture Audio**

**To override the mute feature for surround sound:**

1. In the Settings list, double-click Sound Card Configuration.  
   The Sound Card Configuration dialog box opens.

2. Click the Override Mute menu.  
   The menu contains a list of the output sources available in Windows Master Volume control.

3. Click one or more of the output sources to override the Sound Card Configuration settings and to accept the default settings of the Master Volume control.

   For example, if the Master Volume control is set to disable sound from the Front Speaker output source, your Avid editing application leaves the source muted. If the Master Volume control is set to enable sound from this source, your Avid editing application leaves the source not muted.

**Understanding the Audio Tool**

You use the Audio tool primarily for mixing and monitoring audio.

The Audio tool, along with your hardware’s audio parameters, lets you do the following in preparation for input:

- Check and manage your audio hardware setup.
- Set audio levels before recording.
- Calibrate, set levels, and generate customized calibration tones for output to the speakers or a record device.

The following table describes the components in the Audio tool.

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reset Peak button</td>
<td>Resets the current maximum peak measurements and stops the playback of the internal calibration tone.</td>
</tr>
<tr>
<td>In/Out toggle buttons</td>
<td>Switch the meter displays for each channel between input levels from a source device and output levels to the speakers and record devices. I indicates Input, and O indicates Output.</td>
</tr>
<tr>
<td>Peak Hold Menu button</td>
<td>Lets you select options for customizing the meter displays and for setting and playing back the internal calibration tone.</td>
</tr>
<tr>
<td>Digital scale to the left of the meters</td>
<td>Displays a fixed range of values from 0 to –90 decibels (dB), according to common digital peak meter standards.</td>
</tr>
</tbody>
</table>
Preparing to Capture Audio

Opening the Audio Tool

To open the Audio tool, do one of the following:

- Select Tools > Audio Tool.
- Click the Audio Tool button in the Capture tool.

The Audio tool opens and displays meters for two to sixteen channels, depending on the configuration of your system.

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Volume unit (VU) scale (analog) to the right of the meters</td>
<td>Displays a range of values that you can conform to the headroom parameters of your source audio.</td>
</tr>
<tr>
<td>Meters</td>
<td>Dynamically track audio levels for each channel as follows:</td>
</tr>
<tr>
<td></td>
<td>• Meters show green below the target reference level (default reference level is –20 dB on the digital scale).</td>
</tr>
<tr>
<td></td>
<td>• Meters show yellow for the normal headroom range, above the reference level to approximately –3 dB.</td>
</tr>
<tr>
<td></td>
<td>• Meters show red for peaks approaching overload, between –3 dB and 0 (zero) dB.</td>
</tr>
<tr>
<td></td>
<td>• Thin green lines at the bottom indicate signals below the display range.</td>
</tr>
</tbody>
</table>

Audio tool. Top, left to right: Reset Peak (RP) button, In/Out toggle buttons, Peak Hold (PH) Menu button. Left display column: Digital scale (fixed). Right display column: Volume unit scale (adjustable).
Preparing to Capture Audio

Adjusting Audio Input Levels

You can use the Audio tool and the Audio Project Settings dialog box to check the audio input levels. If the input levels are too high or too low, you need to adjust the output level of your source signal, if possible.

On software-only systems, you can adjust audio input through a slider in the Input tab of the Audio Project settings. For more information, see “Audio Project Settings: Input Tab” on page 1440.

Before you capture, make sure the audio I/O device is properly calibrated. See “Calibrating Audio Hardware for Avid Nitris DX and Avid Mojo DX” on page 217.

To check and adjust input levels using an audio input device:

1. Click the In/Out toggle buttons in the Audio tool for the channels that you use for input. The Audio tool displays an I for Input.
2. Play back the source audio (from a videotape or DAT, for example). If the recording includes reference tone, cue to the tone and play it back.
3. Adjust the output on the playback device so that the device’s volume meter shows the appropriate level for the reference signal in the Audio tool (0 VU for videotape playback, for example).

You can adjust the output by using a deck that supports output gain or by sending the signal through a mixing console.

Creating Tone Media

You can create your own tone media as a master clip for editing directly into sequences.

To create tone media:

1. Open a bin.
2. Select Tools > Audio tool.
3. Click the PH (Peak Hold) menu in the Audio tool, and select Create Tone Media. The Create Tone Media dialog box opens.
4. Set the appropriate calibration tone parameters for the project. You can also use the default output tone of –20 dB (digital scale) with a 1000-Hz signal.

A value of 0 generates random noise. A value of –777 generates a tone sweep.
5. Select the number of tracks of tone you want to create (up to 8 tracks).
6. Click the menus, and select a target bin for the tone master clip and a target drive for the tone media file.
7. Click OK.

After a few seconds, your Avid editing application creates the media file and a master clip appears in the target bin. The default name reflects the options you selected. You can rename the clip by typing a new name.

## Using the Passthrough Mix Tool

The Passthrough Mix tool lets you select the mix and adjust the volume and pan values of the source audio that you monitor. You can adjust the mix, volume, and pan values of multiple monitored channels, controlling either individual channels manually or several channels simultaneously by grouping them together.

*The Passthrough Mix tool adjusts monitored audio only and has no effect on the recorded audio signal. You can adjust volume levels within a clip in the Timeline after you record audio by using Audio Gain Automation. For information, see “Audio Mixer Tool Controls” on page 789.*

### To open the Passthrough Mix tool, do one of the following:

- In the Settings list of the Project window, double-click the Passthrough Mix Tool button.
- In the Capture tool, click the Passthrough Mix Tool button.
- In the Audio Punch-In tool, click the Passthrough Mix Tool button.

For more information, see “Recording Voice-Over Narration Using Audio Punch-in” on page 859.

The Audio Project Settings dialog box opens.

### To choose the number of tracks (4 or 8) to display in the Passthrough Mix tool:

- Click the Number of Mix Panes button.

When you select 4 tracks, an additional button appears that lets you display the first 4 or last 4 enabled tracks.

With the tool minimized, you can continue to adjust levels, either by selecting a track and typing values by using the numeric keypad, or by typing a value in the Volume Level display.

### To adjust audio in the Passthrough Mix tool:

1. Double-click Passthrough Mix Tool in the Settings list.

   The Passthrough Mix tool opens.

2. Switch the Input Mix Mode button to select a type of input:

   - Select Stereo Mix to mix audio channels to a stereo pair. Use the Stereo Mix Tracks menu to specify which stereo pair to use.
   - Select Direct Mix to send the input signal to its corresponding output channel.
In Direct Mix mode, the Pan Value display and pop-up sliders at the bottom of the Passthrough Mix tool are replaced by Channel Menu buttons.

3. Select the audio channel to be adjusted by doing one of the following:
   - Click the Channel Selection button for the appropriate audio channel.
   - In Direct Out mode, click the Channel Menu button, and select a channel from the menu.

   You can select only channels that exist in the source audio.

4. Adjust the volume as needed.

   You can adjust the volume of multiple channels by clicking the appropriate Group button. For more information, see the next procedure.

5. Adjust the pan values as needed.

   For more information, see the final procedure in this topic.

**To change an audio level value in the audio panel in the Passthrough Mix tool, do one of the following:**

- Click a number along the vertical edge of the Volume Level slider.
- Click the Volume Level slider, and type a value.

   Values are cumulative until you press Enter (Windows) or Return (Macintosh). For example, if you want to enter the value 12, type it. However, if you type 1 and then want to change the value to 2, press Enter (Windows) or Return (Macintosh) before typing the 2.

- Click the Volume Level slider, and drag the slider to a new position.
- Click the Volume Level display, and type a value.

- Alt+click the Volume Level slider to reset the value to 0 dB.

**To adjust the pan values in the audio panel of the Passthrough Mix tool:**

- Click the Pan Value display to reveal the pop-up slider, and then drag the slider to a new position.

   Pan Value display (left) and pop-up slider (right) in the Passthrough Mix tool.
Calibrating Audio Hardware for Avid Nitris DX and Avid Mojo DX

By default, your Avid editing application is calibrated for analog 0 Volume Unit (VU) to be digital –20 dBFS, which matches the default calibration of the Avid Nitris DX and Avid Mojo DX hardware.

You can do two things to calibrate audio — make the audio adjustment to correspond to your hardware calibration setting by using the default, or refine the calibration to get to within 1/4 dB. This will require using additional test equipment — an external calibrated signal generator, a voltmeter, or an oscilloscope.

The Audio Hardware Calibration window lets you change your audio hardware calibration. The calibration settings are stored in the Avid Nitris DX or Avid Mojo DX, and moved with the hardware if it is moved to another computer. If you delete the project, user, or site settings, or reinstall your Avid editing application, the settings are saved in the hardware.

If you have already calibrated your analog audio outputs, you can use the Avid Play Calibration Tone generator by connecting one channel’s output to another channel’s input.

To calibrate the audio channels for Avid Nitris DX or Avid Mojo DX using the Audio Hardware Calibration tool:

1. Connect the analog outputs to the analog inputs on the back of the Avid Nitris DX or Avid Mojo DX.
2. Double-click Audio Project in the Settings list of the Project window.
3. Click the Hardware tab.
4. Click the HW Calibration menu, and select a new default hardware calibration setting: –14 dBFS, –18 dBFS, or –20 dBFS.
   A message box opens warning that changing the Hardware Calibration must be synchronized with physical changes to your Audio I/O peripheral.
5. Click OK.
6. Click the Open Calibration window.
   The Audio Hardware Calibration window opens.
7. To change the digital level of the meter’s display of 0 VU, click Set Reference Level.
   The Set Reference Level dialog box opens.

8. Enter the new reference level in dB.
   This should be set to match the 0 VU standard in your workflow. Avid recommends a
   -20 dBfs value.

9. Select the interface you want to calibrate: Analog XLR input, Analog RCA input, Analog
    TRS input, Monitor output, or Analog output.
   Options vary depending on your Avid input/output hardware. You can calibrate only one
   channel at a time.

10. Select the appropriate channel.
    Channels vary depending on your Avid input/output hardware.

11. Use the Up and Down buttons to adjust the calibration in 0.5dB increments.
    Depending on what you selected in the HW Calibration menu, enter the corresponding
    Output or Input.
Preparing to Capture Audio

To calibrate the audio input channels:

1. Connect the tone generator to the analog inputs on the back of the Avid Nitris DX or the Avid Mojo DX.

2. Double-click Audio Project in the Settings list of the Project window.

3. Click the Hardware tab.

4. Click Open Calibration window.

   The Audio Hardware Calibration window opens.

5. Select the interface you want to calibrate: Analog XLR input, Analog RCA input, or Analog TRS input.

   Options vary depending on the Avid input/output hardware you have connected. You can calibrate only one channel at a time.

6. Select the appropriate channel.

   Channels vary depending on your Avid input/output hardware.

7. At the bottom of the Audio Hardware Calibration window, click Audio Tool.

   The Audio tool opens.

8. For whichever channels you want to calibrate, switch the Audio Tool channels to input by clicking each In/Out toggle buttons to change the output (O) to input (I).

   The In/Out toggle buttons in the Audio Tool switch from O to I and highlight in green. The meters levels re-display.

9. Set the tone generator output to the reference level set in the Audio Hardware Calibration window.

   The following are suggested professional settings:

   - Analog XLR input: +4 dBu
   - Analog RCA input: -10 dBV
   - Analog TRS input: +4 dBu

12. Repeat this procedure for each channel.
10. Use the Up and Down buttons in the Audio Hardware Calibration window to adjust the calibration in 0.5dB increments. The meters in the Audio tool should display around 0 VU.

11. Click Calibrate from the Audio Hardware Calibration window. The Audio tool changes to Calibrate mode. The scales display a range of approximately 8 dB, and the meters indicate levels within this range.

12. Repeat this procedure for each channel.

**To calibrate the audio output channels for Avid Nitris DX and Avid Mojo DX:**

1. Connect the external meter or an oscilloscope to the analog outputs on the back of the Avid Nitris DX or Avid Mojo DX.

   *If you use a voltmeter or an oscilloscope to perform the calibration, the target calibration voltage displays in the Voltage ptp and RMS area.*

2. Double-click Audio Project in the Settings list of the Project window.

3. Click the Hardware tab.

4. Click Open Calibration window. The Audio Hardware Calibration window opens.

5. If you need to adjust the tone level or tone frequency, click the Set button. The Set Calibration Tone dialog box opens.

   *You can also access the Set Calibration Tone dialog box from the menu in the Audio Tool window.*

6. Enter the new tone levels in dB and the new tone frequency in Hz.

7. Use the Up and Down buttons to adjust the calibration in 0.5dB increments.

   The following are suggested professional settings:
   - Monitor output: +4 dBu
   - Analog output: +4 dBu

8. Click OK.

9. Select the interface you want to calibrate: Monitor output or Analog output. Options vary depending on your Avid input/output hardware. You can calibrate only one channel at a time.

10. Select the appropriate channel.

    Channels vary depending on your Avid input/output hardware.
11. Click Play Calibration Tone.
12. Repeat this procedure for each channel.

**Using the Console Window to Check Audio Levels**

Once you have played back audio through the Audio tool, you can use the Console window to view a list of precise information about the peak levels.

**To check peak levels in the Console:**

1. Select Tools > Audio Tool.

   The Audio tool opens.

2. Click the RP (Reset Peak) button to clear your system’s record of the most recent maximum peaks.

3. Play a sequence or portion of the sequence.

4. After playing back the audio, open the Console window by selecting Tools > Console.

5. In the Console command line, type:

   ```
   DumpMaxPeaks
   ```

6. Press Enter (Windows) or Return (Macintosh).

   A list of peak values appears in the Console window.

**Preparing to Capture Video**

The Video Input tool lets you select the format of the video input signal and calibrate composite video, component video, and S-Video.
Preparing to Capture Video

If you are capturing SDI, HD-SDI, or DV, for example, from a D1, D5, digital Betacam, DV, or HD deck, you cannot adjust levels by using the video input controls in your Avid editing application. If you plan to make adjustments at the source deck, information in this section regarding the internal Waveform and Vectorscope monitors might be useful.

⚠️ When used with Avid Nitris input/output hardware, Symphony Option requires that the deck and the Avid Nitris hardware are genlocked to the same timing source when capturing. For more information, see “Selecting the Sync Source for Capture” on page 173.

Opening the Video Input Tool

To open the Video Input tool, do one of the following:
- Select Tools > Video Input Tool.
- Click the Video Input Tool button in the Capture tool.

The Video Input Tool opens.

1. Waveform Monitor button
2. Vectorscope Monitor button
3. Waveform monitor
4. Vectorscope monitor
5. Input menu
6. Preset buttons
7. Settings menu
8. 100% bars button

---

222
For information about settings in the Video Input tool, see “Video Input Tool Settings” on page 1532.

**Using the Factory Preset Buttons in the Video Input Tool**

The preset buttons in the Video Input tool show the status of each calibration setting as follows:

- When you first open the Video Input tool in a new project, all preset buttons are lit (green), with the factory presets loaded for each slider.
- When you click the slider of a lit preset button, the arrow changes to black and the slider moves to the position of the pointer.
- When a preset button has a black arrow and you click it, the arrow becomes lit (appears green), and the slider moves to the factory preset level for that parameter.
- When you click a lit preset button, the arrow changes to black, and the slider returns to the last manual setting.

As you adjust levels in the tool, you can switch the preset buttons between the levels you set manually and the factory preset levels.

**Calibrating Video Input**

You should calibrate video input levels to ensure the continuity of picture quality between tapes. Before you calibrate the video input, check the following:

- Make sure your monitor is properly calibrated for displaying footage accurately. For more information, see your monitor’s hardware documentation.
- If your system’s output settings have not already been calibrated according to house standards, use the procedures described in “Calibrating for Video Output” on page 1059. If you are in a facility where this is not necessary, leave the output settings at their preset values.
- If you are using footage in the NTSC-EIAJ format (used primarily in Japan), deselect the NTSC Has Setup option in the General Settings dialog box. This enables the appropriate display for the setup portion of the signal in the Waveform monitor and also adjusts the gain range.

**When you recapture media from a project created on a different Avid system, only reuse settings that originate on systems that use the same video I/O board. For projects from other Avid systems, check the Video settings for each tape.**

**To calibrate the video input:**

1. Ensure that you have properly connected the video playback device to the system.

   For more information, see the setup guide for your Avid system.
2. Select Tools > Video Input Tool.

The Video Input tool opens.

3. Click the Input menu, and select the appropriate video input channel.

Your options for video input depend on the model of your Avid editing application and the project you select.

The Video Input tool displays the appropriate parameters for the selected video format. For a description of each parameter, click the Video Input tool and press the F1 key (Windows) or Help key (Macintosh).

![Sync for video input comes from the source selected in the Video Input tool.](image)

*When you capture audio with video, the audio is always synced to the video source. For information regarding sync during audio-only input, see “Establishing Sync for Audio-Only Input” on page 174.*

4. Cue the tape to the section containing bars and tone (usually the beginning) and play the tape.

![Always play the tape when calibrating. Signal display is unstable when the tape is paused.](image)

The Client monitor displays one of the following types of bars (or a variation of them).
Preparing to Capture Video

Top: full-field color bars (the leftmost bar is 100% white). Bottom: SMPTE standard split bars (the leftmost bar in the top row of bars is 75% white, the second bar in the center row of bars is 7.5 black level, and the second bar in the bottom row of bars is 100% white).

5. If you are capturing from a consumer-grade video deck (such as a home VCR) or a deck that has no built-in time-base corrector, and you are having trouble with the incoming video quality, click the SignalLock button and select Consumer in the Video Input tool.

For more information, see “Limitations When Using Consumer Decks or Decks Without Time-Base Correctors” on page 227.

6. Click the 100% Bars button if the source tape contains 100% bars for calibration.

\[\text{In 100\% bars, the luminance waveform plot displays fairly even steps from the first bar (white) to the last bar (black). In 75\% bars, the white bar is at 100\%, which causes a larger step from the first bar (white) to the first color bar.}\]

7. Open the Waveform monitor by clicking the Waveform Monitor button.
Preparing to Capture Video

NTSC (top) and PAL waveform values in the Video Input tool. NTSC values are measured in IRE, with the white level at 100 IRE (digital 235), the black level at 7.5 IRE (digital 16), and the 75% white level at 77 IRE (digital 180, the horizontal dotted line in the display). For NTSC-EIAJ, the black level falls at 0 IRE. PAL values are measured in volts, with the white level at 1 V (digital 235) and the black level at 0.3 V (digital 16). The Line slider controls appear below the waveform display.

8. Adjust the Line slider located below the Waveform monitor to display the appropriate line of the test pattern, then adjust the luminance values as described in “Luminance Settings for Video Input” on page 227.

9. Open the Vectorscope monitor by clicking the Vectorscope Monitor button.

10. Adjust the Line slider to display the signal for color bars at around line 150 (this applies to all formats and all types of bars).

To switch between a display of perfectly calibrated bars and your input signal while making adjustments, press and release the Shift key.
11. Adjust the Sat and Hue sliders (composite or S-Video) or the RY Gain and BY Gain sliders (component) until the angle and amplitude of the six color vectors fall within the target boxes on the Vectorscope monitor.

There is no hue adjustment for PAL video.

*You can also monitor hue with a vectorscope in the Color Correction tool. See “Working with the Waveform Monitors and Vectorscope Monitor” in the Help.*

*If you incorrectly select or deselect the 100% Bars button, the factory presets for Saturation or RY and BY Gain are incorrect. Adjusting these controls in this condition results in oversaturated or undersaturated video.*

### Luminance Settings for Video Input

The following table describes recommended luminance settings for video input.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>SMPTE Bars</th>
<th>Full-Field Bars at 75% or 100% Signal Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Black level (setup)</td>
<td>Adjust Line slider to approximately 190</td>
<td>Adjust Line slider to approximately 150</td>
</tr>
<tr>
<td></td>
<td>Adjust Black or Brightness slider to place black level at:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• 7.5 IRE (for NTSC)</td>
<td>• 7.5 IRE (for NTSC)</td>
</tr>
<tr>
<td></td>
<td>• 0.0 IRE (for NTSC-EIAJ)</td>
<td>• 0.0 IRE (for NTSC-EIAJ)</td>
</tr>
<tr>
<td></td>
<td>• Not applicable for PAL</td>
<td>• 0.3 V (for PAL)</td>
</tr>
<tr>
<td>White level (gain)</td>
<td>Adjust Line slider to approximately 220</td>
<td>Adjust Line slider to approximately 150</td>
</tr>
<tr>
<td></td>
<td>Adjust Gain/Y Gain slider to place white level at:</td>
<td>Adjust Gain/Y Gain slider to place white level at:</td>
</tr>
<tr>
<td></td>
<td>• 100 IRE (for NTSC and NTSC-EIAJ)</td>
<td>• 100 IRE (for NTSC and NTSC-EIAJ)</td>
</tr>
<tr>
<td></td>
<td>• Not applicable for PAL</td>
<td>• 1.0 V (for PAL)</td>
</tr>
</tbody>
</table>

### Limitations When Using Consumer Decks or Decks Without Time-Base Correctors

This topic describes difficulties you might encounter when working with consumer video decks and tapes or decks that do not provide time-base correction or stabilized timing on their outputs.
Capturing from Unstable Time-Base Sources

Your Avid system is optimized for use with modern, broadcast-quality VTRs that contain time-base correctors (TBCs). If the input is stable, your system captures the video by using a high-quality, very-low-jitter clock reference.

However, some sources do not include an internal TBC. In some cases, due either to the deck performance or the deck performance in conjunction with a particular videotape, your system does not lock to non-TBC sources. As a result, the image might be unstable or might have reduced or missing color, or syncing might not be possible at all.

If you select SignalLock > Consumer in the Video Input tool, a wider bandwidth (more closely tracking time-base) improves the range of syncing capability. In this mode, the video input levels are set by automatic gain control. Not all of the Video Input tool’s adjustment sliders operate, and the video might be slightly softened, but the syncing in most cases is more reliable and more stable. The overall image quality is not as high as with normal operation.

The Video Input tool is not available on all models. If your model does not have the Video Input tool, your Avid editing application sets the default input options automatically.

If you continue to experience difficulty with a source that does not include an internal TBC, Avid recommends that you process the video signal through an external TBC for maximum image quality. For more information on time-base correctors, contact your Avid Reseller.

Green Line in VHS Video

Some VHS tape decks do not output the full 240 lines of video normally included in the VHS format. As a result, after you capture from a device such as a VCR, a green line might appear at the bottom of the monitors in your Avid editing application.

This line is at the bottom of the visible area of the picture, and is not seen in a standard consumer monitor in most cases. If you use the video in a circumstance in which the line is visible, you can remove it by cropping the bottom edge of the picture.

Saving Video Input Settings

You can save the settings for an individual tape each time you calibrate bars. Saved settings are restored each time you select the same tape for recapturing clips. The settings that are saved and restored are the Level adjustments made with the sliders and the selection status of the SignalLock or 100% Bars options.
**Preparing to Capture Video**

*Video Input settings do not restore the source format* (Composite, Component, S-Video, DV, or SDI). The source format you select in the Video Input tool remains the default for that project until you select another format from within the project. This lets you establish a new format on a project basis when moving between systems, or from the offline to the online phase.

*The Video Input tool is not available on all models. If your model does not have the Video Input tool, your Avid editing application sets the default input options automatically.*

⚠️ **If you do not use a name that matches the tape name, your system does not recall the setting automatically the next time you load the tape.**

Whenever you batch capture or select a tape name during capturing, your system recalls the saved settings as follows:

- Your system looks for a Tape setting with the same name as the tape. If the setting exists, your system recalls it.
- If no matching Tape setting exists, your system looks for a setting labeled “Default” and loads that setting.
- If no matching Tape setting or “Default” setting exists, the Video Input tool is left in its prior state (with the most recent settings applied during the session).

Tape settings and the Default setting are Project settings, and are available to the current project only.

**To save the calibration settings for a tape:**

1. After calibrating the video input, click the Settings menu in the Video Input tool, and select Save As.
   For more information, see “Calibrating Video Input” on page 223.
   The View Name dialog box opens.
2. Accept the default name (matching the tape name), or type a new name for the settings.
3. Click OK.

**To create a customized default Video Input Tool setting:**

1. Select Tools > Video Input Tool.
   The Video Input tool opens.
2. Adjust the Calibration settings.
   For more information, see “Calibrating Video Input” on page 223.
3. Click the Settings menu in the Video Input tool, and select Save As.
   The View Name dialog box opens.
4. Type **Default**, and click OK.
You must use this spelling and initial capitalization.

**Adjusting Video Levels for Tapes Without Color Bars**

Color bars are the best way to set the video levels consistently. However, if you have a tape or series of tapes with no color bars, you might need to adjust levels by using the internal Waveform and Vectorscope monitors.

*Calibrate your Client monitor before making these adjustments.*

The following table describes the criteria for adjusting video levels by eye, without color bars.

<table>
<thead>
<tr>
<th>Color</th>
<th>Adjustment Criteria</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blacks</td>
<td>Should not seem flat and lacking detail. Find a series of frames in the footage that include black areas. Shadows work better than black objects. Blacks should fall around 7.5 IRE for NTSC, 0 IRE for NTSC-EIAJ, or 0.3 V for PAL in the Waveform monitor.</td>
</tr>
<tr>
<td>Whites</td>
<td>Should not be washed out or lacking detail. Find a series of frames in the footage that include white areas. Bright, well-lit regions work better than white objects. Whites should peak at around 100 IRE for NTSC-EIAJ or 1.0 V for PAL in the Waveform monitor.</td>
</tr>
<tr>
<td>Skin colors</td>
<td>Should be realistic. Find a series of frames in the footage that include skin colors. Skin colors should fall generally between the target boxes for the red and yellow vectors in the Vectorscope monitor.</td>
</tr>
<tr>
<td>Pure yellows</td>
<td>Should be a rich gold and not reddish or greenish in tone. Find a pure yellow, and adjust both hue and saturation as necessary.</td>
</tr>
<tr>
<td>Chroma</td>
<td>Should not exceed 110 or fall below –120 in the Vectorscope monitor.</td>
</tr>
</tbody>
</table>

**Capture Preparations Check List**

☐ Check your hardware configurations, particularly connections between your deck and the Avid system. See “Preparing the Hardware for Capture” on page 172.

☐ If you are working on a complex project with multiple streams of video and high-resolution images, make sure your drives are striped properly. See “Getting Information About Striped Drives” on page 173.
Select options in the Media Creation Settings, Capture Settings, General Settings, and (if appropriate) Film and 24P Settings dialog boxes. See “Selecting Settings for Capture” on page 176.

Configure your deck or decks using Deck Configuration and Deck Preferences settings. See “Configuring Decks” on page 188.

Insert a tape into the deck, and set up the Capture tool for source tape, source deck, pulldown switch (24p projects), and other requirements. See “Setting Up the Capture Tool” on page 194.

Select audio settings, and set up the Audio tool. See “Preparing to Capture Audio” on page 207.

Use the Video Input tool to select the input source; set the video input levels for setup, gain, saturation, and hue; save your Video settings for future use. See “Preparing to Capture Video” on page 221.
Capturing Media

This chapter provides information on capturing media from video or audio input. When you capture, you convert source material into master clips that contain reference information and media files that contain the digital audio and video.

- Capturing and Logging at the Same Time
- Capturing Directly from a DV Device
- Capturing Audio from a Music CD
- Frame Chase Capture
- Batch Capturing from Logged Clips
- Recapturing and Decomposing
- Using Capture Function Keys
- Handling Errors During the Capture Process
- Creating Subclips While Capturing
- Adding Markers On-the-Fly While Capturing
- Naming a New Tape from the Keyboard While Capturing
- Controlling Decks from the Keyboard
- Adding Extra Text Fields in the Capture Tool
- Ejecting Tapes with a Button or Key
- Delaying Audio During Capture
- Working in Quick Record Mode
- Capturing in Satellite Mode or No Device Control
- Scheduling a Capture Session
- Capturing to the Timeline
- Capturing Video Without Pulldown into a 24p NTSC Project
- Remote Play, Capture, and Punch-In
- Relinking Clips by Key Number
- Modifying the Pulldown Phase After Capturing
Capturing and Logging at the Same Time

- DV and HDV Scene Extraction
- Using the Panasonic VariCam

For information about setting up the capture tools and adjusting capture settings, see “Preparing for Capture” on page 168.

Capturing and Logging at the Same Time

When you capture without entering log information in a bin ahead of time, your Avid editing application creates clips and associated media files while you capture. You manually cue source footage with an Avid-controlled deck, using the deck controls in the Capture tool.

If you entered log information in a bin, see “Batch Capturing from Logged Clips” on page 250.

There are several ways to capture and log at the same time:

- Capturing from a mark IN to a mark OUT: This method lets you specify the exact timecode location to begin and end capturing. You can specify both marks, or you can set only one mark and let your Avid editing application enter the other mark on-the-fly (see “Capturing by Setting Both Marks” on page 236 and “Capturing by Setting Only One Mark” on page 237).

  Use this method in the following circumstances:
  - If logs exist in written or printed form but not in the proper format for quick import into your system.
  - If the IN and OUT points are rough and need to be double-checked for accuracy.
  - If you are familiar enough with the source material to estimate the timecode for the mark IN, the mark OUT, or both, quickly and accurately.

- Capturing on-the-fly: This method is easier than setting marks, but less precise. It involves using the deck controls in the lower left corner of the Capture tool to cue, play, and stop the source footage manually while capturing. See “Capturing On-the-Fly” on page 237.

- Autocapturing: This method requires the least amount of supervision and effort, but usually calls for more capture time and drive storage space. Each source tape plays from a cue point near the beginning and your system captures the entire tape, automatically naming and entering each cut into the bin. See “Autocapturing” on page 240.

Capturing on-the-fly and autocapturing can cause incorrect pulldown and stuttering playback. Do not use these methods for capturing 24-fps film that has been transferred to NTSC video unless you have set the correct pulldown phase. See “Setting the Pulldown Phase” on page 158.
Two additional techniques you can use when capturing and logging at the same time are described in “Capturing from a Non-Avid-Controlled Deck” on page 241 and “Capturing with Time-of-Day Timecode” on page 242.

You can name clips and add comments before or during the capture of a clip. For more information, see “Naming Clips and Adding Comments in the Capture Tool” on page 234.

You can log and capture at the same time with either a PAL or NTSC film-to-tape transfer as the source. However, when capturing an NTSC transfer, you must observe the following basic rules:

- Specify the pulldown frame before capturing. See “Entering Pulldown Information” on page 160.
- The mark IN must be an A frame, and you cannot capture with a mark OUT only, unless you have set the correct pulldown phase. See “Setting the Pulldown Phase” on page 158.

**Naming Clips and Adding Comments in the Capture Tool**

You can type clip names and comments before or during the on-the-fly capture of a clip. This information is saved in the clip Name and Comments columns in the bin. You can add comments about such things as color correction or directions for editing.

If you do not type a clip name before or during capturing, your Avid editing application provides a default clip name. You can edit a clip name and add a comment in the bin.

> **To carry your comments over to the sequence so that they appear in the Timeline, in cut lists, or in EDLs, you must add the comments again when creating the sequence by using the Add Comments command in the Clip Name menu. For more information, see “Adding Comments to Sequence Clips” on page 612.**
To name a clip and add a comment before capturing:

1. Click the arrow in the Capture tool to display the Name and Cmnt text boxes.
2. Type a name for the clip.
3. (Option) Press the Tab key and type a comment.
   You can edit the text before capturing.

To add clip names and comments during capture:

1. Click the arrow in the Capture tool to display the Name and Cmnt text boxes.
2. Start typing the clip name at any time during the capture of a clip.
3. After typing the clip name, press the Tab key and type a comment.
   You cannot edit the text until after the capture is complete, but you can backspace to retype the comments.

If the Name text box is not visible on the Capture tool, you can type a clip name but you cannot view your typing. To display the Name text box, you must click the arrow before you begin capturing.
Capturing and Logging at the Same Time

Capturing by Setting Both Marks

To capture by specifying a mark IN and a mark OUT:

1. Select the proper Capture settings and set up the capture tools, as described in “Preparing for Capture” on page 168.

2. (Option) Click the arrow in the Capture tool to display the Name and Cmnt text boxes if you plan to enter clip names or comments.

You can enter this information before you capture a clip or while you are capturing a clip. See “Naming Clips and Adding Comments in the Capture Tool” on page 234.

3. Set either a mark IN or a mark OUT for the clip you want to capture, using one of the following methods:
   - Use the deck controls in the Capture tool. Cue your source tape to where you want to start or end the clip, and click the Mark IN or Mark OUT button.
   - If the material starts at a known IN point or ends at a known OUT point, you can type the timecode in the display area next to the mark. Press Enter (Windows) or Return (Macintosh) to enter the mark.

   To double-check the accuracy of the IN or OUT point, click the Go to IN button. The system cues the tape and pauses the deck at the mark. You can play the tape and reset the mark, if necessary.

4. Finish logging the clip, using either of the following methods:
   - Set the corresponding IN or OUT point.
   - Type a timecode for the clip’s duration in the text box next to the Duration mark (below the mark OUT) in the format HH:MM:SS:FF.

   Your Avid editing application automatically calculates the appropriate timecode for the corresponding mark IN, mark OUT, or duration.

5. Click the Record button in the Capture tool, or press the F4 key.

   The Capture tool automatically rewinds the tape to the preroll point before the IN point of the clip, and the tape begins to play. The Record button becomes bright red, and the message bar displays the message that your Avid editing application is capturing.

   When the tape reaches the clip’s OUT point, capturing stops and your Avid editing application creates a new clip in the bin. It also enters basic log information for each clip, consisting of the mark IN, the mark OUT, the duration, and any other information typed in during the capture procedure.

You can map the Record button from the Play tab in the Command palette to a key on the keyboard. This lets you start capturing by pressing a key. The Record button works for either the Capture tool or the Audio Punch-In tool, depending on which tool is active. For more information on mapping buttons, see “Understanding Button Mapping” on page 129.
6. If you did not type a clip name while capturing, type it now while the clip name is highlighted in the bin.

If you return to the Capture tool and begin another clip, the default clip name remains in the bin until you change it.

Capturing by Setting Only One Mark

**To set only one mark and enter the other mark on-the-fly:**

- Mark an IN point and click the Record button to begin capturing. Then, click the Record button again to stop capturing on-the-fly and mark an OUT point.

  This method is useful if you do not need a precise OUT point. You save time because you do not have to shuttle to locate the OUT point before capturing.

- You can map the Record button from the Play tab in the Command palette to a key on the keyboard. This lets you start capturing by pressing a key. The Record button works for either the Capture tool or the Audio Punch-In tool, depending on which tool is active. For more information on mapping buttons, see “Understanding Button Mapping” on page 129.

- Mark an OUT point only, then move to a position on the tape that is a few seconds before where you want to start capturing. Play the tape and then immediately click the Record button to begin capturing on-the-fly.

  When the tape reaches the clip’s OUT point, capturing stops.

  This method is useful if you do not need a precise IN point, but do need to stop at a precise OUT point, for example, just before a timecode break.

Capturing On-the-Fly

Use the capturing on-the-fly method in any of the following circumstances:

- If you need to begin editing immediately and no adequate logs exist for importing into the system or setting marks.
- If your source tape does not have timecode.
- If you are capturing from a digital source such as a CD or DAT player.
- If you are capturing from a live source, such as a satellite feed, or an in-house router.
- If you are capturing from a source deck that cannot be controlled by the Capture tool or a V-LAN VLXi unit.

There is a slight delay of several frames after you manually select a spot to either start or to stop capturing. Therefore, use this method when you do not need precise beginning and end points in your clip.
Capturing on-the-fly can cause incorrect pulldown and stuttering playback. Do not use this method for capturing 24-fps film that has been transferred to NTSC video unless you have set the correct pulldown phase. See “Setting the Pulldown Phase” on page 158.

In some circumstances, the captured material might exceed the 2-GB media file size limit. In such a case, set up the Capture tool to capture to multiple media files. For more information, see “Capturing to Multiple Media Files” on page 183.

To capture on-the-fly:

1. Select the proper Capture settings and set up the capture tools, as described in “Preparing for Capture” on page 168.

2. (Option) Click the arrow in the Capture tool to display the Name and Cmnt text boxes if you plan to enter clip names or comments.

   You can enter this information before you capture a clip or while you are capturing a clip. See “Naming Clips and Adding Comments in the Capture Tool” on page 234.

3. Use the deck controls in the bottom left corner of the Capture tool to locate the position on the tape where you want to start capturing.

---

Deck controls in the Capture tool

1. Shuttle button
2. Single-Frame Backward button
3. Single-Frame Forward button
4. Fast Forward/Rewind buttons
5. Stop button
6. Pause button
7. Play button
8. Eject button
9. Clear Marks buttons
4. To begin capturing, play the deck. When it gets up to speed, click the Record button or press the F4 key.

Make sure you clear any previous marks so the deck does not begin cueing to the previous location.

Capturing begins within a few frames, and the timecode for the clip’s IN point appears. The Capture indicator, to the right of the Record button, flashes on and off. The message bar displays a message that your Avid editing application is capturing.

You can map the Record button from the Play tab in the Command palette to a key on the keyboard. This lets you start capturing by pressing a key. The Record button works for either the Capture tool or the Audio Punch-In tool, depending on which tool is active. For more information on mapping buttons, see “Understanding Button Mapping” on page 129.

If your Avid editing system is an asset manager client in an MXF/AAF workgroup, you cannot create markers while capturing media using the Capture tool. However, you can use the Frame Chase feature when capturing media from a supported external device using Avid Interplay Transfer. For more information about using Frame Chase, see your Avid Interplay documentation.

5. Click the Pause button at any time to pause play.

You can also abort the capture procedure by clicking the Trash button. The clip is discarded.

6. To stop capturing and enter the OUT point of the clip, click the Record button, or press the Escape key on the keyboard.

Your Avid editing application creates a new clip in the bin. It also enters basic log information for each clip, consisting of the mark IN, the mark OUT, the duration, and any other information typed in during the capture procedure.

7. If you did not type a clip name while capturing, type it now while the clip name is highlighted in the bin.

If you return to the Capture tool and begin another clip, the default clip name remains in the bin until you change it.

Preparation to Autocapture

You can autocapture entire tapes to bypass both the logging and cueing processes necessary for other types of capture, as described in “Autocapturing” on page 240.
Before you begin autocapturing entire tapes, you should do the following:

- Select the following settings in the Capture Settings dialog box.
  - Capture to multiple files (Media Files tab)
  - Maximum default capture time (Media Files tab).
    Set this to the length of your tape. Do not underestimate, because the system captures for only the specified number of minutes.
  - Preroll Method (General tab)
    Set this to Best Available or Best Available Control Track
  - Capture across timecode breaks (General tab)
  - Log errors to the console and continue capturing (Batch tab)

For more information, see “Viewing and Modifying Settings” on page 1421 and “Capture Settings” on page 1446. You can also view this information by clicking the dialog box and pressing the F1 key (Windows) or the Help key (Macintosh).

- Turn off the FAST CUE option in the Deck Settings dialog box, and set the preroll to approximately 4 seconds. For more information, see “Deck Settings” on page 1461.

- Prepare accurate notes on the number and content of takes on each tape to identify the content of each clip when necessary.

### Autocapturing

Autocapturing an entire tape can save you time by allowing you to bypass both the logging process and the time it takes to cue each shot. However, this process requires the most storage space, and it takes time to capture an entire tape.

When you autocapture, you mount and cue your tape to a starting point and start the capturing process through the Capture tool. If you follow the tips and techniques described in this section, you can allow the system to complete the capturing process unattended.

Before autocapturing, you should make sure that you have taken the preparation steps described in “Preparing to Autocapture” on page 239.

⚠️ Your Avid editing application can capture across timecode breaks, but it cannot capture across control-track breaks in the recording (that is, if the recorded footage breaks up into noise between shots). If such breaks in recording exist on your tape, consider using the methods described in “Capturing On-the-Fly” on page 237.

⚠️ Capturing on-the-fly can cause incorrect pulldown and stuttering playback. Do not use this method for capturing 24-fps film that has been transferred to NTSC video unless you have set the correct pulldown phase. See “Setting the Pulldown Phase” on page 158.
Capturing and Logging at the Same Time

To autocapture:

1. Create one bin for each tape.
   This keeps bins to a manageable size and automatically names all clips from each tape after the name of their respective bins.
2. Name each bin after the source tape number.
   By default, all clips are named after the tape and are numbered incrementally beginning with .01.
3. Open the bin for the first tape and select Bin > Go To Capture Mode.
4. Select the proper Capture settings and set up the capture tools, as described in “Preparing for Capture” on page 168.
5. Load the source tape and cue past any false starts.
6. Play the tape, and wait 4 seconds before clicking the Record button.
   At the end of the tape, capturing stops and your Avid editing application creates a new clip in the bin.

You can map the Record button from the Play tab in the Command palette to a key on the keyboard. This lets you start capturing by pressing a key. The Record button works for either the Capture tool or the Audio Punch-In tool, depending on which tool is active. For more information on mapping buttons, see “Understanding Button Mapping” on page 129.

Capturing from a Non-Avid-Controlled Deck

If you have a deck that cannot be controlled directly by the system, you can capture with manual deck control.

To capture with manual deck control:

1. Select the proper Capture settings and set up the capture tools as described in “Preparing for Capture” on page 168.
2. Click the Toggle Source button in the Capture tool until the Deck Offline icon appears to disable the deck controls and leave only the Tape Name display.
3. Click the Timecode Source menu to select the deck.
4. Click the Tape Name display to open the Select Tape dialog box and identify the source tape.
You can select the option Show other projects to display the tape names and associated project names for all bins that were opened in the current session.

Because the media file database does not open when you start your Avid editing application, tape names of all online media files do not appear automatically.

If the tape name you are searching for does not appear in the Select Tape dialog box, click the Scan for tapes button to list tape and project names.

5. Provide your Avid editing application with a tape name in one of the following ways:
   - Select the name of the tape from the list in the Select Tape dialog box and click OK.
   - Click the New button if the tape is not in the list. A New Tape name line appears in the dialog box. Type the new name and click OK.

   The tape name appears in the Capture tool.

6. Play the tape manually and click the Record button to stop and start the capturing of each clip.

You can map the Record button from the Play tab in the Command palette to a key on the keyboard. This lets you start capturing by pressing a key. The Record button works for either the Capture tool or the Audio Punch-In tool, depending on which tool is active. For more information on mapping buttons, see “Understanding Button Mapping” on page 129.

For information about capturing with external timecode, see “Capturing in Satellite Mode or No Device Control” on page 278.

**Capturing with Time-of-Day Timecode**

When you capture with an Avid-controlled deck, you can capture your footage with time-of-day timecode rather than source timecode.

**To capture with time-of-day timecode:**

1. Select the proper Capture settings and set up the capture tools, as described in “Preparing for Capture” on page 168.

2. When selecting tracks, deselect the TC button.

3. Capture by using any of the techniques described in “Capturing and Logging at the Same Time” on page 233.
Capturing Directly from a DV Device

You can capture DV 25, DV 50, DVCPRO HD, and HDV media directly from a DV camera or deck (a DV device). You can also play and output directly to the DV device. To use a DV device, you must connect it your system correctly, as described in “Connecting a DV Device” on page 193.

Capturing DV 25 Media

If you are using an Avid Nitris DX or Mojo DX, or if you are not using an Avid input/output hardware device (software-only), you use a 1394 port on your computer (Host 1394). You specify that you are capturing via the 1394 port by selecting Host 1394 from the Video menu in the Capture tool.

Capturing DV 50, DVCPRO HD, or HDV Media

How you capture DV 50, DVCPRO HD, or HDV media depends on whether you are using Avid input/output hardware and on what type of Avid input/output hardware is connected to your system:

If you are using Avid input/output hardware, or if you are not using an Avid input/output hardware device (software-only), you use a 1394 port on your computer (Host 1394).

For information on playing back DV 50 and DVCPRO HD media, see “Playing Back to a DV Device” on page 541.

Selecting a DV Device

If your system has an Avid Nitris DX or Avid Mojo DX attached, you specify that you are capturing via 1394 by selecting Host 1394 from the Video menu in the Capture tool.

For information on connecting a DV device to your system, see “Connecting a DV Device” on page 193.

Understanding DV Capture Offset

DV capture offset lets you offset the incoming DV stream against the timecode assigned to each frame during capturing. This offset is only used in a transcoder configuration or in configurations where the DV stream does not encode timecode into the incoming DV frames.
**RS-422 Controlling a DV Device Configuration**

DV capture offset is primarily designed for configurations where an RS-422 controller is used to control a DV device and the DV stream is captured over a FireWire cable. For example, you might be working with an analog deck and a transcoder. You control the deck using RS-422, but the data moves from the deck to the transcoder, and then into your Avid editing application as a DV stream over a FireWire cable.

**FireWire Configuration Without Timecode**

You can also use DV capture offset in a configuration where the DV stream is captured over a FireWire cable, but the timecode of the master clip is not received through an RS-422 controller. When you adjust the DV capture offset in this configuration, results could vary, depending on the number of devices involved.

**FireWire Configuration with Encoded Timecode**

A configuration in which FireWire control is used to control a DV device and the DV stream is captured does not use this offset. In this case, the DV frames contain the encoded timecode.

**Example of a Capture with Offset**

The range of DV capture offset in your Avid editing application is from –6 to 24 frames with the default value set to 0. To use DV capture offset, perform several captures with the DV capture offset set to 0. Note the first frame of the master clip for each clip. If the first frame of the master clip is not what you expect, adjust the DV capture offset to account for this variation.

For example, the following illustration represents a RS-422-controlled capture where the timecode for capture comes in through an RS-422 controller. The first frame of the master clip is the sixth frame from the IN point on the tape.

![Example of a DV offset of 6 frames: tape frames (top) and master clip frames (bottom)](image)

To adjust for this device behavior, set the DV capture offset to –6 frames. The result should be a frame-accurate capture. However, the results are dependent on device behavior. If the device behavior for sending streams across a FireWire cable is inconsistent, frame-accurate results on capture are also inconsistent.
Capturing Audio from a Music CD

Capturing Audio from a Music CD

Avid editing applications let you capture selected tracks from a music CD. Once the audio is captured, you can then edit the audio clip to an audio track in your sequence.

The following procedure is one method of capturing audio from a CD or microphone in software-only models. Another method to capture audio, and the only way to import audio with Avid editing systems that have Avid input/output hardware attached, is to import the audio file. See “Importing Files” on page 297.

To capture audio from a music CD:

1. Insert the music CD into the computer’s CD-ROM drive.
2. Start the CD player application, and select the track you want to capture.
3. Minimize the CD player application.
4. Select Tools > Capture.
   The Capture tool opens.

Capturing DV Material with Offset

To offset the sequence for capture:

1. Click the Settings tab in the Project window.
2. Double-click Deck Preferences.
   The Deck Preferences Settings dialog box opens.
3. Determine the approximate offset, and then enter that offset in the Capture Offset (frames) text box.
4. Click OK.
   The delay is reflected in the DV Capture Offset box in the Capture tool.
5. Capture your material.
   See “Capturing by Setting Both Marks” on page 236 and “Capturing On-the-Fly” on page 237.
6. Repeat this process until you achieve the appropriate offset.
5. Click the Toggle Source button until the Satellite Mode icon appears.
6. Select an audio track.
7. Click the Audio menu, and select CD Player.
8. Click the Source Tape Display button.
    The Select Tape dialog box opens.
9. Click New.
10. Name the tape, and then select the tape.
11. Click OK.
12. Click the Record button in the Capture tool.
Your Avid editing application captures audio to the selected bin.

*You can map the Record button from the Play tab in the Command palette to a key on the keyboard. This lets you start capturing by pressing a key. The Record button works for either the Capture tool or the Audio Punch-In tool, depending on which tool is active. For more information on mapping buttons, see “Understanding Button Mapping” on page 129.*

13. Click the Record button again or press the Esc key to stop the capture.

The audio file appears in the bin.

14. When you are finished capturing music from the CD, quit the CD player application.

**Frame Chase Capture**

If your Avid editing application is part of a workgroup environment managed by Avid Interplay™, you can use the Capture tool to capture media to shared storage on the workgroup using your Avid editing application’s Frame Chase™ capture capabilities.

When you capture in this way, the media becomes available for viewing and editing from any applications in the workgroup while the capture is still in progress.

*You can also perform Frame Chase captures using a line feed or ingest device connected to the Interplay workgroup, for example, an Avid AirSpeed® video server controlled by an application such as Avid CaptureManager™. For more information, see the Avid Interplay Transfer Setup and User’s Guide or Avid Interplay Best Practices.*

**Understanding Frame Chase Capture**

To understand how Frame Chase capture saves and manages media files, you can compare the Frame Chase capture process with conventional capture performed within an Interplay workgroup environment (and therefore using the MXF file format). Frame Chase capture is only available in an Interplay environment.

**Conventional Capture**

A conventional capture creates media files (one for each track) in a temporary location (Avid MediaFiles\MXF\1\Creating on a media storage volume). These media files are not available for check-in to Interplay while the capture is in progress, and you cannot view or edit the files. When the capture ends, the files are moved to their final location (Avid MediaFiles\MXF\1). Only then are the files checked in to Interplay and made available for use.
**Frame Chase Capture**

A Frame Chase capture creates media files directly in Avid MediaFiles\MXF\1 and creates a special type of clip known as an in-progress clip. In-progress clips are represented by In-progress master clip and In-progress audio clip icons.

In-progress master clip icon (left) and in-progress audio clip icon (right)

An initial check-in to Interplay takes place 10 seconds after the capture begins. Subsequent updates to Interplay occur at intervals that you define in the Capture Settings dialog box.

As soon as the initial check-in takes place, the in-progress clip is available for viewing and editing on any applications in the workgroup. Portions of the clip’s media that have already been captured are visible in monitors, while portions of the clip that have not yet been captured are represented in monitors by a “Capture in Progress” slide.

Metadata associated with the clip (including information such as comments and markers added during capture) updates at the defined intervals. For example, you might be capturing an in-progress clip with the update interval set to 1 minute. A comment you enter 5 minutes and 20 seconds after capture begins is associated with the clip in Interplay (and therefore available to any applications in the workgroup) in the update that occurs 6 minutes after capture begins.

Your Avid editing application and Interplay might not know the true length of a capture in advance (because you can end a capture at any time). So the length of an in-progress clip is based on the expected duration of the clip when capture begins. This duration is either the duration indicated by IN and OUT points set in the Capture tool, or, if no marks are set, is a default duration that you define in the Capture Settings dialog box.

When the capture ends, a final update to Interplay occurs. This update changes the clip’s type from an in-progress clip to a conventional master clip, and if necessary changes the clip’s duration to the actual length of the capture.

You can also refresh AMA in progress clips when performing an edit while capture. From the Bin menu, select Refresh In-progress AMA Clips.

**Enabling Frame Chase Capture**

You use options in the Capture Settings dialog box to enable Frame Chase capture and to set both the default clip length and the interval for updates to Interplay.
To enable and set options for Frame Chase capture:

1. In the Settings tab of the Project window, double-click Capture.

   The Capture Settings dialog box opens.

2. Click the MXF Media Files tab.

3. Select options as described in the following table, and then click OK.

---

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum (default) capture time</td>
<td>Type a number in the text box to define the expected duration in minutes for a Frame Chase clip that you create during on-the-fly or open-ended capture (that is, when no IN and OUT marks are set in the Capture tool).</td>
</tr>
<tr>
<td>During capture, clip is updated in Interplay</td>
<td>When this option is selected, Frame Chase capture is enabled. An initial check-in takes place 10 seconds after a capture begins. Subsequent Interplay updates occur at intervals defined by the Update Interval option.</td>
</tr>
<tr>
<td>Update Interval</td>
<td>Select an update interval from the menu to determine how frequently updates to Interplay occur during the capture. In most circumstances it is preferable to keep the update interval low (1 minute or 2 minutes). This ensures that information added during capture (for example, comments or markers) is available as quickly as possible.</td>
</tr>
</tbody>
</table>

---

Requirements and Guidelines for Frame Chase Capture

You should be aware of the following when you are planning to perform Frame Chase captures:

- Frame Chase capture is only available on Avid editing applications that are part of an Avid Interplay workgroup environment. The media file format must be MXF. If your application is not connected to an Interplay workgroup, the “During capture, clip is updated in Interplay” setting in the Capture Settings dialog box is not available.

- Frame Chase capture is only available for the initial capture of clips using the Capture tool. Frame Chase capture is not possible during batch capture, and is not possible using other media creation methods such as import or transcode.

- Frame Chase capture is only possible if media files are captured to shared storage in the workgroup. If you select a local storage volume in the Capture tool, you override the “During capture, clip is updated in Interplay” setting in the Capture Settings dialog box and your Avid editing application performs a conventional capture.
• Frame Chase capture is not available for JFIF or HDV video resolutions. If you select a JFIF or HDV resolution in the Capture tool, you override the “During capture, clip is updated in Interplay” setting in the Capture Settings dialog box and your Avid editing application performs a conventional capture.

• The capture process itself is the same regardless of whether you are performing a conventional or a Frame Chase capture. You can rename clips, add comments or markers, and create subclips in the normal way during Frame Chase capture. This information becomes available to all applications in the workgroup following the next update to Interplay after the information is entered.

• If you abort a Frame Chase capture by clicking the Trash button in the Capture tool and then clicking Discard, your Avid editing application deletes the media files and the local clip, and indicates the aborted status by prepending the word “Aborted” to the clip name for the checked-in clip in Interplay.

> If you abort an in-progress clip, you delete the clip’s media even if it is being used in another sequence or for playback. Always verify that an in-progress clip is not being used anywhere in the workgroup before aborting the clip.

### Batch Capturing from Logged Clips

After you import a log or manually log a group of clips into a bin, you can automate the capture process by using your Avid editing application’s batch-capturing capabilities. When you batch capture, you open a bin, select the clips you want to capture, and select Clip > Batch Capture. Your Avid editing application automatically finds the start and end timecode for each clip and captures it. Source tapes from which you batch capture must have timecode that matches the timecode for the selected clips.

You can also use the batch-capturing process to recapture clips you have already captured. The recapturing process is described in “Recapturing and Decomposing” on page 254.

You cannot recapture a mixed-rate sequence without using decompose because you cannot batch capture material in formats other than the project format. A message box appears if you attempt to recapture such material. Instead, you can decompose the sequence, then recapture the resulting clips by opening the bin in projects that match each of the decomposed formats.

> When you capture footage from an NTSC film-to-tape transfer with pulldown, the playback flickers in the Client monitor during capturing because the system is dropping occasional frames due to the pullin process. The footage plays back smoothly in your Avid editing application, however, after the pullin conversion is complete.
Preparing to Batch Capture

Before you batch capture, you need to establish settings that allow the batch capture to take place with minimal supervision.

Because your clips are already logged in a bin, you can simplify the interface during batch capture by hiding the deck controller and logging controls in the Capture tool. You can hide any other panels in the Capture tool in a similar way.

Unattended batch capturing lets you capture a large number of clips with minimal supervision by selecting Capture settings that avoid a pause in the capture process.

To prepare for unattended batch capturing:

1. Double-click Capture in the Settings list in the Project window.
   The Capture Settings dialog box opens.
2. Click the Batch tab and select the following options:
   - Log errors to the console and continue capturing
   - Switch to the emptiest drive if current drive is full
   For additional options, see “Capture Settings: Batch Tab” on page 1447. You can also view this information by clicking the dialog box and pressing the F1 key (Windows) or the Help key (Macintosh).
3. Click the General tab and select “Capture across timecode breaks.”
   For more information, see “Selecting Settings for Preroll Method and for Capturing Across Timecode Breaks” on page 182.
4. Click OK.

You cannot batch capture clips that contain timecode breaks between the logged IN and OUT points. Also, you cannot capture across breaks in the recording (that is, if the recorded footage breaks up into noise between shots). If such breaks in recording exist on your tape, consider using the methods described in “Capturing On-the-Fly” on page 237.

Batch Capturing Clips

To batch capture clips:

1. Select the proper Capture settings and set up the capture tools, as described in “Preparing for Capture” on page 168.
2. Open the bin that stores the clips you want to capture.
3. Select the clips to batch capture:
   - Select Edit > Select All.
Ctrl+click to select specific clips.

If you are batch capturing the original source master clips used in the sequence, the sequence is updated automatically. Therefore, you might want to deselect the sequence during this procedure. See “Recapturing and Decomposing” on page 254.

4. Select Clip > Batch Capture.

The Batch Capture dialog box opens. If the clips you want to batch capture are not highlighted in the active bin, Batch Capture appears dimmed in the Clip menu.

5. Select options in the dialog box:
   - If the bin contains some clips that are already captured and you do not want to recapture those clips, select “Offline media only.” If this option is not selected and some of the selected clips have media files, your Avid editing application deletes the media files and recaptures new media files.
   - Select “All clips in a group edit” to allow capturing of each clip in a group clip.
   - If your selections include a sequence for batch capturing, the dialog box prompts you for handle length information. Your Avid editing application creates new master clips based on the length of edited clips in the sequence.
   - (Option) Select “Extend handles beyond master clip edges” to allow the handles to extend before the beginning and after the end of the original master clip.
When you batch capture, deselecting this option prevents capturing across a discontinuous timecode error.

For example, if the starting timecode for a master clip is 1:00:10:00 and the resulting master clip after a decompose with handles causes the new master clip to begin at 1:00:09:00, batch capturing fails if there are any timecode discontinuities between 1:00:09:00 and 1:00:10:00.

For more information on handle lengths when recapturing, see “Decomposing Sequences” on page 258 and “Recapturing a Sequence Without Using Decompose” on page 262.

6. Click OK.

If you have not loaded a tape, your Avid editing application prompts you to load the first tape.

7. Load the tape into the tape deck and click Mounted.

A dialog box opens.

8. Click OK to confirm the tape and deck entries and begin the capture process.

Your Avid editing application captures each clip from the tape, in start timecode order.

9. If your Avid editing application needs another source tape, it prompts you for the tape. At this point, you have several options. Do one of the following:

   ▶ Load the new tape and click Mounted to continue the capturing process.
   ▶ Select Skip this clip to bypass just the first clip from the tape and continue capturing the remaining clips.
   ▶ Select Skip this tape to bypass all the clips from the mounted tape. Your Avid editing application then prompts you for the next tape.
   ▶ Click Abort to end the batch-capturing process.

You can also stop capturing at any time by clicking the Trash button in the Capture tool.

To bypass specific clips in the process of batch capturing a particular tape, you must abort each clip manually by clicking the Trash button. Then click the Skip Clip button in the Abort window to continue.

When your Avid editing application has finished batch capturing, a dialog box notifies you that the process is complete.
Recapturing and Decomposing

Recapturing is the process of recording previously captured source footage based on existing clips and sequences. Recapturing uses the batch-capturing process and does not require extra logging time because the clip information for items, such as source tracks, timecodes, and compression settings, already exists in the bin.

Decomposing creates new, shorter master clips based only on the material you have edited into a sequence, which saves disk space. You can decompose an entire sequence, or you can use the Expert Decompose feature for additional control. For example, you can use Expert Decompose to decompose only some of the material in a sequence, or use it to “up-rez” your clips from SD to HD. After decomposing, you use the batch-capturing process to recapture footage for the new master clips.

Understanding Recapturing

There are three main situations in which you might want to recapture:

- The original media files are unavailable.
  For example, you might transfer a sequence to a system that does not have access to the original media files, or you might accidentally delete media files.

- The original media files have errors.
  For example, you might forget to check audio levels or set the wrong resolution when you first capture the media.

- You need to work in a different format from that of the original media files.
  For example, a common workflow involves offline editing using low-resolution clips followed by online editing using high-resolution clips.

Recapturing requires your original source footage. Do not delete the media files if the source footage is no longer available, unless you are sure you do not need the material.

For information on loading the media database to relink clips, see “Loading the Media Database” on page 490.

Recapturing Master Clips and Subclips

The procedure for recapturing master clips and subclips is identical to the process for batch capturing logged clips. See “Batch Capturing from Logged Clips” on page 250.
Although the procedure is the same, the result is slightly different, as follows:

- Master clips link to entire media files and serve as sources for subclips and sequences. When you recapture a master clip, changes in compression settings and levels affect all subclips and sequences created from the master clip.

- Subclips are smaller sections of master clips. When you recapture a subclip, your Avid editing application creates a new master clip that links to new media files and reflects the shortened length of material. Therefore, recapturing subclips streamlines the capturing process.

Also, recapturing breaks the link from the subclip to the original master clip. But if you edit the subclip into a sequence, the sequence reflects any changes in the newly captured subclip.

**Recapturing Sequences**

When you recapture a sequence, you create new master clips and associated media files based on the length of each clip edited into the sequence. Recapturing breaks any links to the original source clips, and only the sequence and its new master clips are linked to the newly captured media files.

You can recapture a sequence in two ways:

- Decompose to create new master clips, and then batch capture the clips.
- Recapture without using decompose, which creates new master clips and batch captures new media files in a single operation.

Although recapturing without using decompose might save a small amount of time, decompose offers much more control and flexibility. You should only recapture sequences without using decompose if you are sure you do not need any of the additional control decompose provides. For more information, see “Understanding Decompose and Expert Decompose” on page 256.

You cannot recapture a mixed-rate sequence without using decompose because you cannot batch capture or batch import material in formats other than the project format. A message box appears if you attempt to recapture such material. Instead, you can decompose the sequence, then recapture the resulting clips by opening the bin in projects that match each of the decomposed formats.

Consider creating a duplicate of the original version of your sequence before recapturing. You might also want to create a new bin to store the duplicate sequence and keep the new master clips created by the recapture or decompose operations separate from existing clips. For example, duplicate a sequence that uses low-resolution clips to save storage space if you want to recapture the sequence at a higher resolution while retaining the low-resolution version.

*If you use decompose, you can choose to create a duplicate sequence automatically in the Decompose dialog box. However, if you want to organize new master clips in a separate bin, you need to duplicate the sequence and place it in a new bin before you start the decompose process.*
Understanding Decompose and Expert Decompose

Decompose creates new master clips in the bin based on the lengths of the clips edited into a sequence. You can then recapture media for the new master clips. Decompose breaks any links to the original source clips, and only the sequence and its new master clips are linked to the newly captured media files. If decomposing results in a change to the edit rate of some clips in the sequence, your Avid editing application adds Motion Adapter effects, or modifies existing Motion Adapter effects, to manage the edit rate change.

Decompose gives you more control over the recapturing process than simply recapturing a sequence without using decompose. You can sort or modify the clips that decompose creates before you recapture media. You can also use the Expert Decompose feature to customize how decompose operates.

For film projects, clips you create with decompose retain all the information from the original master clips, including Pullin column information, key numbers, ink numbers, or any other information formerly entered in the bin.

You do not need to decompose clips that were linked with the AMA (Avid Media Access) method. For information about AMA, see “Acquisition of File-Based Media (AMA)” on page 394.

Expert Decompose

Expert Decompose lets you control the following aspects of the decompose process:

- You can select which material in the sequence to decompose, either by tape/source or by clip.
- For tapes/sources or clips that you can recapture in several different formats, you can select the target format to which you want to recapture.

For information on the available formats, see “Target Formats for Expert Decompose” on page 257.

If you decompose only some of the clips in a sequence, the resulting sequence contains some clips that remain linked to existing master clips and media (the clips you did not decompose) and other clips that are linked to new offline master clips (the clips you did decompose). Once you recapture media for the new master clips, all the clips in the sequence are available in the formats you have chosen.

There are several situations in which you might want to decompose some but not all of the clips in a sequence. For example, you might have made an error while capturing from only one of the tapes or sources you are using in the sequence. In this case, you can decompose the clips from just the one tape or source and recapture them. Or you might have a mixed-rate sequence that is composed mostly of low-resolution clips but that also contains some high-resolution clips. If you
want to up-rez the entire sequence for the online phase of your workflow, you might not need to recapture the high-resolution material, so you can decompose only the low-resolution parts of the sequence.

Expert Decompose is particularly useful when you need to recapture some or all of a mixed-rate sequence because you have complete control over what to decompose and which target formats to create. You can decompose to several different target formats if necessary, creating new master clips in the bin. You can then open the bin successively in projects that provide the correct format for recapturing, select the clips that match each project format, and batch capture those clips.

For information on activating and using Expert Decompose, see “Decomposing Sequences” on page 258 and “Using Expert Decompose” on page 260.

### Target Formats for Expert Decompose

The following table lists the target formats that are available using Expert Decompose. If the format of an existing clip is listed in the first column, you can decompose the clip to any of the formats listed in the second column, and then recapture the clip in that format. If the format of an existing clip is not listed in the first column, then you can only decompose and recapture it in its existing format.

The third and fourth columns indicate whether or not the format change involves a change to the source or edit frame rate.

<table>
<thead>
<tr>
<th>Existing Format</th>
<th>Target Formats</th>
<th>Source Rate Change</th>
<th>Edit Rate Change</th>
</tr>
</thead>
<tbody>
<tr>
<td>23.976p NTSC</td>
<td>23.976p NTSC 1080p/23.976</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>24p NTSC</td>
<td>24p NTSC 1080p/24</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>30i NTSC</td>
<td>30i NTSC 720p/29.97 720p/59.94 1080i/59.94 1080p/29.97</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>24p PAL</td>
<td>24p PAL 1080p/24</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>25i or 25p PAL</td>
<td>25i PAL 25p PAL 720p/25 720p/50 1080i/50 1080p/25</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>
Decomposing Sequences

You can decompose sequences to create new master clips that you can then recapture. For more information on this process, see “Understanding Decompose and Expert Decompose” on page 256.

To decompose one or more sequences:

1. Activate the appropriate bin and select the sequence or sequences.
2. Select Clip > Decompose.

   The Decompose dialog box opens.

3. To preserve clips that already have existing media files, select “Offline media only.”

   Do not select this option if you plan to decompose and recapture any material in the sequence or sequences that has available media.

4. Select other options for the types of clips to decompose: captured only, imported only, captured and imported, or all clips in a group edit.

5. Click the Handle Length text box and type the number of additional frames you want to capture at the heads and tails of the new master clips.

   This provides enough overlap for trimming and adding transition effects.
If you attempt to trim or add effects with no handles, you receive an error message notifying you that there is insufficient media.

6. (Option) Select “Extend handles beyond master clip edges” to allow the handles to extend before the beginning and after the end of the original master clip.

When you batch capture, deselecting this option prevents capturing across a discontinuous timecode error.

For example, if the starting timecode for a master clip is 1:00:10:00 and the resulting master clip after a decompose with handles causes the new master clip to begin at 1:00:09:00, batch capturing will fail if there are any timecode discontinuities between 1:00:09:00 and 1:00:10:00.

7. (Option) If you want to create a copy of each selected sequence to use for the decompose, select Create New Sequence.

When the decompose process starts, your Avid editing application creates a duplicate of each of the selected sequences, named using the suffix .Decomposed.xx. For example, the duplicate of a sequence named MySequence is named MySequence.Decomposed.01. Your Avid editing application decomposes the duplicate sequences, and the original sequences remain unchanged.

8. (Option) If you want to use Expert Decompose, select Expert Decompose, and then select one of the following options to control how information displays in the Expert Decompose dialog box:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display tapes/sources only</td>
<td>An item appears in the Expert Decompose dialog box for each tape or other source represented in the selected sequences. That is, this option groups all clips from each unique source into one item.</td>
</tr>
<tr>
<td>Display clips</td>
<td>An item appears in the Expert Decompose dialog box for each clip in the selected sequences. Depending on the number of sequences you have selected and the length of the sequences, this might result in a very long list of items in the Expert Decompose dialog box.</td>
</tr>
</tbody>
</table>

9. Click OK.

If you selected Expert Decompose in step 8, the Expert Decompose dialog box opens. For information on how to use this dialog box, see “Using Expert Decompose” on page 260.

New master clips appear in the bin, named using the suffix .new.xx. You can now sort and select these clips like all other objects in the bin.
Your Avid editing application selects a resolution for each new clip that is appropriate for the target format you select in the Expert Decompose dialog box. If the target format matches the current project type, your Avid editing application uses the capture resolution set in the Media Creation settings. Otherwise, your Avid editing application uses the resolution of the original clip or the default resolution for the project. The clip’s resolution is a default that you can override when you recapture.

10. Proceed with the recapturing procedures described in “Batch Capturing Clips” on page 251.

Using Expert Decompose

If you select the Expert Decompose option in the Decompose dialog box, the Expert Decompose dialog box opens before the decompose process begins.

In the Expert Decompose dialog box, you can:

- View information about the tapes/sources or clips in the sequences you are decomposing.
  
  If you select “Display tapes/sources only” in the Decompose dialog box, a line of information appears for each tape or source used in the sequences you are decomposing, and the information columns display the name of each tape or source, the original video resolution of the clip, the source frame rate, and the edit frame rate.

  If you select “Display clips” in the Decompose dialog box, a line of information appears for each source clip represented in the sequences you are decomposing, and an additional column displays the name of each clip.

- Sort the information in any of the columns.
- Select the tapes/sources or clips that you want to decompose.
- Select the target format at which you want to recapture the decomposed tapes/sources or clips.

The following illustration shows the Expert Decompose dialog box as it might appear if you select sequences that contain clips of a variety of different formats and then select “Display clips” in the Decompose dialog box. In some cases, the edit rate for a clip differs from the source rate.
Recapturing and Decomposing

For more information, see “Understanding Decompose and Expert Decompose” on page 256 and “Decomposing Sequences” on page 258.

To sort or reverse sort a column of information:
- Right-click the column heading for any column, and then select one of the following:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sort Column</td>
<td>Sorts the information in order, for example, alphabetically A to Z.</td>
</tr>
<tr>
<td>Reverse Sort</td>
<td>Sorts the information in reverse order, for example, reverse alphabetically Z to A</td>
</tr>
</tbody>
</table>

To select or deselect a single tape/source or clip to decompose:
- Click the check box for the tape/source or clip in the Decompose column.

To select or deselect multiple tapes/sources or clips to decompose:
1. In any of the information columns, click the first tape/source or clip you want to select.
2. Do one of the following:
   - To select a contiguous group of tapes/sources or clips, Shift+click the last tape/source or clip you want to select.
     
     Your Avid editing application selects the last tape/source or clip and all the tapes/sources or clips between the first and last.
   - To select or deselect additional tapes/sources or clips from anywhere in the list, Ctrl+click (Windows) or Command+click (Macintosh) on each tape/source or clip you want to select or deselect.
3. Right-click on any selected item, and then select one of the following:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include in Decompose</td>
<td>Selects the check box in the Decompose column for each of the selected items.</td>
</tr>
<tr>
<td>Exclude from Decompose</td>
<td>Deselects the check box in the Decompose column for each of the selected items.</td>
</tr>
</tbody>
</table>

To deselect all selected tapes/sources or clips:
- Click below the last item in any of the information columns.

To select the target format for a tape/source or clip:
- Select a format from the menu for the tape/source or clip in the Target Format column.
  - The available target formats vary depending on the source formats.
  - Some source formats can only be recaptured in their original format. For these formats, the entry in the Target Format column is only for your information, and you cannot select a different format.
  - For more information, see “Expert Decompose” on page 256.

To proceed with the decompose process:
- Click OK.

Recapturing a Sequence Without Using Decompose

When you recapture a sequence without using decompose, your Avid editing application creates new master clips and captures new media in a single operation.

For more information on recapturing a sequence with and without decompose, see “Understanding Recapturing” on page 254 and “Understanding Decompose and Expert Decompose” on page 256.

To recapture a sequence:
1. Select the proper Capture settings and set up the capture tools, as described in “Preparing for Capture” on page 168.
2. Open or activate the bin that stores the sequence.
3. Select Bin > Go To Capture Mode.
4. Select the sequence you want to recapture.
5. Select Clip > Batch Capture.
The Batch Capture dialog box opens.

6. To preserve clips that already have existing media files, select “Offline media only.”
   Deselect this option if you plan to recapture the entire sequence.

7. (Option) Select “All clips in a group edit.”

8. Click the Handle Length text box and type the number of additional frames you want to capture at the heads and tails of the new master clips.
   This provides enough overlap for trimming and adding transition effects.

   **If you attempt to trim or add effects with no handles, you will receive an error message notifying you that there is insufficient media.**

9. (Option) Select “Extend handles beyond master clip edges” to allow the handles to extend before the beginning and after the end of the original master clip.
   When you batch capture, deselecting this option prevents capturing across a discontinuous timecode error.
   For example, if the starting timecode for a master clip is 1:00:10:00 and the resulting master clip after a decompose with handles causes the new master clip to begin at 1:00:09:00, batch capturing fails if there are any timecode discontinuities between 1:00:09:00 and 1:00:10:00.

10. Click OK.
    Your Avid editing application prompts you to load the first tape.

11. Load the tape into the tape deck if you have not already done so.

12. Click Mounted to indicate to the system that the correct tape is loaded and ready for capturing.
    A dialog box opens.

13. Click OK to confirm the tape and deck entries.
    Your Avid editing application captures each clip from the tape, in start timecode order. If another source tape is needed, your Avid editing application prompts for the tape. You can stop the batch-capturing process at any time by clicking the Trash button in the Capture tool. A message box notifies you when batch capturing finishes. The new master clips appear in the bin, and associated media files exist on the targeted drive or drives.

**Alternate Source Capture**

Alternate source capture allows you to choose a different source name (Tape) and timecode (Start) to use when you perform a batch capture. This is helpful when the clips used in your sequence are from a submaster source tape that is different than the original master tape. For example, if during production you record RGB to HDCAM SR and then make color corrected
selects to HDCAM for the offline workflow, when mastering, it is best to go back to the original master tape and color correct from the HD RGB sources. When you create the original HDCAM tapes, the metadata displays as:

<table>
<thead>
<tr>
<th>TAPE</th>
<th>Color corrected submaster</th>
</tr>
</thead>
<tbody>
<tr>
<td>START</td>
<td>Timecode from color corrected submaster</td>
</tr>
<tr>
<td>Camroll</td>
<td>Tape name from original field HDCAM SR master</td>
</tr>
<tr>
<td>Auxiliary TC 1</td>
<td>Timecode from original field master</td>
</tr>
</tbody>
</table>

When you perform a batch capture of the Timeline or source clips, you can select and frame accurately batch capture from either the HDCAM submaster or the HDCAM SR master.

You can also use an alternate tape name if the original tape name was incorrectly logged. You can use any custom column in the bin as a source name when you batch capture in addition to Labroll, Camroll, and Soundroll, or you can correct for timecode offsets and store them in the Auxiliary TC column and batch capture from that.

When you use an alternate tape source, the tape does not have to display in the list of tapes. You can create a temporary tape for the capture process and remove it from the list once the batch capture is complete.

For more information and additional steps to batch capture, see “Preparing for Capture” on page 168 and “Batch Capturing Clips” on page 251.

To batch capture with an alternate source:

1. In a bin, select the clips you want to batch capture.
2. Select Tools > Capture to open the Capture tool.
   
   The Capture Tool opens.
3. Open the bin that stores the clips you want to batch capture.
4. Select the clips to batch capture:
5. Select Clip > Batch Capture.
   
   The Batch Capture dialog box opens.
6. Under the Alternate Source Options (Advanced), select the type of timecode from the Timecode Column menu that you want to batch capture from.
   
   Options depend on your project type. Timecode options can include: Start, Auxiliary TC1-TC5, Sound TC.
   
   If you choose a timecode other than Start, a message displays informing you that an Alternate Source is enabled.
7. Select the tape source from the Source Column menu that you want to batch capture from.
   Options depend on your project type and custom columns. Tape options can include: Tape, Camroll, Labroll, Soundroll, Custom Tape.

   To set the Timecode Column and Source Column menu selections back to the defaults (Start and Tape), click Reset.

8. Click OK.

   If any clips you select do not have the alternate source options you selected (for example, a clip does not have an Auxiliary timecode), a message displays and asks you if you want to skip those clips. Click Continue to continue with the batch process and skip those clips.

9. A message opens and asks you to mount the (alternate) tape.
   You can choose to mount the tape or skip this particular clip.

10. Load the tape into the tape deck and click Mounted.

    The deck rolls to the alternate source timecode and begins the capture process.
    Your Avid editing application captures each clip from the alternate source timecode and tape.

### Using Capture Function Keys

Several function keys are mapped to specific capture functions when the Capture tool is active. When you are not in Capture mode, these keys operate with their default keyboard shortcut mappings. For more information, see “Shortcuts” in the Help.

The following table lists the default functions. You can change the functions in the Keys tab of the Capture Settings dialog box.

<table>
<thead>
<tr>
<th>Press</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>F1</td>
<td>Mark the beginning of the subclip while capturing.</td>
</tr>
<tr>
<td>F2</td>
<td>Mark the end of the subclip while capturing.</td>
</tr>
</tbody>
</table>

⚠️ Capturing on-the-fly can cause incorrect pulldown and stuttering playback. Do not use the F1 or F2 keys for capturing 24-fps film that was transferred to NTSC video unless you have set the correct pulldown phase. See “Setting the Pulldown Phase” on page 158.
### Press  To

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>F3, F5 through F12</td>
<td>Add a marker to the current frame while capturing. Each Function key adds a different color marker. See “Adding Markers On-the-Fly While Capturing” on page 269.</td>
</tr>
<tr>
<td>F4</td>
<td>In Capture mode, start the capture process. During capture, end a comment for a marker. In Log mode, press once to mark an IN point. Press again to mark an OUT point to log the clip in the bin.</td>
</tr>
</tbody>
</table>

**To change function key commands for capturing media:**

1. Double-click Capture in the Settings tab in the Project window.
   
   The Capture Settings dialog box opens.

2. Click the Keys tab.

3. Click the key you want to map, and then select the new function from the menu.

---

*The Start Capture function is not included in the key menus. F4 always starts capture. You can map an additional function to F4 to use after capture starts; End Marker Entry is the default.*

4. Click OK.
Handling Errors During the Capture Process

You can log errors that occur during the capture process to the Console window. If you are not logging, you can respond to errors if they occur.

For more information about the Console window, see “Using The Console Window” on page 134.

To enable or disable logging to the Console window during capture:

1. Double-click Capture in the Settings tab in the Project window.
   The Capture Settings dialog box opens.
2. Click the Batch tab.
3. Select or deselect “Log errors to the console and continue capturing.”
   - If “Log errors to the console and continue capturing” is selected, when you batch capture and your Avid editing application encounters an error, it aborts the clip, enters error comments into the Console, and continues capturing the next clip.
   - If “Log errors to the console and continue capturing” is not selected, a message appears and your Avid editing application pauses if an error occurs while capturing. If this happens, use the last procedure below.
4. Click OK.

To open the Console window:

Select Tools > Console.

To respond when your Avid editing application pauses during capture and is not logging to the Console:

1. Click Try Again to retry the operation.
   The clip might capture successfully.
   If the clip does not capture the second time you try, the error message appears again.
2. Click Next Clip to bypass the clip that caused the error and continue batch capturing any remaining clips, or click Abort to cancel the entire batch capturing process.
3. Note all errors, messages, and steps you have taken. Try to troubleshoot the problem on your own, or contact Avid Customer Support.

Creating Subclips While Capturing

You can create subclips on-the-fly while capturing, or you can create timed subclips. The maximum number of subclips you can generate while capturing a clip is 100.
You instruct your Avid editing application to create a timed subclip automatically when you press a function key that you have mapped to the Timed Subclip button. Your Avid editing application creates IN and OUT points at predetermined intervals before and after the point you identify in the source media by pressing the button. For information on mapping capture functions to function keys, see “Using Capture Function Keys” on page 265.

For information about creating subclips after capturing, see “Creating Subclips” on page 547.

You should be aware of the following while creating subclips while capturing:

- When you create subclips in 24p or 25p projects, they are always “hard” subclips. You cannot trim past the edges of the subclip when adjusting transitions and edits. Hard subclips prevent film-tracking information errors for editing and cut lists.
- For NTSC film-to-tape transfers, you must log the correct pulldown phase before you create subclips. For more information, see “Setting the Pulldown Phase” on page 158.
- If your Avid editing system is an asset manager client in an OMF workgroup, and you are capturing with shared volume segmentation (“chunking”) enabled, see your Avid shared storage documentation for details on the capture procedure.
- If your Avid editing system is an asset manager client in an MXF/AAF workgroup, you cannot create subclips while capturing media using the Capture tool. However, you can use the Frame Chase editing feature when capturing media from a supported external device using Avid Interplay Transfer. For more information about using Frame Chase editing, see “Using Frame Chase Editing” in Avid Interplay Best Practices.

To create a subclip on-the-fly:

1. Start capturing.
2. At the point where you want the subclip to begin, press the F1 key.
   This highlights the subclip IN point.
3. While you capture, you can type a name for the subclip. Press the Tab key to type comments about the clip.
4. When you want the subclip to end, press the F2 key.
   This highlights the subclip OUT point.
5. (Option) Press the F2 key repeatedly as you search for the end point of the subclip.
   Your Avid editing application accepts the last occurrence as the end point.
   You can also press the F1 key at any time before pressing F2 again to remove the previous subclip marks and to start a new subclip IN point.
   The subclip appears in the target bin when you stop capturing. When capture is complete, a number appears between the subclip indicators to show the number of subclips created.
To set the duration of a timed subclip:
1. Double-click Capture in the Settings tab in the Project window.
   The Capture Settings dialog box opens.
2. Click the Keys tab.
3. Enter the time in minutes and seconds to be used by the timed subclip in the Before mark (M:SS) and the After mark (M:SS) text boxes.
4. Click OK.

To create a timed subclip:
1. Start capturing.
2. At the point where you want to start a timed subclip, press the mapped function key.
   This highlights the subclip IN and OUT points, and your Avid editing application creates the subclip automatically.
3. While your Avid editing application is capturing, you can type a name for the subclip. Press the Tab key to type comments about the clip.

Adding Markers On-the-Fly While Capturing

You can use function keys to add markers on-the-fly while capturing. When the Capture tool is active, eight colored markers are mapped to the F5–F12 function keys on the keyboard, and the End Marker Entry key is mapped to F4. The markers override any other functions mapped to these keys.

If your Avid editing system is an asset manager client in an OMF workgroup, and you are capturing with shared volume segmentation (“chunking”) enabled, see your Avid shared storage documentation for details on the capture procedure.

If your Avid editing system is an asset manager client in an MXF/AAF workgroup, you cannot create markers while capturing media using the Capture tool. However, you can use the Frame Chase editing feature when capturing media from a supported external device using Avid Interplay Transfer. For more information about using Frame Chase editing, see “Using Frame Chase Editing” in Avid Interplay Best Practices.

For more information about markers, see “Using Markers” on page 550.

To add a marker to a frame while capturing:
1. Start capturing.
2. Watch the playback of the footage in the monitor, and press one of the marker keys (F5–F12) when you see the shot or frame with which you want to associate a marker.
A default name and number for the marker appear in the Name text box in the Capture tool.

3. While you capture, you can add comments for the marker. Press the Tab key to move the cursor to the Comments text box, and type your comment.

4. When you finish adding your comment for the marker, press the F4 key (End Marker Entry).

The Name and Cmnt (Comment) text boxes revert to association with the master clip or the subclip being captured. Marker comments appear in the Markers window.

5. To see the marker comments, open the Markers window as described in “Viewing Markers in the Markers Window” on page 560.

**Naming a New Tape from the Keyboard While Capturing**

You can name a new tape without taking your hands off the keyboard.

**To create a new tape name by using a keystroke in Capture mode:**

1. Select Tools > Capture.
   
The Capture tool opens.

2. Do one of the following:
   - Load a tape in the deck.
   - Click the Source Tape Display button.
   
The Select Tape dialog box opens.

3. Press Ctrl+N (Windows) or Command+N (Macintosh).
   
A new tape name text box opens.

4. Type the new tape name.

5. Press Enter (Windows) or Return (Macintosh) to register the tape name.

6. Press Enter (Windows) or Return (Macintosh) or click OK to close the Select Tape dialog box.

**Controlling Decks from the Keyboard**

You can use the J-K-L keys to control a deck from the Capture tool, Digital Cut tool, and Deck Controller window.

The J-K-L keys work in the same way as they do in the Source and Record monitors. See “Playing Footage with the J-K-L Keys (Three-Button Play)” on page 539.
Adding Extra Text Fields in the Capture Tool

In addition to the Name and the Cmnt (Comment) fields in the Capture tool, you can enter up to 10 extra text fields before and during capturing. Your Avid editing application stores the typed information with the captured clip in the bin, and the extra text fields appear as columns in the bins.

To add extra text fields:

1. Select Tools > Capture.
   The Capture tool opens.

2. Click the Extra Field Selection button.
   The Field Selection dialog box opens.

3. Click the New Field button
   The New Field Name dialog box opens.

4. In the Field Name text box, type the name you want to appear as a text field in the Capture tool.
   This is also the name that appears in the bin column heading.

5. Click OK in the New Field Name dialog box.

The following restrictions apply:

- You must select the Capture tool, Digital Cut tool, or Deck Controller window for the keys to be active.
- Single-field stepping is not supported.
- If you remap the function of the J-K-L keys, you can no longer control decks with those keys.

### Press | To
---|---
K | Stop the deck.
L | Shuttle the deck at 1x, 2x, 3x, 5x, 8x, 16x, or 24x normal speed.
J | Shuttle the deck at –1x, –2x, –3x, –5x, –8x, –16x, or –24x normal speed.
K+L | Shuttle the deck at 0.25x normal speed.
J+K | Shuttle the deck at –0.25x normal speed.
The Field Selection list opens with your new text field selected. If you do not capture and use the new extra text field after creating it, your Avid editing application does not save the new text field in the Field Selection list or bin.

6. Click OK in the Field Selection dialog box.

The new text field appears in the Capture tool. Press the Tab key to move between fields while capturing.

**To display or hide text fields:**

1. Select Tools > Capture.

The Capture tool opens.

2. Click the Extra Field Selection button.

The Field Selection dialog box opens.

3. Do one of the following:
   - Select the text fields that you want to display in the Capture tool.
   - Click Select None to hide the extra text fields in the Capture tool.

4. Click OK.

Only the selected fields appear in the Capture tool.

**To delete extra text fields:**

1. Click the column heading in the bin.

2. Do one of the following:
   - Select Edit > Delete.
   - Press the Delete key.

Your Avid editing application deletes the column from the view and the entry from the Field Selection list.
Ejecting Tapes with a Button or Key

If you click the Eject button and eject a tape, you can bring the fact that the tape must be changed to the attention of any tape operator in a remote machine room.

To eject tapes by using a button:
1. Select Tools > Command Palette.
2. Click the Play tab.
3. Select Active palette.
4. Click the Eject button.

You can map the Eject button to any button on the Tool palette or any key on the Keyboard palette. See “Mapping User-Selectable Buttons” on page 131.

Using Dolby E Media

Dolby® E is an audio coding technology created by Dolby Labs that compresses up to 8 channels of audio and metadata into 2 channels. This enables the distribution of multichannel audio within a stereo track or on two mono tracks which you can then use in your Avid editing project. Dolby E support is available for Avid systems using the following Avid hardware: Avid Nitris DX and Avid Mojo DX.

The workflow for using Dolby E clips includes the following steps:
- Select the “Keep Dolby E Material Safe” setting in the Audio Project Settings dialog box to ensure the capture of Dolby E media.
- Use the Capture tool to bring Dolby E media into your project. A Dolby E Safe button in the Capture tool indicates that your audio settings protect Dolby E media information.
- Add the Dolby E clip to your sequence, and edit the video and audio. Your Avid editing application maintains synchronization between audio and video as long as you do not convert or modify the Dolby E clip.
- When you finish editing, output the sequence. The Dolby E track preserves the encoded data and can be restored to the original multichannel audio.

If editing the sequence modifies your audio settings in a way that prevents the Dolby E information from being preserved, you cannot output or mix down your sequence with the original Dolby E metadata. You should reset your Audio Project settings before you output your sequence by an export operation or by using the Digital Cut tool, or if you mix down your sequence.
If you are working in a film project, you cannot use pulldown settings when you capture your media if you want to use Dolby E material. Avid does not support capturing Dolby E media with audio pulldown because pulldown interferes with the preservation of Dolby E information.

Selecting Dolby E Safe Settings

You can automatically set your Avid editing system to protect Dolby E information during capture. Selecting Dolby E safe settings changes the following options in the Audio Project Settings dialog box and the Passthrough Mix tool:

<table>
<thead>
<tr>
<th>Location</th>
<th>Option</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio Project Settings (Main tab)</td>
<td>Sample Rate</td>
<td>48 kHz</td>
</tr>
<tr>
<td>Audio Project Settings (Main tab)</td>
<td>Bit Depth</td>
<td>24 bit</td>
</tr>
<tr>
<td>Audio Project Settings (Main tab)</td>
<td>Convert Sample Rates When Playing</td>
<td>Never</td>
</tr>
<tr>
<td>Audio Project Settings (Input tab)</td>
<td>Input Gain Slider</td>
<td>0 dB (unity gain)</td>
</tr>
<tr>
<td>Audio Project Settings (Input tab)</td>
<td>Sample Rate Conversion</td>
<td>Never</td>
</tr>
<tr>
<td>Audio Project Settings (Input tab)</td>
<td>Output Sync During Passthrough</td>
<td>Same as Audio In</td>
</tr>
<tr>
<td>Audio Project Settings (Output tab)</td>
<td>Mix Mode Selection</td>
<td>Direct Out</td>
</tr>
<tr>
<td>Passthrough Mix tool</td>
<td>Input Mix Mode</td>
<td>Direct Out</td>
</tr>
<tr>
<td>Passthrough Mix tool</td>
<td>Input Gain Slider</td>
<td>0 dB (unity gain)</td>
</tr>
</tbody>
</table>

When you output your sequence either by selecting an export operation or by using the Digital Cut tool, or when you mix down the sequence, you must reset your Audio Project settings if a change in your sequence prevents the safe output of Dolby E information.

To select Dolby E safe settings:

1. In the Project window, click the Settings tab, and then double-click Audio Project.

   The Audio Project Settings dialog box opens.
2. Click the Main tab.

3. Click Keep Dolby E Material Safe, and select Yes.

   If you modify your sequence to change any of these settings, the Keep Dolby E Safe setting automatically changes to No. You can reset the settings by selecting Yes.

**Capturing Media with Dolby E Information**

The Capture tool includes a Dolby E Safe button in the Message bar that indicates if your audio settings protect the capture of Dolby E material. The button displays blue when the Keep Dolby E Material Safe option in the Audio Project Settings dialog box is set to Yes. If your audio settings do not protect Dolby E information, the button displays yellow.

**Capture tool with blue Dolby E Safe button**

*The Dolby E Safe button appears only on systems using the following Avid hardware: Avid Nitris DX and Avid Mojo DX.*
To capture media while protecting Dolby E information:

1. In the Main tab of the Audio Project Settings dialog box, click Keep Dolby E Material Safe, and select Yes.
3. Check to make sure the Dolby E Safe button displays blue.
   If the Dolby E Safe button displays yellow, reset the Dolby E Safe settings in the Audio Project Settings dialog box (see “Selecting Dolby E Safe Settings” on page 274).
4. Capture your media using the appropriate capture method. For more information, see “Capturing Media” on page 232.

Delaying Audio During Capture

Sometimes the source from which you are capturing provides an audio signal that is one or more frames ahead of the video. For example, the Panasonic AG-DVX100 DV camcorder always records audio one frame ahead of the video. Also, a timebase corrector (TBC) or other video processing device on your input signal might introduce fixed frame delays of video.

If the input signal is not DV when you choose your IN point, the audio that lines up with the IN point should remain in sync with the captured media. The video is what shifts in the captured media. If the input signal is a DV signal however, then the audio shifts.

If the audio you are capturing is always at a fixed offset ahead of the video, use the Delay Audio feature to correct this problem and produce a master clip with correct A/V sync.

To offset your audio:

1. Select Tools > Capture.
2. Select the number of offset frames from the Delay audio menu.
3. Capture your material.
4. Play the captured media to verify that the audio and video are in sync.

Working in Quick Record Mode

Quick Record mode allows the deck to control the capture of media into Avid editing systems. In Quick Record mode, your Avid editing application starts capturing automatically whenever the servo-lock signal is detected from the deck. When Servo Lock mode is detected (the deck is playing), capturing begins and continues until play is stopped, at which point it will wait for the next servo-lock signal.
To use Quick Record mode, you must connect a deck that supports servo-lock signals to the system by using a deck control serial cable and a serial adapter. For information about the cable connection, see the setup information that came with your system.

If the appropriate conditions for Quick Record are not present, the messages in the following table might appear. The second column recommends what you can do to be ready for the Quick Record mode.

<table>
<thead>
<tr>
<th>Message</th>
<th>Cause or Action Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>No deck</td>
<td>A deck is not selected in the Capture tool or the system does not detect a deck. Make sure the deck is connected, turned on, and selected in the Capture tool.</td>
</tr>
<tr>
<td>No tape in deck</td>
<td>The system does not detect a tape in the deck. Make sure a tape is in the deck.</td>
</tr>
<tr>
<td>No source tape selected</td>
<td>Give the source tape a name in the Capture tool. Click the Source Tape Display button and name the tape.</td>
</tr>
<tr>
<td>Selected deck will not Servo Lock</td>
<td>Some deck models do not generate a servo-lock signal. This is defined in the deck’s template.</td>
</tr>
</tbody>
</table>

If this message appears, make sure you have the correct deck selected in the Deck Selection pop-up menu. If the message continues, you cannot use the deck with Quick Record mode.

Deck not in Local mode
Quick Record mode requires the deck to be in Local mode.

To use Quick Record mode:

1. Select Tools > Capture.

   The Capture tool opens.

2. Click the Toggle Source button until the Deck Capture icon appears.

3. Click the Deck Selection pop-up menu, and select your deck.

   See “Setting Up the Capture Tool” on page 194.

4. Click the Servo Lock Mode button.

   A check mark appears in the button and the Toggle Source button changes to the Quick Record Mode icon.

5. When the “Waiting for Servo Lock” message appears in the message area of the Capture tool, press the deck’s Play button.

   The system starts capturing when the deck is in servo lock and stops capturing when the deck is not in servo lock (for example; stopped, rewinding, or shuttling).
During Quick Record mode, the timecode display for the deck shows the timecode followed by “* LOCAL”; for example: 00;01;05;14 * LOCAL.

**Capturing in Satellite Mode or No Device Control**

LTC (longitudinal or linear timecode) from an external source lets you capture from multiple sources at the same time as recording to tape. This is called satellite Mode. If your facility has a central timecode generator you can use that clock to send identical timecode to all systems. You can run this timecode output directly to your Avid system through the LTC IN connection available on some Avid input/output hardware.

*Discontinuous timecodes are not checked during this type of capture.*

Satellite mode using external timecode is especially useful for live events, dramatic multicamera shows, and video material coming in on routers that do not support timecode. You can start editing immediately after the shoot without waiting to capture from the backup reference tapes.

If you are capturing 24p film, however, you need to account for the pulldown phase, which allows for 24p capture to have the same behavior as a video rate. Your selection in the Set Pulldown Phase of Timecode (A, B, X, C, or D) area in the Film and 24p Settings dialog box determines what type of pulldown the system uses during the 24p capture. Only non-drop-frame timecode is supported with the Pulldown Phase of Timecode option.

A 23.976p video-only capture is supported only with the Advanced Pulldown cadence of 2:3:3:2 as created by the Panasonic cameras AG-DVX100 and the AG-SDX900 NTSC versions. When creating a 23.976 project in these products, capture always assumes the pulldown cadence to be “advanced.”

Setting IN and OUT points is especially useful if you are taking a feed from a source based on a time-of-day timecode generator. Your Avid editing application begins to capture when the time of the external timecode source matches the IN point, and stops when the external timecode matches the OUT point.

*You can log an event ahead of time and it automatically starts recording that signal when the internal clock or external LTC arrives at that timecode. For example, if you log a clip at 14:00:00:00 to 14:30:00:00 sometime before 2:00 pm, the capture starts at 2:00 pm and ends at 2:30.*

**To capture with external timecode:**

1. Select Tools > Capture.
   
   The Capture tool opens.
2. Select the audio, video and data tracks.
3. Select the audio and video input.
4. Click the Timecode Source menu, and select one of the following (the devices that appear in the Timecode Source menu originate from the current Deck Configuration settings):

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internal</td>
<td>Uses internal system timecode.</td>
</tr>
<tr>
<td>LTC Input</td>
<td>Detects LTC input. LTC is only available with some Avid input/output hardware devices. If LTC is not available for your configuration, the LTC Input option is grayed out.</td>
</tr>
<tr>
<td>Auto Detect</td>
<td>Detects LTC input by default. If the LTC Input is deactivated, the Capture tool automatically switches to internal timecode. If the LTC Input is reactivated, the Capture tool switches back to LTC Input.</td>
</tr>
</tbody>
</table>
5. Click the Source Tape Display button.

The Select Tape dialog box opens. Because the media file database does not open when you start your Avid editing application, tape names of all online media files do not appear automatically.

6. If the tape name for which you are searching does not appear in the Select Tape dialog box, click the Scan for Tapes button.

Tape and project names appear in the list of tapes.

7. Provide a tape name in one of the following ways:
   - Select a tape name from the list.
     Tape names and associated projects are listed in two columns.
   - If the tape is not in the list, click New, and then type a new tape name in the text box that appears at the bottom of the Tape Name list.
   - Click the Source Tape Display to display the tape names and associated project names for all bins that have been opened in the current session.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Firewire Timecode</td>
<td>Detects timecode over a FireWire connection. FireWire Timecode is only listed if you have a FireWire deck configured in the Deck Configuration dialog box. See “Configuring Decks” on page 188.</td>
</tr>
<tr>
<td>RS422 Timecode</td>
<td>Detects timecode over a serial connection. RS422 Timecode is only listed if you have an RS422 deck configured in the Deck Configuration dialog box. See “Configuring Decks” on page 188.</td>
</tr>
</tbody>
</table>
Scheduling a Capture Session

You can schedule a capture session for upcoming live satellite feeds by placing the Capture tool in Scheduled Record mode.

When the time-of-day timecode is within 10 seconds of the next scheduled capture time (and if the Capture Tool window is still active) the Capture tool enters Coincidence Wait mode (blinking yellow record light) and then begins capturing. When the capture is complete, the Capture tool updates the timecode entry fields for the next scheduled capturing session.

You can still use the Capture tool with Scheduled Record mode enabled as long as you stop using the Capture tool before the next scheduled capturing session. You cannot start a scheduled live feed capture if the Capture tool is in use. The Capture tool must be the active window for a scheduled capturing to occur.

To schedule a capture session:

1. Select Tools > Capture.
   The Capture tool opens.
2. Click the Toggle Source button until the Satellite Mode icon appears.
3. Click the Setup Capture Schedule button.
   The Scheduled Record dialog box opens.
4. Do one of the following:
   ▶ Type the clip name, start time, and clip duration in the appropriate columns.
   ▶ Click Load and navigate to a tab-delimited text file of a schedule.
   If a clip has a start time that overlaps the end of the previous scheduled clip, it appears red.

Stop the process at any time by clicking Cancel.
For guidelines on naming tapes, see “Naming Tapes” on page 148.
8. Click OK.
   The tape name is displayed in the Capture tool.
9. Play the tape manually from the deck or media source, and click the Record button to start and stop capturing of each clip.
   For more information, see “Capturing On-the-Fly” on page 237.
10. If you notice that your captured material is consistently one or more frames off, select “Latency for satellite mode” in the General tab in the Capture Settings dialog box to fix the problem.
   For more information, see “Capture Settings: General Tab” on page 1446.
5. (Option) You can save a schedule as a tab-delimited text file and load it at a later date. Click Save to save your schedule list as a tab-delimited text file.

6. Select the Scheduled Record Mode option.

7. Select how to capture the satellite feed:
   - Select Once to capture the satellite feed one time. Any clips with a start time earlier than the current time-of-day timecode appear yellow.
   - Select Loop to repeat the schedule every day.

8. Click OK.

The Toggle Source button displays the Satellite Mode icon with a clock and the Setup Capture Schedule button changes to green. The timecode fields appear dimmed and contain the information for the upcoming capture session.

![Toggle Source button with clock icon (left) and Setup Capture Schedule button (right) when Scheduled Record Mode is active](image)

To clear the scheduled capture:
1. Select Tools > Capture.
   The Capture tool opens.
2. Click the Toggle Source button until the Satellite Mode icon appears.
3. Click the Setup Capture Schedule button.
   The Scheduled Record dialog box opens.
4. Click Clear.
5. Click OK.

**Capturing to the Timeline**

You can capture footage directly from tape to a sequence loaded in the Timeline in one step, bypassing several steps such as organizing and reviewing clips, marking edit points, and performing edits.

By default, your Avid editing application edits the tracks you select for capturing to the corresponding tracks in the Timeline. You can patch the captured footage to any track in the Timeline.
You can also patch tracks in the Timeline in the same way you patch tracks when editing from the Source monitor. See “Patching Tracks” on page 709.

Only tracks that are enabled in the Timeline are available for patching. Other tracks appear dimmed in the menu.

To capture to the Timeline:

1. Prepare for capturing.
   See “Preparing for Capture” on page 168.

2. Set options in the Capture Settings dialog box:
   a. Click the Settings tab in the Project window.
   b. In the Settings list, double-click Capture.
      The Capture Settings dialog box opens.
   c. Click the Edit tab.
   d. Select “Enable edit to timeline (splice, overwrite)”.
   e. Set the handle length (the amount of footage you want to capture before and after the IN and OUT points of the clips).
   f. Click OK.

3. Load a sequence into the Record monitor.

4. (Option) Patch tracks you are capturing (source tracks) to the tracks in your sequence (record tracks):
   a. In the Capture tool, click and hold the Track Selector button for the track (video, data, or audio) you want to patch.
      There is only one data track to select, you cannot patch a data track to any other track.
   b. From the menu, select the track to which you want to patch the captured footage.
5. Mark an IN point in the sequence or move the position indicator to where you want the edit to take place.

6. Mark the source material you want to capture by using the Capture tool logging controls. For more information, see “Logging with Avid-Controlled Decks” on page 148.

7. (Option) Mark an OUT point based on the following:
   - If you are recording to the middle of a sequence in the Timeline, mark both IN and OUT points for frame accuracy.
   - If you are recording to the end of a sequence, you can mark just an IN point and then mark the OUT point later on-the-fly.

8. Click the yellow Splice-in button or the red Overwrite button in the Capture tool to select the type of edit.

9. Click the Record button to begin recording.

10. If you did not mark the OUT point in advance, click the Record button again when the footage reaches the appropriate frame.
    - If you already marked an OUT point, recording stops automatically.
    - When capturing ends, the clip appears in place in the sequence, and a master clip appears in the bin.
    - If your capture includes ancillary data, a data track appears in the Timeline.

Capturing Video Without Pulldown into a 24p NTSC Project

Film-to-tape transfers that are made without using pulldown can be captured directly into a 24p project. This feature is useful when special effects are generated on a frame-to-frame basis to tape, and need to be integrated into a 24p project.

Before capturing the footage, click the Film to Video Transfer menu in the Film and 24p Settings dialog box, and select Video Rate. The Film-to-Video Transfer setting lets you specify the type of film-to-tape transfer you are capturing. For more information, see “Capture-Related Settings for Film and 24p Projects” on page 185.
Remote Play, Capture, and Punch-In

You can use an external edit controller with an Avid editing system for the following functions:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Capture</td>
<td>Controls the capturing of media into an Avid editing system while using an edit controller. Remote Capture lets you record and stop.</td>
</tr>
<tr>
<td>Remote Play</td>
<td>Controls sequences loaded in the Record monitor and played back through an edit controller to the edit room, along with other sources. Remote Play lets you cue, play, and stop.</td>
</tr>
<tr>
<td>Remote Punch-In</td>
<td>Controls the recording of audio into an Avid editing system while using an edit controller. Remote Punch-In lets you cue, play, record, and stop.</td>
</tr>
</tbody>
</table>

When you select Remote Capture or Remote Punch-In in the Remote Play and Capture Settings dialog box, your Avid editing system performs like a VTR and waits for an external controller to operate the capture functions.

You must be in Deck Offline mode to use Remote Capture. For information on Deck Offline mode, see “Capturing from a Non-Avid-Controlled Deck” on page 241.

You must be in Satellite mode to use Remote Capture. For information on Satellite mode, see “Capturing in Satellite Mode or No Device Control” on page 278.

To use Remote Play and Capture, you must connect a supported controller (any controller that uses Sony® serial control protocol) to your system by using a special Avid 9-pin VTR emulation cable and a serial adapter.

If a message appears stating that the Avid Serial Driver is not installed for Remote Play and Capture, make sure the correct serial driver is installed on your system. If you are running Avid Media Browse™ and using the Remote Play and Capture option, you need to run your Avid editing application with the Microsoft driver. If you are running your Avid editing application without Avid Media Browse, you need to install the Avid serial driver.
Remote Play, Capture, and Punch-In

Selecting Remote Play and Capture Settings

To open the Remote Play and Capture Settings dialog box:


   2. Click the Mode menu, and select Remote Play, Remote Capture, or Remote Punch-In. For information about each option, see “Remote Play and Capture Settings” on page 1519.

Enabling Remote Capture

Before you enable Remote Play and Capture, ensure your edit controller is properly connected.

> The Remote Play and Capture command behaves like a Local/Remote switch on a playback device, with the VTR in Local mode by default when you start your system.

To enable Remote Capture:

1. Double-click Communication (Serial) Ports in the Settings list of the Project window. The Communication (Serial) Ports tool opens.
2. Select Remote Play and Capture > port.
3. Close the Communication (Serial) Ports tool.
   Your Avid editing application saves the setting as a Site setting, effective for all projects.
5. Select Mode > Remote Capture.
7. Specify the time (measured in frames) it takes the deck to start playing from a cued position in the Runup area.

8. Select Special > Remote Play and Capture when you are ready to capture.
   A check mark appears next to the command to indicate that the system is ready. A yellow outline appears around the Play button in the Source/Record monitor to indicate that Remote Play and Capture is active.

   The Capture tool opens.

10. Select the tracks onto which you want to capture by clicking the Channel Selection buttons.

11. Choose Bin > bin.

12. Click the Toggle Source button until the Deck Offline icon appears.

13. Control capturing from the controller.

**Enabling Remote Play**

Remote Play lets you control sequences through an edit controller. You can play, cue, and stop your sequence from the edit controller.

*Avid recommends that you do not inhibit preloading under normal circumstances. For more information about the inhibit preloading option, see “Remote Play and Capture Settings” on page 1519.*

**To enable Remote Play:**

1. Double-click Remote Play and Capture in the Settings list of the Project window.
   The Remote Play and Capture Settings dialog box opens.

2. Select Mode > Remote Play.


4. Select Special > Remote Play and Capture when you are ready to use your system for playing.
   A check mark appears next to the command to indicate that your system is ready. A yellow outline appears around the Play button in the Source/Record monitor to indicate that Remote Play and Capture is active. The Remote Play and Capture command behaves like a Local/Remote switch on a playback device, with VTR in Local mode by default when you start your system.

5. Use the Play, Cue, and Stop buttons on the edit controller to control a sequence loaded in the Record monitor.
   At this time, you cannot fast-forward, rewind, or shuttle and jog from the edit controller.
Setting up Your System for Remote Punch-In

Before you enable your Serial Remote, you must set the following options on your edit controller:

- 049 — Send Record In and Out to Machine set to 1=Yes
- 065 — Locate Type set to 0=Locate
- 077 — Extended Status Request set to 1=Off

In addition, all devices controlled by the controller must be genlocked, and your Avid editing system must be configured as the Master device. For more information on configuring the Serial Remote, see the documentation for your controller.

To record audio using Remote Punch-In:

1. Double-click Communication (Serial) Ports in the Settings list of the Project window.
   
   The Communication (Serial) Ports tool opens.

2. Click the Remote Play and Capture menu, and select the appropriate port.

3. Close the Communication (Serial) Ports tool.
   
   Your Avid editing application saves the setting as a Site setting, effective for all projects.

4. Double-click Remote Play and Capture in the Settings list of the Project window.
   
   The Remote Play and Capture Settings dialog box opens.

5. Select Mode > Remote Punch-In.

6. Click the Device Code menu, and select the appropriate device.

7. (Option) Specify other settings as described in “Remote Play and Capture Settings” on page 1519.

8. Click OK.

9. Select Clip > Remote Play and Capture when you are ready to use your system for capturing.
   
   A check mark appears next to the command to indicate that your system is ready. A yellow outline appears around the Play button in the Source/Record monitor to indicate that Remote Play and Capture is active.

   The Remote Play and Capture command behaves like a Local/Remote switch on a playback device, with the VTR in Local mode by default when you start your system.

10. Select Tools > Audio Punch-In.

   The Audio Punch-In tool opens. Some of the features in the Audio Punch-In tool — such as the preroll and postroll options — do not appear when you open the tool in Remote Play and Capture mode.
11. Select the tracks you want to record to by clicking the Input Channels buttons.

12. Load a sequence in the Source monitor.

13. Using the controls on the external controller, set an IN point in the Timeline.

   If you set the IN point at the first frame of the sequence, you must add filler to the start of the sequence equal to the amount of preroll. This allows your system to sync lock your Avid editing application to the external controller. Setting an OUT point is optional.

14. Control recording from the controller.

   Remote Punch-In does not use preroll or postroll settings, and it does not initiate a loop playback or audition playback prior to recording. Remote Punch-In begins recording audio to the selected channels as soon as you start the record operation.

**Relinking Clips by Key Number**

The film-tape-film-tape (FTFT) relinking feature lets you re-create an offline, film-originated sequence as a final finished sequence by using the key numbers of the original film footage. During the offline stage, you capture and edit footage that was transferred to tape through a one-light or best-light telecine transfer (the first FT). During the finishing stage, you batch capture, relink by key number, and edit footage that was transferred through a second timed, color-corrected telecine transfer (the second FT).
Alternatively, if you are finishing a sequence in an online suite and need only an EDL, you do not need to batch capture the footage. Just import the new shot log, relink to the offline items, and then create the EDL.

Relinking by key number eliminates the need for the telecine transfer facility to match the timecode and pulldown of the second transfer to the timecode of the first transfer.

For more information about relinking, see “Relinking Media Files” on page 494.

Duplicate your sequence before relinking. If you relink to the original sequence, you will lose your links to the original media.

To relink clips by key number:

1. After you finish editing the offline sequence, use the Lists Tool to create a pull list of the clips used in the sequence.

   For information see “Using the Lists Tool” on page 1100.

2. Have the telecine facility use the pull list to pull selects from the original negative and to transfer picture-only footage by using a timed, color-corrected telecine process.

   You do not need to transfer audio again. The telecine facility supplies a new shot log file along with the transfer tape.

3. In your original project, create a new bin.

4. Duplicate the edited offline sequence and move it to the new bin.

   At this point, the duplicate sequence still links to the original media.

5. Process the new log file through ALE and import it into the bin that holds the duplicated sequence.

6. (Option) Batch capture the clips imported from the new log file. Select 1:1 or another high-quality resolution.

   For more information, see “Batch Capturing from Logged Clips” on page 250.

7. Select the duplicated sequence and the new clips.

8. Select Clip > Relink.

   The Relink dialog box opens.
9. Select Relink > Key Number [KN Start] - video only.
10. Select “Relink all non-master clips to selected online items.”
11. (Option) If you did not batch capture the original clips, select “Allow relinking to offline items.”
12. In most cases, select “Relink only to media from the current project.”
   Deselect this option if you know the new clips were captured with a different project name.
   Also, if the sequence does not relink to the new clips, try deselecting the option and relinking again.
13. Click OK.
   The new clips link to the sequence.
If you duplicated the offline sequence, the offline sequence is still linked to the original clips. If you did not duplicate the sequence, you relink it to the original clips.

**To relink a sequence to the original clips:**

1. Duplicate the sequence.
2. Create a new bin and move the sequence to the bin.
3. Locate the original clips. Look for a bin with the original clips, or use the Media tool to locate the original clips.
   
   For information on the Media tool, see “Using the Media Tool” on page 471.
4. Copy the clips to the bin that contains the duplicated sequence.
5. Select the sequence and the original clips.
6. Relink the clips by key number.

---

**Modifying the Pulldown Phase After Capturing**

If you have captured film-originated clips (NTSC transfer only) that seem to stutter, the problem might be an incorrectly logged pulldown phase (the video frame at which the master clip starts: A, B, X, C, or D). You log this pulldown phase in the “Pullin” column of a bin. To solve the problem, you need to determine the correct pulldown cadence of the frame, modify the clip information, and recapture the clip.

You can also determine the correct pulldown phase from the original tape. See “Entering Pulldown Information” on page 160.

**To check for an incorrect pullin frame:**

1. Look for a section of the clip that includes a series of frames with motion.
2. Step through the clip frame by frame (using the Step buttons or another method) and look for two frames that have no movement.
   
   If the pattern is two frames of movement followed by two frames of no movement, the pullin is incorrect.

**To determine the correct pullin frame, use one of the following approaches:**

- If the source footage includes burn-in code with the pulldown phase, go to the start of the clip and look for the pulldown for the first frame.

- If you want to maintain the start timecode for each clip, review the original tape field by field, using the procedure described in “Entering Pulldown Information” on page 160.
If you do not need to maintain the start timecode:

a. Step through the clip frame by frame (using the Step buttons or another method). Look for two frames that are identical (no movement).

b. Think of these frames as frames B and X of a four-frame series.

Incorrect sequence (top, no movement between B and X frames) and correct sequence (bottom)

Step backward (either one frame from the B frame or two frames from the X frame) to locate the correct A frame. Note the last digit of its timecode. Timecode for all A frames in the clip starts either with this digit or this digit plus 5. For example, if the A frame has the timecode 1:00:10:20, timecode for all A frames in the clip ends in either 0 or 5.

c. Compare these digits with the last digit of the start timecode (first frame) of the clip to determine the correct pullin.

For example, if the A frame ends in 0 or 5, and the start timecode ends in 4, the pullin is D.

d. If the pullin for the clip is the X frame, you need to modify the timecode to produce a number you can associate with a pullin.

For example, if the A frame ends in 0 or 5, and the start timecode ends in 2, the pullin falls on the X frame and you need to modify the timecode along with the pullin. Move forward one frame to create a start timecode ending in 3. Then you can change the pullin to C.

⚠️ When you change the timecode of a clip, you lose the key number of the clip. You need to enter it in the bin and adjust it to match any changes to the timecode.

To modify the clip information after you determine the pullin frame:

1. In a bin, select the clip you want to modify and press the Delete key.

   The Delete dialog box opens.

2. Deselect the option “Delete master clip(s)” and select “Delete associated media file(s).”

3. (Windows only) Select the resolutions to delete.

4. Click OK.
Your Avid editing application deletes the original media file.

5. Make sure the clip is still selected. Press Ctrl+Shift and choose Unlink from the Clip menu.
   The clip information is unlinked and you can modify it.

6. Type the correct letter for the pulldown phase in the Pullin column. If necessary, type a new
   timecode and key number.
   For multiple clips, you can use the Modify command or the Modify Pulldown Phase
   command. See “Modifying the Pulldown Phase Before Capturing” on page 163.

7. With the new clip information in the bin, batch capture the clip.
   See “Batch Capturing Clips” on page 251.
   If the pulldown phase is accurate, the clip should play smoothly, with no repeated frames.
   This method might not work for some clips that start with either an A frame or a D frame. If
   the clip still stutters after you modify it, modify the clip again. This time, if the pullin is A,
   change it to D. If the pullin is D, change it to A.

DV and HDV Scene Extraction

While you are capturing DV or HDV footage, the DV and HDV Scene Extraction feature lets you
generate subclips and markers automatically, based on time-of-day (TOD) information contained
in the DV or HDV format.

Discontinuities in the DV or HDV TOD metadata indicate each new take in a master clip or
subclip shot on a DV or HDV camera. Using this feature, you can capture an entire DV or HDV
tape as a single master clip and have your Avid editing application automatically locate all the
takes for you, eliminating the need to log manually.

You can perform a DV Scene Extraction in two ways and an HDV Scene Extraction one way:

- Set up the DV or HDV Scene Extraction option before capturing. When capturing is
  performed, subclips and marker marks appear in the bin.
- Perform DV Scene Extraction after capturing. Select those clips in the bin for which you
  want to generate subclips and marker marks

You should be aware of the following:

- You can perform DV Scene Extraction on any existing clip or subclip in a bin that has TOD
  information breaks.
- DVCPRO format does not provide TOD metadata. You cannot use DV or HDV Scene
  Extraction with DVCPRO format.
- DV or HDV Scene Extraction does not work on non-DV or audio-only clips.
To set up DV and HDV scene extraction before capturing:

1. Double-click Capture in the Settings list of the Project window.
   The Capture Settings dialog box opens.
2. Click the DV&HDV Options tab.
3. Select DV or HDV Scene Extraction, depending on your type of project.
4. Select one of the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Markers</td>
<td>Creates marker marks where the TOD information breaks occur while capturing.</td>
</tr>
<tr>
<td>Create Subclips</td>
<td>Creates subclips where the TOD information breaks occur while capturing.</td>
</tr>
<tr>
<td>Both</td>
<td>Creates subclips and marker marks where the TOD information breaks occur while capturing.</td>
</tr>
</tbody>
</table>

5. Click OK.
6. Select Tools > Capture and then click the Record button.

When capturing has finished, your Avid editing application creates subclips with the same source clip name and the file name extension .sub.01 where TOD information breaks occurred. Marker marks appear in the master clip where TOD information breaks occurred.

To set up DV scene extraction after capturing:

1. Open a bin.
2. Click the clip for which you want to create subclips or marker marks. Ctrl+click (Windows) or Command+click (Macintosh) to select multiple clips.
3. Select Bin > DV Scene Extraction.
   The Capture Settings dialog box opens.
4. Click the DV Options tab.
5. Select DV Scene Extraction.
6. Select one of the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Markers</td>
<td>Creates marker marks where the TOD information breaks occur while capturing.</td>
</tr>
<tr>
<td>Create Subclips</td>
<td>Creates subclips where the TOD information breaks occur while capturing.</td>
</tr>
</tbody>
</table>
7. If you have chosen to create subclips, select the bin where you want these subclips stored.

8. (Option) To cancel the process, press Ctrl+period (Windows) or Command+period (Macintosh).

9. Click OK.

In the bin, your Avid editing application creates subclips with the same source clip name and the file name extension `.sub.01` where TOD information breaks occurred. Marker marks appear in the master clip where TOD information breaks occurred.

If you select a DVCPRO, a non-DV, or an audio-only clip, an error message appears, informing you that you selected an incompatible clip. Your Avid editing application bypasses these clips during the DV Scene Extraction process.

---

### Using the Panasonic VariCam

The Panasonic VariCam® (Panasonic AJ-HD1200A) allows the recording of frame rates between 1fps and 60fps. For example, material captured at 24 frames per second and played back at 24 frames per second has no speed change, but the same action captured at 48 frames per second and played back at 24 frames per second runs at 50% speed (slow motion).

The 720p format is always recording to a progressive 60 (59.94) frame tape format. The camera achieves the different frame rates by flagging the “true” frames within the 60 frame sequence. Your Avid editing application detects these flags and captures and stores only these frames. When the material plays back at the project’s frame rate, the result is either slow or fast motion.

*If you capture audio, it will be out of sync.*

**To use the VariCam camera with your Avid editing application:**

1. Connect the VariCam camera through a 1394 (FireWire) port on your computer.
2. Select a 720p project format.
3. Either select or deselect “Preserve VariCam Frames” in the Capture tool:
   - When this option is deselected (the default), your Avid editing application observes the flags in the video stream and only captures those frames. This type of capture results in slow or fast motion depending on original recording speed.
   - When this option is selected, your Avid editing application captures every frame (all 60 frames), essentially ignoring the flagged frames.
Importing Files

When you import files, your Avid editing application converts them into objects in a bin. You can manipulate and edit these objects as you would any other clip or sequence. You can specify a target drive to store any corresponding media files. The following topics describe how to import files:

- Preparing to Import Files
- Creating and Modifying Import Settings
- Importing Media Files
- Importing Audio Files from a Music CD
- Adjusting Gain Before Importing Audio Files
- Sample Rate Conversion and Audio Import
- Setting Sample Rate Conversion Options Before Importing Audio Files
- Photoshop Graphics Import
- Digital Bars and Tone
- Importing Color Bars and Other Test Patterns
- Importing Editcam Files
- Importing XDCAM Media
- Importing P2 Clips and Media
- Importing Sequences from Pro Tools through Interplay
- Using the Drag-and-Drop Method to Import Files
- Reimporting Files
- Batch Import Dialog Box
Preparing to Import Files

Before you begin the import process, make sure the system and the files are ready for import:

- Prepare the files in advance according to specifications described in “File Format Specifications” on page 1540.
- Determine the source for the files. Consider copying all files to a single folder before you import. See “Importing Media Files” on page 301.
- Review the information on using import settings in “Creating and Modifying Import Settings” on page 298. For a complete description of all options in the Import Settings dialog box, see “Import Settings” on page 1502.

Creating and Modifying Import Settings

You can create one or more sets of import parameters and save them as an Import setting. For example, you can create one setting for importing animations and another for importing still graphics, or you can create individual settings for importing specific multichannel audio mixes. This feature is especially useful when you use the drag-and-drop method to import multiple files. See “Using the Drag-and-Drop Method to Import Files” on page 333.

The default Import setting and any additional Import settings you create appear in the Settings list. After you select a setting in the Settings list, the parameters remain the default settings for all imported files, unless you change them during import. See “Using the Settings Tab” on page 96.

Once you create a new Import setting, you can select the setting whenever you import a frame, clip, or sequence. For more information, see “Importing Media Files” on page 301 and “Using the Drag-and-Drop Method to Import Files” on page 333.

To create a new Import setting:

1. Click the Settings tab in the Project window.
2. Right-click Import and select Duplicate.
   A duplicated entry displays.
Creating and Modifying Import Settings

3. Select the duplicated entry, click the Custom setting name column, type a name, and press Enter (Windows) or Return (Macintosh).

4. Double-click the new Import setting.

The Import Settings dialog box opens.
5. Select the appropriate options.
   For more information about Import settings, see “Import Settings” on page 1502.

6. Click OK.

To modify an existing Import setting:

1. Click the Settings tab in the Project window.
   The Settings list appears.

2. Double-click an Import setting.
   The Import Settings dialog box opens.

3. Select the appropriate options, as described in “Import Settings” on page 1502.

4. Click OK.
Importing Media Files

You can access files for import from any folder, disk, or drive source mounted on the desktop, such as a CD or DVD, fixed drive, removable drive, or network server. You can import more than one file or types of file at a time.

When importing files from third-party applications, you may need to install specific codecs to convert these files into an Avid format.

Consider copying all graphics files to a single folder before you import the files. Using this folder helps you manage graphics from multiple sources and streamlines the reimporting process because all graphics point to the same original path.

If you are working with stereoscopic files, it is important that you clearly identify the folders for the left and right eye cameras, and keep them well organized. The Avid editing application imports stereoscopic 3D files just as it would any standard 2D file. After the master clips are created, they need to be converted to stereoscopic clips—see For information on using the drag-and-drop method, see “Using the Drag-and-Drop Method to Import Files” on page 333.

To import files:

1. If you created one or more Import settings, select the Import setting you want to use from the Settings list in the Project window. See “Creating and Modifying Import Settings” on page 298.

2. Do one of the following:
   - Double-click Media Creation in the Settings list.
   - Select Tools > Media Creation.
     The Media Creation dialog box opens.

3. Click the Media Type tab.

4. Click the File Format menu, and select the format (MXF or OMF).
   If you are working in an HD project, you cannot select OMF as a file format. MXF is selected by default.

5. Click the Import tab.

6. Select the resolution and target drives.
   For more information on using the Media Creation dialog box, see “Selecting Video Resolutions and Media Drives” on page 176.

   The information you select is displayed in the Select Files to Import dialog box.
7. Click OK and close the dialog box.
8. Open the bin in which you want to store the imported files.
9. From the main menu, select File > Import.

The Select Files to Import dialog box opens.
10. Do one of the following:
   ▶ Click the Files of Type menu (Windows) and select All Files, or select the Any Documents option (Macintosh) to display all files in a selected folder, regardless of file type. Use this option if you want to batch import from multiple file types.
   ▶ Click the Files of Type menu (Windows) or the Enable menu (Macintosh), and select an import file type to display only files of the selected file type in the source file list:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All files (<em>.</em>)</td>
<td>Use to import the selected files.</td>
</tr>
</tbody>
</table>
To import a series of sequentially numbered files, select the first file in the sequence. To automatically select the entire sequence of files, you must select the Autodetect Sequential Files option in the Import Settings dialog box.

For sequentially numbered files — for example, myfile_001.jpg, myfile_002.jpg, myfile_003.jpg — the system combines all of the files into one clip.

11. (Option) Click Options to open the Import Settings dialog box, select the options you want, and then click OK to save the settings.

For a complete description of all options in the Import Settings dialog box, see “Import Settings” on page 1502.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shot Log</td>
<td>Use to import Avid Log Exchange (.ale) files containing clip information to a bin. For more information about Avid log specifications, see “Avid Log Specifications” on page 137.</td>
</tr>
<tr>
<td>Graphic</td>
<td>Use to import one of the supported graphics file types. For more information on the file types and their import specifications, see “Specifications for Graphics (Image) Files” on page 1540.</td>
</tr>
<tr>
<td>Audio</td>
<td>Use to import one of the supported audio file types. For more information on the various file types and their import specifications, see “Audio Projects Settings: Main Tab” on page 1438 and “Working with BWF Files” on page 1548.</td>
</tr>
<tr>
<td>HDV</td>
<td>Use to import HDV transport stream (.m2t) files. For more information, see “Capturing and Importing HDV” on page 1618.</td>
</tr>
<tr>
<td>AVCHD</td>
<td>Use to import AVCHD transport stream (.mts) files. If you are not connected to the internet the first time you import .mts files, the system opens the Avid License Control tool. Follow the onscreen directions to activate this feature. If you are connected to the internet, activation is automatic.</td>
</tr>
<tr>
<td>OMFI</td>
<td>Use to import OMFI (.omf) files, such as sequences transferred from an effects or digital audio workstation.</td>
</tr>
<tr>
<td>CamCutter</td>
<td>Use to import Editcam™ or Editcam-station (.bin or .spl) files. For more information, see “Importing Editcam Files” on page 318.</td>
</tr>
<tr>
<td>AAF</td>
<td>Use to import AAF (.aaf) files.</td>
</tr>
<tr>
<td>MXF</td>
<td>Use to import MXF (.mxf) files or, for some Avid editing applications, clips stored on an XDCAM device. For more information, see “Importing XDCAM Media” on page 320.</td>
</tr>
<tr>
<td>Windows Media (Windows only)</td>
<td>Use to import Windows Media (.wmv) files.</td>
</tr>
</tbody>
</table>
12. Use the Look In menu (Windows) or the From menu (Macintosh) to locate the folder containing the source files.

13. For graphics and video files, click the Video Resolution menu (Windows) or the Resolution menu (Macintosh), and select a resolution for the imported media.

   The resolution matches the resolution selected on the Import tab of the Media Creation Settings dialog box. If you select a different resolution, the resolution is also selected in the Media Creation Settings dialog box.

   OMFI and AAF files do not convert DV 25 to DV 50 or DV 50 to DV 25.

   Your Avid editing application imports XDCAM media at the native resolution of the media on the XDCAM disc. The system ignores other video resolution settings.

14. Click the Single/Dual Drives button and select a destination drive for the imported file.

   The target drive or drives match the drives selected on the Import tab of the Media Creation Settings dialog box. If you select a different drive, the drive is also selected in the Media Creation Settings dialog box.

15. For an XDCAM disc, type a name in the Disk Label text box.

   Your Avid editing application uses the disk label for operations such as Batch Import, where you are prompted to insert a specific XDCAM disc that holds the files you want to import. A disk label is required in order to import XDCAM media.

16. Select files or deselect files from the source file list by using the standard selection methods for your operating system.

17. Click Open.

   When the system finishes importing the files, the clips display in the selected bin.

   If you imported stereoscopic files, standard master clips are created in the bin. These clips must manually be selected and converted into stereoscopic master clips before you do any stereoscopic editing.

**Importing with Multichannel Audio**

You can use the Import Settings dialog box to define the audio track formats for the audio channels in your imported media, up to a maximum of 16 audio channels for the clips in your bins. This allows you to specify which source channels are treated as mono or multichannel audio tracks in your project, rather than having to modify the clips in your bin after you import the source media.

The mappings affect all media clips created when you import your source media. If you want to use different mixes for different master clips or different projects, create a custom Import Settings template for each separate type of mix and then import your clips. For information on
Importing with Multichannel Audio

creating custom Import settings, see “Creating and Modifying Import Settings” on page 298.

Multichannel audio settings do not apply to the following formats when you import media or files:
- AAF
- OMFI
- Shot log files
- Tab-delimited files

Each stereo track requires two channels, but you can mix mono and stereo input channels for your linking operation as long as you do not exceed the maximum of 16 audio channels for each master clip.

**To specify the multichannel audio mix for imported clips:**

1. Do one of the following:
   - Open a bin, select File > Import, and then click the Options button in the Select Files to Import dialog box.
   - In the Project window, click the Settings tab and then double-click Import.

   The Import Settings dialog box appears.

   You can also open the Import Settings dialog box by clicking the Options button in the For information about the Import Settings, see “Import Settings” on page 1502.

2. Click Edit.

   The Set Multichannel Audio dialog box opens.
3. Click the format buttons to select one of the following audio track formats for each pair of source channels:

<table>
<thead>
<tr>
<th>Button</th>
<th>Track Format</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Mono</td>
</tr>
<tr>
<td></td>
<td>Stereo</td>
</tr>
<tr>
<td></td>
<td>5.1 Surround Sound</td>
</tr>
<tr>
<td></td>
<td>7.1 Surround Sound</td>
</tr>
</tbody>
</table>

You must map source audio channels in mono or stereo pairs. For example, you cannot map A1 to a mono track and A2 and A3 to a stereo track. Instead, map A1 and A2 to mono tracks, and A3 and A4 to a stereo track. If the source media does not have an audio channel on A2, the Avid editing application ignores the channel.

4. Click OK to close the Set Multichannel Audio dialog box, and then click OK to close the Import Settings dialog box.

The Track Formats column in the bin Text view displays the format for all multichannel audio tracks in a master clip.

---

**Importing Audio Files from a Music CD**

**To import audio files from a music CD:**

1. Follow the procedure in “Importing Media Files” on page 301.
2. In step 10, select Files of Type > Audio (Windows) or Show > Audio Documents (Macintosh).
3. In step 16, navigate to the music CD and select the track or tracks you want to import.

   *(Macintosh)* If you encounter an error, copy the audio files to your desktop and import them from there.

4. Finish the procedure.

   Your track or tracks appear in the bin you opened in the procedure.
Adjusting Gain Before Importing Audio Files

When you import audio files, you can set the gain on a clip without opening the Audio Mix tool. This is especially useful when you import audio from a CD or an MP3 device and you would like to lower the decibel level for all files that you import.

To adjust the gain before import:

1. In the Project window, click the Settings tab.
2. Double-click Import.
3. Click the Audio tab, and then select Apply attenuation/gain effect on Import.
4. Type a decibel level from 12 to -96 to adjust the volume, or use the Up and Down arrows on the keyboard to locate the decibel level you want to apply to all the imported clips.
5. (Option) If you only want gain to apply to CD imports, select “CD only” to apply the gain to all the music files on the CD.
6. Click OK.

When your Avid editing application imports the files, it applies the gain adjustment i to each file imported to a bin. If you later apply gain from the Clip menu to a clip that you adjusted the gain before import, your Avid editing application ignores the pre-import gain. For example, if you apply -6 dB before import, and then apply another -6 dB to the clip, the clip remains at -6 db and not -12 db. For each subsequent adjustment, your Avid editing application ignores the previous adjustment, except where the clip appears in a sequence. To adjust a clip’s gain in a sequence, you must use the Audio Mix tool.

7. Follow the usual import procedures. For more information, see “Importing Media Files” on page 301.

To adjust the gain after import:

1. Choose one of the following methods:
   ▶ Select the clip in the bin, and select Clip > Apply Gain.
   ▶ Right-click a single clip and select Apply Gain.
      The Apply Clip Gain menu opens.
2. Type a decibel level from 12 to -96 to adjust the volume, or use the Up and Down arrows on the keyboard to locate the decibel level you want to apply.
3. Click OK.

The gain adjustment applies to every clip. If there was a gain previously associated with the clip, the new gain value override it.
Sample Rate Conversion and Audio Import

When you import audio to your project, you have the option of converting the sample rate of the source audio files to the project sample rate. You select this option on the Audio tab of the Import settings dialog box (see “Import Settings: Audio Tab” on page 1506). The default setting is to convert all files, which means that your Avid editing application converts the sample rate of source files to the project sample rate when it imports the file to your project. If you deselect this option, your Avid editing application imports the files at the source sample rate.

If you choose to convert your source sample rates when importing audio files, you also have the option to skip the conversion of files recorded with pullup or pulldown sample rates. This option affects the import process in the following ways:

• Skipping the sample rate conversion of audio files with .1% pullup or pulldown sample rates imports the files, bit for bit, with no change to the source audio file. Your Avid editing application marks the imported files with non-pullup or non-pulldown sample rates, and the length and pitch of the imported audio changes by plus or minus .1%. For example, a source audio file with a 48048 sample rate is marked on import with a 48000 sample rate, and it plays back .1% slower than audio with a converted sample rate. Because no conversion occurs, importing the files proceeds quickly. This is the default setting.

• Converting audio files with pullup or pulldown sample rates results in imported files with the project sample rate. The length and pitch of the imported audio matches the length and pitch of the source audio. Because your Avid editing application must convert the sample rates, importing these files proceeds less quickly than it does when skipping the sample rate conversion.

If you choose not to convert any sample rates when you import audio files, your Avid editing application imports the audio files at the source sample rate. This leaves the audio source files unchanged, but your Avid editing application marks any source files with pullup or pulldown sample rates with non-pullup or non-pulldown sample rates, and the length and pitch of the imported audio changes by plus or minus .1%. Again, this means that a source audio file with a 48048 sample rate is marked on import with a 48000 sample rate, and it plays back .1% slower than audio with a converted sample rate.

For information on setting the import options for converting audio sample rates, see “Adjusting Gain Before Importing Audio Files” on page 308.
Setting Sample Rate Conversion Options Before Importing Audio Files

When you import audio files, you can choose to convert the sample rate of the source audio files to the project sample rate or to import the files at the source sample rate. For more information about converting sample rates when importing audio files, see “Sample Rate Conversion and Audio Import” on page 309.

To set sample rate conversion options:

1. In the Project window, click the Settings tab.
2. Double-click Import.
3. Click the Audio tab, and then select the following options, as appropriate:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Convert source sample rate to project sample rate</td>
<td>Selecting this option converts all source audio files to the sample rate of your project. Deselecting this option imports all files at the source sample rate. The default is to convert sample rates on import.</td>
</tr>
<tr>
<td>Do not convert sources with pullup and pulldown rates</td>
<td>If you choose to convert the sample rates of your source audio files, selecting this option lets you skip the conversion of audio files with pullup or pulldown sample rates while converting all other files to the project sample rate. Deselecting this option converts all files to the project sample rate. The default is not to convert pullup and pulldown sample rates on import.</td>
</tr>
</tbody>
</table>

If you skip the conversion of files with pullup and pulldown sample rates on import, the length and pitch of the imported files are changed by plus or minus .1%. If you do convert these files, length and duration do not change for the imported audio files.

4. Click OK.

When the files import and appear in the bin, any converted sample rates display in the bin for the imported files. If you do not convert audio files with pullup or pulldown sample rates, these audio files display in your bin with the sample rate closest to the source sample rate. For example, a file with a 48048 sample rate displays in your bin after import with a 48000 sample rate, regardless of the project sample rate.
Photoshop Graphics Import

You can import both single-layer and multilayered graphics created in Adobe® Photoshop®. If you import multilayered graphics, you can preserve the original layers, and then edit them individually in your Avid editing application.

Your Avid editing application supports graphics created in the following modes: RGB 8-bits/channel, RGB 16-bits/channel, and grayscale, including alpha channels. For more information, see “Import Specifications for Supported Graphics File Formats” on page 1540. An alpha channel must be straight — your Avid editing application does not properly import premultiplied alphas.

Single-Layer Photoshop Graphics

A single-layer graphic is a graphic file that was created either on a single layer or with multiple layers and subsequently flattened in Photoshop. Avid editing applications import this kind of graphic as a matte key or master clip, depending on the format of the Photoshop file.

- If the graphic uses a transparent background or an alpha channel, your Avid editing application creates a matte key.
- If the graphic uses a background color, your Avid editing application creates a master clip.

Single-layer files that contain transparency gradients or feathering and a transparent background do not import correctly. Partially transparent pixels display with either white or black blended into them, based on the percentage of transparency. To avoid this problem, create an additional layer in the original Photoshop file that contains at least one pixel of information, such as a spot drawn with a paintbrush. Then import it as a layered file, as described in “Importing Photoshop Files” on page 314. In the message box, click Select Layers and select only the layer that contains the graphic elements. Do not select the additional layer.

Multilayer Photoshop Graphics

A multilayered graphic is a graphic file that was created in Photoshop with two or more layers. You can import multilayered graphics created in Photoshop v6.0 or later.

When you import a multilayered graphic, you can import each layer as a separate object (a matte key or master clip). You can then manipulate individual layers like any other matte key or master clip. You can also import the graphic as a flattened image, or select the layers to import.

Some layer options in Photoshop are not supported for import into your Avid editing application. See “Support for Multilayered Photoshop Graphics Import” on page 313. For example, a title with a Drop Shadow and an Outer Glow effect would not keep these effects when imported.

To preserve the effects in these layers, merge them in Photoshop (as described in the Photoshop documentation) and then import the file.
You can also preserve layer effects and the original structure of the file by importing the file in two stages:

**Example of Multilayered Photoshop Graphics Import**

A multilayered Photoshop graphic might consist of a collage of still images over a background image, with a layer of text. Separate layers contain each image and the text. The goal is to edit the collage into a sequence, building it up one image at a time, and then add the text. The following illustration shows the graphics and layers in Photoshop.

Your Avid editing application imports each layer as an individual matte key with alpha channel. In this example, the graphic uses a background image, so the system creates the background image as a master clip. (If the graphic uses a transparent background, the background layer is imported as a matte key.)

The following illustration shows the layers as they appear in a bin.
During the import, your Avid editing application creates a sequence with each layer on a separate video track. This makes it easy to edit all layers into the final sequence. This sequence preserves the names and order of the layers as created in the original Photoshop file.

You can then edit the tracks as necessary to build up to the full collage.

**Support for Multilayered Photoshop Graphics Import**

You should be aware of the following requirements for multilayered graphics import and details of how your Avid editing application handles the import:

- Graphics must be RGB 8 or 16 bits, or grayscale.
- Importing preserve layer order and layer names.
- Hidden layers are imported as matte keys.
- Importing converts Opacity to Foreground level in the Matte Key effect.
- Importing rasterizes text and shape layers.
- Not all layer options and types are supported for import.

For information on preserving layer effects during import, see “Importing Photoshop Files” on page 314.
For information on support for layer options and types, see the following tables.

<table>
<thead>
<tr>
<th>Layer Option</th>
<th>Supported</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blending Mode</td>
<td>No</td>
<td>To preserve the blending mode (Dissolve, Multiply, and so on), merge the layer into another layer that does not use a special blending mode. Only normal mode is supported.</td>
</tr>
<tr>
<td>Opacity</td>
<td>Yes</td>
<td>The imported layer’s Level is set to the opacity specified in Photoshop. You can adjust opacity levels with the Foreground Level control in the Effect Editor.</td>
</tr>
<tr>
<td>Layer Group</td>
<td>Partial</td>
<td>Import ignores layer grouping and instead imports all layers, including grouped layers, as individual layers. To preserve a clipping group, merge the grouped layers into the base layer.</td>
</tr>
<tr>
<td>Layer Set</td>
<td>Partial</td>
<td>All layers within a set are imported as individual layers.</td>
</tr>
<tr>
<td>Layer/Set Mask</td>
<td>No</td>
<td>Import ignores layer and set masks. To preserve a layer mask, apply it to the layer. To preserve a set mask, merge the set into an empty layer. To preserve a special layer’s mask, rasterize the layer.</td>
</tr>
<tr>
<td>Layer Style</td>
<td>No</td>
<td>Import ignores layer styles. To preserve a layer style, you must convert the style into layers.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Special Layer Option</th>
<th>Supported</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type Layer</td>
<td>Yes</td>
<td>—</td>
</tr>
<tr>
<td>Solid Layer</td>
<td>Yes</td>
<td>Solid layers import as a graphic with a full-screen opaque alpha channel.</td>
</tr>
<tr>
<td>Gradient Layer</td>
<td>Yes</td>
<td>Gradient transparency is preserved.</td>
</tr>
<tr>
<td>Pattern Layer</td>
<td>Yes</td>
<td>—</td>
</tr>
<tr>
<td>Adjustment Layer</td>
<td>No</td>
<td>Adjustment layers include Levels, Curves, Color Balance, Brightness/Contrast, Hue/Saturation, Channel Mixer, Gradient Map, Invert, Threshold, and Posterize.</td>
</tr>
</tbody>
</table>

**Importing Photoshop Files**

To import a single-layer graphic, or a flattened multilayered Photoshop graphic:

- Follow the standard instructions for importing a graphic, as described in “Importing Media Files” on page 301.
To import a multilayered Photoshop file:

1. Prepare the Photoshop graphic for import.
   
   For more information, see “Support for Multilayered Photoshop Graphics Import” on page 313.

2. Follow the standard instructions for importing a graphic, as described in “Importing Media Files” on page 301. To create the matte correctly, you need to click the Options button and select Alpha: Invert Existing.

3. After you select one or more files and click Open, a message box opens.

4. In the message box, do one of the following:
   
   ▶ Click Sequence of Layers if you want to preserve all layers. If the number of layers exceeds the number of tracks supported, your Avid editing application creates a sequence that contains the number of tracks supported. Additional layers are imported into the bin, but not as tracks in a sequence. This selection applies to all files you select for import.

   ▶ Click Flattened Image if you want to import the graphic as a single matte key or clip. Your Avid editing application flattens the file by combining the layers. This selection applies to all files you selected for import.

   Hidden layers are not combined in the flattened image. Make sure all layers you want in the final image are visible. In addition, layers with partial transparency do not display properly in the flattened, imported image.

   ▶ Click Select Layers if you want to select which layers to preserve.

   The Select Layers dialog box opens. Select the layers you want to import and click OK. If you select more than 24 layers, your Avid editing application imports the additional layers but does not include them in the sequence.

   Your Avid editing application displays messages as it creates media for each layer. At the end of the process, the selected bin displays the objects.

To preserve layer effects:

1. For the first import, click Select Layers and select all layers except the layers that contain layer effects.

2. For the second import, open Photoshop, hide the layers you’ve already imported, and show the layers that contain layer effects. During the import, click Flattened Image.

   The resulting image contains only the layers that contain layer effects.
Digital Bars and Tone

If you expect to output your final sequence as a digital cut that requires calibration before playback (a digital cut that will be broadcast, for example), in most cases you might need a clip of color bars. You can add the clip to the front of the sequence, or you can output the clip separately as an assemble or insert edit onto tape during digital cut.

There are several ways to acquire a clip of bars, each with different advantages:

<table>
<thead>
<tr>
<th>Acquisition Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record bars and tone from a house generator</td>
<td>Requires the least effort with good results because you record high-quality bars and tone simultaneously, with a minimum of calibration.</td>
</tr>
<tr>
<td>Record bars and tone from a videotape</td>
<td>Lets you record bars and tone simultaneously, but you must calibrate carefully to ensure accuracy. In addition, the final clip reflects the quality of the source tape recording.</td>
</tr>
<tr>
<td>Record bars from an external color bar generator</td>
<td>Provides good results, but you must have a color bar generator, and you must rearrange your system inputs to attach the generator. In addition, you must acquire tone separately and sync it with bars within your Avid editing application.</td>
</tr>
<tr>
<td>Import a file of bars</td>
<td>Provides the highest quality results because the source image is already digital. If the file is accurate, the quality of the clip is ensured. You must, however, acquire tone separately and sync it with bars within your Avid editing application. For more information, see “Importing Color Bars and Other Test Patterns” on page 316.</td>
</tr>
</tbody>
</table>

Importing Color Bars and Other Test Patterns

Avid editing applications supply files for color bars and other test patterns. You can import 8-bit PICT files or 16-bit TIFF files.

To import a test pattern from a file:

1. Open an existing bin, or create a new one for the test pattern.
2. Select the destination bin.
3. Select File > Import.
   The Select Files to Import dialog box opens.
4. Do one of the following:
   - (Windows) Click the Files of Type menu, and select Graphic Files.
- (Macintosh) Click the Show menu, and select Graphic Documents.

5. Use the Look in menu (Windows) or the From menu (Macintosh) to locate the folder containing the test pattern file.

   Test pattern files are located in the following folder:
   - (Windows) drive:\Program Files\Avid\Avid editing application\SupportingFiles\Test_Patterns
   - (Macintosh) Macintosh HD/Applications/Avid editing application/SupportingFiles/Test_Patterns

6. Select a test pattern file from the File browser (Windows) or Source File list (Macintosh) for importing:
   - 8-bit PICT files are located at the top level of the Test_Patterns folder.
   - 16-bit TIFF files are located in the HD_720p, HD_1080i, SD_NTSC, and SD_PAL folders.

   The file name appears in the File Name text box (Windows) or the Go to text box (Macintosh).

7. Click Options to adjust the Import settings.

   The Import Settings dialog box opens.

8. Click the Image tab, and select the following options:
   a. Select 601/709, non-square from the Aspect Ratio, Pixel Aspect area.
   b. Select 601/709 from the Color Levels area.
   c. Click OK to save the settings and close the dialog box.

9. Click Open.

   The clip for the imported file appears in the selected bin.

When you import SMPTE_Bars.pct, the file does not exactly match the SMPTE bars generated by the Video Output tool. The I and Q blocks in the bottom portion of the pattern cannot be exactly represented in the RGB color space used when importing files.

10. If you must have I and Q blocks correct in a sequence, do one of the following:
    - Record SMPTE bars from a signal generator.
    - Use the Video Output tool to generate SMPTE bars, and record them to tape using the controls on the deck. Then, capture them back into the system from the tape.

11. Load the new color bars clip into the Source monitor, and create a subclip of appropriate length for use in sequences (1 minute is a common standard).

12. Select the new subclip, Ctrl+click (Windows) or Command+click (Macintosh) the audio clip containing the tone, and select Bin > AutoSync.
A new subclip containing bars and tone appears in the bin.

13. Rename the clip as necessary.

## Importing Editcam Files

You can import clips recorded with Ikegami® disk-based Editcam™ or Editcam-station products. The Editcam is a digital news-gathering (DNG) camera that uses Avid's CamCutter® technology.

For more information about Editcam, CamCutter technology, and how these systems operate with nonlinear editors, see the Web site [www.nltek.com](http://www.nltek.com).

Note the following restrictions:

- The CamCutter clips are not copied onto a media drive. The bin references clips physically located on the FieldPak. If you remove the FieldPak, the referenced clips appear as Media Offline.

- The FieldPak has limited performance and is used only to record and play back clips. If you require multiple streams of video for advanced effects, the data might not be supplied fast enough for proper operation. If this situation occurs, you can do one of the following:
  - Render the effects. See “Rendering Effects” in the Help.
  - Consolidate the sequence to a valid media drive. See “Consolidating Media” on page 477.
  - Import the CamCutter clips as OMFI files. This effectively copies the clips to a media drive. See “Import Settings” on page 1502.

### To import Editcam files:

1. (Option) Select File > Mount All.
   - If you previously mounted the drive or volume, or if you inserted the FieldPak® before starting your Avid editing application, you do not need to perform this step.

2. Open a bin.

3. Select File > Import.
   - A dialog box opens.

4. Click the Files of Type menu (Windows) or the Show menu (Macintosh), select CamCutter, and then select the CamCutter bin by doing the following:
   - From the desktop, select the FieldPak drive letter (Windows) or FieldPak volume name (Macintosh).
   - Open the bin folder on the FieldPak.
   - Select the CamCutter bins or select the .spl files you want to import.
The Outakes.bin contains clips that were discarded by the Editcam operator. These clips are generally not imported.

5. Ignore the field specifying video resolution to import.
6. Ignore the field regarding video and audio drive selection.
7. Proceed with the import operation.
   A dialog box opens, asking you to identify the drives that contain the media files.
8. Select the FieldPak drive letters (Windows) or volume names (Macintosh) as appropriate.
   If the drive or volume is not listed, go back to step 1 and retry the procedure.
9. Complete the import process.
   Your Avid editing application creates entries in the selected bin that reference the clips on the FieldPak.
   For more information on importing files, see “Importing Media Files” on page 301.

**Setting XDCAM Import Options**

Set the default options to import XDCAM media in the XDCAM tab of the Import Settings dialog box.
Use these settings to override the selections made in the Select Files to Import dialog box or to set default behavior when you import XDCAM media. For more information, see “Import Settings: XDCAM Tab” on page 1507.

**Importing XDCAM Media**

XDCAM and XDCAM HD devices store media as MXF OP1a interleaved files. Your Avid editing application does not use these files directly. Instead, you must first import the media. The import process creates new video and audio MXF OP Atom media files which consist of one video track and up to eight audio tracks.

Low-resolution proxy media have the same number of audio tracks as the high-resolution formats.
There are several ways to access XDCAM media:

- Automatically import all proxy media when you load a disc in your XDCAM device. See “Automatically Importing Proxy Media from an XDCAM Device” on page 323.
- Manually import all proxy media on all discs currently loaded on your system. See “Importing Proxy Media from an XDCAM Disk” on page 325.
- Copy the proxy media files to a separate location (for example, to a folder copied on an FTP site), transfer them to a local drive or removable disk, and import the proxy media without directly accessing the XDCAM device. See “Copying XDCAM Proxy Media to a Local Drive or a Server” on page 326.
- Import proxy media, high-resolution media, or both using the Import function. See “Manually Importing XDCAM Media from the XDCAM Disk” on page 326.

For some workflows, you might want to import the proxy media first so you can start editing. Once you create your sequence, use the batch import function to import only those portions of the high-resolution clips needed for your sequence.

For other workflows, you might want to import the proxy media to an editing workstation, and then separately import the high-resolution media either to another workstation or to an Avid shared storage server using Avid Interplay Transfer. Your Avid editing application maintains the connection between the proxy media and the high-resolution media, so you can relink the edited clips at any time to the high-resolution master clips in a shared storage environment.

When you relink proxy media to high-resolution media, do not select Specific Resolution as the Relink Method option. Instead, select either Highest Quality or Most Compressed.

The import process for XDCAM media differs from the standard import in that you can import XDCAM media only at the native resolution of the XDCAM media (for information on XDCAM resolutions, see “Using XDCAM and XDCAM EX and XDCAM SR AMA Plug-Ins” on page 436).

XDCAM cameras record proxy audio at a sample rate of 8 kHz. When you import proxy media, you can choose to change (upconvert) the sample rate to your project rate. This might slow the import process a bit, but it greatly improves playback of audio tracks.

**Importing XDCAM EX Media**

XDCAM EX devices store media as MP4 interleaved files. Your Avid editing application does not directly support these files. You must first convert them to MXF OP1a files using the Sony XDCAM EX Clip Browser application, then you can import them in the same manner as XDCAM and XDCAM HD clips.
First you need to export the clip from the XDCAM EX device. There are two export options to choose from, one option is to export “MXF for NLEs.” This option creates an OP1a .mxf file, and then import the file into a bin. The other option is to choose to export “Avid AAF.” This option creates an AAF composition file, and concurrently creates an OPAtom MXF media file. In the Avid AAF export options, choose a valid Avid MediaFiles folder. The AAF composition file links to the media once you import.

**To import an XDCAM EX clip using Avid AAF:**

1. With an XDCAM EX camera or reader attached to your system, insert an XDCAM EX card.
2. Launch the Sony XDCAM EX Clip Browser.
3. From within the Clip Browser, choose Tools > User Configuration, and click the Conversion tab.
4. In the Avid AAF section, click Browse and select the folder where you want to place the AAF composition file.
5. In the User Configuration window, click the General tab.
6. In the Copy section, click Browse and select a valid Avid MediaFiles folder destination. This folder holds the OPAtom files and the Avid editor recognizes this media after you import the AAF composition.
7. Click OK.
8. In the Clip Browser, click or Ctrl+click (Windows) or Command+click (Macintosh) the XDCAM EX clips you want to export.
9. Right-click the clip and select Export > Avid AAF.
10. The clips appear in the folder location you selected.
11. Open the Avid editor.
12. Open a project and a bin, or create a new bin.
13. With the bin selected, right-click and select Import.
   
   The Select files to Import dialog box opens.
14. Locate and select the AAF composition files, and then click Open.
   
   All metadata information is embedded with the clip. The video resolution in the Import window is ignored.
   
   The XDCAM EX clips appear in the bin.
To import an XDCAM EX clip using MXF for NLEs:

1. With an XDCAM EX camera or reader attached to your system, insert an XDCAM EX card.
2. Launch the Sony XDCAM EX Clip Browser.

   *The XDCAM EX Clip Browser application should have come with your Sony camera or reader. For information about the Sony XDCAM EX Clip Browser, see Sony’s documentation.*

3. From within the Clip Browser window, select the clips you want to export.
4. Right-click the clips and select Export > MXF for NLEs.
   
   This creates OP1a MXF media files that you import into the Avid editor.
5. The MXF for NLEs window opens, click the Browse button and select the destination folder for the MXF media files.
6. Click Execute.
7. Open the Avid editor.
8. Open a project and a bin, or create a new bin.
9. With the bin selected, right-click and select Import.
   
   The Select files to Import dialog box opens.
10. Locate and select the MXF media files, and then click Open.
    
    All metadata information is embedded with the clip. The video resolution in the Import window is ignored.
    
    The XDCAM EX clips appear in the bin.

**Automatically Importing Proxy Media from an XDCAM Device**

You can use this method to automate the process of importing proxy media from your XDCAM device to your Avid editing application.

**To import proxy media from an XDCAM device:**

1. Double-click Import in the Settings list.
   
   The Import Settings dialog box opens.
2. Click the XDCAM tab.

3. Select Automatically Import Proxies when disk is inserted.

4. Click OK.

5. Open the bin in which you want to store the imported files.

   If you do not select a bin, or if you have more than one bin open, a dialog box opens and directs you to select from a list of open bins or create a new bin.

6. Insert a disk into your XDCAM device.

   The Import XDCAM Proxy from drive: dialog box opens.

7. Type a name in the Disk Label text box.

   Your Avid editing application uses the disk label for operations such as Batch Import, where you are prompted to insert a specific XDCAM disc that holds the files you want to import. A disk label is required in order to import XDCAM media.

8. Click the Single/Dual Drives button, and select a destination drive for the imported file from the menu.

9. Click Import.
Importing Proxy Media from an XDCAM Disk

When the import finishes, the clips appear in the selected bin.

Your Avid editing application imports XDCAM media at the native resolution of the media on the XDCAM disc. Your Avid editing application ignores other resolution settings — for example, in the Select Files to Import dialog box.

10. (Option) Repeat this procedure for each XDCAM disc that holds media you want to import.

Importing Proxy Media from an XDCAM Disk

You can use this method when you want to import proxy media stored on your disk, but you have not opted to import the proxy media automatically. If you want to import only some of the files on your disk, use the procedure described in “Manually Importing XDCAM Media from the XDCAM Disk” on page 326.

For information on setting the XDCAM import to start automatically, see “Automatically Importing Proxy Media from an XDCAM Device” on page 323.

To import proxy media from a disk:

1. Open the bin where you want to store the imported files, and select it to make it the active bin.
2. Insert a disk into your XDCAM device.
3. Select File > Import XDCAM Proxy.
4. Type a name in the Disk Label text box.
   Your Avid editing application uses the disk label for operations such as Batch Import, where you are prompted to insert a specific XDCAM disc that holds the files you want to import. A disk label is required in order to import XDCAM media.
5. Click the Single/Dual Drives button, and select a destination drive for the imported file from the menu.
6. Click Import.
   When the import finishes, the clips appear in the selected bin.

Your Avid editing application imports XDCAM media at the native resolution of the media on the XDCAM disc. Your Avid editing application ignores other resolution settings — for example, in the Select Files to Import dialog box.

7. (Option) Repeat this procedure for each XDCAM disc that holds media you want to import.
Copying XDCAM Proxy Media to a Local Drive or a Server

You might want to import proxy media when the XDCAM device is not available. For example, if you want an editor to start editing the XDCAM footage while the actual XDCAM disk is at another location, you can transfer the proxy media files to an FTP server. You can then download the files from the server, and an editor can import the proxy media and begin editing. Later, you can relink the proxy media to the high-resolution media, or use the batch import function to import the high-resolution media for final editing and finishing.

When you copy the XDCAM media files from the XDCAM device to another system or to a removable drive, you need to copy only the Sub folder (for proxy media) or the Clip folder (for high-resolution media).

A possible workflow to import XDCAM proxy media from a non-XDCAM drive uses the following steps:

1. Copy the proxy folder (Sub) from an XDCAM device to an FTP server.
2. Download the files to a local drive.
3. Import the proxy media to an Avid editing application from a local drive just as you would from an XDCAM disc, and then begin editing.
   
   See “Manually Importing XDCAM Media from the XDCAM Disk” on page 326.

4. When the XDCAM disk is available, either import or batch import the high-resolution media to finish editing.
   
   See “Importing Media Files” on page 301 or “Batch Importing High-Resolution XDCAM Media from the XDCAM Disk” on page 329.

Manually Importing XDCAM Media from the XDCAM Disk

Use the standard Import function to import XDCAM media into your Avid editing application. Set the default XDCAM import options in the XDCAM tab of the Import Settings dialog box. For more information on import options, see “Import Settings: XDCAM Tab” on page 1507.

You can import files through the:

- Import function
- Drag and drop method of importing files
Importing Essence Marks as Markers in XDCAM Media

For more information, see “Importing Media Files” on page 301 and “Using the Drag-and-Drop Method to Import Files” on page 333.

Your Avid editing application imports XDCAM media at the native resolution of the media on the XDCAM disk. The system ignores other resolution settings — for example, in the Select Files to Import dialog box.

You can locate the MXF media files in the following directories on your XDCAM disk:

• High-resolution media — XDCAM drive:\Clip
• Proxy media — XDCAM drive:\Sub

Importing Essence Marks as Markers in XDCAM Media

Essence Marks store metadata about media clips. You can set Essence Marks manually or automatically with the XDCAM cameras. Use Essence Marks to mark events such as clip start points or audio clipping and for sorting and searching clips stored on XDCAM discs. For a description of Essence Marks, see your Sony documentation.

You can import Essence Marks as markers when you import either proxy media or high-resolution media. The markers appear in the bin of the XDCAM master clips, and you can view them in the Source/Record monitor, in the Timeline, and in the Markers window. For information on using marker information as you edit, see “Suggested Uses for Markers” on page 550.

To import Essence Marks as markers:

1. Double-click Import in the Settings list.

   The Import Settings dialog box opens.
2. Click the XDCAM tab.

3. Select Import Essence Marks as markers.

4. Click OK.

**Editing XDCAM Proxy Media**

When you import proxy media files, a new master clip is created that you can edit in the timeline just like any other clip. You can mix the clips in the Timeline with any supported resolutions, add effects or titles, or perform any other editing function available in your Avid editing application.

XDCAM proxy media is single-frame resolution media. For the best performance during playback, select Draft Quality or Best Performance from the Video Quality Menu in the Timeline. For more information, see “Video Quality Options for Playback” on page 543.
To set the playback options for XDCAM media:

1. Right-click the Video Quality menu button, and select Draft Quality (yellow/green) or Best Performance (yellow/yellow).

Some effects, such as IllusionFX and FluidMotion effects, do not playback in real time when you select Draft Quality. For these effects, you must also select the Progressive Source button in the Effect Editor before you render.

2. (Option) You can perform emergency play-to-air operations of the proxy media as an export, as a Send to Playback operation, or as a digital cut.

**Batch Importing High-Resolution XDCAM Media from the XDCAM Disk**

Once you finish editing your sequence with proxy media, you can replace the low-resolution media with the corresponding high-resolution media with the Batch Import command. The Batch Import command lets you reimport the high-resolution DVCAM, MPEG IMX, or XDCAM HD files, directly from the XDCAM disk, while automatically linking the new imported material with the sequences and master clips created with the low-resolution MPEG-4 media. If you batch import media for an edited sequence, the import operation copies only those portions of the high-resolution master clip needed by the sequence, not the whole clip. If you batch import master clips, the import process copies the entire clip.

*The Disk Label column in the bin headings displays the XDCAM disk labels created when you import the XDCAM media. For information on displaying bin columns, see “Bin Column Headings” on page 368. If necessary, you can use the Modify command to change the name in the Disk Label column.*

You can also import the high-resolution media files separately. Since importing high-resolution master clips requires more storage, time, and bandwidth than batch importing only the necessary parts of clips, you might want to import the master clips to another workstation or to another system in a shared storage environment — for example, to an Avid shared storage server. Once you import the high-resolution media, you can Relink to move between the proxy media and the high-resolution media. For more information about relinking media, see “Editing and Finishing High-Resolution XDCAM Media” on page 332 and “Relinking Media Files” on page 494.

**To batch import high-resolution XDCAM media:**

1. Double-click Import in the Settings list.

   The Import Settings dialog box opens.
2. Click the XDCAM tab.

3. Select Batch Import High-resolution Video.

4. Click the Handle Length text box and type the number of additional frames you want to import at the heads and tails of the new master clips.

   This provides enough overlap for trimming and adding transition effects. The default is 30 frames.

5. Click OK.

6. Open the bin, and select the sequences or master clips created with proxy media that you want to replace with high-resolution media.

7. Insert a disk into your XDCAM device.

8. (Option) If your source media is stored on multiple XDCAM discs, and you have multiple XDCAM devices, you can insert all the discs at the same time.

9. Select Clip > Batch Import.

   A message box opens.

10. Click the All Clips button.
The Batch Import dialog box opens.

Single/Dual Drives button (left) and Video Drive and Audio Drive menu location (right) in the Batch Import dialog box

Your Avid editing application imports XDCAM media using the native resolution of the XDCAM files.

11. Click the Video Drive and Audio Drive menus, and select a destination drive or drives for all the media files.

You can separate video and audio onto different drives.

12. Click Import.

The high-resolution files import. If the source media is stored on more than one disk and not all disks are attached to your system, the system prompts you to insert additional disks as needed.
Editing and Finishing High-Resolution XDCAM Media

Once you import the high-resolution media, you can playback and edit your sequence with full resolution and in real-time. You can also send the sequence to a broadcast playback server using Avid Interplay Transfer.

As you edit your sequence, you can move between the proxy media and the high-resolution media by relinking your clips with the corresponding media files. When you relink proxy media to the high-resolution media, select one of the following Relink Method options:

- Highest Quality
- Most Compressed

Do not select Specific Resolution as the Relink Method.

This allows the audio tracks to relink to the appropriate audio files. For more information about the Relink command, see “Relinking Media Files” on page 494.

Importing P2 Clips and Media

P2 media files include information (metadata) that lets them appear as master clips in an Avid editing application. You can import the P2 clips directly from a P2 card or a copy of a P2 card on another drive into a bin. You can also import the media associated with the clips if you want to reuse the P2 card, for example, if you want to capture additional material onto the card in a camera. For more information about copying P2 cards to another drive, see “Manually Copying File-Based Media to a FireWire or Network Drive” on page 399.

To import P2 clips directly from a P2 card or a copy of a P2 card on a drive:

1. Open and select the bin where you want to import the master clips to.
2. Select File > Import P2 > Clips to Bin.
   
   The Browse for Folder dialog box opens.
3. Navigate to the P2 files:
   - Navigate to the P2 card
   - Navigate to the folder where multiple P2 cards reside. The system can import P2 files from multiple cards as long as each card has a Contents folder.

   The Import P2 option imports all the clips on the card.
4. Click OK.
A progress box appears as the clips import. When the import is complete, the clips appear in the active bin. You can play and edit the clips; the media resides on the P2 card. If you leave your Avid editing application and then restart it, you see the clips in the bin, but the media is offline. You need to import the clips again to continue working with them.

**To import media from a P2 card:**

1. Open and select the bin where you want to import the clips to.
2. Select the master clips, sequences, or a combination which you want to import media.
4. Follow steps 3 and 4 in the preceding procedure.

The system consolidates the items selected according to the current settings in the Media Creation Import tab.

**Importing Sequences from Pro Tools through Interplay**

You can import a sequence you have worked on in Pro Tools back into your Avid editing application. You need to have checked the sequence into Interplay from Pro Tools.

**To import a sequence from Pro Tools:**

1. Open the Interplay Window and navigate to the location of the checked-in sequence.
2. Click the sequence and drag it into your bin.

Your Avid editing application checks out the sequence and imports the sequence and the related files into the bin. For more information, see “Using Pro Tools and Interplay” in *Avid Interplay Best Practices*.

**Using the Drag-and-Drop Method to Import Files**

**To import one or more files by using the drag-and-drop method:**

1. Click the Settings tab in the Project window.
   
   The Settings list appears.
   
2. Click Import.
3. Select either the default Import setting or one you have created.
   
   To view or modify the parameters, double-click the setting. For more information, see “Creating and Modifying Import Settings” on page 298.
4. Open the bin in which you want to store the imported files.
5. Open the folder that contains the files you want to import.

6. Select the file you want to import and drag it to the bin. To select multiple files, Ctrl+click (Windows) or Command+click (Macintosh) the files and drag them to the bin.

7. (XDCAM only) The Import file(s) from XDCAM dialog box opens. Type a name in the Disk Label text box, and then click Import.

   Your Avid editing application uses the disk label for operations such as Batch Import, where it prompts you to insert a specific XDCAM disc that holds the files you want to import. A disk label is required in order to import XDCAM media.

---

**Reimporting Files**

If you are working with master clips or sequences that contain imported material, you can use the Batch Import command to reimport the imported files. For example, you might want to do the following:

- Upgrade the video resolution of the imported files to an online resolution for distribution.
- Create new media files when the media files are lost or accidentally deleted.

### Reimporting requires your original source file. Do not delete the media files for imported files unless you have access to the source files.

The Batch Import command lets you reimport files while automatically linking the new imported material to the original master clips and sequences. When you play your sequence after reimporting the files, the new imported material plays in your sequence.

When you reimport a media file, the entire media file, including all tracks, is reimported. For example, if you imported only the video track of a file that contains both video and audio and edited it into a sequence, the reimport process imports both the video and audio from the source file.

You cannot reimport a mixed-rate sequence because you cannot batch import material in formats other than the project format. A message box appears if you attempt to reimport such material. Instead, you can decompose the sequence, then reimport the resulting clips by opening the bin in projects that match each of the decomposed formats.

### OMFI files can contain only one master clip when you reimport them.

**To reimport files:**

1. (Option) Mount any removable media drives that held the original media.

2. Do one of the following:
   - Double-click Media Creation in the Settings list.
Select Tools > Media Creation.
The Media Creation dialog box opens.
3. Click the Media Type tab.
4. Click the File Format menu, and select the format (MXF or OMF).

*If your project uses an HD resolution, you cannot select OMF as a file format. MXF is selected by default.*

5. Open the bin, and select the imported master clips and sequences you want to reimport.
6. Select Clip > Batch Import.
   
   A message box opens.

```
Avid Media Composer

Import clips with offline media only?

[ ] Offline only
[ ] All clips
[ ] Cancel
```

7. Click one of the following:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Offline only</td>
<td>Reimports only the selected imported master clips that are missing their media files.</td>
</tr>
<tr>
<td>All clips</td>
<td>Reimports all the selected imported master clips. For example, click this button if you need to change the video resolution of the imported master clips.</td>
</tr>
</tbody>
</table>

The message box closes and the Batch Import dialog box opens. For reference information on the Batch Import dialog box, see “Batch Import Dialog Box” on page 336.

8. If you want to remove clips from the list, select the clips you want to remove and then click Skip This Clip.
   
The clips are removed from the list and are not imported.

9. Locate the sources for files that weren’t found by doing the following:
   a. Select a clip or clips displayed in red in the Selected Clips section.
   b. Click the Set File Location button.

   The Locate File dialog box opens.
c. Navigate to the location of the source file.

If you select more than one clip displayed in red, the system first attempts to find the rest of the clips in the same folder as the first clip and then in folders that maintain the same relationship with the first clip’s folder.

Found clips are displayed in black.

10. Click the Video Resolution menu, and select a video resolution for all the reimported files.

*OMFI and AAF files do not convert DV 25 to DV 50 or DV 50 to DV 25.*

11. Click the Video Drive and Audio Drive menus, and select a destination drive or drives for all the media files.

You can separate video and audio onto different drives by clicking the Single/Dual Drives button.

12. (Option) By default, your Avid editing application imports the file using the Import settings from the last time it imported the file. You can change the Import settings for all clips to import by doing the following:
   a. In the Import Options section, select “Override clip settings with current settings.”
   b. Click Current Settings to open the Import Settings dialog box.
   c. Select the appropriate options.
   d. Click OK to close the Import Settings dialog box.

13. Click Import.

The file is imported.

**Batch Import Dialog Box**

The Batch Import dialog box lets you select a source file for each master clip that you selected in a bin. Your Avid editing application finds the source file automatically if the it is located in the same folder where you last imported the file.

For information on working in the Batch Import dialog box as part of the reimporting process, see “Reimporting Files” on page 334.
Batch Import dialog box. Top: Selected Clips area. Center: Import Target area (including, top to bottom, Video Resolution menu, Video Drive menu, and Audio Drive menu). Bottom: Import Options area.

<table>
<thead>
<tr>
<th>Area</th>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selected Clips list</td>
<td></td>
<td>Shows the clips you selected for import. The caption at the top of the section summarizes the total number of clips shown and how many of them are available for import. Found clips display in black. Clips not found in their original location display in red.</td>
</tr>
<tr>
<td>Skip This Clip button</td>
<td>Remove any clips that you select in the list so that they are not reimported.</td>
<td></td>
</tr>
<tr>
<td>Area</td>
<td>Control</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>--------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Import Target</td>
<td>Set File Location button</td>
<td>Lets you locate sources for files whose sources are not found automatically (displayed in red in the list).</td>
</tr>
<tr>
<td></td>
<td>Import Target</td>
<td>Lets you select a resolution and destination drives.</td>
</tr>
<tr>
<td></td>
<td>Video Resolution menu</td>
<td>Lets you select a video resolution.</td>
</tr>
<tr>
<td></td>
<td>Video Drive and Audio Drive menu</td>
<td>Let you select a destination drive for the media files.</td>
</tr>
<tr>
<td>Import Options</td>
<td>Use Source Compression for OMFI</td>
<td>When selected, your Avid editing application takes the resolution used to create the OMFI files (the native resolution) to reimport the files if the resolution is available in your Avid editing application. This allows for fast import of these files. When deselected, or if a resolution is not available on the system, your Avid editing application uses the resolution in the Video Resolution menu as the resolution for import. This option always overrides the OMFI Resolution setting in the Import Settings dialog box.</td>
</tr>
<tr>
<td></td>
<td>Override clip settings with current settings</td>
<td>Lets you change the Import settings for all imported files. By default, each file imports using the Import settings from the last time it was imported.</td>
</tr>
<tr>
<td></td>
<td>Current Settings button</td>
<td>Opens the Import Settings dialog box, allowing you to change the current import options.</td>
</tr>
</tbody>
</table>

*If you change the Import settings by using the Import Options section, the new settings apply to all the files you import.*
Bins provide powerful database tools for organizing and managing your captured material. Bin functionality lets you view bin objects and information in several different ways. You can rename, sort, sift, duplicate, assign colors, and delete clips and sequences, move or copy clips from one bin to another, and print single-clip frames or whole bins.

The following topics provide information on working with bins:

- Object Icons in Bins
- Bin Views
- Bin Procedures
- Working with Bin Columns
- Modifying Clip Information
- Working with Film Information in Bins
- Creating a Storyboard
- Setting the Bin Display
- Film Scene Workflow
- Sifting Clips and Sequences
- Working with Restricted Material
- Printing Bins
- Favorite Bins
- Filtering Items in the Bin

**Object Icons in Bins**

Bins use icons to identify clips, sequences, and other media objects that they display. The table describes all of the object icons that you might see in a bin display.

*By default, bins display all existing media objects except source clips and rendered effects.*
<table>
<thead>
<tr>
<th>Icon</th>
<th>Object Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🎥</td>
<td>Master Clips</td>
<td>A clip that references audio and video media files formed from captured footage or imported files</td>
</tr>
<tr>
<td>🎥</td>
<td>Stereo Master Clips</td>
<td>A single clip generated from a left and right eye pair of master clips that were created when stereoscopic full frame material was captured or imported.</td>
</tr>
<tr>
<td>🎥</td>
<td>Shared Storage Master Clip</td>
<td>A master clip that references media files located on a shared storage system</td>
</tr>
<tr>
<td>🎥</td>
<td>Local Storage Master Clip</td>
<td>A master clip that references media files located on local storage.</td>
</tr>
<tr>
<td>🎥</td>
<td>MultiRez Shared Storage Master Clip</td>
<td>In a MultiRez environment, clip media is partially available in current resolution.</td>
</tr>
<tr>
<td>🎥</td>
<td>Remote clip</td>
<td>In a Media Composer</td>
</tr>
<tr>
<td>🎥</td>
<td>Remote Sequence</td>
<td>In a Media Composer</td>
</tr>
<tr>
<td>🎥</td>
<td>In-progress Master Clips</td>
<td>A master clip that references media currently being captured that you can view and edit. For more information, see “Understanding Frame Chase Capture” on page 247.</td>
</tr>
<tr>
<td>🎥</td>
<td>Subclips</td>
<td>A clip that references a selected portion of a master clip</td>
</tr>
<tr>
<td>🎥</td>
<td>Shared Storage Subclips</td>
<td>A subclip that references media files on a shared storage system</td>
</tr>
<tr>
<td>🎥</td>
<td>Audio Clips</td>
<td>A clip that references audio media files formed from captured audio or imported files</td>
</tr>
<tr>
<td>🎥</td>
<td>Shared Storage Audio Clips</td>
<td>An audio clip that references media files located on a shared storage system</td>
</tr>
<tr>
<td>🎥</td>
<td>In-progress Audio Clips</td>
<td>An audio clip that references media currently being captured that you can play and edit. For more information, see “Understanding Frame Chase Capture” on page 247.</td>
</tr>
<tr>
<td>🎥</td>
<td>Sequences</td>
<td>A clip that represents an edited program, partial or complete, that you create from other clips</td>
</tr>
<tr>
<td>🎥</td>
<td>Sources</td>
<td>A clip that references the original videotape source footage for master clips</td>
</tr>
</tbody>
</table>
Using Text View

Text view provides the most complete view of clip information. It uses database columns that you can rearrange and customize to suit your needs.

You can select individual or multiple headings to display or hide in the bin. For a complete description of each column heading, see “Working with Bin Columns” on page 361.

To enter Text view:

- Click the Text View button in the bin.
Text view in the bin. Top to bottom: bin column headings, Bin View button, Bin View menu

To select column headings:

1. With a bin in Text view, do one of the following:
   - Select Bin > Choose Column.
   - Right-click and select Choose Column.
   
   The Bin Column Selection dialog box opens.

2. Select the headings you want to add to the bin:
   - Click the name of a heading to select it.
   - Click a selected heading to deselect it.
   - Click All/None to select or deselect all the headings.

3. Click OK.

   Only the headings selected in the Bin Column Selection dialog box appear in the bin or bin view.

For information on hiding columns, see “Moving, Aligning, and Deleting Bin Columns” on page 362.

Sorting in Bins

You can sort clips to arrange them in either numerical or alphabetical order, based on the data in the column you select as the sorting criteria. When you sort clips, any selected items in the bin remain active.

You can also sort clips by color if you have assigned colors to the clips. For more information, see “Assigning Colors to Objects in a Bin” on page 357.
If you want to sort clips in a customized order in Text view, you must first rearrange the clips in Script view, and then return to Text view. For information about Script view, see “Duplicating, Copying, and Moving Clips and Sequences” on page 352.

Sorting Clips and Sequences

You can automatically sort clips and sequences in Text view. If you need to view sorted clips in Script or Frame view, sort them in Text view first and then return to Script or Frame view.

To sort clips in ascending or descending order:

1. With a bin in Text view, do one of the following:
   - Double-click the heading of the column that you want to use as the criterion.
   - Right-click the column heading and select Sort on Column, Ascending or Sort on Column, Descending.
   
   If the Sort command appears dimmed in the menu, you have not selected a column.
2. To reverse the order of the sort, do one of the following:
   - Double-click the column heading again.
   - Right-click the column heading and select the reverse order for the Sort on Column command.

To reapply the last sort, do one of the following:

- Select Bin > Sort Again with no column selected.
  
  This step is useful after you add new clips to a sorted bin.
- Click the column heading and select Bin > Sort.

To perform a multilevel sort using the information in the bins:

1. With a bin in Text view, arrange the columns in the bin to establish the primary column.
   
   The column that appears farthest to the left in the bin has higher sort priority.
2. Select the headings for the columns you want to contribute to the sort criterion. Cmd+click (Macintosh) or Ctrl+click (Windows) columns to add them to your selection. You can also Shift+click headings to select a range of columns.
3. Select Bin > Sort.
   
   The objects in the bin sort.

To sort clips by color:

1. Click the Color column heading in the bin.
2. Do one of the following:
Double-click the column heading.
Select Bin > Sort.
The objects in the bin sort by color. Colors sort by hue, saturation, and value.

Understanding Bin Views

Use the Bin View menu (Text view only) to select different bin views. The Bin View menu appears to the right of the bin tabs. The following table describes the default bin views that are available.

<table>
<thead>
<tr>
<th>View</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Capture</td>
<td>Contains a set of headings that are useful when capturing footage from tape — for example, start and end timecodes, tape, tracks, and resolutions.</td>
</tr>
<tr>
<td>Custom</td>
<td>Lets you create and save customized views. The Name heading is only required column heading, which displays by default. Add, hide, or rearrange column headings to customize the view.</td>
</tr>
<tr>
<td>Film</td>
<td>The film-related column headings, including key number, ink number, and pullin display. If you work on a non-film-related project and select Film view, only the non-film-related column display.</td>
</tr>
<tr>
<td>Format</td>
<td>Displays the video formats, resolutions, and projects for the bin’s contents</td>
</tr>
<tr>
<td>Media Tool</td>
<td>Duplicates the headings currently saved in the Media tool.</td>
</tr>
<tr>
<td>Statistics</td>
<td>Displays standard statistical column headings derived from information established during capture, such as start and end timecodes, duration, and resolution.</td>
</tr>
</tbody>
</table>

You can also create and save customized bin views, and then access them from the Bin View menu. For more information, see “Saving a Custom Bin View” on page 345.

When you create a new bin view, your Avid editing application saves the settings for the view so that you can alter, copy, or delete the settings at a later time. You can name and save bin views to suit your needs.

Bin view settings are also available in the Settings list of the Project window. For more information, see “Working with Settings” on page 1421.
Saving a Custom Bin View

To save a bin view:

1. Open a bin, click the Text View button.
2. Resize, add, hide, or rearrange bin columns according to preference to customize your view. The Name column is the default and the only required column heading.
   The bin view name changes to an italic name with the file name extension .n to indicate that it no longer matches the original view. If you select a new bin view setting while the current setting is untitled or italic, the system discards the current setting.
3. Click the Bin View menu, and select Save as.
   The View Name dialog box opens.
4. Type a name for the custom view, and click OK.

To change a custom bin view with the Bin View dialog box:

1. Click the Settings tab in the Project window.
   The Settings list appears.
2. Double-click the custom bin view you want to change.
   The Bin View dialog box opens.
3. Select and deselect the columns you want to display.
4. Click OK.

Using Frame View

In Frame view, each clip is represented by a single frame, with the name of the clip displayed below the frame. The system uses the head frame as the default.

You can perform the following functions in Frame view:

- Enlarge and reduce the sizes of the frames.
  You must enlarge or reduce all frames together, and you cannot change the sizes of individual frames.
- Rearrange the display of the frames in the bin by moving them.
- Realign the frames in a bin after you have changed their display.
- Select any frame to represent the footage.
- Play back the footage within any clip.
- Show border colors based on either the object type or clip color. You can also show icons in Frame view.

To enter Frame view:

- Click the Frame View button in the bin.

To enlarge the frame size:

- Select Edit > Enlarge Frame.
  The display size increases each time you select this option, up to seven times.
To reduce the frame size:
- Select Edit > Reduce Frame.
  The display size decreases each time you select this option, up to seven times.

To rearrange a single frame:
1. Click the frame, and drag it to its new position.
2. Click the background area of the bin to deselect the clips.

To rearrange multiple frames:
1. Do one of the following:
   - Shift+click the frames.
   - Lasso the frames by clicking the mouse pointer outside the first frame and drag it to surround the frames with a white dotted line.
2. Drag the selected frames to a new position in the bin.
3. Click the background area of the bin to deselect the clips.

To align all frames to an invisible grid:
- Select Bin > Align to Grid.

To align selected frames to an invisible grid:
- Select Bin > Align Selected to Grid.

To space the frames evenly to fill the Bin window:
- Select Bin > Fill Window.

To arrange frames in the order in which they are sorted in Text view:
- Select Bin > Fill Sorted.

To change the frame identifying the clip:
1. Select the clip that you want to change.
   - Press and hold the K key (Pause) on the keyboard and press the L key (Play Forward) to roll the footage within the frame forward at slow speed. To move backward through the footage, press and hold the K key and press the J key (Play Reverse).
2. When you see the frame that you want to use, release the keys.
   - Your Avid editing application saves your choice as part of the bin configuration.
Use the Home key or End key to change the represented frame. On Symphony Option systems, use the Home key or End key on the keyboard or jog or shuttle with the mouse to change the represented frame. For more information about playing footage, see “Controlling Playback” on page 533.

If you have group or multigroup clips in the bin and want to change the displayed frame, use controls in Source/Record mode.

To set Frame View border colors and icons:

1. Click the Settings tab in the Project Window.
2. Double-click Bin.
   The Bin Settings dialog opens.
3. In the Frame View pane select Show Border Colors.
4. Select one of the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use color based on object type</td>
<td>When selected, a colored border appears around the following:</td>
</tr>
<tr>
<td></td>
<td>• Blue - Precomputes and source side motion effects</td>
</tr>
<tr>
<td></td>
<td>• Green - Master clips</td>
</tr>
<tr>
<td></td>
<td>• Dark Green - Subclips and Group clips</td>
</tr>
<tr>
<td></td>
<td>• Red - Sequences</td>
</tr>
<tr>
<td></td>
<td>• Purple - Media files in the Media Tool</td>
</tr>
<tr>
<td>Use clip Color</td>
<td>If you assigned colors to items in the bin in Text View, these same colors will be used as a border for the bin item when in Frame View.</td>
</tr>
<tr>
<td>Show icons</td>
<td>The applicable bin item icon, for example sequence, clip, subclip, title, etc. will appear in Frame View.</td>
</tr>
</tbody>
</table>

5. Click OK.
   The applicable borders and icons will appear in the bin when in Frame View.

Using Script View

Script view combines the features of Text view with Frame view and adds space for typing notes or script. The frames are displayed vertically on the left side of your screen with the text box next to each clip. As in Text view, each clip is represented by a single frame, and the head frame is the default. Clip information is displayed above the text box.
You can do the following in Script view:

- Add text.
- Use basic word processing procedures to highlight, delete, cut, copy, and paste text between script boxes.
- Rearrange clips.
- Select any frame to represent the footage.
- Play back the footage within any clip.

To enter Script view:

- Click the Script View button in the bin.

To type text in the script box:

1. Click the text box and begin typing.
2. (Option) If the text you type extends beyond the size of the script box, you can use the Page Up and Page Down keys on the keyboard to scroll through the text.

   This text does not appear in sequences edited from the clips, only in printouts of the bin in Script view.

To change the represented frame in Script view:

- Press the J-K-L keys to move through the clip.
To rearrange clips in Script view:

- Drag each clip up or down to a new location in the bin.
- Sort and sift clips in Text view, and then return to Script view to display selected clips in the sort order you want.

*When you return to Text view, the order of the clips is changed there as well.*

**Bin Procedures**

You can manipulate material in the bin in a variety of ways, including selecting, deleting, duplicating, moving, copying, and sifting clips and sequences.

When you work with bins, an asterisk appears before the bin name in the bin's title bar. The asterisk indicates that the changes to the bin have not been saved. Once you save the bin, the asterisk is removed.

**Using Bin Tabs**

When you create a new bin, the bin opens in a separate window by default. However, you can drag bins to a single window to conserve space within your Avid editing application. Having multiple bins available to you in bin tabs allows you to access your media easily and to manage your media efficiently.
If the bin window contains more bin tabs than the window can display, the bin tab names become truncated and some bin tabs do not display in the window. You can view these bins, or view a list of all bins in the bin window, by using the tab navigation controls or by accessing the Tab menu.

**To move a bin into another bin:**
- Click the bin tab in the bin you want to move, and drag it to the target bin.
  - The bin tab in the target bin window displays all bins.

**To move a bin into separate window:**
- Click the tab for the bin you want to move, and drag it to a clear region of the application interface.
  - The bin displays in a separate window.

**To view bin tabs that do not display in the tab panel, do one of the following:**
- Click the Previous Bin button or the Next Bin button to shift the tab view to the left or the right.
  - The bin tab displays adjusts to display the next bin either on the left or the right.
- Click the Tab menu, and then select the name of the bin you want to view.
  - The selected bin displays in the bin window.

**To organize bins by changing the order of tabs:**
- Click the tab of a bin you want to move, and drag it to a new position in the bin tabs row in the bin.

**To close a bin tab:**
- Click the Close button in the tab.

### Using the Bin Fast Menu

All Bin menu commands are also available in the Bin Fast menu located in the lower left corner of every bin. The Bin Fast menu is especially convenient when you work with several open bins and need to access Bin menu commands quickly.

**To open the Bin Fast menu:**
- Click the Fast Menu button.

### Selecting Clips and Sequences

**To select a clip or sequence in a bin, do one of the following:**
- Click the clip or sequence icon (Text view).
Click in the picture area of the clip or sequence (Frame or Script view).

Ctrl+click (Windows) or Cmd+click (Macintosh) toggles the selection between selected and deselected states. Double-clicking a clip loads it into the Source monitor.

**To select multiple clips or sequences in a bin, do one of the following:**

- Ctrl+click (Windows) or Cmd+click (Macintosh) clips to add them to your selection.
- Select a clip, and then Shift+click another clip to select a range of items. If you then Shift+click another clip, the range covers all clips from the one you originally selected to the new clip. In Frame view, the range of items includes all clips within a rectangular region bounded by the first and last clips selected.
- Lasso several items. Click the mouse pointer outside the first item and drag it to surround the items with a white dotted line.

Selecting a single item deselects any other selections.

**To reverse your selection:**

- Select Bin > Reverse Selection.

The items that you previously selected are deselected, and those items that were previously deselected are selected.

**Duplicating, Copying, and Moving Clips and Sequences**

When you duplicate a clip or sequence, your Avid editing application creates a separate clip linked to the same media files. You can move, rename, and manipulate this clip without affecting the original clip.

When you copy clips, you are cloning the same clip in another bin. Any change you make to the copy affects the original clip. You cannot copy clips to the same bin, and you cannot return a clip copy to the same bin where the original resides.

When you copy clips from one bin to another, the custom columns that you create in the first bin are also copied to the second bin. The custom columns appear in the order in which you created them.

**To duplicate clips or sequences:**

1. Select the clip or sequence that you want to duplicate, or select multiple clips or sequences.
2. Select Edit > Duplicate.

A copy of the clip or sequence appears in the bin, with the original clip or sequence name followed by the file name extension .Copy.\(n\), where \(n\) is the number of duplicates created from the original clip or sequence.
Deleting media files for the duplicate clip or sequence also deletes the media files for the original clip or sequence.

To move clips or sequences from one bin into another:
1. Create or open another bin.
   Give the bin a name that represents its purpose or contents.
2. Position or resize the original bin and the new bin so that you can see both of them at the same time.
3. Select the clips or sequences that you want to move.
4. Drag the clips or sequences to the new bin.

If the destination bin’s display has been set to show reference clips, the referenced object types do not appear until you save the bin. For more information on setting the bin display, see “Setting the Bin Display” on page 383.

To copy clips or sequences from one bin to another bin:
1. Position or resize the bins so that you can see both of them at the same time.
2. In the original bin, click the clips or sequences that you want to copy.
3. Press and hold the Alt key (Windows) or Option key (Macintosh) and drag the clips or sequences to the destination bin, and release the mouse button.
   The copies appear in the destination bin, and the originals remain in the source bin. The system does not add the file name extension .Copy.n to the clip or sequence as it does when duplicating. If the destination bin’s display was set to show reference clips, the referenced object types do not appear until you have saved the bin.

Copying Clips and Sequences

When you copy clips, you are cloning the same clip in another bin. Any change you make to the copy affects the original clip. You cannot copy clips to the same bin, and you cannot return a clip copy to the same bin where the original resides. (For information on duplicating a clip within a bin, see “Duplicating, Copying, and Moving Clips and Sequences” on page 352.)

When you copy clips from one bin to another, the custom columns that you created in the first bin are also copied to the second bin. The custom columns appear in the order in which you created them.

To copy clips or sequences from one bin to another bin:
1. Position or resize the bins so that you can see both of them at the same time.
2. In the original bin, click the clips or sequences that you want to copy.
3. Press and hold the Ctrl key (Windows) or the Command or Option key (Macintosh) and drag the clips or sequences to the destination bin, and release the mouse button.

The copies appear in the destination bin, and the originals remain in the source bin. The system does not add the file name extension .Copy\n to the clip or sequence as it does when duplicating. If the destination bin’s display was set to show reference clips, the referenced object types do not appear until you have saved the bin.

**Deleting Items from a Bin**

You can delete the following items from a bin:

- Clips
- Subclips
- Sequences
- Effect clips and their media files
- Motion effect clips and their media files
- Rendered effects clips and their media files
- Data clips and their media files
- Master clips and their media files
- Sources
- Groups

⚠️ **When you delete media files, you can no longer see the deleted material. If you load a clip for which a media file has been deleted, a black screen appears with the words “Media Offline.” If you need to use those clips again, you must recapture the media from tape or reimport graphics.**

If you work with multiple-resolution clips in an Avid Interplay environment, you can delete only media that is specially associated with the clip. For more information, see “Deleting MultiRez Clips and Media from a Bin” on page 1365.

To delete individual video, audio and data tracks from a clip, use the Media tool. For more information, see “Deleting Media Files with the Media Tool” on page 475.

(Windows) **To delete clips, subclips, and sequences with their media files from a bin:**

1. Select the clips, subclips, or sequences you want to delete.
2. Do one of the following:
   - Select Edit > Delete.
   - Press the Delete key.
The Delete dialog box opens which displays the items that you selected. By default, media files are not selected for deletion.

Examples of the Delete dialog box with one master clip selected (left) and with multiple clips selected (right)

3. Select the items you want to delete:
   - Select clips and their associated media files for deletion.
   - Select only the media files for deletion if you want to retain the clips to recapture later.
   - Select only the clips for deletion (in case the media file is referenced by other clips in your project).
   - Select the resolutions you want to delete.

The Resolutions to Delete section lists all video resolutions for the clips you selected. It also lists a single entry for all audio sample rates and compressed audio and a single entry for the data (ancillary data) file. Click All to delete all resolutions. However, you still need to select the individual media files that you want to delete. If you don’t want to delete any media files, click None, and all media files are deselected.

The options in this section also let you delete only audio media, only data media or only video media from a clip, if that clip has separate media files for audio, data and video.

4. Click OK.

If you choose to delete media files, a dialog box opens.
5. Click Delete.
   The selected clips, sequences, and media file are deleted.

When you select a title for deletion, you might see more than one resolution.

(Macintosh) To delete clips, subclips, and sequences with their media files from a bin:
1. Select the clips, subclips, or sequences you want to delete.
2. Do one of the following:
   ▶ Select Edit > Delete.
   ▶ Press the Delete key.
   The Delete dialog box opens which displays information about the selected items.
3. Select the items you want to delete.
   ▶ Select clips and their associated media files for deletion.
   ▶ Select only the media files for deletion if you want to retain the clips for recapturing later.
   ▶ Select only the clips for deletion if the media file is referenced by another clip.
4. Click OK.
   If you choose to delete media files, a dialog box opens.
5. Click Delete.
   The selected clips, sequences, and media file are deleted.

**Changing the Bin Background Color**

You can customize the background color of the bin. Changes affect only the currently active bin. Also, you can reset the bin background color to the default color for your Interface settings.

To change the bin background color:
1. In the Settings list of the Project window, double-click Interface.
   The Interface Settings dialog box opens.
2. Select Allow Custom Bin Backgrounds, and then click OK.
3. Activate the bin you want to change.
   In Text view, make sure no clips are selected.
4. Select Edit > Set Bin Background and click a color.
The bin color changes. The change applies to all bin views.

To restore the default bin background color, do the following:
- Activate the bin you want to change, and then select Edit > Set Bin Color to Default.

Assigning Colors to Objects in a Bin

You can assign colors to clips, subclips, sequences, and effect clips to help you manage and organize the bin objects. You can also display colors in bins and in the Timeline. For information on displaying colors in the Timeline, see “Displaying Clip Colors in the Timeline” on page 667.

Also, you can reset the clip color to the default color for your Interface settings.

Clip colors assigned to sequences, groups, motion effects, and title clips do not appear in the Timeline.

To add a Color column to a bin:
1. With a bin in Text view, select Bin > Choose Columns.
   - The Bin Column Selection dialog box opens.
2. In the column list, click Color.
3. Click OK.
   - The Color column appears in the bin. By default, a new column appears as the first column in the bin, to the left of all other columns. You can reposition the Color column by clicking the column heading and dragging it to a new location.

To assign a color to a clip, subclip, sequence, or effect clip in a bin:
1. With a bin in Text view, select the bin objects to which you want to assign a color.
2. Do one of the following:
   - Select Edit > Set Clip Color and click a color.
   - Right-click in the Color column and click a color.
   - Alt+right-click (Windows) or Option+Command+click (Macintosh) in the Color column in the bin, and then select one of the colors from the color picker.
   - The color appears in the Color column (Text view only).
To reset clip color to the default, do one of the following:

- Select Edit > Set Clip Color and click None.
- Right-click in the Color column and click None.

**Locking and Unlocking Items in a Bin**

You can lock any items in a bin — including source clips, master clips, subclips, and sequences — to prevent deletion. When you lock clips in a bin, you lock their associated media files on your desktop as well.

**To lock items:**

1. Click a clip, subclip, or sequence to select it. Ctrl+click (Windows) or Cmd+click (Macintosh) additional clips, if necessary.

2. Select Clip > Lock Bin Selection.

   A Lock icon appears for each locked clip in the Lock column of the bin in Text view.

   If the Lock column does not display, you might have the column hidden. For information on hiding and restoring bin columns, see “Moving, Aligning, and Deleting Bin Columns” on page 362.
To unlock previously locked items:

1. Select the items in the bin.
2. Select Clip > Unlock Bin Selection.

You can use the clip-locking feature along with archiving software to automatically archive all locked media files.

**Selecting Offline Items in a Bin**

Offline items are clips, subclips, or sequences that are missing some or all of their original media files or that have never been captured.
To identify offline items, do one of the following:
- Select Bin > Select Offline Items.
- Click the Bin Fast Menu button, and then select Select Offline Items.

The bin highlights all items that are missing media files. To identify offline items in the Timeline, see “Displaying Clip Colors in the Timeline” on page 667.

Selecting Media Relatives for an Object in a Bin

When you identify media relatives of a selected clip or sequence, your Avid editing application highlights all other clips linked to the selected clip, such as subclips or other sequences.

You can also use the Media tool to look at the captured video and audio data files stored on your media drives. For more information on the Media tool, see “Using the Media Tool” on page 471.

To identify media relatives:

1. Open the bin that contains the selected clip or sequence.
2. Open any other bins that might contain the media relatives that you want to find.
3. Resize and position the bins so that you can see their contents.
   - Text view is the best display for viewing as many objects as possible.
4. Select the clip or sequence, and select Bin > Select Media Relatives.
   - The system highlights all related objects in all open bins.

Example of finding media relatives. In the bin on the right, objects are highlighted if they relate to the sequence selected in the bin on the left.
Selecting Sources Used by an Object in a Bin

The Select Sources command identifies all the sources used by a particular object. For example, if you select a sequence as the object, the Select Sources command identifies every master clip, subclip, tape, and media file that is a source for that sequence.

To identify sources for a clip or sequence:
1. Select one or more objects in a bin.
2. Select Bin > Select Sources.
   All sources for the selected objects in all open bins highlight.

Selecting Unreferenced Items in a Bin

When you select unreferenced clips, your Avid editing application highlights all clips not currently referenced by clips or sequences that are in the open bins. Any master clips, subclips, or effect clips you edited into sequences in the bins do not highlight.

The Select Unreferenced Clips option is useful for finding unused media.

To identify unreferenced clips:
1. Open the bin containing the sequence or clip that is referenced.
2. Open all other bins containing clips that were used during editing.
3. Select Bin > Select Unreferenced Clips.
   A message informs you that unreferenced clips highlight in open bins only (items in closed bins do not display).
4. Click OK.
   All unreferenced clips highlight in the open bins.

Working with Bin Columns

The topics in this section describe how to work with the columns of information that appear in the bin when you are in Text view.

For more information on Text view, see “Using Text View” on page 341. For information on modifying the information that appears in bin columns, see “Modifying Clip Information” on page 368.
Moving, Aligning, and Deleting Bin Columns

You can move, align, and delete columns in a bin.

When you align bin columns, the system maintains the same order of columns from left to right but spaces them according to the length of their contents. This is useful to remove spaces which remain after you move or rearrange columns.

When you delete a statistical column it is the same as hiding the column; you can restore the column at any time by using the Bin Column Selection option. When you delete a custom column, however, you must re-create the column.

For information to display and hide column headings in the bin, see “Using Text View” on page 341.

To move a text column in a bin:
1. Click the heading of the column that you want to move.
   The column is highlighted.
2. Drag the column to the position you want, and release the mouse button.
   A bounding outline of the column guides you as you drag it. The column appears in the new position, and columns to the right move to make room.

To align bin columns:
- Select Bin > Align to Columns.

To hide or delete a column:
1. Do one of the following to hide a column:
   - Click the column heading in a bin, and then select Bin > Hide Column.
   - Right-click a column heading and select Hide Column.
     The column disappears from the view, and surrounding columns close to fill the space.
2. Do one of the following to delete a column:
   - Click the column heading in a bin, and then select Edit > Delete.
   - Click the column heading in a bin, and then press the Delete key.
     The column disappears from the view, and surrounding columns close to fill the space.
3. When you delete a custom column, a confirmation dialog box opens. Select OK to delete the column or Hide to hide the column and save the custom information.

If you delete a custom column, all information in the column is deleted. You must re-create the column to restore it.
Duplicating Bin Columns with Timecode Information

You can duplicate existing columns containing timecode information into other compatible columns that you target.

When you duplicate a timecode column (Start, TC 24, TC 25, TC 25P, or TC 30), the values for master clips and subclips convert to the appropriate timecode. For more information, see “Displaying Timecodes in a 24p or 25p Project” on page 366.

To duplicate a timecode column:
1. Click the column head you want to duplicate.
2. Select Edit > Duplicate.
   The Select dialog box opens.
3. Select a column name from the list.
   The column must contain the same type of data for the copy to occur. For example, you can copy start timecodes to the Auxiliary TC column, but you cannot copy timecodes to the Pullin column.
4. Click OK.
   The column of information appears in the column you designated.

Adding Customized Columns to a Bin

In addition to the standard column headings, you can add your own column headings to describe information about clips and sequences. For example, you might want to add a column heading to describe what kind of shot (close-up, wide shot, master shot, extreme or close-up) is used in a clip.

To add a new custom column:
1. Move any existing column to the right or left to create an empty area.
   Move the column partly over the adjacent column. If you move the column too far, the column repositions.
2. Click an empty area to the right of the current headings in the headings box.
   A text box appears.
3. Type the column heading you want, and press Enter (Windows) or Return (Macintosh).
   Column headings must contain a maximum of 14 characters, including spaces.
   This places the pointer in the data box, beside the first clip in the bin.
4. Select Bin > Align to Columns after you enter the new column heading.
5. Type the information, and press Enter (Windows) or Return (Macintosh) to move to the next line.

Changing a Custom Bin Column Heading

You can change the heading name of custom columns only. You cannot change any of the standard column headings.

To change the name of a custom column:

1. Press and hold the Alt key (Windows) or Option key (Macintosh), and click the heading to highlight it.
2. Type the new text for the heading, and press Enter (Windows) or Return (Macintosh).

Adding a Metadata Bin Column Heading

When you use the Avid Media Access (AMA) method to link to third-party media, each manufacturer has its own metadata information associated with the media. Avid displays this information in customized bin columns. The headings can include: Manufacturer, Data Source, Creation Date, and Last Update. The headings change depending on the manufacturer. After the media links into a bin, the metadata bin column headings appear at the bottom of the Bin Headings list, separated by a divider.

For information about AMA, see “Acquisition of File-Based Media (AMA)” on page 394.

To add a metadata column:

1. With a bin in Text view, select Bin > Choose Columns.
   The Bin Column Selection dialog box opens.
2. Scroll to the bottom of the list and select the metadata headings you want to add to the bin.
3. Click OK.

Only the metadata headings selected appear in the bin.

*When you use AMA and metadata column headings, Avid recommends that you do not create custom bin views. Use the default preset bin views.*

**Moving Within Column Cells**

You can use the keyboard shortcuts described in the table to move from cell to cell in bin columns:

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tab</td>
<td>Moves the pointer to the cell in the next column. You can continue to press the Tab key to move through the cells to the right until the cell in the last column highlight. The next time you press the Tab key, the cell in the first column highlights.</td>
</tr>
<tr>
<td>Shift+Tab</td>
<td>Moves the pointer left to the cell in the previous column. You can continue to press Shift+Tab to scroll through cells to the left until the cell in the first column highlights. The next time you press Shift+Tab, the cell in the last column highlights.</td>
</tr>
</tbody>
</table>
Copying Information Between Columns

To copy column information to another column:

1. (Option) If you want to copy only the information on specific rows, select the rows that contain the clip information you want to copy.
2. Select the column that you want to copy.
3. Select Edit > Duplicate.
   The Select dialog box opens, to prompt you to target a column for the data.
4. Select the target column for the data, and click OK.

Displaying Timecodes in a 24p or 25p Project

When you work with 24p and 25p projects (PAL with pulldown), you can add timecode columns to bins or the Media tool to enter and display starting timecodes in several timecode formats for master clips, subclips, and sequences.

For information to display timecodes in the Timeline and the Tracking Information display, see “Displaying Timecode Tracks in the Timeline” on page 672 and “Displaying Tracking Information” on page 518.

After you add a timecode column (TC 24, TC 25, TC 25P, TC 30, or TC 30NP) to a bin, you can use the Duplicate command to convert the values for master clips and subclips to the appropriate timecode for that column.

For example, when you work with a 24p NTSC project, if you duplicate the Start column values to one of the timecode columns and the Start column contains a master clip with the timecode 01:00:00:15, the timecode converts to the timecode of that column.

The TC1 track in the Timeline represents the timecode of the project in which you work. For example, when you work in a 24p NTSC project, the TC1 track displays the same timecode as the TC 30 track.
Adding Timecode Columns to a Bin or the Media Tool

To add timecode columns to a bin or to the Media tool:

1. Select Bin > Choose Columns.
   The Bin Column Selection dialog box opens.
2. Ctrl+click (Windows) or Command+click (Macintosh) the timecode columns you want to display.
3. Click OK.
   The timecode columns appear in the bin or the Media tool.

Frame Counting for Timecodes

The table shows the frame count for each timecode available for your Avid editing application. The timecodes are listed as 24 for 24 fps, 25 for 25 fps, 25P for 25 PAL with pulldown, 30 for 30 fps (the count skips six frames to fit 30 frames into 24 fps), 30NP for 30 fps with no pulldown, and 60 for 60 fps.

<table>
<thead>
<tr>
<th>Timecode</th>
<th>Frame Count</th>
</tr>
</thead>
<tbody>
<tr>
<td>24</td>
<td>00 01 02 03 04 05 06 07 08 09 10 11 12 13 14 15 16 17 18 19 20 21 22 23 00</td>
</tr>
<tr>
<td>25</td>
<td>00 01 02 03 04 05 06 07 08 09 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24</td>
</tr>
<tr>
<td>25P</td>
<td>00 01 02 03 04 05 06 07 08 09 10 11 13 14 15 16 17 18 19 20 21 22 23 24 00</td>
</tr>
<tr>
<td>30</td>
<td>00 01 03 04 05 06 08 09 10 11 13 14 15 16 18 19 20 21 23 24 25 26 28 29 00</td>
</tr>
<tr>
<td>30NP</td>
<td>00 01 02 03 04 05 06 07 08 09 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24</td>
</tr>
</tbody>
</table>

Adding Timecode Values to the Timecode Columns

To add timecode values to the timecode columns:

1. Open a bin or the Media tool.
2. Add the Start column and the timecode column with the format you want to use.
3. Select the Start column.
4. Select Edit > Duplicate.
   The Select dialog box opens.
5. Select the timecode heading from the list.
6. Click OK.
   The values for master clips, subclips, and sequences in the Start column convert to the
   appropriate timecode format and display in the column you selected.

Modifying Clip Information

You can change or modify the information in certain columns for your master clips, subclips,
tapes, and other objects stored in the bin. This is useful if some of the data is incorrect or if you
need to conform information for organizational purposes.

The following conditions apply to modifying clip information:

• When you modify a clip’s information, related objects automatically update to reflect the
  new data. For example, if you change the name of a clip, the updated name appears in the
  sequences that use the clip.
• You cannot modify some data after capture because changes would prevent you from
  playing back and editing the material successfully.
• You cannot change sequence data even though it appears in your bin. The only way to
  modify sequence data is to edit the sequence itself. You can, however, change the name and
  start time for the master timecode track, as described in “Changing the Name and Timecode
  for a Sequence” on page 584.

You can modify data in two ways:

• Modify some data directly for master clips, subclips, and other objects stored in a bin.
• Use the Modify command to change specific information for master clips only.

For more information, see “Modifying Data in Bins” on page 375.

Bin Column Headings

You can select individual or multiple headings to display or hide in a bin. For information on
how to select column headings, see “Moving, Aligning, and Deleting Bin Columns” on
page 362.
Your Avid editing application provides the ability to track multiple film gauges within a bin and within a sequence. Bin column headings let you display detailed information about edgecodes, film gauges, and source information such as scanned file type, color lookup table, and resource location.

If you work in an Interplay environment, the list of bin column headings include audio sample rates and video resolutions. Select from these headings to display multiple sample rates and resolutions in the bin. For more information, see “MultiRez Bin Headings” on page 1363.

You can modify information in bin columns. For example, you can type a new name for a clip or correct the start and end timecodes. For more information, see “Modifying Data in Bins” on page 375 and “Modify Command Options” on page 377.

You can modify any data in the bin even while you log, prior to capture. After the footage is captured, however, you can modify information only in selected headings, with restrictions. For more information, see the following table.

⚠️ **When you modify tape names and timecodes, the modification affects any key numbers you enter for the selected clips.**

The following table describes all bin column headings available in Avid editing applications, including information on which bin columns you can modify after you have captured footage. Depending on the model of your Avid editing application, you might not see all column headings.

<table>
<thead>
<tr>
<th>Bin Column Heading</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Heading always appears in the bin. The column contains the name of the clip or sequence (you can rename a clip or sequence after you capture it). Modifiable after capture with no restrictions.</td>
</tr>
<tr>
<td>Aspect Ratio</td>
<td>Indicates the shape of the image frame. Ratio of width to height.</td>
</tr>
<tr>
<td>Audio Bit Depth</td>
<td>Use audio bit depth when you work with audio files: 16 bit or 24 bit.</td>
</tr>
<tr>
<td>Audio Format</td>
<td>Audio format of master clips (AIFF-C or WAVE).</td>
</tr>
<tr>
<td>Audio SR</td>
<td>Audio resolution (sample rate).</td>
</tr>
<tr>
<td>Aux TC 24</td>
<td>Original HDTV sources (1080p/24) or audio DATs created for PAL feature film productions that use in-camera timecode.</td>
</tr>
<tr>
<td>Auxiliary Ink</td>
<td>Auxiliary ink format settings let you display an additional type of ink number. This lets you track additional types of film information for different film gauges. Used for 24p projects, 25p projects, and matchback projects only. Auxiliary Ink is the starting frame for the clip.</td>
</tr>
</tbody>
</table>
## Bin Column Heading | Description
--- | ---
Auxiliary TC1 through TC5 | You can enter an auxiliary timecode, such as Aaton® or Arri, or another timecode for editing film or audio timecode for film. (*Not restricted to film projects.*) Modifiable after capture with no restrictions.
AuxInk Dur | Length of the clip, expressed in the auxiliary ink number. You cannot modify this number.
AuxInk Edge | Type of edgecode used in the auxiliary ink number. Ctrl+click the cell, and then select the type of edgecode. See “Selecting an Edgecode Type” on page 382.
AuxInk End | Ending auxiliary ink number for the clip. You cannot modify this number.
AuxInk Film | Film gauge for the auxiliary ink number. Ctrl+click the cell, and then select the gauge. See “Selecting a Film Gauge” on page 381.
Cadence | Type of pulldown present on the source NTSC tapes when in a 23.976 or 24p project. Modifiable after capture (Ctrl+click and choose from the menu). All clips with the same tape name change according to your selection.
Camera | Camera used to film this clip. This feature is used in multicamera shoots.
Camroll | Camera roll containing this clip. Used for 24p projects, 25p projects, and matchback projects only.
CFPS | Captured frames per second.
Color | Color of the bin objects for organizing the objects. For more information, see “Assigning Colors to Objects in a Bin” on page 357. Modifiable after capture with no restrictions.
Color Framing | The color framing for the tape. For NTSC, the choice is Even or Odd. For PAL, the choice is A Standard, A Non-Standard, B Standard, or B Non-Standard. Modifiable after capture in accordance with tape specifications. For more information, see “Tracking Color Frame Shifts” on page 727.
Color Space | Indicates the color space (RGB or YUV) of the clip.
Comments | Modifiable after capture with no restrictions.
Creation Date | Date and time you log or capture the clip.
Disk Label | For XDCAM media, this heading displays the user-supplied disk label you create when you import the media file. For other media, the heading displays the disk label of the drive from where you imported the clip. For more information, see “Importing XDCAM Media” on page 320.
## Bin Column Heading | Description
--- | ---
**DPX** | Frame-counting field for Digital Picture Exchange, a SMPTE standard describes frames scanned from film. The format includes: a descriptor of up to 32 alphanumeric characters, followed by a hyphen (-), followed by a six-digit frame count, for example, DPXChildDocu-023657.

**Drive** | Last known drive where the media for the master clip existed.

**Duration** | Length of the clip.

**End** | Timecode of the clip’s tail frame.

**Field Motion** | Sets the default source parameter value for the Motion Adapter effect.

**Film TC** | Timecode you use on film. For 24p and 25p projects only.

**Format** | The format of a clip or sequence which you determine by the project type, such as 30i NTSC or 1080i/59.94. This is useful if you have both SD and HD clips in the same bin.

**FPS** | Play rate: the number of frames that display each second. The default is 29.97 for NTSC and 25 for PAL for video. The play rate is also 24 or 23.98.

**Frame** | Displays the same frame that displays when you select Frame view. See “Using Frame View” on page 346.

- *It takes longer for the screen to display frames than text.*

**Frame Count Duration** | Displays the frame count duration of the clip.

**Frame Count End** | Displays the end frame count for the clip. This number is automatically adjusted if you change the Frame Count Start.

**Frame Count Start** | Displays the start frame for the clip. You can edit the number in the column to change the starting frame.

**IN-OUT** | Length of the marked segment.

**Ink Dur** | Displays the length of the clip, in ink number. For 24p projects, 25p projects, and matchback projects only. You cannot modify this number.

**Ink Edge** | Type of edgecode you use in the ink number. See “Selecting an Edgecode Type” on page 382.

**Ink End** | Ending ink number for the clip. You cannot modify this number.

**Ink Film** | Film gauge for the ink number. See “Selecting a Film Gauge” on page 381.

**Ink Number** | Ink number for the clip. For 24p projects, 25p projects, and matchback projects only.
### Bin Column Heading | Description
--- | ---
Journalist | First and last name of a person associated with the clip. Metadata information from a P2 file. Modifiable after capture with no restrictions.
KN Dur | Length of the clip, expressed in feet and frames.
KN End | Ending key number for the clip. Modifiable after capture only for 24p, 25p, and matchback projects. If you alter the starting key number, you also alter the KN Start to maintain the duration.
KN Film | Key number film gauge. See “Selecting a Film Gauge” on page 381.
KN IN-OUT | Mark IN and Mark OUT key number for the clip.
KN Mark IN | Key number for the IN point, if you set one for the clip.
KN Mark OUT | Key number for the OUT point, if you set one for the clip.
KN Start | Starting key number for the clip. Modifiable after capture only for 24p, 25p, and matchback projects. If you alter the starting key number, you also alter the KN End to maintain the duration. This causes discrepancies with any auxiliary timecode information that you enter manually.
Labroll | Labroll containing the clip.
Lock | Specifies whether the clip is locked from deletion.
LUT | File name of the color look-up table used for the series of clips or frames.
Mark IN | Timecode for the IN point, if you set one for the clip. Modifiable after capture — altering the mark IN also alters the IN to OUT duration. This replaces any previous mark.
Mark OUT | Timecode for the OUT point, if you set one for the clip. Modifiable after capture — altering the mark OUT also alters the IN to OUT duration. This replaces any previous mark.
Master Dur | Length of the final master sequence, expressed in feet and frames. You cannot modify this number.
Master Edge | Type of edgecode used in the final master sequence. See “Selecting an Edgecode Type” on page 382.
Master End | Ending key number for the final master sequence. You cannot modify this number.
## Bin Column Heading Description

<table>
<thead>
<tr>
<th>Bin Column Heading</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Master Film</td>
<td>Gauge of the final master sequence. See “Selecting a Film Gauge” on page 381.</td>
</tr>
<tr>
<td>Master Start</td>
<td>Starting key number of the final master sequence.</td>
</tr>
<tr>
<td>Modified Date</td>
<td>Date and time a sequence was last edited or changed.</td>
</tr>
<tr>
<td>Offline</td>
<td>Track names for any media files offline.</td>
</tr>
<tr>
<td>Perf</td>
<td>Film edge perforations format used for 3-perf projects.</td>
</tr>
<tr>
<td>Pixel Aspect Ratio</td>
<td>Indicates the shape of each pixel in the image. Ratio of width to height.</td>
</tr>
<tr>
<td>Production</td>
<td>Name of the production associated with the clip. Metadata information from a P2 file. Modifiable after capture with no restrictions.</td>
</tr>
<tr>
<td>Project</td>
<td>Project under which the media was originally captured.</td>
</tr>
<tr>
<td>Pullin</td>
<td>Telecine pulldown of the first frame of the clip (pulldown phase). Pullin can have the values A, B, X (matchback only), C, or D. For 24p projects and matchback projects only. (NTSC only) Modifiable after capture only for 24p projects and matchback projects. You can only alter pullin data imported from a telecine-generated list directly before you capture or after you unlink. For more information, see “Modifying the Pulldown Phase Before Capturing” on page 163. (NTSC only) You can directly modify the pullin for sequences. For more information, see “Changing the Default Pulldown Phase for Sequences” on page 1097.</td>
</tr>
<tr>
<td>Pullout</td>
<td>Telecine pulldown of the last frame of the clip. Pullout can have the values A, B, X (matchback only), C, or D. For 24p projects and matchback projects only. (NTSC only)</td>
</tr>
<tr>
<td>Reel</td>
<td>Displays the reel information from the camera or capture device for those devices that support REEL info.</td>
</tr>
<tr>
<td>Reformatting Options</td>
<td>Set the media conversion mode to use when working with media of different sizes and aspect ratios in the same sequence.</td>
</tr>
<tr>
<td>Scene</td>
<td>Scene number of the clip.</td>
</tr>
<tr>
<td>Shoot date</td>
<td>Date you shot the footage. Modifiable after capture with no restrictions.</td>
</tr>
<tr>
<td>Slip</td>
<td>Number and direction of perfs for subclips (audio clips only).</td>
</tr>
<tr>
<td>Bin Column Heading</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Sound TC</td>
<td>Timecode for audio.</td>
</tr>
<tr>
<td>Soundroll</td>
<td>Sound roll the clip came from. Modifiable after you enter a soundroll.</td>
</tr>
<tr>
<td>Source File</td>
<td>Specifies the source file name.</td>
</tr>
<tr>
<td>Source Path</td>
<td>Specifies the location of resources on local or remote storage using Universal Naming Convention (UNC).</td>
</tr>
<tr>
<td>Start</td>
<td>Timecode of the clip’s head frame. Modifiable after capture with no restrictions.</td>
</tr>
<tr>
<td>Take</td>
<td>Take number of the scene. Modifiable after capture with no restrictions.</td>
</tr>
<tr>
<td>Tape</td>
<td>Source tape name.</td>
</tr>
<tr>
<td>TapeID</td>
<td>Tape ID number. Modifiable after capture with no restrictions.</td>
</tr>
<tr>
<td>TC 24</td>
<td>24-fps timecode. Modifiable after capture with no restrictions.</td>
</tr>
<tr>
<td>TC 25</td>
<td>25-fps timecode, no pulldown. Modifiable after capture with no restrictions.</td>
</tr>
<tr>
<td>TC 25PD</td>
<td>25-fps timecode with PAL pulldown. Modifiable after capture with no restrictions.</td>
</tr>
<tr>
<td>TC 30</td>
<td>30-fps timecode with 2:3 pulldown. Modifiable after capture with no restrictions.</td>
</tr>
<tr>
<td>TC 30NP</td>
<td>30-fps timecode with no pulldown (frames 00 through 29). Modifiable after capture with no restrictions.</td>
</tr>
<tr>
<td>TC 60</td>
<td>60-fps timecode. For HD projects. Modifiable after capture with no restrictions.</td>
</tr>
<tr>
<td>Track Formats</td>
<td>Multichannel audio tracks for master clips and audio clips.</td>
</tr>
<tr>
<td>Tracks</td>
<td>All tracks used by this media object.</td>
</tr>
<tr>
<td>Transfer</td>
<td>Frame-counting field for sources that you prepped for transfer. The format: a descriptor of up to 32 alphanumeric characters, followed by a hyphen (-), followed by a six-digit frame count, for example, TransferChildDocu-023657.</td>
</tr>
<tr>
<td>VFX</td>
<td>Frame-counting field for visual effects. The format: a descriptor of up to 32 alphanumeric characters, followed by a hyphen (-), followed by a six-digit frame count, for example, FXChildDocu-023657.</td>
</tr>
<tr>
<td>VFX Reel</td>
<td>Source reel identification for the FX shot.</td>
</tr>
<tr>
<td>Video</td>
<td>Clip video format (resolution, color space and field motion type).</td>
</tr>
</tbody>
</table>
Modifying Data in Bins

You can modify data in bin columns directly by typing in a selected text field. You can use the standard keyboard shortcuts for entering text — for example, press Ctrl+A (Windows) or Command+A (Macintosh) to select all text in a text field.

You can also use the Modify command for specialized control over groups of clip information. For example, you can use the Modify command to change the name of source tapes, or to increment or decrement the start and end timecodes by a specified length of time for one or several clips at once.

You can apply changes with the Modify command to master clips only. You cannot alter subclips and sequences in this way. You can modify the data of captured, imported and file-based clips. In addition, you can perform modifications that only alter the end timecodes or the tracks before capture.

⚠️ When you modify tape names and timecodes it affects any key numbers entered for the selected clips.

To modify the clip data directly in a bin:

1. Click the Text View button in the bin to enter Text view.
2. Click the cell that you want to modify. Select only one item at a time.
   The timecode data highlights, as displayed in the following example.

<table>
<thead>
<tr>
<th>Bin Column Heading</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor</td>
<td>A list of vendor headings is provided for use with Avid Marketplace. See “Adding Vendor Columns to your Avid Bin” on page 1403.</td>
</tr>
<tr>
<td>Video File Format</td>
<td>Clip video file format (OMF, AAF, MXF, or none).</td>
</tr>
<tr>
<td>VITC</td>
<td>Vertical interval timecode.</td>
</tr>
</tbody>
</table>
3. Click the cell again to enter text.
   If the pointer does not change to an I-beam, you might be selecting a column that cannot be directly modified.

4. Type the new information, and press Enter (Windows) or Return (Macintosh).

**To modify selected data using the Modify command:**

1. Click the Text View button in the bin.

2. Click the icon to the left of the clip, sequence, or other object you want to modify. Ctrl+click (Windows) or Cmd+click (Macintosh) each additional object you want to modify.

3. Select Clip > Modify.
   The Modify dialog box opens.

4. Click the Modify Options menu, and select an option.
5. Select an option or type information into the text boxes.
   For more information, see “Modify Command Options” on page 377.

6. Click OK.
   The modification takes effect.

**Modify Command Options**

<table>
<thead>
<tr>
<th>Type of Modification</th>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set Timecode Drop/Non-drop</td>
<td>Drop, Non-drop</td>
<td>Changes the timecode format between drop-frame and non-drop-frame. Setting must match the timecode format of the tape.</td>
</tr>
<tr>
<td>Set Timecode By Field</td>
<td>Start or End</td>
<td>Changes either the start or end timecode. You can only alter start timecodes after capture.</td>
</tr>
<tr>
<td></td>
<td>Hour, Minutes, Seconds, Frames</td>
<td>Lets you enter custom timecode.</td>
</tr>
<tr>
<td>Type of Modification</td>
<td>Options</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>Increment Timecode</td>
<td>Start or End</td>
<td>Changes either the start or end timecode. If you increment the start timecode automatically, it modifies the end timecode by the same amount. You can only alter start timecodes after capture.</td>
</tr>
<tr>
<td></td>
<td>Timecode text box</td>
<td>Lets you enter custom incremental timecode.</td>
</tr>
<tr>
<td>Decrement Timecode</td>
<td>Start or End</td>
<td>Changes either the start or end timecode. If you decrement the start timecode, it automatically modifies the end timecode by the same amount. You can only decrement start timecode after capture.</td>
</tr>
<tr>
<td></td>
<td>Timecode text box</td>
<td>Lets you enter custom decremental timecode.</td>
</tr>
<tr>
<td>Set Key Number</td>
<td>Key Number text box</td>
<td>Lets you enter a custom generic key number. Only for 24p, 25p, and matchback projects.</td>
</tr>
<tr>
<td>Generic (Prefix)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Set Pullin</td>
<td>A, B, C, or D</td>
<td>Selects the pulldown phase to match to the timecode entry (24p and matchback projects only). For more information, see “Setting the Pulldown Phase” on page 158. After you capture, the clip must be unlinked. See “Modifying the Pulldown Phase Before Capturing” on page 163.</td>
</tr>
<tr>
<td>Set Tracks</td>
<td>V, A1, A2, A3, A4, A5, A6, A7, A8 and D track selector buttons</td>
<td>Changes the clip’s configuration of tracks (film projects only). You must unlink the clip. See “Unlinking Media Files” on page 502.</td>
</tr>
<tr>
<td>Set Source</td>
<td>None</td>
<td>Opens the Select Tape dialog box. Selects another source tape name for the clips that should match the original source tape name.</td>
</tr>
<tr>
<td>Set Disk Label</td>
<td>Set label</td>
<td>Lets you change the name assigned to an XDCAM disk. For more information, see “Importing XDCAM Media” on page 320.</td>
</tr>
<tr>
<td>Set Format</td>
<td>Compatible formats</td>
<td>Lets you change the format of a sequence. The choice of formats is limited to the compatible frame rate of the current sequence. This option is useful if you work with downconverted HD material in an offline/online workflow. For more information, see “Changing the Sequence Format” on page 1605 and “Converting a 23.976p NTSC Sequence to 720p/23.976” on page 1608.</td>
</tr>
</tbody>
</table>
The topics in this section cover several bin procedures that are specific to working with film material.

**Film Scene Workflow**

During the organizing phase, common practice on film productions is to organize the captured clips according to scene. This helps to simplify the work environment and keeps crowded bins to a minimum.

---

<table>
<thead>
<tr>
<th>Type of Modification</th>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set Multichannel Audio</td>
<td>Mixed, Mono, Stereo</td>
<td>Lets you assign multichannel formats to audio tracks. For more information, see “Working with Multichannel Audio Tracks” on page 762.</td>
</tr>
<tr>
<td>Active Format Description</td>
<td>Active Format for 4x3, 16x9, or Use Project Format.</td>
<td>Lets you set the Active Format Description (AFD) in the data track. AFD information allows you to display the video of one aspect ratio on a display with another aspect ratio. See “Adding the Active Format Description to the Data Track” on page 1126.</td>
</tr>
</tbody>
</table>
It is good practice to copy or duplicate clips as you reorganize them in bins. As a result, the original source clips remain in the appropriate dailies bin if you ever need to recapture according to source tape.

Organize scene bins according to the following basic workflow:

1. Create one bin for each scene.
   See “Creating a New Bin” on page 89.
2. Gather clips according to scene. Use one of the following optional procedures:
   - Copy clips for each scene from the capture bins into the appropriate scene bin.
   - Duplicate the clips and then move the duplicates into the appropriate scene bin.
   See “Duplicating, Copying, and Moving Clips and Sequences” on page 352.
3. Sort, sift, and organize the clips within each scene bin.

Tracking Frames Based on File Name

Bins can display a digital file name for each frame in addition to key numbers, ink numbers, and other reference numbers. Tracking frames with the frame number is useful when using the film scanning process where each frame is an independent file. It is also useful when working with effects and animation processes that are dependent on a frame-based counting scheme. You can include the frame number when you generate a cut list using the Lists Tool. See “Using the Lists Tool” on page 1100.

The naming and counting scheme consists of a prefix (8 character maximum), separated by a dash (-), and followed by 6 characters that count as total frames. For example, FXS32v01-000001 identifies the first frame of a series of frames that belong to an FX shot for Scene 32 version 1. As the FX shot progresses during the creative process, the version number increases.

To compensate for offsets, you can subtract the number of header and information frames from 999999 when entering the frame number. For example, if the first frame of picture is 1 and there are 8 frames of header and identification frames you would enter FXS32v01-999993 for the frame number.

To display the frame count numbers in a bin and cut list:

1. In the Film and 24p Settings dialog box, select Frame Count from the “Ink Number Default Edge Type” option or the “Auxiliary Ink Default Edge Type” option.
2. In a bin, select Ink Number or Auxiliary Ink from the Bin Headings dialog box.
   The Ink Number and Auxiliary Ink columns display the frame count numbers in the bin.
3. Then generate the cut list. See “Using the Lists Tool” on page 1100.
The cut list includes the frame count numbers.

**To display the frame count numbers above the Source or Record monitors in your Avid editing application:**

1. Follow the steps for displaying the frame count numbers in a bin.
2. From the Tracking Information Menu above the monitor, select either Ink Number or Aux Ink.

**Selecting a Film Gauge**

The film gauge consists of the film size and either the number of perfs per frame (for 35mm and 65mm) or the number of frames per foot (for 16mm). You specify the gauge in any of the film-gauge columns (Aux Ink Film, Ink Film, and Master Film).

*You cannot modify the KN Film column.*

**To specify the gauge of the film:**

- Ctrl+click the cell, and then select one of the following film sizes and perf count or frame count:
  - 35mm, 4 perf
  - 35mm, 2 perf
  - 35mm, 3 perf
  - 35mm, 8 perf
  - 16mm, 40 perf
  - 16mm, 20 perf
  - 65mm, 15 perf (used in IMAX® films)
  - 65mm, 10 perf
  - 65mm, 8 perf
  - 65mm, 5 perf
  - VistaVision®

**Tracking 3-Perf Counts**

You can track 3-perf counts in film projects. The perf value is an extension of the key number, and appears in the KN Start, Ink Number, and Aux Ink Number bin columns. A sample key number might look like this:

KJ 12 1234-3456-10.3
The “.3” at the end of the key number represents the perf value.

To specify the perf value:
- Enter 1, 2, or 3 in the appropriate bin column cell.

Selecting an Edgecode Type

There is one edgecode per foot of film. You enter an edgecode type for a particular place on the film in any of the edgecode-type bin columns (Aux Ink Edge, Ink Edge, Master Edge).

Select the appropriate edgecode type for a clip so you can track frames in the Timecode window, above the Source/Record monitor.

To select an edgecode type:
- Ctrl+click the cell, and select the edgecode type that matches the edgecodes on the film.

<table>
<thead>
<tr>
<th>Edgecode Type</th>
<th>Edgecode Format</th>
<th>Sample Edgecode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Key Number</td>
<td>XX NNNNNN NNNN+NN (Film type Film ID</td>
<td>KL 43 5146-0152+00</td>
</tr>
<tr>
<td></td>
<td>Feet on film+Frame in foot)</td>
<td></td>
</tr>
<tr>
<td>Edgecode (4 count)</td>
<td>NNN-NNNN+NN (Identifier-Feet on film+Frame in foot)</td>
<td>103-9025+03</td>
</tr>
<tr>
<td>Edgecode (5 count)</td>
<td>NNN-NNNNN+NN (Identifier-Feet on film+Frame in foot)</td>
<td>203-09025+03</td>
</tr>
<tr>
<td>Frames</td>
<td>NNNNNN</td>
<td>45678</td>
</tr>
</tbody>
</table>

Creating a Storyboard

To create a storyboard:
1. Synchronize picture and sound, convert audio timecode, and modify clip data.
2. Set the bin display to show the media objects for the clips you want in your storyboard.
3. Delete, move, copy, and sort clips to narrow down the clip selection.
4. Select Frame view to display your storyboard in the bin.
5. Rename clips to include additional information such as numbered ordering.
6. Use the keyboard to step through each clip and display the reference frame you want to use for each clip.
7. Select and drag one or several clips at a time to a new location to rearrange the clips in sequential order.
8. Enlarge or reduce the size of the frames as necessary.
9. Align the rearranged frames along invisible grid lines.
10. (Option) Change the font and background color for the storyboard.
11. When the storyboard is complete, select File > Save Bin.
12. To print the storyboard, select File > Print Bin.

**Setting the Bin Display**

By default, your bins display all existing media objects except source clips and rendered effects. To reduce crowding in the bin and to display only those objects that you need to organize your project, you can display selected media objects.

You can also display bins as tabs in a common bin window. For more information, see “Using Bin Tabs” on page 350.

You can use the Set Bin Display option to display clips referenced by a sequence, even if the clips were not previously in the bin.

**To set the bin display:**

1. Place a sequence in a new bin and click the bin.
2. Select Bin > Set Bin Display.
   
   The Set Bin Display dialog box opens.
3. Select the object types that you want to see: master clips, subclips, sequences.
   
   For information on the icons used to represent the different object types, see “Object Icons in Bins” on page 339.
4. (Option) Accept the default or deselect “Show clips created by user” if you want to hide all objects except those created by the system.
5. (Option) Select “Show reference clips” to automatically display objects that are referenced by sequences in the bin, whether those clips were previously in the bin or not.
6. Click OK.
   
   The bin displays objects according to your specifications.

**Sifting Clips and Sequences**

When you sift clips and sequences, the bin displays only those clips and sequences that meet a specific set of criteria. For example, you can do a custom sift to display only those clips containing the word “close-up” in the heading column. The Custom Sift dialog box provides six levels of criteria.
You can also sift on a timecode (or keycode) number within a specific range. For more information, see “Sifting Timecodes or Keycode Ranges” on page 388.

**To sift clips or sequences:**

1. Select Bin > Custom Sift.

   The Custom Sift dialog box opens.

   ![Custom Sift dialog box](image)

   Custom Sift dialog box. Left to right: Criterion menu, Text to Find text box, and Column or Range to Search menu

2. Click the Criterion menu, and select one of the sifting options.

3. Click the first Text to Find text box, and type the text that you want to use as a sift criterion. When sifting by color, type the *exact* name of the color (using uppercase and lowercase letters) in the text box.

4. Click the Column or Range to Search menu, and select a column heading to which you want to apply the criterion.

5. Type additional sift criteria, and make additional column selections as necessary.

6. Click OK.

   Only the clips or sequences that meet your criteria remain in the bin, with the word “sifted” added to the bin name. After you have sifted the clips in a bin, you can display the bin in a sifted or an unsifted state.

**To view the entire bin:**

- Select Bin > Show Unsifted.
To view the sifted bin:

- Select Bin > Show Sifted.

The word “sifted” appears in parentheses after the bin name when you view the bin in its sifted state.

**Understanding Sifting Timecodes or Keycode Ranges**

You can sift on a timecode (or keycode) number within a specific range. For example, you can sift for all the clips that start before and end after a particular timecode.

![Example of a bin before a custom sift by timecode](image)

If you type a value in the Text to Find text box in the Custom Sift dialog box, click the Column or Range to Search menu, and select Start to End Range.
Example of a bin after a custom sift by timecode. The detail of the Custom Sift dialog box (top) shows the query used for sifting, and the bin (bottom) shows only those clips that encompass the timecode number entered.

Some column pairs explicitly define a range, for example, Start and End or Mark IN and Mark OUT. Other columns define the beginning of a range, and the end of the range is determined by the Duration column. For example, Auxiliary TC1 implies a range that begins at the value in the Auxiliary TC1 column and ends at that value plus the value in the Duration column.

If you display any column in the bin that is associated with ranges, either explicit or implicit, the corresponding range menu item appears in the Column or Range to Search menu in the Custom Sift dialog box. For example, if you choose to display the Start column and the Auxiliary TC1 column in the bin, the Start to End Range and Auxiliary TC1 Range menu choices appear in the Column or Range to Search menu.

When you specify a timecode or keycode number, you do not need to enter colons or semicolons, and you can omit the leading zero. For example, you can type 3172000 as a timecode number.
Keycodes contain letters, numbers, and a dash before the feet and frames; for example, KJ23 6892-0345+13. When you sift on a keycode number, you enter only the numbers after the dash (the actual counter portion). Any information before the dash is ignored. If you do enter characters before the dash, they must match the corresponding characters in the bin column exactly.

The table lists all columns associated with explicit ranges and their corresponding menu choices.

<table>
<thead>
<tr>
<th>Bin Column (Explicit Ranges)</th>
<th>Column or Range to Search Menu Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start, End</td>
<td>Start to End Range</td>
</tr>
<tr>
<td>Mark In, Mark Out</td>
<td>Mark In to Out Range</td>
</tr>
<tr>
<td>KN Start, KN End</td>
<td>KN Start to End Range</td>
</tr>
<tr>
<td>KN Mark In, KN Mark Out</td>
<td>KN Mark In to Out Range</td>
</tr>
</tbody>
</table>

The table lists all columns associated with implicit ranges and their corresponding menu choices. The Duration column determines the end of these ranges.

<table>
<thead>
<tr>
<th>Bin Column (Implicit Ranges)</th>
<th>Column or Range to Search Menu Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>Film TC</td>
<td>Film TC Range</td>
</tr>
<tr>
<td>Sound TC</td>
<td>Sound TC Range</td>
</tr>
<tr>
<td>Auxiliary TC1</td>
<td>Auxiliary TC1 Range</td>
</tr>
<tr>
<td>Auxiliary TC2</td>
<td>Auxiliary TC2 Range</td>
</tr>
<tr>
<td>Auxiliary TC3</td>
<td>Auxiliary TC3 Range</td>
</tr>
<tr>
<td>Auxiliary TC4</td>
<td>Auxiliary TC4 Range</td>
</tr>
<tr>
<td>Auxiliary TC5</td>
<td>Auxiliary TC5 Range</td>
</tr>
<tr>
<td>Ink Number</td>
<td>Ink Number Range</td>
</tr>
<tr>
<td>Auxiliary Ink</td>
<td>Auxiliary Ink Range</td>
</tr>
</tbody>
</table>
Sifting Timecodes or Keycode Ranges

To sift for a timecode or keycode number within a specific range:

1. Select Bin > Custom Sift.
   
The Custom Sift dialog box opens.
2. Type the timecode (or keycode) number for the range in which you want to sift.
3. Type the timecode number for the range in which you want to sift.
4. Click the Column or Range to Search menu, and select a range; for example, Start to End Range or Mark In to Out Range.
   
The criterion “contain” appears in the Criterion menu. If you try to change this criterion, no information appears in the Column or Range to Search menu.
5. Click OK.
   
The bin displays those clips that encompass the timecode (or keycode) number that you entered.

Working with Restricted Material

Broadcast facilities sometimes need to manage digital rights by restricting the use of footage. You can mark restrictions on clips in Avid Interplay Assist. When you bring marked footage into your Avid editing application, you can see the restriction marker (a red triangle) on the clip icons in the bin, and your Avid editing application warns you about the restriction before you display or output that footage.
Restriction marker on a clip in the bin

When you first open a restricted clip or load a sequence containing restricted clips, a warning message box opens. The warning appears every time you open or display a clip on restricted material in this session, not just on the present clip. The same warning appears when you try to perform a digital cut, send the sequence to playback, or export. If you send more than one clip to export, the message box lists all the clip names that contain restricted material.

You can use extended search capabilities to search for restrictions in Avid Interplay Access. For more information, see the Avid Interplay Access User’s Guide. Search for the DRM (digital rights management) attribute, which can have the values Has DRM or Does not have DRM.

If you are allowed to use all restricted material in the current project and you can safely ignore the warning, you can continue with your editing or output task.

To ignore the warning for the rest of the editing session and continue with editing or output:

- Click the “Don’t warn again” button.

  Restriction warnings for the current clip or any other clip do not display. When you quit your Avid editing application and then open it, you see the warning again the first time you display or output restricted material.

  If you select “Don’t warn again,” it stops the warning from appearing again only for the current operation in the current editing session. For example, if you select it after you display a clip in the Source monitor, you can load additional restricted clips without seeing the message. If you select those clips for Export, however, you see the warning again.

  The restriction is tied to the source tape name and timecode. You can disassociate the restriction from the clip if you change those values in the bin.

To view Restriction comments, do one of the following:

- Click the View Restrictions button in the warning message box when it opens.
- Select Tools > Restrictions.

  The Restriction window opens. It displays the name, head frame, and description of each restricted clip. The description contains the comments associated with the restriction that you entered in Avid Interplay Assist.

To see changes in Restriction comments while you are editing:

1. Change the comments in Avid Interplay Assist.
2. In your Avid editing application, select Tools > Remote Assets.
3. Navigate to the changed clip, and drag it into the bin again.
The changes appear in the Restriction window.

**Printing Bins**

**To print entire bins:**
1. Make sure your printer is correctly set up.
2. Select the Text, Script, or Frame bin view of the bin you want to print.
   The Page Setup dialog box opens, reflecting the specific options for your printer.
4. Select the appropriate options.
5. Click OK (Windows) or Print (Macintosh).
6. Select File > Print Bin.
   The Print dialog box opens, reflecting the specific options for your printer.
7. Select the Print options.
8. Click OK (Windows) or Print (Macintosh).
   The system prints the active bin.

**To print a single frame of a clip or sequence:**
1. Load a clip or sequence into the Source or Record monitor.
2. Select the frame you want to print.
3. Select File > Print Frame.
   The Print dialog box opens.
4. Select the Print options.
5. Click OK (Windows) or Print (Macintosh).
   The system prints the frame currently displayed in the active monitor.

**Favorite Bins**

A Favorite Bin is a bin that you can easily access regardless of what project you are in. A Favorite Bin can hold any items that a regular bin can hold, such as clips, sequences, effects templates, and titles. You might want to create a Favorite Bin to hold often used music, transitions, and templates. A Favorite Bin can reside on local or shared storage. You can create multiple Favorite Bins. The list of Favorite Bins is stored in the current user setting. You can choose to have the Favorite Bins folder appear at the top or the bottom of the Project Window.
To create a Favorite Bin:

1. Click the Settings tab in the Project Window.
2. Double-click the Bin Settings.
   The Bin Settings window opens.

3. Select the “Favorite Bins show at” option, and choose either Top of the Project Window or Bottom of the Project Window.
4. Open the bin you want to make a Favorite Bin.
5. Do one of the following:
   - Select Bin > Add Bin to Favorites.
   - Click the Bin Fast Menu and select Add Bin to Favorites.
   - Right click in a bin and select Add Bin to Favorites.

The bin appears in the Project Window in the Favorite Bins folder. If the same user opens another Project, the Favorite Bin appears in the Favorites Bins folder.
The list of Favorite Bins is stored in the Bin User settings. If you want multiple users to see the same list of Favorite Bins, you can drag the Bin Setting to the Site Settings dialog. Any newly created User setting would then automatically see the Favorite Bins. For pre-existing User settings you can drag the Bin setting from the Site Settings dialog into the Project Window's Setting tab, then make it the active Bin setting by placing the check mark to the left of the copied Bin setting. Avid recommends you name the Bin Setting before placing it in the Site Settings. For information on Site Settings, see “Using Site Settings” on page 1429.

To delete a bin from the Favorite Bin Folder:
1. Open the Favorite Bin Folder in the Project window.
2. Select the bin you want to delete from the Favorite Bin folder.
3. Click the Delete key.

**Filtering Items in the Bin**

The editing application bins include a quick filter text box that allows you to quickly filter out items in a bin that match the filter criteria. This is helpful when you have a large number of items in a bin and want to quickly filter for specific items.

**To filter items in a bin:**
1. Open the bin.
2. Enter text in the filter text box.
Filtering Items in the Bin

The search will display only those items in the bin that match the search criteria.

If individual columns are selected, the search is performed on the information in the selected columns. If no columns are selected, the search is performed on all displayed columns.
You can link, import, or export clips and sequences from many third-party volumes or third-party files to and from the Avid editing system. You can manipulate and edit this media as you would any other clip or sequence.

File-based media can be acquired from a third-party device (a camera, reader, or drive), from a CD or DVD, from a folder on your system, or from a virtual volume (a server connected to your system). To move the media into your Avid editing system, you have the option to use the AMA method (Avid Media Access) which links the file-based media directly into a bin through an AMA plug-in, or you can use the non-AMA method which imports the media onto your system. When you work with high-resolution media, the AMA method is the preferred and the faster method.

AMA linking also allows for more metadata to be brought into the bin which gives you more information about the media. For example, essence marks (or markers) associated with the clip are automatically brought into your bin.

For information on importing and exporting media, see “Importing Files” on page 297 and “Exporting Frames, Clips, or Sequences” on page 1019.

Before you begin working with AMA, make sure you have done the following:

- Go to the avid.com web site to make sure you download the AMA latest plug-in for your specific third-party device.
- If you are using an XDCAM, XDCAM EX or a P2 device, make sure you have the appropriate drivers installed. See your third-party documentation for information on installing drivers.
- Connect the third-party device according to the documentation supplied with the device.

The Avid Media Access (AMA) Workflow

Avid Media Access (AMA) is a plug-in architecture that lets you link directly to clips on an external third-party device. The device can be a camera, a card reader, an optical disk, a virtual volume. AMA lets you be more productive by browsing and editing directly from the device or volume.
There are two ways of browsing and editing this media:

- Manually browse through the media on the third-party device, and link to selected media to create master clips in your bin, or
- Move all the media from the third-party device to an Avid Dynamic Media Folder (DMF) where you have set up an automated process to create the master clips.

Typical media management functions (e.g. deletes, transcodes, consolidates) apply to all AMA-linked clips in the same robust manner as they do for managed MXF Avid-compliant OPAtom files. All media, whether captured, imported or linked by AMA, will be displayed in a single window in the Media Tool.

AMA and dynamic media folders are the quickest method by which you can automate the acquisition of footage, and significantly enhance your production workflow when working with media in popular digital formats.

With the use of dynamic media folders, you can organize your files and assign automated actions to a “watched” folder system. These actions run in the background, allowing you to keep working while files are being ingested into the application. The actions include copy, transcode, and create master clips—see “Creating Dynamic Media Folders” on page 400.

Before you begin editing, set up media service profiles to run automated media acquisition actions on the specific drives/folders where the original media is located. Any files placed in these folders will be processed and managed in the background.

Avid recommends that you first create a profile to do the copy. If you intend to do other functions, such as transcode, this can be done with a separate profile later in the process.

The illustration below shows how you can automate the acquisition of file-based media in the background so that you can continue editing your sequence without interruption.
The Avid Media Access (AMA) Workflow

1. The pre-configured Dynamic Media Folder (DMF) profiles will automatically copy the files from the external device to an AMA media folder of your choice on a local or shared storage. These folders will be managed and indexed by the application.

2. Master clips will be created for all the copied files and added to a 'staging' area so as not to cause interruptions each time a new file is acquired. Any related audio and video files will be auto-synced. Similarly, any related clips coming from multiple cameras will be auto-grouped.

3. Depending on how your dynamic media folders were configured, some specific file formats will be transcoded to MXF proxy media. This media will be placed in the Avid MediaFiles folder and separate master clips (*.new) will be created in the bin for this media.

4. When the media has been moved to the local or shared storage, and the master clips are ready to be pulled into a bin, you will be notified by a green light to the right of the audio meters in the timeline. Through the Dynamic Media Folders dialog, you can request a bin update.

You can start building your rough-cut by linking directly to the media on an external device. You can later update your bins so that any AMA-linked clips already on the timeline will automatically update to reference the new location of the media.

You can also switch from working with the master clips to the transcoded clips (proxies), but you will need to manually relink your sequence to the .new master clips in the bin.
In an Interplay environment, the relink can be done automatically. See “Enabling Dynamic Relink” in the online help.

Considerations and Limitations for AMA

Footage from the Sony XAVC and ARRI ALEXA cameras can be recorded directly to MXF. Since Avid will have native HD codecs for these MXF formats, editors can link to or import this media in Media Composer and work immediately with these formats.

Other high resolution raw file formats that are not supported by Media Composer can be transcoded to MXF. Transcoding is a more time-consuming operation but once the media is available in MXF it provides better performance for playback and rendering.

The following limitations apply:

• When the AMA setting is activated, the non-AMA method does not appear in the File menu. Deactivate the AMA setting to display the File > Import P2 (and Import XDCAM Proxy) option. The AMA setting is on by default.

• Windows UNC (Universal Naming Convention) paths are supported with AMA media. You can move your AMA bins from a Windows system to a Macintosh system and from a Macintosh system to a Windows system. The media files need to reside in the same shared location when you move the bins to and from different operating systems.

• Do not AMA link to a volume or file if the file path name has an illegal character. AMA clips display offline if the file path name you are linking to contains illegal characters, including < > : “ | ? *. for Windows and : for Macintosh.

• You can create stereo clips from AMA-linked media. Refer to Avid Stereoscopic 3D Editing Workflow Guide.

• Interplay and Media Composer | Cloud users can use the dynamic relink capability to view the best available media for AMA-linked clips. Refer to “Using Dynamic Relink with Media Composer | Cloud Editing Systems” on page 1341.

• When you render an audio effect on an AMA media clip, all audio media files are written as PCM (MXF), regardless of what you set for the audio file format.

• Avid does not support MultiCamera editing with AMA clips.

• You should not mix workflows. Either use the AMA method or use the traditional import/batch import method.

Viewing Installed AMA Plug-ins

Once you download and install a third-party AMA plug-in from avid.com, you can enter a console command to view a list and the version number of the plug-ins installed on your system.
To display the list of installed AMA plugins:
1. Select Tools > Console.
2. In the command entry text box, type: **AMA_ListPlugins**
3. Press Enter (Windows) or Return (Macintosh).
   
   AMA_ListPlugins displays a list of the plugins installed on your system.

**Selecting the AMA Settings**

You can set options in the AMA Settings dialog box to turn AMA on or off (on by default), to automatically mount your volumes, to customize your bin, and to set audio channel linking options.

**To set up AMA:**

1. In the Project window, click the Settings tab.
2. Double-click AMA.
   
   The AMA Settings dialog box appears.

3. Click the Volume Mounting tab.
4. If you want the system to automatically scan drives (volumes) every time, select the option “When mounting previously mounted volumes, do not check for modifications to the volume.” This option is off by default.
5. If you remount a volume, deselect the option “When mounting previously mounted volumes, do not check for modifications to the volume,” and the system checks the modification date of the device or drive against the last time the clips were linked. If the date is the same, the clips come back online. If the date is different, the system links the clips again, and links any new clips added to the volume. This option is off by default.

If you restart your Avid editing application, the system automatically rescans the drives regardless of the options you’ve selected.

6. To customize your bin, click the Bins tab.

By default, the system links your clips into a new bin using the same name as your project name. If you want to change the bin name or want to use an already existing bin, you can make these changes in the Bins tab.

For more information on Bins options, see “AMA Settings: Bins Tab” on page 1433.

Depending on your AMA Settings, every time you insert a card into a reader, the system creates a new bin regardless of whether the same card or device has been inserted or not.

7. To map source audio channels to multichannel or mono tracks in your clips, click the Link Options tab, and then click Edit.

The Set Multichannel Audio dialog box opens. For information on setting multichannel audio options, see “Importing with Multichannel Audio” on page 305.

8. Click OK.

Manually Copying File-Based Media to a FireWire or Network Drive

After you’ve connected your camera or other portable storage to the editing system, you can copy the media to a FireWire drive or a network drive and then eject the camera or disk.

Alternatively, you can use Dynamic Media Folders (DMF) and profiles to carry out this copy function in the background—see “Creating Dynamic Media Folders” on page 400.

You can work with media on a card/disk or work with media on another drive, but you cannot work with media that is stored in both places simultaneously. To avoid the problem, eject the card or disk after you copy the media files to the other drive.

To manually copy the card or disk media to another drive:

1. On the local or shared system drive, set up a folder for each card or disk you want to copy.

Follow the recommendations outlined in “Organizing your File-Based Media” on page 44.
2. Give each folder a unique name that identifies the card or disk.
   The name does not have to be the same as the actual card or disk name.
3. Navigate to the actual card or disk and select the folder with the media.
4. Do one of the following:
   - Copy and paste the contents of the card or disk media folder to the system folder.
   - Click the card or disk folder and drag it to the system folder.
5. Eject the card or disk.

**Dragging and Dropping File-based Media Directly to a Bin**

You can drag and drop file-based media directly to a bin.

**To drag and drop files directly into a bin:**

1. Navigate to the folder that contains the file based media.
2. Select the files you want to drag to the bin.
3. Alt + drag (Windows) or Option + drag (Macintosh) the files to the bin.
   The files appear in the bin as AMA linked files. These are also managed files and appear in the Media Tool.

**Creating Dynamic Media Folders**

Dynamic Media Folders (DMFs) are user-created folders that allow you to work more efficiently with file-based media. DMFs allow you to manage and process media even when the editing application is not running. For example, you can create an automated process where the media from a digital camera or removable drive can be moved off the camera and placed in a designated folder on a shared storage, allowing the production team to quickly take the device back out to the field.

You can create DMFs that are set up to perform background tasks such as copying, transcoding or consolidating. You can create a DMF folder that:

- copies all files placed in the DMF to a specified location
- transcodes any file that is placed in the folder to a specified resolution
- creates linked master clips in a particular bin
AMA media is now managed. Therefore the AMA media will now appear in the Media Tool and can be checked into Interplay.

The basic workflow for using DMFs is the following.

- In the Dynamic Media Folders window, create a DMF folder. This folder can reside locally or on shared storage.
- Create a new profile or assign an existing profile to the DMF folder. This profile is where you specify the actions you want performed on any files that get added to the DMF folder.
- An indicator on the Timeline will let you know when files have been added to a DMF folder. Access the DMF window and choose to place the files from the DMF into the appropriate bin.

To create a Dynamic Media Folder:


   The Dynamic Media Folders window opens.

2. Create a new folder by clicking the + icon in the Dynamic Media Folders window.

   The Select Folder window opens.

3. Navigate to the folder on which you want to perform the action and click Choose.

   A DMF is added to the list.

4. Click the Profile Editor button to create a profile that you want associated with the DMF.

   The Profile Editor opens.
5. Click the Menu bars to open the default profile summary and default AMA Settings and Actions.

6. Select AMA Settings options as described in the following table.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AMA Plugin</td>
<td>Link Using</td>
<td>Select which Plug-in you want the editing application to use when performing AMA links for the files added to the selected DMF folder. If you are linking to Volumes, Avid recommends you select the Autodetect AMA Plug-in.</td>
</tr>
<tr>
<td>Bins</td>
<td>Use active bin</td>
<td>When this option is selected, your Avid editing application uses the currently active bin to store clips linked using AMA.</td>
</tr>
<tr>
<td>Setting</td>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Create a new bin</td>
<td>When this option is selected, your Avid editing application creates a new bin to store clips linked using AMA and controls the bin name. This is the default option.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Default bin naming convention: uses the project name for the bin (bin name followed by a consecutive number).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Volume name: the name or label of the volume (for example D:).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Specify bin name: lets you enter a new bin name.</td>
</tr>
<tr>
<td>Link</td>
<td>Multichannel Audio</td>
<td>Select this option if you want to assign audio tracks to specific channels in your linked media, up to a maximum of 16 audio channels for the clips in your bins. This allows you to specify which source channels are treated as mono or multichannel audio tracks in your project, rather than having to modify the clips in your bin after you link to the AMA media.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Click Edit to open the Multiple Mixes dialog box, which allows you to map audio tracks to channels.</td>
</tr>
<tr>
<td></td>
<td>Audio Start-Time Option (for Broadcast Wave)</td>
<td>Select this option to set the audio Project Rate for Broadcast Wave files.</td>
</tr>
<tr>
<td>AIS</td>
<td>Reel name for Labroll column based on:</td>
<td>Select from where to read the Reel name. This information will appear in the Labroll bin column. If data exists in the Input Device field of the DPX file, this information will appear in the Camroll bin column after linking to the file. If no data exists in the Input Device field, the Camroll bin column will be empty.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Source file name - Enabling this setting gets the Reel Name from the source file name. If the source file name is only numeric characters, no data will appear in the Labroll bin column.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Source folder name - Enabling this setting gets the Reel Name from the folder name specified. When Source folder name is enabled, a pulldown menu becomes active. The pulldown menu is used to select a particular folder in the DPX folder directory structure. The directory range is one folder (that contains the DPX files) up to eight folders higher.</td>
</tr>
</tbody>
</table>
Creating Dynamic Media Folders

7. To add actions to be performed on files found in the DMF such as copy, transcode, consolidate or check into Interplay, click the Actions + to add an action.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frame Count for DPX column:</td>
<td>Select how you want Frame count to appear in the DPX bin column and Tracking Information. The frame count will appear as a 7 digit number in the DPX bin column. The DPX pre-fix is derived from the Labroll bin column. If no data exists in the Labroll column, then the DPX prefix will be empty.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Start frame count at 0 - Enabling this setting starts the frame count in the DPX column at 0000000</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Start frame count at 1 - Enabling this setting starts the frame count in the DPX column at 0000001</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Convert timecode to frames - Enabling this setting extracts timecode from the header and converts it to frames based on the current timebase</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• From the File name - Enabling this setting gets frame information from the file name</td>
</tr>
<tr>
<td>Timecode for Start column:</td>
<td>Select where to read the Timecode. This information will appear in the Start bin column. If no timecode can be extracted from either location, the column will populate with the default timecode.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Embedded in source file - Enabling this setting extracts the timecode from the Header file</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• From file name - Enabling this setting gets the timecode from the file name</td>
</tr>
<tr>
<td>Default FPS</td>
<td>Select a default FPS if there is no FPS in the DPX header file,</td>
<td></td>
</tr>
</tbody>
</table>
8. Click the Menu button on a row to access the desired copying, consolidating and/or transcoding actions you want to be performed on the files. Choose from the following options:

<table>
<thead>
<tr>
<th>Action</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy to Folder</td>
<td>Copy to:</td>
<td>Click the Set button to choose the location where you want the files copied to.</td>
</tr>
<tr>
<td></td>
<td>Auto Relink when complete</td>
<td>Files are automatically relinked when the copy is completed.</td>
</tr>
<tr>
<td></td>
<td>Checkin to Interplay</td>
<td>Checks in assets to Interplay. When you select this option, also select the “Auto Relink when complete” option.</td>
</tr>
<tr>
<td>Consolidate</td>
<td>Skip media files already on the target drive</td>
<td>Select to bypass files if some related media files are already located on the target drive.</td>
</tr>
<tr>
<td></td>
<td>Relink selected clips to target drive before skipping</td>
<td>Select to ensure that all selected clips are linked to media on the target drive.</td>
</tr>
<tr>
<td></td>
<td>Convert Audio Sample Rate</td>
<td>Select this option to convert the sample rate to 32 kHz, 44.1kHz, or 48 kHz.</td>
</tr>
<tr>
<td></td>
<td>Convert Audio Bit Depth</td>
<td>Select this option to convert the Bit Depth to 16 Bit or 24 Bit.</td>
</tr>
<tr>
<td></td>
<td>Convert Audio Format</td>
<td>Select either OMF (WAVE), OMF(AIFF-C), or MXF (PCM) audio format.</td>
</tr>
<tr>
<td></td>
<td>Video Drive Audio Drive</td>
<td>Select the applicable drives.</td>
</tr>
<tr>
<td>Transcode</td>
<td>Transcode Video Resolution</td>
<td>Select the applicable Project type, Color Space, Raster and Codec you want to transcode to.</td>
</tr>
<tr>
<td></td>
<td>Apply Reformatting option (compatibility mode)</td>
<td>Transcodes the media and applies any framing and reformatting options that have been set on the master clips.</td>
</tr>
</tbody>
</table>
Creating Dynamic Media Folders

9. You can also reorder the actions by priority by dragging one above or below the other.

10. Click Save to save the Profile.

11. Name the Profile and click OK.

12. Assign the profile to the DMF by choosing the profile from the drop down list.

13. Select Enable in the Dynamic Media Folders window to make sure that any files added to the Dynamic Media folder will have the actions set by the associated Profile.

When files are placed in a Dynamic Media Folder, you will see a progress indicator in the Timeline.

When you are working with DPX files and DMF, drop the folder containing the .dpx files into the DMF folder rather than individual .dpx files. This will allow each group of consecutive dpx files in that folder to be managed as individual master clips.

If the progress indicator includes a solid green dot in the center, new DMF assets are available. See the table below for descriptions of other possible indicators.
14. If there is a green dot, right+click the progress indicator and select Dynamic Media Folders.

<table>
<thead>
<tr>
<th>Button State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solid green dot</td>
<td>You can access the DMF folder to ingest the assets into your bin.</td>
</tr>
<tr>
<td>Spinning with or without a green center dot</td>
<td>This indicates that background processing is in progress.</td>
</tr>
<tr>
<td>Grey</td>
<td>This indicates that the background services have been suspended. To restart the services, select Tools &gt; Background Services and click Start.</td>
</tr>
<tr>
<td>Yellow</td>
<td>This indicates the background service is paused. To restart a paused background service, select Tools &gt; Background Services and click Start.</td>
</tr>
<tr>
<td>Not spinning and no center dot</td>
<td>This indicates that no background processing is in progress and there are no DMF assets to ingest.</td>
</tr>
<tr>
<td>Icon with yellow triangle</td>
<td>If any of the progress icons appear with a yellow triangle, an error has occurred during previous background processing. Right-click the progress indicator and select Generate Error Report in Console. The yellow triangle will remain until you generate an error report.</td>
</tr>
</tbody>
</table>

The Dynamic Media Folders window opens.
15. Click the green icon in the Acquire column.

The new assets will populate the editing application Bin according to the Bin setting you chose in the Profile Editor. Any clips that have been consolidated or transcoded will also populate the bin as .new files. If some clips are still being processed, they will populate the bin as offline. When they are ready, the Acquire icon will redisplay next to the DMF.

You can monitor the background progress of these files by selecting Tools > Background Queue.

You can cancel a job by clicking on the x next to the item in the queue. If you want to cancel all jobs in progress, you can stop the Avid Background Services.

Starting and Stopping Avid Background Services

The editing application installs a Background Transcode service, a Background Render service, and a Dynamic Media Folder service. These services are off by default. You must turn the Avid Services On if you want to use either Background Transcode, Background Render or Dynamic Media Folders. You can choose to turn the services on or off either from the taskbar (Windows) or menu bar (Macintosh). Or you can choose to stop, start, or pause the services from within the editing application.
Starting and Stopping Avid Background Services

To Start and Stop the Avid Services Outside the Editing Application:

1. Click the Avid Background Services Manager icon in the menu bar (Macintosh) or right-click the Avid Background Services Manager icon in the task bar (Windows) and choose to Stop or Start the services.

   The icon changes color to represent the state of the services; green (services active) - gray (services not active) or orange (services paused).

2. To restart the services, click the Avid Background Services Manager icon (Macintosh) or right-click the Avid Background Services Manager icon (Windows) and choose to Start the services.

   If you choose to Quit the Avid Background Services, the icon will no longer appear in the taskbar. To get the taskbar icon to appear again, select Tools > Background Services, enable “Always Start Avid Editor Services at Launch” and restart the application.

To Start, Stop or Pause the Avid Services from within the Editing Application:

1. In the editing application, select Tools > Background Services.

   The Background Services window opens.

2. Choose from the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start</td>
<td>Immediately starts the background services if they are currently stopped.</td>
</tr>
<tr>
<td>Stop</td>
<td>Immediately stops the background services if they are currently running.</td>
</tr>
<tr>
<td>Pause</td>
<td>Allows you to explicitly pause the background services for the specified amount of time. This might be useful if you are experiencing a slow down due to background services and need to temporarily stop the services from running. If the pause time period ends and you are in the middle of a play operation, the pause time period is extended.</td>
</tr>
<tr>
<td>Always Start Avid Background Services at Launch</td>
<td>Select this option if you want the background services to start when you launch the editing application.</td>
</tr>
</tbody>
</table>
Linking Media with AMA

The editing application will automatically link clips on a volume when you connect to your third-party device. You can also use the File > AMA Link option to manually link to a volume or file.

AMA media is managed. AMA managed media means that the AMA media is tracked. The AMA media is associated with .pmr and .mdb files. Therefore the AMA media will appear in the Media Tool and can be checked into Interplay.

AMA linking lets you point to media on a device or point to the media directly on your system. The media physically resides on your system or it can reside on an external device. The media points to the most recent source. For example, if you link the clips to a virtual volume on your desktop, the drive column displays the desktop as the location where the clips are linked to. If you then insert a card into a reader with the same media, the clips point to the media on the card. If you remove the card, the clips point to the media on the card and the clips appear offline. The card being the most recent source. Once the card is reinserted, the clips in the bin appear online.

See also, “Using Virtual Volumes” on page 424 and “Virtual Volumes and AMA Bins” on page 424.

For optimum viewing and playing, Avid recommends a single clip length should not exceed more than 12 hours.

The decompose option from the Clip menu is not available with AMA. You do not need to decompose clips when you use the AMA Link.
To automatically link clips from a third-party device:

1. Connect the drive, card reader or device to your computer as described in the third-party device documentation.

The system scans the device and links the clips into the default bin and with the default multichannel audio track formats (based on the AMA settings). A link icon appears next to the clip.

To change the default bin, bin name, or audio track format, from the Project window double-click AMA Settings and select options from the Bins and Link Options tabs.

For more information, see “AMA Settings: Bins Tab” on page 1433.

To link clips from a virtual volume with AMA:

1. Select File > AMA Link.

The Open dialog box opens.

2. Navigate to the folder that contains your file-based media.
For P2, navigate one level above the Contents folder. For XDCAM disks, navigate to one level above the Clip folder. For XDCAM EX, navigate to one level above the BPAV folder. For RED, navigate to the root directory of the RED card. For GFCAM, navigate to the root directory of the GFPAK. For QuickTime, navigate to the QuickTime folder that holds the QuickTime files.

Depending if you are using an existing bin or creating a new bin, the Bin Selection dialog box opens.

![Bin Selection Dialog]


<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single Bin Based On Selected Folder</td>
<td>Places all linked clips into one default bin.</td>
</tr>
<tr>
<td>Single Bin Named</td>
<td>Lets you create a new bin and type in a new bin name.</td>
</tr>
<tr>
<td>Bin(s) Based on Current AMA Setting</td>
<td>Places the clips in the bin(s) you set up in the AMA Settings Bins tab.</td>
</tr>
<tr>
<td>Bin(s) Based on Subfolders</td>
<td>Places the clips in bin(s) based on their subfolders.</td>
</tr>
<tr>
<td>Top Bin Window</td>
<td>Places the clips in the active bin.</td>
</tr>
</tbody>
</table>

4. Click OK.

The clips appear in the bin or bins depending on the options you selected. A link icon appears next to the clips.

**To link clips from a file with AMA:**

1. Select File > AMA Link.

You can also right-click a bin and select AMA Link.
2. The Open dialog box opens.
3. Navigate to and select the files you want to link to. Ctrl+click or Shift+click to select multiple files.
4. From the Files of Type menu either select Autodetect AMA Plug-in or select the plug-in from the list. Audodetect will detect the appropriate plug-in from the list of installed plug-ins.
5. Click Open.

The clips appear in the active bin with the default multichannel audio track formats (based on the AMA settings). A link icon appears next to the clips.

If the system cannot link a file, an error message displays informing you to open the Console window for more information about the file(s) in error.

If you move the clip from the original drive to another drive on your system, the clip displays as offline in your bin.

If you move a source file from one location to another and then back to the original location, you might need to refresh the bin to redisplay the clip. Close and reopen the bin to refresh the bin.

Relinking to AMA-Linked QuickTime Files

After you link Quicktime files into your sequence, you have the option to make changes (in a third party applications, such as Adobe After Effects) to that file. If you change the filename or change the location of the file, the best way to link that clip back into your sequence is through the relink option. Relinking to an AMA file allows you to link to a different file. This process only works if the targeted file is compatible with the old file, for example the file has the same duration, edit rate or number of tracks.

This feature is helpful when you have a group of linked clips that were moved to a different folder or drive. You can relink the clips to the new location. You can also use this feature to toggle between different versions of a QuickTime movie, for example a low-resolution version of the movie is myMovie_DV.mov and the high-resolution version of the movie is myMovie_1to1.mov. You can relink to both of these versions, to see which clip works better in your sequence.

At this time, Relink to AMA File(s) is only available with AMA QuickTime files.

To relink to AMA file(s):
1. Select the file(s) you want to relink by doing one of the following:
   ▶ Click a single file
   ▶ Shift+click to select multiple adjacent files
Ctrl+click (Windows) or Command+click (Macintosh) to select multiple nonadjacent files

2. Right-click and select Relink to AMA File(s).

   The Select file(s) to relink AMA clip dialog box opens asking you to locate the new file(s).

3. Locate the folder where the files exist.

4. Click OK.

   The clips appear linked in the bin. If all the clips you wanted to relink to do not reside in the selected folder, you will receive a dialog indicating how many files were not relinked. Open the Console window to see the name of the file or files that were not relinked.

   If the new file is not compatible with the clip in the bin (it does not have the same duration, edit rate or number of tracks), the clip in the bin retains its original link.

AMA Linking to DPX Files

The Avid Image Sequencer Plug-in allows you to AMA Link to DPX files. DPX is a bitmap file format used to store a single frame of a motion picture or video data stream. The DPX format is an ANSI and SMPTE standard based on the Kodak Cineon file format.

The Avid Image Sequencer Plug-in is automatically installed when you install the Avid editing application.

The DPX plug-in can link to RGB files that have 8-bit, 10-bit (filled using Method A only), 12-bit (filled using Method A only), and 16-bit components. It can only link to files that contain a single image element for example, interleaved RGB). It can link to files of either byte order (MSB or LSB). The DPX plug-in cannot link to files that are encrypted or run-length encoded. For information on Method A, see Annex C of the SMPTE spec 268M-2003.

This release supports reading 8-bit, 10-bit, 12-bit and 16-bit DPX files. Only export of 10-bit HD is supported at this time.

When linking to DPX media, first set the AIS Metadata options in the AMA Settings dialog. “Linking Media with AMA” on page 410.

Linking to DPX Media with AMA

The editing application allows you to link to DPX files.

To link to DPX files:

1. Click the Settings tab in the Project window.

2. Click AMA.
The AMA dialog opens.

3. Click the AIS Metadata tab and select the Reel name and Frame Count metadata you want to read from the DPX file.

   Reel names are mapped to Camroll and Reel # bin columns and Frame Counts are mapped to the DPX column. Both should populate AAF exports.

   *DPX, Transfer and VFX bin columns have expanded from 64 characters and 7 digits to 120 characters and 9 digits.*

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reel name based on:</td>
<td>Select from where to read the Reel name:</td>
</tr>
<tr>
<td></td>
<td>• Embedded in source file</td>
</tr>
<tr>
<td></td>
<td>• Source file name</td>
</tr>
<tr>
<td></td>
<td>• Source file path</td>
</tr>
</tbody>
</table>
4. Select File > AMA Link.

The Open dialog box opens.

5. Navigate to the folder that contains your DPX files. Note the following when selecting files.

- If you select the entire folder, all sequential files will be represented as one master clip in the bin. For example, selecting a folder containing the following DPX files results in one Kermit master clip and one Oscar master clip in the bin.

- If you select one file from a sequential group, the resulting master clip contains the entire group. If you select a range within the sequential group, the master clips includes just the selected files. For example, if you select the highlighted files below, the following master clips would appear in the bin: Bert (1 and 3), Bird (1, 2, 3, and 4), Ernie (1 and 2), Ernie (5 and 6), Kermit (1, 2, 3, and 4), Oscar (1 and 2), and the count.mov.)
6. Ctrl+click or Shift+click to select multiple files.

7. From the Files of Type menu either select the Avid Image Sequencer (.DPX) if you are selecting files or Avid Image Sequencer (.Folder) if you are selecting the entire folder.

8. Click Open.

The clips appear in the bin with a link icon.

If the system cannot link a file, an error message displays informing you to open the Console window for more information about the file(s) in error.

For details on setting color properties, see “Setting the Color Properties of Acquired Media” in the Help.

**Exporting as DPX**

You can export clips and sequences as DPX files.
To export as DPX:

1. Select the clip or sequence you want to export as DPX.
2. Right-click and select AMA File Export.
   
The AMA File Export window opens.

3. Click File Type and select DPX.
4. (Option) Select the Use Marks or Use Enabled Tracks option.
   
   ▶ When you select Use Marks, your Avid editing application uses current IN and OUT points in the selected clip or sequence to determine starting and ending frames for the export. To export the entire clip or sequence, deselect this option or mark the entire clip or sequence.
   
   ▶ When you select Use Enabled Tracks, your Avid editing application exports the tracks that are enabled in the Timeline. To export all the tracks in the sequence, deselect this option.

5. Click the Directory Set button and browse to the location where you want the DPX files saved.
6. Select from the following options:
Spanned Clips

Spanned clips are clips that extend from one card to another. Avid supports working with spanned clips with some third party devices such as P2, AVCHD, Canon, and XDCAM EX.

The following illustration shows how clips can span multiple cards.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create subfolder name</td>
<td>This is the folder in the specified directory where the DPX files are exported.</td>
</tr>
<tr>
<td>Include in Header (Input Device)</td>
<td>Provide an ASCII string entry field up to 32 characters that will populate the Input Device (field 38) in the DPX header.</td>
</tr>
<tr>
<td>Start Frame</td>
<td>Enter a value from 0 to 999999999. Entering a value into this field will reflect the first frame in the export and will increment for all additional frames. For example if you enter 20 and have entered 7 into the number of digits in the file name, the first file name in the sequence would be: name.0000020.dpx.</td>
</tr>
<tr>
<td>Convert Timecode to Frames</td>
<td>Converts the Timecode of the Sequence or master clip to frames. For example the sequence timecode is 02:00:10:00 would show the file name as name.173040.dpx.</td>
</tr>
<tr>
<td>Digits in File Name</td>
<td>Determines how many digits are in the file name. The range is from 1 to 9. The default is 7. For example a value of 2 would be name.01.dpx, name.02.dpx, etc. If the count reached 99 an additional digit is added, name.100.dpx.</td>
</tr>
<tr>
<td>Color Depth</td>
<td>Supports RGB 8bit, RGB 10bit and RGB 16bit.</td>
</tr>
<tr>
<td>FPS</td>
<td>Declare a frame rate and embed it into the DPX header.</td>
</tr>
<tr>
<td>Set to highest scaling quality</td>
<td>Disabling this option accesses the scaling/quality settings from the Media Creation Settings. Enabling this option provides the highest available scaling/quality and overrides the Media Creation Settings.</td>
</tr>
<tr>
<td>Levels</td>
<td>Enabling Video provides 64-940. Full Range provides 0-1023.</td>
</tr>
</tbody>
</table>

7. Click Save.

The DPX files are exported to the folder set in Step 5.
Example of spanned clips. The white rectangles represent P2 cards and the gray rectangles represent clips. The first and third clips span multiple cards.

When you work with spanned clips, consider the following:

- If you remove a card that contains a spanned clip, for example Card 2 in the above example, and you try to play Clip 1, it plays until it reaches the portion of the clip that resides on Card 2. Media Offline appears until you reach the media on Card 3. Avid recommends that you do not place another card in the removed card’s place unless you remove all the cards that contain the spanned clip (Cards 1 and 3 in this example).

- You can mix cards that contain spanned and unspanned master clips. However, if you eject a card which contains a chunk of a spanned clip and insert another card, the master clips in the newly inserted card are not visible in the Media Tool but the media files are visible. To work around this, remove all the cards which contain chunks of the spanned clip and choose File > Unmount followed by File > Mount All (non-AMA method). All the master clips are visible.

- P2 and XDCAM EX spanned media covers multiple drives, but the bin displays only one drive letter. The drive letter in the bin might be any of the drives, but is usually the highest lettered drive where the media exists.

- If necessary, copy all spanned clips to another drive to ensure a clip’s integrity before you swap out the cards.
AMA Linking with Ancillary Data

You can AMA link to an XDCAM or an MXF (SMPTE 436M) clip with ancillary data, the ancillary data appears in your bin. You can link to the ancillary data clip without an Avid input/output hardware, however, in order to view the ancillary data in a monitor, an Avid Nitris DX or Avid Mojo DX device is required.

For information about ancillary data and data tracks, see “Preserving HD Closed Captioning and Ancillary Data” on page 1123.

AMA Linking with Multichannel Audio

You can use the AMA Settings dialog box to define the audio track formats for the audio channels in your linked media, up to a maximum of 16 audio channels for the clips in your bins. This allows you to specify which source channels are treated as mono or multichannel audio tracks in your project, rather than having to modify the clips in your bin after you link to the AMA media.

The mappings affect all media clips created when you link to your source media. If you want to use different mixes for different master clips or different projects, create a custom AMA Settings template for each separate type of mix and then create your linked master clips.

Each stereo track requires two channels, but you can mix mono and stereo input channels for your linking operation as long as you do not exceed the maximum of 16 audio channels for each master clip.

To specify the multichannel audio mix for linked AMA clips:

1. In the Project window, click the Settings tab.
2. Double-click AMA.
   
   The AMA Settings dialog box appears.

   For information about the AMA Settings, see “AMA Settings” on page 1433.
3. Click the Link Options tab.

   The Link Options tab lists any multichannel audio mappings in the current AMA Settings template.
4. Click Edit.

The Set Multichannel Audio dialog box opens.

5. Click the format buttons to select one of the following audio track formats for each pair of source channels:

<table>
<thead>
<tr>
<th>Button</th>
<th>Track Format</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Mono" /></td>
<td>Mono</td>
</tr>
<tr>
<td><img src="image" alt="Stereo" /></td>
<td>Stereo</td>
</tr>
</tbody>
</table>
You must map source audio channels in mono or stereo pairs. For example, you cannot map A1 to a mono track and A2 and A3 to a stereo track. Instead, map A1 and A2 to mono tracks, and A3 and A4 to a stereo track. If the source media does not have an audio channel on A2, the Avid editing application ignores the channel.

6. Click OK to close the Set Multichannel Audio dialog box, and then click OK to close the AMA Settings dialog box.

   The Track Formats column in the bin Text view displays the format for all multichannel audio tracks in a master clip.

**To save a custom map of linked audio channels as a settings template:**

1. Click the Settings tab in the Project window.

   The Settings list appears.

2. Click AMA.

3. Select Edit > Duplicate.

   A duplicate setting appears in the Settings list.

4. Name the setting by doing the following:

   a. Click the custom name column.

   b. Type a name.

   c. Press Enter (Windows) or Return (Macintosh).

You can select this new setting whenever you link clips with AMA.

---

**The AMA Plug-in Log File**

The Avid system creates an AMA plug-in log file when you link clips. The log file records errors and information about the clips. If you experience any problems while you link clips or if you receive an error message, check the AMA log file to get more information about the error (for example: a corrupt file or a bad filename). You can view the log file from the following location on your system:

- (Windows) drive:\Program Files\Avid\Media Composer\Avid FatalError Reports. The name of the log file is AMALoggerMM_DD_YY.log.

- (Macintosh) Volume/Users/Shared/AvidMediaComposer/Avid FatalError Reports. The name of the log file is AMALoggerMM_DD_YY.log.
Using Virtual Volumes

You can use a virtual volume to copy media from a card or disk. This lets you use the card or disk again. A virtual volume can be a folder on your desktop or a folder located on a server. However, the virtual volume folder should reside one level down from the root level in order for the system to display it as a virtual volume. The following are examples of virtual volumes:

- C:\Desktop\BPAV
- Z:\P2\Card 1
- Z:\GFPAK\

When linking to AMA volumes, the system looks into folders up to two levels deeper. This is helpful when linking to AMA volumes that contain left and right stereoscopic files/folders.

With the AMA method, all drives and virtual volumes associated with your bin mount automatically. You cannot remove a volume while in AMA, however you can remove a virtual volume.

To unmount a virtual volume:

   
   The Unmount dialog box opens.

2. Select the virtual volume you want to remove.

3. Click OK.

   The system removes the virtual volume from your system and clips linked to this virtual volume appear offline. When you restart your Avid editing application, the system scans the system for virtual volumes and the clips appear online.

Virtual Volumes and AMA Bins

If you select Volume Name in the AMA Bin Settings tab, the system names the bin the same name as the virtual volume drive name. If you continue to use the same virtual volume to link other media through AMA, the system continues to place the linked media in the same bin. If you want to create a new bin for different types of media you link through AMA, you can either create a new virtual volume drive for each type of media (XDCAM, XDCAM EX, P2, GFCAM, etc.) or you can create a new bin every time you link to new media on a virtual volume.

To create a new bin on the same virtual volume:

1. Before you link your media through AMA, click the Settings tab in the Project window.
2. Double-click AMA.
3. Click the Bins tab.
4. Select “Create a new bin” and specify a new bin name.
5. Click OK.
6. Select File > AMA Link.
   The media appears in the newly created bin. Repeat these steps for each type of media.

Deleting Clips

You can delete master clips, but you cannot delete media files that reside on drives. Your Avid editing application treats files as read-only devices.

You can delete master clips and media files the same way you delete other master clips and media files. However, you might not be able to delete files that you moved rather than copied. If you cannot delete master clips and media files, first unlock the clips as described in the second procedure, and then delete them.

To delete files from cards/volumes:
1. Quit your Avid editing application.
2. On the desktop, navigate to the drive.
3. Select the files you want to delete and press the Delete key.

To delete files on a local drive in your Avid editing application:
1. In a bin, select the clips you want to delete.
2. (Option) Right-click and select Unlock Bin Selection.
3. Press the Delete key.
   The Delete dialog box opens.
4. Select Delete master clips and Delete associated media files.
5. Click OK.
   You can also choose to AMA Link if you want to open the assets as Read-only in a classic bin.

Understanding the Source Settings Histogram

The histogram in the Source Settings window helps you visualize the distribution of color values in an image. You can use the histogram to adjust the Source Settings of your AMA media more precisely while avoiding clipping and color imbalance.
Example of a Source Settings histogram. The histogram plots color values on the horizontal axis and the percentage or proportional number of pixels on the vertical axis. The vertical lines represent the black point (left) and the white point (right), so the area between them is the safe color range.

The histogram plots color values that can be represented by the image bit-depth on the horizontal axis. Therefore, the width of the histogram is the same as the width of the image. The histogram plots the percentage, or proportional number of pixels in the image, with each particular color value on the vertical axis. The vertical axis is scaled according to the height of the maximum value in the plot. Whenever the histogram changes, the vertical axis rescales according to the new maximum.

Pixels with color values that are out of range are grouped into either the maximum or minimum color values on the plot. Spikes in either the highest or lowest color values might indicate loss of color information due to clipping.

Your Avid editing application draws separate histograms for the red, green, and blue color components. The histograms for each color stack on top of one another, with the fill color changing appropriately to indicate overlap. The following illustration shows the colors produced by overlap.
Adjusting the Source Settings Histogram

You can adjust the Source Settings Histogram in two ways. You can toggle drawing a histogram for an individual color, and you can zoom the vertical axis.

To adjust the Source Settings Histogram:

- Right-click anywhere inside the histogram graph, and then select one of the following options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red Green</td>
<td>Enables or disables the histogram display for the selected color. A check mark indicates that the histogram for that particular color displays.</td>
</tr>
<tr>
<td>Blue</td>
<td>Zooms in on the lower half of the vertical axis.</td>
</tr>
<tr>
<td></td>
<td>Changes the scaling of the vertical axis so that the height is half that of the maximum value in the plot. You can zoom in indefinitely to display, for example, 1/4, 1/8, or 1/16 of the maximum value.</td>
</tr>
<tr>
<td>Zoom In</td>
<td>Zooms out of the vertical axis by a factor of two.</td>
</tr>
<tr>
<td></td>
<td>Changes the scaling of the vertical axis to be twice that of the maximum value in the plot. You can zoom out indefinitely to display, for example, 4, 8, or 16 times the height of the maximum value.</td>
</tr>
<tr>
<td>Reset Zoom</td>
<td>Resets the zoom so that the vertical axis boundary is equal to the maximum value in the plot.</td>
</tr>
</tbody>
</table>
The Avid editing application supports the creation of AS-02 Export Volumes. AS-02 is a specification for grouping multiple versions of program content into one single bundle. These bundles provide an efficient approach for working in a file-based environment.

For example, if you have a sequence with an English audio mix and a sequence with the same video but with a Spanish audio mix, creating an AS-02 Export Volume allows you to have all the program elements contained in a bundle without redundancy. The same video essence file can be the source for both the English and the Spanish versions. This is useful if you want to save time on export and reduce used disk space.

The basic workflow is to create a new Export Volume Bin, copy the sequence or sequences you want to the Volume Bin, commit the assets in the Export Volume Bin, and then archive the AS-02 bundle folder. You can also link to an existing AS-02 bundle.

The bundle folder structure is shown below. This is for reference only. These elements will be automatically created for you when you commit an Export Volume Bin.

- The *Asset.mxf* file is the sequence (version).
- The *Manifest.xml* file lists the creator information, creation date, version information and a list of all the files and folders in the bundle.
- The *Shim.xml* file is used as a template or settings file that constrains the rules for a specific facility.
- The *Media* folder contains all the media files included in the bundle.
- The *Extra* folder contains a copy of the unflattened sequence (AAF composition only). The Extra folder can also contain any other files you want to keep with the bundle, such as scripts, graphics, etc.
Creating an Export Volume

You can create an export volume to place all program elements into a bundle.

To create a new export volume:
   The Export Volume dialog box opens.

2. Select a Volume Type, for example AS-02.
3. Click Set to select the path where you want the Export Volume to reside.
4. Enter a name for the volume.
5. Click Set to select the path to the shim template you want to use.
   - AS-02 supports J2K, Uncompressed 10b RGB, DNxHD, AVCI, IMX and Uncompressed 8b for SD.
   - All DNxHD templates are tuned to the DNxHD 220x family. That means depending on the project type, selecting a DNxHD template will export to a DNxHD 10b codec.
   - AS-02 Shim templates for all supported resolutions are located in the Supporting Files folder.
   - You can choose any one of these templates depending on the desired output codec/format.
   - You can also create a folder named Default at the root of the AS-02 Templates folder where you can place custom templates. For example, you can duplicate the AS-02_Shim_DNxHD_1080i_59.94.xml found in the DNxHD folder, modify it (to a different audio sample rate or DNxHD resolution) and place the duplicate in the Default folder. This duplicated template will now be the default template for 1080i59 projects.
   - DNxHD resolutions are supported except DNxHD 100 and DNxHD 36.

6. Click OK.

The Export Volume bin opens.

Moving Assets to an Export Volume

You can move the desired assets to the Export Volume.
To move assets to the Export Volume:

1. Open the bin that contains the sequence or sequences you want to write to the Export Volume.
2. Select and drag the sequence(s) to the Export Volume.

A copy of the sequence(s) appears in the Export Volume.

You can only drag sequences to an AS-02 Export Volume Bin. If you try to drag master clips, effects, titles, etc, you will receive a message indicating that some assets that you selected could not be dragged to the Volume Bin. If you receive this message, open the Console Tool to see the list of items that were not written.

Committing Assets to an Export Volume

Once you commit the assets, the sequence is flattened to the OP1b format, the video is encoded to the J2K codec and audio saved as PCM.

To commit the assets to the Export Volume:

1. Open the Export Volume that contains the sequence(s) to commit.
2. Click the Commit button to commit the assets to the AS-02 bundle.

The sequence along with its associated media files populate the Export Volume.
Note the Media Status column indicates the committed status of each asset in the volume. Green indicates the asset is committed. Yellow indicates the asset is not committed. Red indicates the asset is offline.

Once the assets are committed, the following are written to the bundle folder:
- The sequence (version)
- The essence files
- The manifest (a file listing the creation date, creator, version information and a list of all the files and folders in the bundle.)
- The shim file (used as a template or settings file that constrains the rules for the specific facility)
- An AAF copy of the unflattened sequences(s) in the Extras folder

Archiving the AS-02 Bundle

Once you have committed the assets to the Export Volume, you can archive the AS-02 bundle.

To archive the Assets Folder.
1. Locate the AS-02 bundle folder by accessing the path you set in step 4 of Creating an Export Volume.
2. Copy the AS-02 bundle folder to your archive server.
Linking to an existing AS-02 Bundle

You can open an existing AS-02 bundle.

To link to an existing AS-02 Volume:
1. Select File > Link to Volume for Export.
2. Select the folder where the AS-02 bundle resides.
3. Click OK.
4. A new volume bin opens with the AS-02 assets.
   You can also choose to Link to AMA Volume if you want to open the assets as Read-only in a classic bin.

AS-11 Support

The Avid editing application supports the Advanced Media Workflow Association (AMWA) AS-11 specification. This specification is used in broadcast environments. The specification defines a set of rules that constrain the specification. AS-11 is an OP1A MXF file format for the delivery of finished programming. This specification requires program segment markers. Program segmentation defines specific regions of a show, for example a segment marker for the A-block, B-block and C-block. See “Adding Spanned Markers While Editing” on page 553 to apply these markers before you export your sequence.

To export a sequence as AS-11:
1. Select the sequence you want to export as AS-11.
2. Click File > AMA File Export, or right click the sequence and select AMA File Export.
   The AMA File Export dialog opens.
3. Select File Type AS-11.

4. (Option) Select the Use Marks or Use Enabled Tracks option.
   - When you select Use Marks, your Avid editing application uses current IN and OUT points in the selected clip or sequence to determine starting and ending frames for the export. To export the entire clip or sequence, deselect this option or mark the entire clip or sequence.
   - When you select Use Enabled Tracks, your Avid editing application exports the tracks that are enabled in the Timeline. To export all the tracks in the sequence, deselect this option.

5. Click the Directory Set button to and browse to the location where you want the AS-11 file saved.

6. Click Select Folder.

7. Select the Shim Set button to locate the Shim file you want associated with the export and click Open. Avid provides shims in the following location:
   - (Windows) Program Files/Avid/EditingApplicationName/SupportingFiles
   - (Macintosh) MacintoshHD/Applications/EditingApplicationName/SupportingFiles

   The Descriptive Metadata populates in the window depending upon the shim you selected.

8. Enter the specific program information in the Descriptive Metadata fields.

   This is the descriptive data stored in the AS-11 export that describes Essence data. For example, the language, series title, program title, episode title, etc.

9. Click Save.
The AS-11 file is exported to the selected directory.

When you perform an AMA link to the AS-11 sequence, the spanned markers are represented in the source Timeline and all the descriptive metadata appears in the Bin columns.
AMA Plug-ins

You’ll need to download and install the AMA plug-ins that you want separately from your editing software (these plug-ins are no longer included in the installer except for the QuickTime AMA plug-in). This enables Avid and third-party camera manufacturers to update plug-ins outside of a software release.

Before you begin working with AMA, make sure you have done the following:

• Go to the avid.com web site to make sure you download the AMA latest plug-in for your specific third-party device.

• If you are using an XDCAM, XDCAM EX or a P2 device, make sure you have the appropriate drivers installed. See your third-party documentation for information on installing drivers.

• Connect the third-party device according to the documentation supplied with the device.

The following sections include high-level procedures of a typical workflow you might use when you edit with a particular media type and AMA Plug-Ins.

Using XDCAM and XDCAM EX and XDCAM SR AMA Plug-Ins

The Sony® XDCAM™ decks and camcorders use an optical disk to store recorded media. The XDCAM devices record media in high-resolution MPEG IMX™, DVCAM™, and XDCAM HD formats or corresponding low-resolution or compressed (proxy) media (MPEG-4). This lets you work with the compressed or low-resolution media in an off-line editing session and then later conform or link the compressed media to the corresponding high-resolution media. The HDCAM SR AMA plug-in supports MXF-wrapped SR Lite and SR SQ formats (422 YUV and 444 RGB) as transferred from HDCAM SR devices.

You can play XDCAM HD media to a Client monitor or output a digital cut as Best Performance (yellow/yellow) or Draft Quality (yellow/green). If you use Avid Nitris DX or Avid Mojo DX, you can play out the back of the HD-SDI.

The following steps describe a typical workflow for editing XDCAM, XDCAM EX or XDCAM SR clips with AMA.
Do not mix AMA and traditional workflows. Either use AMA when you work with an XDCAM device or use the traditional import/batch import workflow.

You should be aware of the following:

- Playback performance from an optical disk is very slow. To create a sequence with multiple effects or layered tracks, Avid suggests that you consolidate the media to a local drive, instead of working directly from the optical disk.

- Avid has turned off redrawing of waveforms in the Timeline when you link to XDCAM clips that reside on a disk. This allows for a faster linking process. When the media is consolidated, the waveforms redraw.

- When you link XDCAM clips from an optical disk, Avid recommends that you do not display the bin in Frame view or Script view due to performance issues.

A typical workflow is as follows:

1. Make sure the Sony XDCAM and XDCAM EX, or XDCAM SR AMA plug-in is installed on your system.

2. For XDCAM, install the appropriate Sony XDCAM drivers.
   
   You do not need drivers for XDCAM EX.

3. Insert the XDCAM disk or XDCAM EX card.
   
   The system links the XDCAM clips into a bin. The media itself remains on the disk. The clips point directly to the high-resolution media on the disk.

   For XDCAM clips from an optical disk, a progress bar appears to show you how much time is left to link the media.

   If you use multiple cards and you remove one of the cards, your media displays offline.

4. Use the master clips to edit the sequence.

5. (Option) Rename the clips to help organize your material.

6. You can either transfer your media to your hard drive and then transcode or consolidate your sequence or clips, or consolidate directly from the XDCAM disk.

   When you consolidate, if you want to keep your AMA clips linked to the original source, select the option “Keep Master clips linked to media on the original drive,” in the Copying Media Files dialog box.

   Consolidating your media helps when you work with multiple cards. If you remove a card from the reader, consolidating lets you view your sequence with all the media online.
Due to the design of the Nitris input/output hardware, playback of XDCAM or XDCAM EX media on a Symphony Option using Nitris causes dropped frames. To allow for full performance playback, transcode the XDCAM media into DNxHD media to play the video on your Symphony Option system with Avid Nitris input/output hardware.

For information on consolidating your sequence, see “Consolidating Media” on page 477. For information on transcoding your sequence, see “Using the Transcode Command” on page 483.

7. Remove the XDCAM disk or XDCAM EX card:
   - (Windows) Select Safely Remove Hardware icon in the taskbar and select Safely Remove XDCAM EX device name.
   - (Macintosh) Click the device icon on your desktop and drag it to the Trash.

Using XDCAM Multiple Resolution Clips with AMA

The XDCAM AMA plug-in allows you to link to low-resolution (proxy) or high-resolution audio or video media. The AMA multiple resolution feature supports specific XDCAM devices which include a /PROAV folder. For example, the Sony PDWU1 Professional Disc Drive Unit. See your Sony documentation for information on how to enable the /PROAV directory for your device.

Avid editing systems do not support XDCAM proxy audio.

The following steps describe a typical workflow for editing XDCAM multiple resolution clips with AMA.

Do not mix AMA and traditional workflows. Either use AMA when you work with an XDCAM device or use the traditional import/batch import workflow.

You should be aware of the following:

- Playback performance from an optical disk is very slow. To create a sequence with multiple effects or layered tracks, Avid suggests that you consolidate the media to a local drive, instead of working directly from the optical disk.
- Avid has turned off redrawing of waveforms in the Timeline when you link to XDCAM clips that reside on a disk. This allows for a faster linking process. When the media is consolidated, the waveforms redraw.
- When you link XDCAM clips from an optical disk, Avid recommends that you do not display the bin in Frame view or Script view due to performance issues.
A typical workflow is as follows:

1. Use Sony’s PDZ-1 software to associate your low-resolution clips with metadata to identify the clip in the Avid bin. This includes entering a User Disc ID in the Disc Properties window.

2. The Sony XDCAM and XDCAM EX AMA plug-in should be installed on your system.

3. Install the appropriate Sony XDCAM drivers.

4. In the Project window, click the Settings tab.

5. Double-click AMA.

   The AMA Settings dialog box appears.

6. Click the Quality tab.

7. Click the appropriate resolution for your video and audio in the AMA Link Preference section, and click OK.

8. Insert the XDCAM disk in the XDCAM device.


   For information on bin selection options, see “Linking Media with AMA” on page 410.

10. Select File > Link to AMA Volume.

    The Browse for Folder dialog box opens.

11. Navigate to the XDCAM clips, and then click OK.

    The clips appear in the bin or bins depending on the bin options you selected. A link icon appears next to the clips.

12. Edit the sequence.

13. Right-click the bin and select Modify AMA Resolutions to relink your low-resolution to high-resolution media.

14. To consolidate your media, see “Consolidating Multiple Resolution Media” on page 441.

   When you consolidate, if you want to keep your AMA clips linked to the original source, select the option “Keep Master clips linked to media on the original drive,” in the Copying Media Files dialog box.

15. Click the Highest Quality for your video and audio and click OK.

    The highest quality clips appear in the bin along with the low resolution (most compressed) clips. A link icon appears next to the clips.

    If the system cannot find the corresponding low-resolution clip, it might be because you inserted the wrong XDCAM disk. If you insert the wrong disk, the system displays a message that informs you to insert the correct disk. If you used Sony’s PDZ-1 software and
provided a disk name in the User Disc ID field, the system message displays the disk label name. If you did not use the PDZ-1 software, the system asks you to insert the disk containing the (low-resolution) clip selected in the bin.

16. Remove the XDCAM disk.

Spanned clips are clips that extend from one card to another. Avid supports working with spanned XDCAM EX clips in your Avid editing application.

For more information about spanned clips, see “Spanned Clips” on page 419.

Switching Between Multiple Resolution Media

Once you link to the low-resolution or high-resolution media and complete your edits, you can easily switch from low to high and high to low-resolution media. When you switch to a different resolution, the system replaces the clip in the bin with the new clip and resolution.

The steps below highlight switching from low-resolution to high-resolution media. You can also switch from high-resolution to low-resolution.

For XDCAM, if you use the Sony PDZ-1 software to assign a User Disc ID, the Avid editing system displays this information in a bin column and knows what disk name is associated with each clip.

To switch from low-resolution to high-resolution media:

1. Insert the disk in the device.
2. Select the low-resolution clips in the bin.
3. Right-click the bin and select Modify AMA Resolutions.
   The AMA Resolutions Quality dialog box appears.

4. Click the Highest Quality for your video (audio is always set to Highest Quality) and click OK.
The highest quality clips replace the most compressed (low-resolution) clips in the bin. A link icon appears next to the clips.

If the bin contains clips from multiple volumes, you will be prompted to insert another disk.

**Consolidating Multiple Resolution Media**

When you are ready to move your media to shared storage, you can link to your resolution and consolidate at the same time.

The steps below highlight consolidating high-resolution media. You can also consolidate low-resolution media.

For information on why you should consolidate, see “Consolidating Media” on page 477.

**To consolidate high-resolution media:**

1. In the Project window, click the Settings tab.
2. Double-click AMA.
   
   The AMA Settings dialog box appears.

   For information about the AMA Settings, see “AMA Settings” on page 1433.
3. Click the Quality tab.
4. Click the appropriate resolution for your video in the Consolidate Preference section, and click OK.
   If a particular resolution is not available, it will be grayed out.

5. To consolidate the clip, follow the steps in “Using the Consolidate Command” on page 479.
   The resolutions you select in the Consolidate Preference area of the AMA Settings Quality tab displays in the Transcode/Consolidate dialog box when you consolidate or transcode.

**Using the P2 AMA Plug-In**

Panasonic’s P2 equipment records DV, DVCPro, and DVCPro 50 media on compact, solid-state memory cards (P2 cards). Avid editing applications support editing of media directly from these memory cards, without the need to capture. You can also write your sequence back to the P2 card. Panasonic P2 video and audio media is recorded in MXF format.

The following are recognized as P2 cards by your Avid editing application:

- Panasonic P2 cards in an attached reader or camera or in a laptop PC Card slot.
- Synthetic P2 cards. A complete copy of a P2 card copied to the root of a drive or mounted as a drive, for example, by mapping to a drive letter.

Each P2 card stores MXF files in two folders:

- (Windows) `drive:\Contents\Audio`
- (Macintosh) Macintosh HD/Contents/Audio
- (Windows) `drive:\Contents\Video`
- (Macintosh) Macintosh HD/Contents/Video
Using the P2 AMA Plug-In

Examples of MXF audio and video files contained in the Audio and Video folders. Top: four audio tracks for a single clip. Bottom: the corresponding video track.

Panasonic P2 devices write individual MXF audio and video media files for each track of each clip. For example, a P2 clip that includes one track of video and four tracks of audio is stored on the P2 card as five individual media files. Within your Avid editing application the five media files are represented as a single clip with audio and video.

The following steps describe a typical workflow for editing P2 clips with AMA.

Do not mix AMA and traditional workflows. Either use AMA when you work with a P2 device or use the traditional import/batch import workflow.

A typical workflow is as follows:

1. Make sure the Panasonic P2 AMA plug-in is installed on your system.
2. Install the appropriate Panasonic P2 driver.
3. Mount one or more P2 cards (up to five). For information on mounting and naming P2 cards, see your Panasonic device documentation.
   - The system links the P2 clips automatically into a bin.
4. Use the master clips to edit and output a sequence.
5. (Option) Rename the clips to organize your material.
6. Consolidate or transcode your sequence or clips.

The media consolidates to the destination you set in the Media Creation dialog box.

Consolidating your media helps when you work with multiple P2 cards. If a card is removed from the reader, consolidating lets you view your sequence with all the media online.

- When you consolidate, if you want to keep your AMA clips linked to the original source, select the option “Keep Master clips linked to media on the original drive,” in the Copying Media Files dialog box.

- When you transcode a sequence, the system automatically defaults to convert both audio and video. You cannot transcode video only with P2.

- For information on consolidating your sequence, see “Consolidating Media” on page 477. For information on transcoding your sequence, see “Using the Transcode Command” on page 483.

7. Remove the P2 card.

If you work in an Avid shared storage environment, you can share sequences that contain P2 clips in an Avid shared storage workspace. However, you can share P2 clips only if you transcode or consolidate them to a workspace.

- In an MXF workgroup, you can either consolidate or transcode P2 clips to a workspace. If you transcode, you must transcode P2 MXF files to another MXF resolution.

- In an OMF workgroup, you must transcode P2 clips to a workspace. You must transcode P2 MXF files to OMF files.

If you consolidate or transcode clips to an Avid shared storage workspace, it automatically checks all related metadata into the asset manager. This makes the clips accessible to other users.

For more information on workgroup support, see the Avid Interplay Help.

- Some card slots of the P2 drive might require drive letters that have already been assigned to existing network drives. If your computer does not display all five card slots as drives, reassign the network drives or restart your system.

Spanned clips are clips that extend from one card to another. Avid supports working with spanned P2 clips in your Avid editing application.

For more information about spanned clips, see “Spanned Clips” on page 419.
Using the AVCHD AMA Plug-In

AVCHD is a file-based format and does not use magnetic tape. Instead, video can be recorded onto DVD discs, hard disk drives, non-removable solid-state memory and removable flash memory cards.

*Play performance might vary depending on the type of medium you use and the speed of our computer.*

AVCHD media files are recorded in MTS format; the file contains both the video and audio. Audio can be either uncompressed PCM or Dolby® AC-3 format.

*You must activate the Dolby AC-3 codec the first time you AMA link to an AVCHD clip. If you are connected to the Internet, activation is automatic. If you are not connected to the Internet, the system opens a dialog box and then the Avid License Control tool. Follow the on screen instructions to activate this feature.*

The folder and file structure is dependent on the camera you use.

*Most AVCHD cameras produce default file names starting with “00000.” Be aware that you could have multiple clips with the same file name across multiple media drives.*

The following steps describe a typical workflow for editing AVCHD clips with AMA.

**A typical workflow is as follows:**

1. Install the AVCHD AMA plug-in on your system.

2. To link to an entire volume, attach the camera and insert a card, disc or drive.

   The system links the AVCHD clips automatically into a bin.

*It is highly recommended for performance reasons, that you copy the entire media volume to an external HD drive if you plan on copying media from a card. You may have to use the File > AMA Link command if the files do not automatically link.*

*If you use multiple AVCHD cards and you remove one of the cards, your media displays offline.*

3. To link to an individual AVCHD file, with the camera and card, disc or drive inserted, select File > AMA Link.

   The Open dialog box opens.

4. From the AMA Plugin Filter menu, select AVCHD.

5. Locate and select the .mts file(s) you want to link. Ctrl+click or Shift+click to select multiple files.

6. Click Open.
The clips appear in the active bin. A link icon appears next to the clips.

7. Use the master clips to edit and output a sequence.
8. (Option) Rename the clips to organize your material.
9. Transcode your sequence or clips.

When you transcode a sequence, the system automatically defaults to convert both audio and video. You cannot transcode video only with AVCHD.

For information on transcoding your sequence, see “Using the Transcode Command” on page 483.

Spanned clips are clips that extend from one card, disc or drive to another. Avid supports working with spanned AVCHD clips in your Avid editing application.

For more information about spanned clips, see “Spanned Clips” on page 419.

Using the Canon XF AMA Plug-In

The Canon XF305 and Canon XF300 camera records MPEG-2 media onto compact flash cards. Through the Canon XF AMA plug-in and the MXF AMA plug-in, you can link to Canon MPEG-2 media through the AMA method. Canon XF video and audio media files record in MXF format.

You can edit directly from a flash card, without having to capture. You can link to a Canon XF flash card and reader attached to your system or copy a Canon XF flash card to the root of a drive.

Each card stores the video and audio files in:

- (Windows) drive:\CONTENTS\CLIPS
- (Macintosh) Macintosh HD/CONTENTS/CLIPS

AMA does not recognize clips if the folder names in the selected path contain double-byte characters (DBCS). AMA recognizes folders with the directory path that includes ASCII alphanumeric characters.

A typical workflow is as follows:

1. The Canon XF AMA plug-in and the MXF AMA plug-in should be installed on your system.
2. Mount the flash cards.

   The system links the Canon XF clips automatically into a bin.
If you use multiple flash cards and you remove one of the cards, your media displays offline.

3. Use the master clips to edit and output a sequence.
4. (Option) Rename the clips to organize your material.
5. Consolidate or transcode your sequence or clips.

   The media consolidates to the destination you set in the Media Creation dialog box.

   Consolidating your media helps when you work with multiple cards. If a card is removed from the reader, consolidating lets you view your sequence with all the media online.

When you consolidate, if you want to keep your AMA clips linked to the original source, select the option “Keep Master clips linked to media on the original drive,” in the Copying Media Files dialog box.

For information on consolidating your sequence, see “Consolidating Media” on page 477. For information on transcoding your sequence, see “Using the Transcode Command” on page 483.

6. Remove the flash card.

Spanned clips are clips that extend from one card to another. Avid supports working with spanned Canon XF clips in your Avid editing application. For more information about spanned clips, see “Spanned Clips” on page 419.

Using the GFCAM AMA Plug-In

The Ikegami GFCAM HDS-V10 is a tapeless camera/recorder that uses flash memory instead of video tapes as a recording medium. GFCAM devices record MPEG-2 Long GOP media onto a GFPAK™, a removable high-speed storage medium. GFCAM is only available through the AMA method. GFCAM video and audio media files record in MXF format.

Each GFPAK stores the video MXF files in:
- (Windows) drive:\BINxxx\VIDEO
- (Macintosh) Macintosh HD/BINxxx/VIDEO

Each GFPAK stores the audio MXF files in:
- (Windows) drive:\BINxxx\AUDIO
- (Macintosh) Macintosh HD/BINxxx/AUDIO

The GFCAM video file directory stores MXF files regulated by SMPTE 390M (MXF OP-Atom) and SMPTE 381M (MXF mapping MPEG streams into MXF GC). If a video clip needs to split, such as under the FAT32 file system, the system creates multiple MXF files for that clip.
The GFCAM audio file directory stores MXF files regulated by SMPTE 382 (MXF mapping AES3 and BWF into the MXF GC). Each file has an AES channel that consists of two audio channels. For example, the system creates two MXF files from two AES channels (four audio channels). If an audio clip splits, the system creates multiple audio files for that clip.

GFCAM allows gapless recording over several GFPAKs, however, each GFPAK handles the contents as a separate clip. If you record across three GFPAKs, you create three separate clips. You can then edit those clips together into one continuous sequence.

1080p/23.98 pulldown and 720p/23.98 pulldown record at 59.94fps and are only compatible with 1080i/59.94 and 720p/59.94 projects.

1080p/29.97 records as PSF at 59.94fps and is only compatible with 1080i/59.94 projects.

1080p/25 and 720p/25 record as PSF at 50fps and are only compatible with 1080i/50 and 720p/50 projects.

A typical workflow is as follows:

1. Make sure the GFCAM AMA plug-in is installed on your system.
2. Insert the GFPAK.
   Your Avid editing system links the GFCAM clips automatically into a bin. The media itself remains on the disk. The clips point directly to the high-resolution media on the disk.

3. Use the master clips to edit the sequence.
4. (Option) Rename the clips to organize your material.
5. Consolidate or transcode your sequence or clips.
   Consolidating your media helps when you work with multiple GFPAKs. If a GFPAK is unplugged, consolidating lets you view your sequence with all the media online.

   When you consolidate, if you want to keep your AMA clips linked to the original source, select the option “Keep Master clips linked to media on the original drive,” in the Copying Media Files dialog box.

   When you transcode a sequence, the system automatically defaults to convert both audio and video. You cannot transcode video only with GFCAM.

6. Disconnect the GFPAK.

Working with Shot Marks and Check Marks with GFCAM Media

GFCAM products use Shot Marks and Check Marks to store metadata about media clips.
Shot Marks allow GFCAM cameras to mark events such as clip start points or audio clipping. Press the RET button on the GFCAM device while you record or playback to set a Shot Mark. For a description of Shot Marks, see your GFCAM documentation.

In the AMA method, Shot Marks are brought over automatically and appear as markers in your Avid editing application. There is no text associated with a Shot Mark, just a marked location (or a marker). For information about editing markers, see “Using Markers” on page 550.

A Check Mark flags a “good shot.” The AMA method translates this good shot clip with the word “true” in a new bin column named Check Mark. If there are no Check Marks associated with a clip, a Check Mark heading does not appear.

Using the RED AMA Plug-In

The RED ONE camera generates a 4K (or 2K - 4.5K) full resolution REDCODE™ RAW (.R3D) file. Media is stored on a REDFlash card or a RED drive. You can link to a specific R3D file on the volume or link to the entire volume. RED ONE cameras record metadata which displays in an Avid bin. The metadata includes: edge code, timecode, lens parameters, audio settings and any video image processing information.

Your Avid editing application supports RED R3D files as high quality HD media. Once you link the clips through AMA, you can change and fine-tune the clip color settings through the Source Settings dialog.

You cannot consolidate the RED media in your Avid editing application.

The RED Camera records a unique clip name and additional files that include the REDCODE RAW files and an optional QuickTime reference file placed in a clip folder (.RDC). The system names clips by Camera Letter + Reel Number + Month + Day + a two digit alphanumeric random number.

For example: A001_C002_0502A6.RDC

Each clip folder (.RMD) is at the root directory. In each of these folders is the .RDC folder which contains the video, audio, and metadata files:

- (Windows) drive:\camera+reel_date.RMD\camera+reel_clip_date+random number.RDC
- (Macintosh) Macintosh HD/camera+reel_date.RMD/camera+reel_clip_date+random number.RDC
Avid’s RED workflow allows you to work with RSX, RLX, and RMD files to manage a clip’s color. You have access to all the metadata and color values in the raw RED files as well as the above mentioned “look” files associated with this media. You may also make non-destructive, custom color adjustments to the R3D clip. These adjustments can be made at any stage of the process.

AMA detects folders named with RMD and RDC and files named .R3D.

Audio is included in the RED files, and will display as .wav files in the bin.

You cannot span media across multiple cards. Each clip is recorded as a separate clip, regardless of how many cards you use. There is a 2GB limit on a single master clip. As you record footage, once a 2GB file is captured, an R3D file is created (.001). The camera continues to record and the next 2GB (or less) of media creates another R3D file (.002) until you end recording. So, you can have several R3D files in one clip folder but they are all associated with one master clip. When you link these files/folders through the AMA method, one master clip appears in your bin.

A typical workflow is as follows:

1. Make sure the RED AMA plug-in is installed on your system.
2. Attach the RED drive or insert a REDFlash card.
   
   Your Avid editing system links the RED clips automatically into a bin. The media itself remains on the disk. The clips point directly to the high-resolution media on the disk. All metadata information displays as columns in the bin.

3. Right-clip the clip in the bin and select Source Settings.
   
   For detailed information to set clip parameters, see “Adjusting RED Source Settings” on page 452.
4. Use the master clips to edit the sequence.
5. (Option) Rename the clips to help you organize your material.
6. Choose the video quality from the Transcode & Consolidate tab of the Media Creation setting.
   
   For more information, see “Preparing your RED Clip for Transcode, Mixdown, or Render” on page 451.
7. Transcode your sequence or clips to an HD or SD resolution.
   
   If you need to output to a resolution higher than HD, then export an AFE of your sequence for the conform process on an Avid DS. If your high-resolution media is on a shared storage device and Avid DS has access to the device, Avid DS automatically relinks to the RED files.
8. Remove the RED drive or card.

For information on preparing your RED clip for transcode, mixdown, or renders, see “Preparing your RED Clip for Transcode, Mixdown, or Render” on page 451

**Preparing your RED Clip for Transcode, Mixdown, or Render**

If you want to take a RED clip and offline it to another application, you can create a different resolution RED file, depending on your requirements. This changes the speed and quality of the clip, which could affect the playback performance. The higher the video quality the slower the process (transcode, mixdown, render). The lower the video quality the faster the process. Before you transcode, mixdown or render your clip or sequence, set the appropriate quality in the Media Creation dialog box.

- If you apply any Reformat options (stretch, letterbox, etc.) to your clip, when you perform a transcode, the reformatting options will apply.

**To prepare your RED clip for transcoding, mixdown or rendering:**

1. Before you transcode, mixdown or render, select Tools > Media Creation.
2. Click the Mixdown & Transcode tab or click the Render tab.
3. Select the playback quality from the AMA Source Scaling/Quality menu.
   - Full
   - Half (Best Quality)
   - Half (Good Quality)
   - Quarter
   - Eighth
   - Sixteenth
4. Click OK.
5. Transcode, mixdown or render your clip or sequence as required.

For information about transcoding, see “Using the Transcode Command” on page 483.
For information about mixdown, see “Performing a Video Mixdown” in the Help.
For information about render, see “Basics of Effects Rendering” in the Help.
Adapting RED Source Settings

When you link to R3D (RED) files, the Avid editing system reads each REDCODE RAW file directly. You can then change the clip’s color values: color balance, exposure, and contrast in the Source Settings window. This color value information is encoded with the R3D file through an RLX, RSX or RMD file. These files hold the camera’s original color values of your clip.

The RLX, RSX or RMD files might be created if you set the color values outside of the Avid editing application. These files can be loaded and applied to the associated RED clip through the Source Settings window.

When a RED clip displays in the bin, the system displays the metadata columns of the clip’s color values. For example: Color Space, Gamma Space, Kelvin, Tint. You can export this information to ALE (Avid Log Exchange) and XML (through the Lists Tool) for downstream use in your workflow.

The AMA Source Settings window also has various color spaces to choose from. You can set up different color options (or presets) in each of these color spaces and then apply their color values to multiple clips.

To change the RED source settings:

1. Link the RED clip through the AMA Link option.
   See “The Avid Media Access (AMA) Workflow” on page 394 and “Linking Media with AMA” on page 410 for information on linking.

2. Right-click the RED clip in the bin and select Set Source Settings.
   The Source Settings dialog box opens. The clip displays in the video area.
   You can choose from the Settings menu to select a camera metadata setting or an RSX, RLX or RMD setting (template), or adjust your own custom parameters. This procedure details the custom parameters.
   For information on settings (templates) in the Settings menu and how to apply a setting, see “Using RED Source Settings” on page 456 and “Applying a RED Source Setting” on page 457.
3. Drag the video slider to the frame you want to view.
   The new frame displays and the histogram updates.

   The histogram is a tool that helps you more precisely adjust Source Settings. For more information about the histogram, see “Understanding the Source Settings Histogram” on page 425.

4. Set the appropriate options, you can select from a menu, drag the sliders, enter values or click the eyedropper:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Color Space | Choose from:  
|             | Camera RGB: as close to RAW  
|             | REC.709: SMPTE standard color space for HD  
|             | REDcolor (default): newest, more accurate color science from RED  
|             | REDcolor2: better skin tones and color from RED  
|             | REDcolor3: more improvements from RED  
|             | REDSpace: based on the camera’s RGB but more saturated |
### Option Description

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gamma Curve</td>
<td>Lets you override the gamma curve. Choose from:</td>
</tr>
<tr>
<td></td>
<td>- REC.709: a REC.709 gamma curve with a linear portion at black and a gamma at 2.2 curve</td>
</tr>
<tr>
<td></td>
<td>- REDLog: maps the 12-bit sensor data on to a 10-bit curve with minimal loss</td>
</tr>
<tr>
<td></td>
<td>- REDLogFilm: a way of containing a large dynamic range in a video file. Needs to be viewed through a LUT to convert it for viewing on a monitor.</td>
</tr>
<tr>
<td></td>
<td>- REDSpace: based on REC.709 but with more contrast</td>
</tr>
<tr>
<td></td>
<td>- REDGamma (default): gamma curve from RED with a smoother highlight rolloff</td>
</tr>
<tr>
<td></td>
<td>- REDGamma2</td>
</tr>
<tr>
<td></td>
<td>- REDGamma3</td>
</tr>
<tr>
<td>White Balance</td>
<td>Adjusts the color temperature of your image in one click. Use the eyedropper icon and then click a known white area in your RED footage to achieve the correct light or neutral balance. This option is equivalent to adjusting the Kelvin and Tint options. When you use the White Balance option, the system automatically adjusts Kelvin and Tint. It is recommended you adjust White Balance first before performing any other adjustments to the image for best quality. This change adjusts the entire clip and updates the histogram.</td>
</tr>
<tr>
<td>Kelvin</td>
<td>Adjusts the RGB color to compensate for red - blue tinting of the scene at different color temperatures of the ambient light while you shoot. Common values are 3200 (tungsten) and 5600 (daylight). Click and drag the slider from 1700 to 9400. Default is 5600.</td>
</tr>
<tr>
<td>Tint</td>
<td>Adjusts the RGB color to compensate for yellow - green tinting of the scene at different color temperatures of the ambient light while you shoot. This is valuable when the ambient light source contains a significant amount of yellow or green, such as fluorescent. Click and drag the slider from -100 to 100. Default is 0.00.</td>
</tr>
<tr>
<td>ISO</td>
<td>Allows the ISO level to change from 50 to 2000. Default is 320.</td>
</tr>
<tr>
<td>FLUT™</td>
<td>The latest color science developed by RED. Allows you to balance your mid-grays in the center of the histogram without pushing highlight details over the edge.</td>
</tr>
<tr>
<td>Shadow</td>
<td>Adjusts the overall black level of the image without affecting the white level. Click and drag the slider from 0.00 to 1.00. Default is 0.00.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>DRX</td>
<td>Lets you recover potentially lost dynamic range by extending and balancing highlights, taking into account the rendering intent of the desired Kelvin and Tint white balance. Click and drag the slider from 0.00 to 1.00. Default is 0.00.</td>
</tr>
<tr>
<td>Debayer Detail</td>
<td>Choose from High (default), Medium, or Low.</td>
</tr>
<tr>
<td>Chroma Denoise</td>
<td>Choose from Off (default), Minimum, Milder, Mild, Strong, or Maximum.</td>
</tr>
<tr>
<td>OLPF</td>
<td>Controls the optical low-pass filter. Choose from Off (default), Low, Medium, or High.</td>
</tr>
<tr>
<td>Exposure</td>
<td>Allows adjustment to the clip exposure. Click and drag the slider from -7.00 to 7.00. Default is 0.00.</td>
</tr>
<tr>
<td>Brightness</td>
<td>Adjusts the overall brightness of the image. Lifts blacks without affecting the white level. Click and drag the slider from -10.00 to 10.00. Default is 0.00.</td>
</tr>
<tr>
<td>Contrast</td>
<td>Adjusts the tonal range of the image, which usually improves sharpness and detail. When you increase the Contrast, it increases tonal separation between adjacent gray levels but decreases the total number of discreet gray levels in the image. Click and drag the slider from -1.00 to 1.00. Default is 0.00.</td>
</tr>
<tr>
<td>Saturation</td>
<td>Affects the intensity of the red, green and blue channels. As the value increases color saturation increases. As the value decreases, so does the color decrease. If the value is set to high, colors might clip. If the level is set to 0.00, a monochromatic image with only gray tones appear. Click and drag the slider from 0.00 to 4.00. Default is 1.00</td>
</tr>
<tr>
<td>Red</td>
<td>Increases or decreases the camera’s sensitivity to red light by amplifying the R channel digital video signal received from the sensor. A 0 (zero) no Red is visible, the image has a strong cyan cast. Click and drag the slider from 0.00 to 10.00. Default is 1.00.</td>
</tr>
<tr>
<td>Green</td>
<td>Increases or decreases the camera’s sensitivity to green light by amplifying the G channel digital video signal received from the sensor. At 0 (zero), no green is visible, the image has a strong magenta cast. Click and drag the slider from 0.00 to 10.00. Default is 1.00.</td>
</tr>
</tbody>
</table>
Using the RED AMA Plug-In

5. Click Apply.

The changes apply to your clip. You can continue to make additional changes.

If the clip is in the Source viewer, the changes are reflected in the Source viewer and in the
Client monitor (if you have one attached).

If you click Cancel after you click Apply, the Set Source Settings window closes with the
changes you made.

6. Click OK to save your change and close the window.

The system updates the bin column metadata with the new parameters.

If you make changes in the Source Settings window and then relink the clip through AMA again,
you still keep all the parameters that you set.

Using RED Source Settings

Source Settings lets you choose from a selection of preset templates or you can create your own
look. Each source setting has its own color values associated with it. There are a few different
ways to obtain source settings:

- Camera and default source settings are included with the RED AMA plugin
- Link a RED clip from RED Alert! (imports the RSX source setting)
- Load a source setting onto your system (for example, an RLX, RSX, or RMD)
- Create a custom source setting

You cannot change the default RSX and RLX source settings, these are predefined. Once you
make a change to a parameter, the setting becomes a Custom setting. At this time, you can only
have one Custom setting.

You can load multiple RSX and RLX source settings. As you link a RED clip from RED Alert!
(RSX) or load an RLX file, the setting appears in the Source Settings menu.

Source Settings are helpful when you want to apply one setting to multiple clips in your bin.
Different subclips from the same master clip can have different source settings.
When you edit a clip into a sequence, the material you edit in uses the clip’s current attribute values or RED source settings. If you change the RED source settings at a later point in your workflow, the sequence does not automatically adjust for the change. If you want the sequence to use the RED source settings for clips that you have changed since you edited, you must refresh the sequence. For procedures on how to refresh your sequence, see “Refreshing Sequences to Use Current Clip Attributes” on page 608.

**Applying a RED Source Setting**

**To apply a source setting to a RED clip:**

1. Right-click a RED clip in the bin (or Shift-click multiple clips), then choose Set Source Settings.
   
   The Set Source Settings window opens and your clip displays in the viewer.

2. Select a setting (template) from the Source Settings menu.
   
   Source Settings vary depending on the files or templates loaded on your system.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Origin</th>
</tr>
</thead>
<tbody>
<tr>
<td>Camera Metadata Settings</td>
<td>Default</td>
</tr>
<tr>
<td>Default Settings</td>
<td>Default</td>
</tr>
<tr>
<td>Grade (RSX) Settings</td>
<td>RED Alert!</td>
</tr>
<tr>
<td>filename RLX Setting</td>
<td>RED Alert!</td>
</tr>
<tr>
<td>Grade (RMD) Setting</td>
<td>REDCINE-X</td>
</tr>
<tr>
<td>Custom</td>
<td>User created in Avid</td>
</tr>
</tbody>
</table>

3. Click Apply.
   
   The settings apply to the clip and if the clip is loaded in the Timeline, the video updates and displays in a Client monitor (if one is attached) and the Source monitor.

4. Click OK to save your settings and close the window.
   
   The system updates the bin column RED metadata with the parameters.

   If you make additional changes after you select a setting, the system creates a Custom setting and Custom appears in the Settings list. You cannot make changes to a system generated setting, however you can use a system setting and make changes to create your own Custom setting.
To import additional source settings:
1. From the Source Settings window, click the Load button.
   The Load External Settings window opens.
2. Browse to the Settings file.
3. Change the filter to display RSX, RLX or RMD files.
4. Select your setting and click OK.
   The new source setting appears in the Source Settings menu, and is immediately applied to the clip.

Using the QuickTime AMA Plug-In

There are a few guidelines you should follow when you link QuickTime files through AMA.

To link QuickTime media through the AMA method, you first need to create a QuickTime movie from a third-party application or through the Avid editing system. The third-party applications that supports creating a QuickTime movie include Adobe AfterEffects® and Final Cut Pro. This is done through the QuickTime Export dialog box which uses the Avid QuickTime Codecs. These codecs automatically install on your Avid editing system. At this time, Avid supports the Same as Source and Custom export settings options when you export with the Avid QuickTime codecs. This process creates an Avid compressed QuickTime media file, with a .mov extension. AMA only detects and links to Avid compressed QuickTime media.

For information about exporting a QuickTime movie, see “Exporting QuickTime Movies” on page 1038.

QuickTime files use the .mov file name extension. After you link a QuickTime file through AMA, the file drops the .mov file name extension. QuickTime media is linked at the data rate at which it was recorded.

A QuickTime AMA workflow is as follows:
1. Create a QuickTime movie with a supported codec in an application such as Adobe AfterEffects or Apple’s Final Cut Pro.
   Avid supports the Same as Source and Custom export settings options when you export with Avid QuickTime codec.

See Adobe and Apple documentation for information on how to create a QuickTime movie.

2. Move the created .mov file onto your Avid editing system.
3. Open a bin.
   If there is no active bin, a dialog box appears asking you to select a bin.
4. Select File > AMA Link.

You can also right-click a bin and select AMA Link.

To link to multiple QuickTime files, use the File > Link to AMA Volume(s) option and select the folder that stores all the QuickTime files.

The Open dialog box opens.

5. From the AMA Plugin Filter menu, select QuickTime.

6. Locate and select the .mov file(s) you want to link. Ctrl+click or Shift+click to select multiple files.

7. Click Open.

The clips appear in the active bin. A link icon appears next to the clips.

If any of the movies you linked to were QuickTime with Alpha channel files, they appear in your bin as a Matte Key effect. The Alpha Channel options in the Import Settings Image tab apply to the QuickTime AMA linked file. Therefore, the QuickTime file will appear in the bin as a master clip if the Ignore option is set or will appear inverted or not inverted depending on the selected options.

8. Use the linked clips to edit your sequence.

9. If you need to change the QuickTime clip in After Effects or FCP, open the existing file in After Effects or FCP and make the change.

If you change the number of tracks, change the duration of the clip or change the clips file name, when you relink through AMA, the system creates a new clip and will not overwrite or replace the existing clip in the bin.

If you change the number of tracks, the duration, or edit rate, but not the file name, any clips linked to the sequence will unlink and the clips display Media Offline.

If you change the file name or the location of the clip, you can Relink to AMA files. For more information, see “Relinking to AMA-Linked QuickTime Files” on page 413.

10. From your Avid editing application, select Clear Monitor from the Clip Name menu above the monitors.

This clears the monitors and Timeline of any old clips.

11. Render or export the newly changed QuickTime movie out of AfterEffects or FCP to the same folder location as the original file. Accept all overwrite prompts. Once the changed QuickTime movie is exported or rendered, refocus or open (if FCP or AfterEffects are on the same system) your Avid editing application.

The updated clip appears in your bin (and sequence) and replaces the old clip. If the clip is in the Source or Record monitor, it also will update.
12. Continue to edit your sequence or consolidate or transcode your sequence or clip.

- When you consolidate, if you want to keep your AMA clips linked to the original source, select the option “Keep Master clips linked to media on the original drive,” in the Copying Media Files dialog box.

- For information on consolidating your sequence, see “Consolidating Media” on page 477. For information on transcoding your sequence, see “Using the Transcode Command” on page 483.

### Adjusting QuickTime Source Settings

You can change the dynamic range of a linked AMA QuickTime movie from 601/709 video range (16-235) to RGB range (0-255) or from RGB range (0-255) to 601/709 video range (16-235). This setting is only supported with QuickTime movies that were created with a non-Avid codec, including ProRes, H.264 and Animation.

When a QuickTime clip displays in the bin, the system displays the metadata columns of the clip’s color values.

**To change the QuickTime source settings:**

1. Link the QuickTime clip through the File > Link to AMA File option or to link to multiple QuickTime files, use the File > Link to AMA Volume(s) option.

   See “The Avid Media Access (AMA) Workflow” on page 394 and “Linking Media with AMA” on page 410 for information on linking.

2. Right-click the QuickTime clip in the bin and select Set Source Settings.

   If your QuickTime movie was created with an Avid codec, the Set Source Settings option will not be available.

   The Source Settings dialog box opens. The clip displays in the video area.

   For information on settings in the Settings menu and how to apply a setting, see “Applying a QuickTime Source Setting” on page 462.
3. Drag the video slider to the frame you want to view.

The new frame displays and the histogram updates.

The histogram is a tool that helps you more precisely adjust Source Settings. For more information about the histogram, see “Understanding the QuickTime Source Settings Histogram” on page 463

4. Set the appropriate options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Settings</td>
<td>Default&lt;br&gt;Custom: User created in Avid.</td>
</tr>
<tr>
<td>Field Ordering</td>
<td>Default&lt;br&gt;Progressive: The image is interpreted as a progressive image.&lt;br&gt;Interlaced - Odd (upper field first) ordered: Adjusts the clip so that the top field is played before the lower field.&lt;br&gt;Interlaced - Even (lower field first): Adjusts the clip so that the lower field is played before the top field.</td>
</tr>
<tr>
<td>Field Layout</td>
<td>Merged (default): Alternates field information.</td>
</tr>
<tr>
<td></td>
<td>Split: Based on the field ordering selection (Interlaced Odd or Interlaced Even), fields will be split into one over the other. For example, all odd fields are over all even fields.</td>
</tr>
</tbody>
</table>
Using the QuickTime AMA Plug-In

5. Click Apply. The changes apply to your clip. You can continue to make additional changes. If the clip is in the Source viewer, the changes are reflected in the Source viewer and in the Client monitor (if you have one attached). If you click Cancel after you click Apply, the Set Source Settings window closes with the changes you made.

6. Click OK to save your change and close the window. The system updates the bin column metadata with the new parameters.

If you make changes in the Source Settings window and then relink the clip through AMA again, you still keep all the parameters that you set.

Applying a QuickTime Source Setting

Source Settings lets you choose from a Custom of Default setting. Each source setting has its own color values associated with it.

To apply a source setting to a QuickTime clip:

1. Right-click a QuickTime clip in the bin (or Shift-click multiple clips), then choose Set Source Settings. The Set Source Settings window opens and your clip displays in the viewer.

2. Select a setting from the Source Settings menu.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Origin</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Settings</td>
<td>Default</td>
</tr>
<tr>
<td>Custom</td>
<td>User created in Avid</td>
</tr>
</tbody>
</table>
3. Click Apply.

   The settings apply to the clip and if the clip is loaded in the Timeline, the video updates and displays in a Client monitor (if one is attached) and the Source monitor.

4. Click OK to save your settings and close the window.

   The system updates the bin column metadata with the parameters.

   If you make additional changes after you select a setting, the system creates a Custom setting and Custom appears in the Settings list. You cannot make changes to a system generated setting, however you can use a system setting and make changes to create your own Custom setting.

   *The Load button does not apply to QuickTime media.*

**Understanding the QuickTime Source Settings Histogram**

The histogram in the Source Settings window helps you visualize the distribution of color values in an image. You can use the histogram to adjust the Source Settings of your AMA media more precisely while avoiding clipping and color imbalance.

![Source Settings histogram](image)

Example of a Source Settings histogram. The histogram plots color values on the horizontal axis and the percentage or proportional number of pixels on the vertical axis. The vertical lines represent the black point (left) and the white point (right), so the area between them is the safe color range.

The histogram plots color values that can be represented by the image bit-depth on the horizontal axis. Therefore, the width of the histogram is the same as the width of the image. The histogram plots the percentage, or proportional number of pixels in the image, with each particular color value on the vertical axis. The vertical axis is scaled according to the height of the maximum value in the plot. Whenever the histogram changes, the vertical axis rescales according to the new maximum.
Using the MXF AMA Plug-In

Material Exchange Format (MXF) is a wrapper or container format which encapsulates media and rich production metadata into a single file, which is useful for media storage and exchange. It is an open technology that can be implemented by different manufacturers.

MXF is designed to be flexible enough for use in all stages of content creation, from acquisition, to authoring, to distribution. The primary benefit of MXF is that it provides greater workflow efficiency by preserving useful metadata as media files make their way through the content creation process. The MXF format is independent of the type of content that it contains, so an MXF file can contain video and/or audio at any resolution or compression. In many instances MXF files encapsulate media which is already formatted to one of the existing industry standards.

The MXF AMA plug-in is automatically installed when you install your editing application.

**A typical workflow is as follows:**

1. Create a supported MXF file (create a supported MXF file from your third party application, for example: Rhozet or Omneon).
2. Move the .mxf file onto your Avid editing system.
3. Select File > AMA Link.
   
   You can also right-click a bin and select AMA Link.
   
   The Open dialog box opens.
4. From the AMA Plugin Filter menu, select MXF.
5. Select the file(s) you want to link. Ctrl+click or Shift+click to select multiple files.
6. Click Open.
   
   The MXF clips appear in the active bin. A link icon appears next to the clips.
   
   If the system cannot link a file, an error message displays informing you to open the Console window for more information about the file(s) in error.
   
   If you move the clip from the original drive to another drive on your system, the clip displays as offline in your bin.

*If you move a source file from one location to another and then back to the original location, you might need to refresh the bin to redisplay the clip. Close and reopen the bin to refresh the bin.*
7. Use the linked clips to edit your sequence.
8. (Option) Rename the clips to help organize your material.
9. Consolidate or transcode your sequence or clips.
   The media consolidates to the destination you set in the Media Creation dialog box.

When you consolidate, if you want to keep your AMA clips linked to the original source, select the option “Keep Master clips linked to media on the original drive,” in the Copying Media Files dialog box.

Workflow for Editing Clips with Ancillary Data and AMA

The following steps describe a typical workflow for editing XDCAM or MXF clips with ancillary data and AMA.

Do not mix AMA and traditional workflows. Either use AMA or use the traditional import/batch import workflow.

You should be aware of the following:

- You can link to the ancillary data clip without an Avid input/output hardware, however, in order to view the ancillary data in a monitor, an Avid Nitris DX or Avid Mojo DX device is required.
- If you consolidate the XDCAM or MXF clip or the sequence that contains the XDCAM or MXF clip with ancillary data, the ancillary data track stays with the consolidated clip or sequence. In addition, the Ancillary Data bin column populates with the DID and SDID numbers once you consolidate or transcode the clip with the ancillary data.

A typical workflow is as follows:

1. The Sony XDCAM or MXF AMA plug-in should be installed on your system.
2. For XDCAM, install the appropriate Sony XDCAM drivers.
3. For an XDCAM clip with ancillary data, insert the XDCAM disk.
   The system links the XDCAM clip with ancillary data into a bin. The media itself remains on the disk. The clips point directly to the media on the disk.

Ancillary data is only supported with high resolution XDCAM clips. A proxy clip does not contain a data track, however once you relink to the high resolution XDCAM clip, the data track comes online.

If you use multiple cards and you remove one of the cards, your media displays offline.
4. For an MXF clip with ancillary data, select File > Link to AMA File(s).

The Select file(s) for AMA linking dialog box opens.

5. From the AMA Plugin Filter menu, select MXF.

6. Select the file(s) you want to link. Ctrl+click or Shift+click to select multiple files.

The MXF clip appears in the bin along with a new Ancillary Data bin column.

> For information about AMA, see “The Avid Media Access (AMA) Workflow” on page 394.

7. Use the master clips to edit the sequence.

When you load the clip into a sequence, a Data track appears which contains the ancillary data.

8. You can then transcode or consolidate your sequence or clips.

> When you consolidate, if you want to keep your AMA clips linked to the original source, select the option “Keep Master clips linked to media on the original drive,” in the Copying Media Files dialog box.

When you consolidate the XDCAM or MXF clip or the sequence that contains the XDCAM or MXF clip with ancillary data, the ancillary data track stays with the consolidated clip or sequence.

> For information on consolidating your sequence, see “Consolidating Media” on page 477. For information on transcoding your sequence, see “Using the Transcode Command” on page 483.
Managing Media Files

When you capture footage, the system creates digital media files on the media drives connected to your system. In addition to the bins where you organize the clips that reference these media files, your Avid editing application provides tools for directly managing these media files. These tools and features are described in the following topics:

- Working with Media Files in an Avid Interplay Environment
- Using Avid Editing Systems in an Avid LANshare Workgroup
- Viewing Media with a 100Base-T Connection to Avid ISIS
- Understanding Drive Mounting
- Mounting and Unmounting Drives
- Using the Media Tool
- Consolidating Media
- Using the Consolidate Command
- Using the Transcode Command
- Background Consolidate and Transcode
- Loading the Media Database
- Refreshing Media Directories
- Deleting Unreferenced Clips and Media
- Backing Up Media Files

In an Avid Interplay environment, your Avid editing application uses the Interplay Media Indexer service to keep track of media files in the locations that you identify. As a result, features such as the Media tool and relinking work differently in an Interplay environment. This chapter includes notes and cross-references where appropriate. For more information, see “Using MultiRez and Dynamic Relink” on page 1327 as well as the Interplay documentation.
If you are using your Avid editing system in an Avid Interplay environment, you can use Avid’s media asset manager, the Avid Interplay Engine, to share media files between systems. The Interplay Engine, installed on the Avid Interplay server, is a media database that lets you search the large number of media objects (master clips, sequences, effects, and any other type of object that references digital media) in the Avid shared storage environment. You can also use the Interplay Engine to manage sequences and other media objects whose media is no longer online. You can then search for these objects, view information about them such as the source tape name, obtain the source footage, and rerecord or recapture it.

If you want to transfer media from one workgroup to another, you can use the Interplay Transfer application. Interplay Transfer receives and queues transfer requests from one or more clients. Transfers are then initiated by the Interplay Transfer server to off load the client. For more information about the Transfer setting, see the *Avid Interplay Transfer Setup and User's Guide*.

You can also use Avid Interplay Transfer to share files between workgroups. For more information about the Interplay Engine and Avid Interplay Transfer, see the *Avid Interplay Access User’s Guide* and the *Avid Interplay Transfer Setup and User's Guide*.

**Configuring Avid Editing Systems for the Interplay Engine and Interplay Transfer**

Before you can interact with the Avid Interplay Engine and Avid Interplay Transfer, you need to configure your Avid editing application with the required Interplay settings.

You must specify the Interplay Server location to let your Avid editing application know where to look for the Interplay Engine on the network. After you specify the network settings, you can check in clips to and check out clips from the Interplay database. For more information about Interplay settings, see “Configuring Interplay Settings on the Editing Workstation” on page 1214 and the *Avid Interplay Engine and Avid Interplay Archive Engine Administration Guide*.

The Interplay Server setting is a Project Setting that applies to all users of a particular Avid editing system. If you want to access another asset manager, you must modify the Interplay Server settings to reflect the server.

The directory defined in your Interplay Project settings identifies the Interplay folder location to which you check in media objects. You can check out objects from a different asset manager by dragging clips from that asset manager to a bin without changing the Interplay Project settings.
Using Avid Editing Systems in an Avid Workgroup Environment

When you work with Avid Interplay, you belong to a workgroup that allows you open a bin with assets stored in the Interplay database. To read and write media to the database you first need to mount a workspace. For information on mounting workspaces, see “Mounting Workspaces on an Avid ISIS System” on page 1226.

⚠️ When you are in a workgroup environment using an asset manager server with an anti-virus utility, you need to turn off any auto-protection feature when you access the asset manager. You can then turn the auto-protection feature back on. You need to perform this each time you access the asset manager. In addition, do not perform a live update while the system use is high. For more information, see your anti-virus documentation.

For information on disconnecting your Avid editing application from the Interplay environment, see the topic “Disconnecting from the Interplay Environment” in the Avid Interplay Help.

Using Avid Editing Systems in an Avid LANshare Workgroup

You can use your Avid editing system as a client in an Avid LANshare workgroup. A LANshare workgroup lets you share media with other clients connected to a high-performance server through an Ethernet network.

For complete information on using a LANshare workgroup, including system requirements and supported resolutions, see the LANserver release notes and documentation.

⚠️ Because LANshare workgroups and PortServer workgroups do not support all Avid resolutions, make sure you specify a supported resolution in your Avid editing application. For information on supported resolutions, see the LANserver system or PortServer system documentation.

When you use your Avid editing application with the LANserver system, you need to set up the client so LANshare workspaces are recognized when you start your Avid editing application.

To enable the client to recognize LANshare workspaces:

1. Open a bin.
2. Double-click PortServer in the Settings list of the Project window
   The Port Server Settings dialog box opens.
3. Select “Auto-connect to LANshare at Launch.”
4. Click Connect, and then click OK.
   The dialog box closes, and auto-connect is set.
Viewing Media with a 100Base-T Connection to Avid ISIS

Avid editors can access MPEG-2 low-resolution video and MPEG-1 Layer II (or MP2) compressed audio stored on an Avid ISIS media network. This is useful if you connect to the media network with a 100Base-T connection in a Zone 3 configuration, instead of the higher bandwidth connection used for Avid ISIS clients in a Zone 1 or Zone 2 configuration. For more information on Avid ISIS media networks, see the *Avid ISIS Setup Guide*.

You cannot output, consolidate, or transcode media using MP2 compressed audio. Instead, use dynamic relink to link the low-resolution media to the high-resolution source media stored on the media network. You can then output or transcode the high-resolution media.

Understanding Drive Mounting

By default, all media drives connected to your system are listed and can be seen by your Avid editing application. You can remove one or more drives from the list at any time by using the Unmount command. For example, if you want to use only some of your drives for a particular project, select Unmount to prevent other drives from appearing in your Avid editing application.

If the drive being ejected supports the auto-eject feature (for example, Jaz® drives), the command ejects the disk from the drive. The Unmount command does not remove drives from the Windows system.

You can unmount one or several drive volumes mounted on the desktop at any time from within your Avid editing application. You can also remount all the drives and return them to the desktop. However, you cannot mount selected drives because your Avid editing application cannot interface with selected drive individually. For more information, see “Mounting and Unmounting Drives” on page 471.

This is useful in several circumstances:

- If you work with optical drives for backup and retrieval of low-resolution material, you can unmount drives and mount them as needed to avoid cluttering the desktop during normal use.
- If you work with an extensive array of fixed-storage drives, which might involve many partitions divided among several projects, you can selectively mount and unmount drives according to use.
- If you work with an Avid shared storage environment, you might have to unmount and remount icons on the desktop. See “Working with Bins and Projects in an Avid Shared Storage Environment” on page 118.
On systems with multiple media drives, unmounting unused drives can improve the performance of the Media tool. You need to unmount the drives before you open the Media tool. See “Using the Media Tool” on page 471.

If you need to physically add or remove drives, see the documentation that came with your drive. You cannot physically add or remove drives from your Avid editing application. Before you physically remove or add drives, shut down your system completely.

Mounting and Unmounting Drives

For more information on mounting and unmounting drives, see “Understanding Drive Mounting” on page 470.

To mount all drives:

- Select File > Mount All.
  
  All drives turned on and connected to the system become available to your Avid editing application.

To unmount a drive or make a drive unavailable to your Avid editing application:

1. With your Avid editing application running, select File > Unmount.
   
   The Unmount Disk or Drives dialog box opens.
   
   The list displays all drives currently available.
2. Select a drive to unmount.
3. Ctrl+click (Windows) or Command+click (Macintosh) to select additional drives.
4. Click Unmount.
   
   The drives are no longer available to your Avid editing application.

If you receive an error message that prevents you from unmounting a drive, it might be that you have Avid Media Access (AMA) enabled. AMA does not require you to mount and unmount drives. AMA is on by default. To turn off AMA (and unmount your drive), see “Selecting the AMA Settings” on page 398.

Using the Media Tool

The Media tool is your window into the captured video and audio data files stored on your media drives. The Media tool provides similar database tools for manipulating digital media files to those provided by bins for manipulating clips and sequences.
The Media tool displays media that is stored on local drives (drives directly connected to the Avid editing system) and on unmanaged shared storage (shared storage that is part of an Avid shared storage network but is not managed by an Avid asset manager).

In an Interplay environment, the Media tool displays only media that is stored on local drives, see “Using the Media Tool in an Avid Interplay Environment” on page 473. Use the Media tool to search for media on local drives, and use the Interplay Engine to search for media on shared drives.

**Basic Media Tool Features**

The Media tool provides many of the same controls for viewing and managing information that you use with bins:

- The three display options in the Media tool function like the bin display views: Text view, Frame view, and Script view.
- You can use Text View headings and options for columns of clip and media file data. You can also use procedures such as customizing the display of columns, moving within columns, and sorting information, as described in “Using Text View” on page 341.
- You can use the same Frame view options described in “Using Frame View” on page 346.
- You can use the same Script view options described in “Using Script View” on page 348.
- The Media Tool Fast menu gives you quick access to the same commands available in the Bin Fast menu.
- You can highlight, move, copy, duplicate, delete, sort, and sift clips in the Media tool. You can also select media relatives, source clips, and unreferenced clips, as described in “Bin Procedures” on page 350.
- Media Tool database and display options are saved as User settings. When you close the Media tool, the view you are in (Brief, Frame, Script, or Text) is saved and any customizations of columns are saved.
- You have the option of saving a custom view of the Media tool. Any view created in the Media tool is available from all bins and all custom bin views are available in the Media tool from the Views menu. For more information on creating customized views, see “Saving a Custom Bin View” on page 345.
Using the Media Tool

Media Tool views are saved as User settings and appear in the Settings list in the Project window as bin views.

- You can print Media Tool data by using the same procedures for printing bins, as described in “Printing Bins” on page 390.

The Media tool also has a number of unique functions:

- Unlike a bin, the Media tool can display all the tracks captured for each clip as separate media files. Therefore, when you view, delete, and manipulate files, you have the added option of specifying individual video and audio tracks.

- Unlike a bin, the Media tool does not display sequences and subclips. Only master clips, AMA Master clips, precompute (rendered effect) clips, and associated media files are available for display.

- The following Bin menu commands do not apply to the Media tool: Batch Capture, Batch Import, Relink, Modify, AutoSync, and AutoSequence. You must perform these functions from a bin.

Using the Media Tool in an Avid Interplay Environment

On an editing system in an Avid Interplay environment, the Media tool displays only media that is stored on local drives. When you use the Media tool to search for media on a local drive, the Interplay Media Indexer (an Interplay service) searches its database and determines if media is online. If the media is online, it tells the Media tool to display it. However, the Media Indexer keeps track of media only if the media is on indexed storages (storages for which Media Indexer is configured).

If some media seems to be missing when you use the Media tool, that media might be stored in a folder not indexed by Media Indexer. If you want to see all local media in the Media tool, all your local storages must be properly indexed. For information on configuring Media Indexer, see the installation documentation for Avid Interplay.

Opening the Media Tool

To open the Media tool:

1. Select Tools > Media Tool.

   The Media Tool Display dialog box opens.
2. Select the media drives from which to load by doing one of the following:
   - In the Media Drive(s) list, select individual media drives.
   - Click the All Drives button.

   The Media tool loads the media database only for the drives you select. The more drives you select, the more memory is required for the Media tool to open.

3. Select the projects to load by doing one of the following:
   - In the Projects list, select individual projects.
   - Click the Current Project button.
   - Click the All Projects button.

   Only projects with associated online media and the current project appear in the Project(s) list in the Media Tool Display dialog box.

4. Select Master Clips, AMA Master Clips, Precompute Clips, Media Files, or any combination of the options.

5. Click OK.

   The Media tool opens.
Deleting Media Files with the Media Tool

You can use the Media tool to delete selected media files without harming the related master clips, subclips, and sequences.

If you use the Media tool to delete selected media files, you no longer have access to visuals of the deleted material. If you load a clip for which a media file has been deleted, a black screen appears with the words “Media Offline.” If you need to use those clips again, you must recapture from tape or reimport graphics.

Depending on your needs, you can do the following:

- Delete selected audio or video tracks and retain other tracks from a clip.
- Delete entire sets of media files and related clips from within the Media tool.
- Delete all unrelated media upon completion of a project, and retain only the media required for playback of a finished sequence as described in “Consolidating Media” on page 477.

To delete selected media files:

1. Select Tools > Media Tool.
2. Select one or more media files (audio, video, or both) or master clips whose media files you want to delete.
3. Do one of the following:
   - Select Edit > Delete.
Press the Delete key.

The Delete Media dialog box opens.

4. Select the media objects that you want to delete:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video media file (V)</td>
<td>After deletion, the master clip linked to that file is black, with the message “Media Offline” displayed. Related subclips and sequences are affected in the same way.</td>
</tr>
<tr>
<td>Audio media file (A1, A2, A3, A4, A5, A6, A7, A8)</td>
<td>After deletion, the master clip linked to that file is silent. Subclips and sequences created from the master clip are affected in the same way.</td>
</tr>
<tr>
<td>Precompute media file (V, A)</td>
<td>After deletion, the section of the sequence with the effect is black, and the message “Media Offline” is displayed.</td>
</tr>
<tr>
<td>Audio mixdown file (A)</td>
<td>After deletion, the section of the sequence with the mixdown is silent.</td>
</tr>
</tbody>
</table>

5. Click OK.

A dialog box opens, asking you to confirm the deletion.

6. Click Delete.

The selected media files are deleted.
Consolidating Media

When you consolidate media files, your Avid editing application finds the media files or portions of media files associated with selected clips, subclips, or sequences. It then makes copies of them, and saves the copies on a target drive that you specify.

There are three basic reasons to use the Consolidate feature:

- To copy media onto one drive for storage or transfer to another system.
- To keep only the media required to play back a sequence, and delete the rest to use less storage space.
- To create backup files.

Because the Media tool displays only master clips, you cannot consolidate subclips or sequences with the Media tool. You can consolidate master clips, subclips, and sequences in a bin.

The Consolidate feature operates differently, and provides different advantages, depending upon whether you are consolidating master clips, subclips, or sequences.

Master Clips

When you consolidate a master clip, your Avid editing application creates exact copies of the media files. If you link the original master clip to the new files, your Avid editing application creates a master clip with the file name extension .old that remains linked to the old files. If you maintain the link between the original master clip and the old media files, your Avid editing application creates a new master clip with the file name extension .new that is linked to the new media files.

The new master clips are also numbered incrementally beginning with .01. Consolidating master clips does not save storage space because your Avid editing application copies the same amount of media for each clip.

Consolidating a master clip (original clips and media files in red, new clips and media files in black). Top: in this scenario, the original master clip remains linked to the original media file (for example, on drive A), and the new master clip (which receives a .new.01 file name extension) is linked to a new copy of the original media file (on drive B). Bottom: in this scenario, the original master clip is linked to a new copy of the original media file (on drive B), and the new master clip (which receives a .old.01 file name extension) is linked to the original media file.
Subclips

When you consolidate a subclip or group of subclips, your Avid editing application copies only the portion of the media files represented in the subclip and creates a new master clip that is the duration of the subclip and a new subclip. The file name extension `.new` is attached, along with incremental numbering beginning with `.01`.

Consolidating a subclip. Left: the original master clip, the subclip created from it, and its original media file. (on, for example, drive A). Right: the new master clip, the new subclip, and the smaller subclipped copy of the original media file (on drive B).

Sequences

When you consolidate a sequence, your Avid editing application copies only the portions of media files edited into the sequence and creates new master clips for each clip in the sequence. The file name extension `.new` is attached to the master clips, along with incremental numbering beginning with `.01`. The sequence is not renamed but is automatically relinked to the new media files.

Consolidate finished sequences to:

- Create backup files.
- Preserve only the captured media required for playback, and delete the rest to use less storage space.
- Gather dispersed media onto one drive for storage or transfer to another system.

Because a consolidated sequence is linked to the new files by default, consider duplicating the sequence each time you consolidate if you need to maintain links to the original files.
Using the Consolidate Command

**To consolidate master clips, subclips, or sequences:**

1. If you are consolidating a sequence, duplicate the sequence to maintain links to the original files, if necessary, and render any unrendered effects.
2. Select a clip or sequence.
3. Select Clip > Consolidate/Transcode.

*If you have any compressed audio (MP2 audio) in the clip or sequence you selected to consolidate or transcode, a message appears informing you that selected items contain MP2 audio and cannot be consolidated or transcoded. You should relink this MP2 audio to an uncompressed audio format. If you do not relink to an uncompressed audio format, the selected clip or sequence with the MP2 audio is skipped.*

The Consolidate/Transcode dialog box opens.
4. Select Consolidate in the upper left corner.
5. In the Target Drive(s) area, select a drive or drives.
6. Select the appropriate options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video, audio and data on same drive(s)</td>
<td>Select to store the consolidated media files on the same target drive. Deselecting this option lets you select separate drives for the audio, video and data media files.</td>
</tr>
<tr>
<td>Option</td>
<td>Description (Continued)</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Handle length ( n ) frames</td>
<td>If you are consolidating subclips or sequences, type a handle length for the new clips, or accept the default: leave it at 60 frames (NTSC), 50 frames (PAL), or 24 frames (progressive). The handle length is the number of frames outside the IN and OUT points that you can use for dissolves and trims with the new, shorter master clips.</td>
</tr>
<tr>
<td>Create new sequence(s)</td>
<td>Select this option to create a new sequence from the consolidated clips (appears only if you selected a sequence).</td>
</tr>
<tr>
<td>Delete original media files when done</td>
<td>Select to delete original media files automatically.</td>
</tr>
<tr>
<td>Skip media files already on the target drive</td>
<td>Select to bypass files if some related media files are already located on the target drive.</td>
</tr>
<tr>
<td>Relink selected clips to target drive before skipping</td>
<td>Select to ensure that all selected clips are linked to media on the target drive. This option appears when you select “Skip media files already on the target drive.”</td>
</tr>
<tr>
<td>Consolidate all clips in a group edit</td>
<td>Select to copy media for all clips in a group edit, for consolidating a group clip or a sequence that contains group clips.</td>
</tr>
<tr>
<td></td>
<td>For more information on group clips, see “Understanding Grouping and Multigrouping Clips” on page 1374.</td>
</tr>
<tr>
<td>Convert Audio Sample Rate</td>
<td>Select this option to convert any sample rates not set in the Sample Rate menu in the Main tab in the Audio Project Settings window. For information on setting the sample rate, see “Changing the Audio Sample Rate for Sequences and Audio Clips” on page 835.</td>
</tr>
<tr>
<td>Target Audio Sample Rate</td>
<td>Select a sample rate for the sequence.</td>
</tr>
<tr>
<td>Convert Audio Bit Depth</td>
<td>Select this option to convert any sample rates not set in the Sample Rate menu in the Main tab in the Audio Project Settings window. For information on setting the sample rate, see “Changing the Audio Sample Rate for Sequences and Audio Clips” on page 835.</td>
</tr>
<tr>
<td>Target Audio Bit Depth</td>
<td>Select either 16 bit or 24 bit.</td>
</tr>
<tr>
<td>Convert Audio Format</td>
<td>Select this option to convert the audio to the target audio format.</td>
</tr>
</tbody>
</table>
7. Click Consolidate in the lower right corner.

The Copying Media Files dialog box opens.

8. Select an option for how you want your clips to link to the new media.

If you want to keep your AMA clips linked to the original source, select the option “Keep Master clips linked to media on the original drive.”

For more information, see “Consolidating Media” on page 477.

9. Click OK.

Your Avid editing application creates new media files and new clips which are linked according to your selection.

Another way to back up media files is to copy them directly onto another hard drive by using the Windows desktop or the Macintosh desktop. You cannot, however, take advantage of the storage-saving features of the Consolidate command, and it is more difficult to identify particular media files when searching directly through folders.

Do not make copies of media files from the Windows desktop or the Macintosh desktop while your Avid editing application is running. Also, do not keep duplicate copies of media files online; either delete the originals, take the backups offline, or store the backups in a folder with a different name.
Using the Transcode Command

The Transcode option in the Consolidate/Transcode dialog box lets you create new clips and new media files that use a different resolution. If you have a sequence composed of clips that use different resolutions, you can use the Transcode feature to create a sequence in which all clips use a single resolution. The Transcode option also lets you convert from OMF to MXF, and from MXF to OMF, except in HD projects where MXF is the only available format.

The transcode option does not apply to a data clip.

For information to prepare a RED clip for transcode, see “Preparing your RED Clip for Transcode, Mixdown, or Render” on page 451.

Even if you change the resolution to a higher quality resolution, your footage will not look better than the resolution you selected for capture. For example, if you capture your video at 20:1 to save space and then transcode the sequence to 1:1, the sequence will not look uncompressed.

New clips created through the Transcode operation are in the project format. When you transcode a clip across formats, for example if you transcode a 16:9 clip in a 4:3 project, the Reformat bin setting determines how the clip is conformed to the new format. For more information, see “Modifying the Reformat Attribute for a Clip” on page 605.

To use the Transcode option:

1. Select a clip or sequence in a bin.
2. Select Clip > Consolidate/Transcode.

If you have any compressed audio (MP2 audio) in the clip or sequence you selected to consolidate or transcode, a message appears informing you that selected items contain MP2 audio and cannot be consolidated or transcoded. You should relink this MP2 audio to an uncompressed audio format. If you do not relink to an uncompressed audio format, the selected clip or sequence with the MP2 audio is skipped.

The Consolidate/Transcode dialog box opens.
3. Select Transcode in the upper left corner.

4. In the Target Drive(s) area, select a drive or drives.

5. In you are an Interplay environment, with Dynamic Relink enabled, select whether or not to create new master clips for the transcoded media.

   For more information, see “Understanding How Clips are Associated with Multiple Resolutions” on page 1333.

6. Click the Target Video Resolution menu, and select a video resolution.

   \textit{If your project uses an HD resolution, you cannot select OMF as a file format. MXF is selected by default.}
7. Select the appropriate options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video and audio on same drive(s)</td>
<td>Select to store the transcoded media files on the same target drive. Deselecting this option lets you select separate drives for the audio and video media files.</td>
</tr>
<tr>
<td>Handle length n frames</td>
<td>If you are transcoding subclips or sequences, type a handle length for the new clips, or accept the default: leave it at 60 frames (NTSC) or 50 frames (PAL). The handle length is the number of frames outside the IN and OUT points that you can use for dissolves and trims with the new, shorter master clips.</td>
</tr>
<tr>
<td>Create new sequence(s)</td>
<td>Select this option to create a new sequence from the transcoded clips.</td>
</tr>
<tr>
<td>Create new clips</td>
<td>In an Interplay environment, with Dynamic Relink enabled, select this option to create new master clips for the transcoded media. If you do not select this option, the existing master clip is associated with both the original media file and the transcoded media file. For more information, see “Understanding How Clips are Associated with Multiple Resolutions” on page 1333.</td>
</tr>
<tr>
<td>Convert Video</td>
<td>Select this option to convert the video to the target video resolution.</td>
</tr>
<tr>
<td>Target Video Resolution</td>
<td>Select a video resolution for the sequence.</td>
</tr>
<tr>
<td>Include reformatted clips already at target resolution</td>
<td>Select this option if you want to include reformatted clips in the sequence that are already at the target video resolution. Your Avid editing application does not normally transcode clips in a sequence that are already at the target video resolution. However, you might want to include reformatted clips at the target resolution to preserve the reformatting.</td>
</tr>
<tr>
<td>Convert Audio Sample Rate</td>
<td>Select this option to convert any sample rates not set in the Sample Rate menu in the Main tab in the Audio Project Settings window. For information on setting the sample rate, see “Changing the Audio Sample Rate for Sequences and Audio Clips” on page 835.</td>
</tr>
<tr>
<td>Target Audio Sample Rate</td>
<td>Select a sample rate for the sequence.</td>
</tr>
<tr>
<td>Convert Audio Bit Depth Conversion</td>
<td>Select this option to convert the audio to the target bit depth.</td>
</tr>
</tbody>
</table>
8. Click Transcode in the lower right corner.

Your Avid editing application creates new media files and clips, according to your selections.

Consolidate or Transcode AMA Clips Only

The editing application allows you to consolidate or transcode just the AMA clips in a sequence. Access the Consolidate/Transcode window and select Consolidate/Transcode only AMA linked media.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description (Continued)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Target Audio Bit Depth</strong></td>
<td>Select either 16 bit or 24 bit.</td>
</tr>
<tr>
<td>Convert Audio Format</td>
<td>Select this option to convert the audio to the target audio format.</td>
</tr>
<tr>
<td><strong>Target Audio Format</strong></td>
<td>Select either OMF (WAVE), OMF (AIFF-C), or MXF (PCM) audio format.</td>
</tr>
<tr>
<td></td>
<td>See “Audio Projects Settings: Main Tab” on page 1438.</td>
</tr>
</tbody>
</table>

Background Consolidate and Transcode

Background consolidate and transcode functionality provides you with the ability to consolidate and transcode clips of any supported resolution or AMA format as a background operation, allowing you to continue working on your editing project while the transcode progresses.
Once you start a consolidate or transcode operation, selected master clips, subclips, and sequences appear in your bin as offline media. As the job progresses, you can monitor and manage the consolidate or transcode process in the Background Queue Window. Once completed, the offline media automatically link to the new formats and then you can begin to work with them in your project.

You cannot use background consolidate or transcode if you have installed the components for Media Composer | Cloud. If you work with a Media Composer | Cloud configuration, remote upload automatically consolidates and transcodes clips in the background, but this functionality only applies when you upload media clips to Interplay remotely. All other consolidate and transcode operations occur in the foreground as you work on your editing project.

The Background Queue Window

You can use background consolidate and transcode to modify clips, subclips, and sequences stored on your system. The operation consolidates your media and saves it to a specified drive, or the operation transcodes your media to the resolution specified in the Consolidate/Transcode dialog box.

While the operation progresses, the consolidated or transcoded clips appear in your bin as offline media. When the operation completes, a new clip or sequence appears in the bin with the file name extension .new that is linked to the new media file. You can view the online media by one of the following methods, depending on your system configuration:

- If you work in a standalone configuration, refresh the media database.
- If you work in an Interplay or shared storage configuration, enable dynamic relink.

The Background Queue Window dialog box displays the status of all media selected for background transcode operations.
### Element Description

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1 Tool menu | Provides options for the Background Queue Window:  
- Clear Inactive Jobs — clears the Background Queue Window of all jobs not currently transcoding.  
- Show Job Groups — allows you to display or hide specific job groups listed in the menu. |
| 2 Clip or Sequence name | Lists either the name of the transcoded sequence above the clips within the sequence or the name of the transcoded clip. |
| 3 Cancel/Resume button | Changes from a Cancel button (for transcode operations) to a Resume button (for suspended transcodes). |
| 4 Progress bar | Displays the percentage of the transcode and transcoding processes that have completed. |
| 5 Priority menu | Sets or modifies the priority level assigned to a transcoded clip or sequence. Options are High Priority, Normal Priority (default), Low Priority. The priority level affects which clips get transcoded first. |
| 6 Completed icon | Indicates that the transcode operation has completed successfully. |
Using Background Consolidate and Transcode

You can set your consolidate or transcode options in the Consolidate/Transcode dialog box. For more information, see “Using the Consolidate Command” on page 479 and “Using the Transcode Command” on page 483.

To manage background transcode with the Background Queue window:

1. Select a master clip, subclip, or sequence, and then select Clip > Consolidate/Transcode. The Consolidate/Transcode dialog box opens.

2. Select Transcode, and then select Run in background, and then click Transcode.

3. Select Tools > Background Queue Window. The Background Queue Window opens and displays all current jobs.
4. (Option) If you consolidate or transcode multiple clips and want to change the priority of one or more clips — for example, to transcode the most important clips first — click the Priority menu and select one of the following:

- High Priority
- Normal Priority
- Low Priority

You can change the priority of your consolidate or transcode jobs at any time during the operation. Changing the priority does not affect an consolidate or transcode operation currently in progress.

**Loading the Media Database**

The media database is a catalog of master clips and precomputes stored on a media drive. One use of the media database by your Avid editing application is to display master clips and precomputes in the Media tool.
The information in this topic applies only to media on local drives or on unmanaged shared storage drives. The information does not apply to shared storage managed by Avid Interplay. For more information, see the Interplay documentation.

Bins contain references to media files based on the contents of the bin. Your Avid editing application does not maintain the entire database in memory at all times. Instead, it builds up a partial database for the bins that have been opened in the current session to preserve as much memory as possible for editing.

If you store the master clips and the edited sequences for a project in separate bins, you need to load the entire database to relink clips to their media files in the following two cases:

- **Recapturing:** When you recapture the master clips while the sequences bin is closed, quit and restart your Avid editing application, and open the sequences bin only—the sequences might appear to be offline.
- **Consolidating:** When you consolidate the master clips and relink them to the consolidated media while the sequences bin is closed, quit and restart your Avid editing application, and open the sequences bin only—the sequences might appear to be offline.

**To update the offline sequences with the new media files:**

- Select File > Load Media Database.
  
  Your Avid editing application loads all online master clips and precomputes.

You do not need to load the media database more than once during a single editing session because the database remains in memory until you quit your Avid editing application or restart your system.

If a bin continues to display the message “Media Offline” after loading the media database, either the media files are missing or the links have been broken. For more information, see “Relinking Media Files” on page 494.

### Refreshing Media Directories

Each media folder (OMFI MediaFiles and Avid MediaFiles) includes database files for the media in that folder. The Refresh Media Directories command reexamines all the media folders (directories) on the system and determines whether any of the files are out of date and need to be rebuilt. If so, it tells your Avid editing application to rebuild the files.

The information in this section applies only to media on local drives or on unmanaged shared storage drives. The information does not apply to storages (local or shared) that are managed by Avid Interplay. For more information, see the Interplay documentation.
You should refresh the media directories after you add or remove media from the media drives. For example, after you have physically moved drives). If you physically add a drive, use the Mount All command. See “Mounting and Unmounting Drives” on page 471.

Refreshing media directories can take a long time to execute on systems that have large amounts of media online.

To refresh media directories:
- Select File > Refresh Media Directories.

Deleting Unreferenced Clips and Media

Unlike the bin files stored in project folders, media files require considerable storage space. When you finish either a rough cut or a final version of a sequence, you can quickly free storage space by deleting the media and clips that are not referenced by the sequence. You perform this procedure only on clips selected in bins.

To quickly view remaining storage on your media drives at any time:
- Open the Hardware tool as described in “Using the Hardware Tool” on page 135.

To delete all unreferenced clips and media files:
1. Select the sequence in the bin.
2. Select Bin > Select Sources.
   All source clips for the sequence are highlighted in the bin.
3. Click the bin containing the highlighted clips to activate it.
4. Select Bin > Reverse Selection.
   All the clips in the bin that are not source clips for the sequence are now highlighted.
5. Press the Delete key, and then click the check boxes in the Delete dialog box to select the clips or the media files to delete.
6. Click OK.
   The selected clips and media files are deleted.
Backing Up Media Files

The OMFI MediaFiles folders and the Avid MediaFiles folders on your media drives contain the individual media files created when you captured source material. The OMFI MediaFiles folders contain the OMF media files. The Avid MediaFiles folders contain the MXF media files.

The options for backing up media files include:

- Using the Consolidate feature, as described in “Consolidating Media” on page 477, to make copies of selected media files on a target media drive connected to the system or for transfer to another system.
- Backing up smaller projects captured at low video resolutions to a removable storage device, such as a hard drive.
- Archiving larger media files and folders to a network storage device.
- Backing up to videotape (interlaced media only). For more information, see “Archiving and Restoring Media Files to Videotape” on page 503.

For information on system archiving procedures, see your Windows documentation or Macintosh documentation.

Finding a Related Media File

The Reveal File command lets you select a clip in a bin and automatically open its related media file. This command is useful if you want to delete, move, or label the media file.

To find a related media file:

1. Select the clip in a bin for which you want to find the media file.
   The clip is highlighted.
2. Select File > Reveal File.
   The system searches all available drives, opens Windows Explorer or the folder (Macintosh), and highlights related media files.
Relinking Media Files

Sometimes, after you consolidate or move material between systems, the clips or sequences lose their links to the original media files. When a clip becomes unlinked, it displays the message “Media Offline.” If appropriate media exists online, you can use the Relink command to reestablish the link.

*In an Avid Interplay environment, relinking through the Relink dialog box is limited to non-master clips (subclips and sequences). For more information, see “Using the Relink Dialog Box in an Avid Interplay Environment” on page 1356.*
When you select subclips or sequences and select the Relink command, the system searches for master clips that contain the same material included in the selection. If you relink online media, the system searches for media clips that best match the options selected in the Relink dialog box.

You can relink master clips to appropriate media files or to source tapes with compatible rates, and you can relink based on resolution. You can also relink sequences to imported or linked AMA master clips. The system compares information such as source tape name, source file name, timecode information, and channels captured. If the search is successful, the system establishes new links to the available media files. You can instruct the system to search specific drives or all available drives.

To maintain the original capture settings for a subclip or sequence, use the Batch Capture command; do not use the Relink command.

If you relink a sequence and the bin that stores the AMA (Avid Media Access) referenced clips is closed, the media does not relink. Before you relink, open the bin of the referenced clips. For information on AMA, see “The Avid Media Access (AMA) Workflow” on page 394.

To relink master clips, subclips, or sequences:

1. Select the unlinked object or objects in the bin.
2. Select Clip > Relink.

   The Relink dialog box opens.
3. Select options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Relink selected items to:</strong></td>
<td></td>
</tr>
<tr>
<td>Media on drive:</td>
<td>All Available Drives: Searches across all media drives that are online</td>
</tr>
<tr>
<td></td>
<td>A specific drive volume: Relinks to media on a specific media drive</td>
</tr>
<tr>
<td>Master clips</td>
<td>Relinks master clips to the appropriate media</td>
</tr>
<tr>
<td>All other items</td>
<td>Relinks non-master clips (sequences, subclips, group clips, and other clips) to the appropriate media</td>
</tr>
<tr>
<td>Relink only to media from the current project</td>
<td>Restricts relinking to the current project.</td>
</tr>
<tr>
<td>Selected items in ALL open bins</td>
<td>Allows you to select multiple clips across multiple bins.</td>
</tr>
<tr>
<td>Allow relinking to offline items</td>
<td>Allow relinking to offline elements: Relinks to clips that are offline. All available drives are searched regardless of the setting for “Relink to media on volume.”</td>
</tr>
<tr>
<td><strong>Relink by:</strong></td>
<td></td>
</tr>
<tr>
<td>Timecode</td>
<td>Allows you to relink to Start, Aux TC1-TC5, or Sound Timecode.</td>
</tr>
<tr>
<td>Source Name</td>
<td>Allows you to relink to a number of relink options: Tape Name or a Source File ID, Tape Name or Source File Name, Keynumber, Name, Camroll, Labroll, Disk Label, More. Click the More option to see the list of additional column name options.</td>
</tr>
<tr>
<td>Ignore extension</td>
<td>If selected, the system compares names and ignores extensions (for example, File1.jpeg can be relinked to File1.png)</td>
</tr>
<tr>
<td>Ignore characters after last occurrence</td>
<td>Select this option to have the system ignore the characters in the name after the last occurrence of the text you enter.</td>
</tr>
<tr>
<td>Match case when comparing tape and source file names</td>
<td>Makes tape name and source file name search case sensitive.</td>
</tr>
</tbody>
</table>
### Video Relink Parameters

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Relink to:</strong></td>
<td>Video format of current project only: Restricts relinking to the current video format (listed in the menu option).</td>
</tr>
<tr>
<td></td>
<td>Any HD video format: Restricts relinking to HD formats only. Relinking searches for any available HD formats.</td>
</tr>
<tr>
<td></td>
<td>Any SD video format: Restricts relinking to SD formats only. Relinking searches for any available SD formats.</td>
</tr>
<tr>
<td></td>
<td>Any video format: Relinks to any available high-resolution, HD and SD formats.</td>
</tr>
<tr>
<td><strong>Relink method:</strong></td>
<td>Highest Quality: Relinks to the highest quality clip; for online work.</td>
</tr>
<tr>
<td></td>
<td>Most Compressed: Relinks to the most compressed clip; for offline work.</td>
</tr>
<tr>
<td></td>
<td>Specific Resolution: Relinks to clips of a specific resolution. See “Relinking by Resolution” on page 499.</td>
</tr>
<tr>
<td><strong>Relink if quality:</strong></td>
<td>If you select Specific Resolution as a relink method, this menu lets you specify the range of the relink search:</td>
</tr>
<tr>
<td></td>
<td>Is greater than or equal to: If the selected resolution is not available, then the nearest resolution that is better (more pixels, less compression) than the requested one and that has the closest video format (image size, field topness) is used.</td>
</tr>
<tr>
<td></td>
<td>Is equal to: If the selected resolution is not available, the clip is displayed in the “If no match is found” list.</td>
</tr>
<tr>
<td></td>
<td>Is less than or equal to: If the selected resolution is not available, then the nearest resolution that is less (fewer pixels, more compression) than the requested one and that has the closest video format (image size, field topness) is used.</td>
</tr>
<tr>
<td><strong>Format</strong></td>
<td>Lets you select a target project format for relinking. The selected format is used for quality comparison; you specify the relink format in the “Relink to” parameter.</td>
</tr>
<tr>
<td><strong>Resolution</strong></td>
<td>Lets you select a target resolution for relinking. The selected resolution is used for quality comparison; you specify the relink resolution in the “Relink method” parameter.</td>
</tr>
</tbody>
</table>
Relinking Media Files

4. Click OK.

   The system searches the selected media drives, and relinks clips and sequences if possible. The system disregards audio sample rate when matching media files.

Relinking by Resolution

You can relink to clips of a specific resolution.

*In an Avid Interplay environment, you can use dynamic relinking to easily switch between resolutions. For more information, see “Using MultiRez and Dynamic Relink” on page 1327.*

**To relink a clip by resolution:**

1. Select the object or objects in the bin that you want to relink.
2. Select Clip > Relink.
   
   The Relink dialog box opens.
3. Select Relink Method > Specific Resolution.
4. Select an option from the “Relink if quality” menu.
5. Select a project format from the Format menu.
6. Select a resolution from the Resolution menu.

   The default resolution is determined by the current Media Creation setting for Capture. See “Media Creation Settings” on page 1512. If you select a different resolution in the Relink dialog box, the Media Creation setting does not change.
7. If you selected Specific Resolution as your Relink method, Select one of the following:
Use Existing Media — displays the media to which the clips are currently linked
- Unlink (Take Offline) — unlinks the clip and displays the message Media Offline

If you are working in an offline resolution and want to capture in a higher resolution, select Unlink to ensure that you recapture all the media at the higher resolution. You can check for offline media in the Timeline by displaying offline clips in a distinct color. For more information, see “Displaying Clip Colors in the Timeline” on page 667.

8. Select other Relink options as described in “Relinking Media Files” on page 494.

9. Click OK.

The system searches the selected media drives, and relinks clips and sequences if possible.

**Relinking to Selected Clips**

You can also use the Relink command for connecting subclips or sequences to selected master clips and subclips.

**To relink to selected master clips and subclips:**

1. Move the subclips or sequences that you want to relink into the bin containing the clips.
2. Select the clips targeted for relinking.
3. Select Clip > Relink.

   The Relink dialog box opens.

4. Select “Relink all non-master clips to selected online items” to relink related subclips or sequences to the highlighted clip in the bin.

5. Click the “Relink to media on volume” menu, and select an option:
   - Select All Available Drives to search across all media drives that are online.
   - Select a specific drive volume if you know the location of the media or if you want to relink to media on a specific media drive.

6. (Option) Select “Relink only to media from the current project.”

7. (Option) Select “Match case when comparing tape names.”

8. Click OK.

   The subclips or sequences are linked to the selected clips or subclips.

**Relinking Tape and File Based Media**

You can relink between imported and AMA linked media and captured tape based media. Usually you can only relink between clips with the same source file name or clips with the same tape name. By selecting the “Allow relinking between tape and file media” option, the system can relink by comparing the tape name to the source file name or the source file name to the tape
name. The tape name is treated like a file name when it is compared to the source file name. For example, a clip with the tape name File1.jpg can be relinked to a clip with the source file name File1.png.

Make sure that the tape name and the source filename matches exactly, minus the file extension and the version separator, before you relink. Since some third-party transcoding applications only accept a specific file name character limit, your tape name could get changed without you realizing it when you bring the file into the Avid editing system. If you plan on relinking the file, Avid recommends you change the tape name in the third-party application (to match the tape name to the source file name) before you bring the file into the Avid editing system.

**To relink tape and file based media:**

1. Select the sequence.
2. Select Clip > Relink.
   
   The Relink dialog box opens.
3. Select “Allow relinking of Imported/AMA clips by Source File name.”
4. Select “Allow relinking between tape and file based media.”
5. Click OK.

   The clips are relinked to the original media files.

**Relinking Consolidated Clips**

If the appropriate media exists online, you can reconnect consolidated clips, subclips, or sequences to the new or old media files.

For example, if you consolidated a sequence and forgot to create a duplicate, and later decide to use the original media files instead of the consolidated media files, you can break the new link and reestablish the old link to the original files.

Because subclips and sequences do not point directly to the media files, you can perform this procedure only by using the source master clips.

**To relink consolidated subclips or sequences:**

1. Select the new master clips for a consolidated subclip or sequence (the clips have the file name extension .new), and unlink them.
   
   For information on unlinking, see “Unlinking Media Files” on page 502.
2. Select Clip > Relink.
   
   The Relink dialog box opens.
3. Select “Relink offline master clips to online media files” to relink master clips to media files that share similar database information.

4. Click the “Relink to media on volume” menu, and select a specific drive volume that contains the original media files.

5. (Option) Select “Relink only to media from the current project.”

6. (Option) Select “Match case when comparing tape names.”

7. Click OK.

The clips are relinked to the original media files.

**Relinking Moved Projects**

If you move projects between systems with similar media existing at each site but captured separately, your clips and sequences display the message “Media Offline.” You can use the Unlink and Relink commands to reconnect the files at either site.

For example, if you have a project that requires sharing work between two different sites, you can capture the source material once at each site and exchange only the project folder at each stage, rather than move large media drives back and forth. The project folder can be exchanged on floppy disks or instantly across a network. Because the media files maintain slightly different parameters at each site, you must relink the material each time.

**Unlinking Media Files**

You can use the Ctrl and Shift keys to modify the Relink command for unlinking clips from their media files.

*Because subclips and sequences do not point directly to the media files, you can perform this procedure only by using the source master clips.*

**To unlink master clips from their current links:**

1. Select the master clips to unlink.

2. Depending on your operating system, do one of the following:
   - (Windows) Ctrl+Shift+Right-click the clips and select Unlink.
   - (Macintosh) Using a multi-button mouse: Press and hold Cmd+Shift and Right-click the clips and select Unlink, or select Clip > Unlink from the main menu.
   - (Macintosh) Using a standard mouse: Press and hold Cmd+Ctrl+Shift and click the clips and select Unlink, or select Clip > Unlink from the main menu.

The clips are unlinked and display the message Media Offline.
To enable the Right-mouse button functionality on a multi-button mouse, see your Macintosh documentation.

3. (Option) If you have similar material from different sources, you can duplicate a set of clips, unlink the duplicates, and then modify the sources of the duplicates before capturing the new source material.

For example, if you are working with multicamera material, you can capture one reel, duplicate the clips several times, unlink the duplicated clips, and rename their source tapes to batch capture the remaining reels.

Archiving and Restoring Media Files to Videotape

You can archive to videotape the source media associated with sequences, master clips, subclips, and group clips. Archiving the source media to videotape is similar to recording a digital cut, except that you can reedit the sequence after you restore it.

The archive to videotape process is not available with progressive media projects.

You can use the archiving process to:

- Archive completed projects that you can restore at a later date if you need to reedit the project.
- Provide more space on the media drives for a new project.
- Create backups of your project files.
- Move a project to another workstation.

When you archive a project, the source media files are archived to videotape, and then you save the project files. For information about saving the project files, see “Backing Up Your Project Information” on page 81. You can reconstruct your project with the archived files and your source tapes.

The media files experience generation loss when the media is archived and restored because the target videotape format might include some compression.

The archiving process divides the archive into multiple archive sequences based on the lengths of the available videotapes. The archiving to videotape process adds handles to the new clips that let you reedit the sequence after you restore the media files from the videotape.

During the archiving process, the original media is archived to videotape. Media with effects is not recorded to tape because you can easily re-create the effects after the project is recaptured. However, the handles for transition effects are included in the archive file. The final sequence can be linked to the recaptured media to recreate the project.
Archiving and Restoring Media Files to Videotape

Each archived master clip is stamped with the archive tape name and archive timecodes during the restore process. The original source information on the master clips remains unchanged.

Archiving Media Files

Before archiving your media files to videotape, you must stripe the record tapes (record black and timecode for approximately 15 seconds after the bars and tone on the tape). For information about preparing record tapes, see “Preparing Record Tapes” on page 1075.

To archive a video project's media files:

1. Set up the Digital Cut tool as follows:
   a. Select Output > Digital Cut.
      The Digital Cut tool opens.
   b. Click the Deck Selection menu, and select a deck.
   c. If the Select Tape dialog box opens, click Cancel to leave Tape Name unspecified.
   d. (Option) Select the Custom Preroll option, and select the number of seconds to indicate how many seconds the tape will roll before the archiving process starts. This option overrides the Preroll setting in the Deck Settings dialog box.

2. Create a new bin for the archive, and name the bin.
   For example, you can name the bin Archive.

3. Duplicate the sequences and clips you want to archive.

4. Drag the appropriate duplicate sequences and clips to the Archive bin.

5. Select the clips and sequences to archive from the Archive bin by doing one of the following:
   - Select Edit > Select All to select all the clips and sequences in the bin.
   - Ctrl+click (Windows) or Command+click (Macintosh) to select specific clips or sequences.

6. Select Clip > Archive to Videotape.
   The Archive to Videotape dialog box opens.
7. Select the appropriate options.

If the clips or sequences that you want to archive are not highlighted in the active bin, Archive to Videotape appears dimmed in the Clip menu.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Archive Name</td>
<td>Type a name for the archive in the Archive Name text box. ProjectArchive is the default name. The archive name is numbered incrementally beginning with 001 to indicate the order of the tapes.</td>
</tr>
<tr>
<td>Start Timecode</td>
<td>Type a value in the Start Timecode text box to set the starting timecode of the archive on the videotape. By default, the start timecode is set to 01:00:00:00.</td>
</tr>
</tbody>
</table>

**For Subclips and Sequences:**

- **Use handles**
  - Select this option, and in the Handle Length text box type the number of additional frames you want to archive at the heads and tails of the new master clips. This option provides enough overlap for trimming and adding transition effects.

- **Archive entire master clips**
  - Select this option if you want to archive entire master clips.

**For Sequences:**

- **Archive all clips in a group edit**
  - Select this option if you selected a sequence that contains group clips and you want to archive the media for all the clips in the group.

8. Click OK.

The Tape Lengths dialog box opens.
The Archive Length area displays the calculated length of time required for archiving the media files. The archiving process might require more time than indicated because individual clips are not divided between tapes.

9. Under the “Enter the quantity of tapes available for the archive” area, do one of the following:

- Type the number of blank videotapes needed for the archive next to the length of time of your blank tapes. For example, if the archive length is 2 hours and 15 minutes, and you have 30-minute videotapes, you would type 5 in the 30 Minutes text box.
- Type a custom tape length in the Custom text box, and type the number of available blank videotapes.

The archiving process uses the tapes in the order listed in the Tape Lengths dialog box. For example, if you type 10 in the 120 Minutes text box and 5 in the 60 Minutes text box, when you start the archive your Avid editing application prompts you for each of the ten 120-minute tapes before using the five 60-minute tapes.

10. Click OK.

The Digital Cut tool opens and becomes the active window.

11. Follow the instructions displayed in the message boxes to complete the archiving process.

A set of archive sequences is created in the Archive bin, and the source media is output to the videotape. One archive sequence is created for each tape. When needed, the system prompts you for another blank tape. The tapes are requested in the order that they appear in the Tape Lengths dialog box.

When the system finishes creating the archive, a message box notifies you that the process is complete.
Restoring an Archive from Videotape

Restoring an archive from videotape is similar to performing a batch capture. The archiving process creates new master clips for sequences. During the restore process, each archived master clip is stamped with the archive tape name and archive timecodes. The original source information on the master clips remains unchanged.

After restoring an archive, any links to the original master clips are broken, and only the sequence and its new master clips are linked to the newly captured media files.

To restore an archive from videotape:

1. Copy the project files to the Avid Projects folder.
   
   For information about the location of the Avid Projects folder, see “Avid Projects and Avid Users Folders” on page 72.

2. Open the project in your Avid editing application.

3. Open the archived bin.

4. Select Tools > Capture, and set the following options in the Capture tool:
   
   a. Click the Deck Selection menu, and select a deck.
   
   b. If the Select Tape dialog box opens, click Cancel to leave Tape Name unspecified.
   
   c. Click the Res (Resolution) menu, and select a resolution.
   
   d. Click the Target Drive menu, and select a drive volume.

   For more information about setting up the Capture tool, see “Setting Up the Capture Tool” on page 194.

5. Select the archived sequences, original sequences, and original clips.

   If you select only the archived sequences, the media is restored during the restore process, but the new media is not relinked to your original clips.

6. (Option) To relink the new media to the original clips, select the original clips and repeat the restore process.

   Repeating the restore process relinks only the selected items to the new media files.

7. Select Clip > Restore from Videotape.

   The Restore from Videotape dialog box opens.

8. (Option) If you are repeating the restore process, select “Restore only those items for which media is currently unavailable.” Otherwise, deselect this option.

9. Click OK.

   The Capture tool becomes the active window.

10. Follow the instructions displayed in the message boxes to complete the restore process.
Your Avid editing application recaptures the archived sequences and clips, and relinks the selected clips and sequences to the new master clips.

11. Batch import any graphics and render all non-real-time effects.

For information about batch import, see “Reimporting Files” on page 334.

Sequence and Clip Information Summary

You can generate a report to display information about the contents of a sequence. For example, you can generate a list of the types of effects in your sequence or the location of a particular effect. You can also create a clip summary or a source summary. This allows you to display a list of clip names, tape names, offline clips, and path locations of imported clips contained in your selection.

You generate reports from the Sequence Report dialog box, which you can access from the Source monitor, the Record monitor, or directly from a sequence in a bin. The Sequence Report dialog box allows you to select your criteria and create a report that displays in a text editor. You can then search the summary for the exact information you want.

Example 1: Preparing for Online Editing

When you move your sequence from an offline system to an online system, you can run an effect summary and a source summary report. The Effect Summary displays a list of all effects, including a separate list of plug-ins used. The Source Summary lists all the tapes you need for recapture and all of the import paths for imported graphics.

Example 2: Finding Specific Effects

You use the Effect Summary and Effect Location List to find a particular effect. When you output the summary to a text editor, you can search the report to find all occurrences of the particular effect. In addition, you can type the start or end timecode value for each occurrence into the Source/Record monitor to go to the start of the effect in the Timeline. You might find this useful when you need to replace or modify a specific plug-in, for example.

Example 3: Plug-in Information

An Effect Summary displays a list of effects found in the selection, including how many times the sequence uses an effect. For plug-ins loaded on your system, a section displays a summary of the plug-ins used, displaying the name, the vendor, the version and the ID of the plug-in. This can help by providing a list of the plug-ins needed for online work.
If a plug-in is not loaded on your system when you generate the summary, if you select the option "Show Missing Effects Only" from the Sequence Report dialog box, the information displays "unavailable effect," in addition to the plug-in name, the plug-in ID (is this gone?), and other information associated with the effect. (Is the vendor and version number displayed). This is helpful when identifying the effect.

Creating a Summary of Effects and Source Information

Before you use the Sequence Report dialog box to create a summary of effects, source information, or clip information, you might want to do the following:

- Determine if you want the report to cover specific tracks or a section of the sequence between In and Out points. Loading a sequence in the Source/Record monitor before you generate a report allows you to select which part of the sequence about which you want information.
- Choose the summary options you want information on — types of effects, location of effects, source information, or clip information.

You can modify the sequence name and the starting timecode in the Sequence Report dialog box.

To generate a summary report:

1. Do one of the following:
   - From a bin, right-click a sequence and select Sequence Report. You can select multiple sequences for generating reports.
   - With a sequence loaded in a monitor, right-click the monitor and select Sequence Report.

The Sequence Report dialog box opens.
2. (Option) Do the following:
   - If you selected specific tracks, click Enabled Tracks Only.
   - If you set In and Out points, click Use Marks.

   If you want to run a report on the entire sequence regardless of tracks or marks, do not select either of these options.

3. Select the Summary Info options you want to include in your report. For information on report options, see “Summary Information Options” on page 511.

4. Click Generate Report.

   The Save Summary Output File As dialog box opens.

5. Use the default file name or rename the report and choose a folder to save the report to, click Save.

   If you select more than 8 sequences, a dialog box asks if you want to generate sequence reports for all selected items.

   The application writes the report to a text file and opens a text editor.
# Summary Information Options

The following options allow you to select which information to include in the sequence report.

<table>
<thead>
<tr>
<th>Summary Option</th>
<th>Suboption</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Effect</td>
<td>Summary</td>
<td>This displays the types of effects and how many were found in your sequence, the breakdown by effect type, and an effect plug-in summary. If you have selected individual tracks or selected IN and OUT points, only those effects that fall within those parameters appear.</td>
</tr>
<tr>
<td>Create Effect</td>
<td>Location List</td>
<td>This displays the location of an effect. Depending on the criteria you selected, this displays track, start timecode, end timecode and effect name.</td>
</tr>
<tr>
<td>Skip Non-Renderable Effects</td>
<td></td>
<td>Select this option if you do not want any non-renderable effects, such as pan/volume effects, to appear in the report.</td>
</tr>
<tr>
<td>Skip Relationship-Only Color Correction</td>
<td></td>
<td>Select this option if you do not want any color correction effects with only relationships to appear in the report.</td>
</tr>
<tr>
<td>Show Nested Effects Only</td>
<td></td>
<td>Select this option if you want to only display the nested effects in your sequence. Effects that are nested inside of other effects show the parent effect track they are applied to with the track name in parentheses and indented to show the nesting relationship.</td>
</tr>
<tr>
<td>Show Missing Effects Only</td>
<td></td>
<td>Select this option if you want to only display the plug-in effects missing from your sequence. Plug-in effects that are missing in your sequence display as “Unavailable Effect,” but also lists the type of effect and other important information which help you identify the type of effect. This option is helpful when you move your sequence to a system that does not have the plug-in installed.</td>
</tr>
</tbody>
</table>
Create Clip Summary or Create Source Summary

- **Offline Only**: Select this option if you want to display offline clips and/or sources only.
- **Skip Non-Selected Clips in Group Clips**: Select this option if you do not want any non-selected clips inside of a group clip to appear in the report.
- **Show Globally Unique Identifier (UID)**: Select this option if you want to display the unique identifiers (Mob IDs) associated with the clips and sources in your sequence.
Before you begin editing, you can review your footage, add markers and comments to clips, mark IN to OUT points, and create subclips. By viewing and marking your material in advance, you can concentrate on editing and refining your sequence at a later time without having to pause and set marks each time you load a new clip. Techniques for playing back, viewing, and subcataloging clips are described in the following topics:

- Viewing Methods
- Customizing the Composer Window and Monitors
- Using the Info Window
- Using the Timecode Window
- Playing Video to the Client Monitor
- Activating and Deactivating the Client Monitor Display
- Selecting the Video Display Settings
- Playing Video to a Full-Screen Monitor
- Adjusting the Play Delay Offset
- Using the Tool Palette
- Playing Selected Clips in a Loop
- Loading and Clearing Footage
- Controlling Playback
- Playing Back to a DV Device
- Video Quality Options for Playback
- Setting the Video Quality for Playback
- Marking and Subcataloging Footage
- Using Markers
- Finding Frames, Clips, and Bins
Viewing Methods

You can work with clips and sequences in several ways, depending on your needs and preferences. Each method has its own uses and advantages, as described in the following table:

<table>
<thead>
<tr>
<th>Viewing Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>In bins</td>
<td>You see pictorial images of the clips in your bins by using Frame or Script view and can play the clips in the bin. For more information, see “Using Frame View” on page 346 and “Using Script View” on page 348.</td>
</tr>
<tr>
<td>In the Source monitor</td>
<td>You can load clips and sequences into the Source monitor to view and mark or subcatalog shots for use in a sequence that you build in the Timeline. For more information, see “Loading and Clearing Footage” on page 530.</td>
</tr>
<tr>
<td>In the Record monitor</td>
<td>You can load a sequence into the Record monitor to view, mark, or modify an existing sequence. You can load a series of clips into the Record monitor to create an instant sequence (rough cut). For more information, see “Loading and Clearing Footage” on page 530 and “Creating an Instant Rough Cut” on page 589.</td>
</tr>
<tr>
<td>In pop-up monitors</td>
<td>You can load several clips into pop-up monitors to view and mark clips in smaller, movable windows. For more information, see “Loading and Clearing Footage” on page 530.</td>
</tr>
<tr>
<td>In the Timeline</td>
<td>Use the Timeline to view individual tracks for either a sequence or a source clip. Click the Toggle Source/Record in Timeline button to switch between displaying the sequence tracks and the source tracks.</td>
</tr>
</tbody>
</table>
Customizing the Composer Window and Monitors

The Composer window is central to the editing process, providing all the essential controls for viewing, tracking, marking, and editing source and record footage. The Composer window includes the Source and Record monitors.

All monitors in your Avid editing application use a display aspect ratio that matches the aspect ratio for the project. For HD projects, this is always 16:9. For SD projects, it is either 4:3 or 16:9. For more information, see “Changing the Aspect Ratio for a Project” on page 604.

To view 16:9 footage on a Client monitor, you need an HD monitor or a 16:9 compatible full-screen NTSC or PAL monitor.

Use the Composer Settings dialog box and the menus within the Composer window to configure various displays and functions. For information on all Composer settings, see “Composer Settings” on page 1454.

Illustrations of the Composer window in this chapter show two button rows, two information rows, and the Center Duration display. You can set this display on the Window tab of the Composer Settings dialog box.
Resizing the Composer Window and Monitors

You can resize the monitors that display your footage in a variety of ways. You can:

- Resize any monitor to provide more area for displaying the Timeline or other windows

*If you are working with a multi-track Timeline, you might want to change the screen resolution to display more information on the screen. See your Windows or Macintosh documentation.*

- Hide the Source monitor and display an enlarged Record monitor for a more detailed view of the media in your sequence

  You can then use a keyboard shortcut to switch between the enlarged Record monitor and the standard size. This configuration is particularly useful during final finishing.

- Hide the video completely, leaving only the controls and information portions of the monitors visible. No video is displayed in the Composer window. Video is still displayed on the Client monitor.

- Hide the controls completely, leaving only the video visible.

- Display data above the monitor as one or two rows of data, or allow the Avid editing application to arrange the data into one or two rows as you resize the monitors.

To resize the Source and Record monitors:

- Drag the lower right or lower left corner (Windows) or lower right corner (Macintosh) of the Composer window to the size you want.

  If you select the Flow Data Dynamically option on the Window tab of the Composer Settings dialog box, the data above the monitors displays in either one or two rows, depending on the size of the Composer window.

To resize a pop-up monitor:

- Click the lower right corner of the monitor and drag it to the size you want.

To switch back to the standard-size Source/Record monitors:

- Select Workspaces > Source/Record Editing.

To hide the Source monitor and enlarge the Record monitor:

1. Press and hold the Alt key (Windows) or Option key (Macintosh) and then click the Source/Record Mode button.

   Only the Record monitor is displayed in the Composer window.

2. Right-click the Record monitor, and select Full Size Video.

To reduce the Record monitor to its standard size:

- Right-click the Record monitor, and deselect Full Size Video.
To toggle between the single Record monitor and the Source/Record monitors:

- Press and hold the Alt key (Windows) or Option key (Macintosh) and then click the Source/Record Mode button.

To hide or display the video in a monitor:

- Right-click the monitor, and select Hide Video.
  The video disappears or reappears. When the video is hidden, the Hide Video command has a check mark beside it.

To hide the controls in a monitor:

1. In the Settings list of the Project window, double-click Composer.
   The Composer Settings dialog box opens.

   ![Composer Settings - Current](image)

   2. In the Button Display at Bottom region, select Off.
   3. Click OK.

**Displaying a Second Row of Buttons**

You can choose to display a second row of buttons under the Source/Record monitors. You can use this row of buttons in the same manner as the top row of buttons.
To display a second row of buttons below the Source/Record monitor:

- Right-click in the Source/Record monitor, and select Composer Settings. Click Two Rows under Button Display at Bottom.

**Displaying Tracking Information**

Tracking information consists of various formats used to identify clips, audio and video tracks, individual frames, or footage durations while you work. Your Avid editing application displays this information above the monitors in the Composer window and in the Timeline window.

Tracking information is updated continuously to reflect your current position in the footage. You can select which information you want to track from the Tracking Information menu (see “Tracking Format Options” on page 519).

![Tracking information in the Composer window.](image)

By default, the tracking information area displays no data until you select a tracking format. There is no display of tracking data when there is no material loaded in the monitor. If you load a clip and no information is currently displayed, you can still open the menu by clicking in the area above a monitor.

**To display tracking information:**

1. Load a clip or sequence into the monitor.
2. Click in the information display area in either the first or second row of information above the monitor to open the Tracking Information menu.
3. Select the type of tracking information you want to display.
If you select the option for two information rows above the monitors in the Composer settings (in the Window tab), you can display two different types of tracking information for the footage in each monitor.

For example, you can display both running timecode and IN to OUT durations for clips loaded in the Source monitor. You can display similar information for the sequence shown in the Record monitor.

To move through footage by entering timecode, make sure the top row of information displays timecode (for example, V1). For more information, see “Using Timecode to Find a Frame” on page 567.

### Tracking Format Options

The Tracking Information menu contains options for information to be displayed above the monitors. The contents of the menu varies, depending on the monitor.

<table>
<thead>
<tr>
<th>Source</th>
<th>None</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source V1:</td>
<td></td>
</tr>
<tr>
<td>Duration</td>
<td>5:28</td>
</tr>
<tr>
<td>In/Out</td>
<td>4:06</td>
</tr>
<tr>
<td>Absolute</td>
<td>4:05</td>
</tr>
<tr>
<td>Remain</td>
<td>1:23</td>
</tr>
<tr>
<td>Source Tracks:</td>
<td></td>
</tr>
<tr>
<td>V1</td>
<td>01:03:24:29</td>
</tr>
<tr>
<td>A1</td>
<td>01:03:24:29</td>
</tr>
<tr>
<td>A2</td>
<td>01:03:24:29</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Sequence</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Source</td>
<td></td>
</tr>
<tr>
<td>None</td>
<td></td>
</tr>
<tr>
<td>Sequence Timecode:</td>
<td></td>
</tr>
<tr>
<td>Master</td>
<td>01:00:00:00</td>
</tr>
<tr>
<td>Duration</td>
<td>6:26</td>
</tr>
<tr>
<td>In/Out</td>
<td>6:26</td>
</tr>
<tr>
<td>Absolute</td>
<td>0:00</td>
</tr>
<tr>
<td>Remain</td>
<td>6:26</td>
</tr>
<tr>
<td>Source Tracks:</td>
<td></td>
</tr>
<tr>
<td>V1</td>
<td>01:03:24:29</td>
</tr>
<tr>
<td>A1</td>
<td>01:34:51:18</td>
</tr>
<tr>
<td>A2</td>
<td>01:34:51:18</td>
</tr>
</tbody>
</table>

Examples of the three panes in the Tracking Information menu for the Source monitor (left) and for the Record monitor (right)

### Panes in the Tracking Information Menu

The Tracking Information menu has three panes. You can select an option from pane 1, pane 2, or pane 3 to be displayed above a monitor. The following table describes the contents of the three panes:
Pane 1 lets you select a format for the tracking information. In the Record monitor, you set select a format for either the Sequence tracking information or the Source clip tracking information. In the Source monitor, you can select a format for the Source clip tracking information only.

The **Sequence submenu** lets you select Timecode, Footage (feet and frames for 24p and 25p projects), or Frames (a sum total of frames for either film or video).

 imageData={"image-type":null,"image-url":null,"image-desc":null} When you are working with a 24p or 25p project, the Timecode submenu lets you select an output timecode format. The Footage submenu lets you select a supported film type. The final Timecode, Footage, and Frames submenu then displays the master timecode (Mas), duration of the entire clip (Dur), IN to OUT duration (I/O), absolute timecode (Abs), and time remaining (Rem).

The **Source submenu** displays the information for the tracks existing in the currently loaded clip or sequence. For example, a clip with only one audio track does not show an option for A2. The item you select is displayed above the monitor.

- **Master**: Timecode for the entire clip.
- **Duration**: Length of the clip in minutes and seconds.
- **In/Out**: Timecode for the start and end of the clip.
- **Absolute**: Timecode for the selected track.
- **Remaining**: Time remaining in the clip for the selected track.

![Pane 1 example when you select Sequence > Timecode > TC1](image-url)
Customizing the Composer Window and Monitors

The following table describes the tracking format options.

<table>
<thead>
<tr>
<th>Pane</th>
<th>Description (Continued)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pane 1 example when you select Source &gt; V1</td>
<td></td>
</tr>
</tbody>
</table>

**Pane 2**

Lists Source or Sequence timecode options, such as master timecode (Master), duration of the entire clip (Duration), IN to OUT duration (In/Out), absolute timecode (Absolute), and time remaining ( Remain). The format type that you select from pane 1 determines the tracking format that is displayed.

**Pane 3**

Displays the timecode for the source track of a specific track (V1, A1, A2, and so on). The information is continuously updated based on the location of the position indicator.

**Tracking Format Options**

The following table describes the tracking format options.
Using the Info Window

The Info window displays statistical information about clips and sequences. You can open the Info window from the Source monitor, the Record monitor, a pop-up monitor, a bin, or a Script window. The Info window updates the information automatically.

You can cut, copy, and paste information from the Info window, but you cannot edit or change any information within the window.

To display information from the Record monitor:
1. Do one of the following:
   - Right-click the monitor and select Get Info.
   - Place the mouse pointer over the monitor and press Ctrl+I (Windows) or Command+I (Macintosh).
The Info window opens. Only fields with data are displayed.

![Info Window](image)

**To display information from a bin:**

1. Select a clip or sequence in a bin. You can use any bin view, and you can Ctrl+click to select multiple media objects.

2. Do one of the following:
   - Press Ctrl+I (Windows) or Command+I (Macintosh).
   - Right-click the clip or sequence and select Get Info.

The Info window opens. Only fields with data are displayed.

![Info Window](image)

If you select more than 8 media objects, a dialog box asks if you want to open information windows for all selected items.

**Using the Timecode Window**

Each monitor has two lines available to display timecode as described in “Displaying Tracking Information” on page 518. In addition, the Timecode window lets you display up to 48 lines of timecode in a separate window.

When you are working with a 24p or 25p project, you can display additional timecode information in the Timecode window. The output format timecodes TC 24, TC 25, TC 25P, and TC 30 are available from the Timecode menu, as are the source timecodes for clips and subclips.
You need to add the timecode track to the clip or sequence before the timecode tracking formats appear in the Timecode menu. For more information, see “Displaying Timecodes in a 24p or 25p Project” on page 366.

When displaying TC 30 source or M 30 timecodes, the pulldown phase for NTSC reference is displayed.

**To set a timecode display:**

1. Select Tools > Timecode Window.
   
The Timecode window opens.
   
2. Click anywhere in the Timecode window, and select an option.
   
3. To add an additional line of timecode, click Add Line, then click the new line and select an option.
   
4. To change the size of the font displayed in the Timecode window, select Size > font size.
   
5. Click the Close button to close the Timecode window.

**Playing Video to the Client Monitor**

You might want to see your sequences and effects as they appear on an external display monitor. To do this, connect a Client monitor to your Avid system.
Activating and Deactivating the Client Monitor Display

There are two ways to connect a Client monitor to your Avid system:

- Through your Avid input/output hardware device
  
  For details on connecting a Client monitor through your Avid input/output hardware, see the appropriate topic for your Avid input/output hardware device in “Connecting Cameras, Decks, and Monitors” in the Help.

- For software only-systems, through an IEEE 1394 connection, analog connection, or dual-head display board.
  
  For details on connecting a Client monitor to a software-only system, see “Connecting the Editing Equipment.”

If you do not have a Client monitor connected, you can still view the video through the camera eyepiece or through a monitor attached to a deck when outputting to an external camera or deck.

For details on playing video to a DV device, see “Playing Back to a DV Device” on page 541.

When you display video through an external monitor, you might see less responsiveness during certain system functions, such as scrub, single-frame play, effect editing, and effect preview.

Video and audio might appear to be out of sync when you have a DV device and a Client monitor attached to your system. The system, however, is functioning normally. For more information, see “Audio and Video Sync Issues” in the Help.

If you are using the Play Length Toggle button to limit the length of the material in the Timeline, the Play button is highlighted in white. You should check the color of the Play button, and if necessary turn off the Play Length function, before an important play and review session, such as when you want to play the entire sequence to the Client monitor. For more information on the Play Length function, see “Playing a Limited Duration of a Sequence” on page 614.

Activating and Deactivating the Client Monitor Display

If your Avid editing system has an Avid input/output hardware device attached and active, you can activate or deactivate the display in your Client monitor at any time. When the display is inactive, video is not visible in the Client monitor for either playback or scrubbing. Audio playback is not affected by deactivating the Client monitor.

Deactivating the Client monitor might be useful, for example, when you are screening material for clients and you want to make an editing change. You can deactivate the Client monitor display so that the client does not see your editing work while it is in progress, then activate the display to show the finished edit.
Selecting the Video Display Settings

The status of the Client monitor display does not persist between working sessions on your Avid editing application. The Client monitor display is always active when you first start your application.

You cannot activate or deactivate the Client monitor display if you are using your Avid editing application in software-only mode. If you do not have an Avid input/output hardware device attached to your system, the Toggle Client Monitor button has a gray monitor icon and is disabled. Clicking the button has no effect.

To enable or disable Client monitor display:

- Click the Toggle Client Monitor button in the Timeline bottom toolbar.

  Client monitor display becomes active or inactive.

  The Toggle Client Monitor button has a blue monitor icon when the Client monitor is active, and has a black monitor icon with a red diagonal line when the Client monitor is inactive. (If the Toggle Client Monitor button has a gray monitor icon, your application is running in software-only mode and clicking the button has no effect.)

The states of the Toggle Client Monitor button. Monitor active (left), monitor inactive (center), and button disabled (Avid editing application is in software-only mode).

The Toggle Client Monitor button appears in the Play tab of the Command palette. You can use it in the Command palette, or map it to any available button location or to the keyboard. For more information, see “The Command Palette” on page 129 and “Mapping User-Selectable Buttons” on page 131.

Selecting the Video Display Settings

After you connect the camera or digital deck and Client monitor to your Avid system, you might need to modify the way your Avid editing application plays video to the Client monitor and application monitors. Use the Video Display setting in the Settings list to configure these settings.

To select Video Display settings:

1. Click the Settings tab in the Project window.

   The Settings list appears.

2. Double-click Video Display.

   The Video Display Settings dialog box opens. The options available in the Video Display Settings dialog box vary depending on the model and configuration of your Avid editing application.
3. Select or modify the options for video display and click OK.

The options available vary depending on the model of your Avid editing application. For information about all options in the dialog, see “Video Display Settings” on page 1531. Some of these settings apply to playback and how effects are processed. See the following topics:
- “Playing Back to a DV Device” on page 541
- “Video Quality Options for Playback” on page 543
- “Setting the Video Quality for Playback” on page 544
- “Options for Controlling Real-Time Effects Playback” in the Help

### Playing Video to a Full-Screen Monitor

The Full Screen Playback option lets you view your video on a full-screen monitor.
To enable full screen playback:

1. Make sure your system is properly set up for full-screen monitor play.
   For more information, see “Understanding Full Screen Playback Options” in the Help.
2. Check the Full Screen Playback Settings to ensure you have them set properly.
   For more information, see “Full Screen Playback Settings” on page 1495.
3. Select Special > Full Screen Playback.

To disable full screen playback:

- Type Shift+Ctrl+F (Windows) or Shift+Command+F (Macintosh).

Adjusting the Play Delay Offset

Your Avid editing application uses a combination of hardware to provide for full audio and video playback capabilities. The use of an OHCI (Open Host Controller Interface) or a 1394 card to input and output DV signals along with the output to a computer’s desktop monitor and consumer audio chip could present playback sync issues.

If you do have 1394 selected from the Device menu, the Desktop Play Delay option lets you adjust the offset between audio and video playback on the Avid system.

With a camera or transcoder connected to your system, when you play a sequence in the Timeline and the Composer (desktop) monitor plays back video and audio ahead of the camera or transcoder, you can adjust this offset. Playback on the Composer monitor can be delayed by the number of frames chosen as an offset so that the video and audio play simultaneously to the camera or transcoder and the Composer monitor.

To adjust the offset:

1. In the Project window, click the Settings tab.
   The Settings list appears.
2. Double-click Desktop Play Delay.
   The Desktop Play Delay dialog box opens.
3. Click the Desktop Play Delay slider to increase or decrease the amount of frame offset.
   You might need to readjust the frames a few times to find the correct offset.
Using the Tool Palette

The Tool palette provides additional buttons for editing and navigating with your Avid editing application. The Tool palette buttons can appear with or without labels, and you can “tear off” the Tool palette to display it in another screen location.

You can also map other functions and buttons to the Tool palette for easy access. See “The Command Palette” on page 129.

To use the Tool palette:

1. Click the Fast Menu button in the Composer window or on a pop-up monitor.
   The Tool palette opens.

2. Click a button in the Tool palette.
   Your Avid editing application performs the function associated with the button.

To leave the Tool palette open and move it to another location:

1. Click the Fast Menu button in the Composer window or on a pop-up monitor.
2. Click the location where you want the Tool palette to be displayed.
3. (Option) If a subset of the buttons appears in the Tool palette, click the lower right corner and drag it to the right and down to reveal the full Tool palette.

To view the names of the buttons in the Tool palette:

- Move the pointer over a button.
  The name of the button appears in a ToolTip box.

To display labels on the Tool palette buttons:

1. In the Project window, double-click the Interface Setting.
   The Interface Setting dialog box appears.
2. Select Show Labels in Tool Palette.
3. Click OK.
   Labels appear on the buttons under the icons.
Playing Selected Clips in a Loop

You can view several clips one after another in a continuous loop by selecting Bin > Loop Selected Clips. This feature is useful if you want to view several versions of the same scene. While playing the loop, you can jump to the next clip by pressing the Tab key or jump to the previous clip by pressing Shift+Tab.

To play several clips in a continuous loop:
1. Select the clips in the bin that you want to play in a loop.
2. Select Bin > Loop Selected Clips.
   The clips begin playing in the Source monitor from the IN point to the OUT point.
3. Press the space bar to stop the play loop.
   If you want to play the clips from start to end, press the Alt key (Windows) or the Option key (Macintosh) while performing this procedure.

Loading and Clearing Footage

You can use several methods to load individual or multiple clips or sequences into monitors. You can also use the Clip Name menus to display or clear clips and sequences from the monitors.

You can adjust settings to optimize playback performance in the monitors. For more information, see “Video Quality Options for Playback” on page 543 and “Setting the Video Quality for Playback” on page 544.

If a sequence that was created in an older version of an Avid editing application contains effects or color corrections, you might need to update the sequence. If a sequence requires updating, the Update Sequence dialog box might open when you load the sequence. For more information, see “Updating and Reverting Existing Effects in Sequences” in the Help.

Loading Clips or Sequences into Monitors

To load clips or sequences into a monitor:
1. Click the Source/Record Mode button to enter Source/Record mode.
2. Open a bin and do one of the following:
   ▶ Locate a single clip or sequence.
   ▶ Select multiple clips or sequences.
   For more information, see “Selecting Clips and Sequences” on page 351.
3. Do one of the following:
Double-click the single clip or sequence, or any one of the selected set of clips or sequences.

By default, the material opens in the Source or Record monitor. If you have the “Double-click loads clip in” option in the Bin Settings dialog box set to “New Pop-up Monitor,” the material opens in a pop-up monitor. For more information, see “Bin Settings” on page 1444.

Alt+double-click (Windows) or Option+double-click (Macintosh) the single clip or sequence, or any one of the selected set of clips or sequences.

By default, the material opens in a pop-up monitor. If you have the “Double-click loads clip in” option in the Bin Settings dialog box set to “New Pop-up Monitor,” the material opens in the Source or Record monitor. For more information, see “Bin Settings” on page 1444.

Drag the single clip or sequence, or the selected set of clips or sequences, into the Source monitor or the Record monitor.

Alt-drag (Windows) or Option-drag (Macintosh) a single clip into the Record monitor. The clip will appear at the position of the position indicator in the Record monitor.

You can also load a series of clips into the Record monitor to create an instant sequence (rough cut) by pressing and holding the Alt key (Windows) or Option key (Macintosh) while dragging the clips from the bin to the Record monitor. For more information, see “Creating an Instant Rough Cut” on page 589.

Switching Between Loaded Clips

When you have loaded multiple clips or multiple sequences into the monitor, you will see only one clip displayed at a time. You can view an alphabetical list of the loaded clips and select an alternate clip for viewing in the Clip Name menu located above the monitor.

If you press and hold the Alt key (Windows) or Option key (Macintosh) while dragging multiple clips into the Record monitor, they appear as one sequence in the Clip Name menu. For more information, see “Creating an Instant Rough Cut” on page 589.

To switch between clips:

1. Click the name of the current clip or sequence displayed above the monitor to reveal the Clip Name menu.

The list in the lower portion of the menu contains a list of all the clips or sequences currently loaded in the monitor.
2. Select a different clip name from the menu.
   The selected clip replaces the current clip in the monitor display.

   *To see the list of clips or sequences sorted in the order in which they were loaded into the monitor, press the Alt key (Windows) or Option key (Macintosh) while opening the menu.*

### Clearing Clips from Monitors

You can use the Clip Name menu located above each monitor to clear clips from a monitor. There are two options for clearing clips:

- Remove the displayed clip and leave the monitor black but keep the clip loaded.
- Remove all the clip names from the Clip Name menu, and leave only the displayed clip loaded.

**To clear the monitor or the clip or sequence names from the menu:**

1. Click the name of the clip or sequence currently displayed above the monitor to reveal the Clip Name menu.

2. Select one of the following commands:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear Monitor</td>
<td>Removes the displayed clip or sequence from the screen, leaving black. The clips or sequences are still loaded.</td>
</tr>
<tr>
<td>Clear Menu</td>
<td>Deletes the list of all loaded clip or sequence names and leaves only the clip currently displayed.</td>
</tr>
</tbody>
</table>
Controlling Playback

There are several ways to play, view, and cue clip and sequences:

- Instantly access frames or move through footage by using the position indicator within the position bar under the monitors.
- Play, step (jog), or shuttle through footage by using user-selectable buttons.
- Play, step, or shuttle by using keyboard equivalents.
- Step or shuttle by using the mouse.

You can use the methods to control clips or sequences loaded in monitors, or to play clips and sequences in the bin while in Frame view and Script view.

- When viewing sequences in the Source monitor or the Record monitor, you can play only video and audio tracks that are currently monitored in the Track Selector panel. For more information, see “Understanding the Track Selector Panel” on page 703.

- If you try to play a sequence and the outline of the monitor flashes, another window is covering the monitor. Click the monitor to bring it forward, or move the window that is covering it.

Using Position Bars and Position Indicators

You can quickly access frames or move within loaded footage by using the position indicators that appear in the position bars under the monitors (and in the Timeline when you are viewing a sequence). The position bars represent the length of the clip or sequence, and the position indicator marks your current position in the clip or sequence.
To move the position indicator in the Timeline, do one of the following:

- Disable the segment tools (Lift/Overwrite and Extract/Splice-in) and click an area of the segment outside of the active trim region.
- Use the Timeline ruler.

By default, if you drag the position indicator (or scrub) through the Timeline, the media in the monitor updates quickly and smoothly. However, you do not see markers such as the start-of-clip and end-of-clip marks, sawtooth marks for In and Out points, and markers. To find a particular point of interest without viewing markers, use one of the approaches listed in the following procedure. For example, to snap to an In point in the Timeline, hold down the Ctrl key and drag the position indicator toward the In point until it stops. The position indicator will be aligned with the In point in the Timeline and the monitor displays the frame marked by the In point.

To access frames in or move through loaded footage, do one of the following:

1. If you want to use the position indicator in the Timeline to view footage, do one of the following:
   - Deselect the segment tools on the Timeline palette, or click the Smart tool toggle bar to deselect all edit tools on the Timeline palette.
   - Position the mouse pointer over the Timeline ruler or the Timecode (TC1) track to move through the sequence.

2. Depending on which frames in your sequence you want to access, do the following:
To move the position indicator and access the frame at the new position, click anywhere in a monitor’s position bar or in the Timeline, or drag the position indicator to the left or right in a monitor’s position bar or in the Timeline.

The speed with which you drag the position indicator determines the speed at which you move through the footage.

To go directly to the beginning or end of a clip or sequence, click to the far left or far right of the position bar or the Timeline.

To snap to the nearest transition, edit mark, marker, or audio keyframe, Ctrl-click (Windows) or Command-click (Macintosh) between the position indicator and that transition, mark, marker, or keyframe, or Ctrl-drag (Windows) or Command-drag (Macintosh) the position indicator toward that transition, mark, marker, or audio keyframe.

To snap to the last frame before the nearest transition, edit mark, marker, or audio keyframe, Ctrl+Alt-click (Windows) or Command+Option-click (Macintosh) between the position indicator and that transition, mark, marker, or keyframe, or Ctrl+Alt-drag (Windows) or Command+Option-drag (Macintosh) the position indicator toward that transition, mark, marker, or audio keyframe.

You can select the Use Fast Scrub setting to always display markers while scrubbing; however, with this option selected, the media in the monitor might update more slowly.

**To display markers when scrubbing:**

- In the Settings list, double-click Timeline and deselect Use Fast Scrub.

  When the Fast Scrub option is selected in an HD project, some effects are not displayed. Deselect this option to view all effects.

You can create a Timeline setting that has this option deselected and then easily switch between the settings. For information on duplicating settings, see “Duplicating Settings” on page 1425.

### Playback Control Buttons

You can use the buttons that appear below the Source and Record monitors and in the pop-up monitors to play and step through your footage.

You can also use additional buttons available in the Command palette to control playback. You can remap Command palette buttons onto some existing button locations (for example, in the Tool palette) or to the keyboard. For more information about mapping user-selectable buttons, see “Understanding Button Mapping” on page 129.

The following table describes the common playback control buttons:
### Controlling Playback

<table>
<thead>
<tr>
<th>Button</th>
<th>Primary Default Location</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Play</td>
<td>Monitors</td>
<td>Plays the footage at normal speed. Changes to the Stop button when playback is taking place.</td>
</tr>
<tr>
<td>Stop</td>
<td>Play tab in Command palette</td>
<td>Stops playback. Changes to the Play button when you have stopped playback.</td>
</tr>
<tr>
<td>Pause button</td>
<td>Play tab in Command palette</td>
<td>Pauses playback.</td>
</tr>
<tr>
<td>Play Reverse button</td>
<td>Play tab in Command palette</td>
<td>Plays the footage backward at normal speed.</td>
</tr>
<tr>
<td>Fast Forward button</td>
<td>Monitors</td>
<td>Cues the footage to the next transition in the sequence.</td>
</tr>
<tr>
<td>Rewind button</td>
<td>Monitors</td>
<td>Cues the footage to the previous transition in the sequence.</td>
</tr>
</tbody>
</table>

*By default, the Fast Forward and Rewind buttons cue footage to the head frame of the next transition. You can customize their behavior by selecting other alternatives from the FF/REW tab of the Composer Settings dialog box. For more information, see Composer Settings: FF/REW Tab.*

| Play Standby button     | Play tab in Command palette               | Places play in standby mode to prepare for playback. This is especially useful for long sequences. |

**To play in standby mode:**

1. Click the Play Standby button.
   
   The button under the Source or Record monitor blinks yellow.

2. Click anywhere to play the sequence.

| Step Backward button    | Monitors                                  | Moves the footage one frame backward.                                    |
|                        |                                           | • Press and hold the Alt key (Windows) or Option key (Macintosh) while clicking the button to move 10 frames (NTSC and PAL) or 8 frames (24p) backward. |

| Step Forward button     | Monitors                                  | Moves the footage one frame forward.                                     |
|                        |                                           | • Press and hold the Alt key (Windows) or Option key (Macintosh) while clicking the button to move 10 frames (NTSC and PAL) or 8 frames (24p) forward. |
Controlling Playback

Stepping Forward and Backward by Field

You can locate defects on individual fields of a frame with the single-field step feature.

*The single-field step feature is not available when you work with progressive formats.*

By default, your Avid editing application displays the first field of every frame when you step through material. With single-field step, you can view both fields of each two-field frame sequentially to locate a dropout from the source videotape or dust and scratches from the original film footage.

**To use single-field step:**

1. Click the Step Forward One Field button or the Step Backward One Field button.

   A number 2 displays in the upper right corner of the monitor to indicate you are parked on field 2 of a frame. (The absence of the number 2 indicates you are parked on field 1 of the frame.) Subsequent single-frame steps are based on this field.

2. Continue to click the Step Forward One Field or Step Backward One Field button to view each field of a frame.

   **To return to viewing only field 1 of each frame, make sure you park on field 1 of a frame before using the Step Forward or Step Backward buttons.**

   *Any edits you make using the paint tools affect both field 1 and field 2 of each frame.*
Playback Control Using the Keyboard

Many playback functions, including most of the playback controls covered in “Playback Control Buttons” on page 535, are mapped to keys on your keyboard. You can customize the keyboard by mapping buttons or menu commands to it from the Command palette, for example to add other playback functions.

Default keyboard mappings vary, depending on the type of keyboard attached to your Avid system. The information in this topic describes default keyboard mappings for playback control for a keyboard used in the United States. If an Avid-supported international keyboard is attached to your Avid system, the default keyboard mappings match that keyboard.

For more information on keyboard settings and keyboard mapping, see the following topics:

- “Understanding Button Mapping” on page 129
- “Using Foreign Keyboard Mapping (Windows)” on page 1636
- “Keyboard Settings” on page 1510

The following table describes the default keyboard mappings for basic playback control for a keyboard used in the United States:

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Keyboard Keys" /></td>
<td>Start and stop playback</td>
</tr>
<tr>
<td><img src="image" alt="Keyboard Keys" /></td>
<td>Tab key</td>
</tr>
<tr>
<td><img src="image" alt="Keyboard Keys" /></td>
<td>5 key</td>
</tr>
<tr>
<td><img src="image" alt="Keyboard Keys" /></td>
<td>Space bar</td>
</tr>
<tr>
<td><img src="image" alt="Keyboard Keys" /></td>
<td>1 key—moves the footage 10 frames backward (NTSC or PAL) or 8 frames backward (progressive formats)</td>
</tr>
<tr>
<td><img src="image" alt="Keyboard Keys" /></td>
<td>2 key—moves the footage 10 frames forward (NTSC or PAL) or 8 frames backward (progressive formats)</td>
</tr>
<tr>
<td><img src="image" alt="Keyboard Keys" /></td>
<td>3 key—moves the footage 1 frame backward</td>
</tr>
<tr>
<td><img src="image" alt="Keyboard Keys" /></td>
<td>4 key—moves the footage 1 frame forward</td>
</tr>
</tbody>
</table>
Playing Footage with the J-K-L Keys (Three-Button Play)

The J-K-L keys on the keyboard let you play, step, and shuttle through footage at varying speeds. This feature, also referred to as three-button or variable-speed play, lets you use three fingers to manipulate the speed of playback for greater control.

You can also use the J-K-L keys to perform smooth audio scrubbing of selected tracks. For more information, see “Performing Smooth Audio Scrub” on page 770.

To shuttle through the footage using the J-K-L keys on the keyboard:

1. Do one of the following:
   - Load a clip or sequence into the Source or Record monitor.
   - Open a pop-up monitor.
   - Select a clip in a bin in Frame view.

2. Use the following keys to shuttle at varying speeds:
   - Press the L key to move forward through the footage at normal speed.
   - Press the L key multiple times to move forward through the footage at faster speeds, as described in the following table:

<table>
<thead>
<tr>
<th>Press the L Key</th>
<th>To Play Footage at</th>
<th>NTSC Rate</th>
<th>PAL Rate</th>
<th>24p Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 times</td>
<td>2x normal speed</td>
<td>60 fps</td>
<td>50 fps</td>
<td>48 fps</td>
</tr>
<tr>
<td>3 times</td>
<td>3x normal speed</td>
<td>90 fps</td>
<td>75 fps</td>
<td>72 fps</td>
</tr>
<tr>
<td>4 times</td>
<td>5x normal speed</td>
<td>150 fps</td>
<td>125 fps</td>
<td>120 fps</td>
</tr>
</tbody>
</table>
Controlling Playback

<table>
<thead>
<tr>
<th>Press the L Key</th>
<th>To Play Footage at NTSC Rate</th>
<th>PAL Rate</th>
<th>24p Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>5 times</td>
<td>8x normal speed</td>
<td>240 fps</td>
<td>200 fps</td>
</tr>
</tbody>
</table>

- Press the J key to move backward at the same shuttle speed increments.
- Press the K and L keys together for slow forward (8 fps for NTSC, 6 fps for PAL, and 6 fps for 24p projects).
- Press the K and J keys together for slow backward.
- Press and hold the K key and tap the L key or the J key to step through footage one frame at a time.

To slow or change play direction one speed at a time:
- Press Alt (Windows) or Option (Macintosh) while you tap the J or L key.
  Play slows or changes direction one speed at a time from the speed at which you are currently playing.

For example, you are shuttling backward with the J key at 2x normal speed. Press and hold Alt and tap the L key once. Play slows to backward at normal speed (1x speed). Hold Alt (Windows) or Option (Macintosh) and tap L once again. Play stops. Continue to hold Alt (Windows) or Option (Macintosh) and tap L once again. Play goes forward at normal speed. Continue to hold Alt (Windows) or Option (Macintosh) and tap L once again. Play goes forward at 2x normal speed. Continue to hold Alt (Windows) or Option (Macintosh) and tap L once again; play goes forward at 3x normal speed. Release the keys to continue playing forward at 3x normal speed.

To pause shuttling:
- Press the K key.

To stop shuttling:
- Press the space bar.

Using the Mouse for Playback

You can use the mouse for one-handed control of playback. You can either jog or shuttle by using the mouse.
To jog or shuttle by using the mouse:

1. Do one of the following:
   - Load a clip or sequence into the Source or Record monitor.
   - Open a pop-up monitor.
   - Select a clip in a bin in Frame view.

2. Do one of the following:
   - Press the N key to activate mouse control for jogging.
   - Press the semicolon (;) key to activate mouse control for shuttling.
   - Click the Mouse Jog button, which is available in the Play tab of the Command palette and can be mapped to any button under the Record monitor.
   - Click the Mouse Shuttle button, which is available in the Play tab of the Command palette and can be mapped to an editing button under the Record monitor.

3. Move the mouse to the right to jog or play forward or to the left to jog or play backward.

To pause shuttling with the mouse:
- Click the mouse button.

To quit jogging or shuttling with the mouse:
- Double-click the mouse button or press the space bar.

You can also use the keyboard in conjunction with the mouse to control shuttling. For example, if you are shuttling with the mouse and you press the L key, the playback speeds up to the next normal play rate (30, 60, 90, 150, or 240 fps for NTSC; 25, 50, 75, 125, or 200 fps for PAL; 24, 48, 72, 120, or 192 fps for 24p projects). You can continue to change the shuttle speed and direction with the mouse.

Playing Back to a DV Device

If you do not have Avid input/output hardware attached to your system (software-only), you can play back DV media through a DV device.

Your options for playback of media to a DV device vary, depending on whether the media is played back as DV 25, DV 50, or DVCPro HD (DV 100).

- You can play back DV 25 media through a DV device attached to a 1394 port on your computer.
- You can play back DV 50 or DVCPro HD media through a 1394 port on your computer.
When you are playing back to a DV device, you have the option of enabling real-time encoding of effects and mixed resolutions.

**To play back to a DV device connected through a 1394 port:**

1. Right-click the Video Quality Menu button and select Output to DV Device.
   
   Playback to the DV device and playback to the desktop occur simultaneously.

   *If you do not have a device connected to a 1394 port, these options are grayed out.*

2. Right-click the Video Quality Menu button, select Format, and then select the native format to be sent to the DV device:

<table>
<thead>
<tr>
<th>Format</th>
<th>Availability</th>
</tr>
</thead>
<tbody>
<tr>
<td>DV 25 411</td>
<td>Enabled in any SD project</td>
</tr>
<tr>
<td>DV 25 420</td>
<td>Enabled only in PAL SD projects</td>
</tr>
<tr>
<td>DV 50</td>
<td>Enabled in any SD project</td>
</tr>
<tr>
<td>DVCPRO HD</td>
<td>Enabled only in HD 720p 59.94, 1080i 50, and 1080i 59.94 projects</td>
</tr>
</tbody>
</table>

3. (Option) If you are in an SD project, right-click the Video Quality Menu button, and then select Realtime Encoding.

   - If you select Realtime Encoding, you are in real-time effects mode. The media in your sequence is encoded to the format selected in the Video Quality menu. Enabling Realtime Encoding is helpful if you have a faster processor because it lets you bypass rendering many of your effects to disk.

   - If you do not select Realtime Encoding, you are in native play mode. You must render all effects and any media not matching the selected format will be played as black. The Video Quality menu only lets you select Full Quality (green) playback. Disabling Realtime Encoding is helpful if your machine has a slower processor.

   - Select Realtime Encoding to output 24p media to a DV device. You must also select Full Quality playback.

   *Realtime Encoding applies only to playing DV 25 and DV 50 media to a DV device.*

   *You can also select the DV playback options in the Video Display Settings dialog box.*
Video Quality Options for Playback

Your Avid editing application provides a range of video quality options for playback. Depending on your system configuration and the complexity of your sequence, you might need to switch to a lower quality option to avoid missing frames or choppy video during real-time playback.

The options available vary depending on your attached hardware. Some third party hardware might not support Draft Quality and Best Performance options.

The options are also different when you are working in MultiCamera Mode. For more information, see “Real-time Playback in MultiCamera Mode” on page 1382.

Your Avid editing application can only play back interlaced stereoscopic material using one of the Full Quality options. When you are working with interlaced stereoscopic material, other options are not available.

Your Avid editing application also provides an option that improves image quality during playback of mixed-format sequences where material requires resizing. You might need to deselect this option to avoid missing frames or choppy video during real-time playback.

The first of the following tables describes the video quality options. The second of the following tables lists the options available for each configuration.

<table>
<thead>
<tr>
<th>Video Quality Name and Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full Quality</td>
<td>Processes and plays the full image raster for the project. Uses a bit depth of 8 bits. This option provides the highest video playback quality by processing every image pixel. In interlaced projects, this option processes the full width of every line in both fields. In progressive projects, this option processes the full width of every scan line.</td>
</tr>
<tr>
<td>Full Quality 10-bit</td>
<td>Processes and plays the full image raster for the project, as described for Full Quality in the previous row. However, this option uses a bit depth of 10 bits, which provides higher quality processing for some effects. For more information, see the “Change the Bit Depth for Effects Processing” section in “Options for Controlling Real-Time Effects Playback” in the Help.</td>
</tr>
<tr>
<td>DNxHD Native</td>
<td>Processes and plays the full image raster of DNxHD native media only. This option does not process any effects in the sequence or any media that is not DNxHD encoded. Non-DNxHD media is replaced by black frames.</td>
</tr>
</tbody>
</table>
Setting the Video Quality for Playback

**Draft Quality**
Processes and plays a subsample of the full image raster for the project that uses 1/4 of the image information. Uses a bit depth of 8 bits.

This option subsamples 50% of the raster width. For interlaced projects, this option uses one field. For progressive projects, this option uses 50% of the scan lines.

**Best Performance**
Processes and plays a subsample of the full image raster for the project that uses 1/16 of the image information. Uses a bit depth of 8 bits.

This option subsamples 25% of the raster width. For interlaced projects, this option uses 50% of the lines in one field. For progressive projects, this option uses 25% of the scan lines.

---

### Video Quality Name and Icon Description (Continued)

**Configuration**

<table>
<thead>
<tr>
<th>Available Options (single camera editing)</th>
<th>Available Options (MultiCamera Mode)</th>
</tr>
</thead>
</table>

**Software-only** (no input/output hardware)
- Full Quality
- Draft Quality
- Best Performance

**Avid Mojo DX, Avid Nitris DX**
- Full Quality 10-bit
- Full Quality
- Draft Quality
- Best Performance (HD only)

---

For information about video quality and effects processing, see “Playing Effects Back at Different Video Qualities” in the Help.

### Setting the Video Quality for Playback

**To set the video quality for playback:**

1. Do one of the following:
   - Click the Video Quality Menu button to cycle through the video quality options available until the button icon indicates the video quality you want.
   - Right-click the Video Quality Menu button, and select a video quality option.

For detailed information on the video quality options, see “Video Quality Options for Playback” on page 543.
2. (Option) Right-click the Video Quality Menu button, and select Video Display Settings.

This opens the Video Display Settings dialog box and lets you select additional video display settings.

For information about the Video Display settings, see “Selecting the Video Display Settings” on page 526 and “Video Display Settings” on page 1531.

Marking and Subcataloging Footage

You can speed the editing process by marking clips with IN and OUT points, by subcataloging using markers, and by creating subclips. When subcataloging, you might want to create or open additional bins for storing and isolating specific subclips, marked clips, or sequences, as described in “Using the Bins Tab” on page 88.

Marking IN and OUT Points

You can mark IN and OUT points in your footage to indicate selected material, for example, the portion of a clip that you want to edit into a sequence. You can also easily clear or move these marks.

You can mark IN and OUT points for your clips while in the bin, which provides several advantages:

- You can quickly build a sequence by splicing the marked clips into place one after another.
- You can use the process of rough-cut or storyboard editing, which lets you instantly splice several prepared clips into a sequence, as described in “Creating an Instant Rough Cut” on page 589.
- You can play back and mark clips in the bin before loading a single clip, saving several steps. Use Frame view or Script view to play back and mark clips in a bin.

Even if your marks are not accurate now, your Avid editing application lets you trim the edit points and fine-tune the sequence later without reediting the material.

To mark IN and OUT points:

1. Load a clip or sequence from a bin into a monitor, or select a clip in the bin (Frame view or Script view).
2. Play, step, or shuttle through the material. Use the J-K-L keys when playing a clip in a bin (Frame view or Script view).

For more information on the J-K-L keys, see “Playing Footage with the J-K-L Keys (Three-Button Play)” on page 539.
3. Mark an IN point by doing one of the following:
Click the Mark IN button under the monitor to mark an IN point and stop playback.
Press the Mark IN key when marking a clip in a bin. (The Mark IN key does not stop playback.)
By default on United States keyboards, the Mark IN key is the I key.
In the monitor, a Sawtooth icon appears on the left to indicate the mark IN frame.

4. Continue moving through the material.
5. Mark an OUT point by doing one of the following:

- Click the Mark OUT button under the monitor to mark an OUT point and stop playback.
- Press the Mark OUT key when marking a clip in a bin.
  By default on United States keyboards, the Mark OUT key is the O key.
In the monitor, a Sawtooth icon appears on the right to indicate the mark OUT frame.

**To clear the IN point, do one of the following:**

- Click the Clear IN Mark button.
- Press the Clear IN Mark key.

**To clear the OUT point, do one of the following:**

- Click the Clear OUT Mark button.
- Press the Clear OUT Mark key.
To clear both the IN and OUT points:

- Click the Clear Both Marks button.
- Press the Clear Both Marks key.

To set a new IN point:

- Click the Mark IN button or press the Mark IN key when you reach a different frame.

To set a new OUT point:

- Click the Mark OUT button or press the Mark OUT key when you reach a different frame.

To move a mark icon:

- Press the Alt key (Windows) or the Option key (Macintosh), drag the mark icon to a new location, and release the mouse button.

Marking an Entire Clip or Segment

Use the Mark Clip button to select an entire clip or an entire segment from a sequence. (A segment in a sequence consists of the material between any two edit points.) The Mark Clip button chooses a segment between the first set of edit lines that line up on all the selected tracks.

To ignore the current track selection and mark the material between the two nearest edit points at the current position in the sequence, press and hold the Alt key (Windows) or Option key (Macintosh) while you click the Mark Clip button.

To mark an entire clip or segment:

1. Load a clip or sequence into a monitor.
2. In a sequence, move the position indicator to the segment that you want to mark.
3. In the Track Selector panel in the Timeline, select the tracks corresponding to the cuts you want to mark.
   For more information, see “Understanding the Track Selector Panel” on page 703.
4. Click the Mark Clip button.

Creating Subclips

When you mark footage with IN and OUT points, either you can save the entire clip along with the new marks, or you can create subclips based on the marks you set to break up longer master clips into smaller segments of selected footage. This procedure is similar to creating a pull reel of the selects or circle takes of your best footage before editing.
Subclips do not directly reference the original media. Subclips remain linked to the master clips from which they are created, and the master clips, in turn, reference the captured media files located on your media drives. As a result, none of the original footage is lost.

In most projects, subclips do not limit your access to the original, captured master clip material when trimming. Therefore, if you must trim beyond the marked IN to OUT boundaries of the subclip to make it longer or shorter, your Avid editing application accommodates the boundary adjustments during the trim.

However, when subclips are created in 24p or 25p projects, they are always created as “hard” subclips, and you cannot trim past the edges of the subclip when adjusting transitions and edits. Hard subclips prevent film tracking information errors for editing and cut lists.

New subclips appear in bins with a distinct subclip icon and with a numbered .Sub file name extension.

A subclip in Text view in the bin

**To create subclips:**

1. Load a clip into a monitor and mark the material from which you want to create the subclip.
   
   For more information, see “Marking IN and OUT Points” on page 545.

2. Do one of the following:
   
   - Press and hold the Alt key (Windows) or Option key (Macintosh), and then drag the picture from the monitor to the bin in which you want to store the subclip.
   
   - Click the Create Subclip icon, located above and to the side of the Source monitor, and drag it to the bin in which you want to store the subclip.
The Create Subclip icon changes to an icon of a hand pointing at a frame during the drag, and then becomes a Subclip icon when you release the frame in the intended bin.

- Click the Make Subclip button in the Edit tab of the Command palette.
  Your Avid editing application creates the subclip and places it in the active bin.
- Press the Alt key (Windows) or the Option key (Macintosh) while you click the Make Subclip button.
  Your Avid editing application creates the subclip and opens a dialog box that lets you select the destination bin for the subclip.

Creating Subsequences

You can use IN and OUT marks to create a new, shorter sequence from an existing sequence. This subsequence becomes an independent sequence and you can edit it in the same way you edit any other sequence.

To create a subsequence:

- Click the Create Subsequence icon located above and to the side of the Record monitor, and drag it to the bin in which you want to store the subsequence.
  The new subsequence appears in the bin, with a numbered .Sub file name extension.

Subclips and Audio Sync for 24p and 25p Projects

Your Avid editing application allows for the ¼-frame resyncing of audio in the event of telecine errors or for the purpose of adjusting audio sync for intended online mixing, but this subframe syncing can be done only to subclips. Avid recommends that you create subclips after you capture your footage and audio but before you begin editing in order to check or adjust audio sync. It is easier to adjust the subclip’s audio sync before you work the subclip into an edit. For more information about adjusting audio sync, see “Resyncing Subframe Audio” on page 626.

Marking Audio Clips

You can mark audio and video separately for an edit by using the Audio Mark buttons. This feature is useful for creating an overlap edit for an audio clip.

You can map the Audio Mark buttons from the Edit tab of the Command palette. For information on mapping buttons, see “Understanding Button Mapping” on page 129.

To mark IN and OUT points on audio tracks:

1. Load a clip or sequence into a monitor.
2. In the Track Selector panel in the Timeline, select the tracks corresponding to the cuts you want to mark.
For more information, see “Understanding the Track Selector Panel” on page 703.

3. Move the position indicator to the location where you want to mark the audio clip.

4. Do one of the following:
   - Click the Audio Mark IN button to mark an IN point.
   - Click the Audio Mark OUT button to mark an OUT point.

   The Audio Marks appear in the Timeline and in the position bar beneath the monitors.

   Audio Mark IN and Mark OUT marks in the position bar

To remove audio IN and OUT points:
   - Shift+click the Clear IN Mark, Clear OUT Mark, or Clear Both Marks button.

Using Markers

Markers are a type of electronic bookmark. They let you find and identify specific frames during editing. Keywords that you enter in the comments attached to a marker let you use standard Find procedures to call up the clips quickly. You can display information about the markers using the Markers window. For more information about the Markers window, see “Using the Markers Window” on page 559.

There are eight Add Marker buttons in the More tab of the Command palette. Each Add Marker button is a different color, which lets you group markers by color. For example, you can use the red Add Marker button to identify color correction frames and use the blue Add Marker button to identify cutaway shots.

You can map Add Marker buttons, as described in “Understanding Button Mapping” on page 129.

Suggested Uses for Markers

The following table describes some possible uses for markers and the Markers window:
When you insert a marker, it appears as an oval in the Timeline, in the position bar, and at the bottom of the frame in the monitor. The color of the oval corresponds to the color of the marker button you used.

<table>
<thead>
<tr>
<th>Use</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color correction notations</td>
<td>Use markers to mark clips or specify frames that require color correction, noting the specific correction to perform if someone else does the job.</td>
</tr>
<tr>
<td>Visual track alignments</td>
<td>Use markers at matching points in synchronized audio and video tracks so that if the tracks lose sync, you can visually realign the markers in the Timeline to restore sync. For more information on sync, see “Working with Multiple Tracks” on page 703.</td>
</tr>
<tr>
<td>Music cues</td>
<td>Use markers to mark the IN and OUT points for music.</td>
</tr>
<tr>
<td>Audio information sent to Avid Pro Tools</td>
<td>Use markers to mark places in the sequence for advanced audio editing in Pro Tools or to indicate video data useful to your Pro Tools editor.</td>
</tr>
<tr>
<td>Trim markers</td>
<td>Use markers in the Timeline to return directly to an edit you have designated for further trimming at a later time.</td>
</tr>
<tr>
<td>Cutaway markers</td>
<td>Use markers to identify cutaway shots with comments so that when you return to cover jump-frame edits with cutaway footage, you can quickly call up the shots using basic Find procedures.</td>
</tr>
<tr>
<td>Replace markers</td>
<td>Use markers to mark filler segments with comments to identify the items that should replace the filler.</td>
</tr>
<tr>
<td>Semi-permanent IN or OUT points</td>
<td>Use markers with the Mark Markers button to put multiple sets of markers on a long clip, and so on.</td>
</tr>
<tr>
<td>Add comments for EDLs</td>
<td>Use markers to add comments to sequence clips to appear in lists that you create, such as an EDL or cut list.</td>
</tr>
<tr>
<td>Viewing reviewer comments</td>
<td>Use the Markers window to view reviewer comments and the specific frame. See “Using the Markers Window” on page 559.</td>
</tr>
<tr>
<td>Print a list of reviewer comments</td>
<td>Use the Markers window to print a list of changes or comments that you can distribute to other people in the production. See “Using the Markers Window” on page 559.</td>
</tr>
<tr>
<td>Import and export markers</td>
<td>Import or export markers from one sequence or clip into another sequence or clip. See “Exporting and Importing Markers” on page 562.</td>
</tr>
</tbody>
</table>
You can add markers to your source material while you are in an editing session, as described in “Adding Markers While Editing” on page 552.

When you export sequences with markers as AAF files, the marker information is included. A Pro Tools editor can then choose to import the markers as Pro Tools as markers. The markers contain the same information as markers in your Avid editing system.

**Adding Markers While Editing**

**To add markers and comments while in an editing session:**

1. Load a clip or sequence.
2. (Option) Select a specific track by using the Track Selector panel.
   
   See “Understanding the Track Selector Panel” on page 703.

3. Cue to the frame, and click an Add Marker button.

   The Add Marker buttons are in the More tab of the Command palette.

   The Marker edit entry window opens. The marker name, color, frame, and track information appear. By default, the marker name is the user name logged onto your system.
The following illustration shows the Marker edit entry window.

Marker edit entry window. Top: a comment in the comment area. Bottom: button to open the Markers window

4. (Option) Type a new name in the Name text box.
5. Type your comments in the comment area of the Marker edit entry window.
6. Change the color from the Color menu or change the marker name.
7. To save your information, click OK, or press the Enter (Windows) or Return (Macintosh) key.

The information is stored with the marked frame. The marker oval appears in the Timeline, in the position bar, and at the bottom of the frame in the monitor.

Adding Spanned Markers While Editing

You can mark a region in either a source clip or sequence to display spanned markers.

To add spanned markers and comments while in an editing session:
1. Load a clip or sequence.
2. In the location where you want the spanned marker, add a Mark In and a Mark Out.
3. Select Tools > Command Palette and click the More tab.
4. Press Alt (Windows) or Option (Macintosh) and click an Add Marker button.

The Marker edit entry window opens. The marker name, color, frame, and track information appear. By default, the marker name is the user name logged onto your system.
If the Add Marker button is mapped to a button in your Timeline or Composer window, simply hold Alt (Windows) or Option (Macintosh) and click the mapped button. Likewise, if the Add Marker button is mapped to a keystroke, simply combine the keystroke with Alt or Option to apply the spanned marker.

5. (Option) Type a new name in the Name text box.
6. Type your comments in the comment area of the Marker edit entry window.
7. Change the color from the Color menu or change the marker name.
8. To save your information, click OK, or press the Enter (Windows) or Return (Macintosh) key.

If you added a spanned marker to a sequence, the spanned marker appears in the Timeline on the Timecode 1 track.

You cannot create overlapping spanned markers, nor can you move a spanned marker on top of another spanned marker.

When you open Tools > Markers, the Markers window will display the markers for the currently active monitor; the Source monitor, the Record monitor, or the pop-up monitor. The marker icon lets you easily identify a single frame marker (oval) and a spanned marker.
To deleted a marker, click to select the marker in the Markers window and press the Delete key.

**Adding Markers On-the-Fly while Playing**

**To add markers on-the-fly while playing:**

1. Load a sequence or clip.
   
   See “Loading and Clearing Footage” on page 530.

2. (Option) Select a specific track, using the Track Selector panel.
   
   See “Understanding the Track Selector Panel” on page 703.

3. Map the Add Marker button to a key by doing the following:
   a. Open the Command Palette, click the More tab, and select Button-to-Button Reassignment.
   b. In the Settings list of the Project window, double-click Keyboard.
   c. Drag an Add Marker button to a key on the Keyboard palette.
   
   For more information about mapping buttons to keys, see “Mapping User-Selectable Buttons” on page 131.

4. Click the Play button, and every time you want to add a marker, press the key to which you mapped the Add Marker button.

5. (Option) Map different Add Marker buttons to different keys to be able to add more than one color of marker.

**To add comments to the markers:**

1. Stop playing.

2. Do one of the following:
   a. Double-click the marker in the position bar under the monitor.
Click the large oval on the frame in the monitor. A Marker edit pane opens. The marker name, color, frame, and track information appear. By default, the marker name is the user name logged onto your system.

3. (Option) Type a new name in the Name text box.
4. Type your comments in the comment area of the Marker edit pane.
5. (Option) Change the color from the Color menu or change the marker name.
6. To save your information, click OK, or press the Enter key.

   The information is stored with the marked frame. The marker oval appears in the Timeline, in the position bar, and at the bottom of the frame in the monitor.
7. (Option) Click the Marker icon to edit marker information.

   **To keep the Marker edit pane from opening:**
   1. Select Tools > Markers.
      The Markers window opens.
   2. Select Disable Markers Popup from the Fast menu.
      The Marker edit pane now does not open even if you double-click a marker.

   **Finding Markers**

   **To quickly go to a frame with a marker while editing:**
   ▶ Search for a particular comment by selecting Edit > Find.
Finding Marker Comment Text

You can search for text within the Marker Comment field across all sequences and master clips within the project, including opened or closed bins.

To search for Text within Markers:

1. Press Ctrl+F (Windows) or Cmd+F (Macintosh), or select Edit > Find.
   The Find window opens.

2. Click the Markers tab.

3. Type a word or phrase that you want to use as search criteria in the Find text box.

4. (Option) To refine the number of results, you can enter additional criteria in the filters. Select a specific column from the Filter menu that you would like to search in, then enter additional text relating to that column. The column you are searching on does not have to display in the bin.

5. (Option) Click the “+” button to add additional filters. Click the “-” button to remove filters.

6. (Option) Select Ignore Case if you want the system to search for the text regardless if it is upper or lower case characters.

7. Click Find or press Enter (Windows) or Return (Macintosh).
   The application searches the bins (open or closed) in the project. Any markers containing the word or phrase entered appear in the Results window.

To change the columns displayed in the Results window, click Select Columns and select the columns to display.
8. Double-click a Marker in the results window to load the respective master clip or sequence into the source monitor and position the blue bar at the selected Marker.

**Editing Marker Information**

You can open the Marker edit entry window directly from a monitor, from the position indicator bar, or from the Markers window. In the Marker edit entry window, you can change the color of a marker, the marker name, or the text of the comment associated with a marker.

**To edit Marker information in the Marker edit entry window:**

1. Do one of the following:
2. Click the oval Marker icon in the Source or Record monitor.
3. Double-click the marker in the position indicator bar.
4. In the Markers window, right-click a marker item, and then select Edit Marker.

   The Marker edit entry window opens.

5. Do one or more of the following:
   - Select from the Color menu to change the color of the Marker icon.
   - Type a new marker name.
   - Enter new text or update the current text comment.

6. Click OK.

**Copying Markers from Source Clips**

You can copy all markers currently placed in source clips directly into the sequence as you edit. The markers and the marker text appear in all sequence segments that reference the source clips.

**To automatically copy source markers as you edit:**

1. Double-click Composer in the Settings tab of the Project window.
   - The Composer Settings dialog box opens.
2. Click the Edit tab.
3. Select Copy Source Markers.
4. Click OK.

**Marking an Area Using Markers**

You can mark the area between two markers by using the Mark Marker button.
To mark the area between two markers:

1. Move the position indicator between two markers.
2. Click the Mark Markers button in the Edit tab of the Command palette.

The area between the two markers is selected.

Moving to the Previous or Next Marker

You can move to a frame marked by a marker by using the Go to Previous Marker button or the Go to Next Marker button.

To move to the previous marker:

- Click the Go to Previous Marker button in the Move tab of the Command palette.

To move to the next marker:

- Click the Go to Next Marker button in the Move tab of the Command palette.

Deleting Markers

You can delete markers using the Delete key, or the Markers window.

To delete a single marker:

1. Select a marker in the Timeline or in the position bar.
2. Press the Delete key.

The selected marker is removed.

To delete markers using the Markers window.

- See “Working in the Markers Window” on page 561.

Using the Markers Window

The Markers window lets you quickly add comments, go to marker marks, copy and paste markers, export and import markers, delete markers, and print a list of markers in the currently loaded clip or sequence. Many features of the Markers window are similar to those of the Bin window.

You can use the Markers window to:

- Go to the marker in the sequence or clip.
- Find frame, timecode, and footage information about each marker.
- Modify and sort the display.
Using Markers

- Display frames for easy visual reference.
- Change the color of the Marker icons.
- Move a marker from one track to another.
- Delete a single marker or multiple markers.
- Export markers to send out as a review and approval file.
- Print the Markers window.
  This is especially useful for identifying and listing specific frames to be used in an effect, for example. You can also make a list of IN and OUT points for adding music.
- Copy and paste markers from one clip or sequence to another.

The following illustration shows a Markers window with three markers.

![Markers window illustration](image)

**Viewing Markers in the Markers Window**

The Markers window is monitor specific. If you have selected the Source monitor, the Markers window displays the markers for the clip in the Source monitor. If you have selected the Record monitor, the Markers window displays the markers for the sequence in the Record monitor.

**To view markers in the Markers window:**

1. Load the sequence containing the markers.
2. Do one of the following:
   - Right-click the Source or Record monitor and select Markers.
   - Select Tools > Markers.
Working in the Markers Window

You can perform a number of basic procedures in the Markers window. You can select markers, go to the frame marked by a marker, display marker frames or additional information, sort markers, change marker column widths, change marker colors, and delete markers.

You can also:

- Export and import markers
  For more information, see “Exporting and Importing Markers” on page 562.
- Copy and paste markers
  For more information, see “Copying and Pasting Markers Using the Markers Window” on page 563.
- Print the contents of the Markers window
  For more information, see “Printing the Contents of the Markers Window” on page 565.

To select a marker item:
- Click anywhere in the marker item’s row except in the Comment column.

To browse through the list of marker items:
- Press the Up Arrow and Down Arrow keys.

To go to the frame marked by a marker item:
- Double-click the marker in the Markers window.
- Right-click the marker, and select Jump to Marker.

To display the frame associated with a marker:
- Right-click, and select Show Images.

To display a timecode column, a footage column, or a frame number column in the Markers window:
- Right-click, and select Display > Frame Number, Timecode, or Footage.

To sort markers:
1. Click the heading of the column that you want to sort.
2. Right-click, and select Sort Column (to sort in ascending order) or Reverse Sort Column (to sort in descending order).
Using Markers

To change column widths:
1. Click the heading of the column that you want to resize.
2. Right-click, and select Enlarge Column or Reduce Column.

To change the color of a Marker icon:
- Right-click the marker icon, select Change Marker Color, and select a color.

To move a Marker from one track to another:
- Right-click the marker icon, select Change Track, and select a track.

To delete markers:
1. Click a marker item, or Ctrl+click (Windows) or Command+click (Macintosh) multiple marker items.
2. Press the Delete key.

Exporting and Importing Markers

You can export markers from a sequence or a clip. A text (.txt) or XML (.xml) file is created when you export the marker and a tab-delimited file or XML file displays all the information about the marker. You can then send the .txt or .xml file to those who need to review and give feedback about the sequence or clip. They can place additional comments in the text file or XML file and send it back for you to reimport the marker comments back into your sequence.

You can also import the text file into a spreadsheet program, such as Excel.

You can also use the Markers window to import markers back into your sequence.

To export markers:
1. From the Markers window, right-click and select Export Markers and select Text or XML.
   A dialog box opens, asking if you want to export only the selected markers or export all markers.
2. Click All or Selected.
   The Choose location for Exported Markers dialog box opens.
3. Type a file name and click Save.
   The marker is saved as a either text file (.txt) or XML (.xml) file.

To import markers:
1. With a sequence loaded in the Record monitor, right-click and select Markers.
2. From the Markers window, right-click and select Import Markers.
Using Markers

The Import dialog box opens.
3. From Files of type, select the tab-delimited file or Text/XML file containing the markers you want to import, and then click Open.
4. (Option) Another way to import a marker file is to select the tab-delimited marker file or the xml file and drag it into the Markers window.

Creating a Marker Text (.txt) File

You can create a Marker text file if you don’t have access to an Avid system. This lets you make timecode-specific comments offline and give them to an editor to import into a sequence. The Marker text file is a tab-delimited file which must be created with certain parameters. This file can be edited in a text editor application or in a spreadsheet program. The Marker text file can be exported from or imported into the Markers window. See “Exporting and Importing Markers” on page 562.

The fields in the tab-delimited file are required and must be in the order shown in the following procedure. The following lines are examples:

John<tab>203<tab>V1<tab>red<tab>Correct tint
Mary<tab>354<tab>A1<tab>blue<tab>A voice-over

To add comments or information into the Marker text file:
1. Type each line of the file using the following syntax:
   Name<tab>Frame<tab>Track<tab>Color<tab>Comment
2. Enter the color names as follows: red, green, blue, cyan, magenta, yellow, black, white
3. Enter the track names as follows: V1, V2, V3, etc, A1, A2, TC1

Copying and Pasting Markers Using the Markers Window

You can use the Markers window to copy a single marker or multiple markers and then paste them into another clip or a sequence. The copied marker is placed in the same frame position when it is pasted into the new clip. If the frame position does not exist in the new clip, then the paste does not occur.

You can also use a text editor to cut and paste markers in the Markers window. This lets you move markers easily between clips, sequences, tracks, or different users on your system.

Timecode, clip data, color, marker identification, and comments are all associated with a marker entry. You can edit the entries before pasting them into a new clip or sequence using the Markers window, or you can save the marker information as a text file and distribute it as needed.
To copy markers from a clip and paste them into a new clip using the Markers window:

1. Select the markers in the Markers window by doing one of the following:
   - Click a single marker.
   - Ctrl+click (Windows) or Command+click (Macintosh) multiple markers.
2. Do one of the following:
   - Select Edit > Copy.
   - Press Ctrl+C (Windows) or Command+C (Macintosh).
3. Load a new clip in the Source monitor.
4. Click the Marker window and do one of the following:
   - Select Edit > Paste.
   - Press Ctrl+V (Windows) or Command+V (Macintosh).
   The marker is pasted into the new clip.

To copy markers from a clip and paste them into a sequence using the Markers window:

1. Select the markers in the Markers window by doing one of the following:
   - Click a single marker.
   - Ctrl+click (Windows) or Command+click (Macintosh) multiple markers.
2. Do one of the following:
   - Select Edit > Copy.
   - Press Ctrl+C (Windows) or Command+C (Macintosh).
3. Load a sequence into the Record monitor or into the Timeline.
4. Click the Marker window and do one of the following:
   - Select Edit > Paste.
   - Press Ctrl+V (Windows) or Command+V (Macintosh).
   The marker is pasted into the sequence.

To copy and paste markers using the Markers window and a text editor:

1. Select the markers in the Markers window by doing one of the following:
   - Click a single marker.
   - Ctrl+click (Windows) or Command+click (Macintosh) multiple markers.
2. Do one of the following:
   - Select Edit > Copy.
   - Press Ctrl+C (Windows) or Command+C (Macintosh).
Using Markers

3. Open a text editor application, and paste the selection into the document.
   The marker information displays in the text document.

**Printing the Contents of the Markers Window**

You can print the complete contents or the current view of the Markers window.

*If you select Show Images to display the frame associated with each marker and you want to print the frames, you must use the procedure for printing the current view of the Markers window. Printing the complete contents does not print the frames.*

**To print the current view of the Markers window:**

1. Make sure your printer is correctly set up.
2. Expand the view of the Markers window to display the information you want to print.
   The Page Setup dialog box opens, reflecting the specific options for your printer.
4. Select the Page Setup options.
5. Click OK.
   The Print dialog box opens, reflecting the specific options for your printer.
7. Select the Print options.
8. Click OK (Windows) or Print (Macintosh).
   The system prints the current view of marker information.

**To print the complete contents of the Markers window:**

1. Make sure your printer is correctly set up.
2. Click the Markers window to make it active.
3. Press Ctrl+Alt+P (Windows) or Command+Option+P (Macintosh) to place the marker information in the Console window.
   The Console window opens.
5. Select File > Page Setup.
   The Page Setup dialog box opens, reflecting the specific options for your printer.
6. Select the Page Setup options.
7. Click OK.
8. Select File > Print.
   The Print dialog box opens, reflecting the specific options for your printer.
9. Select the Print options.
10. Click OK (Windows) or Print (Macintosh).
   The system prints the marker information displayed the Console window.

Disabling the Marker Edit Window

If you want to add markers without including comments, you can modify the behavior of the Marker edit window so that it does not open each time you create a new marker. This lets you add markers quickly and then edit marker information later.

This option is selected by default if you upgraded your Avid editing application from a previous version where the “Disable Markers Popup” option was selected.

You can also disable the Marker edit window so it only opens from the Markers window. For information on accessing the Marker edit window, see “Editing Marker Information” on page 558.

To keep the Marker edit window from opening each time you add a marker:
1. Select Tools > Markers.
   The Markers window opens.
2. Select Disable Marker Popup when Adding from the Fast menu.
   The Marker edit window now does not open when you add markers.

To keep the Marker edit window from opening:
1. Select Tools > Markers.
   The Markers window opens.
2. Select Disable Marker Popup Always from the Fast menu.
   The Marker edit window now does not open even if you double-click a marker.

Finding Frames, Clips, and Bins

Once you have captured, viewed, marked, and subcataloged numerous clips for a project, you might have difficulty relocating specific clips or frames among several bins. Your Avid editing application provides a number of features for quickly locating and cueing footage, including conventional timecode and frame-offset techniques, text searches, and Match Frame and Find Bin commands.
Using Timecode to Find a Frame

You can cue a loaded clip or sequence to a specific frame by typing timecode values with the numeric keypad on the right side of the keyboard. In addition, you can cue backward or forward from the current location in the clip or sequence by a specified number of minutes and seconds, or feet plus frames, by using positive or negative frame-offset values.

The system interprets the numbers you type with the numeric keypad according to the type of tracking format you have selected from the Tracking Information menu (timecode or frames). If you have two rows of information displayed above the monitor, the system looks at the top row. For more information on selecting the display of tracking information, see “Displaying Tracking Information” on page 518.

To use timecode to find a frame, the top row of information must include timecode, for example, V1.

To cue to a frame based on a known timecode:

1. Click the monitor that is displaying the clip or sequence you want to search.

2. Select a timecode tracking format from the Tracking Information menu that appears above the monitor.
   
   If two rows of information are displayed above the monitor, make sure the timecode format is in the top row.

3. (Option) If you are using a notebook computer or a keyboard that does not have a dedicated numeric keypad, press and release the left Control key twice quickly.
   
   This lets you enter timecode using standard keys on the keyboard, such as the number keys and the Enter key (Windows) or Return key (Macintosh).

4. Enter the timecode for the frame by using the numeric keypad on the right side of the keyboard.
   
   If you have performed step 3 on a notebook computer or a keyboard that does not have a dedicated numeric keypad, use the standard keyboard number keys.
Finding Frames, Clips, and Bins

Example of timecode entry with the numeric keypad. The timecode appears in the monitor. In this example, the interface displays master timecode.

Use one of the following formats:

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SMPTE timecode</td>
<td>Use two digits each for the hours, minutes, seconds, and frames. For example, type 01230200 to enter 01:23:02:00.</td>
</tr>
<tr>
<td>Current timecode</td>
<td>To find a timecode that starts at the same hour, minute, or second as the current timecode, type only the last digits. For example, if the current timecode is 1:05:12:13 and you type 425, the system finds the frame at 1:05:04:25.</td>
</tr>
</tbody>
</table>

5. Press Enter on the numeric keypad.

If you have performed step 3 on a notebook computer or a keyboard that does not have a dedicated numeric keypad, press the Enter key (Windows) or Return key (Macintosh).

**To cue a frame using frame offset timecode:**

1. Click the monitor that is displaying the clip or sequence that you want to search.
2. (Option) If you are using a notebook computer or a keyboard that does not have a dedicated numeric keypad, press and release the left Control key twice quickly.
   
   This lets you enter timecode using standard keys on the keyboard, such as the number keys and the Enter key (Windows) or Return key (Macintosh).
3. Using the numeric keypad, type a plus sign (+) to move forward or a minus sign (–) to move backward from the current position.
If you have performed step 2 on a notebook computer or a keyboard that does not have a dedicated numeric keypad, use the standard keyboard plus (+) and minus (-) keys.

4. Type a number for the frame offset, and then press Enter on the numeric keypad.

If you have performed step 2 on a notebook computer or a keyboard that does not have a dedicated numeric keypad, use the standard keyboard number keys, and then press the Enter key (Windows) or Return key (Macintosh).

Use the following formats:

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>One or two digits</td>
<td>Type 1 through 99 to specify a number of frames forward or backward. For example, type -42 to move backward 42 frames.</td>
</tr>
<tr>
<td>Three digits</td>
<td>Type 100 or greater to move forward or backward a specified number of seconds and frames. The results vary depending on the tracking format you have selected in the Tracking Information menu that displays information above the monitor. For example, if you type +100 and the master timecode is displayed in the top row of the tracking information above the monitor, you move forward 1 second and zero frames. If you select frames to display above the monitor and type +100, you move forward 100 frames.</td>
</tr>
<tr>
<td>Frames only</td>
<td>To move by frames (regardless of the display in the Tracking Information menu) add an f to the end of the number you type. For example, if you have a timecode displayed in the Tracking Information menu and type +100f, the display changes to 3:10 (3 seconds and 10 frames) and you move forward 100 frames.</td>
</tr>
</tbody>
</table>

Searching for a Clip or Sequence with Text Find

Text find allows you to enter text and search bins, Scripts and the Timeline for the information you enter. You can customize your search by selecting to only search the active bin or search all bins across a single project. Bins do not have to be open for the system to search in them, Find searches all bins and scripts within your project. The text find feature is included with your Avid editing application.

Things You Should Know About Text Find

- You can continue to work, while the system indexes your project.
- All tabs: Clips and Sequences, Script Text, and Timeline and Monitors tab apply to text find.
- The system does not search and find referenced clips in a sequence.
- If you make a change to a bin (or add a new clip to the bin), you must save the bin first in order for the system to find the changes.
• The system searches through all available columns in your bins including metadata columns, even if they are not visible in your current bin.
• The use of quotes in search queries has no affect on your results.
• The following characters: @#$%^&*()+=\ are recognized by text find.
• When you perform an Edit While Capture in an Interplay environment, you need to update the bin so that the system indexes your new media. After you capture, right-click the clip in the bin and select Update from Interplay. Then save the bin. When you perform a text find, the system should find the new captured clips.
• To make sure all your open bins are indexed, click the Project window and select File > Save All. This will save all opened bins. When the Bin Index light turns solid green, perform your search. This will ensure that your results include the most up-to-date files.
• Before you filter to refine your results, you need to first perform a find, then the Filter columns are selectable.

To open a search window:

1. Press Ctrl+F (Windows) or Cmd+F (Macintosh), or select Edit > Find.
The Find window opens.
The Bin Index status at the bottom of the window indicates if the data files in your bins have been indexed. A full green display indicates that your files have been indexed and are ready to search. A partial green display indicates that the index is in process and if you perform a search, your results might not be complete.

If you want to stop the indexing process, click the Settings button in the Find window and click Stop Indexing. The indexing stops and the button changes to Start Indexing. The indexing remains off until you click Start Indexing.

2. Type a word or phrase that you are looking for in the text box.

3. Select to search in Clips and Sequences, Script Text, or Timeline and Monitors.

4. If you select Clips and Sequences, then select from the menu:

<table>
<thead>
<tr>
<th>Bins in Project</th>
<th>The system searches for the text criteria in all the bins/scripts within the project regardless if the bin/script is currently opened.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bins and Scripts in Project</td>
<td>The system searches for the text criteria in the last active bin. The system then selects the first occurrence in the bin. Press Ctrl+G (Windows) or Cmd+G (Macintosh) to take you to the next occurrence</td>
</tr>
</tbody>
</table>

| Current Bin | The system searches for the text criteria in the last active bin. The system then selects the first occurrence in the bin. Press Ctrl+G (Windows) or Cmd+G (Macintosh) to take you to the next occurrence |

5. If you select Script Text, then select from the following:

<table>
<thead>
<tr>
<th>Scripts in Project</th>
<th>The system searches for the text criteria in all the scripts within the project regardless if the script is currently opened.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current Script</td>
<td>The system searches for the text criteria in the last active script. The script must be open and active in order for the system to search within the script.</td>
</tr>
</tbody>
</table>

6. A script text search displays all matches in the script, to find the next occurrence of your text criteria, press Ctrl+G (Windows) or Cmd+G (Macintosh) in your script.

7. If you select Current Script, you can select “Whole words only” to search for only that word.

8. Select Ignore Case if you want the system to search for the text regardless if it is upper or lower case characters.
9. If you select Timeline and Monitors, then select from the following:

<table>
<thead>
<tr>
<th>Markers</th>
<th>The system searches for clips in the Timeline that contain the marker text. The blue position bar jumps to the marker position on the clip and displays the marker information in the Source/Record monitor.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clip Names</td>
<td>The system searches for clips in the Timeline that contains the clip name. The blue position bar jumps to the head frame of the clip.</td>
</tr>
<tr>
<td>Timeline Text</td>
<td>The system searches for clips in the Timeline that contain Timeline text based on what is displayed in the Clip Text pulldown menu. The blue position bar jumps to the head frame of the clip.</td>
</tr>
</tbody>
</table>

10. If you would like to open the clip(s) in a Source monitor when you double-click a clip in the Results window, then select Load into monitor.

*Loading the clip in the Source monitor is dependant on the option you have chosen for “Double-click loads object in” in your Bin Settings.*

11. With your text criteria entered, click Find or press Enter.

A Cancel button appears and the system informs you that it is finding your text criteria.

The results appear in the Results window. If you select Current Bin, the clips are selected in the bin and do not display in the Results window. The system displays the total number of items found after your search.

*To select the next occurrence in your bin, press Ctrl+G (Windows) or Cmd+G (Macintosh).*

12. (Option) To refine the number of results, you can enter additional criteria in the filters. Select a specific column from the Filter menu that you would like to search in, then enter additional text relating to that column. The column you are searching on does not have to display in the bin.

*Click the “+” button to add additional filters. Click the “-” button to remove filters. If the last filter appears, the “-” button removes the text, not the filter.*

The filter menu populates after the initial search.

**Setting the Location of the SearchData folder**

When creating a new project you can choose the location of the SearchData folder.
To choose the location of the SearchData folder:

1. Start the editing application.
2. In the project window, select New Project.
   The New Project dialog opens.

3. Select the Search Data Folder menu. Select either Default, Local Default, or Other. To change the location from the Default options, select Other.
4. Choose the folder where you want the SearchData folder to reside.
5. Click OK.

A subfolder with the project name is created in the folder you selected in step 4.

You can also set the SearchData folder in the Settings tab of the Find Window.

Using Match Frame

The Match Frame feature lets you locate the source clip for the frame currently displayed in either the Record monitor or the Source monitor. This feature is useful when you want to relocate and reedit source material, such as subclips and master clips.
Match framing loads the source clip into the Source monitor, cues to the matching frame in the source clip, and marks an IN point. Any original IN and OUT points are removed from the source clip.

You can also use the Match Frame feature to locate clips quickly, based on media relatives, when you have forgotten their location. For example, you can matchframe a cut in the sequence to its original subclip, matchframe the subclip to the original master clip, and then locate the bin in which the master clip is saved. Match framing stops when you reach the master clip.

You can also use the Match Frame feature to locate the source clip for a traditional motion effect.

You can also locate frames in a sequence that match a selected source frame; see “Performing a Reverse Match Frame” on page 575.

Match framing does not create a permanent sync relationship between clips but provides a convenient way of locating, marking, and editing matching material.

The Match Frame button appears by default in the second row of buttons below the Source monitor. To match frame from footage in the Record monitor, you must map the button from the Other tab of the Command palette to the Record monitor palette or the Keyboard palette. For information about mapping buttons, see “Mapping User-Selectable Buttons” on page 131.

To use Match Frame to locate the source clip for a selected frame or motion effect:

1. Load a sequence into the Record monitor or a subclip into the Source monitor.
2. Move the position indicator to the frame or motion effect that you want to match.
3. In the Track Selector panel, select the track for the frame that you want to match.
   
   For more information, see “Understanding the Track Selector Panel” on page 703 and “Selecting Tracks for Matching Frames” on page 575.
4. Do one of the following:
   
   ▶ Click the Match Frame button.
   The source clip is loaded into the Source monitor, and any previous IN or OUT points are removed. A new IN point is marked at the matching frame.
   
   ▶ Alt+click (Windows) or Option+click (Macintosh) the Match Frame button.
   The source clip is loaded into the Source monitor, and any previous IN or OUT points are maintained.
   
   ▶ Press and hold Alt+Ctrl (Windows) or Option+Command (Macintosh), and click the Match Frame button.
   The source clip of the motion effect is loaded into the Source monitor.
Performing a Reverse Match Frame

The Reverse Match Frame feature lets you locate frames in a sequence that match a selected source frame.

To perform a reverse match frame:
1. Load the source footage into the Source monitor.
2. Move the position indicator to the frame that you want to match.
3. Select the appropriate tracks in the Timeline.
   For more information, see “Understanding the Track Selector Panel” on page 703 and “Selecting Tracks for Matching Frames” on page 575.
   The system searches all selected tracks in the Record monitor for the frame on all selected tracks in the Source monitor.
4. Click the Reverse Match Frame button in the Other tab of the Command palette.
   Your Avid editing application cues the sequence to the matching frame on the record side. If the frame exists in more than one place, the sequence cues to the first location of the match frame and continues through the sequence to subsequent locations each time you click the Reverse Match Frame button.

Selecting Tracks for Matching Frames

Track selection determines the match frame. If you select a video track, your Avid editing application matches a frame from the video. If you enable several tracks, your Avid editing application matches the frame from the highest selected track level, in descending order: V1, A1, A2, and so on.

You can match frame a single track without having to turn off all other tracks. With audio, you can select the audio track that you want to match frame instead of having your Avid editing application match frame the top audio track.

To matchframe a selected frame on a single track:
- Right-click the track number that you want to match frame, and select Match Frame Track.

Finding a Bin

With a clip or sequence loaded into a monitor, you can quickly find the original bin in which it is stored by using the Find Bin button. Clicking this button finds the bin, opens it, and highlights the clip or sequence within the bin. This works for sequences, subclips or clips within sequences, or clips in the Source monitor.
To find the bin in which a specific clip is located:
1. Load a clip into the Source monitor.
2. Click the Source monitor to activate it.
3. Click the Find Bin button in the Other tab of the Command palette.
   Your Avid editing application highlights the clip in the bin.

To find the bin in which a specific sequence is located:
1. Load a sequence into the Record monitor.
2. Click the Record monitor to activate it.
3. Click the Find Bin button.
   Your Avid editing application highlights the sequence in the bin.

To find the bin in which a specific clip in a sequence is located:
1. Move the position indicator to the clip within the sequence.
2. Press and hold the Alt key (Windows) or the Option key (Macintosh), and click the Find Bin button.
   Your Avid editing application opens the bin and highlights the clip.

Locating a Master Clip from a Subclip in a Sequence

You can use the Match Frame and Find Bin buttons together to find the original clip in the bin for a subclip that was edited into a sequence.

For this operation, you must have the monitors in the two-monitor display and the Match Frame button must be mapped below both the Source and Record monitors.

To locate a master clip from a subclip:
1. Cue to the subclip in the sequence.
2. Click the Match Frame button in the Record monitor to load the subclip into the Source monitor.
3. Click the Match Frame button in the Source monitor to load the original master clip into the Source monitor.
4. Click the Find Bin button in the Source monitor to open the bin and highlight the master clip.
Finding a Frame

The Find Frame button, located in the Other tab of the Command palette, lets you trace a captured frame of footage displayed in a sequence or source clip back to its analog source on tape. This is useful for finding frames for color correction or for recapturing specific clips to lengthen them or alter capture parameters.

To find a frame:

1. Make sure the source deck is properly connected to the system, and load the clip or sequence.

2. In the Timeline or position bar, move the position indicator to the frame you want to find.

3. Click the Find Frame button in the Other tab of the Command palette.

   If the tape is not in the deck (for example, you do not know which tape the footage is on), a dialog box prompts you to insert the appropriate tape.

4. Insert the tape.

   Your Avid editing application cues to the requested frame and displays the frame. You can recapture as necessary.

Sequence and Clip Information Summary

You can generate a report to display information about the contents of a sequence. For example, you can generate a list of the types of effects in your sequence or the location of a particular effect. You can also create a clip summary or a source summary. This allows you to display a list of clip names, tape names, offline clips, and path locations of imported clips contained in your selection.

You generate reports from the Sequence Report dialog box, which you can access from the Source monitor, the Record monitor, or directly from a sequence in a bin. The Sequence Report dialog box allows you to select your criteria and create a report that displays in a text editor. You can then search the summary for the exact information you want.

Example 1: Preparing for Online Editing

When you move your sequence from an offline system to an online system, you can run an effect summary and a source summary report. The Effect Summary displays a list of all effects, including a separate list of plug-ins used. The Source Summary lists all the tapes you need for recapture and all of the import paths for imported graphics.
Example 2: Finding Specific Effects

You use the Effect Summary and Effect Location List to find a particular effect. When you output the summary to a text editor, you can search the report to find all occurrences of the particular effect. In addition, you can type the start or end timecode value for each occurrence into the Source/Record monitor to go to the start of the effect in the Timeline. You might find this useful when you need to replace or modify a specific plug-in, for example.

Example 3: Plug-in Information

An Effect Summary displays a list of effects found in the selection, including how many times the sequence uses an effect. For plug-ins loaded on your system, a section displays a summary of the plug-ins used, displaying the name, the vendor, the version and the ID of the plug-in. This can help by providing a list of the plug-ins needed for online work.

If a plug-in is not loaded on your system when you generate the summary, if you select the option "Show Missing Effects Only" from the Sequence Report dialog box, the information displays "unavailable effect," in addition to the plug-in name, the plug-in ID (is this gone?), and other information associated with the effect. (Is the vendor and version number displayed). This is helpful when identifying the effect.

Creating a Summary of Effects and Source Information

Before you use the Sequence Report dialog box to create a summary of effects, source information, or clip information, you might want to do the following:

- Determine if you want the report to cover specific tracks or a section of the sequence between In and Out points. Loading a sequence in the Source/Record monitor before you generate a report allows you to select which part of the sequence about which you want information.
- Choose the summary options you want information on — types of effects, location of effects, source information, or clip information.

You can modify the sequence name and the starting timecode in the Sequence Report dialog box.

To generate a summary report:

1. Do one of the following:
   - From a bin, right-click a sequence and select Sequence Report. You can select multiple sequences for generating reports.
   - With a sequence loaded in a monitor, right-click the monitor and select Sequence Report.

The Sequence Report dialog box opens.
2. (Option) Do the following:
   - If you selected specific tracks, click Enabled Tracks Only.
   - If you set In and Out points, click Use Marks.

   If you want to run a report on the entire sequence regardless of tracks or marks, do not select either of these options.

3. Select the Summary Info options you want to include in your report. For information on report options, see “Summary Information Options” on page 580.

4. Click Generate Report.

   The Save Summary Output File As dialog box opens.

5. Use the default file name or rename the report and choose a folder to save the report to, click Save.

   If you select more than 8 sequences, a dialog box asks if you want to generate sequence reports for all selected items.

   The application writes the report to a text file and opens a text editor.
## Summary Information Options

The following options allow you to select which information to include in the sequence report.

<table>
<thead>
<tr>
<th>Summary Option</th>
<th>Suboption</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Effect</td>
<td>Summary</td>
<td>This displays the types of effects and how many were found in your sequence, the breakdown by effect type, and an effect plug-in summary. If you have selected individual tracks or selected IN and OUT points, only those effects that fall within those parameters appear.</td>
</tr>
<tr>
<td>Create Effect</td>
<td>Location List</td>
<td>This displays the location of an effect. Depending on the criteria you selected, this displays track, start timecode, end timecode and effect name.</td>
</tr>
<tr>
<td></td>
<td>Skip Non-Renderable Effects</td>
<td>Select this option if you do not want any non-renderable effects, such as pan/volume effects, to appear in the report.</td>
</tr>
<tr>
<td></td>
<td>Skip Relationship-Only Color Correction</td>
<td>Select this option if you do not want any color correction effects with only relationships to appear in the report.</td>
</tr>
<tr>
<td></td>
<td>Show Nested Effects Only</td>
<td>Select this option if you want to only display the nested effects in your sequence. Effects that are nested inside of other effects show the parent effect track they are applied to with the track name in parentheses and indented to show the nesting relationship.</td>
</tr>
<tr>
<td></td>
<td>Show Missing Effects Only</td>
<td>Select this option if you want to only display the plug-in effects missing from your sequence. Plug-in effects that are missing in your sequence display as “Unavailable Effect,” but also lists the type of effect and other important information which help you identify the type of effect. This option is helpful when you move your sequence to a system that does not have the plug-in installed.</td>
</tr>
<tr>
<td>Summary Option</td>
<td>Suboption</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>----------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Create Clip Summary or</td>
<td><strong>Offline Only</strong></td>
<td>Select this option if you want to display offline clips and/or sources only.</td>
</tr>
<tr>
<td>Create Source Summary</td>
<td><strong>Skip Non-Selected Clips in Group Clips</strong></td>
<td>Select this option if you do not want any non-selected clips inside of a group clip to appear in the report.</td>
</tr>
<tr>
<td></td>
<td><strong>Show Globally Unique Identifier (UID)</strong></td>
<td>Select this option if you want to display the unique identifiers (Mob IDs) associated with the clips and sources in your sequence.</td>
</tr>
</tbody>
</table>
Creating and Editing Sequences

This chapter introduces you to procedures that you use to build a sequence, as described in the following topics:

- Entering Source/Record Mode
- Creating a New Sequence
- Making a First Edit
- Creating an Instant Rough Cut
- Undoing or Redoing Edits
- Editing Additional Clips into the Sequence
- Mixing Frame Rates and Field Motion Types
- Mixing Frame Sizes and Aspect Ratios
- Refreshing Sequences to Use Current Clip Attributes
- Lifting, Extracting, and Copying Material
- Adding Comments to Sequence Clips
- Playing Back a Sequence
- Understanding Sync Breaks
- Fixing Sync Breaks
- Understanding Sync Lock
- Ganging Footage in Monitors
- Sync Point Editing
- Autosyncing Clips
- Understanding AutoSequence
- Adding Audio or Video to Original Videotape Using AutoSequence
- Resyncing Subframe Audio
- Resyncing Audio for a Selected Subclip
- Working with Phantom Marks
- Creating Video and Audio Leaders
Entering Source/Record Mode

Source/Record mode is the default editing mode. It includes the screens and controls used for the Source and Record monitor. Use Source/Record mode to create new sequences from source clips.

To enter Source/Record mode from another mode:

- Click the Source/Record Mode button.

Depending on the model of your Avid editing application, the Source/Record Mode button might appear in a default location, for example, in the second row of buttons below the monitors. You can map the Source/Record Mode button to any mappable button location, or use it directly from the Command Palette. For information about mapping buttons, see “Mapping User-Selectable Buttons” on page 131.

For more information about the Composer window, see “Customizing the Composer Window and Monitors” on page 515.

Creating a New Sequence

You can create a new sequence in one of two ways, depending on the requirements of your workflow:

- To set specific parameters for the sequence before you start editing, you can use the New Sequence command to create and name a sequence, set the start timecode, (see “Changing the Name and Timecode for a Sequence” on page 584) and determine the numbers and types of tracks (see “Track Display for New Sequences” on page 586) to use before you make the first edit.

- To begin editing right away and build the sequence as you go without setting parameters ahead of time, you can create the sequence automatically by making an initial edit, as described in “Making a First Edit” on page 588.

To create a sequence with the New Sequence command:

1. Do one of the following:
   - Select Clip > New Sequence.
   - Right-click in either the Timeline or the Source/Record monitor, and select New Sequence.

   One of the following occurs:
   - If just one bin is open or you activate a bin, the new sequence appears in that bin. It also appears in the Record monitor and in the Timeline, with the generic title “Untitled Sequence n.” Each new sequence is numbered incrementally until you rename it.
- If a bin is not activated, the Select dialog box opens. Select the bin where you want to store the new sequence, or click New Bin to create and open a new bin, then click OK. An untitled sequence appears in the bin, in the Record monitor, and in the Timeline.

2. (Option) In the bin, click the Name field and rename the new sequence.

**Changing the Name and Timecode for a Sequence**

To rename a new sequence and set a start timecode:

1. Do one of the following:
   - From a bin, right-click a sequence and select Sequence Report. You can select multiple sequences for generating reports.
   - With a sequence loaded in a monitor, right-click the monitor and select Sequence Report.

   The Sequence Report dialog box opens.
Creating a New Sequence

Start timecode text box (left) and Start key number text box (right, for 24p or 25p projects only) in the Sequence Report dialog box

2. Type a new name in the Name text box.

3. Drag the pointer across the start timecode (Starting TC) to select it, and type a new timecode.

   You need to type only the first colon (non-drop-frame timecode) or semicolon (drop-frame timecode). For example, type 01:000000 for 01:00:00:00. For information about non-drop-frame and drop-frame timecode, see “Understanding Timecode” on page 192.

4. For film projects, select the start key number (Starting EC) and type a new start key number.

5. Click Apply Changes.

6. Click OK.

   You can also change the default start timecodes for all new sequences by using General settings. For more information, see “General Settings” on page 1499.
To change the start timecode of a sequence in a bin:
1. In the bin, click the start time for the sequence in the Start column.
2. Type a new timecode.

Track Display for New Sequences

When you create a new sequence with the New Sequence command and no material is loaded in the Source monitor, the Timeline displays a default set of tracks—the master timecode track (TC1), at least one video track (V1), and at least two audio tracks (A1 and A2). For film projects, the output timecode format tracks and EC (edgecode) track also display.

You can change the initial set of tracks that display in the Timeline in the Edit tab of the Timeline Settings dialog box. For more information, see “Timeline Settings: Edit Tab” on page 1526.

You can add up to 24 audio or video tracks to a sequence. For more information, see “Adding and Deleting Tracks” on page 715. You can also add one Data (D1) track for ancillary data (closed captioning). For more information, see “Preserving HD Closed Captioning and Ancillary Data” on page 1123.

The following illustration shows the default Timeline for a new sequence, with no material loaded in the Source monitor.

User Preferences for Creating Tracks

There are two options in the Edit tab of the Composer Settings dialog box that help automate the way you create and enable tracks. You can adjust these settings in advance, based on personal preference.

For information on opening and changing settings, see “Viewing and Modifying Settings” on page 1421.
The default settings are:

- **Auto-create New Tracks**: Whenever you edit new source material from the Source monitor, the system automatically creates any new tracks in the sequence that match enabled tracks on the source side.

- **Auto-enable Source Tracks**: Whenever you load new source material into the Source monitor, the system automatically enables all existing source tracks.

Alternatively, you can do the following:

- Deselect **Auto-create New Tracks** to have the existing tracks in the sequence remain the same when you edit in new source material. This lets you create new tracks selectively as you edit.

- Deselect **Auto-enable Source Tracks** to leave the tracks of newly loaded material in whatever state they were in when they were last loaded. This lets you turn on the source tracks more selectively as you edit.

### Adding Filler

You can add a small amount of black filler at the start of your sequence. A brief moment of black before the start of your sequence is sometimes useful during playback or when recording a digital cut. You can also add filler to another part of the sequence at any time during editing.

> You cannot add filler to the end of a sequence or to an empty sequence. You can create black title media and insert it at the end of a sequence. For information about creating title media, see “Creating Titles” in the Help.

**To add filler at the start of a sequence, do one of the following:**

- Select Clip > Add Filler at Start.

- Right-click in the Timeline, and select Add Filler at Start.

  Filler appears at the beginning of the sequence in the Timeline. You can set a default duration for the filler in the Edit tab of the Timeline Settings dialog box. For more information, see “Timeline Settings: Edit Tab” on page 1526.

**To add filler anywhere in a sequence:**

1. Click above the Source monitor, and select Load Filler from the Clip Name menu.
   
   The system loads a 2-minute clip of filler into the Source monitor.

2. Mark the amount of filler that you want to add.

   For more information, see “Marking IN and OUT Points” on page 545.

3. Do one of the following:
Move the position indicator for the sequence to the point where you want to add the filler.

Mark an In point at the point in the sequence where you want to add the filler.

4. Click the Splice-in or Overwrite button to edit the filler into the sequence.

For more information, see “Performing an Insert or Splice-in Edit” on page 591 and “Performing an Overwrite Edit” on page 592.

Making a First Edit

This topic describes a method for adding a first clip to a sequence. You can use this method after you create a new sequence, as described in “Creating a New Sequence” on page 583. You can also use this method without creating a new sequence in advance, in which case the sequence is created as soon as you make the edit.

To begin editing:

1. Load the first clip into a monitor.

   For more information, see “Loading and Clearing Footage” on page 530.

2. (Option) If you have not already marked In and Out points for the clip in advance or created a subclip, view and mark the clip.

   For more information, see “Marking and Subcataloging Footage” on page 545.

3. Click buttons in the Track Selector panel to select the tracks you want to include in the edit.

   Only the tracks that you capture for the clip appear as source tracks in the Timeline. For more information on using the Track Selector panel, see “Understanding the Track Selector Panel” on page 703.

   For example, with a talking head you might select tracks V1 (picture) and A2 (sound) if the voice was recorded on that track. You would deselect track A1, that might have unwanted wild sound picked up from a second microphone or no sound at all.
As another example, if you lay down a music track first, you would select track A1 or A2 depending on where the music was recorded, and deselect V1.

4. Click the Splice-in button to add the edit to the sequence in the Record monitor.

The Record monitor displays the end of the last frame of the new edit. (You can drag the position indicator in the Timeline or the position bar beneath the monitor to review the clip.) The edit also generates a graphical display of the cut in the Timeline.

Creating an Instant Rough Cut

As an alternative to creating a new sequence by editing clips one at a time, you can create a rough cut by creating a storyboard in the bin, and then load these clips directly into the Timeline.

For additional information on editing directly from the bin into the Timeline, see “Bin Editing into the Timeline” on page 701.

To create a rough cut from a bin:

1. In the bin, sort the clips in the order in which you want them to appear in the sequence.

   For example, in Frame view, arrange the bin so that you can drag clips into the storyboard order you want.

2. Select the tracks for the edit.
If no sequences are loaded in the Record monitor, the Timeline has no features.

3. Do one of the following:
   - Ctrl+click (Windows) or Command+click (Macintosh) the clips.
   - Lasso the clips by dragging left to right and down to select more than one clip.
     For more information, see “Selecting Clips and Sequences” on page 351.
   - Select Edit > Select All if there are no other clips in the bin.

4. Do one of the following:
   - Drag the selected clips to the Timeline to splice the clips into place.
   - Shift-drag the selected clips to the Record monitor.
   - Alt-drag (Windows) or Option-drag (Macintosh) the selected clips to the Record monitor.
     The clips splice together to form a new sequence based on the order in which they were listed in the bin.

Undoing or Redoing Edits

You can undo or redo up to 100 previous actions listed in the Edit menu. You can undo or redo a just completed command, or you can search through a submenu to undo or redo all commands leading back to a particular command.

You can limit the Undo function to undo only record actions by selecting the Undo Only Record Events option in the Edit tab of the Composer Settings dialog box.

For example, you can select the Undo Only Record Events option and then mark several In and Out points in clips loaded in the Source monitor. If you decide to undo the last edit made to the sequence, then you would not lose the In and Out points in the source clips.

**To undo only the previous edit or function, do one of the following:**
- Select Edit > Undo.
- Press Ctrl+Z.

**To redo only the previous edit or function, do one of the following:**
- Select Edit > Redo.
- Press Ctrl+R.

**To undo or redo every edit and function back to a particular command:**
- Select Edit > Undo/Redo List, and then select a command.
  
  All the previous commands, including the command selected from the submenu, are undone or redone.

## Editing Additional Clips into the Sequence

There are three primary edit functions for adding material to your sequence:

- Insert (splice-in)
- Overwrite
- Replace edit

In most cases, you perform three-point edits in which you set three marks—two in the source material and one in the sequence, or the reverse. The fourth mark is determined automatically. The way you set marks depends on the type of edit you perform.

You can use two marks or sometimes one mark to complete an edit using phantom marks. For more information, see “Working with Phantom Marks” on page 627.

### Performing an Insert or Splice-in Edit

An insert or splice-in edit inserts marked source material into the sequence without replacing material already in the sequence.
Existing material moves beyond the spliced material, lengthening the overall duration of the sequence.

A splice-in edit. Clip 3 in the sequence moves down when you splice clip 4 in at the insertion point (red line).

**To perform an insert edit:**

1. Load a clip into the Source monitor.
2. Mark an In point and an Out point.
3. Mark an In point in the sequence as follows:
   a. Move the position indicator for the sequence to the point where you want to splice the clip into the sequence.
   b. Click the Mark In button, or press the Mark In key.
4. Click the Splice-in button (yellow) to complete the edit.

*If you do not mark an In point, the system splices the new clip into the sequence at the current location of the position indicator.*

Performing an Overwrite Edit

An overwrite edit replaces a section of the sequence with the selected source material.

An overwrite edit replaces existing material and does not lengthen the overall duration of the sequence unless the material used to overwrite goes beyond the end of the sequence.

An overwrite edit. Clip 4 overwrites parts of clips 2 and 3 (shaded in red) when you edit it in at the insertion point (red line).
To perform an overwrite edit:

1. Load a clip into the Source monitor.
2. In the monitor, mark an In or Out point, but not both, to show the start or end of the clip you want to use.
3. In the Record monitor, mark both an In point and an Out point to select the material in the sequence you want to overwrite.
   You can also mark an Out point and move the position indicator to the In point.
4. Click the Overwrite button (red) to complete the edit.

Performing a Replace Edit

The Replace Edit button (blue) replaces a clip in the sequence (video, audio, or both) with new source material, while maintaining the original In and Out points of the previous edit.

A replace edit. Clip 4 replaces clip 3 and maintains the IN and OUT points for the original edit.

By default, the Replace Edit button is located on the Edit tab of the Command Palette. You can use it from the Command Palette or map it to a monitor palette. For information about mapping buttons, see “Understanding Button Mapping” on page 129.

Sync Point editing, which is similar to replace editing, lets you overwrite material in the sequence based on the alignment of position indicators in the source material and in the Timeline. The difference is that Sync Point edits end at the nearest marks in either the source or record material, and replace edits always fill the In to Out portion of the clip in the sequence. For more information on sync point editing, see “Sync Point Editing” on page 621.

To perform a replace edit:

1. Move the position indicator to select a sync frame in the source clip.
   The frame displays in the monitor.
   The sync frame can be an In point, Out point, or any frame in between that you want to sync to a frame in the existing clip in the sequence.
2. Move the position indicator to select the sync frame in the sequence for the edited segment that you want to replace.
3. Click the Replace Edit button (blue).
The system calculates In and Out points for the source material by using the sync frames and the existing In and Out points in the sequence for the previously edited clip that you want to replace.

*When you select the tracks you want, check the durations before you perform the edit. If you replace a clip in an overlap edit and the position indicator falls within the overlap, you might end up replacing the wrong material unless you select the entire segment you want to replace. See “Selecting and Deselecting Segments” on page 689.*

### Enabling Single-Mark Editing

Single-mark editing lets you establish a single mark, and then use the location of the position indicator to determine the second mark when making the edit. You can use this procedure in several ways to save steps:

- You can mark an In point in the Source monitor and then perform a splice-in, overwrite, or replace edit without marking an Out point.
- You can mark an Out point, locate a frame for the In point, and then perform the edit without marking the In point.
- You can mark the In or Out point, play, step (jog), or shuttle through the clip forward or backward, and then press the Splice-in, Overwrite, or Replace Edit button to perform the edit on-the-fly without adding the second mark.

To enable single-mark editing:

1. In the Project window, click the Settings tab.
2. Double-click Composer.
   
   The Composer Settings dialog box opens.
3. In the Edit tab, select Single Mark Editing.
4. Click OK.

### Mixing Frame Rates and Field Motion Types

You can work with clips of any frame rate or field motion type (interlaced or progressive) in a project, regardless of the project’s type. For example, you can work with 30i clips in a 24p project. In your Avid editing application and in this documentation, clips that do not match the frame rate or field motion type of the project are known as mixed rate clips.

You can view and play mixed rate clips in the Source monitor or in pop-up monitors. You can also edit mixed rate clips into a sequence.
Mixed rate clips always play at the project’s frame rate, both in Source or pop-up monitors and in sequences. Audio remains synchronized with video. You can stack clips with different frame rates or field motion types on multiple video tracks, apply effects, and otherwise perform all normal editing operations.

How Your Avid Editing Application Handles Mixed Rate Clips

Motion Adapter Effects

Your Avid editing application uses Motion Adapter effects to handle:

- Clips that have a different frame rate from the project’s frame rate
- Clips with field motion that need adjustment to be compatible with the project
- Clips with 2:3 pulldown or strobe frames

Motion Adapter effects allow mixed rate clips to play at the project’s frame rate and to have the correct field motion.

Motion Adapter effects are different from other effects in several ways:

- You do not apply Motion Adapter effects manually. The Motion Adapter effect does not appear in the Effect Palette and does not have an effect icon. Your Avid editing application applies Motion Adapter effects and sets their parameter values automatically.
- Your Avid editing application applies Motion Adapter effects when they load into a Source or pop-up monitor for viewing and playing as well as when they are edited into a sequence.

If you load a traditional (source-side) motion effect that has a different frame rate from the project’s frame rate, it is automatically promoted. In the case of Strobe Motion effects, the update rate of the strobe motion is adjusted so that the effect maintains the same look at the project’s frame rate.

- You cannot remove a Motion Adapter effect that adjusts the speed of a clip with the Remove Effect button. If you promote a Motion Adapter effect to a Timewarp effect and then use the Remove Effect button to remove the Timewarp, your Avid editing application re-applies a Motion Adapter effect.
- You often do not need to adjust Motion Adapter effects. Most of the time, they work automatically and seamlessly to allow mixed rate clips to play correctly in a project. For information on when you might want to adjust a Motion Adapter effect and on how to do so, see “Viewing and Adjusting Motion Adapter Parameters” on page 597.

You might need to provide accurate frame layout information for a clip, such as its field motion or whether it contains pulldown. For information on how to do this, and more details of the circumstances that might require it, see “Modifying the Field Motion Attribute for a Clip” on page 599.
User Interface Summary for Mixed Rate Clips

<table>
<thead>
<tr>
<th>Illustration</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Illustration" /></td>
<td>In the Timeline, several visual indicators highlight mixed rate clips. For more information, see “Viewing Mixed Rate Clips in the Timeline” on page 597.</td>
</tr>
<tr>
<td><img src="image2.png" alt="Illustration" /></td>
<td>In the Motion Effect Editor, you can view the parameter values for a Motion Adapter effect, and adjust the render type. To make further adjustments, you need to promote the Motion Adapter effect to a Timewarp effect. For more information, see “Viewing and Adjusting Motion Adapter Parameters” on page 597.</td>
</tr>
<tr>
<td><img src="image3.png" alt="Illustration" /></td>
<td>In the bin, the Field Motion column provides field motion and frame layout information for a clip. Motion Adapter effects use the Field Motion attribute value to determine their Source parameter value. For more information, see “Modifying the Field Motion Attribute for a Clip” on page 599 and “Refreshing Sequences to Use Current Clip Attributes” on page 608.</td>
</tr>
<tr>
<td><img src="image4.png" alt="Illustration" /></td>
<td>In the Modify dialog box, set a new format for a sequence to create a version of the sequence that plays at a different rate from its original rate. You can then work with that sequence in a project that uses the new frame rate. For more information, see “How Your Avid Editing Application Reformats Clips in Sequences” on page 603 and “Changing the Sequence Format” on page 1605.</td>
</tr>
</tbody>
</table>
**Viewing Mixed Rate Clips in the Timeline**

Mixed rate clips that are unrendered always appear with a green dot that represents the Motion Adapter effect, the green dot appears on mixed rate clips edited into a sequence. If you use the Toggle Source/Record button to view the Timeline for a mixed rate clip loaded in the Source monitor, you also see the green dot on that clip.

Mixed rate clips also display with their original frame rate appended to the clip name. For example, if you have a 24 fps clip named `sunset` that you edit into a sequence with a frame rate other than 24 fps, the clip name displays as `sunset (24.00 fps)`.

The illustration shows a mixed rate clip in the Timeline.

![sunset (24.00 FPS)](image)

To further distinguish mixed rate clips from other material in the Timeline, you can display them in distinct colors. For more information, see “Displaying Clip Colors in the Timeline” on page 667.

**Viewing and Adjusting Motion Adapter Parameters**

Use the Motion Effect Editor to view and adjust parameters for a Motion Adapter effect.

To change the appearance of a mixed rate clip, you can select a different rendering option from the Type list to change the way your Avid editing application interprets and displays frames.

The other Motion Adapter effect parameters are inactive. You can check the values your Avid editing application has calculated, but you cannot change them.

If you need to make other adjustments, promote the Motion Adapter effect to a Timewarp effect. The full set of Timewarp effect parameters become available and you can freely change or animate the speed at which the clip plays.

The illustration shows the Motion Adapter effect in the Motion Effect Editor, with the Type list and the Promote button active, and other parameters inactive.
In some circumstances, the Adaptive Deinterlace Source option is active in the Motion Effect Editor for a Motion Adapter effect. Adaptive deinterlacing is a processing option that can improve the look of interlaced source material that is being converted to progressive frames. For more information, see “Using Adaptive Deinterlacing” in the Help.

To view parameter values for a motion adapter and adjust the render type:

1. Move the position indicator to the mixed rate clip that uses the Motion Adapter effect you want to adjust.

2. Click the Motion Effect button.

   The Motion Effect Editor opens and displays the current parameter settings for the Motion Adapter effect.

   The system displays the current parameter values for the adapter. If you have not yet made any manual adjustments to the adapter, the values you see are those your Avid editing application created automatically. For example, you see a Speed percentage value that adjusts the clip’s speed to the project’s rate.

   The Type list (render options) is active. The Adaptive Deinterlace Source option might also be active. Other parameters are inactive.
3. Select a rendering option from the Type list.
   For information on the rendering types available, see “Rendering Options for Timewarp Effects” in the Help.

**To promote a motion adapter to a Timewarp effect**

1. Move the position indicator to the mixed rate clip that uses the motion adapter you want to adjust.
2. Click the Motion Effect button.
   The Motion Effect Editor opens.
3. Click the Promote button.
   The motion adapter is promoted to a Timewarp effect and all standard Timewarp effect parameters are available.
4. Adjust the Timewarp parameters as necessary to create the motion that you want for the clip.

**Modifying the Field Motion Attribute for a Clip**

The Field Motion bin column contains information about the frame layout of a clip or subclip. It indicates whether the clip is interlaced or progressive, or whether it contains 2:3 pulldown or repeated (strobe) frames. The Field Motion attribute sets the default Source parameter value for the Motion Adapter effect.

When you create a clip or subclip, its Field Motion attribute is set to either Interlaced or Progressive, depending on the project type. In most cases this value accurately represents the field motion of the clip or subclip, but you sometimes need to override the value to match the actual field motion of the video source or to indicate that the source contains 2:3 pulldown or repeated frames.

The illustration shows the Field Motion bin column and the menu that lets you change the Field Motion attribute value.
Changes you make to the Field Motion attribute apply only to the individual clip or subclip. You can have several subclips derived from the same master clip, and set different Field Motion values on each of them.

When you change the Field Motion attribute of a clip, it updates if it is loaded in a Source or pop-up monitor, and new edits into a sequence from the clip use the new Field Motion attribute value. However, edits that you made from that clip before you change the Field Motion attribute continue to use the old value. If you want to update a sequence so that all its Motion Adapter effects use the current Field Motion attribute values for their source clips, refresh the Motion Adapter effects for the sequence. For more information, see “Refreshing Sequences to Use Current Clip Attributes” on page 608.

To modify the Field Motion attribute for a clip or subclip:

1. Open the bin that contains the clip or subclip you want to modify.
   For more information, see “Opening and Closing Bins” on page 90.
2. (Option) If it is not already visible, display the Field Motion bin heading.
   For more information, see “Using Text View” on page 341.
3. Click the Field Motion item for the clip or subclip, and select one of the following:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interlaced</td>
<td>Use for all video with interlaced field motion.</td>
</tr>
<tr>
<td>2:3 Film</td>
<td>Only available for clips or subclips created in 30 fps projects.</td>
</tr>
<tr>
<td></td>
<td>Use for a clip or subclip that contains 2:3 pulldown.</td>
</tr>
<tr>
<td></td>
<td>Video material can contain pulldown frames in a number of circumstances, such as the following:</td>
</tr>
<tr>
<td></td>
<td>• The telecine process inserts pulldown frames when it transfers film footage shot at 24 fps to 30 fps video.</td>
</tr>
<tr>
<td></td>
<td>• Some cameras can shoot at 24 fps but record at 30 fps, and insert pulldown frames to achieve the record frame rate.</td>
</tr>
<tr>
<td></td>
<td>• Some HD video decks insert pulldown frames when downconverting material, for example, from 1080p/24 to NTSC 30i.</td>
</tr>
<tr>
<td>Progressive</td>
<td>Use for progressive video.</td>
</tr>
<tr>
<td>Progressive Strobe</td>
<td>Use for a clip or subclip that contains repeated frames, for example, a traditional strobe motion effect clip, or a clip where the original video was shot at a reduced frame rate such as 15 fps.</td>
</tr>
<tr>
<td></td>
<td>Usually results in a better finished look because blending between frames reduces stuttering motion.</td>
</tr>
</tbody>
</table>
Considerations When Working with Mixed Rate Clips

Playback of Mixed Rate Material with Different Frame Sizes

When your mixed rate sequence includes clips of different frame sizes, consider using the High-Quality Scaling for Real-Time Decode setting. This setting improves image quality during playback of mixed-format sequences where material requires resizing. For more information, see “Video Display Settings” on page 1531.

Playback of Mixed Rate Material Using XDCAM AMA Media

Playback limitations when you work with XDCAM AMA media on an optical disk are particularly noticeable with mixed rate sequences or with mixed rate clips loaded into the Source monitor. Consider consolidating the media to a local disk. For more information, see “Using XDCAM and XDCAM EX and XDCAM SR AMA Plug-Ins” on page 436.

Behavior of Mixed Rate Material at Different Video Quality Settings

Be aware of the following if you work with mixed rate clips when you use the Draft Quality, Best Performance, or DNxHD Native video quality options:

- You do not see an accurate pulldown cadence when you field-step through material where pulldown is inserted. This is a limitation of Timewarp and Motion Adapter effects when you work in draft qualities. If you switch to Full Quality, or render the Motion Adapter effects, the pulldown cadence is correct.

- Playback of clips whose frame rate do not match the sequence frame rate might be jumpy when you use Draft Quality. To achieve smooth playback, you can either use Full Quality or render the motion adapters for the relevant clips.

Transcoding Mixed Rate Material

You can transcode clips of any edit rate, including clips that you have edited into a sequence, to any resolution available within your current project.

You might need to transcode mixed-rate material as part of common workflows like offline/online conversion or creation of a QuickTime reference movie. You also might want to transcode mixed-rate material in order to homogenize your sequence and transfer it to an editing application that cannot conform mixed-rate sequences, such as an Avid DS version older than 10.3, or an older Media Composer application. You can also use transcoding for general clip conversion tasks such as removing 2:3 pulldown from 29.97i sources (to generate 23.976 sources), or generating NTSC material from a PAL source.

Once the transcode process completes, you can edit with the clips directly, or you can batch capture or import if you have access to original sources at the new rate. The transcoded material uses the project’s edit rate, so the new clips no longer require motion adapters when you edit.
them into sequences in the same project type. When existing material in a sequence is transcoded across edit rates, your Avid editing application automatically removes motion adapters and adjusts Timewarp effects.

Your Avid editing application creates new clips whose duration and start and end timecode matches the original clips as closely as possible and which are as compatible as possible with the project’s edit rate. However, due to roundoff error, you might see minor variations in clip duration or in frame offset information that could result in such issues as minor audio/video differences (for example, slips of 1 or 2 frames).

In some cases, the last frame of a transcoded clip might be offline. Avid recommends using non-zero handles when you transcode sequences with mixed-rate clips to minimize the chance of seeing offline frames.

You should check transcoded sequences carefully and adjust any variations from the original sequences that are not acceptable to you, for example, by trimming.

You cannot transcode clips across edit rates using the Transcode Server in Interplay.

Grouped Clips and Mixed Rate Material

Be aware of the following if you group clips or work with grouped clips:

- You cannot group clips that have different frame rates
- You cannot load a grouped clip whose frame rate does not match the project's frame rate. If you load this type of clip into the Source monitor or drag it into the Timeline, an error message appears.
- You can create a sequence that includes both grouped clips that have the same frame rate as the project and single clips of other frame rates.

Working with Markers on Mixed Rate Material

You should be aware of the following when you work with markers on mixed rate material:

- Depending on the frame rates of your clips and your project, you might not be able to add a marker at the exact location of the position indicator. For example, if you add a marker to a 30 fps clip in a 720p/59.94 project, you can move the position indicator to a location that does not match a frame in the clip. Your Avid editing application adds the marker at the closest valid location in the clip.
- Depending on the frame rates of your clips and your project, you might not be able to access all of the markers on a clip in the Source monitor. For example, if you load a 720p/59.94 clip in a 30 fps project, the position bar in the Source monitor cannot display every marker position. You can use the Markers Window to access all the markers. For more information, see “Using the Markers Window” on page 559.
Effect Templates and Mixed Rate Material

You can use effect templates that you save in bins with clips of all frame rates and in sequences of any project type. When you apply a template, your Avid editing application adjusts keyframes if necessary to account for differences in frame rate.

Dynamic Relink and Mixed Rate Material

You can enable the Dynamic Relink feature to work with mixed rate clips. However, Dynamic Relink behaves slightly differently when it operates on clips that do not match the frame rate of the project. For more information, see “Using Dynamic Relink with Mixed Rate Clips” on page 1354.

⚠️ Motion adapters do not conform in versions of Avid DS prior to version 10.3. You cannot play or adjust mixed rate material in these versions. Do not include mixed rate clips in sequences that you intend to finish on an Avid DS system running an older version of Avid DS than version 10.3.

Mixing Frame Sizes and Aspect Ratios

You can work with media of different frame sizes, aspect ratios, and pixel aspect ratios in the same sequence. For example, you can mix SD 4:3, HD 16:9, and film formats.

How Your Avid Editing Application Reformats Clips in Sequences

Your Avid editing application reformats a clip in a sequence when the aspect ratio, pixel aspect ratio, or frame size of the clip do not match those of the project. Your Avid editing application automatically resizes and repositions these clips to match the project’s format settings.

You need to ensure that your project’s format settings are set correctly so that clips are reformatted properly. For more information, see “Creating a New Project” on page 156 and “Changing the Aspect Ratio for a Project” on page 604.

When you change a format setting, for example, the aspect ratio for an SD project, all clips currently edited in a sequence immediately adapt to the new format. You do not need to re-edit any clips in your sequences. When you next view the sequence, you see any changes to the size and position of clips.

By default, your Avid editing application reformats clips to fill the frame by stretching. You can set other reformatting options by changing the Reformat attribute for that clip in the bin. For more information, see “Modifying the Reformat Attribute for a Clip” on page 605.
Changing the Aspect Ratio for a Project

You typically set the aspect ratio for a project when you create the project (see “Creating a New Project” on page 156). The aspect ratio can be changed at any time, however this will affect any titles that you have created, so the titles also need to be recreated at the new aspect ratio.

For HD projects, only the 16:9 aspect ratio is available as this is the only aspect ratio allowed in the HD standard.

To change the aspect ratio for a project, do one of the following:

- Click the Format tab in the Project window, then click the Aspect Ratio menu, and select either 4:3 or 16:9, depending on the aspect ratio you want to use.

- Right-click in the monitor window in Source/Record or in Trim mode, select Project Aspect Ratio, and then select either 4:3 or 16:9, depending on the aspect ratio you want to use.

Your Avid editing application changes the aspect ratio of the monitors, and resizes and repositions any material in the project’s sequences that does not match the new aspect ratio so that it conforms to that aspect ratio. You see these changes when you next open and view an affected sequence. You do not need to re-edit the media into the sequence, and the source media remains unchanged.

To recreate titles at the new aspect ratio:

1. After you have switched to the new aspect ratio, select a clip on the timeline that has a title that you need to recreate.

2. From the main menu, select Clip > Recreate Title Media.

   A new title will be recreated in the bin with the new aspect ratio.

3. Continue recreating all other titles on your timeline using the same steps.
Modifying the Reformat Attribute for a Clip

Your Avid editing application uses the Reformat attribute of a clip to resize and reposition the clip so that it conforms to the current frame size and aspect ratio specified in the Project Settings. When you create a clip or subclip, the Reformat attribute is automatically set to Stretch. If you are using AMA to link to clips, then the default is set to Center Keep Size.

You can modify this Reformat attribute at any time. Reformat options apply only when a clip does not match the project aspect ratio. For a list of these options, see “Reformatting Options Reference” on page 606.

If you are working in an Interplay environment, do not change the Reformat attribute from the Stretch setting. If you use a different setting, and you then use Interplay Transcode or Send to Playback, the results might not be what you expect.

The illustration shows the Reformat bin column and the menu that lets you choose a Reformatting Option.

Changes you make to the Reformat attribute apply only to the selected clip in the bin. You can have several subclips derived from the same master clip, and set different Reformatting Options on each of them.

When you change the Reformat attribute of a clip, it updates if it is loaded in a Source or pop-up monitor, and new edits into a sequence using this clip use the new Reformatting Option. However, previous edits using this clip continue to use the old value. If you want to update a sequence so that all versions of this clip in a sequence use the current Reformat attribute, refresh the Reformatting Options for the sequence. For more information, see “Refreshing Sequences to Use Current Clip Attributes” on page 608.

To set the Reformat value for an individual clip or subclip:

1. Open the bin containing the clip or subclip you want to modify.
   For more information, see “Opening and Closing Bins” on page 90.
2. Click the Text tab.
3. (Option) If it is not already visible, display the Reformat bin heading.
   For more information, see “Using Text View” on page 341.
4. Click the Reformat field for the clip or sub-clip, and select an option.
   Options apply only to clips that do not match the frame size and aspect ratio of the project.
   For more information, see “Reformatting Options Reference” on page 606.

**Reformatting Options Reference**

The table describes the choices available under the Reformat bin heading and their effect when you edit a clip into a sequence of a different size or aspect ratio. These options have no effect on clips that do match the project size and aspect ratio. For information on how to set the reformatting options for a clip, see “Mixing Frame Sizes and Aspect Ratios” on page 603.

*In all reformatting options, the center of the source material is set by default to the center of the sequence frame. You can reformat the clip manually by using the “Center Keep Size” reformatting option and then using the Resize effect to modify the position of a clip after you edit it into a sequence.*

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stretch</td>
<td>Scales the clip to match the width and height dimensions of the sequence. If the clip’s aspect ratio does not match the sequence’s aspect ratio the image is distorted (stretched or squeezed).</td>
</tr>
</tbody>
</table>

The illustration shows an example where a 4:3 clip is placed in a 16:9 sequence. The clip is stretched horizontally to accommodate the width of the sequence.
Mixing Frame Sizes and Aspect Ratios

Option | Description
--- | ---
Pillarbox/Letterbox preserve aspect ratio | Scales the clip to create the largest possible image without cropping, while maintaining the original aspect ratio.

The illustration shows two examples. When you edit a 16:9 clip into a 4:3 sequence (left), the resulting segment has horizontal bars at the top and the bottom. When you edit a 4:3 clip into a 16:9 sequence (right), the resulting segment has vertical bars at the sides.

Center crop, preserve aspect ratio | Scales and crops the clip to be the smallest size possible while filling the entire frame. The resulting image is centered in the frame.

The illustration shows two examples. When you edit a 16:9 clip into a 4:3 sequence (left), the resulting segment is cropped at the sides. When you edit a 4:3 clip into a 16:9 sequence (right), the top and the bottom of the segment are cropped.

Center, keep original size | Centers the clip in the sequence but does not resize it. If the source clip is not the same size as the sequence, the clip is either cropped or does not cover the whole of the sequence frame.
Refreshing Sequences to Use Current Clip Attributes

You can change certain attribute values or settings for any master clip in a bin. You can change these settings even if a clip has already been used in a sequence. If you want the change to be reflected, you can refresh the sequence to use the latest values for just one, or all attributes.

Make sure that you are applying the attributes to the appropriate clip in the bin. The same clip may exist as an AMA-linked clip or a transcoded clip.

To refresh a sequence, do one of the following:

- Load the sequence into the Record monitor and then, with either the Composer window or the Timeline window active, select Clip > Refresh Sequence > refresh command.
- Right-click the sequence in the bin, and then select Refresh Sequence > refresh command.

The following table describes the refresh commands that are available:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Motion Adapters/Timewarps</td>
<td>Refreshes the sequence so that media with Motion Adapters or Timewarps use the current Field Motion attribute value from their source clip.</td>
</tr>
<tr>
<td>Aspect Ratio and Reformatting Options</td>
<td>Refreshes the sequence so that clips whose frame size or aspect ratio have been changed now use the attributes set on the master clip.</td>
</tr>
<tr>
<td>Color Adapters</td>
<td>Refreshes the sequence so that clips whose color space has been changed now use the attributes set on the master clip.</td>
</tr>
<tr>
<td>AMA Plug-in Settings</td>
<td>Refreshes the sequence so that clips whose AMA source settings have changed now use the attributes set on the master clip.</td>
</tr>
<tr>
<td>Stereo Correction Effects</td>
<td>Refreshes the sequence so that all source-side effects applied to stereoscopic clips in the bins are updated accordingly in the sequence.</td>
</tr>
<tr>
<td>All</td>
<td>Refreshes the sequence so that it uses the current values for all of the individual options listed above.</td>
</tr>
</tbody>
</table>

To refresh multiple sequences:

- Use the Shift or Control keys to select multiple sequences in the bin, then right-click the selection, and select Refresh Sequence > refresh command.
Lifting, Extracting, and Copying Material

Lifting, extracting, and copying let you remove or reposition material quickly in your sequence. For example, you can move a clip from the end of your sequence to the beginning; or you can remove the material from the sequence altogether. Your Avid editing application places the material you remove into the Clipboard. You can then paste the material elsewhere in the sequence or into another sequence.

You can also remove and reposition segments. For more information, see “Working with Segments” on page 688.

Lifting removes selected material from a track in the sequence and leaves black filler or silence to fill the gap. You can later move or fill this gap with other footage. When you lift material, the overall duration of the track (or sequence) remains the same.

Extracting removes selected material from a track in the sequence and closes the gap left by its removal. When you extract material, you shorten the duration of the track or sequence.

Comparison of Lift and Extract operations. Lifting material (left) leaves a gap that is replaced with black filler, and the length of the sequence remains the same. Extracting material (right) closes up the gap that the material previously occupied, and the sequence becomes shorter. In both cases, the material you remove is placed into the Clipboard.

The Copy to Clipboard function makes a duplicate of selected material in the sequence and leaves the material intact. When you copy material, the sequence remains unaffected. You can then insert the material elsewhere in the sequence or into another sequence.

To lift material:

1. Mark In and Out points at the start and end of the material in the sequence that you want to lift.
2. Select the tracks containing the material.
   
   The system performs the function on selected tracks only. For more information on track selection, see “Understanding the Track Selector Panel” on page 703.
3. Click the Lift button in the Edit tab of the Command palette to complete the edit.
To extract material:

1. Mark In and Out points at the start and end of the material in the sequence that you want to extract.

2. Select the tracks containing the material.
   
   The system performs the function on selected tracks only. If sync locks are on, all material on all tracks is extracted. For more information, see “Understanding the Track Selector Panel” on page 703 and “Understanding Locking and Sync Locking” on page 713.

3. Click the Extract button in the Edit tab of the Command palette to complete the edit.

To copy material to the Clipboard:

1. Mark In and Out points at the start and end of the material in the sequence that you want to copy.

2. Select the tracks containing the material.
   
   The system performs the function on selected tracks only. For more information on track selection, see “Understanding the Track Selector Panel” on page 703.

3. Click the Copy to Clipboard button.
   
   The system copies the selected material to the Clipboard, and leaves the sequence untouched.

Using the Avid Clipboard

The Avid Clipboard is a cut, copy, and paste tool adapted to the special needs of the editing environment.

The Copy to Clipboard function is useful for moving or repeating material in a sequence without moving multiple segments or for rebuilding the section at another location. For example, you can:

- Copy a portion of a sequence for pasting into another sequence.
- Isolate and copy a portion of an audio track for looping music or repeating a sound effect.
- Copy graphic elements for repeating at other locations in a format cut.

The Clipboard stores only one clip at a time. Each time you copy, lift, or extract additional material, you delete and replace the previous contents. However, you can preserve clipboard content for the duration of your working session when you add it as a clip to the Source monitor’s Clip Name menu. All the clips added remain available in menu until you select Clear Menu or close the project.
The Clipboard lets you restore lifted or extracted segments quickly. This is useful if you have performed one or more edits since removing the material. In contrast, if you use the Undo function to restore the material, your Avid editing application also undoes all edits performed in the meantime.

*Material in the Clipboard does not appear as a clip in the bin and is deleted when you close the project. To save a portion of a sequence for future use, mark the section and create a subclip.*

**To place a marked section of the sequence into the Clipboard at any time:**
- Click the Lift, Extract, or Copy to Clipboard buttons.

**To keep the Clipboard contents throughout a session, do one of the following:**
- Click the Clip Name menu above the Source monitor, and select Clipboard Contents. The contents appear as a clip in the Source monitor, and the name “Clipboard Contents.n” appears above the monitor and in the Clip Name menu. The \( n \) is an incremental numbering of clips placed in the Clipboard during the session.
- Press Alt key (Windows) or Option key (Macintosh) when you copy, lift, or extract the material. The contents appear as a clip in the Source monitor, and the name “Sequence name.Sub” appears above the monitor and in the Clip Name menu.

**To restore material from the Clipboard:**
1. Load the Clipboard contents by doing one of the following:
   - Click the Clip Name menu above the Source monitor, and select Clipboard Contents to place the Clipboard contents into the Source monitor and add the clip name to the Clip Name menu.
   - Click the Clipboard Contents button in the Edit tab of the Command Palette.
   - Open the Clipboard as a pop-up monitor by selecting Tools > Clipboard Monitor.
2. Click the Mark Clip button to mark the entire segment.
3. (Option) Click the Toggle Source/Record button in the Timeline toolbar to view, mark and select specific tracks.
4. Locate the In point in the sequence from which the segment was removed. Move the position indicator here, or mark an In point.
5. Splice or overwrite the material into the sequence.
Adding Comments to Sequence Clips

When you add comments to sequence clips, they appear in the Timeline or in lists that you create, such as an EDL or a cut list. Comments can include instructions for color correction or for adjusting an effect.

To add comments to the clips in a sequence:

1. Click one of the Segment buttons (located in the Timeline palette), and highlight the clip to which you want to add a comment in the Timeline.

![Segment Overwrite button (red) and the Segment Insert button (yellow)](image)

2. Click the Clip Name menu above the monitor, and select Add Comments.

The Comments dialog box opens.

3. Type your comments in the text box, and click OK.

To display comments in the Timeline:

- Click the Timeline Fast menu button, and select Clip Text.

Playing Back a Sequence

You can play a sequence at any time to see the results of your editing. You can view the sequence in the Record monitor or a Client monitor.

You can also play back your sequence in a continuous loop by augmenting the Play In to Out command with the Alt key (Windows) or Control key (Macintosh). You must set marks in the sequence to determine the range of the playback loop.

- Use looping playback to isolate and continuously play back a small portion of a sequence during a difficult edit.

- If you have several tracks of audio, you might need to mix them down and adjust levels before playback. For more information, see “Mixing Down Audio Tracks” on page 836.

To play a sequence:

1. Click the Video Track Monitor icon located on the uppermost video track to display all video tracks and effects during playback.

2. Click the Active/Inactive button to ensure proper playback of the audio tracks.
3. Click the Data Track Monitor button to ensure proper playback of the data track.
   
   You can only monitor and view the data on a client monitor capable of handling ancillary data. The hardware or client monitor needs to be able to decode ancillary data to playback your media. You can not playback from the Source or Record monitor.

4. Go to the start of the sequence. Click the left side of the position bar to reposition the position indicator at the beginning or press the Home key on the keyboard.

5. Use the position indicator, buttons, mouse, or keyboard to play, step, or shuttle through footage. View the sequence in the Record monitor or the Client monitor.

**To start a playback loop:**

1. Mark In and Out points in the sequence. To play back the entire sequence, mark the In point at the beginning and the Out point at the end.

2. Press and hold the Alt key (Windows) or Ctrl key (Macintosh) while you press the Play In to Out key, or click the Play In to Out button in the Play tab of the Command palette.

   The playback loop begins and continues until you press the space bar or click anywhere with the mouse.

   *You can also press and hold the Alt key (Windows) or Ctrl key (Macintosh) while you click the Play to Out button. The location of the position indicator acts as the In point for a continuous loop.*

**Playback Performance Tips**

As you edit, you might find the playback performance of your Avid editing application diminishing as the sequence grows in length and layers. This happens when you use a great deal of system memory for playback of large and complex sequences. The following are a few tips for improving playback performance:

- Check the number of media objects in use for your project in the Memory window (see “Using the Info Tab” on page 102). If this number is large, reduce the number of media objects by doing one of the following:
  
  - Close bins that are not in use.
  - Reduce the number of clips in the open bins.
  - Unmount drives that are currently not in use.

  See “Mounting and Unmounting Drives” on page 471. You can remount the drives at any time by selecting File > Mount All.

- When displaying real-time effects, adjust the video quality (see “Setting the Video Quality for Playback” on page 544).
• Restart your computer once a day to refresh the system memory.
• Split the sequence into two or more segments, if possible.

**Playing a Limited Duration of a Sequence**

Long sequences with many effects can be time-consuming to work with in the Timeline. Working with a shorter sequence can save time. The Play Length Toggle feature lets you switch between playing the entire sequence and playing a limited duration centered around the current position of the sequence. When you use the Play Length Toggle feature, the Play button and Play Length Toggle button change to white.

**To play a limited duration of a sequence:**

1. Map the Play Length Toggle button from the Play tab of the Command palette to a monitor toolbar button.
   
   For information about mapping buttons, see “Understanding Button Mapping” on page 129.

2. Move the position indicator to the location where you want to start playing the sequence.

3. Click the Play Length Toggle button.
   
   The Play button and the Play Length Toggle button change to white, indicating the Play Length Toggle feature is active.

4. Click the Play button.
   
   The sequence plays for the default Play Length, which is 1 minute.

5. To set the Play Length back to play the entire sequence, click the Play Length Toggle button again.

**Understanding Sync Breaks**

Sync breaks occur when a frame-accurate relationship between two clips or between the audio and video tracks within a single clip is offset during editing. Your Avid editing application provides several features to avoid, track, and remove sync breaks.

In many cases, sync breaks are the unavoidable result of selecting only one track in a synced relationship (for example, audio only or video only), and performing edit functions that change the duration of that track when you extract, splice-in, or add or remove frames.

By default, the Timeline displays sync breaks whenever they occur while you edit. They appear at break points as white numbers indicating negative or positive offset values relative to zero. The Sync Breaks option also displays match-frame edits as an equal sign (=) on the edits. For more information on match frames, see “Working with Add Edits (Match Frames)” on page 722.
You encounter sync breaks and match frames in different circumstances:

- You can encounter sync breaks in one or several video tracks, audio tracks, data track, or all. Sync-break offset numbers appear by default only in the affected tracks.
- You encounter match-frame cuts whenever you perform an add edit or whenever you move a segment next to footage from the same clip and the timecode is continuous across the edit.

You can customize the Timeline view to display sync breaks and match-frame edits in video tracks only, audio tracks only, or neither. For more information, see “Fixing Sync Breaks” on page 616.

The Sync Breaks feature applies only to master clips in which audio and video tracks were captured simultaneously, to autosynced subclips, or to any other subclip with video and audio tracks.

**Tips for Avoiding Sync Breaks**

One way to avoid breaking sync is to maintain the duration of the track when you add or remove material. The following table provides tips on how to do this in different circumstances:

<table>
<thead>
<tr>
<th>Task</th>
<th>Tips</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add material to a track</td>
<td>Use the Overwrite or Replace functions instead of Splice-in.</td>
</tr>
<tr>
<td></td>
<td>For more information on overwrite and replace editing, see “Performing an Overwrite Edit” on page 592 and “Performing a Replace Edit” on page 593.</td>
</tr>
<tr>
<td>Remove material from a track</td>
<td>Use Lift instead of Extract. (The Lift function leaves filler of the same duration when you remove footage.)</td>
</tr>
<tr>
<td></td>
<td>For more information, see “Lifting, Extracting, and Copying Material” on page 609.</td>
</tr>
<tr>
<td>Perform Segment edits</td>
<td>Use the Lift/Overwrite function instead of Extract/Splice-in. (Lift/Overwrite leaves filler behind and overwrites material at the new destination, maintaining sync in both cases.)</td>
</tr>
<tr>
<td></td>
<td>For more information, see “Working with Segments” on page 688.</td>
</tr>
</tbody>
</table>
You fix sync breaks by eliminating the overlapping portion of out-of-sync tracks. You can do this in one of several ways, depending on the type of break and your sequence. For more information, see “Tips for Fixing Sync Breaks” on page 616.
You can customize the sync breaks display in the Timeline, for example to limit the display to video tracks only. This can reduce clutter and help you focus on a particular set of fixes.

**To restore frames to sync while Trimming:**
- Perform one or more single-roller trims on the out-of-sync tracks.
  - Trim the exact number of sync-break frames displayed in the Timeline to reverse the break.
  - For more information on performing trims, see “Working with Trim Edits” on page 731.

**To fix sync in Source/Record mode:**
- Add new material or extract material from the out-of-sync track.
  - Add or extract the exact number of offset frames displayed in the Timeline.

**To fix sync when Segment editing:**
- Select and move the entire out-of-sync segment.
  - You can move the segment forward or backward in the opposite direction of the break to reverse it. For more information on editing segments, see “Working with Segments” on page 688.

**To customize the Sync Breaks display:**
- Click the Timeline Fast Menu button, and select Sync Breaks > *option*.

### Understanding Sync Lock

The Sync Lock feature lets you maintain sync among several tracks while you add, move, trim, or remove material in a sequence. For example, if you insert an edit into one track that is sync locked to a second track, the system automatically inserts filler in the second track to maintain sync between the two.

---

[Image: Sync Lock icon (top) and Sync Lock All button (bottom) in the Track Selector Panel]
There are several unique aspects to sync locking:

- You control sync lock by the Segment Drag Sync Locks option in the Edit tab of the Timeline Settings dialog and the Sync Lock icons in the Timeline. For more information on sync locking tracks, see “Maintaining Sync with Segment Edits” on page 695.

- When trimming, sync lock applies only to single-roller trims because dual-roller trims do not break sync. For more information on sync locking tracks when trimming, see “Maintaining Sync While Trimming” on page 751.

- You can sync lock any number of tracks in any combination. The tracks do not require matching timecode or common sources and can include multiple video tracks as well as audio tracks.

- Sync lock affects entire tracks. This means that parallel segments in other sync-locked tracks are affected when you add, move, trim, or remove material anywhere in the sequence.

**Syncing with Tail Leader**

You can add tail leader to the audio or video material to provide a useful visual reference in the Timeline for tracking and fixing sync breaks across any number of tracks.

Film editors traditionally use standard head and tail leaders for this purpose. You can create your own leader according to any specification, as described in “Creating Video and Audio Leaders” on page 629.

With tail leader added to synchronized tracks, you can go to the end of the sequence after you make a complicated edit and see if the leaders line up. If they are out of line, this indicates a sync break that you can eliminate.

**To eliminate a sync break when the leaders do not line up:**

1. Move the position indicator to the black segment that follows the out-of-sync leader.

2. Select the track, and then click the Mark Clip button. You can measure the break by checking the In to Out duration of the marked segment.

3. Find the point at which the sync was lost.

4. Use the appropriate edit function to add or remove frames, as described in “Fixing Sync Breaks” on page 616.

5. (Option) For a quick fix, click the Segment insert (yellow arrow) button. Drag the black segment at the end of the out-of-sync tail leader to the location where the sync was lost. This segment of black, created when the track went out of sync, is the exact length of the sync break.
Syncing with Markers

You can add markers to material in the Timeline to track and adjust breaks in sync between any number of tracks. You can place markers anywhere in the sequence and you can add specific notes.

For more information on using markers, see “Using Markers” on page 550.

To mark sync points with markers:

1. Move the position indicator to the point in the sequence where you want to maintain sync between two or more tracks.
2. Select all tracks where you want the markers to appear.
3. Click an Add Marker button.

The system adds a marker to the enabled tracks in the Timeline and in the Record monitor.

Example of markers in sync in the Timeline

To add a note whenever you park on the marker frame (such as Music sync or Sound Effect sync):

1. Double-click the marker in the Record monitor.
2. Type your comments in the comment entry area of the Marker window.

The note appears in the Record monitor.

To determine if sync is broken after an edit:

- Return to the segment that contains the markers and click the Focus button.
  If the markers are not lined up, the sync is broken.
- (Option) Use the Find procedure to go to a marker quickly with text. For more information, see “Finding Frames, Clips, and Bins” on page 566.

To adjust the sync break:

1. Measure the sync break:
   a. Move the position indicator to the leftmost marker and click the Mark In button.
   b. Move the position indicator to the other markers, and click the Mark Out button.
2. Check the In to Out duration of the marked section.
To restore sync:

1. Find the point at which the sync was lost.
2. Use the appropriate edit function to add or remove frames, as described in “Fixing Sync Breaks” on page 616.

Using Add Edit When Trimming

When you trim with several audio tracks in sync, you can create an edit in the silent or black areas of the synced tracks. They occur in line with the track you trim, and they trim all the tracks at once to maintain sync.

You can also add an edit to filler. For more information, see “Working with Add Edits (Match Frames)” on page 722.

To use the Add Edit button while trimming:

1. Move the position indicator to the edit that you want to trim.
2. Select only the additional tracks that are in sync, and click the Add Edit button.
   The system adds a transition at the location of your position indicator in the Timeline.
3. Select the transition and trim (be sure to select all the synced tracks).
   As you trim, the system adds or removes frames from the additional tracks.
4. When you finish trimming, select Clip > Remove Match Frame Edits to remove the add edits from the sync tracks.

Ganging Footage in Monitors

The Gang function does not combine tracks into a synced relationship but locks monitors in sync so that you can move through footage in two or more monitors simultaneously. This function is convenient when you view and mark the sequence and source material simultaneously, based on syncing of the position indicators in each monitor.

You can gang the Source monitor and any number of pop-up monitors with the Record monitor. For instance, before you edit them into a sequence, you can gang a music track in a pop-up monitor, source footage in the Source monitor, and a sequence in the Record monitor. Then you can view the footage, adjust the sync points, and mark them before you complete the edit.

The Gang button appears by default in the second row of buttons below the Source and Record monitors.
To gang footage in monitors:

1. Load a sequence into the Record monitor.
2. Load one or more clips into the Source monitor and pop-up monitors.
3. Click the Gang button for each monitor that you want to synchronize (the Record monitor is always ganged).
4. View the footage in any of the monitors.

As you move through footage in one monitor, the footage in all other monitors freezes. The footage is updated when the play stops. Simultaneous full-motion playback is not possible, although the system maintains sync at all times.

Sync Point Editing

Sync Point editing lets you overwrite material onto your sequence so that a particular point in the source material is in sync with a particular point in the sequence. For example, you can sync an action in the source video with an audio event, such as a musical beat in the Record monitor, and then edit it so that the action occurs on the beat.

Like a replace edit, Sync Point editing uses the relative location of the position indicator in both the source and record material as the sync point. Sync Point editing, however, determines the duration of the new edit according to marks that you set, as opposed to a replace edit, which uses the head-to-tail frame duration already established in the Timeline. You can apply these marks across multiple tracks when you mark a sequence. This lets you add overlap cuts.

Sync Point editing requires two pieces of information:

- Sync points: The points where the synchronized relationship between the source and record material is established.
- Duration of the relationship: This is determined by the positions of the head and tail frames (and sometimes by the position indicator). Both marks are in one monitor, or one mark is in one monitor and the other mark is in the other monitor. The duration of the material being edited into the sequence is sufficient for the size of the edit.

To perform a sync point edit:

1. Load a clip or sequence into the Source monitor.
2. Load a sequence into the Record monitor.
3. Mark the material in one of the following ways:
   ▶ Mark the In and Out points in either the Source or Record monitor, leaving the opposite monitor clear of marks.
• Mark an In or Out point in the Source monitor, or an In or Out point in the Record monitor. For example, if you marked an In point in the Source monitor, mark the Out point in the Record monitor.

4. Move the source position indicator to the sync frame in the clip.
   This establishes the source sync point.

5. Move the record position indicator to the sync frame in the sequence.

6. Select Sync Point Editing (Overwrites) in the Edit tab of the Composer Settings dialog box or select Special > Sync Point Editing.
   The orange mark on the Overwrite button signals Sync Point editing is active.

7. Select the source and record tracks for this edit, then click the Overwrite button.
   The system completes the sync point edit.

Autosyncing Clips

When you capture footage that includes both audio and video, your Avid editing application automatically establishes sync when it creates clips in the bin. Autosyncing applies to audio and video clips that you capture separately, usually from two separate sources. Autosyncing creates a new subclip that displays sync breaks in the Timeline as though the audio and video were captured simultaneously.

Example of sync break information in the Timeline

For more information on tracking sync breaks, see “Fixing Sync Breaks” on page 616.

Understanding Autosyncing

Autosyncing is often used for projects in which picture and sound were captured separately. These clips are often synced based on common film timecode, sound timecode, or auxiliary timecode.

You can also autosync™ any audio and video clips based on a user-defined In point or Out point relationship that you establish with marks. For example, you can use the slate as a common visual and audio reference for autosyncing the clips.
Use the following guidelines when autosyncing:

- You can autosync audio clips with video clips only. To link two or more video clips or audio clips, use the Grouping option described in “Understanding Grouping and Multigrouping Clips” on page 1374.
- You can create only one autosynced subclip at a time. You cannot autosync numerous pairs of audio and video clips simultaneously.
- If the audio and video clips do not have matching source or auxiliary timecode, you must establish common sync frames. To do this, mark In points (or Out points) on both clips before you autosync. When you autosync using this method, the whole clip is taken into the subclip.
- If you autosync clips of different lengths, the longer clip is truncated to the length of the shorter clip; video clips override audio clips.
- If you autosync according to common timecodes that are staggered (one clip starts later than the other), the later starting timecode becomes the start of the new subclip. The clip with the earlier starting timecode is trimmed accordingly.

Creating an Autosynced Subclip

To create an autosynced subclip:

1. Highlight two or more clips in the bin.
2. Select Bin > AutoSync.
   
   The Sync Selection dialog box opens.
3. Select an option, based on the following:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Film TC/Sound TC</td>
<td>Use this option if you sync clips with matching film and sound timecode recorded in the field. This option appears dimmed if you are not in a 24p or 25p project.</td>
</tr>
<tr>
<td>Inpoints</td>
<td>Use this option if you sync two clips at a time according to In points set in both clips.</td>
</tr>
<tr>
<td>Outpoints</td>
<td>Use this option if you sync two clips at a time according to Out points set in both clips.</td>
</tr>
<tr>
<td>Source Timecode</td>
<td>Use this option if the two clips have matching timecode or to Autosync multiple clips, use the Start timecode. The default option.</td>
</tr>
</tbody>
</table>
4. Click OK.

The subclip is created and named by default after the video clip with the file name extension .sync.n, where n is the incremental number of subclips created with the same name.

You can change the name according to preference. You can load an autosynched subclip into the Source monitor and immediately edit it into a sequence.

In a 35mm 4 perf or 35mm 3 perf project type, you can "perf slipped" the subclip up to a 1/4 frame in either direction for even tighter sync.

Understanding AutoSequence

AutoSequence is used when picture and sound are captured separately. AutoSequence lets you add audio or video to the original videotape if it was transferred without sound or picture. You can also use the AutoSequence feature to organize dailies without having to duplicate source clips when you move them to other bins.

For information and procedures for Autosync, see “Autosyncing Clips” on page 622.
To establish sync with the original videotape, use filler to add where gaps in audio or video exist in the sequence. After you finish editing the audio or video, you can use the Digital Cut command to output only the audio, or both audio and video only the video onto the original videotape.

If you do not use AutoSync and the video clip timecode does not match the audio clip timecode, you should select only video clips when you use AutoSequence. You can then add audio to the sequence and sync the audio with the video by using the Splice-in and Overwrite functions.

You can use the AutoSequence command with imported or AMA linked clips. You can also AutoSequence multiple clips together with non-continuous timecode, closing the gap on the filler in your sequence. This is helpful if you want to create a rough cut sequence with imported or linked clips.

Use the following guidelines when you create a synchronized sequence:

- Your original videotape must have continuous timecode.
- Use only master clips, subclips, autosynced subclips, and/or group clips to create the synchronized sequence.
- If you select two unrelated clips with overlapping timecodes, a message box indicates you cannot do this operation. If the clips are related (for example, one clip is a subclip of the other master clip), then one of the clips is selected automatically.
- The system removes and ignores points in the clips. A message box provides you with a choice to continue and remove the points or to cancel the operation.
- Synchronized sequences are named from the Tape Name column for tape-based media and the Source File column for file-based media.

Adding Audio or Video to Original Videotape Using AutoSequence

⚠️ If you add audio only, make sure the video tracks are not enabled when you begin recording a digital cut. If you add video only, make sure you do not enable audio tracks when you record a digital cut.

To add audio or video to your original videotape:

1. (Option) Use the AutoSync command to create synchronized subclips from your tape’s master clips and your audio or video clips.
2. Open the bins that contain the clips you want to include in the sequence.
3. Select the clips.
4. Select Bin > AutoSequence.
The system creates a synchronized sequence with the clips you selected. The new sequence appears in the Record monitor and in the Timeline. The sequence also appears in the bin with the same name as the tape name (for tape-based media) or the same name as the source file name (for file-based media) with a .xx (.01, .02, .03) extension.

5. Edit the audio or video tracks.

6. Record a digital cut of the audio or video directly onto the original videotape when you finish editing the sequence.

7. (Option) Press and hold the Alt (Windows) or Option key (Macintosh) while you select Bin > AutoSequence to build a sequence without filler.

The system creates a sequence without gaps by placing the clips in ascending timecode order.

**Resyncing Subframe Audio**

When you work with a 24p or 25p project (35mm, 4-perf or 35mm, 3-perf only), you can adjust the sync between the audio and video portions of subclips at the subframe or perforation level (1/4-frame adjustments for 4-perf and 1/3-frame adjustment for 3-perf) for more exact sync.

When you perform a subframe resync, you can obtain a closer relationship between audio samples and film frames than the relationship established in the film-to-tape transfer process. For example, when a film lab punches the correct clapsticks frame to match the audio clap, during telecine transfer, the process of aligning the sync points is inexact. As a result, true sync might be off by one or more perforations.

The following conditions apply to resyncing at the perforation level:

- You can adjust the sync between a single video and a single audio track within subclips only. Use the subclips created:
  - When you autosync
  - Manually from master clips in preparation for editing
  - From an imported shot log
  - While you capture
- From imported audio media (OMFI, AIFF-C, or WAVE format), master clips generated by AudioSuite plug-ins, or tone generator media

- You cannot slip at the perforation level of the imported QuickTime audio media.

*The batch import process does not create new clips; therefore, slipping at the perforation level is not available when you batch import audio clips from Symphony versions earlier than v3.5.3 and Avid editing application versions earlier than v10.5.3.*

- You cannot slip beyond the duration boundaries of the source master clip.

- The sync adjustments you make are referenced in any cut list you output for any sequence that uses the adjusted subclip.

- The number of perfs you slip appears in the Slip column when you select the Slip heading to display in the bin.

---

**Resyncing Audio for a Selected Subclip**

**To resync audio for a selected subclip:**

1. Load the subclip into the Source monitor.

2. Use one of the audio scrub techniques described in “Using Audio Scrub” on page 768 to locate the closing slate frame.

3. Click Slip Left One Perf or Slip Right One Perf button to move the audio sync either backward or forward in 1-perf increments.

   Each click of the perf button performs the sync adjustment.

4. Play the subclip in the Source monitor to evaluate your sync adjustment. Repeat the previous steps to further adjust the sync, up to eight perfs in either direction.

5. Use the resynced clip to edit into the sequence.

*If you find a subclip frame sync problem within an edited sequence, be sure to correct the audio sync in the original subclip used in the edit. The sequence is then updated. The telecine facility must correct sync problems with 16mm format.*

---

**Working with Phantom Marks**

Phantom marks provide visual guidance when you edit according to the three-mark rules. For information on editing using three marks, see “Editing Additional Clips into the Sequence” on page 591.
To enable phantom marks:

1. In the Settings tab of the Project window, double-click Composer. The Composer Settings dialog box opens.
2. In the Edit tab, select Phantom Marks., and then click OK.

When you enable phantom marks, your Avid editing application displays blue mark In or Out icons in the position bars below both the Source and the Record monitors. These phantom marks indicate one, two, or sometimes three edit points calculated by your Avid editing application to complete an edit.

The following examples illustrate two typical scenarios.

**Setting One Mark**

In this example, you set only the mark In on the source side. By default, your Avid editing application uses the location of the position indicator as the mark In for the sequence and calculates both Out points based on the length of the source clip.

![One mark IN set (left) and three phantom marks (right)](image)

You can see your Avid editing application calculations instantly and can make the edit after you set just one mark.

**Adding a Second Mark**

If you decide that a mark Out is required — to shorten the source clip, for example — then your Avid editing application recalculates and displays new phantom marks.

![Phantom marks added (left) with updated phantom marks (right)](image)

Phantom marks can help you see the results of marks you set before you complete the edit and are useful when you perform a Sync Point edit or other complicated replace edits in which two or more marks calculate automatically.
Creating Video and Audio Leaders

Film editors use standard head and tail leaders to cue and sync material. You can use digital leaders in your Avid editing application to mark the beginning and end of tracks and to help you maintain sync, as described in “Syncing with Tail Leader” on page 618. You can create your own leader for video or film. Whatever you choose for specifications, make all your leader clips the same length, with common sync points.

To create leaders for picture tracks:

1. Create a black screen in the Title tool for tail leader, or a white screen for head leader.

   For information on using the Title tool, see “Creating Titles” in the Help.

2. (Option) Type a title onto the screen that says Tail Leader or Head Leader.

3. Name this clip Head Leader or Tail Leader when you save the title.

4. Create a subclip from an appropriate length of the clip, according to your chosen specifications.

5. (Option) Mark a sync frame in the subclip as follows:

   a. Load the clip into the Source monitor.

   b. Find an appropriate sync point, and add a marker.

      For more information, see “Using Markers” on page 550.

   c. (Option) Double-click the marker in the Source monitor to add a sync point notation that appears on the monitor.

      Once you prepare the leader, you can splice the leader while you edit onto the tracks that you want to keep in sync. You can use the sync points for visually aligning tracks.

To create tail leader for audio tracks:

1. Load a clip that includes a section of captured tone into the Source monitor.

2. Create a subclip according to your chosen specifications.

3. Name this new subclip Head Leader or Tail Leader.

4. Load this subclip into the Source monitor.

5. To prepare the sound levels for leader without a sync point (no audio pop), open the Audio Mixer tool and bring the audio level all the way down for the entire clip.

6. Prepare the sound levels for leader that include a sync point (audio pop) by doing the following:

   a. Find the appropriate sync point.

      Step one frame backward and place an add edit before the sync frame; then step two frames forward and place an add edit after the sync frame.
For information on placing add edits, see “Working with Add Edits (Match Frames)” on page 722.

b. Move the position indicator before the first add edit, and open the Audio Mixer tool.

c. Bring the audio level all the way down.

d. Move the position indicator after the second add edit, and use the Audio Mixer tool to bring the level all the way down.

After you prepare the leader, you can splice the leader while you edit onto the audio tracks that you want to keep in sync. You can use the sync points for visually aligning tracks.
Script-Based Editing

The following topics provide information about working with script-based editing:

- Understanding Lined Scripts
- Script Integration — Lining in the Digital Realm
- Understanding the Script Window
- Working with the Script Window
- Working with Script Text
- Working with Page or Scene Numbers and Searching in a Script
- Linking Clips to a Script
- Interpolating Position for Script Integration
- Working with Slates in the Script Window
- Working with Takes in the Script Window
- Indicating Off-Screen Dialog in a Script
- Using Color Indicators in the Script Window
- Script Marks
- Finding Clips and Script
- Editing From the Script Window

Understanding Lined Scripts

The conventional lined script evolved during decades of trial and error in Hollywood. It provides assistant editors and chief editors with a road map that helps them find the coverage they need to edit scenes in a film or television show.

The script-based editing feature in your Avid editing application lets you adapt the lined script to the digital realm for use in any type of production, from drama to documentary to spot advertising. For more information, see “Script Integration — Lining in the Digital Realm” on page 633.

A traditional lined script is created by hand at the time of shooting. The following is an example of a scene from a lined script.
Each vertical line drawn through the scene represents a single take from the moment the director says “Action” to the moment the director says “Cut.” Each scene might require several camera angles and positions, with one or more takes, all of which are lined and identified alphanumerically.

The following table summarizes the lining techniques and numbering system shown in the example.

<table>
<thead>
<tr>
<th>Master shot</th>
<th>The line labeled 33/1 is the master shot that usually covers all the action in a wide shot. The first number in the label indicates the scene number as written on the script (scene 33). The number following the slash indicates that this is the first take captured on film for the master shot. A second take of the master shot, for example, would be labeled 33/2.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Additional setups</td>
<td>The lines for each subsequent camera setup within the scene are labeled with the scene number (33 in our example) followed by a letter for each setup, followed by a slash and the number of the take within that setup. These lines can be any length, depending upon what portion of the script is covered by the particular shot.</td>
</tr>
</tbody>
</table>
When the scene is recorded — for example, in a sitcom shoot — the lined script can also include timecode notes written next to specific lines of dialog that represent a sync point between the dialog on the page and the recorded dialog. These sync points provide assistant editors or chief editors with a quick path to specific points in the source material.

Script Integration — Lining in the Digital Realm

Script integration in your Avid editing application enhances the traditional lined script system described in “Understanding Lined Scripts” on page 631.

Unlike the traditional lining of a script, digital script integration usually happens after the shoot. For example, the assistant editor uses the notes of the continuity person as the basis for script integration. The following is an example of the script shown in “Understanding Lined Scripts” on page 631, prepared and lined using script integration.

Off-screen dialog

The jagged lines in the script represent the parts of dialog where the actor is off screen. For example, the character Mary Sue is off camera during the action described in the second paragraph (when the waitress character enters), so a jagged line is drawn through the shots that cover Mary Sue (33A/1 and 2).
In addition to the standard lining conventions, script integration includes the following enhancements:

<table>
<thead>
<tr>
<th>Slates</th>
<th>Takes</th>
<th>Indicators</th>
<th>Script marks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Takes are organized into slates that display a representative frame and clip name for the take that is currently selected.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>The Takes tabs and lines extending from the bottom of each slate indicate the number of takes for that scene. Click a Takes tab to select the take.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>You can apply off-screen dialog indicators or colors to indicate such things as preferred takes, takes used in the current active sequence, or line changes in dialog.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>The double arrows marking the takes at various points represent marked lines of dialog in the script that are synchronized to matching dialog in the source clip. Script marks are especially effective during editing, allowing the editor to quickly locate dialog and piece together parts of a scene.</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The Script window provides additional controls for matching back to clips in the source bins, loading and playing back takes, and searching for takes and script text.

**Script Integration Workflow**

The basic workflow for script integration is as follows:

1. The continuity person or an assistant creates the lined script in hardcopy form during shooting.

2. Source footage from the shoot is prepared and captured by using methods described in “Creating a New Project” on page 156.

3. The assistant editor uses the lined script from the shoot, a text file of the script itself, and methods described throughout this chapter to import and line the script, link clips to the script, place script marks, and customize the display of takes prior to editing.

4. The editor uses the fully prepared Script window to edit the program.
Using Script Integration in Video Projects

Script integration is an effective tool for editing any type of production, not just feature films and television drama. For example:

- You can adapt many of the procedures described in this chapter for use in audiovisual scripts for documentaries, corporate spots, news magazine segments, and spot advertisements.
- You can turn script integration into a quick storyboarding tool by positioning selected slates in the Script window and printing storyboard bins that include your script.

The following is an example of an audiovisual script for a news magazine piece imported into the Script window, with the basic features of script integration applied.

Left to right: narration track synced to the script, B-roll shots ready to be loaded and cued (color indicates preferred shots), music cuts linked to appropriate sections of the script.

Understanding the Script Window

You begin the script integration process by importing a script into a project. The script appears in a script bin, and opens in a Script window.
Script Settings

You use settings in the Script Settings dialog box to control how scripts display in the Script window and how the Script window behaves. You should make changes to these settings before you open a Script window. After the Script window is open, any changes you make in the Script Settings dialog box are ignored by the window. You must close the Script window and then reopen it for the new settings to take effect.

However, the Script menu provides several commands that override the Script settings. Script menu commands are described throughout this chapter.

You can also specify the text encoding of the script from the Script menu. This ensures that diacritical marks and multibyte character sets appear correctly in your script.

Script Window Behavior

The Script window behaves in many respects like a bin:

- When you make changes in the Script window, an asterisk appears in the title bar to indicate that the changes are not yet saved.
- The Script window has the same auto-save functionality as bins, based on the auto-save options in the Bin settings.
- Your Avid editing application saves Script window files in the project folder along with bins, and stores backup copies automatically in the Avid Attic folder.

When you save a Script window, the saved file has an .avc file name extension.

You can navigate to any point in the text of a script by using basic techniques available in most word processors. You can also use several search features, as described in “Working with Page or Scene Numbers and Searching in a Script” on page 642.

You can resize a Script window at any time to show more script or to enlarge the right margin. The default size of the left margin is established on import, based on the current Script settings, but you can override the margin setting and adjust the left margin after importing the script.

You can open the Info window, which displays statistical information about a clip or sequence, directly from the Script window. The window updates the information automatically.

For details of basic Script window procedures, see “Working with the Script Window” on page 637.
Working with the Script Window

This topic describes basic procedures for working with Script windows, including importing script text, navigating through the script, displaying clip information, opening and closing windows, saving windows, and adjusting margins. For more information on the Script window, see “Understanding the Script Window” on page 635.

Before you begin creating Script windows, make sure you have established the proper defaults in the Script Settings dialog box for font, margin, and display of frames and takes.

To set Script settings:

1. Double-click Script in the Settings list in the Project window.
   The Script Settings dialog box opens.
2. Make the changes to settings that you need, and then click OK.
   For information on the settings, see “Script Settings” on page 1524.

To import a new script:

1. Place the script file in a local or network directory that is available to your Avid editing system.

The imported script must be in text format. To maintain the original formatting, however, export the script from your word processor by using the “Text Only with Line Breaks” option. If you export the script as “text” only, the formatting is lost.

2. Click the Bins tab in the Project window of your Avid editing application.
   The Bins list appears.
   The Open dialog box opens.
4. Select the file, and then click Open.
   A script bin appears in the Bins list in the Project window. The script, with its original layout, appears in the Script window.
5. Change the name of the script bin by clicking the title in the Bins list in the Project window, and typing a new name.

To select text encoding:

- Select Script > Text Encoding, and then select one of the following:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>Your Avid editing application uses your system’s default encoding. Select this option when the text was created on a system with the same system character set you are currently using. Use this option for non-Latin-based encoding where UTF-8 was not used.</td>
</tr>
<tr>
<td>Mac (MacRoman)</td>
<td>Select this option when the script was created on a Macintosh system using the MacRoman character set. This is the default encoding on Macintosh systems for plain text using the Latin character set.</td>
</tr>
<tr>
<td>PC (Latin-1)</td>
<td>Select this option when the script was created on a Windows-based system using the Latin-1 character set. This is the default encoding on Windows-based systems for plain text using the Latin character set.</td>
</tr>
<tr>
<td>UTF-8</td>
<td>Select this option when the script was created using the Unicode UTF-8 character set. Non-native characters might not display correctly even if they are encoded in UTF-8. The ability to display non-native characters is limited at this time.</td>
</tr>
</tbody>
</table>

To open, close, or save the Script window:

- To open a new script (.txt) file and add it to the Bins list in the Project window, select File > New Script.
To open existing Script window (.ave) files and add them to the Other Bins folder in the Bins list in the Project window, select File > Open Bin.

To close Script windows, select File > Close.

To save changes, select File > Save Script.

To save a copy of the Script window, select File > Save a Script Copy As.

To explore the Script window:
- Use the bar on the right to scroll up or down.
- Resize the window by dragging the size box in the lower right corner.
- Press the Page Down or Page Up key to move one screen at a time.
- Press the Home or End key to move to the beginning or end of the script.
- Press the Up Arrow or Down Arrow key to move your line selection up or down by one line.

To adjust the left margin of an imported script:
1. Select Script > Left Margin.
   The Left Margin dialog box opens.
2. Type a new margin size (in pixels) in the text box, and click OK.
   The Script window reflects the new setting.

To open the Info window from a Script window:
1. Press the Alt key (Windows) or the Option key (Macintosh), and click the Takes tab.
2. Drag the window to a new location to leave the Info window open.

Working with Script Text

The default font and font size for a script is established when you import the script, based on the current Script settings. You can override the settings and change the font and size after importing the script.

You can also cut, copy, paste, or remove selected lines of script to reflect changes that might occur during the course of a project. Selecting text in the Script window is similar to making selections in a word processor, except that the smallest unit you can select is an entire line of text. You cannot select or otherwise manipulate individual characters or words.

To rearrange or rewrite individual words or characters in a script, make the changes in a word processor, import them into a separate Script window, and then use the procedures in this topic to copy and paste the new lines into the existing Script window, overwriting the incorrect lines.
You cannot undo cut, copy, or paste operations in the Script window.

**To change the font and font size of imported script:**

1. Select Edit > Set Font.
   
   The Set Font dialog box opens.

2. Click the Font menu, and select a new font.
   
   The menu includes all fonts currently installed on your system.

3. Type a new font size in the text box, and click OK.
   
   The Script window reflects the new settings.

As you enlarge font size, the available sizes for the slate frames also increase. This is useful for presentation or screening purposes, when you need to display extra-large text and slate frames for a large audience or across a room. For information on enlarging slate frames, see “Working with Slates in the Script Window” on page 646.

**To select a single line of script:**

- Click anywhere in the line to highlight it.

**To select several lines of script, use one of the following methods:**

- Lasso the first line of the selection, drag through the text, and release the mouse button when you finish lassoing the lines you want to select.

  As you drag, a box outlines your selection. After you release the mouse button, the text is highlighted.
Example of a lasso to select a portion of a script

- Click the first line of the selection, and then Shift+click the last line. The entire block of text is highlighted.
- Press Ctrl+A (Windows) or Command+A (Macintosh) to select all the text and takes.

**To extend an existing selection:**
- Shift+click a line of text preceding or following the existing selection.

**To cut or copy lines of script and then paste them:**

1. Select the lines.
2. Select Edit > Cut or Edit > Copy.
3. Select the line below the location where you want to insert the text.
4. Select Edit > Paste.

   If you select only one line at the insertion point, a message box asks if you want to replace the selected line.

   If you select more than one line at the insertion point, no message box opens. When you select Edit > Paste, your Avid editing application replaces the selected lines with the text you cut or copied in step 2. You cannot use the Undo command after performing this step.

5. Do one of the following:
   - Click Replace to overwrite the selected line.
   - Click Insert Before to insert the text above the selected line.
Click Insert After to insert the text below the selected line.

The text is pasted into the script.

**To remove lines of script:**

1. Select the lines of script you want to delete.
2. Select Edit > Cut.

   Unlike a normal deletion, the text remains in the Windows Clipboard or Macintosh Clipboard until the next time you copy or cut a selection.

> You cannot delete lines of text from the Script window by using the Delete key as you would in a normal word processor. Use the Cut command to remove the text.

### Working with Page or Scene Numbers and Searching in a Script

Script integration provides a number of search tools you can use during the preparation phase, during editing, or during screenings. You can use page or scene numbers, or you can conduct a full-text search.

When you add page and scene numbers to the Script window, you gain the ability to search for them during preparation of the script and during editing. You can change a scene or page number to correct any errors that occur when adding numbers, and to reposition scene and page numbering to match script changes during postproduction.

> You can use the Find Bin and Find Script buttons to match back and forth between script and clips. For more information, see “Finding Clips and Script” on page 658.

**To add a page or scene number:**

1. Select the line of the script at the beginning of the scene or page.
2. Click the Add Scene (AS) or the Add Page (AP) button in the Script window toolbar, or select Script > Add Scene or Script > Add Page.

   ![AS AP]

   A dialog box opens.

3. Type the number for the scene or page, and click OK.
The scene number appears in the left margin. The page number appears in the right margin next to the first line of the selected region. Scene and page numbers both appear in the status bar at the bottom of the Script window and reflect your current position within the script. Each scene or page number continues throughout the script until you mark another line as the beginning of a new scene or page.

To change a page or scene number:
1. Select the beginning line of the scene or page.
2. Do one of the following:
   ▶ Click the Add Scene or the Add Page button in the Script window toolbar.
   ▶ Select Script > Add Scene or Script > Add Page.
   A dialog box opens.
3. Type a new number for the scene or page, and click OK.
4. If the renumbering affects page or scene numbers that precede or follow the current change, then repeat these steps as necessary.

To delete a page or scene number:
1. Select the first line of the scene or page.
   You can also delete all page or scene numbering throughout a range of the script by selecting the range of lines or the entire script.
2. Press the Delete key.
   The Delete dialog box opens.
3. Select the options for Delete scene(s) or Delete page break(s) as appropriate, and click OK.
   Your Avid editing application deletes the numbering from the Script window.
To search for a page or scene number:
1. Select Script > Go To Page or Script > Go To Scene.
   
   You can also click in the page or scene display in the status bar at the bottom of the Script window.
   
   The Go To Scene/Page dialog box opens.
2. Type the number of the scene or page, and click OK.
   
   The Script window scrolls to the page or scene, and the first line is highlighted. If you type a page or scene number that is not in the script, then no action occurs.

To search for text in a script:
1. With the Script window active, select Edit > Find.
   
   The Find dialog box opens.
2. Type the text you are looking for.
3. Select one of the optional search parameters, when appropriate:
   ▶ If you do not want the search to be case sensitive, select Ignore Case.
   ▶ If you do not want the search to highlight instances where your text is part of another word, select Whole Word.
4. Click OK.
   
   The first occurrence of the text is highlighted in the Script window.
5. Select Edit > Find Again to search for the next occurrence of the text.

Linking Clips to a Script

You can link clips to the script by hand.

To link clips to the script:
1. Open the script bin by double-clicking the Script Bin icon.
2. Open the source bin for the clips that you want to link to the script.
3. (Option) Sort the source clips to make the job easier:
   ▶ You can sort the Scene/Take column for an alphanumeric list of clips that matches their relative order in the script.
   ▶ If you are not working with scene and take information (for example, in a video documentary project), you can provide your own numbering for the clips in a custom column, or you can sort the clips manually in Frame view according to their order in the script. For more information on adding a custom column, see “Adding Customized
Columns to a Bin” on page 363.

4. Select the portion of the script that is covered by the first clip or clips.
5. Select the clip or clips in the source bin, and drag them to the highlighted text.
   Make sure the pointer is over the highlighted text before releasing the mouse button.

Drag one or more clips to the highlighted material in the Script window

A slate frame appears above the text, with one or more of the takes covering the scene as lines.

6. Continue to apply clips to additional portions of the script until you have finished creating all your slates.
   Alternatively, you can create slates one at a time, place script marks, and fine-tune the lining of each scene before proceeding to the next portion of the script.
Interpolating Position for Script Integration

Interpolate Position matches a clip to a take and lets you see where a particular line in the script would appear in the clip footage.

When you set Interpolate Position, your Avid editing application matches the length of the take in the script to the length of the clip in the Source monitor. The position indicator in the Source monitor corresponds to wherever you double-click in the take.

If you set a script mark in the take, the portions of the take on either side of the script mark are matched to the portions of the clip on either side of the IN point in the Source monitor.

You can change the default behavior before opening a script in the Script window by selecting Interpolate Position in the Script Settings dialog box. See “Script Settings” on page 636.

To set Interpolate Position:

- Select Script > Interpolate Position.

Working with Slates in the Script Window

Once you create a slate by dragging a clip into the Script window, you can manipulate the slate’s appearance and position. You can:

- Select one or more slates.
  Selecting multiple slates is especially useful when you are adding or deleting color or off-screen dialog indicators across takes, as described in “Working with Takes in the Script Window” on page 649.
- Resize slates in the same way that you resize frames in the bin in Frame view.
  You can also enlarge the font size of the script to increase the size of the slate frames. This can be useful for presentation or screening purposes when you need a large display for an audience. For information on resizing the font, see “Working with Script Text” on page 639.
- Hold slates on screen so that, as you scroll a script in the Script window, each slate remains on screen as long as the take lines to which it is linked remain on screen.
- Hide the representative frame that your Avid editing application displays by default for each slate.
  When you do this, your Avid editing application shows only the clip name to simplify the interface or speed up scrolling and movement in a complex Script window.
- Show only one take for each nonactive slate to minimize screen clutter.
• Adjust the position of slates to make room for more slates, to avoid blocking words, or to display takes over specific lines.
• Delete slates, for example, if you find that you no longer need the takes in the slate.

**To select slates, do one of the following:**
- Click a slate to select it.
- Shift+click additional slates to select all the active takes.
- Drag a lasso through a region of the script containing slates.
  All slates and takes within the lasso are selected.

**To enlarge or reduce the slates:**
- Select Edit > Enlarge Frame or Edit > Reduce Frame.

**To hold slates on screen, do one of the following:**
- Select Hold Slates Onscreen in the Script Settings dialog box before you open the Script window.
  For more information, see “Script Settings” on page 636.
- Select Script > Hold Slates Onscreen.

**To hide or show the slate frames, do one of the following:**
- Select or deselect Show Frames in the Script Settings dialog box before you open the Script window.
  For more information, see “Script Settings” on page 636.
- Select or deselect Script > Show Frames.
  When Show Frames is enabled, a check mark appears to the left of the Show Frames command.
  When Show Frames is deselected, the Script window shows only the clip names for the takes.
To control the number of takes that display for a nonactive slate, do one of the following:

- Select or deselect Show All Takes in the Script Settings dialog box before you open the Script window.
  
  For more information, see “Script Settings” on page 636.

- Select or deselect Script > Show All Takes.

  When Show All Takes is enabled, a check mark appears to the left of the Show Frames command.

  When Show All Takes is deselected, the Script window shows only one take for each nonactive slate.

To move a slate, do one of the following:

- To move a slate horizontally, drag it to the left or the right. If necessary, resize the Script window by dragging the size box.

- To move a slate vertically without moving the position of the take lines in the script, drag it up or down.

  The take lines remain fixed over the text to which they have been previously linked.

- To move the slate and all its take lines vertically to a new location in the script, Ctrl+drag (Windows) or Command+drag (Macintosh) the slate to the new location.

  As you move the slate, the takes continue to cover the same number of lines in the script. To lengthen or shorten the number of lines covered in the takes at the new location, see “Working with Takes in the Script Window” on page 649.
To delete a slate:
1. Select all the takes in the slate by pressing the Shift key and clicking the tab for each take.
2. Press the Delete key.
   The Delete dialog box opens.
3. Select Delete Takes, and click OK.
   The slate and all its takes are deleted from the script.

When you delete slates and takes from the Script window, the captured source clips remain in the source bins.

You cannot undo the deletion of slates. To restore a slate after deletion, you need to re-create the slate. See “Linking Clips to a Script” on page 644.

Working with Takes in the Script Window

Script integration provides a number of tools and techniques for manipulating the relationship between lined takes in the Script window and their source clips. You can:

- Select takes.
- Add and delete takes.
  You might want to delete a take if it has been applied to the wrong scene, or delete a bad take to simplify the script interface.
- Display take numbers.
- Change the representative frame that appears in the slate for a take.
- Load and play takes in the Source monitor.
- Change the length of a take line when you find that a take or group of take lines should begin earlier or end later in the script.

To select takes, do one of the following:

- Click any take tab to select it.
  The outline of the take changes to red, indicating that the take is active.
- Double-click any line in the take to select the take and load it into a monitor.
- Shift+click additional takes in the same slate or across slates to select them.
  Selecting multiple takes is especially useful when you add or delete color or off-screen dialog indicators. See “Using Color Indicators in the Script Window” on page 652 and “Indicating Off-Screen Dialog in a Script” on page 651.
- Drag a lasso through an entire region of the script.
All takes within the lasso are selected.

**To add another take to an existing slate:**
1. Select the region of the script that the take covers.
2. Open the bin that contains the clip for the take.
3. Drag the clip to the slate.

   The new take appears in the slate and is applied to the selected region of the script. You need to manually adjust the take lines if the new take covers a region different from the existing slate. See the procedure below.

**To delete one or more takes:**
1. Select the takes in the Script window.
2. Press the Delete key.
   The Delete dialog box opens.
3. Select Delete Takes, and click OK.
   The takes are deleted.

⚠️ **You cannot undo the deletion of takes. To restore a take after deletion, add the take again using the procedure above.**

**To display the take numbers in the tab of each take:**
- Type the numbers in the Take column of the source bin for the clips.

![Image of script window showing take numbers in tabs](Image)

Numbers in the Take column appear in the tabs for each take.
To change the representative frame that appears in the slate for a take:
1. Select the Takes tab in the Script window.
2. Press the appropriate arrow keys or step keys on the keyboard to advance the footage displayed in the slate forward or backward to the frame you want.
   
   You can also select multiple takes and advance them all at once.

To load individual takes into the Source monitor:
- Double-click any Takes tab.

To load multiple takes into the Source monitor:
- Select multiple takes, and then double-click any take you selected.

To play back a take, do one of the following:
- Double-click a take to load it into the Source monitor, and then click the Play button or press the Play key.
  
  The clip plays back and stops when it reaches the end.
- Select a take in the script, and then click the Play button at the top of the Script window.
  
  The clip loads and plays back in a continuous loop until you press the space bar. If you select more than one take, each take plays in sequence.

To change the length of a take line:
1. Press the Ctrl key (Windows) or the Command key (Macintosh).
   
   Notice the movement icon that appears when you place the pointer at either end of the take.
2. Click the end mark or beginning mark of a take, and drag it until you reach the correct line in the script.
3. Ctrl+drag (Windows) or Command+drag (Macintosh) the opposite end of the take to a new location, if necessary.
4. Repeat the procedure for other takes in the slate as necessary.

Indicating Off-Screen Dialog in a Script

In a traditional lined script, a jagged line next to the dialog indicate off-screen dialog. You can apply a similar effect to lines in the Script window.

To indicate off-screen dialog:
1. Select the range of script containing the off-screen dialog.
2. Select one or more takes that you want to mark with the off-screen indicator.
3. Click the Set Offscreen button in the Script window toolbar.

   The off-screen indicator appears, superimposed on the selected takes of the highlighted range of the script. You can switch the indicators on or off by clicking the button repeatedly.

**To remove one or more off-screen indicators:**
1. Select the range of script containing the off-screen indicators.
2. Select only those takes that display the indicators.
3. Click the Set Offscreen button.

---

**Using Color Indicators in the Script Window**

You can use color to indicate several pieces of information, including:
- Preferred takes or takes used in the current active sequence.
- Picture versus audio track used in the current active sequence.
- Line changes in dialog.
- Use of multiple cameras.

**To apply color to takes:**
1. Select Script > Color > *color*.
2. Select the region of the script that covers the range within the take or takes that you want to highlight with color.
3. Select one or more takes.
4. Click the Set Color button in the Script window toolbar.

   The color appears only in the highlighted script region of the selected takes. You can switch the indicators on or off by clicking the button repeatedly.

**To remove one or more color indicators:**
1. Select the range of script containing the color indicators.
   
   The first take in the selected region determines the color indicator status that displays in the Set Color button.
2. Select only those takes that display the indicators.
3. Click the Set Color button.
Script Marks

Script marks let you synchronize individual lines of script with matching points in captured clips. When you place a mark in the script, an IN point also appears in the clip when you load it into a monitor for editing. This provides line-by-line control over alternative takes that the editor can instantly load and edit into the sequence.

You can place script marks in several ways. You can:

- Place marks manually, one take at a time.
  For more information, see “Placing Script Marks Manually” on page 653.
- Place marks in a playback loop in real time.
  For more information, see “Using Real-Time Screening and Marking” on page 655.

Once you have created script marks, you can load and play marked segments. You can also move or delete existing marks. For more information, see “Loading and Playing Marked Segments” on page 657

Placing Script Marks Manually

To place script marks manually:

1. Map the Add Script Mark button from the Other tab in the Command palette to a user-customizable palette or to the Keyboard palette.
   For more information, see “Mapping User-Selectable Buttons” on page 131.
2. Double-click in the Script window at the intersection of a take and the line of dialog that you want to mark.
   The take is selected in the slate, the selected line of the dialog is highlighted, and the clip loads into the Source monitor.
3. Click the Play button, or press the Play key.

The take plays in the monitor.

You can also step (jog) or shuttle through the footage, place the position indicator on the exact frame, or scrub the audio to find the exact line of dialog. The clip does not have to be playing.

4. When the playback reaches the selected line of dialog, click the Add Script Mark button or press the Add Script Mark key.

The line is marked in the Script window with a small horizontal bar, and play stops.
Using Real-Time Screening and Marking

The Script window provides controls for automating the process of screening and placing script marks for a single take or across multiple takes.

To use real-time screening and marking:

1. Select one or more takes.
2. Click the Record button in the Script window toolbar.
   The first selected take changes to green in the Script window, your Avid editing application loads the clip into the Source monitor, and the clip begins to play.

5. Repeat these steps to add more script marks.
Example of real-time screening and marking: several takes are selected for automatic playback, and the current playback is highlighted in green.

3. As you hear a line of dialog or see a particular clip that you want to mark, click the matching line in the Script window.

A script mark appears at that location in the take, and the clip continues to play.

You can scroll through the Script window without affecting playback.

4. Continue to mark additional sync points by doing one of the following:
   - Click a line that already contains a mark to replace the previous mark and update the sync point in the clip.
   - Click a line in the script before or after the range of the existing take line to add the mark and extend the take line to include the new line.
   - Use variable-speed play controls (J-K-L keys on the keyboard) to shuttle, step, or pause during playback.
   - Press the Tab or Shift+Tab keys on the keyboard to begin playback of the next or the previous take.

As each take reaches its end, your Avid editing application automatically loads and plays the next take.

5. Continue to place marks until all takes have been screened.

**To stop the playback loop:**

- Press the space bar.
Loading and Playing Marked Segments

Once you place marks syncing lines in your script to points in the source clips, you can quickly load and cue takes for selected lines of dialog. You can load a single take, or you can load all the coverage for any given range of lines.

To load the marked segment of a take:
- Double-click the script mark at the line of dialog that you want to cue.

Your Avid editing application loads the take into the Source monitor, cues it to the synced line of dialog, and places an IN point at the sync location.

To load all the coverage for a range of lines:
1. Select the lines in the Script window, dragging through all intersecting takes.
   - The script lines and takes are highlighted.
2. Click the Play button in the Script window if you want to screen the takes for those lines, or click the Record button if you want to add script marks.

![Play button (left) and Record button (right)]

The takes load and play back one after another. You can use the Tab key or J-K-L keys to jump between takes and to control playback.

Moving or Deleting a Script Mark

When you move a script mark up or down, the mark in the source clip remains at the same frame but is resynced to a new line in the script.

When you remove a script mark, you do not delete the marked portion of the take, only the sync point between the script and the source clip.

⚠️ You cannot undo the deletion of script marks. To restore a script mark after deletion, see “Placing Script Marks Manually” on page 653.

To move a script mark:
1. Press the Ctrl key (Windows) or the Command key (Macintosh) and mouse over the mark in the script.
   - The pointer changes to a movement indicator.
2. Click the mark, and drag it to the new position.
To delete a script mark:

1. Click once on a script mark to select it.
   You can select multiple script marks for removal by highlighting an entire region of text and selecting the takes containing the script marks you want to remove.
2. Press the Delete key.
   The Delete dialog box opens.
3. Select Delete 1 mark(s), and click OK.
   The mark is deleted.

Finding Clips and Script

After you place script marks, which synchronize lines in the Script window to frames in the source clips, you can use the Find Script or Find Bin buttons to search back and forth between the two items.

To find the script linked to a loaded clip:

1. Place the position indicator in the clip at the line of dialog (or within a range of dialog) that you want to find.
2. Click the Find Script button in the Other tab of the Command palette.
   The Script window scrolls to and highlights the portion of script that most closely matches the clip location.

To find source clips and bins:

1. Select the takes that you want to find.
2. Click the Find Bin button in the Script window toolbar.
   Your Avid editing application searches through bins linked to the project, opens the bin containing the linked clips, and highlights them in the bin.
Editing From the Script Window

To use the Script window most effectively during an editing session, make sure the Script window is fully prepared, including preferred takes, alternative takes (indicated with colors), and script marks for matching lines of text to sync points in the clips.

Consider using the Single Mark Editing option, which lets you skip several steps by performing edits on-the-fly while playing back clips (without marking OUT points). For more information, see “Enabling Single-Mark Editing” on page 594.

For procedures that let you assemble a rough cut quickly from the Script window and to splice clips linked to ranges of script into a sequence, see “Assembling a Rough Cut From the Script Window” on page 660 and “Splicing a Script Range” on page 660.

Revising the Script

During or after each session, or when a scene or segment is completed, the editor or assistant editor can update the Script window to reflect the final edit decisions made during the day. This maintains a complete record of the elements used to construct the scene or segment, as well as all existing alternatives. You can quickly retrieve all the source material in one window whenever you need to make further changes.

Interactive Screenings

The Script window is a valuable tool during screenings of work in progress. You can:

- Quickly search for scenes and pages with clips attached for instant retrieval.
  
  You cannot load sequences into the Script window. Instead, you can perform a video mixdown and load the resulting master clips. For more information, see “Performing a Video Mixdown” in the Help.

- Match back and cue source material to compare alternative takes.

- Quickly find and open bins for retrieval of additional material not included in the Script window.

- Enlarge script font and slate frames for better viewing by your audience.

The Script window provides a visual, interactive look at the content of the original script against the elements in the final piece.
Assembling a Rough Cut From the Script Window

To quickly assemble a rough cut from the Script window:

1. Open the Script window for the current cut.
2. Double-click the first preferred take to load it into the Source monitor.
   Your Avid editing application automatically marks and cues to the IN point.
3. Play the take until the appropriate OUT point is reached, and stop play.
4. Click the Splice-in or the Overwrite button to make the first edit.

   Splice-in button (left) and Overwrite button (right)

5. Prepare the sequence for the next edit:
   a. Create new tracks, if necessary.
   b. Enable the appropriate source and record tracks.
   c. Patch the tracks, if necessary.
   d. Mark an IN point in the sequence for the next edit.
6. Double-click the next preferred take to load it.
7. Play the clip until you reach the appropriate OUT point, and stop play.
8. Perform the edit on-the-fly.
9. Repeat steps 5 through 8 until you have moved through the entire scene or segment.
10. Fine-tune the edits by using normal trimming and editing procedures. Continue to use the Script window to quickly load and cue alternative takes as necessary.

Splicing a Script Range

You can splice clips linked to ranges of script directly from the Script window into the sequence. To use this feature with accuracy, you should carefully add script marks to the ranges of script during the screening and marking phase. For more information, see “Script Marks” on page 653.

To splice a range:

1. Mark an IN point or place the position indicator at the location in the sequence where you want to splice in the segment.

2. Press the Ctrl and Alt keys (Windows) or the Command and Option keys (Macintosh).
   Notice that the Splice-in arrow appears when you point to a take.
3. Double-click the preferred take within the range of dialog that is marked with script marks.
The marked section of the clip is spliced into the sequence.
Using the Timeline

Your Avid editing application represents each edit and effect on a timeline to help you track and manipulate the elements of your sequence. The Timeline continuously updates as you work, displaying icons and information that you can customize in various ways. The Timeline also has its own set of editing tools for creating and revising edits and transitions across multiple tracks.

The audio and video tracks in the Timeline play in the Record monitor. You can continually edit your sequence and review your changes until you are pleased with the result.

Timeline features are described in the following topics:

- Customizing Timeline Views
- Navigating in the Timeline
- Working with Segments
- Working with Multiple Tracks
- In to Out Highlighting in the Timeline
- Editing in Heads or Heads Tails View
- Performing a Quick Edit Using the Top and Tail Commands
- Working with Add Edits (Match Frames)
- Dupe Detection
- Editing with the Film Track
- Tracking Color Frame Shifts
- Finding Black Holes and Flash Frames
- Printing the Timeline
- Activating and Deactivating I/O Hardware
Customizing Timeline Views

You can customize your view of the Timeline to display a variety of information about your sequence as well as the clips and transitions it contains. You can do the following:

- Use options in the Timeline Fast menu to change the display in a variety of ways
  For more information, see “Using the Timeline Fast Menu” on page 665 and “Timeline Fast Menu Options” on page 665.

- Manipulate the height of tracks or move tracks as part of a view
  For more information, see “Enlarging and Reducing Timeline Tracks” on page 667 and “Moving Timeline Tracks” on page 667.

- Highlight clips in the Timeline for special purposes
  For more information, see “Displaying Clip Colors in the Timeline” on page 667.

- Hide or display audio waveforms or pan and gain automation.
  For more information, see “Audio Displays in the Timeline” on page 772.

- Hide or display the Track Control panel. The Track Control panel defaults to hidden the first time you start your Avid editing application.
  For more information, see “Using the Track Control Panel” on page 678.

- Save different custom views that you can call up instantly in various circumstances.
  For more information, see “Managing Customized Timeline Views” on page 681 and “Using Timeline View Buttons” on page 682.

You can also change your view of the Timeline by using on-the-fly procedures — for example, the Zoom and Focus functions. You cannot save these as part of a Timeline view.

For illustrated examples of custom timeline views, see “Examples of Customized Timeline Views” on page 663.

Examples of Customized Timeline Views

The following table describes several examples of custom timeline views that you might find useful while editing:

<table>
<thead>
<tr>
<th>Purpose</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Effects Editing</td>
<td>If you are editing complex visuals with multiple tracks and effects, you can display Effect contents, Effect and Dissolve icons, Clip Frames, and Clip Transition Durations within enlarged video tracks in the Timeline.</td>
</tr>
</tbody>
</table>
Customizing Timeline Views

### Complex audio work
If you are doing advanced audio work with multiple tracks or fine-tuning difficult audio edits, you can hide video tracks and enlarge audio tracks while displaying waveform plots. If you enable per track settings in the Track Control panel to display waveforms on specific tracks, these settings are not saved in custom Timeline views.

### Film and animation editing
If you are working on a film or animation project, you can display the film track, show several frames in the sequence, and display sync breaks where they occur.

### Editing for online
If you are editing offline with plans to generate an EDL and finish the sequence in an online videotape suite, you can track detailed clip and dupe-reel information by displaying and enabling Dupe Detection.
Customizing Timeline Views

Using the Timeline Fast Menu

You can customize the appearance of the Timeline by using various options from the Timeline Fast Menu.

To use the Timeline Fast menu:

Click the Fast Menu button, and select or deselect an option from the menu.

For information on the options, see “Timeline Fast Menu Options” on page 665.

Timeline Fast Menu Options

The following table describes the options available in the Timeline Fast Menu.

Selected options have check marks next to them in the menu. You can select some options only from submenus.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Setup</td>
<td>Returns Timeline display settings to the system default settings; see “Managing Customized Timeline Views” on page 681.</td>
</tr>
<tr>
<td>View Type</td>
<td>Displays a submenu for selecting different segment display formats; see “Editing in Heads or Heads Tails View” on page 720.</td>
</tr>
<tr>
<td>Track Panel</td>
<td>Displays or hides the Track Selector panel.</td>
</tr>
<tr>
<td>Effect Icons</td>
<td>Switches the display of effect icons; see “Changing Timeline View Settings for Effects” in the Help.</td>
</tr>
<tr>
<td>Render Ranges</td>
<td>Indicates unrendered or partially rendered effects; see “Using Partial Render” in the Help.</td>
</tr>
<tr>
<td>Dissolve Icons</td>
<td>Switches the display of transition dissolve icons.</td>
</tr>
<tr>
<td>Clip Frames</td>
<td>Switches the display of start frames for each segment in the Timeline.</td>
</tr>
</tbody>
</table>
### Customizing Timeline Views

<table>
<thead>
<tr>
<th>Option</th>
<th>Description (Continued)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clip Text</td>
<td>Displays a submenu of clip text display options.</td>
</tr>
<tr>
<td>Sync Breaks</td>
<td>Displays a submenu of sync break display options; see “Fixing Sync Breaks” on page 616.</td>
</tr>
<tr>
<td>Dupe Detection</td>
<td>Enables color-coded dupe material display for V1 track; used in 24p projects and matchback projects. See “Dupe Detection” on page 723.</td>
</tr>
<tr>
<td>Color Correction</td>
<td>Displays indicator lines to show which segments have Source or Program color correction.</td>
</tr>
<tr>
<td>Audio Data</td>
<td>Displays a submenu for customizing audio tracks with waveforms or volume gain automation; see “Displaying Audio Waveforms” on page 773 and “Displaying Volume and Pan Values” on page 775.</td>
</tr>
<tr>
<td>Clip Color</td>
<td>Displays and controls the color coding assigned to clips. For more information, see “Displaying Clip Colors in the Timeline” on page 667.</td>
</tr>
<tr>
<td></td>
<td>You can also color clips to provide information when you are working in a MultiRez environment. For more information, see “Using Clip Coloring to Show Available Resolutions” on page 1357.</td>
</tr>
<tr>
<td>Track Color</td>
<td>Displays a palette for changing the color of the tracks in the Timeline; see “Changing the Track Color” on page 671.</td>
</tr>
<tr>
<td></td>
<td><em>A track must be selected in the Timeline for the Track Color command to appear.</em></td>
</tr>
<tr>
<td>Show Markers</td>
<td>Displays a submenu for selecting the markers to be displayed in the Timeline; see “Showing Markers in the Timeline” on page 673.</td>
</tr>
<tr>
<td>Show Track</td>
<td>Displays a submenu for displaying tracks; see “Displaying Timecode Tracks in the Timeline” on page 672.</td>
</tr>
<tr>
<td>Track Control Panel</td>
<td>Displays or hides the Track Control panel; see “The Track Control Panel” on page 678.</td>
</tr>
<tr>
<td>More Detail</td>
<td>Expands the Timeline horizontally around the position indicator.</td>
</tr>
<tr>
<td>Less Detail</td>
<td>Shrinks the Timeline horizontally around the position indicator.</td>
</tr>
<tr>
<td>Show Every Frame</td>
<td>Displays every frame in the Timeline if you select Show Track &gt; Film.</td>
</tr>
<tr>
<td>Show Entire Sequence</td>
<td>Shows the entire sequence within the Timeline.</td>
</tr>
<tr>
<td>Zoom Back</td>
<td>Restores the Timeline to the previous view before zoom; see “Zooming and Focusing in the Timeline” on page 685.</td>
</tr>
<tr>
<td>Zoom In</td>
<td>Zooms the Timeline into a detailed view for a selected area; see “Zooming and Focusing in the Timeline” on page 685.</td>
</tr>
</tbody>
</table>
Enlarging and Reducing Timeline Tracks

You can enlarge or reduce the height of one or more tracks to improve visibility and display more information within the tracks.

To enlarge or reduce the height of tracks:

1. Select the tracks in the Timeline that you want to resize.
   For more information, see “Selecting Tracks” on page 705.
2. Do one of the following:
   ▶ Select Edit > Enlarge Track or Edit > Reduce Track.
   ▶ Press Ctrl+L (Windows) or Command+L (Macintosh) to enlarge the track, or Ctrl+K (Windows) or Command+K (Macintosh) to reduce the track, which changes the height of all highlighted tracks in the Timeline.

Moving Timeline Tracks

You can move a track to reposition it vertically relative to the Timeline. Surrounding tracks are repositioned above or below the track.

Do not move a track when patching to another track is more appropriate.

To move a track:

▶ Press and hold the Ctrl key (Windows) or Option key (Macintosh), click the Track button for the track that you want to move, and drag the track to its new position.

Displaying Clip Colors in the Timeline

You can use colors to highlight the following types of clips in the Timeline:

- Clips that have offline media.
- Clips whose frame rate does not match the sequence frame rate (mixed-rate clips).
- Clips that do not match the video resolution type of the project — for example, HD clips in an SD project, or SD clips in an HD project.
- Clips to which you assign a local color in the Timeline.
- Clips to which you assign a color in the bin.

When you work with nested layers, a clip that contains offline media appears colored even if the missing media is located in a nested layer.

When working in a MultiRez environment, you can also use colors to track available resolutions.
You can control which types of clip coloring to enable, and customize the colors themselves. Clip color options are saved when you save a customized Timeline View, so you can set up several coloring schemes and then switch between them. For more information, see “Managing Customized Timeline Views” on page 681.

Displaying clip colors overrides any track color you assign from the Timeline Fast menu.

For HD and SD projects, DVCPro HD clips are colored light red. You cannot customize this color, which is an indicator that DVCPro HD media plays by skipping frames. To avoid skipped frames, use the Transcode command and select a compatible resolution.

**To display clip colors in the Timeline:**

1. Click the Timeline Fast Menu button, and select Clip Color.

   The Clip Color dialog box opens.
2. Select one or more of the following:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolution Tracking</td>
<td>Colors clips to indicate the availability of particular resolutions in a MultiRez environment. For more information, see “Using Clip Coloring to Show Available Resolutions” on page 1357. This option is only available if you are working in a MultiRez environment.</td>
</tr>
<tr>
<td>Offline</td>
<td>Colors clips that have offline media.</td>
</tr>
<tr>
<td></td>
<td>In a MultiRez environment, colors clips that do not match the working resolution, if you have selected Relink to Offline in the Dynamic Relink Settings dialog box. For more information, see “Using Clip Coloring to Show Available Resolutions” on page 1357.</td>
</tr>
<tr>
<td>Proxy</td>
<td>Colors proxy clips in the Timeline.</td>
</tr>
<tr>
<td>AMA</td>
<td>Colors AMA clips in the Timeline.</td>
</tr>
<tr>
<td>Mixed Rates</td>
<td>Colors clips whose frame rates do not match the sequence frame rate. A different color is available for each frame rate.</td>
</tr>
<tr>
<td>SD/HD</td>
<td>Colors clips that do not match the video definition type of the project format — in an HD project this option colors the SD clips, while in an SD project this colors the HD clips.</td>
</tr>
</tbody>
</table>

You can also display clip text that can help you to identify particular clips by selecting Clip Text > Clip Resolutions from the Timeline Fast menu.

| Timeline Local    | Colors clips to which you have assigned a local color in the Timeline. For more information, see “Assigning Local Colors to Clips in the Timeline” on page 671. |
| Source            | Colors clips to which you have assigned a color in the bin. (Colors assigned to sequences, groups, motion effects, and title clips do not appear as source colors in the Timeline.) For more information, see “Assigning Colors to Objects in a Bin” on page 357. |

The order of the options in the Clip Color dialog box indicates the priority order in which your Avid editing application applies colors when you select more than one option. For example, if you have Offline and SD/HD selected, an offline SD clip in an HD project uses the higher-priority Offline color rather than the SD/HD color.
To change the display colors for the Resolution Tracking, Offline, Mixed Rates, or SD/HD options:

1. Click the Timeline Fast Menu button, and select Clip Color.
   The Clip Color dialog box opens.
2. Click the color swatch for the option you want to change.
   A color picker grid opens.
3. Click a color in the grid.
   The color you select becomes the display color for that option.

To reset the display colors for the Resolution Tracking, Offline, Mixed Rates, and SD/HD options:

1. Click the Timeline Fast Menu button, and select Clip Color.
   The Clip Color dialog box opens.
2. Click Default Colors.
   The Offline, Mixed Rates, and SD/HD color swatches reset to their default colors.
Changing the Track Color

To change the color of the selected tracks in the Timeline:

1. Click in the Timeline to activate it.
2. Select the tracks whose color you want to change.
3. Click the Timeline Fast Menu button, and select Track Color > color.
4. (Option) If you want to choose a custom color for the tracks, press the Alt key (Windows) or Option key (Macintosh) while performing this procedure.
   When you release the mouse button on the color palette, the Windows Color dialog box or the Macintosh Colors panel opens.

Assigning Local Colors to Clips in the Timeline

You can assign local colors to clips in the Timeline — for example, to indicate clips that you want to group together or to make clips stand out while you work in the Timeline.

For more information on clip colors in the Timeline, see “Displaying Clip Colors in the Timeline” on page 667.

To assign a local clip color:

1. Click the Timeline Fast Menu button, and select Clip Color.

   The Clip Color dialog box opens.
2. Select Timeline Local, and then click OK.

3. Select one of the segment tools in the Timeline palette, and select a clip you want to color.

4. Do one of the following:
   - Select Edit > Set Local Clip Color > color to select a standard color.
   - Select Edit > Set Local Clip Color > Pick to select a custom color from the Windows Color dialog box.

The assigned local color appears in the clip in the Timeline.

**To remove a local clip color:**

1. Select one of the segment tools in the Timeline palette, and select the clip whose color you want to remove.

2. Select Edit > Set Local Clip Color > None.

   The assigned local color no longer appears in the clip in the Timeline.

**Clip Color for Proxy Clips in Timeline**

An additional option in the Clip Color window allows you to highlight h.264 proxy clips in the Timeline. Proxy clip color is enabled by default.

**To select or deselect the proxy clip color in the Timeline:**

1. Click the Timeline Fast Menu and select Clip Color.

   The Clip Color dialog opens.

2. Select Proxy.

3. Click OK.

   The h.264 proxy clips will appear highlighted yellow in the Timeline.

**Displaying Timecode Tracks in the Timeline**

When you are working with 24p or 25p projects (PAL with pulldown), you can display separate tracks for 24, 25, 25P, and 30 timecodes in the Timeline. You can also display an edgecode track in the Timeline. By default, the Timeline displays all the tracks. You can hide the timecode tracks by deselecting them in the Show Track submenu of the Timeline Fast menu.

The master timecode also displays in the Timeline ruler above the Timeline.

**To customize the tracks to be displayed in the Timeline:**

- Click the Timeline Fast Menu button, and select Show Track > tracks.

*The TC1 track represents the timecode of the active project.*
Showing Markers in the Timeline

When you add markers to a sequence, the markers are displayed in the Timeline. You can modify which markers to display in the Timeline by selecting Show Markers from the Timeline Fast menu. When you select a color from the Show Markers submenu, only markers of that color appear in the Timeline. You can select All from the Show Markers submenu to display all the markers, or you can select None to prevent any markers from being displayed in the Timeline.

Show Markers affects only how the marker icons display in the Timeline and does not affect the markers.

To change the display of markers in the Timeline:
1. Load a sequence that contains markers into the Record monitor.
2. Click the Timeline Fast Menu button, select Show Markers, and then select the colors of the markers you want to display in the Timeline.
   The Timeline displays only those markers with the colors you selected.

Setting the Playback Option for the Timeline

You can control how the Timeline displays during playback by setting a preference in the Timeline Settings dialog box:

- The Timeline display can page to the next section of your sequence when the position indicator gets to the end of the visible section of the Timeline as you play.
- The Timeline display can scroll over the position indicator while you play a sequence
- The Timeline display can remain stationary as the sequence plays, even when the position bar moves beyond the right of the Timeline.

For the Timeline to page or scroll, you might need to display more detail in the Timeline to expand the sequence. Click the slider and drag it to the right to expand the Timeline. All effect icons are hidden as you scroll.

To set the playback option:
1. Double-click Timeline in the Settings list in the Project window.
   The Timeline Settings dialog box opens, displaying a list of your current Timeline settings. For more information, see “Timeline Settings” on page 1525.
2. Click the Display tab, and select one of the following:
   - Page
   - Scroll
   - None
3. Click OK.

**Disabling the Smart Tool in the Timeline**

Using the Smart tool enables a dynamic, cursor-based editing method in the Timeline. This changes the standard behavior of the mouse pointer so that you cannot scrub through the Timeline as you do in normal edit mode. If you want to move or scrub through the Timeline without making segment edits, you can turn off the editing tools by using the Smart tool toggle bar or by clicking the Timecode ruler or Timecode track to deselect the edit tools if you set this option in the Timeline Settings dialog box.

To disable the Smart tool using the Timecode ruler or the Timecode track:

1. Double-click Timeline in the Settings list in the Project window.
   The Timeline Settings dialog box opens, displaying a list of your current Timeline settings.
   For more information, see “Timeline Settings” on page 1525.
2. Click the Edit tab, and select Clicking the TC Track or Ruler Disables Smart Tools.
3. Click OK.

**Using the Full-Screen Timeline**

As an alternative to constantly scrolling through the Timeline window or resizing tracks to get a view of the material, you can resize the Timeline window to full-screen display. You can also enlarge the tracks to view complex audio or video layers in greater vertical detail.

A Timeline with reduced tracks wraps around to show more of the sequence. As you reduce tracks in a full-screen Timeline, the sequence wraps around, allowing you to examine a long sequence in greater horizontal detail.

If the Timeline or monitor window is hidden behind another window, select the window again from the Tools menu.

To resize the Timeline window:

- Click the Resize box at the lower right corner of the window, and drag it.
- (Macintosh only) Click the Maximize button in the top right corner of the window.
  The Timeline expands to full-screen size.

To restore a resized Timeline window to its default position:

- Click the Timeline and select Windows > Home.

To enlarge tracks:

- Select the tracks, and press Ctrl+L (Windows) or Command+L (Macintosh).
To reduce tracks:
- Select the tracks, and press Ctrl+K (Windows) or Command+K (Macintosh).

You can also continue to work in Source/Record mode by resizing the Timeline window so that it overlaps the Composer window.

You can click either window to activate it and bring it forward at any time, or you can click the title bar of the Timeline window and drag it to the Bin monitor to place each window in its own monitor.

The Timeline Palette

Your Avid editing application provides a quick way to edit sequences in the Timeline without having to enter a specific editing mode such as Trim mode. By using the Timeline palette, you can perform the following editing actions:

- Select and move segments in the Timeline
- Copy and delete segments
- Edit with Lift/Overwrite and Extract/Splice-in edits
- Create single- and dual-roller trims, such as ripple trims and overlap edits
- Adjust transition effects in the Timeline

The Timeline palette provides you with the most common tools you need for Timeline editing, as well as several buttons you can use to enable editing modes such as Effect mode or Color Correction mode.
The editing tools at the top of the Timeline palette make up the Smart tool. The Smart tool lets you access the most common segment editing tools and to combine functions by selecting multiple tools.
The Smart tool, with all of the functions selected by the toggle bar (left)

The Smart Tool buttons also appear on the Smart Tool tab of the Command palette, so you can map them to the keyboard, a toolbar, or the Tool palette. For more information on mapping buttons, see “Mapping User-Selectable Buttons” on page 131.

When you combine functions on the Timeline palette, you modify how the mouse pointer functions in the Timeline:

- When you select the Lift/Overwrite or Extract/Splice-in button, the mouse pointer changes to a segment edit pointer for either Lift/Overwrite or Extract/Splice-in edits. If you select both buttons, the segment edit depends on which region of the segment in the Timeline that you activate. For more information, see “Working with Segments” on page 688.

- When you select the Overwrite Trim or Ripple Trim button, the mouse pointer changes to a trim roller when you mouse over a transition point and lets you perform the selected trim edit. If you select both trim buttons, the trim edit depends on which region of the transition in the Timeline that you activate. For more information, see “Timeline Trim States” on page 735.

- The Transition Manipulation tool lets you select and modify transition effects in the Timeline. You can adjust the duration and position of the transition effect by moving the effect handles or the effect icon. For more information, see “Adjusting Transitions in the Timeline” in the Help.

- The Smart tool toggle bar lets you turn off the Timeline palette editing tools. When you use the toggle bar to enable Timeline palette tools, the toggle bar enables the tools that you had previously selected.

Since using the Timeline palette tools change the behavior of the mouse pointer in the Timeline, you cannot scrub through the Timeline as you do in normal edit mode. Instead, you can use the Timeline ruler above the Timeline or the Timecode track to move the position indicator. (The Timeline ruler displays the master timecode for your sequence.) If you want to scrub through the Timeline without making segment edits, you can also turn off the segment tools by using the Smart tool toggle bar or by clicking the Timecode ruler or Timecode track to deselect the edit tools if you set this option in the Timeline Settings dialog box (see “Disabling the Smart Tool in the Timeline” on page 674).
The Track Control Panel

Timeline tracks include a Track Control panel that provides features useful when you edit audio tracks. The Track Control panel arranges components in two rows of tools, and it allows you to do the following:

- Show or hide waveforms and clip gain, auto gain, and pan displays on individual tracks (see “Displaying Audio Waveforms” on page 773 and “Displaying Volume and Pan Values” on page 775).
- Add, delete, move, and copy RTAS® (Real-Time AudioSuite) effects (see “Audio Track Effect Plug-Ins” on page 925).
- Mark tracks as inactive or solo or mute tracks so you can monitor the audio on a track.

Using the Track Control Panel

The Track Control panel displays two rows of tools. If you reduce the size of the Timeline tracks, you might not see the Track Control panel tools. For more information on resizing Timeline tracks, see “Enlarging and Reducing Timeline Tracks” on page 667.”
To show the Track Control panel, do one of the following:

- Click the Timeline fast menu and select Track Control Panel. To hide the Track Control panel, deselect Track Control Panel.
- Click the Track Control Panel button above the Timeline.

Displaying Source Material in the Timeline

You can display source material in the Timeline. This feature is useful when you edit with a sequence or subclip created from a sequence. You can also use it to look at the contents of any source clip in a Timeline display.

Heads and Tails view is disabled when you are displaying material from the Source monitor.

To view multitrack source material quickly in the Timeline for selecting and marking specific tracks:

- Click the Toggle Source/Record in Timeline button.

By default, the Timeline displays only the available tracks for source material. Both the button and the position indicator turn green to indicate that you are viewing source material.
**Displaying the Timeline Top Toolbar**

You can display a top toolbar in the Timeline for easy access to editing buttons. You can also map additional buttons to the Timeline top toolbar. For information about mapping buttons, see “Mapping User-Selectable Buttons” on page 131.

**To show the Timeline top toolbar:**

1. In the Project window, double-click the Timeline Setting.
   
   The Timeline Settings dialog box opens.

2. Select Show Toolbar in the Display tab.

3. Click OK.

**To hide the Timeline top toolbar:**

- Deselect Show Toolbar, and then click OK.
Managing Customized Timeline Views

You can save a customized Timeline view. Timeline views appear in the Settings list in the Project window. You can save, rename, and copy multiple views.

Your Avid editing application saves the Timeline information from the Timeline Fast menu with each view.

You can select alternate views from the View menu located in the Timeline bottom toolbar. The Timeline view is labeled Untitled until you name and save a customized Timeline view.

You can replace a Timeline view with a different view, while keeping the same name. You can also restore the default Timeline setup at any time.

You can also change the name of a Timeline view or delete a view from the Settings list in the Project window. For more information, see “Naming Settings” on page 1425 and “Deleting Settings” on page 1426.

To name a Timeline view or to change a view’s name:

1. Click the View Menu button, and select Save As.

   The View Name dialog box opens.

2. Type a name for the view, and click OK.

3. Press and hold the Alt key (Windows) or Option key (Macintosh) while you click the View Menu button to display the list of saved view names, each appended with the Replace command.

4. (Option) If you want to replace a Timeline view, select a view name from the list that you want to replace.

   Your Avid editing application applies the current Timeline view to the selected name and displays that name in the Settings list in the Project window.

To restore the default view in the Timeline:

   - Click the Timeline Fast Menu button, and select Default Setup.
Using Timeline View Buttons

The More tab of the Command Palette contains eight Timeline View buttons that you can use to switch between Timeline views. You can map these buttons to any mappable button location or to the keyboard, or you can use them directly in the Command Palette.

You must create at least one Timeline view to use the Timeline View buttons. For more information, see “Managing Customized Timeline Views” on page 681.

The Timeline View buttons are assigned to your Timeline views in the order that they appear on the View menu in the Timeline bottom toolbar and in the Settings list. For example, the T1 button is assigned to the first Timeline view that appears in the menu and the Settings list, the T2 button is assigned to the second view, and so on.

Your Avid editing application sorts the Timeline views alphabetically, and the button assignments might change if you add Timeline views. To keep a designated order, name your Timeline views with a number preceding the first letter (for example, you might have views named 1default, 2headframes, 3waveforms, and so on).

To map a Timeline view button:
1. Select Tools > Command Palette.
2. Click the More tab.
3. Select Button to Button Reassignment.
4. Click a Timeline view button (T1 – T8), and drag the button to a location on another palette (for example, the Tool palette) or the Keyboard settings window.

For more information, see “Mapping User-Selectable Buttons” on page 131.

The Timeline view button appears in the new location.

To use a Timeline View button or key, do one of the following:
- Click the Timeline view button in the location to which you have mapped it.
- Press the key on the keyboard that you have associated with the Timeline View button.
In the More tab of the Command Palette, select Active Palette, and then click the Timeline View button.

Navigating in the Timeline

The Timeline window provides various controls for quickly moving through a sequence and adjusting your view of details displayed in the tracks while editing. You can use the position indicator, the Timeline scroll bar/position bar, the Timeline scale bar, the Zoom In and Zoom Back commands, or the Focus button. In addition, you can highlight marked sections of the sequence for visual reference.

You can also use the Video Quality Menu button in the Timeline bottom toolbar to control the quality level at which media plays back. For more information about the Video Quality Menu button, see “Real-Time Playback of Video Effects” in the Help.

The following illustration shows the Timeline window.

Understanding the Timeline Position Indicator and Scroll Bar

The position indicator in the Timeline marks your place in the sequence. It also determines how your Avid editing application interprets some of your commands. For example, when you perform an edit, the system takes the location of the position indicator as the In point in the absence of established marks.
When you move the position indicator in the Timeline, the smaller position indicator within the Record monitor’s position bar also moves.

By default, the Timeline scroll bar appears on the right side of the Timeline bottom toolbar. You can drag the scroll slider to reposition yourself within the Timeline, or click the arrows to scroll left or right.

You can change the Timeline scroll bar to a position bar that acts like the position bar in the Record monitor, except that you can manipulate it without deactivating the Timeline window. For more information, see “Switching to the Timeline Position Bar” on page 685.

An advantage of the position bar is that when you focus on only a portion of the sequence, both the Timeline and Record monitor’s position bars show a highlighted region around the position indicator. This represents the range of material displayed in the window.
Navigating in the Timeline

Switching to the Timeline Position Bar

To switch to the Timeline position bar:

1. Double-click Timeline in the Settings list in the Project window.
   The Timeline Settings dialog box opens.
2. Select the Show Position Bar option in the Display tab.
   A check mark appears in the box. To deselect an option, click it again.
3. Click OK.
   The scroll bar changes to a position bar.

For information on all Timeline settings, see “Timeline Settings” on page 1525.

Zooming and Focusing in the Timeline

You can change your view of the Timeline to focus in on particular information in the following ways:

- You can use the scale bar to stretch and contract the Timeline area centered around the position indicator.
  This lets you either zoom in to focus on a specific area of your sequence or zoom out to display your whole sequence. This feature is especially useful when you have a lengthy sequence with many edits.

- You can use the Zoom In command in the Timeline Fast menu to select a portion of the Timeline of any size to instantly expand to fill the window, and the Zoom Back command to instantly restore the Timeline to its former size.
  The Zoom In and Zoom Back commands do not depend on the placement of the position indicator. You can select any portion of the Timeline to expand and contract.

- You can use the Focus button to quickly change your view of the Timeline so that you focus on a few seconds of material on either side of the position indicator.
  The Focus button centers the position indicator and scales the Timeline so each second of time in the sequence fills 90 pixels in the display. The Focus button is located in the Timeline bottom toolbar next to the Timeline Fast Menu button.

Left to right: Timeline Fast Menu button, Focus button, and scale bar in the Timeline bottom toolbar
Navigating in the Timeline

**To zoom in the Timeline using the scale bar:**

1. Click the scale slider, and drag it to the right.

   The Timeline expands horizontally and shows more detail. The position indicator splits into a solid blue line and a dotted blue line (or “shadow”), marking the beginning and end of the current frame. You can click either the line or the shadow to move exactly one frame forward or back.

2. To shrink the Timeline to its original size, drag the scale slider back to the left.

**To zoom in the Timeline using the Zoom In and Zoom Back commands:**

1. Click the Timeline Fast Menu button, and select Zoom In.

   The pointer arrow changes to a selection bar.

2. Position the pointer at either the start or end of the place you want to zoom in on, and drag to select the section.

   When you release the mouse button, the material inside the Zoom In box expands to fill the Timeline window.

3. To return to the previous Timeline display, click the Timeline Fast Menu button, and select Zoom Back.

**To focus the Timeline using the Focus button:**

1. Make sure none of the edit tools in the Smart tool is active.

2. Move the position indicator to the frame or transition you want to expand.

3. Click the Focus button.

   Your Avid editing application centers and enlarges the region of the Timeline immediately surrounding the position indicator.

4. To return the Timeline to its previous view, click the Focus button again.

**Vertical Scrolling in the Timeline**

The editing application allows you to automatically scroll vertically in the Timeline. This is useful if you have many tracks in the Timeline and want to scroll below the visible area of the Timeline.

**To scroll vertically in the Timeline perform one of the following:**

- Select the blue bar in the ruler and drag vertically to scroll down the Timeline.
- In Segment mode, select a segment and drag vertically to scroll down the Timeline.
- Lasso an area above the tracks and drag vertically to scroll down the Timeline.
Controlling Movement in the Timeline

While working in the Timeline window, you can use modifier keys to control the movement of both the position indicator and any segments that you move.

The motion mode indicator in the Timeline toolbar displays a specific icon, depending on the keys you press to facilitate your movement within the Timeline.

<table>
<thead>
<tr>
<th>Motion Mode Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Head Frame]</td>
<td>Snaps the position indicator to head frame.</td>
</tr>
<tr>
<td>![Tail Frame]</td>
<td>Snaps the position indicator to tail frame.</td>
</tr>
<tr>
<td>![Edit Point]</td>
<td>Snaps the position indicator to the edit point in a track above or below the current track.</td>
</tr>
</tbody>
</table>

To snap to the head of transitions:
- Press the Ctrl key (Windows) or Command key (Macintosh) as you drag either the position indicator or any selected segments.

To snap to the tail of transitions:
- Press Ctrl+Alt (Windows) or Command+Option (Macintosh) as you drag either the position indicator or any selected segments.

To snap the selected segments to an edit point in the track above or below the current track:
- Click a segment edit button in the Timeline palette, and then press Ctrl+Shift while dragging the segments.
Working with Segments

Your Avid editing application provides editing controls for moving, deleting, marking, and editing entire segments in the Timeline. A segment is a portion of a sequence between two clip transitions.

There are two basic ways to edit segments:

- Select one of the segment tools on the Timeline palette (Lift/Overwrite or Extract/Splice-in). This lets you manipulate segments by positioning the cursor over the segment and performing either a Lift/Overwrite or Extract/Splice-in edit.

- Select both segment tools on the Timeline palette. This lets you edit segments by positioning the cursor over either the upper half of the segment (for Lift/Overwrite actions) or the lower half of the segment (for Extract/Splice-in actions) and then clicking the segment.

You can also edit directly from a bin, as described in “Bin Editing into the Timeline” on page 701.

Guidelines for Segment Editing

General Guidelines

- Moving a selection with an Extract/Splice-in edit deletes transition effects on either side of the selection. If the selection includes multiple segments around a transition effect, moving the segments preserves transition effects inside the selection.

- You can track the audio while moving segments by pressing the Caps Lock key to enable audio scrub. For more information, see “Using Audio Scrub” on page 768.

- You can select segments linked by common source media and timecode by enabling link selection. For more information, see “Linked Clips” on page 690.

- When you finish making an edit, the active segment tool continues to affect edits you make unless you deactivate the segment tool on the Timeline palette.
Guidelines When Selecting Segments

- You cannot overlap the source and destination tracks. For example, you can move audio segments from A3 and A4 to A1 and A2, but you cannot move them from A3 and A4 to A2 and A3 (A3 overlaps). You can move mono audio tracks only to other mono audio tracks, and you can move stereo audio tracks only to stereo tracks.

- With a group or with linked clips, you can click any selected segment to drag the entire group to a new position.

- You can select black filler as a segment, except when filler is used at the head or tail of a sequence.

Guidelines When Lassoing Segments

- Position the pointer above the tracks before dragging. If you click within the tracks, you either select a segment or a transition (if an edit tool is active on the Timeline palette) or you relocate the position indicator to that position. To lasso segments in the middle of the Timeline between multiple tracks, press and hold the Alt key (Windows) or Option key (Macintosh) while you drag the lasso.

- Lasso at least two transitions or all transitions included in multiple segments. If your lasso surrounds only one transition, you enter Trim mode.

- Drag from left to right. If you drag from right to left, you enter Trim mode with slip rollers selected.

- Link selection does not affect which segments you select when you lasso segments in the Timeline.

Selecting and Deselecting Segments

You can select segments for moving or editing by activating tools on the Timeline palette and then clicking segments in the Timeline, or you can lasso one or more segments. You can also select linked clips when you enable Link Selection. For more information, see “Linked Clips” on page 690.

You can then continue to select or deselect additional segments. The selected segment or group of segments becomes highlighted and remains in its original position during the move until you select its new position.

For additional guidelines when selecting and lassoing segments, see “Guidelines for Segment Editing” on page 688.

To select segments with the pointer:

1. Select one of the segment tools on the Timeline palette.

The mouse pointer arrow changes to a large red or yellow arrow when inside the Timeline, depending on where you position the pointer or which segment tool you click.
2. Click a segment in any track to select it. Shift+click to select additional segments. You can Shift+click a selected segment to deselect it.

If you have Link Selection enabled, all segments linked to your selection are selected in the Timeline. If you Shift+click a selected segment, all segments linked to your selected are deselected as well.

3. (Option) If you enable Link Selection and want to select a single segment and not the segments linked to it, Alt+click (Windows) or Option+click (Macintosh) the segment.

**To lasso segments:**
- Draw a lasso beginning in the area above the tracks in the Timeline. Drag left to right and then down to select more than one segment.

   ![Lasso selection](image)

   *When you draw a lasso, if neither segment tool in the Timeline palette is selected, Lift/Overwrite mode is enabled by default. To switch the mode, click the Extract/Splice-in button, after drawing the lasso.*

**To deselect one or more selected segments, do one of the following:**
- To deselect an entire track, click the Track button in the Track Selector panel.
  
  For example, if you lasso segments on V1, V2, and A1, you can click the V2 and A1 Track buttons to leave only the segment on the middle track, V1, selected.
- Click one of the segment tools on the Timeline palette, and then Shift+click specific segments on any track.
  
  This deselects the segments you click on any track, leaving the remaining tracks selected. If you have Link Selection enabled, all segments linked to your selection are deselected in the Timeline.
- To deselect a linked segment if you have Link Selection enabled, Shift+Alt+click (Windows) or Shift+Option+click (Macintosh) the segment.

**Linked Clips**

Media objects in bins can contain media on more than one track, such as a master clip with a video track and two audio tracks. When you add media to a sequence that come from the same source and share the same timecode, the Timeline displays the associated tracks. By default, the
Avid editing application treats these tracks as linked so that when you select a segment, the application automatically selects any linked segments. You can select linked clips for both segment editing and trim editing.

The following apply to linked clip selection:

- Track linking affects segments. If you use the same master clip in more than one place in your sequence, each segment maintains its own linking relationship unless the segments overlap in the Timeline.
- When you select a non-video track, clip linking selects only the first appropriate video segment. Other video segments are not selected.
- When you select a trim roller, clip linking selects trim rollers on all linked segments.
- You can turn off linked clip selection in the Timeline by using the Link Selection button.
- If you enable Link Selection, you can select a segment without selecting all segments linked to it by Alt+clicking (Windows) or Option+clicking (Macintosh) the segment.
- If you disable Link Selection, you can select a segment and all segments linked to it by Alt+clicking (Windows) or Option+clicking (Macintosh) the segment.
- A video segment cannot link to another video segment.
- Link selection operates across tracks, not along the same track. However, if a video segment links to an audio segment that includes a cut point, link selection operates on both audio segments.
- When two or more video tracks from the same clip overlap in the Timeline and sync is broken with the linked audio segments, link selection links to the video segment with the smallest sync break point.
- When you move a linked clip independently of the tracks to which it is linked so it no longer vertically overlaps the linked segments, the link relationship is broken.

**Selecting Linked Clips**

Link selection allows you to select segments in the Timeline that are linked by common source media and timecode. When you select a non-video segment that has more than one linked video segment, the video segment closest to the selected segment is selected. If sync breaks exist, the video segment with the smallest sync break is selected.

**To enable or disable link selection in the Timeline, do one of the following:**

- Click the Link Selection button.
- Press Shift+L.
To select linked clips:

1. Click a segment with linked clips.
   The application selects all linked segments.

2. (Option) If you want to select additional linked clips, Shift+click additional segments.

3. (Option) If you want to deselect selected segments, Shift+Alt+click (Windows) or Shift+Option+click (Macintosh) a linked segment.

Selecting Multiple Segments

Instead of lassoing segments in the Timeline to edit, you can select multiple segments on enabled tracks quickly by using the multiple segment selection buttons in the Edit tab of the Command palette. This allows you to select segments to the left or right of the position indicator, or to select all segments within In and Out marks. The multiple segment edit buttons also appear in the Timeline top toolbar if you create a new user profile (for information on creation user profiles, see “Managing User Profiles” on page 105).

When you use the multiple segment selection buttons, your Avid editing application activates the Segment Extract/Splice-in button if you have not selected one of the segment buttons on the Timeline palette.

You can also use the Shift key to add segments on enabled tracks to the current selection.

To select segments on enabled tracks using the multiple segment selection buttons:

1. Move the position indicator to the first or last segment you want to select.

2. Select Tools > Command Palette, and click the Edit tab.

3. Do one of the following:

   - Click the Select Left button to select segments under the position bar and all segments to the left.
   - Click the Select Right button to select segments under the position bar and all segments to the right.
   - Click the Select In/Out button to select segments intersecting In and Out marks if both marks are present.

   If the Timeline has only an In mark or an Out mark, or no In and Out marks, the Select In/Out button selects all segments under the position bar.

Excluding Filler when Selecting Multiple Segments

You can use a modifier key to exclude filler when selecting multiple segments.
To select segments on enabled tracks using the multiple segment selection buttons:

1. Move the position indicator to the first or last segment you want to select.
2. Select Tools > Command Palette, and click the Edit tab.
3. Do one of the following:
   - Click the Select Left button to select segments under the position bar and all segments to the left.
   - Click the Select Right button to select segments under the position bar and all segments to the right.
   - Click the Select In/Out button to select segments intersecting In and Out marks if both marks are present.
     If the Timeline has only an In mark or an Out mark, or no In and Out marks, the Select In/Out button selects all segments under the position bar.

Holding the Alt key (Windows) or Option key (Macintosh) while selecting the Select Left, Select Right, or Select In/Out button will exclude filler from the selection.

Selecting Filler with Segment Tools

A Timeline Settings option allows you to choose whether or not you want filler to be selected when using the Segment Tools. The Select Filler with Segment Tools option appears in the Timeline Settings Edit tab.

To select filler when using the Segment Tools:

1. In the Project Window, click Timeline in the Settings list.
2. Click the Edit tab.
3. Enable the Select Filler with Segment Tools option.
When using the Segment tools, filler will be selected.

If you do not want filler selected when using the Segment Tools, make sure the Select Filler with Segment Tools option is deselected.

*Using the Alt key (Windows) or Option key (Macintosh) while selecting the Select Left, Select Right, or Select In/Out button will exclude filler from the selection if the Select Filler with Segment Tools option is selected and will include filler from the selection if the Select Filler with Segment Tools is deselected.*

**Four-Frame Display**

When you begin to drag the segments, the interface changes to the four-frame display:

- The Source and Record monitors change to a four-frame monitor display. The two outer frames update while you drag the segment forward or backward in the Timeline, indicating the frames you pass as you drag the segment. The two outer frames in the four-frame display allow you to view and analyze the frames between which you might want to drop the selected segment.

- A centered numeric offset counter appears below the frame monitors. The offset counter tracks the number of frames or feet+frames (24p and 25p projects) that you move while dragging the selected segment from its starting point.

*When you drag segments with only the Record monitor displayed, the interface changes to a two-frame display. Only the outer two frames in the four-frame display appear in the Record monitor.*

Four-frame display. The two outer frames indicate ending and beginning frames of clips before and after the segment. The two inner frames represent the start and end frames of the segment. The offset counter is highlighted.

When you drag the segments, the original highlighted segment remains in place, while a “ghost” segment enclosed in a dotted white box moves along with the pointer until you release it at a new edit point.
When you release the segment into its new position, the actual lift (Overwrite) or extract (Splice-in) occurs. Until then, the segment position is preserved in the Timeline, allowing you to maintain your perspective of the sequence while selecting the new edit point.

**Suppressing Four-Frame Display**

The four-frame display of incoming or outgoing frames can occasionally slow the movement of segments as you drag them through the sequence. You can improve the speed of segment editing by suppressing the four-frame display.

**To suppress the four-frame display:**

1. Double-click Timeline in the Settings list in the Project window.

   The Timeline Settings dialog box opens.

2. Deselect the Show Four Frame Display option in the Display tab, and click OK.

3. Select one of the segment tools on the Timeline palette.

   The mouse pointer arrow changes to a large red or yellow arrow when inside the Timeline, depending on where you position the pointer or which segment tool you click.

4. Click the segment, and drag it to its new position.

   As you drag the segment, the monitors maintain their Source/Record configuration rather than shift to the four-frame display or two-frame display.

**Maintaining Sync with Segment Edits**

When you use the Lift/Overwrite tool, the application adds filler to the sequence to maintain sync. When you move segments in the Timeline using Extract/Splice-in, the sync might be broken.

To maintain sync when you use Extract/Splice-in, select the Segment Drag Sync Locks option in the Edit tab of the Timeline Settings dialog box. After you move a segment in the Timeline with Extract/Splice-in, this option maintains sync by adding filler to the following locations:

- Where the segment was moved from in the sequence
- On all other sync-locked tracks that correspond to the new location of the segment you moved

You can move either an audio segment or a video segment. You can also maintain sync for some edits if you enable link selection in the Timeline (see “Linked Clips” on page 690).
To move a segment and keep sync:

1. Double-click Timeline in the Settings list in the Project window.
   The Timeline Settings dialog box opens.
2. Select the Segment Drag Sync Locks option in the Edit tab.
3. Click OK.
4. In the Track Selector panel, click the Sync Lock button for the video, audio and data tracks that you want to keep in sync.
5. Click the Extract/Splice-in button.
6. Click an audio or video segment, and drag it to the new location.

In the following example, an audio segment in track A2 is moved. The new location for the audio segment has filler added to the video track. All segments remain in sync.

Moving Segments with Drag and Drop

You cannot move segments to locked tracks. If you attempt to drop a selection on a locked track, the move fails and all selected segments return to their original position in the Timeline.

If you move audio segments, you can only move segments on mono tracks to other mono tracks and segments on stereo tracks to stereo tracks.

To perform a segment edit:

1. Do one of the following:
   - Select both of the segment tools on the Timeline palette, and then position the mouse pointer over the top of the segment (for Lift/Overwrite operations) or the bottom of the segment (for Extract/Splice-in operations).
Select one of the segment tools on the Timeline palette.

The mouse pointer arrow changes to a large red or yellow arrow when inside the Timeline, depending on where you position the pointer or which segment tool you click.

1. Click the segment you want to move (Shift+click to select multiple segments), and drag it to its new position. If you enable link selection, all linked segments move when you drag the selected segment (see “Selecting Linked Clips” on page 691).

Use the four-frame monitor display, the offset counter, and the segment image in the Timeline to carefully determine the new position. You can also snap to the head or tail of the new edit point (see “Controlling Movement in the Timeline” on page 687).

3. Release the mouse button.

   If you used the Extract/Splice-in method, the system extracts the selected segment from its old position, closes the gap left by its removal, and then splices the material back into the sequence at the newly selected location.

   If you used the Lift/Overwrite method, the system lifts the selected segment from its old position, leaving black filler, and then overwrites the material onto the sequence at the newly selected location.

   If the segment contains transition effects, and you move or extract the segment, the transition effect remains. For information about how the system preserves transition effects, see “Transition Effect Preservation” in the Help.

To cancel a segment move, do one of the following:

- If you have not dropped the selected segment at a new location, drag the selection out of the Timeline window and release the mouse button.
- If you have dropped the selected segment at a new location, select Edit > Undo.

**Copying and Dragging Segments**

Simply use Option (Mac) or Alt (Windows) while dragging a segment to copy the segment.

**To copy and drag a segment:**

1. Using a segment tool, click and hold the segment you want to copy and drag.
2. Press Option (Mac) or Alt (Windows) and drag the segment.

   A plus sign (+) should appear in the segment if you have selected it properly for a copy drag.
3. Drop the copied segment in the new position in the Timeline.

**Dragging Nonadjacent Segments**

You can drag nonadjacent segments in the Timeline. You must be in Overwrite mode to drag the segments.

**To drag nonadjacent segments:**
1. Make sure you are in Lift/Overwrite mode by selecting the Lift/Overwrite button in the Smart Tool.
2. Select the nonadjacent segments that you want to move.
3. Move the segments to the desired location.

**Deleting Segments**

You can use the segment tools in the Timeline palette to delete whole segments in the Timeline quickly without having to mark In and Out points. You can also select multiple segments in separate tracks anywhere along the Timeline to delete them all at once.
By default, your Avid editing application deletes the selected segment and leaves blank space or silence in its place (a Lift segment edit). You can use In and Out points to perform a standard Extract edit.

You can also delete segments by using the Cut command. See “Cutting, Copying, and Pasting in the Timeline” on page 700.

**To delete segments quickly:**

1. Do one of the following:
   - Select both of the segment tools on the Timeline palette, and then position the mouse pointer over the top of the segment (for Lift/Overwrite operations) or the bottom of the segment (for Extract/Splice-in operations).
   - Select one of the segment tools on the Timeline palette.

   The mouse pointer arrow changes to a large red or yellow arrow when inside the Timeline, depending on where you position the pointer or which segment tool you click.

   - Lift/Overwrite (red) deletes the segments but leaves blank space or silence in their place. The total duration of the sequence remains the same, and sync is maintained.
   - Extract/Splice-in (yellow) deletes the segments and closes the remaining gaps. The total duration of the sequence is shortened, and any synchronized tracks lose sync.

2. Select one or multiple segments.

3. Press the Delete key.

   The system deletes the segments and any effects applied to them.

   If the segment contains transition effects, and you delete the segment, the transition effect remains. For information about how the system preserves transition effects, see “Transition Effect Preservation” in the Help.

**Marking Clips and Sequences**

As an alternative to marking sections of the Timeline in Source/Record mode for deleting, copying, subclipping, rendering, or creating an EDL or digital cut, you can use the segment tools to mark segments quickly.

**To mark segments in the Timeline:**

1. Do one of the following:
   - Select both of the segment tools on the Timeline palette, and then position the mouse pointer over the top of the segment (for Lift/Overwrite operations) or the bottom of the segment (for Extract/Splice-in operations).
   - Select one of the segment tools on the Timeline palette.
Working with Segments

The mouse pointer arrow changes to a large red or yellow arrow when inside the Timeline, depending on where you position the pointer or which segment tool you click.

2. Click one or more segments to highlight a section of the sequence.

3. Click the Mark Clip button.

   The system marks an In point at the start and an Out point at the end of the selected segments. If you selected more than one track, the In and Out points mark where the edit points across tracks line up.

---

Cutting, Copying, and Pasting in the Timeline

You can use the shortcut keys for cutting, copying, and pasting segments selected in the Timeline.

To cut or copy and paste segments:

1. Do one of the following:
   - Select both of the segment tools on the Timeline palette, and then position the mouse pointer over the top of the segment (for Lift/Overwrite operations) or the bottom of the segment (for Extract/Splice-in operations).
   - Select one of the segment tools on the Timeline palette.

   The mouse pointer arrow changes to a large red or yellow arrow when inside the Timeline, depending on where you position the pointer or which segment tool you click.

2. Click the segment to highlight it.

3. Press Ctrl+C (Windows) or Command+C (Macintosh) to copy, or Ctrl+X (Windows) or Command+X (Macintosh) to cut.

4. Move the position indicator to the new In point, and press Ctrl+V (Windows) or Command+V (Macintosh) to paste the segment in the Timeline.

   If you selected both segment tools in the Timeline palette, the paste operation uses the default segment tool specified in the Timeline Settings dialog box.
Setting the Default Segment Edit Tool

When you perform a segment edit without first selecting a segment edit tool, the Avid editing application uses the default segment tool for the edit. You can use the Timeline Settings dialog box to define which tool to use by default. Selecting a specific segment edit tool in the Timeline palette overrides the default tool.

To set the default tool used for segment editing:

1. Double-click Timeline in the Settings list in the Project window.
   The Timeline Settings dialog box opens, displaying a list of your current Timeline settings. For more information, see “Timeline Settings” on page 1525.

2. Click the Edit tab, and select one of the following:
   ▶ Segment Insert for Extract/Splice-In edits
   ▶ Segment Overwrite for Lift/Overwrite edits

3. Click OK.

Enabling Only One Segment Edit Tool at a Time

You can use the Timeline Settings dialog box to specify the behavior of the segment tools in the Timeline palette to allow only one segment tool to be enabled at a time. This overrides the default behavior, which allows both segment tools to be enabled at once, and is useful in some workflows.

For more information on Timeline settings, see “Timeline Settings” on page 1525.

To specify that the segment tools in the Timeline palette be enabled one at a time:

1. Double-click Timeline in the Settings list in the Project window.
   The Timeline Settings dialog box opens.

2. Click the Edit tab, and select Only One Segment Tool Can Be Enabled At A Time.

3. Click OK.

Bin Editing into the Timeline

You can use the segment tools on the Timeline palette to edit clips directly from a bin into the sequence in the Timeline. Bin editing lets you bypass the process of loading clips into the monitor, setting marks, and clicking the Splice-in button or Overwrite button.

You can also use keyboard shortcut keys to edit clips directly from a bin into the sequence in the Timeline.
For information on editing multiple clips directly from the bin into the RecordSource/Record monitor, see “Creating an Instant Rough Cut” on page 589.

To activate bin editing:

1. Double-click Bin in the Settings list in the Project window.
   The Bin settings dialog box opens.
2. Select the “Enable edit from bin (Splice, Overwrite)” option.
3. Click OK.

To perform a direct edit from a bin into your Timeline:

1. (Option) For a more accurate edit, mark In and Out points for each clip or create subclips. Otherwise, the entire clip is edited into the sequence.
2. Click one of the segment tools in the Timeline palette:
   - Lift/Overwrite (red) acts as an overwrite edit, causing the clip to overwrite material of the same length in the sequence while maintaining the same duration of the sequence.
   - Extract/Splice-in (yellow) acts as a splice edit, inserting the clip into the sequence, moving existing material down, and lengthening the total duration.
   If you do not select a segment tool, or if you select both tools, your Avid editing application defaults to the segment tool specified in the Timeline Settings dialog box. For more information, see “Setting the Default Segment Edit Tool” on page 701.
3. Drag a clip from the bin into the Timeline.
   You can edit only one clip at a time.
   The pointer changes to the selected segment icon, and the interface changes to the four-frame monitor display. As you drag, a white outline of the clip indicates the segment position.
4. When you find the right placement for the clip, release the mouse button.
   The Timeline reflects the new edit. After the edit is completed, the segment tool you selected remains active until you click the active segment tool button to deactivate it.

To perform a direct edit from a bin into a sequence:

1. Mark an In or Out point in the Timeline, or move the position indicator to the location where you want the clip to appear.
2. Select a clip in the bin.
3. Do one of the following:
   - Press the V key to perform a splice-in edit, which inserts the clip into the sequence and moves existing material down, lengthening the total duration of the sequence.
Press the B key to perform an overwrite edit, which causes the clip to overwrite material of the same length in the sequence while maintaining the same duration of the sequence. The Timeline reflects the new edit.

**Working with Multiple Tracks**

Your Avid editing application lets you edit up to 24 tracks of video and 24 tracks of audio, including multichannel audio tracks, and one data track. While working with multiple tracks, you can use the Track Selector panel to select, manipulate, delete, lock, patch, and monitor your tracks. You can use multiple tracks to layer audio effects and sound or to add video titles and other effects.

Multichannel audio tracks contain more than one channel of audio in a single track. Stereo multichannel tracks, for example, contain two stereo channels in one track. You can edit multichannel audio tracks in the same way that you edit mono audio tracks.

Multiple video tracks do not immediately play back at the same time until you apply an appropriate effect that composites the layers. Multiple audio layers, however, do play back immediately if correctly monitored.

Occasionally, effects editing involves a procedure known as nesting. Nesting involves stepping into existing tracks to reveal added layers for combining multiple images and digital video effects. When you apply an effect, you can step out to view and render the effect as one segment on the track. You can nest up to 24 additional tracks within each track.

For more information on nesting techniques, see “Nesting Effects” in the Help.

**Understanding the Track Selector Panel**

The Track Selector panel provides a quick display of track information. You can see which tracks are available, active, patched, monitored, or locked on the source and record sides at any time. The Track Selector panel can look very different depending on the nature of the source material or the work underway in the sequence. The following configuration shows only one example.

You cannot patch a data (D) track.
Track Selector and Track Control panels, with Source tracks (left) and Record tracks (right). See the following table for a list of Track Selector buttons.

<table>
<thead>
<tr>
<th><strong>Icon</strong></th>
<th><strong>Button</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="icon" /></td>
<td>Video Track Monitor button</td>
</tr>
<tr>
<td><img src="image" alt="icon" /></td>
<td>Video Track, Source and Record</td>
</tr>
<tr>
<td><img src="image" alt="icon" /></td>
<td>Sync Lock button</td>
</tr>
<tr>
<td><img src="image" alt="icon" /></td>
<td>Audio Mono Track Monitor button</td>
</tr>
<tr>
<td><img src="image" alt="icon" /></td>
<td>Audio Stereo Track Monitor button</td>
</tr>
<tr>
<td><img src="image" alt="icon" /></td>
<td>Audio 5.1 Surround Track Monitor button</td>
</tr>
<tr>
<td><img src="image" alt="icon" /></td>
<td>Audio 7.1 Surround Track Monitor button</td>
</tr>
<tr>
<td><img src="image" alt="icon" /></td>
<td>Audio Track, Source and Record</td>
</tr>
<tr>
<td><img src="image" alt="icon" /></td>
<td>Timecode button</td>
</tr>
</tbody>
</table>

The source side of the panel displays only those tracks available for the clip currently loaded. For example, a clip that has audio captured only for track A1 does not display an A2 track in the Track Selector panel.

The record side of the panel displays only those tracks currently in use for the sequence. When you edit source material with a track selected that does not yet exist on the record side, by default the track appears on the record side after the edit takes place.
Selecting Tracks

You can select tracks on the source side or the record side of the Track Selector panel to control your options for editing. For example, you might select the source and record tracks for V1, A1, and A2 to edit picture and audio from the source clip into the sequence. To edit the picture without sound, select only V1 source and record tracks. To edit the sound without the picture, select only A1 and A2 source and record tracks.

The following guidelines apply to track selection when you edit:

- You can edit selected tracks on the source side directly into the sequence, assuming you have selected parallel tracks on the record side.
- You cannot edit deselected tracks on the source side into the sequence, regardless of record track selections.
- You cannot edit deselected tracks on the record side into the sequence, regardless of source track selections.

The Tracks tab of the Command Palette contains buttons for all available Timeline tracks. You can map these buttons to any mappable button location or to the keyboard, or you can use them directly in the Command Palette. For more information, see “Mapping User-Selectable Buttons” on page 131 and “Activating Commands from the Command Palette” on page 133.

To select one or more tracks, do one of the following:

- Click the Track button of any inactive track to select the track.
- Drag a lasso around multiple tracks to select them at once.
- With the Timeline active, select Edit > Select All Tracks to select all tracks on the record and source sides.
- Click the Cycle Picture/Sound button in the Edit tab of the Command palette to cycle among selected video tracks, audio tracks, data track, or all tracks.
To use a Command Palette button for track selection, do one of the following:

1. Click the appropriate button in the location to which you have mapped it.
2. Press the key on the keyboard that you have associated with the track button.
3. In the Tracks tab of the Command Palette, select Active Palette, and then click the track button.

To deselect a track:
- Click the Track button of any active track.

Understanding Track Monitoring

The following information describes how track monitoring functions and your options for monitoring tracks. For procedures on monitoring or soloing tracks, see “Monitoring and Soloing Tracks” on page 708.

Monitoring Video

The Video Track Monitor button determines whether you see video during playback. You can turn it off at any time to monitor only audio during editing. When there are multiple video tracks, all tracks below the monitored track are active during playback. The Video Track Monitor button displays a Monitor icon when the track is monitored for playback and output.

When you edit with multiple tracks, you can activate the monitoring of a lower track to monitor only the video on that track and below. You can use this feature when you have multiple layers of video effects and need to isolate lower tracks for viewing. You can also monitor a solo track.

*If you monitor a video track below the topmost track, return monitoring to the topmost track to view, export, mix down, or record all the tracks together. Unmonitored tracks are not included in playback.*

Monitoring Audio

You can monitor up to 16 audio tracks at a time.
The following characteristics apply to audio track monitoring:

- The system pans odd-numbered mono tracks to the left speaker and even-numbered mono tracks to the right speaker by default. Stereo tracks include channels for the left and right speakers, with the stereo mix panned to the center.

- If your sequence includes more than 16 audio tracks, you can select any 16 tracks to monitor at one time by selecting the Audio Track Monitor button for each audio track you want to monitor. The Audio Track Monitor button displays either with a black border (primary monitored audio track) or without the black border (monitored audio track), when you select the audio track for monitoring playback and output.

- An Audio Track Monitor button with a black border indicates that the tracks are the primary monitored tracks and audio information is not dropped when the play speed increases during scrubbing. By default, the Avid editing application sets the two top audio tracks as the primary monitored tracks. For more information about setting an audio track to ensure it is not dropped during scrubbing, see “Selecting Tracks for Audio Scrubbing” on page 769.

- To hear more than 16 tracks at once, you must mix down some of them to a maximum of 16. For more information, see “Mixing Down Audio Tracks” on page 836.

- By default, all monitored audio tracks are selected for scrubbing. To isolate specific audio tracks for scrubbing, see “Soloing Audio Tracks” on page 767.

- By default, Direct Out maps all audio tracks in numerical sequence to existing output channels.

- You can customize the output of audio tracks, as described in “Setting Audio Output Options” on page 1072.

**Advantages of Solo Monitoring**

When editing, you can isolate individual video or audio tracks for monitoring without having to deselect monitoring of all other tracks.

Solo monitoring provides several advantages:

- You can eliminate slow cueing and playback when working with a complex sequence by monitoring a specific track.

- You can view any individual layer of a composited effect.

- You can isolate an individual audio track with a single mouse click (without manually deselecting the other audio tracks).

- You can isolate audio tracks for audio scrubbing without having to deselect monitoring of all other audio tracks.
Monitoring and Soloing Tracks

The Track Monitor buttons allow you to choose which tracks to monitor in the Source monitor, the Record monitor, and the speakers. You can monitor a single track or monitor multiple tracks at the same time. You can also isolate, or solo, an individual track for monitoring without having to deselect other tracks.

For more information on monitoring video and audio tracks, and on the benefits of solo monitoring, see “Understanding Track Monitoring” on page 706.

You cannot monitor or solo a data (D) track.

To activate or deactivate monitoring for a track:

- Click the Track Monitor button for the track on either the source-side or the record-side.

To select a track for solo monitoring:

1. Ctrl+click (Windows) or Command+click (Macintosh) the Track Monitor button for the video track you want to solo monitor.

2. Click the Solo button for the audio track you want to solo monitor.

The Track Monitor button changes to green with a black Monitor icon (video track) and the Solo button changes to green (audio track) to indicate solo monitoring. The Mute button on all other audio tracks changes to orange.

Track Selection panel, with video and audio tracks selected for monitoring
To deselect solo monitoring:

- Click the Track Monitor button or the Solo button again.

**Patching Tracks**

When working with multiple tracks, you can encounter a circumstance in which you must edit source audio or video onto a track other than the parallel track displayed in the Track Selector panel. To edit the source material onto another record track above or below it, you must patch the source track to the targeted record track.

You can perform only one patch per edit, but there is no limit on the number of times you can patch from the same source track. Audio can patch only to audio, and video only to video. Also, you can only patch multichannel audio tracks to multichannel audio tracks, or mono tracks to mono tracks. Your Avid editing application dims the track selector buttons on tracks with unsupported track formats when you patch tracks.

You can also patch tracks by using the Auto-Patching option in the Edit tab of the Timeline Settings dialog box. For more information, see “Timeline Settings” on page 1525.

When you patch from one video track to another, the Video Track Monitor icon moves to the track you are patching to if you selected the Auto-Monitoring option in the Edit tab of the Timeline Settings dialog box. Return to monitoring the topmost track, when necessary, to play back and output all video tracks.

You cannot patch a data (D1) track to another track.

To patch a track:

- Drag from a source track (audio or video) to the targeted record track (a white arrow appears during the patch). You can also drag from a record track to a targeted source track.

Track selection buttons for tracks with unsupported track formats dim as you drag the source track to a record track and you cannot patch to those tracks. For example, if you patch a source mono audio track, then all record stereo and record video tracks are disabled and you can only patch to a record mono audio track.

If you move the mouse pointer over a track selector button, and then press and hold the mouse button, a list of available tracks displays.
Working with Multiple Tracks

After you patch tracks, it is helpful to display the destination track of the clips in the Timeline. Select Clip Text > Clip Tracks from the Timeline Fast menu to display the destination track.

To undo a patch:

1. Click in the Record monitor or Timeline.
2. Select Special > Restore Default Patch, or manually repatch to the previous track.

The selected source track moves beside the record track to which it is patched as soon as you draw the arrow and release the mouse. The patched track remains highlighted in preparation for your edit. You can proceed to select any other tracks required for the edit.

After you make the edit, you can continue to work on the same track or patch to a different track as necessary.

Performing an Alternate Edit

Using Alternate Edit mode allows you to overwrite a selected clip in a sequence with several clips located in a special bin called Alternate Edits. To do this, you place the position indicator on a clip in the Timeline and click the Alternate Edit button. Each Alternate Edit replaces the clip where the position indicator is located with a clip from the Alternate Edits bin.

The order in which the clips appear in the Alternate Edits bin is the same order used for the overwrites in the sequence. If the clip you want to replace in the sequence is also in the Alternate Edits bin, then the selection defaults to the next clip in the bin.

Check the duration of the clip in the sequence. The clips or subclips in the Alternate Edits bin must be as long or longer than the clip in the sequence you want to replace.

To perform an alternate edit:

1. Load a sequence in the Timeline.
2. Create a bin called Alternate Edits.
3. Place clips or subclips in the Alternate Edits bin you want for your sequence.
The clips swapped into the sequence start at the beginning of the clip or subclip unless you mark an In or an Out point. When Out points are used, the sequence backfills the duration on the clip being replaced, starting from the Out point.

4. Move the position indicator in the Timeline to the clip you want to replace.
5. Select Tools > Command Palette.
6. Click the Play tab.
7. Click the Alternate Edit button.

The system replaces the clip and performs an Edit Review command. (For information on Edit Review, see “Reviewing Trim Edits” on page 745.)

The replacement clip prerolls in the sequence, using the preroll time specified in the Trim Settings dialog box.

Each time you click the Alternate Edit button, a clip from the Alternate Edits bin overwrites the selected clip.

8. (Option) Perform successive alternate edits as follows:
   a. Stop playing the sequence when the position indicator is on the clip being replaced, or move the position indicator to the clip being replaced.
   b. Click the Alternate Edit button.

Repeat this process to cycle through all the clips in the Alternate Edits bin.

**Muting Individual Clips in the Timeline**

The editing application allows you to mute individual video and audio clips in the Timeline. You can mute an audio or video clip in the Timeline by either right clicking on the clip and choosing Mute clips or selecting Mute clips from the Clip menu.

**To mute an individual clip in the Timeline:**

1. Locate the audio or video clip the sequence in the Timeline that you want to mute.
2. Right click the clip and select Mute clip. (You must be in Segment mode to mute a clip.)
The clip is then grayed out and the clip text appears in italics.

The clip plays back as filler. Muted clips can be edited like non muted clips. You can select, move, trim, etc. The clip keeps its timing and position in the sequence.

To unmute a muted clip in the Timeline:

1. Locate the muted audio or video clip the sequence in the Timeline.
2. Right click the clip and select Unmute clips.

   The clip is no longer muted.

Disabling a Video Track

The editing application allows you to disable a video track in the Timeline. When a video track is disabled, the entire input for that track is disabled.

To disable a video track in the Timeline:

1. Click the triangle opener to access the Track Control Panel.
2. Click the Disable Track button on the Video track you want to disable.
When a track is disabled, you cannot render any effects on that track. For example, if you disable a track and then try to render an effect on the disabled track, you will receive a “No effects to render” message.

Understanding Locking and Sync Locking

Your Avid editing application provides two ways of locking tracks and sync locking tracks. You can sync lock selected tracks so that trimming one track also trims the other tracks. Sync locking is useful when you work with multiple tracks and want to maintain sync between two or more tracks.

Locking tracks prevents further editing from being performed on them and can help in the following workflows:

- For video or picture editing, you can lock tracks when you have completed a set of complex, multilayer edits and want to avoid making accidental changes while you work on adjacent tracks.
- For audio editing, you can lock audio tracks containing sync dialog that should be maintained while you edit adjacent video tracks or audio tracks.
- For projects involving multiple editors, you can lock tracks to prevent unnecessary or accidental changes.

For more information on using the sync lock feature in Trim mode, see “Understanding Sync Lock” on page 617.

The Sync Lock and Lock buttons of the Track Selector panel display different icons for sync-locked and locked tracks. For more information on applying the locks, see “Locking and Sync Locking Tracks” on page 714.
Locking and Sync Locking Tracks

The following illustration shows the location of the Sync Lock and Lock buttons in the Track Selector panel, and the icons that appear on these buttons. For more information on your options for locking tracks, see “Understanding Locking and Sync Locking” on page 713.

Top to bottom: Lock icon, Sync Lock icon, and Sync Lock All button in the Track Selector panel

To lock tracks:

1. Select the tracks you want to lock (Source, Record, or both).

2. Do one of the following:
   - Select Clip > Lock Tracks.
   - Right-click in the Timeline, and select Lock Tracks.
   - If you want to lock a single track, right-click the track selector button and select Lock Track.

The Lock icon indicates that the selected tracks are locked. No further editing can occur on locked tracks until you unlock them.

To unlock tracks:

1. Select the tracks you want to unlock.

2. Do one of the following:
   - Select Clip > Unlock Tracks.
   - Right-click in the Timeline, and select Unlock Tracks.
   - If you want to unlock a single track, right-click the track selector button and select Unlock Track.

The Lock icon disappears and the tracks are unlocked.

To sync lock tracks, do one of the following:

- Click a Sync Lock button to activate the Sync Lock icon for each synchronized track.
- Click the Sync Lock All button to switch sync lock on and off for all tracks.

To resume editing on individual tracks:

- Click a Sync Lock button or the Sync Lock All button to remove the Sync Lock icon.


Adding and Deleting Tracks

Your Avid editing application lets you create up to 24 video and 24 audio tracks in the Timeline when building a sequence. (You can monitor 16 audio tracks at a time.) You can also add a data track, which is used for ancillary data. For more information, see “Preserving HD Closed Captioning and Ancillary Data” on page 1123.

By default, new tracks are numbered consecutively. For example, if a sequence contains video tracks numbered V1 and V2, a new video track is numbered V3. However, you can customize the numbering, and you can also assign custom names to tracks.

You can remove one or more tracks from a sequence if you no longer need the tracks. When you delete a track, you remove it permanently from the sequence. If you want to remove the track temporarily, hide the tracks as described in “Customizing Timeline Views” on page 663.

To add a new track to a sequence, do one of the following:

- With a sequence loaded in the Record monitor, select the type of track you want to add:
  - Select Clip > New Video Track.
  - Select Clip > New Audio Track Mono.
  - Select Clip > New Audio Track Stereo.
  - Select Clip > New Meta Track.
  - Select Clip > New Data Track.
- Right-click in the Timeline, and select one of the following:
  - New Video Track.
  - New Audio Track Mono.
  - New Audio Track Stereo.
  - New Meta Track.
  - New Data Track.

The new track appears in the Timeline.

To add a new track to a sequence and customize its numbering:

1. Press and hold the Alt key (Windows) or Option key (Macintosh) and select the type of track you want to add:
   - Select Clip > New Video Track.
   - Select Clip > New Audio Track Mono.
   - Select Clip > New Audio Track Stereo.
   - Select Clip > New Meta Track.
Select Clip > New Data Track.

The Add Track dialog box opens.

2. (Option) Select the type of track you want to add (for example, a video or an audio stereo track) by clicking the Track Type menu, and selecting that option.

3. (Option) Select a track number other than the default number displayed in the dialog box by selecting another number from the Track Number menu.

4. Click OK.

One of the following occurs:
- The new track appears in the Timeline and in the Track Selector panel. Stereo tracks in the Timeline display with a horizontal divider, indicating two channels of audio.
- If you selected the number of an existing track in step 3, a dialog box asks if you want to insert the new track. Click Insert to add the new track below the current track with that number. Your Avid editing application labels the new track with the number you selected and renumbers the existing tracks in consecutive order.

To add a custom name to a track in the Timeline:
1. Right-click the Track Selector button, and select Rename Track.
   
The Comments window opens.
2. Type a new name for the track.
3. Click OK.

To remove a custom track name:
1. Right-click the Track Selector button, and select Rename Track.
   
The Comments window opens.
2. Click Remove.
   
The track name returns to the default track name, such as V1.
To delete one or more tracks from a sequence:

1. Click one or more Track Selector buttons to select the tracks you want to delete.
2. Press the Delete key.

   The Delete Track(s) dialog box opens.
3. Click OK.

   The tracks are deleted.

Splitting Stereo Tracks to Mono Tracks

You can split a stereo audio track in the Timeline into separate mono tracks if you want to edit separate audio channels or if you need to export a sequence either to an older version of the Avid editing application. You can also split a clip or sequence with stereo tracks to mono from a bin. You can split individual stereo tracks to mono, or you can split all stereo tracks in your sequence.

When you split a stereo track, the original stereo track becomes a mono track and a new mono track is added below the original track. For example, if you split a stereo track on A1 in the Timeline, the application makes A1 a mono track holding one stereo channel and adds a second mono track on A2 for the other stereo channel. If A2 already exists in the Timeline, the application rennumbers tracks to allow for the split mono tracks. Also, the application renumbers tracks to preserve the odd and even track numbers for left and right mono channels. Renumbered tracks start at the highest track available.

If you duplicate a clip in a bin and split the copy to mono, or if you edit a stereo clip into a sequence on multiple tracks and split one track to mono, your sequence can contain both a stereo and a mono instance of the same master clip. This does not cause a problem with editing, playback, or any other operation.

If splitting stereo tracks to mono tracks causes your sequence to exceed 24 audio tracks, or if splitting to mono cannot maintain the relative order of tracks or the left/right channel alignment, the Avid editing application cannot complete the operation and an error message displays. You can reduce the number of audio tracks in your sequence and retry the operation.
When the Avid editing application splits a stereo track to two mono tracks, it changes some audio properties of the track:

- Removes stereo track effects such as RTAS plug-in effects.
- Converts stereo AudioSuite plug-in effects to mono effects.
- Applies any existing gain automation to the resulting mono tracks.
- Applies any existing pan automation to the resulting mono tracks, panning odd-numbered tracks to the left and even-numbered tracks to the right.
- Clears rendered effects. If you have effects on audio segments on stereo tracks, you need to render them after splitting the tracks to mono.

When you split all tracks in a sequence to mono, the Avid editing application automatically duplicates your original sequence and saves a copy to your bin before splitting stereo tracks to mono.

**To split a stereo audio track to mono, do the following:**

- Right-click the stereo track you want to split, and select Split Track to Mono.
- Right-click a stereo clip in a bin that you want to split, and select Split Track to Mono.

  The stereo track splits into two mono tracks, with the second mono track added below the original stereo track. A copy of your original sequence is saved to your bin as `[sequence_name].Copy.[number]`.

**To split all stereo audio tracks in the Timeline to mono, do one of the following:**

- Right-click in the Timeline, and select Split All Tracks to Mono.
- Select Clip > Split All Tracks to Mono.
All stereo tracks in the Timeline split into two separate mono tracks, with the new mono tracks added below each original stereo track. A copy of your original sequence is saved to your bin as [sequence_name].Copy.[number].

**Backtiming Edits**

Backtiming an edit is effectively the reverse of the process you normally use for marking footage: instead of marking from the In points forward, you mark according to the Out points. For example, you might have a track of audio (music or voice) that ends at a specific point, and you want to synchronize a video clip to end on a particular clip. You can backtime the edit to match the end points of the tracks.

Consider the following:

- Your Avid editing application needs only three marks to perform a backtimed edit. The In and Out points set on the record side always take precedence.
- If you do not mark an In point in the sequence, your Avid editing application uses the In point and Out point in the source clip (if both are marked) to determine the In point in the sequence. If you do not set both marks in the source clip, the system uses the position indicator as the In point.
- If you do not mark an Out point in the clip and an Out point in the sequence, your Avid editing application uses the end of the source clip as the Out point.
- If you mark Out points in both the Source monitor and in the Record monitor, your Avid editing application uses the Out point on the record side.

**To backtime an edit:**

1. Mark In and Out points in the sequence where you want the edit to start and end.
2. Select the appropriate tracks.
3. Load the source clip into the Source monitor.
4. Mark an Out point for the source clip to synchronize to the Out point in the sequence.
5. Click the Overwrite button.

The source material is added to the sequence, with the synchronized ending.

**In to Out Highlighting in the Timeline**

When you mark a sequence with In to Out points, the system indicates the selection by highlighting the marked region on selected tracks in the Timeline.
Marked region highlighting in the Timeline

This visual guide helps you monitor track and segment selection more carefully when mixing or applying effects across multiple tracks and segments.

**To turn the highlighting feature on and off:**

- Select the Show Marked Region option in the Display tab of the Timeline Settings dialog box.

---

**Editing in Heads or Heads Tails View**

While in the early stages of editing a project, you can rearrange clips in the sequence visually by using Heads view or Heads Tails view. These display formats are useful for rearranging simple straight-cut edits.

**If you rearrange a split edit (in which the audio extends beyond the video, or the reverse), the system cuts all tracks to the same edit point. To rearrange split edits or edits on multiple video tracks, or to move audio and video separately, use the Segment editing techniques described in “Working with Segments” on page 688.**

**To edit in Heads view or Heads Tails view:**

1. Click the Track buttons to select the tracks to be edited.
2. Click the Timeline Fast Menu button, and select View Type > Heads or Heads Tails.

The Timeline changes to one of the following displays.
Performing a Quick Edit Using the Top and Tail Commands

Heads view (top) and Heads Tails view (bottom) in the Timeline. Heads view shows the Head frame for each clip. Heads Tails view shows both the head and tail frames for each clip.

3. Press and hold the Alt key (Windows) or Option key (Macintosh), click the frames representing the clip you want to move, and drag the clip to its new position.

The sequence is rearranged to match the changes you made.

Performing a Quick Edit Using the Top and Tail Commands

The Top and Tail commands let you perform quick edits to segments in the Timeline.

Use the Top button in the Edit tab of the Command palette to extract footage from the start of the clip or segment to the position indicator. This action is equivalent to the T-R-X keyboard command sequence: Mark Clip, Mark Out, Extract.

Use the Tail button in the Edit tab of the Command palette to extract footage from the position indicator to the end of the clip or segment. This action is equivalent to the T-E-X keyboard command sequence: Mark Clip, Mark In, Extract.

For information about how the Mark Clip button works, see “Marking an Entire Clip or Segment” on page 547.

To edit using the Top and Tail commands:

1. Load a sequence into a monitor.
2. Select the track or tracks you want to edit, and deselect all other tracks.
3. Move the position indicator to the location where you want to perform an edit.
4. Do one of the following:
   - Click the Top button to extract footage from the start of the clip or segment to the position indicator.
Click the Tail button to extract footage from the position indicator to the end of the clip or segment.

**Working with Add Edits (Match Frames)**

The Add Edit function places an artificial edit point between frames of a clip. The edit appears in the Timeline as a transition between two clips, but when you play the clip, the footage appears unchanged because the frames are continuous. This form of edit is also known as a match frame.

You use add edits primarily to isolate a portion of a clip or sequence, which lets you modify that portion without affecting the rest of the footage. You can also add edits to filler segments to maintain sync while trimming. Once you make the adjustment, playback of the clip is no longer seamless because the two portions of the clip are different.

You can add an edit to a single audio or video track, or you can place the Add Edit across several tracks at once. You can add an edit to all tracks with filler, regardless of the track selection.

The Add Edit button appears in the Edit tab of the Command palette. Depending on the model of your Avid editing application and your button mappings, it might appear in other locations such as the Tool palette or the Timeline top toolbar. You can also map the Add Edit button to a custom location. For more information, see “Mapping User-Selectable Buttons” on page 131.

If you make a mistake when adding an edit, or if you have finished performing edit functions with multiple Add Edits and want to remove them, you can remove all Add Edits in the entire sequence or within a selected portion of the sequence.

You can also remove individual match frames by using the Undo command, or by selecting them in Trim mode and pressing the Delete key. For more information, see “Undoing or Redoing Edits” on page 590 and “Working with Trim Edits” on page 731.

You cannot remove match-frame edits between segments in which segment effects and audio pan or volume adjustments have been applied.

**To add a match-frame edit:**

1. Move the position indicator to the selected frame.
2. Select the tracks where you want to add the edit.
3. Click the Add Edit button.

The edit appears in the sequence with an equal sign to indicate a match frame.
By default, the match-frame indicator is white. If a change in level occurs, the match-frame indicator changes to red.

To add an edit to filler clips at the position indicator:

1. Move the position indicator to the selected frame.
2. Alt+click (Windows) or Option+click (Macintosh) the Add Edit button.

The edit appears on all tracks with filler in the sequence at the position indicator.

To remove match-frame edits:

1. Select the entire sequence or a portion of it as follows:
   - Select the entire sequence by removing any In and Out points.
   - Select a portion of the sequence by marking an In point and an Out point surrounding the match-frame edits (Add Edits) you want to remove.
2. Select the tracks from which you want to remove the edits.
3. Select Clip > Remove Match Frame Edits.

Your Avid editing application removes the edits.

Dupe Detection

When you edit offline with plans to generate an EDL, the Dupe Detection feature lets you visually track duplicate frames of footage while editing so that you can eliminate or manage the requirements of an online dupe reel.

The Dupe Detection feature works only for track V1.

When you activate Dupe Detection, each set of duplicate frames is tagged with a different color. (Up to 10 color sets can be distinguished during a single detection process.) Matching frames have matching colors. You can use any of the Trim Mode options to remove the duplicate frames, if necessary.

The colored bars that distinguish duplicate frames in the sequence appear automatically above the frames in the Timeline.
Two duplicate frames marked above the clip in the Timeline by the automatic Dupe Detection feature

Orange bars mark the first set of duplicate frames, green bars mark the second set, and so on. You can use Dupe Detection while you edit to locate duplicate frames, and remove them as the sequence evolves.

**Activating Dupe Detection**

You can change the handle size used by Dupe Detection in the Edit tab of the Timeline Settings dialog box. For more information, see “Adjusting Handle Length in Dupe Detection” on page 726.

Your Avid editing application might mark a special effect optical (such as a blowup) as a duplicate frame. Double-check your sequence for this possibility before deleting frames.

To activate Dupe Detection:

- Click the Timeline Fast Menu button, and select Dupe Detection.
  
  Dupe Detection occurs instantaneously and retroactively; if duplicate frames already exist in your sequence, the colored bars appear immediately. As you edit, your Avid editing application dynamically displays the duplicate frames.

**Methods for Changing Handle Length in Dupe Detection**

In 35mm film editing (using the single-strand method), one extra frame, known as the safety frame, provides tabs for the negative cutter to use when cutting two segments of film together. However, this frame is always lost during the negative conform.
Example of a splice on a safety frame. Frames 1 and 3 are still usable, but frame 2 has been cut in the middle and is lost.

In 16mm film editing (using the multiple-strand method), labs sometimes use the zero-frame cutting method to avoid seeing each splice in a 35mm blowup print. In this method, the negative is conformed along with the handles so that the cuts appear as soft frame handles rather than jumps in the resulting 35mm blowup.

Different labs have different standards depending on the equipment used. Usually, a minimum of four frame handles is needed.

Example of zero-frame cutting with multiple strands. The handles are shown in lighter gray.

Adding specific handle lengths to dupes (as they appear both in the sequence and in film lists) has the following advantages:

- In 35mm single-strand conforming — Editors can better track duplicate frames and provide the negative cutter with more than one safety frame to avoid losing specific frames.
- In 16mm multiple-strand conforming — For labs using the zero-frame cutting method, editors can track the number of handles during editing according to the specific standards of a particular lab.
Adjusting Handle Length in Dupe Detection

To adjust handle lengths in Dupe Detection:

1. Double-click Timeline in the Settings list in the Project window.
   The Timeline Settings dialog box opens.

2. Click the Dupe Detection Handles menu in the Edit tab, and select the number of handle frames. The typical 35mm safety frame setting is 0.5 frame (amounting to a 1-frame total with both sides of a cut).

3. Click OK.
   The selected value is applied to the head and tail of every event.

When you enable Dupe Detection during editing, the handles are added to the colored dupe indicators that appear in the Timeline.

Editing with the Film Track

You can use the film track to examine each frame of the sequence in a linear display, much as you would when looking at a strand of film on a flatbed or workbench. Unlike your view of the footage in the monitors, that display one frame at a time, the film track within the Timeline lets you compare individual frames side by side within a range of frames.

To display the film track:

- Click the Timeline Fast Menu button, and select Show Track > Film.
  A row of film frames appears at the top of the Timeline. The film track displays as many representative frames as possible within the window.

To adjust your view of the Timeline quickly for frame-by-frame viewing and editing:

- Click the Timeline Fast Menu button, and select Show Every Frame.
  The film track displays frames for the topmost video track only. You cannot display more than one film track at a time.
To quickly view more frames as you scroll:
> Drag the resize box in the lower right corner of the Timeline for a full-screen view.
> You can reduce the size of Timeline tracks to wrap the sequence around several times.
> As you continue to scroll, each strand of the Timeline wraparound is updated.

**Tracking Color Frame Shifts**

In preparation for an online edit using 1-inch reel-to-reel sources, you can enable the Color Framing options to track and correct instances where an edit cuts between the four fields (two frames) required to create a complete NTSC color sync signal phase (or eight fields — four frames — required for PAL).

When you enable Color Framing, green bars appear above the Overwrite and Splice-in buttons (Source and Record monitors) or above the position bar which blink whenever a color sync signal is interrupted by an edit. The blinking lights indicate that color framing is out of phase at the edit transition.

![Color-frame phase bars above the position bar](image)

**To enable color-frame tracking while editing:**

1. Double-click Composer in the Settings list in the Project window.
   
   The Composer Settings dialog box opens.

2. Click the Color Framing menu in the Edit tab, and select the appropriate option:
   > For NTSC video, select 4-field.
   > For PAL video, select 8-field.

3. Click OK to complete the setting selection.

**To correct color-frame interruption as you edit:**

1. Note any edits that cause the green lights to blink.
   
   You can adjust the edits now or place markers to return to these edits and correct them later.

2. To adjust the edit, enter Trim mode.
   
   In Trim mode, your Avid editing application displays small green boxes at the top corners of adjacent frames. When the color sync signals are in phase, the boxes align horizontally.
Example of color-framing boxes. Top: color sync signals are in phase and the boxes align horizontally. Bottom: color-sync signals are out of phase.

3. Trim one frame at a time on one side of the transition or the other until the green boxes align and the color-frame phase bars stop blinking.

If you pay attention to color framing while editing, you do not need to think about it when assembling your master tape. If you ignore color framing during the edit session, you might have to make adjustments during online editing if your edits interrupted any color-frame fields in the sequence.

**Finding Black Holes and Flash Frames**

You can use the Find Black Holes and Find Flash Frames commands to help you quickly find parts of your sequence that you might want to delete from the final sequence:

Black holes are segments of the sequence consisting of one or more frames of filler. Flash frames are clips with an extremely short duration — for example, fewer than 10 frames.

**To find black holes:**
1. Click the Timeline to activate it.
2. Select the tracks you want to search.
3. Move the position indicator to the beginning of the sequence or before the part of the sequence you want to search.
4. Select Clip > Find Black Holes.
   
   The position indicator moves to the first segment that contains filler. You can then edit or delete the filler, if necessary.

**To find the next segment that contains filler:**
- Select Clip > Find Black Holes again.
To find flash frames:

1. Set the maximum frame length that you want to detect:
   a. In the Project window, double-click the Timeline Setting.
      The Timeline Settings dialog box opens.
   b. Click the Edit tab.
   c. In the option Find Flash Frames Shorter Than, type the maximum number of frames you want to detect. The default is 10, which indicates the system will detect clips with 9 or fewer frames.
   d. Click OK.
2. Click the Timeline to activate it.
3. Select the tracks you want to search.
4. Move the position indicator to the beginning of the sequence or before the part of the sequence you want to search.
5. Select Clip > Find Flash Frames.
   The position indicator moves to the first flash frame.

To find the next flash frame:

Select Clip > Find Flash Frames again.

Printing the Timeline

To print the Timeline:

1. Click the Timeline to activate it.
2. Select File > Print Timeline.
   The Print dialog box opens. The name of the printer and details of the dialog box vary, depending on your facility.
3. Select the Print options.
4. Click OK (Windows) or Print (Macintosh).
   Your Avid editing application prints the current view of the Timeline. You can also use the Print Timeline command to print the Timeline in Heads view or in Heads Tails view.
Activating and Deactivating I/O Hardware

The editing application includes a hardware toggle button in the Timeline. This allows you to switch between hardware and software editing modes. The hardware toggle button appears in the Timeline if I/O hardware is attached when you launch the editing application. This includes Avid Nitris DX and Mojo DX hardware and 3rd party Open I/O hardware. This feature allows you to enable and disable the hardware for use with other software, for example After Effects. This also allows you to access certain software only features such as Full Screen Play.

The editing application will automatically release the hardware if you switch to another application. It will be reactivated when you switch back to the editing application.

Activating and Deactivating I/O Hardware

If the Toggle Hardware button is enabled, the I/O hardware is active. If the Toggle Hardware button is disabled, the I/O hardware is inactive.

To activate the I/O hardware:
- Click the Toggle Hardware button until it is active. The button is gray when hardware is active. This puts the editing application in Hardware mode.

To deactivate the I/O hardware:
- Click the Toggle button until it is inactive. The button has a red circle and line through it when inactive. This puts the editing application in Software mode.

Certain settings and buttons in the editing application change depending upon which mode you are in. For example, the Toggle Client Monitor button is disabled when the editing application is in Software mode. And you have access to additional Audio Project Output, Video Input and Video Output options when the editing application is in Hardware mode.

The I/O third party vendors are working on updating their plugins to work with the Toggle Hardware feature. Your current third party plugins will work properly with this version of the editing application, but if you try and use the Toggle Hardware button without updated plugins, you might need to reboot the system to reacquire your hardware.
Basic editing of a sequence initially produces a rough cut, which is loosely defined as a series of straight-cut edits with many rough edges and few effects. After creating a rough cut, you can use trim edits to fine-tune the transitions between each clip or between whole segments. You can also trim edits as you build a sequence rather than create a rough cut first. The following sections describe trim editing procedures:

- Trimming with the Timeline Palette
- Understanding Trim Displays
- Setting Small Trim Display
- Trim Settings Overview
- Timeline Trim States
- Selecting Trim Sides
- Overwrite Trimming
- Ripple Trimming
- Dual-Roller Trimming
- Refining Trims
- Reviewing Trim Edits
- Trimming with the J-K-L Keys
- Trimming On-the-Fly
- End of Trim Indicators
- Using Dual-Image Playback During Trims
- Trimming During a Playback Loop
- Creating Overlap Edits
- Extending an Edit
- Maintaining Sync While Trimming
- Slipping or Sliding Segments
- Using the Transition Corner Display
Trimming with the Timeline Palette

You can perform trim edits by using the trim tools on the Timeline palette. This lets you create trims quickly in your sequence which you can later fine-tune by using the advanced functionality of trimming.

You can make the following basic kinds of trim edits using the Timeline palette:

- **Overwrite trim** — single-roller trims which either add black or overwrite frames while trimming
- **Ripple trim** — single-roller trims with no sync lock
- **Dual-roller trim** — edits that move the transition boundary between segments without affecting the duration of the sequence

Some trims, such as overwrite trim edits, maintain sync between video and audio clips. Other trims, such as ripple trims, might break sync. For more information on keeping video and audio clips in sync, see “Maintaining Sync While Trimming” on page 751.

The following limitations apply to trim edits:

- You cannot trim a clip so that its duration equals zero frames.
- You can only trim until you encounter another segment in the same track. If you trim multiple clips, you can trim until any of the transitions encounters a segment in the same track or until the reach the duration of the shortest clip in the group.
- You cannot perform an overwrite trim beyond the duration of the selected clip.

Understanding Trim Displays

Different trim displays provide unique sets of controls for fine-tuning edits with various trim procedures. You can perform many of the same functions from any of these trim displays, such as removing and adding frames or slipping and sliding segments. For information about accessing these modes, see “Trim Settings Overview” on page 735.

You can render transition effects while trimming, but you cannot render segment effects once you select a transition for trimming. If the position indicator is on a segment effect or if the marked portion of your sequence includes a segment effect, you cannot access Render menu commands and buttons.

**Small Trim Display**

Small Trim display leaves the monitor display intact and has smaller displays of outgoing and incoming frames.
Small Trim display — replaces Record monitor in two-monitor view. Outgoing and incoming frames appear side-by-side on the right, with playback loop parameter controls above them, and with frame offset counters and Trim buttons beneath them.

**Quick Trim Display**

If you display only the Record monitor (for example, as you review the final version of a sequence), you can use Quick Trim display for making quick adjustments to transitions in your sequence.

Like Small Trim display, Quick Trim display replaces the Record monitor with smaller displays of outgoing and incoming frames.
When you click the Trim Mode button with the Record monitor active, the system enters Big Trim display. If you click the Trim Mode button again, the interface switches back to the Record monitor. This toggle feature is useful if you like to trim quickly as you finish your sequence.

**Big Trim Display**

Big Trim display replaces the Source and Record monitors with displays of outgoing and incoming frames. Big Trim display also shows transition playback loop parameters.

---

**Setting Small Trim Display**

When you click the Trim Mode button from Source/Record mode, by default the system activates Big Trim display. If you want to keep the Source monitor displayed, you can enter Small Trim display, which lets you access the Source monitor controls.

**To set Small Trim display:**

1. Double-click Trim in the Settings list in the Project window.
   - The Trim Settings dialog box opens.
2. Click the Features tab and select “Always use Small Trim mode.”
   - Your Avid editing application defaults to Small Trim display when you use the Trim Mode button.
Trim Settings Overview

You can customize how trimming works from the Trim Settings dialog box. The Trim Settings dialog box has two tabs: Features and Play Loop. The Play Loop feature continuously replays the last trim you performed for review purposes.

You can learn about specific Trim settings as follows:

- For setting some default behavior for trimming, see “Dual-Roller Trimming” on page 743.
- For information on transition playback loop parameters, see “Trimming During a Playback Loop” on page 749.
- For information on dual-image playback during trims, see “Using Dual-Image Playback During Trims” on page 748.
- For more information about the Play Loop feature, see “Reviewing Trim Edits” on page 745.

For information about all Trim settings, see “Trim Settings” on page 1530. For general information on accessing and working with settings, see “Working with Settings” on page 1421.

You can also do the following:

- Map trim-related buttons onto palettes or the keyboard, as described in “Understanding Button Mapping” on page 129.
- Configure a Trim-mode-specific Timeline view, as described in “Customizing Timeline Views” on page 663.

Timeline Trim States

When you trim using the Timeline palette, the kind of edit you can perform depends on which trim tools you select and the position of the mouse pointer relative to the transition you want to trim. If you enable both the Overwrite Trim and Ripple Trim tools and then hover the pointer over the upper half of your clip, you can perform an overwrite trim edit on either the outgoing frames (A-side) or the incoming frames (B-side). When you hover the pointer over the lower half of your clip, you can perform a ripple trim. Positioning the pointer over the transition between clips lets you perform a dual-roller trim.

When you select one of the trim tools on the Timeline palette, you can perform only that type of trim on your sequence.

The trim edit buttons also appear on the Smart Tool tab of the Command palette, so you can map them to the keyboard, a toolbar, or the Tool palette. For more information on mapping buttons, see “Mapping User-Selectable Buttons” on page 131.
As you move the pointer back and forth across a transition, notice that the roller icon changes from an A-side roller (facing left), to a dual roller, to a B-side roller (facing right) to indicate the type of trim.

Trim icons for the outgoing frames of the A-side clip (left) and the incoming frames of the B-side clip (right)

The following table describes the kinds of trim you can perform in each zone adjacent to your transition.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Trim Type</th>
<th>Trim Zone</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Overwrite trim (outgoing)</td>
<td>Upper right corner of the outgoing clip</td>
</tr>
<tr>
<td></td>
<td>Overwrite trim (incoming)</td>
<td>Upper left corner of the incoming clip</td>
</tr>
<tr>
<td></td>
<td>Ripple trim (outgoing)</td>
<td>Lower right corner of the outgoing clip</td>
</tr>
<tr>
<td></td>
<td>Ripple trim (incoming)</td>
<td>Lower left corner of the incoming clip</td>
</tr>
<tr>
<td></td>
<td>Dual-roller trim</td>
<td>Transition between outgoing and incoming clips</td>
</tr>
</tbody>
</table>

**Selecting Trim Sides**

You can trim a transition on either the outgoing side (A-side or tail), the incoming side (B-side or head), or both sides (dual-roller).

Once you select a trim side, the following happens:

- The selected parts of the transition are highlighted
- The corresponding rollers appear in the Timeline, colored to represent the type of trim: red for overwrite trim, yellow for ripple trim, and pink for dual-roller trim. This provides visual feedback so you always know what type of trim you can perform.
Selecting Trim Sides

Your Avid editing application highlights one or both of the frame counter indicators below the monitors to reflect the active trim sides: A-side, B-side, or both. The number indicates the frames added to or subtracted from the transition.

When you clear your trim selections, the trim tools remain active. You can turn off the trim tools by clicking the trim tool buttons in the Timeline palette or by clicking the Smart tool toggle bar.

You can use different methods to select a transition for trimming. The optimal selection method depends on your workflow.

To select the sides of a transition to trim, do one of the following:

- Select one or both of the trim tools on the Timeline palette, and then click the outgoing (A-side) or incoming (B-side) monitor to define which side of the transition to trim.
  
  The pointer changes to an overwrite trim or an ripple trim icon over either the A-side or the B-side of the transition, depending on the position of the pointer.

- Use the Trim buttons in the Trim tab in the Command palette or the Trim keys on the keyboard to select side A, side B, or both.
  
  You can map these buttons to other locations, as described in “Mapping User-Selectable Buttons” on page 131.

- Use the Cycle Trim Sides button to cycle between selection for a single transition of the A-side, B-side, or both.

- Lasso a transition to select both sides of a transition for trimming.
  
  If you lasso multiple transitions from left to right, you select the segment and not the transitions. If you lasso multiple segments from right to left, you select transitions for slip trim.

- Use one of the keyboard shortcut keys to select both sides of a transition relative to the position indicator:

<table>
<thead>
<tr>
<th>Shortcut Key</th>
<th>Selection</th>
</tr>
</thead>
<tbody>
<tr>
<td>U</td>
<td>Nearest transition</td>
</tr>
<tr>
<td>A</td>
<td>Previous transition</td>
</tr>
</tbody>
</table>
Selecting Trim Sides

<table>
<thead>
<tr>
<th>Shortcut Key</th>
<th>Selection</th>
</tr>
</thead>
<tbody>
<tr>
<td>S</td>
<td>Next transition</td>
</tr>
</tbody>
</table>

- Use the Trim Counter frame indicators located below the monitors. Click the A-side or B-side of a frame indicator to select single-roller trimming, or Shift+click both frame indicators to select dual-roller trimming.

![Trim Counter frame indicators: A-side (left) and B-side (right). The counter is purple when the side is active.](image)

To clear trim selections, do one of the following:
- Click the Smart tool toggle bar to turn off the Timeline palette Smart tools.
- Click the Trim mode button.
- Click the Source/Record Mode or the Effect Mode button.

![Source/Record Mode button (left) and Effect Mode button (right)](image)

- Click a frame step, or press the Right Arrow key or Left Arrow key.
- Click a location in the Timecode (TC1) track at the bottom of the Timeline or the Timeline ruler at the top of the Timeline.

The position indicator moves to that location.

![Click in the TC1 track to clear trim rollers and relocate the position indicator](image)

**Selecting Video Tracks for Trimming**

When you click the outgoing (A-side) or incoming (B-side) monitor with a transition selected for trimming, or the A-side or B-side of a transition in the Timeline, all trim rollers are set to the selected side. You can modify this behavior to select only the video tracks for trimming.
To change only the trim rollers on the video tracks:
- Alt+click (Windows) or Option+click (Macintosh) either the outgoing monitor or incoming monitor, or either the A-side or the B-side.

The trim rollers change only on the video tracks.

To return to the last position of the trim rollers:
- Press the Alt key when you click the Trim Mode button.

Selecting Additional Transitions

You can select additional transitions for trimming in different contexts.

To quickly select additional transitions on contiguous tracks for trimming on the same side:
- Click the corresponding Record track buttons in the Track Selector panel.

For more information, see “Selecting Tracks” on page 705.

For example, if you select a single transition in track V1 for single-roller A-side trimming and want to add tracks A1 and A2 at the same transition, click the corresponding track selectors.

You can also deselect tracks in the Track Selector panel to remove transitions on those tracks from the trim procedure.

To select additional transitions for single-roller trimming in varying locations on different tracks:
- Shift+click the transitions in the Timeline.

This method is useful when you work with staggered transitions across multiple tracks, This also lets you select both A-side and B-side transitions for simultaneous trimming in opposite directions (asymmetrical trim). You cannot do this with dual-roller trims.

Example of two A-sides and one B-side selected for asymmetrical trimming

To quickly add multiple transitions to the currently selected transitions:
- Press and hold the Shift key, and lasso the additional transitions.
You can select and trim two heads or tails simultaneously, in any combination, for each track in the sequence. All selected transitions are trimmed the same number of frames. This lets you save time and, in some cases, maintain sync by performing a single-trim procedure across multiple tracks and transitions.

To select transitions on clips linked by common source and timecode:

1. Click the Link Selection button.
2. Click a selection with linked clips.

The application selects all transitions on linked segments.

For more information on link selection, see “Linked Clips” on page 690.

**Soloing Audio while Trimming**

Soloing audio lets you listen to a single audio track while trimming multiple tracks.

To solo an audio track while trimming, do the following:

- Click the Solo button in the Track Control panel for the track you want to solo.

  The Solo button turns green, and Mute buttons on all other audio tracks turn orange.

**Overwrite Trimming**

If you want to trim one side of a transition but still maintain synchronization between video and audio, you can create an overwrite trim on either the A-side (outgoing frames) or the B-side (incoming frames) of a transition while maintaining the overall duration of the track and the sync relationships. This procedure either adds a black segment or overwrites frames to fill the duration of trimmed frames. For more information on preserving sync by adding black filler, see “Maintaining Sync While Trimming” on page 751.

You can lasso transitions in the Timeline to select more than one transition for trimming. This method is useful when you need to select multiple transitions staggered across parallel tracks (overlap cuts) for simultaneous trimming.
If you enable link selection, clicking a transition also selects transitions on linked segments (see “Linked Clips” on page 690).

**To perform and overwrite trim:**

1. Do one of the following:
   - Select the Overwrite Trim tool on the Timeline palette, and then click a transition to select it for trimming. Shift+click to select multiple clips aligned at the same transition.
   - Select the Overwrite Trim tool on the Timeline palette, and then lasso the transitions in the Timeline.

   Draw the lasso by clicking at a point above the top track in the Timeline and dragging to surround the transitions. You can drag from right to left or left to right to lasso one transition across several contiguous tracks. Avoid lassoing more than one transition on a single track because lassoing left to right selects the segment and activates segment editing tools, and lassoing right to left activates slip trim.

2. Click and drag in the direction you want to trim.

   The new incoming frame displays in the Record monitor as you trim, and one of the following occurs:
   - If you trim from an A-side trim handle toward the outgoing segment or from a B-side trim handle to the incoming segment, black filler is added.
   - If you trim from an A-side trim handle toward the incoming segment or from a B-side trim handle to the outgoing segment, frames are added to the segment with the trim handle and removed from the other segment.

   After you add black filler to a video track, you can replace the filler with footage by performing a replace edit. For more information, see “Performing a Replace Edit” on page 593.
Ripple Trimming

If you make a single-roller trim on either the outgoing or the incoming frames of your transition on an unlocked track, you can move the rest of the your sequence in the direction of the trimmed segment while maintaining the duration of all other clips. Ripple trims “ripple” the effects of your trim along the sequence. However, ripple trims can change the duration of your sequence if you select all tracks, and it can break synchronization with any unselected track. For more information about preserving sync, see “Maintaining Sync While Trimming” on page 751.

You can lasso transitions in the Timeline to select more than one transition for trimming. This method is useful when you need to select multiple transitions staggered across parallel tracks (overlap cuts) for simultaneous trimming.

If you enable link selection, clicking a transition also selects transitions on linked segments (see “Selecting Linked Clips” on page 691).

To perform a ripple trim:

1. Do one of the following:
   - Select the Ripple Trim tool on the Timeline palette, and then click a transition to select it for trimming. Shift+click to select multiple clips aligned at the same transition.
   - Select the Ripple Trim tool on the Timeline palette, and then lasso the transitions in the Timeline.
     
     Draw the lasso by clicking at a point above the top track in the Timeline and dragging to surround the transitions. You can drag from right to left or left to right to lasso one transition across several contiguous tracks. Avoid lassoing more than one transition on a single track because lassoing left to right selects the segment and activates segment editing tools, and lassoing right to left activates slip trim.

2. Click and drag in the direction you want to trim.

   The new outgoing frame displays in the Source monitor as you trim, and all segments located on the selected tracks move with the trim.
Dual-Roller Trimming

Using a dual-roller trim allows you to move the transition point between segments without changing the duration of the sequence. This adds frames to one side of the transition and subtracts them from the other side.

There are several ways to select a transition for dual-roller trimming. Which method you use depends on your editing workflow.

If you enable link selection, clicking a transition also selects transitions on linked segments (see “Selecting Linked Clips” on page 691).

To select a transition for dual-roller trimming, do one of the following:

- Position the mouse pointer over the transition you want to trim so the pointer changes to a dual-roller icon, and click the transition.
- Click the Trim Mode button.

Your Avid editing application selects the transition nearest the position indicator for dual-roller trimming. The dual-roller icon appears on all highlighted tracks. This method is useful for selecting straight-cut transitions on one track or across video and audio tracks.

![Default trim selection for a straight cut (showing dual-roller icons)](image_url)

If you selected the option in the Trim Settings dialog box to “Auto focus when entering Trim mode,” the Timeline enlarges at the transition selected for trimming.

If the transitions are not straight cuts (overlap cuts or L-edits), the dual-roller icon appears only on the transition nearest the position indicator of the topmost track, and all other tracks are deselected.

- Alt+click (Windows) or Option+click (Macintosh) the Trim Mode button to select the previous trim roller configurations.

By default, when you click the Trim Mode button, the trim rollers are set for dual-roller trimming. For more information about selecting trim sides, see “Selecting Trim Sides” on page 736.

- Click the Go to Previous Edit or Go to Next Edit button.

By default, the system selects the nearest transition in either direction of the selected track for dual-roller trimming.
If the transitions are a straight cut, the system selects all selected tracks. If the nearest transition is an overlap edit with staggered transition points, the system selects the next transition where all selected tracks have transitions at the same point.

- Click the Play Loop button on a palette twice, or press the Play Loop key on the keyboard twice.

When you click the Play Loop button once, the system plays the transition in a playback loop. Clicking the Play Loop button a second time stops the playback.

This method is useful if you want to trim quickly as you edit, going back and forth between trimming and other edit modes. The action takes you to the last trimmed transition. For more information on this method, see “Trimming During a Playback Loop” on page 749.

The Play Loop button does not appear in Source/Record mode by default. You must map it to the keyboard or a palette in advance. For information on button mapping, see “Understanding Button Mapping” on page 129.

Refining Trims

After you select your transitions and trim sides, you can make your trim more accurate by using the advanced features of trim editing.

To refine a trim, do one of the following:

- Use the Trim buttons to trim forward or backward by 1-frame or 10-frame (NTSC or PAL) or by 1-frame or 8-frame (24p) increments.

- Use the J-K-L keys to trim forward or backward in the sequence.

- Use the numeric keypad at the right side of the keyboard, as follows:
  - To move the transition a specific number of frames, type a plus sign (+) or minus sign (−) and the number of frames (from 1 to 99), and then press Enter.
    If the number of frames exceeds 99, type an f after the number to indicate frame count. For example, to enter 200 frames, type 200f and press Enter.
  - To move the transition to an exact point in the timecode, type a timecode number larger than 99, including frames. For example, type 102 to enter 1 second and 2 frames (1:02).
For greater control while performing a trim, do one of the following:

- Press Ctrl+Alt (Windows) or press the Command+Option key (Macintosh) as you drag one frame at a time.
- Press the Ctrl key (Windows) or Command key (Macintosh) to snap to other transition points.

As you trim, all selected transitions in the Timeline move in unison. The Trim counter displays the frame count backward or forward for one or both trim sides, and the monitors display the new incoming or outgoing frames.

### Reviewing Trim Edits

You can review an edit by using the Play Loop button or the Edit Review button.

The Edit Review button (in the Play tab of the Command Palette) lets you review an edit or other change that you made to a transition. You can set how far the position indicator moves backward by using the Preroll option in the Play Loop tab of the Trim Settings dialog box. For more information, see “Trim Settings Overview” on page 735.

*Using the Edit Review command causes your Avid editing application to deselect trim rollers on all transitions.*

**To review the most recent trim edit or to play the currently selected transition:**

1. (Option) To see the Timeline in a closer view while you review the trim, click the Focus button. (To return to your original view of the Timeline, click the Focus button again.)

   You can also select an option in the Features tab of the Trim Settings dialog box to focus the Timeline automatically when you select a transition by entering trim mode with no trim edits or trim tools selected. For more information, see “Trim Settings: Features Tab” on page 1530.

   ![Focus button](image)

2. Click the Play Loop button.

   The system enters a playback loop. This loop begins at a preroll point before the transition and ends at a postroll point.

3. Modify the length of the preroll, postroll, and transition effect duration by clicking the appropriate timing text box and typing a new value.

   ![Timing text boxes](image)

   Preroll length text box (top left), postroll length text box (top right), and transition effect duration text box (bottom)
You must display two rows of buttons in the Composer window to see the trim controls. For more information, see “Composer Settings” on page 1454.

4. To stop the playback loop, click the Play Loop button again.
5. To deselect trim points, click the Source/Record Mode button.

To review footage starting from the previous transition:
1. Move the position indicator to the transition you want to review.
2. Click the Edit Review button.
   The position indicator moves before the previous transition and begins to play.
   In a sequence with multiple selected tracks, the Edit Review command moves the position indicator before the first set of edits that line up on all the selected tracks.
3. To stop play, press the space bar.

**Trimming with the J-K-L Keys**

The J-K-L keys on the keyboard let you play, step (jog), and shuttle through footage at varying speeds. When you have transitions selected for trimming, you can use the J-K-L keys to play, step, shuttle and trim frames at the same time.

To use the J-K-L keys to only play, step, and shuttle without trimming, deselect the J-K-L Trim option in the Trim Settings dialog box.

**To trim with the J-K-L keys:**
1. Double-click Trim in the Settings scroll list in the Project window, and then click the Features tab.

**Trimming On-the-Fly**

You can use the J-K-L keys on the keyboard to play outgoing or incoming material and mark trim points. This is similar to the procedure for marking footage on-the-fly, as described in “Marking and Subcataloging Footage” on page 545.

For convenience, this method isolates the trim controls to just three keys.

When trimming with the J-K-L keys, you cannot completely trim away all frames in a segment. Your Avid editing application always leaves one frame. To remove the remaining frame, see “Refining Trims” on page 744.
To trim on-the-fly:

1. Click either the outgoing (A-side) or incoming (B-side) monitor to play in real time during the trim.

2. Select one or more transitions for overwrite trimming, ripple trimming, or dual-roller trimming.

   For more information, see “Selecting Trim Sides” on page 736.

3. Use the J-K-L keys to step (jog), play, or shuttle through the footage at varying speeds:

   ▶ Press and hold the K key while pressing the J or L key to step slowly backward or forward through the footage. When you find the frame where you want to relocate the transition, release the K key to complete the trim.

   ▶ Press the J or L key once to play at normal speed, or more than once to shuttle at higher speeds. When you see the frame where you want to relocate the transition, press the space bar or the K key to complete the trim.

   The monitors and the Timeline update to reflect the trim.

End of Trim Indicators

The extent to which you can trim many edits at once is constrained by the amount of footage available to trim. When you trim to either the beginning or ending of the footage, the trim stops without any indication of which track ran out of footage to trim. On tracks that run out of room to trim, the editing application adds white brackets to the trim indicators so you can clearly identify the track or tracks that caused the trim to stop. All tracks that cause the trim to stop display these indicators.
Using Dual-Image Playback During Trims

Dual-image playback lets you view A-side and B-side frames in real time while performing a trim. You can play through the transition by using the J-K-L keys or the Play and Trim buttons.

*Using the Dual Image Play option disables real-time effects.*

**To use dual-image playback during trims:**

1. Double-click Trim in the Settings list in the Project window.
   
   The Trim Settings dialog box opens.
2. Select the Dual Image Play option in the Features tab.
3. Click OK.
4. Select a transition for trimming.
   
   For more information, see “Selecting Trim Sides” on page 736.
5. Press one or a combination of the J-K-L keys.
   
   As the transition plays, notice that both the A-side and B-side of the trim play back in the Trim monitors.
6. When you see or hear the point at which you want to trim, press the space bar to stop playback and update the transition in the sequence.
Trimming During a Playback Loop

An alternative method for trimming is to view the transition continuously in a playback loop and use the keyboard to adjust the transition in 1-frame or 10-frame (8-frame for 24p) increments until you achieve the trim you want. You can perform this procedure using single-roller or dual-roller trims.

To trim during a playback loop:

1. Select a transition for trimming.
   For more information, see “Selecting Trim Sides” on page 736.

2. Click the Play Loop button to repeatedly play the selected transitions.

   To make adjustments to the playback loop for preroll, postroll, or intermission intervals, see “Reviewing Trim Edits” on page 745.

3. Press a keyboard equivalent to perform a Trim function.
   If you are having difficulty determining which side of the transition to trim (for example, during a difficult audio edit), use the Go to In and Go to Out keys to review only one side.
   Your Avid editing application performs the trim before the next playback loop. You can then view the trimmed transition during playback and make further changes until you are satisfied with the result.

4. When you finish, exit the playback loop by doing one of the following:
   - Press the space bar.
   - Click the Play Loop button.

Creating Overlap Edits

You can use an overlap edit (or L-edit) to smooth a transition by giving the viewer the illusion that the audio or video is shared between two adjacent clips.
Example of an audio overlap edit. After the trim, the audio for Clip B is extended so that it overlaps the beginning of the video for Clip C.

To create an overlap edit:
1. Perform a straight-cut edit between two clips, including audio and video tracks:
   - If the timing of the video edit is crucial, mark edit points according to video.
   - If the timing of the audio transition is crucial, mark edit points according to audio.
2. Perform a dual-roller trim on either the video track or the audio track, but not on both:
   - If the video transition occurs at the correct place but you want an audio transition either before or after the video cut, trim the audio tracks accordingly.
   - If the audio transition occurs at the correct place but you want a video transition either before or after the audio cut, trim the video track accordingly.
3. (Option) You can also create an overlap edit for an audio track by using the Audio Mark buttons (see “Marking Audio Clips” on page 549).

Extending an Edit

Use an extend edit to perform dual-sided (A-side and B-side) trims on selected tracks. An extend edit lets you quickly create a split edit without selecting trim sides at a transition. It also lets you establish the exact frame that you want to trim to by using the position indicator.

You can extend edits backward or forward in the Timeline. In either case, like a dual-roller trim, extend edits always maintain sync relationships.

To perform an extend edit:
1. Select the tracks you want to extend.
   - To extend multiple tracks, all the tracks must have the same edit point in the Timeline. Otherwise, you must extend the tracks separately.
2. Find the point in the sequence to which you want to trim. If the trim point is before the edit, mark an In point. If the trim point is after the edit, mark an Out point.

3. (Option) If you are extending the edit to an Out point, remove any In points on the track. Otherwise, the extend edit goes in the wrong direction.

4. Click the Extend button.

The Extend button appears in the Trim tab of the Command palette. You can map the Extend button to a custom location. For information on the Command palette and button mapping, see “Understanding Button Mapping” on page 129.

The adjustment appears in the Timeline.

Example of an extend edit. The video track is selected for extending backward (left), and the Mark In point (right) indicates where you want the edit to extend to.

4. Click the Extend button.

The Extend button appears in the Trim tab of the Command palette. You can map the Extend button to a custom location. For information on the Command palette and button mapping, see “Understanding Button Mapping” on page 129.

The adjustment appears in the Timeline.

After the Extend edit. The edit point on the video track moves backward to the location of the Mark In point.

## Maintaining Sync While Trimming

Because single-roller trims (A-side or B-side) can change the duration of the track being trimmed, any relationships that exist with other tracks downstream of the trim lose sync. Trim editing uses two features that prevent unintentional sync breaks between two or more video and audio tracks when performing trims:

- You can use an overwrite trim to add black filler on either the A-side or the B-side of a transition while maintaining the overall duration of the track and the sync relationships.
  
  For more information, see “Overwrite Trimming” on page 740.

- You can sync lock tracks that maintain a synchronized relationship.

If you perform an overwrite trim moving across the edit point and away from the selected side of the transition, your Avid editing application performs a dual roller trim on sync-locked tracks.
Because dual-roller trims do not cause sync breaks, you can add black only while performing single-roller trims, and sync-locked tracks only aid single-roller trim functions.

To trim with sync-locked tracks:

1. Do one of the following:
   - Click the Sync Lock button in the Track Selector panel for the track you want to keep in sync.
     The Sync Lock icon appears.
   - Click the Sync Lock All button to switch sync lock on and off for all tracks.

2. Perform single-roller trims as necessary, with the following results:
   - When you trim the A-side of a transition forward, all other segments locked in sync move forward with the trim. If the transitions are staggered, this action might split one or more of the segments at the sync point established by the position indicator, leaving filler.
     If you trim the B-side of the transition in the same direction, the additional sync-locked segments slide back in the sequence to maintain sync until they encounter another segment in the same track. At this point, you can trim no further and the system emits a warning sound.
   - When you trim back the A-side of a transition, additional segments locked in sync move back as well. If the segments are staggered and one of the additional sync-locked segments encounters another segment on the same track, you can trim no further and the system emits a warning sound.
     If you trim the B-side of the transition in the same direction, all other segments locked in sync move forward to stay in sync. If the transitions are staggered, this action might split one or more of the sync-locked segments at the sync point established by the position indicator. The trim adds Filler where the split occurs.

3. (Option) Select all synced tracks for simultaneous slipping or sliding to avoid sync breaks.
   Slip and slide trims are not protected for sync.
Slipping or Sliding Segments

Slip and slide procedures constitute two unique trim techniques that let you make frame-accurate adjustments to a selected segment. They do not affect the overall duration of the sequence or the sync relationships between multiple tracks.

Slip or Slide trimming lets you do the following:
- Slip or slide the video and audio segments together.
- Slip or slide a single segment of video or audio independently from the rest of the segment.
- Slip segments in Source/Record mode by using the Slip Left or Slip Right buttons.

The type of trim you perform (slip or slide) determines which frames update:
- In slip trimming, the two inner monitors for the head and tail frames of the clip change because this adjusts only the contents of the clip. It does not affect the frames that precede and follow the clip.

Example of a one-frame slip to the right. The head and tail frames of the segment change by one frame. The material before and after the segment remains fixed.

- In slide trimming, the two outer monitors for the outgoing (A-side) and incoming (B-side) frames change because the clip remains fixed while the footage before and after it is trimmed.

Example of a one-frame slide to the right. The segment does not change, but the material before the segment is trimmed out by one frame and the material after the segment is trimmed back by one frame.

Once you select the clips for slipping or sliding, the trim display changes to a four-frame display.
Selecting Segments for Slip or Slide Trimming

To select segments for slip or slide trimming by dragging a lasso:

1. In Source/Record mode, select a segment for slipping or sliding.
2. Drag a lasso from right to left around a segment (two or more transitions).
   
   Your Avid editing application enters slip trim by default.
3. To switch to slide trim, press and hold the Shift+Alt keys (Windows) or Option key (Macintosh) while dragging the lasso from right to left.

To select segments on a lower track:

1. Press and hold the Alt key (Windows) or Option key (Macintosh) while dragging a lasso around the segment.
2. To switch to slide trim, press the Alt key (Windows) or Option key (Macintosh) and double-click the segment.
   
   You can also select two or more contiguous segments within a track for slipping or sliding by dragging the lasso around four or more transitions.

Be sure to drag the lasso from right to left. If you drag from left to right, you select the segment, not the transition.
To select segments for slip or slide trimming:

1. Position the mouse pointer over one of the transitions for the segment you want to trim so the pointer changes to a trim icon, and double-click the transition to select the segment for slip trimming.

2. To select a segment for slide trimming, double-click the transition.

To select two or more segments on different tracks for simultaneous slip or slide trimming, do one of the following:

- Press Shift and select the head and tail of a segment for slipping.
- Press Shift and select the outgoing tail frame of the preceding segment and the incoming head frame of the following segment in a sequence for sliding.

Performing a Slip or Slide Trim

To slip or slide a shot:

1. After selecting the segments, as described in “Selecting Segments for Slip or Slide Trimming” on page 754, do one of the following:
   - Click any roller in the Timeline, drag the selected material to the left or right, and release the mouse button.
   - Use the numeric keypad to enter specific frame-count or timecode values, and press Enter.
   - Use the trim keys or buttons to shift the selection by 1-frame or 10-frame (8-frame for 24p) increments.
   - Use the J-K-L keys.

2. Monitor the progress of the trim by using the monitors, the Trim counters, and the Timeline.

When you reach the end of available material while slipping a shot, the trim stops. Similarly, when you reach the next transition while sliding a shot along a track, the trim stops. A red bracket at the transition indicates the limit. After completing the initial slide, you can perform another slide in the same direction.

3. When you finish, exit Slip mode or Slide mode by doing one of the following:
   - Click another transition for trimming.
   - Click either the Source/Record Mode or the Effect Mode button.
   - Click the Trim Mode button on the Tool palette.
   - Press the Escape key.
To slip a shot in Source/Record mode:

1. Select the tracks for the clips to be slipped.
2. Move the position indicator within the shot that you want to slip.
3. Slip the shot by doing one of the following:
   - Click the Slip Left button to slip the shot one frame left (revealing later material from the source clip).
   - Click the Slip Right button to slip the shot one frame right (revealing earlier material from the source clip).
   - Alt+click (Windows) or Option+click (Macintosh) the Slip Left or Slip Right button to trim 10 frames (8 frames for 24p) at a time.

The Slip Left and Slip Right buttons do not appear on the interface by default. You must map them from the Trim tab in the Command palette to use this procedure.

Trimming in Two Directions

You can select non-contiguous transitions in the Timeline and perform a trim simultaneously on all selected transitions. This allows you to trim segments without altering the duration of the sequence in cases where you cannot perform a simple dual-roller trim. For example, if you need to trim the outgoing frames of one segment, but you do not want to trim the incoming frames of the segment at the same transition, you can select another edit point to use in the trim.

You can also trim in two directions by trimming frames from one segment while adding frames to a second segment. This can help to keep video and audio aligned when you do not have the alternative of using a dual-roller trim or sync locked tracks.
To trim in two directions:

1. Select one or both of the trim tools on the Timeline palette, and then click the outgoing (A-side) or incoming (B-side) monitor to define which side of the transition to trim.

   The pointer changes to an overwrite trim or a ripple trim icon over either the A-side or the B-side of the transition, depending on the position of the pointer.

2. Shift+click the other transitions in the Timeline you want to trim.

3. Click and drag in the direction you want to trim.

Using the Transition Corner Display

The Transition Corner Display is a trim editing interface that shows six frames you can use as reference points when trimming a transition effect.

![Transition Corner display](image)

Transition Corner display. Left: the two frames on which the transition effect starts. Center: the two frames between which the cut point defines the transition. Right: the two frames on which the transition effect ends.

Use the Transition Corner Display to trim the transition effect’s start frames, end frames, and duration in timecode or feet+frames (for 24p and 25p projects). As you trim the transition effect, you can see the corresponding frame adjustments in all six monitors simultaneously.

The Transition Corner Display applies only to the trimming of transition effects (for example, dissolves, wipes, picture-in-picture, and so on). It is not designed for trimming key, image, or segment effects.

The Transition Corner Display feature is only available when you use Big Trim display. To ensure that you use Big Trim display when you make a trim, select “Never use Small Trim mode” in the Features tab of the Trim Settings dialog box. For more information, see “Trim Settings: Features Tab” on page 1530.
To trim a transition using the Transition Corner Display:

1. Select a transition effect for trimming by doing one of the following:
   - Position the mouse pointer over the transition you want to trim so the pointer changes to a dual-roller icon, and click the transition.
   - Lasso the effect in the Timeline from right to left.
   - Click the Trim Mode button, and click in the transition in the Timeline, or use the Go to Edit buttons to step through transitions until you highlight the transition you want.
     For more information, see “Dual-Roller Trimming” on page 743.

2. Click the Transition Corner Display button.
   The button changes to green, and the display is enabled.

   To use this button, you must display two rows of buttons in the Composer window or map the button to a palette or a keyboard key. For more information, see “The Command Palette” on page 129.

3. Trim the transition effect by clicking the outgoing or incoming frame you want to trim, and then position your pointer on the rollers and drag the transition backward or forward. Press and hold the Alt key (Windows) or Option key (Macintosh) to roll forward or backward slowly one frame at a time.

4. To review your edit, click the Play Loop button.
Working with Audio

You edit audio by using many of the same techniques and tools you use to edit video. Your Avid editing application also provides several unique features that facilitate audio editing, such as audio scrub, waveform displays, and tools for adjusting and mixing audio levels and pan between speakers as well as the frequency ranges of segments.

Basic audio editing is described in the following topics:

- Overview of Audio Tools
- Working with Multichannel Audio Tracks
- Displaying Track Formats in Bins
- The Track Control Panel
- Using Audio Scrub
- Audio Displays in the Timeline
- Displaying Audio Formats in Bins
- Working with Surround Sound Audio
- Adjusting the Play Buffer Size for Audio (Software-only Models)
- Using the Audio Mixer Tool
- Rendering and Unrendering Order for Audio Effects
- Audio Volume Staging and an Audio Editing Workflow
- Using Clip Volume and Pan Mode
- Using Volume and Pan Automation
- Copying, Pasting and Moving Audio Keyframes
- Using Live Mix Mode
- Fading and Dipping Audio
- Adjusting Audio Clip Gain in the Timeline
- Audio Sample Rate Conversion
- Changing the Audio Sample Rate for Sequences and Audio Clips
- Mixing Down Audio Tracks
Overview of Audio Tools

The following table describes the general purpose of each audio tool in your Avid editing application:

<table>
<thead>
<tr>
<th>Audio tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio Mixer tool</td>
<td>This tool adjusts pan and volume levels on clips or whole tracks within a sequence. For more information, see “Using the Audio Mixer Tool” on page 788.</td>
</tr>
<tr>
<td>Audio EQ tool</td>
<td>This tool adjusts the sound characteristics of audio clips in the sequence based on three-band control over high, low, and midrange frequencies. For more information, see “Using the Audio EQ Tool” on page 842.</td>
</tr>
<tr>
<td>Avid AudioSuite Plug-In tool</td>
<td>This tool accesses third-party audio plug-ins. For more information, see “Avid AudioSuite Plug-Ins” on page 932.</td>
</tr>
<tr>
<td>RTAS tool</td>
<td>This tool inserts Real-Time AudioSuite (RTAS) track effects on selected tracks. For more information, see “Audio Track Effect Plug-Ins” on page 925.</td>
</tr>
<tr>
<td>Audio tool</td>
<td>This tool adjusts and calibrates global input and output levels when capturing from analog sources or output to tape. For more information, see “Understanding the Audio Tool” on page 212 and “Preparing for Audio Output” on page 1069.</td>
</tr>
<tr>
<td>Audio Punch-In tool</td>
<td>This tool records up to two or four channels of audio (depending on the model of your Avid editing application) directly into the Timeline for voice-over narration. For more information, see “Recording Voice-Over Narration Using Audio Punch-in” on page 859.</td>
</tr>
</tbody>
</table>

Accessing Audio Effect Tools

The following audio effect tools can display in a single tabbed window or in separate windows:

- Audio Mixer
- AudioSuite
- Audio EQ
You can arrange these tools in a single, tabbed tool window to make it easy to switch to another tool.

**To access one of the audio effect tools:**
- Select Tools > *tool name*.

**To keep more than one tool open at the same time:**
- Select Tools > *tool name*, and then drag the tool to a tabbed tool window.

To prevent confusion, your Avid editing application allows only one copy of an audio effect tool to be open at a time. For example, you can open only one copy of the Audio EQ tool.

### Using Audio Timecode

Your Avid editing application can read audio timecode (LTC, or longitudinal timecode, recorded on an audio track). If you captured the LTC as an audio track, use the Read Audio Timecode command. This command instructs your Avid editing application to access this track for timecode information to be displayed in the bins and used in editing.

**To use timecode on an audio track:**

1. In the bin, select the appropriate clips.
2. Select Special > Read Audio Timecode.

   The Read Audio Timecode dialog box opens.

3. Select User Bit Timecode to read timecode stored in the user bits of the LTC.

   If you do not select this option, the system reads the LTC timecode.

   **Information contained in the user bits of the LTC must be timecode only. Other data stored in the user bits does not appear in your Avid editing application.**

4. Click the Audio Timecode Source menu, and select the audio track containing the timecode.

   A1 is the default.
5. Click the Destination Track menu, and select the target auxiliary timecode bin column for recording the audio timecode.

   Auxiliary TC1 is the default selection.

6. Do one of the following:
   ▶ Select Fill Undecodable Frames to instruct the system to fill in any timecode breaks with continuing timecode. This is the default.
   ▶ Deselect Fill Undecodable Frames if you do not want to fill timecode breaks.

   For example, in a 3-minute master clip, the audio timecode starts at 1:00:20:20. At 1:00:22:10, the timecode ends. With the Fill Undecodeable Frames option selected, the system assigns 1:00:22:11 to the next frame and continues assigning timecode.

7. Click OK to complete the procedure.

   The timecode appears in the bin in the auxiliary timecode column that you selected.

---

**Working with Multichannel Audio Tracks**

Video and audio information in your project can be represented as tracks, channels, and voices. The following list defines these terms as used in this documentation:

- **Tracks**
  - A region of a clip or sequence on which audio or video is placed.
  - A playback channel represented in a sequence as either a video track or an audio track. You edit tracks in the Timeline.

- **Channels**
  - A physical audio input or output. You capture audio channels, which then become audio tracks in your clip or sequence.
  - The separate audio signals that compose an audio track. Stereo tracks have two audio channels. 7.1 surround sound tracks have 8 channels.

- **Voices**
  - Discrete audio streams that you send from audio tracks to physical audio outputs, such as speakers or output channels. Typically, any audio channel for a track in your sequence uses a single voice. A mono audio clip uses one voice, a stereo clip uses two voices, and
a 5.1 or 7.1 surround sound clip uses six or eight voices. You can monitor up to 64 voices with your Avid editing application — for example, 16 mono tracks, 8 stereo tracks, or two 7.1 surround sound tracks.

You can edit multichannel audio tracks in the same way you edit mono audio tracks. Your Avid editing application supports the following audio track formats:

- Mono
- Stereo
- 5.1 surround sound
- 7.1 surround sound

The Track Formats column in the bin Text view displays the format for all multichannel audio tracks in a master clip. You can modify the audio format by grouping or ungrouping selected audio tracks. You can modify audio formats for master clips only. Track formats for sequences, group clips, or subclips cannot be modified.

For more information on surround sound multichannel audio, see “Working with Surround Sound Audio” on page 779.

**Displaying Track Formats in Bins**

You can select a bin heading to display the track formats in the bin. Multichannel formats appear in the Track Formats column for master clips and list the audio tracks in the clip that combine multiple channels in a single audio track. For example, a track format marked as “Stereo A1A2” indicates that the clip includes a stereo track with two channels.

**To add the Track Formats column to a bin:**

1. With a bin in Text view, select Bin > Choose Column.

   The Bin Column Selection dialog box opens.

2. Click Track Formats in the list to select it.

3. Click OK.

   The Track Formats column appears in the bin.

**Modifying Track Formats in Bins**

You use the Modify command to set or change the multichannel formats for your audio tracks. For example, this lets you create a stereo track from two associated mono tracks or to split a stereo track into two separate audio tracks. You can set the multichannel format for multiple master clips at the same time.
If you duplicate a clip in a bin and modify the track format in the copy, you can create a sequence that contains both a multichannel and a mono instance of the same master clip. This does not cause a problem with editing, playback, or any other operation.

You can also split multichannel tracks in the Timeline into mono tracks. For more information, see “Splitting Multichannel Tracks to Mono Tracks” on page 840.

To set the multichannel audio format for audio tracks:

1. Open the bin and click the Text tab.
2. Click the icon to the left of the clip you want to modify. Ctrl+click (Windows) or Cmd+click (Macintosh) each additional object you want to modify.
3. Do one of the following:
   - Select Clip > Modify.
   - Right-click a clip and select Modify.
   The Modify dialog box opens.
4. Click the Modify Options menu, and select Set Multichannel Audio.
   The Modify dialog box displays the audio tracks for all selected clips with format buttons beneath paired tracks. If an audio track is not used by the selected clips, it does not appear.

   ![Modify dialog box](image)

   Track formats for sequences, group clips, or subclips cannot be modified.

5. Do one of the following:
   - Click the Format buttons to cycle through the available options until you find the appropriate format.
Click the Format menu on a Format button and select the appropriate multichannel format.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mixed tracks</td>
<td>Does not modify the audio track formats. The Mixed Format Tracks button appears only when you select more than one clip and the clips contain both mono and multichannel tracks.</td>
</tr>
<tr>
<td>Mono tracks</td>
<td>Sets the paired audio tracks to two mono tracks.</td>
</tr>
<tr>
<td>Stereo tracks</td>
<td>Sets the paired audio tracks to one stereo track.</td>
</tr>
<tr>
<td>5.1 Surround sound tracks</td>
<td>Sets the selected tracks to one 5.1 surround sound track.</td>
</tr>
<tr>
<td>7.1 Surround sound tracks</td>
<td>Sets the selected tracks to one 7.1 surround sound track.</td>
</tr>
</tbody>
</table>

6. Click OK.

The bin information updates to reflect the audio format modifications. Check the Track Formats column in bin Text view to see all multichannel audio tracks.

---

The Track Control Panel

Timeline tracks include a Track Control panel that provides features useful when you edit audio tracks. The Track Control panel arranges components in two rows of tools, and it allows you to do the following when editing either a sequence or source material displayed in the Timeline:

- Show or hide waveforms, volume, and pan displays on individual tracks or on all tracks (see “Displaying Audio Waveforms” on page 773 and “Displaying Volume and Pan Values” on page 775).
- Add, delete, move, and copy RTAS® (Real-Time AudioSuite) effects (see “Audio Track Effect Plug-Ins” on page 925).
- Mark tracks as inactive or solo or mute tracks so you can monitor the audio on a track.
### Using the Track Control Panel

The Track Control panel displays two rows of tools. If you reduce the size of the Timeline tracks, you might not see the Track Control panel tools. For more information on resizing Timeline tracks, see “Enlarging and Reducing Timeline Tracks” on page 667.”

To show the Track Control panel, do one of the following:

- Click the Timeline fast menu and select Track Control Panel. To hide the Track Control panel, deselect Track Control Panel.
- Click the Track Control Panel button above the Timeline.

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Waveform</td>
<td>Turns on or off the waveform display for individual tracks.</td>
</tr>
<tr>
<td>Clip Volume/Pan</td>
<td>Turns on or off the clip volume and pan display for audio tracks.</td>
</tr>
<tr>
<td>Inactive</td>
<td>Disables a track so you can play back your sequence without processing the plug-in effects or automation for the inactive track.</td>
</tr>
<tr>
<td>Solo</td>
<td>Allows you to monitor a single track of audio without deselecting other tracks.</td>
</tr>
<tr>
<td>RTAS plug-ins</td>
<td>Lists the RTAS plug-ins inserted on the track. Clicking the button for an existing RTAS insert opens the RTAS plug-in window so you can edit the plug-in parameters. Clicking a blank RTAS button opens the RTAS tool so you can insert a plug-in on the track.</td>
</tr>
<tr>
<td>Mute</td>
<td>Allows you to mute a single track of audio without deselecting it.</td>
</tr>
</tbody>
</table>

Track Control panel, with the Track Control Panel button above the Timeline
Soloing Audio Tracks

You can solo multiple tracks in the Timeline, which lets you do the following:

- Listen to several tracks at once without deactivating or deselecting the other audio tracks off or reducing volume.
- Isolate audio tracks for audio scrubbing without having to deselect monitoring of all other audio tracks.

For more information about audio scrubbing, see “Using Audio Scrub” on page 768.

You can also use the Track Solo buttons in the Audio Mixer tool. See “Using the Track Solo and Track Mute Buttons” on page 794.

To solo an audio track:

- Click the Solo button in the Track Control panel for the track you want to solo.
  The Solo button turns green, and Mute buttons on all other audio tracks turn orange.

To turn off soloing for the track:

- Click the Solo button again.

To turn off the solo feature for all audio tracks:

- Alt+click (Windows) or Option+click (Macintosh) the Solo button on any track.

Making Tracks Inactive

Unlike muted audio tracks, inactive audio tracks process no plug-in effects or automation. You can make any audio track inactive if you want to play back your sequence without audio information. This allows you to limit the number of voices you monitor so you can manage output voices as you play your sequence.

The Active/Inactive button displays the monitoring status of the track:
Using Audio Scrub

To make an audio track inactive, do the following:

- Deselect the Active/Inactive button in the Track Control panel.
  
  You can click the Active/Inactive button again to restore audio monitoring to the track.

Using Audio Scrub

You have two options for scrubbing audio in either the sequence or the source material:

- Smooth audio scrub — Mimics the variable pitch playback of traditional analog tape
- Digital audio scrub — Takes advantage of the digital environment by sampling incoming frames, outgoing frames, or both at a normal pitch and playback rate

Digital audio scrub enables you to sample selected frames of incoming or outgoing audio as you move through the footage, without a change in pitch or speed. Digital scrub has the following unique characteristics:

- The frames of audio you hear are always at your point of destination. For example, if you step forward 10 frames (8 frames for 24p), you hear a selected number of audio frames from a point behind the position indicator (outgoing frames) to a point in front of the position indicator (incoming frames) as it reaches the new destination point.
- Digital scrub samples audio in a forward playback direction. Whether you step backward or forward through the material, you hear the same audio sampling at each destination frame.

Each type of scrub has its advantages:

- Smooth scrub makes it easier to examine sound at varying speeds.
- Digital scrub lets you focus quickly on individual bits of incoming or outgoing audio for frame-accurate edits and adjustments.

*If you attach a 002 to Avid input/output hardware, you cannot hear the results of audio scrubbing.*
Selecting Tracks for Audio Scrubbing

By default, all monitored audio tracks are selected for scrubbing. However, as the play speed increases during audio scrubbing, some monitored audio tracks are dropped. You can select up to two tracks to ensure they play during scrubbing, even if the system has to drop some tracks.

The following table shows how many tracks you can scrub at the varying speeds of play.

<table>
<thead>
<tr>
<th>When you play footage forward or backward at:</th>
<th>You can scrub:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal speed</td>
<td>16 tracks</td>
</tr>
<tr>
<td>Two times normal speed</td>
<td>16 tracks</td>
</tr>
<tr>
<td>Three times normal speed</td>
<td>2 tracks</td>
</tr>
<tr>
<td>Greater than three times normal speed</td>
<td>0 tracks</td>
</tr>
</tbody>
</table>

To ensure an audio track is monitored during scrubbing:

- Enable the Active/Inactive button in the Track Control panel for the selected track.

Active/Inactive buttons, displaying a black border to indicate tracks that can play without dropping audio information

The Active/Inactive button displays a black border to indicate which tracks can be played if the system has to drop tracks during audio scrubbing. By default, the two top Active/Inactive buttons display black border.

You can isolate specific audio tracks for scrubbing without having to deselect monitoring of all other audio tracks by soloing the audio tracks. See “Soloing Audio Tracks” on page 767.

To make a track the primary active track:

- Alt+click the Audio Track Monitor button for the selected track.
Performing Smooth Audio Scrub

You can use three-button play with the J-K-L keys to perform smooth audio scrubbing of selected tracks of audio at variable speeds but not digital audio scrub. You can monitor while stepping (jogging) or while shuttling at fixed rates up to three times normal speed. The audio cuts out at greater than three times the normal speed and comes back in after the speed drops below three times.

(Symphony Option) You can also use the mouse to perform smooth audio scrubbing of selected tracks. Mouse Jog lets you move the position indicator with the mouse. Mouse Shuttle lets you control the speed of the position indicator by dragging the mouse. You can jog and shuttle using the mouse but, unlike three-button play, playback rates using the mouse do not occur at fixed increments. They can vary all the way from 1 to 300 fps, depending on manipulation of the mouse.

To monitor audio with three-button play:

1. Select the correct track, and adjust the playback volume as necessary.
2. Play the audio by using the three-button variable speed playback procedures described in “Playing Footage with the J-K-L Keys (Three-Button Play)” on page 539.

(Symphony Option) To monitor audio with the mouse:

1. Select the correct track, and adjust the playback volume as necessary.
2. Activate the mouse for jogging or shuttling by pressing the Mouse Jog button or the Mouse Shuttle button.
   
   Both buttons are available in the Play tab of the Command palette and can be mapped to an editing button under the Record monitor.
   
   To deactivate jog or shuttle, press the space bar or the Escape key.
3. Play the footage with the mouse.

Adjusting Digital Scrub Parameters

The default parameters for the number of frames you hear as you scrub are zero frames of outgoing audio (behind the position indicator) and one frame of incoming audio (ahead of the position indicator). To isolate frames for marking or trimming, the default parameters are sufficient.

You can increase these settings to include more frames of audio on either side — for example, when you want to sample whole words or parts of words as you scrub to find edit points within a phrase. You can also reverse the settings to sample frames behind the position indicator.
(outgoing frames) as you scrub. You should avoid increasing the number of sampled frames on both sides at once because this can make it difficult to isolate an edit point or trim point based on the location of the position indicator.

To adjust the parameters for digital scrub:

1. Double-click Audio in the Settings list in the Project window.
   The Audio Settings dialog box opens.

![Audio Settings - Untitled]

The Play Buffer Size in Samples option and the Tool Buffer Size in Samples option appear only if your Avid editing application is not using Avid input/output hardware (software-only).

2. Click in a text box and type a new number of outgoing or incoming frames on the source side, the record side, or both.
   The new parameters take effect.

Performing Digital Audio Scrub

To locate an audio edit point by using digital scrub:

1. Solo an audio track for scrubbing and adjust the output volume, if necessary.

2. Press the Caps Lock key to activate digital audio scrub.
   You can also activate digital audio scrub by pressing and holding the Shift key while you drag the position indicator or click the Step buttons as described in step 3.

3. Move through the material in one of the following ways to hear the scrub:
   ▶ Drag the position indicator.
   ▶ Click the Step buttons to step through in fixed increments: 1 frame backward, 1 frame forward, 10 frames (8 frames for 24p) backward, or 10 frames (8 frames for 24p) forward.
Audio Displays in the Timeline

You can display audio waveforms in the Timeline to help you visually locate points in an audio track for editing or trimming. Waveforms for multichannel tracks in the Timeline display waveforms for all channels within a single track, separated by a horizontal divider. For more information, see “Displaying Audio Waveforms” on page 773.

You can also view a graph for pan and volume information in the Timeline. For more information, see “Displaying Volume and Pan Values” on page 775.

If you have a sequence with several different sample rates, you can identify a specific sample rate by color. For more information, see “Identifying Sample Rates by Color” on page 776.

The following notes apply to audio displays:

• When you click a Waveform or Clip Volume/Pan button in the Track Control panel, or when you Alt+click (Windows) or Option+click (Macintosh) a Waveform or Clip Volume/Pan button to display all waveforms or pan displays, the Avid editing application maintains the display setting with the sequence. You cannot save specific per track settings in a custom Timeline view.

• You can map the Allow Per Track Settings menu command on the Timeline fast menu to the keyboard. This provides you a quick method of turning selected track waveform displays off and on as you edit. For example, if you display waveforms for audio tracks A1 and A2 but not A3 and A4, and then disable per track settings, no waveforms display in the Timeline. When you enable per track settings, only A1 and A2 display waveforms. You can save the menu command state in a custom Timeline view.

The Avid editing application stores per track settings with the sequence and does not apply them to other sequences. Timeline views are saved as user settings, so you can apply them to any of your sequences.
Displaying Audio Waveforms

Audio waveforms in the Timeline display a sample plot of the entire amplitude of the track. This is the same as the sample voltage values seen on an analog oscilloscope waveform. You can display waveform plots for all audio tracks in the Timeline or you can select individual tracks for waveform display.

The editing application saves cached waveforms for projects. This allows the waveform to draw faster the next time you open the project. You will see a WaveformCache folder in the Avid Projects directory. The WaveformCache folder also appears in the Shared Avid Projects directory.

You might want to display waveforms on only some of your audio tracks. To do this, you can activate per track settings, or you can create a custom Timeline view as described in “Customizing Timeline Views” on page 663.

You can also select Show Marked Waveforms in the Timeline Settings dialog box to narrow the view of the tracks in the Timeline. This option allows the Timeline to display faster because the waveform displays only between the Mark In and the Mark Out points.

To display audio waveforms for all tracks:

1. To search for a point in a known section of the tracks, zoom in and show more detail in the sequence to isolate a section of the audio. With less audio to display, the system draws the waveform plot faster.

2. Do one of the following:
   - Click the Timeline fast menu and select Audio Data > Allow Per Track Settings, and then Alt+click (Windows) or Option+click (Macintosh) the Waveform button in the Track Control panel for any track.
   - Click the Timeline Fast menu button, and select Audio Data > Waveform.

Press Ctrl+period (Windows) or Command+period (Macintosh) at any time during the redraw of the waveform plot to stop the redraw.

The waveform appears in all audio tracks.

3. (Option) Maximize the visibility of your waveform display using one of the following procedures:
Audio Displays in the Timeline

- Continue to expand or shrink your view of the Timeline by using the scale bar, spreading out the waveform plots to show detailed variations in the audio levels.
- To enlarge the height of selected audio tracks and subsequently the waveform display, press Ctrl+L (Windows) or Command+L (Macintosh).
- To reduce the height of selected audio tracks and subsequently the waveform display, press Ctrl+K (Windows) or Command+K (Macintosh).
- To enlarge the size of the waveform plot image without enlarging its track, press Ctrl+Alt+L (Windows) or Command+Option+L (Macintosh).
  
  This procedure is useful when you view detail in loud passages.
- To reduce the size of the sample plot image without reducing its track, press Ctrl+Alt+K (Windows) or Command+Option+K (Macintosh).
  
  This procedure is useful when you view detail in quiet passages.

4. Move through the audio shown in the waveform using any of the playback methods.

You hear sound as you track the audio visually. When the position indicator reaches the point you want in the waveform, you can mark, trim, or perform any other function.

**To display audio waveforms for selected tracks:**

1. Click the Timeline fast menu and select Audio Data > Allow Per Track Settings.

2. Click the Timeline fast menu and select Audio Data > Allow Per Track Settings, and then click the Waveform button in the Track Control panel for the tracks you want to display audio waveform plots.

The waveform appears in the selected tracks.

You can turn off all waveforms on selected tracks by disabling Allow Per Track Settings. This disables the display of waveforms, but it does not change the per track settings. Enabling per track settings again restores your per track waveform displays. You can also save the Allow Per Track Settings state as part of a customized Timeline view. For more information, see “Customizing Timeline Views” on page 663.
Displaying Volume and Pan Values

You can view the volume and pan automation values in the Timeline, including surround sound pan values for sequences using a surround sound mix. If you choose to view volume and pan on individual tracks rather than on the entire sequence, you can view volume values on one track and pan values on another.

When you display pan information in surround sound sequences, you can select which speaker layout you want to view. For example, if you want to view the pan information for a stereo track in a 5.1 surround sound sequence, you can view how either the left or right stereo channel pans in the following speaker configurations:

- Front speaker position
- Front speaker position
- Front and rear speaker positions
- Center speaker position, displayed as a percentage

For information on displaying audio waveform information and using per track settings, see “Displaying Audio Waveforms” on page 773.

To turn on the display of clip volume values and volume automation values for all tracks, do the following:

- Alt+click (Windows) or Option+click (Macintosh) the Clip Volume/Pan button in the Track Control panel for any track, and select Clip Volume or Volume.

To turn on the display of clip volume values and volume automation values for selected tracks, do the following:

- Click the Clip Volume/Pan button in the Track Control panel for the tracks you want to display clip or volume automation information, and select Clip Volume or Volume.

The volume values appear in the selected tracks.

- (Option) If you want to view both clip volume and volume values, repeat the previous step and select an additional volume value to display.

To turn on the display of pan values in the Timeline:

1. If you want to view pan values for all tracks, Alt+click (Windows) or Option+click (Macintosh) the Clip Volume/Pan button in the Track Control panel and select one of the pan value options (pan value options depend on the sequence format and track format in your project):

   - Pan
   - Pan L > [speaker layout]
   - Pan R > [speaker layout]
2. If you want to view pan values for individual tracks, click the Clip Volume/Pan button in the Track Control panel for the tracks you want to display pan information, and select the appropriate pan option:
   - Pan
   - Pan L > [speaker layout]
   - Pan R > [speaker layout]

   The pan values appear in the selected tracks.

Identifying Sample Rates by Color

To apply a color coding to a sample rate:

1. Load a sequence with multiple sample rates into the Timeline.

2. Do one of the following:
   - To display waveforms for all tracks, click the Timeline Fast Menu button, and select Audio Data > Waveform.
   - To display waveforms for a single track, click the Waveform button in the Track Control panel.

3. In the Project window, double-click Audio Project.

   The Audio Project Settings dialog box opens.

4. Click the Main tab.

5. Click the Convert Sample Rates When Playing menu, and select Always.

6. Click the Show Mismatched Sample Rates as Different Color menu, and select Yes.

   Depending on which sample rate you selected for your project, the color black is displayed on those clips. For example, if you selected 48 kHz from the Sample Rate menu in the Main tab in the Audio Project Settings dialog box, the sample plot of these clips (48 kHz) is displayed as black, and the sample plot of all other clips with different sample rates (32 kHz and 44.1 kHz) is displayed as white.

Example of mismatched sample rates displaying with different colors in the Timeline. Clips with a 48 kHz sample rate display as black, while clips with other sample rates display as white.
Using Audio Meters in the Timeline

The Audio meters in the Timeline let you view and adjust audio levels without opening the Audio tool.

The Meter menu options are the same options as those available in the Audio tool. For more information, see “Understanding the Audio Tool” on page 212.

To display the Audio meters in the Timeline:

Click the Meter Menu button, and select Show Audio Meters.

The Audio meters display in the Timeline.

Audio meters display in the Timeline. Left to right: Master Volume button, Tracks indicators, In/Out Toggle buttons, Meter menu button

When you load a sequence in the Timeline and press the Play button, the Audio meter displays the audio levels of the audio tracks in your sequence.

When the Audio meter is hidden, extra mappable buttons are available. For more information on mapping buttons, see “Mapping User-Selectable Buttons” on page 131.

Adjusting Volume

You can adjust your speaker or headphone volume without leaving your Avid editing application.

You can also mute audio in several ways:

- Using the Master Volume button in the Timeline
- Using the Mute button in the Play tab of the Command palette

The Mute button lets you quickly make all audio tracks inactive or active during editing. This is convenient when you fine-tune complex audio and video edits, making it possible to shift quickly between the two. You can set your audio levels and speaker volumes and mute them whenever necessary without changing the settings.

- Using the Mute buttons in the Audio Mixer tool to mute selected tracks

For more information, see “Using the Track Solo and Track Mute Buttons” on page 794.

- Using the Mute button in the Track Control panel.

For more information, see “Soloing Audio Tracks” on page 767.
(Windows) To adjust the volume control (software-only models):
1. From the Timeline, click and hold the Master Volume button.

Master Volume button (left) and Audio Meter menu button (right) in the Timeline

If you do not see the Master Volume button, click the Audio Meter menu button, and then select Show Audio Meters. The Master Volume button displays with the Audio Meters.

The Windows Mixer appears.

2. On the Windows Mixer, drag the volume control to the audio level you prefer.

(Macintosh) To adjust the volume control (software-only models):
1. From the Timeline, click and hold the Master Volume button.

Master Volume button (left) and Audio Meter menu button (right) in the Timeline

If you do not see the Master Volume button, click the Audio Meter menu button, and then select Show Audio Meters. The Master Volume button displays with the Audio Meters.

The Volume Control slider appears.

2. Continue to click and hold, and drag the volume control to the audio level you prefer.
3. Release the mouse button.

To adjust the volume control (models using Avid input/output hardware):
- Adjust the volume control on your Avid input/output hardware to the desired audio level.

Adjusting the volume control affects the volume only while you work in your Avid editing application. Once you exit your Avid editing application, the volume control defaults to your desktop setting.

To mute volume from the Timeline:
- Click the Master Volume button.
A line appears through the button, and you cannot hear audio through your speakers or headphone. The Mute buttons on individual tracks do not change when you use the Master Volume button to mute audio.

*This does not apply to software-only models using Windows Vista and later.*

**To mute an individual audio track:**
- Click the Mute button in the Track Control panel for the track you want to mute.

**To mute all audio tracks:**
- Ctrl+click (Windows) or Command+click (Macintosh) the Mute button on any track.

**To turn the volume for audio tracks back on:**
- Click the Mute button to deselect it.

### Displaying Audio Formats in Bins

You can select a bin heading to display the audio formats in the bin. The applicable audio format, AIFF-C, WAVE, PCM, or SDII (Macintosh), appears in the Audio Format column for master clips.

**To add the Audio Format column to a bin:**
1. With a bin in Text view, select Bin > Choose Columns.
   - The Bin Column Selection dialog box opens.
2. Click Audio Format in the list to select it.
3. Click OK.
   - The Audio Format column appears in the bin.

### Working with Surround Sound Audio

Avid editing applications let you edit audio in mono and multichannel formats, including surround sound audio. You can hear this audio as either mixdown multichannel audio or as true stereo and surround sound using two, six, or eight speakers.

Six-channel and eight-channel digital surround sound systems use several different 5.1 and 7.1 speaker formats that constitute a standard in major motion pictures, music, and digital television. Speaker layouts generally use left and right speakers, left rear and right rear surround speakers, left side and right side surround speakers, center speaker, and a low frequency effects (LFE) speaker. The following table summarizes the supported multichannel formats and standard speaker configurations.
The 5.1 Film format is the default surround sound format for monitoring 5.1 surround sound audio and 7.1 Pro Tools is the default surround sound format for monitoring 7.1 surround sound audio.

The following illustrations show sample surround sound speaker arrangements (5.1 and 7.1 SMPTE surround sound formats).

<table>
<thead>
<tr>
<th>Mixing Format</th>
<th>Surround Format</th>
<th>Speaker Layout</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stereo</td>
<td>Left, Right</td>
<td></td>
</tr>
<tr>
<td>5.1 Film</td>
<td>Left, Center, Right, Left surround rear, Right surround rear, LFE</td>
<td></td>
</tr>
<tr>
<td>5.1 SMPTE</td>
<td>Left, Right, Center, LFE, Left surround rear, Right surround rear</td>
<td></td>
</tr>
<tr>
<td>7.1 Pro Tools</td>
<td>Left, Center, Right, Left surround side, Right surround side, Left surround rear, Right surround rear, LFE</td>
<td></td>
</tr>
<tr>
<td>7.1 SMPTE</td>
<td>Left, Right, Center, LFE, Left surround side, Right surround side, Left surround rear, Right surround rear</td>
<td></td>
</tr>
</tbody>
</table>

5.1 SMPTE surround sound configuration, with left (L), center (C), right (R), left surround rear (Lsr), right surround rear (Rsr), and low frequency effects (LFE) speakers

7.1 SMPTE surround sound configuration, with left (L), center (C), right (R), left surround side (Lss), right surround side (Rss), left surround rear (Lsr), right surround rear (Rsr), and low frequency effects (LFE) speakers
The Output tab in the Audio Project Settings dialog box lets you select which surround sound option you want to use when you export a sequence with surround sound audio. You can also use the Output tab to select the 5.1 or 7.1 option to designate a project with surround sound audio even if you do not have surround tracks in your sequence. If you have more than six or eight tracks, or if the tracks are given in a different order, you can use the Direct Out channel map to designate which tracks of the sequence go to which channels.

*The Direct Out channel map affects the audio on the desktop monitors and the output. When you use direct out to export a clip or to play a clip in the Source monitor, the channel order reflects the channel order used when you captured the audio. You might need to reset the channels prior to a Digital Cut to preserve a required channel order on the output tape.*

When you select a surround sound format, the Avid editing application displays the appropriate pan tools to use when you edit your sequence. Setting the surround sound format determines in which format you can mix your audio. For example, if you want to mix your audio in 5.1 surround sound, you need to assign that format to your sequence.

**To assign a surround sound sequence format:**


   The Audio Mixer tool opens.

   ![Audio Mixer tool: Sequence Format button](image)

2. Click the Sequence Format button and select one of the following:
   - Stereo Sequence
   - 5.1 Sequence
   - 7.1 Sequence

   Channel meters in the Audio Mix tool default to the Film format (for 5.1 sequences) or Pro Tools (for 7.1 sequences). Channel meters in the Audio tool reflect the monitor mix format.

**Surround Mixing**

Your Avid editing application allows you to mix in surround sound and create output in different formats. You can also mix down your surround sound sequences to mono, stereo, or different surround sound formats.
Surround sound audio tracks contain an individual channel for each signal in the track (for example, a 5.1 track has six channels, one each for left, center, right, left surround, right surround, and LFE). You can add surround sound master clips to your project in different ways:

- You can capture the audio from your source (see “Selecting Source Tracks and Audio Channels” on page 198).
- You can import the audio using standard import procedures (see “Importing with Multichannel Audio” on page 305).
- You can modify existing audio clips to create surround sound audio (see “Working with Multichannel Audio Tracks” on page 762).

Stereo and multichannel tracks consist of multiple audio signals, linked together. The Audio Mixer tool displays a channel faders for each multichannel track, in addition to solo and mute buttons. If you need discrete control of signals, you can convert multichannel tracks to individual mono tracks (see “Splitting Multichannel Tracks to Mono Tracks” on page 840).

You can mix mono, stereo, and surround sound audio tracks in any supported multichannel format. The Audio Mixer tool indicates the track format by the number of track meters contained in its fader strip (for example, a single meter for mono tracks, a pair of meters for stereo tracks, and six meters for 5.1 tracks). Assigning track output determines the format of that output. For example, a mono track always has a single track meter, even when assigned to a stereo output path. If you assign a mono track to a 5.1 output path, the output splits among six output channels, depending on the position of the panner.

**Surround Monitoring**

In order to monitor your multichannel mix, you must have appropriate hardware connected to your computer — for example, an audio card that supports surround sound or a Nitris DX connected to your system. You also need to set up the proper speaker placement and calibrate your audio system for the surround sound format of your sequence. When your audio system does not match your surround sound mix — for example, if your workspace includes only stereo speakers while your sequence uses a 5.1 Film format — you need to understand how your Avid editing application delivers surround sound tracks to the available output channels.

When your monitoring setup does not support the audio format selected for a sequence, your Avid editing application downmixes the audio tracks to the desired monitor mix. The following table describes the speaker arrangements of mono, stereo, and surround mix formats and the corresponding monitoring structure. Sequence format indicates which format you select for your sequence, and speaker layout describes how the Avid editing application outputs audio tracks to a mono speaker, two stereo speakers, and six and eight surround sound speakers. Speaker placement, alignment, and calibration depend on your specific hardware and audio configuration. See the documentation that came with your speakers and other monitoring equipment.
For example, if your sequence uses the 5.1 Film surround sound format, but your studio has two stereo speakers, the Avid editing application mixes down your six audio tracks to the following monitoring layout:
In addition to monitoring your audio through your speakers, you can monitor surround sound audio as it plays by watching the channel faders in the Audio Mix tool and in the Audio tool. When playing a sequence in the Timeline, the Audio Mix tool matches the default 5.1 Film surround sound format or the default 7.1 Pro Tools format. The channel faders in the Audio tool match the format of the sequence mix (see “Assigning Surround Sound Mix Output” on page 784).

**Assigning Surround Sound Mix Output**

You can set a surround sound mix output for any sequence in your project. This specifies how the Avid editing application sends surround sound signals to your speakers and determines what you hear when you monitor the audio in your sequence.

Your monitor mix output might differ from your sequence format. If you want to mix your audio in a surround sound format but only have two stereo speakers connected to your system, you can set your sequence format to surround sound and your mix output to stereo. If you need to mix your sequence in stereo but you have configured your speakers for surround sound output, you can set your sequence format to stereo and your mix output to surround sound. This ensures that the Avid editing applications sends the correct signals of your stereo channels to your surround sound speaker system.

To designate a surround sound mix output:

   
   The Audio Mixer tool opens.
Working with Surround Sound Audio

Audio Mixer tool: Monitor Mix Format button

2. Click the Monitor Mix Format button and select one of the following:
   - 5.1 Film: L C R Ls Rs Lfe
   - 5.1 SMPTE: L R C Lfe Ls Rs
   - 7.1 Pro Tools: L C R Lss Rss Lsr Rsr Lfe
   - 7.1 SMPTE: L R C Lfe Lsr Rsr Lss Rss

When you play a clip in the Source monitor, the monitor mix respects the channel order used when you captured the audio.

Setting Up the Analog Audio Output for Surround Sound Audio (Avid Nitris DX and Avid Mojo DX Only)

Depending on the Avid input/output hardware attached to your system, you can have two balanced TRS audio outputs labeled Monitor and four balanced XLR audio outputs labeled Analog. The TRS outputs are always left and right speakers. You can configure the XLR outputs in the Output tab of the Audio Project Settings dialog box.

If your workflow requires analog output to a tape deck, you configure the XLR outputs to connect to a deck. You see these channels, 1 through 4, in the Direct Out Channel Menu map in the Output tab of the Audio Project Settings dialog box.

If your workflow does not require analog output to a tape deck, you can use the XLR outputs to provide Center, LFE, Left Rear and Right Rear channels for desktop monitoring.

When the analog output is marked for use as desktop surround monitors, you should set the audio connectors as shown in the following table.

<table>
<thead>
<tr>
<th>Channel</th>
<th>Speaker</th>
</tr>
</thead>
<tbody>
<tr>
<td>TRS Channel 1</td>
<td>Left Front</td>
</tr>
<tr>
<td>TRS Channel 2</td>
<td>Right Front</td>
</tr>
<tr>
<td>XLR Channel 1</td>
<td>Center</td>
</tr>
<tr>
<td>XLR Channel 2</td>
<td>LFE</td>
</tr>
</tbody>
</table>
To set up for an analog audio output:

1. Double-click Audio Project in the Settings tab of the Project window.
   The Audio Project Settings window opens.
2. Click the Output tab.
3. Click the Analog tab.
4. Depending on your setup, select Use as Output to Tape Deck or Use as Desktop Surround Monitors.
5. Click the Mix Mode Selection Menu button to select Direct Out.
6. If necessary, assign the tracks and channels through the Direct Out channel menu.

If the sequence in the Timeline is multichannel or is direct out without being surround sound audio, the four analog XLR outputs remain silent and only the left and right speakers are active.

Setting Up the Audio Output with HDMI (Avid Nitris DX and Avid Mojo DX Only)

Avid supports two ways to configure your audio output, either 2-channel stereo speaker setup or 6-channel surround sound setup. To achieve the 6-channel surround sound setup, connect your audio output through an High-Definition Multimedia Interface (HDMI) connection.

HDMI carries both video and audio in an uncompressed, all-digital signal. HDMI is an interface standard for audiovisual equipment such as high-definition television.

In order to use HDMI for audio, the HDMI device attached to your system must receive at least two channels of PCM (uncompressed) audio at the project sample rate and receive 6 channels or more of PCM audio.

If you send the HDMI output to a deck, the deck receives the channels in the Timeline in the same order as the channels set in the Direct Out Channel map in the Audio Project Settings window. If you configure your system for surround sound audio, the output is sent in the HDMI standard channel order as shown in the following table.
To set up for a surround sound (HDMI) audio output:

1. Double-click Audio Project in the Settings tab of the Project window.
   The Audio Project Settings window opens.
2. Click the Output tab.
3. Click Direct Out, then select First six tracks are 5.1 surround: L, R, C, LFE, LR, RR.
4. Click the HDMI tab.
5. Depending on your setup, select Use as Output to Tape Deck or Use as Desktop Surround Monitors.
   When you select Use as Output to Tape Deck, LFE and Center are swapped from the recommended track order.

If your HDMI device cannot play six channels of audio or if the 5.1 option in the Direct Out tab is not selected, the option to Use as Desktop Stereo Monitors does not appear.

6. Click the Mix Mode Selection Menu button to select Direct Out.
7. If necessary, assign the tracks and channels through the Direct Out channel menu.

Adjusting the Play Buffer Size for Audio (Software-only Models)

You can use third-party host audio devices, such as a Sound Blaster® audio card, in software-only configurations of Avid editing applications. Although most host audio devices work properly within Avid editing applications, some exhibit problems during output (for example, audio clicking). You might also encounter audio latency issues when adding audio effects such as volume automation. To counteract these problems, use the Play Buffer Size in Samples slider and the Tool Buffer Size in Samples slider in the Audio Settings window.
Avid strongly recommends that you use the default “recommended sample” setting, which is determined by the host audio device connected to your system.

For more information on the Buffer Size in Samples sliders, see “Audio Settings” on page 1437.

To adjust the samples in the play buffer or tools buffer:
1. Double-click Audio in the Settings tab of the Project window.
   The Audio Settings window opens.
2. In the Play Buffer Size in Samples, click and drag the slider to select a sample size.
3. In the Tool Buffer Size in Samples, click and drag the slider to select a sample size.
   If you change the default setting, a warning dialog box opens informing you of how this change might affect your system.
4. Click Change.
5. To select the Avid recommended default setting, click the rs (recommended sample) button.

Using the Audio Mixer Tool

The Audio Mixer tool has three modes that let you perform the following tasks:

<table>
<thead>
<tr>
<th>Mode</th>
<th>Task Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clip Volume and Pan</td>
<td>Lets you adjust the overall volume and pan values for a clip, in a bin or in the Timeline. For more information, see “Using Clip Volume and Pan Mode” on page 797.</td>
</tr>
<tr>
<td>Volume automation and Pan</td>
<td>Lets you adjust and record volume and pan changes within a clip in the Timeline. For more information, see “Using Volume and Pan Automation” on page 813.</td>
</tr>
<tr>
<td>Live Mix</td>
<td>Lets you temporarily override any existing volume and pan automation settings. You can use the controls on the Audio Mixer tool or use an external controller to change volume and pan settings without modifying the existing volume and pan automation settings. For more information, see “Using Live Mix Mode” on page 826.</td>
</tr>
</tbody>
</table>
Accessing the Audio Mixer and Audio Mixer Modes

To open the Audio Mixer tool, do one of the following:

- If one of the Audio tools is already open, click the Effect Mode Selector menu, and select Audio Mixer.
- Select Tools > Audio Mixer.

The Audio Mixer tool opens.

To select the Audio Mixer mode, do one of the following:

- Click and hold the Audio Mixer mode button, and select the mode from the menu.
- Click the Audio Mixer mode button and cycle through the Audio Mixer mode settings to the mode you want to select.

Audio Mixer Tool Controls

The following illustrations and tables identify the controls of the Audio Mixer tool in Clip Volume and Pan mode, including controls common to all three modes. The elements described in the following tables appear in all Audio Mixer modes unless otherwise noted. For specific information on Volume and Pan Automation mode, see “Using Volume and Pan Automation” on page 813. For specific information on Live Mix mode, see “Using Live Mix Mode” on page 826.

### Element Description

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sequence Mix Format button</td>
<td>Lets you select the sequence mix format.</td>
</tr>
</tbody>
</table>
## Element Description (Continued)

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 Monitor Mix button</td>
<td>Controls how your system interprets audio values during playback:</td>
</tr>
<tr>
<td></td>
<td>• Stereo: Mixes the currently monitored audio tracks into a stereo pair. Depending on your Avid input/output hardware, you can customize the mix using the Stereo Mix Tracks option.</td>
</tr>
<tr>
<td></td>
<td>• Mono: Pans all the currently monitored tracks to center and ignores pan effects.</td>
</tr>
<tr>
<td></td>
<td>• 5.1 as L C R Lr Rr Lf e: Mixes currently monitored tracks to the appropriate surround sound channel. See “Surround Monitoring” on page 782.</td>
</tr>
<tr>
<td></td>
<td>• 5.1 as L R C Lfe Lr Rr: Mixes currently monitored tracks to the appropriate surround sound channel. See “Surround Monitoring” on page 782.</td>
</tr>
<tr>
<td></td>
<td>• 7.1 as L C R Lss Rss Lr Rr Lfe: Mixes currently monitored tracks to the appropriate surround sound channel. See “Surround Monitoring” on page 782.</td>
</tr>
<tr>
<td></td>
<td>• 7.1 as L R C Lfe Lr Rr Lss Rss: Mixes currently monitored tracks to the appropriate surround sound channel. See “Surround Monitoring” on page 782.</td>
</tr>
<tr>
<td></td>
<td>• Direct (available depending on your Avid input/output hardware): Maps tracks directly to the available output channels. Ignores pan settings. On Symphony Option systems, by default, Direct Out maps the first eight audio tracks in numerical sequence to the first eight output channels. You can remap a track to any channel by clicking the Channel Assignment menu and selecting another channel.</td>
</tr>
<tr>
<td>3 Audio Loop Play button</td>
<td>Lets you adjust audio effects while looping over a portion of audio. This button is also available in the Play tab of the Command palette. For more information, see “Adjusting Volume While Playing a Clip Volume Effect” on page 810.</td>
</tr>
<tr>
<td>4 Render Effect button</td>
<td>Lets you render audio effects. For example, if you change the level of a clip that contains a rendered audio dissolve, the effect becomes unrendered. You can use the Render Effect button to rerender the audio dissolve directly from the Audio Mixer tool. Then you can play back the clip immediately to hear the effect of the level change with the dissolve in place.</td>
</tr>
<tr>
<td>5 Fast Menu button</td>
<td>Lets you select from a list of functions that vary according to the Audio Mixer mode. For more information, see the following topics:</td>
</tr>
<tr>
<td></td>
<td>• “Audio Mixer Fast Menu: Clip Volume and Pan Mode” on page 808</td>
</tr>
<tr>
<td></td>
<td>• “Audio Mixer Tool Fast Menu: Volume and Pan Automation Mode” on page 820</td>
</tr>
<tr>
<td></td>
<td>• “Audio Mixer Tool Fast Menu: Live Mix Mode” on page 828</td>
</tr>
<tr>
<td>6 Bypass button</td>
<td>Lets you temporarily turn off any Clip Volume or volume automation effects. This button functions the same as the Bypass panel in the Effects tab in the Audio Project Settings dialog box. (This control does not appear in Live Mix mode.)</td>
</tr>
<tr>
<td>Element</td>
<td>Description (Continued)</td>
</tr>
<tr>
<td>---------</td>
<td>-------------------------</td>
</tr>
<tr>
<td>7</td>
<td>Number of Mix Panes</td>
</tr>
<tr>
<td></td>
<td>Lets you display four or eight panes. For more information, see “Resizing the Audio Mixer Tool” on page 793.</td>
</tr>
<tr>
<td>8</td>
<td>Display/Hide Sliders button</td>
</tr>
<tr>
<td></td>
<td>Lets you switch between hiding and displaying the Volume Level sliders.</td>
</tr>
<tr>
<td>9</td>
<td>Audio Mixer mode button</td>
</tr>
<tr>
<td></td>
<td>Lets you select the mode for the Audio Mixer tool:</td>
</tr>
<tr>
<td></td>
<td>• Auto (volume and pan automation)</td>
</tr>
<tr>
<td></td>
<td>• Clip (Clip Volume and Pan)</td>
</tr>
<tr>
<td></td>
<td>• Live (Live Mix)</td>
</tr>
<tr>
<td></td>
<td>The default mode is Clip Volume and Pan. The mode that you select is saved as a project setting. If you want to change the default mode, select the mode you want in the Audio Mixer tool, then save the Audio Project settings as a site setting. See “Using Site Settings” on page 1429.</td>
</tr>
<tr>
<td></td>
<td>You cannot save Live Mix mode as a project setting.</td>
</tr>
<tr>
<td>10</td>
<td>Which Set of Tracks to Display in Mix Panes buttons</td>
</tr>
<tr>
<td></td>
<td>Lets you select which enabled tracks to display in the mix panes. When you display 8 panes (with the Number of Mix Panes button), Grp 1 displays tracks 1-8. Click the Which Set of Tracks to Display in Mix Panes button to change it to Grp 2, which displays tracks 9-16. When you display 4 panes, each click of the Which Set of Tracks to Display in the Mix Panes button displays the next group of 4 tracks.</td>
</tr>
<tr>
<td>Element</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>1 Pan value and knobs</td>
<td>Displays the pan value and lets you adjust it. These controls appear only when you select a surround sound format using the Sequence Mix Format menu or when you set Stereo, 5.1 Surround, or 7.1 Surround as output in the Audio Project settings.</td>
</tr>
<tr>
<td>2 Track Solo and Track Mute buttons</td>
<td>Lets you solo or mute selected tracks. The values persist when you switch to another group, switch to another Audio Mixer mode, and when you close the Audio Mixer tool. For more information, see “Using the Track Solo and Track Mute Buttons” on page 794.</td>
</tr>
<tr>
<td>3 Volume Level sliders</td>
<td>Lets you adjust the volume level of the clip.</td>
</tr>
<tr>
<td>4 Volume Level Displays</td>
<td>Displays the volume level of the track. You can click and type in a new value. In Clip Volume mode, if the track has an volume and pan automation value associated with it, the word Auto appears. In Volume and Pan Automation mode, if the track has a system clip volume value associated with it, the word Clip appears.</td>
</tr>
<tr>
<td>5 Position Indicator Lights</td>
<td>Indicates whether the external fader controller or mixer is connected and configured correctly. For more information, see “Interpreting Position Indicator Lights” on page 794.</td>
</tr>
<tr>
<td>6 Track Selection Menu buttons</td>
<td>Lets you enable tracks for mixing audio. When you select an item from this menu, the system selects or deselects the corresponding track in the Timeline.</td>
</tr>
</tbody>
</table>
Resizing the Audio Mixer Tool

You can change the number of mix panes that display in the Audio Mixer tool, or hide the volume level sliders altogether. Both of these customizations can reduce the amount of space that the Audio Mixer tool occupies. You can continue to adjust levels by typing values when the sliders are hidden.

To add or remove items such as faders, legends, effect buttons, and the solo and mute buttons:

1. Right-click in the Audio Mixer tool and select Set Display Options.
2. The Mix Tool Display Options dialog opens
3. Select the items you want to appear in the Audio Mixer Tool.
4. Click OK.

To switch between displaying four tracks and eight tracks:

- Click the Number of Mix Panes button.

To show or hide the Volume Level sliders:

- Click the Display/Hide Sliders button.

To adjust levels when the sliders are hidden, do one of the following:

- Select a track, and type level values by using the numeric keypad on the keyboard.
- Type values into the Volume Level display.
Track Selection in the Audio Mixer Tool and in the Timeline

When you select a track in the Audio Mixer tool, your Avid editing application selects the corresponding track in the Timeline. Similarly, when you select an audio track in the Timeline, your Avid editing application selects the corresponding track in the Audio Mixer tool.

You can use the audio track buttons in the Tracks tab of the Command Palette to select tracks in the Audio Mixer tool. You can map these buttons to any mappable button location or to the keyboard. For more information, see “Mapping User-Selectable Buttons” on page 131.

A track needs to be monitored in the Timeline before you can work with it in the Audio Mixer tool.

Using the Track Solo and Track Mute Buttons

The Track Solo and Track Mute buttons let you mute and solo individual audio tracks in all three modes. The settings persist between modes and stay in effect when you close the Audio Mixer dialog box. When you solo or mute tracks in the Audio Mixer tool, the system solos or mutes the corresponding tracks in the Timeline.

You can also use the buttons above each fader on the external fader controller or mixer to solo or mute an individual audio track as follows:

- Some EUCON devices have solo and mute buttons above the fader. Additionally, some devices include an On key, which indicates that a specified track is unmuted.
- 002, Command|8® and MCS-3000X have separate buttons for solo and mute. On Symphony Option systems, Command|8® and MCS-3000X have separate buttons for solo and mute.

Interpreting Position Indicator Lights

The position indicator lights indicate whether the external fader controller or mixer is connected and configured correctly. They also provide information about the current location of the volume faders on the external fader controller or mixer.

Position indicator lights in the Audio Mixer tool

The following table describes how to interpret the position indicator lights.
The position indicator lights are not used for pan recording. However the blue lights do indicate that the device is connected and configured correctly.

The position indicator lights are especially useful for the FaderMaster Pro because you must position the faders close to the track volume before you start recording. Otherwise, you might create an unwanted jump in the volume when you move the faders during a recording.

Your Avid editing application does not record values from a fader on the FaderMaster Pro until you move the fader. Then it reads the current position of the fader and adjusts the volume accordingly. In many cases, it is not possible to exactly match the Timeline value.

You do not have to reposition the faders on the 002, MCS 3000X, Command|8, Yamaha 01V, and Yamaha 01V/96 because the units automatically reset the faders to match the volume data in the Timeline.

(Symphony Option) You do not have to reposition the faders on the MCS 3000X, Command|8, Yamaha 01V, and Yamaha 01V/96 because the units automatically reset the faders to match the volume data in the Timeline.

For more information on fader controllers or mixers, see “Using External Audio Devices” on page 865.

## Rendering and Unrendering Order for Audio Effects

Your Avid editing application processes audio effects in the following order (you can also think of this as the audio volume staging):

3. EQ (Audio EQ tool — real-time, can be rendered).
4. Audio Fade or Dissolve (Quick Dissolve button — real-time, can be rendered).

Changing an audio effect unrenders any audio effect that follows it in the render order but does not affect audio effects that precede it in the render order. For example, if you have a clip that contains clip volume, an AudioSuite plug-in effect, and volume automation, and you change the volume automation, the system does not unrender the AudioSuite plug-in effect. This preserves the workflow because you use volume automation for finishing the audio levels. You need to hear how changes in the volume automation affect the rendered effects. You could add, render, and modify EQ and audio dissolves on the same clip and you still would not unrender the AudioSuite plug-in effect.

However, if you change the clip volume on the same clip, the system unrenders the AudioSuite plug-in. This preserves the workflow because when you reset the level of the clip, you need to reprocess any effects applied to the clip.

If you have an AudioSuite plug-in and an Audio EQ effect applied to the same effect, only the Audio EQ effect icon displays. The AudioSuite plug-in still applies even though the icon is not visible.

Audio Volume Staging and an Audio Editing Workflow

You can adjust the volume of an audio clip at several points during an editing session. For example, you can adjust volume using the Audio Mixer tool in Clip Volume mode and Volume and Pan Automation mode. Also, the EQ tool and many of the AudioSuite and RTAS plug-in effects let you modify the volume of the clip. When you can adjust the volume in a signal chain at several points, the process is referred to as audio volume staging. This section describes the audio volume staging model used by Avid editing applications. It also describes a basic workflow for taking advantage of the volume staging.

You can set audio volume levels with the Audio Mixer tool. When you use the Audio Mixer tool in Clip Volume mode, values set by the volume level sliders are referred to as system clip volume values. When you use the Audio Mixer tool in Volume and Pan Automation mode, values set by the Audio Mixer tool are additive to the system clip volume values. This lets you adjust the values separately. You typically adjust clip volume values first, as in the following workflow:

1. Adjust overall volume (Clip Volume).
2. Apply effects (Audio Effect Processing).
This workflow lets you apply effects to an audio clip in a way similar to the signal flow in a mixing console.

In this workflow, clip volume is like a trim level, where you can lower (attenuate) or increase (amplify) the levels of a clip before applying any other effects. For example, when importing a sound file from an audio CD, you notice when the level of the clip is very high and close to clipping (distortion). If you add an EQ effect to raise the level of the bass, the audio starts to distort. To solve this problem, you can use clip volume to lower the signal level. Then you can adjust the bass in the EQ tool without distorting the audio.

The following workflow illustrates this procedure:

1. Use the Audio Mixer tool in Clip Volume mode to lower the overall volume.
2. Apply an EQ effect and any other audio effects.
3. Use the Audio Mixer tool in Volume and Pan Automation mode to fine-tune the volume of different sections of the audio in the sequence.

This workflow also applies to using AudioSuite and RTAS plug-ins because some plug-ins affect the level of the audio. Often, if you use clip volume to raise or lower the level before you apply an audio effect, you can achieve higher quality results.

In this workflow, the Audio Mixer tool in Volume and Pan Automation mode acts like the level faders on a console for final mixing of the audio material.

For more information, see “Using the Audio Mixer Tool” on page 788.

Using Clip Volume and Pan Mode

The Audio Mixer tool in Clip Volume and Pan mode lets you do the following:

- Adjust volume and pan for an individual clip, a whole track, several tracks at once, or a whole sequence.
- Adjust the volume, pan, or both for one track at a time.
- Adjust the volume, pan, or both for multiple tracks simultaneously by grouping them together.

The system uses these adjustments for all playback, including output to a digital cut.

For additional information on audio levels for digital cut output, see “Preparing for Audio Output” on page 1069.
When the Audio Mixer tool is in Clip Volume and Pan mode, you can adjust the volume and pan values for entire clips only. You can use Volume and Pan Automation mode and Live Mix mode to adjust volume and pan levels within a clip in the Timeline. For more information, see “Using Volume and Pan Automation” on page 813 and “Using Live Mix Mode” on page 826.

The default volume for master clips is set to zero (that is, with no attenuation) when you first capture the media. For a description of how to integrate clip volume into your workflow, see “Audio Volume Staging and an Audio Editing Workflow” on page 796.

There are two basic ways to work with pan values:

• Create or modify an audio pan effect. This method creates an effect that is stored with the sequence, as described in “Adjusting Clip Volume and Pan for Audio Tracks” on page 798 and “Using the Center Pan Command” on page 812.

• Modify the way that your Avid editing application interprets pan values during playback, as described in “Modifying How Your Avid Editing Application Interprets Pan” on page 812.

You can create pan effects only when you select stereo or surround sound output (in the Output tab of the Audio Project Settings window).

**Adjusting Clip Volume and Pan for Audio Tracks**

**To adjust clip volume and pan for audio tracks:**

1. Load a clip or sequence, and activate the appropriate monitor:
   - To adjust a track in a source clip, click the Source monitor to make it active.
   - To view a source clip’s tracks in the Timeline, click the Toggle Source/Record in Timeline button.
   - To adjust a track in a sequence, click the Record monitor to make it active.

2. Select the track or portion of a track you want to adjust:
   - To adjust the track in a single edited clip in a sequence, place the position indicator in the clip.
   - To adjust an isolated section of audio on a track, mark In and Out points.
   - To adjust levels from an In point through the end of the track, mark an In point only. One mark also adjusts the entire track from the beginning of the clip that includes the mark.
   - To adjust levels globally throughout the track, make no marks.

   The Audio Mixer tool opens.

4. Select Clip Volume and Pan mode by doing one of the following:
   - Click and hold the Audio Mixer mode button, and select Clip Mode from the menu.
Click the Audio Mixer mode button and cycle through the Audio Mixer mode settings to Clip.

5. In the Audio Mixer tool, select the audio track to be adjusted by doing one of the following:
   - Click the Track Selection Menu button for the appropriate audio track.
   - Alt+click (Windows) or Option+click (Macintosh) the Track Selection Menu button, and then select a track.

   To select more than one track, click the Group button for each track you want to group.

   The Track Selection buttons in the Audio Mixer tool match the track selection buttons in the sequence or source clip. When you select a track in the Audio Mixer tool, the system selects the corresponding track in the Timeline or source clip. Selecting a track in the Timeline selects the corresponding track in the Audio Mixer tool.

   To verify or change the output channels, use the Audio tool (select Tools > Audio Tool).

6. With the Audio Mixer tool active, use any playback method (such as the J-K-L keys on the keyboard) to play, shuttle, or step through the audio to check for necessary volume or pan adjustments.

   The keyboard can control either the Source or Record monitor, depending on which monitor was active when you opened the Audio Mixer tool. Switch your selection by clicking the appropriate monitor.

7. Decide whether to raise or lower the volume. To change an audio level value in a mix pane, do one of the following:
   - Click a number along the vertical edge of the Level slider.
   - Click the Level slider, type a value, and press Enter (Windows) or Return (Macintosh).

   Values are cumulative until you press Enter (Windows) or Return (Macintosh). For example, if you want to enter the value 12, type it. However, if you enter 1 and then want to change the value to 2, press Enter (Windows) or Return (Macintosh) before typing the 2.

   - Click the Volume Level display, type a value, and press Enter (Windows) or Return (Macintosh).
   - Click the Level slider, and then drag the slider to a new position.
   - Alt+click (Windows) or Option+click (Macintosh) the Level slider to reset the value to 0 dB.
8. Decide if you want to adjust pan values. To adjust the pan values in a mix pane, do one of the following:

- Click the Pan control, and then drag the control to a new position. Drag left or up to pan to the left, or drag right or down to pan to the right.

- Alt+click (Windows) or Option+click (Macintosh) the Pan Value display for MID.

- If you are working with a stereo sequence, two Pan controls appear in the Audio Mix tool for each track. Click the Pan control, and then drag the control to a new position. Drag left or up to pan to the left, or drag right or down to pan to the right.

- (Option) If you are working with a stereo sequence, click the Stereo Link button if you want to link the two Pan controls so that when you move one control the other moves correspondingly. You can also click the Stereo Mirror button so that the two Pan controls mirror each other as you adjust them.

- If you mix for a surround sound format, a multichannel Pan grid appears for each track. Click the panner icon and drag it to the desired pan position. For more information about surround panning, see “Using the Pan Grid for Surround Panning” on page 803.

If the sequence is playing, play stops when you make an adjustment.
You can adjust volume while playing the clip. For more information, see “Adjusting Volume While Playing a Clip Volume Effect” on page 810.

9. Apply the adjustments to a chosen region of the track by using the Fast Menu button located in the top bar of the tool. See “Audio Mixer Fast Menu: Clip Volume and Pan Mode” on page 808.


11. Repeat steps 7 through 10 until you are satisfied with the pan and volume levels.

Your Avid editing application stores the new settings and uses them whenever you play back or capture the sequence.

**Surround Sound Pan Controls**

When you work with surround sound sequences, you might need to pan tracks to the appropriate speakers. For example, if your surround sound sequence includes mono or stereo tracks, you might need to pan them to the left rear or right rear speaker positions. Your Avid editing application provides a multichannel Pan grid and an Advanced Panner which allow you to control audio panning.

- The Pan grid provides a simple control to pan your audio to any speaker position.
- The Advanced Panner provides a larger panning display and more controls to adjust the pan values for your sequence, including an X/Y grid, Position controls, and an LFE slider.

The following illustration shows the Pan grid and the Advanced Panner for mono tracks. Stereo tracks include a second Pan grid and Advanced Panner.
Using Clip Volume and Pan Mode

The following table describes the Pan grid and Advanced Panner controls:

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Pan Grid</td>
<td>Allows you to input pan information by dragging the Pan Location cursor anywhere within the grid.</td>
</tr>
<tr>
<td>2 Advanced Panner button</td>
<td>Opens the Advanced Panner.</td>
</tr>
<tr>
<td>3 Stereo Link button</td>
<td>For stereo sequences, links the two pan controls so that when you move one Pan Location cursor, the other moves in a parallel direction.</td>
</tr>
<tr>
<td>4 Stereo Mirror button</td>
<td>For stereo sequences, links the two pan controls so that when you move one Pan Location cursor, the other moves in a mirrored direction — for example, if you drag the Pan Location cursor to the left, the corresponding cursor in the second X/Y grid moves to the right.</td>
</tr>
<tr>
<td>5 LFE slider</td>
<td>Indicates the amount of the audio signal routed to the LFE channel. Scale is 0 - 100.</td>
</tr>
<tr>
<td>6 Speaker icon</td>
<td>Allows you to snap the Pan Location cursor to the selected speaker. This pans the audio fully to that speaker position.</td>
</tr>
</tbody>
</table>
Using Clip Volume and Pan Mode

The Pan grid displays for all mono and stereo tracks in a 5.1 or 7.1 multichannel sequence. The grid allows you to quickly adjust the pan for these tracks. For greater control over pan values, you can use the Advanced Panner (see “Using the Advanced Panner for Surround Sound Panning” on page 804).

**Using the Pan Grid for Surround Panning**

The Pan grid displays for all mono and stereo tracks in a 5.1 or 7.1 multichannel sequence. The grid allows you to quickly adjust the pan for these tracks. For greater control over pan values, you can use the Advanced Panner (see “Using the Advanced Panner for Surround Sound Panning” on page 804).

**To pan using the Pan grid:**

   
The Audio Mixer tool opens.

2. Select Clip Volume and Pan mode by doing one of the following:
   
   ▶ Click and hold the Audio Mixer mode button, and select Auto Mode from the menu.
   
   ▶ Click the Audio Mixer mode button and cycle through the Audio Mixer mode settings to Auto.

3. In the Audio Mixer tool, select the audio track to be adjusted by doing one of the following:
   
   ▶ Click the Track Selection button for the appropriate audio track.
   
   ▶ Alt+click (Windows) or Option+click (Macintosh) the Track Selection button, and then select a track.

**Element Description**

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>7 Volume Level sliders</td>
<td>Lets you adjust the volume level of the clip.</td>
</tr>
<tr>
<td>8 Audio meter</td>
<td>Displays the volume level for each channel in a track.</td>
</tr>
<tr>
<td>9 X/Y Grid</td>
<td>Allows you to input pan information by dragging the Pan Location cursor anywhere within the grid, by using 3-Knob mode, or by entering numeric values in the Position data fields.</td>
</tr>
<tr>
<td>10 Front Position control</td>
<td>Displays and controls the current front X-axis (left/right) position of the panner.</td>
</tr>
<tr>
<td>11 Rear Position control</td>
<td>Displays and controls the current rear X-axis (left/right) position of the panner.</td>
</tr>
<tr>
<td>12 F/R (Front/Rear) Position control</td>
<td>Displays and controls the current Y-axis position of the panner.</td>
</tr>
<tr>
<td>13 Center percentage</td>
<td>Indicates the amount of the audio signal routed to the center channel. Scale is 0 - 100, with 100 sending the full signal to the center channel.</td>
</tr>
<tr>
<td>14 Side/Center percentage</td>
<td>For 7.1 surround sound sequences, indicates the amount of the audio signal routed to the right surround and the left surround speaker positions. Scale is 0 - 100.</td>
</tr>
</tbody>
</table>
4. With the Audio Mixer tool active, use any playback method (such as the J-K-L keys on the keyboard) to play, shuttle, or step through the audio to check for necessary pan adjustments.

5. (Option) If you are working with a stereo track, click the Stereo Link button if you want to link the two Pan controls so that when you move one control the other moves correspondingly. You can also click the Stereo Mirror button so that the two Pan controls mirror each other as you adjust them.

6. Click the Pan Location cursor and drag it to adjust pan.

**Using the Advanced Panner for Surround Sound Panning**

The controls in the Advanced Panner provide different ways to pan mono and stereo tracks in your surround sound sequence:

- You can use the Pan Location cursor in the X/Y Grid to pan audio to any position in the surround sound mix.
- You can use the Position controls to pan in straight lines — moving the Pan Location cursor to the front, rear, and front-rear position — and to pan discretely between pairs of speakers.

For example, when panning left front to right rear with the Position controls, you hear audio from just those two speakers. By comparison, when panning in the X/Y Grid, a diagonal pan might result in audio being heard in some or all channels. The difference is that the Position controls pan discretely between the front and rear positions of the panning trajectory, while the X/Y Grid panning takes place in the full surround sound panning grid.

**To pan using the X/Y Grid:**


   The Audio Mixer tool opens.

2. Select Clip Volume and Pan mode by doing one of the following:
   - Click and hold the Audio Mixer mode button, and select Auto Mode from the menu.
   - Click the Audio Mixer mode button and cycle through the Audio Mixer mode settings to Auto.

3. In the Audio Mixer tool, select the audio track to be adjusted by doing one of the following:
   - Click the Track Selection button for the appropriate audio track.
   - Alt+click (Windows) or Option+click (Macintosh) the Track Selection button, and then select a track.

4. With the Audio Mixer tool active, use any playback method (such as the J-K-L keys on the keyboard) to play, shuttle, or step through the audio to check for necessary pan adjustments.

5. Click the Advanced Panner button.

   The Advanced Panner opens.
6. (Option) If you are working with a stereo track, click the Stereo Link button if you want to link the two Pan controls so that when you move one control the other moves correspondingly. You can also click the Stereo Mirror button so that the two Pan controls mirror each other as you adjust them.

7. Drag the Pan Location cursor to pan the track. The location of the Pan Location cursor determines the pan position of the signal. For example, to pan something to the left rear speaker, move the Pan Location cursor to the lower-left corner of the grid.

   You can snap the Pan Location cursor to one speaker position by double-clicking a speaker icon. This pans the audio fully to that speaker position. For example, if you click the upper left speaker icon, the Pan Location cursor moves to the upper left corner of the grid and pans the audio fully to the left speaker position.

8. When you finish adjusting pan with the Advanced Panner, click the Close button to return to the Audio Mixer tool.
To pan using the Position controls:

1. Adjust the Front and Rear Position controls to set the trajectory line.
2. Rotate the Front/Rear Position control to pan along the trajectory. The Pan Location cursor is constrained to the trajectory line.
3. If you want to change the trajectory angles, do one of the following:
   - Drag either end point (Front or Rear) of the trajectory line.
   - Adjust the Front or Rear Position controls.
4. If you want to change the current trajectory position (left-to-right) and retain its current angles, drag the trajectory line (not its end points) to a new position.

Using the Center Percentage and LFE Controls

The Advanced Panner provides you with additional controls:

- Center Percentage controls whether there is a discrete center channel for the track or a phantom center channel. For example, in film and video production, the center channel often contains dialog. To enhance the clarity of dialog, you might need to reduce the Center Percentage on music tracks, which forces music panned only to the left and right speakers and leaves a variable phantom center image.

- The LFE slider controls how much of the track is sent to LFE.

To adjust the Center Percentage:

   The Audio Mixer tool opens.
2. Select Clip Volume and Pan mode by doing one of the following:
   - Click and hold the Audio Mixer mode button, and select Auto Mode from the menu.
   - Click the Audio Mixer mode button and cycle through the Audio Mixer mode settings to Auto.
3. In the Audio Mixer tool, select the audio track to be adjusted by doing one of the following:
   - Click the Track Selection button for the appropriate audio track.
   - Alt+click (Windows) or Option+click (Macintosh) the Track Selection button, and then select a track.
4. With the Audio Mixer tool active, use any playback method (such as the J-K-L keys on the keyboard) to play, shuttle, or step through the audio to check for necessary pan adjustments.
5. Click the Advanced Panner button.
   The Advanced Panner opens.
6. Turn the Center Percentage control as needed.

7. When you finish adjusting the Center Percentage with the Advanced Panner, click the Close button to return to the Audio Mixer tool.

**To adjust the LFE control:**


   The Audio Mixer tool opens.

2. Select Clip Volume and Pan mode by doing one of the following:
   - Click and hold the Audio Mixer mode button, and select Auto Mode from the menu.
   - Click the Audio Mixer mode button and cycle through the Audio Mixer mode settings to Auto.

3. In the Audio Mixer tool, select the audio track to be adjusted by doing one of the following:
   - Click the Track Selection button for the appropriate audio track.
Alt+click (Windows) or Option+click (Macintosh) the Track Selection button, and then select a track.

4. With the Audio Mixer tool active, use any playback method (such as the J-K-L keys on the keyboard) to play, shuttle, or step through the audio to check for necessary pan adjustments.

5. Click the Advanced Panner button.

The Advanced Panner opens.

6. Adjust the LFE slider as needed.

7. When you finish adjusting the LFE with the Advanced Panner, click the Close button to return to the Audio Mixer tool.

**Audio Mixer Fast Menu: Clip Volume and Pan Mode**

The commands in the Audio Mixer tool Fast menu operate differently, depending on the types of points you set within the clip or sequence, as described in the following table:
The following table describes the Audio Mixer tool Fast menu commands for Clip Volume and Pan mode:

<table>
<thead>
<tr>
<th>Points Set</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Both In and Out points</td>
<td>Commands apply adjustments to selected tracks between the points.</td>
</tr>
<tr>
<td>In point only</td>
<td>Commands apply adjustments to full clips from the In point to the end of selected tracks.</td>
</tr>
<tr>
<td>Out point only</td>
<td>Commands apply adjustments to full clips from the beginning of selected tracks to the Out point.</td>
</tr>
<tr>
<td>None</td>
<td>Commands apply globally (across entire tracks).</td>
</tr>
</tbody>
</table>

The following table describes the Audio Mixer tool Fast menu commands for Clip Volume and Pan mode:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set Level on Track, Set Pan on Track</td>
<td>Applies the same pan or volume levels currently set in the Audio Mixer tool to all segments in the marked regions of the tracks.</td>
</tr>
<tr>
<td>Adjust Pan/Vols on Track</td>
<td>Opens a dialog box for making incremental adjustments to all current settings across segments in the marked regions of selected tracks.</td>
</tr>
<tr>
<td></td>
<td>For example, when you type –1 in the Volume Adjustment text box, the various audio level settings across all segments of the marked region of selected tracks are lowered by exactly 1 dB when you click OK.</td>
</tr>
<tr>
<td>Remove Clip Volume on Track, Remove Pan on Track</td>
<td>Removes clip volume or pan values from the marked regions of selected tracks.</td>
</tr>
<tr>
<td>Remove Pan/Vols on Track</td>
<td>Deletes all audio mix adjustments that have been applied to segments in the marked regions of selected tracks. Each audio clip is restored to its default pan and volume settings.</td>
</tr>
<tr>
<td>Disable Track Monitoring</td>
<td>Makes an audio track inactive so that it does not process any audio information.</td>
</tr>
<tr>
<td>Set Display Options</td>
<td>Opens a dialog that allows you to add or remove items such as the faders, legends, effect buttons, and the solo and mute buttons in order to save space in the Audio Mixer Tool.</td>
</tr>
</tbody>
</table>
Using Clip Volume and Pan Mode

Note the following:

- The commands in the Fast menu appear dimmed until you select a track.
- Levels set in master clips carry across to the sequence after you edit the clips.
- Clip volume values are the values for the entire segment; for example, you cannot set volume for a portion of a segment without affecting the entire segment. To set volume for a portion of a segment, use Volume and Pan Automation mode. For more information, see “Using Volume and Pan Automation” on page 813.

Bypassing Existing Volume Settings

You can instruct your Avid editing application to ignore the volume settings established with the Audio Mixer tool when playing back or recording a sequence.

To turn off current volume adjustments, do one of the following:

- Click the Bypass button in the Audio Mixer tool.
- Click the Clip Volume/Pan button in the Effects Bypass panel in the Effects tab of the Audio Project Settings window. See “Audio Project Settings: Effects Tab” on page 1443.

The volume controls disappear.

To restore the previous settings:

- Click the Bypass button or the Clip Volume/Pan button again.

Adjusting Volume While Playing a Clip Volume Effect

You can use the Audio Loop Play button to change the volume on an existing Clip Volume effect while you play the clip. The Audio Loop Play button appears in several of the audio effect tools and is also a mappable button in the Play tab of the Command palette. For more information on mapping buttons, see “Mapping User-Selectable Buttons” on page 131.

While your Avid editing application plays the loop, you can do the following:

- Adjust audio effects.
- Use the Peak Hold menu in the Audio tool to change between Peak Hold and Infinite Hold.
- Use the Reset Peak button in the Audio tool.

For more information on the Audio tool, see “Understanding the Audio Tool” on page 212. For information on improving response time, see “Improving Response Time When Adjusting Volume” on page 811.

For additional ways to change the volume while playing audio, see “Understanding Volume or Pan Automation Recording” on page 818.
To adjust volume while playing a Clip Volume effect:

1. Do one of the following:
   - Select an existing Clip Volume effect.
   - Identify an area of the clip with In and Out points.
   - Place the position indicator over an audio clip.

2. Click the Audio Loop Play button in the Audio Mixer tool.
   Your Avid editing application repeatedly loops through the selected area as follows:
   - If you have In and Out points on your sequence, the command loops over the selected area.
   - If there are no In or Out points, the command loops over the shortest segment on the selected audio track at the position indicator.
   - If you have only an In point or only an Out point, the system uses the location of the position indicator as the second point. For example, if there is an In point and no Out point, the system loops from the In point to the end of the (smallest selected) audio segment under the position indicator.

3. Adjust the volume as necessary.

4. Click the Audio Loop Play button to stop.
   Your Avid editing application automatically saves your changes as part of a Clip Volume effect.

Improving Response Time When Adjusting Volume

If there is no Clip Volume effect on the clip before you start, you do not hear any changes until you click the Audio Loop Play button to stop and replay the effect.

As you adjust the volume values on an existing Clip Volume effect, you might not hear the results immediately. It takes a few seconds for your Avid editing application to apply the changes to the clip. The response time for this feature is considerably longer than it is when changing EQ parameters while using Audio Loop Play. You might need to click the Audio Loop Play button to complete the edit and then play the effect to hear the result.

You can also do any of the following:
- Monitor as few audio tracks as possible.
- Deselect the video track, if practical.
- Use In and Out points to select a narrow interval to adjust.
Modifying How Your Avid Editing Application Interprets Pan

The way you record footage in the field and capture it with your Avid editing application affects the way sound pans between the speakers. By default, the system pans mono audio tracks 1 and 3 to the left speaker output and pans mono tracks 2 and 4 to the right speaker output.

When you adjust pan values on multichannel stereo tracks, you pan the stereo mix of the left/right audio pair for the clip. For example, when you pan to the right output channel, you move the full stereo mix further to the right channel.

You can set global pan settings before or during editing by using the Audio Settings dialog box or the Audio Project Settings dialog box. You can also set pan for individual mono clips by using the Center Pan command.

To modify the way the system interprets pan during playback:

- Set the default pan values in the Audio Settings dialog box, which you access from the Settings list in the Project window.

  By default, the mono audio tracks for clips alternate with track 1 on the left speaker and track 2 on the right speaker for monitoring and output. The All Tracks Centered option instructs the system to center the pan of all tracks between the two speakers for monitoring and output. The system pans stereo tracks to the center by default, with the left speaker panned full left and the right speaker panned full right.

- Click the Mix Mode Selection Menu button in the Output tab in the Audio Project Settings window, and select one of the following modes (the options in the Mix Mode Selection menu depend on your audio hardware):

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stereo</td>
<td>Uses the default pan settings and lets you create pan effects.</td>
</tr>
<tr>
<td>Mono</td>
<td>Pans all mono tracks to center during output. This mode ignores pan effects.</td>
</tr>
<tr>
<td>Direct</td>
<td>This mode uses the default pan settings and ignores pan/vol effects.</td>
</tr>
</tbody>
</table>

Using the Center Pan Command

You can use the Center Pan command on source material in bins. Use it prior to editing or at any time during the editing process.

Instead of adjusting pan on individual clips by using the Audio Mixer tool, Center Pan lets you create a standard distribution of audio between left and right speakers. You can adjust the pan on selected clips or all clips with a single command. This is especially useful when you have clips...
Using Volume and Pan Automation

with field audio recorded (and subsequently captured) variably between A1 and A2. Panning all
the audio to center eliminates the distraction of having to listen to left and right speakers, in turn.
It also smooths the playback of the edited sequence because all shots are panned to center.

To adjust the pan on clips:

1. In a bin, select the clips you want to pan to the center.
2. Select Clip > Center Pan.
   A dialog box opens and asks you to confirm the pan.
3. Click OK.
   The system pans all the selected clips to the center.

Isolating Clip Portions for Audio Adjustment

When making audio level and pan adjustments, your Avid editing application looks at either an
individual clip in the Source monitor, a segment in the sequence, or entire tracks. To change level
or pan settings in an area not defined by a discrete clip or group of clips, use the Add Edit
function to define your own custom area.

To isolate clip portions for adjustment:

1. Find the start of the area where you want to change the pan or level, leaving your position
   indicator on that frame as a marker.
2. Select the appropriate track in the Track Selector panel.
3. Click the Add Edit button.
   This places an edit where the position indicator is parked.
4. Find the end of the area where you want to change the pan or level, leaving your position
   indicator on that frame as a marker.
5. Select the appropriate track.
6. Click the Add Edit button.
7. Use the process described in “Using the Audio Mixer Tool” on page 788 to change the level
   or pan within this new segment.

Using Volume and Pan Automation

Volume and pan automation lets you change the volume or pan values of a segment by adding
and manipulating volume or pan automation keyframes in the Timeline. The following
illustration shows an expanded audio track containing volume keyframe information.
Using Volume and Pan Automation

Example of the graphic representation of keyframes and volume ramps in the Timeline. Volume values in decibels are highlighted on the left.

Your Avid editing application uses a linear ramp to change the volume or pan from one keyframe to the next.

When you adjust pan parameters, you can select which parameter displays in the Timeline. The pan parameters available depend on your sequence format and the audio track format. The following table lists the volume and pan displays available in the Timeline:

<table>
<thead>
<tr>
<th>Sequence Format</th>
<th>Audio Track Format</th>
<th>Volume and Pan Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stereo</td>
<td>Mono</td>
<td>None, Clip Volume, Volume, Pan</td>
</tr>
<tr>
<td>Stereo</td>
<td>None, Clip Volume, Volume, Pan l, Pan R</td>
<td></td>
</tr>
<tr>
<td>5.1</td>
<td>None, Clip Volume, Volume</td>
<td></td>
</tr>
<tr>
<td>7.1</td>
<td>None, Clip Volume, Volume</td>
<td></td>
</tr>
<tr>
<td>Surround Sound 5.1</td>
<td>Mono</td>
<td>None, Clip Volume, Volume, Pan (Front, Rear, FrontRear, Center %), LFE Volume</td>
</tr>
<tr>
<td>Stereo</td>
<td>None, Clip Volume, Volume, Pan L (Front, Rear, FrontRear, Center %), Pan R (Front, Rear, FrontRear, Center %), LFE Volume</td>
<td></td>
</tr>
<tr>
<td>5.1</td>
<td>None, Clip Volume, Volume</td>
<td></td>
</tr>
<tr>
<td>7.1</td>
<td>None, Clip Volume, Volume</td>
<td></td>
</tr>
</tbody>
</table>
Using Volume and Pan Automation

Using Volume and Pan Automation in the Timeline

To use volume and pan automation to adjust volume or pan in the Timeline:

1. Select an audio track for adjusting volume or pan.

2. Click the Clip Volume/Pan button in the Track Control panel, and select the Volume or Pan option you want to adjust. Alt+Click the Clip Volume/Pan button to select all tracks. For more information on volume and pan options, see “Using Volume and Pan Automation” on page 813.

3. (Option) Expand the audio track by doing one of the following:
   - Press and hold Ctrl+L (Windows) or Command+L (Macintosh).
   - Press and hold the Ctrl key (Windows) or the Option key (Macintosh) while dragging in the Track Selector panel. When the pointer changes to a cross, drag the cross to expand or shrink the track.

   If you expand the audio tracks enough, you can display volume data. The following illustration shows the expanded audio track with volume data.

    | Sequence Format | Audio Track Format | Volume and Pan Parameters |
    |-----------------|--------------------|--------------------------|
    | Surround Sound 7.1 | Mono | None, Clip Volume, Volume, Pan (Front, Rear, FrontRear, Center %, Side Center %), LFE Volume |
    | Stereo | None, Clip Volume, Volume, Pan L (Front, Rear, FrontRear, Center %, Side Center %), Pan R (Front, Rear, FrontRear, Center %, Side Center %), LFE Volume |
    | 5.1 | None, Clip Volume, Volume |
    | 7.1 | None, Clip Volume, Volume |

You adjust volume and pan automation directly in the Timeline or by using the Audio Mixer tool.
4. Click the Add Keyframe key on the keyboard (“”) or the Add Keyframe button on the Tool palette to add keyframes along the Timeline.

Your Avid editing application adds a keyframe to each enabled track. If you add a keyframe for pan, the keyframe applies only to the automation value displayed in the Timeline. For example, if you are working with pan left automation, the keyframe is added to the pan left automation values.

A straight line appears in the selected audio track. The line shows the current volume level for that track in the Audio Mixer tool.

After you add the first keyframe to a segment, you can adjust the volume for the entire clip. After you add a second keyframe, you can adjust the volume between keyframes.

5. Adjust the volume automation or pan keyframes by doing one of the following:
   - Click a keyframe and drag it up or down to increase or decrease the volume or pan at that point. If there is a point at the same position on another enabled track, it moves also. When you move the keyframe up or down, the corresponding Volume Level slider or Pan Value slider in the Audio Mixer tool also moves.
   - Click a keyframe and use the sliders, Pan controls, Position controls, or other controls in the Audio Mixer tool to adjust the volume or pan.
   - To snap to the decibel lines, press and hold the Ctrl key (Windows) or the Command key (Macintosh) while you drag the point.
   - Move a keyframe horizontally to move the start or end of a ramp. Place the pointer over a keyframe. When the pointer changes to the hand pointer, press and hold the Alt key (Windows) or the Option key (Macintosh), click the keyframe, and drag it.
Move several keyframes vertically on a track at the same time by placing In and Out points to select the area you want. When you move one keyframe up or down within the marked area, all keyframes within the marked area move in relation to each other. This works for all enabled audio tracks.

This procedure is similar to grouping sliders on an audio mixing board or in the Audio Mixer tool.

To delete a single volume automation or pan keyframe:

1. Move the pointer over the keyframe.
2. When the pointer changes to the hand pointer, press the Delete key.

Don’t press the mouse button. If you press the mouse button, you might change the volume.

If there are identical keyframes in other active tracks, your Avid editing application deletes them also.

To delete groups of volume automation or pan keyframes:

1. Mark an In point and an Out point or mark the entire segment.
2. Delete any keyframes in the marked area.

Volume and Pan Automation Mode

This topic describes controls in the Audio Mixer tool that are active only in Volume and Pan Automation mode.

In Volume and Pan Automation mode, record controls are available, as shown in the following illustration and described in the table. These controls are similar to those in the Audio Punch-In tool:

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record button</td>
<td>Starts and stops the recording.</td>
</tr>
<tr>
<td>Cancel button</td>
<td>Stops a recording without saving the recorded data.</td>
</tr>
<tr>
<td>Preroll text box</td>
<td>Lets you provide a visual cue before the recording begins. Your Avid editing application backs up the blue position indicator for the prescribed number of seconds.</td>
</tr>
</tbody>
</table>
Using Volume and Pan Automation

The volume slider areas appear blue in Volume and Pan Automation mode.

For descriptions of other controls in the Audio Mixer tool, see “Audio Mixer Tool Controls” on page 789.

Understanding Volume or Pan Automation Recording

You can instruct your Avid editing application to record your actions while playing the clip as you move sliders to adjust volume or turn pan knobs to adjust pan values. Your Avid editing application creates the corresponding keyframes and saves them as part of a pan/volume audio effect. After you finish the recording, you can move, add, and delete keyframes to achieve the results you want.

You can do the following:

- Use sliders in the Audio Mixer tool to adjust volume values while you play the clip, as described in “Using the Audio Mixer Tool for Volume and Pan Automation” on page 818. For additional information, see “Audio Mixer Tool Fast Menu: Volume and Pan Automation Mode” on page 820 and “Using Keyboard Shortcuts with Audio Keyframes” on page 821.
- Use the stereo pan controls or surround sound controls to adjust pan values as you play the clip. For more information on using the multichannel pan controls, see “Surround Sound Pan Controls” on page 801.
- Attach an optional fader controller or mixer to the system, and use the faders on the unit to adjust volume.
- Attach an Avid Artist Mix or Avid Artist Control to the system, and use the pan knobs to adjust pan values for the active tracks.

For information about using an Avid Artist Mix or Avid Artist Control, see “Using Avid Artist Series Controllers” on page 897.

Using the Audio Mixer Tool for Volume and Pan Automation

You can record volume automation or pan information without using an external fader controller or mixer. You can also use command in the Audio Mixer tool Fast menu in Volume and Pan Automation mode for other tasks such as removing or incrementally adjusting volume automation or pan on a marked region. For more information, see “Audio Mixer Tool Fast Menu: Volume and Pan Automation Mode” on page 820.
To record volume automation or pan information by using the Audio Mixer tool sliders:


2. Do one of the following:
   - Click and hold the Audio Mixer Mode button and select Auto Mode from the menu.
   - Click the Audio Mixer Mode button and cycle through the Audio Mix mode settings to the Auto mode setting.

3. Select an audio track for adjusting volume or pan.

4. Click the Clip Volume/Pan button in the Track Control panel and select the Volume or Pan option you want to adjust. Alt+Click the Clip Volume/Pan button to select all tracks.

   If a clip contains volume automation or pan data and you do not select Volume or Pan from the Clip Volume/Pan menu, the system displays a pink triangle on the clip to indicate that automation data is present but not displayed.

5. (Option) Expand the audio track by pressing Ctrl+L (Windows) or Command+L (Macintosh).

6. Move the blue position indicator to the section of audio that you want to adjust and mark In to Out points.

7. Click the Record button or press the B key to start recording your actions.

8. Listen to the audio and do one of the following:
   - Adjust the Audio Level sliders in the Audio Mixer tool as necessary.
   - Click the Pan Location cursor in the Pan grid in the Audio Mixer tool and adjust the position.
   - Click the Advanced Panner button in the Audio Mixer tool to open the Advanced Panner and adjust the pan controls. For more information, see “Using the Advanced Panner for Surround Sound Panning” on page 804.

9. Click the Record button again to stop recording.

   Your Avid editing application adds volume automation or pan keyframes to the audio in the Timeline. Because it records every movement of the sliders, there are usually more keyframes than you need.

10. Decrease the number of keyframes:
    a. Click the Track Selection Menu button for the track to enable the Fast menu.
    b. Click the Audio Mixer Tool Fast Menu button, and select Filter volume automation on Track or Filter Pan on Track.

11. Repeat step 10 until you have decreased the number of keyframes to an acceptable level.
You should remove as many excess keyframes as possible while still maintaining the volume changes.

You can move, add, and delete keyframes individually or as groups to further adjust the volume or pan. For details on how to adjust the keyframes, see “Using Volume and Pan Automation in the Timeline” on page 815.

Audio Mixer Tool Fast Menu: Volume and Pan Automation Mode

The commands in the Audio Mixer tool Fast menu operate differently, depending on the types of points you set within the clip or sequence, as described in the following table:

<table>
<thead>
<tr>
<th>Points Set</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Both In and Out points</td>
<td>Commands apply adjustments to selected tracks between the points.</td>
</tr>
<tr>
<td>In point only</td>
<td>Commands apply adjustments to full clips from the In point to the end of selected tracks.</td>
</tr>
<tr>
<td>Out point only</td>
<td>Commands apply adjustments to full clips from the beginning of selected tracks to the Out point.</td>
</tr>
<tr>
<td>None</td>
<td>Commands apply globally (across entire tracks).</td>
</tr>
</tbody>
</table>

The commands in the Fast menu appear inactive until you select a track.

The following table describes the Audio Mixer tool Fast menu commands for Volume and Pan Automation mode:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter volume automation on Track</td>
<td>Removes approximately 50 percent of the volume automation keyframes in the marked region. If you press and hold the Alt key (Windows) or the Option key (Macintosh) while selecting the menu item, the system removes all keyframes in the selected area, except for the minimum and maximum peaks. Your Avid editing application tries to save major gestures while removing redundant points and points on a linear ramp. This is useful for deleting extra keyframes after a recording.</td>
</tr>
<tr>
<td>Filter Pan on Track</td>
<td>Removes approximately 50 percent of the pan keyframes in the marked region.</td>
</tr>
</tbody>
</table>
Using Volume and Pan Automation

<table>
<thead>
<tr>
<th>Command</th>
<th>Description (Continued)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adjust Volume/Pan on Track</td>
<td>Opens a dialog box for making incremental adjustments to all current settings across segments in the marked regions of selected tracks. For example, if you type –1 in the Volume Adjustment text box, the various audio level settings across all segments of the marked region of selected tracks are lowered by exactly 1 dB when you click OK.</td>
</tr>
<tr>
<td>Remove volume automation on Track</td>
<td>Removes all of the volume automation keyframes within the marked region.</td>
</tr>
<tr>
<td>Remove Pan on Track</td>
<td>Removes all of the pan keyframes within the marked region.</td>
</tr>
<tr>
<td>Remove Volume/Pan on Track</td>
<td>Deletes all volume and pan automation adjustments applied to segments in the marked regions of selected tracks and restores each audio clip to its previous pan and volume settings.</td>
</tr>
<tr>
<td>Remove Hidden Volume Automation on Track - Global</td>
<td>Select this option to remove all the volume automation keyframes.</td>
</tr>
<tr>
<td>Remove Hidden Pan on Track - Global</td>
<td>Select this option to remove all the Pan keyframes.</td>
</tr>
<tr>
<td>Remove Hidden Pan/Volume on Track - Global</td>
<td>Select this option remove all the Pan and Volume keyframes.</td>
</tr>
<tr>
<td>Calibrate Hardware Sliders</td>
<td>Takes the place of the HW (hardware) button. When you enable the Calibrate Hardware Sliders option, the external faders control the sliders in the Audio Mixer tool. This is a test mode. Select the Fast menu option again to disable the test mode.</td>
</tr>
<tr>
<td>Set Display Options</td>
<td>Opens a dialog that allows you to add or remove items such as the faders, legends, effect buttons, and the solo and mute buttons in order to save space in the Audio Mixer Tool.</td>
</tr>
</tbody>
</table>

Using Keyboard Shortcuts with Audio Keyframes

You can map the Fast Forward and Rewind buttons on your keyboard to speed your editing of audio keyframes. For more information, see “Mapping User-Selectable Buttons” on page 131.

*The Audio Mixer tool must be active when you use the Fast Forward or Rewind keys.*
To use the Fast Forward and Rewind keys when editing volume automation or pan keyframes:

1. Click the Audio Mixer tool to make it active.
2. Do one of the following:
   - Click and hold the Audio Mixer Mode button and select Auto Mode from the menu.
   - Click the Audio Mixer Mode button and cycle through the Audio Mix mode settings to the Auto mode setting.
3. Select the appropriate track or tracks.
4. Press the Fast Forward key or the Rewind key.
   The position indicator moves to the next or previous audio keyframe.

Copying, Pasting and Moving Audio Keyframes

Enhancements have been made that affect how you select, cut, copy, paste and move audio keyframes. You can select audio keyframes in the Timeline and copy them to a different area of the same clip or to different clips. You can also choose to copy either just Automation Pan or Automation Gain keyframes.

Creating a New Keyframe

A new keyframe can be created with a keyboard shortcut and clicking in the Timeline.

To create a new keyframe:

1. Click the Clip Volume/Pan button in the Track Control panel, and select the Volume or Pan.
2. Enable the Keyframe Selection button.
3. Click in the Timeline in the area where you want to create a keyframe or click on an already existing keyframe curve/line in the Timeline.
4. Press Ctrl+Shift (Windows) or Command+Shift (Macintosh) and click on the track.
   A keyframe is created.

Copy and Paste Individual Keyframes

To copy and paste individual keyframes:

1. Click on the keyframe to select it.
   The keyframe highlights pink.
2. Shift+click to select multiple keyframes.
3. Press Ctrl+C (Windows) or Command+C (Macintosh) to copy the audio keyframes to the clipboard.

4. Either Mark IN or Mark OUT or move the blue bar to the area in the audio track where you want to paste the audio keyframes. You can also select another audio track where you want to paste the keyframes.

5. Press Ctrl+V (Windows) or Command+V (Macintosh) to paste the individual keyframes.

Pressing Shift+click on an already selected keyframe, deselects the keyframe. Clicking anywhere else in the Timeline deselects the keyframe(s) if the Smart Tool is enabled. Clicking the Timecode ruler in the Timeline does not affect selection unless “Clicking the TC Track or Ruler Disables Smart Tools” is checked in the Timeline Settings.

Copy and Paste by Lassoing an Area of Audio Keyframes

To copy and paste by lassoing an area of audio keyframes:

1. Lasso the area that contains the keyframes you want to copy.

If a keyframe is already selected, Shift + lasso only selects more keyframes even if a whole segment or transition is within the lasso.

Shift+lasso deselects any currently selected keyframes.

2. Press Ctrl+C (Windows) or Command+C (Macintosh) to copy the audio keyframes to the clipboard.

3. Either Mark IN or Mark OUT or move the blue bar to the area in the audio track where you want to paste the audio keyframes. You can also select another audio track where you want to paste the keyframes.

4. Press Ctrl+V (Windows) or Command+V (Macintosh) to paste the keyframes.

The keyframes are pasted in the Timeline.

Copy and Paste a Whole Region or Marked Region of Audio Keyframes

To copy and paste audio keyframes:

1. Do one of the following:
   ▶ Select an entire audio segment.
   ▶ Select the audio region with Mark IN and Mark Out

2. Press Ctrl+C (Windows) or Command+C (Macintosh) to copy the audio keyframes to the clipboard.
3. Either Mark IN or Mark OUT or move the blue bar to the area in the audio track where you want to paste the audio keyframes. You can also select another audio track where you want to paste the keyframes.

4. From the Edit Menu select Paste Audio Keyframes or use the shortcut Shift+Ctrl+V (Windows) or Shift+Command+V (Macintosh).

A dialog opens asking you to choose the type of keyframes to paste.

5. Select either Automation Gain or Automation Pan. Or choose both.

6. Click OK.

The keyframes are pasted in the Timeline.

**Moving Keyframes in the Timeline**

A number of enhancements have been made that make it easier to move audio keyframes. You can now move a range of audio keyframes up and down in volume. You can nudge individual keyframes and you can horizontally drag individual keyframes or a group of keyframes.

**To nudge individual keyframes:**

1. Select the keyframe you want to move.

2. Press Shift+Command (Macintosh) or Ctrl+Shift (Windows) + up or down arrow keys to move the keyframe in 1dB increments.

3. Press Shift+Command (Macintosh) or Ctrl+Shift (Windows) + left or right arrow keys to move the keyframe left or right in one frame increments.

**To move a range of keyframes up and down in volume:**

1. Either lasso the range of keyframes or Shift+click the range of keyframes you want to move.

2. Click on any single keyframe in the range and move up and down. The entire range moves.
To move a range of keyframes in time:

1. Lasso the range of keyframes or Shift+click the range of keyframes you want to move.
2. Press Option+drag (Macintosh) or Alt+drag (Windows) to move the entire group of keyframes horizontally in the Timeline.

Removing Hidden Keyframes

When you edit or trim an audio track that contains keyframes, there may be keyframes that are hidden to the left or right of the remaining part of the clip. You can easily remove hidden keyframes.

To remove hidden keyframes:

1. Mark the area that contains the keyframes you want to remove. (If you do not select a marked area, all hidden keyframes will be removed.)
2. Open the Audio Mixer Tool. Ensure you are in Auto Mode.
3. Select the Audio Mixer Tool Fast menu (hamburger menu).
4. Select one of the following:
   - Remove Hidden Volume Automation On Track to remove all the volume automation keyframes
   - Remove Hidden Pan On Track to remove all the Pan keyframes
   - Remove Hidden Pan/Volume on Track to remove all the Pan and Volume keyframes

You can also right+click at the transition and choose Delete Hidden Left, or Delete Hidden Right to remove the hidden keyframes to the left or the right of the transition.
Using Live Mix Mode

Live Mix mode lets you temporarily override existing volume and pan automation settings currently applied to a sequence. The most common way to use Live Mix mode is with a 002 or Command|8 attached as a control surface. When you use an external controller you can play the audio and override existing volume and pan automation settings in real time. For example, you want to loop through a portion of audio and want to lower the dialog on one track while you concentrate on the other tracks. You could mute the track that contains the dialog, but it might be more useful to simply lower the volume of the track without changing any existing volume automation or pan settings.

The volume slider areas appear red in Live Mix mode.

The following illustration shows the Audio Mixer tool in Live Mix mode.
Entering Live Mix Mode

To enter Live Mix mode:

2. Do one of the following:
   - Click and hold the Audio Mixer Mode button and select Live Mix Mode from the menu.
   - Click the Audio Mixer Mode button and cycle through the Audio Mix mode settings to the Live mode setting.

   The Audio Mixer tool changes to Live Mix mode.

Using Live Mix Mode with an External Controller

To use a control surface in Live Mix mode:

1. Connect and configure the control surface.
   For more information, see “Using the 002 and the Command|8” on page 872 or “Using Avid Artist Series Controllers” on page 897.
2. Double-click Controller Settings in the Settings list and make sure that the Controller, Port, and Gain Controller Port options identify the controller you are using.

   The following illustration shows the controller settings for an Avid Artist Series controller.

3. Press the Mix button on your controller to open and put focus on the Audio Mixer tool.
4. Enter Live Mix mode in the Audio Mixer tool (see “Entering Live Mix Mode” on page 827).
5. Play and listen to the audio.
6. While the audio plays, you can adjust the faders or turn the pan knobs on the controller.
   This temporarily adjusts the audio without changing the volume automation or pan settings.
7. (Option) Change to Volume and Pan Automation mode and play the audio.
The faders jump back to the volume automation settings and automatically move with any volume automation keyframes on the track.

8. (Option) Change back to Live Mix mode and play the audio.

The faders jump back to the settings you last used in Live Mix mode and the audio plays at the Live Mix mode setting.

You cannot save the Live Mix mode settings between editing sessions. For information on applying or overwriting the Live Mix mode settings, see “Audio Mixer Tool Fast Menu: Live Mix Mode” on page 828.

For information on using controllers in Volume and Pan Automation mode, see “Using External Audio Devices” on page 865.

Using Live Mix Mode Without an External Controller

You can use Live Mix mode without an external controller but you cannot change the volume or pan sliders in real time.

To use the controls in the Audio Mixer tool:

- Move the volume sliders or change the pan settings, and then play the audio.

  When you play the audio, the system uses your new settings without saving any volume automation information.

Switching Between Live Mix Mode and Other Audio Mixer Modes

When you switch between Live Mix mode, Clip Volume mode, and Volume and Pan Automation mode, your Avid editing application displays your previous view of the values for that mode. Your Avid editing application saves Clip Volume mode and volume and pan automation settings between editing sessions, but it does not save Live Mix mode settings between editing sessions.

The Live Mix mode settings are not tied to the sequence. If you load a different sequence into the Timeline, the Live Mix mode settings on the controller (and in the Audio Mixer tool) do not change. You can think of the Live Mix mode as an external mixer connected to the Avid editing system. Changing to another sequence has no effect on the Live Mix mode settings.

Audio Mixer Tool Fast Menu: Live Mix Mode

The commands in the Audio Mixer tool Fast menu operate differently depending on the types of points you set within the sequence, as described in the following table:

<table>
<thead>
<tr>
<th>Points Set</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Both In and Out points</td>
<td>Commands apply adjustments to selected tracks between the points.</td>
</tr>
</tbody>
</table>
Using Live Mix Mode

The following table describes the Audio Mixer tool Fast menu options in Live Mix mode:

<table>
<thead>
<tr>
<th>Points Set</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>In point only</td>
<td>Commands apply adjustments to full clips from the In point to the end of selected tracks.</td>
</tr>
<tr>
<td>Out point only</td>
<td>Commands apply adjustments to full clips from the beginning of selected tracks to the Out point.</td>
</tr>
<tr>
<td>None</td>
<td>Commands apply globally (across entire tracks).</td>
</tr>
</tbody>
</table>

The following table describes the Audio Mixer tool Fast menu options in Live Mix mode:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set Live Mix to Default</td>
<td>Sets the active tracks to 0 dB and does not modify any existing volume automation keyframes.</td>
</tr>
<tr>
<td>Set Live Mix to Automation</td>
<td>Sets the Live Mix mode settings to match the volume and pan settings where each track crosses the Position bar in the Timeline. When you use this option, the system permanently removes the existing automatic volume or pan key frames between the In and Out points.</td>
</tr>
<tr>
<td>Set Live Mix as Automation</td>
<td>Removes the existing volume automation or pan keyframes and replaces them with the current Live Mix mode settings. You usually use this option with In and Out points. The system applies the Live Mix mode levels to the portions of the selected tracks between the points.</td>
</tr>
</tbody>
</table>

**Live Mix Mode Example**

The following illustration shows the Live Mix mode settings on two tracks in the Timeline. Track A1 is at 0 dB, and the volume of track A2 is set to -45. The Live Mix mode settings are not represented in the Timeline, but you can hear the difference when you play the audio.
Using Live Mix Mode

Live Mix level settings at 0 dB and -45 dB

The following illustration shows a sequence in the Timeline with volume automation applied.

The following illustration shows the result after choosing Set Live Mix to Automation In/Out from the Audio Mixer Fast menu. The portion of the Timeline between the In and Out on Track A1 is changed to 0 dB and the same portion of Track A2 is changed by -45 dB to match the Live Mix settings. The system adds volume automation keyframes at the In and Out points and creates ramps from the In and Out points to the new value.
After changing the levels in this way, you might enter Volume and Pan Automation mode and further adjust the volume between the In and Out points.

### Fading and Dipping Audio

In traditional analog editing, you manually change volume levels to smooth audio transitions between elements in an edited sequence by doing any of the following:

- Fading audio up or down.
- Crossfading between audio elements on two separate channels.
- Dipping audio to a lower level.

In Avid editing applications, these effects are more accurately termed “audio dissolves” because they occur instantly when you apply the same dissolve effect that you use for video tracks.

Crossfading in an Avid editing application differs from crossfading in analog editing. In the analog world, unless you are using a mixer, you must lay down audio on two separate channels and fade one down, and then fade up the second on an overlapping section. In an Avid editing application, you simply apply an audio dissolve.

To fade or crossfade audio, use the procedures described in “Using Volume and Pan Automation” on page 813 or the procedure below. To dip audio from a higher level to a lower one — for example, when bringing music down and under a voice-over track, use the procedures described in “Using Volume and Pan Automation” on page 813 or the procedure below.

For an overview of when to use clip volume and when to use volume automation, see “Audio Volume Staging and an Audio Editing Workflow” on page 796.

**To apply a fade or crossfade:**

1. Move the position indicator to a transition.
2. Click the Quick Transition button (which appears by default in the second row of buttons below the Record monitor or in the Timeline top toolbar).

   The Quick Transition dialog box opens.
3. Click the Add menu, and Select Dissolve.

   Only dissolves work with audio tracks.

4. Click the Position menu, and select the location for the dissolve.

5. Select a duration for the dissolve by doing one of the following:

   - Type a duration, measured in frames (30 frames equals 1 second of NTSC footage; 25 frames equals 1 second of PAL footage), in the Duration text box.

   - Click either the left or right edge of the Dissolve Effect icon, and drag it to change the duration.

   The graphic display changes—the size of the effect icon gets smaller or larger, and the numbers in the Duration and Start text boxes change—to reflect the new duration.

   The number of frames available for a dissolve depends on how much of the clip has been edited into the sequence. For more information, see “Using the Quick Transition Button” in the Help.

6. If you selected Custom Start, type the number of frames before the transition to begin the effect in the “Start $n$ frames before cut” text box. Otherwise, leave the default value in the text box.

7. (Option) Click the Target Drive menu, and select a media drive other than the default.

8. (Option) If you have In and Out points marked in your sequence, the Quick Transition dialog box contains the following two options:

   - Apply to All Transitions (In -> Out)
   - Skip Existing Transition Effects
The Skip Existing Transition Effects option is useful when you want to add a number of dissolves to a sequence that already has transition effects.

Do one of the following:

- Select Apply to All Transitions (In -> Out) to overwrite all existing transition effects between the In and Out points.
- Select both options to avoid overwriting any existing transition effects.

9. Click Add to move the effect to the transition point without rendering. Click Add and Render to do both at once.

In most cases, you can select Add and Render for immediate real-time playback of the audio effect (rendering of audio dissolves is usually instantaneous).

The effect is completed.

To apply a dip in audio:

1. Play back the section of the sequence where you want to dip the audio to determine the start point for the dip, and apply an add edit to the audio track.
   
   For information on add edit, see “Working with Add Edits (Match Frames)” on page 722.

2. Repeat the action in step 1 for the end point where the audio dips back up.

3. Move the position indicator to the new segment of audio, and open the Audio Mixer tool.

4. Adjust the track to the volume level you want, as described in the section “Using Clip Volume and Pan Mode” on page 797.

5. Apply a dissolve to both Add Edit points, using the techniques described in “Fading and Dipping Audio” on page 831.

   Be sure to click the Position menu, and select Centered on Cut or Custom Start.

   After rendering, the audio dips smoothly from the higher levels of the adjacent segments of the track to the lower level applied to the middle segment.

Adjusting Audio Clip Gain in the Timeline

Modifying audio clip gain can be performed directly in the Timeline.

To adjust audio clip gain in the Timeline:

1. Load your sequence in the Timeline.

2. Do one of the following:

   - Select Clip Gain for the enabled track. Select Alt + Clip Gain (Windows) or Option + Clip Gain (Macintosh) to enable all tracks.
Select Audio Data > Clip Gain from the Timeline Fast Menu.

A fader icon appears for each audio clip. Clip gain values appear in the Timeline for each clip that has clip gain set.

3. Click the fader icon.

A mini fader opens.

4. Slide the fader to adjust the value of the clip gain or enter a value in the fader text box.

Option + Click the fader (Macintosh) or Alt + Click the fader (Windows) to reset the value to zero.
You can also move the position bar to the clip you want to adjust, select Alt + Shift and the Up and Down arrows to adjust the clip in one decibel increments.

Audio Sample Rate Conversion

The following options are available for audio sample rate conversion:

- You can perform sample rate conversion on a clip or sequence, as described in “Changing the Audio Sample Rate for Sequences and Audio Clips” on page 835.
- You can perform sample rate conversion as part of a Transcode operation. See “Using the Transcode Command” on page 483.
- You can perform sample rate conversion as part of a Consolidate operation. See “Using the Consolidate Command” on page 479.
- You can perform on-the-fly sample rate conversion while playing when the system encounters different sample rates. See “Audio Projects Settings: Main Tab” on page 1438.
- You can instruct the system to perform sample rate conversion during an import operation if it encounters a sample rate different from the project sample rate. See “Sample Rate Conversion and Audio Import” on page 309 and “Import Settings: Audio Tab” on page 1506.
- You can instruct the system to automatically perform sample rate conversion during capture if it encounters an audio sample rate different from the project sample rate. Sample rate conversion on input applies to the following digital inputs: SDI embedded, AES/EBU, SPDIF, and ADAT. For more information, see “Selecting the Audio Sample Rate and Controlling Audio Sample Rate Conversion” on page 208.

Changing the Audio Sample Rate for Sequences and Audio Clips

You can change the sample rate for sequences and audio clips from within the Change Sample Rate dialog box. Because you can combine clips with different sample rates in the same sequence, this feature is useful when you need to ensure that the entire sequence has the same sample rate for a digital cut or export.

For information on setting the sample rate for a project, see “Audio Project Settings for Capture” on page 207.

To change the sample rate for a sequence or an audio clip:

1. Select one or more sequences or audio clips in the bin.
2. Select Clip > Change Sample Rate.
The Change Sample Rate dialog box opens.

3. Choose from the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample Rate</td>
<td>Lets you choose between 32 kHz, 44.1 kHz and 48 kHz, (and 88.2_kHz and 96_kHz if attached to Nitris DX or Mojo DX). The broadcast standard for most high-end video postproduction houses is 48 kHz. Choose the rate based on the requirements of your facility.</td>
</tr>
<tr>
<td>Quality</td>
<td>Lets you choose the conversion quality: High, Medium, and Low.</td>
</tr>
<tr>
<td>Delete Original Media</td>
<td>When you select this option, the system automatically deletes the original media after the conversion process completes.</td>
</tr>
<tr>
<td>Target Drive</td>
<td>Identifies the drive for the new media files. Make sure that you choose a target drive with enough storage space for the generated media files and the ability to play back media.</td>
</tr>
</tbody>
</table>

4. Click OK.

**Mixing Down Audio Tracks**

When you work with multiple audio tracks while editing your material, you might need to mix down the final audio to a multichannel track or to a mono track. When you mix down audio, your Avid editing application inserts the mixdown audio in the next available track in the Timeline by default. You can override the default target track by selecting another one in the Audio Mixdown dialog box.

*You cannot mix down compressed audio.*

**To mix down several edited audio tracks to one or two audio tracks:**

1. Load a sequence into the Record monitor.
2. Click the Track buttons in the Track Selector panel to select the audio tracks you want to mix down.
3. Mark an In point and an Out point at the start and end of the material you want to mix down.
   
   If you do not mark the section of audio you want to mix down, the system mixes down all of the selected audio tracks.
4. Select Special > Audio Mixdown > To Sequence.
The Audio Mixdown dialog box opens. The Source Tracks area lists the source audio tracks and the Range area lists the start and end timecodes for the section of audio you have selected to mix down.

5. Select Mono, Stereo, 5.1, or 7.1 and select the target track to which you want to mix down the audio.

A mono mixdown goes to the next available mono track in the Timeline, and a stereo or surround sound mixdown goes to the next available stereo or surround sound track. If there are no appropriate tracks in the Timeline, the mixdown operation creates them.

6. Select a drive and a bin.

The drive is the media drive where the system stores the media files for the mixed-down audio.

7. Select Save Premix Sequence if you want to save the sequence before mixing down the audio.

8. Click OK.

Your Avid editing application mixes down the audio, displays the new master clip in the bin, and edits the mixdown clip into the sequence.
Mixing Down Multiple Audio Tracks

The editing application allows you to generate multiple audio mixes. You can map multiple inputs into multiple output channels. You can create up to 24 output channels for the mix.

**To create multiple audio mixes:**

1. Load the sequence into the Record Monitor.
2. Select Special > Audio Mix > Multiple Mixes.
   
   The Multiple Mix dialog opens.

3. Click the output channel button and select Add Output to add additional output channels or simply click the + button below the channel to add another output channel. You can add up to 24 output channels for the mix.
4. (Option) Click the button above the Output channel to apply the Master Fader effects and gain value to the output mix.

5. Map the inputs for each output channel by clicking to enable the input buttons for each channel. Holding Shift + hovering over the inputs toggles them on and off. Alt + clicking on a column, toggles all inputs in that column.

6. Select the type of output for each output channel by right-clicking the channel and selecting either Mono, Stereo, Dual Mono, Surround 5.1, or Surround 7.1.

    `Dual Mono is a stereo mix written to two mono output tracks, one for the left channel, panned left, and one for the right channel, panned right. The Dual Mono option counts as two tracks against the limit of 24 output mixes. Only odd-numbered tracks can be set to Dual Mono.`

7. (Option) Right click the output channel and select Edit Mix. The Edit Mix dialog opens. You can name the output track as well as edit the mix mode and master fader options.

8. (Option) Save the mix configuration as a Setting. The saved settings will appear as an Audio Multi-Mix setting in the Project Window Settings tab.

9. Select a drive and a bin.
The drive is the media drive where the system stores the media files for the mixed-down audio.

10. (Option) Select Use Marks. When this option is selected, your Avid editing application uses current IN and OUT points in the selected sequence to determine starting and ending frames for the mixdown.

11. (Option) Select Create New Sequence.

12. Click Mix.

New master clips will be created in the selected bin for each mixdown specified in the setting. If you selected Create New Sequence, these clips will also be built into a new sequence with a track for each mix. The video and data tracks are also copied into the new sequence unchanged, unless you selected Exclude Video and Data Tracks.

Opening a saved Audio Multi-Mix setting from the Project Window allows you to make changes to the Setting. You cannot perform a mix when selecting the setting from the Project Window. To choose a saved setting, access the Multiple Mix dialog from Special > Audio Mixes and then select the saved setting from the Select Settings pull down menu.

**Splitting Multichannel Tracks to Mono Tracks**

You can split a multichannel audio track in the Timeline into separate mono tracks if you want to edit separate audio channels or if you need to export a sequence either to an older version of the Avid editing application or to Avid Pro Tools. You can also split a clip or sequence with multichannel tracks to mono from a bin. You can split individual multichannel tracks to mono, or you can split all multichannel tracks in your sequence.

When you split a multichannel track, the original multichannel track becomes a mono track and a new mono tracks are added below the original track. For example, if you split a stereo track on A1 in the Timeline, the application makes A1 a mono track holding one stereo channel and adds a second mono track on A2 for the other stereo channel. If A2 already exists in the Timeline, the application renumbers tracks to allow for the split mono tracks. Also, the application renumbers tracks to preserve the odd and even track numbers for left and right mono channels. Renumbered tracks start at the highest track available.

If you duplicate a clip in a bin and split the copy to mono, or if you edit a multichannel clip into a sequence on multiple tracks and split one track to mono, your sequence can contain both a multichannel and a mono instance of the same master clip. This does not cause a problem with editing, playback, or any other operation.
If splitting multichannel tracks to mono tracks causes your sequence to exceed 24 audio tracks, or if splitting to mono cannot maintain the relative order of tracks or the left/right channel alignment, the Avid editing application cannot complete the operation and an error message displays. You can reduce the number of audio tracks in your sequence and retry the operation.

Stereo track A4 (left) split into mono tracks A5 and A6 (right)

When the Avid editing application splits a stereo track to two mono tracks, it changes some audio properties of the track:

- Removes stereo track effects such as RTAS plug-in effects.
- Converts stereo AudioSuite plug-in effects to mono effects.
- Applies any existing volume automation to the resulting mono tracks.
- Applies any existing pan automation to the resulting mono tracks, panning odd-numbered tracks to the left and even-numbered tracks to the right.
- Clears rendered effects. If you have effects on audio segments on stereo tracks, you need to render them after splitting the tracks to mono.

When you split all tracks in a sequent to mono, the Avid editing application automatically duplicates your original sequence and saves a copy to your bin before splitting multichannel tracks to mono.

**To split a multichannel audio track to mono, do the following:**

- Right-click the multichannel track you want to split, and select Split Track to Mono.
- Right-click a multichannel clip in a bin that you want to split, and select Split Track to Mono.
The multichannel track splits into mono tracks, with the additional mono tracks added below the original multichannel track. A copy of your original sequence is saved to your bin as [sequence_name].Copy.[number].

To split all multichannel audio tracks in the Timeline to mono, do one of the following:

- Right-click in the Timeline, and select Split All Tracks to Mono.
- Select Clip > Split All Tracks to Mono.

All multichannel tracks in the Timeline split into separate mono tracks, with the new mono tracks added below each original multichannel track. A copy of your original sequence is saved to your bin as [sequence_name].Copy.[number].

Using the Audio EQ Tool

The Audio Equalization (EQ) tool supports real-time, segment-based frequency equalization on individual clips, which lets you adjust the high, low, and midrange frequency ranges of an audio clip. You can also save a variety of audio EQ effects and apply them in different circumstances.

To access the Audio EQ tool, do one of the following:

- Select Tools > Audio EQ.
- If one of the Audio tools is already open, click the Effect Mode Selector menu, and select EQ.

The Audio EQ tool opens.

Audio EQ Tool Features

This topic describes the basic buttons and menus on the Audio EQ tool as well as the EQ-specific items on the tool.
<table>
<thead>
<tr>
<th><strong>Button</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Effect icon</td>
<td>Lets you create an EQ template. Drag the icon to an open bin to create the template.</td>
</tr>
<tr>
<td>2 Audio Loop Play</td>
<td>Lets you make adjustments to an EQ effect while you play the effect. This button is also a mappable button on the Command palette. For more information about using this button, see “Adjusting Volume While Playing a Clip Volume Effect” on page 810.</td>
</tr>
<tr>
<td>3 Render Effect</td>
<td>Lets you render an effect without leaving the Audio EQ tool.</td>
</tr>
<tr>
<td>4 Fast Menu</td>
<td>Lets you perform the following tasks:</td>
</tr>
<tr>
<td></td>
<td>• Set EQ for enabled tracks.</td>
</tr>
<tr>
<td></td>
<td>• Remove EQ for one or more tracks.</td>
</tr>
<tr>
<td></td>
<td>• Apply an effect template. See “Using Audio EQ Templates” on page 851.</td>
</tr>
<tr>
<td>5 Track Selection</td>
<td>Lets you enable tracks for the EQ effect. When you select an item from this menu, the system selects or deselects the corresponding track in the Timeline.</td>
</tr>
<tr>
<td>Menu button</td>
<td></td>
</tr>
<tr>
<td></td>
<td><em>If you enable more than one track in the Timeline, the tracks are designated by plus signs (+) indicating the effect is applied to more than one track.</em></td>
</tr>
<tr>
<td>6 Enable/Disable EQ</td>
<td>Lets you enable or disable the current EQ effect. When the button is yellow, the effect is enabled. (The button text “In” stands for “Inline.”)</td>
</tr>
<tr>
<td>Effect</td>
<td></td>
</tr>
<tr>
<td>7 Bypass RT EQ</td>
<td>Lets you instruct the system to ignore all the EQ effects. This button is also available in the Audio Mixer tool and the Output tab in the Audio Project Settings dialog box. If you select this feature in one place, it is selected in the others as well.</td>
</tr>
</tbody>
</table>
The Audio EQ tool provides three bands of control:

- The first band, the low shelf, has four turnover points (50 Hz, 80 Hz, 120 Hz, and 240 Hz). A turnover point is the point at which the curve starts to return to 0.

  A shelf affects all frequency values within the range of the shelf. The low shelf affects all frequencies from 20 Hz to the low shelf turnover point. For more information, see “Audio EQ Examples” on page 849.

- The second band is the parametric midrange. This band has two bandwidth values, 1/4 octave and 2 octaves. These values control the width of the curve. For more information, see “Audio EQ Examples” on page 849.

- The third band, the high shelf, has four turnover points (6 kHz, 8 kHz, 12 kHz, and 15 kHz). The high shelf affects all frequencies from the high shelf turnover point to 20 kHz.

The horizontal center line of the graph is 0 (zero). As you move the curve below the zero line, the corresponding frequencies are de-emphasized. Above the zero line, the corresponding frequencies are emphasized. The parametric midrange allows a smooth transition from de-emphasized frequencies to emphasized frequencies.
The In button lets you turn off an individual EQ effect (the currently selected effect). The button is yellow when the EQ effect is on (inline) and gray when the EQ effect is off.

The Ignore EQ option turns off all EQ effects for the sequence. Rendered EQ effects still play correctly.

When you apply Audio EQ effects, consider the following:

- Apply Audio EQ to entire segments only. You cannot isolate portions of a segment for an Audio EQ effect by using In to Out points. You must use add edits (match frames) to mark off a smaller segment.

- Use In to Out points to select a range of complete segments for applying an Audio EQ effect. Segments that fall within the marks, either in part or whole, have the effect applied to them.

The following illustration shows the Audio EQ tool with the frequency response curve displayed and identifies the related areas of the tool.

![Audio EQ Tool Illustration](image)

Example of shelf, parametric midrange, and turnover point information in the Audio EQ tool. The current value for all EQ parameters is 0 dB. Top: buttons that display turnover points (for the low shelf and high shelf curve) and bandwidth (in this case, 2 octaves) around the center point of the parametric curve. Bottom: EQ Range slider showing the center point of the parametric midrange curve.

The Audio EQ tool lets you emphasize or de-emphasize audio frequencies. The height of the curve in the bottom pane shows the amount of emphasis or de-emphasis (also called boost or cut) that is being applied. The range is from +15 dB to –20 dB.
Applying Audio EQ Effects

To adjust audio EQ for a track:

1. Load the sequence or clip containing the audio track:
   - To adjust a track in a source clip, click the Source monitor to make it active.
   - To view a source clip’s tracks in the Timeline, click the Toggle Source/Record in Timeline button.
   - To adjust a track in a sequence, click the Record monitor to make it active.
2. (Option) Isolate a portion of an audio segment by placing add edits.
3. (Option) Mark a range of audio segments by adding In to Out points in the track.
4. Select Tools > Audio EQ.
5. Click and hold the Track Selection Menu button in the Audio EQ tool, and select a track to be adjusted.

![Track Selection Menu button in the Audio EQ tool]

The Track Selector panel in the Timeline updates to reflect your selection. If you enable multiple tracks in the Timeline, plus signs (+) appear next to the enabled tracks in the Audio EQ tool.

6. Click the Audio Loop Play button to play the currently selected audio clip within the current In to Out range. To stop playing the loop, click the button again or click anywhere in the Timeline.

7. Use one of the following methods to change a value in the Audio EQ tool:
   - Click a number along the vertical edge of the Low Shelf, Parametric Midrange, or High Shelf sliders.
   - Click the Low Shelf, Parametric Midrange, or High Shelf slider, and type a value. Values are cumulative until you press Enter (Windows) or Return (Macintosh). For example, if you want to enter the value 12, simply type it. However, if you enter 1 and then want to change the value to 2, press Enter (Windows) or Return (Macintosh) before typing the 2.
   - Click a slider, and then drag the slider to a new position.
   - Click the EQ Parameter display, and type a value on the numeric keypad.
Using the Audio EQ Tool

- Set a value of 0 dB by clicking the slider and entering 0, or by clicking 0 along the vertical edge of the Low Shelf, Parametric Midrange, or High Shelf sliders.

8. Click the Audio EQ Tool Fast Menu button, and select Set EQ to apply the adjustments to the track.

The command works as follows on the selected tracks:
- In and Out points — Applies the EQ effect to selected tracks between the points.
- An In point (no Out point) — Applies the EQ effect to full clips from the In point to the end of selected tracks.
- No points — Applies the EQ effect globally (across entire tracks).

9. Play through the audio again, using the Audio Loop Play button.

10. Repeat steps 6 to 9 until you are satisfied with the EQ adjustments.

Saving Audio EQ Effects

Your Avid editing application treats an EQ setting as an effect. You can save EQ settings in a bin just as you save any other effect template. This makes it easy to save EQ settings and apply them whenever you need them. The following illustration shows an EQ Effect icon in a bin and in the Timeline.

To save EQ settings in a bin:
- Drag the effect icon in the Audio EQ tool to a bin.
To copy the settings to another audio clip:

- Drag the effect icon in the Audio EQ tool to another audio clip in the Timeline.

For more information on using effect templates, see “Working with Effect Templates” in the Help.

Removing Audio EQ Effects with the Fast Menu

You can remove audio EQ effects with the Audio EQ Tool Fast menu or with the Remove Effect button.

The Audio EQ Tool Fast menu lets you remove EQ effects from one track or all enabled tracks and provides access to a number of predefined EQ templates. For a description of predefined audio templates, see “Using Audio EQ Templates” on page 851.

For example, the following illustration shows a segment with one EQ effect applied to the second audio clip on the first audio track. If you select Set EQ In/Out, the current EQ effect is also applied to the first and third audio clips on the first audio track.

If there is no EQ setting on the currently selected clip, selecting Set EQ In/Out deletes the EQ settings on all clips within the In to Out range. For example, because there is no EQ setting on the third audio clip in the following example, Set EQ In/Out deletes the EQ effect from the first and second audio clips.
Set EQ In/Out applies only to the audio track currently selected by the Audio EQ tool. You can change your selected region by eliminating or adding marks in the Timeline, or by selecting a different track.

Removing Audio EQ Effects with the Remove Effect Button

To remove an Audio EQ effect:

1. Move the position indicator to the effect in an active track.
2. Do one of the following:
   - In Source/Record mode, click the Remove Effect button.
   - In Effect mode, press the Delete key.

Audio EQ Examples

The following procedures are examples of two different ways to use the Audio EQ tool to remove excess bass from an audio track. Assume that a bass drum in the sound track is very pronounced. You want to use the Audio EQ tool to de-emphasize it, but there are voices on the same track as the music. The human voice covers a wide range of frequencies, and the challenge is to preserve the bass frequencies of the voices while de-emphasizing the bass drum sound.

Consider that the goal of the adjustments is the final sound. You should use small adjustments to preserve as much of the original sound track as possible. Do not be overly concerned about specific parameter values.

The first procedure adjusts the low shelf to de-emphasize the bass. By dropping the low shelf to –20 dB, you can de-emphasize it. However, there are voices on this track, and simply dropping the low shelf also removes some bass from the voices.

The remaining procedures use the parametric midrange to isolate the particular frequency to de-emphasize.
To compensate for the loss of bass by adjusting the low shelf:
1. Use the 2-octave midrange setting to create a wide midrange.
2. Move the midpoint of the parametric curve to 88 Hz (Windows) or 90 Hz (Macintosh).
3. Boost the midrange of the parametric curve to +7.7 dB.

To isolate the frequency:
1. Use the ¼-octave influence range.
2. Set the midrange EQ parameter to –15 dB.
3. Use the EQ Range slider to move the midpoint of the parametric curve until it isolates the bass frequency.
   In this case, the bass frequency to de-emphasize is approximately 80 Hz.
Once you locate the frequency you want, you can adjust it as needed.

**To locate a specific frequency and either emphasize or de-emphasize it:**
- Use the ¼-octave influence range and a large negative decibel value.
- Keep both the high shelf and low shelf set to zero.
- Use the EQ Range slider to move the center point of the parametric curve along the frequency range while you play the audio track.

**Using Audio EQ Templates**

Your Avid editing application provides a set of predefined audio EQ templates. The EQ templates are designed to fix problems that you often encounter with audio clips. For example, Tape Hiss Filter rolls off frequencies above 4 kHz. NTSC Hum Buster cuts the bass on frequencies that often cause hum on NTSC systems. The templates are accessible from the Fast menu in the Audio EQ tool. You can also add your own custom EQ templates to the Fast menu.
Predefined EQ templates in the Audio EQ tool Fast menu

The following illustration shows the contents of the Audio EQ tool when you select the Female Voice with Presence template in the Timeline. As explained in the tool, you cannot change the parameters of a predefined EQ template.
To see the parameter values of one of the EQ templates that cannot be edited, view the Console window after you apply the effect. For more information, see “Using The Console Window” on page 134.

If you create an EQ effect, you can use it again as a template in another sequence or on another track.

Your Avid editing application stores predefined EQ templates in a special bin named Site_EQs_Bin.avb. You can add your own EQ templates to the Audio EQ Tool Fast menu by storing your EQ templates in the same bin as the predefined templates.

**To apply an EQ template from the Audio EQ Tool Fast menu:**

1. Move the position indicator to the audio clip in the Timeline.
2. Click the Audio EQ Tool Fast Menu button, and select the template.
   
   Your Avid editing application places the EQ effect on the audio clip.

**To create your own EQ effect template:**

1. Drag the effect icon from the Audio EQ tool to a bin.
   
   Your Avid editing application creates an EQ effect in the bin.
2. Rename the template by clicking the text and typing a new name.

**To add an EQ template to Site_EQs_Bin:**

1. Open the bin containing your EQ templates.
2. Select File > Open Bin.
   
   A dialog box opens.
3. Navigate to the bin named Site_EQs_Bin.avb in one of the following locations:
   
   (Windows) drive:\Program Files\Avid\Avid editing application\SupportingFiles\Site_Effects

   (Macintosh) Macintosh HD/Applications/Avid editing application/SupportingFiles/Site_Effects
4. Double-click the Site_EQs_Bin.avb file.
   
   The Site_EQs_Bin window opens.
5. Drag one of your EQ templates into the Site_EQs_Bin window.
6. Name the template by clicking the text and typing a name.
7. Close the bin.
   
   Your Avid editing application does not save the effect to the bin until you close the bin.
8. Click the Audio EQ Tool Fast Menu button, and look for your new template.
Adjusting EQ While Playing an Audio Effect

You can use the Audio Loop Play button to create or change an EQ effect while a clip is playing.

Use the same procedure as described in “Adjusting Volume While Playing a Clip Volume Effect” on page 810.

If the clip has no existing EQ effect before you start, you do not hear any changes until you click the Audio Loop Play button to stop and replay the effect.

As you adjust the EQ values on an existing EQ effect, you might not hear the results immediately. It takes a few seconds for the changes to be applied to the clip.

You can improve the response time by doing any of the following:

• Monitor as few audio tracks as possible.
• Deselect the video track, if practical.
• Use In and Out points to choose a narrow interval to adjust.

Recording Voice-Over Narration

You can use the Audio Punch-in tool to record audio directly into the Timeline for voice-over narration.

Recording voice-over narration directly into your Avid editing application saves you the extra steps of recording the narration to tape first, capturing the narration audio to your Avid system, and then editing the audio clip into the sequence.

Hardware Connections for Voice-Over Recording

Before you can record voice-over narration, you need to connect a microphone or other input device to your system. The following are typical examples:

• Connect a microphone to a mixer, and connect the mixer to the audio interface I/O device on your Avid system.
• Connect a microphone to an external audio device — for example, one of the Mbox family devices — and connect the device to your Avid editing system.
• Connect a microphone to a microphone preamplifier, and connect the preamplifier to the audio interface I/O device on your Avid system.

For information on connecting the hardware, see “Using the Avid Input/Output Hardware” in the Help.
Recording Voice-Over Narration Using the Capture Tool

The Capture tool lets you record up to two channels of audio directly into the Timeline for voice-over narration.

You can also use the Audio Punch-in tool to record audio directly into the Timeline. For more information, see “Recording Voice-Over Narration Using Audio Punch-in” on page 859.

To capture voice-over narration using the Capture tool:

1. Mark the In and Out points in the Timeline.
2. Select Tools > Capture.
   
   The Capture tool opens.

3. Click the Voice-over button in the Capture tool.
4. Click the Audio Input menu, and select the appropriate input.
5. In the Timeline, patch the source track to the record track you want.
   
   For more information on patching, see “Patching Tracks” on page 709.
6. Click the Record button.
7. Stop the recording as follows:
   - If you started with both In and Out points in the Timeline, the system automatically stops recording when it reaches the Out point (or after it adds the appropriate audio handle after the Out point).
   - If you added only an In point, click the Record button a second time to stop the recording.

Your Avid editing application automatically names the voice-over. You can change the name as you would for any clip (for example, change the name in the bin).

The following illustrations show the results of adding a voice-over.

![Examples of adding a voice-over in the Timeline. Top: voice-over adding a new track. Bottom: voice-over replacing a portion of a track.](image)

**Audio Punch-in Tool Features**

You can use the Audio Punch-in tool to record voice-over narration directly into the Timeline. However, you can only record to mono tracks when you use the Audio Punch-In tool.

You can “rehearse” the voice-over while listening to the sequence. The voice-over is not recorded while you rehearse. You can continue to rehearse until you get it right. While recording, you can watch and listen to the sequence and hear the playback of edited sound tracks.

The following illustration shows the features of the Audio Punch-In tool. The following table describes the features of the tool.
**Audio Punch-In Tool Feature**  |  **Description**  
---|---
1 **Play In/Out button**  | Starts playing with the ability to perform a real-time punch-in. The play loops from the In point to the Out point but stops looping once recording completes. This button blinks bright green while playing.  
2 **Record button**  | Starts and stops the recording. If you set an In point and Out point, recording automatically starts at the In point and stops at the Out point. This button blinks bright red while recording.  
3 **Stop button**  | Stops playing or recording and saves the last recorded data. This button is bright blue when recording stops.  
4 **Go to Mark In button**  | Moves the position indicator to the In point. If there is no In point, your Avid editing application goes to where the position indicator was previously located or to the start of the sequence.  
5 **Cancel button**  | Stops a recording without saving the recorded data.  
6 **Audio Tool button**  | Opens the Audio tool so you can monitor and adjust the audio levels during recording.
## Audio Punch-In Tool Feature

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input Channels button</td>
<td>Identify the channels on the audio hardware used for recording. Click the appropriate button to select the channel. Alt+click (Windows) or Option+click (Macintosh) the button to display a menu and select another channel. The selected input channels are not used for playback. Do not select the same channels as mix output on the Audio Mixer tool.</td>
</tr>
<tr>
<td>Passthrough Mix Tool button</td>
<td>Opens the Passthrough Mix tool so you can monitor the audio levels during recording.</td>
</tr>
</tbody>
</table>
| Punch-In Monitoring button | Allows you to set the Audio Punch-In monitoring  
  - Automatic - Monitoring is not disabled if latency <100ms. If the editing application detects a latency >100ms, monitoring is turned off.  
  - On - Audio will monitor IN to OUT during punch-in.  
  - Off - Audio will not monitor IN to OUT during punch-in. |
| Preroll and postroll text boxes | Let you provide audiovisual cues before the recording begins and after it ends. For preroll, your Avid editing application backs up the position indicator for the prescribed number of seconds. You can hear the audio during preroll. When starting a punch-in with the Record button, a preroll lets you provide the duration, in seconds, of the audiovisual cue before the recording begins. |
| Handles text box         | Instructs your Avid editing application to record audio at the beginning and end of the clip. This lets you perform trim edits on the audio. This feature applies only when you start recording with the Record button. You can record real-time punch-in only until the end of the handle. |
| Input Source menu        | Includes several optional sources for audio input, depending on your system and audio board.                                                                                                           |
| Timeline Track menus     | Allow you to specify where your Avid editing application places the audio in the Timeline. Select either New Track or an existing track. When you select an existing track, your Avid editing application overwrites the audio on that track and silences that portion during playback. You can only use mono audio tracks for punch-in. You cannot select stereo tracks or locked tracks. |
| Target Drive menu        | Lets you choose a target drive.                                                                                                                                                                          |

*The Record button takes precedence over preroll. During preroll, if you press the Record button, the system starts recording immediately.*

To view the audio input sources available on your system, see the Input Source menu in the Input tab in the Audio Project Settings dialog box.
Audio Punch-in Tool Scenarios

You can punch-in audio in several ways:

- Scenario 1 — Set only an Out point. The position indicator is used as the In point. Set a preroll time. Click the Play In/Out button to loop continuously through the sequence. Click the Record button when you find what you want to punch-in, and then click the Record button again to end recording.

- Scenario 2 — Set an In point and an Out point around the material you want to record. Set a preroll time. Click the Record button to start the preroll. When the system arrives at the Out point, recording ends. The last region including the Out point is recorded. Repeat recording over the same region until you are satisfied with the results.

- Scenario 3 — With no In point or Out point set, click the Record button continuously throughout your sequence. Click the Record button to start recording, and then click the Record button again to end recording. Continue this process to record multiple punch-ins.

Recording Voice-Over Narration Using Audio Punch-in

The steps below represent general guidelines for recording audio punch-ins, regardless of your scenario. You should determine when to add the In and Out points, when to use the Play In/Out button, and when to use the Record button, based on your needs. For more information, see the scenarios described in “Audio Punch-in Tool Scenarios” on page 859.

When performing an audio punch-in, the video resolution is dropped a quarter-frame due to bandwidth limitations.

To use the Audio Punch-In tool:

1. Load a sequence into the Timeline.
2. Select Tools > Audio Punch-In.

   The Audio Punch-In tool opens. For information on the buttons and other controls in the Audio Punch-In tool, see “Audio Punch-in Tool Features” on page 856.
3. Select the input source and input channels that correspond to your hardware setup, and set other values in the window as appropriate.

To select the input channels you want, click and hold the appropriate Input Channels button.

4. Click the Timeline Track menus, and select either New Track or an existing track to specify where your Avid editing application places the audio voice-over in the Timeline.

You can only use mono audio tracks for punch-in. You cannot select stereo tracks or locked tracks.

You can replace part (or all) of an existing track, or you can create a new track for the voice-over.

5. (Option) Set In and Out points in the Timeline to specify the part of the sequence to which you want to add narration.

6. Click the Play In/Out button or press the V key.

Loop play begins over the entire sequence. If you set an In point and an Out point, loop play begins from the In point to the Out point.

The Play In/Out button blinks bright green while playing.

7. When you are ready to start the voice-over, click the Record button or press the B key.

The Record button blinks bright red while recording, and the Play In/Out button is a steady green. The Audio Meter Channel button in the Audio tool becomes an I and changes to orange.

8. Continue to click the Record button to record additional voice-overs.

During the audio punch-in process, you have the ability to record over the duration of the sequence or from the In point to the Out point.
9. Click the Stop button, or press the space bar to stop play and recording.

Your Avid editing application automatically names the voice-over and saves it as an audio clip. You can change the clip name as you would for any other clip. The position indicator stops to get ready for your next voice-over.

10. (Option) To go to the In point at any time, click the Go to Mark In button.

Your Avid editing application creates one master clip, regardless of how many punch-ins you perform.

The following illustrations show the results of adding a voice-over.

Examples of adding a voice-over in the Timeline. Top: voice-over adding a new track. Bottom: voice-over replacing a portion of a track.

Three Undo functions can be performed during one session. The first undo removes the most recent punch-in, the second undo removes the second-to-last punch-in, and the third undo removes all the punch-ins.

**Monitoring Previously Recorded Tracks While Recording Voice-Over Narration**

You can monitor previously recorded audio tracks while you record a voice-over narration.

**To monitor other audio tracks:**

1. Select Tools > Audio Tool.

   The Audio tool opens.

2. Click the Output Options menu, and select Mono.

3. Record your voice-over as described in “Recording Voice-Over Narration Using Audio Punch-in” on page 859.

4. As you record, monitor the previously recorded audio tracks along with your current recording from the meters in the Audio tool and from the sound on the speakers.
Audio Punch-In Support for Open I/O Devices

If your Open I/O device allows you to record and play simultaneously, you can perform an Audio Punch-In. Check with your 3rd party vendor to see if they support simultaneous record and play.

By clicking on the Punch-In monitoring button in the Audio Punch In tool, you can choose the following monitoring options:

- **On** - allows for IN to OUT audio monitoring during audio punch-in.
- **Off** - turns off IN to OUT audio monitoring during audio punch-in. When monitoring is off, the icon in the Punch-In tool changes to indicate punch in monitoring is off. For example, this mode is useful when you want to use another device such as the Mbox to provide local passthrough.
- **Automatic** - Allows the editing application to detect if monitoring should be On or Off due to detected latency. Monitoring is *not* disabled if latency <100ms. If the editing application detects latency >100ms, monitoring is turned off. Note: You can choose to override this by setting the monitoring to On.

In some hardware configurations, audio monitoring during Punch-In will not be allowed at all because the hardware does not support it. In this case, the Punch-In tool indicates the monitoring is Off and you cannot override it.

Using Peak Hold While Recording Voice-Over Narration

Peak Hold lets you customize the meter displays, and sets and plays back the internal calibration tone. You can use Peak Hold while recording a punch-in as follows:

- Use the Peak Hold menu in the Audio tool to change between Peak Hold and Infinite Hold.
- Use the Reset Peak button in the Audio tool.

For more information about Peak Hold, see “Understanding the Audio Tool” on page 212.
Using Automatic Voice-Over

The Automatic Voice-Over feature (Auto VO) lets you automatically remove certain segments from a sequence based upon their relationship to a selected audio track.

You can also use automatic voice-over to quickly create a new sequence that consists only of the background material or only of the interview material. You can then use the new sequence as a starting point for a revised version of the story, for example, in a follow-up newscast.

**To remove selected segments from a sequence, do one of the following:**

- Extract all the segments whose audio appears on the selected track.
- Extract all other segments from the sequence, leaving only those segments whose audio appears on the selected track.

Your Avid editing application creates a new sequence with a `.vo` file name extension that contains only the material remaining after the Auto VO process. The original sequence is retained and is unaffected.

Auto VO might be useful whenever you organize the audio tracks in your sequence so that audio from one type of material is isolated on one audio track. For example, a common approach in broadcast news intersperses interview material with B-roll (background or location) footage. You can edit the audio from the interview onto one audio track and the audio from the B-roll footage onto another audio track.

**To create an edited sequence by using Auto VO:**

1. Open the bin that contains the sequence you want to edit.
2. Select the sequence in the bin.
3. Select Bin > Auto VO.

   The Auto VO dialog box opens.

   ![Auto VO dialog box](image)

4. From the Using track menu, select the audio track that you want to control the edit.
5. Select one of the following:
   - Extract segments, to remove all segments with audio on the track selected in step 4.
Keep segments, to retain all segments with audio on the track selected in step 4 and remove all other segments.

6. Click OK.

Your Avid editing application creates a new sequence in the bin and names it by adding a .vo file name extension to the original sequence name.
Avid editing applications support the following external fader controllers or mixers for volume automation and pan recording or as control surfaces.

External fader controllers or mixers are optional. You do not need them to perform volume automation or pan recording on an Avid editing system.

- 002 (Windows only) and Command|8 — These units support touch-sensitive flying faders. While recording volume automation, the faders automatically move. Touch sensitivity means that you can grab a fader and move it during a volume automation recording to quickly punch in a small change in volume. Each track has a separate pan control knob that you can use for pan recording. You can use the 002 as a standalone audio mixer, but not at the same time that you use it as a volume or pan controller or as a control surface. The 002 and Command|8 are the only controllers that can be used as control surfaces to control other parts of your Avid editing application. You can also use these units as control surfaces for other parts of your Avid editing application. Besides basic functions such as Play, Stop, and Rewind, you can map buttons and menu items to the different buttons on the control surface.

- Mbox family of audio devices — These devices include the Mbox, Mbox Pro, and Mbox Mini. You can use these devices in supported configurations to control audio input and output, as well as to monitor audio playback. For more information, see “Using Mbox Family Audio Devices” on page 879.

- EUCON devices — These devices include the MC Control, MC Mix, and MC Transport. You can use these devices to perform various audio navigation and transport functions as well as some video and audio editing operations such as recording volume automation. For more information, see “Using Avid Artist Series Controllers” on page 897.

The following table compares Avid external controllers and mixers.

| Feature                        | Digi 002 (MC/NC only) | Command|8 | MC Control | MC Mix | MC Transport       |
|-------------------------------|-----------------------|------|------------|--------|-------------------|
| Control surface for transport | Yes                   | Yes  | Yes        | Yes (transport only, no soft keys) | Yes   |
| and other functions           |                       |      |            |        |                   |

---
The following list provides additional information on touch sensitivity and automatically stopping recording:

- Touch sensitivity — As soon as you touch a moving fader on the 002 or Command|8, the unit passes control of the fader to you. For more information, see “Using the Latch Mode Feature on the 002 and Command|8” on page 878.

- Latch mode — In Latch mode, you record gain information only while touching the fader. In Latch mode, recording begins when you touch and ends when you stop playback. For more information, see “Using the Latch Mode Feature on the 002 and Command|8” on page 878.

For more information on using these external fader controllers or mixers, see “Understanding Volume or Pan Automation Recording” on page 818.
Configuring an External Controller

Some fader controllers require specific configuration procedures before you can use the devices with your Avid editing application. For more information, see the following topics:

- “Configuring the Command|8” on page 873
- “Configuring the Mbox Device” on page 880
- “Using Avid Artist Series Controllers” on page 897

For information about using third-party devices, see the documentation that came with your fader controller.

To set the correct port in the Controller Settings:

1. Start your Avid editing application.
2. Click the Settings tab in the Project window.
3. Double-click Controller Settings.
4. In the Gain Controller Port menu, select the port that corresponds to your controller.
5. Click OK.

An external fader controller is optional. It is not required to perform volume automation recording.

To test the external fader controller:

   The Audio Mixer tool opens.
2. Do one of the following:
   - Click and hold the Audio Mixer Mode button and select Automation Mode from the menu.
   - Click the Audio Mixer Mode button and cycle through the Audio Mix mode settings to the Automation Mode setting.
3. Click the Audio Mixer Tool Fast Menu button, and select Calibrate Hardware Sliders.
   The box changes to blue.
4. Check the color of the position indicator lights.
   If the external fader controller is connected, at least one of the lights should be on (blue). If the external fader controller is not connected properly, the lights will probably appear gray.
Configuring External Controller Settings

You use the Controller Settings dialog box to configure your system so that it can communicate with supported fader controllers. You can use the Controller Settings dialog box for your device to configure several aspects of the controller’s behavior:

- You can map the Command palette functions of your choice to the fader controller buttons.
  
  For information on mapping Avid Artist Series buttons, see “Customizing Avid Artist Series Controls” on page 909.

- Depending on your controller, you might be able to customize the maximum jog or shuttle speed. You can view footage at the maximum speed when you turn the jog/shuttle wheel all the way to the right or the left position.

Because you cannot map all the Command palette functions to supported controllers, you might want to create multiple Controller settings in the Settings list of the Project window for different sets of editing functions. For more information, see “Duplicating Settings” on page 1425 and “Selecting Among Multiple Settings” on page 1426.

To configure your Avid editing application for a controller and open the Controller Settings dialog box:

1. Double-click Controller Settings in the Settings list of the Project window.

   The Controller Settings dialog box opens.
2. Click the Port menu, and do one of the following, depending on your operating system, to select the appropriate port:
   - (Windows) Select COM1 or COM2
   - (Macintosh) Select Port #1, #2, #3, or #4

3. Select Controller > [controller].

4. Click Edit Settings.

   The Controller Settings dialog box for your controller opens. For information on the layout of the dialog box and the default button mappings, see the documentation that came with your controller.

To map from the Command palette to the fader controller buttons:

1. Open the Controller Settings dialog box for your device.
2. If the Command palette is not already open, click Open Command Palette.
   The Command palette opens.

4. Do one of the following:
   - To map an unshifted function, click the function in the Command palette and drag it to the button in the Controller Settings dialog box whose function you want to program.
If your controller uses shifted functions, press and hold the Shift key on your keyboard, click the function in the Command palette, and drag it to the button in the Controller Settings dialog box whose function you want to program.

As you drag between the Command palette and dialog box, the pointer changes to the hand pointer.

The new function appears on the controller button.

Using an External Fader Controller or Mixer to Record Volume Automation

For more information on using third-party controllers with your Avid editing system, see the documentation that came with your device.

To record audio gain information using an external fader controller or mixer:

1. Attach the fader controller or mixer to your system.

   The position indicator lights change to blue when the fader controller or mixer is on and correctly attached to the system.

2. Move the blue position indicator to the section of audio that you want to adjust and mark In to Out points.

3. Set Preroll and Postroll values, if necessary.

4. Click the Record button to start recording your actions.

5. Listen to the audio, and when you want to start recording volume information either touch or move the corresponding fader.

   Depending on the fader controller or mixer, you might have to click the fader’s On button before moving the fader.

6. Click the Record button again to stop recording.

7. Click the Audio Loop Play button to play the clip and test your results.
8. To decrease the number of keyframes, click the Audio Mixer Tool Fast Menu button, and select Filter Volume Automation on Track — In/Out. (Click the Track Selection button for a track to enable Filter Automation.)

   If you delete too many keyframes, use the Undo command to restore them.

9. Repeat the previous step until you have decreased the number of keyframes to an acceptable level.

   You should remove as many excess keyframes as possible while still maintaining the volume changes.

---

**Adjusting the Volume or Pan of Individual Keyframes**

**To edit the volume for individual keyframes using an external fader controller or mixer:**

1. Check the color of the position indicator lights.

   ![Position indicator lights](image)

   If the external fader controller or mixer is on and is correctly attached to the system, at least one of the position indicator lights on each enabled track is blue.

2. Click an audio gain keyframe.

   On the 002 (Windows only) and the Command|8, the faders automatically adjust to the volume setting.

3. Move the corresponding fader to adjust the volume for the keyframe.

   For information on connecting a fader controller or mixer, see “Using an External Fader Controller or Mixer to Record Volume Automation” on page 870.

**To edit the pan values for individual keyframes using a 002 or Command|8:**

1. Click an audio gain keyframe.

2. Activate the track on the 002 (Windows only) or Command|8.

3. Move the corresponding pan knob to adjust the pan for the keyframe.

   Your Avid editing application displays the values in the Pan Value display for the corresponding track in the Audio Mixer tool.
For information on connecting a fader controller or mixer, see “Using an External Fader Controller or Mixer to Record Volume Automation” on page 870.

The position indicator lights do not apply to pan.

Using the 002 and the Command|8

You can use the Command|8 as a control surface for your Avid editing application as well as a controller for volume automation and pan recording.

On Windows systems, you can use the 002 as an audio input and output device for your Avid editing application. You can also make use of its control surface capabilities and use it as a controller for live mix mode and for volume automation and pan recording.

Avid does not support the use of the Avid 002 with Avid video editing applications on Macintosh systems. However, you can use the Avid 002 with Avid Pro Tools on Macintosh systems.

The following table compares some of the features of the 002 and Command|8.

| Feature                                | 002 (Windows only) | Command|8 |
|----------------------------------------|--------------------|------|
| Connection type                        | FireWire           | USB  |
| Use as an audio device for Avid editing application (play, record, output) | Yes                | No   |
| Works with Avid editors for controlling pan and gain and as a control surface | Yes                | Yes  |

Using the Command|8 with Your Avid Editing System

The Command|8 is primarily a control surface. You can use it for controlling aspects of the user interface as well as for volume automation and pan recording. You can use it with all Avid editing applications that use Avid input/output hardware.

If your Avid input/output hardware provides four audio channels, you can connect channels 1 and 2 from the input/output hardware to the first Command|8 stereo pair input and connect channels 3 and 4 to the second pair. Then you can switch between the two inputs. If your Avid input/output hardware does not provide four audio channels, you can connect the hardware’s audio outputs to one of the Command|8 stereo inputs.
Configuring the Command|8

Before you configure your Command|8 with your Avid editing application, install and configure the device as described in the documentation that comes with Command|8.

You must start Command|8 before you start your Avid editing application. If you start your Avid editing application when the controller is turned off, you must exit your Avid editing application, turn the controller on, and then start your Avid editing application.

To set the correct ports in the Controller Settings dialog box.

1. Connect the 002 (Windows only) or Command|8 to your Avid editing system and turn on the unit.
2. Start your Avid editing application.
3. Click the Settings tab in the Project window.
4. Double-click Controller Settings.
   The Controller Settings dialog box opens. The Controller menu, Port menu, and Edit Settings button apply to the control surface. For Windows systems, you can use either an 002 or a Command|8. For Macintosh systems, you can use a Command|8. The Gain Controller Port applies to any controller that you connect for volume automation or pan recording.
5. From the Controller menu, select one of the following:
   - 002 Controller (Windows only)
   - Command|8
6. From the Port menu, select one of the following:
   - Windows - “002 Control Port” or “C|8 Surface”
   - Macintosh - Command|8 Port 1
7. From the Gain Controller Port menu, select a controller for volume automation or pan recording.
   The Gain Controller Port menu displays all COM or MIDI ports that are available on the system.
8. (Option) Click Edit Settings to view or modify the button assignments.

Mapping Buttons and Menu Commands for the Avid 002 or Command|8

On Windows systems, you can map the buttons in the 002 Controller Settings dialog box to buttons on the Command palette and to menu commands.
The buttons on the 002 (for Windows systems only) and Command|8 can have different functions depending on the modifier key you press. You can either use the keyboard or press one of the Keyboard Modifier switches on the controller surface.

For the 002 and the Command|8, pressing the Option key on a Macintosh system is equivalent to pressing the Alt key on a Windows system. Pressing the Command key on a Macintosh system has no equivalent on a Windows system.

To display the dialog box for mapping buttons and menu commands:

- Click the Edit Settings button in the Controller Settings dialog box.

The 002 Controller Settings or Command|8 Controller Settings dialog box opens.

The following illustration shows the 002 Controller Settings dialog box.


The following illustration shows the Command|8 Controller Settings dialog box.
Groups of controls in the Command|8 Controller Settings dialog box. Top, left to right: Console View controls, Transport and Navigation controls, Display Controls and Foot Switch. Center: Keyboard Modifier switches. Bottom: Open Command Palette button.

**To view the different button settings on the Controller Settings dialog box:**
- Press the Shift, Control, Option, or Command key while viewing the Command|8 Controller Settings dialog box.

**Mapping Controller Menu Commands for the 002 or Command|8**

You can change the Keyboard Modifier switches by selecting a new button from the appropriate menu in the Keyboard Modifiers area.

Each Controller Settings dialog box has an Open Command Palette button. Use the standard techniques for mapping buttons and menu selections from the Avid interface to the buttons on the control surface. For more information, see “Mapping User-Selectable Buttons” on page 131 and “Mapping Menu Commands” on page 132.

**To map a menu command to a button on a Controller Settings dialog box:**

1. Click the Settings tab on the Project window.
2. Double-click Controller Settings.
   - The Controller Settings dialog box opens.
3. From the Controller menu, select either 002 Controller (Windows only) or Command|8.
4. Click Edit Settings.
   The 002 Controller Settings dialog box or Command|8 Controller Settings dialog box opens.
5. Click Open Command Palette.
   The Command palette opens.
6. Click Menu to Button Reassignment on the Command palette.
   As you move the mouse over a button, the cursor changes to a menu icon.
7. Click the button on the dialog box that you want to change.
   The system highlights the button.
8. Select a menu command. For example, select Tools > Audio Punch-In.
   The system maps the menu command to the button.
9. When you finish mapping menu commands, click Active Palette on the Command palette or
   Button to Button Reassignment to map buttons.
10. When you finish mapping menu commands and buttons, click OK to save your changes.
   The 002 Controller Settings dialog box or the Command|8 Controller Settings dialog box
   closes and the Controller Settings dialog box appears.
11. Click OK.
   The system makes the new button assignments.

⚠️ The assignments do not take effect until you click OK in both dialog boxes.

**Using 002 or Command|8 Buttons to Change Focus in your Avid Editing Application Interface**

Many buttons perform different functions depending on which window in the Avid interface is active. For example, if the Timeline is active, pressing Play plays the sequence in the Timeline. If a bin is in Frame view and a clip is selected, pressing Play plays the footage in the clip.

⚠️ You cannot assign a function to the F1 key on a Command|8. The F1 key is a local function on
   the device.

⚠️ Do not press the Standalone button on the 002 while you are using it as a control surface for
   your Avid editing application. This puts the controller in Standalone mode and closes the
   FireWire connection. To use the controller again, you must exit your Avid editing
   application, power cycle the controller, and then restart your Avid editing application.
To ensure that you perform the correct operation when you press a button on the control surface:

1. Map some buttons to menu commands that makes a particular window or tool active.
   
   For example, on the 002, the F5 key is mapped to Tools > Timeline by default for Windows systems. Pressing the F5 button on the 002 makes the Timeline active.

2. (Option) To see the function of a mapped button, hold the cursor over the button to view the tooltip.

Using a Foot Pedal as a Foot Switch with the 002 or Command|8

The 002 (Windows only) and Command|8 each have a connection on the back for a foot pedal. The system accepts any “normally open” foot pedal. For example, you can use a standard normally-open sustain pedal for an electronic keyboard.

You can assign any button or menu item to the foot pedal. By default, the system assigns the foot pedal to the Record button on the Audio Punch-In tool. You could also assign the foot pedal to the Shift key function.

Switching Between the 002 and Command|8

The button mappings for the 002 for Windows systems carry over to the Command|8. The button-mapping dialog boxes for the 002 and Command|8 are set up differently to match the layout of the controllers, but the same settings are used for both controllers.

There are several buttons on the Command|8 that are not on the 002:

- Mon 0
- Default
- MemLock

These buttons appear in the Command|8 Controller Settings dialog box and do not appear in the 002 Controller Settings dialog box.

Using a 002 or Command|8 to Record Pan

To record pan information using a Command|8:

1. Attach the 002 (Windows only) or Command|8 to your system. (See “Configuring the Command|8” on page 873.)

   The position indicator lights change to blue when the fader controller or mixer is on and correctly attached to the system.
Using the 002 and the Command|8

Position indicator lights

2. Click the Timeline Fast Menu button and select Audio Data > Pan.
3. Move the blue position indicator to the section of audio that you want to adjust and mark In to Out points.
4. Set Preroll and Postroll values, if necessary.
5. Click the Record button to start recording your actions.
6. Listen to the audio and turn the pan knob for the track.
   The system displays the values in the Pan Value display for the corresponding track in the Audio Mixer tool.
7. Click the Record button again to stop recording.
8. Click the Audio Loop Play button to play the clip and test your results.
9. To decrease the number of keyframes, click the Audio Mixer Tool Fast Menu button, and select Filter Pan on Track — In/Out. (Click the Track Selection button for a track to enable Filter Automation.)
10. (Option) If you delete too many keyframes, use the Undo command to restore them.
11. Repeat step 9 until you have decreased the number of keyframes to an acceptable level.
   You should remove as many excess keyframes as possible while still maintaining the pan changes.

Using the Latch Mode Feature on the 002 and Command|8

The 002 (Windows only) and Command|8 have a Latch Mode button for each track that lets you easily punch-in and punch-out small sections of volume automation information. The Channel View buttons on the 002 are used as the Latch Mode buttons. These buttons are directly above the display on the 002 and directly below the display on the Command|8. The first two buttons are labeled EQ and Dynamics.

When a fader is not in Latch Mode, it automatically stops recording as soon as you release it. When you release the fader, it begins moving again as it follows the volume information in the Timeline.

The light inside the Latch mode button is on when a fader is not in Latch mode.
To use Latch Mode:

1. Click the Latch Mode button for the appropriate tracks on the controller.
   You can click the button before or during a recording session.
2. Set In and Out points, and click the Record button.
   The system begins playing the section and the faders move accordingly.
3. When you want to make an adjustment, move the fader to change the volume.
   The system immediately begins recording.
4. When you are finished adjusting the section, release the fader.
   The system stops recording (but keeps playing) and the fader snaps back to the level in the Timeline.
   When the track is in Latch mode, the system continues to record audio volume information after you release the fader.
5. (Option) Press the Latch Mode button to stop recording and snap the button back to its current Timeline position.

Using Mbox Family Audio Devices

You can use the Mbox® family of audio input/output hardware as external audio devices for your Avid editing application. This means you can use the Mbox devices to record source audio and to monitor output audio.

When you attach the Mbox device to your Avid editing system, all of its audio input and output connections are live. If you use a video input/output hardware device, you can use a Mbox device with either a USB or an IEEE 1394 (FireWire) connection. (For more information on using an input/output device with a 1394 connection, see “Selecting a DV Device” on page 243.) The Mbox device and the video I/O device remain as two separate audio sub-systems. They are not combined to increase the number of available audio channels. For audio input/output, the system creates a list of input options based on the audio devices that are present — for example, Mbox Mic/Line, Mbox S/PDIF, or Host 1394.

The following table lists some of the features of the Mbox 2 and the Mbox (3rd Generation) family of audio devices.

<table>
<thead>
<tr>
<th>Device</th>
<th>Connection Type</th>
<th>Input/Output Types</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mbox 2</td>
<td>USB</td>
<td>Analog, S/PDIF, MIDI</td>
</tr>
<tr>
<td>Mbox 2 Pro</td>
<td>1394</td>
<td>Analog, S/PDIF, MIDI, Word Clock In</td>
</tr>
</tbody>
</table>
Using Mbox Family Audio Devices

Mbox (3rd Generation) devices support audio sample rates up to 96 KHz. For a full description of MBox specifications, see the documentation that came with your device.

For a list of currently supported Mbox devices, see the ReadMe for your Avid editing application.

<table>
<thead>
<tr>
<th>Device</th>
<th>Connection Type</th>
<th>Input/Output Types</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mbox 2 Mini</td>
<td>USB</td>
<td>Analog</td>
</tr>
<tr>
<td>Mbox 2 Micro</td>
<td>USB</td>
<td>Analog (monitor audio only; no input/output available)</td>
</tr>
<tr>
<td>Mbox (3rd Generation)</td>
<td>USB</td>
<td>Analog, S/PDIF, MIDI</td>
</tr>
<tr>
<td>Mbox Pro (3rd Generation)</td>
<td>1394</td>
<td>Analog, S/PDIF, MIDI, Word Clock In</td>
</tr>
<tr>
<td>Mbox Mini (3rd Generation)</td>
<td>USB</td>
<td>Analog</td>
</tr>
</tbody>
</table>

(Macintosh only) S/PDIF inputs appear in the Capture tool as Tracks 3-4.

To select the Mbox device in the Audio Project Settings dialog box.

1. Connect the Mbox device to your Avid editing system.
2. Start your Avid editing application.
3. Click the Settings tab in the Project window.
   - The Audio Project Settings dialog box opens.
5. Click the Hardware tab.
6. Click the Peripheral menu, and then select your Mbox device.

7. Close the Audio Project Settings dialog box.

Once you configure the Mbox device, you can select the audio input interface in the Capture tool and the Audio Punch-in tool. For more information, see “Preparing to Capture Audio” on page 207 and “Recording Voice-Over Narration” on page 854.

You can also use your device to monitor output audio by connecting headphones or speakers to the Mbox device.

**Setting Up the Mbox Pro for Passthrough Monitoring (Windows Only)**

If you use the Mbox Pro to monitor source audio, you must set the source for your headphone output in the Mbox Pro Control Panel to Stereo Mix 1. This allows you to monitor audio with your Avid editing application using the Passthrough Mix tool.

**To set your Mbox Pro to monitor passthrough audio:**

1. Make sure your Avid editing application is not running.

2. Click the Start button, and select Control Panel.

3. Do one of the following:

   - **(Windows 7)** If the View by menu is set to Category, click Hardware and Sound, and then click Avid Mbox Pro.
   - **(Windows 7)** If the View by menu is set to Large icons or to Small icons, click Avid Mbox Pro.
(Windows XP) Click Avid Mbox Pro.
The Mbox Pro Control Panel opens.

4. Select your headphone output, and then click the Audio Source menu and select Stereo Mix 1.
5. Close the Mbox Pro Control Panel.

### Configuring USB-to-MIDI Software for External Controllers

If your fader controller uses USB-to-MIDI software, you can install and configure the software to recognize your fader controller once you have connected a fader controller to your Avid editing system.

For information on connecting your controller and installing USB-to-MIDI software, see the instructions that came with your controller.
Testing External Fader Controller Connections

To test the external fader controller connections:

1. Connect all MIDI hardware devices.
   MIDI port A is the default port used by the Avid system. To change the port configuration, see “Switching Between MIDI Connections on the USB-to-MIDI Converter” on page 884.

2. Move the sliders on the fader controller, and confirm that the MIDI In LED indicator on the USB-to-MIDI converter turns on and off appropriately.
   The USB LED indicator pulses — this is expected behavior.

3. Start your Avid editing application, and open the Project window.

4. Click the Settings tab and double-click Controller Settings.
   The Controller Settings dialog box opens.

5. Choose the appropriate port for the device from the Gain Controller menu.

6. Click OK.

7. Select Tools > Audio Mixer.

8. Do one of the following:
   ▶  Click and hold the Audio Mixer Mode button and select Automation Mode from the menu.
   ▶  Click the Audio Mixer Mode button and cycle through the Audio Mix mode settings to the Automation Mode setting.

9. Click the Audio Mixer Tool Fast Menu button, and select Calibrate Hardware Sliders.
   If the external fader controller is connected and the system is using the correct MIDI port, then the Audio Mixer tool displays the following:
   - At least one of the position indicator lights is on (blue).
   - The Recording Status Light changes to gold.

10. If the lights do not change to blue, see “Troubleshooting MIDI Connections” on page 884.
11. To disable the hardware calibration, click the Audio Mixer Tool Fast Menu button, and select Calibrate Hardware Sliders.
   The Recording Status Light changes to black.

12. Move the sliders on the external fader controller.
   The corresponding sliders move in the Audio Mixer tool.
   Now you are ready to use the fader controller with your Avid editing application. For more information on using the Audio Mixer tool, see “Using Volume and Pan Automation” on page 813.

Switching Between MIDI Connections on the USB-to-MIDI Converter

If you need to switch to a different MIDI port connection, change the hardware connections and then make the appropriate change in the Controller Settings dialog box.

To change the MIDI port connection in your Avid editing application:

1. Click the Settings tab in the Project window.
2. Double-click Controller Settings.
   The Controller Settings dialog box opens.
3. Select the correct MIDI port from the Gain Controller menu.
4. Click OK.
5. Select Tools > Audio Mixer.
6. Do one of the following:
   ▶ Click and hold the Audio Mixer Mode button and select Automation Mode from the menu.
   ▶ Click the Audio Mixer Mode button and cycle through the Audio Mix mode settings to the Automation Mode setting.

   If the fader or mixer is on and correctly configured, the indicator lights on the Audio Mixer tool should change to blue. If the lights do not change to blue, see “Troubleshooting MIDI Connections” on page 884.

Troubleshooting MIDI Connections

Do the following if the Audio Mixer tool does not respond to the external fader controller:

1. Make sure the MIDI hardware devices are connected and configured.
   For more information, see the documentation that came with your fader controller.
2. Check that the MIDI cable connections are correct. Check that the cables are connected from Out to In and from In to Out.
3. Check the Controller Settings dialog box in the Settings list of the Project window. Verify that the correct Gain Controller port is selected.

4. (Macintosh only) Use the Apple System Profiler to check whether the system is recognizing the MIDI device:
   a. Select Apple menu > About This Mac.
   b. Click More Information.
      The Apple System Profiler opens.
   c. Click the Devices and Volumes tab.
      The USB Information portion of the display identifies the USB devices that the system recognizes. The system might not display the name of each device, but the number of USB devices should match the number of devices you have connected to the system.

**Avid HD Native and Pro Tools|HD Hardware Configuration for Avid Editing Systems**

Avid Pro Tools v8.5 and later supports HD Native audio hardware, and Pro Tools v9.0 and later supports both HD Native and Pro Tools|HD hardware. If you install your Avid editing application on a system with Pro Tools HD, you can use the same audio hardware for both applications. The supported versions of Avid Pro Tools installs the necessary audio drivers.

Not all versions of Avid editing applications are compatible with Pro Tools|HD and HD Native hardware. For up-to-date information on co-installation and supported configurations, see the ReadMe for your Avid editing application.

If you use 3rd party hardware or if you have Avid DX hardware installed with your system, you cannot access Pro Tools|HD or HD Native hardware. You can use this hardware in a software-only Avid editing system or with supported Avid hardware in 1394 mode.

*Pro Tools|HD and HD Native audio hardware is supported only in some co-installation configurations, and for Pro Tools v9.0 the HD hardware is supported only on Macintosh systems and 32-bit Windows systems. For more information about co-installation, see the ReadMe documentation that came with your Avid editing application.*
With Pro Tools|HD or HD Native hardware installed on a supported Avid editing system, you can perform the following:

- Play back audio through up to 8 audio outputs. You can also play back audio with a SYNC HD or SYNC I/O device connected. The Avid editing application does not control the clock settings for these devices.
- If you have multiple audio interfaces connected (“daisy-chained”) to your Pro Tools|HD or HD Native card, the playback defaults to outputs 1 and 2 of the first device.
- The Avid editing application can input and output audio up to 48 kHz with HD or Native hardware.

To set up your system to use Pro Tools|HD or HD Native hardware with your Avid editing application, see the following topics:

- “Configuring the ASIO Driver (Windows)” on page 886
- “Configuring the Core Audio Driver (Macintosh)” on page 888

**Configuring the ASIO Driver (Windows)**

You can configure the ASIO driver settings by using the ASIO Control Panel, which you access from the Audio Project Settings dialog box.

**To configure the ASIO driver:**

1. In the Avid editing application, click the Settings tab in the Project window.
2. Double-click Audio Project in the Settings list.
   
   The Audio Project Settings dialog box opens.
3. Click the Hardware tab.
4. Click the Control Panel button. The ASIO Control Panel opens.

5. (Optional) Click the Buffer Size menu and select a buffer size. Generally, smaller buffer sizes are preferable. However, if you experience any problems with performance (such as clicks and pops during recording or playback), try increasing the Buffer Size setting.

6. Click the Device menu and select the audio device connected to your Pro Tools|HD or HD Native hardware.

7. Click Advanced. The Hardware Setup dialog box opens.
8. Select the options you want for your audio input/output operations. For more information on the settings in the Hardware Setup dialog box, see the user guide that came with your Pro Tools system.

Your Avid editing application uses only 8 channels of audio output. Also, the application controls the audio sample rate, not your Pro Tools|HD or HD Native hardware.

9. Click OK to close the Hardware Setup dialog box.

10. Click OK to close the ASIO Control Panel.

Once you configure the audio device, you can use your device to monitor output audio by connecting headphones or speakers to the audio device.

11. Close the Audio Project Settings dialog box.

**Configuring the Core Audio Driver (Macintosh)**

You can configure the Core Audio driver using the Avid Core Audio Manager application. The Core Audio Manager application launches automatically the first time your Avid editing application accesses the Core Audio driver — for example, the first time you play audio on a system with an HD Native or Pro Tools|HD card installed. If the Core Audio Manager icon is hidden when first launched, click the icon in the dock.

Use Core Audio Manager to change the Core Audio Buffer Size setting and control volume and mute for the Core Audio Driver. Core Audio Manager also identifies your audio hardware, the supported number of input and output channels and the number of attached clients (applications).
To configure the CoreAudio driver:

1. Do one of the following:
   - If your Avid editing application is running and you have an audio sequence loaded in the Source/Record monitor, click Play and then click the CoreAudio Manager icon in the dock.
   - Double-click the CoreAudio Manager file (located in /Applications/Digidesign/).

   The CoreAudio Manager opens.

2. (Optional) Click the Buffer Size menu and select a buffer size.
   Generally, smaller buffer sizes are preferable. However, if you experience any problems with performance (such as clicks and pops during recording or playback), try increasing the CoreAudio Buffer Size setting. You can also change the buffer size from within the Avid editing application if it is the only client attached to the CoreAudio Driver.

3. Click HW Setup.

   The Hardware Setup dialog box opens.
4. Select the options you want for your audio input/output operations. For more information on the settings in the Hardware Setup dialog box, see the user guide that came with your Pro Tools system.

Your Avid editing application uses only 8 channels of audio output. Also, the application controls the audio sample rate, not your Pro Tools|HD or HD Native hardware.

5. Click OK to close the Hardware Setup dialog box.

Once you configure the audio device, you can use your device to monitor output audio by connecting headphones or speakers to the audio device.

6. If your Avid editing application is not running, you can click Quit to close the CoreAudio Manager.

If the Avid editing application connected to the CoreAudio Manager is running when you quit the Manager, you might receive an error message and lose your connection to the Pro Tools hardware.

7. Close the Audio Project Settings dialog box.

Using a GPI Device with the Audio Punch-In Tool

Your Avid editing application can send signals to a V-LAN® VLX®i® deck controller and a general-purpose interface (GPI) device that trigger GPI actions. These signals are sent when playback begins and ends, and also when recording with the Audio Punch-In tool begins and ends.
Using a GPI Device with the Audio Punch-In Tool

If you have a V-LAN VLXi deck controller and a GPI device connected to your Avid system and they are configured correctly, you can use the GPI to control additional external hardware while you are working with the Audio Punch-In tool. For example, you might want to control an indicator light in a recording studio to provide a visual cue for performers or a control light outside the studio that indicates when recording is in progress.

To make use of this feature, you must:

- Understand when your Avid editing application sends GPI trigger signals. For more information, see “Understanding GPI Trigger Signals” on page 891.
- Connect a V-LAN VLXi deck controller and a VLXi-GT GPI to your Avid system. For more information, see “Connecting a V-LAN VLXi Controller and GPI” on page 892.
- Configure the V-LAN VLXi deck controller and the GPI. For more information, see “Configuring a V-LAN VLXi Controller and GPI” on page 893.
- Create GPI settings for your specific needs. For more information, see “Working with GPI Settings” on page 894.

**Understanding GPI Trigger Signals**

Your Avid editing application sends three different GPI trigger signals under the following circumstances:

<table>
<thead>
<tr>
<th>Trigger Signal Sent</th>
<th>When</th>
</tr>
</thead>
<tbody>
<tr>
<td>Play Out</td>
<td>Playback begins. Recording with the Audio Punch-In tool ends but playback continues because a postroll value is set in the Audio Punch-In tool (that is, the signal is sent when the Stop button in the Audio Punch-In tool changes to blue).</td>
</tr>
<tr>
<td>Record Out</td>
<td>Recording with the Audio Punch-In tool begins.</td>
</tr>
<tr>
<td>Stop Out</td>
<td>Playback stops.</td>
</tr>
</tbody>
</table>

For more information on using the Audio Punch-In tool, see “Recording Voice-Over Narration Using Audio Punch-in” on page 859.

**GPI Signal Sequences**

GPI signal sequences differ, depending on whether or not you are using the Audio Punch-In tool with preroll and postroll.
When you use the Audio Punch-In tool without any preroll or postroll, the following occurs:

- Record Out is sent when recording begins.
- Stop Out is sent when recording (and playback) ends.

When you use the Audio Punch-In tool with preroll and postroll, the following occurs:

- Play Out is sent when preroll begins (the position indicator begins moving in the Timeline, and the Play In/Out button in the Audio Punch-In tool blinks green).
- Record Out is sent when recording begins (the Record button in the Audio Punch-In tool blinks red).
- Play Out is sent when recording ends and postroll begins (the Stop button in the Audio Punch-In tool changes to blue).
- Stop Out is sent when postroll ends (the position indicator stops moving).

*Record Out and Play Out repeat if you perform additional recordings.*

**Example of Linking GPI Actions to Trigger Signals**

You can configure the GPI to respond to each signal sent by your Avid editing application in a specific manner. For a simple indicator light, you might create a GPI setting linking the Record Out signal from your Avid editing application to the GPI Set action (to turn the light on) and a setting linking the Stop Out signal from your Avid editing application to the GPI Reset action (to turn the light off).

For information on GPI actions, see “Working with GPI Settings” on page 894.

If you are working with preroll and postroll values, you might also link the Play Out signal to the GPI’s Pulse action to flash the light on and off repeatedly during the preroll and postroll periods. (Since the Pulse action does not switch between on and off very rapidly, your preroll and postroll durations might need to be quite long to allow for the light to flash enough times to be meaningful.)

For more information on configuring the GPI, see “Configuring a V-LAN VLXi Controller and GPI” on page 893.

**Connecting a V-LAN VLXi Controller and GPI**

The V-LAN VLXi controller and VLXi-GT GPI connect to your Avid system through a direct serial connection as shown in the following illustration.
Using a GPI Device with the Audio Punch-In Tool

You must configure the V-LAN VLXi controller to work with the VLXi-GT GPI. Assign the VLXi-GT to a V-LAN node address between 16 and 19. LAN connections of more than 50 feet (15.24 meters) must have a terminator. For more information on configuring the V-LAN, see the Videomedia VLXi User’s Guide.

Configuring a V-LAN VLXi Controller and GPI

Once you have connected a V-LAN VLXi controller and VLXi-GT GPI to your Avid system, you can configure the system to communicate with the controller and the GPI, and create GPI settings appropriate to your needs. For more information on creating settings, see “Working with GPI Settings” on page 894.

To configure the V-LAN VLXi controller and the VLXi-GT GPI:

1. In the Project window, double-click Deck Configuration.
   The Deck Configuration dialog box opens.
2. Click Add Channel.
3. Click the Channel Type menu, and select VLAN VLX.
4. Click the Port menu, and select the serial port to which the V-LAN VLXi is connected.
5. Click OK.
   The Autoconfigure message box opens.
6. Click Yes.
   The connected GPI is automatically detected and appears in the Deck Configuration dialog box.

**Working with GPI Settings**

You must create a separate GPI setting for each trigger signal you want the GPI to recognize. For example, you would need one setting for the Record Out signal and another for the Stop Out signal.

You might also create GPI settings for other control purposes, such as starting and stopping capture.

You can also edit an existing GPI setting or delete a GPI setting so that it no longer appears as an option in the GPI Settings dialog box.

**To create a GPI setting:**

1. In the Project window, double-click Deck Configuration.
   The Deck Configuration dialog box opens.
2. Double-click the VLXi-GT text box.
   The GPI Settings dialog box opens.
3. Select the appropriate settings.
   For more information about GPI settings option, see “GPI Settings Options” on page 895.
4. Click Add.
   The GPI Node Settings dialog box opens.
5. Select the appropriate settings.
   For more information about GPI Node settings option, see “GPI Settings Options” on page 895.
6. Click OK.
   The GPI Settings dialog box opens.
7. Click OK to set the GPI.
8. Click Apply in the Deck Configuration dialog box.
To edit a GPI setting:
1. In the Project window, double-click Deck Configuration.
   The Deck Configuration dialog box opens.
2. Click the VLXi-GT text box.
3. Select the name of the GPI you want to edit.
4. Click Edit.
5. Make the applicable changes to the setting.
6. Click OK.
7. Click Apply.
   The GPI setting is updated.

To delete a GPI setting:
1. In the Project window, double-click Deck Configuration.
   The Deck Configuration dialog box opens.
2. Click the VLXi-GT text box.
3. Select the name of the GPI you want to delete.
4. Click Delete.
5. Click OK.
6. Click Apply.
   The GPI setting is deleted.

GPI Settings Options

The following tables describe the GPI settings and GPI Node settings options.

<table>
<thead>
<tr>
<th>GPI Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Keep the default V-LAN VLXi name, or type a new name.</td>
</tr>
<tr>
<td>Description</td>
<td>(Option) Add a description of the GPI trigger.</td>
</tr>
<tr>
<td>Device Type</td>
<td>Select V-LAN, which is the Avid-supported device type.</td>
</tr>
<tr>
<td>Address</td>
<td>Select the V-LAN network address to which the VLXi-GT is assigned. Valid addresses on the V-LAN network are 16 through 19. This address must match the internal V-LAN address.</td>
</tr>
</tbody>
</table>
### GPI Option Description

<table>
<thead>
<tr>
<th>GPI Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pulse Duration</td>
<td>Leave this setting at its default value; it does not alter the length of the Pulse action in the GPI.</td>
</tr>
<tr>
<td>GPI Control Enable</td>
<td>When you deselect this option, you disable the GPI but keep the GPI settings. This is useful for troubleshooting purposes.</td>
</tr>
<tr>
<td>Edit</td>
<td>Click to edit an existing GPI node setting.</td>
</tr>
<tr>
<td>Delete</td>
<td>Click to delete an existing GPI node setting.</td>
</tr>
<tr>
<td>Add</td>
<td>Click to add another GPI node setting.</td>
</tr>
</tbody>
</table>

### GPI Node Option Description

<table>
<thead>
<tr>
<th>GPI Node Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Function</td>
<td>Select one of the three active functions:</td>
</tr>
<tr>
<td></td>
<td>• Record Out</td>
</tr>
<tr>
<td></td>
<td>• Play Out</td>
</tr>
<tr>
<td></td>
<td>• Stop Out</td>
</tr>
<tr>
<td></td>
<td>Seven options are listed, but only the three signals described in “Understanding GPI Trigger Signals” on page 891 are active.</td>
</tr>
<tr>
<td>Function</td>
<td>Select a function for a particular node:</td>
</tr>
<tr>
<td></td>
<td>• Capture in (Satellite mode)</td>
</tr>
<tr>
<td></td>
<td>• Play in</td>
</tr>
<tr>
<td></td>
<td>• Cue to first frame</td>
</tr>
<tr>
<td></td>
<td>• Stop in</td>
</tr>
<tr>
<td></td>
<td>• Capture out (Satellite mode)</td>
</tr>
<tr>
<td></td>
<td>• Play out</td>
</tr>
<tr>
<td></td>
<td>• Stop out</td>
</tr>
<tr>
<td>Node</td>
<td>Click the Node menu, and select a node. Nodes 1 through 6 correspond to the physical connectors on the back of the VLXi-GT GPI device.</td>
</tr>
<tr>
<td>Action</td>
<td>Select an action:</td>
</tr>
<tr>
<td></td>
<td>• <em>Set</em> activates a command.</td>
</tr>
<tr>
<td></td>
<td>• <em>Reset</em> deactivates a command.</td>
</tr>
<tr>
<td></td>
<td>• <em>Pulse</em> switches the state between active and inactive.</td>
</tr>
</tbody>
</table>
Using Avid Artist Series Controllers

This section includes topics that provide information on configuring and using the Avid Artist Series controllers with your Avid editing application: Avid Artist Control, Avid Artist Transport, and Avid Artist Mix. These controllers employ the EUCON™ (Extended User Control) protocol, which allows for integrated control of your Avid editing application and EUCON-compatible devices. You can use the controllers with your Avid editing application to perform audio navigation and transport functions, as well as some video and audio editing features such as recording volume automation.

- Installing EuControl Software
- Configuring Avid Artist Series Controller Settings
- Configuring Ethernet Connections (Macintosh)
- Setting the IP Address
- Configuring EuControl Settings
- Artist Series Controller Button Mappings
- Customizing Avid Artist Series Controls
- Moving Through Footage with Artist Series Controllers
- Volume Automation and Pan on Artist Series Controllers
- Recording Volume Automation and Pan with Artist Series Controllers
- Using the Latch Mode Feature on Artist Series Controllers
- Using the Artist Series Controller for Editing Media
- Controller Application Sets

Installing EuControl Software

The EuControl application controls your Artist Series controller and communicates with your Avid editing application. You must install EuControl before you use any Artist Series controller.
If you want to connect your Artist Series controller to an Avid editing system that is part of an Avid ISIS shared storage environment, the following requirements apply:

- (Macintosh only) Avid recommends that you connect your Artist Series controller to the built-in Ethernet 1 port on your Macintosh system. If you have limits to the number of Ethernet connections you use — for a corporate network or for shared storage — you might need to set the service order for your Artist Series controller to a lower priority than your other Ethernet connection. For more information on configuring your Ethernet connections, see “Configuring Ethernet Connections (Macintosh)” on page 900. You can change port assignments in the EuControl Settings application if necessary.

- Avid also recommends that you disable the network interface you use for your Artist Series controller in the ISIS Client Manager preferences. This prevents ISIS from trying to use the Ethernet port assigned to EUCON for your shared storage operations. For more information, see the Avid ISIS Client Guide that came with your ISIS product.

- Avid ISIS supports dual Ethernet connections to maximize bandwidth use and increase performance. Since your Artist Series controller must use one Ethernet port to connect to your Avid editing system, Avid does not support dual connection on Macintosh systems connected to an ISIS switch.

- Artist Series controllers do not support connection through a third-party Ethernet card.

**To install EuControl:**

1. Do one of the following:
   - If you downloaded the latest software from the Avid Web site, double-click the installer.
   - Insert the installation CD into your system, and double-click the installer.

2. Follow the on-screen instructions to install the software.

   *Download the most current version of EuControl if prompted to do so during installation.*

   When installation completes, EuControl launches automatically.

3. You should check for updated firmware for your Artist Series controller by doing the following:
   a. Do one of the following:
      - (Windows) Double-click the EUCON icon in the notification area.
EUCON icon in the notification area

- (Macintosh) Click the EUCON icon in the dock, and then select Window > EuControl Settings.

The EuControl Settings dialog box opens.

b. Click the Surfaces tab, and then click Update Firmware.

If there is updated firmware for your Artist Series controller, EuControl automatically downloads it.

c. Follow the on-screen instructions to install the new firmware.

4. Shut down your system.

5. Connect your Artist Series controller. For information on setting up your Artist Series controller, see the documentation that came with your equipment.

Configuring Avid Artist Series Controller Settings

You use the Controller Settings dialog box to configure your Avid editing application so that it can communicate with your Artist Series controllers.
To configure your Avid editing application for an Artist Series controller:

1. Double-click Controller Settings in the Settings list of the Project window.
   The Controller Settings dialog box opens.
   
   ![Controller Settings dialog box]

   2. Select Controller > EUCON Controller.
   3. Click OK.

### Configuring Ethernet Connections (Macintosh)

You can connect your Artist Series controller to either the Ethernet 1 or Ethernet 2 port on your Macintosh system. By default, the EuControl application is configured to use Ethernet 1. You might need to change this configuration if your system connects to a corporate network or if it is part of a shared storage environment — for example, if you connect your Macintosh system to an Avid ISIS system.

The following procedure describes how to configure your network connections if you need to reserve one Ethernet port for a network or shared storage connection. You can use either Ethernet port for your Artist Series controller, but you should set the network priority for your network or storage connection higher than the priority for your Artist Series controller.

To configure Ethernet ports on a Macintosh system:

1. Connect your Artist Series controller to either the Ethernet 1 or Ethernet 2 port on your Macintosh system.
2. Select the Apple menu > System Preferences.
3. In the Other area, click Euphonix.

   The Euphonix dialog box opens.
4. Click the Network Interfaces menu and select either Ethernet 1 or Ethernet 2, depending on which Ethernet port you want to use for your Artist Series controller.

5. Close the Euphonix dialog box.

6. Select the Apple menu > System Preferences.

7. In the Internet & Wireless area, click Network.

   The Network dialog box opens.

8. Click the Action menu and select Set Service Order.

   The Service Order dialog box opens.

9. If the Ethernet connection you want to use for your corporate network or shared storage connection is not at the top of the network connections list, select that Ethernet connection and drag it to the top of the list. For more information on setting the service order, see the Apple Help for your Macintosh system.

10. Click Apply, and then close the Network dialog box.

---

**Setting the IP Address**

Avid Artist Series controllers typically use Dynamic Host Configuration Protocol (DHCP) to obtain its IP address, usually from a router. The controllers revert to link-local addressing to generate an IP address if a DHCP server is not found on the network — for example, when you
connect a controller to a system using an Ethernet cable. You can override these methods of obtaining IP addresses by supplying a static IP address, which the devices use in all cases when turned on.

Avid does not recommend setting up static IP addresses unless you have experience in configuring network properties.

**To set a static IP address (Avid Artist Control):**

1. Press and hold the Page Left and Page Right keys while you press and release the Power button.

   The Network Setup screen appears on the Touchscreen.

2. Touch Use DHCP (Obtain IP Address automatically).

   The parameter is deselected, and the Touchscreen displays the IP Address and Subnet Mask fields.
3. Touch the first box of the IP Address field to select it, and then adjust its value by turning any of the eight knobs or the Jog wheel.

4. Repeat the previous step to adjust all values of the IP Address and the Subnet Mask fields.

5. Touch OK to save this static IP address. Turn off the controller and then turn it on to use the new IP address.

You can touch Cancel at any time to discard changes made to the IP address.

**To set a static IP address (Avid Artist Transport):**

1. Press and hold the two soft keys on the left while you press and release the Power button. Hold down the soft keys until the Use DHCP screen appears in the display.

2. Turn the Jog wheel clockwise to change the Use DHCP value from yes (default) to no.

   You can use the + (plus) and – (minus) keys instead of the Jog wheel to decrease or increase the value, respectively.

3. Press the Enter key to move the cursor to the next screen.

4. Do one of the following:
   - Use the Jog wheel to set the value of the IP Address field.
   - Press the + (plus) key or the – (minus) key on the numeric keypad to increment or decrement the value. You can also use the numeric keypad to enter the number directly.

5. Repeat step 3 and step 4 to adjust all values of the IP Address and the Subnet Mask fields.

   You can press the Enter key to move the cursor forward until the first screen reappears to change a parameter to a different value.

6. Press the two soft keys on the left at the same time to save this static IP address. Turn off the controller and then turn it on to use the new IP address.

   You can discard changes made to the IP address at any time by turning off the controller before saving your changes.
To set a static IP address (Avid Artist Mix):

1. Press and hold the Page Left and Page Right keys while you press and release the Power button.

   The Use DHCP screen appears in the channel display for fader strip 1.

2. Turn the knob underneath the display clockwise to change the Use DHCP value from yes (default) to no.

   You can use the SEL and ON keys instead of the knob to decrease or increase the value, respectively.

3. Press the Page Right key or the Top key to move the cursor to the next screen.

4. Use the knob to set the value of the IP Address field.

5. Repeat step 3 and step 4 to adjust all values of the IP Address and the Subnet Mask fields.

   You can press the Page Left key to move the cursor back to the previous field or screen to change a parameter to a different value.

6. Press the Page Left and Page Right keys at the same time to save this static IP address. Turn off the controller and then turn it on to use the new IP address.

   You can discard changes made to the IP address at any time by turning off the controller before saving your changes.

Configuring EuControl Settings

Before you can use an Artist Series controller with your Avid editing application, you must configure the EuControl settings. You can connect your Artist Series controller to the EuControl application on your system so you can use it as a controller, connect additional workstations so they can access the controllers, and assign functions to buttons and keys on the Artist Series controller.
The EuControl application starts when you start your computer and runs in the background. Avid recommends that you make sure EuControl is running before you start your Avid editing application.

For a full description of configuration procedures and options, see the documentation that came with your Artist Series controller.

**To connect an Artist Series controller to your system:***

1. Connect your Artist Series controller to your system and turn on the power for the device.
2. Start your Avid editing application.
3. Do one of the following:
   - (Windows) Double-click the EUCON icon in the notification area.
   - (Macintosh) Click the EUCON icon in the dock, and then select Window > EuControl Settings.

   EuControl Settings application opens. The All Surfaces list displays all available Artist Series controllers.
4. Click the Automatically add: menu, and select one of the following:

- To add all controllers listed in the All Surfaces list — which lists all devices available on your subnet — select All Surfaces. This setting is useful when you are the only person running EuControl on your network.

- To add only those controllers listed in the My Surfaces, select My Surfaces Only. Since only one user at a time can control a surface, this avoids claiming surfaces needed by other users on your network.

The selected devices are connected to EuControl.

5. (Option) If you select My Surfaces Only and you want to specify additional controllers to connect to your EuControl application, select a controller in the All Surfaces list, and then click Add.

The controller appears in the My Surfaces list. You can rearrange the order of the controllers using the up and down arrows, and you can remove controllers from the list using the Remove button. You can also rename the controller, which allows you to easily identify multiple controllers in the My Surfaces list.

6. Click the Workstation tab.

The Workstations tab opens. The All Workstations list displays all systems on your subnet that have been configured for access to the available Artist Series controllers.
7. (Option) If you want more than one workstation to access your Artist Series controllers, do the following:
   a. Select the workstation in the All Workstations list and click Add.
   b. Select the workstation in the My Workstations list and click Attach.

   A check mark appears in the Attached column in the My Workstations list. The workstation can now access the Artist Series controllers connected to EuControl.

8. Close the EuControl Settings application.

**Artist Series Controller Button Mappings**

When EuControl opens for the first time, it includes a set of default Avid editing functions mapped to the Artist Series controller buttons (the default mappings are called the “application set”). For a full list of the default application sets used with Avid editing applications, see “Controller Application Sets” on page 917. To modify the button mappings, see “Customizing Avid Artist Series Controls” on page 909.

The Soft Keys tab controls Surface, Wheel, and Touchscreen soft key assignments. With Artist Series controllers that include a Touchscreen, you can access the Surface soft keys with the circular buttons below the Touchscreen, and you can access the Touchscreen soft keys with the Soft Keys Setup Touchscreen.

*The mappings included in the Soft Keys tab apply only to Artist Control and Artist Transport.*
Artist Control and Artist Transport can control multiple applications, each with its own soft key assignments. Since the EuControl application responds dynamically as you move between applications, soft key assignments might change in the Soft Keys tab as the active application changes. Changing the focus to the desired application and then to the EuControl application restores the current assignments. You can save your soft key assignments at any time while using EUCON.

*Be sure to check that the proper application is active before you click Save, Restore, or Revert.*

The Soft Keys tab displays the name of the active application above the option menus and the soft key assignments.

![EuControl Settings](image)

EuControl Settings: active application, option menus, soft key display buttons

The default EuControl button mappings include the following:

- **Surface** — The Surface keys control the functions assigned to the 12 buttons located below the Touchscreen on Artist Control. The Surface section organizes the buttons in 6 pages. You can click the Page menu to select a different set of commands.

- **Touchscreen** — The Touchscreen keys control the keys displayed on the Soft Keys Setup Touchscreen on Artist Control. The Touchscreen section organizes the buttons in 6 pages.

- **Wheel** — The Wheel keys control the keys displayed above the Jog and Shuttle wheels on the Artist Control and Artist Transport.
Customizing Avid Artist Series Controls

You can modify the default Soft Key functions of the controls on your Artist Series controller by mapping them to buttons and keyboard shortcuts in your Avid editing application. You can also add custom key sequences, EUCON commands, pages to the surface controls or the touchscreen, and jog and shuttle wheel functions for some devices.

The following procedure provides a generic description of how to customize your controller. For a full description of the customizations available, see the documentation that came with your Artist Series controller.

To change a function in the Artist Series controls:
1. In the EuControl application, click the Soft Keys tab.
2. Click the Section menu, and select one of the following:
   - Surface
   - Touchscreen
   - Numpad
   - TU Softkeys
   - TU Wheel

   The Soft Keys tab displays the existing controls for the selected section.

The Artist Transport controls for the Touchscreen.
3. Do one of the following:
   - Select a button whose function you want to customize, and click Command.
   - Double-click a button whose function you want to customize.

   The Soft Key Command Editor opens.

4. Specify the action you want to associate with the control button.
   - The Soft Key Command Editor organizes the default commands as they appear in the Command palette or in menus.

5. Close the Soft Key Command Editor.
   - The Soft Key tab updates and displays the new function.

6. Click Save.

7. Close the EuControl Settings application.

To add a function to the Artist Series controls:

1. In the EuControl application, click the Soft Keys tab.

2. Click the Section menu, and select one of the following:
   - Surface
   - Touchscreen
   - Numpad
   - TU Softkeys
   - TU Wheel

   The Soft Keys tab displays the existing controls for the selected section.
Customizing Avid Artist Series Controls

3. If the display does not include any blank keys, click the Page menu and select a new page. You can also click the Add button to add a new page.

4. Do one of the following:
   - Select a blank key and click Command.
   - Double-click a blank key.

   The Soft Key Command Editor dialog opens.

5. Click Add and select one of the following:
   - Key
- EuCon
- Page
- MC
- Wheel

6. In the Details column, select the function you want to associate with the new soft key. EUCON commands automatically label the button but do not select an icon.

7. Close the Soft Key Command Editor.

The Soft Key tab updates and displays the new function.

**Moving Through Footage with Artist Series Controllers**

You can use your Artist Series controller to control how you move through footage. Depending on the functions available on your controller and the default and customizable controls, you can use the following methods:

- The Jog wheel allows for frame-by-frame positioning, depending on how fast you turn the wheel right (clockwise) or left (counterclockwise). Use the Jog wheel when you want to locate a specific frame by slowly viewing footage.

  You can modify the sensitivity of the Jog wheel and the Shuttle ring by adjusting parameters in the EuControl application — for example, you can set the Jog wheel to step through your footage frame by frame. For more information, see the user’s guide that came with your controller.

- The Shuttle ring alters the speed of playback by how far you turn the ring. The more you turn the ring to the right, the faster the footage moves forward. To move the footage in reverse, turn the ring to the left of the midpoint position. When held in position, footage continues to moves at a fixed rate. When you release the Shuttle ring, it automatically returns to its center position and footage stops changing. Use the Shuttle ring when you want to quickly scan footage.

- The Transport Controls allow you to play, pause, rewind, and fast forward in your sequence.

- You can use the Rewind, Pause, and Fast Forward keys on your Artist Series controller to move through your footage as you do with J-K-L play in your Avid editing application. For more information on using the J-K-L keys, see “Playing Footage with the J-K-L Keys (Three-Button Play)” in the Help.
The track selection buttons on your Artist Series controller allow you to select and deselect tracks in the Timeline. Selecting tracks in the Timeline or in the Audio Mixer tool updates the track selection display in your Artist Series controller.

You can solo and mute tracks on your Artist Series controller to isolate tracks as you monitor the audio playback. Using the solo and mute buttons on your Artist Series controller automatically updates the display in the Track Control panel and the Audio Mixer tool in your Avid editing application. You can use these buttons during playback.

Some commands only apply to specific windows in your Avid editing application. You might need to click the appropriate window — for example, the Timeline — before you can perform a specific function. For more information on moving through footage, see the documentation that came with your Artist Series controller.

Volume Automation and Pan on Artist Series Controllers

Some Artist Series controllers provide fader strips, each with a touch-sensitive fader, that control audio tracks for recording gain. Faders control assigned tracks and reflect changes made in the audio track properties, such as volume automation. Some Artist Series controllers also provide pan soft knobs that control audio tracks for recording pan automation. Pan soft knobs control assigned tracks and reflect changes made in the audio track pan values.

You can use the features available in the Audio Mixer tool to group faders on the Artist Series controller. When the faders for two or more tracks are grouped, the fader sends identical volume or pan messages for the tracks when you move one fader. This can be useful when you want to adjust audio on multiple tracks.

For information on grouping faders, see “Adjusting Clip Volume and Pan for Audio Tracks” on page 798.

Some Artist Series controllers include an On key, which indicates that a specified track is unmuted. Deselecting the On key mutes the track and changes the Mute button in your Avid editing application to orange for the specified track.

A second On button is located next to the faders on Artist Mix controllers. This button currently is not used.

You can also use the Bank and Nudge keys available on some Artist Series controllers to change the track assignments of the faders on the controller if the number of tracks you want to automate gain or pan on exceeds the number of faders on the controller. The Bank button changes track
assignments by the number of available faders — for example, shifting assignments from tracks 1 – 8 to tracks 9 – 16. The Nudge button changes track assignments by one track — for example, shifting assignments from tracks 1 – 8 to tracks 2 – 9.

Artist Mix provides buttons and indicator lights mapped to standard audio editing functions:

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>SEL</td>
<td>Controls and indicates pan recording.</td>
</tr>
<tr>
<td>SOLO</td>
<td>Controls and indicates when a track is set to solo.</td>
</tr>
<tr>
<td>ON</td>
<td>Controls and indicates when a track is unmuted or muted. The indicator is on when the track is not muted.</td>
</tr>
<tr>
<td>REC N</td>
<td>Controls and indicates volume automation recording. The track display indicates the automation state by either an R (Read) or a W (Write).</td>
</tr>
<tr>
<td>Shift + REC/AUTO</td>
<td>Controls and indicates automation mode. Latch mode (the default) is indicated by an unlit LED button; touch mode is indicated by a lit LED.</td>
</tr>
<tr>
<td>SEL Y</td>
<td>Controls and indicates if a track is selected or deselected.</td>
</tr>
</tbody>
</table>

Once you record your gain or pan automation, you can use the Artist Mix or the Artist Control to modify gain or pan values on any audio keyframe selected in the Timeline.

You can disable the faders on your controller by pressing the Shift button and then pressing the Solo button on the left of the control surface. You might find this useful when you do not need to use the faders and you switch between the Source and Record monitors or the Source and Record views in the Timeline. To enable the faders, press the Shift button and the Solo button again.

**Recording Volume Automation and Pan with Artist Series Controllers**

If you record your automation in unlatched mode, releasing the fader returns the gain or pan values to the original values of the audio in your sequence. For information on enabling latch mode, see “Using the Latch Mode Feature on Artist Series Controllers” on page 916.

**To record volume automation and pan information using an Artist Series controller:**

   
   The Audio Mixer tool opens.

2. (Optional) Click the Audio Mixer mode button and cycle through the Audio Mixer mode settings to the mode you want to select.
3. Attach the Artist Series controller to your system. (See “Configuring Avid Artist Series Controller Settings” on page 899.)

The position indicator lights in the Audio Mixer tool change to blue when the fader controller or mixer is on and correctly attached to the system.

4. Click the Timeline Fast Menu button and select Audio Data > Auto Gain or Audio Data > Audio Pan.

5. Move the blue position indicator to the section of audio that you want to adjust and mark In to Out points.

6. Set Preroll and Postroll values, if necessary.

7. Click the Record button to start recording your actions.

8. Listen to the audio and adjust the slider or the pan control on the Artist Series controller for the track.

   The system displays the slider values for the corresponding track in the Audio Mixer tool as you adjust the gain or pan.

9. Click the Record button again to stop recording.

10. Click the Audio Loop Play button to play the clip and test your results.

11. To decrease the number of keyframes, click the Audio Mixer Tool Fast Menu button, and select Filter Volume Automation on Track — In/Out or Filter Pan on Track — In/Out. (Click the Track Selection button for a track to enable Filter Automation.)

12. (Option) If you delete too many keyframes, use the Undo command to restore them.

13. Repeat step 11 until you have decreased the number of keyframes to an acceptable level.

You should remove as many excess keyframes as possible while still maintaining the pan or gain changes.

To change the tracks assigned to faders on the Artist Series controller, do one of the following:

- To move the track assignments to the left or right by the number of available faders, click the Bank Left or Bank Right button.
To move the track assignments to the left or right by one track, click the Nudge Left or Nudge Right button.

**Using the Latch Mode Feature on Artist Series Controllers**

Some Artist Series controllers have an Auto REC button for each track that lets you enable or disable latch mode for recording volume automation and pan information.

When a track is not in latch mode (sometimes called “touch mode”), it automatically stops recording as soon as you release it. When you release the fader, it begins moving again as it follows the volume information in the Timeline.

If you enable latch mode, the controller continues to record gain and pan after you release the fader or pan knob, with the gain and pan values remaining at the last values set during your recording session.

**To use latch mode:**

1. Click the Auto REC button for the appropriate tracks on the controller.
   
   You can click the button before or during a recording session.

2. Set In and Out points, and click the Record button in the Audio Mixer tool.
   
   The system begins playing the section and the faders move accordingly.

3. When you want to make an adjustment, move the fader or pan soft knob to change the volume.
   
   The system immediately begins recording.

4. When you are finished adjusting the section, release the fader or pan soft knob.
   
   When the track is in latch mode, the system continues to record audio volume information after you release the fader or soft knob.

5. (Option) Press the Auto REC button to stop recording and snap the button back to its current Timeline position.

**Using the Artist Series Controller for Editing Media**

You can use your Artist Series controller to perform some of the basic editing functions available in your Avid editing application, including the following:

- Mark In and Out points
- Splice in and Overwrite edits
These functions allow you to edit and trim clips in your sequences using the controller rather than the buttons and tools in your Avid editing application. For example, you can use the Jog wheel to navigate to a transition in the Timeline, and then you can use the Soft Key functions to activate Trim mode, and then perform a single- or dual-roller trim.

Some editing commands only apply to specific windows in your Avid editing application. You might need to click the appropriate window — for example, the Timeline — before you can perform a specific function.

Some editing functions are mapped to your Artist Series controller by default. If you want to access other editing functions, you can customize the controls by mapping other functions to the soft keys or Touchscreen on your controller. For more information, see “Customizing Avid Artist Series Controls” on page 909.

Controller Application Sets

The following sections include a list of the default key assignments (called an application set) for the Avid Artist Series controllers when used with an Avid editing application. You can customize the key assignments for your controller by using the EuControl application and save your customizations in a separate application set. For more information, see the user’s guide that came with your Avid Artist controller.

- Avid Artist Control
- Avid Artist Transport
- Installing EuControl Software

Avid Artist Control

The following table lists the default application set for Avid Artist Control when used with your Avid editing application.

Not all hardware and software versions support all of the functionality listed in this section. Some buttons might be unavailable on your controller.
### Control Function

<table>
<thead>
<tr>
<th>Control</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solo button</td>
<td>Solos the selected track.</td>
</tr>
<tr>
<td>On button</td>
<td>Unmutes and mutes the selected track.</td>
</tr>
<tr>
<td>Soft knobs</td>
<td>Eight continuously rotating knobs allowing you to adjust parameters such as pan levels. The knob has a built-in switch allowing it to be pressed from the top. The Touchscreen displays the current functions of the knobs.</td>
</tr>
<tr>
<td>Rec</td>
<td>Enables the selected track for recording.</td>
</tr>
<tr>
<td>Rec+Shift (Auto)</td>
<td>Changes the automation mode for a track. Press Rec+Shift to cycle through the automation modes (the Touchscreen displays the selected automation mode).</td>
</tr>
<tr>
<td>Sel</td>
<td>Selects an audio track.</td>
</tr>
<tr>
<td>Sel+Shift (Assign)</td>
<td>Opens the EuControl Settings dialog box and displays the Assign tab.</td>
</tr>
<tr>
<td>Fader strips</td>
<td>Allow you to adjust parameters while recording volume automation or pan. Press the Shift key and touch a fader to set it to unity gain.</td>
</tr>
<tr>
<td>Soft key navigation</td>
<td>Moves through the pages listing soft key functions in the display. Press Shift+up arrow (Home) or Shift+down arrow (End) to go to the first or last page.</td>
</tr>
<tr>
<td>Display</td>
<td>Displays functional information and controls, including the knob functions, Touchscreen controls, soft key labels.</td>
</tr>
<tr>
<td>Control</td>
<td>Function</td>
</tr>
<tr>
<td>-------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Soft keys</td>
<td>Provide editing and navigation functions specified in the soft key pages in the display. Moving through the soft key pages with the soft key navigation buttons changes the functions assigned to the soft keys.</td>
</tr>
<tr>
<td>Volume</td>
<td>Adjusts the volume.</td>
</tr>
<tr>
<td>Power</td>
<td>Turns the controller on or off.</td>
</tr>
<tr>
<td>Back</td>
<td>Moves the knob set functions up one level if the knob set in the display is a submenu.</td>
</tr>
<tr>
<td>Top</td>
<td>Moves the knob set functions to the topmost level if the knob set in the display is a submenu.</td>
</tr>
<tr>
<td>Application</td>
<td>Switches between the most recently used open applications. Press and hold the Bank (left or right) button to cycle among all open applications.</td>
</tr>
<tr>
<td>Workstation (Shift+Application)</td>
<td>Allows you to change the active workstation if you have more than one system attached to your controller. For information on attaching multiple workstations, see the documentation that came with your Artist Series controller.</td>
</tr>
<tr>
<td>Page (left and right)</td>
<td>Changes the knob set functions by one page.</td>
</tr>
<tr>
<td>Cfg (Shift+Page left and right)</td>
<td>Opens a knob set configuration page if available.</td>
</tr>
<tr>
<td>Nudge (left and right)</td>
<td>Moves the set of four tracks assigned to the faders one track to the left or right — for example, if the faders are assigned to tracks 5 – 8, pressing the Nudge Left button changes the assignments to tracks 4 – 7.</td>
</tr>
<tr>
<td>Bank (left and right)</td>
<td>Moves the set of four tracks assigned to the faders four tracks to the left or right — for example, if the faders are assigned to tracks 5 – 8, pressing the Bank Left button changes the assignments to tracks 1 – 4.</td>
</tr>
<tr>
<td>Mixer (Shift+Nudge Left)</td>
<td>Opens the Audio Mixer tool.</td>
</tr>
<tr>
<td>Close (Shift+Nudge Right)</td>
<td>Closes the active dialog box or tool.</td>
</tr>
<tr>
<td>Home (Shift+Bank Left)</td>
<td>Moves the set of four tracks assigned to the faders to tracks 1 – 4.</td>
</tr>
<tr>
<td>End (Shift+Bank Right)</td>
<td>Moves the set of four tracks assigned to the faders to the last bank of four faders.</td>
</tr>
<tr>
<td>Zoom Horz</td>
<td>Allows you to use the Jog wheel to zoom horizontally in the Timeline.</td>
</tr>
</tbody>
</table>
### Avid Artist Transport

The following table lists the default application set for Avid Artist Transport when used with your Avid editing application.

*Not all hardware and software versions support all of the functionality listed in this section. Some buttons might be unavailable on your controller.*

<table>
<thead>
<tr>
<th>Control</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom Vert</td>
<td>Allows you to use the Jog wheel to zoom vertically in the Timeline.</td>
</tr>
<tr>
<td>(Shift+Zoom Horz)</td>
<td></td>
</tr>
<tr>
<td>Jog</td>
<td>Allows you to use the Jog wheel to jog through media in the Timeline or a</td>
</tr>
<tr>
<td></td>
<td>monitor.</td>
</tr>
<tr>
<td>Shuttle (Shift+Jog)</td>
<td>Allows you to use the Jog wheel to adjust playback. You can alter the speed</td>
</tr>
<tr>
<td></td>
<td>of playback depending on how far you turn the Jog wheel.</td>
</tr>
<tr>
<td>Rew</td>
<td>Moves to the previous transition in the sequence.</td>
</tr>
<tr>
<td>FF</td>
<td>Moves to the next transition in the sequence.</td>
</tr>
<tr>
<td>Stop</td>
<td>Stops playback.</td>
</tr>
<tr>
<td>Play</td>
<td>Starts playback.</td>
</tr>
<tr>
<td>Rec</td>
<td>Starts recording at the present location. Recording can use all active tracks.</td>
</tr>
<tr>
<td>Jog wheel</td>
<td>Turn the wheel to move through media in the Timeline or monitor (jog) or</td>
</tr>
<tr>
<td></td>
<td>adjust playback speed (shuttle).</td>
</tr>
</tbody>
</table>
Avid Artist Transport: Display, Soft keys, Numeric keypad (Show/Redo/Undo), Transport keys, Application change key, Shift key

<table>
<thead>
<tr>
<th>Control</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display</td>
<td>Displays functional information including timecode, active application, and soft key labels.</td>
</tr>
</tbody>
</table>
| Soft keys| Provide editing and navigation functions specified in the soft key pages in the application set. You can view the soft key functions by pressing the Show button. The default soft key assignments for your Avid editing application, from left to right, include the following (Shift+soft key functions are listed in parentheses):
- Jog (Horizontal Zoom)
- Shuttle (Vertical Zoom)
- Splice-in (Toggle Source/Record)
- Overwrite (Timeline)
- Go to Start (Lift)
- Undo (Extract)
| Show     | Opens the EuControl application and displays the Soft Keys tab. |
Controller Application Sets

The following table lists the default application set for Avid Artist Mix when used with your Avid editing application.

<table>
<thead>
<tr>
<th>Control</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show+soft key</td>
<td>Shows the label for the selected soft key in the display. You can lock the Show key by pressing the key and then quickly pressing a soft key. Press the Show key again to unlock it.</td>
</tr>
<tr>
<td>Redo (Shift+period)</td>
<td>Redoes the last undone edit.</td>
</tr>
<tr>
<td>Undo (Shift+asterisk)</td>
<td>Undoes the previous edit.</td>
</tr>
<tr>
<td>Transport keys</td>
<td>Allow you to perform navigation and editing functions specified in the application set. The default Transport key assignments for your Avid editing application, from left to right, include the following (Shift+Transport key functions are listed in parentheses):</td>
</tr>
<tr>
<td></td>
<td>• Mark In (Trim Left 1 Frame)</td>
</tr>
<tr>
<td></td>
<td>• Previous Edit (Previous Edit)</td>
</tr>
<tr>
<td></td>
<td>• Reverse Play (Trim A Side)</td>
</tr>
<tr>
<td></td>
<td>• Stop (Trim Mode)</td>
</tr>
<tr>
<td></td>
<td>• Forward Play (Trim B Side)</td>
</tr>
<tr>
<td></td>
<td>• Next Edit (Next Edit)</td>
</tr>
<tr>
<td></td>
<td>• Mark Out (Trim Right 1 Frame)</td>
</tr>
<tr>
<td>Application</td>
<td>Switches between the two most recently used open applications. Press and hold the Application button while turning the Jog wheel in either direction to cycle among all open applications.</td>
</tr>
<tr>
<td>Workstation (Shift+Application)</td>
<td>Allows you to change the active workstation if you have more than one system attached to your controller. For information on attaching multiple workstations, see the documentation that came with your Artist Series controller.</td>
</tr>
</tbody>
</table>

Avid Artist Mix

The following table lists the default application set for Avid Artist Mix when used with your Avid editing application.
Avid Artist Mix: Display, Knob Set navigation, Sel/On keys and touch-sensitive knobs, Solo/On keys, Fader navigation, Knob Set selections, Fader strips, Shift key, Shift key

<table>
<thead>
<tr>
<th>Control</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display</td>
<td>Displays functional information including timecode, active application, and soft key labels.</td>
</tr>
<tr>
<td>Back</td>
<td>Moves the knob set functions up one level if the knob set in the display is a submenu.</td>
</tr>
<tr>
<td>Top</td>
<td>Moves the knob set functions to the topmost level if the knob set in the display is a submenu.</td>
</tr>
<tr>
<td>Page (left and right)</td>
<td>Changes the knob set functions by one page.</td>
</tr>
<tr>
<td>Cfg (Shift+Page left and right)</td>
<td>Opens a knob set configuration page if available.</td>
</tr>
<tr>
<td>Sel</td>
<td>Changes the knob function or switches a secondary function’s value.</td>
</tr>
<tr>
<td>On</td>
<td>Switches two-state parameters, such as EQ Band 1 on/off.</td>
</tr>
<tr>
<td>Soft knobs</td>
<td>Eight continuously rotating knobs allowing you to adjust parameters such as pan levels. The knob has a built-in switch allowing it to be pressed from the top. The Touchscreen displays the current functions of the knobs.</td>
</tr>
<tr>
<td>Control</td>
<td>Function</td>
</tr>
<tr>
<td>------------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Solo button</td>
<td>Solos the selected track.</td>
</tr>
<tr>
<td>On button</td>
<td>Unmutes and mutes the selected track.</td>
</tr>
<tr>
<td>Chan</td>
<td>Enables channel mode.</td>
</tr>
<tr>
<td>Flip (Shift+Chan)</td>
<td>Switches control between the fader controls to the knobs. A vertical double arrow appears in the display when the faders and knobs are flipped.</td>
</tr>
<tr>
<td>Insert</td>
<td>Allows you to select the plug-in effect listed in the display. Press the soft knob for a track to select the plug-in.</td>
</tr>
<tr>
<td>Input (Shift+Input)</td>
<td>Displays the Input knob set to configure input routing, mic gains, phantom power, and other application-specific parameters when pressed.</td>
</tr>
<tr>
<td>EQ</td>
<td>Allows you to adjust a track’s EQ parameters.</td>
</tr>
<tr>
<td>Dyn (Shift+EQ)</td>
<td>Displays the Dynamics knob set to configure compressors, limiters, expanders, and gates when pressed.</td>
</tr>
<tr>
<td>Aux</td>
<td>Assign a track’s first aux send to a soft knob.</td>
</tr>
<tr>
<td>Group (Shift+Aux)</td>
<td>Displays the Group knob set to configure group bus routing or control group (VCA) membership.</td>
</tr>
<tr>
<td>Pan</td>
<td>Enables selected channels for pan control using the soft knob.</td>
</tr>
<tr>
<td>Mix (Shift+Pan)</td>
<td>Displays the Mix knob set to configure output routing.</td>
</tr>
<tr>
<td>Fader strips</td>
<td>Allow you to adjust parameters while recording volume automation or pan. Press the Shift key and touch a fader to set it to unity gain.</td>
</tr>
</tbody>
</table>
21 Using Audio Plug-Ins

This chapter describes how to access and use the audio plug-ins, including the Real-Time AudioSuite (RTAS) and AudioSuite plug-ins that come with your Avid editing application.

- Audio Track Effect Plug-Ins
- Avid AudioSuite Plug-Ins
- Core Avid Audio Plug-Ins

Audio Effects Plug-Ins Installation

The installer for your Avid editing application automatically creates a Plug-Ins folder that stores Audio Track Effect and AudioSuite plugins in the following location:

(Windows) drive:\Program Files\Common Files\Avid\Audio\Plug_Ins

(Macintosh) Macintosh HD/Library/Application Support/Avid/Audio/Plug-Ins

Your Avid editing application automatically installs a set of core plug-ins. When you purchase additional plug-ins, the third-party vendor provides instructions on how to load the plug-ins.

AudioSuite Plug-ins supported by Avid appear in the Plug-In Selection menu in the AudioSuite window. Audio Track Effects appear in the Audio tab of the Effect Palette, as well as in the menus of the Audio Track inserts in the Audio Mixer Window and the Timeline Track Control Panel.

Audio Track Effect Plug-Ins

Your Avid editing application supports up to five Audio Track Effect plug-in inserts on each audio track. Audio Track Effect plug-ins are audio effects that you apply (or insert) on tracks, rather than on segments within your sequence. These inserts let you process audio material on a track in real time so that you can apply the effects to a sequence and play them back or output them without rendering them first. This lets you add a type of audio track effect that Avid Pro Tools® also supports.
When you use more than one plug-in on a track, your Avid editing application processes them in a series. Each effect gets added to that of any previous effect (moving from left to right in the Track Control panel). You can only apply mono plug-ins to mono audio tracks and stereo plug-ins to stereo audio tracks.

Avid qualifies a number of Audio Track Effect plug-ins manufactured by Avid for use with the current version of your Avid editing application. For a description of available Audio Track Effect plug-ins, see “Avid AudioSuite Plug-Ins” on page 932.

Avid also supports some plug-ins from third-party vendors that you can purchase separately. These plug-ins have their own detailed documentation. For information on Avid and third-party plug-ins, go to the Avid Web site at www.avid.com.

If you move your sequence from one Avid editing application to another system and the Audio Track Effect plug-in is not installed on that system, information about the effects display. In addition to the “Unavailable Effect” text, the effect name and other information displays which allows you to identify the effect. The information is displayed in the Audio Track Effect Tool.

### Inserting an Audio Track Effect Plug-In on a Track in the Timeline

You can insert up to five plug-in track effects (inserts a through e) on an audio track. When you insert a plug-in effect to a track, you select the track where you want to apply the effect, which insert location you want to use on the track, and the specific effect you want to add to your sequence.

You can also insert a plug-in track effect by dragging an Audio Track Effect template from a bin to your sequence. For more information, see “Using Audio Track Effect Templates” on page 931.

**To insert an Audio Track Effect plug-in from the Timeline, do the following:**

- Right-click the Record Track button or the Track Control panel for the track where you want to apply the insert and select RTAS Effects [track number] > Insert [a-e] > [insert].

  The plug-in effect is inserted in the track.

**To insert an Audio Track Effect plug-in using the insert button, do the following:**

1. Click an Audio Effect insert button in the Track Control panel for the track where you want to apply the insert.

  The Audio Track Effect tool opens.
2. Click the Select Effect button, and select an Audio Track Effect plug-in effect:
   The plug-in effect is inserted in the track.

To insert an plug-in using the Effect Palette:
1. In the Project window, click the Effects tab.
   The Effect Palette appears.

2. Click the Audio tab.
3. Click an effect category, select the effect you want, and drag it to the segment or to the Audio Track Effect insert button where you want to apply the insert. You can only insert mono effects on a mono track, stereo effects on a stereo track, and surround sound effects on a surround sound track.

The Select Insert dialog box opens.

4. Do one of the following:
   - If you want to add a new insert, click an [Empty] insert button.
   - If you want to replace an existing insert, click the appropriate insert button.

The plug-in effect is inserted in the track to which you dragged the effect icon.

**Editing an Audio Track Effect Plug-In on a Track in the Timeline**

After you insert an Audio Track Effect plug-in on an audio track, you can access the plug-in controls by using the Track Control panel or the Audio Track Effect tool. When you select an insert button in the Track Control panel or an effect in the Audio Track Effect tool, the controls for the plug-in appear in the Audio Track Effect tool window.

You can modify the parameters of the effect as you play your sequence so you can hear how your modifications affect the sound of your audio.

*If you have more than one insert on a track, you can dynamically change the plug-in controls that display in the Audio Track Effect tool as you play your sequence.*
To edit an Audio Track effect:

1. If the Track Control panel is not visible, click the Track Control Panel button or click Timeline fast menu and select Track Control Panel.

2. Click the Audio Track Effect insert button for the effect you want to edit.
   If a plug-in is inserted on the track, the Select Effect button displays the name of the plug-in and the Audio Track Effect tool opens a window associated with the plug-in.

3. (Option) If you want to change the plug-in effect for your insert, click the Select Effect button and select a new plug-in.

4. Make any necessary adjustments to your effect.
   If you play your sequence, you can modify the effect dynamically without stopping playback.

5. (Option) If you have multiple inserts on a track, do one of the following to change the plug-in controls that display in the tool:
   - Click the Select Track or the Select Insert button and select a different insert.
   - Press the arrow keys to cycle through the available inserts.
     Up and down arrow keys change the selected track. Right and left arrow keys change the selected insert.
6. (Option) Click the Bypass button if you want to play audio without processing the track effect. This lets you compare the audio with or without the plug-in effect.

If you click Ctrl+Bypass (Windows) or Cmd+Bypass (Macintosh), you can disable Audio Track effects on all tracks in the Timeline.

The Bypass button and the insert buttons on the selected track change to blue.

7. To save your changes, do one of the following:
   - Click the Save Effect icon in the Audio Track Effect tool.
   - Close the Audio Track Effect tool.

Moving and Copying Audio Track Effect Inserts

You can move and copy Audio Track Effect inserts from one track to another. However, you can only move mono inserts to mono tracks and stereo inserts to stereo tracks.

Audio Track Effect plug-in effects on inserts a, b, and c in the Track Control panel

To move an Audio Track Effect insert from one position to another, do the following:
   - Click an Audio Track Effect insert button and drag it to an insert button on a new track or to a new insert button on the same track. If the destination Audio Track Effect button already has an insert on it, the new insert replaces the existing one.

To copy an Audio Track Effect insert from one position to another, do the following:
   - Alt+drag (Windows) or Option+drag (Macintosh) an insert button to an insert button on a new track or to a new insert button on the same track.

Ordering Audio Track Effect Inserts on a Track

When you combine Audio Track Effect plug-ins on an audio track, the order in which you insert them affects how your Avid editing application applies the effects. This can produce different results for your sequence. Your Avid editing application processes Audio Track effects in order from left to right as they appear in the Track Control panel (insert a through insert e). For example, if you insert a compressor plug-in to the right of an EQ plug-in, your Avid editing application applies EQ effect first and then applies the compressor effect to the result.
You must have one empty insert on your audio track so you do not replace an existing insert when you reorder the inserts.

**To modify the order of Audio Track Effect inserts on a track, do the following:**

- Click an insert button and drag it to an empty insert button in the Track Control panel.

### Removing Audio Track Effect Inserts on a Track

Removing an insert deletes the effect from the track.

**To remove an Audio Track Effect insert:**

1. Do one of the following:
   - Select Tools > Audio Track Effect.
   - Right-click the Record Track button for the track where you want to edit an insert and select Audio Track Effect tool.
   - Click the insert button for the Audio Track effect.

   The Audio Track Effect tool opens.

2. Click the Select Track button and select the track where you want to delete an insert.

3. Click the Select Insert button and select “no insert.”

   Your Avid editing application removes the insert from the track.

4. Close the Audio Track Effect tool to save your changes.

### Using Audio Track Effect Templates

If you apply an Audio Track effect and make a set of adjustments to it, you can quickly recreate the same sound on other tracks in your sequence or project. You can save an Audio Track effect with its parameter settings to a bin as an effect template. You can then apply the template to other audio tracks at any time.

You can apply an Audio Track effect template with all its parameters directly to an Audio Track Effect insert button in the Track Selection panel or to clips in the Timeline.

**To save an Audio Track Effect as a template, do one of the following:**

- Click the Save Effect button in the Audio Track Effect tool and drag it to a bin.
- Click an Audio Track Effect button and drag it to a bin.

A new track effect template appears in the bin, containing the parameter setting information for the effect. The new effect template is identified in the bin by an effect icon. By default, your Avid editing application names the template by the plug-in name.
To apply an Audio Track Effect template to an audio track, do one of the following:

- Drag the Audio Track Effect template from the bin to an insert button in the Track Selection panel.
- Drag the Audio Track Effect template from the bin to a segment on the track where you want to apply the effect. The Select Insert dialog box opens so you can select the insert where you want to apply the effect.

The effect is applied to the track.

Avid AudioSuite Plug-Ins

Your Avid editing application supports AudioSuite, the Avid host-based, file-based plug-in specification. Users have access to mono and stereo audio-processing plug-ins developed by Avid and by Avid third-party developers. These plug-ins perform pitch modifications, artifact removal, audio reversal, and many other processes.

Avid qualifies a broad range of the AudioSuite plug-ins manufactured by Avid for use with the current version of your Avid editing application. This includes all AudioSuite plug-ins in the DigiRack and Bomb Factory plug-ins series.

Avid supports other AudioSuite plug-ins that do not install with your Avid editing application. You can use these plug-ins on a trial basis and then purchase them through Avid. These plug-ins have their own detailed documentation.

For information on Avid and third-party plug-ins, go to the Avid Web site at www.avid.com.

For information on plug-ins that are not supported by your Avid editing application, see “AudioSuite Plug-in Limitations” on page 942.

Using Avid AudioSuite Plug-Ins

You can use AudioSuite plug-ins in two ways.

- You can apply a plug-in to a clip in the Timeline and then create a rendered effect. For more information, see “Applying an AudioSuite Plug-in to a Clip in the Timeline” on page 933.
- You can use the controls in the AudioSuite window to create a new master clip. This method lets you process more than one channel at a time and to create new media with a duration longer or shorter than the source media. For more information, see “Creating New Master Clips with AudioSuite Plug-Ins” on page 936.

By default, the AudioSuite window displays the controls for applying a plug-in to a clip in the Timeline. When you drag a master clip into the window, the window expands to display additional parameters for working with master clips.
The AudioSuite tool automatically applies stereo plug-ins to stereo tracks and mono plug-ins to mono tracks.

### Applying an AudioSuite Plug-in to a Clip in the Timeline

The following illustration shows the default layout of the AudioSuite window.

If you want to use plug-ins that operate on stereo pairs or that change the length of the audio clip, use the methods described in “Creating New Master Clips with AudioSuite Plug-Ins” on page 936.

To apply an AudioSuite plug-in to a clip in the Timeline:

1. Open the AudioSuite window by doing one of the following:
   - Select Tools > AudioSuite.
   - If an audio tool is already open, click the Effect Mode Selector menu, and select AudioSuite.

2. Use the Track Selection Menu button to select the tracks that you want to modify.
   - When you select an item from this menu, the system selects or deselects the corresponding track in the Timeline.
3. (Option) To select multiple tracks, press the Shift key while you select additional tracks from the Track Selection menu.

Plus signs (+) mark the additional tracks and indicate that the effect is applied to more than one track.

4. Click the Plug-In Selection menu, and select a plug-in.

Your Avid editing application automatically applies the plug-in effect to the track or tracks in the Timeline. It applies stereo effects to stereo tracks and mono effects to mono tracks.

5. Click the Activate Current Plug-In button.

A dialog box associated with the plug-in opens.

6. Make any necessary adjustments, and click the Preview button to preview the effect.

For more information, see “Common Buttons in the AudioSuite Plug-In Dialog Box” on page 934.

7. To save the effect, click OK.

To close the dialog box without saving the effect, click Cancel.

8. (Option) To save the effect as a template, drag the effect icon to a bin.

Common Buttons in the AudioSuite Plug-In Dialog Box

The contents of the plug-in dialog boxes vary, but the top six buttons are always visible. Buttons unavailable for a plug-in appear dimmed. The following illustration shows the Gain plug-in.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OK</td>
<td>Saves the effect and closes the dialog box.</td>
</tr>
</tbody>
</table>
The AudioSuite Fast menu lets you do the following:

- Apply an existing AudioSuite template. See “Using AudioSuite Effect Templates” on page 940.
- Set, render, or remove AudioSuite plug-ins. The menu text differs, depending on whether you have In to Out points in the sequence.

The following commands appear in the menu:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Global</td>
<td>The segment has no In points. The command affects all the plug-ins on the enabled tracks.</td>
</tr>
<tr>
<td>IN/OUT</td>
<td>The segment has In to Out points. The command affects the plug-ins on the enabled tracks within the marked region.</td>
</tr>
<tr>
<td>From IN</td>
<td>The segment has an In point but no corresponding Out point. The command affects all plug-ins on enabled tracks, starting with the In point.</td>
</tr>
</tbody>
</table>
Rendering AudioSuite Plug-in Effects

You need to render all AudioSuite plug-ins before you can play back the effect. If you do not render the effect manually, your Avid editing application automatically renders the effect before it creates an audio mixdown or audio dissolve containing the effect.

When you render an audio effect on an AMA media clip, all audio media files are written as PCM (MXF), regardless of what you set for the audio file format.

For more information, see “Troubleshooting AudioSuite Plug-Ins” on page 942.

Creating New Master Clips with AudioSuite Plug-Ins

You can use AudioSuite plug-ins to create new master clips. This lets you use multiple input and output channels and to change the length of the media. You can perform the following operations on the media you create:

- Apply AudioSuite plug-ins to more than one track at the same time. For example, a plug-in might let you process two separate tracks as a stereo pair. This enables you to use plug-ins that perform linked compression, reverb, and other effects that allow multichannel input.

- Create new media with a longer or shorter duration than the source media. This lets you use effects that perform time compression and expansion. For example, you can use a Time Compression Expansion plug-in to change the length of the audio file, or you can lengthen the file in order to add a reverb trail.

- Apply one mono AudioSuite effect to multiple inputs of a master clip in a multiple-mono fashion.

AudioSuite Controls for Creating New Master Clips

When you drag a master clip onto the AudioSuite window, the window automatically expands to display additional controls. You can also click the Display/Hide Master Clip Controls button to display or hide the additional parameters.

The following illustration identifies the controls in the expanded AudioSuite window. For information on the controls in the top part of the window, see “Applying an AudioSuite Plug-in to a Clip in the Timeline” on page 933.
The following table describes the controls in the AudioSuite window.

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Clip Selection menu</td>
</tr>
<tr>
<td>2</td>
<td>Input Source Track selectors</td>
</tr>
<tr>
<td>3</td>
<td>Processing Mode Selection menu</td>
</tr>
<tr>
<td>4</td>
<td>Target Bin for New Master Clip menu</td>
</tr>
</tbody>
</table>
### Control | Description
--- | ---
5 | Status display Provides information about the current state of the DAE (the software that manages the AudioSuite plug-ins) and the currently applied effect. For stereo and multichannel processing plug-ins, the Status display identifies the maximum number of tracks that the plug-in can process. If you initially select more than the maximum, the system automatically disables tracks until it reaches the plug-in’s maximum number.

*On the Macintosh, you can Command+click the status display to close the DAE. This might reclaim a small amount of system memory, especially if you have a large number of AudioSuite plug-ins installed. However, when you close the DAE in this way, the Status display changes to “Must relaunch application to reconnect to DAE,” and you cannot start the DAE again without quitting and reopening your Avid editing application.*

6 | Load Result check box When enabled, instructs the system to automatically load the resulting master clip into the Source monitor.

7 | Handle Length for End of Master Clip (seconds) text box Lets you add filler at the end of a master clip. The value represents the number of seconds to add. For example, use this feature to add filler at the end of a master clip when you use a reverb effect to add a reverb trail to the end of the clip. Select the value before you run the plug-in.

8 | Load In Source Monitor button Loads the current source master clip into the Source monitor. You can use when you want to add or change In to Out points on the clip.

9 | Toggle Master Clip Mode button Activates the master clip processing mode. The button displays as yellow when master clip processing mode is active.

10 | Mark IN to OUT indicators These lights change to green when a mark In or mark Out exists on the current master clip.

11 | Find Source From Effect button Lets you find the master clip associated with an AudioSuite template. When you drop an AudioSuite effect template into the AudioSuite window, the system activates this button. Click the button to load the master clip into the AudioSuite window as the active master clip.

* A template in the AudioSuite window must reference an existing master clip.
Mono, Stereo, and Multichannel Processing in AudioSuite Plug-Ins

AudioSuite plug-ins let you select the following types of processing:

- Mono processing only — This option is available for plug-ins that operate on only one mono audio track at a time. The other option (Stereo) appears dimmed. The plug-in applies the effect to each source track individually, in a serial manner.

- Mono and stereo processing — These options are available for plug-ins that can operate on stereo tracks or that can treat two tracks as a stereo pair. This allows the system to apply the audio effect simultaneously to each track. For example, the Time Compression Expansion plug-in typically operates on a stereo pair. You can choose mono if you want the plug-in to operate on each track individually, in a serial manner.

- Mono and multichannel processing — These options are available for plug-ins that can process multiple channels or tracks simultaneously. For example, the Normalize plug-in lets you adjust the volume separately for each channel or track or to adjust the volume for all channels or tracks at the same time. In the latter case, the system examines all enabled channels and tracks for the loudest volume and then adjusts them relative to that value.

For mono processing and for stereo processing of stereo clips, the system creates a new master clip with the same number of tracks that you selected in the AudioSuite window.

For stereo and multichannel processing of mono audio clips, the plug-in creates a master clip with the number of tracks equal to the number of output tracks from the plug-in. For example, a plug-in that operates on stereo pairs creates a two-track master clip. A plug-in that operates on multiple tracks creates a master clip with the same number of tracks that were selected in the AudioSuite window.

The Status display at the bottom of the AudioSuite Plug-in window indicates how many tracks the plug-in can process. If you enable more tracks than it can be process, the plug-in automatically selects the correct number of tracks. You can change the track selection based on your needs.

Most AudioSuite plug-ins automatically select the appropriate processing mode and label the values in the Processing Mode Selection menu. For example, the Normalize plug-in offers two choices: Level On Each Chan-Track and Levels On All Chans-Tracks (default).

You select the processing mode from a menu in the AudioSuite window as described in the next section.
Using AudioSuite Plug-ins to Create New Master Clips

To create new master clips using the AudioSuite plug-ins:

1. Drag one or more master clips or subclips into the AudioSuite window.
   Your Avid editing application automatically enters Master Clip Processing mode and expands the AudioSuite window, if necessary.

2. If you dropped more than one master clip in the AudioSuite window, select a clip to work on from the Clip Selection menu.

3. Select the input sources from the Input Source Track selectors.

4. (Option) Alt+click (Windows) or Option+click (Macintosh) the Input Source Track selector to change the preview source track.

5. (Option) Type a value in the Handle Length text box to lengthen the clip by a specific amount.
   For example, type 2 if you plan to add a 2-second reverb trail.
   If you are using Time Compression/Expansion plug-ins, the plug-ins automatically lengthen or shorten the clip.

6. Click the Plug-In Selection menu, and select a plug-in.

7. Click the Activate Current Plug-In button to open the plug-in’s dialog box.
   For more information, see “Common Buttons in the AudioSuite Plug-In Dialog Box” on page 934.

8. Make any changes, and click the Preview button to preview the effect.

9. Either render the plug-in from the Plug-In dialog box, or return to the AudioSuite window.
   For more information on rendering, see “Rendering AudioSuite Plug-in Effects” on page 936.
   When you click the Render Effect button, your Avid editing application creates a new master clip in the target bin. Your Avid editing application names the new master clip by combining the original clip name with the effect name, for example, Test Audio clip_Normalize (Windows) or QuietClip.Normalize (Macintosh).
   Your Avid editing application also creates an AudioSuite effect template in the bin as described in “Using AudioSuite Effect Templates” on page 940.

Using AudioSuite Effect Templates

When you create a new master clip, your Avid editing application also creates an AudioSuite effect template in the bin. This effect template contains a reference to the original master clip to which you applied the effect.
Template names take the following format:

- (Windows) Your Avid editing application combines the original clip name with the effect name — for example, Test Audio clip - AudioSuite Plug-In Effect: Normalize.
- (Macintosh) Your Avid editing application adds an effect file name extension to the effect name — for example, QuietClip.NormalizeQuietClip.Normalize.effect.

You can use the template if you want to modify an effect on a clip.

**To use a template to modify a master clip:**

1. Drag an AudioSuite plug-in template into the AudioSuite window.
   The Find Source From Effect button becomes active.
2. Click the Find Source From Effect button to load the master clip into the AudioSuite window.
   If a corresponding master clip exists, the system loads the master clip with its associated plug-in values.
3. Modify the effect as described in “AudioSuite Controls for Creating New Master Clips” on page 936.

**To add a template to the AudioSuite Fast menu:**

1. Open the bin containing your AudioSuite templates.
2. Select File > Open Bin.
   A dialog box opens.
3. Navigate to the AudioSuite Site bin file in the following location:
   (Windows) \drive:\Program Files\Avid\Avid editing application\SupportingFiles\Site_Effects\Site_AudioSuite_Bin.avb
   (Macintosh) Macintosh HD/Applications/Avid editing application/SupportingFiles/Site_Effects/Site_AudioSuite_Bin
   The Site_AudioSuite_Bin window opens.
5. Drag one of your AudioSuite templates to the Site_AudioSuite_Bin window.
6. If you have not already done so, name the template by clicking the text and typing a name.
7. Close the bin.
   Your Avid editing application does not save the effect to the bin until you close the bin.
8. Click the AudioSuite Fast Menu button to locate your new template.
Using AudioSuite Plug-Ins in Stereo

You can use some AudioSuite plug-ins on either mono or stereo tracks.

To use AudioSuite plug-ins in stereo, be aware of the following:

- To process a mono track and obtain a stereo result, select the desired track or mark an In point and Out point, then either select an empty track or add an new one. When you process the audio, the result will be two tracks or regions that represent the right and left channels of the processed audio. You should then pan these tracks hard right and hard left in your mix.

- If you work with mono tracks and set a plug-in to Stereo mode, then select an odd number of tracks for processing, the plug-in processes the selected tracks in pairs to create the stereo effect. However, the last odd, unpaired track will be processed as mono, using the left channel settings of the stereo plug-in. If you want the last track to be processed in stereo, you must select an additional track to pair it with — an empty one, if necessary.

AudioSuite Plug-in Limitations

The following limitations apply to the AudioSuite plug-ins:

- Avid does not support some plug-ins that perform analysis passes on the audio data. This includes plug-ins that use playlist information to cache analysis data.

- If you want to use plug-ins that change the length of an audio clip or that operate on multiple inputs at the same time, use the method described in “Creating New Master Clips with AudioSuite Plug-Ins” on page 936. Applying an effect to a clip in the Timeline does not work for these operations.

Troubleshooting AudioSuite Plug-Ins

You might need to respond to an error message or cancel a render operation when rendering AudioSuite plug-ins. If the DAE is not running when you start to render an AudioSuite plug-in effect, the system displays an error message stating that the DAE connection does not exist.

To respond to error messages:

1. Do one of the following:
   - Select Cancel to stop the rendering process. This lets you open the AudioSuite tool and then start rendering again.
   - Select Bypass to continue the rendering process. The plug-in effect does not render.

In most cases, you should click Cancel and open the AudioSuite window.

If you have not installed the plug-in when you go to render a plug-in effect, your Avid editing application displays an error message informing you which plug-in you must install. At that time, you can cancel or bypass the rendering process.
2. To cancel a render operation, press Ctrl+period (Windows) or Command+period (Macintosh).

Be careful not to press these keys multiple times. If you press Ctrl+period (Windows) or Command+period (Macintosh) after the render operation stops from a previous Ctrl+period (Windows) or Command+period (Macintosh), your Avid editing application closes the window after it cancels the render operation.

Working with Dolby E Surround Sound Plug-ins

Dolby E is an audio coding technology created by Dolby Labs that compresses up to 8 channels of audio and metadata into 2 channels. You can capture or import media clips that include encoded Dolby E surround sound data, and you can then edit those clips in the Timeline. When you want to monitor tracks with Dolby E surround sound encoding, you can use supported third-party Dolby E plug-ins to decode the metadata. You can also encode Dolby E metadata in order to export surround sound media for use in your production environment.

For more information on capturing Dolby E media, see “Capturing Media with Dolby E Information” on page 275.

When you work with Dolby E encoder and decoder plug-ins, keep in mind the following:

- You can add an RTAS Dolby E decoder plug-in to a track to decode Dolby E data in the Timeline in real time. This allows you to easily monitor and edit the surround sound audio in your sequence.

- You can use an AudioSuite decoder plug-in to decode the Dolby E data on a clip, but you must use the plug-in to create a new master clip in master clip processing mode. (For information on creating master clips with plug-ins, see “Using AudioSuite Plug-ins to Create New Master Clips” on page 940.) Supported Dolby E decoder plug-ins decode the metadata and create separate mono audio clips in the bin, which you can then edit into your sequence or use the Modify dialog box to create a surround sound audio clip.

- When you use a Dolby E encoder plug-in to encode Dolby E data in an audio clip or a surround sound audio track in the Timeline, the plug-in creates a new media file in the specified location on your system. If you render the plug-in effect or create a mixdown of a sequence with a Dolby E encoder effect applied to it, you can no longer use the Dolby E metadata to monitor your audio because the effect has been rendered. Instead, you should encode the Dolby E data, creating a new media file on your system, and then remove the Dolby E plug-in effect from your sequence. This allows you to continue to monitor and edit the surround sound audio. Alternately, you can leave the effect in the Timeline as long as you do not perform either a render or mixdown of the sequence.

For more information, see the documentation that came with your Dolby E plug-in.
Core Avid Audio Plug-Ins

A set of core audio plug-ins installs with your Avid editing application. Audio Track Effect and AudioSuite Plug-ins supported by Avid, such as the core set, appear in the Audio Track Effect tool and the AudioSuite Plug-in Selection menu with their plug-in name.

Other audio plug-ins might get installed on your system for use with Pro Tools, or you might download plug-ins. Avid does not recommend using unsupported plug-ins with Avid editing applications.

Avid supports other Audio Track Effect and AudioSuite plug-ins that do not install with your Avid editing application. You can use these plug-ins on a trial basis and then purchase them through Avid. These plug-ins have their own detailed documentation. For information on Avid and third-party plug-ins, go to the Avid Web site at www.avid.com.

The following table provides a brief description of each of the core plug-ins, with cross-references to more detailed information in the remaining topics in this section.

You can use track effect plug-ins on both mono and stereo tracks. You can use some AudioSuite plug-ins in either mono or stereo clips. For more information, see “Using AudioSuite Plug-Ins in Stereo” on page 942.

### Audio Plug-ins

<table>
<thead>
<tr>
<th>Plug-In</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AIR Chorus</td>
<td>Gives depth and space to the audio signal by applying a short modulated delay. For more information, see “AIR Chorus (Audio Track Effect)” on page 947.</td>
</tr>
<tr>
<td>AIR Distortion</td>
<td>Modifies the audio signal with various types of distortion. For more information, see “AIR Distortion (Audio Track Effect)” on page 948.</td>
</tr>
<tr>
<td>AIR Dynamic Delay</td>
<td>Creates a delay line that can synchronize to the tempo of your audio sequence. For more information, see “AIR Dynamic Delay (Audio Track Effect)” on page 949.</td>
</tr>
<tr>
<td>AIR Enhancer</td>
<td>Enhances the low and high broadband frequencies of the audio signal. For more information, see “AIR Enhancer (Audio Track Effect)” on page 951.</td>
</tr>
<tr>
<td>AIR Ensemble</td>
<td>Creates fluid, shimmering modulation effects. For more information, see “AIR Ensemble (Audio Track Effect)” on page 952.</td>
</tr>
<tr>
<td>AIR Filter Gate</td>
<td>Breaks the audio signal into staccato rhythmic patterns with variable filtering, amplitude, and panning. For more information, see “AIR Filter Gate (Audio Track Effect)” on page 952.</td>
</tr>
<tr>
<td>AIR Flanger</td>
<td>Applies a short modulating delay. For more information, see “AIR Flanger (Audio Track Effect)” on page 953.</td>
</tr>
</tbody>
</table>
## Core Avid Audio Plug-Ins

### Audio Plug-ins

<table>
<thead>
<tr>
<th>Plug-In</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AIR Frequency Shifter</td>
<td>Shifts the audio signal’s individual frequencies inharmonically. For more information, see “AIR Frequency Shifter (Audio Track Effect)” on page 956.</td>
</tr>
<tr>
<td>AIR Fuzz-Wah</td>
<td>Modifies the audio signal with different types and varying amounts of transistor-like distortion. For more information, see “AIR Fuzz-Wah (Audio Track Effect)” on page 957.</td>
</tr>
<tr>
<td>AIR Kill EQ</td>
<td>Removes the Low, Mid, or High broadband frequency range from an audio signal. For more information, see “AIR Kill EQ (Audio Track Effect)” on page 958.</td>
</tr>
<tr>
<td>AIR Lo Fi</td>
<td>Lets you bit-crush, down-sample, clip, rectify, and mangle the input signal. For more information, see “AIR Lo Fi (Audio Track Effect)” on page 958.</td>
</tr>
<tr>
<td>AIR Multi-Chorus</td>
<td>Applies a thick, complex chorus effect to the audio signal. For more information, see “AIR Multi-Chorus (Audio Track Effect)” on page 961.</td>
</tr>
<tr>
<td>AIR Multi-Delay</td>
<td>Applies up to six delay lines to the audio signal. For more information, see “AIR Multi-Delay (Audio Track Effect)” on page 962.</td>
</tr>
<tr>
<td>AIR Non-Linear Reverb</td>
<td>Creates special gated or reversed reverb effects. For more information, see “AIR Non-Linear Reverb (Audio Track Effect)” on page 963.</td>
</tr>
<tr>
<td>AIR Phaser</td>
<td>Creates a unique sweeping sound by applying a phaser effect. For more information, see “AIR Phaser (Audio Track Effect)” on page 964.</td>
</tr>
<tr>
<td>AIR Reverb</td>
<td>Creates a sense of room or space by applying a reverb to the audio signal. For more information, see “AIR Reverb (Audio Track Effect)” on page 966.</td>
</tr>
<tr>
<td>AIR Spring Reverb</td>
<td>Creates a classic analog, spring reverb sound. For more information, see “AIR Spring Reverb (Audio Track Effect)” on page 968.</td>
</tr>
<tr>
<td>AIR Stereo Width</td>
<td>Lets you enhance the stereo presence for mono audio signals. For more information, see “AIR Stereo Width (Audio Track Effect)” on page 969.</td>
</tr>
<tr>
<td>AIR Vintage Filter</td>
<td>Applies a modulating, resonant filter to the audio signal. For more information, see “AIR Vintage Filter (Audio Track Effect)” on page 972.</td>
</tr>
<tr>
<td>Bomb Factory BF76</td>
<td>Provides compression modeled after the 1176 studio compressor. For more information, see “Bomb Factory BF76 (Audio Track Effect and AudioSuite)” on page 973.</td>
</tr>
<tr>
<td>Compressor/Limiter III</td>
<td>Applies either compression or limiting to audio material, depending on the ratio of compression used. For more information, see “Compressor/Limiter III — Dynamics III (Audio Track Effect and AudioSuite)” on page 981.</td>
</tr>
</tbody>
</table>
## Audio Plug-ins

<table>
<thead>
<tr>
<th>Plug-In</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>D-Verb™</td>
<td>Provides a studio-quality reverberation or ambience processing to single or multiple tracks. For more information, see “D-Verb (Audio Track Effect and AudioSuite)” on page 985.</td>
</tr>
<tr>
<td>DC Offset Removal</td>
<td>Removes an audio artifact that is common in digital audio files. A DC offset is caused by poorly calibrated analog-to-digital converters (A/Ds), and can produce clicks and pops on clip edit transitions if not removed. For more information, see “DC Offset Removal (AudioSuite)” on page 986.</td>
</tr>
<tr>
<td>De-Esser III</td>
<td>Reduces sibilants and other high frequency noises that can occur in vocals, voiceovers, and wind instruments such as flutes. For more information, see “DeEsser III — Dynamics III (Audio Track Effect and AudioSuite)” on page 986.</td>
</tr>
<tr>
<td>Duplicate</td>
<td>Creates a new master clip from a selected audio clip. The plug-in uses the In and Out points on the selected clip to define the boundaries of the new clip. For more information, see “Duplicate (AudioSuite)” on page 990.</td>
</tr>
<tr>
<td>EQ</td>
<td>Lets you adjust frequency equalization on individual audio clips. Four EQ plug-ins are available: 1-Band EQ II, 4_Band EQ II, 1-Band EQ III, and 7-Band EQ III. For more information, see “EQ (AudioSuite)” on page 992.</td>
</tr>
<tr>
<td>Expander/Gate III</td>
<td>Applies expansion or gating to audio material, depending on the ratio setting. For more information, see “Expander/Gate III — Dynamics III (Audio Track Effect and AudioSuite)” on page 995.</td>
</tr>
<tr>
<td>Funk Logic Masterizer</td>
<td>Provides low-fidelity sound design capabilities for the creative degradation of audio. For more information, see “Funk Logic Masterizer (AudioSuite)” on page 997.</td>
</tr>
<tr>
<td>Gain</td>
<td>Same as Normalize, but allows positive or negative gain adjustment. For more information, see “Gain (AudioSuite)” on page 997.</td>
</tr>
<tr>
<td>Invert</td>
<td>Inverts the polarity (phase) of the audio file. For more information, see “Invert (AudioSuite)” on page 998.</td>
</tr>
<tr>
<td>Lo-Fi</td>
<td>Processes audio by reducing its sample rate and bit resolution. For more information, see “Lo-Fi Plug-In (Audio Track Effect and AudioSuite)” on page 998.</td>
</tr>
<tr>
<td>Normalize</td>
<td>Finds the peak value in the source audio file and scales the entire file proportionally to that maximum value. For more information, see “Normalize (AudioSuite)” on page 1004.</td>
</tr>
<tr>
<td>Pitch Shift</td>
<td>Changes pitch with or without changing length. For more information, see “Pitch Shift (AudioSuite)” on page 1004.</td>
</tr>
</tbody>
</table>
Core Avid Audio Plug-Ins

**Air Chorus (Audio Track Effect)**

You can use the AIR Chorus plug-in to apply a short modulated delay to give depth and space to the audio signal.

The following table lists the AIR Chorus plug-in parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rate</td>
<td>Lets you adjust the rate of the low frequency oscillator (LFO) applied to the delayed signal as modulation. The higher the setting, the more rapid the modulation. You can select either a sine wave or a triangle wave as a modulation source, using the LFO Waveform selector.</td>
</tr>
<tr>
<td>Depth</td>
<td>Lets you adjust the depth of the low frequency oscillator (LFO) applied to the delayed signal as modulation.</td>
</tr>
</tbody>
</table>
| Chorus    | • Feedback — Controls the amount of feedback applied from the output of the delayed signal back into its input. Negative settings provide a more intense effect.  
• Pre Delay — Sets the delay time between the source chorus signal and the processed signal in milliseconds. The higher the setting, the longer the delay and the wider the chorusing effect. |
You can use the AIR Distortion plug-in to color the audio signal with various types and varying amounts of distortion.

The following table lists the AIR Distortion plug-in parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drive</td>
<td>Lets you increase the drive (input volume) of the signal from 0 dB (no distortion) to 60 dB (extreme distortion). An increase or decrease of 1–2 decibels can make a big difference on the amount and quality of distortion.</td>
</tr>
<tr>
<td>Output</td>
<td>Lets you lower the Output level of the distorted signal from 0–100%. At 0%, no distorted signal passes through the output. At 100%, the distorted signal passes through the output at full volume.</td>
</tr>
<tr>
<td>Tone</td>
<td>Lets you shape the timbral quality of the distortion.</td>
</tr>
<tr>
<td>Clipping</td>
<td></td>
</tr>
<tr>
<td>Pre Shape</td>
<td>Lets you increase or decrease a broad gain boost (or attenuation) of treble frequencies in the processed signal. Pre-Shape is essentially a pre-distortion tone control that makes the distortion bite at different frequencies. Set to 0%, the Pre-Shape control doesn’t affect the tone at all. Higher settings provide a boost in the high end of the distorted signal (more treble distortion), while lower setting suppress the high end, with some mid-range boost, for a darker less distorted tone.</td>
</tr>
<tr>
<td>High Cut</td>
<td>Lets you adjust the frequency for the High Cut filter. To attenuate the high-end of the processed signal, lower the frequency.</td>
</tr>
<tr>
<td>DC Bias</td>
<td>Lets you change clipping from being symmetrical to being asymmetrical, which makes it sound richer and more extreme at high settings. The difference is most noticeable at lower Drive settings.</td>
</tr>
<tr>
<td>Threshold</td>
<td>Lets you adjust the headroom for the dynamic range of the distorted signal between –20.0 dBFS and 0.0 dBFS. Rather than using the Drive to adjust the signal level relative to a fixed clipping level, use the Threshold control to adjust the clipping level without changing the signal level.</td>
</tr>
</tbody>
</table>
AIR Dynamic Delay (Audio Track Effect)

You can use the Dynamic Delay Plug-In for a delay line that can synchronize to the tempo of your audio sequence, and you can modulate the delay using an envelope follower.

The following table lists the AIR Dynamic Delay plug-in parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stereo</td>
<td>When you enable Stereo, the control processes the left and right channels of the incoming stereo signal separately. When you disable Stereo, the control sums and processes the incoming stereo signal as mono.</td>
</tr>
<tr>
<td>Mix</td>
<td>Lets you balance the amount of dry signal with the amount of wet (distorted) signal. At 50%, the output includes equal amounts of dry and wet signal. At 0%, the output is all dry and at 100% it is all wet. You can use the Mix control in conjunction with the Output control to find just the right balance of the distorted signal with the input (dry) signal. For example, with Mix set to 50%, equal amounts of the dry and wet signal pass to the output. You can then lower the Output control to decrease the amount of distorted signal passed to the output until you get exactly the right mix between the two signals and the right overall level.</td>
</tr>
<tr>
<td>Sync</td>
<td>When you enable Sync, the delay time synchronizes to the tempo of your audio sequence. When you disable Sync, you can set the delay time in milliseconds independently of the tempo. The Sync button is lit when it is enabled.</td>
</tr>
</tbody>
</table>
Core Avid Audio Plug-Ins

### Delay

When you enable Sync, the Delay control lets you select a rhythmic subdivision or multiple of the beat for the delay time (based on the tempo). Select from the following rhythmic values:

- 16 (sixteenth note)
- 8T (eighth-note triplet)
- 16D (dotted sixteenth-note)
- 8 (eighth note)
- 4T (quarter-note triplet)
- 8D (dotted eighth-note)
- 4 (quarter note)
- 2T (half-note triplet)
- 4D (dotted quarter-note)
- 2 (half note)
- 1T (whole-note triplet)
- 3/4 (dotted half note)
- 4/4 (whole note)
- 5/4 (five tied quarter notes)
- 6/4 (dotted whole note)
- 7/4 (seven tied quarter notes)
- 8/4 (double whole note)

When you disable Sync, the Delay control lets you set the delay time in milliseconds and seconds (1 ms to 4.00 seconds).

### Feedback

Lets you adjust the amount of delay feedback. At 0% the delayed signal repeats only once. As you increase the feedback, the number of times the delay repeats increases. At 100%, the delay repeats for an extended period of time.

Each Delay mode produces a different feedback pattern, especially when you do not center the L/R Ratio.

### Delay Section

- **L/R Ratio** — Lets you set the ratio of left to right delay times. If you move the control all the way to the left (50:100), the left channel delay time equals half the right channel delay time. If you move the control all the way to the right (100:50), the right channel delay time equals half the left channel delay time.
- **Stereo Width** — Lets you adjust the width of the delay effect in the stereo field.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delay</td>
<td>When you enable Sync, the Delay control lets you select a rhythmic subdivision or multiple of the beat for the delay time (based on the tempo). Select from the following rhythmic values:</td>
</tr>
<tr>
<td>Feedback</td>
<td>Lets you adjust the amount of delay feedback. At 0% the delayed signal repeats only once. As you increase the feedback, the number of times the delay repeats increases. At 100%, the delay repeats for an extended period of time.</td>
</tr>
<tr>
<td>Delay Section</td>
<td></td>
</tr>
</tbody>
</table>
AIR Enhancer (Audio Track Effect)

You can use the Enhancer plug-in to enhance the low and high broadband frequencies of the audio signal.

The following table lists the AIR Enhancer plug-in parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>High Gain</td>
<td>Adjusts the frequency to boost the high end.</td>
</tr>
<tr>
<td>Low Gain</td>
<td>Adjusts the frequency to boost the low end.</td>
</tr>
</tbody>
</table>
AIR Ensemble (Audio Track Effect)

You can use the Ensemble plug-in to apply fluid, shimmering modulation effects to the audio signal.

The following table lists the AIR Ensemble plug-in parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tune</td>
<td>Lets you set the center frequency for low and high-end enhancement.</td>
</tr>
<tr>
<td></td>
<td>• Low — Sets the center frequency for the bass boost.</td>
</tr>
<tr>
<td></td>
<td>• High — Sets the center frequency for the treble boost.</td>
</tr>
<tr>
<td>Harmonic</td>
<td>Lets you generate additional high-frequency harmonics, which can brighten up dull signals.</td>
</tr>
<tr>
<td>Generation</td>
<td>• Depth — Generates additional high frequency harmonics in the signal (0.0–12.0 dB).</td>
</tr>
<tr>
<td></td>
<td>• Phase — Toggles the polarity of the generated harmonics, changing their phase relationship with the dry signal.</td>
</tr>
<tr>
<td>Output</td>
<td>Lets you lower the Output level from 0.0 dB to –INF dB.</td>
</tr>
</tbody>
</table>

AIR Filter Gate (Audio Track Effect)

You can use the Filter Gate effect to chop up the audio signal into staccato rhythmic patterns with variable filtering, amplitude, and panning.

The following table lists the AIR Filter Gate plug-in parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rate</td>
<td>Changes the frequency of the modulating LFO (0.01–10.0 Hz).</td>
</tr>
<tr>
<td>Depth</td>
<td>Adjusts the amount of modulation applied to the Delay time.</td>
</tr>
<tr>
<td>Modulation</td>
<td>Lets you adjust and randomize the delay time.</td>
</tr>
<tr>
<td></td>
<td>• Delay — Adjusts the Delay time.</td>
</tr>
<tr>
<td></td>
<td>• Shimmer — Lets you randomize the Delay time, adding texture to the effect.</td>
</tr>
<tr>
<td>Stereo Width</td>
<td>Lets you widen or narrow the effect’s stereo field.</td>
</tr>
<tr>
<td>Mix</td>
<td>Lets you balance the amount of dry signal with the amount of wet (processed) signal. At 50%, the output includes equal amounts of dry and wet signal. At 0%, the output is all dry and at 100% it is all wet.</td>
</tr>
</tbody>
</table>


<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pattern</td>
<td>Lets you select from a number of preset rhythmic patterns that the gate will follow.</td>
</tr>
</tbody>
</table>
| Gate      | • Attack — Lets you adjust the duration of the attack as a percentage of the step duration.  
           • Hold — Lets you adjust the duration of the hold (or sustain) as a percentage of the step duration.  
           • Release — Lets you adjust the duration of the release as a percentage of the step duration. |
| Filter    | Provides controls for the selected filter type:  
           • Mode — Lets you select the type of Filter:  
             - Off (no filtering)  
             - LP (Low Pass filter)  
             - BP (Band Pass filter)  
             - HP (High Pass filter)  
             - Phaser (Phaser)  
           • Cutoff — Lets you adjust the Filter Cutoff frequency.  
           • Res — Lets you adjust the Resonance at the Cutoff frequency. |
| Modulation| • Env — Lets you adjust how much an envelope follower affects the Cutoff frequency. Note that the Cutoff is fixed for the duration of each step, so it will not respond to a peak in the envelope until the start of the next step.  
           • LFO — Lets you adjust the amount of LFO modulation of the Cutoff frequency.  
           • LFO Steps — Sets the duration of one cycle of the LFO to the selected number of steps. Changes to the Step Rate consequently affect the durations of cycles of the LFO. When set to Random mode, the level of the LFO changes randomly every step, for a “sample and hold” waveform. |
| Rate      | Lets you select the duration, or frequency of the Low Frequency Oscillator (LFO). The duration of one cycle of the LFO is measured in Steps. |
| Mix       | Lets you balance the amount of dry signal with the amount of wet (filtered) signal. At 50%, the output includes equal amounts of dry and wet signal. At 0%, the output is all dry and at 100% it is all wet. |

**AIR Flanger (Audio Track Effect)**

You can use the Flanger plug-in to apply a short modulating delay to the audio signal.

The following table lists the AIR Flanger plug-in parameters:
Sync
Synchronizes the modulation rate to the audio sequence tempo. When you enable Sync, you can select a rhythmic subdivision or multiple of the beat for the Flanger modulation rate. When you disable Sync, you can set the delay time in milliseconds independently of the sequence tempo.

Select from the following rhythmic values:
- 16 (sixteenth note)
- 8T (eighth-note triplet)
- 16D (dotted sixteenth-note)
- 8 (eighth note)
- 4T (quarter-note triplet)
- 8D (dotted eighth-note)
- 4 (quarter note)
- 2T (half-note triplet)
- 4D (dotted quarter-note)
- 2 (half note)
- 1T (whole-note triplet)
- 3/4 (dotted half note)
- 4/4 (whole note)
- 5/4 (five tied quarter notes)
- 6/4 (dotted whole note)
- 8/4 (double whole note)

Depth — Lets you adjust the amount of modulation applied to the Delay time.
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
</table>
| Rate      | Lets you select from the following rhythmic values:  
  - 16 (sixteenth note)  
  - 8T (eighth-note triplet)  
  - 16D (dotted sixteenth-note)  
  - 8 (eighth note)  
  - 4T (quarter-note triplet)  
  - 8D (dotted eighth-note)  
  - 4 (quarter note)  
  - 2T (half-note triplet)  
  - 4D (dotted quarter-note)  
  - 2 (half note)  
  - 1T (whole-note triplet)  
  - 3/4 (dotted half note)  
  - 4/4 (whole note)  
  - 5/4 (five tied quarter notes)  
  - 6/4 (dotted whole note)  
  - 8/4 (double whole note)  
| Depth     | Lets you adjust the amount of modulation applied to the Delay time.  
| Pre-Delay | Sets the minimum delay time in milliseconds.  
| LFO       | Provides controls for the Low Frequency Oscillator (LFO) used to modulate the Delay time.  
  - Retrigger — Resets the LFO phase. This lets you manually start the filter sweep from that specific point in time (or using automation, at a specific point in your arrangement). Clicking the Retrigger button also forces the Mix control up if it is too low while the button is held. This ensures that the sweep is audible.  
  - Wave — lets you interpolate between a triangle wave and a sine wave for the modulating LFO.  
  - L/R Offset — Lets you adjust the phase offset for the LFO waveform applied to the left and right channels.  

AIR Frequency Shifter (Audio Track Effect)

You can use the Frequency Shifter plug-in to shift the audio signal’s individual frequencies inharmonically, creating a unique effect.

The following table lists the AIR Frequency Shifter plug-in parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
</table>
| EQ        | Provides controls for cutting lows from the Flanger signal, and inverting phase.  
- Phase Invert — When enabled, Phase Invert flips the wet signal’s polarity, which changes the harmonic structure of the effect.  
- Low Cut — Lets you adjust the Low Cut frequency for the Flanger, to limit the Flanger effects to higher frequencies. |
| Feedback  | Lets you adjust the amount of delay feedback for the Flanger. At 0%, the delay repeats only once. At +/-100%, the Flanger feeds back on itself. |
| Mix       | Lets you balance the amount of dry signal with the amount of wet (flanged) signal. At 50%, the output includes equal amounts of dry and wet signal. At 0%, the output is all dry and at 100% it is all wet.  
You can use the Mix control to create an “infinite phaser” effect between the dry and shifted signals, which always rises or always falls (depending on the direction of shift). |
| Frequency | Sets the amount of frequency shifting. |
| Shifter   | Provides control over the direction of frequency shift, and feedback of the signal through the algorithm.  
- Mode — Sets the direction of the frequency shifting effect:  
  - Up — Shifts frequencies up.  
  - Down — Shifts frequencies down.  
  - Up & Down — Shifts frequencies equally up and down, and the two shifted signals are heard simultaneously.  
  - Stereo — Shifts the right channel frequencies up, and the left channel down.  
- Feedback — Lets you run the signal through the pitch shifting algorithm multiple times, creating a cascading, layered effect. |
| Mix       | Lets you balance the amount of dry signal with the amount of wet (delayed) signal. At 50%, the output includes equal amounts of dry and wet signal. At 0%, the output is all dry and at 100% it is all wet. |
AIR Fuzz-Wah (Audio Track Effect)

You can use the Fuzz-Wah plug-in to color the audio signal with different types and varying amounts of transistor-like distortion.

The following table lists the AIR Fuzz-Wah plug-in parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fuzz</td>
<td>Turns the distortion effect on and off.</td>
</tr>
<tr>
<td>Drive</td>
<td>Sets the level of gain in the Fuzz algorithm.</td>
</tr>
<tr>
<td>Mix (Fuzz)</td>
<td>Lets you balance the amount of dry signal with the amount of wet (distorted) signal. At 50%, the output includes equal amounts of dry and wet signal. At 0%, the output is all dry and at 100% it is all wet.</td>
</tr>
<tr>
<td>Post Wah</td>
<td>Lets you reverse the Fuzz section and the Wah section, placing one before the other.</td>
</tr>
<tr>
<td>Fuzz section</td>
<td>Provides tonal and volume control over the plug-in.</td>
</tr>
<tr>
<td></td>
<td>• Tone — Lets you change the brightness of the Fuzz algorithm.</td>
</tr>
<tr>
<td></td>
<td>• Output — Sets the overall output volume of the Fuzz section.</td>
</tr>
<tr>
<td>Pedal Min</td>
<td>• Freq — Sets the low (Pedal Min) limit of the wah filter’s frequency sweep.</td>
</tr>
<tr>
<td></td>
<td>• Res — Sets the low (Pedal Min) limit of the wah filter’s resonance.</td>
</tr>
<tr>
<td>Pedal Max</td>
<td>• Freq — Sets the high (Pedal Max) limit of the wah filter’s frequency sweep.</td>
</tr>
<tr>
<td></td>
<td>• Res — Sets the high (Pedal Max) limit of the wah filter’s resonance.</td>
</tr>
<tr>
<td>Modulation</td>
<td>Provides controls for the Low Frequency Oscillator (LFO) and Envelope Follower (ENV) that can be used to modulate the wah filter’s sweep.</td>
</tr>
<tr>
<td></td>
<td>• Rate — Sets either the LFO frequency, or the response time of the envelope follower, depending on the setting of the Mode control.</td>
</tr>
<tr>
<td></td>
<td>• Type — Lets you select either the LFO or the Envelope follower as the modulation source for the wah filter.</td>
</tr>
<tr>
<td></td>
<td>• Depth — Sets the amount of modulation sent by the LFO or envelope follower.</td>
</tr>
<tr>
<td>Wah</td>
<td>Lets you turn the wah filter on and off.</td>
</tr>
<tr>
<td>Pedal</td>
<td>Sweeps the wah center frequency up and down.</td>
</tr>
<tr>
<td>Filter</td>
<td>Switches the wah filter between LP (lowpass), BP (bandpass), and HP (highpass) modes.</td>
</tr>
<tr>
<td>Mix (Wah)</td>
<td>Lets you balance the amount of dry signal with the amount of wet (wah-processed) signal. At 50%, the output includes equal amounts of dry and wet signal. At 0%, the output is all dry and at 100% it is all wet.</td>
</tr>
</tbody>
</table>
AIR Kill EQ (Audio Track Effect)

You can use the Kill EQ plug-in to remove the Low, Mid, or High broadband frequency range from an audio signal. This is a popular effect with DJs and is commonly used in electronic music production (especially in dance music).

The following table lists the AIR Kill EQ plug-in parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mix (overall)</td>
<td>Lets you balance the amount of fuzz-processed signal with the amount of wah-processed signal. At 50%, there are equal amounts of fuzz and wah signal. At 0%, the output is all fuzz, and at 100% it is all wah.</td>
</tr>
<tr>
<td>High</td>
<td>Switches the high frequency band on and off.</td>
</tr>
<tr>
<td>Mid</td>
<td>Switches the middle frequency band on and off.</td>
</tr>
<tr>
<td>Low</td>
<td>Switches the low frequency band on and off.</td>
</tr>
</tbody>
</table>
| Gain | • Low — Controls the volume of the low frequency band.  
• Mid — Controls the volume of the middle frequency band.  
• High — Controls the volume of the high frequency band. |
| Freq | • Low — Sets the crossover frequency of the low pass filter.  
• Sweep — Changes both the low and high-band cutoff frequencies simultaneously. When you kill the high and low bands, manipulating this control creates a swept bandpass filter effect.  
• High — Sets the crossover frequency of the high pass filter. |
| Output | Sets the final output volume. |

AIR Lo Fi (Audio Track Effect)

You can use the Lo Fi effect to bit-crush, down-sample, clip, rectify, and mangle the input signal.

The following table lists the AIR Lo Fi plug-in parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample Rate</td>
<td>Lets you resample the audio signal at another sample rate.</td>
</tr>
</tbody>
</table>
Anti-Alias Provides control over anti-aliasing filters that you can use before and after downsampling to reduce aliasing in the resampled audio signal.

- **On** — Lets you enable or disable the Anti-Alias filter. Disabling the filter creates a much grittier sound.

- **Pre** — Lets you adjust the anti-aliasing filter cutoff applied to the audio signal before resampling. The filter is applied as a multiplier of the sample frequency (Fs) between 0.12 Fs and 2.00 Fs.

- **Post** — Lets you adjust the range of anti-aliasing filter cutoff applied to the audio signal after resampling. The filter is applied as a multiplier of the sample frequency (Fs) between 0.12 Fs and 2.00 Fs.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Anti-Alias</td>
<td>Provides control over anti-aliasing filters that you can use before and after downsampling to reduce aliasing in the resampled audio signal.</td>
</tr>
<tr>
<td></td>
<td>- <strong>On</strong> — Lets you enable or disable the Anti-Alias filter. Disabling the filter creates a much grittier sound.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Pre</strong> — Lets you adjust the anti-aliasing filter cutoff applied to the audio signal before resampling. The filter is applied as a multiplier of the sample frequency (Fs) between 0.12 Fs and 2.00 Fs.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Post</strong> — Lets you adjust the range of anti-aliasing filter cutoff applied to the audio signal after resampling. The filter is applied as a multiplier of the sample frequency (Fs) between 0.12 Fs and 2.00 Fs.</td>
</tr>
</tbody>
</table>
LFO Lets you apply a Low Frequency Oscillator to modulate the Sample Rate.

- **Sync** — Synchronizes the LFO Rate to the audio sequence tempo. When you enable Sync, you can select a rhythmic subdivision or multiple of the beat for the LFO Rate. When you disable Sync, you can change the modulation rate independently of the sequence tempo.

- **Rate** — Select from the following rhythmic values:
  - 16 (sixteenth note)
  - 8T (eighth-note triplet)
  - 16D (dotted sixteenth-note)
  - 8 (eighth note)
  - 4T (quarter-note triplet)
  - 8D (dotted eighth-note)
  - 4 (quarter note)
  - 2T (half-note triplet)
  - 4D (dotted quarter-note)
  - 2 (half note)
  - 1T (whole-note triplet)
  - 3/4 (dotted half note)
  - 4/4 (whole note)
  - 5/4 (five tied quarter notes)
  - 6/4 (dotted whole note)
  - 8/4 (double whole note)

- **Wave** — Select from the following waveforms for the LFO:
  - Sine (sine wave)
  - Tri (triangle wave)
  - Saw (saw-tooth wave)
  - Square (square wave)
  - Morse (Morse code-like rhythmic effect)
  - S&H (Sample and Hold modulation)
  - Random (random modulation)

- **Depth** — Lets you adjust the amount of modulation applied to the Sample Rate.
You can use the AIR Multi-Chorus plug-in to apply a thick, complex chorus effect to the audio signal.

The following table lists the AIR Multi-Chorus plug-in parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rate</td>
<td>Sets the rate for the oscillation of the LFO in Hertz.</td>
</tr>
<tr>
<td>Depth</td>
<td>Sets the depth of LFO modulation of the audio signal in milliseconds.</td>
</tr>
<tr>
<td>Chorus</td>
<td>Provides control over the low-frequency content and stereo width of the Multi-Chorus effect.</td>
</tr>
</tbody>
</table>

  • Low Cut — Lets you adjust the Low Cut frequency for the chorus, to limit the Multi-Chorus effects to higher frequencies.

  • Width — Lets you widen or narrow the effect’s stereo field.
AIR Multi-Delay (Audio Track Effect)

You can use the Multi-Delay Plug-In to apply up to six delay lines to the audio signal.

The following table lists the AIR Multi-Delay plug-in parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
</table>
| Mod       | • Pre Delay — Sets the Pre-Delay in milliseconds.  
             • Waveform — Selects a triangle or a sine wave for the LFO. This affects the character of the modulation. The sine wave has a gentler ramp and peak than the triangle wave. |
| Voices    | Sets the number of layered chorus effects that are applied to the audio signal. The more voices you use, the thicker the effect. |
| Mix       | Lets you adjust the balance between the dry signal and the wet (processed) signal, giving you control over the depth of the effect. 0% is all dry, and 100% is all wet, while 50% is an equal mix of both. |
| Sync      | When you enable Sync, the delay time synchronizes to the tempo of your audio sequence. When you disable Sync, you can set the delay time in milliseconds independently of the tempo. The Sync button is lit when it is enabled. |
| Delay     | When you enable Sync, the Delay control lets you set the main delay length in 16th-note lengths (based on the tempo).  
             When you disable Sync, the Delay control lets you set the delay time in milliseconds and seconds. |
| Feedback  | Lets you adjust the amount of delay feedback. At 0% the delayed signal repeats only once. As you increase the feedback, the number of times the delay repeats increases. At 100%, the delay repeats for an extended period of time.  
             The From and To controls let you feed signal from one delay tap to another, or back to the main input, to create complex delay/feedback effects. If the delay time of the To tap is greater than the delay time of the From tap, then the result is “feed-forward” rather than feedback, so you can hear only one delay repeat.  
             • From — Sets the tap from which signal is cross-routed.  
             • To — Sets the tap (or the main input) to which the cross-routed signal is routed. |
AIR Non-Linear Reverb (Audio Track Effect)

You can use the Non-Linear Reverb effect to apply special gated or reversed reverb effects to the audio signal, creating a synthetic, processed ambience.

The following table lists the AIR Non-Linear Reverb plug-in parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
</table>
| Delay Taps | Provides five Taps (delay lines). Each tap provides the same set of controls. You can edit the controls for each tap independently of the other taps.  
- On — Turns the selected tap’s signal on or off.  
- Delay — Sets the length of delay for the tap, relative to the main Delay setting.  
- Level — Changes the output level of the tap.  
- Pan — Pans the audio signal from the tap left or right in the stereo field. |
| High Cut | Lets you adjust the frequency for the High Cut filter. For less treble, lower the frequency. |
| Low Cut | Lets you adjust the frequency for the Low Cut filter. For less bass, raise the frequency. |
| Mix | Lets you balance the amount of dry signal with the amount of wet (delayed) signal. At 50%, the output includes equal amounts of dry and wet signal. At 0%, the output is all dry and at 100% it is all wet. |
| Reverse | Turns Reverse mode on and off. In Reverse mode, the tail of the reverb signal fades up to full volume, then disappears, rather than fading out.  
- Pre-Delay — Determines the amount of time that elapses between the original audio event and the onset of reverberation.  
- Dry Delay — Applies a specified amount of delay to the dry portion of the signal, which can create a “reverse reverb” effect, where the reverb tail is heard before the dry signal. |
| Reverb | Provides control over the reverb’s diffusion and stereo width.  
- Diffusion — Changes the rate at which the sound density of the reverb tail increases over time. Higher Diffusion settings create a smoother reverberated sound. Lower settings result in more fluttery echo.  
- Width — Lets you widen or narrow the effect’s stereo field. |
You can use the Phaser effect to apply a phaser to the audio signal for a unique sweeping sound.

The following table lists the AIR Phaser plug-in parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sync</td>
<td>When you enable Sync, the delay time synchronizes to the tempo of your audio sequence. When you disable Sync, you can set the delay time in milliseconds independently of the tempo. The Sync button is lit when it is enabled.</td>
</tr>
</tbody>
</table>
When you enable Sync, the Rate control lets you select a rhythmic subdivision or multiple of the beat for the Phaser Modulation Rate. When you disable Sync, you can change the phaser rate independently of the sequence tempo. Select from the following rhythmic values:

- 16 (sixteenth note)
- 8T (eighth-note triplet)
- 16D (dotted sixteenth-note)
- 8 (eighth note)
- 4T (quarter-note triplet)
- 8D (dotted eighth-note)
- 4 (quarter note)
- 2T (half-note triplet)
- 4D (dotted quarter-note)
- 2 (half note)
- 1T (whole-note triplet)
- 3/4 (dotted half note)
- 4/4 (whole note)
- 5/4 (five tied quarter notes)
- 6/4 (dotted whole note)
- 8/4 (double whole note)

Wave — Select from the following waveforms for the LFO:
- Sine (sine wave)
- Tri (triangle wave)
- Saw (saw-tooth wave)
- Square (square wave)
- Morse (Morse code-like rhythmic effect)
- S&H (Sample and Hold modulation)
- Random (random modulation)

Depth  
Lets you adjust the depth of modulation, which in turn affects the amount of phasing applied to the audio signal.
Different physical environments have different early reflection signatures that our ears and brain use to localize sound. These reflections affect our perception of the size of a space as well as where an audio source sits within it. You can use the Reverb effect to apply Reverb to the audio signal, creating a sense of room or space.

The following table lists the AIR Reverb plug-in parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
</table>
| Phaser | Provides control over the effect’s center frequency and number of phaser stages (or poles).  
  - Center — Lets you change the frequency center (100 Hz to 10.0 kHz) for the phaser poles.  
  - Poles — Lets you select the number of phaser poles (stages): 2, 4, 6, or 8. The number of poles changes the character of the sound. The greater the number of poles, the thicker and more sweeping the sound. |
| LFO | Provides control over the waveform and stereo offset of the LFO.  
  - Wave — Lets you interpolate between a triangle wave and a sine wave for modulating the phaser.  
  - L/R Phase — Lets you adjust the relative phase of the LFO modulation applied to the left and right channels. |
| EQ | Provides tonal control over the phase signal. The Low Cut control lets you adjust the frequency of the Low Cut Filter in the phaser’s feedback loop. This can be useful for taming low frequency “thumping” at high feedback settings. |
| Feedback | Feeds the output signal of phaser back into the input, creating a resonant or singing tone in the phaser when set to its maximum. |
| Mix | Lets you balance the amount of dry signal with the amount of wet (effected) signal. At 50%, the output includes equal amounts of dry and wet signal. At 0%, the output is all dry and at 100% it is all wet. |

**AIR Reverb (Audio Track Effect)**

Different physical environments have different early reflection signatures that our ears and brain use to localize sound. These reflections affect our perception of the size of a space as well as where an audio source sits within it. You can use the Reverb effect to apply Reverb to the audio signal, creating a sense of room or space.

The following table lists the AIR Reverb plug-in parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pre-Delay</td>
<td>Determines the amount of time that elapses between the original audio event and the onset of reverberation. Under natural conditions, the amount of pre-delay depends on the size and construction of the acoustic space, and the relative position of the sound source and the listener. Pre-Delay attempts to duplicate this phenomenon, and you can use it to create a sense of distance and volume within an acoustic space. Long Pre-Delay settings place the reverberant field behind rather than on top of the original audio signal.</td>
</tr>
<tr>
<td>Room Size</td>
<td>Changes the apparent size of the space.</td>
</tr>
</tbody>
</table>
Early Reflections

Changes the perceived location of the reflecting surfaces surrounding the audio source. Reverb simulates early reflections by using multiple delay taps at different levels that occur in different positions in the stereo spectrum (through panning). Long reverberation generally occurs after early reflections dissipate.

Type — Provides the following Types of Early Reflection models:

- Booth (a vocal recording booth)
- Club (a small, clear, natural-sounding club ambience)
- Room (the center of a small room without many reflections)
- Small Chamber (a bright, small-sized room)
- Medium Chamber (a bright, medium-sized room)
- Large Chamber (a bright, large-sized room)
- Small Studio (a small, live, empty room)
- Large Studio (a large, live, empty room)
- Scoring Stage (a scoring stage in a medium-sized hall)
- Philharmonic (the space and ambience of a large, symphonic, concert hall)
- Concert Hall (the space and ambience of a large concert hall)
- Church (a medium-sized space with natural, clear-sounding reflections)
- Opera House (the space and ambience of an opera house)
- Vintage 1 (a vintage digital reverb effect)
- Vintage 2 (a vintage digital reverb effect)

Spread — Controls the length of the early reflections.

Reverb

Provides control over the stereo width of the reverb algorithm.

- In Width — Widens or narrows the stereo width of the incoming audio signal before it enters the reverb algorithm.
- Out Width — Widens or narrows the stereo width of the signal once reverb has been applied.
- Delay — Sets the size of the delay lines used to build the reverb effect. Higher values create longer reverberation.

EQ

Provides tonal control over the reverb signal.

- Low Cut — Adjusts the frequency for the Low Cut filter. For less bass, raise the frequency.
- High Cut — Adjusts the frequency for the High Cut filter. For less treble, lower the frequency.
AIR Spring Reverb (Audio Track Effect)

You can use the Spring Reverb effect to apply a classic spring reverb sound. The analog spring reverb feeds a signal to a transducer at the end of a suspended metal coil spring. The transducer causes the spring to vibrate so that the signal reflects from one end of the spring to the other. At the other end of the spring another transducer converts the motion of the spring back into an electrical signal, which creates a delayed and reverberated version of the input signal. The Spring Reverb effect models this analog effect.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Room</td>
<td>Controls the overall spatial feel of the simulated room.</td>
</tr>
<tr>
<td></td>
<td>• Ambience — Affects the attack of the reverb signal. At low settings, the reverb arrives quickly, simulating a small room. At higher settings, the reverb ramps up more slowly, emulating a larger room.</td>
</tr>
<tr>
<td></td>
<td>• Density — Changes the rate at which the sound density of the reverb tail increases over time. Higher Density settings create a smoother reverberated sound. Lower settings result in more fluttery echo.</td>
</tr>
<tr>
<td>High Freqs</td>
<td>Provides controls that let you shape the tonal spectrum of the reverb by adjusting the decay times of higher frequencies.</td>
</tr>
<tr>
<td></td>
<td>• Time — Decreases or increases the decay time for mid- to high-range frequency bands. Higher settings provide longer decay times and lower settings provide shorter decay time. With lower settings, high frequencies decay more quickly than low frequencies, simulating the effect of air absorption in a hall.</td>
</tr>
<tr>
<td></td>
<td>• Freq — Sets the frequency boundary between the mid- and high-range frequency bands.</td>
</tr>
<tr>
<td></td>
<td>• Cut — Adjusts the frequency for the High Cut filter (1.00–20.0 kHz). Adjusting the High Cut control changes the decay characteristics of the high frequency components of the Reverb. To cut the high-end of the processed signal, lower the frequency.</td>
</tr>
<tr>
<td>Low Freqs</td>
<td>Controls the low-frequency-heavy tail of the reverb signal.</td>
</tr>
<tr>
<td></td>
<td>• Time — Decreases or increases the decay time for the low-range frequency band. Higher settings provide longer decay times and lower settings provide shorter decay time.</td>
</tr>
<tr>
<td></td>
<td>• Freq — Sets the frequency boundary between the low and high-range frequency bands.</td>
</tr>
<tr>
<td>Reverb Time</td>
<td>Changes the rate at which the reverberation decays after the original direct signal stops. At its maximum value, infinite reverberation is produced.</td>
</tr>
<tr>
<td>Balance</td>
<td>Changes the output level of the early reflections. Setting the level control to 0% produces a reverb effect that is only the reverb tail.</td>
</tr>
<tr>
<td>Mix</td>
<td>Lets you balance the amount of dry signal with the amount of wet (processed) signal. At 50%, the output includes equal amounts of dry and wet signal. At 0%, the output is all dry and at 100% it is all wet.</td>
</tr>
</tbody>
</table>
The following table lists the AIR Spring Reverb plug-in parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pre-Delay</td>
<td>Determines the amount of time (0–250 ms) that elapses between the original audio event and the onset of reverberation.</td>
</tr>
<tr>
<td>Reverb</td>
<td>Provides control over the diffusion and stereo width of the reverb signal.</td>
</tr>
<tr>
<td></td>
<td>• Diffusion — Changes the rate at which the sound density of the reverb tail increases over time. Higher Diffusion settings create a smoother reverberated sound. Lower settings result in more fluttery echo.</td>
</tr>
<tr>
<td></td>
<td>• Width — Changes the spread of the reverberated signal in the stereo field. A setting of 0% produces a mono reverb, but leaves the panning of the original source signal unprocessed. A setting of 100% produces a open, panned stereo image.</td>
</tr>
<tr>
<td>Low Cut</td>
<td>Lets you adjust the frequency of the Low Cut Filter (20.0 Hz–1.00 kHz). Use the Low Cut filter to reduce some of the potential low frequency resonance (or booming) you can get with longer reverb times.</td>
</tr>
<tr>
<td>Reverb Time</td>
<td>Changes the reverberation decay time (1.0–10.0 seconds) after the original direct signal stops. Shorter times result in a tighter, more ringing and metallic reverb, such as when walking down a narrow hall with hard floors and walls. Longer times result in a larger reverberant space, such as an empty, large, concrete cistern.</td>
</tr>
<tr>
<td>Mix</td>
<td>Lets you balance the amount of dry (non-reverb) signal with the amount of wet (reverb) signal. At 50%, the output includes equal amounts of dry and wet signal. At 0%, the output is all dry and at 100% it is all wet.</td>
</tr>
</tbody>
</table>

**AIR Stereo Width (Audio Track Effect)**

You can use the Stereo Width effect to create a wider stereo presence for mono audio signals.

The following table lists the AIR Stereo Width plug-in parameters:
AIR Talkbox (Audio Track Effect)

You can use the Talkbox effect to add voice-like resonances to audio signals.

The following table lists the AIR Talkbox plug-in parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vowel</td>
<td>Lets you choose the shape of the formant filter, by the vowel sound that is simulated (OO/OU/AU/AH/AA/AE/EH/EE/ER/UH/OH).</td>
</tr>
<tr>
<td>Env Depth</td>
<td>Creates a positive or negative offset in the setting of the Vowel control, effected by the envelope follower. At its center, the knob has no effect. Turned to the right or left of center, the Env Depth knob shifts the value of the Vowel control up or down. When you trigger the envelope follower, the Vowel parameter moves to its normal setting (in time with the envelope’s attack), then back to the offset value (in time with the envelope’s release).</td>
</tr>
</tbody>
</table>
LFO Provides controls that let you apply a Low Frequency Oscillator to modulate the Formant setting.

Sync — Synchronize the LFO Rate to the audio sequence tempo. When you enable Sync, you can select a rhythmic subdivision or multiple of the beat for the LFO Rate. When you disable Sync, you can change the modulation rate independently of the sequence tempo.

Rate — Select from the following rhythmic values:

- 16 (sixteenth note)
- 8T (eighth-note triplet)
- 16D (dotted sixteenth-note)
- 8 (eighth note)
- 4T (quarter-note triplet)
- 8D (dotted eighth-note)
- 4 (quarter note)
- 2T (half-note triplet)
- 4D (dotted quarter-note)
- 2 (half note)
- 1T (whole-note triplet)
- 3/4 (dotted half note)
- 4/4 (whole note)
- 5/4 (five tied quarter notes)
- 6/4 (dotted whole note)
- 8/4 (double whole note)

Wave — Select from the following waveforms for the LFO:

- Sine (sine wave)
- Tri (triangle wave)
- Saw (saw-tooth wave)
- Square (square wave)
- S&H (Sample and Hold modulation)
- Random (random modulation)

Depth — Lets you adjust the amount of modulation applied to the Formant setting.
You can use the Vintage Filter effect to apply a modulating, resonant filter to the audio signal. You can experiment with filter sweeps or give your sounds a large, resonant sound.

The following table lists the AIR Vintage Filter plug-in parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
</table>
| Envelope  | Modulates the Formant setting by using an envelope follower. This allows you to accentuate and enhance signal peaks in rhythmic material.  
  - Thresh — Sets the amplitude threshold at which the Formant setting begins to be modulated by the envelope follower.  
  - Attack — Sets the time (10.0 ms to 10 seconds) it takes to respond to increases in the audio signal level.  
  - Release — Sets the time (10.0 ms to 10 seconds) it takes to recover after the signal level falls. |
| Mix       | Lets you balance the amount of dry signal with the amount of wet (processed) signal. At 50%, the output includes equal amounts of dry and wet signal. At 0%, the output is all dry and at 100% it is all wet. |
| Cutoff    | Lets you adjust the Cutoff frequency (20.0 Hz to 20.0 kHz) of the filter. |
| Resonance | Lets you adjust the amount filter Resonance (0–100%). The filter can go into self-oscillation at high values creating a sine wave-like overtone at the Cutoff frequency. |
| Fat       | Lets you adjust the amount of overdrive in the resonant peak. At lower settings the signal gets quieter at high resonance settings for clean distortion. At higher settings the signal is over-driven at high resonance settings. |
The Bomb Factory BF76 plug-in is a compressor modeled after the solid-state (transistor) 1176 studio compressor. Introduced in the late 1970s, the 1176 offers a much different compression sound than other compressors.

The following table lists the Bomb Factory BF76 plug-in parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Envelope</td>
<td>Provides an envelope follower for controlling the Cutoff frequency, which allows you to control the envelope’s shape and depth of modulation.</td>
</tr>
<tr>
<td></td>
<td>• Attack — Sets the time (10.0 ms to 10 seconds) it takes to respond to increases in the audio signal level.</td>
</tr>
<tr>
<td></td>
<td>• Release — Sets the time (10.0 ms to 10 seconds) it takes to recover after the signal level falls.</td>
</tr>
<tr>
<td></td>
<td>• Depth — Determines how much the envelope follower affects the Cutoff frequency.</td>
</tr>
<tr>
<td></td>
<td>- At 0%, the envelope follower has no effect on the Cutoff frequency.</td>
</tr>
<tr>
<td></td>
<td>- At +100%, the Attack ramps up to the Cutoff frequency setting, and the Release starts from the Cutoff frequency setting and ramps down.</td>
</tr>
<tr>
<td></td>
<td>- At –100%, the Attack starts from the Cutoff frequency setting and ramps down, and the Release ramps up to the Cutoff frequency setting.</td>
</tr>
<tr>
<td>LFO</td>
<td>Provides a sinusoidal Low Frequency Oscillator (LFO) for modulating the filter cutoff frequency, which allows you to control the rate, depth and synchronization of the modulation.</td>
</tr>
<tr>
<td></td>
<td>• Sync — Turns on and off the synchronization between the LFO and the sequence tempo.</td>
</tr>
<tr>
<td></td>
<td>• Rate — Increases or decreases the frequency (0.01–100.0 Hz) of the LFO. Lower settings are slower and higher settings are faster. When you enable Sync, the Rate knob changes from counting in milliseconds to rhythmic values.</td>
</tr>
<tr>
<td></td>
<td>• Depth — Increases or decreases the amount of modulation (0–100%) of the Cutoff frequency by the LFO. Lower settings create a slight vibrato (with the rate set high) and higher settings create a wide sweep of the Cutoff frequency range.</td>
</tr>
<tr>
<td>Mode</td>
<td>Select one of the following options for the type of filter:</td>
</tr>
<tr>
<td></td>
<td>• LP24 — Provides a low pass filter with a 24 dB cutoff.</td>
</tr>
<tr>
<td></td>
<td>• LP18 — Provides a low pass filter with a 18 dB cutoff.</td>
</tr>
<tr>
<td></td>
<td>• LP12 — Provides a low pass filter with a 12 dB cutoff.</td>
</tr>
<tr>
<td></td>
<td>• BP — Provides a band pass filter.</td>
</tr>
<tr>
<td></td>
<td>• HP — Provides a high pass filter.</td>
</tr>
<tr>
<td>Output</td>
<td>Lets you lower the Output level from 0.0 dB to –INF dB.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
</tr>
<tr>
<td>Input</td>
<td>Sets the input signal level to the compressor, which, in the 1176 design, determines both the threshold and amount of peak reduction.</td>
</tr>
<tr>
<td>Output</td>
<td>Sets output level. Use this control to bring the signal back to unity after applying gain reduction.</td>
</tr>
<tr>
<td>Attack</td>
<td>Sets the attack time of the compressor. Full counterclockwise is slowest, and full clockwise is fastest. Attack times vary between 0.4 milliseconds to 5.7 milliseconds.</td>
</tr>
<tr>
<td>Release</td>
<td>Sets the release time of the compressor. Full counterclockwise is slowest, and full clockwise is fastest. Attack times vary between 0.06 milliseconds to 1.1 seconds.</td>
</tr>
</tbody>
</table>

Setting either the attack or release time too fast generates signal distortion (as it did on the original 1176 compressor). This may or may not be the effect you want to achieve.

<table>
<thead>
<tr>
<th>Ratio</th>
<th>Selects the compression ratio. Available ratios range from 4:1 to 20:1. You can also Shift-click any one of the Ratio buttons to enable “All Buttons In” mode. The compression ratio is still only 20:1, but the knee changes drastically and the compressor starts (mis)behaving a little bit like an expander—watch the meter for details.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Meter</td>
<td>Determines how the meter operates.</td>
</tr>
<tr>
<td></td>
<td>• GR shows the amount of gain reduction</td>
</tr>
<tr>
<td></td>
<td>• –18 and –24 show the output level (calibrated so that 0VU indicates –18dB FS and –24dB FS respectively)</td>
</tr>
<tr>
<td></td>
<td>• Off turns off the meter</td>
</tr>
</tbody>
</table>

Channel Strip (Audio Track Effect and AudioSuite)

Channel Strip provides EQ, Dynamics, Filter, and Gain effects. Channel Strip processing algorithms are based on the award winning Euphonix System 5 console channel strip effects.

The following table lists the Channel Strip plug-in parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input</td>
<td></td>
</tr>
<tr>
<td>Input Trim</td>
<td>The Input Trim control sets the input gain of the plug-in before EQ processing, letting you make up gain or prevent clipping at the plug-in input stage.</td>
</tr>
<tr>
<td>Phase Invert</td>
<td>The Phase Invert button at the top of the Input section inverts the phase (polarity) of the input signal, to help compensate for phase anomalies that can occur either in multi-microphone environments or because of mis-wired balanced connections.</td>
</tr>
</tbody>
</table>
Core Avid Audio Plug-Ins

**Input Meters**
The Input meters show peak signal levels before processing:

- Dark Blue - Indicates nominal levels from –INF to –12 dB.
- Light Blue - Indicates pre-clipping levels, from –12 dB to 0 dB.
- White - Indicates full scale levels from 0 dB to +6 dB.

**Gain Reduction Meters**
The Input meter can be switched to show Gain Reduction metering for the processed signal from 0 dB to –36 dB.

The Gain Reduction meters are usually displayed in yellow. When the Knee setting for either or both the Expander and the Compressor is greater than 0 dB, the Gain Reduction meter displays the amount of the Knee level in amber over the meter’s usual yellow display.

**Output Section**

**Output Volume Control**
The Output Volume control sets the output volume after processing, letting you make up gain or prevent clipping on the channel where the Channel Strip plug-in is being used.

**Output Meters**
The Output meters show peak signal levels before processing:

- Dark Blue - Indicates nominal levels from –INF to –12 dB.
- Light Blue - Indicates pre-clipping levels, from –12 dB to 0 dB.
- White - Indicates full scale levels from 0 dB to +6 dB.

**Channel Strip FX Chain**
Channel Strip lets you determine the signal path through the available Equalizer (EQ), Filter (FILT), Dynamics (DYN), and Volume (VOL) processing modules. This way you can determine the best signal path for the type of processing you want.

To set the FX Chain:

Click the FX Chain show/hide button to reveal the Process Order options.

Click an effects chain ordering option to select it. The available options include:

- EQ > FILT > DYN
- EQ > DYN > FILT
- DYN > EQ > FILT
- FILT > DYN > EQ

Select PRE or POST to place the Output Volume control at the beginning or at the end of the effects signal chain.

**Channel Strip Dynamics**
Core Avid Audio Plug-Ins

Parameter | Description
---|---
The Dynamics Graph display—used with Expander/Gate and Compressor/Limiter processing—shows a curve that represents the level of the input signal (on the horizontal x-axis) and the amount of gain reduction applied (on the vertical y-axis). The display shows two vertical lines representing the Threshold setting for the Expander/Gate and Compressor/Limiter, respectively.

The Dynamics Graph display also features an animated red ball in the gain transfer curve display. This ball shows the amount of input gain (x-axis) and gain reduction (y-axis) being applied to the incoming signal at any given moment. To indicate overshoots (when an incoming signal peak is too fast for the current compression setting), the cursor temporarily leaves the gain transfer curve.

Use this graph as a visual guideline to see how much dynamics processing you are applying to the incoming audio signal.

**Expander/Gate Controls**

**Threshold**

The Threshold (Thresh) control sets the level below which an input signal must fall to trigger expansion or gating. Signals that fall below the threshold will be reduced in gain. Signals that are above it will be unaffected.

The Dynamics Graph display shows the threshold as a vertical line.

**Attack**

The Attack control sets the attack time, or the rate at which gain is reduced after the input signal crosses the threshold. Use this along with the Ratio setting to control how soft the Expander’s gain reduction curve is.

**Ratio**

The Ratio control sets the amount of expansion. For example, if this is set to 2:1, it will lower signals below the threshold by one half. At higher ratio levels the Expander/Gate functions like a gate by cutting off signals that fall below the threshold. As you adjust the ratio control, refer to the Dynamics Graph display to see how the shape of the expansion curve changes.

**Depth**

The Depth control sets the depth of the Expander/Gate when closed. Setting the gate to higher range levels allows more and more of the gated audio that falls below the threshold to peek through the gate at all times.

**Hold**

The Hold control specifies the duration (in seconds or milliseconds) during which the Expander/Gate will stay in effect after the initial attack occurs. This can be used as a function to keep the Expander/Gate in effect for longer periods of time with a single crossing of the threshold. It can also be used to prevent gate chatter that may occur if varying input levels near the threshold cause the gate to close and open very rapidly.

**Release**

The Release control sets how long it takes for the gate to close after the input signal falls below the threshold level and the hold time has passed.

**Knee**

The Knee control sets the rate at which the Expander/Gate reaches full effect once the threshold has been exceeded.
## Core Avid Audio Plug-Ins

### Hysteresis
The Hysteresis (Hyst) control lets you adjust whether or not the gate rapidly opens and closes when the input signal is fluctuating near the Threshold. This can help prevent undesirably rapid gating of the signal. This control is only available when Ratio is set to Gate, otherwise it is greyed out.

### Compressor/Limiter Controls

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threshold</td>
<td>The Threshold control sets the level that an input signal must exceed to trigger compression or limiting. Signals that exceed this level will be compressed. Signals that are below it will be unaffected.</td>
</tr>
<tr>
<td>Attack</td>
<td>The Attack control sets the attack time, or the rate at which gain is reduced after the input signal crosses the threshold. The smaller the value, the faster the attack. The faster the attack, the more rapidly the Compressor/Limiter applies attenuation to the signal. If you use fast attack times, you should generally use a proportionally longer release time, particularly with material that contains many peaks in close proximity.</td>
</tr>
<tr>
<td>Ratio</td>
<td>The Ratio control sets the compression ratio, or the amount of compression applied as the input signal exceeds the threshold. For example, a 2:1 compression ratio means that a 2 dB increase of level above the threshold produces a 1 db increase in output. The compression ratio ranges from 1.0:1 to 20.0:1. Once the Ratio control passes 20.0:1 the Compressor/Limiter effect functions as a limiter rather than a compressor. At the limiter setting (LMTR), for every decibel that the incoming signal goes over the set Threshold, 1 dB of gain reduction is applied. Once the Ratio control passes the LMTR setting, it provides negative ratio settings from –20.0:1 to 0:1. With these settings, for every decibel that the incoming signal goes over the set Threshold, more than 1 dB of gain reduction is applied according to the negative Ratio setting. For example, at the setting of –1.0:1, for each decibel over the set threshold, 2 db of gain reduction is applied. Consequently, the output signal is both compressed and made softer. You can use this as an creative effect, or as a kind of ducking effect when used with an external key input.</td>
</tr>
<tr>
<td>Depth</td>
<td>The Depth control sets the amount of gain reduction that is applied regardless of the input signal. For example, if the Limiter is set at a Threshold of –20 dB and Depth is set at 0 dB, up to 20 dB of gain reduction is applied to the incoming signal (at 0 dB). If you set Depth to –10 dB, no more than 10 dB of gain reduction is applied to the incoming signal.</td>
</tr>
<tr>
<td>Release</td>
<td>The Release control sets the length of time it takes for the Compressor/Limiter to be fully deactivated after the input signal drops below the threshold. Release times should be set long enough that if signal levels repeatedly rise above the threshold, the gain reduction “recovers” smoothly. If the release time is too short, the gain can rapidly fluctuate as the compressor repeatedly tries to recover from the gain reduction. If the release time is too long, a loud section of the audio material could cause gain reduction that continues through soft sections of program material without recovering.</td>
</tr>
</tbody>
</table>
Knee The Knee control sets the rate at which the compressor reaches full compression once the threshold has been exceeded.

As you increase this control, it goes from applying “hard-knee” compression to “soft-knee” compression:

With hard-knee compression, compression begins when the input signal exceeds the threshold. This can sound abrupt and is ideal for limiting.

With soft-knee compression, gentle compression begins and increases gradually as the input signal approaches the threshold, and reaches full compression after exceeding the threshold. This creates smoother compression.

Gain The Gain control lets you boost overall output gain to compensate for heavily compressed or limited signals.

Side Chain Processing Controls

Source The Source selector lets you set the source for side chain processing: Internal, Key, or All-Linked.

Internal - If Internal is selected, the plug-in uses the amplitude of the input signal to trigger dynamics processing. With greater-than-stereo multichannel processing, the input signal for each stereo pair effects only those same channels, and likewise mono channels are effected only by their own input signal. For example, with an LCR multichannel format, the processing for the Center channel is only triggered when the Center channel input signal reaches the threshold. However, when the input signal reaches the threshold on the Left or the Right channel, processing is triggered for both the Left and the Right channel.

Key - If Key is selected, the plug-in uses the amplitude of a separate reference track or external audio source to trigger dynamics processing. The reference track used is selected using the Plug-In Key Input selector in the Plug-In window header. With greater-than-stereo multichannel processing, the key signal triggers dynamics processing for all processed audio channels equally.

All-Linked - If All-Linked is selected, dynamics processing is applied equally to all channels when the input signal reaches the threshold on any input channel, except for the LFE channel (if present). The LFE channel is processed independently based on its own input signal.

Detection The Detection options include Peak or Avg (Average).

Peak - Select the Peak option to apply side-chain processing according to the detected peak amplitude.

Average - Select the Average option to apply side-chain processing according to the detected average amplitude.
### Parameter Description

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter Frequency</td>
<td>The Filter Frequency control lets you set the frequency for the selected Filter Type. Four Filter Type options are available for side-chain processing: Low Pass - Select the Low Pass option to apply a low pass filter to the side-chain processing at the selected frequency. High Pass - Select the High Pass option to apply a high pass filter to the side-chain processing at the selected frequency. Notch - Select the Notch option to apply a notch filter to the side-chain processing at the selected frequency. Band Pass - Select the Band Pass option to apply a band pass filter to the side-chain processing at the selected frequency.</td>
</tr>
<tr>
<td>Side Chain Processing Graph</td>
<td>The Side Chain Processing Graph display shows the frequency curve for the selected Filter Type at the selected Filter Frequency.</td>
</tr>
</tbody>
</table>

### Channel Strip EQ/Filters Section

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EQ/Filters Graph</td>
<td>The EQ/Filters section provides an interactive Frequency Graph display that shows the response curve for the current EQ settings on a two-dimensional graph of frequency and gain. The Frequency Graph display also lets you modify frequency, gain, and Q settings for individual EQ bands by dragging their corresponding points in the graph. The Frequency Graph display also plots the frequency, Q, and filter shape of the two filters (when either or both are enabled).</td>
</tr>
<tr>
<td>Low Frequency Controls</td>
<td>The LF tab provides controls for the low frequency band of the EQ. The low frequency band can be set to be a Peak or Low Shelf EQ. EQ Type - Select either the Peak or Low Shelf button to set the EQ type for the low frequency band. Frequency - The Frequency control lets you set the center frequency for the low frequency band (Peak or Shelf EQ). Gain - The Gain control lets you boost or attenuate the corresponding frequencies for the low frequency band. Q - With the low band EQ set to Peak, the Q control changes the width of the EQ band. Higher Q values represent narrower bandwidths. Lower Q values represent wider bandwidths. With the low band EQ set to Shelf, the Q control changes the Q of the shelving filter. Higher Q values represent steeper shelving curves. Lower Q values represent broader shelving curves.</td>
</tr>
</tbody>
</table>
### Low Mid Frequency EQ Controls
The LMF tab provides controls for the low mid frequency band of the EQ. This band is a peak EQ.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency</td>
<td>The Frequency control lets you set the center frequency for the peak low mid frequency band.</td>
</tr>
<tr>
<td>Gain</td>
<td>The Gain control lets you boost or attenuate the corresponding frequencies for the low mid frequency band.</td>
</tr>
<tr>
<td>Q</td>
<td>The Q control changes the width of the low mid peak EQ band. Higher Q values represent narrower bandwidths. Lower Q values represent wider bandwidths.</td>
</tr>
</tbody>
</table>

### High Mid Frequency EQ Controls
The HMF tab provides controls for the high mid frequency band of the EQ. This band is a peak EQ.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency</td>
<td>The Frequency control lets you set the center frequency for the peak high mid frequency band.</td>
</tr>
<tr>
<td>Gain</td>
<td>The Gain control lets you boost or attenuate the corresponding frequencies for the high mid frequency band.</td>
</tr>
<tr>
<td>Q</td>
<td>The Q control changes the width of the high mid peak EQ band. Higher Q values represent narrower bandwidths. Lower Q values represent wider bandwidths.</td>
</tr>
</tbody>
</table>

### High Frequency EQ Controls
The High Frequency EQ tab provides controls for the high frequency band of the EQ.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter Type</td>
<td>The High Frequency band can be set to be a Peak or High Shelf EQ.</td>
</tr>
<tr>
<td>Frequency</td>
<td>The Frequency control lets you set the center frequency for the high frequency band (Peak or Shelf EQ).</td>
</tr>
<tr>
<td>Gain</td>
<td>The Gain control lets you boost or attenuate the corresponding frequencies for the high frequency band.</td>
</tr>
<tr>
<td>Q</td>
<td>With the high band EQ set to Peak, the Q control changes the width of the EQ band. Higher Q values represent narrower bandwidths. Lower Q values represent wider bandwidths. With the high band EQ set to Shelf, the Q control changes the Q of the shelving filter. Higher Q values represent steeper shelving curves. Lower Q values represent broader shelving curves.</td>
</tr>
</tbody>
</table>
Compressor/Limiter III — Dynamics III (Audio Track Effect and AudioSuite)

The Compressor/Limiter III plug-in applies either compression or limiting to audio material, depending on the ratio of compression used.

Compression reduces the dynamic range of signals that exceed a chosen threshold by a specific amount.

Limiting prevents signal peaks from ever exceeding a chosen threshold, and is generally used to prevent short-term peaks from reaching their full amplitude. Used judiciously, limiting produces higher average levels, while avoiding overload (clipping or distortion), by limiting only some short-term transients in the source audio. To prevent the ear from hearing the gain changes, extremely short attack and release times are used.

Limiting is used to remove only occasional peaks because gain reduction on successive peaks would be noticeable. If audio material contains many peaks, the threshold should be raised and the gain manually reduced so that only occasional, extreme peaks are limited.

The following table lists the Compressor/Limiter III plug-in parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
</table>
| Filter 1 and Filter 2 Controls | The Filter 1 and Filter 2 tabs provide the same set of controls for each filter.  
Filter Type - Both Filter 1 and Filter 2 can be set independently. Select from the following Filter Type options: High Pass, Low Pass, Band Pass, and Notch.  
Frequency - The Frequency control lets you set the center frequency for the selected Filter Type (from 20 Hz to 21.0 kHz).  
Slope - When the Filter Type is set to Low Pass or High Pass, the Slope control is available. The Slope control lets you set the slope for the filter from the selected Frequency to –INF (12 dB/O or 24 dB/O).  
Q - When the Filter Type is set to Band Pass or Notch, the Q control is available. The Q control changes the width of the filter around the center frequency band. Higher Q values represent narrower bandwidths. Lower Q values represent wider bandwidths. |
| Levels panel            | Phase invert button Inverts the phase (polarity) of the input signal, to help compensate for phase anomalies that can occur either in multi-microphone environments or because of mis-wired balanced connections. |
Input/Output level meters: Show peak signal levels before and after processing.
- Green indicates nominal levels
- Yellow indicates pre-clipping levels, starting at –6 dB below full scale
- Red indicates full scale levels (clipping)

Unlike scales on analog compressors, metering scales on a digital device reflect a 0 dB value that indicates full scale (fs)—the full-code signal level. There is no headroom above 0 dB.

The clip indicators at the top of the Output meters indicate clipping at the input or output stage of the plug-in. Click an indicator to clear it.

Threshold arrow: The orange Threshold arrow next to the Input meter indicates the current threshold. You can drag the arrow up or down to adjust the threshold. For more information on threshold, see the Threshold row below in this table.

Gain Reduction meter (GR): Indicates the amount the input signal is attenuated (in dB) and shows different colors during dynamics processing.
- Light orange indicates that gain reduction is within the “knee” and has not reached the full ratio of compression
- Dark orange indicates that gain reduction is being applied at the full ratio (for example, 2:1)

Graph display: Shows a curve that represents the level of the input signal (on the x-axis) and the level of the output signal (on the y-axis). The orange vertical line represents the threshold. Use this graph as a visual guideline to see how much dynamics processing you are applying.

Side-Chain panel: The side-chain is the split-off signal used by the plug-in’s detector to trigger dynamics processing. The Side-Chain panel lets you toggle the side-chain between the internal input signal or an external key input, and tailor the equalization of the side-chain signal so that the triggering of dynamics processing becomes frequency-sensitive.

For full information on how to work with the side-chain controls, see “Using the Side-Chain Input in Dynamics III” in the Avid DigiRack Plug-Ins Guide. Search for “digirack plug-ins guide” at www.avid.com.
**Parameter** | **Description**
--- | ---
**Compressor/Limiter panel (COMP/LIMIT)**
Knee | Sets the rate at which the compressor reaches full compression once the threshold has been exceeded. As you increase this control, it goes from applying “hard-knee” compression to “soft-knee” compression. Values range from 0dB (hardest response) to 30dB (softest response).

With hard-knee compression, compression begins when the input signal exceeds the threshold. This can sound abrupt and is ideal for limiting.

With soft-knee compression, gentle compression begins and increases gradually as the input signal approaches the threshold, and reaches full compression after exceeding the threshold. This creates smoother compression.

The following illustration shows examples of hard knee and soft knee compression in the graph display.

![](hard_knee.png) ![soft_knee.png]

Hard knee (left) and soft knee (right)

Ratio | Sets the compression ratio, or the amount of compression applied as the input signal exceeds the threshold. For example, a 2:1 compression ratio means that a 2 dB increase of level above the threshold produces a 1 db increase in output. Values range from 1:1 (no compression) to 100:1 (hard limiting).

Limiting generally begins with the ratio set at 10:1 and higher. Large ratios effectively limit the dynamic range of the signal to a specific value by setting an absolute ceiling for the dynamic range.
Core Avid Audio Plug-Ins

Attack
Sets the attack time, or the rate at which gain is reduced after the input signal crosses the threshold. Values range from 10 microseconds (fastest attack time) to 300 milliseconds (slowest attack time).

The smaller the value, the faster the attack. The faster the attack, the more rapidly the Compressor/Limiter applies attenuation to the signal. If you use fast attack times, you should generally use a proportionally longer release time, particularly with material that contains many peaks in close proximity.

To use compression most effectively, the attack time should be set so that signals exceed the threshold level long enough to cause an increase in the average level. This helps ensure that gain reduction does not decrease the overall volume too drastically, or eliminate desired attack transients in the program material. Of course, compression has many creative uses that break these rules.

Release
Sets the length of time it takes for the Compressor/Limiter to be fully deactivated after the input signal drops below the threshold. Values range from 5 milliseconds (fastest release time) to 4 seconds (slowest release time).

Release times should be set long enough that if signal levels repeatedly rise above the threshold, the gain reduction “recovers” smoothly. If the release time is too short, the gain can rapidly fluctuate as the compressor repeatedly tries to recover from the gain reduction. If the release time is too long, a loud section of the audio material could cause gain reduction that continues through soft sections of program material without recovering.

Gain
Lets you boost overall output gain to compensate for heavily compressed or limited signals. Values range from 0 dB (no gain boost) to +40 dB (loudest gain boost). 0 dB is the default value.

Threshold (THRESH)
Sets the level that an input signal must exceed to trigger compression or limiting. Signals that exceed this level will be compressed. Signals that are below it will be unaffected. Values range approximately from -60 dB to 0 dB (no compression or limiting). -24 dB is the default value.

In the Levels panel, the orange Threshold arrow on the Input meter indicates the current threshold. You can drag the arrow up and down to adjust the Threshold setting.

In the graph display, the threshold appears as an orange vertical line.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attack</td>
<td>Sets the attack time, or the rate at which gain is reduced after the input signal crosses the threshold. Values range from 10 microseconds (fastest attack time) to 300 milliseconds (slowest attack time). The smaller the value, the faster the attack. The faster the attack, the more rapidly the Compressor/Limiter applies attenuation to the signal. If you use fast attack times, you should generally use a proportionally longer release time, particularly with material that contains many peaks in close proximity. To use compression most effectively, the attack time should be set so that signals exceed the threshold level long enough to cause an increase in the average level. This helps ensure that gain reduction does not decrease the overall volume too drastically, or eliminate desired attack transients in the program material. Of course, compression has many creative uses that break these rules.</td>
</tr>
<tr>
<td>Release</td>
<td>Sets the length of time it takes for the Compressor/Limiter to be fully deactivated after the input signal drops below the threshold. Values range from 5 milliseconds (fastest release time) to 4 seconds (slowest release time). Release times should be set long enough that if signal levels repeatedly rise above the threshold, the gain reduction “recovers” smoothly. If the release time is too short, the gain can rapidly fluctuate as the compressor repeatedly tries to recover from the gain reduction. If the release time is too long, a loud section of the audio material could cause gain reduction that continues through soft sections of program material without recovering.</td>
</tr>
<tr>
<td>Gain</td>
<td>Lets you boost overall output gain to compensate for heavily compressed or limited signals. Values range from 0 dB (no gain boost) to +40 dB (loudest gain boost). 0 dB is the default value.</td>
</tr>
<tr>
<td>Threshold (THRESH)</td>
<td>Sets the level that an input signal must exceed to trigger compression or limiting. Signals that exceed this level will be compressed. Signals that are below it will be unaffected. Values range approximately from -60 dB to 0 dB (no compression or limiting). -24 dB is the default value. In the Levels panel, the orange Threshold arrow on the Input meter indicates the current threshold. You can drag the arrow up and down to adjust the Threshold setting. In the graph display, the threshold appears as an orange vertical line.</td>
</tr>
</tbody>
</table>
D-Verb (Audio Track Effect and AudioSuite)

Digital reverberation processing can simulate the complex natural reflections and echoes that occur after a sound has been produced. Reverberation can take relatively lifeless mono source material and create a stereo acoustic environment that gives the source a perceived weight and depth in a mix. In addition, digital signal processing can be used creatively to produce reverberation characteristics that do not exist in nature.

The character of reverberation depends on a number of factors. These include proximity to the sound source, the shape of the space, the absorptivity of the construction material, and the position of the listener. D-Verb provides control over these reverberation parameters so that extremely natural sounding reverb effects can be created and applied.

The D-Verb plug-in has the following parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input</td>
<td>Lets you adjust the input volume of the reverberation.</td>
</tr>
<tr>
<td>Mix</td>
<td>Lets you adjust the balance between the Dry (source) signal and the Wet (processed) signal, giving you control over the depth of the effect.</td>
</tr>
<tr>
<td>Algorithm</td>
<td>Lets you select one of seven reverberation algorithms. Selecting an algorithm changes the preset provided for it.</td>
</tr>
<tr>
<td></td>
<td>• Hall — Good, general-purpose concert hall with a natural character</td>
</tr>
<tr>
<td></td>
<td>• Church — Dense, diffuse space simulating a church or cathedral</td>
</tr>
<tr>
<td></td>
<td>• Plate — Simulation of the acoustic character of a metal plate–based reverberation, which has the general effect of thickening the initial sound itself</td>
</tr>
<tr>
<td></td>
<td>• Room 1 — Medium-sized, natural, rich-sounding room with an adjustable range from very small to large</td>
</tr>
<tr>
<td></td>
<td>• Room 2 — Smaller, brighter reverberant characteristic than Room 1, with an adjustment range that extends to very small</td>
</tr>
<tr>
<td></td>
<td>• Ambient — Transparent response for adding a sense of space without adding a lot of depth or density</td>
</tr>
<tr>
<td></td>
<td>• Nonlin — Nonlinear reverberation with a natural buildup and an abrupt cutoff similar to a gate</td>
</tr>
<tr>
<td>Size</td>
<td>In conjunction with the Algorithm parameter, lets you adjust the overall size of the reverberant space. There are three sizes: Small, Medium, and Large. The character of the reverberation changes with each setting (as does the relative value of the Decay parameter).</td>
</tr>
<tr>
<td>Diffusion</td>
<td>Sets the degree to which initial echo density increases over time. High settings result in high initial buildup of echo density. Low settings cause low initial buildup. This control interacts with the Size and Decay parameters to affect the overall reverberation density.</td>
</tr>
</tbody>
</table>
Core Avid Audio Plug-Ins

DC Offset Removal (AudioSuite)

The DC Offset Removal plug-in removes DC offset from your audio files. DC offset describes a specific type of audio artifact that might appear in digital audio signals.

You can identify DC Offset in a waveform because it appears as a near-vertical fade-in with a constant or “steady-state” offset from zero when the file is actually “silent” (it contains no audible audio). The DC Offset plug-in can help remove (or at least reduce) the DC offset from your source audio files.

DeEsser III — Dynamics III (Audio Track Effect and AudioSuite)

The DeEsser III plug-in reduces sibilants and other high frequency noises that can occur in vocals, voiceovers, and wind instruments such as flutes. These sounds can cause peaks in an audio signal and lead to distortion.

The De-Esser reduces these unwanted sounds using fast-acting compression. A Threshold control sets the level above which compression starts, and a Frequency control sets the frequency band in which the De-Esser operates.

To use de-essing most effectively, insert the De-Esser after compressor or limiter plug-ins.

The De-Esser has no control to directly adjust the threshold level (the level that an input signal must exceed to trigger de-essing). The amount of de-essing will vary with the input signal.

The following table lists the DeEsser III plug-in parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Decay</td>
<td>Controls the rate at which the reverberation decays after the original direct signal stops. The value of the Decay parameter is affected by the Size and Algorithm parameters. You can set this parameter to infinity on most algorithms for infinite reverberation times.</td>
</tr>
<tr>
<td>Pre-Delay</td>
<td>Lets you determine the amount of time that elapses between the original audio event and the onset of reverberation.</td>
</tr>
<tr>
<td>HF (High Frequency) Cut</td>
<td>Controls the decay characteristic of the high frequency components of the reverberation. It acts in conjunction with the LP Filter control to create the overall high frequency contour of the reverberation.</td>
</tr>
<tr>
<td>LP Filter</td>
<td>Controls the overall high frequency content of the reverberation by allowing you to set the frequency above which a 6-dB-per-octave filter attenuates the processed signal.</td>
</tr>
</tbody>
</table>
Levels panel

Input/Output level meters  Show peak signal levels before and after processing.
- Green indicates nominal levels
- Yellow indicates pre-clipping levels, starting at –6 dB below full scale
- Red Indicates full scale levels (clipping)

Unlike scales on analog compressors, metering scales on a digital device reflect a 0 dB value that indicates full scale (fs)—the full-code signal level. There is no headroom above 0 dB.

The clip indicators at the top of the Output meters indicate clipping at the input or output stage of the plug-in. Click an indicator to clear it.

Gain Reduction meter  Indicates the amount the input signal is attenuated (in dB) and shows different colors during de-essing.
- Light orange indicates that gain reduction is being applied, but has not reached the maximum level set by the Range control
- Dark orange indicates that gain reduction has reached the maximum level set by the Range control

Options panel

HF Only button  When this button is enabled, gain reduction is applied only to the active frequency band set by the Frequency control. When this button is disabled, the De-Esser applies gain reduction to the entire signal.

Listen button  When this button is enabled, you monitor the sibilant peaks used by the De-Esser as a side-chain to trigger compression. This is useful for listening only to the sibilance for fine-tuning De-Esser controls. To monitor the whole output signal without this filtering, deselect the Listen button.

Graph display  Shows a curve that represents the level of gain reduction (on the y-axis) for the range of the output signal’s frequency (on the x-axis). The white line represents the current Frequency setting, and the animated orange line represents the level of gain reduction being applied to the signal. Use this graph as a visual guideline to see how much dynamics processing you are applying at different points in the frequency spectrum.
Dither (Audio Track Effect)

Dither is a dither-generation plug-in. The Dither plug-in minimizes quantization artifacts when reducing the bit depth of an audio signal to 16-, 18-, or 20-bit resolution.

The following table lists the Dither plug-in parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Frequency</strong></td>
<td>Sets the frequency band in which the De-Esser operates. Values range from 500 Hz (lowest frequency) to 16 kHz (highest frequency). When HF Only is disabled in the Options panel, gain is reduced in frequencies within the specified range. When HF Only is enabled, the gain of frequencies above the specified value will be reduced. Set the Frequency control to remove sibilants (typically the 4–10 kHz range) and not other parts of the signal. This helps prevent deessing from changing the original character of the audio material in an undesired manner.</td>
</tr>
<tr>
<td><strong>Range</strong></td>
<td>Defines the maximum amount of gain reduction possible when a signal is detected at the frequency set by the Frequency control. Values range from –40 dB (maximum de-essing) to 0 dB (no de-essing). Set the Range control to a dB level low enough so that de-essing is triggered only by sibilants. If the Range is set too high, a loud, non-sibilant section of audio material could cause unwanted gain reduction or cause sibilants to be over-attenuated. To improve de-essing of material that has both very loud and very soft passages, automate the Range control so that it is lower on soft sections.</td>
</tr>
</tbody>
</table>
Avid Down Mixer can be used to automatically mix greater-than-stereo multichannel tracks (such as 5.1) down to stereo (Pro Tools HD only) or stereo tracks down to mono.

The following table lists the Down Mixer plug-in parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bit Resolution Button</td>
<td>Use this pop-up menu to choose one of three possible resolutions for the Dither processing. Set this control to the maximum bit resolution of your destination.</td>
</tr>
<tr>
<td>16-bit</td>
<td>Recommended for output to digital devices with a maximum resolution of 16 bits, such as DAT and CD recorders.</td>
</tr>
<tr>
<td>18-bit</td>
<td>Recommended for output to digital devices with a maximum resolution of 18 bits.</td>
</tr>
<tr>
<td>20-bit</td>
<td>Recommended for output to digital devices that support a full 20-bit recording data path, such as the Sony PCM-9000 optical mastering recorder, or the Alesis ADAT XT 20. The 20-bit setting can also be used for output to digital effects devices that support 20-bit input and output, since it provides for a lower noise floor and greater dynamic range when mixing 20-bit signals directly in Pro Tools.</td>
</tr>
<tr>
<td>Noise Shaping Button</td>
<td>The Noise Shaping button engages or disengages Noise shaping. Noise shaping is on when the button is highlighted in blue. Noise shaping can further improve audio performance and reduce perceived noise inherent in dithered audio. Noise shaping uses filtering to shift noise away from frequencies in the middle of the audio spectrum (around 4 kHz), where the human ear is most sensitive.</td>
</tr>
</tbody>
</table>
Duplicate (AudioSuite)

The Duplicate plug-in creates a new master clip from a selected audio master clip. The plug-in uses the In and Out points on the selected clip to define the boundaries of the new clip. This plug-in applies only when you use the Create New Master Clips features of the AudioSuite plug-ins.

Eleven Free (Audio Track Effect and AudioSuite)

Eleven is a guitar amplifier plug-in. Eleven Free is a free version of Eleven with a reduced feature set.

The following table lists the Eleven Free plug-in parameters:
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input LED</td>
<td>The Input LED shows green, yellow, orange, or red to indicate whether you are under- or over-driving the plug-in. The Input LED is before the Input section of the Master section.</td>
</tr>
<tr>
<td>Gate</td>
<td>Noise Gate Threshold</td>
</tr>
<tr>
<td></td>
<td>The Noise Gate Threshold control sets the level at which the Noise Gate opens or closes. At minimum Threshold setting, the Noise Gate has no effect. At higher Threshold settings, only louder signals will open the Gate and pass sound. Threshold range is from Off (–90 dB) to –20 dB.</td>
</tr>
<tr>
<td></td>
<td>Noise Gate Release</td>
</tr>
<tr>
<td></td>
<td>The Noise Gate Release control sets the length of time the Noise Gate remains open and passing audio. Adjust the Release to find the best setting for the current task (not too fast to avoid cutting off notes, and not too slow to avoid unwanted noise). Release range is from 10 ms to 3000 ms.</td>
</tr>
<tr>
<td>Amp Type</td>
<td>Amp Type selects which amplifier model to use</td>
</tr>
<tr>
<td>Cab Type</td>
<td>This selector lets you select which speaker cabinet model to use</td>
</tr>
<tr>
<td>Output</td>
<td>The Output control sets the output gain after processing, letting you make up gain or prevent clipping on the channel where the plug-in is being used. Output range is –60 dB to +18 dB</td>
</tr>
<tr>
<td>Amp Bypass</td>
<td>The Amp Bypass switch (or lamp) lets you bypass just the amp model, leaving the cab and mic settings in effect. The default setting is On. When set to Bypass, only the amp is bypassed; Master section, cabinet and microphone settings remain active.</td>
</tr>
<tr>
<td>Bright</td>
<td>The Bright switch provides extra high frequency response to the input signal, and alters the timbre of the distortion. On some amp models, the effect is most apparent at lower volume settings.</td>
</tr>
<tr>
<td>Gain</td>
<td>Gain determines the overall gain amount and sensitivity of the amp. When Gain is low it allows for cleaner, brighter sounds with enhanced dynamic response. When set high, the entire personality of the amp changes, becoming fatter and overdriven. Gain responds differently with each amp model and is designed to have a musical response that closely matches that of its original amp, at all settings.</td>
</tr>
<tr>
<td>Bass</td>
<td>The Bass control determines the amount of low end in the amp tone. The response of this control in some models is linked to the setting of the Treble control. The default setting is 5.0. Bass range is from 0 to 10.</td>
</tr>
<tr>
<td>Middle</td>
<td>The Middle control determines the mid-range strength in lower gain sounds. With high gain amp models, the Middle control has a more dramatic effect and can noticeably shape the sound of the amp at both the minimum and extreme settings. The default setting is 5.0. The Middle range is from 0 to 10.</td>
</tr>
</tbody>
</table>
EQ plug-ins provide a set of high-quality options for adjusting the frequency spectrum of audio material:

7-Band EQ III Parameters

The following table lists the 7-Band EQ III plug-in parameters.
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>In and Out meters</td>
<td>Show peak signal levels before and after EQ processing. Green indicates nominal levels. Yellow indicates pre-clipping levels, starting at –6 dB below full scale. Red indicates full scale (clipping) levels. The clip indicators to the right of each meter indicate clipping at the input of output stage of the plug-in. Click a clip indicator to clear it.</td>
</tr>
<tr>
<td>Input</td>
<td>Sets the input gain of the plug-in before EQ processing, letting you make up gain or prevent clipping at the plug-in input stage.</td>
</tr>
<tr>
<td>Input Polarity control</td>
<td>Inverts the phase (polarity) of the input signal, to help compensate for phase anomalies occurring in multi-microphone environments, or because of mis-wired balanced connections.</td>
</tr>
<tr>
<td>Output</td>
<td>Sets the output gain after EQ processing, letting you make up gain or prevent clipping on the channel where the plug-in is being used.</td>
</tr>
<tr>
<td>Bands</td>
<td>The plug-in has separate parameter controls for each of the following 7 bands:</td>
</tr>
<tr>
<td></td>
<td>• High-Pass/Low-Notch (HPF)</td>
</tr>
<tr>
<td></td>
<td>• Low-Pass/High-Notch (LPF)</td>
</tr>
<tr>
<td></td>
<td>• Low Shelf/Low Peak (LF)</td>
</tr>
<tr>
<td></td>
<td>• Low-Mid Peak (LMF)</td>
</tr>
<tr>
<td></td>
<td>• Mid-Peak (MF)</td>
</tr>
<tr>
<td></td>
<td>• High-Mid Peak (HMF)</td>
</tr>
<tr>
<td></td>
<td>• High Shelf/High Peak (HF)</td>
</tr>
<tr>
<td>Band Enable button</td>
<td>Toggles the band in and out of the circuit. When a band’s Enable button is highlighted, the band is in circuit. When a band’s Enable button is dimmed, the band is bypassed.</td>
</tr>
</tbody>
</table>
The HPF, LPF, LF, and HF band sections have type selectors that toggle between the two available filter types for that section, as follows:

- **High-Pass Filter (HPF band)** — Attenuates all frequencies below the Frequency setting at the selected slope while letting all frequencies above pass through.
- **Low-Notch EQ (HPF band)** — Attenuates a narrow band of frequencies centered around the Frequency setting. The Q setting determines the width of the attenuated band.
- **Low-Pass Filter (LPF band)** — Attenuates all frequencies above the Frequency setting at the selected slope while letting all frequencies below pass through.
- **High-Notch EQ (LPF band)** — Attenuates a narrow band of frequencies centered around the Frequency setting. The Q setting determines the width of the attenuated band.
- **Low-Shelf EQ (LF band)** — Boosts or cuts frequencies at and below the Frequency setting. The amount of boost or cut is determined by the Gain setting. The Q setting determines the shape of the shelving curve.
- **Low Peak EQ (LF band)** — Boosts or cuts a band of frequencies centered around the Frequency setting. The Q setting determines the width of the selected band.
- **High-Shelf EQ (LF band)** — Boosts or cuts frequencies at and above the Frequency setting. The amount of boost or cut is determined by the Gain setting. The Q setting determines the shape of the shelving curve.
- **High Peak EQ (LF band)** — Boosts or cuts a band of frequencies centered around the Frequency setting. The Q setting determines the width of the selected band.

**Q**

(Peak and Notch bands) Controls the width of the EQ band. Higher values represent narrower bandwidths. Lower values represent wider bandwidths.

(Shelf bands) Changes the Q of the shelving filter. Higher Q values represent steeper shelving curves. Lower Q values represent broader shelving curves.

(High-Pass and Low-Pass bands) Lets you select from any of the following Slope values: 6 dB, 12 dB, 18 dB, or 24 dB per octave.

**Freq**

Lets you set the center frequency (Peak, Shelf, and Notch EQs) or the cutoff frequency (High-Pass and Low-Pass filters).

**Gain**

Lets you control the amount that the selected frequencies are cut or boosted (for Shelf and Peak only).

**Frequency Graph Display**

Shows a color-coded control dot that corresponds to the color of the Gain control for each band, and a frequency response curve. You can adjust the parameters by dragging one or more of the control dots.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type selectors</td>
<td>The HPF, LPF, LF, and HF band sections have type selectors that toggle between the two available filter types for that section, as follows:</td>
</tr>
<tr>
<td></td>
<td>• High-Pass Filter (HPF band) — Attenuates all frequencies below the Frequency setting at the selected slope while letting all frequencies above pass through.</td>
</tr>
<tr>
<td></td>
<td>• Low-Notch EQ (HPF band) — Attenuates a narrow band of frequencies centered around the Frequency setting. The Q setting determines the width of the attenuated band.</td>
</tr>
<tr>
<td></td>
<td>• Low-Pass Filter (LPF band) — Attenuates all frequencies above the Frequency setting at the selected slope while letting all frequencies below pass through.</td>
</tr>
<tr>
<td></td>
<td>• High-Notch EQ (LPF band) — Attenuates a narrow band of frequencies centered around the Frequency setting. The Q setting determines the width of the attenuated band.</td>
</tr>
<tr>
<td></td>
<td>• Low-Shelf EQ (LF band) — Boosts or cuts frequencies at and below the Frequency setting. The amount of boost or cut is determined by the Gain setting. The Q setting determines the shape of the shelving curve.</td>
</tr>
<tr>
<td></td>
<td>• Low Peak EQ (LF band) — Boosts or cuts a band of frequencies centered around the Frequency setting. The Q setting determines the width of the selected band.</td>
</tr>
<tr>
<td></td>
<td>• High-Shelf EQ (LF band) — Boosts or cuts frequencies at and above the Frequency setting. The amount of boost or cut is determined by the Gain setting. The Q setting determines the shape of the shelving curve.</td>
</tr>
<tr>
<td></td>
<td>• High Peak EQ (LF band) — Boosts or cuts a band of frequencies centered around the Frequency setting. The Q setting determines the width of the selected band.</td>
</tr>
<tr>
<td>Q</td>
<td>(Peak and Notch bands) Controls the width of the EQ band. Higher values represent narrower bandwidths. Lower values represent wider bandwidths.</td>
</tr>
<tr>
<td></td>
<td>(Shelf bands) Changes the Q of the shelving filter. Higher Q values represent steeper shelving curves. Lower Q values represent broader shelving curves.</td>
</tr>
<tr>
<td></td>
<td>(High-Pass and Low-Pass bands) Lets you select from any of the following Slope values: 6 dB, 12 dB, 18 dB, or 24 dB per octave.</td>
</tr>
<tr>
<td>Freq</td>
<td>Lets you set the center frequency (Peak, Shelf, and Notch EQs) or the cutoff frequency (High-Pass and Low-Pass filters).</td>
</tr>
<tr>
<td>Gain</td>
<td>Lets you control the amount that the selected frequencies are cut or boosted (for Shelf and Peak only).</td>
</tr>
<tr>
<td>Frequency Graph Display</td>
<td>Shows a color-coded control dot that corresponds to the color of the Gain control for each band, and a frequency response curve. You can adjust the parameters by dragging one or more of the control dots.</td>
</tr>
</tbody>
</table>
Expander/Gate III — Dynamics III (Audio Track Effect and AudioSuite)

The Expander/Gate III plug-in applies expansion or gating to audio material, depending on the ratio setting.

Expansion decreases the gain of signals that fall below a chosen threshold. It is particularly useful for reducing noise or signal leakage that creeps into recorded material as its level falls, as often occurs in the case of headphone leakage. Expanders can be thought of as soft noise gates since they provide a gentler way of reducing noisy low-level signals than the typically abrupt cutoff of a gate.

Gating silences signals that fall below a chosen threshold. To enable gating, simply set the Ratio and Range controls to their maximum values.

The following table lists the Expander/Gate III plug-in parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Levels panel</strong></td>
<td></td>
</tr>
<tr>
<td>Phase invert button</td>
<td>Inverts the phase (polarity) of the input signal, to help compensate for phase anomalies that can occur either in multi-microphone environments or because of mis-wired balanced connections.</td>
</tr>
</tbody>
</table>
| Input/Output level meters | Show peak signal levels before and after processing.  
  - Green indicates nominal levels  
  - Yellow indicates pre-clipping levels, starting at –6 dB below full scale  
  - Red Indicates full scale levels (clipping)  

  *Unlike scales on analog compressors, metering scales on a digital device reflect a 0 dB value that indicates full scale (fs)—the full-code signal level. There is no headroom above 0 dB.*

  The clip indicators at the top of the Output meters indicate clipping at the input or output stage of the plug-in. Click an indicator to clear it.
| Threshold arrow | The orange Threshold arrow next to the Input meter indicates the current threshold. You can drag the arrow up or down to adjust the threshold. For more information on threshold, see the Threshold row below in this table. |
### Gain Reduction meter (GR)
Indicates the amount the input signal is attenuated (in dB) and shows different colors during dynamics processing.
- Light orange indicates that gain reduction is within the “knee” and has not reached the full ratio of compression
- Dark orange indicates that gain reduction is being applied at the full ratio (for example, 2:1)

### Graph display
Shows a curve that represents the level of the input signal (on the x–axis) and the level of the output signal (on the y–axis). The orange vertical line represents the threshold. Use this graph as a visual guideline to see how much dynamics processing you are applying.

### Options panel
**Look Ahead button**
Normally, dynamics processing begins when the level of the input signal crosses the threshold. When this button is enabled, dynamics processing begins 2 milliseconds before the level of the input signal crosses the threshold.

The Look Ahead control is useful for avoiding the loss of transients that may have been otherwise cut off or trimmed in a signal.

### Side-Chain panel
The side-chain is the split-off signal used by the plug-in’s detector to trigger dynamics processing. The Side-Chain panel lets you toggle the side-chain between the internal input signal or an external key input, and tailor the equalization of the side-chain signal so that the triggering of dynamics processing becomes frequency-sensitive.

For full information on how to work with the side-chain controls, see “Using the Side-Chain Input in Dynamics III” in the Avid DigiRack Plug-Ins Guide. Search for “digirack plug-ins guide” at www.avid.com.

### Expander/Gate panel (EXP/GATE)
**Range**
Sets the depth of the Expander/Gate when closed. Setting the gate to higher range levels allows more and more of the gated audio that falls below the threshold to peek through the gate at all times. Values range from -80 dB (lowest depth) to 0 dB (highest depth).

**Ratio**
Sets the amount of expansion. For example, if this is set to 2:1, it will lower signals below the threshold by one half. At higher ratio levels (such as 30:1 or 40:1) the Expander/Gate functions like a gate by cutting off signals that fall below the threshold. As you adjust the ratio control, refer to the built-in graph to see how the shape of the expansion curve changes. Values range from 1:1 (no expansion) to 100:1 (gating).
The Funk Logic Mastererizer plug-in is a low-fidelity sound design tool, designed for the creative degradation of audio. By experimenting with adjustments to the controls, you can introduce varying amounts of hiss, hum, distortion, crackle, and other audio characteristics that are associated with old or flawed equipment, media decay, and so on.

Gain (AudioSuite)

Gain lets you boost or lower amplitudes in a file or selection by a specified amount. Use Gain for smoothing out undesirable peaks and other dynamic inconsistencies.

You can specify the desired gain level in several ways:

- Enter a numeric decibel value.
- Enter a percentage value.
- Drag the slider.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attack</td>
<td>Sets the attack time, or the rate at which gain is reduced after the input signal crosses the threshold. Use this along with the Ratio setting to control how soft the Expander’s gain reduction curve is. Values range from 10 microseconds (fastest attack time) to 300 milliseconds (slowest attack time).</td>
</tr>
<tr>
<td>Release</td>
<td>Sets how long it takes for the gate to close after the input signal falls below the threshold level and the hold time has passed. Values range from 5 milliseconds (fastest release time) to 4 seconds (slowest release time).</td>
</tr>
<tr>
<td>Hold</td>
<td>Specifies the duration (in seconds or milliseconds) during which the Expander/Gate will stay in effect after the initial attack occurs. This can be used as a function to keep the Expander/Gate in effect for longer periods of time with a single crossing of the threshold. It can also be used to prevent gate chatter that may occur if varying input levels near the threshold cause the gate to close and open very rapidly. Values range from 5 milliseconds (shortest hold) to 4 seconds (longest hold).</td>
</tr>
<tr>
<td>Threshold (THRESH)</td>
<td>Sets the level below which an input signal must fall to trigger expansion or gating. Signals that fall below the threshold will be reduced in gain. Signals that are above it will be unaffected. Values range approximately from -60 dB to 0 dB (no expansion or gating). -24 dB is the default value.</td>
</tr>
</tbody>
</table>

In the Levels panel, the orange Threshold arrow on the Input meter indicates the current threshold. You can drag the arrow up and down to adjust the Threshold setting.

In the graph display, the threshold appears as an orange vertical line.
Core Avid Audio Plug-Ins

- Press and hold the Ctrl key (Windows) or the Command key (Macintosh), then drag the slider to fine-adjust.
- Use the rms and peak buttons to switch the calibration of gain adjustment between RMS and Peak modes.

Peak adjusts the gain of the signal to the maximum possible level without clipping. RMS adjusts the input signal to a level consistent with the root-mean-square value, or the effective average level of the selected material.

**Invert (AudioSuite)**

The Invert plug-in reverses the polarity of the selected audio. All positive sample amplitude values become negative, and all negative amplitudes become positive. You can use this process for permanently altering the phase (polarity) relationship of tracks. Inverting can be useful when mixing because it alters frequency response between source tracks recorded with multiple microphones and also lets you correct for audio that was recorded out of phase.

**Lo-Fi Plug-In (Audio Track Effect and AudioSuite)**

Lo-Fi down-processes audio by reducing its sample rate and bit resolution. It is ideal for emulating the grungy quality of 8-bit samplers.

The following table lists the Lo-Fi plug-in parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample Rate</td>
<td>The Sample Rate slider adjusts an audio file’s playback sample rate in fixed intervals from 700 Hz to 33 kHz in sessions with sample rates of 44.1 kHz, 88.2 kHz, or 176.4 kHz; and from 731 Hz to 36 kHz in sessions with sample rates of 48 kHz, 96 kHz, or 192 kHz. Reducing the sample rate of an audio file has the effect of degrading its audio quality. The lower the sample rate, the grungier the audio quality. The maximum value of the Sample Rate control is Off (which effectively means bypass). The range of the Sample Rate control is slightly different at different session sample rates because Lo-Fi’s subsampling is calculated by integer ratios of the session sample rate.</td>
</tr>
<tr>
<td>Anti-Alias Filter</td>
<td>The Anti-Alias control works in conjunction with the Sample Rate control. As you reduce the sample rate, aliasing artifacts are produced in the audio. These produce a characteristically dirty sound. Lo-Fi’s anti-alias filter has a default setting of 100%, automatically removing all aliasing artifacts as the sample rate is lowered. This control is adjustable from 0% to 100%, letting you add precisely the amount of aliasing you want back into the mix. This slider only has an effect if you have reduced the sample rate with the Sample Rate control.</td>
</tr>
</tbody>
</table>
Maxim is a unique and powerful peak-limiting and sound maximizing plug-in. Maxim is ideal for critical mastering applications, as well as standard peak-limiting tasks.

Maxim (Audio Track Effect and AudioSuite)

Maxim is a unique and powerful peak-limiting and sound maximizing plug-in. Maxim is ideal for critical mastering applications, as well as standard peak-limiting tasks.
Maxim offers several critical advantages over traditional hardware-based limiters. Maxim takes full advantage of the random-access nature of disk-based recording to anticipate peaks in audio material and preserve their attack transients when performing reduction. This makes Maxim more transparent than conventional limiters, since it preserves the character of the original audio signal without clipping peaks or introducing distortion.

The following table lists the Maxim plug-in parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maxim Controls and Meters</td>
<td></td>
</tr>
<tr>
<td>Maxim Input Level Meter</td>
<td>This meter displays the amplitude of input signals prior to limiting. Unlike conventional meters, Maxim’s Input meter displays the top 24 dB of dynamic range of audio signals, which is where limiting is typically performed. This provides you with much greater metering resolution within this range so that you can work with greater precision.</td>
</tr>
<tr>
<td>Maxim Histogram</td>
<td>The Histogram displays the distribution of waveform peaks in the audio signal. This graph is based on audio playback. If you select and play a short loop, the histogram is based on that data. If you select and play a longer section, the Histogram is based on that. Maxim holds peak data until you click the Histogram to clear it. The Histogram provides a visual reference for comparing the density of waveform peaks at different decibel levels. You can then base limiting decisions on this data. The X axis of the Histogram shows the number of waveform peaks occurring at specific dB levels. The Y axis shows the specific dB level at which these peaks occur. The more waveform peaks that occur at a specific dB level, the longer the X-axis line. If there appears to be a pronounced spike at a certain dB level (4 dB for example), it means that there are a relatively large number of waveform peaks occurring at that level. You can then use this information to decide how much limiting to apply to the signal. By dragging the Threshold slider downwards, you can visually adjust the level at which limiting will occur. Maxim displays the affected range in orange.</td>
</tr>
<tr>
<td>Maxim Threshold Slider</td>
<td>This slider sets the threshold level for limiting. Signals that exceed this level will be limited. Signals below it will be unaffected. Limited signal peaks are attenuated to match the threshold level, so the value that you set here will determine the amount of reduction applied.</td>
</tr>
<tr>
<td>Maxim Output Meter</td>
<td>This meter displays the amplitude of the output signal. The value that appears here represents the processed signal after the threshold, ceiling, and mixing settings have been applied.</td>
</tr>
<tr>
<td>Maxim Ceiling Slider</td>
<td>This slider determines the maximum output level. After limiting is performed you can use this slider to adjust the final output gain. The value that you set here will be the absolute ceiling level for limited peaks.</td>
</tr>
</tbody>
</table>
### Core Avid Audio Plug-Ins

#### Maxim

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Attenuation Meter</strong></td>
<td>This meter displays the amount of gain reduction being applied over the course of playback, with the maximum peak displayed in the numeric readout at the bottom of the meter. For example, if the numerical display at the bottom of the Attenuation meter displays a value of 4 dB, it means that 4 dB of limiting has occurred. Since this is a peak-hold readout, you can temporarily walk away from a session during playback and still know the maximum gain reduction value when you come back. To clear the numeric readout, click it with the mouse.</td>
</tr>
<tr>
<td><strong>Release Knob</strong></td>
<td>This knob sets how long it takes for Maxim to ease off of its attenuation after the input signal drops below the threshold level. Because Maxim has an attack time of zero milliseconds, the release control has a very noticeable effect on the character of limiting. In general, if you are using heavy limiting, you should use proportionally longer release times in order to avoid pumping that may occur when Maxim is forced to jump back and forth between limited and unlimited signal levels. Lengthening the release time has the effect of smoothing out these changes in level by introducing a lag in the ramp-up or ramp-down time of attenuation. Use short release times on material with peaks that are relatively few in number and that do not occur in close proximity to each other. The Release control has a default value of 1 millisecond.</td>
</tr>
<tr>
<td><strong>Mix Slider</strong></td>
<td>This slider sets the ratio of dry signal to limited signal. In general, if you are applying Maxim to a main output mix, you will probably want to set this control to 100% wet. If you are applying heavy limiting to an individual track or element in a mix to modify its character, this control is particularly useful since it lets you control precisely the amount of the processed effect mixed with the original signal.</td>
</tr>
<tr>
<td><strong>Link Button</strong></td>
<td>When depressed, this button (located between the Threshold and Ceiling numeric readouts) links the Threshold and Ceiling controls. These two sliders will then move proportionally together. As you lower the Threshold control, the Ceiling control is lowered as well. When these controls are linked you can conveniently compare the effect of limiting at unity gain by clicking the Bypass button.</td>
</tr>
<tr>
<td><strong>Dither Button</strong></td>
<td>When selected, this applies dither. Dither is a form of randomized noise used to minimize quantization artifacts in digital audio systems. Quantization artifacts are most audible when the audio signal is near the low end of its dynamic range, such as during a quiet passage or fade-out. Applying dither helps reduce quantization noise that can occur when you are mixing from a 24-bit source to a 16-bit destination, such as CD-R or DAT. If you are using Maxim on a Master Fader during mixdown, Maxim’s built-in dither function saves you the trouble and DSP resources of having to use a separate Dither plug-in. If Dither is disabled, the Noise Shaping and Bit Resolution controls will have no effect.</td>
</tr>
<tr>
<td><strong>Noise Shaping Control</strong></td>
<td>When selected, this applies noise-shaped dither. Noise shaping biases the dither noise to less audible high frequencies so that it is not as readily perceived by the ear. Dither must be enabled in order to use Noise Shaping.</td>
</tr>
</tbody>
</table>
Mod Delay III (Audio Track Effect and AudioSuite)

Mod Delay III provides mono, multi-mono, mono-to-stereo, and stereo modulating delay effects.

The following table lists the Mod Delay III plug-in parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maxim Bit Resolution Button</td>
<td>These buttons select dither bit resolution. In general, set this control to the maximum bit resolution of your destination media. For output to digital devices such as DAT recorders and CD recorders, 16-bit is recommended since they have a maximum resolution of 16 bits. 18-bit is recommended for devices with a maximum resolution of 18 bits. 20-bit is recommended for devices that support a full 20-bit recording data path.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input Meters</td>
<td>The Input meters show peak signal levels before processing:</td>
</tr>
<tr>
<td></td>
<td>- Dark Blue - Indicates nominal levels from –INF to –12 dB.</td>
</tr>
<tr>
<td></td>
<td>- Light Blue - Indicates pre-clipping levels, from –12 dB to 0 dB.</td>
</tr>
<tr>
<td></td>
<td>- Red - Indicates clipping.</td>
</tr>
<tr>
<td>Phase Invert</td>
<td>The Phase Invert button at the top of the Input section inverts the phase (polarity) of the input signal, to help compensate for phase anomalies that can occur either in multi-microphone environments or because of mis-wired balanced connections. To enable (or disable) phase inversion on input: Click the Phase Invert button so that it is highlighted. Click it again so that it is not highlighted to disable it.</td>
</tr>
<tr>
<td>Link</td>
<td>For stereo and mono-to-stereo tracks, enable the Link button to link the Delay, Modulation, and Mix controls between the Left and Right channels. This option is highlighted when it is enabled. For mono tracks, this option reads Mono and is display only.</td>
</tr>
<tr>
<td>Delay Time</td>
<td>The Delay Time control sets the delay time between the original signal and the delayed signal (from 0.0 ms to 5,000.0 ms).</td>
</tr>
<tr>
<td>Feedback (FBK)</td>
<td>The Feedback setting controls the amount of feedback applied from the output of the delay back into its input (from –100% to 100%). It also controls the number of repetitions of the delayed signal. Negative feedback settings give a more intense “tunnel-like” sound to flanging effects.</td>
</tr>
</tbody>
</table>
### Parameter Description

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Low Pass Filter (LPF)</td>
<td>The Low Pass Filter setting controls the cutoff frequency of the Low Pass Filter (from 10 Hz to 22 kHz). Use the LPF setting to attenuate the high frequency content of the feedback signal. The lower the setting, the more high frequencies are attenuated. The maximum value for LPF is Off. This lets the signal pass through without limiting the bandwidth of the plug-in.</td>
</tr>
<tr>
<td>Sync</td>
<td>When Sync is enabled, and a Duration (a rhythmic note value) is selected, the Delay Time setting is affected by the session tempo. When Sync is disabled, and a Duration is selected, the Delay Time setting is affected by changes to the Tempo setting.</td>
</tr>
<tr>
<td>Meter</td>
<td>The Meter setting lets you enter either simple or compound time signatures. The Meter control defaults to a 4/4 time signature. When Sync is enabled, the Meter control is unavailable.</td>
</tr>
<tr>
<td>Tempo</td>
<td>The Tempo control sets the tempo in beats per minute (from 5.00 to 500.00 bpm). This setting is independent of the Pro Tools session tempo. When a specific Duration is selected, moving this control affects the Delay Time setting. When Sync is enabled, the Tempo control is unavailable.</td>
</tr>
<tr>
<td>Duration</td>
<td>The Duration setting lets you set the Delay Time based on a rhythmic value. Select a note value (whole note, half note, quarter note, eight note, or sixteenth note). Additionally, you can select the Dot or Triplet modifier buttons to dot the selected note value or make it a triplet. For example, selecting a quarter note and then selecting the dot indicates a dotted quarter note, and selecting an eighth note and then selecting the triplet indicates a triplet eighth note.</td>
</tr>
<tr>
<td>Groove</td>
<td>The Groove control provides fine adjustment of the delay in percentages of a 1:4 subdivision of the beat (from –100% to 100%). It can be used to add “swing” by slightly offsetting the delay from the precise beat of the track.</td>
</tr>
</tbody>
</table>

### Modulation Section

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rate</td>
<td>The Rate control sets the rate of modulation of the delayed signal (from 0.00 Hz to 20.0 Hz).</td>
</tr>
<tr>
<td>Depth</td>
<td>The Depth control sets the depth of the modulation applied to the delayed signal (from 0% to 100%).</td>
</tr>
<tr>
<td>Mix</td>
<td>The Mix control sets the balance between the delayed signal (wet) and the original signal (dry). If you are using a delay for flanging or chorusing, you can control the depth of the effect somewhat with the Mix setting. Click the Dry button to set the Mix to 100% dry. Click the Wet button to set the Mix to 100% wet.</td>
</tr>
<tr>
<td>Output</td>
<td>The Output section provides output metering and controls for adjusting the level of the output signal.</td>
</tr>
</tbody>
</table>
Core Avid Audio Plug-Ins

Normalize (AudioSuite)

In cases where a sound file has been recorded with too little amplitude, the Normalize plug-in ensures that the inherent dynamics of the performance remain unchanged while the overall volume level of the passage is raised.

The controls let you specify how close to maximum level (the clipping threshold) the peak level of your selection or file is boosted. You can enter this information in several ways.

- Enter a numeric decibel value below the clipping threshold.
- Enter a percentage of the threshold.
- Drag the slider.
- Press and hold the Ctrl key (Windows) or the Command key (Macintosh), then drag the slider to fine-adjust.
- Use the rms and peak buttons to switch the calibration of normalizing between RMS and Peak modes.

Peak normalizes the signal at the maximum possible level without clipping. RMS normalizes the input signal at a level consistent with the root-mean-square value, or the effective average level of the selected material.

Output Meters
- Dark Blue Indicates nominal levels from –INF to –12 dB.
- Light Blue Indicates pre-clipping levels, from –12 dB to 0 dB.
- Red Indicates clipping.

Output Gain
- The Output Gain control sets the output level after processing. For mono instances of Mod Delay III, there is a single Gain control. For stereo and mono-to-stereo instances of Mod Delay III, there are independent Gain controls for each channel (left and right).

Pitch Shift (AudioSuite)

The Pitch Shift plug-in lets you adjust the pitch of any source audio file with or without a change in its duration. This powerful function allows sounds to be transposed a maximum of a full octave up or down in pitch with or without altering playback speed.

Edit the Pitch Shift parameters by double-clicking and typing in any Destination text box or by dragging a slider to adjust. All Pitch Shift plug-in controls are linked, so that changing one changes the others.
The following table lists the Pitch Shift plug-in parameters.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gain</td>
<td>The Gain controls set the input level, in tenths of a decibel. Set the input level so that the plug-in can adequately handle amplitude peaks in the selection. Dragging the slider to the right increases gain, and dragging the slider to the left decreases gain.</td>
</tr>
<tr>
<td>Coarse and Fine</td>
<td>Adjust the pitch by dragging either of the two faders, or by typing values in the Coarse and Fine text boxes. The Coarse slider transposes in semitones (half steps); the Fine slider transposes in cents (hundredths of a semitone).</td>
</tr>
<tr>
<td>Ratio</td>
<td>The Ratio slider lets you set the amount of transposition (pitch change). Dragging the slider to the right raises the pitch of the processed file, and dragging the slider to the left decreases its pitch. Press and hold the Ctrl key (Windows) or the Command key (Macintosh) when you drag the slider to fine-adjust.</td>
</tr>
<tr>
<td>Crossfade, Min</td>
<td>For information on these parameters, see the parameters table in “Time Compression Expansion (AudioSuite)” on page 1012.</td>
</tr>
<tr>
<td>Pitch, Accuracy</td>
<td></td>
</tr>
<tr>
<td>Time Correction</td>
<td>Click the Time Correction check box to enable or disable time correction.</td>
</tr>
</tbody>
</table>

You can deselect the Time Correction check box if you use the Create New Master Clips feature of the AudioSuite plug-ins. However, you must select the Time Correction check box when you apply AudioSuite plug-ins to audio clips in the Timeline.

If the Time Correction check box is deselected, it has the effect of “permanently varispeeding” your audio file. Like working with tape, the file’s duration is compressed or extended according to the settings of the Coarse and Fine controls. Playback speed increases proportionally as the sound file is transposed up in pitch and decreases proportionally as it is transposed down in pitch, just like a tape recorder that is varispeeding.

 Altering a file in this way has little detrimental effect on the fidelity of audio files, whereas time correction can affect fidelity in a pronounced way.
Power Dither (Audio Track Effect)

POW-r Dither is a dither-generation plug-in. The POW-r Dither plug-in is an advanced type of dither that provides optimized bit depth reduction. It is designed for final-stage critical mixdown and mastering tasks where the highest possible fidelity is required when reducing bit depth.

The following table lists the POW-r Dither plug-in parameters.

### Parameter Description

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
</table>
| Reference Pitch | The Reference Pitch feature generates a sine wave tone that you can adjust to match a selected portion of audio material, and then use as an audible reference when pitch-shifting other audio material in your session. **To use the Reference Pitch feature:**  
  1. Select the audio material you want to use as a pitch reference. Click the Preview button to begin playback of the selected audio.  
  2. Click the Reference Pitch button to activate the reference sine wave tone.  
  3. Adjust the Note and Detune settings to match the reference tone to the pitch of the audio playback. Adjust the Level setting to change the relative volume of the reference tone. You can also switch the Reference Pitch on and off to compare pitch.  
  4. Select the audio material where you want to shift pitch.  
  5. Adjust the Coarse and Fine controls to match the pitch of the audio playback to the reference pitch. |
| Bit Resolution | Use this pop-up menu to choose either 16- or 20-bit resolutions for POW-r Dither processing. Set this control to the maximum bit resolution of your destination.  
  - 16-bit - Recommended for output to digital devices with a maximum resolution of 16 bits, such as DAT and CD recorders.  
  - 20-bit - Recommended for output to devices that support a full 20-bit recording data path. |
Recti-Fi provides additive synthesis effects through waveform rectification. Recti-Fi multiplies the harmonic content of an audio track and adds subharmonic or superharmonic tones.

The following table lists the Recti-Fi plug-in parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pre-Filter</td>
<td>The Pre-Filter control filters out high frequencies in an audio signal prior to rectification. This is desirable because the rectification process can cause instability in waveform output — particularly in the case of high-frequency audio signals. Filtering out these higher frequencies prior to rectification can improve waveform stability and the quality of the rectification effect. If you wish to create classic subharmonic synthesis effects, set the Pre-Filter and Post-Filter controls to a relatively low frequency, such as 250 Hz. The range of the Pre-Filter is from 43 Hz to 21 kHz, with a maximum value of Thru (which effectively means bypass).</td>
</tr>
</tbody>
</table>
Reverse (AudioSuite)

Reversed sounds are useful effects in many music and film and video projects. The Reverse plug-in lets you easily perform this type of processing.

SansAmp PSA-1 (Audio Track Effect and AudioSuite)

SansAmp PSA-1 is a guitar amp simulator plug-in. Punch up existing tracks or record great guitar sounds with the SansAmp PSA-1. Capture bass or electric guitar free of muddy sound degradation and dial in the widest range of amplifier, harmonic generation, cabinet simulation...
and equalization tone shaping options available! Tube sound, speaker simulation, warm equalization and cool lo-fi textures—no wonder thousands of records feature the classic sounds of SansAmp!

The following table lists the SansAmp PSA-1 plug-in parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PSA-1 Controls</td>
<td>Use the eight knobs to dial in your tone or effect.</td>
</tr>
<tr>
<td></td>
<td>• Pre-Amp - Determines the input sensitivity and pre-amp distortion. Increasing the setting produces an effect similar to putting a clean booster pedal ahead of a tube amp, overdriving the first stage. For cleaner sounds, use settings below the unity-gain point.</td>
</tr>
<tr>
<td></td>
<td>• Buzz - Controls low frequency break up and overdrive. Boost the effect by turning clockwise from the center point indicated by the arrows. As you increase towards maximum, the sound becomes (you guessed it) buzzy, with added harmonic content. For increased clarity and definition when using distortion, position the knob at its midpoint or towards minimum.</td>
</tr>
<tr>
<td></td>
<td>• Punch - Sets midrange break up and overdrive. Decreasing from the center produces a softer, “Fender”-style break up. Increasing the setting produces a harder, heavier distortion. At maximum, it produces a sound similar to a wah pedal at mid-boost position placed in front of a Marshall amp.</td>
</tr>
<tr>
<td></td>
<td>• Crunch - Brings out upper harmonic content and, on guitars, pick attack. For cleaner sounds or smoother high end, decrease as needed.</td>
</tr>
<tr>
<td></td>
<td>• Drive - Increases the amount of power amp distortion. Power amp distortion is associated with the “Vintage Marshall” sound—using SansAmp, you can produce the effect even at low levels.</td>
</tr>
<tr>
<td></td>
<td>• Low - Provides a tone control specially tuned for maximum musicality when used to EQ low frequencies on instruments. Boost or cut by ±12 dB by turning from the center point indicated by the arrows.</td>
</tr>
<tr>
<td></td>
<td>• High -Boosts or cuts high frequencies by ±12 dB.</td>
</tr>
<tr>
<td></td>
<td>• Level -Boosts or cuts the overall gain to re-establish unity after adding distortion or equalizing the signal.</td>
</tr>
</tbody>
</table>

**Sci-Fi (Audio Track Effect and AudioSuite)**

Sci-Fi is designed to mock-synthesize audio by adding effects such as ring modulation, resonation, and sample & hold, that are typically found on older, modular analog synthesizers. Sci-Fi is ideal for adding a synth edge to a track.

The following table lists the Sci-Fi plug-in parameters:
### Parameter Description

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input Level</td>
<td>Input Level attenuates signal input level to the Sci-Fi processor. Since some Sci-Fi controls (such as Resonator) can cause extreme changes in signal level, adjusting the Input Level is particularly useful for achieving unity gain with the original signal level. The range of this control is from –12 dB to 0 dB.</td>
</tr>
<tr>
<td>Effect Type</td>
<td>Sci-Fi provides four different types of effects:</td>
</tr>
<tr>
<td></td>
<td>• Ring Mod — Modulates the signal amplitude with a carrier frequency, producing harmonic sidebands that are the sum and difference of the frequencies of the two signals. The carrier frequency is supplied by Sci-Fi itself. The modulation frequency is determined by the Effect Frequency control. Ring modulation adds a characteristic hard-edged, metallic sound to audio.</td>
</tr>
<tr>
<td></td>
<td>• Freak Mod — Modulates the signal frequency with a carrier frequency, producing harmonic sidebands that are the sum and difference of the input signal frequency and whole number multiples of the carrier frequency. Frequency modulation produces many more sideband frequencies than ring modulation and an even wilder metallic characteristic. The Effect Frequency control determines the modulation frequency of the Freak Mod effect.</td>
</tr>
<tr>
<td></td>
<td>• Resonator+ and Resonator — Adds a resonant frequency tone to the audio signal. This frequency is determined by the Effect Frequency control. The difference between these two modules is that Resonator– reverses the phase (polarity) of the effect, producing a hollower sound than Resonator+. The Resonator can be used to produce metallic and flanging effects that emulate the sound of classic analog flangers.</td>
</tr>
<tr>
<td>Effect Amount</td>
<td>Effect Amount controls the mix of the processed sound with the original signal. The range of this control is from 0-100%.</td>
</tr>
<tr>
<td>Effect Frequency</td>
<td>Effect Frequency controls the modulation frequency of the ring modulator and resonators. The frequency range is dependent on the effect type. For Ring Mod, the frequency range of this control is from 0 Hz to 22.05 kHz. For Freak Mod, the frequency range is from 0 Hz to 22.05 kHz. For Resonator+, the frequency range is from 344 to 11.025 kHz. For Resonator–, the frequency range is from 172 Hz to 5.5 kHz. You can also enter a frequency value using keyboard note entry.</td>
</tr>
<tr>
<td>Modulation Type</td>
<td>Modulation Type determines the type of modulation applied to the frequency of the selected effect. Depending on the type of modulation you select here, the sliders below it will change to provide the appropriate type of modulation controls. If the Mod Amount is set to 0%, no dynamic modulation is applied to the audio signal. The Effect Frequency slider then becomes the primary control for modifying the sound.</td>
</tr>
<tr>
<td>LFO</td>
<td>Produces a low-frequency triangle wave as a modulation source. The rate and amplitude of the triangle wave are determined by the Mod Rate and Mod Amount controls, respectively.</td>
</tr>
</tbody>
</table>
The Signal Generator plug-in produces audio test tones in a variety of frequencies, waveforms, and amplitudes. The plug-in has the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency</td>
<td>Sets the frequency of the signal in hertz. Values range from a low of 20 Hz to a high of 20 kHz.</td>
</tr>
<tr>
<td>Level</td>
<td>Sets the amplitude of the signal in decibels. Values range from a low of –95 dB to a high of 0.0 dB.</td>
</tr>
</tbody>
</table>
Use the rms and peak buttons to switch the calibration of the generated signal between RMS and Peak modes. Peak generates the signal at the maximum possible level without clipping. RMS generates the signal at levels consistent with the root-mean-square value, or the effective average level of the signal.

The Signal Generator produces a tone as soon as it is inserted on a track. To mute the tone, click the Bypass button.

Time Compression Expansion (AudioSuite)

The Time Compression Expansion plug-in lets you adjust the duration of selected regions by increasing or decreasing the selection’s length without changing pitch. This function is particularly important in audio postproduction applications because it lets you adjust sounds to specific time lengths or timecode durations for synchronization.

The Time Compression Expansion plug-in is in the Unused Plug-ins folder. Avid recommends you use the Time Shift plug-in.

To change duration (length) and pitch simultaneously, use the Pitch Shift plug-in.

The Time Compression Expansion plug-in can compress or expand two tracks as a “stereo pair,” processing the two sides of the stereo signal relative to each other.

The Time Compression Expansion plug-in has special parameters that let you enter time compression or expansion values in different formats. They are located in the Source and Destination columns, and include the Ratio slider. You can also fine-tune the compression and expansion process in the following ways:

- Press and hold the Ctrl key (Windows) or the Command key (Macintosh) to engage slider fine-tune mode.
- Alt+click (Windows) or Option+click (Macintosh) a field or slider to reset its default value.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Signal | Lets you select the waveform:  
- Sine  
- Square  
- Sawtooth  
- Triangle  
- White Noise  
- Pink Noise |
The following table lists the Time Compression Expansion plug-in parameters.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source and Destination</td>
<td>The Source text boxes display the length of the current selection before processing in each of the listed formats. All the text boxes in both columns update dynamically, so a change made to one value is immediately reflected in the values displayed in the other text boxes. The text boxes in the Destination column display and control the length of the selection after processing using the current settings. You can enter the length of the Destination file by double-clicking the appropriate text box in the Destination column. Type the number of samples in \textit{min:secs:msec} format or type timecode values as start and end locations. All the Destination text boxes update dynamically, so a change made to one value is immediately reflected in the values displayed in the other text boxes. You can also enter a new tempo, \textit{bars:beats:ticks} length, or time signature for regions that have tempo or Bars &amp; Beats settings. This can be any region associated with a MIDI Metronome value (such as an overdub recorded to a MIDI click) or regions that have been processed with the Pro Tools Identify Beat command. The Ratio slider lets you set the destination length in relation to the source length. Dragging the slider to the right increases the length of the destination file, and dragging the slider to the left decreases its length. The controls below the bar line lets you fine-tune the time compression and expansion process. They include the Crossfade, Min Pitch, and Accuracy sliders.</td>
</tr>
<tr>
<td>Crossfade</td>
<td>The Crossfade slider lets you manually adjust the crossfade length in milliseconds to optimize performance of the Time Compression Expansion plug-in according to the type of audio material you process. The Time Compression Expansion plug-in achieves length modification by replicating or subtracting very small portions of audio material and very quickly crossfading between these alterations in the waveform of the audio material. Crossfade length essentially affects the amount of smoothing performed on audio material to prevent audio artifacts such as clicks. In general, small narrow-range time (length) changes require longer crossfades while larger changes in length require shorter crossfades. The disadvantage of long crossfade times is that they smooth the signal, including any transients. While this can be desirable for audio material such as vocals, it is not appropriate for material with sharp transients such as drums or percussion. The default setting for this parameter is Auto (leftmost position), in which crossfade times are set automatically according to the percentage of change in length for the current process. This setting should suffice for most applications, but you can use this slider to manually adjust and optimize crossfade times, if necessary. For audio material with sharper attack transients, use shorter crossfade times. For audio material with softer attack transients, use longer crossfade times with a range in values of 1 to 200 ms.</td>
</tr>
</tbody>
</table>
The Time Shift plug-in provides high quality time compression and expansion algorithms and formant-correct pitch-shifting. Time Shift is ideal for music production, sound design, and post-production applications. You can use it to manipulate audio loops for tempo matching or to transpose vocal tracks using formant-correct pitch-shifting, or you can use it in audio postproduction for pullup and pulldown conversions as well as for adjusting audio to specific time or SMPTE durations for synchronization purposes.

The Time Shift plug-in has special parameters that let you enter time compression or expansion values in different formats and edit the pitch shift parameters displayed in the plug-in window. Time Shift plug-in controls are organized in four parts: Audio, Time, Formant/Transient, and Pitch.

The following table lists the Time Shift plug-in parameters.

---

**Time Shift (AudioSuite)**

---

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Min Pitch</td>
<td>The Min Pitch slider lets you select the minimum (lowest) pitch that is used in the plug-in’s calculations during the time compression and expansion process. The slider has a range of 40 Hz to 1000 Hz. By controlling the minimum pitch, you can focus the time compression and expansion process for maximum efficiency depending on the audio’s spectral shape. Set this slider lower when you process bass guitar or another instrument with a similarly low range. Set the min pitch higher when processing instruments such as snare drums, violins, and other higher range instruments and sounds. Experiment with combinations of the other fine-tune controls in relation to the Min Pitch slider.</td>
</tr>
<tr>
<td>Accuracy</td>
<td>Use the Accuracy slider to prioritize the processing resources allocated to audio quality (sound) or timing (rhythm). Dragging the slider toward sound generally results in better sonic quality and fewer audio artifacts. Dragging the slider toward rhythm puts the emphasis on keeping the tempo consistent. When working with loops, listen carefully and adjust accuracy until you find the setting that keeps timing solid within the region. Start and end times are precise, but the perception of beats might be “shuffled” if the Accuracy slider’s rhythm setting is too low.</td>
</tr>
</tbody>
</table>

⚠️ **The smallest time ratio allowed for time compression and expansion is 0.25. The largest time ratio allowed is 4.0.**

appid Normalizing a selection before applying the Time Compression Expansion plug-in can sometimes produce better-sounding results.
### Parameter Description

**Audio**

You use the Audio parameter controls to select the most appropriate time compression and expansion mode for the type of material you want to process, and to attenuate the gain of the processed audio to avoid clipping.

Audio parameter controls let you select the following Mode settings to determine the correct time compression and pitch shift algorithms:

- **Monophonic** — for processing monophonic sounds (such as a vocal melody)
- **Polyphonic** — for processing complex sounds (such as a multipart musical selection)
- **Rhythmic** — for processing percussive sounds (such as a mix or drum loop)
- **Varispeed** — for linking time and pitch change for tape-like pitch and speed change effects, and postproduction workflows

You can also select the following frequency Range settings:

- **Low** — for low-range material, such as a bass guitar
- **Mid** — for mid-range material, such as male vocals
- **High** — for material with a high fundamental frequency, such as female vocals
- **Wide** — for more complex material that covers a broad frequency spectrum

> In Polyphonic mode, Wide is the default Range setting and is usually best for all material. In Monophonic mode, Mid is the default Range setting and usually matches the range of most monophonic material. Range settings are not available when you select either Rhythmic mode or Varispeed mode.

The Audio Gain control attenuates the input level to avoid clipping. Adjust the Gain control from 0.0 dB to –6.0 dB to avoid clipping in the processed signal.

The Clip indicator is active when clipping occurs in the processed signal. If the processed signal clips, remove the AudioSuite plug-in effect, attenuate the input gain using the Gain control, and then reapply the plug-in.

The Level indicator displays the level of the output signal, which uses the full range of plasma-level meter colors.
You use the Time parameter controls to specify the amount of time compression or expansion you want to apply.

The Original column displays the Start and End times, and Length of the edit selection. Times are displayed in units of the timebase selected in the Units menu.

The Processed column displays the target End time and Length of the processed signal. Times are displayed in units of the timebase selected in the Units menu. You can click the Processed End and Length text boxes to type the desired values. These values update automatically when you are adjusting the Time control.

The Tempo row displays the Original Tempo and Processed Tempo in beats per minute (bpm). You can click the Original Tempo and Processed Tempo text boxes to type the desired values. The Processed Tempo value updates automatically when adjusting the Time control.

You use the Units menu to select the desired timebase for the Original and Processed time fields:

- Bars|Beats
- Min:Sec
- Time Code
- Feet+Frames
- Samples

The Shift text box displays the target time compression or expansion as a percentage of the original. You can adjust the Time control, or click the Shift text box and type the desired value. You can shift time from 25.00% to 400.00% of the original speed (or 4 to 1/4 times the original duration). The default setting is 100.00%, or no time shift. Selecting 25.00% results in 4 times the original duration and 400.00% results in 1/4 of the original duration.

*The Shift field displays up to 2 decimal places, but you can type in as many decimal places as you require (up to the IEEE standard). While the display rounds to 2 decimal places, the actual time shift is applied based on the number typed in the Shift text box. This is useful for postproduction pullup and pulldown factors.*
Core Avid Audio Plug-Ins

Trim (Audio Track Effect)

The Trim plug-in can be used to attenuate an audio signal from -\([\infty]\) dB to +6 dB or \([\infty]\) dB to +12 dB. For example, using a multi-mono Trim plug-in on a multichannel track provides simple, DSP-efficient muting control over the individual channels of the track.

This capability is useful, since Mute buttons mute all channels of a multichannel track and do not allow muting of individual channels within the track.
The following table lists the Trim plug-in parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Phase Invert</td>
<td>Inverts the phase (polarity) of the input signal to change the frequency response characteristics between multi-miked sources or to correct for miswired microphone cables.</td>
</tr>
<tr>
<td>Gain</td>
<td>Provides -[Infinity] dB to +6 dB or +12 dB of gain adjustment, depending whether the Gain toggle is set to +6 or +12.</td>
</tr>
<tr>
<td>+6/+12 Gain Toggle</td>
<td>Switches the maximum level of attenuation between -[Infinity] dB to +6 dB and -[Infinity] dB to +12 dB.</td>
</tr>
<tr>
<td>Output Meter</td>
<td>Indicates the output level, including any gain compensation added using the Gain control.</td>
</tr>
<tr>
<td>Mute</td>
<td>Mutes the signal output.</td>
</tr>
</tbody>
</table>
Exporting Frames, Clips, or Sequences

This chapter describes how to export files for use with another system, application, or platform.

- Understanding Export
- Preparing to Export a Sequence
- Exporting With the Send To Templates
- Send To Templates Reference
- Creating a Custom Send To Template for Exporting to Third-Party Applications
- Exporting With the Export Command or the Drag-and-Drop Method
- Customizing Export Settings
- Guidelines for Exporting OMFI and AAF Files
- Exporting Projects and Bins Using AFE Files (Windows Only)
- Exporting QuickTime Movies
- Installing or Copying the Avid Codecs for QuickTime on Other Systems
- Exporting from a Third-Party QuickTime or AVI Application
- Exporting as Windows Media (Windows Only)
- Creating a Custom Profile for Windows Media Export (Windows Only)
- Exporting to XDCAM
- Exporting XDCAM OP1a Media
- Exporting MXF OP1a
- Exporting a Simplified AAF
- Exporting Your Clip or Sequence to a P2 Card
- Using Avid Interplay Media Services

For information about linking file-based media, see Acquisition of File-Based Media (AMA).
Understanding Export

You can export material directly from your Avid editing application to many supported file types. You can export an individual frame, a selected region of footage, or an entire clip or sequence.

If a power failure or application error occurs during the export process, the entire file is unusable. You need to repeat the export process. The only exception is a sequential file sequence, where all frames up to the point of failure are usable.

Reasons for Exporting Material

You can export video, audio, or both for many reasons, including the following:

- You can export video files for touching up or creating special effects in third-party applications or other Avid applications.
- You can export files to view as AVI or QuickTime movies.
- You can export files for further processing to create streaming media files in formats such as RealVideo®, QuickTime, and Windows Media™.
- You can export files for use in multimedia projects distributed on CD or DVD, or for DVD authoring workflows.
- You can export audio files for audio sweetening in a digital audio workstation, such as a Pro Tools system.
- You can use the export process to convert audio media files from one supported audio format to another. Your Avid editing application supports the AIFF-C, Sound Designer II (Macintosh only), and WAVE formats.

Export Settings and Send To Templates

Your Avid editing application uses Export settings and Send To templates to control the format of the exported file. Your Avid editing application ships with a default Export setting and a set of templates for common types of export. You can also create any custom Export settings that you might need.

Depending on how you choose to export and the type of export you are performing, you select the Export setting or Send To template you need in one of the following ways:

- Choose a Send To command from the File menu.
- Select from the Export Settings list in the Export As dialog box.
- Select from the Settings list in the Project window.
Depending on how you choose to export, you can:

- Use the Export setting or Send To template you select without modification.
- Modify the options in the setting or template for use in the current export only.
- Modify the Export setting and save the modifications to that setting.
- Modify the setting or template and save the modifications as a new Export setting or a new custom Send To template.

## Preparing to Export a Sequence

When you export part or all of a sequence — for example, to create an OMFI file, an AAF file, a QuickTime file, an AVI file, or a graphic sequence — you might want to prepare the sequence in advance in one or more of the ways described in the following table. These preparation tasks can speed the export process or otherwise help with your workflow.

<table>
<thead>
<tr>
<th>Preparation Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Make sure all media for the sequence is online.</td>
<td>For more information about selecting offline items in a bin, see “Displaying Clip Colors in the Timeline” on page 667 and “Selecting Offline Items in a Bin” on page 359.</td>
</tr>
<tr>
<td>Consider archiving the source sequence before making any alterations.</td>
<td>Duplicate the sequence, place the duplicate in another bin, and prepare the duplicate for export. The original sequence is unaffected.</td>
</tr>
<tr>
<td>Consider rendering all effects in advance.</td>
<td>Although any unrendered effects are rendered on export (except for an OMFI or AAF export), rendering effects in advance saves time during the export process. For information on rendering effects, see “Basics of Effects Rendering” in the Help.</td>
</tr>
<tr>
<td>Render fast-saved titles.</td>
<td>You must do this before using OMFI or AAF to export a sequence, or before creating an EDL from the sequence.</td>
</tr>
<tr>
<td>Consider mixing down tracks.</td>
<td>If your sequence contains numerous video or audio tracks, export is faster if you mix down the tracks in advance. However, you should not mix down if you need to preserve multiple-track information. For more information about mixing down video tracks, see “Performing a Video Mixdown” in the Help. For more information about mixing down audio tracks, see “Mixing Down Audio Tracks” on page 836.</td>
</tr>
</tbody>
</table>
Exporting With the Send To Templates

The Send To option lets you to send clips or sequences from your Avid editing system to other applications. You choose a Send To template that uses options customized for the specific workflow. In many instances you can choose to automatically launch your Avid editing application to which you are sending your clip or sequence.

If a power failure or application error occurs during the export process, the entire file is unusable. You need to repeat the export process. The only exception is a sequential file sequence, where all frames up to the point of failure are usable.

To export by using a Send To template:

1. Select a clip or sequence in a bin.
2. Do one of the following:
   - Select File > Send To > template.
   - Right-click the clip or sequence in the bin, and select Send To > template.

---

### Preparation Task Description

<table>
<thead>
<tr>
<th>Preparation Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Make sure all audio clips have the same sample rate.</td>
<td>For more information, see “Changing the Audio Sample Rate for Sequences and Audio Clips” on page 835. You can also use OMFI or AAF to change the sample rate. For more information, see Guidelines for Exporting OMFI and AAF Files.</td>
</tr>
<tr>
<td>Check and adjust all pan and audio levels.</td>
<td>All current Pan and Level settings in the sequence are carried to the exported media. For information on adjusting level and pan, see “Using the Audio Mixer Tool” on page 788.</td>
</tr>
<tr>
<td>Consider consolidating the sequence before OMFI export.</td>
<td>You cannot export OMFI files that are larger than 2 GB. Consolidating the sequence to create smaller source clips saves time and disk space. In addition to consolidating in advance, you can also consolidate as part of the export. For more information, see Using the Consolidate Command and Guidelines for Exporting OMFI and AAF Files.</td>
</tr>
<tr>
<td>Consider breaking the sequence into smaller sequences before OMFI or AAF export.</td>
<td>OMFI or AAF files with very complex sequences might fail during import into some applications due to memory limitations. You can also consider adding more physical memory.</td>
</tr>
<tr>
<td>Create a sequence from multiple clips to export them as a single file.</td>
<td>You can select all the clips, Alt+drag (Windows) or Option+drag (Macintosh) them into the Record monitor to create an instant sequence, and then export the sequence.</td>
</tr>
</tbody>
</table>
If you are sending to Avid Pro Tools®, a template options dialog box opens. Otherwise, the Send To dialog box opens.

3. (Option) If you are sending to Avid Pro Tools, select one of the template options in the following table.

The last three options are only available when you send to Pro Tools over an Avid shared storage using Send To > Pro Tools on Avid Unity.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Avid Video -</td>
<td>Select this option to send to a Avid Pro Tools system that supports playback of Avid standard definition (SD) video using a video peripheral. Your Avid editing application creates a video mixdown of the tracks at DV 25, consolidates the audio, and saves the audio into the AAF file.</td>
</tr>
<tr>
<td>Consolidate</td>
<td></td>
</tr>
<tr>
<td>Audio</td>
<td></td>
</tr>
<tr>
<td>QuickTime -</td>
<td>Select this option to send to a Pro Tools system that supports QuickTime video only. The Pro Tools system does not have a video peripheral. Your Avid editing application creates a QuickTime movie for the SD video, consolidates the audio, and embeds the audio into the OMF file.</td>
</tr>
<tr>
<td>Embed Audio</td>
<td></td>
</tr>
<tr>
<td>QuickTime -</td>
<td>Select this option to send to a Avid Pro Tools system that supports playback of Avid high definition video using a video peripheral. Your Avid editing application creates a video mixdown of the tracks, consolidates the audio, and saves the audio into the AAF file.</td>
</tr>
<tr>
<td>Consolidate</td>
<td></td>
</tr>
<tr>
<td>Audio</td>
<td></td>
</tr>
<tr>
<td>Link to Video</td>
<td>Select this option to export AAF metadata only (no media is exported). Pro Tools links to, or references, the Avid video and audio files located on Avid shared storage. The Pro Tools user can copy media during the AAF import into Pro Tools. This is the fastest export from Avid.</td>
</tr>
<tr>
<td>and Audio</td>
<td></td>
</tr>
<tr>
<td>Video Mixdown -</td>
<td>Select this option to create a flattened video mixdown of the tracks. The AAF links to the Avid audio media files located on Avid shared storage. The Pro Tools user can copy media during the AAF import into Pro Tools.</td>
</tr>
<tr>
<td>Link to Audio</td>
<td></td>
</tr>
<tr>
<td>QuickTime -</td>
<td>Select this option to send to a Pro Tools system that supports QuickTime video only. The AAF links to the Avid audio media files located on Avid shared storage. The Pro Tools user can copy media during the AAF import into Pro Tools.</td>
</tr>
<tr>
<td>Link to Audio</td>
<td></td>
</tr>
</tbody>
</table>

The Send To dialog box opens. The Filename text box displays the name of the sequence or clip you chose.
4. (Option) Type a new file name in the Filename text box.

5. (Option) If you are sending to Sorenson Squeeze, click the Options button to select Sorenson Squeeze settings.
   
   For more information, see the Sorenson Squeeze documentation.

6. Click Set to browse to the drive and folder where you want to store the exported file.

   Whenever you return to a Send To dialog box, the destination folder that you set last appears in the destination field.

7. (Option) If the template you are using can automatically launch the application that handles the exported file, an Auto Launch option appears in the Send To dialog box and is selected. Auto Launch might also have sub-options. You typically do not change these settings, but you can deselect Auto Launch if you do not want the application to launch automatically, and you can change the selection of sub-options.
8. Review the current Export settings to ensure that they meet your needs.

The Export Setting Summary area at the bottom of the dialog box lists all the settings that affect the current export.

9. (Option) If you need to make any Export settings changes, click the appropriate Options button, make the changes, and click Save.

Avid recommends that you use the default options in the Send To templates wherever possible. If you are sending to Disc in particular, accept the default options to keep the Disc authoring and burning process as quick and simple as possible.

10. (Option) If you want to save your changes in the Send To dialog box as a new template, do the following:
   a. Click the Save As Template button.
   b. Rename the file.
      Make sure you leave the .stt extension.
   c. Click Save.

      Your Avid editing application saves the new template. The next time you select a sequence and choose File > Send To, the new template appears in the list.

11. (Option) If you are sending to Disc, insert a blank DVD in your Disc drive.

12. Click OK.

   Your Avid editing application exports the file. Depending on the settings you choose, your application might automatically launch an application to handle the exported file.

   If you are sending to Disc, the Burn to DVD dialog box opens.

13. (Option) If you are sending to Disc, select the capacity of your DVD medium from the Capacity menu, and then click OK.

   The capacity of your DVD medium must match the size you select from the Capacity menu.

   For information about the other options in the Burn to DVD dialog box, see the Sonic documentation.

   Your DVD is burned.

---

**Send To Templates Reference**

The following table describes the Send To templates that Avid supplies. If you create custom Send To templates, they also appear as Send To menu commands.

*If you are running an Avid Studio package, an Avid Studio products Send To submenu might appear in your Avid editing application.*
Creating a Custom Send To Template for Exporting to Third-Party Applications

To create a custom Send To template:

1. Select a clip or a sequence in a bin.
2. Do one of the following:
   - Select File > Send To > Make New.

## Template Description

<table>
<thead>
<tr>
<th>Template</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pro Tools, Pro Tools on Avid Unity</td>
<td>You can export a sequence to Avid Pro Tools® by sending it to movable storage and then taking the storage to a Pro Tools system, or you can export it directly to Pro Tools over an Avid shared storage system. Sending the sequence to movable storage lets you assemble all the media in one location for moving to a Pro Tools system. For each export method, you can select a template that meets your needs. You can also transfer files to Pro Tools through Interplay. For more information, see “Using Pro Tools and Interplay” in Avid Interplay Best Practices.</td>
</tr>
<tr>
<td>Disc &gt; Authoring, Disc &gt; One Step</td>
<td>You can export your sequence directly to Avid DVD by Sonic and then perform authoring functions in the Avid DVD by Sonic application. You can also export directly to Avid DVD by Sonic and burn your Disc in one step. This eliminates further authoring work and lets you create a Disc that plays without the graphics, menus, or other navigation devices that are typically added during Disc authoring.</td>
</tr>
<tr>
<td>Sorenson Squeeze</td>
<td>You can export a sequence to Sorenson Squeeze as a QuickTime Reference movie.</td>
</tr>
<tr>
<td>Avid DS</td>
<td>You can send a sequence to Avid DS as an AFE file or an AAF file. The Avid DS Send To template does not auto-launch Avid DS by default. If you have Avid DS installed on your system and want to launch it automatically, you can select Auto Launch and browse for Avid DS. Select Auto Load Exported File(s) if you want the files you export to automatically load in the Avid DS application. Select Reveal file if you want your system to search available drives, open Windows Explorer or the folder (Macintosh), and highlight related media files. If you are editing an offline sequence that you want to finish on Avid DS, make sure to consult the Avid DS Conform Guide, which contains important information about the most efficient way of preparing a sequence for the conform process.</td>
</tr>
<tr>
<td>Make New</td>
<td>This option lets you to create your own custom Send To templates for third-party applications. For more information, see “Creating a Custom Send To Template for Exporting to Third-Party Applications” on page 1026.</td>
</tr>
</tbody>
</table>
Creating a Custom Send To Template for Exporting to Third-Party Applications

- Right-click the clip or sequence in the bin, and select Send To > Make New.

The Send To dialog box opens with a default export template.

3. (Option) Type a new file name in the Filename text box.

4. Click Set to browse to the drive and folder that you want to be the default location for storing the exported file.

Whenever you return to a Send To dialog box, the destination folder you set last appears in the destination field.
5. (Option) Do the following if you want the third-party application to automatically launch after you export.
   a. (Option) Click the Auto Launch button, and select Add Item.
   b. (Option) Browse to find the third-party application.
   c. Click Open.
   d. Select Auto Load Exported File(s) if you want the files you export to automatically load in the third-party application.
   e. Select Reveal file if you want the system to search available drives, open Windows Explorer or the folder (Macintosh), and highlight related media files.

6. Make any changes to the Export settings that you need by clicking the appropriate Options button, making the changes, and then clicking Save.

7. Click OK.
   The Save As dialog opens.

8. Name the new Send To (.stt) template.

9. Click Save.
   Your Avid editing application creates the new template. It is now available as a Send To menu command for use when working with the third-party application.

---

**Exporting With the Export Command or the Drag-and-Drop Method**

You can export frames, clips, or sequences using the Export menu command. This method lets you modify the Export settings as part of the export process.

You can also export most types of files by dragging and dropping. This method is a quick and simple way to perform the actual export, but it requires you to set up the Export setting you want to use in advance.

> **You cannot use the drag-and-drop method to export ALE, tab-delimited, or sequential files.**

You can also perform some types of Export using the Send To commands. For more information, see “Exporting With the Send To Templates” on page 1022.

Regardless of the method you use for the export itself, you must first identify and select the material you want to export.
Your Avid editing application saves an intermediate file in a temporary folder as part of the export process. Ensure that the temporary folder is on a drive with plenty of space. You can view and change the location of the temporary folder in the General Settings dialog box. To save time when exporting with the drag-and-drop method, locate the temporary folder on the drive where you want to store the exported file.

If a power failure or application error occurs during the export process, the entire file is unusable. You need to repeat the export process. The only exception is a sequential file sequence, where all frames up to the point of failure are usable.

To identify and select the material you want to export:

1. Identify the portion of the clip or sequence you want to export.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>To export specific tracks in a clip or sequence:</td>
<td>Enable the tracks in the Track Selector panel, and disable all others. Ensure that Use Enabled Tracks is selected in the Export Settings dialog box.</td>
</tr>
<tr>
<td>To export a single-frame graphic:</td>
<td>Mark an IN point to export the marked frame from a bin or a monitor, or move the position indicator to the frame you want to export. Ensure that Use Marks is selected and that Sequential Files is deselected in the Export Settings dialog box.</td>
</tr>
<tr>
<td>To export part of a clip or sequence:</td>
<td>Mark IN and OUT points to export the marked range from a bin or a monitor. If you mark an IN point and no OUT point, your Avid editing application exports from the IN point to the end of the clip or sequence. Ensure that Use Marks is selected in the Export Settings dialog box.</td>
</tr>
<tr>
<td>To export the entire clip or sequence:</td>
<td>Make sure the topmost track is monitored. Ensure that Use Enabled Tracks and Use Marks are deselected in the Export Settings dialog box.</td>
</tr>
</tbody>
</table>

For information on setting options in the Export Settings dialog box, see “Customizing Export Settings” on page 1032.

2. Select the clip or sequence by doing one of the following:
   - Click the monitor that displays the clip or sequence you want to export.
   - Click the clip or sequence in a bin. Ctrl+click (Windows) or Shift+click (Macintosh) to select multiple clips or sequences.
To export a frame, clip, or sequence by using the Export menu command:

1. Identify and select the material you want to export as described above.

2. Do one of the following:
   - Select File > Export.
   - Right-click the clip or sequence, and then select Export.

The Export As dialog box opens with a default file name in the File name text box (Windows) or the Save As text box (Macintosh), based on the file type.
3. Click the Export Setting menu, and select a setting.

   This setting determines the format of the exported file. The default setting is labeled Untitled. Any settings that appear in the Settings list in the Project window appear in the menu. For information on the standard settings, see “Common Export Settings” on page 1470. For information on creating custom settings, see “Customizing Export Settings” on page 1032.

4. (Option) If you want to view or modify the current Export setting, or create a new one, click Options.

   The Export Settings dialog box opens. For more information, see “Customizing Export Settings” on page 1032.

   Depending on the export format, Export settings can be complicated. In some cases, options in the Export Settings dialog box open additional dialog boxes with further options. If you are modifying Export settings, consult the appropriate reference tables in “Export Settings” on page 1470 for detailed information.

5. In the Export As dialog box, select the destination folder for the file.

6. (Option) Change the file name.

   In most cases, keep the file name extension the same.

7. Click Save.
Your Avid editing application exports the file.

**To export a frame, clip, or sequence by dragging and dropping:**

1. Identify and select the material you want to export as described above.
2. In the Settings list in the Project window, select the setting you want to use for export.
   
   You can select the default Export setting, the preset templates, or any additional Export setting you have created. After you select a setting in the Settings list, the parameters remain the default settings for all exported files, unless you change them during the export. This is especially useful when you batch export a number of files directly from a bin at the same time. To view or modify the parameters, double-click the setting. For information on modifying options, see “Customizing Export Settings” on page 1032.

3. Click the clip or sequence from which you want to export and drag it to the location (folder or drive) where you want to store the file. To select multiple objects, Ctrl+click (Windows) or Shift+click (Macintosh) the objects and drag them to the folder or drive.

---

**Customizing Export Settings**

You can create and customize your own Export settings, either from the Project window or while performing an export by using the Export menu command.

**To create a new Export setting from the Project window:**

1. Click the Settings tab in the Project window.
   
   The Settings list appears.
2. Click Export.
3. Select Edit > Duplicate.
4. Name the setting by doing the following:
   a. Click the custom name column.
   b. Type a name.
   c. Press Enter (Windows) or Return (Macintosh).

> The custom name column is the center column in the Project window. When you move the pointer over the custom name column, the pointer changes from a pointing finger to a text insertion bar.

5. Double-click the new Export setting.
   
   The Export Settings dialog box opens.
6. Select the appropriate file type and options based on the descriptions in “Export Settings” on page 1470.
7. Click OK.

You can select this new setting whenever you export.

To modify an Export setting or create a new Export setting while performing an Export by using the Export menu command:

1. Click Options in the Export As dialog box.
   The Export Settings dialog box opens.
   For complete information on using the Export menu command, see “Exporting With the Export Command or the Drag-and-Drop Method” on page 1028.
2. Select the appropriate file type and options based on the descriptions in “Export Settings” on page 1470.
3. To save your settings in the existing settings file, click Save.
4. To create a new settings file, click Save As.
   The Save Export Setting dialog box opens.
   Type a name in the Setting Name text box, and click OK. The new setting appears in the Settings list in the Project window.

Guidelines for Exporting OMFI and AAF Files

OMFI and AAF are industry-standard file formats that let you exchange compositions and media between applications. OMF Interchange and AAF, as implemented in Avid editing applications, provide two basic methods for exporting files.

When you export to OMFI or AAF, select OMF 1.0, OMF 2.0, or AAF from the Export As menu in the Export Settings dialog box, and then select other options as described in “Export Settings: OMFI, AAF, and AFE” on page 1473.

Understanding OMF Interchange

OMF Interchange® (OMFI) is a platform-independent file format that stores both the digital media (video, audio, graphics, animation) and the information describing how the media is edited together to form a final sequence. This editing information, called a composition, is the OMFI representation of the sequence created in your Avid editing application. The OMF Interchange format is the result of cooperative efforts of many industry and standards partners and Avid.

Any other program that supports OMFI can read OMFI files, even if the program resides on a different computer platform. As a result, with OMFI, you can transfer between different applications on different platforms without worrying about cross-platform translations. This can be very effective for importing animation or audio files created on proprietary platforms.

1033
When you export audio to OMFI, the export option splits stereo audio tracks to separate mono tracks (for more information, see “Splitting Multichannel Tracks to Mono Tracks” on page 840). The operation also removes any Real-Time AudioSuite track effects.

To avoid errors and incompatibilities when you import and export OMFI files, observe the recommendations in “File Format Specifications” on page 1540.

You cannot export OMFI files that are larger than 2 GB. If you exceed this limit, an error message appears. For information on exporting large sequences, see “Preparing to Export a Sequence” on page 1021.

Understanding Advanced Authoring Format

Advanced Authoring Format (AAF), is a cross-platform, multimedia file format that allows interchange of media and composition information between AAF-compliant applications.

There are two general types of data in an AAF file:

- Media such as audio and video
- Composition information, or metadata, that describes how to combine and modify the media portions of the AAF file to produce a complete multimedia program

When you export sequences with effects through AAF, certain effect types are not exported to the AAF file. When you check compositions into an asset manager through AAF, all effects are exported. For export to Avid DS, use AFE files. See “Exporting Projects and Bins Using AFE Files (Windows Only)” on page 1036.

When you export audio to AAF, the export option splits stereo audio tracks to separate mono tracks (for more information, see “Splitting Multichannel Tracks to Mono Tracks” on page 840). The operation also removes any Real-Time AudioSuite track effects.

OMFI and AAF Export Method 1: Compositions with Linked Media

Avid editing applications can export an OMFI or an AAF file that contains only the editing information about a selected master clip or sequence. The file also contains links to the media used in the clip or sequence. You transfer the OMFI or AAF file to the other system, and also either transfer the media files or recapture the media. After you transfer or recapture the media, you can transfer revised composition-only files. However, if you consolidate the media, you must transport the consolidated media files as well. You can consolidate media during the export (see “Export Settings: OMFI, AAF, and AFE” on page 1473), or before the export (see Consolidating Media).
OMFI and AAF Export Method 2: Compositions with Embedded Media

Avid editing applications can export an OMFI or an AAF file that contains all the editing information for the selected master clip or sequence along with the video and audio media files for that master clip or sequence. See “Export Settings: OMFI, AAF, and AFE” on page 1473.

Guidelines for Exporting AAF Files to Pro Tools

You use the same basic method to create an AAF export for use with Pro Tools that you use when creating any other type of AAF export.

Several of the options you can select in the Export Settings dialog box have particular significance for exports to Pro Tools, so you need to select your options with care. The following table provides information on these settings. (For complete information on all the options available in the Export Settings dialog box for AAF export, see “Export Settings: OMFI, AAF, and AFE” on page 1473.)

<table>
<thead>
<tr>
<th>Setting</th>
<th>Guidelines</th>
</tr>
</thead>
<tbody>
<tr>
<td>Media Destinations (Video Details and Audio Details tabs)</td>
<td>• Using the Folder option with “Use Same Folder as AAF File” is very convenient for moving files back and forth between your Avid editing application and Pro Tools. If you select Folder and then check “Use Same Folder as AAF File,” your Avid editing application stores the media in the same folder as the exported AAF files (the folder that you select in the Export As dialog box when you start the export process). For example, you can easily store both the AAF files and the media in a single folder on a Firewire drive that you can move between your editing system and the Pro Tools system. You can also select Consolidate Media from the Export Method menu to copy consolidated media instead of all media. • The Embedded in AAF option is not generally useful for exporting video to Pro Tools because Pro Tools does not support embedded video media in AAF files. Pro Tools only supports embedded audio</td>
</tr>
</tbody>
</table>
### Exporting Projects and Bins Using AFE Files (Windows Only)

AFE (Avid File Exchange) files are an efficient way to transfer project information between Avid applications. For example, you can use AFE files to transfer projects and bins from an offline system to an Avid DS finishing system.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Guidelines</th>
</tr>
</thead>
<tbody>
<tr>
<td>Export Method: Video</td>
<td>- The Mixdown with Video Edits option is only compatible with Pro Tools v7.2 or later, and takes advantage of the fact that Pro Tools v7.2 or later can display multiple video tracks. This lets you add a video track that shows the video edits. This can be very useful to Pro Tools editors because it allows them to view the edit points between the various video clips without actually importing the individual video files into Pro Tools.</td>
</tr>
</tbody>
</table>
| Mixdown (Video Details tab) | - Your Avid editing application creates the following tracks as part of the export:  
  - Video tracks that represent each track and edit in the original sequence  
  - A “render track” that contains the single video mixdown track  
  - The system stores the metadata for the video mixdown “render track” within the AAF file. The render track points to the actual mixed-down video media file. If you open the exported sequence in an Avid editing application, you do not see the video mixdown track. However, when you import the file into Pro Tools v7.2 or later, Pro Tools imports the video mixdown track as a separate video track. Pro Tools composites the edit points from all of the original Avid video tracks into a single track.  
  - Pro Tools displays the video edit track as well as the video mixdown (render) track. This allows the Pro Tools editor to view the video edits. One benefit to this method is that you only bring the video mixdown into Pro Tools. The clips in the edit tracks do not reference any media. They simply match up with the video mixdown.  
  - The Mixdown without Video Edits option is compatible with all versions of Pro Tools, and is the only option suitable for versions of Pro Tools earlier than v7.2. This option replaces all of the video tracks with a single video track named Video Mixdown in the Track Panel. |
| Remove Track Effects | Selecting this option removes all audio track effects — for example, Real-Time AudioSuite (RTAS) effects — during export. This option is selected by default. |
| Split Tracks to Mono | Selecting this option splits all multichannel audio tracks to separate mono tracks. For more information, see “Splitting Multichannel Tracks to Mono Tracks” on page 840. This option is selected by default. |
Exporting Projects and Bins Using AFE Files (Windows Only)

AFE files are based on AAF (Advanced Authoring Format) technology. AFE files, however, are especially designed for sharing project information among Avid applications. AFE files let you transfer one or more bins, their contents, and information about the contents, including master clips, subclips, titles, and sequences.

To create an AFE file:

1. Do one of the following:
   - To include all bins in a project, click the Project window
   - To include the contents of a single bin, open and click the bin.
2. Select File > Export
   The Export Project As or the Export Bin As dialog box opens.
3. If it is not already selected, select Avid File Exchange from the Save As Type or Export Bin As list at the bottom of the dialog box.
4. Select a location, name the file, and click Save.
5. Transfer the AFE file to a location you can access from the other Avid application.
   You can use removable media, a network connection, or an Avid shared storage system.

Exporting the AFE File to Avid DS

Once the edits are completed in the Avid Media Composer, export the sequence as an AFE to Avid DS for finishing.

Some file formats that are linked byAMA (such as XDCAM), may require transcoding to MXF before being exported to Avid DS. These MXF files are saved to the \Avid MediaFiles\MXF\1 folder on your system. You need to make sure that Avid DS has access to this folder on the Media Composer system, or that the folder is copied to the Avid DS system in the same path.

You should also consult the Avid DS Conform Guide which provides information on sequence and clip metadata transferred from one editing application to the other.

To export an AFE from Avid Media Composer to Avid DS:

1. Select the sequence in the bin, right-click on it and select Send To > Avid DS.
   The Send To: Avid DS dialog box opens with the default export template.
2. (Optional) Change the file name.
3. Click the Set button and browse to the drive and folder to which you want to export the sequence, and click OK.
4. Select Export Settings 1.
   All current settings are displayed in the summary panel below.
5. Click the button after the Export Settings 1, and select Avid DS from the drop-down list.

6. Click the Options button.

   The Export Settings - Avid DS dialog box opens.

7. Select AFE from the Export As drop-down list and click Save.

8. In the Send To: Avid DS dialog box, click OK.

**Exporting QuickTime Movies**

You can export a sequence as a QuickTime movie for final distribution or for further processing in another application.

Your Avid editing application comes with a set of Avid codecs for QuickTime. You can use these codecs to export QuickTime files from your Avid system, or to export QuickTime files from third-party applications for fast import into an Avid system. For more information, see “Export Settings: QuickTime Compression Settings” on page 1481 and “Installing or Copying the Avid Codecs for QuickTime on Other Systems” on page 1041.

If you are exporting your QuickTime movie for review or final distribution, then you should use the Apple codecs so that the file can be played back on any system.

The following table describes the three basic methods for QuickTime export.

*Your Avid editing application does not support sample rates higher than 48kHz for QuickTime audio export. If you export material that has a higher audio sample rate, the resulting QuickTime movie has 48kHz audio.*
**Exporting QuickTime Movies**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Same as Source</td>
<td>Select this option if you intend to use the Quicktime movie on an Avid system. When you select this option, your Avid editing application uses an Avid codec and puts a QuickTime wrapper around the media files (with no resolution change). This method is fast and creates output that uses the same quality as your source files. You should select Same as Source for your export option when you select Direct Out as your audio format for media that includes surround sound. This allows you to export the track assignments in your source sequence accurately. <strong>You cannot perform a QuickTime export using the Same as Source option if all of the material you are attempting to export is SD but the project is HD, or if all of the material you are attempting to export is HD but the project is SD. You also cannot perform a QuickTime export using the Same as Source option if the material you are attempting to export does not match the raster size for the project. In these situations, there is no valid resolution available for the export, and a message box informs you that you cannot perform the export. You can transcode the material to a resolution supported by the project and then perform the export.</strong></td>
</tr>
<tr>
<td>Custom</td>
<td>Use this option if you want the Quicktime movie to play on any system. This will require you to use the Apple codecs to output the sequence. When you select this option, your Avid editing application decompresses the files, processes them, and compresses the files at the requested resolution and audio format. This method is slower and may lose quality. When you select the Custom option, you will need to click the Format Options button. In the Movie Settings dialog, click the Video, Settings button and choose the appropriate Compression Type—typically H.264 or MPEG-4. <strong>H.264 will take longer to export and is of higher quality than MPEG-4. However, it's usually not recommended for long sequences. MPEG-4 is a much faster export but of lower quality (and file size) than H.264.</strong> You might install additional QuickTime Export formats on your system. These formats appear in the Export As menu of the Export Settings dialog box with tildes (~) before their names. These formats have not been qualified and are not supported by Avid. The Custom format is useful if you plan to export to an older ABVB or NuVista system.</td>
</tr>
</tbody>
</table>
QuickTime Reference is available from the Export As menu in the Export Settings dialog box. This option is similar to Same as Source, but your Avid editing application links to the original media files. This is the fastest method of export, but the movie can only be run or processed on your local system or in an Avid shared storage workgroup environment. If you want to transfer a QuickTime movie to another system, you must also move the associated media files by creating a self-contained QuickTime movie.

A QuickTime reference movie contains composition information but no movie data. Instead, the movie contains pointers to the original media in the OMFI MediaFiles directory or the Avid MediaFiles directory on local or network media drives. Because the QuickTime reference movie does not contain media, the file is much smaller than a QuickTime movie, usually only a few kilobytes per file. Therefore, exporting a sequence as a QuickTime reference movie is faster and takes up less disk space than exporting a sequence as a QuickTime movie. When you play the movie in QuickTime Player, the movie references the media files for playback.

Avid supports exporting Long-GOP QuickTime Reference movies.

If you want to play the exported movie in QuickTime, you need to purchase a third-party QuickTime plug-in. Avid recommends the CalibratedXD Decode from Calibrated Software: http://www.calibratedsoftware.com/. You can also play the exported movie directly in Final Cut Pro.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video and Audio</td>
<td>Exports the sequence with both video and audio.</td>
</tr>
<tr>
<td>Video only</td>
<td>Exports the sequence with video only.</td>
</tr>
<tr>
<td>Audio only</td>
<td>Exports the sequence with audio only.</td>
</tr>
<tr>
<td>Video Format</td>
<td>Exports the video according to the values that you choose.</td>
</tr>
<tr>
<td>Width x Height</td>
<td>Set a custom frame size for your exported movie. This option is useful if you require a format that can be viewed on mobile devices.</td>
</tr>
<tr>
<td>Size to fit</td>
<td>Stretches the image (disproportionally, if necessary) to fill the frame.</td>
</tr>
<tr>
<td>Crop/Pad</td>
<td>Scales the image proportionally until either the height or the width extends to the project frame. Black bands will appear on the sides (Pillarbox), or on the top and bottom (Letterbox) in order to pad the empty areas of the frame.</td>
</tr>
<tr>
<td>Color levels</td>
<td></td>
</tr>
<tr>
<td>RGB</td>
<td>Exports the video according to the RGB color level limits (0-255).</td>
</tr>
<tr>
<td>601/709</td>
<td>Exports the video according to the 601/709 color level limits. (16-235)</td>
</tr>
<tr>
<td>Audio Format</td>
<td>Exports the audio according to the values that you choose.</td>
</tr>
</tbody>
</table>
Avid supports the import and export of QuickTime movies while preserving their timecode information.

When you export a QuickTime clip or sequence from your Avid editing application, the timecode information of the clip or sequence is embedded in the QuickTime movie. If you move these QuickTime movies to another Avid editing application and import them, the timecode information is included in the clip or sequence information.

If a third-party application supports the preservation of timecode on import and export, the exported timecode track is visible when you export a QuickTime clip from your Avid editing application and then import it into or view it in the third-party application.

Installing or Copying the Avid Codecs for QuickTime on Other Systems

If you want to export a QuickTime movie from a third-party application such as Adobe After Effects® for use on an Avid system, install the appropriate Avid codec on the system running the third-party application. You can either download the codecs from the Avid website or copy them from your editing application system to another system.

To copy the Avid QuickTime Codecs from your editing system to another system:

1. On your Avid system, open one of the following folders:
   - (Windows) \Program Files\QuickTime\QTComponents
   - (Windows) \Windows\System32
   - (Macintosh) MacintoshHD/Library/QuickTime

2. Copy the codecs you need to a removable device or network server.

The following table describes the codecs:

<table>
<thead>
<tr>
<th>Codec (Windows)</th>
<th>Codec (Macintosh)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AvidAV1xCodec.qtx</td>
<td>QTAvidOneToOneXCodec</td>
<td>Avid 1:1x codec (Uncompressed MXF 8-bit or 10-bit)</td>
</tr>
<tr>
<td>AvidAVd1Codec.qtx</td>
<td>QTAvidDV100Codec</td>
<td>Avid DVCPRO codec (MXF)</td>
</tr>
<tr>
<td>AvidAVdnCodec.qtx</td>
<td>QTAvidDNXHDCodec</td>
<td>Avid DNxHD codec (MXF)</td>
</tr>
<tr>
<td>AvidAVdvCodec.qtx</td>
<td>QTAvidDVCodec</td>
<td>Avid DV codec (DV 25 and DV 50, OMF and MXF)</td>
</tr>
<tr>
<td>AvidQTAVjiCodec.qtx</td>
<td>QTAvidMeridienCompressedCodec</td>
<td>Avid Meridien Compressed codec (OMF 8-bit)</td>
</tr>
</tbody>
</table>
Exporting from a Third-Party QuickTime or AVI Application

To export files from a QuickTime compatible application or from an AVI compatible application on a Windows system for import (or reimport) into your Avid system:

1. Ensure the applicable codec is installed on the system.
   See “Installing or Copying the Avid Codecs for QuickTime on Other Systems” on page 1041.

2. Conduct the export according to the procedures used by the particular software, selecting the applicable Avid compressor from the Export settings.
   For QuickTime exports, most applications have format options similar to those described in “Export Settings: QuickTime Movie Export Options” on page 1478. Make sure you select settings that are compatible with your existing media on the Avid system.

   If you select a nonstandard frame size, your Avid system cannot import the file quickly.

3. Complete the export.
Exporting as Windows Media (Windows Only)

Your Avid editing application lets you export your sequence as native Windows Media using a variety of different template options. You can use templates that Avid supplies, use existing Windows Media profiles, or create custom video or audio profiles.

A Profile is a group of settings that matches content type and bit rate with the appropriate audio and video codecs. Profiles have the file name extension .prx. If you have an existing .prx file, select that file to use for the Windows Media export settings. You can create and save .prx files to share with others. For more information, see “Creating a Custom Profile for Windows Media Export (Windows Only)” on page 1043.

For information on the export options for Windows Media, see “Export Settings: Windows Media (Windows Only)” on page 1485.

Creating a Custom Profile for Windows Media Export (Windows Only)

To create a custom profile for Windows Media:

1. Select the sequence or clips you want to export.
2. Select File > Export.
   The Export As dialog box opens.
3. Click Options.
   The Export Settings dialog box opens.
4. In the Export As menu, select Windows Media.
5. (Option) Select Use Marks.
   When Use Marks is selected the current IN and OUT points in the selected clip or sequence determine starting and ending frames for the export.
6. (Option) Select Use Enabled Tracks.
   When Use Enabled Tracks is selected, your Avid editing application uses tracks that are enabled in the Timeline. To export all the tracks in the sequence, deselect this option.
7. Click the Add button and select either Video or Audio.
8. Choose your custom profile settings.
   For more information, see “Export Settings: Windows Media (Windows Only)” on page 1485.
9. Click Save As Custom Profile.
10. Browse to the location where you want to save the .prx file.
11. Name the file and click Save.
   Your Avid editing application saves the .prx file and returns you to the Export Settings dialog box.
12. Do one of the following:
   - If you want to continue with the export of the sequence, click Save, and complete the export in the standard way.
     For more information, see “Exporting With the Export Command or the Drag-and-Drop Method” on page 1028.
   - If you do not want to complete the export, click Cancel.

**Exporting Media to XDCAM Devices**

XDCAM decks and camcorders from Sony use an optical disk with a capacity of either 23.3 GB or 50 GB of media. The XDCAM devices store media in high-resolution MPEG IMX, DVCAM, and XDCAM HD formats.

You can export a clip, subclip, or sequence. You cannot export titles, effects, group clips, or rendered effects. The export mixes down the sequence and creates an XDCAM clip. All clips are given a new sequential name of Cxxxx.mxf, for example, C0019.mxf. This sequential file name system is created by the Sony deck. If you want to change the file name, your Sony deck needs Sony’s firmware version 1.5 or higher.

You can export a sequence or a clip with timecode to an XDCAM device. When you export a clip or sequence from your Avid editing application to an XDCAM device, the timecode information is embedded in the clip or sequence.

When you export XDCAM media, non-drop-frame timecode and drop-frame timecode is supported.

For information on connecting your XDCAM device, see your XDCAM documentation.

**Exporting to XDCAM**

You can export NTSC and PAL projects. Depending on the format (SD or HD), you need to use the appropriate XDCAM device (if you export SD media, use an XDCAM SD device; if you export HD media, you must use an XDCAM HD device).

By default, the Avid editing application pans audio tracks to the center which causes the XDCAM export operation to combine audio channels 1 and 2, 3 and 4, and so on. Before you export audio to XDCAM, use the Audio Mixer Tool to set the pan values to left/right in order to maintain discrete audio tracks in your exported media.
To export to an XDCAM device:

1. Connect your XDCAM device.

2. Select the appropriate mode on your XDCAM device that corresponds to the video format that you will be exporting.

   For example, set your XDCAM device to 1080i 59.94 if you want to export a clip or sequence at XDCAM-35 1080I/59.94.

3. Select the sequence or clips to export.

4. Select Output > Export to Device > XDCAM.

   If you have a sequence loaded in the Record monitor, the sequence exports when you select Export to Device.

   You can also right-click the clip or sequence in a bin and select Export to Device.

   The XDCAM Export Settings dialog box opens.

5. (Option) Select Use Marks.

   The current IN and OUT points in the selected clip or sequence determine starting and ending frames for the export.

6. (Option) Select Use Enabled Tracks.

   The system uses tracks that are enabled in the timeline. To export all the tracks in the sequence, deselect this option.

7. Select an XDCAM disk from the Target XDCAM Disk list.

   If the target XDCAM disk you are exporting to already has other clips on it, you are only allowed to export a clip with the same number of audio tracks. For example, if the target XDCAM disk has a clip with 4-tracks of audio, you cannot export a new XDCAM clip with 2 tracks. You either have to reformat the disk and wipe it clean or add two dummy tracks to your 2-track sequence before you export.
8. Select a video format:
   - For SD projects, select DV-25, IMX30, IMX40, or IMX50. For SD, a disk cannot have mixed formats. For example, a disk that contains IMX40 material can only have IMX40 media added to it, unless you reformat the disk.
   - For HD projects, select XDCAM-50, XDCAM-35, XDCAM-25, or XDCAM-17. For HD, a single disk can have clips with mixed bit rates (17.5, 25, and 35 Mbits). Additionally, a sequence that is being exported to an HD XDCAM disk can have mixed bit rates, as well.

If you use the Sony PDW HD1500 or the Sony PDW 1500 XDCAM device, export of up to 8 tracks of audio is supported for the MPEG IMX and XDCAM HD 50 Mbits formats. For other formats or devices that do not support 8 tracks, the system mixes down to audio tracks 1 and 2 during export.

9. Select a Bit Depth: 16 or 24 bits.
   For HD projects, select 16 bits. XDCAM HD devices are not capable of handling 24 bits, except for the Sony PDW HD1500 device, which is capable of handling 24 bits.

10. Click OK.

   Sony applies its own file-naming convention. All exported clips are given a new sequential name of Cxxxx.mxf, for example, C0019.mxf.

   A progress bar appears displaying the new Sony XDCAM sequential clip name. The sequence exports.

---

**Exporting XDCAM OP1a Media**

You can export frames, clips, or sequences as XDCAM OP1a files. When you open the Export Settings dialog box and select XCDAM MXF OP1a from the Export As menu, you can set export options available for your project.

XDCAM MXF OP1a export is available in any project type that supports XDCAM and XDCAM HD.

The number of audio tracks you can export depends on the bit rate supported by your device. For example, a bit rate of 50 mbps supports 8 tracks of audio for export, while a bit rate of 35 mbps supports only 4 audio tracks.
The Avid editing application supports exporting DNxHD as MXF OP1a wrapped media. Up to 16 channels of output and ancillary data are supported.

**To export a sequence or master clip as MXF OP1a:**

1. Select the sequence or master clip you want to export as MXF OP1a.
2. Click File > AMA File Export, or right click the sequence and select AMA File Export. The AMA File Export dialog opens.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video Format</td>
<td>Lists all XDCAM codecs supported by your project type.</td>
</tr>
<tr>
<td>Audio Bit Depth</td>
<td>Defines bit depth, based on the sample rates supported by your project type. You can use this option if your sequence has a mix of sample rates and you need to create a single sample rate. (You set the project rate in the Audio Project Settings dialog box. For more information, see “Audio Project Settings for Capture” on page 207.)</td>
</tr>
<tr>
<td>Display Aspect Ratio</td>
<td>Defines an image size for the video you want to export. The available aspect ratios depend on what your project type and device support. This lets you control the display format without modifying the source file.</td>
</tr>
</tbody>
</table>
3. Select File Type MXF OP1a Export.
4. (Option) Select the Use Marks or Use Enabled Tracks option.
   - When you select Use Marks, your Avid editing application uses current IN and OUT points in the selected clip or sequence to determine starting and ending frames for the export. To export the entire clip or sequence, deselect this option or mark the entire clip or sequence.
   - When you select Use Enabled Tracks, your Avid editing application exports the tracks that are enabled in the Timeline. To export all the tracks in the sequence, deselect this option.
5. Click the Directory Set button to and browse to the location where you want the file saved.
6. Click Select Folder.
7. Select the Video Compression, Audio Sample Rate, Bit Depth and Audio format.
8. Click Save.
   The MXF OP1a file is exported to the selected directory.
Exporting a Simplified AAF

The “Link To Effects Mixdown” export setting allows you to mix down both audio and video effects so that the exported AAF references only master clips. This might be useful for workflows with third party applications, such as Telestream® that want to link to the exported AAF media for further encoding. When the video is mixed down, if a segment of the video is an existing master clip or filler, a reference to that segment is added to the new sequence. If the segment is a transition or effect, a video mixdown occurs which creates a new master clip. The new mixed-down master clip is added to the project bin and a reference is added to the new sequence. For the audio mixdown, the editing application can limit the number of tracks included in the exported sequence to the first 2, 4, 8, or 16 tracks. If an audio track contains at least one effect or gain change, the entire track is mixed down to a new master clip. The new mixed-down master clip is added to the project bin and a reference is added to the new sequence.

To perform a simplified AAF Export:

1. In the Project Window, click the Settings tab and select the Export Link to Effects Mixdown setting.
   
   If the setting does not appear, click the User Profile Selection menu and select Update User Profiles. The new setting appears in the settings list.

2. Select the sequence you want to export as a simplified AAF.


4. Click Options.

   The Export Settings dialog opens.

5. Select AAF from the Export As menu.
6. Leave the following options enabled: In the Video/Data Details pane, the Mixdown Video/Effects to V1 is enabled. In the Audio Details pane, Flatten Audio Tracks that Contain Effects is enabled.

7. Select the number of audio tracks to include in the sequence.

8. Select the Media Destination Drive where you want to save any newly created media. (This should be a drive that your third party encoding application has access to.)

9. Click Save.

10. Select a location for the AAF file, name the file and click Save.

The AAF file is saved to the selected location.
Exporting Your Clip or Sequence to a P2 Card

If you have a P2 card writer, you can export a clip or sequence to your P2 card. The writer can be a P2 device or a camera enabled for P2 writing. You can export to one card or multiple cards.

If you connect to more than one P2 device, make sure only one is turned on. If more than one device is turned on, you cannot control which device you export to.

To export a clip or a sequence to a P2 card:

1. Make sure your system is connected to a writable P2 device.
2. Select the clip or the sequence in the bin.
3. Select Output > Export to Device > P2.
   The P2 Export Settings dialog box opens.

   ![P2 Export Settings](image)

4. Select options as described in “Export Settings: P2” on page 1493.
   If you do not connect to a P2 device or camera, the options are not available.

5. (Option) If you connect to a P2 device and it does not appear in the P2 Device list, select File > Mount All to update the list of mounted drives.

6. Click Save.
   A progress window opens, and the orange light on the P2 card flashes indicating that the card is being written to. If you have more than one card in the device, your Avid editing application writes to the first one in the list. If your sequence is larger than the space available on that card, your Avid editing application fills the first card and then writes to the next card.
Using Avid Interplay Media Services

The Media Services Settings dialog box lets you connect to an Avid Interplay Media Services Broker. Broker services are used in an Avid Interplay environment where dedicated computers automate time-consuming operations. The following table describes the broker services that you might use.

<table>
<thead>
<tr>
<th>Service</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Avid Interplay</td>
<td>Let you automate the process of encoding a sequence into formats that are suitable for distribution on the Web, on DVD, or on CD-ROM. The ProEncode services use other computers in the Avid Interplay environment to automatically perform the encoding tasks. This lets you quickly send a sequence to be processed and then continue with your editing.</td>
</tr>
<tr>
<td>ProEncode</td>
<td></td>
</tr>
<tr>
<td>Avid Interplay</td>
<td>Lets you transcode Avid assets from one Avid-supported resolution to another. For example, you can use the Avid Interplay Transcode service to create a low resolution version of a sequence or master clip. You can also use the Avid Interplay Auto Transcode service to automatically transcode media.</td>
</tr>
<tr>
<td>Transcode</td>
<td></td>
</tr>
<tr>
<td>Avid Interplay</td>
<td>Provides access to archive and restore features. The Avid Interplay Archive and Restore services manage the process of moving data, instead of using the Avid Interplay Transfer Engine. The Archive database keeps track of the files that you store on external storage devices and lets you restore files to your online system when they are needed.</td>
</tr>
<tr>
<td>Archive</td>
<td></td>
</tr>
</tbody>
</table>

You must install Avid Interplay Access and Avid Interplay Framework for Client on the Interplay Media Services server and any clients.

For more information on using Avid Interplay Media Services, see the Avid Interplay Media Services Setup and User’s Guide.
Generating Output

Your Avid editing application provides tools that let you generate output for individual tracks or entire sequences to various videotape or audiotape formats. The following topics provide basic information on preparing for and generating output:

- Preparing for Output: Overview
- Selecting the Device for Output
- Selecting the Sync Source for Output
- Selecting a Video Output Signal
- Calibrating for Video Output
- Preparing for Converting HD Formats
- Preparing for Audio Output
- Preparing Record Tapes
- Enabling Assemble-Edit Recording
- Using ExpertRender to Prepare Effects for a Digital Cut
- Using the Digital Cut Tool
- Understanding Passthrough
- Using the Lists Tool
- Preserving HD Closed Captioning and Ancillary Data

Preparing for Output: Overview

Preparing for video output involves the following procedures:

- Establish a sync source for output, as described in “Selecting the Sync Source for Output” on page 1055.
- Select the Video Output signal, as described in “Selecting a Video Output Signal” on page 1059.
- Calibrate and adjust video output levels, as described in “Calibrating for Video Output” on page 1059.
Selecting the Device for Output

Your Avid editing application lets you output through two different connections:

- Through connections on your Avid input/output hardware
- Directly to a DV camera or deck on a 1394 port. See “Connecting a DV Device” on page 193 and “Outputting DV50 and DVCPro HD Media Directly to a DV Device” in the Help.

Selecting the Sync Source for Output

You can use one of the following sources as sync for output:

- Black burst or house sync through the reference input (REF or REF SYNC) of your Avid input/output hardware
- Tri-level sync through the HD Tri-Level Sync input or the REF SYNC input on some Avid input/output hardware devices
- Internal timing from your Avid input/output hardware.

The source that you use depends on your production environment and your project needs.
Avid recommends that you use an external sync source whenever you record a digital cut to tape, or whenever the external equipment requires the Avid system to follow an external master clock. Connect the sync source to the appropriate input on the Avid input/output hardware and on the external equipment. For more information, see “Synchronizing Audio and Video Equipment” for your input/output hardware in the Help. Sync is not required for DV output.

To select the sync source:

1. Select Tools > Video Output Tool.
2. Select the sync source from the Sync Lock menu: Reference, Tri-Level, or Internal.

If the source you select is not correctly connected, or if the sync generator is set to an incorrect frame rate, your Avid editing application will automatically switch to internal timing.

Sync Options for HD Formats

Some HD formats let you use either black burst or tri-level as a sync source. Select the type of sync generator according to the following table.

For more specific information, see the documentation for your tri-level sync generator.

<table>
<thead>
<tr>
<th>Sequence Format</th>
<th>Tri-level Frame Rate Setting</th>
<th>Black Burst</th>
</tr>
</thead>
<tbody>
<tr>
<td>720p/23.976</td>
<td>720p/59.94</td>
<td>NTSC</td>
</tr>
<tr>
<td>720p/50</td>
<td>720p/50</td>
<td>PAL</td>
</tr>
<tr>
<td>720p/59.94</td>
<td>720p/59.94</td>
<td>NTSC</td>
</tr>
<tr>
<td>1080p/23.976</td>
<td>1080p/23.98sF</td>
<td>—</td>
</tr>
<tr>
<td>1080p/24</td>
<td>1080p/24sF</td>
<td>—</td>
</tr>
<tr>
<td>1080p/25</td>
<td>1080p/25sF</td>
<td>PAL</td>
</tr>
<tr>
<td>1080p/29.97</td>
<td>1080p/29.97</td>
<td>NTSC</td>
</tr>
<tr>
<td>1080i/50</td>
<td>1080i/50</td>
<td>PAL</td>
</tr>
<tr>
<td>1080i/59.94</td>
<td>1080i/59.94</td>
<td>NTSC</td>
</tr>
</tbody>
</table>

If 1080p/25sF is not available, you can use 1080i50.
Using LTC Timecode for Output

You can use LTC (longitudinal or linear timecode) for output from your Avid editing application through some Avid input/output hardware devices. The LTC OUT connector on the hardware provides SMPTE or EBU timecode you can use as a sync source for decks with built-in synchronizers or to stripe a destination tape. You can also use LTC to record non-drop-frame timecode for downstream encoding.

For more information, see “Selecting the Timecode Format for Output” on page 1093 and “Outputting Drop-Frame and Non-Drop-Frame Timecode Simultaneously for Downstream Encoding” on page 1094.

To set LTC timecode for output:

1. In the Settings list in the Project window, double-click General.
2. Select “Generate LTC On Playback.”
3. Click OK.

Adding LTC Out During Preroll

You can add black filler to the beginning of a sequence when performing a digital cut. This generates a preamble of LTC timecode before the actual digital cut begins. This preroll filler is set to 1 second. The filler added to the beginning of the sequence is not written to tape. This provides external hardware — such as a video overlay system — enough time to synchronize with the sequence time before the start of playback.

You can select the LTC Out during preroll option in the Digital Cut tool to add filler at the start of a sequence.
To add LTC Out During Preroll

1. Load your sequence in the Record monitor.
2. Select Output >Digital Cut.
3. Select the LTC out during preroll option.
4. Press the Play Digital Cut button.

LTC Output During Digital Scrub (When Using Nitris DX only)

LTC timecode will be output when the blue bar in the record monitor is moved, that is, during “digital scrub.” The LTC value is only output when audio is also output, that is, when Caps Lock is engaged or the shift key is down. The LTC value output corresponds to the first audio frame played, obeying the Audio Setting “Record Monitor Scrub” value for “Outgoing” frames.

Typical outboard hardware will add one frame to LTC values it receives, expecting to display the value on the next frame, so when paused, an “outgoing” value of 1 is normally required to get the outboard hardware to display the expected frame.
Selecting a Video Output Signal

Use the Video Output tool to select an analog video output signal. The options that are displayed depend on your hardware configuration.

- If you are using an Avid Nitris DX or Avid Mojo DX input/output hardware, all outputs on the hardware are active. Select an analog signal from the Output menu to calibrate for output. See “Calibrating for Video Output” on page 1059.
- If you are not using Avid input/output hardware (software-only), the Video Output tool is not available.

To select an analog video output signal:

1. Select Tools > Video Output Tool.
   The Video Output tool opens.
2. Click the SD Cal tab.
3. Click the Output menu, and then select an output format: Component, Composite, or S-Video.
4. Click the close box.

Calibrating for Video Output

You can calibrate for video output by using any of the methods described in the following table:

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calibrate for video output by using the factory presets</td>
<td>You should use the factory presets if you do not have an external Waveform monitor, or if your site engineers calibrate the system as a general maintenance procedure. For more information, see “Using the Factory Preset Buttons in the Video Output Tool” on page 1060.</td>
</tr>
<tr>
<td>Calibrate for video output by using external Waveform and VectorScope monitors</td>
<td>All users can follow the steps for calibrating video output, as described in “Basic Video Output Calibration” on page 1061.</td>
</tr>
<tr>
<td>Calibrate/sync output signals in a production facility</td>
<td>Advanced users and house engineers should follow the steps for adjusting and conforming output signals to house standards, as described in “Calibrating the System with Passthrough Signals” on page 1064.</td>
</tr>
</tbody>
</table>
Before you calibrate video output for an NTSC-EIAJ project (for Japan), make sure the “NTSC Has Setup” option is not selected in the General Settings dialog box, accessed from the Settings list in the Project window. For more information on General settings, see “General Settings” on page 1499.

You cannot set separate calibration levels for S-Video output, Composite output, and Component output. When calibrating video output, select one video output for calibration. The two other outputs are not guaranteed to be properly calibrated. If you need to send output to more than one SD device, Avid recommends that you use one analog output (Composite, Component, or S-Video) and one digital output (SDI).

For HD projects, you can calibrate only HD component output, which is usually used for monitors. You cannot calibrate output for HD-SDI.

Using the Factory Preset Buttons in the Video Output Tool

The preset buttons in the Video Output tool show the status of each Calibration setting as follows:

- When the Video Output tool opens the first time you run your Avid editing application, all preset buttons are lit (green), with the factory presets loaded for each slider.
- When you click a slider of a lit preset button, the button dims (appears gray), and the slider returns to the most recent manual level setting.
- When you click an unlit preset button, it becomes lit (green), and the slider moves to the factory preset level for that parameter.
- As you adjust levels in the tool, you can switch the preset buttons between the levels you set manually and the factory preset levels. These adjustments are described in “Basic Video Output Calibration” on page 1061 and “Calibrating the System with Passthrough Signals” on page 1064.
Basic Video Output Calibration

You can perform basic output calibration when working with a standalone editing workstation or in a production environment that does not require advanced calibration of horizontal phase or use of test patterns according to specific house standards.

Calibrating video output requires external Waveform and Vectorscope monitors. If you do not have external Waveform or Vectorscope monitors, keep the Video Output tool preset values.

You cannot set separate calibration levels for S-Video output, Composite output, and Component output. When calibrating video output, select one video output for calibration. The two other outputs are not guaranteed to be properly calibrated. If you need to send output to more than one SD device, Avid recommends that you use one analog output (Composite, Component, or S-Video) and one digital output (SDI).

To calibrate for video output:

1. Select Tools > Video Output Tool.

   The Video Output tool opens.
2. Click the Options tab.

3. Click the Sync Lock menu and select Internal, Reference, or TriLevel (if available) to lock your output connection to the appropriate signal. Some input/output hardware configurations automatically detect TriLevel sync and do not display it as an option.

*Sync for output comes from the reference input (REF) or HD TriLevel Sync input on the Avid input/output hardware or from internal timing. For more information, see “Selecting the Sync Source for Output” on page 1055.*

*If you do not have separate Vectorscope and Waveform monitors, you can use the client monitor’s “blue only” feature, if available, to adjust SC phase output. For more information on this feature, see your monitor’s documentation.*
4. If you are using an HDMI-compliant Avid input/output device, click the HDMI Color Space menu and select a color space (YCbCr or RGB), and then select either an SD or an HD format from the HDMI Format menu.

Some monitors only support one SD HDMI format. See your monitor documentation for more information.

5. (Option) Click the VBI menu (if available) and select Preserve to preserve 5 lines above each field in NTSC or 8 lines above each field for PAL.

6. Display color bars for calibrating:
   - If you edited digital bars and tone into the sequence, go to the head of the bars and tone and click Play.
   - You can use internal bars from the Video Output tool by clicking the Test Patterns menu in the Options tab, and selecting either SMPTE_Bars, (SMPTE standard bars), ColorBars (full-field bars at 75% level), or ColorBars_100 (full-field color bars at 100% level).

   Bars are displayed on the Client monitor, and the signal appears on the external Waveform and Vectorscope monitors.

   **The internal Waveform and Vectorscope monitors do not display output signals from the system.**

7. Click the SD Cal tab or the HD Cal tab, depending on the project format.

8. Click the Output menu, and select the video signal for your output device:
   - For SD, select either Component, Composite, or S Video.
   - For HD, select HD Component YPbPr or HD Component RGB, depending on the connection to your output device.

   **The Video Output tool does not display basic calibration controls for Serial Digital, DV, or HD-SDI. All basic levels remain in digital form and cannot be adjusted from within your Avid editing application. For H-phase adjustment of a Serial Digital output signal, see “Calibrating the System with Passthrough Signals” on page 1064.**

   The Video Output tool displays the appropriate parameters for the selected video format, as described in “Video Output Tool Settings” on page 1533.

9. Adjust luminance values based on the information in “Luminance Settings for Video Output” on page 1065.

10. Depending on your output type and input/output hardware, adjust the following sliders until the angle and amplitude of the six color vectors fall within the target boxes on the Vectorscope monitor. Not all sliders are available for some configurations.
    - Hue and Sat sliders (composite or S-Video output)
    - RY Gain and BY Gain sliders (component output)
Calibrating for Video Output

- Pr Gain and Pb Gain sliders (HD component YPbPr output — with supported input/output hardware)

11. If you want to save this setting, click the Settings menu and select Save As, then type a name, and click OK.

- Output settings are Project settings, available to all users and all projects on the system.

For information on connections on the Avid input/output hardware, see “Using the Avid Input/Output Hardware” in the Help. For information on adjusting output gain, see “Calibrating for Video Output” on page 1059.

Using Test Patterns

Use the menu of test patterns to calibrate the system output.

To display a test pattern:
- In the Video Output tool, click the Test Patterns menu, and select a pattern.

Calibrating the System with Passthrough Signals

If you work in a production environment in which house standards are used to synchronize a number of devices including the source decks connected to your Avid system, you can calibrate the system one time to conform to existing standards with the least amount of alteration of the signal. This method involves the use of a passthrough signal (a signal that gets sent directly from an input source through to the output channels).

This advanced form of calibration is an alternative to Video Input tool Calibration settings for each source tape, and involves calibrating tapes at the source device, using external time-base correction. You need a signal generator and external Waveform and Vectorscope monitors to calibrate the system with passthrough.

To calibrate using a passthrough signal:
1. Connect a source signal with a test pattern from a signal generator.
2. Select Tools > Video Input Tool.
3. Click the Input menu, and select a video format.
   - The selected input provides the passthrough signal.
4. Calibrate the input if necessary by using the Video Input tool, as described in “Calibrating Video Input” on page 223.
5. Save the input calibration settings as the system Default setting, as described in “Saving Video Input Settings” on page 228.
7. Select Tools > Capture.
   
   With the Capture tool active, the input signal passes through to the output channels.
8. Select an output format in the Video Output tool.
   
   You can precisely match only one output format at a time in phase with the reference signal. In most cases, you should select either Composite or Serial Digital.
9. Calibrate any of the available controls in the Video Output tool while checking the external Waveform and Vectorscope monitors.
   
   For example, composite output provides Gain and Saturation controls.
   
   For more information on using the Video Output tool, see “Preparing for Output: Overview” on page 1054.
10. In the Video Output tool, click the Test Patterns menu, and select a test pattern.
    
    The test pattern appears and is sent to the output channels (the input signal is no longer passed through). Additional controls are enabled in the Video Output tool for phase control.
11. Make any necessary adjustments to H phase, SC phase, and Hue by using the sliders in the Video Output tool while checking the external Waveform and Vectorscope monitors.
    
    Whenever the Capture tool is active, hue, horizontal phase (H phase), and subcarrier phase (SC phase) are set to values determined by the input circuitry and are not available to control the outputs. These controls appear dimmed during passthrough.
12. Save this setting with an appropriate name:
    a. Click the Settings menu in the Video Output tool, and select Save As.
    b. Type a name.
    c. Click OK.
    
    The Video Output setting, a Site setting, applies to all users and all projects on the system. The Video Input setting you saved and named Default is recalled each time a new tape is loaded for capturing in the current project only.

**Luminance Settings for Video Output**

Use the following luminance settings for video output.

For Black level (setup), adjust the Black slider to place the black level at the following settings:

<table>
<thead>
<tr>
<th>Video Standard</th>
<th>Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>NTSC</td>
<td>7.5 IRE</td>
</tr>
<tr>
<td>NTSC-EIAJ</td>
<td>0.0 IRE</td>
</tr>
</tbody>
</table>
Preparing for Converting HD Formats

For White level (gain), adjust the Y Gain slider to place the white level at the following settings:

<table>
<thead>
<tr>
<th>Video Standard</th>
<th>Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>PAL</td>
<td>0.3 V (not applicable for SMPTE bars)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Video Standard</th>
<th>Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>NTSC</td>
<td>100 IRE</td>
</tr>
<tr>
<td>NTSC-EIAJ</td>
<td>100 IRE</td>
</tr>
<tr>
<td>PAL</td>
<td>1.0 V (not applicable for SMPTE bars)</td>
</tr>
</tbody>
</table>

Adjusting Phase Controls

The Video Output tool provides controls for adjusting horizontal phase globally for output. Horizontal phase, or H Phase, is the horizontal blanking interval used to synchronize the timing of two or more video signals. SC Phase (subcarrier phase) controls are also available for timing two or more signals based on the color burst portion of a composite or S-Video signal. System Phase controls let you adjust the output signal relative to a reference signal.

In most situations, you do not need to calibrate the horizontal phase, subcarrier phase, or system phase of the output signal. If you are working in a production house in which timing is necessary between various devices—such as switchers, decks, and monitors—use these controls to adjust phase globally for all outputs from your Avid editing application.

Preparing for Converting HD Formats

Your Avid editing application attached to an Avid Nitris DX, or Avid Mojo DX can crossconvert an HD sequence to another HD format or downconvert an HD sequence to an SD format, provided that the sequence has a compatible frame rate for the format to which you are converting. Before you output a converted sequence, you need to set the appropriate options in the Video Output tool.

For information and notes on available crossconversion and downconversion formats for each HD format, see “Crossconversion and Downconversion Formats” on page 1068.

For a list of considerations when crossconverting or downconverting, see “Considerations for Crossconversion and Downconversion” on page 1069.
To set options for crossconverting a sequence:
1. Select Tools > Video Output Tool.
2. Click the Options tab.
3. Click the Downconvert menu, and select OFF.
4. Click the Crossconvert menu, and select the format that you want to output.

To set options for downconverting a sequence:
1. Select Tools > Video Output Tool.
2. Click the Options tab.
3. Click the Crossconvert menu, and select OFF.
4. Click the Downconvert menu, and select the format that you want to output.

The options are Anamorphic, Letterbox, Center Cut. The following illustrations show how a high-definition image is adjusted for downconvert.

Example of downconversion formats. Top: the HD image. Bottom, left to right: Anamorphic, Letterbox, and Center Cut SD downconverted images.

5. For some input/output hardware configurations, you need to set the Component format and HDMI format when you select Downconvert:
   a. Click the Component Format menu and select SD Interlaced. The Component Format menu appears when you select Downconvert.
   b. Click the HDMI format menu and select either SD Interlaced or SD Progressive.
## Crossconversion and Downconversion Formats

The following table lists the available crossconversion and downconversion formats for each HD format. Not all formats are available for all Avid editing configurations.

*Raster Type selection does not affect the conversion options for HD projects, with the exceptions noted in the table.*

<table>
<thead>
<tr>
<th>HD Sequence Format</th>
<th>Crossconverted HD Format</th>
<th>Downconverted SD Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>720p/59.94</td>
<td>1080i/59.94</td>
<td>30i NTSC</td>
</tr>
<tr>
<td>720p/23.976</td>
<td>1080i/59.94</td>
<td>30i NTSC</td>
</tr>
<tr>
<td></td>
<td><em>When crossconverting the 720p/23.976 format, your Avid editing application adds 2:3 pulldown frames to create a sequence with the correct frame rate.</em></td>
<td></td>
</tr>
<tr>
<td>720p/25</td>
<td>1080i/50</td>
<td>25i PAL</td>
</tr>
<tr>
<td>720p/50</td>
<td>1080i/50</td>
<td>25i PAL</td>
</tr>
<tr>
<td>1080p/23.976</td>
<td>1080i/59.94</td>
<td>30i NTSC</td>
</tr>
<tr>
<td></td>
<td>720p/59.94</td>
<td></td>
</tr>
<tr>
<td></td>
<td><em>When crossconverting the 1080p/23.976 format, your Avid editing application adds 2:3 pulldown frames to create a sequence with the correct frame rate.</em></td>
<td></td>
</tr>
<tr>
<td>1080p/24</td>
<td>1080i/59.94</td>
<td>30i NTSC</td>
</tr>
<tr>
<td></td>
<td>(Nitris DX and Mojo DX only)</td>
<td>(Nitris DX and Mojo DX only)</td>
</tr>
<tr>
<td></td>
<td><em>For information on ensuring the correct pulldown cadence when downconverting the 1080p/23.976 format to 30i NTSC, see “Considerations for Crossconversion and Downconversion” on page 1069,</em></td>
<td></td>
</tr>
<tr>
<td>1080p/25</td>
<td>720p/50</td>
<td>25i PAL</td>
</tr>
<tr>
<td>1080p/29.97</td>
<td>720p/59.94</td>
<td>30i NTSC</td>
</tr>
<tr>
<td>1080i/50</td>
<td>720p/50</td>
<td>25i PAL</td>
</tr>
<tr>
<td>1080i/59.94</td>
<td>720p/59.94</td>
<td>30i NTSC</td>
</tr>
</tbody>
</table>

*Non-DX systems: To crossconvert a1080p/24 sequence to HD, output a tape master and then convert. To downconvert a1080p/24 sequence to SD, change the project format and transcode the media, then output a digital cut.*
**Considerations for Crossconversion and Downconversion**

You should be aware of the following when crossconverting or downconverting HD formats:

- You can select an HD crossconvert format for output or an SD downconvert format for output, but you cannot output both at the same time.

- Avid recommends using crossconverted sequences for preview or reference only. When using digital cut to output the HD master sequence to tape, use the native frame rate of the sequence. Crossconvert and downconvert options that change the edit rate are not supported for digital cut. For example, if you have a 1080p/23.976 sequence, you can preview the sequence at 1080i/59.94, 720p/59.94, or NTSC 30i. But when creating the digital cut, use the native format of 1080p/23.976.

- Avid recommends using downconverted 720p/59.94 and 1080p/23.976 sequences for preview or reference only. When using digital cut to output the HD master sequence to tape, use the native frame rate of the sequence. Crossconvert and downconvert options that change the edit rate are not supported for digital cut.

**Preparing for Audio Output**

You can use the Audio tool to generate and customize a calibration tone and to monitor global output levels. Use the Audio Project settings to adjust the global output levels and specify other output settings. The following procedures provide information about preparing for audio output. For information on audio mix procedures such as adjusting volume and pan for selected tracks or audio mixdown, see “Working with Audio” on page 759.

**Setting the Calibration Tone**

The Audio tool provides an internal calibration tone you can customize and play as a reference signal on a digital cut. You can use the recorded reference signal for calibrating the digital cut audio at another site.

The default tone playback is –20 dB (digital scale) or –14 dB (software-only systems) with a 1000-Hz signal. In some cases, you might need to customize the signal. For example, a common reference signal convention for audio work involves recording 30-second segments of 1-kHz, 10-kHz, and 100-Hz tone back-to-back.

For information on creating tone media, see “Creating Tone Media” on page 214.

**To change the parameters for the calibration tone:**

1. Select Tools > Audio Tool.

   The Audio tool opens.
2. Click the PH (Peak Hold) menu, and select Set Calibration Tone.

The Set Calibration Tone dialog box opens.

3. Type new values for the tone level and frequency text boxes, and click OK.

**To play back the tone:**
- Click the PH (Peak Hold) menu, and select Play Calibration Tone.

**To check the adjusted tone level in the meters:**
- Switch the In/Out toggle buttons to O for Output.

### Calibrating Global Output Levels

You can use the meters in the Audio tool to monitor the global output level of your sequence. If necessary, you can use the Output Gain slider (master attenuator) in the Output tab in the Audio Project Settings dialog box to adjust the output from the system. These adjustments affect levels for all output tracks to both the speakers and record devices.

⚠️ **You should leave this output level at the factory preset of 0 dB. Adjust the level only when necessary to raise or lower the overall volume, based on the headroom parameters of the record format, or for consistently overmodulated or undermodulated source material.**

**To calibrate global output levels:**

1. Double-click Audio Project in the Settings list in the Project window.
   - The Audio Project Settings dialog box opens.

2. Click the Output tab.

The Audio tool opens.

4. Click the In/Out toggle buttons above the meters to display O for Output.
Preparing for Audio Output

5. Play back one of the following sources of reference audio by doing one of the following:
   - Click the Peak Hold (PH) Menu button, and select Play Calibration Tone.
   - Play back a representative sequence or clip containing audio.

6. Watch the levels in the meters, and adjust the master attenuator to the level that you want.

   *To adjust levels for individual tracks, use the Audio Mixer tool. See “Using the Audio Mixer Tool” on page 788.*

7. Close the Audio tool.

8. Close the Audio Project Settings dialog box.

**Setting Audio Output Options**

The Audio Project Settings dialog box contains options for audio output, such as how audio tracks in the sequence are mapped to output channels.

**To set audio output options:**

1. Double-click Audio Project in the Settings list in the Project window.
   - The Audio Project Settings dialog box opens.
2. Click the Output tab.
3. Click the Mix Mode Selection Menu button, and select a type of output.
   - Select Stereo to mix the monitored audio tracks into a stereo pair (two paired mono channels) with applied pan effects.
   - Select Mono to map all the monitored tracks to a pair of mono channels, with all channels panned to center and pan effects bypassed.
   - Select Direct to map monitored tracks directly to up to sixteen channels of output (depending on how many audio output channels are currently enabled in your hardware configuration). By default, Direct maps all audio tracks in numerical sequence to existing output channels. Mono tracks are mapped to single output channels, and stereo tracks are mapped to pairs of output channels. You can remap a track to any channel by clicking a Channel Assignment menu and by selecting another channel.
     Direct out ignores pan effects.

   You cannot map a mono track to a channel pair or a stereo track to a single channel.

   If you want to output 16 channels, click the “Allow 16 channel output” button. For more information, see “Enabling 16-Channel Audio Output” on page 1074.

4. (Option) Depending on your type of output, you can make additional adjustments:
   - By default, Stereo directs the mixed tracks to mono output channels 1 and 2. You can also direct mixed tracks to output channels 3 & 4, 5 & 6, or 7 & 8.

   ![Stereo Mix Mode Selection Menu]

   - If you select Direct Out, you can select All or Timeline from the “All or Timeline Track Maps” menu
     - All lets you preset values for all possible audio tracks, with each track treated as a mono track.
     - Timeline lets you assign output channels to the tracks monitored in the Timeline, with multichannel stereo pairs mapped by default to channel pairs.

     Click the Reset button to reassign the tracks to the default channels that are currently available. You might need to reset the defaults track mappings if your hardware configuration has changed.

   If you want to map output channels to audio tracks not listed in the Output Track Maps area, click the Which Set of Track Maps button to display other available audio tracks. The maximum number of available tracks is 24.
5. Select the output format and assign the output channels in the tabbed interface at the bottom of the dialog box.

Options vary depending on the type of input/output hardware you have attached to your system.

For more information, see “Audio Project Settings: Output Tab” on page 1441.

6. (Option) To disable the customized volume, real-time EQ, or volume automation effects you applied with the other audio tools, click the Effects tab and select Clip Gain, RT EQ, or Auto Gain in the Effect Bypass panel.

7. Close the Audio Project Settings dialog box.

**Enabling 16-Channel Audio Output**

Depending on your Avid input/output hardware, you can output up to 16 channels of simultaneous output. You use the Output tab of the Audio Project Settings dialog box to enable 16-channel output.

**To enable 16 channels of audio output:**

1. Double-click Audio Project Settings in the Settings tab of the Project window.
2. Click the Output tab.
3. Click the Mix Mode Selection menu button, and select Direct Out.
4. Click the “Allow 16 channel output” button.
5. Select the tab representing the output format to which you want to assign the additional output channels.
6. Select “On outputs 9–16.”
7. Select Grp 2 from the “Which Set of Track Maps” menu.
8. (Option) Use the Channel menus to match tracks in the timeline to output channels.

> Output channels 9–16 do not appear in the Audio Tool until you assign an output format to the tracks from one of the output format tabs at the bottom of the Output panel.

**Embedded Audio and Output Sample Rate Conversion**

The format for embedded audio must be 48 kHz. If you attempt to set the sample rate to a different value while SD SDI or HD SDI output is enabled, the system displays a message indicating “Switching out of a 48K while SDI Embedded outputs are enabled requires a sample rate conversion of all audio outputs to 48K.”
Preparing Record Tapes

For example, if you have 8 channels of HD SDI output enabled and attempt to change the sample rate to 96 kHz, the system displays the message.

In this example you can switch the project to 96 kHz, but if the SDI outputs are enabled, the system will convert all audio output to 48 kHz.

⚠️ This affects all audio outputs, not just the SDI outputs. That means AES/EBU output will be converted and any Analog output will also be converted. This could result in a quality loss for the Analog signal.

The way to prevent the automatic conversion is to turn off the SDI output. Then you can change to 96 kHz and output an Analog or AES/EBU signal without any conversion. You can change to SDI output later and output a 48 kHz embedded audio signal using hardware sample rate conversion.

Using an XLR Adapter for Consumer-Level Analog Output

When you select Consumer level for Analog Output, analog outputs are attenuated by 6 dB. To achieve an additional 6 dB of attenuation, you must use an adapter that provides an unbalanced XLR connection. The correct adapter provides ground on pin 1 and a line signal on pin 2. Many off-the-shelf connectors supply line level on pin 1 and return on pin 2 or else they short the signal on pin 2 to pin 3. This results in a signal that is 6 dB too high for consumer equipment.

If you want to provide additional attenuation, use the master gain slider on the Output panel of the Audio Project Settings dialog box.

For Avid Nitris DX or Avid Mojo DX, when attaching to consumer level equipment, set the Output calibration for the corresponding outputs to -12 dB in the Audio Hardware Calibration tool.

Preparing Record Tapes

There are two basic methods of recording to tape:

- Frame-accurate recording by using the Digital Cut tool to record your sequence onto either a prestriped tape (a tape with prerecorded control track and timecode) or a partially striped tape
- Manual recording by using controls on the record deck

Each of these methods requires different treatment of the record tapes.
Preparing Record Tapes

Striping Record Tapes (Recording Black with Timecode)

Before you can record a frame-accurate digital cut, you must prepare the record tapes in advance by using one of the following options:

- To perform *insert-edit* recording, stripe the record tapes (record black with timecode for the entire duration of the tape) in advance (prestriped tape).
- To perform *assemble-edit* recording, record black with timecode onto the tape, including the necessary preroll prior to the IN point plus at least 10 seconds (partially striped tape).

For complete instructions on recording a frame-accurate digital cut, see “Using the Digital Cut Tool” on page 1079.

Some Avid input/output hardware supports LTC output for recording onto tapes. For more information, see “Using LTC Timecode for Output” on page 1057.

DV cameras or decks controlled through a 1394 connection do not support commands for frame-accurate recording. As a result, if you are preparing to record to one of these devices, you can use the Digital Cut tool in either Local mode or Remote mode, but all tracks are enabled for recording and cannot be modified.

Recording Bars and Tone

You can record a portion of bars and tone onto the tape before recording a digital cut. There are two methods of recording bars and tone to tape:

- If your recording must be frame accurate, consider adding a segment of digital bars and tone to the front of your sequence, or prepare it as a separate sequence you can record by using the Digital Cut tool. For more information, see “Importing Color Bars and Other Test Patterns” on page 316.
- If your recording does not need to be frame accurate, you can manually record direct output of bars and tone from your Avid editing application.

**To manually record bars and tone:**

2. In the Video Output tool, click the Test Patterns menu, and select a color bars pattern.
3. In the Audio tool, click the PH (Peak Hold) menu, and select Play Calibration Tone. See “Setting the Calibration Tone” on page 1069.
4. Set the record deck to Local for manual recording.
5. Record the bars and tone as either an insert or assemble edit according to the operation of your record deck and selected method. Your deck must be capable of frame-accurate editing to perform this step.
Enabling Assemble-Edit Recording

Insert editing is the default setting for the Digital Cut tool. You can also use Assemble-Edit settings in your Avid editing application, along with the assemble-editing capabilities of your record deck, to quickly record frame-accurate digital cuts without striping entire tapes in advance.

To avoid accidentally breaking timecode on prestriped tapes during digital cut recording, enable assemble editing only when in use, and disable it during normal insert edit recording.

DV cameras or decks controlled through a 1394 connection do not support commands for frame-accurate recording. As a result, if you are preparing to record to one of these devices, you can use the Digital Cut tool in either Local mode or Remote mode, but all tracks are enabled for recording and cannot be modified.

To enable assemble editing:

1. Double-click Deck Preferences in the Settings list in the Project window.
   
   The Deck Preferences dialog box opens.

2. Select the “Allow assemble edit & crash record for digital cut” option.

3. Click OK.

4. Make sure the record deck has the following settings:
   - The free run/rec (record) run switch should be set to record run.
   - The Ext (external)/Int (internal) sync switch should be set to internal.
   - The switch for internal timecode should be set to Regen (regenerate) or Slave Lock, not Preset.
   - After you record 15 to 30 seconds of timecode onto the record tape for jam syncing, return the Local/Remote switch to Remote for deck control from within your Avid editing application.

5. When you are ready to record, select additional options in the Digital Cut tool, as described in “Recording a Digital Cut to Tape (Remote Mode)” on page 1082.

These switches are often located below the machine’s playback control buttons. For more information, see the documentation provided with your record device.
Using ExpertRender to Prepare Effects for a Digital Cut

Real-time effects might exceed the capabilities of your system and cause dropped frames during a digital cut. You can choose to have your Avid editing application select and render effects that might cause dropped frames.

**To prepare effects for a digital cut:**

1. Load the sequence you want to output.
2. Select the entire sequence or mark IN and OUT points for the area you want to output.
3. Open the ExpertRender dialog box by doing one of the following:
   - Select Clip > ExpertRender In/Out.
   - Right-click in the Timeline, and select ExpertRender In/Out.

   The ExpertRender dialog box opens.

4. Select “Prepare effects for Digital Cut,” and then click OK.
Using the Digital Cut Tool

The Digital Cut tool provides controls when you record a sequence to tape. The Digital Cut tool has the following operating modes:

- Remote mode lets you control the record deck by using the deck controller in the Digital Cut tool. This mode provides frame-accurate control when you record a sequence to tape. See “Recording a Digital Cut to Tape (Remote Mode)” on page 1082.

- Local mode lets you manually control the record deck by using the controls on the deck. This mode is useful when you need to use non-Avid-controlled decks, such as consumer-grade VHS or Hi8. See “Recording a Digital Cut to Tape (Local Mode)” on page 1086.

You can use either Remote mode or Local mode to preview the output of a digital cut before recording it to tape. See “Previewing a Digital Cut” on page 1081.

You can manually record a digital cut, but the recording is not frame accurate. See “Recording a Digital Cut to Tape (Local Mode)” on page 1086.

Sync for output comes from black burst or tri-level sync input to the Avid input/output hardware or from internal timing. For more information, see “Selecting the Sync Source for Output” on page 1055.

If you install your Avid editing application on a laptop computer, an Incompatible Power Scheme warning button might appear in the top right corner of the Digital Cut tool. Some of the standard power schemes available to laptops running Windows XP might affect the performance of editing functions, including performing a digital cut. Avid recommends you use the “Always On” power scheme when working with Avid applications. If you select “Always On,” the warning button does not appear. For information on changing power schemes, see the Windows documentation.

The Digital Cut tool lets you:

- Record by using either assemble edit, insert edit, or crash record.
- Record a selected portion of the sequence or selected tracks.
- Record an entire sequence.
- Record according to different timecode parameters.
- Select the sequence video, audio and data tracks to record (Sequence Track buttons).
- Have the system locate real-time effects with dropped frames.
- Select the tracks to record to on the tape (Enable Track button – Remote mode only).
- Add black at the end of a digital cut.
In Remote mode, the Digital Cut tool includes its own deck controls for:

- Cueing a record deck from the Digital Cut tool.
- Cueing the tape and adding an IN point. This capability applies when you click the menu in the deck control area, and select Mark In Time.

The Mark OUT button does not appear in the deck controller section of the Digital Cut tool because it has no effect on digital cuts. Also, the Mark OUT and Duration text fields are read-only. You cannot alter them.

*Depending on the system configuration, you might need to use the deck controls in the Capture tool to review a digital cut.*

The controls and options that appear in the Digital Cut tool depend on the device and format you select. The following illustrations show two examples. This illustration shows the Digital Cut tool configured for DV output to a device connected to the 1394 port.

- Sequence Track buttons
- Enable Track buttons
- Deck controls
- Ref Lock icon
- DV Offset

**Digital Cut Tool**

Device: IEEE 1394
Output Mode: RT DV26
- Entire Sequence
- Digital Cut Safe Mode
- Stop on Dropped Frames
- LTC cut during preroll
- Add Black at Tail
- Sequence Time
- Insert/Edit
- Custom Preroll
- DV Offset

**NO DECK**

Tape Name?
Selecting a Deck in the Digital Cut Tool

The Deck Selection menu in the Digital Cut tool contains a list of all decks that were connected to the system, turned on, and initialized when you opened the Digital Cut tool.

The Deck Selection menu also lists three commands:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adjust Deck</td>
<td>Opens the Deck Settings dialog box. Changes you make apply to the selected deck. For information on Deck settings, see “Deck Configuration Settings” on page 1460.</td>
</tr>
<tr>
<td>Auto-configure</td>
<td>Lets you automatically configure the selected deck with the default deck settings for that deck.</td>
</tr>
<tr>
<td>Check Decks</td>
<td>Helps to reestablish deck control if the power to your decks was off or the decks were disconnected when you opened the Digital Cut tool.</td>
</tr>
</tbody>
</table>

If the words “No Deck” appear in the menu, you need to configure a deck in the Deck Configuration dialog box. See “Configuring Decks” on page 188.

If a deck name appears in *italics* on the menu, the deck has lost power or has been disconnected. Click the menu, and select Check Decks to reestablish deck control.

**To activate an available deck for a digital cut:**

- Click the Deck Selection menu, and select the deck.

Previewing a Digital Cut

You can preview your sequence in Remote mode or Local mode before recording the digital cut.

*You can manually record a digital cut, but the recording is not frame accurate. For more information, see “Recording a Digital Cut to Tape (Remote Mode)” on page 1082 and “Crash Recording Through Remote Deck Control” on page 1085.*
To preview a digital cut:
   The Digital Cut tool opens.
2. Select Remote or Local in the Deck Control options area.
3. Select the options you want for the digital cut.
4. Select the audio tracks, data track, and topmost video track you want represented in the digital cut preview by using the Sequence Track buttons.
   The track display in the Digital Cut tool varies according to the tracks existing in the sequence.
5. Click the yellow Preview Digital Cut button.
   The Digital Cut tool goes through the motions of an insert edit and shows you how the tape will appear before, during, and after the cut, but does not actually change the master tape. You can then modify your digital cut, if you want, before it is committed to the master tape.
6. (Option) To stop the preview at any time, do one of the following:
   ▶ Press the space bar.
   ▶ Click the Halt Digital Cut button.

Recording a Digital Cut to Tape (Remote Mode)

Recording in Remote mode lets you control your record deck by using the deck controller in the Digital Cut tool. This mode provides frame-accurate control when you record a sequence to tape.

To record a digital cut to tape:
1. Make sure you selected the appropriate device for the material you are recording. See “Selecting the Device for Output” on page 1055.
2. Load a sequence into the Record monitor. (You cannot access digital cut options without a sequence loaded.)
   The Digital Cut tool opens.
4. Select the Output Mode and Bit Depth, as described in “Output Mode Resolution Options” on page 1087.
   Take care to select the Output Mode that supports the output device and provides the output resolution you need.
5. Select or deselect the Entire Sequence option based upon the following:
   ▶ Select the Entire Sequence option if you want the system to ignore any IN or OUT points and to play the entire sequence from start to finish.
Deselect the Entire Sequence option if you have established an IN point, an OUT point, or both for recording a portion of the sequence.

6. Click the Digital Cut Safe Mode button (selected by default) to allow your Avid editing application to notify you of conditions that might cause dropped frames.

During a digital cut, real-time effects or HD clips in an SD sequence can drop frames. Digital Cut Safe Mode analyzes and identifies real-time effects that might cause dropped frames during the digital cut and lets you render them. It also identifies HD clips in an SD sequence and gives you the opportunity to transcode them. After these operations are complete, your Avid editing application automatically initiates the digital cut.

If your SD sequence contains HD clips whose frame rate does not match the sequence frame rate, you might need to take additional steps to ensure that you do not drop frames. For more information, see “Considerations When Working with Mixed Rate Clips” on page 601.

You can use ExpertRender to render effects before beginning the digital cut. See “Using ExpertRender to Prepare Effects for a Digital Cut” on page 1078.

7. (Option) Select Stop on Dropped Frames.

When you select this option, if the system detects a dropped frame during output, the digital cut stops. You can fix the frame with ExpertRender and then continue. For more information, see “Using ExpertRender to Prepare Effects for a Digital Cut” on page 1078.

8. (Option) Select the Add Black at Tail option and enter a duration to add black at the end of the digital cut.

9. Click the Deck Selection menu, and select a deck.

See “Selecting a Deck in the Digital Cut Tool” on page 1081.

10. Select Remote in the Deck Control options area.

11. Click the menu, and select either Insert Edit or Assemble Edit.

This menu appears only if you enabled assemble editing in the Deck Preferences dialog box. For more information about this option, see “Enabling Assemble-Edit Recording” on page 1077.

DV cameras or decks controlled through a 1394 connection do not support commands for frame-accurate recording. As a result, if you are preparing to record to one of these devices, you can use the Digital Cut tool in either Local mode or Remote mode, but all tracks are enabled for recording and cannot be modified.
12. Click the menu in the Deck Control options area, and select an option to indicate where to start recording on the tape.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sequence Time</td>
<td>Starts the recording at a timecode existing on tape that matches the start timecode of the sequence. If you intend to record several sequences to tape one after another, this option requires resetting the start timecode on each sequence to match appropriate IN points on the tape.</td>
</tr>
<tr>
<td>Record Deck Time</td>
<td>Ignores the timecode of the sequence and starts the recording wherever the record deck is currently cued. You can change the start timecode to match the record tape by using the Sequence Report command. For more information, see “Changing the Name and Timecode for a Sequence” on page 584.</td>
</tr>
<tr>
<td>Mark In Time</td>
<td>Ignores the sequence timecode. Establish a specific IN point on the record tape by cueing and marking with the deck controls.</td>
</tr>
</tbody>
</table>

13. (Option) Select Custom Preroll, click the menu, and select the number of seconds to indicate how many seconds the tape rolls before the digital cut starts.

This option overrides the Preroll setting in the Deck Settings dialog box.

14. (Option) Select Custom Frame Offset to select a digital cut offset from -5 to 5 frames. This is useful when working with third party I/O devices. If digital cuts are consistently off, you can use this setting to compensate. If 1 or more black frames are at the beginning of the digital cut, try using -1 or a larger negative number to compensate. If the digital cut is missing the first frame of the digital cut, try using +1 or a larger positive number.

15. Select the audio, video, and data tracks you want represented in the digital cut by using the Sequence Track buttons.

The display of tracks in the Digital Cut tool varies according to the tracks existing in the sequence. If you select the D track, the digital cut includes ancillary data in the output.

16. Select the video and audio tracks to record to on the tape by using the Enable Track buttons.

17. For 23.976p, 24p, and 25p projects, select an output format as described in “Selecting Output and Timecode Formats for 23.976p, 24p, and 25p Projects” on page 1089.

Make sure you connect the correct deck and black burst generator for the output format you selected (NTSC or PAL).

18. Click the Play Digital Cut button.

Your Avid editing application cues the record deck, then plays and records the sequence. The playback appears in the Record monitor and in the Client monitor.
Depending on the system configuration, you might need to use the deck controls in the Capture tool to review a digital cut.

19. (Option) To stop the recording at any time, do one of the following:
   - Press the space bar.
   - Click the Halt Digital Cut button.

After assemble-edit recording, a freeze frame is usually added after the OUT point for 1 second or more, depending upon the record deck model. This provides several frames of overlap for the next IN point before the control track and timecode break up.

If you see degraded image quality in your digital cut (particularly visible as noise during black), deselect the "Poll deck during digital cut" option in the Deck Preferences dialog box, which you access from the Settings list in the Project window. Then record the digital cut again. With the option deselected, the timecode display in the deck controller does not update for the duration of the digital cut.

Crash Recording Through Remote Deck Control

If your deck does not support insert editing, or you do not need to start a digital cut cleanly at a particular timecode, you can perform a crash record. You can crash record through local deck control, see “Recording a Digital Cut to Tape (Local Mode)” on page 1086, or you can crash record through remote deck control.

If you use remote deck control, you can start recording at the current location on the tape or you can start recording at a particular timecode. When crash recording, the first few frames and last few frames of the output might flash or appear scrambled.

To perform a crash record through remote deck control:

1. If your deck supports insert editing, select the option “Allow assemble edit & crash record for digital cut” in the Deck Preferences dialog box in the Settings list.
   
   If your deck does not support insert editing, the Crash Record option appears automatically.


3. In the Deck Control area, select Remote.
   
   Crash Record appears in the right menu.

4. Do one of the following:
   - To ignore the starting timecode and start recording at the current location, select Ignore Time from the left menu.
   - To begin recording at a starting timecode, select a timecode option from the left menu.
If you select one of the timecode options for which your device is not equipped, a message box appears.

5. Select other options and perform the digital cut, as described in “Using the Digital Cut Tool” on page 1079.

**Recording a Digital Cut to Tape (Local Mode)**

Recording in Local mode lets you manually control your record deck by using the controls on the deck. This mode is useful when you need to use non-Avid-controlled decks, such as consumer-grade VHS or Hi8.

**To record a digital cut to tape:**

1. Make sure you selected the appropriate device for the material you are recording. See “Using the Digital Cut Tool” on page 1079.

2. Load a sequence into the Record monitor. (You cannot access digital cut options without a sequence loaded.)


   The Digital Cut tool opens.

4. Select the Output Mode and Bit Depth, as described in “Output Mode Resolution Options” on page 1087.

   Take care to select the Output Mode that supports the output device and provides the output resolution you need.

5. Select or deselect the Entire Sequence option based upon the following:

   - Select the Entire Sequence option if you want the system to ignore any IN or OUT points and play the entire sequence from start to finish.
   - Deselect the Entire Sequence option if you have established an IN point, an OUT point, or both for recording a portion of the sequence.

6. Click the Digital Cut Safe Mode button (selected by default) to allow your Avid editing application to notify you of conditions that might cause dropped frames.

   During a digital cut, real-time effects or HD clips in an SD sequence can drop frames. Digital Cut Safe Mode analyzes and identifies real-time effects that might cause dropped frames during the digital cut and lets you render them. It also identifies HD clips in an SD sequence and gives you the opportunity to transcode them. After these operations are complete, your Avid editing application automatically initiates the digital cut.

   If your SD sequence contains HD clips whose frame rate does not match the sequence frame rate, you might need to take additional steps to ensure that you do not drop frames. For more information, see “Considerations When Working with Mixed Rate Clips” on page 601.
You can use ExpertRender to render effects before beginning the digital cut. See “Using ExpertRender to Prepare Effects for a Digital Cut” on page 1078.

7. (Option) Select Stop on Dropped Frames.
   When you select this option, if the system detects a dropped frame during output, the digital cut stops. You can fix the frame with ExpertRender and then continue. For more information, see “Using ExpertRender to Prepare Effects for a Digital Cut” on page 1078.

8. (Option) Select the Add Black at Tail option and enter a timecode to add black at the end of the digital cut.

9. Select Local in the Deck Control options area.

10. Click the Sequence Track buttons to select the audio, video and data tracks you want represented in the digital cut.
    The display of tracks in the Digital Cut tool varies according to the tracks existing in the sequence.

11. For 23.976p, 24p, and 25p projects, select an output format as described in “Selecting Output and Timecode Formats for 23.976p, 24p, and 25p Projects” on page 1089.

   Make sure you connect the correct deck and black burst generator for the output format you selected (NTSC or PAL).

12. Press the Record button on the deck.

13. Click the Play Digital Cut button.
    The deck plays and records the digital cut. The playback appears in the Record monitor and in the Client monitor.

14. (Option) To stop the recording at any time, do one of the following:
    ▶ Press the space bar.
    ▶ Click the Halt Digital Cut button.

Output Mode Resolution Options

The output mode menu in the Digital Cut tool displays the available output resolution options. The options that appear in this menu vary depending on your project type and the output device. The active output device is displayed above the Output Mode menu in the Digital Cut tool. In the case of progressive projects, the options in the menu can also vary depending on the Output Format play rate set in the Digital Cut tool.
With some output modes, you can also use the Bit Depth menu to select either 8-bit or 10-bit effects processing. If this option is not available, the Bit Depth menu is either grayed out or does not appear. For more information, see “Options for Controlling Real-Time Effects Playback” in the Help.

The following table provides information on the output resolutions.

<table>
<thead>
<tr>
<th><strong>Output Mode</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Real-Time</td>
<td>Provides 1:1 uncompressed SD or HD output through an Avid Nitris DX or Avid Mojo DX.</td>
</tr>
<tr>
<td>DVCPRO HD</td>
<td>Provides DVCPRO HD output through a Host 1394 connection. All media must be DVCPro HD. Does not support real-time effects playback.</td>
</tr>
<tr>
<td>RT DV50</td>
<td>Provides DV50 output through a Host 1394 connection.</td>
</tr>
<tr>
<td>RT DV25</td>
<td>Provides DV25 output through a Host 1394 connection.</td>
</tr>
</tbody>
</table>
Outputting DV 50 and DVCPRO HD Media Directly to a DV Device

You can output DV 50 or DVCPRO HD sequences directly to a DV device. This lets you output without any loss due to compression and decompression.

<table>
<thead>
<tr>
<th>You can output:</th>
<th>If the project is:</th>
<th>And if the output device is:</th>
</tr>
</thead>
<tbody>
<tr>
<td>DV 50</td>
<td>Any SD project</td>
<td>1394</td>
</tr>
<tr>
<td>DVCPRO HD</td>
<td>The following HD projects:</td>
<td>1394</td>
</tr>
<tr>
<td></td>
<td>• 720p/23.976</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• 720p/50</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• 720p/59.94</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• 1080i/50</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• 1080i/59.94</td>
<td></td>
</tr>
</tbody>
</table>

To output DV 50 or DVCPRO HD media directly to a DV device:

1. Select the DV 50 or DVCPRO HD sequence you want to output.
2. Render all effects.
   The Digital Cut tool opens.
4. Select other Digital Cut options.
   For more information, see “Using the Digital Cut Tool” on page 1079.
5. Perform the digital cut.

Selecting Output and Timecode Formats for 23.976p, 24p, and 25p Projects

When you are working in a 23.976p, 24p, or 25p project, you can output multiple formats from the same progressive media. You click the Output Format menu in the Digital Cut tool to select the formats you want, as described in “Selecting Output Formats for 23.976p, 24p, and 25p Projects” on page 1090.
Selecting Output Formats for 23.976p, 24p, and 25p Projects

Depending on the type of project you are working with, NTSC or PAL, the system will only display output options for one format. You cannot switch from NTSC to PAL or PAL to NTSC. You can only switch from one PAL format to another PAL format or from one NTSC format to another NTSC format.

(Symphony Option) All output options for PAL and NTSC are available to you. You can switch from an NTSC format to a PAL format and from a PAL format to an NTSC format.

You need to save a title for each aspect ratio your output formats require, but you do not need to save a title for each video format (NTSC and PAL). For example, if you are working at 4:3 aspect ratio in a 24p project, and you intend to output a version of your project at 16:9, you need to save 16:9 versions of your titles.

In Symphony Option systems, conversion from one video format to another (for example from NTSC to PAL), including title resizing, is handled automatically by your Avid input/output hardware. You cannot save titles in a video format different from that of the project.

Depending on the format you select, you also need to:

- Select the timecode to output. See “Selecting the Timecode Format for Output” on page 1093.
- Indicate the destination timecode rate. See “Indicating the Destination Timecode Rate” on page 1094.
- Select the video pulldown cadence. See “Selecting the Video Pulldown Cadence” on page 1095.

Selecting Output Formats for 23.976p, 24p, and 25p Projects

To output a particular format:

2. Click the Output Format menu, and select a play rate.

A brief description of each output format is displayed in the Digital Cut tool.

The play rate you select determines how the digital cut is recorded. For example, if you select 23.976, you tell your Avid editing application to slow down the play rate to match the play rate used during an NTSC telecine transfer. When your Avid editing application records the digital cut, it adds the pulldown frames and re-creates a telecine transfer to an NTSC videotape.

For NTSC output, your Avid editing application automatically sets the pulldown if necessary. If your Avid input/output hardware has a pulldown indicator, it is turned on.
Audio play rates differ depending on your project type.

For full reference information on the output formats and on audio play rates, see “Output Format Reference for 23.976p, 24p, and 25p Projects” on page 1091.

Output Format Reference for 23.976p, 24p, and 25p Projects

The following table provides reference information for the Output formats (play rates) available in the Digital Cut tool for 23.976p, 24p, and 25p projects.

<table>
<thead>
<tr>
<th>Digital Cut Tool Output Format (Play Rate)</th>
<th>Target Project or System, and Recording Media</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>23.976 (NTSC)</td>
<td>NTSC TV; video screenings; digital audio workstations (DAWs) that support pulldown Picture and sound to NTSC tape; sound to video-referenced audiotape</td>
<td>Plays back the sequence at 23.976 fps (film rate). This play rate tells your Avid editing application to replicate a telecine transfer with perfect 2:3 pulldown. Your Avid editing application adds frames and slows the playback speed to create a digital cut to 29.97 fps. Use this option for NTSC video output, such as broadcast masters. For 25p, the media is slowed down by 4.1 percent. Pulldown is set to On (0.99).</td>
</tr>
<tr>
<td>24 (NTSC)</td>
<td>Audio for film projection; DAWs (video for reference only) Picture and sound to NTSC tape; sound to DAT or mag tape</td>
<td>Plays back the sequence at 24 fps (film rate). This play rate tells your Avid editing application to record audio at the film rate. If your Avid editing application records video, it maintains sync by adding pulldown fields and dropping every 1000th frame. This video should be used for reference only. Use this setting for direct audio output to be used in sync with film projection. Also use this setting when audio media files are being used in a digital audio workstation (DAW) and you need a digital cut for picture reference. For 25p projects, video and audio are slowed down 4 percent. Before you output the digital cut, make sure you select the correct destination timecode rate. See “Indicating the Destination Timecode Rate” on page 1094. Pulldown is set to Off (1.00).</td>
</tr>
</tbody>
</table>
The following table provides changes in audio rates if you are working in a 24p or 25p project:

<table>
<thead>
<tr>
<th>Output Play Rate</th>
<th>24p Source</th>
<th>25p Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>23.976 NTSC</td>
<td>0.1% slowdown</td>
<td>4.1% slowdown</td>
</tr>
<tr>
<td>24 NTSC</td>
<td>No change</td>
<td>4% slowdown</td>
</tr>
<tr>
<td>29.97 NTSC</td>
<td>25% speedup</td>
<td>20% speedup</td>
</tr>
<tr>
<td>24 PAL</td>
<td>No change</td>
<td>4% slowdown</td>
</tr>
<tr>
<td>25 PAL</td>
<td>4.1% speedup</td>
<td>No change</td>
</tr>
</tbody>
</table>
If you are working in a 23.976 project, all output play rates are available, but only 23.976 NTSC maintains the original audio quality. For 23.976 NTSC, the audio rate is not slowed down for output and remains at 48 kHz. For 29.97 NTSC, the audio rate is sped up 25 percent and is not usable. Use this output rate for animations and other special applications. 24 fps NTSC, 24 fps PAL, and 25 fps PAL all require a sample-rate conversion, so high-quality audio is not guaranteed.

The following table summarizes the change in audio rates for 23.976p output options.

<table>
<thead>
<tr>
<th>Output Play Rate</th>
<th>Source</th>
<th>Output Audio Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>23.976 NTSC</td>
<td>23.976 fps</td>
<td>48 kHz (no change)</td>
</tr>
<tr>
<td>24 NTSC</td>
<td>23.976 fps</td>
<td>48.048 kHz (0.1% speedup)</td>
</tr>
<tr>
<td>29.97 NTSC</td>
<td>23.976 fps</td>
<td>60 kHz (25% speedup)</td>
</tr>
<tr>
<td>24 PAL</td>
<td>23.976 fps</td>
<td>48.048 kHz (0.1% speedup)</td>
</tr>
<tr>
<td>25 PAL</td>
<td>23.976 fps</td>
<td>50.016 kHz (4.2% speedup)</td>
</tr>
</tbody>
</table>

## Selecting the Timecode Format for Output

If you select one of the three NTSC output formats, you need to indicate the timecode format for output: drop-frame or non-drop-frame.

You can designate drop-frame or non-drop-frame timecode for devices connected to one or both of the following outputs:

- RS422 Output (serial port on the computer)
- LTC (LTC OUT on some Avid input/output hardware)

*To output LTC timecode, you need to select “Generate LTC on Playback” in the General Settings dialog box. For more information, see “Using LTC Timecode for Output” on page 1057.*

By default, the menus display the timecode format of the sequence you loaded into the Timeline.

*Your Avid editing application can generate LTC at 29.97 fps only. See “Indicating the Destination Timecode Rate” on page 1094.*

### To select the timecode format for output:

2. Do one or both of the following:
   - Click the RS422 Output menu, and select Drop or Non-Drop.
Outputting Drop-Frame and Non-Drop-Frame Timecode Simultaneously for Downstream Encoding

You can output drop-frame and non-drop-frame NTSC timecode simultaneously from a 23.976, 24p, or 25p project. A broadcast production company might need to output drop-frame timecode for a broadcast master while outputting non-drop-frame timecode to track NTSC film pulldown.

Tracking the pulldown is important because some networks require the 2:3 pulldown phase to be inserted in the VITC (vertical interval timecode). Inserting the pulldown phase enables downstream encoding of various compression formats (like MPEG-2) to be faster and of higher quality.

For information about 2:3 pulldown, see “Transfer of 24-fps Film to NTSC Video” on page 1593.

It is easy to track pulldown information within non-drop-frame timecode, because the relationship stays the same for the length of the digital cut. Your Avid editing application can use LTC to output the non-drop-frame timecode. See “Using LTC Timecode for Output” on page 1057.

To output drop-frame and non-drop-frame timecode simultaneously for downstream encoding:

2. Do the following:
   - Click the RS-422 Output menu, and select Drop.
   - Click the LTC Output menu, and select Non-Drop.

Indicating the Destination Timecode Rate

When you select 24 (NTSC) as your output format, the Destination Timecode Rate menu (labeled Dest. TC Rate) opens. Select a timecode rate that matches the timecode rate of the recording device, such as a DAT deck.

If you select 29.97 fps as your Dest. TC Rate, the sequence duration displayed in the Timecode Duration display of the Digital Cut tool is slightly shorter than the duration shown in the Timeline. This shorter duration occurs because the video play rate is sped up in comparison with the audio timecode rate. If you select 30.00 fps, the sequence duration in the Digital Cut tool matches the sequence duration in the Timeline.
The value you select also sets the rate for LTC output, if any, without changing the play rate of the media being output (24 NTSC).

Your Avid editing application can generate LTC at 29.97 fps only. No LTC will be output if you select 30.00.

To indicate the destination timecode rate:
2. Click the Dest. TC Rate menu, and select 29.97 fps or 30.00 fps.

Selecting the Video Pulldown Cadence

Depending on your Avid input/output hardware, you might have the option to select whether to use standard or advanced pulldown for output when you select 23.976 (NTSC) as your output format. This pulldown cadence is important if you are outputting a sequence for transfer to another non-linear editing system. Avid editing applications can capture footage that uses either pulldown cadence. Other editing systems might require one or the other.

If you select Advanced, make sure that the sequence timecode is non-drop-frame and that the A frame falls in timecodes ending on :x0 and :x5. You can check the frame/timecode correspondence if the Master timecode is displayed in the Tracking Information above the Record monitor. For information about changing the pulldown phase, see “Changing the Default Pulldown Phase for Sequences” on page 1097.

Some low-cost DV decks cannot be striped as non-drop-frame for performing digital cuts.

To select the video pulldown cadence:
2. Click the Video Pulldown Cadence menu, and select one of the following:
   - Standard 2:3:2:3
   - Advanced 2:3:3:2

Performing an Insert Edit with Pulldown

If you are working in an NTSC 24p project, and you need to insert a segment into a sequence that has already been cut to tape, your Avid editing application automatically adjusts the insert edit to maintain the correct pulldown.
To perform an insert edit with pulldown:

1. Use IN and OUT points to mark the segment you want to insert.
2. Select Output > Digital Cut.
   
   The Digital Cut tool opens.
3. Deselect the Entire Sequence option.
4. Select Remote in the Deck Control options area.
5. Select Sequence Time to start the recording at a timecode existing on tape that matches the start timecode of the sequence.
6. Click the menu, and select Insert Edit.
   This menu only appears if you enabled assemble editing in the Deck Preferences dialog box. For more information about this option, see “Enabling Assemble-Edit Recording” on page 1077.
7. Click the Deck Selection menu, and select a deck.
   See “Selecting a Deck in the Digital Cut Tool” on page 1081.
8. Click the Sequence Track buttons to select the video tracks you want represented in the digital cut.
   The display of tracks in the Digital Cut tool varies according to the tracks existing in the sequence.
9. Select the video track to record to on the tape by using the Enable Track buttons.
10. Click the Output Options area, and select 23.976 (NTSC) and either 4:3 or 16:9.
11. Click the Play Digital Cut button.
   Your Avid editing application cues the record deck, then plays and records the insert edit. Your Avid editing application automatically adds the correct pulldown fields.
12. To stop the recording at any time, press the space bar or click the Halt Digital Cut button.

Digital Cuts and Audio

You can use one of several tape formats and methods for audio output, but the following are most common:

- Record a digital cut directly to videotape by using analog output.
- Record a digital cut directly to DAT or DA-88 by using digital output.
- Play the sequence to an audiotape recorder by using analog output.

You cannot control some analog audio decks from the Digital Cut tool. If the deck does not have a serial control port, you need to select Local when you record the digital cut.
Your output choice in the Digital Cut tool automatically sets the pulldown switch.

If you perform an audio-only digital cut, your Avid editing application plays the video tracks in the Client monitor to ensure the most accurate audio sync. A message appears at the bottom of the Digital Cut tool.

Information on connecting decks and cabling varies depending on the Avid input/output hardware you use. For more information, see “Connecting Cameras, Decks, and Monitors” in the Help.

If your sequence contains audio clips with different sample rates, use the Change Sample Rate dialog box to ensure that all the clips have the same sample rate. For more information, see “Changing the Audio Sample Rate for Sequences and Audio Clips” on page 835.

Changing the Default Pulldown Phase for Sequences

During a digital cut to 30-fps NTSC videotape, your Avid editing application defaults to an A-frame pulldown conversion for sequences (subsequences are an exception). If you are appending sequences to the same output tape on which continuous pulldown is required, you might need to change the default pulldown phase (or pullin) to a B frame. A digital cut can begin only on the first field of an A or B frame.

For example, if one cut ends on an A frame, before performing the digital cut of the next sequence, change the pullin for the next sequence to the B frame. You can determine the frame that ends a sequence by checking the Pullout column in the bin that holds the sequence.

If your sequence ends on a B or C frame, edit the sequence to end on an A or D frame to create a continuous 2:3 pulldown.

For more information on film-to-tape transfers, see “Transferring Film to Tape” on page 1589.

To change the default pulldown phase for a sequence:

1. Open the bin that holds the sequence.
2. Check if the Pullin column appears. If not, do the following:
   a. Click the Bin Fast Menu button, and select Title Onlys.
   b. Ctrl+click (Windows) or Command+click (Macintosh) Pullin.
3. Type A or B in the Pullin column.
- Pullin A: The first frame of the sequence plays back as two fields, the second frame as three fields, the third frame as two fields, and so on.
- Pullin B: The first frame of the sequence plays back as three fields, the second frame as two fields, the third frame as three fields, and so on.

Now you can perform a digital cut to append the new sequence.

**Understanding DV Digital Cut Delay**

DV digital cut delay affects the timing of the DV data sent to the DV device for a digital cut. Increasing the digital cut delay will cause the sequence stream to be delayed when it is sent to the DV device when digital cut begins. While the system is waiting for this delay, the first frame of the sequence is continually sent to the DV device.

There are several components to this setting.

- The recommended value represents the delay that is found in the machine template for the online DV device. If for some reason, there is no “online” DV device, the recommended value is set to the delay in the machine template of the “offline” DV device. If no DV device is configured in the Deck Configuration and Deck Settings dialog boxes, this value is set to 0.
- If you want to override the recommended digital cut delay, select the Override Recommended Digital Cut Delay option, and type a delay value into the Digital Cut Delay (frames) text box. When a digital cut is performed, the delay value used for the cut is based on whether the Override Recommended Digital Cut Delay option is selected. If the option is deselected, the recommended value is used.

Before setting this delay, you should perform several digital cuts to determine the frame-accuracy behavior of the recording device. Begin with the DV digital cut delay set to 0 frames. If the digital cut frame accuracy of the device is inconsistent, the results of using the delay are also inconsistent. If the sequence is missing frames at the beginning of the digital cut on the tape, increase the delay. If the first frame of the sequence is repeated, decrease the DV digital cut delay. The starting frame of the sequence should change according to your delay.

For example, suppose the DV digital cut delay is set to 0 frames. The digital cut is expected to begin with the first frame of the sequence being recorded on the IN point designated on the tape. In this example, the IN point is set to frame number 6. This is where the recording would begin on the tape. However, due to the behavior of the particular DV device, the digital cut does not perform as expected. The first frame of the sequence recorded on the tape is actually the fourth frame.
To correct this, the DV digital cut delay should be increased to have the Avid system delay sending the sequence to the device. If the DV digital cut delay is set to three frames, this should cause recording on the tape to begin with the correct sequence frame.

Delaying the Sequence for a Digital Cut

You can delay the sequence stream being sent to a DV device during a digital cut. This can help you to ensure that the first frame recorded is the first frame of your sequence. For more information, see “Understanding DV Digital Cut Delay” on page 1098.

To delay the sequence for a digital cut:

1. Click the Settings tab in the Project window.
2. Double-click Deck Preferences.
   
   The Deck Preferences dialog box opens.
4. Determine the approximate delay and type the delay in the Digital Cut Delay (frames) text box.
5. Click OK.
6. Perform a digital cut.
   
   See “Using the Digital Cut Tool” on page 1079.
7. Repeat this process until you achieve the appropriate delay.

Understanding Passthrough

When the Digital Cut tool is active, the footage you see in the monitor is passing through from an input source to the output channels. Passthrough, also known as confidence view, uses the input source you specified in the Input tab in the Audio Project Settings dialog box, the Video Input tool Audio menu, or the Capture tool Audio menu. It does not use the target device you selected in the Digital Cut tool.

The Video Input tool is not available on all models.

When you click the Play Digital Cut button, passthrough stops. You see the sequence in the Timeline that you are outputting to digital cut. Passthrough resumes when the digital cut playback is complete.
Using the Lists Tool

The following describes how to read and create lists in Avid Media Composer. You can generate EDLs, Cut Lists, and Change Lists. The List Tool provides one tool to create these lists. The options within the tool change depending on the output format you select.

What is an EDL?

An edit decision list (EDL) is an instruction list for edits you make. The EDL is used for exchanging information between editing systems. This list can include cuts, wipes, dissolves, fades, and black edits. It lets you take a project from Avid Media Composer to a high-end, nonlinear, online editing system. It is common to use EDLs in DI (digital intermediate) workflows.

What is a Cut List?

A cut list is generated the first time to conform a work print, negative, sound track, or optical effect to match the sequence.

What is a Change List?

A change list is generated to simplify the process of updating conformed cuts to match and compare changes in versions of the sequence or sequences.

The Lists Tool

The following describes the User Interface of the Lists Tool. Select Output > Lists Tool. The List Tool opens. The left side of the Tool is where you setup the EDL, Cut List, or Change List.
The options in the Output Format pulldown menu determine the output. The options in the List Options and Formatting tabs change depending on which Output Format you select.

**Input Tab**

The Input tab is where you drag and drop the sequence into the List Tool. You can also click the Load button to load the current sequence from the Timeline into the List Tool. The tracks for that sequence populate the Tracks pane in the Input tab. You can enable or disable any tracks to be included in the list.

![Input Tab](image)

**List Options Tab**

The options in the List Options tab change depending on the Output Type.
Formatting Tab

The options in the Formatting tab change depending on the Output Type. The options display if they are relevant to the selected Output Format.
**Preview Pane**

The right side of the Lists Tool displays the Preview pane. This is where you can preview, save or edit the EDL, Cut List or Change List.

![List Tool Window](image)

Once you click the Preview button, the EDL or Cut List populates the window.

**Creating a List**

To create a List, perform the following.

**To create a List:**

1. Select Output > Lists Tool
   
   The Lists Tool opens.
Using the Lists Tool

2. From the Output Format pulldown menu, select the type of output you want to create. If you are creating an EDL list, choose one of the EDL Output Types; CMX_3600, CMX_DigitalCut, CMX_Transfer, File_16, or File_32, or File_129. If you are creating a Cut List or Change List, choose one of the Cut List or Change List Types; Columnar, TabbedLists, WebLists, or XML.

3. Drag the sequence from the bin into the Input tab Sequence field. Or load a sequence into the record monitor and click the Load button to load the current sequence from the record monitor.

   The title of the List is automatically populated based on the sequence name. You can choose to edit the List name. The tracks associated with the sequence appear in the Tracks pane.

4. By default, all video, audio and data tracks are enabled. Click to enable/disable the tracks you want to appear in the list.

5. Click the List Options Tab.

6. Select the options you want to appear in your output list. See the “EDL: List Options” on page 1107 or “Cut List: List Options” on page 1110 or “Change List: List Options” on page 1113 depending on the Output Format.

7. Click the Formatting tab and select how you want the list to be formatted. See “EDL: Formatting Options” on page 1107 or “Cut List or Change List: Formatting Options” on page 1115.

8. Select the Preview button.
   
   The List appears.
9. Click Save List to save the list to your system. You can choose to save the List as one file or multiple files. If you choose multiple files, the file names include the tracks; v1, v2, v3, if applicable.

10. (Optional) You can also click the New List button which opens a blank list. This might be helpful in creating a new list and comparing multiple lists.

11. (Optional) Click the Clone List button to open a duplicate list based on the current options and format settings.

12. (Optional) To compare the lists, simply click the collapse button and move the windows side by side.

**Editing a List**

Once you create an EDL, Cut List or Change List, you can edit it.

**To edit a List:**

1. Choose the list you want to edit.
2. Click the Preview button.
3. After creating a Preview list, click the Edit button in the upper right corner of the Preview window. Or, right mouse click inside the Preview window and select “Switch to Edit Mode.”

4. Make your edits to the list.

5. (Optional) While in Edit mode, use Ctrl+F (Windows) or Command+F (Macintosh) to open the Find Replace window at the bottom of the Preview List. Enter the text you want to search for and click the arrows to find the text. You can enter replacement text in the Replace text box. Click the arrows again to find the next instance. You can also choose to replace all instances of the text.

6. Click Save List to save the list to a location on your system. You can choose to save the List as one file or multiple files.

If you click Preview before saving the list, a List Tool message appears asking if you want to save the changes before Previewing another list.

Importing an EDL

You can import an EDL.

To import an EDL:

1. In the editing application, select File > Import EDL.
2. In the Select File to Open dialog, navigate to the location of the .edl file.
3. Select the file and click Open.
   A dialog opens.
4. Select the desired Frame Rate, Project Type and Audio Mapping options.
5. Click OK.
   The Select Bin window opens.
6. Select one of the bins listed inside the window or click New Bin to create a new bin.
   A message displays asking you to Decompose the sequence before trying to use it.
7. Click OK.
8. Click on the imported sequence inside the bin.
9. From the Clip menu, select Decompose.
10. Select the desired Decompose options.
11. Click OK.

The decompose process begins. When the decompose process is completed, the bin contains decomposed clips (.new) and a decomposed sequence if “Create New Sequence” was enabled inside the Decompose window. The Video resolution of the Decomposed clips is determined by the Capture tab inside the Media Creation Setting.

The Decomposed master clips and sequences are available for conform.

**EDL: List Options**

Choose from the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Picture</td>
<td>Select the picture options you want included in your EDL. You can choose to include: Dissolves, Other Transitions, 3rd Party Transitions, Black Edits, Color Effects, Other Segment Effects, 3rd Party Segment Effects and Color Decision Lists.</td>
</tr>
<tr>
<td>Sound</td>
<td>Select the sound options you want included in your EDL: Dissolves, Volume, Track Patching, EQ Effects and Track Effects:</td>
</tr>
<tr>
<td>Both Picture and Sound</td>
<td>Select the picture and sound options you want included in your EDL: Clip Names, Source File Name, Cadence, Reel Names, Markers, Spanned Markers, Clip Comments, Repair Notes and Frame Count</td>
</tr>
</tbody>
</table>

**EDL: Formatting Options**

Choose from the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optimize the EDL</td>
<td><em>Optimization</em> is a process that simplifies your EDL. An optimized EDL contains simplified text and events that are combined or condensed to speed up the online assembly process. If two tracks of video and one channel of audio share the same Record IN and Record OUT timecodes and they come from the same source tape, optimization expresses them as one edit instead of three.</td>
</tr>
</tbody>
</table>
### Option Description

**S3D Contributor**  
Monoscopic: Set this option for standard sequences, or if you only want to use the “leading eye” clips in a stereoscopic sequence.  
S3D Left: Only displays the left eye clips.  
S3D Right: Only displays the right eye clips.

**Source TC**  
Start: The starting timecode  
VITC: The vertical interval timecode  
Sound_TC: Audio timecode  
Film_TC: Film timecode  
TC24: 24 fps  
TC25PD: 25 fps with pulldown  
TC25: 25 fps  
TC30: 30 fps  
AUX_1_TC - AUX_5_TC: The timecode from the timecode column in the bin  
AUX_TC_24: 24 fps auxiliary timecode

**Record TC**  
TC1: The timecode from the timecode column in the bin  
TC24: 24 fps  
TC25PD: 25 fps with pulldown  
TC25: 25 fps  
TC30DF: 30 fps drop frame  
TC30ND: 30 fps non-drop frame  
TC30NP: 30 fps without pulldown

**Real ID Type TC**  
Tape: Uses the reel ID from the tape source from which you captured your video.  
Sound_Roll: Uses the reel ID from the sound roll source, (if you entered this information in the bin). Used for film projects.  
Camera_Roll: Uses the reel ID from the camera source (if you entered this information in the bin). Used for film projects.  
Lab_Roll:  
Disk_Label:
## Using the Lists Tool

### Sort Mode

Select the sort mode for the EDL.

- **A (Record In)** Sorts by the Record In timecode. This results in Sequential editing from one IN point to the next. Use this when you have a short show, want to generate a simple, flexible EDL, or need to make many last-minute decisions.

- **B (Source, Record In)** Sorts by the individual source reel, then by the Record IN timecode. This results in checkerboard editing on the record reel, one source reel to the next. Use this when the length of source material is roughly equivalent to the length of the finished show.

- **C (Source, Source In)** Sorts by individual source reel, then by the Source IN timecode. This results in checkerboard editing on the record reel, with sequential playback of material from each source. Use this when the length of source material is much greater than the length of the finished show.

- **D (Source, Record In, Effects at End)** Sorts by individual source reel, then by the Record In timecode. Sorts effects at the end. Use this when the length of source material is roughly equivalent to the length of the finished show, and there are many special effects.

- **E (Source, Source In, Effects at End)** Sorts by individual source reel, then by the Source IN timecode. Sorts effects at the end. Use when the length of source material is much greater than the length of the finished show, and there are many special effects.

- **S (Source Start)** Sorts by Source IN timecode only. This results in Direct sequential transfer of source material, in matching order on the record reel.

- **C (Source Start, Source In)** Sorts by Source IN timecode, then by individual source reel. This results in Direct sequential transfer of source material by record reel. Use when the length of source material is much greater than the length of the finished show.

### Pulldown starting frame

Selects the start frame for your generated EDL.

### Starting Event Number

You can modify the Starting Event Number.

### Starting TC

Selects the sequence starting timecode. You can enter a new sequence starting timecode using drop-frame (:) or non-drop frame (;) numbers.
Using the Lists Tool

**Cut List: List Options**

Choose from the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tape or File Name truncation</td>
<td>Determines which part of the tapename you want to save.</td>
</tr>
<tr>
<td></td>
<td>• End - Truncates the end of the tape name. For example, CHICAGO138101 becomes CHICAGO1.</td>
</tr>
<tr>
<td></td>
<td>• Middle - Takes half of the allowed number of characters from the front and the other half from the end of the tape name. For example, CHICAGO138101 becomes CHIC8101.</td>
</tr>
<tr>
<td></td>
<td>• Beginning - Removes the beginning of the tape name. For example, CHICAGO138101 becomes GO138101.</td>
</tr>
<tr>
<td></td>
<td>• First_N - Keeps the first character and the last character and removes everything in between. For example, CHICAGO138101 becomes CO138101.</td>
</tr>
<tr>
<td>Convert tape names to numbers</td>
<td>Changes all generated EDL reel ID names to numbers.</td>
</tr>
<tr>
<td>Include source table with saved EDL</td>
<td>Includes the source table information whenever you save an EDL.</td>
</tr>
</tbody>
</table>
Using the Lists Tool

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assemble</td>
<td>The Assemble list shows the order in which a sequence’s clips, optical effects, or standard dissolves and fades are assembled from start to finish in the edited sequence. The assemble list also flags duplicate frames.</td>
</tr>
<tr>
<td></td>
<td>• LFOA: (Last Frame of Action) Determines the duration of a sequence at the last frame that is part of the sequence, minus the length of the head and/or tail. Select the option and type the length of the head and/or tail.</td>
</tr>
<tr>
<td></td>
<td>• Mark Short Cuts: Searches the assemble list for cuts that are shorter than a user-specified minimum. All such cuts are flagged with a comment. Not included in XML output.</td>
</tr>
<tr>
<td></td>
<td>• Mark Jump Cuts: Searches the assemble list for jump cuts that are shorter than a user-specified minimum. All such cuts are flagged with a comment. A jump cut occurs when a short piece of material is “missing” between adjacent cuts from the same source material. Not included in XML output.</td>
</tr>
<tr>
<td></td>
<td>• Show Dupe Refs:</td>
</tr>
<tr>
<td></td>
<td>• Include Pull List:</td>
</tr>
<tr>
<td></td>
<td>• First Sort by: Controls how a list is sorted. None, Labroll, Camroll, Soundroll, Scene and Take, Name, and Reel #</td>
</tr>
<tr>
<td></td>
<td>• Second Sort by: Same choices as First sort by</td>
</tr>
<tr>
<td></td>
<td>• Third Sort by: KN Start, Auxiliary Ink, Transfer, DPX, VFX, Start TC, Film TC, Sound TC, Auxiliary TC1</td>
</tr>
<tr>
<td></td>
<td>• Order: Heads Out (ascending edge numbers) Tails Out (descending edge numbers)</td>
</tr>
<tr>
<td></td>
<td>• Place Separators: Select this option to control where separators are placed in the list. The options are First Sort Field, Second Sort Field, Keycode or Ink Prefix, and Prefix or every 1000 ft. The separator’s appearance depends on the template; usually it appears as a horizontal line.</td>
</tr>
<tr>
<td></td>
<td>• Include Leader: Check this option to include leader in the list.</td>
</tr>
<tr>
<td></td>
<td>• Include Optical: Check this option to include opticals in the list.</td>
</tr>
</tbody>
</table>
Using the Lists Tool

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Optical  | Optical lists specify the source material required to create special effects and any edit event other than a straight cut, such as a dissolve or fade that must be sent to an optical house for creation. The optical list presents each optical event in the order in which it appears in the sequence and includes specifications based on either ink numbers, Aux ink numbers, or key numbers.  
  - Key Frames: Controls whether or not optical keyframes from the sequence are shown in the optical list. If you change the keyframe parameters of an effect, the change is reflected in the change list only if you select this option.  
  - Optical Footage: Shows footage relative to the beginning of each optical.  
  - Page Breaks Between Opticals: Each optical prints on a separate page.  
  - Include Optical Pull List:  
    - First Sort by: Controls how a list is sorted. None, Labroll, Camroll, Soundroll, Scene and Take, Name, and Reel #  
    - Second Sort by: Same choices as First sort by  
    - Third Sort by: KN Start, Auxiliary Ink, Transfer, DPX, VFX, Start TC, Film TC, Sound TC, Auxiliary TC1  
    - Order: Heads Out (ascending edge numbers) Tails Out (descending edge numbers)  
    - Place Separators: Select this option to control where separators are placed in the list. The options are First Sort Field, Second Sort Field, Keycode or Ink Prefix, and Prefix or every 1000 ft. The separator’s appearance depends on the template; usually it appears as a horizontal line.  
    - Include Leader: Check this option to include leader in the list. |
| Dupe     | Dupe lists refer to all the source material that the lab must duplicate before conforming the film negative. Additionally, dupe lists display unintended duplicate frames you might have edited into the sequence.  
  - Assume Handles: Specify the number of frames for handles during dupe checking. The frames are added to the beginning and the end of each clip before checking for overlap. (The handles are not reflected in a list but are used for internal calculations.)  
  - Print w/Handles: Specify the number of frames for handles after dupe checking. The frames are added and displayed at the beginning and end of each clip in the list. |
## Change List: List Options

Choose from the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scan</td>
<td>The Scan list type is a pull list for all elements in the Timeline including effects and layers.</td>
</tr>
<tr>
<td></td>
<td>• First Sort by: Controls how a list is sorted. None, Labroll, Camroll, Soundroll, Scene and Take, Name, and Reel #</td>
</tr>
<tr>
<td></td>
<td>• Second Sort by: Same choices as First sort by</td>
</tr>
<tr>
<td></td>
<td>• Third Sort by: KN Start, Auxiliary Ink, Transfer, DPX, VFX, Start TC, Film TC, Sound TC, Auxiliary TC1</td>
</tr>
<tr>
<td></td>
<td>• Order: Heads Out (ascending edge numbers) Tails Out (descending edge numbers)</td>
</tr>
<tr>
<td></td>
<td>• Place Separators: Select this option to control where separators are placed in the list. The options are First Sort Field, Second Sort Field, Keycode or Ink Prefix, and Prefix or every 1000 ft. The separator’s appearance depends on the template; usually it appears as a horizontal line.</td>
</tr>
<tr>
<td>Picture</td>
<td>Select the picture options you want included in your Cut List or Change List. You can choose to include: Dissolves, Other Transitions, 3rd Party Transitions, Black Edits, Color Effects, Other Segment Effects, 3rd Party Segment Effects and Color Decision Lists.</td>
</tr>
<tr>
<td>Sound</td>
<td>Select the sound options you want included in your Cut List or Change List: Dissolves, Volume, Track Patching, EQ Effects, Track Effects, and AudioSuite Effects.</td>
</tr>
<tr>
<td>Both Picture and Sound</td>
<td>Select the picture and sound options you want included in your Cut List or Change List: Clip Names, Source File Name, Cadence, Reel Names, Clip Comments, Repair Notes and Frame Count</td>
</tr>
</tbody>
</table>
### Change

A change list is generated to simplify the process of updating conformed cuts to match and compare changes in versions of the sequence or sequences.

- **Show only changes**: Limits the entries in the change list to insertions, deletions, trims, and moves. There is no explicit indication of sections that remain unchanged. If this option is not selected, the change list also contains events that explicitly show sections that remain unchanged.
- **Combine Deletions**: Forces each group of adjacent deletions to be combined into a single event. If this option is not selected, each deleted clip has its own event in the change list.
- **Preview Code**: Displays preview code numbering.

### Change Pull

The change pull list is similar to the pull list, except that it lists only new clips or effects that you need to insert into the updated cut.

- **First Sort by**: Controls how a list is sorted. None, Labroll, Camroll, Soundroll, Scene and Take, Name, and Reel #
- **Second Sort by**: Same choices as First sort by
- **Third Sort by**: KN Start, Auxiliary Ink, Transfer, DPX, VFX, Start TC, Film TC, Sound TC, Auxiliary TC1
- **Order**: Heads Out (ascending edge numbers) Tails Out (descending edge numbers)
- **Place Separators**: Select this option to control where separators are placed in the list. The options are First Sort Field, Second Sort Field, Keycode or Ink Prefix, and Prefix or every 1000 ft. The separator’s appearance depends on the template; usually it appears as a horizontal line.
- **Include Leader**: Check this option to include leader in the list.
- **Include Opticals**: Check this option to include opticals in the list.

### Change Discard

The change discard list displays each clip that has been removed from the updated sequence.

### Change Optical

Key Frames: Controls whether or not optical keyframes from the sequence are shown in the optical list. If you change the keyframe parameters of an effect, the change is reflected in the change list only if you select this option.

- **Optical Footage**: Shows footage relative to the beginning of each optical.
- **Page Breaks Between Opticals**: When selected, each optical prints on a separate page.
Using the Lists Tool

Cut List or Change List: Formatting Options

Choose from the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Picture</td>
<td>Select the picture options you want included in your Cut List or Change List. You can choose to include: Dissolves, Other Transitions, 3rd Party Transitions, Black Edits, Color Effects, Other Segment Effects, 3rd Party Segment Effects and Color Decision Lists.</td>
</tr>
<tr>
<td>Sound</td>
<td>Select the sound options you want included in your Cut List or Change List: Dissolves, Volume, Track Patching, EQ Effects and Track Effects, AudioSuite Effects.</td>
</tr>
<tr>
<td>Both Picture and Sound</td>
<td>Select the picture and sound options you want included in your Cut List or Change List: Clip Names, Source File Name, Cadence, Reel Names, Clip Comments, Repair Notes and Frame Count</td>
</tr>
<tr>
<td>Running As Mode</td>
<td>Specifies the format in which to display the incrementing count for the sequence.</td>
</tr>
<tr>
<td>Master TC Track</td>
<td>Select which timecode track you want to be used to display the master timecode in the list.</td>
</tr>
<tr>
<td>Start at:</td>
<td>Specify the footage to be used as a starting point in the master.</td>
</tr>
<tr>
<td>Display Handles</td>
<td>Select Display Handles, and then type a handle size. A new With Handles column is added to the lists for each source column for WebLists and TabbedLists templates. The column contains the start and end values of the column and adds a handle of the specified size.</td>
</tr>
<tr>
<td>Show events, hide markers</td>
<td>Select from the following to determine if both events and markers are included in your EDL. Choose from: Show events, hide markers; Show events, show markers; Show events with markers, hide markers; Show events with markers, show markers; or Hide events, show markers.</td>
</tr>
<tr>
<td>Separate List for Each Channel</td>
<td>Select this option to generate a separate set of lists for each selected picture track.</td>
</tr>
<tr>
<td>Show Prefix</td>
<td>Select this option to identify cuts in the cut list or change list by displaying the entire first and last key number for each cut.</td>
</tr>
<tr>
<td>Matchback Info</td>
<td>Select this option to display the matchback information in the list.</td>
</tr>
</tbody>
</table>
Using the Lists Tool

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disable Perf Slip</td>
<td>Select to instruct the Cut List tool to ignore any audio perf slipping and offset data when displaying ink numbers.</td>
</tr>
<tr>
<td>Show Icons</td>
<td>Select to include icons that graphically represent edit events in your lists. See “Cut List and Change List Icons” on page 1116 and “Change List Icons” on page 1117.</td>
</tr>
<tr>
<td>Ignore all Special</td>
<td>Select to exclude special characters.</td>
</tr>
<tr>
<td>Characters from Display</td>
<td></td>
</tr>
</tbody>
</table>

**Cut List and Change List Icons**

The following table lists the icons available in both the cut list and change list. The icons only appear if Show Icons is enabled in the Formatting tab. Icons only display in Columnar Cut Lists and Change Lists.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Event</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Icon" /></td>
<td>Fade Out</td>
</tr>
<tr>
<td><img src="image2" alt="Icon" /></td>
<td>Fade In</td>
</tr>
<tr>
<td><img src="image3" alt="Icon" /></td>
<td>Dupe</td>
</tr>
<tr>
<td><img src="image4" alt="Icon" /></td>
<td>Dissolve</td>
</tr>
<tr>
<td><img src="image5" alt="Icon" /></td>
<td>Optical</td>
</tr>
<tr>
<td><img src="image6" alt="Icon" /></td>
<td>Optical Media</td>
</tr>
<tr>
<td><img src="image7" alt="Icon" /></td>
<td>Media Offline</td>
</tr>
</tbody>
</table>

1116
Change List Icons

The following table lists the icons available only in the change list. The icons only appear in the Change List if Show Icons is enabled in the Formatting tab.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Event</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Delete</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Insert</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Insert Head</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Insert Tail</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Delete Tail</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Delete Head</td>
</tr>
</tbody>
</table>

Understanding Matchback

The Matchback option on some Avid editing applications, lets you generate a film cut list from a 30-fps or 25-fps video project that uses film as the source material. This video-to-film conversion is useful in a variety of matchback circumstances, including the following:

- Using the Matchback option to generate both a videotape master for the project and a final cut on film.
- Using the Matchback option to generate pull lists for retransferring selects at high quality before online editing.

Matchback supports 16mm, 35mm 3-perf, and 35mm 4-perf formats.

If you plan to use matchback, you must select the Matchback option when you first create the project. See “Creating a New Project” on page 156.
Editors working in a film matchback project for the first time should pay extra attention to duplicate material in the final edited piece. Use Dupe Detection in the Timeline and verify any dupes flagged when delivering a cut negative. For information on dupe detection, see “Dupe Detection” on page 723.

How Matchback Works

The matchback process refers to the video edit information for your sequence and performs a conversion to create a matching 24-fps cut list.

Because of the difference in frame rates between video and film (30 fps or 25 fps for video versus 24 fps for film), the conversion of video edit points might fall within a film frame, requiring the addition or subtraction of a frame in that edit event in the resulting cut list.

For example, with a ratio of 24 film frames to 30 video frames, a 7-frame video edit corresponds to approximately 5.6 film frames. However, film cuts cannot include partial frames, so the edit must be rounded to 5 or 6 frames.

To make these adjustments, the following occurs during matchback:

- If the total video-sequence duration at the end of each cut is a frame longer than the film, the system subtracts a frame from the last video edit. If the video is a frame too short, a frame is added to the last video edit.
- Where an essential frame was added to or subtracted from the beginning or end of each edit, the system adds matchback information to the cut list, stating that matchback shortened or lengthened the tail of the clip by one frame. The assistant editor or negative cutter can use this information to check the edit.
- Each track in the sequence must be corrected independently because the start and end points for split edits are different for each track. As a result, the picture and audio for a matchback video edit might be out of sync by no more than one frame.

Matchback Limitations

Matchback is subject to the following limitations:

- The Matchback option uses key numbers to conform the negative, so you must have key-number information entered into the bins for the project.
- You can generate cut lists but not change lists in a matchback project.
- The matchback information applies to the picture only. You must generate a separate list (an EDL, for instance) for conforming the audio source tapes.
- Be sure to remove unwanted match frames (add edits) from your sequence before generating the cut list. Otherwise, the calculation of matchback frames will include these edits. For information about removing match-frame edits, see “Working with Add Edits (Match Frames)” on page 722.
Vertical Blanking Information

Avid editing applications using Avid input/output hardware let you work with vertical blanking information in some SD material. You can choose whether to display 5 lines above each field in NTSC and 8 lines above each field for PAL and whether to preserve the lines when you perform a digital cut. These lines can be used to store additional encoded information such as closed captioning, edgecodes or key numbers for film projects, or various interactive or enhanced TV codes. This section describes when it is useful to preserve the information and describes the limitations involved when preserving these lines.

⚠️ You can preserve VBI information for JFIF, uncompressed, and MPEG IMX resolutions.
You cannot preserve VBI information for DV resolutions.

⚠️ In the majority of cases, you should not preserve these extra lines when you perform a digital cut. Only do so if you have a special need for the information.

Vertical Blanking Interval Line Ranges

Your Avid editing application can capture 248 lines per field in NTSC or 296 lines per field in PAL. For NTSC, only 243 of these lines are in RP-187’s production aperture. For PAL, the number is 288. The additional lines in each field are located immediately above the active part of each of the two fields. These lines (5 per field in NTSC and 8 per field in PAL) can be used for carrying additional data.

The following table lists the extra vertical blanking lines for both NTSC and PAL:

<table>
<thead>
<tr>
<th>Field</th>
<th>Video Raster Line Number Ranges</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>NTSC (5 Lines/Field)</td>
</tr>
<tr>
<td>Field 1</td>
<td>16-20</td>
</tr>
<tr>
<td>Field 2</td>
<td>278-282</td>
</tr>
</tbody>
</table>

Displaying and Preserving Vertical Blanking Information

Avid editing applications using Avid input/output hardware automatically preserve the extra lines of vertical blanking information when you capture footage. You can choose whether to display the lines and whether to retain the lines when you output your sequence as a digital cut.
You might want to preserve the following vertical blanking information:

- Edgecode or key number information for a film project
  
  You might want to preserve edgecode information to easily identify the source film reel for a clip. In this case, the edgecode information would have been originally inserted during the telecine process.

- Closed-captioning information
  
  If you are repurposing a finished sequence for another market, you might want to retain closed-captioning codes that were added after the tape was output from the Avid system. This would let you perform some basic editing on the recaptured sequence and not to have to reapply the closed-captioning codes afterward.

Your Avid editing application does not interpret the vertical blanking information (the encoded data). It treats the coded values simply as pixels in the video frame. If you want to read the vertical blanking information during editing, you must connect an external vertical blanking information reader to the Avid system.

To display vertical blanking information and preserve it for a digital cut:

1. Select Tools > Video Output Tool.

   The Video Output tool opens.
2. Click the VBI menu and select Preserve.  
   If you select Blank, your Avid editing application fills the vertical blanking interval with video black (R=G=B=16).

3. Close the Video Output tool.
   Any VBI information that is present in your clips or sequences will now be displayed. If you perform a digital cut, any VBI information that is in your sequence will be output.

The VBI value resets to Blank each time you launch your Avid editing application. If you want to preserve VBI information on output, set the value before you perform a digital cut.

Editing a Sequence with Vertical Blanking Information

After a sequence is created and output from an Avid editing system, some facilities apply VBI information to the tape to add information such as closed captioning. Often, the tape is recaptured so that the sequence can be repurposed for another market. The VBI option in the Video Output tool lets you display the VBI information and maintain the information when you output the repurposed sequence.
Your Avid editing application uses the following rules when applying effects to material containing VBI information:

- Single track effects do not alter the VBI information. For example, if you apply a color correction effect to the sequence, the VBI lines are not affected.
- Multi-track effects such as picture-in-picture effects or 3D Warp effects use the VBI information of the track on the lowest layer. (Swap sources is ignored in the VBI area).

If you apply a multi-track effect such as a 3D Warp effect to a sequence with a single track, the VBI information will not be visible. One way to work around this problem is to create a second video track and duplicate that portion of the sequence on the second track. Then apply the 3D Warp effect to the top track. The VBI information will display on the bottom track.

- Transitions are treated as cuts in the VBI area.
- Timewarp effects copy the VBI of the input’s temporally nearest field. In mild timewarp effects this may allow VBI to pass through unaltered.

You cannot add or remove VBI information from a sequence. However, you can use the Blank option to turn off the VBI display for the entire sequence.

You cannot preserve VBI information for DV resolutions. You can only preserve VBI information for JFIF, uncompressed, and MPEG IMX resolutions.

**Effects of Preserving Vertical Blanking Information on Compressed Video Quality**

For resolutions other than 1:1, preserving vertical blanking information when you capture can affect the video quality in the rest of the frame. For example, depending on the compression ratio, a video frame might look more blocky with vertical blanking information included.

Your Avid editing application performs the following operations when capturing a frame:

1. It captures the entire frame (including the 5 or 8 extra lines per field) as an uncompressed frame.
2. It compresses the frame if compression is selected.
The following problems may occur:

- If the frame contains vertical blanking information, the picture quality of the entire frame might be slightly degraded due to the added entropy or complexity from the vertical blanking lines.

  The higher the compression ratio, the greater the number of artifacts that might be visible. For a compression ratio of 2:1, the number of artifacts might not be noticeable at all.

- Depending on the compression ratio, the vertical blanking information itself may be distorted.

If you want to preserve vertical blanking information, either use the 1:1 (uncompressed) resolution or experiment with different compression ratios to make sure the captured footage or the vertical blanking information is not unacceptably affected by the compression.

**Preserving HD Closed Captioning and Ancillary Data**

Unlike SD closed captioning data, which is transferred in the vertical blanking interval (VBI), HD closed captioning and ancillary data packets are transferred in the HD-SDI data stream.

In certain circumstances, your Avid editing application lets you capture closed captioning and other ancillary data in HD, preserve this data during editing, and output the data through the HD-SDI port of your Avid input/output hardware. Your Avid editing application lets you turn ancillary data preservation on and off and to control which data is preserved.

Depending on your input/output hardware and the version of software you have, there are two methods for preserving ancillary data. The Legacy method embeds the ancillary data in a DNxHD video file, and the Data Track method adds a separate data track to the Timeline and lets you capture and store ancillary data as a separate MXF file. You need to choose whether you want to use the new Data Track method or the legacy embedded method.

For both methods, you can only monitor and view the data on a client monitor capable of handling ancillary data.

Your Avid editing application can capture and preserve any of the following four types of ancillary data by default:

- **Closed Captioning (CEA 608, CEA 708):** Closed captioning ancillary data packets are captured from the HD-SDI source according to the SMPTE 334M standard.

- **Program Description (AFD):** AFD ancillary data packets are captured from the HD-SDI source according to the SMPTE 334M standard.

- **Ancillary Time Code (ATC):** Ancillary time code packets are captured from the HD-SDI source.
Preserving HD Closed Captioning and Ancillary Data

The options that you set for ancillary data preservation are associated with the project. When you create a new project, you must set the ancillary data options you need for that project.

**Data Track Method**

The Data Track method stores ancillary data as a separate MXF file. A D (Data) track is added to your sequence, along with the video and audio track. You can edit clips on the D track, just as you would any other clip.

When you use the Data Track method, ancillary data preservation is subject to the following requirements and limitations:

- You can capture and output the MXF media using Avid Nitris DX or Avid Mojo DX input/output hardware only.
- You can control which types of ancillary data are captured through the Capture Settings tab in the Media Creation tool. The data you capture is the same as the data you output.
- Four data slots are available, and the maximum size is selectable.
- To view and monitor ancillary data, you must connect an ancillary data capable device to the output of your Avid hardware.
- You can AMA link to XDCAM and MXF media that store ancillary data. For more information, see “Ancillary Data and AMA” on page 1128.
- You cannot add an effect to the Data track.
- Ancillary data is not supported when crossconvert or downconvert are enabled.
- You cannot patch a Data track.
- Multicamera (group clips) is not supported with a Data track.
- A Data track is not allowed when you use mixed rate clips.
- You cannot transcode a data clip.
- You must output through the HD-SDI port of your Avid input/output hardware. Ancillary data is only supported through the HD-SDI input/output of your Avid hardware.
- At this time, the following resolutions/projects are not supported with a data track: RGB, 720p/23, 720p/25 and 720p/29.94.
- Data tracks are supported when you export a sequence to a playback device through the Transfer > Send to Playback option (exporting a sequence with Data tracks to an Avid Interplay Transfer environment). For information about Send to Playback with a Data track, see your Avid Interplay documentation.
- At this time, there is no support to export a sequence with a data track through the File > Send To template options, for example, ProTools.
Adding a Data Track

You can add one Data track directly to the Timeline or you can extract the ancillary data from a video clip to create the Data track.

If you have a clip with ancillary data that you brought in through the Legacy method, the best way to bring this clip onto a data track is to use the procedure by extracting ancillary data from a clip. When you add a Data track by extracting a clip, the clip needs to meet the following criteria, or you will receive an error message:

- The clip must be a master clip
- The clip should not have a Data track associated with it already
- The media needs to be DNxHD format
- The media needs to be online

To add the Data Track to a sequence in the Timeline:

1. With a sequence loaded in the Record monitor, select Clip > New Data Track.
2. Right-click in the Timeline, and select New Data Track.

   The new Data Track appears in the Timeline.

To add a Data Track through extracting ancillary data from a clip:

1. Select the clip (that includes ancillary data) in the bin.
2. Choose Clip > Extract DNxHD Data, or Right-click the clip in the bin and choose Extract DNxHD Data.

   The Confirm dialog box appears.

   If the clip does not meet all the requirements to extract an ancillary data clip, a dialog box appears that informs you of the problem. Open the Console window (Tools > Console) to get more information about the problem.
3. Click Continue or Cancel.

   The system adds the Data track with the clip to the Timeline. The clip in the bin displays D1 in the Track column.

To playback the D1 track, you must have the ancillary data turned on in the Media Creation Settings > Capture tab. See “Controlling Ancillary Data through a Settings Window - Data Track Method” on page 1132.
Adding the Active Format Description to the Data Track

Active Format Description (AFD) is a standard set of codes that can be sent in the video stream that carries information about the aspect ratio and the active picture characteristics. AFD information allows you to display the video of one aspect ratio on a display with another aspect ratio. When in an HD project, you can choose to add the AFD information to the data track.

If a data track is already present in the sequence and populated with ancillary data, the AFD value will simply be added to the data track.

If you have master clips in the Timeline that have ancillary data, the existing ancillary data will be unaffected unless it contains AFD. The AFD that is assigned to the sequence will change the attribute in the sequence, not the source.

To add the AFD to the Data Track:
1. Right+click the sequence to which you want to add the AFD and select Modify.
   The Modify window opens.

   ![Modify window](image)

2. Select Active Format Description.
   The Modify window displays the Active Format Description options.
3. Select the Active format information you want to include with the data track. The active format options change depending upon the selected Coded Frame. A graphical representation of the active format is displayed in the Modify window to show you how the active format area will be displayed.
The table below shows the selectable active format options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active Format</td>
<td>0000 Undefined</td>
</tr>
<tr>
<td></td>
<td>0100 Box &gt;16:9 (center)</td>
</tr>
<tr>
<td></td>
<td>1000 Center</td>
</tr>
<tr>
<td></td>
<td>1001 4:3 (center)</td>
</tr>
<tr>
<td></td>
<td>1010 16:9 (with complete 16:9 image protected)</td>
</tr>
<tr>
<td></td>
<td>1011 14:9 (center)</td>
</tr>
<tr>
<td></td>
<td>1101 4:3 (with alternative 14:9 center)</td>
</tr>
<tr>
<td></td>
<td>1110 16:9 (with alternative 14:9 center)</td>
</tr>
<tr>
<td></td>
<td>1111 16:9 (with alternative 4:3 center)</td>
</tr>
</tbody>
</table>

4. Click OK.

A new data track will be created if one is not already present in the sequence. You will receive a dialog indicating that a data track will be created. The data track appears empty. This data track must be present and monitored during output in order for the AFD value to be inserted. If you delete this data track, the AFD value is also deleted.

**Ancillary Data and AMA**

Avid Media Access (AMA) is a plug-in architecture that lets you link directly to clips from a third-party volume or to a file based media clip into a bin without storing the media directly on your system.

You can AMA link to an XDCAM or an MXF (SMPTE 436M compliant) clip with ancillary data, the ancillary data appears in your bin and it creates a Data track in your Avid sequence. You can link to the ancillary data clip without an Avid input/output hardware, however, in order to view the ancillary data in a monitor, an Avid Nitris DX or Avid Mojo DX device is required.

*Ancillary data is only supported with high resolution XDCAM clips. A proxy clip does not contain a data track, however once you relink to the high resolution XDCAM clip, the data track comes online.*

For information about ancillary data and data tracks, see “Preserving HD Closed Captioning and Ancillary Data” on page 1123 and “Data Track Method” on page 1124.
If you consolidate the XDCAM or MXF clip or the sequence that contains the XDCAM or MXF clip with ancillary data, the ancillary data track stays with the consolidated clip or sequence. In addition, the Ancillary Data bin column populates with the DID and SDID numbers once you consolidate or transcode the clip with the ancillary data.

In order to AMA link to the XDCAM ancillary data clip, you need to install the latest XDCAM AMA plug-in. In order to AMA link to the MXF ancillary data clip, you need to install the latest MXF AMA plug-in. To download the AMA plug-ins, go to www.avid.com/ama.

To link to an XDCAM AMA clip with ancillary data, you need to perform a Link to AMA Volume. See the procedures “To manually link clips from a virtual volume with AMA,” in “Linking Media with AMA” on page 410.

To link to an MXF AMA clip with ancillary data, you need to perform a Link to AMA File. See the procedures “To link clips from a file with AMA,” in “Linking Media with AMA” on page 410.

For detailed information about AMA, see “Acquisition of File-Based Media (AMA)” on page 394.

For procedures on editing with ancillary data and AMA, see “Workflow for Editing Clips with Ancillary Data and AMA” on page 465.

**Moving from Legacy Method to Data Track Method**

The following explains what you need to know when you capture ancillary data with the Legacy method and move to the Data Track method. You might need to perform additional steps when you move sequences or clips from the legacy method to the data track method.

- You should not mix SMPTE 436M (data track) ancillary data media with legacy method media. If you have a sequence that includes media from both methods, only one method plays. If you select SMPTE 436M (data track) in the Media Creation Capture tab, only the SMPTE 436M (data track method) clip plays. If you select Legacy method in the Media Creation Capture tab, only the Legacy method clip plays. If you want to play both methods, you need to perform a Clip > Extract DNxHD Data on the Legacy clip and cut that clip into your sequence.

- Subclips created in the legacy method will not include a data track when you bring the subclip into a sequence or bin with data tracks. Only the master clip will include the data track. You cannot add a data track to a legacy subclip. You need to recreate the subclips again to add the data track.
## Ancillary Data and Avid Editing Functions

The table below describes if you can use a particular editing function with the new Data Track method or with the Legacy method.

### How Data Tracks Are Handled in the Data Track Method and the Legacy Method

<table>
<thead>
<tr>
<th></th>
<th>Data Track Method</th>
<th>Legacy Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a D track</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Play</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>(Avid Nitris DX or Avid Mojo DX only)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Edit</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Capture</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>(Avid Nitris DX or Avid Mojo DX only)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Transcode</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Consolidate</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Mixdown</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Import (AAF)</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Export (AAF)</td>
<td>Yes</td>
<td>No</td>
</tr>
</tbody>
</table>

### How Ancillary Data Embedded in DNxHD Media Is Handled in the Data Track Method and the Legacy Method

<table>
<thead>
<tr>
<th></th>
<th>Data Track Method</th>
<th>Legacy Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a D track</td>
<td>Not Applicable</td>
<td>Not Applicable</td>
</tr>
<tr>
<td>Play</td>
<td>Not Applicable</td>
<td>Yes</td>
</tr>
<tr>
<td>(with Avid Nitris DX or Avid Mojo DX only)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Edit</td>
<td>Not Applicable</td>
<td>Not Applicable</td>
</tr>
<tr>
<td>Capture</td>
<td>Not Applicable</td>
<td>Yes</td>
</tr>
<tr>
<td>(with Avid Nitris DX or Avid Mojo DX only)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Even though Avid preserves ancillary data, if you move a sequence with a data track to and from different systems (with and without supported Avid input/output hardware), be aware that when you perform the editing functions listed in the above tables, ancillary data might not always be preserved the way you expect.

**Legacy Method**

When you use the legacy method, ancillary data preservation is subject to the following requirements and limitations:

- You must capture and output the HD media using Avid Nitris DX or Avid Mojo DX input/output hardware.

*Software only systems do not support capture and output of HD ancillary data.*

- Due to software DNx codec performance requirements, you must have a dual quad core system in order to capture DNxHD 220 or 220x with ancillary data on the Avid Nitris DX or the Avid Mojo DX platform.
- Ancillary data can only be preserved when it resides on the V1 video track.
You can control which types of ancillary data you capture through the Capture Settings tab in the Media Creation tool or by using Console commands. The data you capture is the same as the data you output.

Four data slots are available, and the maximum size of the four data slots combined is 256 bytes, of which 7 bytes per enabled slot is for Avid control data. You might need to disable some data slots in order to have enough space for the data you need to preserve.

You must output through the HD-SDI port of your Avid input/output hardware. Ancillary data is only supported through the HD-SDI input/output of your Avid hardware.

Ancillary data is not supported when crossconvert or downconvert is enabled.

You cannot playback a D-track in Legacy mode.

Controlling Ancillary Data through a Settings Window - Data Track Method

This feature is only available with an Avid Nitris DX or an Avid Mojo DX. Choose SMPTE 436M to capture ancillary data to an MXF file (data track method). You can also set the slots through the Media Creation Settings.

To switch the ancillary data feature on and set options for ancillary data in a Settings window:

1. Do one of the following:
   ▶ Double-click Media Creation in the Settings list.
   ▶ Select Tools > Media Creation.
2. Click the Capture tab.
3. From the Ancillary Data Mode Setting, select SMPTE 436M.
   The system enables all four slots.
4. Select a Data Type for each slot you want to display ancillary data for.
   The default DID and SDID number displays for that slot.
5. Select Enabled next to the appropriate slot.
6. Deselect Enabled for those slots you do not want to capture ancillary data for.
7. Click OK.

For more information about ancillary data options, see “Media Creation Settings” on page 1512.
Controlling Ancillary Data through a Settings Window - Legacy Method

This feature is only available with an Avid Nitris DX or an Avid Mojo DX. You can turn the ancillary data option on and off and set the slots through the Media Creation Settings.

To switch the ancillary data feature on and off through a Settings window:
1. Do one of the following:
   - Double-click Media Creation in the Settings list.
   - Select Tools > Media Creation.
2. Click the Capture tab.
3. From the Ancillary Data Mode Setting, select Legacy.
4. Select a Data Type for each slot you want to display ancillary data for.
   The default DID and SDID number displays for that slot.

The DID and SDID information captured with the data clip displays in the bin.

For more information about ancillary data options, see “Media Creation Settings” on page 1512.

Controlling Ancillary Data with a Console Command (Legacy Method only)

You can turn the ancillary data option on and off and set the slots with Console Commands.

To switch the ancillary data feature on and off with a Console command:
1. Select Tools > Console.
2. Type the following command:
   Embeddnxcc

To set the default for ancillary data preservation for all four slots:
1. Select Tools > Console.
2. Type the following command:
   Embeddnxccdefault
   The default for all four slots is set to the values listed in the table below.

   The following table lists the DID and SDID number values for the four ancillary data packets that your Avid editing application can capture and preserve by default:
The slot 3 default has changed from DTV to AFD, which is different from previous releases.

To set options for ancillary data preservation for a single slot:

1. Select Tools > Console.
2. Type the following command with the appropriate options:
   
   Embeddnxccoptions <slot> <on/off> <optional DID & SDID>

   The following table describes the options you can set in the command:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Slot</td>
<td>A value from 1 to 4 that specifies a data slot</td>
</tr>
<tr>
<td>On/Off</td>
<td>A value of 1 or 0</td>
</tr>
<tr>
<td>DID</td>
<td>A hex number (for example, 0x61)</td>
</tr>
<tr>
<td>SDID</td>
<td>A hex number (for example, 0x60)</td>
</tr>
</tbody>
</table>

   For example:
   - To turn off data slot 1, type Embeddnxccoptions 1 0
   - To set data slot 2 to hold CEA 708 data, type
     
     Embeddnxccoptions 2 1 0x61 0x01
   - To set data slot 4 to hold a custom data type, type
     
     Embeddnxccoptions 4 1 0xaa 0xbb
     
     where aa and bb are the DID and SDID of the custom data type

To view the current status of each slot:

1. Select Tools > Console.
2. Type the following command:

   Embeddnxccoptions
Capturing Ancillary Data with a Data Track

While you capture video and audio clips, if your Avid editing system has an Avid Nitris DX or an Avid Mojo DX attached, you can also capture clips with ancillary data.

You perform the same steps included in “Preparing for Capture” on page 168 and “Capturing Media” on page 232 to capture video and audio media. Make sure you select the Data track (D) Channel Selection in the Capture tool. You also need to select the appropriate ancillary data options in the Capture tab of the Media Creation Settings window.

To capture clips with ancillary data:

1. Prepare your deck for capture. Follow the steps in “Preparing for Capture” on page 168 and “Setting Up the Capture Tool” on page 194. This includes selecting the D Channel Selection button in the Capture Tool.

2. Select SMPTE 436M and the type of ancillary data you want to capture in the Capture tab of the Media Creation Settings window. Follow the steps in “Controlling Ancillary Data through a Settings Window - Data Track Method” on page 1132.

3. Decide on your method of capture, see “Capturing Media” on page 232 for more information.

Depending on the options you select, ancillary data clips along with the video and audio clips you selected to capture, appear in the bin.

Performing a Data Mixdown

With the Data Track method, a data mixdown lets you combine several clips into one new master clip. You can use data mixdown after you finish building your sequence and want to make it into one piece.

Data mixdown is useful when you want to:

- Combine multiple ancillary data clips into one master clip.
- Finalize a complex sequence before you consolidate, export, or transfer.

With data mixdown, your end result is a new master clip made up of all the data clips on the data track. That track becomes one clip.

To perform a data mixdown:

1. Select the Record Track Monitor button in the Track Selector panel for the data track.

2. Mark an In point and an Out point around the area to mix down, or clear the In and Out points to mixdown the entire sequence.

3. Select Special > Data Mixdown.
The Data Mixdown dialog box opens.

4. Select a target bin and target drive for storing the new master clip, and then click OK.
   A progress indicator appears. When the data mixdown finishes, a new clip appears in the bin along with the sequence, and a new media file is created on the target drive.

**Exporting a Sequence with Data Tracks**

When you have completed work on a sequence with a data track, you can export the data track sequence to create an XDCAM HD file. You must use an XDCAM HD device. The XDCAM HD file serves as a wrapper for information about the sequence, with links to the media in the sequence.

The XDCAM HD file exports with the data track and ancillary data, however, if you attempt to import the same file into your Avid editing system, the data track and ancillary data do not import.

*For complete information about the export process, see “Understanding Export” on page 1020.*

**To export to an XDCAM device:**

1. Connect your XDCAM HD device.

2. Select the appropriate mode on your XDCAM HD device that corresponds to the video format that you will be exporting.
   For example, set your XDCAM device to 1080i 59.94 if you want to export a clip or sequence at XDCAM-35 1080I/59.94.

3. Select the sequence or clips to export, or select the data track.

4. With an XDCAM HD HD device connected to your system, select Output > Export to Device > XDCAM.
   If you have a sequence loaded in the Record monitor, the sequence is exported when you select Export to Device.
   You can also right-click the clip or sequence in a bin and select Export to Device.
   The XDCAM Export Settings dialog box opens.
5. (Option) Select Use Marks.

When Use Marks is selected, the current IN and OUT points in the selected clip or sequence determine starting and ending frames for the export.

6. (Option) Select Use Enabled Tracks.

When Use Enabled Tracks is selected, the system uses tracks that are enabled in the Timeline. To export all the tracks in the sequence, deselect this option.

7. Select an XDCAM HD disk from the Target XDCAM Disk list.

If the target XDCAM disk you are exporting to already has other clips on it, you are only allowed to export a clip with the same number of audio tracks. For example, if the target XDCAM disk has a clip with 4 tracks of audio, you cannot export a new XDCAM clip with 2 tracks. You either have to reformat the disk and wipe it clean or add two dummy tracks to your 2-track sequence before you export.

8. Select a video format.

Select XDCAM-50, XDCAM-35, XDCAM-25, or XDCAM-17.
For HD, a single disk can have clips with mixed bit rates (17.5, 25, and 35 Mbits). Additionally, a sequence that is being exported to an HD XDCAM disk can have mixed bit rates, as well.

If you use the Sony PDW HD1500 or the Sony PDW 1500 XDCAM device, export of up to 8 tracks of audio is supported for the MPEG IMX and XDCAM HD 50 Mbits formats. For other formats or devices that do not support 8 tracks, the system mixes down to audio tracks 1 and 2 during export.

9. Select a Bit Depth: 16 or 24 bits.

For HD projects, select 16 bits. XDCAM HD devices are not capable of handling 24 bits, except for the Sony PDW HD1500 device, which is capable of handling 24 bits.

10. Click OK.
Sony applies its own file-naming convention. All exported clips are given a new sequential name of Cxxxx.mxf, for example, C0019.mxf.

A progress bar appears displaying the new Sony XDCAM HD sequential clip name. The sequence is exported.
Conforming and Transferring Projects

This chapter contains information about conforming and transferring projects.

- Understanding Conforming
- Preparations for Conforming
- Conforming Workflow
- Conforming Sequences with Color Correction
- Transferring Project and Media Files Between Avid Editing Systems

Understanding Conforming

You can move projects and media from one Avid editing system to another and preserve your edits and effects. In a typical offline-to-online workflow, you create a program on one Avid editing system — choosing the footage, making edits, adding effects — and then transfer your program to another Avid system for final finishing.

Re-creation of an offline project on an online system is called conforming, and Avid’s solution is called Total Conform. Finishing tasks often include recapturing media in a final resolution, making color corrections, adjusting effects, and outputting the final master.

If you use the same media for offline and online editing, you can access the media in several ways. For example, you can share media in an Avid shared storage environment, or transfer removable drives from one system to another. Your clips and sequences automatically link to the media, and you can complete the final finishing.

Compatibility Between Versions

If you are moving from one Avid editing application to another in the current release, or from a product in a previous release to a product in the current release, you can move project files and media without losing any of your work. You might need to promote some effects so that they are compatible with the current release. For more information, see “Promoting and Demoting Existing Effects in Sequences” in the Help.

However, when you move projects from a product in the current release to a product in a previous release, some effects might not appear, or might appear as unknown effects.
Transferring to Avid DS

You can find specific information for transferring projects to Avid DS in the *Avid DS Conform Guide* (available from the Avid DS Support Center or the Avid Customer Support Knowledge Base.) To access the Knowledge Base, go to www.avid.com/onlinesupport.

⚠️ Do not include mixed rate clips in sequences that you intend to finish on an Avid DS system. Motion adapters do not conform in current versions of Avid DS, and you cannot play or adjust mixed rate material.

Preparations for Conforming

The following topics provide information that you should review before you begin the transferring and conforming process described in “Conforming Workflow” on page 1145.

If possible, work with the offline editor to plan the online edit. Planning the online edit makes the online session easier and more efficient.

Delivery Requirements for Final Masters

The requirements for your final masters determine factors such as the project type you use during the offline edit. Ideally, you perform the offline edit with the online edit in mind.

The most important delivery requirements are the formats and frame rates. A broadcast network might require a range of formats: NTSC, PAL, and HD, at 4:3 and 16:9. Avid’s Symphony Option Universal Mastering lets you output multiple versions from the same source file (see “Step 10: Create the Final Masters” on page 1153). Make sure that you perform the offline edit at the same frame rate as the online edit, or at a compatible frame rate.

Offline Formats for HD

If your project requires final mastering in HD, use the corresponding SD project for offline editing, as listed in the following table.

When you start the online session, you can create a new project in the final format, or use the original project and change the project format. For more information, see “Changing the Project Format” on page 1604.
Preparations for Conforming

1141

File Transfer for the Online Session

Before you begin moving project files between Avid editing applications, consider the following.

- Determine if you need to transfer project information, video media, audio media, or all three. See “Step 1: Transfer Files” on page 1145.

System Compatibility for the Online Session

Ensure that files transfer correctly between editing systems, and that both systems include the necessary applications. Consider the following:

<table>
<thead>
<tr>
<th>HD Online</th>
<th>SD Offline</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>720p/23.976</td>
<td>23.976p NTSC</td>
<td>You cannot change between these project formats because the edit rates are different. See “Converting a 23.976p NTSC Sequence to 720p/23.976” on page 1608.</td>
</tr>
<tr>
<td>720p/25</td>
<td>25p PAL or 25i PAL</td>
<td>Change the project format and modify the sequence.</td>
</tr>
<tr>
<td>720p/50</td>
<td>25p PAL or 25i PAL</td>
<td>You cannot change between these project formats because the edit rates are different.</td>
</tr>
<tr>
<td>720p/59.94</td>
<td>30i NTSC</td>
<td>You cannot change between these project formats because the edit rates are different, see “Editing at 60 fps” on page 1608. Use an NTSC 30i project for offline editing, then open a new 720p/59.94 project for online editing. Open the desired NTSC 30i bins and modify the final sequence, as described in “Changing the Sequence Format” on page 1605.</td>
</tr>
<tr>
<td>1080p/23.976</td>
<td>23.976p NTSC</td>
<td>For 23.976p NTSC, change the project format and modify the sequence.</td>
</tr>
<tr>
<td>1080p/24</td>
<td>24p NTSC or 24p PAL</td>
<td>Change the project format and modify the sequence.</td>
</tr>
<tr>
<td>1080p/25</td>
<td>25p PAL or 25i PAL</td>
<td>Change the project format and modify the sequence.</td>
</tr>
<tr>
<td>1080i/50</td>
<td>25i PAL or 25p PAL</td>
<td>Change the project format and modify the sequence.</td>
</tr>
<tr>
<td>1080i/59.94</td>
<td>30i NTSC</td>
<td>Change the project format and modify the sequence.</td>
</tr>
</tbody>
</table>
Frame Rates

Ensure that both editing systems support the same frame rates. For example, some offline systems support 24p projects and some do not. You might require a 24p project to deliver multiple output formats.

File Naming

To make it easier to move files between products and across platforms, use the following guidelines when naming files:

- Do not use the following characters in project, bin, or other file names:
  
  \ / : * ? " < > |

  The Windows system does not recognize these characters in file names and substitutes other characters, possibly making the file name unrecognizable.

- Do not add spaces at the beginning or end of a file name, or use a period at the end of a file name. The Windows system displays such files but might be unable to open them.

- On Macintosh® systems, the Use Windows Compatible File Names setting in the General Settings dialog box of your Avid editing application prevents you from using restricted characters in file names. It also automatically adds the correct file name extensions to files for your project (.avp for project files and .avb for bin files). The setting is selected by default.

Title Fonts

If the project includes titles and you are moving between Macintosh and Windows systems, make sure you have the same font with exactly the same name (preferably from the same supplier) on both the Macintosh and Windows systems. Check the font carefully because the same font can have slightly different names.

If you open a title on the online system that does not have a matching font, a dialog box opens that lets you substitute the font in the title with a font that exists on your system.

For best results, use OpenType® fonts, which reduce problems when transferring projects from one platform to another.

AVX Plug-Ins

If your project contains AVX™ plug-in effects and you are moving across platforms, make sure the same plug-ins are available on both the Macintosh and Windows systems. If the same AVX plug-in effect is not available, you can mix down or render the effect to a high-quality resolution and then transfer it using an OMFI or an AAF file. However, you cannot change the parameters of the effect.
Preparing Graphics for the Online Session

The most critical step when preparing graphics for online is to make sure that the elements you are going to import are created correctly. The following table summarizes various requirements.

<table>
<thead>
<tr>
<th>Aspect</th>
<th>Requirement</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frame size</td>
<td>Square pixels:</td>
<td>These are the preferred sizes for NTSC and PAL. You can also use 720 x 540, in some situations, for both NTSC and PAL. These are stored by your Avid editing application as non-square pixels.</td>
</tr>
<tr>
<td>(4:3)</td>
<td>648 x 486 (NTSC)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>640 x 480 (NTSC DV)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>768 x 576 (PAL)</td>
<td></td>
</tr>
<tr>
<td>Frame size</td>
<td>Square pixels:</td>
<td>Preferred sizes. SD media is stored by your Avid editing application as non-square pixels.</td>
</tr>
<tr>
<td>(16:9)</td>
<td>864 x 486 (NTSC anamorphic)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1024 x 576 (PAL anamorphic)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1280 x 720 (HD)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1920 x 1080 (HD)</td>
<td></td>
</tr>
<tr>
<td>Alpha channel</td>
<td>White foreground (transparent), black background (opaque)</td>
<td>This is the standard used by graphics, animation, and compositing packages. You need to invert the alpha channel of graphics on import.</td>
</tr>
<tr>
<td>Color mode</td>
<td>RGB</td>
<td>Other formats, including CMYK, might cause import errors. ITU-R 601 is used for SD and ITU-R 709 is used for HD. In HD projects, your Avid editing application automatically converts the media.</td>
</tr>
<tr>
<td></td>
<td>ITU-R 601</td>
<td></td>
</tr>
<tr>
<td></td>
<td>ITU-R 709</td>
<td></td>
</tr>
<tr>
<td>File format</td>
<td>Various</td>
<td>Your Avid editing application accepts many file formats for input. TIFF (.tif) and PICT (.pct) are commonly used formats. See “Import Specifications for Supported Graphics File Formats” on page 1540.</td>
</tr>
<tr>
<td>File field order</td>
<td>Odd (Upper field first)</td>
<td>For interlaced media, your Avid editing application uses the following order:</td>
</tr>
<tr>
<td></td>
<td>Even (Lower field first)</td>
<td>• NTSC (601 and DV): lower field first</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• PAL 601: upper field first</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• PAL DV: lower field first</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• HD Interlaced: upper field first</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If the field order of the graphic is not correct, select the field order of the graphic during import and your Avid editing application reverses the fields appropriately.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Field order does not apply to progressive media. See “Field Ordering in Graphic Imports and Exports” on page 1554.</td>
</tr>
</tbody>
</table>
Preparing Effects for the Online Session

In general, effects from older systems are automatically conformed by newer systems. In some cases, effects are automatically promoted to new versions. However, be aware of the following issues:

- If you work in an offline SD project with complex effects and you plan to conform as HD, you should downconvert the media anamorphically. Media that you downconvert as 4:3 or letterbox causes problems when you conform effects such as picture-in-picture.
- If you are conforming a sequence that includes effects created with Avid FX, mix down or render the effects to a high-quality resolution on the offline system and then transfer them using an OMFI or an AAF file. You cannot adjust an Avid FX effect on a Media Composer system.

(Symphony Option) Preparing Titles for the Online Session

You can save titles in multiple aspect ratios. If you are working with anamorphically downconverted media, save the title as 16:9. After opening the sequence in an HD project, re-create the title media (see “Step 7: Re-create Title Media” on page 1150). This method lets you correctly create titles that fit in the 4:3 center cut or that extend beyond the center cut.

If you are working with media downconverted to center cut or letterbox, save the title as 4:3. In this case the titles appear centered, within the 4:3 center cut.

*If you are working in 23.976p, 24p, or 25p projects, you can output your project in both NTSC and PAL video formats, and in both 4:3 and 16:9 aspect ratios. You need to save a title at each aspect ratio you need for your output requirements, but video format conversion is handled automatically by your system’s hardware.*

Preparing Audio for the Online Session

Your might use an audio workflow where you export audio from the offline system, sweeten it in an audio application such as Pro Tools, and import it into the online system. For more information, see “Step 5: Import and Lay in the Final Audio Mix” on page 1149.

If you are sharing files with Pro Tools, you can use the WAVE or AIFF-C format. Pro Tools v6.9 or later also supports MXF files For more information, see “Transferring Audio Files” on page 1156.

* DigiTranslator™ v2.0 is required on the Pro Tools system for import and export of OMF and AAF files. *You can also transfer files to Pro Tools through Interplay. For more information, see “Using Pro Tools and Interplay” in Avid Interplay Best Practices.*
If you are sharing files between Macintosh and Windows systems, avoid using Sound Designer II™, which is a Macintosh format. For more information, see “Transferring and Working with Sound Designer II Audio Files from Macintosh Systems” on page 1157.

Conforming Workflow

The following topics provide information to help you transfer projects from one Avid editing system to another and conform the sequence to create one or more finished masters. These steps are based on an offline-to-online workflow that uses Media Composer as the online system. For projects that you plan to finish on an Avid DS system, refer to the product documentation that comes with Avid DS.

Before you start the process described in the following topics, review the information provided in “Preparations for Conforming” on page 1140 to ensure that your offline materials are ready for transferring and conforming.

For specific information about HD and film-based workflows, see “Working in HD and High-Resolution Projects” on page 1588.

If you are transferring projects and media but not performing an online edit, refer to “Transferring Project and Media Files Between Avid Editing Systems” on page 1155.

Step 1: Transfer Files

Transferring Project Information Only

Project information includes the components of your project (such as settings, bins, master clips, edited sequences, and so on), but does not include the media for these components. This project information is sometimes called metadata. Transfer only project information if you are planning to recapture media (for example, from an offline resolution to an online resolution) or relink media in an Avid shared storage environment.

The following table describes the main options for transferring project files only.

<table>
<thead>
<tr>
<th>Transfer Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move the project folder from one desktop to another.</td>
<td>This option lets you transfer complete project information, but you need to use the desktop operating system to copy and transfer files.</td>
</tr>
<tr>
<td>Create an OMFI or an AAF file (composition only).</td>
<td>This option lets you export from your Avid editing application, but is limited to a single sequence or master clip. See “Guidelines for Exporting OMFI and AAF Files” on page 1033.</td>
</tr>
</tbody>
</table>
Transferring Project Files and Media Files

Transfer project files and media files if you want to transfer media files to another Avid editing system. For example, your offline sequence might already use a broadcast-quality resolution, but you want to add Symphony Option color correction.

The following table describes the main options for transferring project and media files.

<table>
<thead>
<tr>
<th>Transfer Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move the project folder along with a removable media drive from one system to another.</td>
<td>This option lets you transfer complete project information, but you need to use the desktop operating system to copy and transfer files.</td>
</tr>
<tr>
<td>Create an OMFI or an AAF file that references a removable media drive.</td>
<td>This option lets you work within your Avid editing application, but is limited to a single sequence or master clip. You can link to media files that you have copied or consolidated to a single drive. See “Guidelines for Exporting OMFI and AAF Files” on page 1033.</td>
</tr>
<tr>
<td>Create an OMFI or an AAF file with embedded media.</td>
<td>This option lets you create a single OMF or AAF file, which you can consolidate onto a single drive.</td>
</tr>
</tbody>
</table>

If you want to transfer audio media to a digital audio workstation, such as a Pro Tools, system, see “Transferring Audio Files” on page 1156 or “Using Pro Tools and Interplay” in Avid Interplay Best Practices.

Step 2: Open the Project

Depending on your project requirements and your personal preferences, you can open a project in either of two ways.

Start a New Project

Use the Select Project dialog box to create a new project with the format you want to use for final mastering. If you start a new project you can configure the project settings and eliminate any errors or problems caused by the offline project’s settings.
You can then open the bins that you have transferred from the original project and load the final sequence. If you are finishing an HD project, and the offline project was done in SD, use the Modify command to change the sequence format (see “Changing the Sequence Format” on page 1605).

If you transferred an OMFI or an AAF file with embedded media, you can create a new project and bin and import the OMFI or the AAF file. The sequence automatically links to the media.

*If the clips and sequences do not link automatically, select File > Refresh Media Directories.*

**Open a Transferred or Shared Project**

If you transferred project files, the original project appears in your list of projects. (Depending on the location into which you copied the files, you might need to use the Browse button in the Select Project dialog box to locate the project.) When you open the project, all project settings and bins appear.

If you transferred both project files and media, and your media is compatible, the original project appears in your list of projects. When you open the project, all project settings and bins appear. Clips and sequences automatically link to the media.

If you are finishing an HD project, and the offline project was done in SD, change the project format and then change the sequence format. For more information, see “Changing the Project Format” on page 1604 and “Changing the Sequence Format” on page 1605.

For information about working with shared projects and media in an Avid shared storage environment, see “Transferring a Project Using Shared Storage” on page 1157.

**Step 3: Measure the Video Signal**

When you are working with analog material, measure the actual video signal during both input and output to ensure the signal does not exceed the broadcast specification.

*For SDI or HD-SDI formats, you cannot adjust input or output levels by using the video controls in your Avid editing application. For HD media, you can calibrate only HD component output, which is usually used for monitors.*

For more information, see the following topics:

- Preparing to Capture Video
- Calibrating for Video Output
Step 4: Recapture Media

If you did not transfer media, or you need to recapture your media at a higher resolution, use one of the options described in the following table.

<table>
<thead>
<tr>
<th>Recapture Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recapture master clips</td>
<td>This option offers complete flexibility to make revisions, but takes the most time and disk space.</td>
</tr>
<tr>
<td>Recapture a sequence</td>
<td>This option provides a one-step process, but limits your options during capturing. You can make revisions using only assigned handle lengths.</td>
</tr>
<tr>
<td>Decompose the sequence and recapture the new clips</td>
<td>This option captures only enough media to re-create the sequence. You can specify the length of handles, which you can use for minor revisions. This method is more flexible than capturing from the sequence because it creates new clips that you can sort and selectively capture. This method uses minimal storage and can be one of the fastest methods for recapturing. In most cases, do not decompose clips created from imported graphics, which is an option in the Decompose dialog box. These decomposed clips might cause problems when batch importing, particularly if the sequence uses only part of an imported animation.</td>
</tr>
<tr>
<td>Use the Show Reference Clips option</td>
<td>This option lets you reveal the source clips of a sequence in a single bin by selecting the “Show reference clips” option in the Bin Display dialog box, and then recapturing the source clips. This method can be faster than recapturing a sequence or decomposing if the lengths of the new audio and video clips created differ from the original master clips. Because two passes are necessary to capture audio and video from a single source if the lengths are not the same, it is sometimes faster to capture a slightly longer master clip than to capture the new clips once for audio and once for video. This method also gives you more opportunity for revisions. However, this method uses more disk space and capturing can take longer. It can be a good compromise between capturing all the original clips and capturing only the clips needed to re-create the source.</td>
</tr>
</tbody>
</table>

For instructions on recapturing, see “Recapturing and Decomposing” on page 254.

*When you recapture from SD source tapes, Avid recommends that you readjust the video levels. You can transfer video input settings from another system, but the existing settings have been calibrated to a different set of hardware and might not operate properly.*

*If you are capturing serial digital video (SDI) or DV, your Avid editing application ignores the video input settings.*
**Step 5: Import and Lay in the Final Audio Mix**

In most cases, the final audio mix is done either as part of the offline edit or on a digital audio workstation such as Pro Tools. In either case, import the OMFI or the AAF file. For more information, see “Transferring Audio Files” on page 1156, “Importing Files” on page 297, and “Using Pro Tools and Interplay” in *Avid Interplay Best Practices*.

After importing the audio mix, calibrate the audio hardware and channels as described in “Calibrating Audio Hardware for Avid Nitris DX and Avid Mojo DX” on page 217.

Then use the Audio tool to monitor the audio levels (see “Understanding the Audio Tool” on page 212).

You can quickly check the peak values of the sequence (see “Using the Console Window to Check Audio Levels” on page 221).

**Step 6: Batch Import Graphics**

If you are working with master clips or sequences that contain imported material, you can use the Batch Import command to reimport the source files. For example, you might want to:

- Upgrade the video resolution of the imported files to an online resolution.
- Replace low-quality material with high-quality material finished with other applications.
- Create new media files when the media files are lost or accidentally deleted.

**Reimporting requires your original source files. Do not delete the media files for imported files unless you have access to the source files.**

To make batch importing easier:

- Consider placing a “graphics” folder inside the project folder of your offline project. This makes the batch import process easier because the path is the same, or at least faster to find.
- If you want to edit revised graphics into your project, consider giving them the same names as the original graphics, copying the revised graphics to the folder that contains the original graphics, and batch importing the revised graphics. You can also edit new graphics into your project by deleting the media for your original graphics, batch importing your sequence, and pointing the old clips to the revised graphics files.

For instructions on batch importing, see “Reimporting Files” on page 334.
Step 7: Re-create Title Media

After you transfer or import all files, you might need to re-create title media if you did not render the titles, or if you want to change the resolution of the titles. For more information, see “Re-creating Title Media” in the Help.

If you have the same font on both systems, the equivalent font appears automatically when you re-create title media. However, because the font mapping process might change the exact appearance of the font, check your titles carefully. It might be easier to check your titles from the bin than from the sequence.

If a title opens and the system does not recognize the font, you see a dialog box that lets you substitute the font in the title for one that is installed on the system. This replacement creates a font mapping, which is saved as a Site setting. For information on changing the font mapping, see “Redefining a Font Replacement” on page 1151. If more than one font in the title needs replacement, the dialog box remains open after you click OK, and a new message identifies the next font that needs replacement.

You should be aware of the following when re-creating title media:

- For best results, use OpenType fonts, which reduce problems when transferring projects from one platform to another.

- If you are moving across platforms and the transferred title text uses a single style (the same font and type size), the title text aligns as closely as possible to its original position. The size of the text bounding box adjusts to accommodate the differences between the Macintosh and Windows versions of the font. You might see a changed leading value in the Title Tool leading field to adjust for multiline text.

  Because the Macintosh and Windows systems handle fonts differently, you might see variations in the appearance of titles between the two systems. If necessary, adjust the size of the bounding box, leading values, or kerning information.

  For example, bounding boxes that were set on a Macintosh system might appear in a different size on a Windows system. Some clipping of the new text might occur and words might be lost. If this clipping occurs, you need to open the title, select the text box, and manually change the size of the text box or the size of the fonts to display all the text.

  For more information on differences between the Macintosh and Windows versions of a font, contact the font supplier.
If the original system used any applications to manipulate font display (such as Adobe Type Manager®), the enhancements these applications provided on the original system (such as character anti-aliasing or character spacing) will not transfer to a system that does not use your Avid editing application.

You should save titles created in an offline project with anamorphically downconverted media as 16:9. See “(Symphony Option) Preparing Titles for the Online Session” on page 1144.

**Redefining a Font Replacement**

You can redefine a font replacement at any time. However, your new font choice applies only to a title currently in the Title tool and future replacements. It does not affect the font replacement information in titles you have worked with previously.

Your Avid editing application saves font relationships as a site settings file named AvidFontSub.avt. This file is located in the Settings folder, which is located in the Avid Media Composer folder on your internal drive.

Once you have defined a font replacement, your Avid editing application uses that definition across all projects and all users of the system. If you want to switch to a different replacement font for a title, you must redefine the font replacement.

*If you replace the font for a title and return that title to an Avid editing application on a Macintosh system, the new font information is associated with the title. You must reapply the Macintosh font to restore the title to its original Macintosh style.*

**To redefine a font replacement:**

1. Open a title in the Title tool.
2. Select Object > Font Replacement.
   
   The Font Replacement dialog box opens.
3. Click the Unknown Fonts menu on the left, and select the original font.
4. Click the Available Fonts menu on the right, and select the replacement font you want to use.
   
   When you select a font from the Available Fonts menu, a preview of that font appears in the text boxes.
5. Click OK.
   
   The system updates the font in the open title and records the new replacement information for future use.
Step 8: Refine Effects and Perform Color Correction

After reviewing the sequence, you might find you need to adjust effects, add effects, or perform color correction.

Common effects and color correction tasks during finishing include:

- Motion tracking or stabilization.
  See “Motion Tracking and Stabilization” in the Help.
- Reformatting media to different aspect ratios.
  See “Using the Reformat Effects” in the Help.
- Intraframe editing or scratch removal.
  See “Intraframe Editing” in the Help.
- Review and adjustment of chroma and luma levels.
  See “Safe Colors” in the Help.
- (Symphony Option) Color adjustments to selected areas (secondary color correction).

For complete information on effects and color correction, see the Effects Guide chapters in the Help.

You might need to choose a different rendering method for motion effects after recapturing media in a final online resolution. Consider promoting traditional motion effects to Timewarp effects. For more information, see “Playing and Rendering Motion Effects” in the Help.

You should be aware of the following considerations when conforming on Symphony Option using effects created on other Avid editing systems:

- Chroma and luma keys conform in Symphony Option as they were created in the offline system. However, you might find problems with the keys, especially when working in an uncompressed resolution. For maximum options in adjusting keys, promote 2D keys to 3D. The 3D Warp effect in Symphony Option includes parameters for the SpectraMatte effect. For more information, see “Key Effects” in the Help.
- The position of borders on wipes or PIPs might vary. For wipes created on Media Composer Adrenaline v2.2.x or earlier, or Avid Xpress Pro v5.2.x or earlier, borders end on screen. For wipes created on or conformed on Symphony Option, borders end off screen.
- For Color effects created on Media Composer or Avid Xpress Pro, the Chroma Adjust parameter values might not match.
Step 9: Render Effects as Needed

Although many effects play in real time, you might need to render some complex effects or plug-in effects. For more information, see “Real-Time Playback of Video Effects” and “Basics of Effects Rendering” in the Help.

The ExpertRender feature includes a special setting called Prepare for Digital Cut. For more information, see “ExpertRender” in the Help.

Step 10: Create the Final Masters

(Symphony Option) Avid’s Universal Mastering features offer you a range of output formats you can use for your final master. The output formats that are available depend on the format of your source footage.

Your editing application offers you a range of output formats you can use for your final master. The output formats that are available depend on the format of your source footage.

- You can use the Reformat effect or the Pan and Scan effect to create 4:3, 14:9, and 16:9 versions of the sequence. In addition, the Digital Cut tool includes the option to automatically output titles as 4:3 or 16:9 to match your sequence. If your source footage is 23.976p, 24p or 25p, you can also output versions for special purposes, such as NTSC 24, for recording audio at the film rate.

For more information, see Selecting Output and Timecode Formats for 23.976p, 24p, and 25p Projects.

- If your source footage is HD, you can use the Video Output Tool to crossconvert to a compatible HD format, and downconvert to an NTSC or PAL format. For more information, see “Preparing for Converting HD Formats” on page 1066.

- All formats let you use the Export tool to output in popular file formats, including QuickTime and Windows Media. Avid codecs for QuickTime let you input and output files quickly, and you can install the codecs on graphics workstations for the most efficient input and output. For more information, see “Exporting Frames, Clips, or Sequences” on page 1019.

- You can create cut lists and change lists, and an EDL. For more information, see “Using the Lists Tool” on page 1100.
Conforming Sequences with Color Correction

The following topics explain how sequences with color correction conform as they are moved between Media Composer | Symphony and certain other Avid editing applications, and how you can transfer color correction adjustment values from one type of color correction to another in cases where color corrections do not conform as you want.

Conforming Color Correction Sequences with Media Composer or Avid Xpress Pro Systems

(Symphony Option) If you open a sequence created on a Media Composer or Avid Xpress Pro system, all existing Color Correction effects conform. You can view and play the Color Correction effects in the Timeline, and you can make further adjustments to the Color Correction effects in the Color Correction tool.

If you want to convert existing Color Correction effects to relationship color corrections, you can do so using color correction templates, as described in “Transferring Color Corrections with Color Correction Templates” on page 1154.

In an Avid editing application that works with Media Composer or Avid Xpress Pro, if you open a Symphony Option sequence, you see the following behavior with color corrections:

- All color corrections (whether relationship or Color Correction effect) that use color correction controls available in Media Composer or Avid Xpress Pro conform as Color Correction effects.
- Color correction adjustments that are unique to Symphony Option, for example adjustments on the Channels, Levels, or Secondary tabs, do not conform in Media Composer or Avid Xpress Pro. A color correction that uses these adjustments appears in the Timeline (and if it also contains HSL or Curves adjustments they are available), but you cannot view or further adjust the adjustments that are unique to Symphony Option.
- When segments contain both a Source and a Program relationship color correction, only one of those corrections (the one applied first in time) appears as a color correction effect.

Transferring Color Corrections with Color Correction Templates

In many situations where a color correction does not conform between one Avid editing application and another in the way that you want, all of the color correction adjustment values that you need are still intact, so you can work around the problem by using color correction templates to transfer the color correction adjustment values to a new type of correction. The following procedure provides an example of one typical transfer.
To convert a Color Correction effect in a sequence originally created in an Avid Media Composer product to a relationship color correction:

1. In Color Correction mode, move the position indicator to the Color Correction effect whose adjustment values you want to transfer, and ensure that you are monitoring the track in the Timeline that contains the effect.

2. Drag the Color Correction template icon from the Color Correction tool to a bin.

   Your Avid editing application saves a color correction template in the bin. If you want, you can rename the template to clarify its origin.

3. Click the Remove Effect button to remove the original Color Correction effect from the segment.

4. (Option) If you intend to use a relationship color correction that will apply to multiple segments (taking the place of multiple individual Color Correction effects), you might need to move to each of the other segments and remove the existing Color Correction effects from each.

5. In the Correction Type menu, select the relationship color correction you want to use.

6. Do one of the following:
   ▶ To apply all of the adjustment values stored in the template, drag the Color Correction template icon that you created in step 2 from the bin, and drop it on the monitor containing the current segment.
   ▶ To apply only those adjustment values from the template that appear in one Color Correction tool tab, drag the Color Correction template icon that you created in step 2 from the bin, and drop it on the appropriate tab in the Color Correction tool.

   For example, drop the icon on the Curves tab to apply only Curve adjustments to the new relationship.

Transferring Project and Media Files Between Avid Editing Systems

The following topics describe the options and methods you can use to transfer project files and media between Windows systems, between Macintosh systems, and between Windows and Macintosh systems.

There are two basic methods for transferring projects:

• Moving project folders, settings, and media files between the systems.
• Moving project folders and settings between the systems, and then recapturing the media.

For information on recapturing, see “Recapturing and Decomposing” on page 254.
The devices and technologies you use for transfer depend on which method of transfer you choose.

- Moving project folders, settings, and media files requires large amounts of storage space because of the size of media files.
- Transferring only the project folders and settings files requires minimal storage space.

**Transferring Audio Files**

You might need to transfer audio separately from video. For example, you might send audio from an offline system to a Pro Tools system for sweetening, and then send the finished audio to a Media Composer system for syncing with final video.

When you move your sequence to an audio application, you need to export the sequence as an OMFI or an AAF file (see “[Guidelines for Exporting OMFI and AAF Files](#)” on page 1033). If you are working with a Pro Tools system, you can streamline your workflow by using the Send To feature, see “[Exporting With the Send To Templates](#)” on page 1022. The Send To Pro Tools templates export an AAF file.

If the audio-editing application to which you are moving your sequence supports the audio format used to create your sequence, you can export the sequence as an OMFI or an AAF composition without audio media and move the original media files to the audio-editing workstation. If the audio editing application to which you are moving your sequence does not support the audio format in your sequence, you must export the sequence as an OMFI or an AAF composition with audio media and convert the audio media to the appropriate format.

OMFI files have a 2-GB file-size limit.

The following table lists Pro Tools support for embedded audio. Pro Tools does not support embedded video.

<table>
<thead>
<tr>
<th>Pro Tools Version</th>
<th>Audio embedded in OMFI</th>
<th>Audio embedded in AAF</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>AIFF-C</td>
<td>WAVE</td>
</tr>
<tr>
<td>Pro Tools v7 or later</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Pro Tools v6.9 or later</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Pro Tools v6.7 or earlier</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

For information on importing into and exporting from an audio application, see the documentation for the audio application.
DigiTranslator v2.0 is required on the Pro Tools system for import and export of OMF and AAF files.

For information about working with Sound Designer II audio files, see “Transferring and Working with Sound Designer II Audio Files from Macintosh Systems” on page 1157.

For information on working with ProTools in an Interplay environment, see “Using Pro Tools and Interplay” in Avid Interplay Best Practices.

Transferring and Working with Sound Designer II Audio Files from Macintosh Systems

Sound Designer II audio media is a Macintosh format and is not supported on Windows.

To transfer Sound Designer II media to a Windows system, export an OMFI or AAF composition that includes the media and convert the media to AIFF-C or WAVE. Use the Export command or the Send To command.

Sound Designer II audio media has limited support on Media Composer Macintosh systems.

The following features are supported:

- You can play Sound Designer II audio that you create on another system and transfer.
- You can export audio as Sound Designer II media through the Audio option of the Export command.

The following features are not supported:

- You cannot select Sound Designer II as the file format for a project or output Sound Designer II media in a digital cut.
- You cannot export or convert Sound Designer II media through OMF or AAF.
  You can use the Consolidate or Transcode feature to convert Sound Designer II media to another audio file format, or you can convert it as part of an OMF or AAF export.

Transferring a Project Using Shared Storage

If you are using your Avid editing system in an Avid Unity environment, you can use Avid Interplay to share media files, projects, and bins between systems. For more information, see your Avid Unity and Avid Interplay documentation.

You can also share bins and projects in an Avid Unity environment that does not use Avid Interplay. See “Sharing Bins and Projects in an Avid Unity Environment” in the Help and in the Avid Unity documentation.
Transferring Project Files and Media Files Using Nonshared Storage

You can use removable nonshared storage devices to transfer media files between Avid editing applications.

You can move the project and user files you need to open projects, bins, or user profiles on another Avid system by copying them to the same drive that holds the media files, or to some other removable device or network location. You can also transfer a Site Settings file between Avid systems.

Remember that moving project files and folders alone does not transfer the media files for the project.

When you transfer a project between Avid editing systems, ensure that:

- Both systems have the same release or a compatible release of an Avid editing application.
- The resolutions are compatible if you are transferring media files.
- The fonts used in the project are installed on both systems.

You can also share media files, projects, and bins between systems using Avid Interplay in an Avid Unity environment (for more information, see your Avid Interplay and Avid Unity documentation). In some circumstances, AFE files provide another option for transferring project and bin information. For more information, see “Exporting Projects and Bins Using AFE Files (Windows Only)” on page 1036.

To transfer project files and associated media files to another Avid system:

1. (Option) Consolidate the media for the project onto an appropriate drive for transfer to the other system. For more information on consolidating, see “Consolidating Media” on page 477.

2. Select the project folder, user folder, or Site Settings file you want to transfer (the folder uses the project name or user name you provide).

   You do not need to copy the Statistics folder, which is located in the project folder. This folder might be large and is not needed by the transferred project.
The default locations for application folders are listed in the following table. The exact location on your system depends on your Avid editing application, its version, and how it was installed on your system. For example, older versions store projects in an Avid Projects folder that is located in the same folder as the application.

<table>
<thead>
<tr>
<th>Folder or File</th>
<th>Location</th>
</tr>
</thead>
</table>
| Project folder | Private projects:  
  • (Windows) `drive:\Documents and Settings\Windows login name\My Documents\Avid Projects`
  • (Macintosh) Macintosh HD/Users/Mac login name/Documents/Avid Projects  
  Shared projects:  
  • (Windows) `drive:\Documents and Settings\All Users\Shared Documents\Shared Avid Projects`
  • (Macintosh) Macintosh HD/Users/Shared/Avid editing application/Shared Avid Projects |
| User folder | (Windows) `drive:\Program Files\Avid\Avid editing application\Avid Users`
  (Macintosh) Macintosh HD/Users/Shared/Avid editing application/Avid Users |
| Site Settings file | (Windows) `drive:\Program Files\Avid\Avid editing application\Settings`
  (Macintosh) Macintosh HD/Applications/Avid editing application/Settings |

3. Copy the folders or files you want to maintain at the new location onto a storage device or a location on a server.
   Alternatively, create a folder at the top level of the media drive and copy the folders or files to that folder.

4. If you are transferring a removable drive, quit your Avid editing application and shut down your system.

5. Remove the drives containing the media files, and take them and the storage device to the new location.

6. With the system at the new location turned off, insert or connect the drives and start the system.

7. Copy the folders or files to the appropriate folder.
   The folder locations might be slightly different, depending on the product and how it was installed. Ignore any Resource folders or files that appear.

8. Start your Avid editing application.
   The new project appears in the Project window. New user settings appear in the Users list. Site settings are active for all projects at the new location.
Do not open a project directly from the transfer device. You must copy the folder to the system drive first.

9. Select a user, open the project, and resume work.

Your Avid editing application reconstructs the MediaFiles database the first time you start to incorporate the new media into the system’s internal directory.

Do not rename the project folder. The project settings do not link to the project if you rename the project folder.

Nonshared Storage Issues for Cross-Platform Collaboration

When you share media files by using a nonshared storage device — either peer-to-peer, over a network, or using removable storage — the following restrictions apply:

- NTFS drives formatted on a Windows system can be accessed only on Macintosh systems running Mac® OS X 10.4 or later. Media files on these drives are read-only.
- Striped or nonstriped drives formatted as HFS or HFS+ on a Macintosh system can be read on a Windows system, if an application that lets Windows systems read the drives is installed on the Windows system.

To avoid problems when reading a connected HFS or HFS+ drive, do the following:

- On the Macintosh system, after transferring the media files to the HFS or HFS+ drive, give the media folder a name other than “OMFI MediaFiles” or “Avid MediaFiles”. You cannot change the name of the OMFI folder after you connect the drive to the system.
- Ensure the permissions on the HFS or HFS+ volume allow access to other users by doing the following:
  a. Select the drive in the Finder.
  b. Select File > Get Info.
  c. Select “Ignore ownership on this volume.”
- On the Windows system, after connecting the drive and transferring the media files to an NTFS drive, turn off the system, disconnect the drive, reboot, and then restart the Avid system.
Using the NRCS Tool
(Media Composer | NewsCutter Option)

The Newsroom Computer System (NRCS) tool lets you use one computer to view stories and rundowns located on an Avid iNEWS® server or on an Electronic News Production System (ENPS®) server and to edit sequences in your Avid editing application.

You use the NRCS tool to connect to an iNEWS server to access story scripts and to edit stories on a NewsCutter Option system. When you open a story in the NRCS tool, you can make formatting and content changes to the story instead of moving to an iNEWS workstation to do the editing. After you have made changes to the story, you can save the changes and make the story available to others using the same server. You can also access stories on the ENPS server from the NRCS tool, but you cannot make formatting or content changes to the stories.

Using the duration of the story, you can build a sequence in the editing application. Once you have the duration of the story in the Timeline, you can add footage to match the scripted story. After some quick video editing, the story is ready to air.

The following topics describe how to use the NRCS tool:

- Configuring the NRCS Tool
- Starting the NRCS Tool
- NRCS Tool Components
- Using the Directory Panel
- Changing the Text Display
- Editing Story Text (iNEWS Only)
- Finding the Read Time of a Story
- Sequences and Stories
- Associating a Sequence with a Story
- Adjusting the Story Timing (iNEWS Only)
- Using Associated Sequences
- Saving Changes to a Story (iNEWS Only)
- Using the Post to Web Feature
Configuring the NRCS Tool

You must configure the NRCS settings before you can connect to an iNEWS or an ENPS server.

(ENPS only) Your ENPS administrator must first register your Avid editing system as a client on the ENPS server. When you configure the NRCS tool, you use the client name to log in to the ENPS server.

For more information about options, see “NRCS Settings” in the Help.

Configuring the ENPS Server for Avid Clients

Three required elements must be set up on the ENPS server before the Avid editing system can connect as a client to the ENPS server:

- MOS ID
- Program
- IP address

The following procedures describe the minimum steps for configuring the ENPS server.

To create a MOS ID for the Avid editing system on the ENPS server:

1. Start the ENPS client application and log in as an ENPS administrator.
   You must have ENPS administrator server rights to perform system maintenance functions.

2. Each folder at the bottom of the ENPS client application contains a green dot, called a Rover. Click the fourth Rover from the left, and select System Maintenance > MOS Repeater Target.

3. Click New.

4. Type the new MOS ID in the text box, and click OK.
   The new ID must match the Avid editing system name exactly. This field is case-sensitive.
5. Fill in the following columns in the MOS Configuration window.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Type the description of the new client — for example, Avid editor.</td>
</tr>
<tr>
<td>IP Address</td>
<td>Type the IP address for the Avid editing system client.</td>
</tr>
<tr>
<td>Repeater ID</td>
<td>Select the Repeater ID (ENPS MOS Repeater Name).</td>
</tr>
</tbody>
</table>

To configure the running order:

1. Click the news group folder. Typically, this should be the third folder. Do not click the Rover.
   The group folder lists the running orders.
2. Double-click the running order you want the Avid editing system to access.
3. Click the title bar on the Running Order window.
4. Set the MOS Control field to active.
5. Click Go to save, and close the MOS Configuration window.
   A MOS icon appears in the lower left corner of the Running Order window.

Configuring the NRCS Settings

To configure the NRCS settings and to connect to the server:

1. Double-click NRCS in the Settings scroll list.
   The NRCS Settings dialog box opens.
2. Click the Server menu, and select an NRCS server:
   - iNEWS
   - ENPS
   The options that appear depend on the server selection.
The NRCS Settings dialog box also appears when you connect to a server if the active NRCS setting lists no name in the Server text box.

3. Type the name of the server.

4. (iNEWS only) If you selected the iNEWS server, type a default user name.

5. (Option) Select “Logout when NRCS Tool is closed” if you want to terminate the connection to the server every time you close the NRCS tool.

6. (iNEWS only) Select “Automatic update from server” if you want the information in the NRCS tool to update periodically.
   You can set the time interval used for updates by entering a time in the Update interval text box. The default is 1 minute.

7. Click the iNEWS or the ENPS tab to make additional changes to the NRCS settings.
8. (iNEWS only) Configure the Message-of-the-Day (MOTD) settings, Mail Directory, and Story Field Assignment values:

a. If you want to view the MOTD, select Show Message-of-the-Day, and select one of the following:
   - Every Connection (view the MOTD on every connection to the server)
   - First Connection (view the MOTD only on the first connection to the server)

b. If the MOTD is located in a different directory on the server, type the name of the appropriate directory in the Message-of-the-Day Directory text box.
   SYSTEM.MESSAGE is the standard directory on the iNEWS server for the message-of-the-day files. Type a different directory name only if your system administrator suggests doing so.

c. If you want to change the location of the Mail Directory, type the new directory name in the Mail Directory text box.
   SYSTEM.MAIL.OUT is the standard directory on the iNEWS server for sending e-mail messages. Type a different directory name only if your system administrator suggests doing so.

Contact your system administrator to ensure that the Mail Directory name is appropriate for use in your newsroom environment.
9. (iNEWS only) Select the default metadata used when creating a sequence with the NRCS tool:
   a. Clicking the Build Sequence button in the NRCS tool creates a new sequence with a duration determined by the value in the specified Story Form field. Enter a Story Form field name in the Duration text box. The default is the iNEWS tape-time field.

   The iNEWS server provides the Story Form headings in the NRCS tool. For more information on the Story Form, see “NRCS Tool Components” on page 1168.

   b. If the duration in the tape-time field is empty or is zero, you can set a default value for the duration of the new sequence by entering the default time you want for new sequences in the Default Value text box.

   c. Set the default Story Form fields used to display the Name and TapeID in the NRCS tool. The defaults are the iNEWS title and video-id fields, respectively.

10. (iNEWS only) You can modify the column headings displayed in the Directory panel of the NRCS tool by changing the iNEWS Story Form fields selected in the Browser Fields area. You can select a maximum of three column headings (the Name and Page headings can always be displayed and are not listed in the NRCS tool settings). For more information on iNEWS form field types, see the Avid iNEWS Newsroom Computer System Setup and Configuration Manual.

   a. In the Label text box, type the name of the column heading you want to display in the Directory panel.

   b. In the Field text box, type the name of the iNEWS Story Form field used to display the metadata for the appropriate column.

11. (iNEWS only) The Name column in the Story Form displays the story name. If you want the Name column to display the Index Field/Sort Field from iNEWS instead of the story name, select Show Index Field in “Name” column.

12. (ENPS only) Configure the Media Object Server identification (MOS ID) settings and Network Computer System identification (NCS ID):

   a. Do one of the following to set your MOS ID:
      ▶ Select Use Computer Name.
      ▶ Select Other and type a specific MOS ID you want to use.

      ENPS uses the MOS ID to recognize the client on the ENPS server. (This is most often the system name.) Type a different name only if your system administrator suggests doing so.

   b. Type the NCS ID of your server in the NCS ID text box.

      NCS ID is the assigned name of the ENPS system. Type the name that your system administrator supplies.
c. If you want to list running order names, including the Editorial Start date and time, select Show running order start date/time.

d. If you want to list story names, including the page number, select Show story page number.

e. In the Sequence Creation area, type the default time you want for the duration of new sequences in the Default Duration text box.

f. Select Show MOS ID if you want the MOS identification to display below MOS object cues in the Production panel.

13. Click the Post to Web tab to make additional changes to the NRCS settings by setting the appropriate options for your script.

For more information about options, see “NRCS Settings” in the Help.

14. Click OK to accept the NRCS settings.

Starting the NRCS Tool

To start the NRCS tool after it has been configured:

1. Select Tools > NRCS Tool.

   The NRCS tool opens.

2. Click the Connect button.
(iNEWS only) The NRCS Login dialog box opens for the iNEWS server. The iNEWS server name appears as part of the title bar text.

(ENPS only) The NRCS tool connects to the ENPS server. (A login dialog box does not appear for the ENPS server.)

3. (iNEWS only) If you did not set a default name in the NRCS Settings dialog box, type a user name.

4. (iNEWS only) Type the password.

5. (iNEWS only) Click OK.

If you selected Every Connection or First Connection in the NRCS Settings dialog box, the Message-of-the-Day dialog box opens.

6. (iNEWS only) Click Next to see the next MOTD.

7. (iNEWS only) Click OK to close the MOTD dialog box.

The list of directories appears in the Directory panel of the NRCS tool.

NRCS Tool Components

The following illustration shows the components of the NRCS tool that appear when the editing application connects to an iNEWS server.
The following illustration shows the components of the NRCS tool that appear when the editing application connects to an ENPS server.
Many of the concepts and options in the NRCS tool are similar to those of the iNEWS or the ENPS client application. For more information about the iNEWS or the ENPS client application, see the documentation that came with your server.

The following table describes the components of the NRCS tool.

<table>
<thead>
<tr>
<th>Component</th>
<th>Server Support</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connect/Disconnect button</td>
<td>iNEWS and ENPS</td>
<td>Establishes or cancels the connection to the iNEWS or the ENPS server.</td>
</tr>
<tr>
<td>Send Mail button</td>
<td>iNEWS</td>
<td>Opens a dialog box for sending mail to others in the iNEWS workgroup.</td>
</tr>
<tr>
<td>Component</td>
<td>Server Support</td>
<td>Description (Continued)</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>----------------</td>
<td>----------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Show/Hide Story Form triangular opener</td>
<td>iNEWS</td>
<td>Opens and closes the Story Form display.</td>
</tr>
<tr>
<td>Story Name text box</td>
<td>iNEWS and ENPS</td>
<td>Shows the directory path and name of the story.</td>
</tr>
<tr>
<td>Post To Web button</td>
<td>iNEWS and ENPS</td>
<td>Opens a dialog box for creating Web content from an iNEWS or an ENPS story.</td>
</tr>
<tr>
<td>Directory panel</td>
<td>iNEWS and ENPS</td>
<td>Lists the contents of the accessed news database.</td>
</tr>
<tr>
<td>Story form</td>
<td>iNEWS</td>
<td>Contains summary information about the story in predefined headings. The iNEWS server lets you alter the information in Edit mode only.</td>
</tr>
<tr>
<td>Edit/Save button</td>
<td>iNEWS</td>
<td>Provides access to editing functions and saves changes made to the story either by modifying the original story or by creating a new story. The changes are saved on the iNEWS server.</td>
</tr>
<tr>
<td>Cancel button</td>
<td>iNEWS</td>
<td>Cancels changes made to the story during the edit session and restores the story to the version saved on the server.</td>
</tr>
<tr>
<td>Formatting buttons</td>
<td>iNEWS</td>
<td>Changes the appearance of story text.</td>
</tr>
<tr>
<td>Cue Marking buttons</td>
<td>iNEWS</td>
<td>Inserts Production Cue markers into the story text and the production panel.</td>
</tr>
<tr>
<td>Mark IN/OUT button</td>
<td>iNEWS and ENPS</td>
<td>Sets IN and OUT points, corresponding to text selected in the Story panel, in the Timeline.</td>
</tr>
<tr>
<td>Build Sequence button</td>
<td>iNEWS and ENPS</td>
<td>Builds a sequence in the Timeline:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- (iNEWS) Uses the duration specified in the Story Field Assignment text boxes of the NRCS settings. The default Story Field is Tape-Time, or 30 seconds if the Story Field tape time value is zero. (Tape time in the NRCS tool corresponds to duration of the sequence in the Timeline.)</td>
</tr>
<tr>
<td>Find Sequence button</td>
<td>iNEWS and ENPS</td>
<td>Locates a sequence associated with a story.</td>
</tr>
<tr>
<td>Read Time display</td>
<td>iNEWS and ENPS</td>
<td>Displays the amount of time to read the selected text on air, based on the read rate.</td>
</tr>
</tbody>
</table>
Using the Directory Panel

In the Directory panel, you move through the directories on the iNEWS or the ENPS server. The following sections describe the functions you can perform in the Directory panel.

Opening a Story

After you establish a connection to the iNEWS or the ENPS server, the Story panel remains blank until you open a story.

If you work with stories on the iNEWS server, the Directory panel can display information from iNEWS story form fields. By default, the following form fields can display in the Directory panel:

<table>
<thead>
<tr>
<th>Column Heading</th>
<th>Description</th>
<th>iNEWS Form Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page</td>
<td>The page number, if any, assigned to the story</td>
<td>page-number</td>
</tr>
<tr>
<td>VideoID</td>
<td>The tape number or clip identification number</td>
<td>video-id</td>
</tr>
<tr>
<td>Status</td>
<td>Event errors and play status</td>
<td>event-status</td>
</tr>
</tbody>
</table>

You can also use the NRCS tool settings dialog box to change the form fields that display in the Directory Panel. See “Configuring the NRCS Settings” on page 1163.

To open a story:

1. Navigate through the directories to the file you want to open.

   The panel organizes directories in a tree hierarchy, with stories as the base item in the tree.

   The divider between the Production and Story panels can be moved horizontally to expand or contract each panel.
(ENPS only) A small green light flashes on the Disconnect button as the tool receives stories from the server. Directory stories first display gray in the list, then display black when they become available.

2. Do one of the following:
   - Double-click the story name.
   - Click the story name and press Enter.

   The story’s text appears in the Story panel.

**To display story information in the Directory panel:**

   - Right-click the column heading row and select the appropriate options.

   The selected column displays in the Directory panel. You can hide columns by right-clicking the column and deselecting it.

**Using Shortcuts with Directories (iNEWS Only)**

You can save time accessing directories you use often by creating shortcuts to directories in the Directory panel.
To create a shortcut to a directory:

1. Navigate to the directory.

2. Right-click the directory name, and select Make Shortcut.

The NRCS tool creates the shortcut, which appears in italic above the server name in the Directory panel.

![Image of a shortcut above a server name in the Directory panel]

To remove a shortcut to a directory:

- Right-click the directory name, and select Remove Shortcut.

The shortcut is removed.

Deleting a Story (iNEWS Only)

The NRCS tool lets you delete a story without having to go through the iNEWS workstation, if your iNEWS User settings have the necessary permissions. If you are unsure of your settings, see your system administrator.

To delete a story:

1. In the Directory panel, do one of the following:
   - Right-click the story you want to delete and select Delete File.
   - Select the story and press the Delete key.

   A message box opens.

2. Do one of the following:
   - Click Delete to complete the deletion.
   - Click Cancel to stop the deletion.

Changing the Text Display

You can change the screen display of the entire text of a story without entering Edit mode. The shortcut menu that opens when you right-click in the Story panel lets you change the font and point size of the text.
You save the font and point size with the current NRCS settings, but the changes apply only to the local client. Settings on the iNEWS or the ENPS server do not change.

To alter the appearance of the text in your story:
- Select the text in the Story panel, right-click, and select a font and point size.

Editing Story Text (iNEWS Only)

You can use the NRCS tool to perform basic editing functions on your stories, eliminating the need to do the work on the iNEWS workstation and saving valuable time in the editing process.

*Edit mode functions are not available when the client is connected to an ENPS server.*

When you edit a story, the NRCS tool locks the story on the iNEWS server so no other users can edit the story at the same time. If the story is already locked — for example, if another user is currently editing it — an error message informs you that the story is locked.

If you want to discard the changes made to a story, you can click Cancel and the last-saved version of the story is restored on the iNEWS server. If you load a second story prior to saving your edits, a dialog box warns you that you will lose changes made to the story. You can discard your changes by loading the second story, or you can cancel the action and then save your edits before opening the new story.

To enter Edit mode:
- Click the Edit button.
  The NRCS tool acquires a story lock. An error message informs you if the story is already locked.

To cancel changes made to the story:
- Click the Cancel button.
  Changes made to the story during the edit session are cancelled and the story is restored to the version saved on the server.

Rearranging Text in a Story (iNEWS Only)

The shortcut menu provides commands for cutting, copying, pasting, and deleting text.

To rearrange the text in a story:
1. Select the text you want to cut, copy, or delete.
2. Right-click the text, and select the appropriate command.
3. Position the cursor in the story where you want to paste the text.
4. Right-click, and select Paste.

**Marking Text (iNEWS Only)**

You can mark certain text in your story for the purposes of machine code, closed captions, or presenter instructions. Text marked for these functions does not contribute to the read time of a story. For more information, see “Finding the Read Time of a Story” on page 1180.

- **Machine Control** — Machine control text appears blue. You can mark text as Machine Control only in a Production Cue text box. See “Adding a Production Cue (iNEWS Only)” on page 1177.
- **Closed Caption** — Closed-captioned text appears green in the Story panel. Like Presenter Instructions, the presenter does not read this text on camera.
- **Presenter Instructions** — Presenter instructions text appear red, allowing the presenter who reads the story on camera to differentiate the instructions from the actual script. Using this formatting option, for example, you can mark lines referring to a voice-over that accompanies footage.

**To mark text as Machine Control:**

1. Select the text in the Production Cue text box that you want to mark.
2. Do one of the following:
   - Click the blue Machine Control button.
   - Right-click the text, and select Machine Control.

   The text changes to blue, indicating machine controls.

**To mark text as Closed Caption:**

1. Select the text you want to mark.
2. Do one of the following:
   - Click the Closed Caption button.
   - Right-click the text, and select Closed Caption.

   The text changes to green, indicating closed captions.

**To mark text as Presenter Instructions:**

1. Select the text you want to mark.
2. Do one of the following:
   - Click the Presenter Instructions button.
   - Right-click the text, and select Presenter Instructions.

   The text changes to red, indicating Presenter Instructions.
Formatting Text (iNEWS Only)

You use a combination of the formatting buttons and the shortcut menu to change the format of story text.

If you have applied formatting to text, you can remove the formatting by deselecting the applied format or by marking the text as Normal.

To format text:
1. Select the text you want to format.
2. Do one of the following:
   - Click the Underline (U), the Italic (I), or the Bold (B) button.
   - Right-click the text, and select Underline, Italic, or Bold.

To remove text formatting:
1. Select the formatted text.
2. Do one of the following:
   - Click the Underline (U), the Italic (I), or the Bold (B) button to deselect it.
   - Right-click the text, and reselect Underline, Italic, or Bold.

To mark text as Normal:
1. Select the text from which you want to remove the formatting.
2. Do one of the following:
   - Click the Normal button.
   - Right-click the text, and select Normal.

The text changes to black, indicating that the text contains no formatting.

Adding a Production Cue (iNEWS Only)

Production cues are playback instructions for devices such as video machines, still stores, and character generators. When you insert production cues, they appear in the Production panel. In addition, a Production Cue marker appears in the story text to indicate where each production cue belongs in the story.

If you want to delete a production cue, you must delete the Production Cue marker, not just the text within the Production Cue text box.
Two production cues in the Production panel and corresponding Production Cue markers in the Story panel

**To insert a production cue into your scripted story:**

1. In the Story panel, move the pointer next to or within the text where you want to place the production cue.
2. Right-click, and select Insert Production Cue.
   - A blue asterisk marker appears within the Story panel, and a blank box opens in the Production panel.
3. Type the cue information in the text box.

**To delete a production cue:**

1. Select the Production Cue marker in the Story panel.
2. Do one of the following:
   - Press the Delete key.
   - Right-click the marker, and select Delete.

**Using Loaded Cues (iNEWS Only)**

You can create links to clips and sequences directly from your story. These links, called loaded cues, act as pointers within the script to master clips stored in bins. Using loaded cues, you can move clips or sequences between your script and bins as you edit your story.
You must be in Edit mode to add a loaded cue to your story. For information on entering edit mode, see “Editing Story Text (iNEWS Only)” on page 1175.

*When used with the Post to Web feature, loaded cues become links to video clips accessible to users over the Web (see “Using the Post to Web Feature” on page 1189).*

You can also view the head frame of a loaded cue in the Production Cue text box, and change the size of the head frame display. Enlarging or reducing the size of the head frame affects all head frames in the Story panel.

**To create a loaded cue:**

1. Select the clip or sequence you want to use as a loaded cue.
2. Click the file and drag it to the Story panel. Position it in the script at the point where you want the cue.

A Production Cue marker appears within the Story panel, and a Clip icon and clip name appear in the Production Cue text box.

**To view a head frame of a loaded cue:**

- Right-click the clip icon in the Production Cue text box and select Show HeadFrames.

**To change the size of the head frame, do one of the following:**

- Select Edit > Enlarge HeadFrames or Edit > Reduce HeadFrames.
Finding the Read Time of a Story

- Right-click the clip icon on the Production Cue text box and select one of the following:
  - Enlarge HeadFrames
  - Reduce HeadFrames

**To use a loaded cue:**
- Click the Production Cue text box and drag it to a bin or to the Source/Record monitor.
  - The clip or sequence appears in the bin or in the Source/Record monitor. You can then use and edit it like any other clip or sequence.
  - If the NRCS tool cannot find the clip or sequence, you receive an error message and the clip or sequence will not be loaded. If the clip or sequence cannot be found on your local media storage and you are in an Avid Interplay environment, the NRCS tool downloads the clip or sequence.

**To delete a loaded cue:**
1. Select the Production Cue marker in the Story panel.
2. Do one of the following:
   - Press the Delete key.
   - Right-click the marker, and select Delete.
  - The loaded cue is removed from the NRCS script.

**Finding the Read Time of a Story**

The NRCS tool calculates the read time of a story by using the number of words in the story and the read rate in words per minute (wpm) of the presenter.

The default wpm rate is 180, but it can differ according to the settings for a particular story.

- (iNEWS) The Presenter text box in the story form determines the read rate.
- (ENPS) The presenter and read rate can be included as production cues.

*If you want to change the wpm rate for the presenter, you must make the changes through the iNEWS or the ENPS workstation. If you want to change the presenter for an iNEWS story, you can edit the name in the Presenter text box and save the changes.*

*The NRCS tool does not include Closed Caption or Presenter Instructions text in the read time. Only text marked as Normal (including bold, italic, or underlined text) is calculated.*
To calculate the read time of a story:

1. Move the pointer to the Story panel.
2. Do one of the following:
   - Right-click, and select Select All.
   - Select a portion of the text with the mouse.

The read time appears in the upper right corner of the NRCS tool.

If you have ToolTips enabled, the current wpm rate appears in the label for the Read Time display. For more information on ToolTips, see “” on page 1508.

Example of a read time calculation for selected text in the Story panel. The read time appears in the Read Time display (right) and is calculated based on the presenter identified in the Presenter text box (left).

Sequences and Stories

The NRCS tool lets you create a new sequence with a length that corresponds to a particular story. This feature makes it very easy to edit in shots and to create a sequence quickly according to the duration of the story.

(iNEWS) The Tape-Time text box in the story form of the NRCS tool corresponds to duration in your Avid editing application’s Timeline.

(ENPS) The first MOS media item in the story determines the sequence duration.
Consider the following when you place clips in the new sequence:

- The NRCS tool processes loaded cues in the order they appear in the story text. The tool edits only those that appear before the end of the text (and before the end of the sequence) into the sequence.
- The NRCS tool uses the read time of the text up to the anchor point for the loaded cue to determine the placement of the Timeline position bar for each edit. The clip’s IN to OUT points determine the edit length.
- Performs an Overwrite edit.
- As you edit the series of clips into the Timeline, you overwrite the ends of the earlier clips. The time separation of the anchors in the story text set the lengths of the clips.

**Building a Sequence from a Story**

**To build a sequence from a story:**

1. Open the bin in which you want to place your sequence.

2. Do one of the following:
   - Select the story in the Directory panel, and drag the story to the open bin.
   - Select the story in the Directory panel, right-click, and then select Build Sequence from Story.
   - Click the Build Sequence button.

   The Build Sequence button is active only when the Story panel displays a story and the computed duration is not zero.

The editing application creates a sequence in the open bin with the same name as the story. (iNEWS only) An identifier appears in the NrcsID column in the bin, specifying the story associated with the new sequence (see “Using Associated Sequences” on page 1188).

(iNEWS only) The Tape-Time text box determines the duration of the sequence. If you want to build a sequence with a different duration, you must first edit the Tape-Time text box and save the story. The video-ID field of the story provides the value for the sequence’s tape ID bin column.

*Sequences created with any of these methods have a fixed minimum length. You can lengthen the sequences (by adding clips) but not shorten them.*

(iNEWS) If you select a story from the Directory panel, the editing application creates a sequence even if the Tape-Time text box is blank or zero. If the Tape-Time text box for the story is blank, the duration of the sequence defaults to 30 seconds. If the Tape-Time text box is set to 0:00, the duration of the sequence created is 0 seconds.
(ENPS) The new sequence is built from the first media item in the story. The length of the media item becomes the sequence’s duration, and the tape ID is also assigned. You can create a sequence from any MOS media item in the story by dragging the item’s production cue to a bin (known as loaded cues in iNEWS).

3. (Option) If you Shift+click the Build Sequence button, a new bin will be created to hold the new sequence (named after the sequence).

(iNEWS only) If there are loaded cues in the story, the editing application automatically edits them into the sequence.

Script-Based IN and OUT Points

You can use the Mark IN/OUT button to place IN and OUT points in the Timeline based on text highlighted in the NRCS tool. You can then use the IN and OUT points as a guide to build a sequence.
The editing application bases the length of the created sequence on an assigned duration, associated with the story. The editing application bases the position of the IN and OUT points on an approximate calculation, depending on the word count and the assumed read time. The assigned sequence length and the computed story length might not be the same.

You can create a sequence longer or shorter than the actual read time of the story.

**Setting Timeline IN and OUT Points Based on Story Timing**

The NRCS tool can use its calculated story timing to set IN and OUT points in the sequence loaded in the Timeline.

**To set IN and OUT points based on the story timing:**

1. Load the appropriate sequence in the Timeline.
2. Select a portion of the text in the Story panel.
   
   The read time of the selected text appears in the upper right corner of the NRCS tool.

3. Click the Mark IN/OUT button.
   
   The NRCS tool places IN and OUT points in the Timeline, based on the computed read time of the selected text.
You can use the Timecode pop-up menu to compare the IN and OUT points. For more information on using the Timecode display, see “Using the Timecode Window” on page 523.

### Associating a Sequence with a Story

In addition to using the NRCS tool to create a new sequence, you can associate an existing sequence with an iNEWS or an ENPS story. This lets you create a video sequence in the editing application, and then later associate it with a story in the iNEWS or ENPS database. You can associate only one sequence with a story, which then transfers metadata — such as the information in the fields of the iNEWS story form — from the story to the existing sequence. For example, when you associate a sequence with a story, you transfer the data from the Video ID field for the story to the Tape ID column for the sequence. When you then send the sequence to playback, the NRCS tool automatically sends the correct ID information to the playback device.

Before you associate a sequence with a story, you must use the NRCS tool to connect to either an iNEWS or an ENPS database. You can use any sequence available to your Avid system, including those stored remotely and accessed from the Interplay window.

**To associate a sequence with a story:**

1. Open your story.
   
   For information on opening stories in the NRCS tool, see “Opening a Story” on page 1172.

2. Open the bin or Interplay folder that holds your sequence.

3. Right-click the sequence and select Associate with current NRCS story.
   
   The menu option is active only when a story is displayed in the Story panel of the NRCS tool.

   The tool renames the sequence in the bin and transfers the following NRCS story information.

<table>
<thead>
<tr>
<th>Information from Story</th>
<th>Column Heading in Bin or Interplay Folder</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video ID</td>
<td>Tape ID</td>
</tr>
<tr>
<td>Slug (Story name)</td>
<td>Name (of sequence)</td>
</tr>
<tr>
<td>Full story path</td>
<td>NrcsID (iNEWS only)</td>
</tr>
</tbody>
</table>

You cannot undo this action. If you want to associate a different sequence with your story, select a new sequence and repeat the procedure.

The new sequence becomes an associated sequence, which lets you open it by using the Find Sequence button in the NRCS tool (see “Using Associated Sequences” on page 1188).
Adjusting the Story Timing (iNEWS Only)

You might want to adjust the story timing in cases where you use the Mark IN/OUT button to set In and Out points in the Timeline based on the story text timing.

For example, if your story has introductory text that you do not want included in the sequence, you can set In and Out points in the sequence so that the extra text offsets the computed times.

You must be in Edit mode to insert timing cues in a story. For information on entering edit mode, see “Editing Story Text (iNEWS Only)” on page 1175.

To correct computed times offset by extra text:

- Add a Time Marker cue with a value of 0:00 just before the start of the relevant text (corresponding to the sequence being built).

Adjusting the Story Timing with a Time Marker (iNEWS Only)

Because the calculated story timing might not exactly match the required sequence or clip duration, the NRCS tool lets you add cues to assign a specific time to a point in the text.

To add a cue to the text that assigns a specific story time:

1. In the Story panel, right-click where you want to add a Time Marker cue, and select Insert Time Marker.
   The Time Marker dialog box opens.
2. Type the time you want to assign to that point in the text.
3. Click OK.

   A Time Marker cue appears in the story text, and a corresponding production cue appears with an equal sign (=) and the specified time value.

   Any read-time calculations now take the Time Marker cue into account.

Adjusting the Story Timing with a Time Pad (iNEWS Only)

Because the calculated story timing might not exactly match the required sequence or clip duration, you can specify the duration of the media clip by adding a Time Pad cue to the sequence. The Time Pad cue inserts cues in the text, based on the In and Out points.
For example, if part of the story has a video clip but no corresponding text, this creates an offset of the timing of any following text. You can fix this by adding a Time Pad cue at the point where the video clip occurs (using the clip duration as the value).

You must be in Edit mode to insert timing cues in a story. For information on entering edit mode, see “Editing Story Text (iNEWS Only)” on page 1175.

To add a cue that inserts a Time Pad cue at a point in the text:

1. In the Story panel, right-click where you want to add a Time Pad cue, and select Insert Time Pad.

2. Do one of the following:
   - Select the default time, if you want the Time Pad cue to match the time between the In and Out points in the clip loaded in the Source/Record monitor.
   - Select Other, if you want to specify another time.

The Time Pad dialog box opens.

3. (Option) If you selected Other, type in the Duration text box the amount of time you want to assign to that point in the text.

4. Click OK.

A Time Pad cue appears in the story text, and a corresponding production cue appears with a plus sign (+) and the specified time value.

Any read-time calculations now take the assigned time into account.
Using Associated Sequences

The NRCS tool lets you locate sequences associated with NRCS stories or, conversely, to locate stories from their associated sequences. This makes it easier to find stories on your iNEWS or ENPS server (for example, when the tape ID is unknown) or to load sequences for NRCS scripts directly into the Timeline.

(iNEWS) Only sequences created with the NRCS tool and which have valid identifiers in the NrcsID bin column can be associated with a story.

(ENPS) The associated sequence is located by the information in the Tape ID text box.

To locate a sequence associated with a story:

1. From the Directory panel, load a story into the Story panel.
2. Click the Find Sequence button.

   The NRCS tool loads the sequence into the Timeline, opening the bin holding the sequence, if necessary.

To locate a story associated with a sequence:

1. Select a sequence in an open bin.
2. Click the sequence and drag it to the Story Name text box in the NRCS tool.

   The tool loads the story into the Story panel.

Saving Changes to a Story (iNEWS Only)

After you edit a story, you can save the modified story. Keep in mind, though, that when you save a story in the NRCS tool, the action actually saves the story on the iNEWS server. Therefore, use caution when saving a story because your changes might affect others using the same story. Changes cannot be saved to the ENPS server.

If more than one person accesses a story at the same time, the NRCS tool only saves changes made by the first person to save the story.

Your iNEWS user permissions define whether you can save changes to a story. If you are unsure of your permissions, consult your system administrator.

To save changes, do the following:

- In Edit mode, click the Save button.

  The system saves the story and updates the story on the iNEWS server.
Using the Post to Web Feature

You can use the NRCS tool to generate a hypertext version of your iNEWS or ENPS story for viewing on the World Wide Web. The Post to Web feature helps you to create Internet content directly from a single script rather than requiring the production of dual content, one for broadcast and one for the Web.

When you post a story to the Web, the resulting Web page can include the text of your iNEWS or ENPS story, formatting provided by user-designed templates, and links to videos and images.

Processing the Script for Post to Web

Traditionally, broadcast scripts utilize uppercase letters to make them display clearly in a prompter. Post to Web can automatically change a story’s script to lowercase letters, with the exception of the first letter of each sentence. Additionally, Post to Web deletes text elements designed specifically for broadcast stories, such as Presenter Instructions and Closed Caption.

Post to Web processing does not recognize proper nouns, acronyms, or terms that require special formatting. Stories require manual editing of the text before you can use the finished file as a Web page.

You can control how the NRCS tool converts a story for Web display by selecting options in the NRCS Settings dialog box. For more information on processing the script, see “Configuring the NRCS Tool” on page 1162 and “Creating a Web Page for Post to Web” on page 1189.

Creating a Web Page for Post to Web

You can convert text from your story into a Web page, or you can create a Web page without an iNEWS or an ENPS story loaded in the NRCS tool.

To create a Web page from an iNEWS or an ENPS story:

1. Load a story into the Story panel.
2. Click the Post To Web button.
   The Post To Web dialog box opens with the story script displayed in the Story text box of the Story tab.

   Loaded cues are highlighted in blue within the text box. See “Using Loaded Cues (iNEWS Only)” on page 1178.
3. Edit the script in the Story text box.
4. (Option) Click the Lowercase button to convert the story if Post to Web does not automatically reformat the script (for example, if you did not select the Always option in the Post To Web tab in the NRCS Settings dialog box).

The Lowercase button appears only if Post to Web did not convert the story to lowercase characters.

**To create a Web page without a preloaded story:**

1. Click the Post To Web button.
2. Do one of the following:
   - Cut or copy text from another document and paste it into the Story text box.
   - Type the text of your story in the Story text box.

**Linking Clips for Post to Web**

Post to Web lets you link additional clips to the text of your story for inclusion in a Web page.

(iNEWS only) When you post a story to the Web, loaded cues in the iNEWS story become links to clips stored on your Web server. However, you might have other footage for your story that you want to add for viewing on the Web. Post to Web provides a way to link these clips to the Web page generated from your story.

**To create a linked clip:**

1. Load a story into the Story panel.
2. Click the Post To Web button.
   
   The Post To Web dialog box opens.
3. Do one of the following:
   - Select the text in the Story text box that you want to associate with a clip, click the Linked Clip menu, and select a clip.
   
   The selected text is highlighted in blue and becomes a link to the clip.
Example of linking a clip to text, showing selected text (top) and the Linked Clip menu (bottom)

- Select the text in the Story text box that you want to associate with a clip, right-click in the story text, and select Link > clip.

The Link submenu lists loaded cues and any sequences associated with your story. The menu updates whenever you add clips to the Story text box.

The selected text is highlighted in blue and becomes a link to the clip.
Using the Post to Web Feature

The Link submenu in the Post to Web dialog box

- Click a clip and drag it from an open bin to the Story text box.

  Post to Web creates a link wherever you place the selection cursor. If you selected text in the Story text box before dragging in the clip, the tool highlights the selected text and creates a link. If you did not select any text, the tool inserts the name of the clip and creates a link.

- If you hold the Shift key down while dragging a clip from a bin, you can place the clip anywhere in the story and Post to Web ignores any selected text.

**Understanding Post to Web Templates**

The Template tab of the Post To Web dialog box lets you format your story with a Web-formatted template. This permits a client or a Web designer to customize templates in response to the needs of broadcasters and viewers.

Templates provide a way to organize features common to all Web stories. For example, a template can place headlines in the same place relative to the text of a story, using the same font and style as similar stories on a Web page. Post to Web arranges these features into fields where you can enter necessary information before producing the finished content for your Web site.
The template descriptions in this section refer to HTML coding only as an example. The Web page templates used by Post to Web can be in any formatting language, for example XML.

Templates include tags that Post to Web uses to convert your story into a Web page:

- `< ! - - STORY - - >`
- `< ! - - TEXT - - >`
- `< ! - - CLIP - - >`
- `< ! - - VIDEOFORMAT - - >`
- `< ! - - HYPERCLIP - - >`

Do not include HTML comment tags within the format elements.

These tags use placeholders to insert text and media files in the Web page created when you post a story to the Web. Some tags allow for using text from labeled fields in the Post to Web template. You can add optional formatting elements such as HTML tags (for example, table tags), which can precede or follow the placeholders. You can specify the text and media files to be included in your Web page by using the following placeholders:

- `$TEXT$
- `$URL$
- `$URLn$
- `$IMGURL$

Avid provides generic HTML templates in the following location:

`drive:\Program Files\Avid\Utilities\PostToWeb_Sample_Templates`

Using the Story Tag in Post to Web Templates

You use the Story tag and the `$TEXT$` placeholder to put the text of your formatted story in a Web page. When Post to Web creates your Web page, it inserts the story where the placeholder is located in the source template. The Story tag takes the following form:

`< ! - - STORY format elements $TEXT$ - - >`

The Story tag uses the `$TEXT$` placeholder, which is replaced by the text of your story from the Story text box in the Post To Web dialog box.

If you do not include any format elements, `$TEXT$ is assumed—for example, `<!/ - - STORY - - >`. 
Using the Text Tag in Post to Web Templates

You use the Text tag to position headlines, headings, subheadings, captions, or other text elements on your Web page. The Text tag takes the following form:

```
< ! - - TEXT “Label” format elements $TEXT$ - - >
```

Labels appear in the Field column of the Template tab in the Post To Web dialog box. In creating a Web page, Post to Web replaces $TEXT$ with the user-supplied text associated with a field in the Text column of the Text Fields tab in the Post To Web dialog box.

If you do not include any format elements, $TEXT$ is assumed—for example, `<!- - TEXT “Label” - - >`.

If you do not enter any text for a text field, the output page omits the corresponding text tag in the template, including any page formatting code in the format elements.

The following examples show a Text tag as it appears in a template, in the template fields in the Post To Web dialog box, and in the HTML code generated by the template.

Text tag in a template ($TEXT$ is the placeholder for text):

```
<!- -TEXT “Headline”<B>$TEXT$</B>-->
```

The Label (left) and the user-supplied text (right) that replaces the $TEXT$ placeholder
Using the Post to Web Feature

The HTML code showing the Post to Web output:

```html
<B>Wetlands Controversy</B>
```

### Using the Clip Tag in Post to Web Templates

You use the Clip tag to create links to media files stored on a server. When you link a video clip to your story (see “Linking Clips for Post to Web” on page 1190), Post to Web automatically creates a Uniform Resource Locator (URL) for the clip. The Clip tag inserts the URL into the Web page. You can also include text, such as captions, to accompany the media. The Clip tag takes the following form:

```html
<! - - CLIP “Label” format elements placeholder- - >
```

Labels appear in the Field column of the Template tab in the Post To Web dialog box. The placeholder specifies the media file or text displayed on the Web page. The Clip tag can use the following placeholders:

- `$URL$, which is replaced by the URL of a movie clip
- `$URLn$, where $n$ is an integer (1 to 9) which matches a clip to its associated video format (see “Using the Videoformat Tag in Post to Web Templates” on page 1196)
- `$IMGURL$, which is replaced by the URL of a graphics file created from the head frame of a movie clip
- `$TEXT$, which is replaced by user-supplied text

If you do not include any format elements, `$URL$` is assumed—for example, `<! - - CLIP “Label” - - >`.

If you do not specify a clip for one of the video fields, the corresponding clip tag in the template will not be included in the output page. This includes any page formatting code in the format elements.

The following examples show a Clip tag as it appears in a template, in the template fields in the Post To Web dialog box, and in the HTML code generated by the template.

Clip tag in a template (`$URL$` is the placeholder for a URL reference to a clip and `$TEXT$` is the placeholder for text):

```html
<!- - CLIP “Related Video 1”<P><A HREF="$URL$"><B>$TEXT$</B></A></P>-->
```
Using the Post to Web Feature

The Label (left), the clip name (center) that is the basis for the URL, and the user-supplied text (right) that replaces the $TEXT$ placeholder

The HTML code showing the Post to Web output:

```html
<P><A HREF="WETLANDS1.mov"><B>Wetlands Controversy Brews</B></A></P>
```

Using the Videoformat Tag in Post to Web Templates

You use the Videoformat tag to link encoding formats to video clips. The Post tab of the Post to Web window includes an Export Settings section which displays two columns: the left column shows the video format labels called by the template, and the right column shows the Export settings you have implemented for those formats.

If a format label matches a setting name, it is selected by default.

The Videoformat tag takes the following form:

```html
<! - - VIDEOFORMAT n = “Label” [n = “Label”] - - >
```

In this tag, \textit{n} is an integer (1 to 9) which identifies the video format that displays in the left column of the Export Settings field in the Post tab. This number is used by a placeholder ($URLn$) inside the Clip tag to associate a video format with a specific clip. “Label” is a field name specified in the template, and it appears in the left column of the Export Settings field in the Post tab.

The Videoformat tag applies to the whole template. To use multiple formats in a single Web page, use the tag and the placeholder to define more than one export setting and encoding.
The following example shows a Videoformat tag as it appears in a template, in the Post field in the Post To Web dialog box, and in the HTML code generated by the template.

Videoformat tag in a template ($URL1$ and $URL2$ are the placeholders associated with the integers in the videoformat tag):

<!-- VIDEOFORMAT 1="Low Bandwidth" 2="High Bandwidth" -->

<!-- CLIP "videoclip" -->

<A HREF="$URL1">For Dial-up Connections</A>

<A HREF="$URL2">For DSL/Cable Connections</A> -->

The Export Settings in the Post to Web dialog box

The HTML code showing the Post to Web output:

<P><A HREF="ParisStudents.mov">For Dial-up Connections</A></P>

<P><A HREF="ParisStudents1.mov">For Dial-up Connections</A></P>

Using the Hyperclip Tag in Post to Web Templates

You use the Hyperclip tag to include information and formatting for any linked clips in your story. When you link a video clip to your story (see “Linking Clips for Post to Web” on page 1190), Post to Web lets you add HTML formatting (for example, table tags), JavaScript code, text, or other elements. The Hyperclip tag applies to all linked clips in the story and takes the following form:
< ! - - HYPERCLIP format elements placeholder - - >

The placeholder specifies the media file displayed on the Web page. The Hyperclip tag can use the following placeholders:

- $URL$, which is replaced by the URL of a movie clip
- $URLn$, where $n$ is an integer (1 to 9) which matches a clip to its associated video format (see “Using the Videoformat Tag in Post to Web Templates” on page 1196)

If you do not include any format elements, $URL$ is assumed—for example, <!--HYPERCLIP --> creates a link to a clip without providing any formatting or other information for the clip.

The following examples show a Hyperclip tag as it appears in a template and in the HTML code generated by the template.

Clip tag in a template ($URL$ is the placeholder for a URL reference to a clip and $TEXT$ is the placeholder for text):

<!--HYPERCLIP HREF="$URL$" onMouseOver="window.status='Click for video';return true"-->

The HTML code showing the Post to Web output:

<A HREF="ParisStudents.mov" onMouseOver="window.status='Click for video';return true"></A>

Using a Template with Post to Web

To format a story with a Web template:

1. Load a story into the Story panel.
2. Click the Post To Web button.
   
   The Post To Web dialog box opens.
3. Click the Template tab.
4. Do one of the following:
   - Click the Template menu, and select a template.
     
     The menu lists the most recently used templates.
   - Click the Browse button, and select a template from the appropriate folder.
   - Use Windows Explorer to locate a template file, then click the template file and drag it to the Template text box.
5. Click the Text Fields tab.
6. For any display fields, click in the text column to the right of the field name and type any text you want displayed on the Web page.

   The specific template you use defines which fields are displayed in the Text Fields and Video Fields tabs.

7. Repeat step 6 for each field you want to customize.

8. Click the Video Fields tab.

9. Select an item in the field and do one of the following:
   - Click a clip and drag it from an open bin. Place it in the appropriate row.
   - Right-click in the Clip column, and select a clip.

10. (Option) If the field has a Text column, click the column to the right of the field, and type any text you want displayed with the clip on the Web page (for example, a caption).

**Posting a Story to the Web**

When you post a story to the Web, Avid editing applications create one or more of the following files:

- A Web page file for the story, formatted from a template
- Video clips, created using either Interplay ProEncode or Avid editing application’s export settings
- Image files taken from the head frame of each clip (as displayed in the bin using Frame view)

Once you apply a template to your script (see “Understanding Post to Web Templates” on page 1192), you need to set the options used for exporting the media files that accompany the story. If you have configured Avid Interplay Media Services in your Interplay environment, you can use the ProEncode option for Post to Web. For information on ProEncode, see “Using Avid Interplay Media Services” on page 1053 and the *Avid Interplay Media Services Setup and User’s Guide*.

You can also export clips through Avid editing systems with the Direct Export option. In this case, you set export options through the Export Settings dialog box. For more information on export settings, see “Exporting With the Export Command or the Drag-and-Drop Method” on page 1028 and “Customizing Export Settings” on page 1032.

**To post a story to the Web:**

1. Load a story into the Story panel.
2. Click the Post To Web button.

   The Post To Web dialog box opens.
3. Click the Post tab.

4. Select either the ProEncode or the Direct Export option.
   If you use Direct Export, and the format you want for your video clips does not appear in the menu, click the Options button and select a format from the Export Settings dialog box.

5. In the Video area, click the Format menu and select a video format.
   ProEncode formats are supplied by the Media Services broker. The format name must include the file name extension enclosed in brackets; for example, “low bandwidth QuickTime [.mov].” Only formats marked with bracketed file extensions are available for use with Post to Web.
   For ProEncode formats, the Options button applies only to the QuickTime reference movie sent to ProEncode. To edit the video format settings for ProEncode output, see the *Avid Interplay Media Services Setup and User’s Guide*.

6. In the Image area, click the Format menu, and select a graphics format for the images associated with the video clips.

7. (Option) Click the Options button, and select options as described in “Transferring Project and Media Files Between Avid Editing Systems” on page 1155.
   If the format you want for your images does not appear in the menu, click the Options button, and select a format from the Export Settings dialog box.
8. In the Web Server area, do one of the following:
   ▶ Click the Server Path menu, and select a server or shared volume folder.
       The menu lists the most recently used folders.
   ▶ Click the Browse button, and select a new server or shared volume folder.
   ▶ Use Windows Explorer to locate a folder, and then click the folder and drag it to the
     Server Path text box.

9. (Option) Type a name in the Folder text box for the destination folder of the Web page file
    created by Post to Web.
    If you do not specify a name, Post to Web uses the story name as the default folder name.
    Post to Web assigns the name in the Folder text box to the Web page file created when you
    post the story to the Web.

10. Click the Post button.
    Post to Web creates the text file formatted for the Web, links video clips and image files, and
    stores them in the folder specified in the Post tab of the Post To Web dialog box.

**Sending and Receiving NRCS Mail (iNEWS Only)**

The NRCS tool contains a mail application that lets you send mail to other iNEWS users on the
network. You can also send mail to external addresses if your system administrator has
configured your system for this functionality.

*Do not use the NRCS tool mail as your primary e-mail application. Use the NRCS tool mail for
iNEWS, NRCS-related correspondence, such as notifying a coworker when you have edited a
story.*

**Sending NRCS Tool Mail (iNEWS only)**

**To send mail from within the NRCS tool:**

1. Click the Send Mail button.
   The Send NRCS Mail dialog box opens.
Sending and Receiving NRCS Mail (iNEWS Only)

2. Type an address in the To text box.
3. (Option) Type an address in the CC text box.
4. (Option) Type a subject in the Subject text box.
5. Type your message in the message area.
6. Do one of the following:
   - Click OK to send the message.
   - Click Cancel to close the dialog box without sending the message.

Receiving NRCS Tool Mail (iNEWS only)

To receive NRCS tool mail:
1. Navigate to and open the PEOPLE directory in the Directory panel.
2. Select the letter of the alphabet that matches the first letter in your iNEWS user name.
3. Select your user name from the list.
4. Select the Mail directory.
5. Select the mail message from the list (if there is more than one message).
   The mail message appears in the Story panel of the NRCS tool.
Disconnecting from Your NRCS Server

When you have finished using the NRCS tool, you should disconnect from the iNEWS or the ENPS server.

If you selected “Logout when NRCS Tool is closed” in the NRCS Settings dialog box, the NRCS tool automatically disconnects from the server whenever you close the tool or switch to a workspace that does not include the NRCS tool.

To disconnect from the iNEWS or the ENPS server:

- Click the Disconnect button.
Interplay | Production is an asset management system that provides a central database of assets (such as master clips, subclips, sequences, and graphics) that you use during your production process.

This section is primarily for editing systems within an Interplay workgroup. If you are an editor using Media Composer | Cloud, or if you work with assets created by remote Media Composer | Cloud editors, then refer to “Using Your Avid Editing Application with Media Composer | Cloud” on page 1284 or the Avid Remote News Editing Workflow Guide.

The following topics describe how to work with Interplay Production from an Avid editing system:

- Checklist for Editors Working with Interplay | Production
- Working with Interplay | Production and Remote Assets
- Administrator Settings for Avid Editing Clients
- Using the Interplay Window
- Connecting to the Interplay | Production Database
- Connecting to Avid Shared Storage and Mounting Workspaces
- Editing with Remote Assets
- Managing Remote Assets with the Interplay Window
- Finding Remote Assets
- Using the MediaCentral | UX Messages Window
- Capturing Media to Interplay Folders
The following topic is particularly useful if you are new to working with Interplay Production:

- Dos and Don’ts for Editors Working with Interplay | Production

**Dos and Don’ts for Editors Working with Interplay | Production**

The following information is useful for editors who are working with Interplay Production. It includes guidelines for working with Interplay and a list of dos and don’ts. Also see “Checklist for Editors Working with Interplay | Production” on page 1207.

**Why Do I Need to Do Things Differently?**

When Interplay Production is part of your workgroup environment, you need to work in a slightly different way. When you are editing with an Avid editing application within an Interplay environment, it is important to work with the asset management tools provided by Interplay. Otherwise, problems can arise throughout the system, which can stop workflows, and other users, from working correctly.

The main purpose of the Interplay server is to provide a central database of all the Avid and non-Avid assets that you use during your production process. This database is used as the central “share point” for material in use in your facility. It is also used by media managers as the primary tool for deletion of material from shared storage.

If you do not log in to Interplay Production and check in your work, Interplay has no way of tracking your work. You will still be using shared storage, but because the Media Tool doesn’t function with Interplay editors, you will have no way to monitor or delete your material on shared storage. The storage system will end up clogged up by, literally, thousands of irrelevant media files — rendered effects, imported files, mixdowns, titles — which will use valuable shared-storage space. In addition, if you work in this way, there will be no mechanism to locate and identify the unchecked-in files, other than searching for .mxf files on the Avid shared-storage workspaces. The .mxf file names do not provide you with any useful information about the clip name, project, or bin. That is Interplay’s function.

Keep in mind the relationship between the metadata, which is information that is stored in bins and the Interplay database, and the .mxf media files, which are stored in the Avid shared-storage system.

When you regularly check in assets to Interplay Production, media managers can manage and delete these assets efficiently by looking at specific metadata, for example, who created the assets, when, on which machine, and inside which project and bin.
When an Interplay server is available in an Avid shared-storage system in the workgroup environment, Avid strongly encourages not sharing bins or projects. Use the Interplay Window and the check-in process to share media.

Similarly, you should not use the File > Open Bin command. This is because the “borrowed” bin will be checked in again to Interplay Production from inside your project, creating multiple versions of the bin inside the Interplay database. If you “borrow” material using the File > Open Bin method, there is a strong risk of material being incorrectly deleted from within Interplay. Using the Interplay Window for searching, and for sharing media and sequences, is the only way to ensure that the Interplay database is tracking your work accurately, and that the deletion rules set up for your specific workflow will be correct.

**DOs**

- Log in to Interplay Production when prompted, with your individual username and password. This will ensure that you have the correct access rights to the Interplay folders that you need.
- Create a new project for your work, or use one that you are confident is not being used by any other users at the same time.
- Create a new bin, or use one that you are confident is not being used by any other users at the same time.
- Check in your sequence to Interplay Production at regular intervals, and particularly before you finish your editing session, either by using the correct Interplay Folder setting or by dragging-and-dropping to the correct folder.
- Depending on your facility’s workflow, check in your bin to Interplay Production at regular intervals and particularly before you finish your editing session.
- Find the media (master clips, sequences, effects) that you need by using the Interplay Window and search capabilities.
- Regularly review the contents of your Unchecked-In Avid Assets (UIAA) folder in Interplay Production and regularly delete any assets (media, effects, and so on) that you no longer require. Every time you render your effects, new assets are created and stored in the UIAA until the sequence or bin is checked in. If check-in is used correctly, the remaining items in the UIAA at the end of an editing session are not required in any sequence and can therefore be confidently deleted by the media manager or administrator. Keep in mind that having more than 5,000 items within an Interplay folder can affect system performance.

> Asset deletion in Interplay Production is done through Interplay Access. If you have not been given this function, then it is most likely that a media manager or system administrator is responsible for deleting material. You should regularly inform them of assets you have created that can be deleted.
Checklist for Editors Working with Interplay | Production

- Regularly clean up the contents of your bins: anything that you don’t need can be deleted. It’s a good idea to delete unwanted media before you check in a bin. If you choose to leave material in your bin without checking it in to Interplay Production, the material will go to the UIAA folder and sit there until deleted, taking up space on your Avid shared-storage system.
- Use reservations to protect material against accidental deletion. Reservations are a very powerful feature in Interplay Production. Discuss with your system administrator if you are unsure about how to use them.

**DON’Ts**

- Don’t locate media using the File > Open Bin menu.
- Don’t share bins: that is, don’t work inside a bin that is already being used by another editor.
- Don’t purposely avoid checking in an unfinished sequence thinking that another editor will finish it and check it in when done. If there are unchecked-in Avid assets in your sequence, another editor will not be able to check in a finished version, because the other editor will not have access to your Unchecked-in Avid Assets (UIAA) folder.
- Don’t share projects: that is, do not work on a project which is already being used by another editor.
- Don’t ignore the contents of your UIAA folder. If you do, you will be taking up valuable shared storage space.

Checklist for Editors Working with Interplay | Production

The checklist below provides a basic list of steps for sharing and editing projects and media between Avid editing systems in an Avid Interplay workgroup environment. For more details on working with Interplay, refer to the documentation that came with your Interplay or Avid editing system.

*If you are an editor using Media Composer Cloud, or if you work with assets created by remote Media Composer Cloud, editors, then refer to “Using Your Avid Editing Application with Media Composer | Cloud” on page 1284 or the Avid Remote News Editing Workflow Guide.*

<table>
<thead>
<tr>
<th>Step</th>
<th>Refer to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Before you launch your Avid editing application:</td>
<td></td>
</tr>
</tbody>
</table>
### Checklist for Editors Working with Interplay | Production

<table>
<thead>
<tr>
<th>Step</th>
<th>Refer to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Make sure you are correctly connected to the Avid shared-storage system.</td>
<td>“Connecting to Avid Shared Storage and Mounting Workspaces” on page 1226.</td>
</tr>
<tr>
<td>If you are saving media to a locally-connected storage, then make sure it is properly connected and configured for indexing.</td>
<td></td>
</tr>
</tbody>
</table>

**Before you begin editing:**

<table>
<thead>
<tr>
<th>Step</th>
<th>Refer to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a project in the appropriate location, using the proper naming convention.</td>
<td>“Creating Avid Editing Projects in an Interplay Environment” on page 1220.</td>
</tr>
<tr>
<td>Log in to Interplay Production when prompted by your Avid editing application.</td>
<td>“Logging in to Interplay</td>
</tr>
<tr>
<td>Check the media creation settings.</td>
<td>“Defining the Media Creation Settings” on page 1225.</td>
</tr>
<tr>
<td>Make sure that dynamic relink is properly configured.</td>
<td>“Enabling Dynamic Relink” on page 1349.</td>
</tr>
<tr>
<td>Learn about working with your bins in Interplay Production.</td>
<td>“Working with Interplay</td>
</tr>
</tbody>
</table>

**During Editing:**

<table>
<thead>
<tr>
<th>Step</th>
<th>Refer to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a new bin, or use one that you are confident is not being used by any other users at the same time.</td>
<td>“Dos and Don’ts for Editors Working with Interplay</td>
</tr>
<tr>
<td>Learn some basic rules about what you should and should not do in an Interplay environment.</td>
<td></td>
</tr>
<tr>
<td>Step</td>
<td>Refer to</td>
</tr>
<tr>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>❑ Use the Interplay Window in your editing application or Interplay Access to check out and work with shared media. NEVER open bin files (*.avb) from other people’s project folders.</td>
<td></td>
</tr>
<tr>
<td>❑ If you want to re-edit a sequence from another editor, ALWAYS duplicate (Ctrl+D on Windows, Command+D on Macintosh) before changing it.</td>
<td></td>
</tr>
<tr>
<td>❑ Use reservations to protect material against accidental deletion.</td>
<td>“Understanding Reservations” on page 1242.</td>
</tr>
<tr>
<td>❑ When editing HD formats, make sure that you acquire your media in a format supported by Interplay Production.</td>
<td>“Interplay Support for Native HD 23.976p and 24p Formats” in the Avid Interplay Help”.</td>
</tr>
<tr>
<td>❑ If you are working on an audio production using Avid Pro Tools, refer to the documentation for specific requirements on Interplay.</td>
<td>Pro Tools Avid Interplay Guide on the Avid web site.</td>
</tr>
<tr>
<td>❑ If you are working on a production using Avid DS, refer to the documentation for specific requirements on Interplay.</td>
<td>Avid DS help.</td>
</tr>
<tr>
<td>❑ Check in your sequence and bins to Interplay at regular intervals, and particularly before you finish your editing session, either by using the correct Interplay Folder setting or by dragging-and-dropping to the correct folder.</td>
<td>“Checking Avid Assets Into the Interplay Database” on page 1232.</td>
</tr>
</tbody>
</table>

**After Editing:**

❑ Name the final sequence according to the naming conventions BEFORE you check it in.

❑ Check the Unchecked-in Avid Assets/your username folder for any unchecked-in assets. Delete any assets (media, effects, and so on) that you no longer require.

---

**Support for HD RGB Media**

Interplay Production supports two HD RGB resolutions for native HD 23.976p and HD 24p:

- 1:1 10-bit HD RGB. This resolution is supported for check in, check out, and deletion. It is not supported for Media Services operations.
- DNxHD 444. This resolution is supported for all Interplay operations.
Support for Mixed Frame Sizes and Aspect Ratios

Avid editing applications use the Reformat attribute of a clip to resize and reposition the clip so that it conforms to the current frame size and aspect ratio specified in the Project settings. When you create a clip or subclip, the Reformat attribute is automatically set to Stretch. Settings other than this default are not supported in Interplay workflows.

⚠️ If you are working in an Interplay environment, do not change the Reformat attribute from the Stretch setting. If you use a different setting, and you then use Interplay Transcode or Send to Playback, the results might not be what you expect.

Maximum Number of Characters for Clip Names, Folders, and Files

Avid recommends adhering to a best practice of a 255 character limit for clip names. While it is technically possible for clip names to be longer, folders and files in the Interplay Production database are hard set at this 255 maximum and using it as a guideline may be easier to enforce over time across staff or teams.

Working with Interplay | Production and Remote Assets

With Interplay Production, users can share assets through folders that are managed by the Interplay database and accessible to all workstations in the Interplay environment.

If your workflow includes checking in bins from an Avid editing application, you can set up your editing project so that checkins you perform automatically create corresponding folders on Interplay. Subfolders for each bin are created inside a folder for the project. Depending on the organization of your Interplay database, the project folder is usually located in the Projects directory on Interplay.

The following illustration shows the Project window alongside an opened bin from an Avid editing project, and the corresponding folder in the Interplay Window.
Top: the Project window and opened bin from an Avid editing application. Bottom: the corresponding folder in the Interplay Window.

The project folder and its subfolders also contain project settings that primarily govern media acquisition — for example, frame rates, formats, and target workspaces. For more information about creating and managing projects in an Interplay environment, .

From an Avid editing application you can use the Interplay Window to browse and open folders in the Interplay database. You can also use Interplay Access to browse and open project folders. Interplay Access includes advanced search features and other database features.

You can work directly with assets in the Interplay Window, or you can copy (check out) assets to a bin in an Avid editing project. The bin then contains local copies of the remote assets. You can modify the local copy of an asset, but the changes remain local until you save the changes (check in) to the database.
You can check assets in and out in several different ways:

- Check assets out by dragging them from the Interplay Window or from Interplay Access (see “Checking Avid Assets Out Using the Interplay Window” on page 1229 or “Checking Avid Assets Out Using Interplay Access” on page 1232).

- Check assets in by dragging them to the Interplay Window or by using one of several menu commands (see “Checking Avid Assets In to the Interplay Database” on page 1232).

**Interplay Production manages two kinds of assets:** Avid assets, which are assets that are created by Avid applications (master clips, subclips, and so on) and file assets, which are assets that are created by other applications. When you work with Interplay Production from an Avid editing system, you can work only with Avid assets. You can use Interplay Access to work with both Avid assets and file assets.

### Administrator Settings for Avid Editing Clients

The Interplay Administrator includes several settings that affect Avid editing systems that are clients in an Interplay workgroup:

- **Application Database Settings:** Editing Settings tab
  - Check in bins when closing: Allows an administrator to set the default behavior for checking in media objects from open bins to the Interplay database when closing your Avid editing application. The default is “Ask user.” See “Automatically Checking In Avid Assets” on page 1235.

- **Instinct/Assist User Settings**
  - Can create new column properties: If yes, allows the selected user or group to add new properties to an asset. If an editing application user regularly checks assets into Interplay, select “yes.”
  
  - Can modify column properties: If yes, allows the selected user or group to modify the properties of an asset (such as the name or a comment). If an editing application user regularly checks assets into Interplay, select “yes.”
  
  - Can create markers: If yes, allows the selected user or group to create markers. If no, a user of an Avid editing application can still create markers for an asset, but can check in only the asset, not the marker metadata (an error message is displayed).
  
  - Can modify markers: If yes, allows the selected user or group to modify or delete markers. If no, a user of an Avid editing application can still modify markers on an asset, but can check in only the asset, not the marker metadata (an error message is displayed).

In most cases, if an administrator wants a user to create markers, select “yes” for both “Can create markers” and “Can modify markers.” Both settings are needed because adding text is one aspect of modifying a marker.
For more information, see the *Interplay / Engine and Interplay / Archive Engine Administration Guide*.

**Using the Interplay Window**

The Interplay Window is a tool that you open from the Tools menu of your Avid editing application. The Interplay Window provides you with access to the Interplay database. You can copy (check out) assets to your local bin and work with them like any other bin objects. You can also use the Interplay Window like a bin and edit directly from the Interplay Window by double-clicking an asset in the window, which loads the asset into the Source monitor of your Avid editing application.

The following illustration shows the Interplay window, as it appears on Mac OS X systems and Windows systems. Folders are listed in the tree hierarchy in the left pane, and the contents of the selected folder are displayed in the right pane. In this example, the folder is named after a bin in an Avid editing project.

![Interplay Window](image)

There are some differences between working from Interplay folders and working from bins. For instance, you cannot edit a sequence in an Interplay folder. To edit a sequence, you copy it to a bin, edit it, and then you copy the modified sequence to the Interplay database for sharing.

For more information about using and customizing the Interplay Window, see “Editing with Avid Assets in the Interplay Window” on page 1236 and “Managing Remote Assets with the Interplay Window” on page 1241.
Connecting to the Interplay | Production Database

Before you can connect to the Avid Interplay database and access remote assets, you need to configure the Interplay settings in your Avid editing application.

You also need to be connected to the Avid shared-storage network. If you are working in an Avid shared-storage workgroup, your Avid system administrator needs to configure your system for proper access to the Avid shared-storage workspaces. If you need to log in to Avid shared storage and mount workspaces, see “Connecting to Avid Shared Storage and Mounting Workspaces” on page 1226. For complete information on working with shared storage, see the client documentation for Avid ISIS.

If you have the correct Interplay settings and Avid shared storage connection, you can log in and open the Interplay Window as described in “Logging in to Interplay | Production and Opening the Interplay Window” on page 1217.

Configuring Interplay Settings on the Editing Workstation

You need to specify three Interplay settings before you can view or use remote assets:

- **Interplay Server**: Use this setting to specify the computer name of the Interplay Server. This is a Site setting, so it applies to all users and projects on a particular system. You can override this setting in the Interplay Login dialog box.

- **Interplay User**: Use this setting to specify the Interplay user account to use when logging into Interplay Production. This is a User setting, so it is specific to the Avid user. You can override this setting in the Interplay Login dialog box.

- **Interplay Folder**: Use this setting to specify where assets are checked into the Interplay database when you use menu commands, automatic checkin, or Frame Chase capture. This is a Project setting, so it applies to all users working on a particular project.

You need to log in to the Interplay database through the Interplay User setting before you can specify the Interplay Folder settings.

**To configure Interplay settings:**

1. Start your Avid editing application.
2. Click the Settings tab in the Project window.
4. In the Interplay Server Name text box, type the computer name or IP address of your Interplay server, and then click OK.

It is important to type the correct computer name or IP address. This is the location where the editing system looks to access the database and to check in and check out Avid assets.
5. In the Settings list, double-click Interplay User.

![Interplay User Settings dialog box]

6. In the User Name text box, type a user name.
   This name must be a known user on your workgroup system.

7. Select “Automatic Login at Project Selection” if you want to log in to the Interplay database automatically every time you open a project.
   If you do not select this option, you must open this dialog box when you want to access the database.

8. Click Login to establish the connection to the Interplay database.
   The Interplay Login dialog box opens, with the server name you specified in the Interplay Server Settings as the Host Name.

![Interplay Login dialog box]

9. In the Interplay Login dialog box, type your password, and click OK.
   If you are connecting to the database from a remote editing Media Composer | Cloud client, then select the Remote Client checkbox.
   When the blinking yellow light in the upper left of the dialog box turns green, you are connected to the Interplay database and the dialog box closes. If you cannot log in, see your system administrator.

10. In the Project Settings, double-click Interplay Folder.
    The Interplay Folder Settings dialog box opens.
11. Click the Set button, and a directory tree is displayed for the Interplay database that you logged in to.

12. Select a folder to use as the default Interplay Root Folder for your project and click OK.

   The Interplay Folder setting defines where assets are checked into the Interplay database when you use menu commands, automatic checkin, or Frame Chase capture. (This setting does not apply when you manually drag media from a bin and drop it in a folder in the Interplay Window.) Interplay checks media in to a subfolder of the folder you specify in this dialog box. The subfolder is named after the bin whose assets you are checking in.

13. (Option) Select “Append project to directory path” if you want Interplay to create a folder with your project name in the Projects folder.

   This is the default setting. If this setting is selected, an Interplay folder named after the project contains subfolders named after the bins in the project.

14. (Option) Select options to verify the directory path.

   - On login: When selected, a message box asks you to confirm the directory path each time you log in to Interplay. Select “for new projects only” if you want this message box displayed only after you create a new project.

   - On first checkin: When selected, a message box asks you to confirm the directory path the first time you check in from a project. This message is displayed once for each time you work in a project.

   For more information, see “Verifying the Interplay Checkin Folder” on page 1218.

15. Click OK.
Logging in to Interplay | Production and Opening the Interplay Window

If you configured the Interplay User settings to log in to the database when you select your project, the Interplay Login dialog box opens when you start your Avid editing application. If you did not select this option, then you must open the Interplay User settings before logging in to the database.

After you log in, you have the option of opening the Interplay Window.

You must be logged in to the Interplay database to work with remote assets. For information on configuring your login and other workgroup settings, see “Configuring Interplay Settings on the Editing Workstation” on page 1214.

To log in and open the Interplay Window:

1. If your Interplay User settings are not configured to log in when you start a project, do the following:
   a. In the Settings list, double-click Interplay User.
   b. Click Login to establish the connection to the Interplay database.

2. In the Interplay Login dialog box, type your password, and click OK.
   When the blinking yellow light in the upper left of the dialog box turns green, you are connected to the Interplay database and the dialog box closes.
You can override the Host Name and User Name settings in the Interplay Login dialog box.

3. If an Interplay Folder path is not set, the Interplay Folder Settings dialog box is displayed. Set the path and other options and click OK. See “Configuring Interplay Settings on the Editing Workstation” on page 1214.

   (Option) You can set an option to display a message box that asks you to confirm the Interplay Folder path, if it is already set. If this message box is displayed, click OK to accept the path, or click Change Setting to change the path. See “Verifying the Interplay Checkin Folder” on page 1218.

4. (Option) Select Tools > Interplay Window.

   The Interplay Window opens.

Verifying the Interplay Checkin Folder

To ensure that the objects that you check in are checked in to the correct Interplay folder, you can choose to display a message box that asks you to verify the directory path for the current project.

You can choose to show this message box after logging into Interplay Production. You can also choose to show this message the first time you check in from a project. You control the display of this message box in the Interplay Folder Settings dialog box.

To set when the verification message box is displayed:

1. Start your Avid editing application.
2. Click the Settings tab in the Project window.
3. Double-click Interplay Folder.

   The Interplay Folder Settings dialog box is displayed.
4. Select options to verify the directory path.
   - On login: If this setting is selected, a message box asks you to confirm the directory path after you log in to Interplay Production. Select “for new projects only” if you want this message box displayed only after you create a new project.

   ![Verify the Interplay check-in folder](image)

   When the message is displayed after login, click OK to accept the directory path, or click Change Setting to open the Interplay Folder Settings dialog box.

   - On first checkin: If this setting is selected, a message box asks you to confirm the directory path the first time you check in from a project.

   ![Verify the Interplay check-in folder](image)

   When the message is displayed after the first checkin, click OK to accept the directory path and complete the checkin, click Change Setting to open the Interplay Folder Settings dialog box, or click Cancel to cancel the checkin. The message box is displayed once each time you work in a project.

5. Click OK.
Creating Avid Editing Projects in an Interplay Environment

One of the biggest decisions you will make regarding your workflow is the location of the projects and bins created by the editing applications. A predictable folder structure allows for the following:

- Creates an easily maintained folder structure in the Interplay database
- Makes it easy for editors and other users in the organization to locate assets that are used by different projects
- Makes it easier for the Administrator to delete older projects on the Avid editing systems

In a large Interplay environment it is important to locate Avid editing projects in areas that are easily accessible by the Administrator that has to delete the projects. When you start the editing application, the system displays the project log in window. From this window, you can create a project that is either Private, Shared, or External.

The best choices for a shared structure are either Shared or External. These types of projects are created in a common location, making it easier for the Administrator to locate and delete old projects.

*Any user can create or delete a project via the editor. Keep your project structure consistent to make the Interplay database easy to maintain.*

If you are working with projects created on local drives, then note the following:

- A local project resides on the C: drive of the Avid editing system.
- If the connection between the Avid editing system and shared storage is lost, the project and its contents are unlikely to become corrupt as a by-product.
- You cannot login to the project from another workstation. You (or other users) must go to the Interplay Projects folder to locate the contents created in this project.
- From an administration standpoint, you must clean these projects up or archive them from each editing system. At a large site this can become time consuming and needs to become part of the Administrator’s workflow.

**Private**

A Private Project is stored locally. It can be accessed only by the user currently logged on to the editing machine. On a Windows system, a Private Project is always stored under the user’s Documents directory. An administrator may be able to access this project if they have read/write permission to the user’s directory.
Creating Avid Editing Projects in an Interplay Environment

Shared

A Shared Project is stored locally. It can be accessed by any user that can log on the editing machine. On a Windows system, a Shared Project is always stored in the machine’s Shared Documents directory.
External

An External Project can be saved to any directory, either local or remote. Depending on the file-system permissions set on the selected folder, other users or an administrator may or may not be able to access the project. The external option is particularly useful when you want to save the project on shared network drive to make project maintenance easier.

Avid does not support sharing bins in an Interplay environment. If you create projects on shared storage, do not allow editors to work in the same bin at the same time. This can result in data loss or media corruption. Instead of sharing bins, editors should use the Interplay Window to collaborate and share material.

Interplay Settings in the Editing Application

The Interplay Folder setting defines where the Avid editing application checks files into the Interplay database. After you open a project you can specify several Interplay settings, including the Interplay Folder. To access the settings, open the Settings scroll list in the in the Project window. The following table lists the Interplay-related settings.
Defining the Interplay Folder Setting

The Interplay Folder setting defines where assets will be checked into the Interplay database. You need to define the location for each project. The examples in this chapter assume that you are using the Projects folder in the Interplay database. The following illustration shows the setting defined for the Projects folder. Use the Set button to define the location.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interplay Server (Site Setting)</td>
<td>Specify the name of the Interplay Engine for the environment. If the site has an Interplay Engine Cluster, this is a virtual name that will log in to the active node.</td>
</tr>
<tr>
<td>Interplay User (User Setting)</td>
<td>Specify the name of the default Interplay user (if applicable) and check the Automatic Login at Project Selection checkbox. This does not auto-login to Interplay Production, but prompts the user to do so after logging in to their project.</td>
</tr>
</tbody>
</table>
| Interplay Folder (Project Setting) | Interplay Production organizes assets and media by folders. The default checkin folder must be set on each Avid editing application.  
By default, the folder path is empty. The Interplay database Projects folder is a good location to use. This will check the assets into a folder with the name of the bin inside the folder for the project. Click the Set button to navigate to the directory you want to use. After you select the Projects folder, the Interplay Folder Settings dialog box will display the following: Projects/\{project\} |
| Dynamic Relink                | This setting is utilized in MultiRez environments, to specify the working and target resolutions for the Avid editing applications. The term MultiRez refers to having a single master clip associated with multiple resolutions. |
| Media Services                | This setting specifies the Media Services Engine information. This allows the editor to submit Transcode, Pro Encode, or Archive jobs to the Media Service broker to hand off to the provider. When logged in to Media Services the client can submit the jobs using the File menu options or by right-clicking assets in a bin. You need to specify that Media Services are available, the Host name of your Media Services Engine, and a valid Interplay login account. |
Defining the Interplay Folder Setting

The Project folder selected. Click the Append project checkbox.

The following illustration shows a folder for a project named “The Big Swell” created in the Projects folder. The folder was created automatically when the editor checked the first bin into Interplay Production using the Check in Bin to Interplay command. The system automatically created both folders and checked in the assets into the folder.

Folders created by checking in the bin. Checked in assets.

For a Day-of-the-Week workflow, use the Projects\<project> setting in the Interplay Folder Setting window. Then, when multiple editors work in the 01Monday project, there will be one 01Monday folder populated by the bins from each system. This keeps the organization easier to maintain.
To instruct the system to automatically check in bins when the editor closes the application, select the Bins option in the Editor Database Settings window in the Interplay Administration tool. The default is to ask the editor before checking in the bin.

**Defining the Media Creation Settings**

Use the Media Creation dialog box to define the video resolution and the drives where you want the Avid editing application to store newly created media. This is could be a locally-connected storage or a workspace on shared storage that is monitored by the Interplay Media Indexer High Availability Group.

**To define the Media Creation settings:**

1. Click the Settings tab in the Project window of the Avid editing application.
2. Double-click Media Creation.
3. (Option) On the Drive Filtering and Indexing tab, click Auto-index local drives as they come online.
4. If you are connected to a baseband device such as a tape deck, click the Capture tab.
5. Select the video resolution and shared storage workspace for capturing new material.
6. Set similar options for video resolution and storage areas for Import, Mixdown, Transcode and Render.
Connecting to Avid Shared Storage and Mounting Workspaces

If you need to manually connect to your Avid shared-storage system and mount workspaces, use one of the procedures in “Mounting Workspaces on an Avid ISIS System” on page 1226.

For complete information, see your Avid shared-storage documentation.

Mounting Workspaces on an Avid ISIS System

If your system is connected to an Avid ISIS media network, you can use the Client Manager to mount a workspace before you begin your work session.

You must be connected to an Avid ISIS System Director before you can mount workspaces. For more information, see the Avid ISIS Client Manager Help.

To connect to the Avid ISIS network:

1. Do one of the following:
   - (Windows) If the Client Manager icon is not available in the Windows taskbar, select Start > All Programs > Avid > ISIS Client > ISIS Client Manager.
   - (Windows) Click the Client Manager icon in the Windows taskbar.
   - (Windows) Right-click the Client Manager icon and select ISIS Client Manager.
   - (Macintosh) Double-click the Client Manager alias icon on the desktop, or double-click the Client Manager alias icon in the dock.
   - (Macintosh) If the Client Manager alias icon is not available, select Go > Applications, and then double-click the AvidISIS folder. In this folder, double-click the ClientManager file.

The ISIS Client Manager opens.
Connecting to Avid Shared Storage and Mounting Workspaces

2. Select the System Director you want to connect to from the Connections list.

3. Do one of the following:

   ▶ (Windows) Type your account name in the Username text box, and type your password in the Password text box.

   ▶ (Windows) If your ISIS system is configured to use the Windows user name and password for your local system, select OS Login. By default, the Username and Password text boxes are inactive when you select this option.

   ▶ (Macintosh) Type your Avid ISIS account name in the Username text box, and type your password in the Password text box.

4. Click the Connect button.

   When the connection is successful:

   - Workspaces you have been given access to are listed in the workspace list.

   - The Connect button changes to Disconnect when the connection is complete.

   - The Change Password and Launch Management Console buttons become active.

5. (Option — Windows only) If you used the OS Login option, and you want to connect to the network automatically every time you start your system, select the Auto-Connect box.
To mount an Avid ISIS workspace on your system:

1. Open the Client Manager.
   
The Workspaces list opens. The Online field displays a green ball for workspaces that are already mounted. You can filter the Workspaces list by Workspace name.

2. Do one of the following:
   
   ▶ Click (mount) in the Online column for the selected workspace.
   ▶ Click to select a workspace, then right-click, and select Mount.
   ▶ (Option) Right-click, and select “Mount to drive” from the menu.

   Selecting this option will override the current drive mapping option settings for the selected workspace.

   The Client Manager mounts the selected workspace on your client and the Online icon for the mounted workspace changes to green. The Workspaces list displays the drive the workspace is mounted to. If you use letterless drive mappings, the Workspaces list displays “UNC path” next to the Online icon.

3. (Option) If you want the selected workspace remounted the next time you log in, do one of the following:
   
   ▶ Click (enable) in the Auto column for the mounted workspace.
   ▶ Right-click, and select “Enable auto mount”.

   The next time you log in to your client system, the Client Manager automatically mounts the selected workspace.

To mount multiple Avid ISIS workspaces on your system:

1. Open the Client Manager.
   
The Workspaces list opens. The Online field displays a green ball for workspaces that are already mounted. You can filter the Workspaces list by Workspace name.

2. Do one of the following:
   
   ▶ Select multiple non-contiguous workspaces with Control+click.
   ▶ Select a range of contiguous workspaces by clicking on the first workspace row in the range, then Shift+clicking on the last.
   ▶ Select all workspaces by right-clicking in the Workspaces list and selecting “Select all”.
   ▶ Select all workspaces by pressing Ctrl+A.

3. Right-click, and select Mount.
The Client Manager mounts the selected workspaces on your client and the Online icons for the mounted workspaces change to green. The Workspaces list displays the drives the workspaces are mounted to. If you use letterless drive mappings, the Workspaces list displays “UNC path” next to the Online icons.

4. (Option) If you want the selected workspaces remounted the next time you log in, right-click, and select “Enable auto mount”.

The next time you log in to your client system, the Client Manager will automatically mount the selected workspaces.

**Editing with Remote Assets**

When you edit with remote assets in a workgroup environment, you need to keep in mind that other users might share the clips and sequences in your project. When you first set up your project, you can load the assets you want to work with to the Source monitor, mark In and Out points, and add them to your sequence in the Timeline where you can create your effects and edit your footage. You can then check in your sequence, including titles and effects, to the database so others can access your work. Also, you should update the sequence in your bin to ensure that the remote assets in your sequence include the most recent changes you and other users have made.

**Checking Avid Assets Out Using the Interplay Window**

You can copy assets from the Interplay database to a bin. This process is called *checking out*. Checking out assets from the Interplay database creates a local copy of the assets but does not create a local copy of the associated media. When you check the assets back in to the Interplay database, Interplay looks for any changes to the assets and copies the changes back to the database. See “Checking Avid Assets In to the Interplay Database” on page 1232.

You can load clips directly from the Interplay Window. See “Editing with Avid Assets in the Interplay Window” on page 1236.

To check Avid assets out of the Interplay database using the Interplay Window:

1. Start your Avid editing application, and either create a new project or open a bin in an existing project.
2. Log in to the Interplay Production database.
   
   For more information, see “Connecting to the Interplay Production Database” on page 1214.
4. Navigate to the project containing the master clips and sequences (assets) you want to use, and click the folder that contains the assets.
The Interplay Window displays the Avid assets in the selected folder.

5. Click the assets you want to check out, and drag them to your bin.

The bin displays the clips and sequences.

If you check out an asset and modify it (for example, you edit a sequence), and check out the asset again without checking in the modified version, the following warning is displayed:
This message could also appear if another user has checked in a modified version of the asset after you checked it out. Click “Update anyway” to overwrite the local version with the version on the database, or click “Keep local modifications” to preserve the local version.

Creating a Duplicate Asset When Dragging to a Bin

In some cases you might want to create a duplicate of an Avid asset that you drag from the Interplay database to a local bin, for example, if you want to create a new version of a sequence while preserving the original. You can then work on the duplicate without affecting the original.

To automatically create a duplicate asset when dragging to a bin:

- Hold down the Control key (Windows) or Option key (Macintosh) and drag an asset from the Interplay window to a local bin.

A duplicate copy of the asset is listed in the bin. The name of the duplicate includes the file name extension .Copy.n, where n is the number of duplicates created from the original asset.

Checking Out the Same Sequence to More than One Bin

Avid editing applications have a long-standing internal rule that a sequence cannot simultaneously exist in two open bins. If you Alt-drag a sequence from one bin to another, the sequence is copied and renamed as it is placed in the second bin.

It is possible, under some circumstances, to have the same sequence in two bins when one or both bins are closed. Previously, if you opened one bin and then the other, the sequence was duplicated without renaming in the second bin. Now the sequence is duplicated and renamed in the second bin.

If you attempt to check out a sequence that already exists in a different open bin, a message informs you that a duplicate sequence will be created and renamed (with the extension Copy.n). You can respond to the message in one of the following ways:

- Click OK to check out the sequence and create a duplicate.
- Click Cancel to end the operation without checkout.
- Click “OK and don't show again” to check out the sequence and create a duplicate; if you repeat the operation the message is not shown again until you restart your Avid editing application.

You can force a new copy of an object to be created with a different name by holding down the Ctrl key (Windows) or Option key (Macintosh) when dragging from the Interplay Window to a bin. (See “Creating a Duplicate Asset When Dragging to a Bin” on page 1231).
Checking Avid Assets Out Using Interplay Access

When you are working with an Avid editing application, you might want to use the advanced search in Interplay Access to look for particular Avid assets. After finding the assets, you can drag them from Interplay Access into a bin (checking out the assets), which creates local copies of the assets (but not the media).

If you then modify the asset and want to save the changes in the database, you must use the menu commands in your Avid editing application to check the asset back in to the database. You cannot drag assets from a bin to Interplay Access.

To check Avid assets out of the Interplay database using Interplay Access:

1. Start your Avid editing application, and either create a new project or open a bin in an existing project.
2. Log on to the Interplay Production database, as described in “Connecting to the Interplay | Production Database” on page 1214.
3. Open Interplay Access and browse or search for the assets you want.
4. Select the assets you want to use and drag them to a bin.
   The Avid assets are checked out from the Interplay database. A link is created to the asset, and the bin displays the assets you checked out.

Checking Avid Assets In to the Interplay Database

The process of adding Avid assets to the Interplay database or updating Avid assets already in the database is called checking in. There are two basic ways to check in Avid assets:

- By using menu commands or automatic checkin
- By dragging assets to the Interplay Window

When you use a menu command or automatic checkin to check in assets, the Interplay Engine checks them into a subfolder named after the bin, in a folder that you selected in the Interplay Folder settings (see “Configuring Interplay Settings on the Editing Workstation” on page 1214). When you use the drag-and-drop method for checking in assets, you can select any appropriate Interplay folder to store your assets.

The following table describes the methods available for checking in Avid assets.
By default, a 24-hour reservation is automatically placed on a folder whenever a new or modified Avid asset is checked in to the Interplay database from a bin. An Interplay administrator sets the default duration of the reservation in the Application Database Settings in the Avid Interplay Administrator. For more information on reservations, see “Understanding Reservations” on page 1242.

To add Avid assets from your bin to the Interplay database by using menu commands:

1. Open the bin that contains your clips or sequences.
2. Log in to the Interplay database if you have not already done so.
For more information, see “Connecting to the Interplay | Production Database” on page 1214.

3. Do one of the following:
   - To check in all Avid assets in a bin, select the bin and then select Bin > Check In Bin To Interplay or File > Check In All Open Bins to Interplay, or right-click the Bin Fast menu and select Check In Bin To Interplay.
   - To check in Avid assets in all open bins, select Bin > Check In All Open Bins to Interplay or right-click the Bin Fast menu and select Check In Bin To Interplay.
   - To check in one or more Avid assets, select the assets and select File > Check In To Interplay or right-click and select Check In To Interplay.
   - To check in a sequence for use in a Pro Tools project, select File > Check In to Interplay for Pro Tools or right-click and select Check In to Interplay for Pro Tools.

The Interplay Engine checks in the assets to a subfolder of the folder you specified in the Interplay Folder settings (see “Configuring Interplay Settings on the Editing Workstation” on page 1214).

4. (Option) You can set an option to display a message box that asks you to verify the folder into which the assets will be checked in.
   - Click OK to accept the directory path and complete the checkin.
   - Change Setting to cancel the checkin and open the Interplay Folder Settings dialog box.
   - Click Cancel to cancel the checkin.

The message box is shown the first time you check in from a project. See “Verifying the Interplay Checkin Folder” on page 1218.

To add Avid assets from your bin to the Interplay database using drag and drop:

1. Open the bin that contains your clips or sequences.

2. Log in to the Interplay database if you have not already done so.
   For more information, see “Connecting to the Interplay | Production Database” on page 1214.

4. (Option) Right-click the Projects folder in the Interplay Window, select Create a New Folder, and then type a name for the folder.

5. Select one or more items in the bin and drop them in a folder in the Interplay Window.

**Automatically Checking In Avid Assets**

You can automatically check in media assets by setting the appropriate option in the Avid Interplay Administrator. The “Check in bins when closing” setting in the Application Database Settings provides the following options for checking in media from bins:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Always check in</td>
<td>Your Avid editing application checks in media assets in a bin whenever you close it (for example, when you close an individual bin or a super bin, close a project, or quit your Avid editing application).</td>
</tr>
<tr>
<td>Never check in</td>
<td>Your Avid editing application does not check in media assets in a bin when you close it.</td>
</tr>
<tr>
<td>Ask User</td>
<td>A dialog box asks you if you want to check in a bin or bins to Interplay that you are closing (this is the default setting).</td>
</tr>
</tbody>
</table>

When you automatically check in media assets from a bin, assets are checked in to a subfolder within the folder specified in the Interplay Folder settings (see “Configuring Interplay Settings on the Editing Workstation” on page 1214).
Automatic checkin is optimized to work more quickly than the menu commands described in “Checking Avid Assets In to the Interplay Database” on page 1232. If a bin contains any new or modified items, it is processed exactly as when you use the menu commands. If there are no new or modified items in a bin, no items in the bin are checked in. In this case, automatic checkin will not detect that items have been deleted from the bin’s database folder. You can force these items to be checked in by selecting them and then selecting File > Check in To Interplay.

If you are not sure which option is set for automatic checkin, see your Interplay administrator.

**Updating Remote Assets in Bins**

After you have added remote assets to a bin, you can update the assets by dragging them from the Interplay Window to the bin. You can also update assets by using the Update Bin from Interplay command. This command automatically checks out the most recent version of the clips or sequences in a bin. You can update all items in a bin, or you can update only selected items.

This command is useful if you are working with an in-progress clip. See “Editing with In-Progress Clips” on page 1238.

*If an Interplay folder contains assets that are not contained in its corresponding bin, the Update Bin from Interplay command does not add these assets to the bin.*

To update remote assets:

1. Open the bin that contains the local copies of your remote assets.
2. To update all items in a bin, select the bin and do one of the following:
   - Select Bin > Update Bin from Interplay.
   - Click the Bin fast menu, and select Update Bin from Interplay.
3. To update selected items in a bin, select the items, right-click, and select Update from Interplay.
   
The latest versions of the items are checked out to the bin.

**Editing with Avid Assets in the Interplay Window**

You use the Interplay Window to access master clips and sequences in the Interplay database. When you locate the appropriate Avid asset, you can open the asset in the Source monitor where you can preview it and mark In and Out points. You can then add the assets to a sequence in the Timeline just as you would any other media clip. You then save your sequence to a bin, and you drag it to an Interplay folder in the Interplay Window, which checks in the sequence to the database.

*You cannot edit a sequence directly from an Interplay folder. To edit a sequence, copy it to a bin (check out), edit it, and copy the modified sequence to the Interplay database (check in).*
You can also edit files that have been checked into Interplay from Pro Tools. For more information, see “Using Pro Tools and Interplay” in Avid Interplay Best Practices.

For more information about using and customizing the Interplay Window, see “Managing Remote Assets with the Interplay Window” on page 1241.

To view Avid assets in the Source monitor:

1. Start your Avid editing application, and either create a new project or open an existing project.
2. Log in to the Interplay database.
   
   For more information, see “Connecting to the Interplay | Production Database” on page 1214.
4. Navigate to the project containing the master clips and sequences you want to use, and click the project folder.

   The Interplay Window displays the Avid assets in the Interplay folder.

   5. Select the clip or sequence you want to view
6. Do one of the following:
   
   ▶ Drag the clip or sequence from the Interplay Window into the Source monitor.
   
   ▶ Double-click the clip or sequence in the Interplay Window.

   The Source monitor displays the remote asset.
Understanding In-Progress Clips

If your Avid editing application is part of a workgroup environment managed by Avid Interplay, you can edit using in-progress clips. In-progress clips are created using Frame Chase capture capabilities, either on another Avid editing application or with a line feed or ingest device such as an Avid AirSpeed®.

In-progress clips are available for viewing and for use in editing while the capture is still in progress. The length of in-progress clips is based on their expected duration in the capture device. Portions of the clip that have already been captured are available for viewing in monitors, and you can edit those portions into a sequence. Portions of the clip that have not yet been captured are represented in monitors by a “Capture in Progress” slide.

You can send a sequence that includes material from in-progress clips to playback at any time. You do not have to wait until the capture completes.

For more information on how the Frame Chase capture process works, see “Frame Chase Capture” on page 247.

Editing with In-Progress Clips

The following procedure outlines the basic steps for editing using an in-progress clip when you use the Interplay Window to access the Interplay database.

To edit using an in-progress clip:

1. Open your Avid editing application, open a project, and open the Interplay Window.
2. In the Interplay Window, navigate to the folder that holds the clip that you want to use for editing.
   - If you know some information about the clip, you can use the Search feature.
   - A clip that is being captured displays an in-progress icon.
3. Load the clip into the Source monitor and play the clip.
   - The clip plays in the Source monitor at the same time the media is being captured. Portions of a clip that are not currently available display a “Capture in Progress” slide until those portions are captured.
4. Create a sequence in a bin.

5. Use standard editing techniques to build a sequence incorporating any parts of the in-progress clip that you can view in the Source monitor.

6. (Optional) To get updated information about the clip (metadata), select Bin > Update Bin from Interplay. For more information, see “Updating Remote Assets in Bins” on page 1236.

7. When the clip is completely captured, select Bin > Update Bin from Interplay.

   This command ensures that the latest version of the clip is used in your sequence and removes restrictions related to in-progress clips.

8. Save the sequence.

Limitations When Working With In-Progress Clips

During the Frame Chase capture process the final length of the clip is unknown until the capture is complete and the clip information is updated. Because of this, there are some limitations when you work with in-progress clips.

You can use the following editing functions only when you are working with the available captured media of an in-progress clip:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Editing in-progress clips into a sequence</td>
<td>You can edit the captured portions of in-progress clips into a sequence.</td>
</tr>
<tr>
<td>Subclips</td>
<td>When creating a subclip from an in-progress clip, you must place the IN and OUT points where media has already been captured and is available.</td>
</tr>
</tbody>
</table>
The following editing functions are not available when you are working with in-progress clips:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trimming</td>
<td>The right-side trim limit of an in-progress clip is determined by the currently available media. When you trim an in-progress clip to the end of available media, the trim functions as if it had reached the end of the clip. As more media is captured, the trim limit increases. Performing the trim at a later time might allow more trimming because more media might become available.</td>
</tr>
<tr>
<td>Clip duplication</td>
<td>Duplication of an in-progress clip is not allowed because the duplicated clip loses its relationship with the original in-progress master clip.</td>
</tr>
<tr>
<td>Group clips</td>
<td>You cannot use an in-progress clip in a group clip, because the length of an in-progress clip is unknown until the capture is complete. Group clips are based on the length of the contributing clips. This limitation applies to all of the related grouping operations, such as AutoSync, Group Clips, and MultiGroup.</td>
</tr>
<tr>
<td>Consolidate, Transcode, and Audio Conversion</td>
<td>You cannot consolidate, transcode, or perform audio conversion with an in-progress clip. All the media must be available and the length of the clip known before you can perform these functions. However, you can consolidate and transcode subclips and sequences that reference or contain in-progress clips. In these cases, any right-side handles are restricted by the known media duration of the in-progress clip at the time of the operation. For example, if you set 2-second handles but there is only 1-second of media available for a handle at the time the consolidate or transcode operation is executed, then the right-side handle is restricted to 1 second.</td>
</tr>
<tr>
<td>Decompose</td>
<td>The restrictions for decompose are the same as consolidate and transcode. The right-side handles cannot exceed the known media duration of the clip.</td>
</tr>
<tr>
<td>Non-Check-in export</td>
<td>You cannot export an in-progress clip or a sequence that contains in-progress clips because the final clip length might be different than the clip length at the time of the export.</td>
</tr>
<tr>
<td>Variable-bit-rate media</td>
<td>The only variable-bit-rate (variable-frame-size) media supported for Frame Chase editing is low-res long-GOP MPEG-2 media captured by the Avid Interplay low-res encoder. Only media captured by supported ingest devices is supported for Frame Chase editing.</td>
</tr>
<tr>
<td>Using the Capture tool</td>
<td>Frame Chase editing is not available on an Avid editing system that is using the Capture tool to capture media.</td>
</tr>
</tbody>
</table>
You access remote assets through the Interplay Window. This lets you see all of the Avid assets available to your project, manage your assets, and access the Avid assets stored in Interplay folders so you can edit the clips in your sequence.

The Interplay Window lists your active content, which includes sequences, master clips, and all the media files and metadata files that are associated with them. The Media Directory panel lets you browse and navigate to all of the shared Interplay folders that contain those Avid assets available for your project. The Research panel shows you the contents of the selected folders and the results of media searches. You can use the Layout button to customize the display of the Media Directory panel and the Research panel, see “Modifying the Appearance of the Interplay Window” on page 1246.

You can load clips and sequences from the Interplay Window, which keeps track of your assets in tabbed windows. You also use the tool to search projects and folders. When you start a search, a Media Search tab displays in the Research panel. The Media Search tab lets you search the database for all media files that fit the search parameters you specify. For more information on searching, see “Finding Remote Assets” on page 1260.

*By default, a Media Search tab is always open in the Research panel.*
Assets can carry two different kinds of markers:

- **Reservations**: Reservations protect assets from deletion and moving. Assets protected by a reservation are marked by a Reservation icon in Avid Interplay Access. For more information on reservations, see “Understanding Reservations” on page 1242.

- **Restriction markers**: Restrictions indicate limitation warnings on the use of media assets. Assets that include a restriction are marked by a Restriction icon. For more information on restrictions, see “Understanding Restrictions” on page 1243.

In Interplay Access, an administrator can set the text color of the names of folders and assets (the default is black). This colored text is also visible in the Interplay Window.

### Understanding Reservations

Reservations are time-based protections that authorized users can set on Interplay database folders. Usually reservations are assigned by a user with appropriate privileges using Interplay Access. By default, a 24-hour reservation is automatically placed on a folder whenever a new or modified Avid asset is checked in to the Interplay database from a bin.

*The default duration of automatic reservations is set in the Application Database Settings in the Avid Interplay Administrator.*

When you reserve a folder, the system adds a Reservation icon to the folder and sets the reservation on all of the Avid assets in the folder, including any subfolders and their contents. The reservation protects the assets — which include sequences, master clips, and all the media files and metadata files that are associated with them — from deletion and moving.

![Reservation icons on folders in the Media Directory panel](image)

Only the owner of a reservation or the Administrator can remove the reservation or delete or move the contents of a reserved folder. Since folders can have reservations set by multiple users with multiple end dates, you might not be able to move or delete the asset even if you placed a reservation on it. Unless one of the reservations expires or is revoked by the user that created it, only your Interplay administrator can move or delete the asset.
Understanding Restrictions

Restrictions are placed on Avid assets by adding the restrictions to markers in Avid Interplay Assist. A restriction can represent material that should not be used. It might contain material that needs to be used only after rights are available on a certain date, that the organization must pay for upon use, or that has copyright requirements or other legal restrictions limiting its use.

You can see the restriction markers on the clip icons in the Interplay Window and in your bin. Your Avid editing application warns you about the restriction when you display the restricted material in the monitor, perform a digital cut, send it to playback, or export it. You can choose to continue the operation, and you can view the reason for the restriction in the Restrictions tool. You can change restriction comments by using Interplay Assist and then view them in your Avid editing application. For more information on setting restrictions and on using Interplay Assist, see the *Avid Interplay Assist User’s Guide*.

The clip icon of any clip that contains restricted material displays the Restriction icon. For more information about working with restrictions, see “Working with Restricted Material” on page 388.

You can use extended search capabilities to search for restrictions in Avid Interplay Access. Use the DRM property. For general information about searching in Interplay Access, see the *Avid Interplay Access User's Guide*.

Understanding Access Control for Avid Assets

Access control protects assets in a workgroup environment. The Interplay administrator uses the Avid Interplay Administrator application to assign access levels to groups and to particular folders. For example, you might have permission to read, write, and delete some assets, but only have permission to read other assets. For more information, see the *Avid Interplay Engine and Avid Interplay Archive Engine Administration Guide*.

When you check in an Avid asset to the database, the system creates a link to the clip or sequence and displays the link in the Interplay Window. When you create a copy of a master clip or sequence, the system creates a copy of the link.
Each individual link to an asset has its own access control. This means that it is possible to have read/write/delete access to an asset in folder A, but only read access to another instance of the asset in folder B. For example, if a master clip is visible in two folders, one with a reservation and one without, when you delete the master clip in the non-reserved folder, the master clip in the reserved folder (and the related media) is not deleted.

Moving, Copying, Duplicating, and Deleting Avid Assets

You can move, copy, and duplicate clips and sequences to other folders in the Interplay Window in order to group and organize various types of material based on project needs. When you copy clips from one folder to another, any custom columns that you created in the first folder are also copied to the second folder. The custom columns appear in the order in which you created them.

Remember that there is a difference between copying and duplicating:

- When you copy a clip, you create a reference clip (link) to a clip in another folder, and any change you make to the copy affects the original as well.
- When you duplicate a clip, you create a new asset. This asset points to the same media files (audio and video) but is associated with a completely new set of metadata (by default, a new name and new creation date). Any modifications that you make to the duplicated clip, such as adding markers, do not affect the original clip's metadata.

⚠️ Because a duplicated clip points to the same media as the original clip, be careful when deleting duplicated clips that you do not unintentionally delete media.

If you have delete access control within your workgroup, you can delete Avid assets in the Interplay Window and in bins. You can also delete copies of the assets (links). Users without delete access cannot delete assets or perform any tasks that require delete privileges. For more information, see “Understanding Access Control for Avid Assets” on page 1243.

You cannot delete assets that carry reservations. Reservations can only be applied to folders and they apply only to Avid assets (clips and sequences). Also, you cannot delete a relative of a reserved asset. For example, if a master clip is not reserved, but it is used in a reserved sequence, you cannot delete the master clip until the reserved sequence is unreserved. For information on reservations, see “Understanding Reservations” on page 1242.

If you are working with MultiRez, you might see more than one resolution associated with a clip. For information about deleting multiple resolutions, see “Deleting MultiRez Clips and Media from a Bin” on page 1365.

You might need to press F5 to refresh the Interplay Window display to see the updated contents of the folder or bin.
To move clips or sequences from one folder to another:

1. In the Research panel, select the clip or sequence that you want to move.
2. Drag the clip or sequence to the destination folder in the Media Directory panel, and release the mouse button.

To copy clips from one folder to another:

1. In the Research panel, select the clip or sequence that you want to copy.
2. Press and hold the Ctrl key (Windows) or the Command key (Macintosh), drag the clip or sequence to the destination folder in the Media Directory panel, and release the mouse button. This creates a link to the original clip (and thus a copy of the asset) within the new folder.

When you press and hold the Ctrl key or the Command key and drag a clip to make a copy, the system does not append a number to the clip or sequence as it does when duplicating.

To duplicate a clip:

- Right-click the clip or sequence and select Duplicate.

A new copy of the clip or sequence with a new Creation date is created. The system appends a number such as .01 to the end of the name, creating a new name.

⚠️ The duplicated clip refers to the original media; be careful not to delete media accidentally if you delete the duplicated clip.

To delete clips or sequences from a folder or bin:

1. Select the clips and sequences that you want to delete.
2. Press the Delete key or right-click and select Delete.

The Delete dialog box opens, showing information about the selected items.

3. Select the items for deletion.
4. (Option) Delete the associated media files for master clips and effect clips.

You can select both clips and media files for deletion, or you can select only the media files if you want to retain the clips for recapture later.

5. Click OK.

If you choose to delete media files, a message box opens and asks you to confirm the deletion.

6. Click Delete.
Creating Folders and Shortcuts in the Interplay Window

If you have the appropriate rights, you can create folders in the Avid Interplay database to help organize your projects. You can also save time accessing remote assets you use often by creating shortcuts to Interplay folders and catalogs in the Media Directory panel.

**To create a new folder in the Interplay Window:**

1. Right-click an Interplay folder in the Media Directory panel, and select Create Folder.
2. Type a name for the folder and click OK.

**To create a shortcut to a folder in the Interplay Window:**

- Right-click an Interplay folder in the Media Directory panel, and select Create Shortcut.

  The shortcut appears in italic above the Interplay database name in the Media Directory panel.

**To remove a shortcut to an Interplay folder or a catalog:**

- Right-click the folder in the Media Directory panel, and select Delete Shortcut.

  The shortcut is removed.

Modifying the Appearance of the Interplay Window

You can modify the appearance of the Interplay Window to hide the Media Directory panel or to split the tool horizontally (so the Media Directory panel and the Research panel display on the left and right sides of the tool) or vertically (so they display at the top and bottom of the tool). You can also specify which media objects you want to display in the Interplay Window.
Managing Remote Assets with the Interplay Window

Location of the Layout button in the Interplay Window

To modify the display properties of the Interplay Window, do one of the following:
- Click the Layout button until the layout you want displays in the Interplay Window.
- Press Ctrl+L (Windows) or Command+L (Macintosh) until the layout you want displays in the Interplay Window.

Understanding Column Display in the Interplay Window

You can modify the display of columns in the Interplay Window in a variety of ways. You can:
- Sort the information in all of the columns in the media tabs in the Research panel except the Frame column
  The Type column sorts alphabetically based on the type of media object (audio clip, master clip, sequence, subclip).
- Move columns to rearrange their order
- Select individual or multiple columns to be displayed or hidden in the Interplay Window
- Add columns to the display in the Research panel in the Interplay Window in order to display additional properties for media objects
  Available column headings are determined by selections in the Interplay Administrator.
Added columns appear only for the selected folder and for the current work session. If you want to use the same columns the next time you log in to your Avid editing application, you must save a custom layout. See “Using Custom Layouts for the Interplay Window” on page 1256.

- Create new column headings in the Research panel.

New column headings (custom properties) are added to the database. Be careful when creating custom properties. Currently, you cannot delete custom properties, but you can turn off their display.

If the new heading has the same name as a system property or a user property — for instance, FPS (frames per second) — the new column displays the properties for the heading already in the database. You cannot create two headings with the same name.

- Enlarge or reduce the width of any column in the Research panel.

When you change the size of the Frame column, the head frames increase or decrease in size. You must enlarge or reduce all frames in the Research panel together. You cannot change the size of an individual frame.

For instructions on modifying column display in the Interplay Window, see “Modifying Column Display in the Interplay Window” on page 1248.

**Modifying Column Display in the Interplay Window**

**To sort information in columns:**

- Click the column heading. To reverse the sort order, click the column heading again.

**To move a column in the Interplay Window:**

- Click the heading of the column in the Research panel that you want to move, then drag the column to the position you want and release the mouse button.

  The column appears in the new position, and the other columns shift to make room.

**To hide a column:**

- Right-click the column heading and select Hide this Column.

  When you hide columns, they are listed on the menu below the Hide this Column option.

**To display a hidden column:**

- Right-click a column heading and select Show *heading name*. 
To add columns to the Research panel:

1. Right-click a column heading and select Select Working Set of Columns.

   The Select Working Set of Columns dialog box opens. The dialog box displays four sections of properties as defined in the Interplay Administrator, separated by dotted lines: System, Custom, Video Resolutions and Audio Resolutions.

2. Select the columns you want to display.

   For MultiRez clips, you can select a column for each resolution (1:1, DV 25, and so on). See “Single Clip, Multiple Resolutions” on page 1335.

3. Click OK.

   The new columns appear to the right of the existing columns in the Research panel.

To create a new column:

1. Right-click a column heading and select New Column.

2. Type a name for the new column.

   The new column appears to the left of the active column in the Research panel.
To enlarge or to reduce the size of columns:

- Click the border of a column in the Research panel, and drag it to the right or the left to resize it.

**Selecting Values for a Custom Property**

You can select a property value from a list for a custom property rather than typing it in. You can select this value from a column in the Research Panel. Your system administrator needs to first create a custom property in Interplay Administrator and then import an XML file containing the values into Interplay Administrator. For more information, see “Adding a Custom Property” in the *Avid Interplay Engine and Interplay Archive Engine Administration Guide*.

For example, you might want to specify the status of a particular asset. The XML file might contain status values such as Opened, Approved, and so on. In the Research panel, you can click the Status column cell for an asset and select a value rather than typing it in each time.

**To select a value for a custom property in the Research panel:**

1. Make sure your Administrator has set up the custom property and imported the list of values.
2. Right-click a column heading and select Select Working Set of Columns.
   
   The Select Working Set of Columns dialog box opens. The dialog box displays three sections of properties as defined in the Interplay Administrator, separated by dotted lines: System, Custom, and Resolutions.
3. Navigate to the new custom column heading, select it, and click OK.

4. Locate the custom column in the Research panel and click it in the cell for the asset you want to label.

   The list of values for the property appears.
5. Select a value.
   
The value appears in the cell.

6. Select values for additional assets.
Selecting Asset Types

To select asset types and reference clips to display:

1. Right-click the Type column heading in the Research panel and select Set Type Filter.

   You need to right-click the column heading. If you right-click elsewhere in the column, the option does not appear in the context menu.

   The Set Type Filter dialog box opens.

2. Select the asset types you want to display.

3. (Option) Select “Show reference clips” to display objects that are referenced by sequences.

4. Click OK.

5. (Option) Save the layout if you want to preserve your type filter settings.

Media Objects in the Interplay Window

The following table describes the media objects that you can display in the Interplay Window.

<table>
<thead>
<tr>
<th>Media Object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sequences</td>
<td>A clip that represents an edited program, partial or complete, that you create from other clips</td>
</tr>
<tr>
<td>Master Clips</td>
<td>A clip that references audio and video media files formed from captured footage or imported files</td>
</tr>
<tr>
<td>Subclips</td>
<td>A clip that references a selected portion of a master clip</td>
</tr>
<tr>
<td>Effects</td>
<td>A clip that references an unrendered effect that you create</td>
</tr>
<tr>
<td>Rendered Effects</td>
<td>A clip that references an effect media file generated when you render an effect</td>
</tr>
<tr>
<td>Motion Effects</td>
<td>A file in the bin that references effect media files generated when you create motion effects</td>
</tr>
<tr>
<td>Group Clips</td>
<td>(For MultiCamera editing) Clips containing two or more grouped clips, strung together sequentially according to common timecodes</td>
</tr>
<tr>
<td>Show reference clips</td>
<td>Clips and other objects that are referenced by sequences, even if these objects were not previously displayed in the bin.</td>
</tr>
</tbody>
</table>
Renaming Clips in the Interplay Window

You can rename a clip in a folder directly by modifying the information displayed in the Research panel.

*This action also renames copies of these clips. It does not rename duplicated clips.*

**To change the name of a clip:**
1. Click the cell in the Name column that you want to modify.
   The clip row is highlighted.
2. Click the cell again to enter text.
   The pointer changes to an I-beam.
3. Type the new clip name, and press Enter.

Adding Comments in the Interplay Window

You can add comments to the clip information in any media tab in the Research panel to help you keep track of details not displayed in the other columns.

**To add a comment to the Research panel:**

- Click in the Comment column of the clip you want to annotate, and type your comment in the Comment text box.
  You might have to scroll right to see the Comment column.

Updating the Display in the Interplay Window

If material is ingesting as you are working or other people are working in the same project, you might need to update the display in your Avid editing application to see the latest content.

**To update your Avid editing application display:**

- Press F5.
  The Directory panel and the Research panel update to the latest content. In the Research panel, this includes only the tab in front if you have more than one tab. Tabs that are behind the active tab don’t update. If you try to update before a previous update operation has completed, your Avid editing application ignores the second attempt. Search result tabs are also not updated.

**To refresh just the front tab in the Research panel:**

- Click the Refresh button.
Managing Remote Assets with the Interplay Window

The Refresh button on a tab in the Research panel

**To update a search result tab:**
- Execute the search again.

**Navigating to a Folder that Contains a Selected Asset**

You can use a command to navigate (go to) to a folder that contains a selected asset.

**To navigate to a folder that contains a selected asset:**
1. Right-click an asset in the Research panel (any tab) and select Open Enclosing Folder.
   - The Open Enclosing Folder dialog box opens and displays a list of folders that contain the asset.
2. Select a folder and click OK.
   - The folder is selected in the directory tree and the contents of the folder are displayed in a tab in the Research panel, with the selected asset highlighted.

**Updating Writable Properties in the Property Merge Dialog Box**

If you have Write privileges in your Interplay environment, you can change several of the properties associated with assets, for example, Comments or Name. These are called writable properties. If you try to change a writable property that another user modified after you accessed the asset, the Property Merge dialog box opens.
For example, someone else who accessed a clip in Interplay Access after you loaded the same clip in the Research panel might have changed the name of the clip on the server; when you then try to rename that clip, the Property Merge dialog box opens. The change could have been made in any Interplay application, including Assist, Instinct, Interplay Access, or the Interplay Window.

You can view the original status of the writable property, your change, and the current status of the property on the server, and you can choose to update the asset on the server or to update the asset on your system. You can update the asset on the server by merging the changes; you can also can create the text of the change.

**To update your asset with the change from the server:**

- Select Update from Server.

  The asset is updated with the change from the server.

**To update the server with your change:**

1. Select the version of the property you want to see in the Merged Value text box:
   - Original - the state of the asset before you accessed it
   - Your change - this version is selected by default
   - Current (on server)

   You can select any combination of the versions.

   The versions appear in the Merged Value text box in the order in which you select them.

2. (Option) Edit the text in the Merged Value text box to create the change you want.

3. Select Submit to Server.

   The asset is updated with the text in the Merged Value text box.

**Using Custom Layouts for the Interplay Window**

Any time you modify a column, the Interplay Window maintains the custom layout for the individual folder during your current work session. When you quit your session, the customized layout is lost unless you save it. You can apply saved layouts to any display in the Interplay Window. Your Avid editing application uses the last saved layout to display assets in the Interplay Window. Layouts are saved as Interplay user settings.

The Interplay Window also saves the default layout which appears when you first open your Avid editing application. You cannot save or delete the default layout.
To save a layout:
1. Open a folder.
2. Modify the display or the columns according to preference.
3. Click the Layout menu, and select Save Layout As.
   The initial layout name is “Default.” Once you save a layout, the Layout menu displays the saved layout name.
   If you want to save changes to an existing layout, click Save Layout.
4. Type a name for the custom view, and click OK.
   The layout is saved and added to the list of layouts in the Layout menu. You can select any of the saved layouts from the Layout menu.

To change to another saved layout:
- Click the Layout menu, and select a saved menu from the menu list.
  If you select Default, the Interplay Window reverts to the layout that appears when you first open your Avid editing application.

To delete a layout:
1. Click the Layout menu, and select the layout you want to delete from the menu list.
2. Click the Layout menu, and select Delete Current Layout.
   A confirmation box opens.
3. Click Yes.

**Opening Multiple Tabs in the Interplay Window**

When you open a new Interplay folder, its contents replace the current contents displayed in the Interplay Window. If you want to keep the contents of more than one folder open at a time, you can save the Research panel display as a tab in the Interplay Window and then open the contents of the new folder as a separate tab. This way, you can keep multiple folders open at once.

**To open multiple folders in the Interplay Window:**

1. Click the active tab in the Research panel, and then click the Pin button.
   
   The contents of the folder are saved as a tab in the Research panel.
2. In the Media Directory panel, click a new folder.
   
   The folder opens as a new tab in the Research panel.

   ![Image of Interplay Window with tabs]

   Left to right: Media tabs, the Pin button, and the Close button in the Research panel of the Interplay Window

**To close a tab in the Interplay Window:**

- On the tab you want to close, click the Close button.

**Selecting Font Options from the Context Menu in the Interplay Window**

You can change the default fonts and font sizes in the Research panel and the Directory panel from a context menu.

Font changes are saved as user settings and do not affect other systems.
To change the font from the Research Panel context menu:

1. Right-click and select Set Research Panel font.

![Screenshot of the context menu with Set Research Panel font highlighted]

The Select Research Panel Font dialog box opens.

*On Windows XP, the dialog box lets you select and preview options other than Font and Size, but those options do not affect the font in your Avid editing application. You can change only Font and Size.*

2. Select a font and a size, and then click OK.

The font in the panel changes.
To change the font from the Directory panel context menu:

1. Right-click in the Directory panel and select Set Directory Panel font.
   The Select Directory Panel Font dialog box opens.
2. Select a font and a size, and then click OK.
   The font in the panel changes.

Finding Remote Assets

You find Avid assets stored in the Interplay database by searching Interplay folders.

The most common method of finding remote assets is to perform a search based on attributes. The Interplay Window searches for the attributes associated with Avid assets. Each attribute can define statistical information (such as the date) or descriptive information (such as clip name). The search function lets you search by a date, a word, or a few characters.

The database returns the results of any search in the Research panel, which lets you access more detailed information about displayed assets.

You can have multiple searches running at the same time.

Typically, you conduct database searches for Avid assets based on their associated attributes. For example, you could find all master clips modified in the last hour, all sequences in a particular project, or all subclips in a particular project that have the word “feature” in their names.

Interplay Access includes an extended search with additional features for searching the Interplay database.

Performing Searches on Interplay Folders

A search tab is always available in the Research panel (labeled Media Search before you perform a search). You can define your search based on standard media attributes, described in “Search Attributes for the Interplay Window” on page 1262. You can open multiple search tabs and keep the additional tabs open, as described in “Keeping Search Results in the Interplay Window” on page 1263.

To get the best response times for your searches, make them as specific as possible.
To perform a search:

1. Click the Media Search tab.

   ![Interplay Window](image)

   To open an additional search tab, do one of the following:
   - Press Ctrl+F (Windows) or Command+F (Macintosh).
   - Right-click an Interplay folder and select Search. The folder you select is displayed in the Search In field.

2. In the Text field, type a search term.

   You can specify words or characters for your search. Search terms are not case-sensitive and apply to all searchable text attributes of the Avid assets in your search.

3. Expand the Text Fields field and select the kinds of text fields to search in.

4. Expand the Search In field and navigate to the folder you want to search.

   If you do not specify a location, the Interplay Window searches the entire Interplay database.

   If you right-clicked a folder and selected Search, the Search In field displays the name of the selected folder.

5. Expand the Types field and select the type of media object you want to search for.

6. Expand the Category field and select the asset category you want to search for.

   You can select multiple categories.

7. Click the Time menu, and select a time parameter for your search.

   If you accept the default settings and specify no additional attributes, the search returns all clips, subclips, and sequences in the database.
8. Click Search.

The Interplay Window performs the specified search and returns all matching records in the Research panel. The name of the search tab changes to the text that you searched for.

9. (Option) To start a new search, click Reset or open a new search tab. Then repeat steps 2 through 8.

If necessary, click the show/hide arrow in the upper left of the tab to show the Reset button and the search fields.

For information on keeping your search results when you open a second tab, see “Keeping Search Results in the Interplay Window” on page 1263.

**Search Attributes for the Interplay Window**

The following table describes the search attributes available in the Media Search tab in the Interplay Window.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text</td>
<td>User supplied text</td>
<td>Lets you search the following text-based attributes:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Tape</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• VideoID</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Comments</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• User-created fields</td>
</tr>
<tr>
<td>Text Fields</td>
<td>Any system property or custom</td>
<td>Lets you search in any text field you select; Name is selected by default.</td>
</tr>
<tr>
<td></td>
<td>metadata containing a text</td>
<td>field</td>
</tr>
<tr>
<td></td>
<td>field</td>
<td>• Select All</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Clear All</td>
</tr>
<tr>
<td>Search In</td>
<td></td>
<td>Lets you search in any Interplay folder in the database</td>
</tr>
<tr>
<td>Types</td>
<td>Master Clip</td>
<td>Lets you specify the type of media object for your search (you must select at least one type for each search)</td>
</tr>
<tr>
<td></td>
<td>Subclip</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Sequence</td>
<td></td>
</tr>
</tbody>
</table>
Keeping Search Results in the Interplay Window

One search tab is always open in the Research panel. If you want to keep the results of your search after you open a second search tab, you must “pin” the search tab. Pinning the search tab keeps it available if you open a another search tab.

To keep your search results:

1. Click the Pin button.
   - The search results are kept open as a tab in the Research panel.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category</td>
<td>Examples: Weather, Sports, Local News</td>
<td>Lets you specify which category to search. The specific categories listed for this attribute are defined by the system administrator.</td>
</tr>
<tr>
<td>Time</td>
<td>Whenever, Last 10 minutes, Last hour, Last 24 hours, Last week, Last month, Last year</td>
<td>Lets you set a time parameter for your search (time parameters refer to the date the media object was last modified).</td>
</tr>
</tbody>
</table>

Capturing Media to Interplay Folders

By using the Interplay Window to connect to the Interplay database, you can capture media directly to an Interplay folder. You can capture to any folder currently open in the Interplay Window.

- You can open multiple Interplay folders by using multiple tabs in the Research panel of the Interplay Window. For more information, see “Opening Multiple Tabs in the Interplay Window” on page 1258.

To capture media to an Interplay folder:

1. Select Tools > Interplay Window.
2. Navigate to the Interplay folder to which you want to capture media, and click the folder.
   - The Interplay Window displays the Avid assets in the Interplay folder.
4. Set up the Capture tool as described in “Capturing Media” on page 232.

5. Click the Interplay Folders selection button.

6. Click the Bin menu, and select an open Interplay folder.

7. Start capturing as usual.

Using the MediaCentral | UX Messages Window

MediaCentral UX accommodates a number of workflows and gives users the freedom to write, edit, produce, and manage media through a Web-based interface. MediaCentral UX enables a variety of production roles by providing media access and collaborative media production. If you work in a MediaCentral environment, you can share text messages, media assets stored on your Interplay Production database, and links to Internet sites using Universal Resource Locators (URLs) using the MediaCentral UX Messages window.
Using the MediaCentral | UX Messages Window

The MediaCentral UX messaging system allows you to share Interplay Production assets between MediaCentral users within your workgroup. Once you log in to Interplay using the Interplay User Settings dialog box, you can then log in to MediaCentral UX using the MediaCentral UX Messages window.

**Viewing Messages and Linked Media Assets**

The MediaCentral UX Messages window displays all of the messages received from other users logged in to your MediaCentral workgroup. The messages can contain both text and links to Interplay media.

If you log in to Interplay and your MediaCentral credentials match your Interplay user name and password, you do not need to log in to MediaCentral UX separately. If the user name and password used in the Interplay User Settings dialog box are not the same as your MediaCentral credentials, the MediaCentral UX Message window prompts you to log in to MediaCentral UX.

*You must be a MediaCentral client and logged in to Interplay to use the MediaCentral UX Messages window.*

**To view messages:**

1. Select Tools > MediaCentral | UX Messages

   The MediaCentral UX Messages window opens.
If you have signed into Interplay, the MediaCentral UX Messaging pane attempts to log in to the MediaCentral portal associated with your Interplay workgroup using your Interplay credentials. If your Interplay and MediaCentral credentials are different, you must log in to MediaCentral UX before using the message window.

2. If required, type your MediaCentral UX user name and password, and then click Sign In.

The MediaCentral UX Messages window displays the Messages pane, with the most recent messages at the top of the list. A notification bar indicates if you received any new messages since the last time you logged in to MediaCentral UX.

 Messages sent by you display in the message list with a blue background, while messages received by you display with a green background.

3. Click the notification bar if you received new messages. You can also scroll up to display hidden messages.

New messages display at the top of the message list.
4. If the message includes a media asset, do one of the following:
   - Double-click the head frame in the asset area to view the media. You can view master clips, subclips, group clips, and sequences.
   - Drag the head frame from the message to a bin.

The clip opens in the Source monitor or displays in a bin.

**To log out of MediaCentral UX, do the following:**
- Close the MediaCentral UX Messages window.

Quitting your Avid editing application also logs you out of MediaCentral UX.

### Sending Messages

The Messages pane allows you to share both text messages and Interplay Production assets with other MediaCentral users. You can also share messages with editing application users who log on to MediaCentral UX.

When you share an Interplay Production asset, the recipient can double-click the asset to open it in the MediaCentral UX Media pane. An asset shared with an editing application user opens in the Source/Record monitor in the Avid editing application.

You can share links to master clips, subclips, group clips, and sequences. Shared assets must be checked in to Interplay first so other users can view them. MediaCentral UX users cannot see any changes you make to an asset that you have not first checked in to Interplay.

*You must be a MediaCentral client and logged in to Interplay to use the MediaCentral UX Messages window.*
To write a new message and share media assets:

1. Select Tools > MediaCentral | UX Messages

The MediaCentral UX Messages window opens.

If you have signed into Interplay, the MediaCentral UX Messaging pane attempts to log in to the MediaCentral portal associated with your Interplay workgroup using your Interplay credentials. If your Interplay and MediaCentral credentials are different, you must log in to MediaCentral UX before using the message window.

2. If required, type your MediaCentral UX user name and password, and then click Sign In.

The MediaCentral UX Messages window displays the Messages pane, with the most recent messages at the top of the list.
3. In the address text box at the top of the Messages pane, start typing the name of the recipient for your message.

A list of MediaCentral users displays as you type.

Online users are indicated by a green dot next to the name. A red dot indicates an offline user.

*If you type an invalid name, the name changes to red and you receive an error message. You can only send messages to recipients on the MediaCentral user list.*

4. Select a name from the list or complete the name by typing it in the address box.

*You can add multiple names to the address box.*

If you type an invalid name, the name changes to red and you receive an error message. Type the name again or select a name from the list of MediaCentral users that displays when you start typing in the address text box.

5. If you want to share a media asset, click a clip in a bin and drag it to the asset area of the message:

A head frame of video clip or a clip icon for an audio clip displays in the message, along with metadata describing the asset.

You can remove the clip by clicking the Remove button in the asset area.
6. In the message text box, type your message.

A character count below the message displays the number of characters allowed in your message. You can type a total of 256 characters.

7. Click Send.

The message is sent to the MediaCentral users listed in the address text box and displays as a sent message at the top of your message list. Messages sent by you display with a blue background.

**To reply to a message:**

1. Position the mouse pointer over the address line of the message to which you want to reply. The Reply button displays on the right side of the address line.

2. Click Reply.

The address text box in the top of the Messages pane automatically adds the names of the recipients from the selected message.

3. In the message text box, type your message. You can also share a media asset by dragging it to the asset area of the message.
A character count below the message displays the number of characters allowed in your message. You can type a total of 256 characters. If you share an asset, a head frame of video clip or a clip icon for an audio clip displays in the message.

4. Click Send.

The message is sent to the MediaCentral users listed in the address text box and displays as a sent message at the top of your message list.

Performing a Send-to-Playback as a Background Process from an Avid Editing Application

Depending on your workgroup configuration, the send to playback operation of Long GOP OP1a media can run in the background, allowing the Avid editing system to perform other tasks. The workgroup must have an Avid Interplay STP Encode service installed. For information about setting up a workgroup for background processing of send-to-playback requests, see the Avid Interplay Help.

To send assets and media files for playback using an Avid editing application:

1. Make sure the Media Services Engine and Avid Interplay STP Encode service are running.
2. In the Avid editing application bin, select the asset or assets whose media files you want to send to the playback server.
3. Select Transfer > Send To Playback, and select the profile for the server to which you want to send the sequence.

The Send to Playback dialog box opens.

4. Do the following:
   - Type a tape ID name.
   - (Option) Select PWT (Play While Transferring), if you want to send the sequence as a high-priority.
(Option) Select Overwrite, to overwrite the tape ID name in the Interplay Transfer if the same name exists.

Select Use STP Encode to use the STP Encode provider for processing the send-to-playback operation.

The system immediately starts the send to playback operation. If Interplay Access is installed on the Avid editing system, you can track the status of the job by opening Interplay Access, selecting Tools > Interplay Media Services Status, and clicking the Jobs tab.

5. Click OK.
Interplay Synced Projects provide you with a way to link your bins and projects in the editing application with the folder structure for assets stored in your Avid Interplay database. When you make changes in your project, the changes are saved to Interplay. Other users can work on the same synced project and update their bins and folders by updating them from Interplay. With the synced bins and media asset folders updated, you can easily collaborate on projects with other users, adding bins and editing media that you can sync through Interplay. When you share a synced project with a user or a group of users, they can access the same synced bins and media you set up for your project.

A synced project consists of an Avid editing project on your local machine and an Interplay synced project, which consists of a folder hierarchy matching folders and bins in your local project. By default, you create a local project in a folder on your local machine called Avid Synced Projects, which is in the same folder as your Avid Shared Projects. Interplay synced project are created in a root-level folder called Synced Projects. As you create local projects, folders, and bins, you also create corresponding Interplay folders.

To use Interplay Synced Projects with the editing application, you must be a valid workgroup client. For Windows systems, you must have Interplay Access installed as well as either the Avid ISIS Client Manager or the Media Composer | Cloud components installed.

- Synced Projects
- Enabling Interplay Synced Projects
- Working with Synced Projects
- Creating a New Synced Project
- Opening an Existing Synced Project
- Deleting Synced Projects
- Updating a Synced Project
Synced Projects

When you start your Avid editing application and select Synced Project in the Select Project dialog box, you see the list of Interplay Synced Projects you can access, depending on the permissions attached to the projects. Interplay Synced Projects appear locally as synced projects in the synced projects path on your local machine.

Updating and saving a project in the editing application updates the asset folders in Interplay. When you add bins to your project, corresponding folders are created in the Interplay database as subfolders within your project. Clips in your synced project are checked in to Interplay automatically, avoiding the need for using the Unchecked-in Avid Assets folder.

Because synced projects use Interplay to update synced bins and folders, you must be connected to Interplay in order to work with synced projects. You can manually copy your synced project out of the synced projects folder to the shared projects folder on your system and then open it as a shared project, but doing so prevents you from using the functionality of synced projects necessary for collaboration with other users. Also, if you then move your project back to the synced projects folder, you lose any changes made to your project.

Synced project icons identify folders in the Interplay database created from bins in a synced project. The synced project folders function the same way any asset folder does in Interplay. Reservations and restrictions apply to synced folders and media assets as they do for all other assets stored in Interplay. You should restrict changes to your bins and folders to your Avid editing application, allowing Interplay to update with the changes so other users can access the same updated project.
Enabling Interplay Synced Projects

Before you can use synced projects, your Interplay administrator needs to enable the Synced Projects setting in the Interplay Administrator window.

For more information on using the Interplay Administrator, see Avid Interplay Engine and Avid Interplay Archive Engine Administration Guide.
To enable synced projects:

1. Do one of the following:
   - Click the Start button and then select All Programs > Avid > Avid Interplay Access Utilities > Avid Interplay Administrator.
   - From Interplay Access, select Tools > Open Interplay Administrator.

   The Avid Interplay Administrator Server Login screen appears.

2. Select the server you want to work with, type a user name and password, and then click Connect.

   The Interplay Administrator window opens.

3. In the Site Settings section of the Interplay Administrator window, click the Synced Project Settings icon.

   The Synced Project Settings view opens.

4. Select Enable, and then click Apply.

   The application enables synced projects for the selected workgroup.

### Working with Synced Projects

When you enable synced projects, a folder for that project is created in the Synced Projects folder in Interplay. A message warns you if the project name conflicts with an existing project name so you can rename the project.

To create a synced project, you must have write permissions in Interplay. If you have Read/Write or Read/Write/Delete privileges, you can create synced projects. If you have Read Only permission, you cannot create an Interplay project in the Select Project dialog box. Your Interplay
Creating a New Synced Project

Your Interplay administrator must enable synced projects in the Interplay Administrator window before you can create or open a synced project. Also, you must log in to Interplay to create a new synced project and see the list of synced projects to which you have access.

To create a new synced project:

1. Start your Avid editing application.
   
   The Select Project dialog box opens.
2. If you are not already signed in to Interplay, do the following:
   a. In the Host Name text box, type the computer name or IP address of your Interplay server.
   b. In the User Name text box, type a user name.
      This name must be a known user on your workgroup system.
   c. In the Password text box, type your password, and click Login.
      When the blinking yellow light turns green and the Login button changes to the Logout button, you are connected to the Interplay database.
3. In the Select Project dialog box, select Synced.
4. Create a new project. For more information, see “Creating a New Project” on page 156.
5. Click OK.
   Your Avid editing application creates the new project files and folder, and then returns to the Select Project dialog box. The project name is highlighted in the Projects list.
6. Double-click the project name to open the project.
   The Project window, the Composer window, and the Timeline open with your User settings loaded.
Opening an Existing Synced Project

Interplay creates a synced project folder. To view the folder structure in Interplay, open the Interplay Window.

Opening an Existing Synced Project

When you open an Interplay synced project that you have not opened before, your Avid editing application creates a new project based on the settings saved for the project in Interplay. The project contains bins based on the asset folders in the database that the original project created.

When you open a synced project that already exists on your system, the project automatically updates some settings and assets for the project in Interplay. The project automatically updates the core project settings and the folder and bin hierarchy, adding and deleting folders and bins if necessary. Bins update from Interplay when you open them.

Opening a synced project does not check out media assets from Interplay if those assets have not changed.

If the Select Project dialog box displays synced projects that are stored on your local system but which have been deleted from Interplay, a dialog box opens and asks you if you want to convert the projects to shared projects by moving them to the shared projects folder or if you want to delete them. You can choose to move or delete them, or you can click Cancel to keep the project in the project list. The dialog box appears each time you open a new project until you remove the deleted synced projects from your local system.

To open an existing synced project:

1. Start your Avid editing application.
   
   The Select Project dialog box opens.

2. If you are not already signed in to Interplay, do the following:
   
   a. In the Host Name text box, type the computer name or IP address of your Interplay server.
   
   b. In the User Name text box, type a user name.
      
      This name must be a known user on your workgroup system.
   
   c. In the Password text box, type your password, and click Login.
      
      When the Login button changes to the Logout button, you are connected to the Interplay database.

3. In the Select Project dialog box, select Synced.
A list of synced projects displays, depending on your permissions. Synced projects you have opened before are stored on your local system and appear at the top of the project list. Synced projects that you have not opened on your system are listed in the Select Project dialog box as “add [project name].”

4. Do one of the following:
   - Select a project in the Select Project dialog box, and then click OK.
   - Double-click a project name in the Projects list.

The Project window, the Composer window, and the Timeline open with the User settings loaded. The title bar of the Project window contains the project name and the user profile selected in the Select Project dialog box.

For synced projects, one of the following occurs:
- When you open a synced project that you have opened before on your local system, all bins appear in the Project window and are updated from Interplay.
- When you open a synced project for the first time on your system, a dialog box opens and asks if you want to create a local project synced to the Interplay project. Click OK to create a local copy of the synced project.
Deleting Synced Projects

If you delete a synced project, a dialog box provides you with the following options:

- You can delete the project and its folder on your local system.
- You can delete the Interplay project folder, including subfolders, bins, and all media assets in your synced project. This moves the Interplay project folders to the Synced Projects Trash. Your Interplay administrator can then delete the projects from this folder.
- You can delete both the locally stored project and the synced project on Interplay.

If you use Interplay Access to delete the synced project folder while the project is open in the editing application, you can choose from the following options when you close the project:

- You can delete the project on your local system.
- You can convert the project to a shared project.

If you try to open a bin in your synced project that has been deleted from Interplay, the project updates to reflect the deletion. If you move a bin or folder that has been deleted from Interplay, or if you drag an item to a folder that has been deleted, the project updates to reflect the deletion in Interplay.

Deleting bins or folders from a local project moves them to the Trash folder. You cannot use the Empty Trash function with synced projects. In Interplay, deleting assets moves them to the Deleted Items folder. Using Interplay Access, you can delete the Trash folder if you have administrative privileges. Updating your synced project brings changes made in Access to the project on your local system. For information on deleting media assets and folders in Access, see “Deleting Avid Assets and Media” in the Avid Interplay Access User’s Guide.

To delete a synced project:

1. Start your Avid editing application.
   The Select Project dialog box opens.
2. Click the project you want to delete.
3. Press the Delete key.
   A message box opens.
4. Do one of the following:

- To delete the synced project from your local system but keep the project in Interplay, click Local. This moves the project to the bottom of the project list and changes the project name to “add [project name].”

- To delete the synced project from Interplay but keep the project on your local system, click Interplay. A dialog box asks you to move the local project or delete it.

- To delete the synced project from both your local system and Interplay, click Both.

- To cancel the deletion, click Cancel.

If you select Both, the deleted project no longer appears in the Select Project dialog box.

Deleting a project also deletes any bins that are in that project.

Media related to a deleted project is not deleted with the project folder. For more information on deleting media files, see “Deleting Items from a Bin” on page 354 and “Deleting Media Files with the Media Tool” on page 475.

Updating a Synced Project

When you add, move, rename, or delete media, bins, or folders, or edit your sequence, your changes automatically are updated on Interplay. When you make edits to your sequence, you save your changes to Interplay by saving your local sequence or bin, or by allowing the system to automatically save bins based on the Auto-Save settings in the Bin Settings dialog box. You can also update your project with Interplay by closing your project.

When other users make changes to your synced project and update the Interplay database, you can update your project in the editing application by closing and then opening your editing project or by manually updating your project from Interplay by selecting Update Project from Interplay.

When you update your synced project, changes made to the settings and the bin and folder hierarchies are updated. When you sync bins, changes to the clips and sequences in the bin are updated.
When updating bins in your synced project, keep in mind the following:

- Local bins update to match the media assets in Interplay when you open the bins. This update might include adding, modifying, deleting, or renaming items in the bin. You can also update open bins by selecting Update Project from Interplay.

- When you open a synced project, all open bins are updated.

- Whether you update with the Update Project from Interplay command, by closing and opening the project, or by closing and opening a bin, the update operation only affects the items that have changed. This update might miss some property changes on some items. Selecting Bin > Update Bin from Interplay updates all items in the bin, including media property changes.

Saving a sequence in your synced project saves it to Interplay. However, Interplay does not automatically create a new version of your sequence as it does when you save changes to a sequence in a non-synced project. New Interplay versions are created for synced projects only when a sequence is manually checked in to Interplay, or when a different user modifies a sequence in a synced project and checks it in.

When you make changes to your synced project, those changes are saved to Interplay dynamically with the exception of changes to sequences.

To save sequence changes to Interplay, do one the following:

- Click the bin to activate it, and then select File > Save Bin.
- Click the Bins tab in the Project window, and then select File > Save All.

The system saves the selected bins and saves any modified sequences to Interplay.

You might have to refresh the display in the Interplay Window or in Interplay Access to see the changes.

To update a synced project with changes made by other users and saved to Interplay, do one of the following:

- With the Project window active, select File > Close Project, and then open the project again.
- Click the Close button in the Project window, and then open the project again.
- Right-click in the Project window, and then select Update Project from Interplay.
- To update the contents of a bin, close the bin, and then open it again.

To update all the items in a bin, whether the items have changed or not, do the following:

- Select a bin, and then select Bin > Update Bin from Interplay.
When you use Media Composer Cloud, you can edit media either stored locally on your system or stored on an Interplay server back at your production facility or broadcast station. With Media Composer Cloud, you connect to your Interplay server by way of a Virtual Private Network (VPN) using either a Wi-Fi or a wireless connection. The ability to edit both local and remote media allows you to create and edit your sequence in the field, using all of the media captured from your camera locally as well as the media available in your Interplay database.

Using Media Composer Cloud, for remote editing also provides for the quick uploading of your content from the field and checking it in to Interplay as you work. The transfer of media assets works automatically and in the background so that you can continue editing without having to spend your time creating separate output files, compressing sequences, uploading files to a server, and checking them in to Interplay.

*Media Composer | Cloud is not supported in Avid Unity MediaNetwork configurations.*

The remote editing workflow consists of all or some of the following components, depending on your configuration and needs:

- Installation and configuration of an Avid editing remote applications on a local computer.
- Configuration of Interplay servers to support remote editing.
- Access to a remote broadcast or production facility network using a Wi-Fi or mobile connection and a VPN protocol.
- Access to an Interplay system using the Avid editing application installed on a local system.
- Ability to browse and use media stored on the Interplay system.
- Creation of remote Avid Media Access (AMA) clips. These clips use a configured MediaCentral Platform Services (MCS) server to stream media from the remote Interplay system to the local computer for editing.
- Edit both remote clips and local media in a single sequence.
- Background consolidate or transcode of the sequence prior to uploading remote clips to Interplay. This creates a sequence with locally-managed clips.
• Check in of consolidated sequence to Interplay. Clips are transferred to the Interplay system using a local transfer manager service that runs in the background without the need of additional configuration. The remote upload service can first upload clips at a proxy resolution, and then upload the full-resolution clips when time and bandwidth allow. The clips are automatically checked in to Interplay.

• Check out the uploaded clips at the broadcast or production facility. You need to use dynamic relink to link the uploaded clips to the uploaded media files now checked in to Interplay.

You can also download remote clips and then edit with Media Composer Cloud while your system is disconnected from Interplay Production. For information on downloading remote clips, see “Using Remote Download” on page 1305.

The following workflows are not supported with Media Composer | Cloud while working as a remote client:

• Editing or playing in-progress clips (edit while capture media)
• Editing or playing multicamera media
• Performing a digital cut or exporting sequences that include remote media

For more information, see the following topics:

• Working with Remote Editing
• Using the Disk Cache to Manage Cached Media
• Setting Playback Quality for Remote Media
• Uploading Media Using the Remote Upload Service
• Media Composer | Cloud and Dynamic Relink
• Upload/Download Queue Dialog Box
• Using Remote Download
• Send-to-Playback and Media Composer | Cloud (Windows Only)
• Supported Project Types and Formats

**Working with Remote Editing**

There are several configuration steps you need to complete before you can access remote media or upload clips to Interplay using the Media Composer Cloud, workflow with your Avid editing application. Before you start using remote editing features, you should have installed and configured your Interplay applications and services. These services must be running before you start the editing application.
The remote editing feature does not require that the Avid Unity ISIS Client Manager is installed on your system. However, if you have installed Client Manager, you should not mount any ISIS workspaces.

**Configuring Interplay Settings on the Remote Editing System**

You need to specify three Interplay settings before you can view or use remote editing:

- **Interplay Server** — Use this setting to specify the computer name of the Interplay Server.
- **Interplay User** — Use this setting to specify the Interplay user account to use when logging into Interplay.
- **Interplay Folder** — Use this setting to specify where assets are checked into the Interplay database when you use remote upload function.

You need to log in to the Interplay database through the Interplay User setting before you can specify the Interplay Folder settings.

**To configure Interplay settings:**

1. Start your Avid editing application.
2. Click the Settings tab in the Project window.
   
   The Interplay Server Settings dialog box opens.

   ![Interplay Server Settings](image)

4. In the Interplay Server Name text box, type the computer name or IP address of your Interplay server, and then click OK.
   
   It is important to type the correct computer name or IP address. This is the location where the editing system looks to access the database and to check in and check out Avid assets.

5. In the Settings list, double-click Interplay User.
   
   The Interplay User Settings dialog box opens.
6. In the User Name text box, type a user name.
   This name must be a known user on your workgroup system.

   *The Interplay user must also be listed as an ISIS client with read/write privileges in order to use the remote upload functionality of Media Composer Cloud.*

7. Select “Automatic Login at Project Selection” if you want to log in to the Interplay database automatically every time you open a project.
   If you do not select this option, you must open this dialog box when you want to access the database.

8. Click Login to establish the connection to the Interplay database.
   The Interplay Login dialog box opens, with the server name you specified in the Interplay Server Settings as the Host Name.

9. In the Interplay Login dialog box, select Remote Client, and then type your password, and click OK.
   When the blinking yellow light in the upper left of the dialog box turns green, you are connected to the Interplay database and the dialog box closes.

10. In the Project Settings, double-click Interplay Folder.
    The Interplay Folder Settings dialog box opens.
11. Click the Set button, and a directory tree is displayed for the Interplay database that you logged in to.

12. Select a folder to use as the default Interplay Root Folder for your project and click OK. The Interplay Folder setting defines where assets are checked into the Interplay database when you use the remote upload function. Interplay checks media in to a subfolder of the folder you specify in this dialog box. The subfolder is named after the bin whose assets you are checking in.

13. (Option) Select options to verify the directory path.
- On login: If this setting is selected, a message box asks you to confirm the directory path after you log in to Interplay. Select “for new projects only” if you want this message box displayed only after you create a new project.
- On first checkin: If this setting is selected, a message box asks you to confirm the directory path the first time you check in from a project. This message is displayed once each time you work in a project.

14. Click OK.

**Interplay Settings for the Media Composer | Cloud User**

For users to play back remote media from their Interplay | Production system, the Interplay administrator must set two matching user credentials, one in the Application Settings in the Interplay Administrator tool and the other in System Settings in MediaCentral | UX. The credentials must be identical and unique for Media Composer Cloud users. For more information, see your Interplay or MediaCentral administrator.

*The Interplay user must also be listed as an ISIS client with read/write privileges in order to use the remote upload functionality of Media Composer Cloud.*
Stopping and Starting Media Indexer on a Mac OS X System

In an Interplay environment, if your Avid editing application cannot connect to the Media Indexer running on your system the application displays the following message when it starts: “Could not connect to the Media Indexer. Verify the health of the Media Indexer service.” Failure to connect to the Media Indexer prevents the application from finding the online media for your project. To correct this problem, you need to stop and then restart the Media Indexer service.

For Media Composer Cloud users, you need to restart the Media Indexer service when the IP address of your system changes — for example, when you switch from an Ethernet connection to a wireless (Wi-Fi or 4G) connection.

You must be logged in to your Mac OS X system with an administrative account to stop and restart the Media Indexer service.

To stop and restart the Media Indexer service using the Terminal window:

1. Open a Terminal window by selecting Applications > Utilities > Terminal.
2. At the prompt, type the following and press Return:
   
   `cd /Applications/Avid\ Media\ Indexer/bin`

3. The Terminal window might prompt you for your password. Type your administrative password and press Return.
4. To stop the service, type the following and press Return:
   
   `sudo ./mi.sh remove`
   
   The Media Indexer service stops.

5. To restart the Media Indexer service, type the following and press Return:
   
   `sudo ./mi.sh install`
   
   The Media Indexer service restarts. You might have to wait up to 30 seconds for the service to complete the restart operation.

Using Remote Media

Once you configure the Interplay settings on your Avid editing application, you can remotely view, play, and edit media checked in to Interplay. When you access Interplay assets remotely, audio and video master clips are streamed to your remote system using the MediaCentral Platform Services (MCS) server.

Depending on your connection, it might take up to 30 seconds to connect to the Media Indexer when you first open your Avid editing application or when you first open the Interplay Window. If you experience a delay and a message box opens, you can choose to Cancel the operation or to Wait. If you select Wait, the connection to Media Indexer should complete after a few moments.
Remote clips and subclips use icons different from the usual clip icons to differentiate them from local master clips and clips checked out of Interplay.

To access remote media clips:

1. In the Settings list, double-click Interplay User and log in to Interplay.
   If you have not configured your Interplay settings, follow the procedure in “Configuring Interplay Settings on the Remote Editing System” on page 1286.
2. Select Tools > Interplay Window.
   The Interplay Window opens.
3. Open your Interplay project folder and drag a clip to your bin.
   Remote master clips appear in bins with the remote clip icon.

Limitations on Remote Playback

Clips that you access from a remote location play back the same as locally managed clips. However, because the MCS streams clips to your Avid editing application, your Internet connection might cause some slowness while playing back clips. Avid recommends using either a Wi-Fi network connection or a 4G wireless connection.
The following limitations also apply to remote playback:

- Remote sequences that include rendered effects play back on the remote client without the rendered media. However, sequences maintain the data for the effects. To view an effect, you can render it on your system. You then need to render any locally-rendered effect again once you relink your uploaded media to the source media back at the station or production facility.

- Remote clips that include an alpha channel — for example, titles — do not play back on the local system. You can, however, use Avid Access to acquire the media from your Interplay system, open the clip in a bin, and use the Re-create Title Media command to regenerate titles locally. For information on how to generate title media, see “Re-creating Title Media” on page 560.

- If there are tracks in your sequence you do not need to play back, you can disable those tracks. For example, if your clip has eight audio tracks but you only need to monitor two of those, you can make the others inactive by deselecting the Active/Inactive buttons for the tracks in the Track Control panel. Avid recommends that you limit your video streams to two and your audio channels to four to optimize playback performance.

- You can set the playback quality of your remote media to Low (the default setting) or High. You should only play back remote media at high quality when your connection to Interplay supports high resolution playback — for example, if you have an Ethernet connection to your Interplay system. For more information, see “Setting Playback Quality for Remote Media” on page 1293.

### Using the Disk Cache to Manage Cached Media

When you remotely play back media from your Interplay environment, the Avid editing application caches media to enhance playback performance. The application stores the cached media in a folder on your local system called CloudCache so that each subsequent playback of the clip proceeds smoothly. The cache folder can fill up quickly with unneeded media files, so the editing application deletes the cached files periodically. You can control the size of the cache folder and you can clear the cache manually if needed.

You can also clear the cache both locally and on the MCS system that streams the remote media if you want to ensure that the media playing back reflects the most current version of your sequence.

**To configure the Media Composer Cloud cache settings:**

1. Click the Settings tab in the Project window.
2. Double-click Cloud Playback.
   
   The Cloud Playback Settings dialog box opens.
3. If you want to change the default folder for cached media files, click Browse and navigate to the appropriate folder on your system.

4. If you want to modify the maximum size of the cache folder, click the Disk Cache Size text box and enter a new number. The default size is 2 GB.

**To clear the disk cache of cached media:**

1. Click the Settings tab in the Project window.

2. Double-click Cloud Playback.

   The Cloud Playback Settings dialog box opens.

3. Click Clear Local Caches.

   The Avid editing system deletes all files in the CloudCache folder. The folder is recreated the next time you play back remote media.

**To refresh the remote media cache on your local disk and the MCS system, do one of the following:**

- Right-click a clip or sequence in the bin, and then select Refresh Remote Media.
- Select Bin > Refresh Remote Media.

   The Avid editing system deletes all files for the clip in the CloudCache folder and on the MCS system. The folder is recreated the next time you play back remote media.
Setting Playback Quality for Remote Media

You can choose to play back either low or high resolution remote media. The default setting is Low. You should only play back remote media at high quality when your connection to Interplay supports high resolution playback — for example, if you have an Ethernet connection to your Interplay system. If your connection appears slow, set the playback quality to Low.

If you change your playback setting from Low to High, you must clear the media cache and reload your clip in the Source/Record monitor. For information on clearing the cache, see “Using the Disk Cache to Manage Cached Media” on page 1291.

To set the playback quality for remote media:

1. Click the Settings tab in the Project window.
2. Double-click Cloud Playback.
   
   The Cloud Playback Settings dialog box opens.

3. Select either Low (the default setting) or High.
4. Click OK.

Uploading Media Using the Remote Upload Service

You can use Media Composer Cloud to upload clips and segments within sequences stored on your system and check them in to Interplay using a VPN connection. The upload operation automatically transcodes your media to the resolution specified in the Cloud Upload Settings dialog box and stores the transcoded media in a folder called Avid Transcode. When you upload a sequence, only the segments of clips used in your sequence are transcoded.

When you remotely upload sequences or clips, the Avid editing application creates a new subfolder in Interplay as a destination for the uploaded clips. The Upload folder is located in the Interplay folder named for your bin. All uploaded clips appear with an appended tag to indicate their upload status. For example, if you use a clip called ClipA in a sequence stored in Bin1, enable Remote Sync, and then save Bin1, ClipA is uploaded to the subfolder Bin1/Upload with
the clip name ClipA,upload, n, where n is incremented each time Bin1 is saved and ClipA is uploaded during the Remote Sync operation. This prevents your bin folder in Interplay from filling up with multiple versions of your uploaded clip.

---

### In the Avid editing application

**Bin1**

- ClipA

---

### In Avid Interplay

**Bin1\Upload**

- ClipA,upload,1
- ClipA,upload,2
- ClipA,upload,3

---

When you remotely upload a sequence, the following occurs:

- The clips in your sequence are uploaded and checked in to Interplay. The operation only uploads the frames from the segments used in the sequence.
- If your sequence uses multiple clips, each segment is transcoded separately. The upload service then creates one job for each transcoded clip, which are listed in the Upload/Download Queue window.
- The upload service checks to see if the clip being uploaded already exists in the Interplay database at the requested resolution. If it does, the job is marked as complete and the Upload/Download Queue window displays the message, “Clip Already Exists.” When the segment selected for upload composes part of a larger clip, the upload service checks to see if the clip that is already checked in to Interplay includes the selected frames in the clip you want to upload. If so, the service marks the upload as complete. You can click the Details button in the Upload/Download Queue window to view information about the completed upload.
- If you enable Start Remote Sync Sequence, you can automatically upload sequence content when you make a change to the sequence by adding a new clip or modifying the frames contained in a segment — for example, by trimming a clip. The sync operation starts when the bin containing the sequence is saved. Remote sync does not upload clips that have not changed, although they do appear in the Upload/Download Queue window as completed jobs since they already exist in the Interplay database. For more information on remote sync, see “Syncing Sequences” on page 1300.
- When Remote Sync Sequence is first enabled for a sequence, the sequence begins uploading immediately. Subsequent changes to the sequence are uploaded when the bin containing the sequence is saved (either manually or automatically).
- Because the uploaded proxy clips still point to the source clips on your local system, you need to enable dynamic relink from the production facility and relink to the online resolution in order to view the media from systems other than your local system.
Limitations on Remote Upload and Remote Download

The following limitations apply to remote upload:

- You cannot upload or download effects and precomputes for rendered effects and titles.
  - You must render all effects and sequences at the production facility that includes your Interplay environment or render the downloaded effects once the download completes.
  - For imported graphics with alpha channels — for example, titles and matte effects — you must re-import any graphics that contain alpha channels. If you are working on a remote Media Composer Cloud system, a user at the station or broadcast facility might need to send you the graphics so you can re-import them into the sequence.
  - If you have a sequence with title media, checking in the sequence to Interplay or downloading the sequence from Interplay does transfer metadata for the title with the sequence. Once the operation completes, you can either check out the sequence at the production facility or import the title media on your remote system, and then use the Re-create Title Media command to restore the title to your sequence. For information on how to generate title media, see “Re-creating Title Media” on page 560.
  - For Avid key effects — for example, ChromaKey, Animatte, and Spectramatte effects — you only need to render the effects once the download or upload completes.

- You cannot automatically transcode and upload sequences with mixed frame rates. You must first manually transcode clips with frame rates different from the project frame rate.
- You can only transcode and upload audio clips in the PCM (MXF) format. WAVE (OMF) and AIFF-C (OMF) audio files are not supported.
- Audio transcode defaults to an audio bit depth of 16 bits. If your audio clips uses a different bit rate you should select the Same As Source setting in the Cloud Upload settings dialog box.
- Audio transcode defaults to an audio sample rate of 48 kHz. If your audio clips uses a different sample rate you should select the Same As Source setting in the Cloud Upload Settings dialog box. You cannot transcode audio clips to a 44kHz sample rate.
- For more information on limitations on remote upload, see “Supported Project Types and Formats” on page 1310 and the Avid Media Composer | Cloud ReadMe.

Uploading Media

You can upload clips and sequences at specified resolutions. The remote upload operation transcodes your media and uploads clips in the background so you can continue working on your project.
When you upload media from your remote system to your Interplay environment, you can select which workspace you want to use for your upload. If your Interplay administrator sets the workspace options in the Interplay Administrator window, you can select a workspace from a menu in the Cloud Upload Settings dialog box. If the workspace options have not been set, you can type the name of the workspace in the Workspace text box. For more information, see your Interplay administrator.

**To upload a clip or sequence from a remote client and check it in to Avid Interplay:**

1. Open a bin with a clip or sequence you want to upload.
2. Right-click the clip or sequence, and then select Remote Upload.
   
   The Cloud Upload Settings dialog box opens.

3. Select the appropriate options for your upload, including the upload quality, the local volume used for creating the proxy media, and a priority for upload jobs. For a description of upload options, see “Cloud Upload Settings” on page 1451. For information on selecting the Interplay workspace for remote uploads, see “Selecting the Upload Workspace” on page 1298.

4. Do one of the following:
Select a workspace from the Workspace menu.
Type the name of your workspace in the Workspace text box.

5. Click OK.

The Remote Upload Service begins to upload your clip or sequence, and the Remote Sync Progress button changes to a revolving icon to indicate the remote upload is in progress.

6. To view the progress of the upload operation, select Tools > Upload/Download Queue. The Upload/Download Queue window opens and displays all current jobs.

![Image of Upload/Download Queue window]

7. (Option) If you upload multiple clips and want to change the upload priority of one or more clips — for example, to upload the most important clips first — click the Priority menu and select one of the following:

- High Priority
- Normal Priority
- Low Priority

You can change the priority of your upload at any time during the transcode and upload operation. Changing the priority does not affect an upload operation currently in progress.
Selecting the Upload Workspace

When you upload media from your remote system to your Interplay environment, you can select which workspace you want to use for your upload. If your Interplay administrator sets the workspace options in the Interplay Administrator window, you can select a workspace from a menu in the Cloud Upload Settings dialog box in your Avid editing application. If the workspace options have not been set, you can type the name of the workspace in the Workspace text box.

To set the available workspaces for remote upload:

1. Do one of the following:
   - Click the Start button and then select All Programs > Avid > Avid Interplay Access Utilities > Avid Interplay Administrator.
   - From Interplay Access, select Tools > Open Interplay Administrator.

The Interplay Administrator Server Login screen appears.

2. Type the name of the server that you want to log in to. You can also use an IP address.
3. Type a user name and password for an account with administration rights.
4. Click Connect.

   The Interplay Administrator window opens.

5. In the Application Settings area of the Interplay Administrator window, click the Media Composer | Cloud Settings icon.

   The Media Composer | Cloud Settings display in the Interplay Administrator window.
6. Select a workspace from the Add menu, and then click Add.
   The workspace displays in the Active list.
   Repeat this step for each workspace you want to add.

7. Click Apply Changes.

**To select a workspace for remote upload:**

1. In Media Composer, open a bin with a clip or sequence you want to upload.
2. Right-click the clip or sequence, and then select Remote Upload.
   The Cloud Upload Settings dialog box opens.
3. Do one of the following:
   - Select a workspace from the Workspace menu.
   - Type the name of your workspace in the Workspace text box.
4. Click OK.

**Syncing Sequences**

You can set the sequence you work on to update the clips checked in to Interplay every time you save your bin. When you make a change in your sequence with remote sync turned on, your Avid editing application automatically initiates a new remote upload operation so that the clips checked in to Interplay match the clips used in your sequence. Syncing your sequence checks in the clips to Interplay, but it does not automatically check in the sequence. Sequences get checked in to Interplay only when you remotely upload the sequence itself.

When you upload and sync sequences, the sequence icon in the bin changes to a remote sequence icon.
To sync a sequence with Avid Interplay:

1. Do one of the following:
   - Right-click the sequence in the bin, and then select Start Remote Sync Sequence.
   - Click the Start Remote Sync Sequence button in the Timeline.

The Cloud Upload Settings dialog box opens.
2. Select the appropriate options for your remote sync operation. For a description of upload options, see “Cloud Upload Settings” on page 1451.

3. Click OK.
   The Remote Upload Service begins to sync your sequence with the clips already checked in to Interplay, and the Remote Sync Progress button changes to a revolving icon to indicate the sync is in progress.

4. To view the progress of the sync operation, select Tools > Upload/Download Queue.
   The Upload/Download Queue window opens and displays all current jobs.

To stop remote sync:
1. Do one of the following:
   ▶ Right-click the sequence in the bin, and then select Stop Remote Sync Sequence.
   ▶ Click the Stop Remote Sync Sequence button in the Timeline.

Media Composer | Cloud and Dynamic Relink

When you upload media to your Interplay environment at the broadcast station or production facility, you use dynamic relink to link the clips in your sequence to the high resolution uploaded media.
To use dynamic relink, you need to transfer your remote media to your Interplay environment using a standard Ethernet connection.

Because the clips in your sequence initially link to the source clips’ original location and not to the uploaded media, they might display as offline when you open your sequence back at the station or production facility, or when you open the sequence from another remote system, unless you first enable dynamic relink. If you check the clips in Interplay Access, you might see the file paths for uploaded clips point to their original remote editing location, and the status of the media displays as offline or not available in the target resolution. You use dynamic relink to resolve the links between the sequence and clips checked in to Interplay and the uploaded media:

1. On a system at the station or production facility where you uploaded your media, enable dynamic relink in the Dynamic Relink Settings dialog box. Set the appropriate target and working settings for your project so that the clips used in your sequence correctly link to the online (uploaded) media.

2. Open your sequence in an Avid editing application.

3. Check in your sequence to Interplay.

4. To update the file paths in Interplay Access, you need to update your media by either right-clicking your clips in your bins and selecting Update from Interplay, or right-clicking your master clips in Access and selecting Update Status from Media Indexer.

For more information on dynamic relink, see “Using MultiRez and Dynamic Relink” on page 1327.

There are some differences in how dynamic relink functions with the clips you upload remotely as opposed to with standard MXF media clips:

- Unlike typical dynamic relink operations, relinking with AMA media clips requires that you first load the clips associated with the AMA clip in a bin before you can relink.

- For some formats, AMA clips might not provide full media quality description. In this case, the Avid editing application relinks your clip to the available media that most closely matches the dynamic relink settings, ignoring any unspecified parameters.

- Dynamic relink always privileges managed media (Avid media that you have captured, consolidated, or transcoded) over linked AMA media because the quality of managed media is higher than linked AMA clips. Dynamic relink always selects managed media corresponding to an AMA clip if it is available and has been indexed by the media indexer.

Upload/Download Queue Dialog Box

The Upload/Download Queue dialog box displays the status of all media selected for remote upload.
### Element Description

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Tool menu</td>
<td>Provides options for the Upload/Download Queue window:</td>
</tr>
<tr>
<td></td>
<td>• Clear Inactive Jobs — clears the Upload/Download Queue window of all jobs not currently transcoding or uploading.</td>
</tr>
<tr>
<td></td>
<td>• Show Job Groups — allows you to display or hide specific job groups listed in the menu.</td>
</tr>
<tr>
<td>2 Clip or Sequence name</td>
<td>Lists either the name of the uploaded sequence above the clips within the sequence or the name of the uploaded clip.</td>
</tr>
<tr>
<td>3 Cancel/Resume button</td>
<td>Changes from a Cancel button (for upload operations) to a Resume button (for suspended uploads).</td>
</tr>
<tr>
<td>4 Completed icon</td>
<td>Indicates that the upload operation has completed successfully.</td>
</tr>
<tr>
<td>5 Progress bar</td>
<td>Displays the percentage of the transcode and upload processes that have completed.</td>
</tr>
<tr>
<td>6 Priority menu</td>
<td>Sets or modifies the priority level assigned to an uploaded clip or sequence. Options are High Priority, Normal Priority (default), Low Priority. The priority level affects which clips get uploaded first.</td>
</tr>
</tbody>
</table>
Using Remote Download

Media Composer Cloud allows you to play media checked in to your Interplay Production system at the station or production facility. You can also download remote sequences, clips, or subclips to a local drive on your Media Composer Cloud client system using the remote download feature. This allows you to edit the remote media locally even when you do not have a connection to Interplay Production.

When you download a remote master clip, the whole clip is copied to your system. When you download subclips or sequences, only those parts of the source master clips used by the subclip or sequence are downloaded, along with the specified handles for your media.

When you download media from Interplay Production to your system, the resolution that downloads is the resolution that matches the dynamic relink settings specified in Media Composer. You cannot specify a different resolution for your download.

You must have dynamic relink enabled to use the remote download feature.

After the job is finished and you reload the downloaded media in the Source/Record monitor, the remote clip icon in the bin changes to the standard clip icon to indicate that the media is now local, and Media Composer uses the relinked local media. Once you reload the clip in the monitor, you can disconnect from Interplay Production and use the local media that you downloaded.

To download remote media to your system:

1. Select a remote clip or sequence in your bin. Ctrl+click (Windows) or Cmd+click (Macintosh) multiple clips to add them to your selection.

   Remote clips are identified in the bin by the remote clip icon.

2. Do one of the following:
   ▶ Select Bin > Remote Download.
   ▶ Right-click the clip or sequence and select Remote Download.

The Cloud Download Settings dialog box opens.
3. Set the appropriate options for your download:
   - Local Volume — Select a local drive to store the downloaded media.
   - Priority — You can select High, Normal, or Low for the download priority (the default is Normal). The priority level affects which clips get downloaded first.
   - Handles — You can specify a handle for the clip in frames (the default is 30 frames).
4. Click OK.
   Media Composer Cloud initiates a download of the media that includes all cuts (including handles) from the Interplay Production database at the station or production facility.
   If you do not have dynamic relink enabled, an dialog box informs you that you cannot use the downloaded media. You can click Cancel, enable dynamic relink, and then start the download again.
5. To view the progress of the upload operation, select Tools > Upload/Download Queue. The Upload/Download Queue window opens and displays all current jobs.
6. (Option) If you have multiple download jobs and want to change the priority a job so that it downloads before other jobs, click the Priority menu and select one of the following:
   - High Priority
   - Normal Priority
   - Low Priority
   Priority applies to jobs. If your download job includes multiple clips, you cannot change the priority on individual clips.
You can change the priority of your download at any time during the download operation. Changing the priority does not affect a download operation currently in progress.

7. When the process completes, reload the media from your bin to the Source/Record monitor to use the local copy of your downloaded media.

You must reload the downloaded clips or sequences in the monitor to relink it to the local media. If you disconnect from Interplay Production before you relink your clips, Media Composer cannot use the local media.

Send-to-Playback and Media Composer | Cloud (Windows Only)

You can send media files on your Media Composer Cloud client system to a workgroup playback device or to a generic file transfer protocol (FTP) playback location. Before you can begin a send-to-playback operation, you must install the standalone Interplay Transfer client software and configure your settings in the Transfer Settings dialog box. For information on installing and configuring Interplay Transfer, see the Media Composer Cloud Installation and Configuration Guide.

You must connect to your Interplay system before you can use remote send-to-playback.

The send-to-playback functionality has the following limitations when using Media Composer Cloud:

- To use the send-to-playback functionality from a Media Composer Cloud remote client, you must have sufficient bandwidth for the transfer. Depending on the stability and bandwidth of your connection, you might not experience the same performance you would with an installation of the standalone Transfer client in a typical, non-remote configuration.
- Using the STP Encode or Play While Transferring options is not supported.
- You cannot use remote send-to-playback for incoming transfers, ingest operations, or workgroup to workgroup transfers.

When you want to send a sequence on your Media Composer Cloud system to playback, you can use the standalone Interplay Transfer to send your media to playback directly from your remote client, using a basic Send to Playback command from Media Composer Cloud to a playback device or a general FTP site. However, if most of the media in your sequence is already available at your facility, it might be more practical to send the sequence to playback from your broadcast facility.

The following procedure assumes you have installed the Interplay Transfer standalone client application and configured your transfer settings.
To send assets and media files for playback using Media Composer Cloud:

1. Make sure you are connected to your Interplay system.
2. In the Avid editing application, click the Settings tab in the Project window.
3. Double-click Transfer in the Settings list.
   The Transfer Settings dialog box opens.
4. Click the TMClient.ini tab.

5. In the Other Workgroups area, click Add.
   The Add Workgroup To List dialog box opens.
If you want to edit the names of any of the Interplay Transfer servers or workstations listed in the Other Workgroups area, select the name, click Edit, and make the changes.

6. In the Server text box, type the computer name of other workstation, and in the Workgroup text box, type the name you want to see in the Transfer menu.

7. Click OK.

   The name you typed displays in the Other Workgroups list.

8. Click OK to close the Transfer Settings dialog box.

9. Select the sequence you want to send to a playback device or FTP location.

10. Select Transfer > Send To Playback, and select the profile for the server to which you want to send the sequence.

    The Send to Playback dialog box opens.

11. Do the following:

    ▶ Type a tape ID name.

    ▶ (Option) Select Overwrite, to overwrite the tape ID name in the Interplay Transfer if the same name exists.

12. Click OK.

    The system immediately starts the send to playback operation.
Supported Project Types and Formats

For information on the supported Project types and Formats for Media Composer Cloud, see the Media Composer / Cloud ReadMe.
Using Interplay Transfer to Export Media

Avid Interplay Transfer lets you transfer Avid assets to and from another workgroup, send finished sequences to a configured playback device, and capture media from a configured ingest device. You can also use Interplay Transfer in a standalone environment (an environment other than Avid shared storage) to move Avid assets between workstations.

When you use Interplay Transfer in a workgroup environment, you can use several types of transfers.

- You can perform a transfer from within the Avid editing system to another workgroup or playback device. See “Transferring Avid Assets from an Avid Editing Application” on page 1320.
- You can transfer finished sequences to a configured playback device. See “Transferring Avid Assets to a Playback Device” on page 1320.
- You can edit media during the capture process. See “Frame Chase Capture” on page 247.
- You can monitor the transfer of items from an Avid editing application so you can see the assets you transferred. See “Monitoring Transfers from Within the Avid Editing Application” on page 1324.
- You can also perform other transfer operations from Interplay workgroups to your editing application, from ingest devices, from FTP servers, and between Avid MediaManager workgroups and Avid Interplay. For complete information on using Interplay Transfer, see the Avid Interplay Transfer Setup and User’s Guide.

Installing the Interplay Transfer Client Software

You must install the Interplay Transfer client software on each Avid editing client in the workgroup that plans on transferring Avid assets to another workgroup or playback device.

Depending on your workflow and workgroup environment, you might need to install one of the Interplay Transfer support software products. If your workflow requires auto transferring of assets, you need to install the Avid Interplay Auto Media Services service that includes the Auto Transfer service. If you want to monitor transfers from a standalone system on your network, you should install the Avid Interplay Media Services and Transfer Status software.
Setting Transfer Settings in the Avid Editing Application

For more information on installing Interplay Transfer, see the *Avid Interplay Transfer Setup and User’s Guide*.

### Setting Transfer Settings in the Avid Editing Application

To activate Interplay Transfer each time you start your Avid editing application and to have the application notify you of incoming transfers:

1. In the Avid editing application, click the Settings tab in the Project window.
2. Double-click Transfer in the Settings list.
   
   The Transfer Settings dialog box opens.
3. Click the Settings tab.
4. In the Standalone/Incoming Requests area, do one of the following:
   - Select “Refuse All Requests,” if you do not want to receive files from another workgroup.
   - Select “User Dialog To Accept/Refuse,” and one of the following methods for accepting transfers:
     - Wait for User Action (No Timeout) — You receive a message request for a transfer. You must click OK for the transfer to occur.
     - Accept After Timeout — The system automatically accepts the file after the timeout.
     - Refuse After Timeout — The system does not accept the file after the timeout.
- In the Timeout (seconds) text box, type the amount of time you want to set for the timeout.

5. In the Status Window area, do the following:
   a. In the text box, type the number of seconds you want the status window to update.
   b. (Option) Select “Bring up window if error occurs” if you want errors to display.

6. (Option) In a workgroup environment, if you want mixed-resolution items highlighted in the bin, select “Highlight mixed-resolution items” in the Send to Playback area.

   If a sequence contains DV 25 and DV 50 media within the same sequence, that sequence is highlighted in red in the bin. Interplay Transfer cannot send sequences that contain both DV 25 and DV 50 media to playback. This feature allows you to easily identify those sequences.

7. In the Output Audio Mix area, select the type of audio output you want.
   - Direct channel output — Send to Playback transfers audio tracks without performing a mixdown.
   - Stereo output — Send to Playback mixes all of the tracks to a stereo pair, using pan controls to split the tracks. The sequence is copied before the mixdown is edited in, and the suffix .transfer is added to the name (same as in the direct output option).
   - Multiple Mixes — Send to Playback mixes selected tracks to specified output channels, using the mapping specified in the Multiple Mix Editor dialog box. The operation copies the sequence before editing in the mixdown, and it adds the suffix .transfer to the name (same as in the direct output option). For information on mapping audio tracks to output channels, see “Mapping Audio Tracks to Output Channels” on page 1316.

8. In the Transcode area, if you want to allow the transcoding of clips before performing a send to playback operation, do the following:
   - Select “Transcode before sending to playback.”
   - From the Minimum resolution warning threshold menu, select the lowest resolution allowed for the playback device before a warning message is displayed.

   For example, if you select MPEG30, a warning message will display during a send to playback operation, if a clip in the sequence has a resolution below MPEG30. Therefore, no warning message displays when clip resolutions are MPEG30 and above.

   Dynamic Relink must be enabled to use the Transcode before sending to playback option.

   For more information about using these settings, see “Transcoding of Mixed Resolution Clips During a Send to Playback” on page 1323.

9. Click the TMClient.ini tab.
10. In the Other Workgroups area, click Add.

The Add Workgroup To List dialog box opens.

If you want to edit the names of any of the Interplay Transfer servers or workstations listed in the Other Workgroups area, select the name, click Edit, and make the changes.

11. Do one of the following:
   - In a workgroup environment, type the name of the other Interplay Transfer server in the Server text box, and type the name of your workgroup in the Workgroup text box.
   - In a standalone environment, in the Server text box, type the computer name of other workstation, and in the Workgroup text box, type the name you want to see in the Transfer menu.

12. Click OK.

The name you typed displays in the Other Workgroups list.

13. Click the Settings tab, and then click OK.
Send to Playback with Multichannel Audio Tracks

This section describes a best practice for sending a sequence containing multichannel audio tracks to playback when using Direct Out mode. For information on sending multichannel audio to playback using Multiple Mixes, see “Mapping Audio Tracks to Output Channels” on page 1316.

When using Direct Out mode, keep the multichannel audio tracks at the bottom of your audio tracks. When you send to playback in Direct Out mode the system expands the stereo tracks to separate mono tracks. If there are single tracks at the bottom of the track list you may get unexpected results after the top tracks expand. For example, a single track that was on track 5 may now be on a different track. If you keep the single tracks at the top you can avoid this kind of problem. See the editing application Help for additional information on multichannel audio.

Mapping Audio Tracks to Output Channels

The Multiple Mix Editor dialog box allows you to map any combination of audio tracks to any of the 16 available output channels when you send a sequence to playback using Interplay Transfer. The Send To Playback operation performs a mixdown on the selected tracks before the application sends the sequence to Interplay Transfer.

The mappings you create in the Multiple Mix Editor affect any sequence you send to playback. If you want to use different mixes for different sequences, create a custom Transfer Settings template for each separate type of mixdown.

- You can map a single audio track in the Timeline to a single output track — for example, you can map audio tracks 2, 4, 6, and 8 to output channels 1, 2, 3, and 4, respectively. Stereo tracks require two output channels in the sequence that you send to playback unless you want to perform a stereo-to-mono mixdown.
- You can select multiple audio tracks and map them to a single output channel — for example, you can map audio tracks 4, 5, 8, and 9 to output channel 1.
- You can map a single track to multiple channels — for example, you can map track 2 to output channels 1, 3, and 5.
- You can save your map as a custom Transfer settings template.

Each stereo output requires two channels, but you can mix mono and stereo channels for your Send to Playback operation as long as you do not exceed the maximum of 16 output channels.

To create a map of audio tracks to output channels:

1. In the Avid editing application, click the Settings tab in the Project window.
2. Double-click Transfer in the Settings list.
   The Transfer Settings dialog box opens.
3. Click the Settings tab.

4. In the Output Audio Mix area, select Multiple Mixes, and then click Edit. The Multiple Mix Editor dialog box opens.
5. Click the Format buttons to cycle through the available options until you find the appropriate format:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mono tracks</td>
<td>Maps audio tracks to mono channels, with any assigned stereo tracks</td>
</tr>
<tr>
<td></td>
<td>mixed down to a mono channel.</td>
</tr>
<tr>
<td>Stereo tracks</td>
<td>Maps audio tracks to a single stereo channel, using the pan information on</td>
</tr>
<tr>
<td></td>
<td>the input tracks to generate stereo output.</td>
</tr>
</tbody>
</table>

6. In the track selector row, click the channel or channels for each audio track you want to include in your output. If the track is not visible, use the scroll bar to locate the track you want to map to an output channel.

   The audio channel button and the corresponding Output button change to purple. You can click the channel button again to remove it from the output mixdown. You can also click the Output button to remove it from the output. Only active output channels are sent to playback.

7. (Option) In the Label text box, type a label to identify the type of output for your mixdown. You can use the labels to describe the kind of mixdown for your output, but the Avid editing application does not send this information to the playback device.
8. Repeat steps 5 through 8 to map additional audio tracks to output channels.

9. When you finish assigning tracks to output channels, click OK to save your mixdown sequence.

   The Multiple Mix Editor closes.

10. In the Transfer Settings dialog box, click OK.

**To save a custom map of output audio channels as a settings template:**

1. Click the Settings tab in the Project window.

   The Settings list appears.

2. Click Transfer.

3. Select Edit > Duplicate.

   A duplicate setting appears in the Settings list.

4. Name the setting by doing the following:
   a. Click the custom name column.
   b. Type a name.
   c. Press Enter (Windows) or Return (Macintosh).

   *The custom name column is the center column in the Project window. When you move the pointer over the custom name column, the pointer changes from a pointing finger to a text insertion bar.*
You can select this new setting whenever you send a sequence to playback using Interplay Transfer.

**Transferring Avid Assets from an Avid Editing Application**

If Interplay Transfer is properly installed and enabled on your Avid editing system, it starts automatically whenever you start the Avid editing application. When you complete a sequence, you can transfer it from the Avid editing application to any other connected workgroup or to a playback device. Once you send the sequence, you can work on another project while the transfer is taking place.

For information about configuring the Avid editing application for transferring assets, see the *Avid Interplay Transfer Setup and User’s Guide*.

**To send clips or sequences to another workgroup from within the Avid editing application:**

1. (Option) If you want to use a Transfer setting template, select the custom Transfer setting in the Settings tab in the Project window. For more information on creating a custom map for sending sequences to Interplay Transfer, see “Mapping Audio Tracks to Output Channels” on page 1316.

2. Open the bin that contains the clips or sequences you want to send.

3. Select a clip or sequence in a bin. Ctrl+click to select multiple clips or sequences.

4. Do one of the following:
   - Right-click the sequence and select Transfer > Send To Workgroup and then select the available workgroup to which you want to send the assets.
   - Select Transfer > Send To Workgroup and then select the available workgroup to which you want to send the assets.

The assets are sent to the Interplay Transfer server, where they are then sent to the selected workgroup. You can now work on another project while the transfer is taking place.

For information on monitoring the transfer of assets, see “Monitoring Transfers from Within the Avid Editing Application” on page 1324.

**Transferring Avid Assets to a Playback Device**

In a broadcast environment, you can transfer a finished sequence to a configured playback device. For information about configuring the playback device for transfers, see the *Avid Interplay Transfer Setup and User’s Guide*.
To send a finished sequence to a playback device:

1. (Option) If you want to use a Transfer setting template, select the custom Transfer setting in the Settings tab in the Project window. For more information on creating a custom map for sending sequences to Interplay Transfer, see “Mapping Audio Tracks to Output Channels” on page 1316.

2. Open the bin that contains the clips or sequences you want to send.

3. Select a clip or sequence in a bin. Ctrl+click to select multiple clips or sequences.

4. Do one of the following:
   - Select Transfer > Send To Playback, and select the available playback device to which you want to send the sequence.
   - Right-click the clip or sequence in the bin, and select Send To Playback, and select the available playback device to which you want to send the sequence.

The Send to Playback dialog box opens.

If necessary, you can set the sequence to high priority by clicking the circle in the PWT (Play While Transferring) column next to the sequence.

If you try to send a sequence or clip with the same tape ID as one the Interplay Transfer already has, you receive an error message. If you want to overwrite the tape ID name, select the Overwrite option. Overwrite the tape ID only if you are sure you want to overwrite the previous tape ID name.

5. Click OK.

The sequence is sent to the Interplay Transfer server, which then sends it to the selected playback device. You can now work on another project while the transfer is taking place.

For information on monitoring the transfer of assets, see “Monitoring Transfers from Within the Avid Editing Application” on page 1324.
**Working with Rundowns (NewsCutter Option)**

In a broadcast environment, you can enable the Interplay Transfer scheduling feature to allow interaction with the Newsroom Computer System (NRCS). You can select the assets to send to playback, and the schedule list from the NRCS determines the order in which the assets are played back.

**To use the Interplay Transfer with rundowns:**

1. On your Interplay Transfer server, click Start, and select All Programs > Avid > Avid Interplay Transfer Engine Configuration.

   The Interplay Transfer Engine Configuration window opens.

2. In the Playlist Information area, select “Use Newsroom rundowns to schedule transfers.”

3. Type the computer name of the Newsroom Server.

4. Type the user name and password.

5. If you know the name of the schedule file, type it in the Schedule File Name text box.

   The schedule file specifies which rundowns to use at which time. See “Creating a Rundown Schedule File (NewsCutter Option)” on page 1323.

6. Click OK.

7. Restart the Interplay Transfer server.

   Anytime the configuration information changes, you must restart the server.

8. On your Avid editing system, open the bin that contains the sequences you want to send.

9. Select the sequences.

10. Select Transfer > Send To Playback and select the available playback device to which you want to send the sequence.

    The Send to Playback dialog box opens.
11. Click OK.

    The sequences play back based upon the order in which they appear in the NRCS rundown list.

    In the Send to Playback dialog box, if you set one of the sequences to high priority by clicking the circle in the PWT column next to the sequence, that sequence has priority over the rundown list.

For information on monitoring the transfer of assets, see the *Avid Interplay Transfer Setup and User’s Guide*.

**Creating a Rundown Schedule File (NewsCutter Option)**

A rundown schedule file tells the Interplay Transfer server which rundown to schedule at what time. The format is the time to start monitoring the rundown followed by the name of the rundown. A sample rundown schedule is as follows:

```plaintext
# Rundown Schedule File
# Number of elements
9
#Time (after) Rundown Name
00:00:00 5a
05:55:00 6a
06:55:00 7a
11:45:00 noon
14:45:00 3pmcutin
15:45:00 4pmcutin
17:55:00 6p
20:45:00 9pmcutin
21:10:00 10p
```

**Transcoding of Mixed Resolution Clips During a Send to Playback**

When you perform a Send to Playback operation, the application automatically renders effects and relinks your sequence to the target resolution. You can use the Send to Playback command with sequences that contain clips of different resolutions. Any clips in the sequence with resolutions not matching the target resolution settings in the Dynamic Relink dialog box are transcoded to the target resolution. The application creates a new master clip (with the extension `.new`) and associates the new clip with the new transcoded media.

Before the Send to Playback operation begins, the application searches the sequence for any clips with an undesirable resolution for the transcode operation, such as clips with low resolutions that would create a low quality output after the clip is transcoded. If clips are found, a warning message is displayed to let you decide if the Send to Play operation should continue.
with a lower quality output. You can set the minimum resolution allowed before displaying the warning message by using the Transfer Settings dialog box. For setup information, see the *Avid Interplay Transfer Setup and User’s Guide*.

Dynamic Relink must be enabled to use the Transcode before sending to playback option. For information about using Dynamic Relink, see the Avid editing application Help system.

## Monitoring Transfers from Within the Avid Editing Application

After you transfer an asset from within the Avid editing application, you can monitor the transfer.

**To monitor the asset transfer:**

1. Display the Transfer Status window by doing one of the following:
   - For the Avid Instinct and Avid Interplay Assist applications, select File > Interplay Transfer > Show Status.
     The Interplay Transfer tab displays the transfers.
   - For other Avid editing applications, select Transfer > Status Window.
     The Transfer Status window opens.

2. Right-click the status of a particular transfer to display the status options.
   See “Transfer Status Window Options” on page 1325.
   A plus sign in the PWT column indicates the clip or sequence has been set to a high priority.
Transfer Status Window Options

The following table lists the status options available when you right-click a transfer displayed in the Transfer Status window during a transfer.

<table>
<thead>
<tr>
<th>Status</th>
<th>User Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transferring</td>
<td>Pause or cancel the transfer.</td>
</tr>
<tr>
<td>Paused</td>
<td>Resume or cancel the transfer.</td>
</tr>
<tr>
<td>Error (plus information indicating the error)</td>
<td>Retry or clear the transfer.</td>
</tr>
<tr>
<td>Pending</td>
<td>Cancel the transfer.</td>
</tr>
<tr>
<td>Completed or Canceled</td>
<td>Clear the transfer.</td>
</tr>
</tbody>
</table>

Sorting the Transfer Status Columns

You can sort the transfer status column into either ascending or descending alphabetical order. For example, you might want to view the status or locations of the transfers in alphabetical order. This makes it easy to view all the completed, paused, or canceled transfers together.

To sort a transfer status column:

1. From the Transfer Status window or Interplay Transfer tab, right-click the column to display the Sort options.

2. Select either Sort, Sort Reversed, or No Sort.
   
   Sort lists the information in alphabetical order.
Clearing the Transfer Status Window

When you are using the Transfer Status window from within the Avid editing application to view the status of any transfers, you should periodically clean up the Transfer Status window. The Transfer Status window is cleared of any leftover status messages when you exit the Avid editing application and then restart it. If you have not restarted the Avid editing application in a while, and your Avid editing system appears to be sluggish, clear the messages in the Transfer Status window.

To clear the Transfer Status window:

1. Do one of the following:
   - In the Avid Instinct and Avid Interplay Assist applications, select File > Interplay Transfer > Clear Status.
   - In the Avid editing application, select Transfer > Status Window.
     The Transfer Status window opens.

2. Press Ctrl+A to select all the items in the Status window.

3. Press Delete.
    All the items are removed from the Transfer Status window.
This chapter provides information about using MultiRez and dynamic relinking. MultiRez is available only on Avid editing systems that have the Avid Interplay Media Indexer installed.

- Understanding MultiRez and Proxy Editing
- Acquiring Media at Multiple Resolutions
- Understanding How Clips are Associated with Multiple Resolutions
- Options for Clip and Media Association
- Understanding Dynamic Relink
- Workflow: Editing a Film or HD Project using MultiRez
- Considerations When Working with Dynamic Relink
- Using the Dynamic Relink Settings Dialog Box
- Relinking in Frame Chase Editing
- Using the Relink Dialog Box in an Avid Interplay Environment
- Displaying Whether Media Is Available for Dynamic Relinking
- MultiRez Button Menu
- MultiRez Bin Headings
- Understanding Options for Deleting MultiRez Clips and Media
- Deleting MultiRez Clips and Media from a Bin
- Working with Partially Online Files
- Quality Matching

Understanding MultiRez and Proxy Editing

MultiRez (a term derived from “multiple resolutions”) lets you create a master clip that is associated with multiple media files of different resolutions. For example, you can use the Avid Interplay Low-Res Encoder to simultaneously capture a single master clip that is associated with both low-resolution and high-resolution media files. MultiRez also lets you capture an audio clip with more than one sample rate.
Proxy editing is a workflow where you edit with a low-resolution version of media and then conform the edits into a composition that refers to an equivalent high-resolution version of the same content.

In a post-production workflow, you capture material at a low resolution and perform what is referred to as offline editing, then batch capture the same clips at a higher, online resolution and relink the sequence to the higher resolution.

In a newsroom, Avid products might be configured to capture high-resolution and low-resolution versions of a clip at the same time. Editors work with the low-resolution version and then use MultiRez to relink to the high-resolution version for final output.

A news workgroup might also consist of a number of finish editing stations in addition to the journalist stations. The journalist systems can work effectively with a lower bit-rate version of the media, which uses less network bandwidth. The finishing systems use online-quality media, which requires a large amount of disk space and network bandwidth. The journalists or editors can use dynamic relink to switch to the high-resolution media when it comes to adding effects or sending the final sequence to a playback device.

**MultiRez and Archiving**

You can combine proxy editing and MultiRez with archiving to conserve disk resources. A newsroom editor can delete high-resolution material that is archived, continue editing a low-resolution version, and then restore the needed high-resolution material from the archive later. Archiving also allows a newsroom editor to keep a viewable version of a sequence online in case a story becomes active again — the editors can restore the high-resolution version of the sequence from the archive.

**MultiRez and the Media Indexer**

MultiRez is managed by the Avid Interplay Media Indexer. The Media Indexer is a background service that keeps track of the media files in storage locations that you identify. On Avid Interplay clients, it works with both local storage and shared storage. For more information about the Media Indexer, see the *Avid Interplay Software Installation Guide* and *Avid Interplay Best Practices*.

*The Media Tool and Relink dialog box work differently in an Avid Interplay environment. For more information, see “Using the Media Tool in an Avid Interplay Environment” on page 473 and “Using the Relink Dialog Box in an Avid Interplay Environment” on page 1356.*
Acquiring Media at Multiple Resolutions

In an Avid Interplay environment, you can create and store multiple resolutions of the same media. These can be acquired in several ways. You can configure a workgroup to ingest both high and low-res media simultaneously. You can also first create master clips with high-res media, and if your hardware permits it, you can re-capture these clips as low-res proxies. If multi-rez batch capturing is not supported, you must use your Avid software to transcode to a low-res proxy.

**Dual-Ingest Configuration**

In a newsroom environment, you can use CaptureManager™ or Interplay Capture, an AirSpeed® or AirSpeed Multi Stream system, and an Avid Interplay Low-Res Encoder to simultaneously ingest high-resolution and low-resolution versions of the same master clip. You can use an AirSpeed Multi Stream to ingest both high-resolution and low-resolution (Avid H.264) versions of the same master clip.

**Batch Capture Multiple Resolutions**

You can capture more than once from the same tape at different resolutions and associate the new resolutions with the same master clip. You can batch capture from any system that has access to the master clip and original tape. For example, you can batch capture from the same system that acquired the media originally, or you can use Avid Interplay to check out a clip on another system and perform the batch capture there.

**Capture High-Res and Transcode to Low-Res**

- You can use the Avid Interplay Media Services from within your Avid editing application to capture at a high resolution and then use Avid Interplay Transcode to create different resolutions of the same clip. Interplay Transcode keeps the same master clip and associates it with the new resolution.
- You can use the Consolidate/Transcode command within your Avid editing application to create different resolutions of the same master clip. If you consolidate, your Avid editing application creates a new clip for each resolution. If you transcode, you have the choice of associating the new resolution with the original master clip, or creating a new clip. See “Understanding How Clips are Associated with Multiple Resolutions” on page 1333.

**Batch Capturing Media at a Different Resolution**

Batch capturing lets you create different resolutions of media through the same process that the original media was captured from hardware. To perform a batch capture, you must have a master clip containing either a clip log or previously captured media.
You can only create one new resolution at a time using batch capture. To capture multiple resolutions at the same time (ie: high-res and a proxy simultaneously), use the Interplay Low-Res Encoder. See the Interplay documentation for more information.

**To batch capture a different resolution:**

1. Prepare your system for batch capturing, as described in the Help for your Avid editing application. Be sure to select the new resolution you would like to capture in the Media Creation settings Capture tab or in the Capture tool.

2. Select the clips or sequences you want to batch capture.

3. Select Clip > Batch Capture.

   The Batch Capture dialog box opens.

4. Deselect “Offline media only” to specify that you want to re-capture media that is already online, in addition to offline media.

   The “Discard original local media” option appears.

5. Deselect “Discard original local media” to keep the original resolution of your clips or sequences.

6. (Option) Select “Extend handles beyond master clip edges” to allow the handles to extend before the beginning and after the end of the original master clip.

   When you batch capture, deselecting this option prevents capturing across a discontinuous timecode error.

7. Click OK.

   If you have not loaded a tape, your Avid editing application prompts you to load the original tape.

8. Load the tape into the tape deck, and click Mounted.

   A dialog box opens.

9. Click OK to confirm the tape and deck entries and to begin the capture process.

   Your Avid editing application captures each clip from the tape, in start timecode order.

---

**When you batch capture, make sure to accept the original tape name so that the new media files are associated with the same source as the original media files.**

Batch capture does not create any new master clips. As new media files are created, the Media Indexer adds them to its database, and the original master clip is associated with additional media files. Media files in multiple resolutions are indicated by black dots in the appropriate bin columns. The following illustration shows a clip originally captured at 15:1s and batch captured at 1:1 (uncompressed).
For information about displaying bin columns for MultiRez, see “MultiRez Bin Headings” on page 1363.

Batch Importing File-Based Media at Different Resolutions

Using Batch Import, you can import file-based media at different resolutions. To perform a batch import, you must have a master clip that has the media imported in another resolution.

To batch import a different resolution:

1. Mount and connect to any removable drives that hold the original file-based media.
2. Open the bin, and select the imported master clips and sequences you want to reimport.
3. Select Clip > Batch Import.
   A message box opens.

4. Click All Clips to import new resolutions for media that is already online, in addition to offline media.
   The message box closes and the Batch Import dialog box opens.
5. In the Import Target area, select the desired resolution and storage location.

6. In the Import Options area, select “Keep existing local media” and any other options.

7. Click Import.

Your Avid editing application imports the files and creates media in the resolution you specified. The original media file is preserved, and the master clip is now associated with an additional resolution.

Transcoding Media to Low-Res Proxies

Transcoding allows you to convert media to any Avid supported format. Use the transcode operation only if your hardware does not support batch capturing in a desired proxy format. Transcoding is only useful for creating lower resolution versions of high-res media; it is not recommended that you transcode from low-res to high-res.
To transcode a clip using your Avid editing application:

- Right click the clip in the bin and select Consolidate/Transcode.

To transcode a clip using the Interplay Transcode service, do one of the following:

- In Avid Interplay Access, right-click the clip and select Transcode. Select the profile that has been created for this transcode and click Set.
- In your Avid editing application, right-click the clip in the bin and select Media Services > Avid Interplay Transcode Service. Select the profile that has been created for this transcode.
- Set up an Auto Transcode folder in Interplay Access and drag and drop clips to the folder.

The Transcode service transcodes the clip and stores the media according to the instructions in the profile. The new media is associated with the original clip metadata. The following illustration shows an example of a low-res proxy in the Interplay Window. You can see that the current resolution for the clip is AVCIBP-BLL3.0.60. This is the Avid editing application representation for 720p/59.94 proxy media.

720p proxy media can only be created using the Interplay Transcode service. The Consolidate/Transcode operation in your editing application does not support 720p proxy media in this release.

Understanding How Clips are Associated with Multiple Resolutions

In a MultiRez environment, relinking is source based. That is, your Avid editing application relinks a clip to its media according to the source of the clip rather than the name of the clip.

Whenever you create a new tape or import a file, your Avid editing application creates a unique source ID that is used by your Avid editing application and is not visible to users.
You create a new tape by clicking the New button in the Select Tape dialog box, entering a name for the tape, and clicking OK.

![Select Tape dialog box]

Your Avid editing application then associates the new source ID with each clip that you capture from that tape.

Example of source ID association: the source ID your Avid editing application assigns to a tape (for example, 12345) is also associated with each clip and media file you capture from that tape.

Later, if you recapture a clip at a different resolution, make sure to select the tape name originally associated with that clip. If you select the original name and use the original tape, your Avid editing application associates the new media with the original master clip. In an Avid Interplay environment, this source-based association is the basis for dynamic relink.

_Avid CaptureManager also uses a source ID to associate a master clip with any media created at the same time, such as a clip captured with two resolutions in a dual-ingest configuration. However, instead of associating all clips from the same tape with the same source ID, CaptureManager creates a new source ID every time it captures a new clip._

For details of the possible ways that master clips and media files might be associated with one another in a MultiRez environment, see “Options for Clip and Media Association” on page 1335.
**Guidelines for MultiRez Tape Management**

When working in a MultiRez workflow, it is important to name tapes properly. In particular, you should keep the following in mind:

- Whenever you create a new tape, your Avid editing application generates a new source ID, even if the name you type for the new tape exactly matches that of an existing tape. You cannot dynamically relink media that does not share a source ID.
- Do not use the same name for two different tapes or different names for the same tape. This might cause incorrect media association.
- Do not use the default tape name “New Tape.”

**Options for Clip and Media Association**

You can associate a single master clip with multiple media files. You can also associate two or more master clips with the same media if the clips share a source ID and timecode.

**Single Clip, Multiple Resolutions**

The following illustration shows a single master clip that was captured in two resolutions: 15:1s and 1:1 (uncompressed). This could be the result of a batch capture, a dual-ingest operation, or transcoding.

In a bin, black circles in the 15:1s column and the 1:1 column show this association, as in the following illustration.

<table>
<thead>
<tr>
<th>Morocco Bin</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
</tr>
<tr>
<td>———</td>
</tr>
<tr>
<td>Bazaar scene</td>
</tr>
<tr>
<td>women in bazaar</td>
</tr>
</tbody>
</table>

This information also appears in the Interplay Window.
Options for Clip and Media Association

For information about displaying bin columns for MultiRez, see “MultiRez Bin Headings” on page 1363.

You can batch capture the clip in additional resolutions; there is no limitation to the number of media files associated with a clip.

Multiple Clips, Multiple Resolutions, and the Affinity Model

You can transcode the media associated with a clip to create media in a different resolution, usually to create a low-resolution version of the clip. You can choose to create a new master clip or associate the new media with the original master clip. For more information, see “Using the Transcode Command” on page 483.

If your Avid editing application associates the new media with the original clip, the bin displays multiple resolutions for the master clip. For more information, see “Single Clip, Multiple Resolutions” on page 1335.

If your Avid editing application creates a new master clip (with the extension .new), it associates the new clip with the new transcoded media. In this case, your Avid editing application copies the source ID to the new clip and new media.

When the Avid Interplay Transcode transcodes a clip, it associates the new resolution with the original clip. It does not create a new clip.

The following illustration shows a clip captured in 1:1 and transcoded to 15:1s. Your Avid editing application associates each clip with both resolutions because they share a source ID and a timecode span.
Example of associations between multiple clips and multiple resolutions. The original capture (top) creates high-resolution media. A transcoding operation (bottom) creates a new master clip and a new media file at a lower resolution. The timecode span and length of both clips are the same. Each clip is associated with the resolution created at the time of the capture or transcoding (solid arrows), and also with the other resolution (dashed arrows). The source ID of the original tape is associated with both clips and both media files.

In a bin, both clips appear with black circles in the 15:1s column and the 1:1 column.

Although the two clips share media, there is a special association between the clip and the media created with that clip. In the preceding illustration, this original association is shown by solid arrows. The tracking of the original association is referred to as the **affinity model**, because your Avid editing application keeps track of the relationship (affinity) between the clip and the media created with the clip. The media files associated with the clip are called **affinity resolutions** or **affinity media**. The affinity model applies when you are deleting clips and media from a bin. For more information, see “Deleting MultiRez Clips and Media from a Bin” on page 1365.

**Partial Clips, Multiple Resolutions**

MultiRez also supports association of clips that share only part of a timecode span. For example, after capturing a clip at 15:1s, you might need to recapture only part of the clip at 1:1. Because both clips share a source ID and a timecode span, your Avid editing application associates both clips with the same resolutions and lets you dynamically relink the shared section. The following illustration shows these associations. The original association is shown by solid lines, and the additional association is shown by dashed lines.
Example of associations between clips sharing only part of a timecode span. The original capture (top) creates low-resolution media. A recapture operation (bottom) creates a new master clip and a new media file at a higher resolution. The new master clip is shorter than the original but shares the same timecode span. Each clip is associated with the resolution created at the time of the capture (solid arrows), and also with the other resolution (dashed arrows). The source ID of the original tape is associated with both clips and both media files.

In a bin, the original clip appears with a half circle in the 1:1 column, to indicate that only part of the clip is available in 1:1. The entire new clip (with the .01 extension) is available in both resolutions, as indicated by the full circles in both resolution columns. The following illustration shows these clips in a bin.

You can also create partially online files through archiving, consolidation, and transcoding a subclip. For more information, see “Working with Partially Online Files” on page 1366.

**Understanding Dynamic Relink**

Dynamic relink is a feature that lets you select which media you want to use when you are working in a MultiRez environment. Typically, you use low-res media for offline editing and high-res media for a final master. For instance, you can edit in SD and output in HD. Dynamic relink lets you control how your Avid editing application links your clips to the appropriate media.
Dynamic relink is currently not supported for HD media that requires pulldown. Therefore, you can only use it with projects where media has been acquired at the native frame rate (without pulldown).

You specify two different groups of settings:

- **Working settings** are the settings you want to use while you edit the sequence:
  
  For offline editing of a sequence, your editing application uses the resolution specified in the working settings. This is where you can specify a low-res proxy instead of high-res media so that you can work more efficiently, and save space on your online storage.

- **Target settings** are the settings you want to use for your final master:
  
  When you finish the offline editing, the Send to Playback command automatically outputs the sequence in your target resolution and format. The clips in the sequence do not change — your Avid editing application dynamically relinks them to the media files in the target resolution.

You specify these settings in the Dynamic Relink Settings dialog box, which is available in the Settings list of the Project window. For more information, see “Using the Dynamic Relink Settings Dialog Box” on page 1348.
The following illustration shows a bin and a sequence. The first version of the sequence shows the clip in the working resolution (15:1s) and the second version shows the same clip in the target resolution (1:1). The clip name is the same in both cases, but the resolution of the clip (as shown in the text on the clip) is different.
To display the clip resolution for each clip in the Timeline, click the Timeline Fast Menu button and select Clip Text > Clip Resolutions.

Using Dynamic Relink with Media Composer | Cloud Editing Systems

Dynamic relink should be enabled when you work with remote editing systems connected with Media Composer | Cloud. Refer to the appropriate section below depending on where your editing system is located in the Interplay realm.

Remote Editing Systems in the Field

Generally, when editing a news story on a remote editing system, it's best to keep the dynamic relinked enabled. This way, you will have access to a clip's media on a remote storage as soon as it comes online. In addition, any clips linked to local or remote storage will display in the appropriate color on the timeline to indicate availability of media corresponding to your dynamic relink settings—see “Using Clip Coloring to Show Available Resolutions” in the help for your editing application.

For clips linked to media on the remote storage, you will still only see the compressed media in your viewer during playback.

For clips linked to media on your local storage, you will always see the media in its native resolution. This media is transcoded according to your upload settings when it is uploaded to the central Interplay server. However, your system will continue to display the originally-linked media.

Interplay Editing Systems at the Broadcast Facility

In a Media Composer | Cloud workflow, editing systems at the broadcast facility need to enable dynamic relink so that they can relink to the media associated with AMA-linked clips uploaded by a remote Media Composer | Cloud client. In addition, they can also set the resolution of the uploaded media to which they want to relink—see “Applying Working and Target Settings for
Dynamic Relink” on page 1349”.

There are some differences in how dynamic relink functions with the clips uploaded from a remote editing system:

- Unlike typical dynamic relink operations, relinking with AMA media clips requires that you first load the clips associated with the AMA clip in a bin before you can relink.
- For some formats, AMA clips might not provide full media quality description. In this case, the Avid editing application relinks your clip to the available media that most closely matches the dynamic relink settings, ignoring any unspecified parameters.
- Dynamic relink always privileges managed media (Avid media that you have captured, consolidated, or transcoded) over linked AMA media because the quality of managed media is higher than linked AMA clips. Dynamic relink always selects managed media corresponding to an AMA clip if it is available and has been indexed by the media indexer.

**Workflow: Editing a Film or HD Project using MultiRez**

This workflow describes how to link to media of different resolutions in the context of a Film or an HD project. The steps involved are:

- Opening an HD project and checking out the clip
- Setting Dynamic Relink to work with the low-res proxy
- Performing a partial restore to restore the portions of the clip used in the sequence.
- Using Dynamic Relink to start working with the high-res media.

Most of the same steps apply when working with RGB and 720p media.

*Dynamic relink is currently not supported for HD media that requires pulldown. Therefore, you can only use it with projects where media has been acquired at the native frame rate (without pulldown).*
To create a Film or HD Project:

1. When you create the project, make sure it supports the resolution you want to use. For example, for 25p Film projects, select 1080p/25. The following illustration shows the Project selection for a 25p Film project used in this example.

![New Project window](image)

2. (Film only) If your source media is film-based, check the Film box and select the Film Type. Immediately after creating your project, set up the Film settings under the settings tab.

To check out the clip and set Dynamic Relink:

1. In your Avid editing application, select Tools > Interplay Window.

2. Locate the clip in the Interplay Window and drag it to the bin.

   The following illustration shows the clip in the Interplay window and the bin. Notice that both the high-res and low-res are online.
High-res and low-res media both online (filled circles) for the clip in the bin

3. Open the Dynamic Relink dialog box and set the working resolution to the low-res proxy.

   The following illustration shows the Dynamic Relink values used in this example to link to the low-res media.
4. Edit the media into a sequence.

By default, whenever you load clips into a monitor or the Timeline, they are linked to media that matches the working settings.

The following illustration shows the bin after the sequence is created. In this example, the administrator has already archived and deleted the high-res material. The MultiRez bin columns show that the high-res media is completely offline.
The high-res media is now offline (empty circle in the bin)

5. (Skip this step if the administrator did not archive the high-res media)
When you are finished editing the sequence, restore the portions of high-res material used in the sequence from the archive.

The following illustration shows the bin after the partial restore operation is completed. The MultiRez bin columns show that the high-res media is now partly online because only the required portions of the high-res media are restored.

<table>
<thead>
<tr>
<th>Name</th>
<th>Tracks</th>
<th>DNxHD 36</th>
<th>1:1p 1:1b (HD1080p)</th>
<th>Duration</th>
<th>IN-OUT</th>
</tr>
</thead>
<tbody>
<tr>
<td>25p Clip</td>
<td>V1</td>
<td>●</td>
<td>○</td>
<td>35:25</td>
<td>5:26</td>
</tr>
</tbody>
</table>

After the partial restore, the high-res media is partly online (half-filled circle)

6. In the Target settings, set the project format for output. (This also determines the resolutions that are available in the Dynamic Relink target settings.) You can set this format independently of the format set in the Format tab of the Project window.

Media captured in this format will be used during output.

7. If you need to create effects that require you to view the high-resolution media, check the Override Working Settings with Target Settings box in the dynamic relink window to dynamically relink clips to media that matches the target settings.

Render effects only when you have linked to the target settings. This should be done as the last step before output. If you return to the working settings, any media files created by rendering effects (precomputes) will not dynamically relink in the target resolution.

8. Open the Dynamic Relink dialog box and set the working resolution to the high-res version.

The following illustration shows the Dynamic Relink values used to link to the high-res video and audio. In this example, a specific resolution was chosen.
9. Render effects in the target resolution if necessary.

You can use the MultiRez button and MultiRez clip coloring to give you the necessary indications that you may not have media that matches the target settings.

10. Output your final master by doing one of the following:
    - Create a digital cut.
    - Use the Send to Playback command.

When you perform a Send to Playback operation, your Avid editing application automatically renders effects and relinks your sequence to the target resolution.

When you use the Send to Playback command, make sure you are using the target settings required by the playback device or Send to Playback fails.
Considerations When Working with Dynamic Relink

Consider the following when you are working with dynamic relink:

- If you connect to an Avid ISIS media network with a 100Base-T connection in a Zone 3 configuration, you can access MPEG-2 low-resolution video and MPEG-1 Layer II (or MP2) compressed audio. This is useful for browsing media stored on the media network as the low-resolution media files require less bandwidth to view. However, you cannot output, consolidate, or transcode media using MP2 compressed audio. Instead, you should use dynamic relink to link the low-resolution media to the high-resolution source media.

- If you dynamically relink a sequence and then check the sequence into Avid Interplay, your Avid editing application checks in the resolution to which you are currently linked.

- Dynamic relink does not work with OMF media files that include an alpha channel (titles or graphics with alpha that are imported or created in OMF resolutions). Clips with OMF alpha are unaffected when the dynamic relink settings are changed.

- Dynamic relink works somewhat differently with mixed rate clips. For more information, see “Using Dynamic Relink with Mixed Rate Clips” on page 1354.

- If you are using Media Composer | Cloud, the dynamic relink works slightly differently. For more information, see “Media Composer | Cloud and Dynamic Relink” on page 1302.

Using the Dynamic Relink Settings Dialog Box

You use the Dynamic Relink Settings dialog box to enable dynamic relink and to specify your working settings and target settings. You can also use this dialog box to override the working settings with the target settings. If you work with mixed rate material, you can also enable dynamic relink for mixed rate sequences.

For complete reference information on the Dynamic Relink settings, see “Dynamic Relink Settings” on page 1464.

* Dynamic Relink settings are project settings. You can use them as site settings, so that all projects you create on your editing system use the same settings. For more information, see “Using Site Settings” on page 1429.*

Opening the Dynamic Relink Settings Dialog Box

To open the Dynamic Relink Settings dialog box, do one of the following:

- In the Settings list in the Project window, double-click Dynamic Relink.
- Right-click the MultiRez button at the bottom of the Timeline and select Dynamic Relink Settings.
Enabling Dynamic Relink

To enable dynamic relink:

1. Do one of the following:
   - In the Settings list in the Project window, double-click Dynamic Relink.
   - Right-click the MultiRez button at the bottom of the Timeline and select Dynamic Relink Settings.

2. Select Enable Dynamic Relink and set the appropriate target settings.

   When you select this option, your Avid editing application performs a dynamic relink whenever clips are loaded into the source monitor or the Timeline, and displays options for working with dynamic relink.

Applying Working and Target Settings for Dynamic Relink

The Working Settings tab lets you specify the rules that determine the resolution you use when editing. For example, you might specify any low resolution or a specific single-field resolution because you are working on a 100Base-T connection and need to work with low-resolution material.

The Target Settings tab lets you specify the rules that determine the media that you use for your final output. For the target settings, you might want to select Relink to Offline if no match is found, because this setting provides a clearer warning if the desired resolution is not available.

For illustrated examples of typical settings, see “Examples of Working and Target Settings for Dynamic Relink” on page 1350.

To apply working and target settings:

1. Do one of the following:
   - In the Settings list in the Project window, double-click Dynamic Relink.
   - Right-click the MultiRez button at the bottom of the Timeline and select Dynamic Relink Settings.
2. Select Enable Dynamic Relink.

3. Click the Working Settings tab, and then select your working settings.
   For information on available settings, see “Dynamic Relink Settings” on page 1464.

4. Click the Target Settings tab, and then select your target settings.
   For information on available settings, see “Dynamic Relink Settings” on page 1464.

5. To apply the settings, do one of the following:
   ▶ Click Apply.
     The dialog box remains open.
   ▶ Click OK.
     The dialog box closes.

As long as Dynamic Relink is enabled, your Avid editing application uses the working settings to dynamically relink material while you edit. Applying the target settings, however, does not dynamically relink a sequence to the target settings. You need to take one of the actions described in “Dynamically Relinking to the Target Settings” on page 1353”.

You can use the MultiRez button in the Timeline to instruct your Avid editing application to color any clips for which media is not available. This is especially important because it indicates if you can create the finished sequence in the target resolution. For more information, see “Displaying Whether Media Is Available for Dynamic Relinking” on page 1356.

**Examples of Working and Target Settings for Dynamic Relink**

This topic provides examples of typical working and target settings for Dynamic Relink. For information on applying settings, see “Applying Working and Target Settings for Dynamic Relink” on page 1349.

**Working Settings**

The working settings in the following illustration instruct your Avid editing application to link to the specific video resolution of 15:1s MXF. If it cannot find this resolution for a particular clip, it should display a “Media Offline” slide. Specific parameters are also set for audio: 44.1 kHz and 16-bit.
Top to bottom: Relink to offline media if no match is found, specific video resolution to match, specific audio sample rate and bit depth to match

The working settings in the following illustration instruct your Avid editing application to link to the specific video resolution of DV 25. If your Avid editing application cannot find this resolution for a particular clip, it should relink to media that most closely matches DV 25, based on the specified parameters. In this case, it should relink to a resolution that is more compressed than DV 25 (less than or equal to DV 25), such as 15:1s.

Similarly, for audio, your Avid editing application should use media with a sample rate less than or equal to 44.1 kHz/16 bit. If your Avid editing application finds no match for this rule, it should use the closest media that is available.
Top to bottom: Use closest media if no match is found, highest quality video resolution to match and instruction to accept lower qualities, highest audio sample rate and bit depth to match and instruction to accept lower sample rates

**Target Settings**

The target settings in the following illustration instruct your Avid editing application to use 30i NTSC as the project format and 1:1 MXF (uncompressed) as the specific video resolution. If your Avid editing application cannot find this resolution for a particular clip, it should display a “Media Offline” slide. Specific parameters for final audio are also set: 48 kHz and 24-bit.
Using the Dynamic Relink Settings Dialog Box

Dynamically Relinking to the Target Settings

You need to dynamically relink to the target settings when:

- You are linking to media that was updated by a remote editing system. In this case you need to update your media by either right-clicking your clips in your bins and selecting Update from Interplay, or right-clicking your master clips in Avid Access and selecting Update Status from Media Indexer.
- You need to do color correction or apply another effect that requires viewing media in the target resolution.
In this case, you might temporarily switch from working settings to target settings, apply the effect, and then switch back to working settings.

- You are performing a digital cut.

In this case, you override the working settings, render effects, and output the digital cut. (When you use the Send To Playback command, your Avid editing application automatically links clips to media in the target resolution.)

For information on establishing target settings, see “Applying Working and Target Settings for Dynamic Relink” on page 1349.

⚠️ Render effects only when you have linked to the target settings. This should be done as the last step before output. If you return to the working settings, any media files created by rendering effects (precomputes) will not dynamically relink in the target resolution.

To dynamically relink clips to media that matches the target settings, do one of the following:

- Right-click the MultiRez button at the bottom of the Timeline and select “Override Working Settings with Target Settings.”

- Use the Dynamic Relink dialog box:
  a. In the Settings list in the Project window, double-click Dynamic Relink. The Dynamic Relink dialog box opens.
  b. Select Enable Dynamic Relink and Override Working Settings with Target Settings.
  c. Click OK to perform a dynamic relink to media that matches the target settings and to close the dialog box.

To return to the working settings:

- Deselect Override Working Settings with Target Settings.

### Using Dynamic Relink with Mixed Rate Clips

When you send a mixed rate sequence to playback, you can use the dynamic relink feature to output your sequence at a specified target format and resolution. Dynamic relink attempts to link clips in your sequence following the options you set in the Dynamic Relink settings dialog box (for more information, see “Using the Dynamic Relink Settings Dialog Box” on page 1348).
When using dynamic relink with mixed rate clips, your Avid editing application tries to link your clips to media with the appropriate frame rate. However, unlike clips with the same frame rate as your project, dynamic relink always uses the lowest and nearest resolution to your project frame rate when it does not find an exact match.

If you do not enable dynamic relink for mixed rate clips, a send-to-playback operation fails when your Avid editing application cannot match a mixed frame rate clip with the project frame rate.

Dynamic relink performs the following actions when working with mixed frame rate clips:

- Clips with the same frame rate as the project relink to source media based on the settings in the Dynamic Relink settings dialog box.
- Clips with a frame rate that differs from the project frame rate, but which have source media available in the target resolution, relink to the appropriate source clips.
- Clips with a different frame rate and no source media in the target resolution relink to clips using the “Less than or equal to” quality option in the Dynamic Relink settings dialog box, regardless of which settings you previously selected.
  
  This means that dynamic relink tries to relink to the correct resolution. If it cannot find the appropriate media, it overrides the quality settings in the Dynamic Relink dialog box and instead links to media with the nearest resolution that is less than the specified one and that has the closest video format.
- Clips that cannot dynamically relink to source media cause the send-to-playback operation to fail.

To enable dynamic relink for mixed rate sequences:

1. In the Settings list in the Project window, double-click Dynamic Relink.
   
   The Dynamic Relink dialog box opens.
2. Select Allow Mixed Frame Rate Media.
3. Click Apply, and then click OK.

Relinking in Frame Chase Editing

Frame Chase editing is a workgroup feature that lets you work on a clip while it is being captured. If you are using Frame Chase editing with MultiRez, your Avid editing application can dynamically relink to in-progress media. After the clip is completely captured, your Avid editing application manages it in the same way it manages other clips.

Your Avid editing application cannot dynamically relink an in-progress clip to consolidated or transcoded clips generated from that clip until the capture is complete.
Using the Relink Dialog Box in an Avid Interplay Environment

Relinking through the Relink dialog box is different from dynamic relink. In an Avid Interplay environment, relinking through the Relink dialog box is limited to non-master clips (subclips and sequences). You can relink these only through source timecode and tape. Other options are unavailable.

Relinking through the Relink dialog box is clip-based. Clips are linked to one set of media (video, audio, or both) and you relink a sequence (or subclip) to a selected set of clips. Dynamic relink is source-based. See “Understanding How Clips are Associated with Multiple Resolutions” on page 1333.

Although relinking through the Relink dialog box is different from dynamic relink, the Media Indexer service manages both processes. To relink sequences or subclips through Media Indexer, select the sequence or subclip and one or more master clips.

For complete information on relinking, see “Relinking Media Files” on page 494.

Displaying Whether Media Is Available for Dynamic Relinking

You can display a visual indication of whether media is available in the resolution or sample rate specified in the Dynamic Relink settings. To provide this information, your Avid editing application communicates with the Media Indexer to determine the availability of working and target media for each clip in the Timeline.

Two features provide this information:

- MultiRez button
- Clip coloring

Using the MultiRez Button to Show Available Media

The MultiRez button in the Timeline bottom toolbar lets you display two types of information:

- Whether the media currently linked to a clip matches the working or target settings (Show Mismatches display)
- Whether media for a clip is available in the target settings (Show Target Availability display)
Displaying Whether Media Is Available for Dynamic Relinking

Clicking the MultiRez button changes only the display — it does not perform a dynamic relink, and it does not update the status of the media. To update the status, use the Update Media Status command. For more information, see “MultiRez Button Menu” on page 1361.

It is especially important to know whether media is available in the target settings if you are going to use the Send to Playback command. Send to Playback automatically relinks to the media specified by the target settings and renders any unrendered effects. A Send to Playback operation does not succeed if the required media is not available. The MultiRez button lets you see whether the media is available while you are still editing the sequence in the Timeline. If the media is not available, you need to take an action such as transcoding the clips, recapturing the clips, or performing a partial restore from the archive.

**To show whether media in a sequence is available, do one of the following:**

- Click the MultiRez button to select one of the displays described in the following table.

<table>
<thead>
<tr>
<th>Button Display</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gray - inactive</td>
<td>Bottom half of diamond black - Show Mismatches display. If the background is blue, some media does not match or is not available in the current settings. These can be the working settings or the target settings, depending on which settings the clips are linked to. If the background is gray, all media is available in the working settings.</td>
</tr>
<tr>
<td>Top half of diamond black - Show Target Availability display. If the background is yellow, some media is not available in the target settings. This information is the same whether the clips are linked to working settings or target settings. If the background is gray, all media is available in the target settings.</td>
<td></td>
</tr>
</tbody>
</table>

- Right-click the MultiRez button and select one of the following:
  - Show Mismatches
  - Show Target Availability

**Using Clip Coloring to Show Available Resolutions**

You can determine if clips are available in a particular resolution by coloring clips in the Timeline. For examples of clip coloring in the Timeline, see “Examples of MultiRez Clip Coloring” on page 1359.
The following procedure refers to the default colors available for resolution tracking. You can change the display colors that your Avid editing application uses by selecting custom colors in the Clip Color dialog box. For more information, see “Displaying Clip Colors in the Timeline” on page 667.

**To enable clip coloring for MultiRez in the Timeline, do one of the following:**

- Right-click the MultiRez button and select Enable Clip Coloring.

- Click the Timeline Fast Menu button, select Clip Color, then select Resolution Tracking and click OK.

How your Avid editing application colors clips in the Timeline depends on your settings:

If you click the MultiRez button to show mismatches (bottom half of diamond black), clips are colored as follows:

- No color change: The clip matches the working or target settings, depending on which settings you are linked to.
- Color changes (to blue or red by default): The clip does not match the working or target settings. Whether the color is blue or red depends on how you set the “If no match is found” option in the Dynamic Relink dialog box, as shown in the following table.

<table>
<thead>
<tr>
<th>If no match is found option</th>
<th>Default color if clip does not match current settings</th>
<th>Default color if clip is offline</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keep Existing Media</td>
<td>Blue</td>
<td>Red</td>
</tr>
<tr>
<td>Relink to Offline</td>
<td>Red</td>
<td>Red</td>
</tr>
<tr>
<td>Use Closest Media</td>
<td>Blue</td>
<td>Red</td>
</tr>
</tbody>
</table>

If you click the MultiRez button to show availability in the target resolution (top half of diamond black), clips are colored as follows:

- No color change: The clip is available in the target settings
- Color changes (to yellow by default): The clip is not available in the target settings

This button provides the same information whether the clips are linked to the working settings or the target settings.

If you enable clip coloring for MultiRez and then click the MultiRez button to display mismatches or target availability, this setting overrides any other Timeline clip coloring that might be set.
Clip coloring for the Show Mismatches display is not used when you select Highest Quality or Most Compressed as the relink method. This is because you do not select a specific quality, and your Avid editing application supplies the best quality or the most compressed media that is available.

Examples of MultiRez Clip Coloring

In the following examples, the working resolution is set to 15:1s, and the target resolution is set to DV 25. The examples show the default clip colors for resolution tracking. You can change the display colors that your Avid editing application uses by selecting custom colors in the Clip Color dialog box. For more information, see “Displaying Clip Colors in the Timeline” on page 667.

The following illustration shows a sequence of clips that are linked to working settings. The MultiRez button is blue, indicating that there are clips in the Timeline that do not match the working resolution.

If you select Keep Existing Media or Use Closest Media (in the Working Settings tab of the Dynamic Relink Settings dialog box) and enable clip coloring, clips that are not in the working resolution are colored blue by default. Your Avid editing application is warning you that the DV 25 clips do not match the working resolution but are linked to a different resolution (a mismatch).
If you select Relink to Offline, clips that do not match the working resolution are colored red by default, and the Media Offline slide is displayed in the monitors. In the following example, your Avid editing application is warning you that the DV 25 clips are not in the working resolution and the media is offline.

The “Relink to Offline” option does not delete the existing media. To relink to the media, select a different option in the Dynamic Relink dialog box.
The next example shows the Timeline after you click the MultiRez button to view the target resolution availability. The MultiRez button is yellow, indicating that there are clips that are not available in the target resolution, and the clip that is not available in DV 25 (the target resolution) is also colored yellow by default.

The following table describes the options in the MultiRez button menu:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Enable Clip Coloring | When this option is selected, clips that are linked to media that does not match the specified Dynamic Relink settings are colored. Your Avid editing application uses the following colors by default for clips in the Timeline:  
  - No color change: In the Show Mismatches display, the clip is linked to media that matches the working settings. In the Show Target Availability display, media is available at the target resolution.  
  - Blue: A clip in the Timeline is linked to media that does not match the specified settings. Blue is used if the option “If no match is found” is set to Use Existing Media or Use Closest Media.  
  - Red: A clip in the Timeline is offline. Red is used if the option “If no match is found” is set to Relink to Offline.  
  - Yellow: A clip in the Timeline is not available in the target resolution.  
If you select Enable Clip Coloring and then display mismatches or target availability, this setting overrides any other Timeline clip coloring that you set.  
You can change the display colors that your Avid editing application uses by selecting custom colors in the Clip Color dialog box. For more information, see “Displaying Clip Colors in the Timeline” on page 667.  
For more information, see “Displaying Whether Media Is Available for Dynamic Relinking” on page 1356.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description (Continued)</th>
</tr>
</thead>
</table>
| Show Mismatched Render Ranges     | Identifies effects that are rendered in a resolution that does not match the specified resolution for the resolutions to which the clips are linked (working or target). A blue line appears along the top of the effect to indicate the portion that is rendered using a different resolution.  
  
  *You might find it useful to turn off Enable Clip Coloring when you use this option, to make it easier to see the render range lines.*  
  
  If an effect has a mismatched render range, select the correct resolution in the Render tab in the Media Creation dialog box and then rerender the effect. For more information, see “Rerendering Effects” in the Help. |
| Show Mismatches                   | Indicates whether any clips are linked to media that does not match the working settings (Show Mismatches display). If any mismatched items are found, the MultiRez button turns blue. If Enable Clip Coloring is selected, clips that do not match the working settings are blue and offline clips are red. |
| Show Target Availability          | Indicates whether media is available that matches the target settings (Show Target Availability display). If media is not available, the MultiRez button turns yellow. If Enable Clip Coloring is selected, clips for which media is not available in the target settings are yellow. |
| Find Next Mismatched or Unavailable Clip | In the Show Mismatches display, moves the blue position indicator to the next item that is not in the working or target settings. This could be a clip or a rendered effect.  
  
  In the Show Target Availability display, moves the blue position indicator to the next clip that is not available in the target settings. The command does not apply to rendered effects in this display.  
  
  You can also use Ctrl+/ to move the position indicator.  
  
  *This option works only on enabled tracks.*  
  
| Update Media Status               | In the Show Mismatches display, relinks the clips displayed in the Timeline to the media that matches the working or target settings. Use this command to update links to the media if the desired media was not available when the clips were last linked.  
  
  In the Show Target Availability display, refreshes the clip information to show if media is currently available in the target settings. Use this command to view the availability of the target media without dynamically relinking. |
| Enable Dynamic Relink             | Lets you turn the dynamic relink feature on or off. For more information, see “Enabling Dynamic Relink” on page 1349.                                                                                                                          |
| Override Working Settings with Target Settings | Overrides the working settings with those in the Target setting tab of the Dynamic Relink Settings dialog box and performs a dynamic relink to the media. For more information, see “Dynamically Relinking to the Target Settings” on page 1353. |
| Dynamic Relink Settings           | Opens the Dynamic Relink Settings dialog box. For more information, see “Dynamic Relink Settings” on page 1464.                                                                                                                              |
MultiRez Bin Headings

Some bin columns are specifically associated with MultiRez. These bin headings are available in Avid editing applications when they are part of an Avid Interplay environment. MultiRez headings include:

- Video resolutions (for example, 1:1, DV 25, 15:1s)
- Audio sample rate, bit depth and resolution (for example, 48 kHz, 24-bit, MP2)

Your Avid editing application creates the list of headings from the resolutions that are compatible with the current project format. This list varies by project format and model. For example, if you are working in a 30i NTSC project, the list includes all resolutions that are compatible with 30i NTSC and 1080i/59.94 formats. These headings appear at the bottom of the Bin Column Selection list.

You need to select which columns you want to appear in the Text tab of the bin. For more information, see “Bin Column Headings” on page 368.

There might be more resolutions available on an Avid Interplay workspace than appear in your bin headings. For example, there might be an uncompressed version of the clips you are working with, but if your Avid editing application doesn’t support uncompressed video, the resolution does not appear in your bin settings. Some resolutions might show up as partially online.
Understanding Options for Deleting MultiRez Clips and Media

When working with MultiRez in an Avid Interplay environment, your options for deleting clips and media depend on several factors:

- Whether the clip is associated with media on local or shared storage. You can delete any clip from your bin, and you can delete any media on local storage. However, your ability to delete media on shared storage depends on your permissions as set on Avid Interplay. For more information, see the Avid Interplay Access User’s Guide.

- Which media files were originally captured with the clip. For clips in a bin, you can delete only the media that was originally associated with the clip. This association of the clip with its original media files is referred to as the affinity model (see “Multiple Clips, Multiple Resolutions, and the Affinity Model” on page 1336). The affinity model applies when you are deleting clips and media from a bin.

For example, if you transcode a clip from DV 25 to 15:1s, and create a new master clip, both resolutions are associated with the original clip in the bin. However, if you select the original clip (DV 25) for deletion, you see only DV 25 listed in the Delete dialog box.
For clips that were batch captured, captured in a dual-ingest configuration, or transcoded without a new clip, you see both resolutions listed in the Delete dialog box.

*Multiple audio sample rates are not listed in the Delete dialog box.*

The following table summarizes options for deleting MultiRez clips from a bin:

<table>
<thead>
<tr>
<th>Type of Clip</th>
<th>Resolutions Displayed for Deletion</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clip created through dual ingest</td>
<td>All associated resolutions</td>
</tr>
<tr>
<td>Clip created through batch capture or batch import</td>
<td>All associated resolutions</td>
</tr>
<tr>
<td>Transcoded clip, one clip</td>
<td>All associated resolutions</td>
</tr>
<tr>
<td>Transcoded clip, multiple clips</td>
<td>Original resolution only</td>
</tr>
<tr>
<td>Clips that share timecode and source</td>
<td>Original resolution only</td>
</tr>
</tbody>
</table>

**Deleting MultiRez Clips and Media from a Bin**

For more information on your options when deleting MultiRez clips and media, see “Understanding Options for Deleting MultiRez Clips and Media” on page 1364.

**To delete clips, subclips, and sequences associated with media on local storage:**

1. Select the clips, subclips, or sequences that you want to delete.

2. Do one of the following:
   - Select Edit > Delete.
   - Press the Delete key.

   The Delete dialog box opens, displaying information about the selected items.

3. Select the items you want to delete.

4. Click OK.

   If you choose to delete media files, a dialog box opens.

5. Click Delete.

   The selected clips, sequences, and media file are deleted.

*If you try to delete media for a clip that you have checked out from Avid Interplay, and do not have sufficient permissions to delete, a message informs you that you cannot delete media associated with checked-in assets from a bin.*
For more information about deleting in an Avid Interplay environment, see the *Avid Interplay Access User’s Guide*.

### Working with Partially Online Files

There are several cases where you might be working with MultiRez clips that are partially online:

- Consolidating and transcoding a portion of a clip or a subclip.
- Consolidating and deleting original media.
- Partially restoring from an archive.

Clips that are partially online are marked in a bin by a half circle.

<table>
<thead>
<tr>
<th>* Morocco Bin</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
</tr>
<tr>
<td>Bazaar scene</td>
</tr>
<tr>
<td>women in bazaar</td>
</tr>
<tr>
<td>women in bazaar new 01</td>
</tr>
</tbody>
</table>

### Consolidating and Transcoding a Portion of a Clip

You might create a partial clips if you consolidate and transcode a portion of a clip in a sequence. For example, if you use a portion of a DV 25 clip in a sequence and consolidate and transcode the sequence to a low resolution, your Avid editing application creates a new master clip in the low resolution. The new master clip is associated with both resolutions. The following illustration shows an example with DV 25 clip and 15:1s media.
Working with Partially Online Files

Top to bottom: original DV25 clip, portion of DV25 clip edited into a sequence, and new clip created in 15:1s by consolidating and transcoding the sequence. Only part of the original clip is available in 15:1s.

After consolidating and transcoding, the new master clip is shown in the bin as having media in both DV 25 and 15:1s, while the original master clip is shown as having full media in DV 25 and partial media for 15:1s.

If you trim the original sequence to expose more of the DV 25 clip, the Timeline displays as offline frames in the portions that are not available in 15:1s.

Viewing a Source Clip in the Timeline

You can view an entire source clip in the Timeline. This is useful if you want to check how much of a partial clip is offline and how much is online.

To examine the source clip for a partially online master clip:

1. Place the position indicator on the clip in the Timeline.
2. Click the Toggle Source/Record in Timeline button to display the source clip in the Timeline.
In the following example, the MultiRez button is blue, indicating that your Avid editing application is in the Show Mismatches display. The original master clip is displayed in the Timeline, with a working resolution set to 15:1s. Two portions of the clip are colored red, which is the default color indicating that these portions of the clip are offline and thus are not available in the working resolution.

### Consolidating and Deleting Original Media

You can create partial clips when you consolidate and then delete the original media. The result is similar to the example in “Consolidating and Transcoding a Portion of a Clip” on page 1366, in which a new clip is created through consolidation.

**To consolidate and delete the original media:**

1. Assume you have the same 10-minute master clip that has DV 25 and 15:1s versions of the media.
2. Edit a one-minute portion of the DV 25 media into a sequence.
3. Consolidate the sequence.
   
   This creates a new, one-minute clip with DV 25 media.
4. Use the Dynamic Relink option to relink the clips in the sequence to 15:1s.
5. Delete the DV 25 media from the original 10-minute clip.
6. Perform a dynamic relink to DV 25.

   Your Avid editing application links to the DV 25 media in the consolidated clip but does not replace the clip with the consolidated clip. The original clip remains in the Timeline and your Avid editing application displays the DV 25 material. If you trim the clip past the DV 25 portion you see offline frames or 15:1s frames, depending on your Dynamic Relink settings. In the bin, the DV 25 media is shown as partially online.

### Partially Restoring from an Archive

A clip might be displayed as partially online when you perform a partial restore from an archive.
To perform a partial restore from an archive:

1. Assume you have a 10-minute master clip and you have both 15:1s and DV 25 versions of the media.
2. Archive the DV 25 version of the media.
3. Delete the online DV 25 media and keep the low-resolution, 15:1 media online.
4. Edit one minute of the low-resolution version of the clip into a sequence.
5. Select the sequence in the bin and use Avid Interplay Archive to restore the DV 25 version of the clip from the archive.

If the profile that you choose is set up to perform partial restores, your Avid editing application restores only the portion of the clip that is in the sequence.

Now when you look in the bin, the DV 25 resolution shows as partially online. This is true even if the Timeline shows that all media is available.

Quality Matching

Your Avid editing application follows a specific process when attempting a dynamic relink. Dynamic relink provides you with a way to relink to media if the specific resolution or sample rate is not available. The Dynamic Relink Settings dialog box includes the following options that enable this feature, called quality matching:

- In the common area, for the option “If no match is found,” you can select “Use Closest Media.” Your Avid editing application uses the criteria you set in this dialog box to match the request.

- For the video relink method, you can select Highest Quality, Most Compressed, or Specific Resolution. For Highest Quality, your Avid editing application links to the least compressed and most highly defined media (more pixels, higher bit depth, more color information) with a format that most closely matches the project settings. For Most Compressed, your Avid editing application links to the most compressed media.

- If you select Specific Resolution as a relink method, you can select “Greater than or equal to,” or “Less than or equal to” as a filter for the video relink quality. In this case, your Avid editing application looks for an exact match. If it can’t find an exact match, it links to the closest media that satisfies the selected filter, based on format and compression.

- For the audio relink method, you can select Highest Sample Rate, Highest Bit Depth, or Specific Quality.

- For the audio relink quality, if you select Specific Resolution as a relink method, you can select “Greater than or equal to,” or “Less than or equal to” as a filter for the audio relink quality. Your Avid editing application looks for an exact match. If it can’t find an exact match, it links to the closest media that satisfies the selected filter, based on sample rate and bit depth.
For complete information about options in the Dynamic Relink Settings dialog box, see “Using the Dynamic Relink Settings Dialog Box” on page 1348.

If you select one of the above options, your Avid editing application uses the following queries to perform a dynamic relink:

1. Is there media with the same tape name (source ID) and timespan?
2. Is there media of the same size (NTSC, PAL, 1080HD, 720 HD)?
3. Is there media with the same field order (topness)?
4. Is there media in the same compression family?
5. Is there media of the same or similar compression value or audio sampling?
6. Is there media of the same bit depth?
7. Is there media in the same color space?

At each step, media is examined. Your Avid editing application continues looking for media until a single match remains.

**Quality Matching Reference**

**Video Format for Quality Matching**

The following table lists factors involved in determining the closest match for video format (queries 2 and 3 from the list in “Quality Matching” on page 1369). You select a media format when you create a project or when you select a different format in the Format tab in the Project window.

<table>
<thead>
<tr>
<th>Media Format</th>
<th>Raster dimension (pixels)</th>
<th>Field Order (Topness)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1080i</td>
<td>1920 x 1080</td>
<td>Upper field first</td>
</tr>
<tr>
<td>1080i</td>
<td>1440 x 1080</td>
<td>Upper field first</td>
</tr>
<tr>
<td>1080p</td>
<td>1920 x 1080</td>
<td>None</td>
</tr>
<tr>
<td>720p</td>
<td>1280 x 720</td>
<td>None</td>
</tr>
<tr>
<td>NTSC</td>
<td>720 x 486</td>
<td>Lower field first</td>
</tr>
<tr>
<td>PAL</td>
<td>720 x 576</td>
<td>Upper field first</td>
</tr>
<tr>
<td>DV (NTSC)</td>
<td>720 x 480</td>
<td>Lower field first</td>
</tr>
<tr>
<td>DV (PAL)</td>
<td>720 x 576</td>
<td>Lower field first</td>
</tr>
</tbody>
</table>

**Video Resolutions for Quality Matching**

The following table lists video resolutions supported by Avid editing applications, grouped in resolution families, from least compressed to most compressed (queries 4, 5, and 7 from the list in “Quality Matching” on page 1369). This order is used by your Avid editing application to match a request.

Some resolutions might not be available in your Avid editing application.

| Resolution Family | Resolution Name | 1:1 10b RGB | 1:1 10b | 1:1 |
Quality Matching

Audio Sampling and Bit Depth for Quality Matching

The following table lists sample rates and bit depths, from the highest sample rate to lowest sample rate (queries 5 and 6 from the list in “Quality Matching” on page 1369). This order is used by your Avid editing application to match a request.

Some sample rates might not be available in your Avid editing application.

<table>
<thead>
<tr>
<th>Resolution Family</th>
<th>Resolution Name</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>DNxHD 220</td>
</tr>
<tr>
<td></td>
<td>DNxHD 185</td>
</tr>
<tr>
<td></td>
<td>DNxHD 175</td>
</tr>
<tr>
<td></td>
<td>DNxHD 90</td>
</tr>
<tr>
<td></td>
<td>DNxHD 145</td>
</tr>
<tr>
<td></td>
<td>DNxHD 120</td>
</tr>
<tr>
<td></td>
<td>DNxHD 115</td>
</tr>
<tr>
<td></td>
<td>DNxHD 60</td>
</tr>
<tr>
<td></td>
<td>DNxHD 45</td>
</tr>
<tr>
<td></td>
<td>DNxHD 36</td>
</tr>
<tr>
<td></td>
<td>DNxHD 145-TR</td>
</tr>
<tr>
<td></td>
<td>DNxHD 120-TR</td>
</tr>
<tr>
<td></td>
<td>DVCPro</td>
</tr>
</tbody>
</table>

DNxHD resolutions are based on the frame rate of the project. For example, DNxHD 220 has a compressed data rate of 220 Mb/sec at 29.97 fps. DNxHD 185, which is an equivalent resolution, has a compressed data rate of 185Mb/sec at 25 fps.

<table>
<thead>
<tr>
<th>Resolution Family</th>
<th>Resolution Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>SD: JFIF interlaced</td>
<td>1:1, 2:1, 3:1, 10:1, 20:</td>
</tr>
<tr>
<td>SD:JFIF progressive</td>
<td>1:1, 2:1, 3:1, 14:1, 28:1, 35:1</td>
</tr>
<tr>
<td>SD:JFIF single-field and multicam</td>
<td>2:1s, 3:1m, 4:1s/4:1m, 8:1m, 10:1m, 15:1s</td>
</tr>
<tr>
<td>SD: DV</td>
<td>DV 50, DV 25</td>
</tr>
<tr>
<td>SD: MPEG/IMX</td>
<td>MPEG 50, MPEG 40, MPEG 30</td>
</tr>
<tr>
<td>SD: MPEG-2</td>
<td>MPEG-2</td>
</tr>
</tbody>
</table>

Audio Sampling and Bit Depth for Quality Matching

The following table lists sample rates and bit depths, from the highest sample rate to lowest sample rate (queries 5 and 6 from the list in “Quality Matching” on page 1369). This order is used by your Avid editing application to match a request.

Some sample rates might not be available in your Avid editing application.

<table>
<thead>
<tr>
<th>Sample Rate</th>
<th>Bit Depth</th>
</tr>
</thead>
<tbody>
<tr>
<td>96 kHz/24 bit</td>
<td>48 kHz/16 bit</td>
</tr>
<tr>
<td>96 kHz/16 bit</td>
<td>44.1 kHz/24 bit</td>
</tr>
<tr>
<td>88.2 kHz/24 bit</td>
<td>44.1 kHz/16 bit</td>
</tr>
<tr>
<td>88.2 kHz/16 bit</td>
<td>32 kHz/24 bit</td>
</tr>
<tr>
<td>48 kHz/24 bit</td>
<td>32 kHz/16 bit</td>
</tr>
</tbody>
</table>
Example of Quality Matching

This example is typical of a newsroom offline session. In this workflow, clips are usually captured simultaneously in MPEG-2 and DV 25, but sometimes the MPEG-2 clips are not available. You want to get media immediately, and you want the lowest (most compressed) resolution available to use less network bandwidth, but you’ll take DV 25 if that’s all that’s available.

<table>
<thead>
<tr>
<th>Project</th>
<th>NTSC 30i</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source for clips</td>
<td>Tape0317</td>
</tr>
<tr>
<td>Working settings</td>
<td>If no match is found: Use Closest Match</td>
</tr>
<tr>
<td></td>
<td>Video Parameters</td>
</tr>
<tr>
<td></td>
<td>Relink Method: Most Compressed</td>
</tr>
<tr>
<td></td>
<td>Relink if Quality: Not applicable</td>
</tr>
<tr>
<td></td>
<td>Preferred media format: MXF</td>
</tr>
</tbody>
</table>

As you edit your project and load clips into a monitor, your Avid editing application dynamically relinks the clips to media that most closely matches the working settings. Your Avid editing application checks the Media Indexer to select one clip that matches the criteria. When it finds a single clip, it stops.

For the preceding example settings, your Avid editing application follows this process:

1. Query: Is there media that comes from Tape0317?
   Answer: Yes — there is more than one media file from that tape (MPEG-2 and DV 25 versions).

2. Query: Is there media from this tape that matches the clip’s timecode span?
   Answer: Yes, there is more than one media file.

3. Query: Do these media files match NTSC size and topness?
   Answer: Yes, there is more than one.

4. Query: Do any of these media files match the media family (MPEG-2)?
   Answer: Yes, one media file matches all the criteria. Your Avid editing application links the clip to that media file.

What if the MPEG-2 media doesn’t exist? Your Avid editing application looks for the next most compressed media, finds one media file in DV 25 that matches the criteria, and links to it.
The Avid MultiCamera editing features let you incorporate multiple camera angle sources into the nonlinear editing process. Techniques for using these features are described in the following topics:

- Understanding Grouping and Multigrouping Clips
- Creating Group Clips
- Creating Multigroup Clips
- MultiCamera Displays
- MultiCamera Editing Techniques
- Selective Camera Cutting

**Understanding Grouping and Multigrouping Clips**

The grouping and multigrouping procedures gather selected clips into a single unique clip. Both procedures let you use special MultiCamera editing features, such as multi-split views in MultiCamera mode.

The differences between the two procedures are summarized as follows:

- **Grouping** creates a separate group clip out of a single set of master clips, from the IN point to the OUT point of the longest clip. Multigrouping takes the Group function one step further, literally stringing numerous sequential groups into a rough sequence. For this reason, multigroups are also known as *sequence clips*.

- The **Group function** lets you sync clips based on common source timecode, auxiliary timecode, or marks placed in the footage. Because of the need for complete accuracy in sorting and grouping the clips, multigrouping is performed on the basis of common source timecode only.
Creating Group Clips

The MultiGroup function is designed primarily for situation comedies and similar productions that record multiple takes sequentially on the same source tapes. Multigrouping does not provide any benefit when you edit with clips that do not share common timecode or were not recorded sequentially, and might even cause the wrong clips to be grouped together.

Because the Group function lets you sync the clips based on customized IN points or OUT points, you can group any collection of clips for quick cutting of montage sequences or music-video sequences.

Creating Group Clips

In addition to the multicamera context, you can use grouped clips in other situations. Unlike multigrouping, which requires clips with matching source timecode, you can group clips that were shot at different times, on different days, and on completely different source tapes. This means that you can use group clips to:

- Create montage sequences quickly with fast-cutting between unrelated clips.
- Sync and edit an audio track (music, for example) with two or more video tracks, useful in music-video editing.
- Isolate each take as a group for multicamera editing and edit selectively, rather than build a larger sequence clip.
- Group selected portions of multicamera clips using carefully synchronized marks.

The last two options are generally used in smaller multicamera projects. Sorting, marking, selecting, and grouping individual takes of a larger project can be very time-consuming.

You can also use stereoscopic clips in group clips—see Grouping Stereoscopic Clips.

To create a group clip:

1. If you are using a sync point, load the clips and mark an IN point at the sync point at the start of each clip, or mark an OUT point at the sync point at the end of each clip.

   For multicamera video or film shoots, you typically use a slate for marking IN and OUT points; however, you can use any visual or aural event that is recorded by all cameras simultaneously.

2. In the bin, select all the clips you want to group.

3. Select Bin > Group Clips.
4. Select an option, based on the following:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Film TC/Sound TC</td>
<td>Use this option if you are syncing clips with matching film and sound timecode recorded in the field. This option appears dimmed if you are not working in a 24p or 25p project.</td>
</tr>
<tr>
<td>Inpoints</td>
<td>Use this option if you are syncing according to IN points set in each clip.</td>
</tr>
<tr>
<td>Outpoints</td>
<td>Use this option if you are syncing according to OUT points set in each clip.</td>
</tr>
<tr>
<td>Source Timecode</td>
<td>Use this option if the clips have matching timecode.</td>
</tr>
<tr>
<td>Auxiliary TC1–TC5</td>
<td>Use this option if the clips have matching timecode in the same Auxiliary Timecode column. Select an Auxiliary TC, 1 through 5, from the menu.</td>
</tr>
</tbody>
</table>

5. Click OK.

A group clip appears in the bin, with the name of the first clip in the group, followed by the file name extension Grp.n.

The n is the incremental number of group clips with the same name in the same bin. You might want to rename them for easier reading, such as name_Group.

### Grouping Stereoscopic Clips

Stereoscopic clips can be used for multicam editing in the same manner as regular clips. To start off, you first need to create your stereoscopic clips with the contributing left and right eye master clips. (You can mix both regular and stereoscopic clips in a group clip.) After the group clip has been created, you can load it into the source monitor and begin the multicam editing.

When the group is loaded into the source monitor, you can choose to see just one of the clips, or all of the clips in the group (upto a 9-split view). Note that while viewing stereoscopic clips in the source monitor, the stereoscopic view is turned off. You can choose to display either the left eye image, the right eye image, or the image set as the leading eye. This view mode is set by the Stereoscopic option in the Project Format dialog box.

Before outputting your sequence, you have the option to commit your multicam edits and replace the grouped clips with the clip selected for the edit. For more information, see “Committing MultiCamera Edits” on page 1388.
Creating Multigroup Clips

Multigrouping is strictly for use in large multicamera productions, such as situation comedies, in which all synchronous camera shots are recorded with the same timecode. The MultiGroup function is a single Bin menu command that eliminates the time-consuming steps of collecting, sorting, grouping, and assembling large volumes of multicamera clips.

To multigroup your material:

1. Sort the clips by name in the bin.
2. Select Edit > Select All to select the master clips.
3. Select Bin > MultiGroup.
4. Select an option, based on the following:
5. Click OK.

Your Avid editing application creates several group clips for each take in the bin, and then creates a multigroup clip from the groups. The multigroup clip has the same icon as the group clips, but the icon is preceded by a plus sign.

MultiCamera Displays

There are several displays that let you view and edit with multiple camera angles. You can edit with either group clips or multigroup clips in all of the displays.
Full-Monitor Display

When you first load a grouped or multigrouped clip, the Source monitor displays a single frame from one clip in the group in Source/Record mode. This is called Full-Monitor display when working with group clips because you can view each angle in full-monitor size as you edit.

The basic features of Full-Monitor display:

- Provides source-oriented control of multicamera material. You can switch camera angles, cue, and mark material without affecting the sequence.
- Provides the same Source monitor controls that are available when you edit other clips in Source/Record mode.
- Provides the same MultiCamera editing features that are available in Quad Split Source view, Nine Split Source view, and MultiCamera mode. These features are described in “MultiCamera Editing Techniques” on page 1383. The only difference is that in Full-Monitor display, you can view each angle as full size while you edit.

Quad Split Source View

After loading a group clip into the Source monitor, you enter Quad Split Source view by clicking the Quad Split button located in the Command palette in the MCam tab. The Source monitor splits into four camera angles of the group clip. A Group Menu icon appears above the Source and Record monitors.
Quad Split Source view, with the four camera angle views in the Source monitor and the sequence or linecut in the Record monitor. The location of the Group Menu icon is highlighted.

The basic features of Quad Split Source view:

- Provides source-oriented control of multicamera material. You can switch camera angles, play back (one camera angle at a time), cue, and mark material without affecting the sequence.

- Provides the same Source monitor controls that are available when you edit other clips in Source/Record mode.

- Provides the special MultiCamera editing features that are available in Full-Monitor display, Nine Split Source view, and MultiCamera mode. These features are described in “MultiCamera Editing Techniques” on page 1383.

- Provides a list of all group clip video and audio tracks in the Group menu for custom selection and patching.

- Lets you use the Quad Split button to switch the Source monitor between Full-Monitor display and Quad Split Source viewing and editing modes (editing functions are the same in both displays).

- Lets you use the Swap Cam Bank button to switch the Quad Split Source view from one bank of four camera angles to another bank of four camera angles. The Multi-angle View menus let you change the camera angles of the split displays.

- Does not gang the Record monitor with Quad Split Source view.

**Nine Split Source View**

After loading a group clip into the Source monitor, you enter Nine Split Source view by clicking the Nine Split button located in the Command palette in the MCam tab. The Source monitor splits into nine camera angles of the group clip. A Group Menu icon appears in the second row of information above the Source and Record monitors.
Nine Split Source view, with the nine camera angle views in the Source monitor and the sequence or linecut in the Record monitor. The location of the Group Menu icon is highlighted.

The basic features of Nine Split Source view:

- Provides *source-oriented* control of multicamera material. You can switch camera angles, play back (one camera angle at a time), cue, and mark material without affecting the sequence.

- Provides the same Source monitor controls that are available when you edit other clips in Source/Record mode.

- Provides the special MultiCamera editing features that are available in Full-Monitor display, Quad Split Source view, and MultiCamera mode. These features are described in “MultiCamera Editing Techniques” on page 1383.

- Provides a list of all group clip video and audio tracks in the Group menu for custom selection and patching.

- Lets you use the Nine Split button to switch the Source monitor between Full-Monitor display and Nine Split Source viewing and editing modes (editing functions are the same in both displays).

- Lets you use the Swap Cam Bank button to switch the Nine Split Source view from one bank of nine camera angles to another bank of nine camera angles. The Multi-angle View menus let you change the camera angles of the split displays.

- Does not gang the Record monitor with Nine Split Source view.
MultiCamera Mode

After loading a group clip into the Source monitor and editing it to create a new sequence, select MultiCamera Mode from the Special menu to activate the features. The MultiCamera Quad Split Edit or MultiCamera Nine Split Edit is displayed, depending on whether you were in Quad Split Source view or Nine Split Source view before entering MultiCamera mode.

You can also enter MultiCamera mode by clicking the Quad Split button or the Nine Split button if you have previously mapped the button to one of the toolbars in the Timeline or the Source/Record monitor.

MultiCamera mode takes the Nine Split Source view and Quad Split Source view one step further: it gangs all clips in the group clip displayed in the Source monitor with the sequence displayed in the Record monitor. All clips are synchronized and continuously updated during playback and editing.

You see the best real-time playback performance when you play material that was recorded at 10:1m, 4:1m, or 1:1 resolutions. Also, you see better performance when you play in Best Performance mode rather than in Full Quality mode. For more information about these modes, see “Playing Effects Back at Different Video Qualities” in the Help.

When you play back multicamera material, you can cut by using the MultiCam keys to select different camera angles when stopped. The camera angles you selected with the MultiCam keys are recorded as cuts in the Timeline and are displayed in the Record monitor.

MultiCamera mode. The Source monitor controls are disabled.
The basic features of MultiCamera mode:

- Provides sequence-oriented control of multicamera material, in contrast to Full-Monitor display, Nine Split Source view, and Quad Split Source view. Whenever you play back, cue, switch camera angles, or mark material, your changes occur in the sequence.
- Synchronizes all camera angles displayed in the Source monitor and continuously updates during playback and editing.
- Lets you perform live bank swaps while playing in MultiCamera Quad Split Edit mode by using the Swap Cam Bank button.
- Provides only Record monitor controls.
- Provides special MultiCamera editing features that are available in Full-Monitor display, Quad Split Source view, and Nine Split Source view. These features are described in “MultiCamera Editing Techniques” on page 1383.
- Lets you cut between clips as you would during live switching of a show.
- Provides a list of all group clip video and audio tracks in the Group menu for custom selection and patching.
- Lets you deselect MultiCamera Mode in the Special menu at any time to switch between source-oriented and sequence-oriented MultiCamera editing.
- Lets you switch between singular and multi-angle playback without exiting MultiCamera mode.

**Real-time Playback in MultiCamera Mode**

You can use the Video Quality options to achieve better real-time playback performance in SD projects when you display multiple views (Quad Split Source view or Nine Split Source) in MultiCamera Mode. The range of options available depends on your input/output hardware configuration. For more information on the Video Quality menu, see “Video Quality Options for Playback” on page 543.

Your Avid editing application remembers your most recent Video Quality setting for Multicamera Mode and switches to it automatically whenever you open a multicamera or group clip.

For example, you might be working with group clips and set the Video Quality menu to Draft Quality, then close all group clips and work with single clips. When you reopen a group clip in a monitor, your Avid editing application remembers your last group clip setting and switches to Draft Quality, regardless of the video quality you were using for single clips.
Limitations on Playback of MultiCamera Media

To play back a group clip or a multigroup clip, you must be in MultiCamera mode. In addition, the following limitations apply to playback performance for standard-definition projects and high-definition projects:

- In an SD project, you must have Avid input/output hardware attached to your system in order to view multicamera display in a client monitor during a digital cut. Alternatively, you can view multicamera display using Full Screen Playback.
- In an HD project, you cannot play back a multicamera sequence to the client monitor. To view multicamera playback, use Full Screen Playback.

For more information on full screen playback, see “Playing Video to a Full-Screen Monitor” on page 527.

- In an SD project, multicamera editing works only with 8-bit resolutions. If you use media with a 10-bit resolution, your Avid editing application automatically plays the media at the appropriate 8-bit resolution.

MultiCamera Editing Techniques

When you load a group or multigroup clip into the Source monitor and begin editing, the Timeline adds a unique identifier to indicate the presence of a group.

Your Avid editing application uses the name of the clip within the group to identify the clip in each cut, and adds a G in parentheses to indicate the group.

```
<table>
<thead>
<tr>
<th>Group Name</th>
<th>Source Clip</th>
<th>Record Clip</th>
</tr>
</thead>
<tbody>
<tr>
<td>BreakingWaveScMo(G)</td>
<td>Penguins.new.01</td>
<td>burning sky 2</td>
</tr>
<tr>
<td>BreakingWaveScMo(G)</td>
<td>Penguins.new.01</td>
<td>burning sky 2</td>
</tr>
<tr>
<td>BreakingWaveScMo(G)</td>
<td>Penguins.new.01</td>
<td>burning sky 2</td>
</tr>
</tbody>
</table>
```

Group clips in the Timeline

Using various keys and functions, you can switch and edit the displayed group clip at any point in the sequence. These techniques apply to both group and multigroup clips.

Switching Clips with the Arrow Keys During Multicamera Editing

You can switch the display of camera angles by using the Previous In Group button and the Next In Group button. These buttons are mapped by default to the Up Arrow and Down Arrow keys. The angle selection switches in either the Source monitor (source material) or in the Record monitor (sequence material), whichever is active.
If the group contains more camera angles than the multi-split display, the Up Arrow and Down Arrow keys cycle through all the clips. Only the first four clips are shown in the Quad Split display and only the first nine clips are shown in the Nine Split display.

When the Record monitor is active, you can place the position indicator within any segment and use the arrow keys to switch the group clip selected for that segment.

Whenever you switch camera angles, you also switch the frame representing the group in the bin. You can use this method to change the representative frame for bin display and storyboarding.

**Numeric Keypad and Mouse Support for MultiCamera Editing**

You can use the numeric keypad and mouse buttons to switch the display of camera angles and to swap camera banks. These options provide a quick and intuitive way to do multicamera editing.

**To switch camera angles, do one of the following:**

- Click a camera angle in the split display during playback to switch to that camera angle.
- Press a number key on the numeric keypad to switch to a new camera angle.

For Quad Split display, the following table describes the key mappings:

<table>
<thead>
<tr>
<th>Keys</th>
<th>Position in Split Display</th>
<th>Keys</th>
<th>Position in Split Display</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>Upper left</td>
<td>4 or 1</td>
<td>Lower left</td>
</tr>
<tr>
<td>8 or 9</td>
<td>Upper right</td>
<td>2, 3, 5, or 6</td>
<td>Lower right</td>
</tr>
</tbody>
</table>

For Nine-Split display, each of the nine keys 1 through 9 maps to a position in the split display based on its location on the keypad. For example, the 7 key maps to the upper left camera angle in the split display, while the 5 key maps to the center camera angle.

**To switch camera banks in Quad Split display, do one of the following:**

- Click the right mouse button.
- Press either the 0 (zero) key or the . (period) key on the numeric keypad.

**Editing and Playing Back a Linecut in MultiCamera Mode**

You can edit and play back a linecut (playback of the edited sequence) on the Source monitor while in Quad Split Source view and Nine Split Source view. The client monitor also plays the linecut.
The client monitor displays only SD multicamera sequences. You can view playback of HD multicamera sequences in the Source monitor only.

If you notice frames are dropping during playback, decrease the size of the Composer window until playback becomes smooth.

To play a linecut on the client monitor in MultiCamera mode:

1. Double-click Composer in the Settings list of the Project window.
   The Composer Settings dialog box opens.
2. Click the MultiCam tab.
3. Click the Split Mode Play menu, and select Quad or Nine Split.
4. Click the MultiCam Mode Client Monitor menu, and select Linecut.
5. Click OK.

Using the Add Edit Button During Multicamera Editing

You can use the Add Edit button like a hot key to add edits while stepping through a sequence during playback. The only difference is that you are not switching camera angles until after you set the edit points.

This method is especially useful when editing to music because it lets you concentrate on the beats and ignore camera angles until the edits are placed.

To use this method, you must first map the Add Edit button onto the keyboard. Consider mapping the Add Edit button to a function key next to the default MultiCam keys. For more information on mapping keys, see “Understanding Button Mapping” on page 129.

To add edits:

1. Load the group or multigroup clip into the Source monitor and splice it into a sequence.
2. Play the sequence. Each time you want to make an edit, stop and press the Add Edit key.
   The edits appear in the Timeline.
   Play the sequence repeatedly to add more edits, or remove edits in Trim mode by lassoing them in the Timeline and pressing the Delete key.
3. After adding the edits, place the position indicator within each segment and use the arrow keys to switch camera angles.
Using the Group Menu for Multicamera Editing

The Group menu lets you select video or audio channels from any of the clips in the group and patch to the tracks available in the sequence. You can have nine camera angles and nine or more audio tracks synchronized and available for patching at any time.

Select the Second Row of Info option in the Composer Settings dialog box for the Group Menu icon to be displayed above the Source monitor.

You can select the Audio Follow Video option from the Group menu to instruct the system to switch both audio and video for each camera angle or selective camera style. The Group Menu icon changes to green when you select the Audio Follow Video option. Audio Follow Video overrides the track selection beside the Timeline and switches audio in track A1 only. Audio-Follow-Video edits appear in the Timeline as match frames (that is, the transition contains an equal sign)

To use the Group menu:

1. Click the Group Menu icon in the second row of information above the Source monitor to display the Group menu.

2. Select video or audio channels from any clip in the group to patch the video or audio channels to the tracks available in the sequence.
3. (Option) Select the Audio Follow Video option to switch both audio and video for each camera angle when you cut.

**Using the Multi-angle View Menus During Multicamera Editing**

You can use the Multi-angle View menus to group up to 18 clips at a time, and select additional clips to be shown in any of the multi-split displays in the Source monitor. You can also select Sequence from the Multi-angle View menus to display the entire sequence.

**To select an additional clip from the group to appear in one of the multi-split displays:**

1. Press the Ctrl key to activate the display of clip names in the multi-split displays.
2. Ctrl+click the multi-split display where you want to show the new clip.
   
   The clips in the group are listed in the Multi-angle View menu.

Select additional angles from the Multi-angle View menu

3. Select the clip you want to display from the Multi-angle View menu.
   
   The new clip appears in the multi-split display.
Using Match Frame in MultiCamera Editing

You can use the Match Frame button to display the matching clip within the group when match framing from the sequence, or you can display the original clip when match framing from the source group. For more information on using the Match Frame feature, see “Using Match Frame” on page 573.

If the group contains more clips than are displayed and you match a clip that is not visible (for example, clip 5 and above for the Quad Split display), your Avid editing application selects the clip but does not display it.

Committing MultiCamera Edits

You can remove the grouped clips in a sequence and replace each of them with its selected clip. This might be useful if you experience poor performance with a very complex multicamera sequence on a slower system, for example, a sequence that uses many multicamera clips and many effects or color corrections.

To commit multicamera edits:

1. Select the sequence you want to affect.
2. Right-click the sequence and select Commit Multicam Edits.

Your Avid editing application duplicates the sequence, and then replaces each grouped clip in the duplicate sequence with its selected clip. The original sequence is unaffected and still contains the grouped clips.

Selective Camera Cutting

Selective camera cutting involves marking and editing source material into the sequence, much as you build a sequence by using nongrouped clips in a normal session. You can play, cue, and mark clips on the source side, and then splice, overwrite, and trim clips in the sequence.

To perform selective camera cutting, do one of the following:

- Lay down an entire group as a master sequence, and then add edits, switch camera angles, and trim within the sequence or cut in new clips.
- Edit one clip at a time without laying down a master sequence first, effectively building a sequence as you would with single-camera material.

The advantage of selective camera cutting with grouped clips is that all the clips are synchronized, which simplifies the selection of camera angles. Selective camera cutting generally requires the use of a detailed line script or detailed notes that enable you to select clips and assemble the sequence one clip at a time.
To perform selective camera cutting with grouped clips:

1. Load the group or multigroup clip into the Source monitor.

2. Using timecode notes and the numeric keypad, type the timecode for the first take to begin the sequence, and press Enter (Windows) or Return (Macintosh) to cue the clip in the Source monitor to the take.

3. Mark IN and OUT points for the entire scene.

4. Select a camera angle for the first clip, and then splice the entire scene into a sequence.

5. Use the arrow keys, the Add Edit button, or both to select edit points and switch to different angles throughout the master scene in the sequence.

6. To replace a portion of the take with a part from another take, use the timecode notes again to cue the take, set marks, and perform a replace edit.

7. When you are finished with a scene, repeat the procedure for each additional scene in the sequence.
The Avid Marketplace

The Avid Marketplace feature allows you to purchase video (stock footage), sound effects, music and plug-ins from within your Avid editing application. This chapter describes the process of downloading stock footage clips and Avid supported plug-ins from within your Avid editing application.

You must be connected to the Internet to access features offered in the Avid Marketplace.

The Avid Marketplace window includes a navigation toolbar that allows you to move Backward, Forward, Refresh, and Cancel your last action. When you are ready to download, a progress bar displays at the bottom and indicates the percentage of time left to download your plug-in. You can also cancel the download at anytime.

Avid Marketplace Media Libraries

The Avid Marketplace Media Libraries allows you to search and select from hundreds of thousands of clips in an online footage library, review your search results from a thumbnail clip, and once you decide on the stock footage clips you want, download a proxy clip to try out in your sequence, and then purchase and download the high resolution clip.

With the help of Thought Equity Motion, a third-party distributor of stock footage, you can connect through the Avid Marketplace Media Libraries window and search, view and purchase stock footage clips to load into your sequence.

Avid partnered with Thought Equity Motion because they increase the value of video content through an advanced technology platform and licensing service. You will be able to license and purchase sports, news, entertainment, editorial, and creative content from Thought Equity Motion media partners, including BBC Motion Gallery, Paramount Pictures, Sony Pictures Entertainment, National Geographic, The New York Times, and the NCAA.

The Avid Marketplace requires that you install Flash Player 11 or higher to play the stock footage clips in the Thought Equity Motion website.
Avid Marketplace Media Libraries Quick Start

The following section contains high-level steps you can perform to search, preview and select stock footage clips to purchase and include in your Avid editing sequence. See other topics in this chapter for detailed steps and more information.

To purchase stock footage:

1. From your Avid editing application, select Marketplace > Media Libraries.
   The Avid Media Libraries window opens.
2. From the Stock Video section, click on the link that brings you to the Avid Thought Equity Motion site.
3. If this is your first time, click Register to set up your User Account with Thought Equity Motion.
   For more information, see “Creating a User Sign In and Password” on page 1393.
4. Click Sign In if you have already registered.
5. Enter your user name or e-mail and password.
   The system signs you in and you now have access to hundreds of thousands of clips.
6. In the Search field, enter text to locate the stock footage clips you might want, for example: flowers.
7. Click the Search icon.
   For more information, see “Performing a Search” on page 1395.
   The system searches for and displays your results.
8. Click the filters in the left pane to refine your search results.
9. Click the Download Comp (Down Arrow) icon to download a single clip or add multiple clips to My Bins to download multiple clips at one time.
   You can use the default My Bins or create personalized bins to store your clips.
10. Click My Bins.
    For more information, see “Creating an Online Stock Footage Bin” on page 1399.
11. Select the clips you want to try in your sequence and click Download Comps.
    The Select a bin window opens.
    For more information, see “Getting Comp Clips into Your Avid Bin” on page 1404.
12. Select the bin where you want the system to place your downloaded comp clips.
    A progress bar displays. The low resolution AMA clips appear in your Avid bin. A watermark displays on the clips indicating that it is a low resolution, non-purchased clip.
13. You can now add the clips to your sequence.

14. If you want, you can create a Stock Footage Report (.txt file) to see which clips you have used in your sequence, right-click the sequence in the bin or right-click the sequence in the Record monitor and select Stock Footage Report.
   
   For more information, see “Creating a Stock Footage Report” on page 1408.

15. When you decide which clip you want to purchase, right-click the clip in the bin or to download all the clips in your sequence, right-click the sequence and select Buy Stock Footage clips.
   
   A login window opens asking you to login. A stock footage report is sent and a bin is created in My Bins. This new bin includes all the stock footage clips and information about each clip in your sequence. This report is used to calculate the cost of your clips.
   
   For more information, see “Purchasing Your Stock Footage” on page 1410.

16. Add your clips to your cart (one at a time) and specify the usage type in the License window.
   
   You will receive an e-mail when your high resolution clips are ready to download.
   
   Some footage clips need to be priced and licensed with the assistance of a sales rep. Please contact a Thought Equity Motion Sales Representative, call 866-815-6599, or select Click here to request further details and you will be contacted shortly.

   Call Thought Equity Motion to specify if you need the High Resolution clip to be created with the Avid QuickTime codecs at a specific resolution (for example DNxHD). This is helpful if you need to match the project type and resolution of your finished sequence.

17. Download your high resolution stock footage clips from Thought Equity Motion.

   You can also download your comp clips and high-resolution clips from outside of the Avid editing application. For information on how to do this, see “To download comp clips outside of the Avid editing application to an Avid bin:” on page 1407 or “To download your stock footage outside of the Avid editor:” on page 1413
   
   It is recommended that you place all your high resolution stock footage clips for one project in the same bin.
   
   The media file is stored on the drive you have specified in the Media Creation > Import tab dialog box.

   Make sure that the drive you specify in the Media Creation > Import tab dialog box supports the bandwidth and has enough space to support the downloaded stock footage media.
   
   For more information, see “Downloading your High Resolution Stock Footage” on page 1411.

18. Open the bin(s) that stores all your high resolution stock footage clips and select the high resolution clips that correspond to the comp clips in your sequence.
Creating a User Sign In and Password

Logging in to the Avid Marketplace - Media Libraries gives you access to hundreds of thousands of stock footage clips. The system stores all your information under your user name and password. You need to set up a User Account to use the Thought Equity Stock Footage library.

You may be asked to login during downloading, purchasing and ordering. This allows Avid and the vendor to pass and receive information back and forth. Even though you may be logged in to the vendor site, you may be asked to login again.

**To sign in to the Avid Media Libraries for the first time:**

   
   The Avid Media Libraries window opens.

2. From the Stock Video section, click on the link that brings you to the Avid Thought Equity Motion site.
3. In the Thought Equity Motion page, click Register. The Register Information window opens.

4. Enter required information including e-mail and password.

5. Click Submit Registration.

   Your account information is saved and you are logged into Thought Equity Motion. The next time you visit the Thought Equity Motion, click Sign In and enter your email and password.

**Licensing Options**

Thought Equity Motion displays the legal rights and clearance under each clip.

Within a search, licensing options include:

- Rights Managed footage is subject to specific usage restrictions. These typically include a limit on the number of times used, broadcast territory, and a usage time period. Additional licenses can be purchased for additional uses.

- Royalty Free footage can be used for an unlimited period of time and number of uses.
About the Stock Footage Clips

There are two types of stock footage clips that you can download to your Avid editing system:

- A low resolution “comp” clip which allows you to try out the clip in your sequence first, before you purchase. This comp clip also displays a watermark.
- A high resolution clip that you purchase. You have several formats to choose from.

Both clips are downloaded and linked using Avid’s AMA (Avid Media Access) feature, using the AMA QuickTime plug-in (installed with your Avid editing application). The clips you purchase and download from the Avid Media Libraries should be .mov files. If you plan to download stock footage clips that are HD format, you need to store the HD media on striped drives that support the HD resolution. Also, for final output of a sequence, the AMA linked stock footage can be transcoded to the appropriate resolution.

Since your stock footage clips are linked through the AMA method, you can use the AMA options described in “Acquisition of File-Based Media (AMA)” on page 394.

Searching through Stock Footage

From within the Avid editing application, you can search, view, purchase, and download stock footage clips.

Within the site you can create bins to store your clips in and when you are ready to purchase and download clips, you can choose to download all the clips in one sequence or download a single clip.

The Avid Marketplace window includes a navigation toolbar which allows you to move Backward, Forward, Refresh, and Cancel. When you are ready to download a clip, a progress bar displays and indicates the percentage of time left to download your clip. You can also cancel the download at anytime.

Performing a Search

To start a search:

   The Avid Media Libraries window opens.
2. From the Stock Video section, click on the link that brings you to the Avid Thought Equity Motion site.
3. Click Sign in and enter your user name or email and password.
If you have not registered yet, click Register. See “Creating a User Sign In and Password” on page 1393.

4. Click Log On.

   The system signs you in to Thought Equity Motion.

5. Enter your search terms in the Search for footage bar.

6. Click the Search button or press Enter.

   The system returns your results in the Display window.
7. Place your cursor over the thumbnail to preview a clip.
8. Use the navigation buttons to move Backward, Forward, and Refresh your last action.

**To change the display options:**

1. Enter your search terms in the Search for footage bar.
2. Click the Search button or press Enter.
   
The system returns your results in the Display window.
3. Click Display Options.
   
The Change your display options dialog box opens.

4. Select the results per page, Grid view (thumbnail) or Text view and to display your thumbnail as a still image or video.
5. Click Apply.
   
The Display window updates to the new options.

**Basic Search Terms**

You can use Boolean modifiers to limit or expand your footage search.

- Use the following modifiers: AND, NOT & OR (entered as capital letters).
- **AND**: Use when you want to return clips featuring both terms. For example, a search of butterfly AND yellow returns clips with keywords “butterfly” and the color “yellow.”
- **NOT**: Use when you want to exclude certain clips from a search. For example, a search for butterfly NOT swimming returns clips containing the keyword “butterfly” but eliminates those clips with “swimming.” In this case, swimmers doing the butterfly stroke would not appear in the search results.
• OR: Use when you want to search for clips containing either keyword. For example, a search for butterfly OR moth, returns clips featuring both butterflies and moths.

• Combine modifiers: Use a combination of keywords and operators to narrow your search. For example, butterfly AND yellow NOT swimming NOT fish, returns clips containing “butterfly” and “yellow” but eliminates clips of swimmers doing the butterfly stroke and butterfly fish.

**Modifying a Search**

You can customize your search with filters. The filters are located on the left side of the search results page. These tools allow you to narrow your search by footage type, format, rights, specialty, and other options.

**To filter your results:**

- After you perform an initial search, you can narrow your search by selecting the following options in the menu located to the left of your search results.

<table>
<thead>
<tr>
<th>Filter search results options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Content Type</td>
<td>Allows you to choose from Clips, Screeners, or Text Records. Select one of these options to search for only a specific content type.</td>
</tr>
<tr>
<td>Format</td>
<td>Allows you to choose from SD, HD or Available on Film formats. Select one of these options to search for only a specific format.</td>
</tr>
<tr>
<td>Footage Type</td>
<td>Allows you to choose from a type of footage, including: Creative, Editorial, Commercial. Select one of these options to search for only a specific footage type.</td>
</tr>
<tr>
<td>Editorial</td>
<td>Allows you to choose from Archive, Celebrity, News and Sports. Select one of these option to search for only a specific section.</td>
</tr>
<tr>
<td>Rights</td>
<td>Allows you to choose from Rights Managed or Royalty Free. Select one of these option to search for only specific rights.</td>
</tr>
<tr>
<td>Broadcast Standard</td>
<td>Allows you to choose from NTSC, PAL, 720 or 1080. Select one of these option to search for only a specific broadcast standard.</td>
</tr>
</tbody>
</table>
To refine your search results:

1. After the search results page opens, select from the list of Refine options.

2. Select a keyword.

   The system searches through your results based on the newly added keyword and displays a new set of results.

### Creating an Online Stock Footage Bin

Once you find clips that you are interested in, you can store them in an online Thought Equity Motion bin. Bins are created in the My Bins menu. You might find it helpful to create multiple bins for different projects or topics.

**To create a Thought Equity Motion bin:**

1. Within the site, click My Bins.

   A menu displays bin options.

2. Click Create a new clip bin.

   The Create a new clip bin dialog box opens.

3. Enter the bin name and any information you want associated with the bin.

4. If you want this bin to be your default bin, click Set focus to this bin.
5. Click Submit.

   The system creates your new bin and adds it to the My Bins menu.

**To add a clip to a Thought Equity Motion bin folder:**

1. Once you have identified a clip to add to a bin, click the Add (+) button.
   The clip is added to your default bin.
2. To add a clip to a different bin, click the check box to select the clip.

3. From the Clip tools menu, select Add selected to bin folder name.
   The clip is added to your selected bin.

### Managing Your Bins

After you login, you can manage and view one bin at a time by selecting the Bin name from the My Bins menu, or to see all your bins, you can choose the Manage My Bins option from the My Bins menu.

**To manage a single bin:**

1. Click My Bins.
   A menu displays bin options.
2. Select a bin.
   The bin opens and displays the clips you have stored in that bin.
3. Click the Display options menu to change your current display, click Apply.
4. Under each clip, the system displays icons which allow you to perform different functions, they include:
5. To the left is a list of Options you can perform, they include:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Information (i)</td>
<td>Allows you to view additional information about the clip.</td>
</tr>
<tr>
<td>View (Magnifying Glass)</td>
<td>Opens a window that displays detailed information about the clip including: licensing options and pricing.</td>
</tr>
<tr>
<td>Comments</td>
<td>Allows you to enter comments about your clip.</td>
</tr>
<tr>
<td>Remove (X)</td>
<td>Allows you to remove the clip from your bin.</td>
</tr>
<tr>
<td>View shot reel</td>
<td>Displays multiple shots from the selected clip.</td>
</tr>
<tr>
<td>Add to cart (Shopping Cart)</td>
<td>Adds the selected clip to your shopping cart to purchase.</td>
</tr>
<tr>
<td>Email this bin</td>
<td>Opens a dialog box which allows you to enter information to email this bin to others for review.</td>
</tr>
<tr>
<td>Make a research request</td>
<td>If you need help searching for content, you can fill out a form and a representative will respond to your request.</td>
</tr>
<tr>
<td>Add notes to this bin</td>
<td>Allows you to enter any notes or information you want to associate with the bin.</td>
</tr>
<tr>
<td>Download comps for My Clips</td>
<td>Downloads a frame-accurate comp of all the clips in your bin.</td>
</tr>
<tr>
<td>Contact me about these clips</td>
<td>Opens a window which allows you to fill out a form so a representative can contact you.</td>
</tr>
<tr>
<td>Subscribe to this bin</td>
<td>Allows you to subscribe to the bin RSS feed to track activity including adding and deleting bins.</td>
</tr>
<tr>
<td>History of this bin</td>
<td>Displays the history or changes made to this bin.</td>
</tr>
<tr>
<td>Screening Room</td>
<td>Opens a pop-up window to preview all clips within the bin.</td>
</tr>
</tbody>
</table>

**To manage multiple bins:**

1. Click My Bins.
   
   A menu displays folder options.

2. Click Manage My Bins.
A list of your bins display.

3. Use the Bin tools menu to Select all, Select none or Remove selected bins.

4. Use the Sort by menu to sort and search across multiple bins.

5. To the right of each bin, the system displays icons which allow you to perform different functions, they include:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit</td>
<td>Allows you to edit the name of your bin and add or change any notes you want to include about the bin.</td>
</tr>
<tr>
<td>Information (i)</td>
<td>Allows you to view additional information about the clip.</td>
</tr>
<tr>
<td>View (Magnifying Glass)</td>
<td>Opens the bin so you can view its contents.</td>
</tr>
<tr>
<td>Email this bin</td>
<td>Opens a dialog box which allows you to enter information to email this bin to others for review.</td>
</tr>
<tr>
<td>Delete (X)</td>
<td>Allows you to delete the bin and all its contents.</td>
</tr>
</tbody>
</table>

6. To the left is a list of Management Options and Filters, they include:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a new clip bin</td>
<td>Opens a dialog box which allows you to create a new bin.</td>
</tr>
<tr>
<td>Manage my favorite bins</td>
<td>Assign preference to your bins by placing them in a favorite list. Then drag-and-drop to move your bins to and from a favorite list.</td>
</tr>
<tr>
<td>All bins you are a member of</td>
<td>Displays all the bins your login is connected to.</td>
</tr>
<tr>
<td>You own</td>
<td>These are bins you created or have been assigned to you as the owner.</td>
</tr>
<tr>
<td>You can edit, but do not own</td>
<td>You can add or remove clips from the bin, update clipping information and manage the display. You cannot delete the bin or assign ownership.</td>
</tr>
<tr>
<td>You can view, but not edit</td>
<td>You can select clips to view, download comps and add them to your cart.</td>
</tr>
</tbody>
</table>
Downloading Stock Footage Clips to Your Avid Bin

Once you select clips from the Avid Thought Equity Motion site, you can download low resolution comp clips into your Avid bin to try them out in your sequence.

Although it is recommended to download directly through your Avid editing system, if needed, you can download clips outside of the Avid editing system from an external browser. Store the clips on your system and link them to your bin at a later time. This process can also be used to recreate clips for previously downloaded files.

- It is recommended that you do not change the file name of the downloaded clip. The file name includes information that is used for linking.
- An internet connection is required when you link clips in order to properly recognize files and access the data needed for any new clip metadata.

Adding Vendor Columns to your Avid Bin

New metadata columns are available to display in your bin to provide you with information about the vendor and the stock footage clips you might purchase. They include:

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor Name</td>
<td>The name of the vendor where you are purchasing the clip.</td>
</tr>
<tr>
<td>Vendor URL</td>
<td>The URL address of the vendor.</td>
</tr>
<tr>
<td>Vendor Asset ID</td>
<td>The vendor’s unique ID for the clip.</td>
</tr>
<tr>
<td>Vendor Asset Name</td>
<td>The vendor’s name for the clip.</td>
</tr>
<tr>
<td>Vendor Asset Rights</td>
<td>The usage rights for the clip (for example, Royalty Free).</td>
</tr>
<tr>
<td>Vendor Asset Price</td>
<td>The vendor-specified price for using the clip, if available.</td>
</tr>
<tr>
<td>Vendor Original Master</td>
<td>The original acquisition format of the media, if available (for example, 1080i 59.94 fps HDCAM).</td>
</tr>
<tr>
<td>Vendor Download Master</td>
<td>The master format stored online for download, if available (for example, QuickTime/DVCPRO HD). This file is used to transcode to other formats, if needed.</td>
</tr>
<tr>
<td>Vendor Asset Description</td>
<td>The vendor’s description for the clip.</td>
</tr>
<tr>
<td>Vendor Asset Keywords</td>
<td>The vendor’s list of keywords for the clip.</td>
</tr>
<tr>
<td>Vendor Asset Status</td>
<td>The current status of the clip (Comp, Purchased).</td>
</tr>
</tbody>
</table>
To add vendor columns to your Avid bin:

1. With a bin in Text view, select Bin > Choose Columns.
   
   The Bin Column Selection dialog box opens.
2. Select the Vendor column names you want to display in your bin.
3. Click OK.

   The Vendor columns appear in your Avid bin.

Getting Comp Clips into Your Avid Bin

You can preview clips by downloading them into an Avid bin and edit them into your sequence. The clip is a low-resolution clip and designed to be only a trial clip.

To download clips, Avid uses the AMA method. AMA is selected by default.

You can choose between downloading a standard comp clip from within the Avid editing application or linking a customized comp clip outside of the Avid editing application. A customized comp clip adds burn-in timecode and the name of the comp clip to your file. However, custom comp clips are not available for immediate download. They are processed and zipped. You will be notified when your customized comp clip is ready, typically 15 to 20 minutes.

To download a single comp clip to an Avid bin:

1. From the Avid Marketplace window, navigate to the Avid Thought Equity Motion sight and search for a clip.
2. Click a clip thumbnail or magnifying glass icon.
   
   The clip details page opens.
3. Click the Download comp buttons or choose Options > Download comp.
If you select the Download Comp Arrow icon, a Download window opens allowing you to select a Customize Comp clip. See the steps in the following procedures to customize your comp clip.

If you select the Download Comp button or the menu item, the Select a bin window opens. If you only have one Avid bin opened, the clip downloads to that bin. If you have several Avid bins opened, the Select a bin window opens.

4. Select the bin you want to download the clips to or click New Bin, and then click OK.

If the clip that you selected has already been downloaded to your system, a dialog box opens allowing you to overwrite the file or cancel the download.

If you choose to overwrite the file, the system replaces the original file and creates a new clip in the Avid bin. Any clips originally linked to the previous version of the file might be offline.

A download progress bar appears in the lower-left corner of the Avid Marketplace window. You can click the Cancel button next to the progress bar at any time during the download process to cancel the download.

While the clips are downloading, you can continue to work in your Avid editing application. However, do not close the target bin or the Avid editing application while the download is in progress or the download will not complete successfully.

The word Complete displays when the download is finished and the stock footage clip appears in your Avid bin. An AMA link icon appears next to the clip. The clip is a low-resolution clip. You can add the clip to your sequence and edit it like any other clip.

To download multiple comp clips to an Avid bin:

1. From the Avid Thought Equity Motion site, click My Bins and select the bin that stores the clips you want to download.

   Your bin opens and displays the clips you want to download.

2. Click Download comps for the bin name located in the Options menu on the left of the page.

3. Click Download X Comps.

   X represents the number of clips in the bin. For example, if there are twelve clips to download, the button will display as Download 12 Comps.
If you only have one Avid bin opened, the clip downloads to that bin. If you have several Avid bins opened, the Select a bin window opens.

4. Select the bin you want to download the clips to or click New Bin, and then click OK. 

If the clip that you selected has already been downloaded to your system. A dialog box opens allowing you to overwrite or not download the file.

If you choose to overwrite the file, the system replaces the original file and creates a new clip in the Avid bin. Any clips originally linked to the previous version of the file might be offline.

A download progress bar appears in the lower-left corner of the Avid Marketplace window. You can click the Cancel button next to the progress bar at any time during the download process to cancel the download.

While the clips are downloading, you can continue to work in your Avid editing application. However, do not close the target bin or the Avid editing application while the download is in progress or the download will not complete successfully.

The word Complete displays when the download is finished and the stock footage clip appears in your Avid bin. An AMA link icon appears next to the clip. The clip is a low-resolution clip. You can add the clip to your sequence and edit it like any other clip.

To download a customized comp clip to an Avid bin:

1. From the Avid Marketplace window, navigate to the Avid Thought Equity Motion sight and search for a clip.

2. Click a clip thumbnail or magnifying glass icon.

   The clip details page opens.

3. Click the Download arrow button above the clip preview.

   The Download window opens.

4. Click Customize Your Comp.
5. If you want to include burn-in timecode or an asset name, select Time code or Asset name. These options display in your clip.

6. Click Make a custom comp request.

   The request is sent to Thought Equity Motion. You will receive an e-mail once your custom comp is available to download. If you choose to download the comp by clicking the URL in your e-mail, you will need to download and link the clip outside of the Avid editor. See the steps below for those procedures.

7. To download your comp directly into the Avid editor, from the Avid Marketplace window, navigate to the Avid Thought Equity Motion sight and click on My Account. Select My Orders from the menu.

8. Click Download under On Demand Comps.

   If you only have one Avid bin opened, the clip downloads to that bin. If you have several Avid bins opened, the Select a bin window opens.

9. Select the bin you want to download the clips to or click New Bin, and then click OK.

   If the clip that you selected has already been downloaded to your system, a dialog box opens allowing you to overwrite the file or cancel the download.

   **If you choose to overwrite the file, the system replaces the original file and creates a new clip in the Avid bin. Any clips originally linked to the previous version of the file might be offline.**

   A download progress bar appears in the lower-left corner of the Avid Marketplace window. You can click the Cancel button next to the progress bar at any time during the download process to cancel the download.

   While the clips are downloading, you can continue to work in your Avid editing application. However, do not close the target bin or the Avid editing application while the download is in progress or the download will not complete successfully.

   The word Complete displays when the download is finished and the stock footage clip appears in your Avid bin. An AMA link icon appears next to the clip. The clip is a low-resolution clip. You can add the clip to your sequence and edit it like any other clip.

**To download comp clips outside of the Avid editing application to an Avid bin:**

1. If you are downloading a comp clip or a custom comp clip from an external browser, download the comp files to your system.

   You can store the downloaded files in the Avid Downloads folder or to your Desktop. If there are multiple clips, the downloaded file will be zipped. You will need to unzip them.

2. Select the Avid bin you want to place the comp clip or customized comp clip into, then right-click and select Link to Stock Footage File(s). You can also select File > Link to Stock Footage File(s).
AMA must be enabled to link the stock footage file. The menu item will be unavailable if AMA is not enabled.

An internet connection is required when you link clips in order to properly recognize files and access the data needed for any new clip metadata.

The Browse dialog box opens.

3. Locate the comp file you downloaded, and then click OK.

The stock footage clip appears in your Avid bin. An AMA link icon appears next to the clip. You can add the clip to your sequence and edit it like any other clip.

Creating a Stock Footage Report

Before you decide to purchase your stock footage clips, you can generate a report that gives you the following information:

- All stock footage clips used in your sequence
- The timecode location of each clip in your sequence
- The duration of each clip
- The clip name
- The estimated cost of the clip, if available

A stock footage report is generated from a sequence. You can have multiple uses of the same stock footage clip in your sequence, the report displays the multiple uses indented under the master clip. Also, if you have renamed any of the stock footage clips, the report displays the new clip name followed by the original clip name.

To generate a Stock Footage Report:

1. Do one of the following:
   - From a bin, right-click a sequence and select Stock Footage Report. You can select multiple sequences for generating reports.
   - With a sequence loaded in a monitor, right-click the monitor and select Stock Footage Report.

   The Save Stock Footage Report As dialog box opens.

2. Use the default file name or rename the report and choose a folder to save the report to, click Save.

   The default file name is Stock Footage Report, the default location is your Avid Projects folder.
If you select more than 10 sequences, a dialog box asks if you want to generate sequence reports for all selected items.

The application writes the report to a text file and opens a text editor.

By default, the Stock Footage Report is saved in text format. To save the report as either .csv (comma-separated-value) or .xml, change the extension of the report before you save it. The file saves with .csv or .xml formatting. You can then use these formats to import the report into a spreadsheet program.

Stock Footage Report Information

The Stock Footage Report displays the following information and columns:

- The name of the sequence selected (date and time)
- The Avid editing system generating the report
- The number of stock footage clips found

<table>
<thead>
<tr>
<th>Column Heading</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SEQ_IN</td>
<td>At what timecode in the sequence does the stock footage clip appear.</td>
</tr>
<tr>
<td>SEQ_DUR</td>
<td>The duration of the stock footage clip in the sequence.</td>
</tr>
<tr>
<td>SRC_TKS</td>
<td>The tracks (V1, A1, A2, etc.) the stock footage clip use in the sequence.</td>
</tr>
<tr>
<td>SRC_IN</td>
<td>The IN point of the clip.</td>
</tr>
<tr>
<td>SRC_OUT</td>
<td>The OUT point of the clip.</td>
</tr>
<tr>
<td>SRC_DUR</td>
<td>The duration of the clip.</td>
</tr>
<tr>
<td>CLIP_NAME</td>
<td>The clip name. If you renamed the stock footage clip in the bin, the renamed clip appears first, followed by the vendor clip name in parenthesis.</td>
</tr>
<tr>
<td>STATUS</td>
<td>If available, the status of the clip. Either Comp or Purchased.</td>
</tr>
<tr>
<td>PRICE</td>
<td>If available, the price of the stock footage clip.</td>
</tr>
<tr>
<td>VENDOR</td>
<td>The name of the vendor where you downloaded the stock footage clip.</td>
</tr>
<tr>
<td>INVOICE_ID</td>
<td>The vendor's Invoice ID number if available.</td>
</tr>
</tbody>
</table>
In cases in which a clip is used more than once in a sequence, additional occurrences display indented below the first occurrence. See the example below:

01:00:49:23 5:00  V1A1A2  01:01:05:24  01:01:10:24  5:00  528142_001  Not Available  ThoughtEquity
01:01:22:26 10:00  V1  01:01:05:24  01:01:10:24  5:00
01:01:38:26 2:15  V1  01:01:05:24  01:01:10:24  5:00
01:00:50:23 9:26  V1  01:26:17:10  01:26:27:18  10:08  479310_071  Not Available  ThoughtEquity

Depending on your operating system and the text file application, you might have to turn off “word wrapping” or enlarge the size of your text window to see all the displayed columns correctly.

Purchasing Your Stock Footage

You can purchase your stock footage as an individual clip or as all the clips in your sequence.

Even though you may be logged into the Thought Equity Motion site, you may be asked to login again. This allows Avid and the vendor to pass and receive information back and forth.

To purchase your stock footage:

1. From your Avid bin, select a single clip or sequence, then right-click and select Buy Stock Footage.
   
   If you have selected more than one item, a dialog box opens informing you to select one clip or sequence.
   
   A login window opens asking you to login.
   
   The Avid Marketplace window opens to the Avid Thought Equity Motion site. A bin is created within the My Bins menu with the same name as your sequence and a time stamp. This new bin includes all the stock footage clips and related information about each clip from your sequence.
   
   The clips you plan to purchase display in the window with information about each clip.
   
   The custom clip displays the start and end time of your clip you plan to purchase.

2. Select the clip you want to purchase.

   If there is only a single clip, you do not need to select it.

   You can only select one clip at a time.
Selected clip and the Add to cart icon.

3. Click Add to Cart.

The clip displays in your shopping cart.

4. (Option) If you still need to adjust the In or Out points, you can drag the handles to adjust the length of your clip, then click Update the clips In/Out markers.

If the clip contains clipping information, Avid adds five frames to both the start and end points of your purchased clip.

5. If you did not complete the Licensing Options prior to this point in the purchase process, you will be taken to the clip details page to complete this step.

Licensing and restrictions vary from clip to clip. Call Thought Equity Motion sales at 866-815-6599 to obtain pricing information.

Call Thought Equity Motion to specify if you need the High Resolution clip to be created with the Avid QuickTime codecs at a specific resolution (for example DNxHD). This is helpful if you need to match the project type and resolution of your finished sequence.

6. Select the Delivery method and the Delivery format, then click Proceed to checkout.

Information about your clip order displays.

7. Enter your credit card information and shipping information if needed, then click Proceed.

Your Account > My Orders will display your purchase. You will also receive an e-mail informing you of your purchase and you can download your high resolution clips.

Downloading your High Resolution Stock Footage

After your purchase is successfully completed, you can download your high resolution stock footage.

To download clips, Avid uses the AMA method. AMA is selected by default.

Although it is recommended to download directly through your Avid editing system, if needed, you can download clips outside of the Avid editing system from an external browser. For steps on downloading outside of the Avid editing application, see “To download comp clips outside of the Avid editing application to an Avid bin:” on page 1407.
For more detailed information about downloading, see “Downloading Stock Footage Clips to Your Avid Bin” on page 1403. This section explains downloading low resolution clips, but the same information applies to downloading high resolution clips.

It is recommended that you do not change the file name of the downloaded clip. The file name includes information that is used for linking. However, it is all right to rename the clip name inside the Avid bin.

To download your stock footage:

1. It is recommended that you place all your high resolution stock footage clips for one project in the same bin. You can also specify the drive to store all your downloaded media files.

   The media file is stored on the drive you have specified in the Media Creation > Import tab dialog box. For more information about this setting, see “Preparing for Capture” on page 168 and “Media Creation Settings” on page 1512.

Make sure that the drive you specify in the Media Creation > Import tab dialog box supports the bandwidth and has enough space to support the downloaded stock footage media.

2. From the Avid Marketplace window, click My Account, then click My Orders.

   Your account opens with the clips you have purchased.

3. Click Download Masters.
You need to click Download Masters for each clip.

The clips download to your selected Avid bin. If there is no bin open or multiple bins are opened, the Select a Bin dialog box opens asking you to select a bin or create a new bin.

A download progress bar appears, in the lower-left corner of the Avid Marketplace window, with the number of clips to download.

You can click the Cancel button next to the progress bar at any time during the download process to cancel the download.

While the clips are downloading, you can continue to work in your Avid editing application. However, do not close the target bin or the Avid editing application while the download is in progress, the download will not complete successfully.

The high resolution clips appear in your Avid bin. An AMA link icon appears next to the clip. To play your sequence with the high resolution clips, you need to relink the purchased clips to your sequence. For more information, see “Relinking High Resolution Media to Your Sequence” on page 1414.

To download your stock footage outside of the Avid editor:

1. Open a web browser and login to the Thought Equity Motion website.

2. If the clips you want to download are stored in the Thought Equity Motion bin, download the entire bin or individual clips.

   A zip file is created for an entire bin. The zip file name is the bin name and the date. There may be a delay in receiving the zipped file. Individual clips download immediately.

3. If needed, unzip the file and place the clips in a folder on your Desktop or somewhere convenient for you.

4. In your Avid editing application, select the Avid bin you want to place the clips into, then right-click and select Link to Stock Footage File(s). You can also select File > Link to Stock Footage File(s).

   AMA must be enabled to link the stock footage file. The menu item will be unavailable if AMA is not enabled.

   An internet connection is required when you link clips in order to properly recognize files and access the data needed for any new clip metadata.

   The Browse dialog box opens.

5. Locate the clip you downloaded, and then click OK.
The high resolution clips appear in your Avid bin. An AMA link icon appears next to the clip. To play your sequence with the high resolution clips, you need to relink the purchased clips to your sequence. For more information, see “Relinking High Resolution Media to Your Sequence” on page 1414.

**Relinking High Resolution Media to Your Sequence**

To play your sequence with the high resolution clips, you need to relink the comp clips in your sequence to the new downloaded high resolution media.

**To relink your high resolution media to your sequence:**

1. Open the bin that stores all your high resolution clips for your sequence.

   It is recommended that you download all your high resolution stock footage clips to the same bin. However, you can download to multiple bins.

   The media file is stored on the drive you have specified in the Media Creation > Import tab dialog box. For more information about this setting, see “Preparing for Capture” on page 168 and “Media Creation Settings” on page 1512.

   *Make sure that the drive you specify in the Media Creation > Import tab dialog box supports the bandwidth and has enough space to support the downloaded stock footage media.*

2. Select the downloaded high resolution clips that corresponds to the comp (low resolution) clips.

3. Open the bin that contains the sequence with the comp (low resolution) clips.

4. Select and then right-click the sequence, and select Relink Stock Footage to Sequence.

   *Do not select Link to AMA File(s), the high resolution stock footage files will not relink properly.*

   A message displays informing you that the system will relink the selected sequence to stock footage clips that are selected in all open bins, do you want to continue.

   *If the high resolution master clip and media do not Relink to the comp clip in the sequence, make sure the high resolution clips are selected in the bin prior to Relinking. You can also check the timecode and duration of the clip. You might have to adjust the length of the purchased clip in your order and perform the download again, once the adjustment is made.*

5. Click Continue.

   The system creates a copy of the sequence which links to the high resolution clips. The copy is named with the original sequence name followed by .Relinked.n, where n is the number of the duplicates created from the original sequence.

6. Play the newly created sequence that contains the high resolution media.
You might want to transcode the purchased clip to the project's native format for smoother play. See “Using the Transcode Command” on page 483.

Avid Marketplace Plug-ins

The Avid Marketplace Plug-ins window allows you to purchase and download Avid supported plug-ins from within the Avid editing application. You can open the Avid Marketplace Plug-ins page to download audio and video plugins. You will need to quit the Avid editing application to install them and then relaunch the application.

Click the options listed at the top of the page to go to other Avid Marketplaces.

Purchasing and Downloading a Plug-in from the Avid Marketplace

To purchase and download from the Avid Marketplace Plug-ins window:

1. Open your Avid editing project.
2. Select from the Marketplace menu, for example: Video Plug-ins or Audio Plug-ins.
   - The selected Marketplace appears.
3. Click the plug-in you want to download.
The purchase window with the selected product displays.

4. Select from the “Please select a product” from the pull-down menu.

5. Enter the quantity.

6. Click Add to Cart.

7. Enter a promotional code if you have one, then click Apply.

8. Click Proceed to Checkout.

9. If you have an account, click the Returning Customers check box. You will be prompted to enter your e-mail address and password. Click login. If you do not have an account enter your billing information.

   The Account, Billing & Shipping Info window displays.

10. Fill in the appropriate data, then click Continue.

   The Review Order and Payment window displays.

11. Enter your payment method and information.

12. Click Pay Now.

   Your purchase is processed and a confirmation message appears.

13. Click Submit Order.

14. Click Download Products.

   A window opens which displays your product and a download link.

15. Click Download or Download Now.

   The Select a folder to download dialog box appears.

16. Click Downloads.

   A row appears displaying the download file size and a Download link.

17. Click the Download link.

   The Save File window opens.

18. Select a location to save the download. You may also rename the file before it is downloaded.

   The Avid Marketplace Download progress indicator in the lower left corner of the window updates as the item(s) download.

   When the download finishes, a Download Complete message appears asking if you want to reveal the file.

   If your product requires an activation code, you will receive an e-mail with this information. You will also receive an e-mail with purchase confirmation and tracking information.
This chapter provides information on how to use settings.

- Understanding Settings
- Working with Settings
- Options for Moving User Settings Files

This chapter also provides reference information for all settings categories.

- Summary of Settings
- AMA Settings
- Audio Settings
- Audio Multiple Mix Settings
- Bin Settings
- Capture Settings
- Communication (Serial) Ports Tool Settings
- Composer Settings
- Controller Settings
- Correction Settings
- Deck Configuration Settings
- Deck Preferences Settings
- Dynamic Relink Settings
- Effect Editor Settings
- E-mail Settings
- Export Settings
- Film and 24P Settings
- Full Screen Playback Settings
- General Settings
- Grid Settings
• Import Settings
• Interface Settings
• Interplay Folder, Interplay Server, and Interplay User Settings
• Keyboard Settings
• Marquee Title Settings
• Media Creation Settings
• Media Services Settings (Windows Only)
• Mouse Settings
• NRCS Settings (Media Composer | NewsCutter Option)
• Passthrough Mix Tool
• PortServer Settings
• Remote Play and Capture Settings
• Render Settings
• S3D Settings
• Safe Colors Settings
• Script Settings
• Sound Card Configuration Settings (Windows Only)
• Cloud Playback Settings
• Cloud Upload Settings
• Timeline Settings
• Trim Settings
• Transfer Settings
• Video Display Settings
• Video Input Tool Settings
• Video Output Tool Settings
• Video Satellite Settings
• Workspace Linking Settings
Understanding Settings

The Settings tab in the Project window contains a list of settings that control many aspects of your Avid editing application’s behavior. Using the Settings list, you can:

- Open Settings dialog boxes to view and modify settings.
- Switch between settings.
- Manage settings in a variety of ways.

For more information, see “Working with Settings” on page 1421.

You can also switch between users and work with user profiles. For more information, see “Switching to Another Set of User Settings” on page 1424 and “Understanding User Profiles” on page 104.

The following illustration shows the Settings tab in the Project window.

Top to bottom: Settings tab, Settings Fast menu, Settings list (with setting names in the left column and setting types in the right column)
Types of Settings

There are three types of settings:

- **User settings** are specific to a particular editor and reflect individual preferences for adjusting the user interface in your Avid editing application.
  
  User settings are stored in each user folder.

- **Project settings** are directly related to individual projects. When you change a Project setting, it affects all editors working on the project.
  
  Project settings are stored in each project folder.

  *For information about the location of the user and project folders, see “Avid Projects and Avid Users Folders” on page 72.*

- **Site settings** establish default parameters for all new users and projects on a particular system. They can apply to particular configurations of equipment installed at the site. They can also include other User or Project settings that you copy into the Site Settings window.
  
  Site settings are stored in a separate Settings folder:

  - (Windows) drive:\Users\Public\Public Documents\Avid editing application\Settings
  - (Macintosh) Macintosh HD/Applications/Avid editing application/ Settings

  For more information, see “Using Site Settings” on page 1429.

Examples of Ways to Use Settings

If you organize and manage your settings carefully, you can use them to speed your workflow. For example, you can use settings to address specific needs for one stage of your workflow. Because you can have multiple versions of settings in your Settings list in the Project window, you can also establish settings specific to one user on your team and that user’s work tasks.

For example, you can create:

- **Two Bin settings** — one that automatically saves more often when you are editing intensively, and one that automatically saves less often when you are doing organizational work in the bins.

- **Multiple Capture settings** for capturing various types of source material.
Working with Settings

- Multiple Keyboard and Composer settings to use for various activities such as capturing, offline editing, or online effects editing.
- Multiple Deck Preferences settings for various types of capturing or for output.
- User settings for the assistant editor that facilitate logging, capturing, and organizing projects.
- User settings for the editor that include editing interface preferences.
- Bin View settings that display useful columns of information in bins.

For more information, see “Understanding Bin Views” on page 344 and “Saving a Custom Bin View” on page 345).

If you establish your settings once, and then select the appropriate setting or bin view for your current needs, you can save time and effort that you might spend searching for information or adjusting bin headings on-the-fly.

Working with Settings

You can open a dialog box for most settings that lets you view the current settings and to change them if necessary. You can also duplicate, rename, copy, and move settings among files or systems.

Viewing and Modifying Settings

You can view most settings in a dialog box or window that also lets you change the settings.

You cannot modify the following types of settings:
- Settings that require the presence of standalone peripherals.
- Settings that are only modifiable from within the tools in which they are used, such as Timeline views.
- Film and 24p settings when you are working in nonfilm projects.

To view a category of settings:

1. Click the Settings tab in the Project window.
   The Settings list appears.
2. Double-click a setting in the Settings list.
   A dialog box or window opens.
To modify available settings:

1. In the dialog box or window for the setting, type new values or select new options for the setting.

   For information about navigating within a Settings dialog box, see “Using the Keyboard for Navigating in Dialog Boxes and Menus” on page 61.

2. Click OK, Save, Apply, or Cancel, or click the Close button.

   Your Avid editing application saves changes in the appropriate User, Project, or Site settings file.

Filtering the Settings List

You can filter the Settings list in the Project window so that it displays a more focused group of settings.

To change the Settings list display in the Project window:

1. Click the Settings tab in the Project window.

   The Settings list appears.

2. Click the Fast Menu button, and select a settings group.

   The selected settings group has a check mark in the Settings menu, and the Settings list displays only the settings in that group.
The following table describes the different Settings display groups.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active Settings</td>
<td>Displays currently active settings.</td>
</tr>
<tr>
<td>All Settings</td>
<td>Displays all settings available.</td>
</tr>
<tr>
<td>Base Settings</td>
<td>Displays Project, User, and Site settings only. Does not display views.</td>
</tr>
<tr>
<td>Bin Views</td>
<td>Displays all Bin View settings you have created.</td>
</tr>
<tr>
<td>Export Settings</td>
<td>Displays all Export settings.</td>
</tr>
<tr>
<td>Import Settings</td>
<td>Displays all Import settings.</td>
</tr>
<tr>
<td>Timeline Views</td>
<td>Displays all Timeline View settings you have created.</td>
</tr>
<tr>
<td>Title Styles</td>
<td>Displays all templates you have created for the Title tool.</td>
</tr>
<tr>
<td>Video Tools Settings</td>
<td>Displays only the Video Input Tool and Video Output Tool settings.</td>
</tr>
<tr>
<td>Workspace Linked</td>
<td>Displays only linked workspaces.</td>
</tr>
<tr>
<td>Workspaces</td>
<td>Displays all Workspace settings you have created.</td>
</tr>
</tbody>
</table>
Switching to Another Set of User Settings

User settings are not project or site specific, so you can display another set of User settings in the Project window.

**To select another user:**

1. Click the Settings tab in the Project window.
   
The Settings list appears.
2. Click the User Selection menu, and select another name.

User Selection menu in the Project window

Your Avid editing application saves the previous user’s settings, loads the new user’s settings, and displays them in the Project window.
Duplicating Settings

To create a new version of a setting:

1. Click the Settings tab in the Project window.
   The Settings list appears.
2. Click the setting you want to copy. Ctrl+click (Windows) or Command+click (Macintosh) any additional settings you want to copy.
3. Select Edit > Duplicate.
   A copy of each selected setting appears in the Settings list.
4. Name your settings to indicate their functions.
   For more information, see “Naming Settings” on page 1425.

Naming Settings

You can give settings custom names to differentiate among copies or to indicate a specific use.

To enter a custom setting name:

1. Click the Settings tab in the Project window.
   The Settings list appears.
2. Click the Custom setting name column to the right of the setting name.
Custom setting name column in the Project window

3. Type a name, and press Enter (Windows) or Return (Macintosh).

The new name appears in the list and is saved in the settings file.

**Selecting Among Multiple Settings**

If you have multiple versions of a setting (for example, multiple Export settings), only one setting at a time is active. Settings that are currently active have a check mark to the left of the setting name.

**To change the active setting:**

1. Click the Settings tab in the Project window.

   The Settings list appears.

2. Click in the space to the left of the setting that you want to select as the active setting.

**Deleting Settings**

You can delete settings from the Settings list in the Project window at any time. For example, you might choose to delete one or more versions of a particular setting, or you might want to delete all but a few settings for transfer into another Settings window.
You cannot undo a deletion. You can, however, restore the default settings or copy settings from other files. For more information, see “Restoring Default Settings” on page 1427 and “Copying Settings Between Settings Files” on page 1427.

**To delete a setting:**

1. Click the Settings tab in the Project window.
   The Settings list appears.
2. Click a setting to select it. Ctrl+click (Windows) or Command+click (Macintosh) each additional setting you want to delete.
3. Do one of the following:
   - Press the Delete key.
   - Select Edit > Delete.

   The selected settings are removed immediately.

**Restoring Default Settings**

**To restore settings to their default values:**

1. Click the Settings tab in the Project window.
   The Settings list appears.
2. Click a setting to select it. Ctrl+click (Windows) or Command+click (Macintosh) each additional setting you want to select.
3. Right-click the selected setting (or one of the multiple selected settings), and select Restore to Default.
   A message box opens.
4. Click Copy & Restore to copy the current settings before restoring the default settings, or click Restore to discard the current settings.

   The system restores the default values for the selected settings.

**Copying Settings Between Settings Files**

You can copy selected settings:

- Between existing settings files.
- Into a new settings file for use in other projects.
- Into the Settings folder to establish standard system settings for all new projects and users. For more information, see “Using Site Settings” on page 1429.
- To change one type of setting to another type.
Working with Settings

You can also transfer settings files to another Avid system.

Starting with the release of Media Composer v6.0, Symphony v6.0 and NewsCutter v10.0, the user, project and site settings are saved in an .xml file. If you have an .avs settings file from a previous system, you can bring it forward to a current system and the .avs file will be converted to an xml file.

To copy settings between setting files:

1. With the Settings list in the Project window active, open the destination settings file in one of the following ways:
   - Create and open a new settings file by selecting File > New Settings File.
     An untitled settings file window opens.
   - Open an existing settings file: select File > Open Settings File, locate and select a settings file (with the file name extension .xml) in the Avid Projects or Avid Users folder, and then click Open.
     The settings file window opens.
2. Click the setting you want to copy in the Settings list in the Project window. Ctrl+click (Windows) or Command+click (Macintosh) any additional settings that you want to copy.
3. Drag the selected setting to the destination settings window.

Settings list in the Project window (left) and a destination settings window (right)
The copied settings are saved when you close or save the file or project.
You can also drag settings from the settings window into the Settings list in the Project window.
**To copy a setting from a settings file into the Settings list with the setting active:**

1. Drag the setting into the Settings list.
   
   A message box opens.

2. Do one of the following
   
   ▶ Click Add to add the new settings to the project without affecting the project’s current settings.
   
   ▶ Click Replace to replace the current version of each setting with the new settings. Additional versions of each setting are not affected.

**Using Site Settings**

When your Avid editing application opens a new project, it first searches the Site_Settings file and loads site settings and any other settings you have placed there. Your Avid editing application then proceeds to load any Project and User settings not included in the Site_Settings file.

Adding settings to the site settings files is useful if you need to establish global settings for all new users and projects, such as switcher settings, a specific start timecode for all sequences, or various customized features of the interface.

**To load settings into the Site_Settings file:**

1. Open a project with the settings you want to establish as Site settings. If a project does not already exist with the settings you want, create a project and make adjustments to the default settings as needed.

2. Select Special > Site Settings.

3. Click a Project or User setting in the Settings list in the Project window, or Ctrl+click (Windows) or Command+click (Macintosh) multiple settings.

4. Drag the selected setting to the Site Settings window.
   
   Copies appear in the Site Settings window.

5. Close the Site Settings window.
   
   All new users and projects opened from the Select Project dialog box use these settings as the default settings.

**Options for Moving User Settings Files**

You might want to move user settings information from one location to another on your system, or from one system to another.
The easiest and most reliable way to do this is to take advantage of user profiles. When you import a user profile, your Avid editing application finds all the necessary files and copies them to the correct location. For more information about using and creating User Profiles, see “Understanding User Profiles” on page 104.

Experienced Avid users, however, are accustomed to moving user settings around manually on their systems. If you choose to take this approach, make sure you copy the entire user or user profile folder, not just the individual settings files, and place the copied folder in your user folder.

## Summary of Settings

The following table briefly describes each item in the Settings list and where you can find additional information on a particular item.

<table>
<thead>
<tr>
<th>Setting Name</th>
<th>Description</th>
<th>Reference Topic</th>
</tr>
</thead>
<tbody>
<tr>
<td>AMA</td>
<td>Sets options for creating bins and mounting volumes when you are working with AMA (Avid Media Access).</td>
<td>“AMA Settings” on page 1433</td>
</tr>
<tr>
<td>Audio</td>
<td>Sets the default audio pan and options for audio scrub. For more information, see “Using Clip Volume and Pan Mode” on page 797 and “Adjusting Digital Scrub Parameters” on page 770.</td>
<td>“Audio Settings” on page 1437</td>
</tr>
<tr>
<td>Audio Project</td>
<td>Defines the audio settings for the project and the audio input and output methods.</td>
<td>“Audio Multiple Mix Settings” on page 1444</td>
</tr>
<tr>
<td>Bin</td>
<td>Sets options for bins and for the SuperBin.</td>
<td>“Bin Settings” on page 1444</td>
</tr>
<tr>
<td>Bin View</td>
<td>Selects and formats the information displayed in bins. For more information, see “Understanding Bin Views” on page 344.</td>
<td>“Bin Settings” on page 1444</td>
</tr>
<tr>
<td>Capture</td>
<td>Defines how your Avid editing application captures and batch captures in specific situations.</td>
<td>“Capture Settings” on page 1446</td>
</tr>
<tr>
<td>Cloud Playback</td>
<td>Allows you to specify the quality for remote media and allows you to manage the settings for the CloudCache folder.</td>
<td>“Cloud Playback Settings” on page 1451</td>
</tr>
<tr>
<td>Cloud Upload</td>
<td>Allows you to specify settings for uploading media.</td>
<td>“Cloud Upload Settings” on page 1451</td>
</tr>
<tr>
<td>Color Management</td>
<td>Allows you to specify setting for color management.</td>
<td>“Color Management Settings” on page 1452</td>
</tr>
<tr>
<td>Setting Name</td>
<td>Description</td>
<td>Reference Topic</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>------------------------------------------------------</td>
</tr>
<tr>
<td>Communication (Serial) Ports</td>
<td>Sets a port for Remote Play and Capture.</td>
<td>“Communication (Serial) Ports Tool Settings” on page 1453</td>
</tr>
<tr>
<td>Composer</td>
<td>Configures the display and behavior of buttons and information in the Playback, Source, and Record monitors.</td>
<td>“Composer Settings” on page 1454</td>
</tr>
<tr>
<td>Controller Settings</td>
<td>Sets the default controller, port selection, and custom controller buttons.</td>
<td>“Controller Settings” on page 1458</td>
</tr>
<tr>
<td>Correction</td>
<td>Sets options for the Color Correction tool.</td>
<td>“Correction Settings” on page 1458</td>
</tr>
<tr>
<td>Deck Configuration</td>
<td>Configures channels and decks into your system.</td>
<td>“Deck Configuration Settings” on page 1460</td>
</tr>
<tr>
<td>Deck</td>
<td>Sets custom naming and configuration information for decks.</td>
<td>“Deck Settings” on page 1461</td>
</tr>
<tr>
<td>Deck Preferences</td>
<td>Sets preferences that affect all decks configured into the system.</td>
<td>“Deck Preferences Settings” on page 1462</td>
</tr>
<tr>
<td>Desktop Play Delay</td>
<td>Allows you to increase or decrease the amount of frame offset.</td>
<td>“Desktop Play Delay” on page 1464</td>
</tr>
<tr>
<td>Dynamic Relink</td>
<td>Sets options that control how clips link to media files when you are working in a MultiRez environment.</td>
<td>“Dynamic Relink Settings” on page 1464</td>
</tr>
<tr>
<td>Effect Editor</td>
<td>Sets options for how controls appear and behave in the Effect Editor.</td>
<td>“Effect Editor Settings” on page 1467</td>
</tr>
<tr>
<td>Email</td>
<td>Sets options for receiving email notification when a render operation completes.</td>
<td>“E-mail Settings” on page 1469</td>
</tr>
<tr>
<td>Export</td>
<td>Sets options for file export.</td>
<td>“Export Settings” on page 1470</td>
</tr>
<tr>
<td>Film and 24p</td>
<td>Sets options for edit play rate, ink number format, and transfer rate.</td>
<td>“Film and 24P Settings” on page 1494</td>
</tr>
<tr>
<td>Full-Screen Playback</td>
<td>Sets options for viewing your video on a full-screen monitor.</td>
<td>“Full Screen Playback Settings” on page 1495</td>
</tr>
<tr>
<td>General</td>
<td>Defines default values such as the default starting timecode and temporary file location for your project.</td>
<td>“General Settings” on page 1499</td>
</tr>
<tr>
<td>Grid</td>
<td>Defines the grid to use when you create effects. For more information, see “Setting Effect Grid Options” in the Help.</td>
<td>“Grid Settings” on page 1500</td>
</tr>
<tr>
<td>Import</td>
<td>Sets options for file import.</td>
<td>“Import Settings” on page 1502</td>
</tr>
<tr>
<td>Setting Name</td>
<td>Description</td>
<td>Reference Topic</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------------------------------------------</td>
</tr>
<tr>
<td>Interface</td>
<td>Defines the appearance and function of certain interface elements. For more information, see “Customizing the Avid User Interface” on page 107.</td>
<td>“Interface Settings” on page 1508</td>
</tr>
<tr>
<td>Interplay Folder</td>
<td>Lets you specify a project directory on the asset manager to use for checking in media objects.</td>
<td>“Interplay Folder Settings” on page 1509</td>
</tr>
<tr>
<td>Interplay Server</td>
<td>Lets you specify the Avid Interplay Server location on the network.</td>
<td>“Interplay Server Settings” on page 1510</td>
</tr>
<tr>
<td>Interplay User</td>
<td>Lets you set the preference for accessing Avid asset manager.</td>
<td>“Interplay User Settings” on page 1510</td>
</tr>
<tr>
<td>Keyboard</td>
<td>Lets you map commands from the Command palette to the keyboard.</td>
<td>“Keyboard Settings” on page 1510</td>
</tr>
<tr>
<td>Marquee Title</td>
<td>Lets you select the Title tool for creating titles and provides options for promoting titles.</td>
<td>“Marquee Title Settings” on page 1511</td>
</tr>
<tr>
<td>Media Creation</td>
<td>Sets options for video resolution and selects the drives for capturing, creating titles, importing, performing audio and video mixdown, and motion effects.</td>
<td>“Media Creation Settings” on page 1512</td>
</tr>
<tr>
<td>Media Services</td>
<td>Configures your Avid editing application to work with the Avid Interplay Media Services Broker.</td>
<td>“Media Services Settings (Windows Only)” on page 1515</td>
</tr>
<tr>
<td>Mouse</td>
<td>Lets you set the speed of scrolling with the mouse wheel within your Avid editing application. For more information, see “Using the Mouse Scroll Wheel for Navigating” on page 62.</td>
<td>“Mouse Settings” on page 1515</td>
</tr>
<tr>
<td>NRCS (NewsCutter Option)</td>
<td>Defines the name of the Newsroom Computer System server and the default user name. Sets Message of the Day and Mail options for the NRCS tool.</td>
<td>“NRCS Settings (Media Composer</td>
</tr>
<tr>
<td>Passthrough Mix Tool</td>
<td>Opens the Passthrough Mix Tool</td>
<td>“Using the Passthrough Mix Tool” on page 215</td>
</tr>
<tr>
<td>PortServer</td>
<td>Sets up the LANshare client so your Avid editing application recognizes its workspaces.</td>
<td>“PortServer Settings” on page 1518</td>
</tr>
<tr>
<td>Remote Play and Capture</td>
<td>Lets you use your Avid editing application like a videotape recorder.</td>
<td>“Remote Play and Capture Settings” on page 1519</td>
</tr>
<tr>
<td>Render</td>
<td>Sets options for managing render operations and defining the methods your Avid editing application uses when rendering.</td>
<td>“Render Settings” on page 1520</td>
</tr>
<tr>
<td>Setting Name</td>
<td>Description</td>
<td>Reference Topic</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>------------------------------------------------------</td>
</tr>
<tr>
<td>S3D</td>
<td>Sets stereoscopic parameters.</td>
<td>&quot;S3D Settings” on page 126</td>
</tr>
<tr>
<td>Safe Colors</td>
<td>Sets the safe color parameters for the Color Correction tool.</td>
<td>&quot;Safe Colors Settings” on page 1523</td>
</tr>
<tr>
<td>Script</td>
<td>Sets the default display options for scripts imported using script integration.</td>
<td>&quot;Script Settings” on page 1524</td>
</tr>
<tr>
<td>Sound Card Configuration (Windows only)</td>
<td>Lets you map audio input sources directly to the output sources available with your audio hardware</td>
<td>&quot;Sound Card Configuration Settings (Windows Only)” on page 1525</td>
</tr>
<tr>
<td>Timecode Window</td>
<td>Displays various timecodes in an adjustable window. Appears in the Settings list to facilitate copying settings. For more information, see “Using the Timecode Window” on page 523.</td>
<td></td>
</tr>
<tr>
<td>Timeline</td>
<td>Sets general Timeline preferences.</td>
<td>&quot;Timeline Settings” on page 1525</td>
</tr>
<tr>
<td>Trim</td>
<td>Customizes the Trim mode environment.</td>
<td>&quot;Trim Settings” on page 1530</td>
</tr>
<tr>
<td>Video Display</td>
<td>Sets options for video input, desktop video, Client monitor use, and effects preview.</td>
<td>&quot;Video Display Settings” on page 1531</td>
</tr>
<tr>
<td>Video Input</td>
<td>Lets you calibrate for video input.</td>
<td>&quot;Video Input Tool Settings” on page 1532</td>
</tr>
<tr>
<td>Video Output</td>
<td>Lets you calibrate for video output.</td>
<td>&quot;Video Output Tool Settings” on page 1533</td>
</tr>
<tr>
<td>Video Satellite</td>
<td>Lets you synchronize video playback with a Pro Tools</td>
<td>HD® session.</td>
</tr>
<tr>
<td>Workspace</td>
<td>Lets you associate settings and windows with a workspace. For more information, see “Linking User Settings and Workspaces” on page 113.</td>
<td>&quot;Workspace Linking Settings” on page 1539</td>
</tr>
</tbody>
</table>

**AMA Settings**

**AMA Settings: Bins Tab**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use active bin</td>
<td>When this option is selected, your Avid editing application uses the currently active bin to store clips linked using AMA.</td>
</tr>
</tbody>
</table>
AMA Settings

**AMA Settings: Quality Tab**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AMA Link Preference: Video</td>
<td>This option allows you to select a quality resolution: Highest Quality or Most Compressed before linking your video media.</td>
</tr>
<tr>
<td>AMA Link Preference: Audio</td>
<td>This option allows you to select a quality resolution: Highest Quality or Most Compressed before linking your audio media.</td>
</tr>
<tr>
<td>Consolidate/Transcode Preference: Video</td>
<td>This option allows you to consolidate/transcode your video media to the Highest Quality or Most Compressed resolution.</td>
</tr>
<tr>
<td>Consolidate/Transcode Preference: Audio</td>
<td>This option allows you to consolidate/transcode your audio media to the Highest Quality or Most Compressed resolution.</td>
</tr>
</tbody>
</table>

**AMA Settings: Volume Mounting Tab**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Legacy P2 import (disables AMA P2)</td>
<td>Enables the non-AMA P2 workflow for importing media.</td>
</tr>
<tr>
<td>Enable Legacy XDCAM import (disables AMA XDCAM)</td>
<td>Enables the non-AMA XDCAM workflow for importing media.</td>
</tr>
</tbody>
</table>
### AMA Settings: Link Options Tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Automatically AMA-link to volumes</strong></td>
<td>With this option enabled volumes/disks are automatically mounted. With this option disabled, you can load media without the clips appearing in a bin.</td>
</tr>
<tr>
<td><strong>When mounting previously mounted volumes, do not check for modifications to the volume.</strong></td>
<td>If you select this option, your Avid editing application automatically scans and links all clips from the third-party device and drive every time a device or drive is attached to your system. If you do not select this option, the system checks the modification date of the device or drive against the last time the clips were linked. If the date is the same, the clips come back online. If the date is different, the system links the clips again, and links any new clips added to the volume. The option is off by default.</td>
</tr>
<tr>
<td><strong>Multichannel Audio</strong></td>
<td>Select this option if you want to assign audio tracks to specific channels in your linked media, up to a maximum of 16 audio channels for the clips in your bins. This allows you to specify which source channels are treated as mono or multichannel audio tracks in your project, rather than having to modify the clips in your bin after you link to the AMA media. Click Edit to open the Multiple Mixes dialog box, which allows you to map audio tracks to channels. For more information, see “AMA Linking with Multichannel Audio” on page 421.</td>
</tr>
<tr>
<td><strong>Audio Start-Time Option (for Broadcast WAV)</strong></td>
<td>Sets the interpretation of audio start time for Broadcast Wave and iXML files. For details on using this option, see “iXML Metadata in Broadcast Wave and AIFF Files” on page 1552.</td>
</tr>
</tbody>
</table>
| **Alpha Channel** | Controls how your Avid editing application handles the alpha channel in AMA linked images. The following options are available:  
  * Invert on import (white = opaque): Select this option to reverse the black and white elements of the alpha channel if they differ from the matte key requirements of your Avid editing application. Avid applications use a white background, a black foreground, and a gray transparency blend between the two.  
  * Do not invert (black = opaque): Select this option to import the image, using the existing alpha channel information.  
  * Ignore: Select this option to import an image that contains alpha channel transparency information as one opaque graphic. The imported graphic appears as a single master clip in the bin. |
AMA Settings

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>QuickTime Live Link</td>
<td>Select this option if your editing workflow includes QuickTime movies where the number of tracks, the duration, or the edit rate, but not the file name have been changed in After Effects or Final Cut Pro. See “Using the QuickTime AMA Plug-In” on page 458.</td>
</tr>
</tbody>
</table>

AMA Settings: AIS MetadataTab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reel name for Labroll column</td>
<td>Select from where to read the Reel name. This information will appear in the Labroll bin column. If data exists in the Input Device field of the DPX file, this information will appear in the Camroll bin column after linking to the file. If no data exists in the Input Device field, the Camroll bin column will be empty.</td>
</tr>
<tr>
<td></td>
<td>• Source file name - Enabling this setting gets the Reel Name from the source file name. If the source file name is only numeric characters, no data will appear in the Labroll bin column.</td>
</tr>
<tr>
<td></td>
<td>• Source folder name - Enabling this setting gets the Reel Name from the folder name specified. When Source folder name is enabled, a pulldown menu becomes active. The pulldown menu is used to select a particular folder in the DPX folder directory structure. The directory range is one folder (that contains the DPX files) up to eight folders higher.</td>
</tr>
<tr>
<td>Frame Count for DPX column</td>
<td>Select how you want Frame count to appear in the DPX bin column and Tracking Information. The frame count will appear as a 7 digit number in the DPX bin column. The DPX pre-fix is derived from the Labroll bin column. If no data exists in the Labroll column, then the DPX prefix will be empty.</td>
</tr>
<tr>
<td></td>
<td>• Start frame count at 0 - Enabling this setting starts the frame count in the DPX column at 0000000</td>
</tr>
<tr>
<td></td>
<td>• Start frame count at 1 - Enabling this setting starts the frame count in the DPX column at 0000001</td>
</tr>
<tr>
<td></td>
<td>• Convert timecode to frames - Enabling this setting extracts timecode from the header and converts it to frames based on the current timebase</td>
</tr>
<tr>
<td></td>
<td>• From the File name - Enabling this setting gets frame information from the file name</td>
</tr>
</tbody>
</table>
### Description

| Timecode for Start column: | Select where to read the Timecode. This information will appear in the Start bin column. If no timecode can be extracted from either location, the column will populate with the default timecode.  
  - Embedded in source file - Enabling this setting extracts the timecode from the Header file  
  - From file name - Enabling this setting gets the timecode from the file name |

---

### Audio Settings

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mix Tool Display Options</td>
<td>Opens a dialog that allows you to add or remove items such as faders, legends, effect buttons, and the solo and mute buttons:</td>
</tr>
<tr>
<td>Source Monitor Scrub</td>
<td>Defines the number of outgoing and incoming frames you hear as you scrub.</td>
</tr>
<tr>
<td>Record Monitor Scrub</td>
<td>Defines the number of outgoing and incoming frames you hear as you scrub.</td>
</tr>
<tr>
<td>Source Scrub</td>
<td>Defines the number of outgoing and incoming frames you hear as you scrub the source.</td>
</tr>
<tr>
<td>Timeline Scrub</td>
<td>Defines the number of outgoing and incoming frames you hear as you scrub in the timeline.</td>
</tr>
</tbody>
</table>
| Default Pan for mono tracks | Controls the way you want sound to pan between speakers:  
  - Alternating L/R: Sends the odd tracks to the left channel and the even tracks to the right channel.  
  - All Tracks Centered: Centers the pan of all tracks between the two speakers for monitoring and output. |
| Play Buffer Size in Samples (Software-only Models) | Defines the size of the host audio play buffer during playback and digital cut. Use this option if you experience performance problems with playback to the host audio device.  
  
  *Avid recommends the default value for this option. Changing this parameter might cause audio or video underruns, dropped frames, or increased noise in the audio output.*  
  
  For more information, see “Adjusting the Play Buffer Size for Audio (Software-only Models)” on page 787.  
  
  To return this option to its default value, click the rs (recommended sample) button. |
**Audio Project Settings**

You can save multiple Audio Project settings and select one as the active setting. If you edit an inactive setting, your Avid editing application does not display items that are not saved. For example, Mix Mode does not display in an inactive setting because you cannot save it in the Project settings.

*The Direct Out mode is saved in the Audio settings, not the Audio Project settings. You set it in the Output tab of the Audio Project window but the system saves the value in the active Audio settings.*

**Audio Projects Settings: Main Tab**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tool Buffer Size in Samples</td>
<td>Defines the size of the host audio play buffer during audio loop play and audio tools play (such as volume automation recording). Reducing the</td>
</tr>
<tr>
<td>(Software-only Models)</td>
<td>tools play buffer size decreases the overall latency between the time you adjust an audio parameter in your Avid editing application and the time</td>
</tr>
<tr>
<td></td>
<td>you hear those changes through the speaker. **Changing this option might cause audio or video underruns, dropped frames, or increased noise in the</td>
</tr>
<tr>
<td></td>
<td>audio output. Because performance varies from machine to machine, experiment to find a value that works best. For best results when adjusting this</td>
</tr>
<tr>
<td></td>
<td>option, turn off or disconnect all DV devices. For more information, see “Adjusting the Play Buffer Size for Audio (Software-only Models)” on page 787.</td>
</tr>
<tr>
<td></td>
<td>To return this option to its default value, click the rs (recommended sample) button.</td>
</tr>
<tr>
<td>Monitors Volume</td>
<td>Controls the volume of the desktop speakers. Use the Mute button to mute audio output to speakers or headphones.</td>
</tr>
</tbody>
</table>

For more information, see “Changing the Audio Sample Rate for Sequences and Audio Clips” on page 835.
## Audio Project Settings

### Audio File Format
Defines the file format for audio:
- **WAVE (OMF):** Compatible with Windows applications.
- **AIFF-C (OMF):** Compatible with many third-party applications, including Pro Tools.
- **PCM (MXF):** Enables easy exchange of material between servers, tape streamers, and digital archives.

Select WAVE or AIFF-C for all audio media when you need to transfer audio media files directly to a Pro Tools system for audio sweetening.

*Media Composer has limited support for Sound Designer II audio. For more information, see “Transferring and Working with Sound Designer II Audio Files from Macintosh Systems” on page 1157.*

### Bit Depth
Defines the sample size you use when you work with audio files:
- **16 Bit:** For CD-quality audio.
- **24 Bit:** For work with higher resolution audio.

### DV Audio Pattern
Controls whether variation in the audio sample rate is allowed. Select the option expected by your device.
- **Unlocked Audio:** Allows some imprecision in the audio sample rate, with a variation of up to +/– 25 audio samples per frame.
- **Locked Audio:** Keeps the audio clock locked precisely to the video clock, so exactly the same number of audio samples and video frames are recorded or transmitted in each cycle of the phase relationship.

Depending on your Avid input/output hardware, this option might be unavailable because the option is automatically selected depending on the deck template you choose. The option is set to Locked Audio for DVCPro device templates, and to Unlocked Audio for all other device templates.

### Convert Sample Rates When Playing
Controls whether or not your Avid editing application performs on-the-fly sample rate conversion of segments that do not match the rate defined in Sample Rate.
- **Never:** Your Avid editing application does not perform sample rate conversion (segments play as silence).
- **Always:** Your Avid editing application attempts to perform a sample rate conversion. The resulting audio quality might not be useful for a finished project, but can be useful during an editing session because it prevents audio from playing back with silence.

For information on changing the sample rate for individual sequences and audio clips, see “Changing the Audio Sample Rate for Sequences and Audio Clips” on page 835.
Audio Project Settings

Audio Project Settings: Input Tab

The options that appear in this tab depend on your audio configuration and the hardware installed on your system. Your options might differ from those listed here.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Mismatched Sample Rates as</td>
<td>Controls whether or not your Avid editing application identifies mismatched sample rates by color if you have a sequence with several different sample rates.</td>
</tr>
<tr>
<td>Different Color</td>
<td></td>
</tr>
<tr>
<td>Remove Extra Filler After Punchin</td>
<td>Controls whether your Avid editing application removes or keeps extra filler added during an audio punch-in recording.</td>
</tr>
<tr>
<td>Optical Connection</td>
<td>Depending on your Avid input/output hardware, defines whether you use ADAT or S/PDIF output for use with an optical connection.</td>
</tr>
<tr>
<td>Keep Dolby E Material Safe</td>
<td>Select this option to ensure the capture of Dolby E media.</td>
</tr>
<tr>
<td>Input Gain slider</td>
<td>Depending on your Avid input/output hardware, controls your computer’s volume settings. (Windows only) Select the +20 dB check box to boost gain for low gain inputs.</td>
</tr>
<tr>
<td>Input Source</td>
<td>Controls the type of audio input. The types available depend on the audio hardware installed in or connected to your system. If you select IEEE 1394 as your input device, this option is automatically set to Host-1394. For more information, see “Connecting a DV Device” on page 193.</td>
</tr>
<tr>
<td>Sample Rate Conversion</td>
<td>Controls sample rate conversion:</td>
</tr>
<tr>
<td></td>
<td>• When needed: Your Avid editing application automatically converts incoming audio sample rates to match the project sample rate.</td>
</tr>
<tr>
<td></td>
<td>• Never: Your Avid editing application does not perform sample rate conversion.</td>
</tr>
<tr>
<td></td>
<td>For more information, see “Selecting the Audio Sample Rate and Controlling Audio Sample Rate Conversion” on page 208.</td>
</tr>
<tr>
<td>Output Sync During Passthrough</td>
<td>Controls the timing reference for output:</td>
</tr>
<tr>
<td></td>
<td>• Same as Video Out with SRC (Sample Rate Conversion): This is the default setting and is used for most applications. The timing reference is the same for the audio and video output clock.</td>
</tr>
<tr>
<td></td>
<td>• Same as Audio In: Uses the audio capture clock as the audio output clock while you are capturing. This option does not require the use of a sample rate converter and is useful when using encoded digital audio stream.</td>
</tr>
</tbody>
</table>
Audio Project Settings

Options for HD SDI input

16ch: Lets you capture up to 16 audio channels of HD-SDI input.

*Not all decks support 16-channel audio. For more information, see the documentation for your deck.*

Audio Project Settings: Output Tab

The options that appear in this tab depend on your audio configuration and the hardware installed on your system. Your options might differ from those listed here.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output Gain</td>
<td>Controls the volume of global audio output.</td>
</tr>
<tr>
<td>Mix Mode Selection button</td>
<td>Controls how your system interprets audio values during playback:</td>
</tr>
<tr>
<td></td>
<td>• Stereo: Mixes the currently monitored audio tracks into a stereo pair. Depending on your Avid input/output hardware, you can customize the mix using the Stereo Mix Tracks option.</td>
</tr>
<tr>
<td></td>
<td>• Mono: Pans all the currently monitored tracks to center and ignores pan effects.</td>
</tr>
<tr>
<td></td>
<td>• Direct Out (available depending on your Avid input/output hardware): Maps tracks directly to the available output channels. Ignores pan settings. You can remap a track to any channel by clicking the Channel Assignment menu and selecting another channel.</td>
</tr>
<tr>
<td>Stereo Mix Tracks</td>
<td>This option is available with some Avid input/output hardware.</td>
</tr>
<tr>
<td></td>
<td>Customizes the mix of tracks with Stereo selected in the Mix Mode Selection Menu button.</td>
</tr>
<tr>
<td></td>
<td>Your Avid editing application sends a stereo mix to the two channels you select. Material panned to the left is sent to the odd channel, and material panned to the right is sent to the even channel. The number of channels available depends on the audio output you select or on the options you select in the SD SDI tab.</td>
</tr>
<tr>
<td>First six tracks are 5.1 surround: L, R, C, LFE, LR, RR</td>
<td>Available when you select Direct Out with the Mix Mode Selection Menu button and when you are using an Avid Mojo DX. Select this option when the media in the Timeline is set up as surround sound media even if your speakers are set up as stereo. You can use the Direct Out channel selections to reset which tracks go to which channels. Deselect this option if you are using stereo media in the Timeline.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| All or Timeline Track Maps   | Available when you select Direct Out with the Mix Mode Selection Menu button. Maps the track and output channels:  
|                              | - All: Lets you choose between all available tracks.  
|                              | - Timeline: Lets you assign output channels to the tracks monitored in the Timeline. |
| Which Set of Track Maps      | Available when you select Direct Out with the Mix Mode Selection Menu button. Defines the groups of output tracks to map to audio channels. Groups of tracks display in multiples of 8, up to the maximum of 24 available audio tracks. |
| Reset                        | Available when you select Direct Out with the Mix Mode Selection Menu button. Reassigns the audio tracks of the sequence to the default channels that are currently available. |
| Output type option tab:      | TURNS ANALOG OUTPUT ON OR OFF.                                               |
| Analog                       |                                                                              |
| Output type option tab:      | THIS OPTION IS AVAILABLE DEPENDING ON YOUR AVID INPUT/OUTPUT HARDWARE.       |
| SD SDI                       | USE THE ON OR OFF OPTION TO CONTROL WHETHER TO EMBED THE AUDIO WITH THE VIDEO IN SDI OUTPUT. |
|                              | SELECT ONE OF THE FOLLOWING BASED ON THE NUMBER OF CHANNELS YOU WANT AND THE SAMPLE RATE YOU WANT ON THE OUTGOING SDI SIGNAL:  
|                              | - 4 CHANNELS 20-BITS  
|                              | - 4 CHANNELS 24-BITS  
|                              | - 8 CHANNELS 20-BITS  
|                              | - 8 CHANNELS 24-BITS  
| **With some Avid input/output hardware devices, you must use 48-kHz audio when SDI is enabled. With Avid Nitris DX or , you do not need 48-kHz audio.** |
| Output type option tab:      | THIS OPTION IS AVAILABLE FOR HD PROJECTS DEPENDING ON YOUR AVID INPUT/OUTPUT HARDWARE. |
| HD SDI                       | USE THE ON OR OFF OPTION TO CONTROL WHETHER TO EMBED THE AUDIO WITH THE VIDEO IN HD SDI OUTPUT. |
|                              | SELECT EITHER 4 CHANNELS 24-BITS OR 8 CHANNELS 24-BITS, BASED ON THE NUMBER OF CHANNELS YOU WANT ON THE OUTGOING SDI SIGNAL. |
### Audio Project Settings: Hardware Tab

Apart from HW Calibration, the settings in the Hardware tab are for informational purposes only and list defaults set by your system, depending on your audio hardware and configuration.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Card</td>
<td>Indicates the type of audio card installed.</td>
</tr>
<tr>
<td>Peripheral</td>
<td>Indicates the type of peripheral audio device (audio interface) attached to the system.</td>
</tr>
<tr>
<td>Sync Mode</td>
<td>Sync ensures that the audio sample clock is always in sync with the video clock for audio input and output. This prevents long-term drift between audio and video. When you are working with video and digital audio simultaneously, set your digital audio equipment to the same video reference signal as your video equipment.</td>
</tr>
<tr>
<td>HW Calibration</td>
<td>Depending on your Avid input/output hardware, matches the software audio calibration to your Avid hardware. The default value for the software and hardware is -20d BFS. Other available values are -14d BFS and -18d BFS. If you don’t change your hardware settings, keep this value at -20d BFS. For information on changing the hardware setting, see “Calibrating Audio Hardware for Avid Nitris DX and Avid Mojo DX” on page 217.</td>
</tr>
<tr>
<td>Open Calibration window</td>
<td>Available when you are using Avid Nitris DX or Avid Mojo DX. Opens the Audio Hardware Calibration tool, see “Calibrating Audio Hardware for Avid Nitris DX and Avid Mojo DX” on page 217.</td>
</tr>
</tbody>
</table>

### Audio Project Settings: Effects Tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Effect Bypass panel</td>
<td>Controls which of the volume settings established with the audio tools your Avid editing application ignores when playing back or recording a sequence:</td>
</tr>
<tr>
<td></td>
<td>• Clip Gain: Bypasses the clip gain mode of the Audio Mixer tool.</td>
</tr>
<tr>
<td></td>
<td>• Volume: Bypasses all Volume Automation and Pan effects set in the Volume Automation and Pan mode of the Audio Mixer tool.</td>
</tr>
<tr>
<td></td>
<td>• RT EQ: Bypasses all unrendered EQ effects set in the Audio EQ tool.</td>
</tr>
<tr>
<td></td>
<td>These buttons function the same as the Bypass buttons in the audio tools.</td>
</tr>
<tr>
<td>Render Sample Rate Conversion Quality</td>
<td>Controls the conversion quality of all non-real-time sample rate conversions. The following options are available: High and Slow, Balanced, Low and Fast.</td>
</tr>
</tbody>
</table>
### Audio Multiple Mix Settings

You can save Audio Multiple Mix settings and select one as the active setting. See “Mixing Down Multiple Audio Tracks” on page 838.

### Bin Settings

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto-Save interval $n$ minutes</td>
<td>Defines the interval between attempts to auto-save project files. The default is 15 minutes. To avoid interrupting an edit, your Avid editing application waits until your system is inactive before auto-saving. Use the option “Force Auto-Save at” to specify an interval at which your Avid editing application interrupts an edit to make the auto-save.</td>
</tr>
<tr>
<td>Inactivity period $n$ seconds</td>
<td>Defines how long your Avid editing application waits when your system is inactive before automatically saving the project files. The default is 15 seconds.</td>
</tr>
<tr>
<td>Force Auto-Save at $n$ minutes</td>
<td>Defines the maximum interval between auto-saves. Once this time elapses, your Avid editing application auto-saves the project files even if it must interrupt an edit to do so. The default is 17 minutes.</td>
</tr>
<tr>
<td>Maximum files in a project’s attic</td>
<td>Defines the maximum number of files stored in the Avid Attic folder for each project. When a bin or script is saved, your Avid editing application copies the current version of the bin or script to a subfolder within the special folder called the Avid Attic. Each project has its own subfolder and each bin or script saved in a project has its own subfolder within the project folder. The default is 1000 files per project. The overall file count for the entire Avid Attic will reflect the files stored for each project on the system.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Max versions of a file in the attic</strong></td>
<td>Defines the maximum number of single-bin or script copies stored in a project's attic. This setting prevents filling the project's attic with too many versions of one bin or script. The default is 50 versions.</td>
</tr>
</tbody>
</table>
| **Double-click loads object in** | Determines what happens when you double-click an object in the bin:  
  - New Pop-up Monitor: Creates a new Source pop-up monitor and automatically loads the clip when you double-click an object in the bin.  
  - Source or Record Monitor: When you have the Composer monitor stretched into two monitors, loads the clip into the Source monitor or the sequence into the Record monitor. When you are using the single Composer monitor, loads the clip or sequence into the existing Source pop-up monitor. |
| **Enable edit from bin (Splice, Overwrite)** | Lets you edit clips directly from a bin by selecting a clip and clicking the Splice-in or the Overwrite button.                                                                                                   |
| **Always keep at least one version in Attic.** | This option is on by default and when enabled will keep one version of each bin in the Attic. If you deselect this option, multiple copies of the bins you have currently been working on will be saved rather than making sure one copy of every bin will be saved. If you deselect this option, older bins may have all Attic versions removed to keep to the Max Files limit. |
| **Show local media icons** | Clip icons will appear blue to indicate the media is local or pink to indicate mixed resolution.                                                                                                           |
| **Frame View** | Determines how border colors and icons appear in Frame View  
  **Show Border Colors: Use color based on object type** displays a colored border around the following:  
  - Blue - Precomputes and source side motion effects  
  - Green - Master clips  
  - Dark Green - Subclips and Group clips  
  - Red - Sequences  
  - Purple - Media files in the Media Tool  
  **Show Border Colors: Use clip color**, assigns the same colors you assigned to clips in Text View to items in Frame View.  
  **Show icons** displays the applicable bin item icon, for example sequence, clip, subclip, title. |
Capture Settings

Capture settings include essential options for capturing, batch capturing, auto capturing, capturing to multiple media files, DV scene extraction, and setting key commands.

**Capture Settings: General Tab**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stop deck after capture</td>
<td>When this option is selected, the deck stops when the capture operation is complete.</td>
</tr>
<tr>
<td>Pause deck after capture</td>
<td>When this option is selected, the deck pauses when the capture operation is complete.</td>
</tr>
<tr>
<td>Preroll Method</td>
<td>Defines the preroll method. For more information, see “Selecting Settings for Preroll Method and for Capturing Across Timecode Breaks” on page 182.</td>
</tr>
<tr>
<td>Force unique clip names</td>
<td>When this option is selected, your Avid editing application automatically assigns a clip name based on the bin’s name and ensures this name, or another name you select, is not already used by any other object in the bin.</td>
</tr>
<tr>
<td>Activate bin window after capture</td>
<td>When this option is selected, your Avid editing application changes the focus from the Capture Tool window to a bin window after capturing or logging is complete. This lets you start working in the bin immediately.</td>
</tr>
<tr>
<td>Space bar stops capture</td>
<td>When this option is selected, you can use the space bar to create clip names during the capturing process. When you press the space bar during a capture operation, your Avid editing application stops capturing, creates a clip from the captured material, and places the clip in the active bin.</td>
</tr>
<tr>
<td>Capture across timecode breaks</td>
<td>When this option is selected, your Avid editing application captures sections of discontinuous timecode on a tape as separate clips. When this option is deselected, your Avid editing application stops capturing and reports an error when it encounters a timecode break.</td>
</tr>
<tr>
<td>Stop capture if a bad frame is detected</td>
<td>When this option is selected, your Avid editing application stops capturing if a corrupt frame is detected. This setting is enabled by default.</td>
</tr>
<tr>
<td>Latency for no deck mode n frames</td>
<td>Compensates for problems that might occur when you capture with external timecode. For more information, see “Capturing in Satellite Mode or No Device Control” on page 278. If you notice that your captured media consistently starts on the wrong frame (usually one or two frames off), use this option to ensure that capturing starts on the correct frame. The option is set to zero by default.</td>
</tr>
</tbody>
</table>

This option is not available in software-only configurations.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ignore Detected Media Read Errors</td>
<td>When this option is selected, capture accuracy improves, especially on tapes that appear to be experiencing a lot of dropouts.</td>
</tr>
<tr>
<td>Capture a single video frame only</td>
<td>When this option is selected, your Avid editing application captures a single frame of video from your clip. When you click the Record button, your Avid editing application captures the currently displayed frame.</td>
</tr>
<tr>
<td>Ask before discarding a canceled clip</td>
<td>When this option is selected, your Avid editing application lets you choose whether to discard the canceled clip, keep it, or try again.</td>
</tr>
<tr>
<td>Ask for name when a new tape is seen</td>
<td>When this option is selected, your Avid editing application asks you for a name when it detects a new tape.</td>
</tr>
<tr>
<td>Display incoming video in the client monitor</td>
<td>When this option is selected, your Avid editing application displays incoming video in the Client monitor as soon as you open the Capture tool.</td>
</tr>
<tr>
<td>Pause deck while logging</td>
<td>When this option is selected, the deck pauses after you set an OUT point while you log clips. This gives you time to type the name of the clip. For more information, see “Logging Directly into a Bin” on page 147. When this option is deselected, the camera or deck continues playing after you set an OUT point.</td>
</tr>
</tbody>
</table>

**Capture Settings: Batch Tab**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optimize for disk space</td>
<td>When this option is selected, your Avid editing application captures only the exact amount of material in the master clips plus any additional handles. The tape pauses and prerolls independently for each master clip that is batch captured.</td>
</tr>
</tbody>
</table>
| Optimize for batch speed      | When this option is selected, your Avid editing application speeds up batch capturing by allowing the deck to continue to roll forward between adjoining clips. To qualify for this operation, the two adjoining clips must meet the following criteria:  
  * There is 5 seconds or less between the OUT point of the first clip and the IN point of the second clip.  
  * The two clips have the same video resolution and the same audio rate.  
  * If you select this option, your Avid editing application might occasionally capture more material than you need.  |
### Capture Settings

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Switch to emptiest drive if current drive is full</td>
<td>When this option is selected, your Avid editing application switches to the target media storage drive with the most available space when the current target drive becomes full during batch capturing. Your Avid editing application switches before starting to capture the clip, based on the number of minutes in the clip. For more information, see “Batch Capturing from Logged Clips” on page 250. When this option is deselected, your Avid editing application stops capturing when a drive becomes full.</td>
</tr>
<tr>
<td>Rewind tape when finished</td>
<td>When this option is selected, your Avid editing application automatically rewinds tapes after batch capturing finishes.</td>
</tr>
<tr>
<td>Eject tape when finished</td>
<td>When this option is selected, the tape ejects as soon as the last shot from that tape is captured. You can do other tasks while the tape is in use and be alerted as soon as the tape is no longer needed.</td>
</tr>
<tr>
<td>Log errors to the console and continue capturing</td>
<td>When this option is selected, your Avid editing application continues capturing if an error occurs during the capture process.</td>
</tr>
<tr>
<td>Capture the tracks logged for each clip</td>
<td>When this option is selected, your Avid editing application captures the tracks logged for each clip.</td>
</tr>
<tr>
<td>Use the audio sample rate logged for each clip</td>
<td>When this option is selected, your Avid editing application uses the audio sample rate logged for each clip.</td>
</tr>
<tr>
<td>Use the audio bit depth logged for each clip</td>
<td>When this option is selected, your Avid editing application uses the audio bit depth logged for each clip.</td>
</tr>
<tr>
<td>Use the video compression logged for each clip</td>
<td>When this option is selected, your Avid editing application uses the video compression logged for each clip.</td>
</tr>
</tbody>
</table>

### Capture Settings: Edit Tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable edit to timeline (splice, overwrite)</td>
<td>When this option is selected, Splice-in Edit and Overwrite Edit buttons display in the Capture tool.</td>
</tr>
<tr>
<td>Handles</td>
<td>Controls the amount of footage you capture before and after the IN and OUT points of the clips (when capturing to the Timeline only).</td>
</tr>
<tr>
<td>Enable voice-over</td>
<td>When this option is selected, the Voice-Over button displays in the Capture tool.</td>
</tr>
<tr>
<td>Preroll</td>
<td>Controls the amount of preroll and postroll you want to capture before and after the voice-over.</td>
</tr>
</tbody>
</table>
**Capture Settings: OMF Media Files Tab**

The OMF Media Files tab is available in the Capture Settings dialog box when you select OMF in the Media Type tab of the Media Creation dialog box.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Capture to a single file, 2 GB limit</td>
<td>When this option is selected, capture stops when the media captured has taken up 2 gigabytes (GB) of storage space on the media drive.</td>
</tr>
<tr>
<td>Capture to multiple files</td>
<td>When this option is selected, your Avid editing application writes captured video or audio to multiple files across multiple drive partitions. Select this option for clips that might exceed the 2-GB file-size limit.</td>
</tr>
<tr>
<td>Maximum (default) capture time <em>n</em> minutes</td>
<td>Determines how much space your Avid editing application preallocates on the target drive or drives before a capture begins. The default capture time is 30 minutes. This option applies only to capture-on-the-fly and capture from an IN point without an OUT point. Capture from an IN point to an OUT point overrides this option. Change this option only if you intend to capture on-the-fly for longer than 30 minutes. Your Avid editing application captures for only the specified number of minutes, so be careful not to underestimate.</td>
</tr>
<tr>
<td>Switch to emptiest drive when <em>n</em> minutes left</td>
<td>When this option is selected, your Avid editing application switches to another storage drive when the specified amount of time remains.</td>
</tr>
</tbody>
</table>

**Capture Settings: MXF Media Files Tab**

The MXF Media Files tab is available in the Capture Settings dialog box when you select MXF in the Media Type tab of the Media Creation dialog box.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum (default) capture time <em>n</em> minutes</td>
<td>Determines how much space your Avid editing application preallocates on the target drive or drives before a capture begins. The default capture time is 30 minutes. If Frame Chase capture is enabled (the “During capture, clip is updated in Interplay option is selected), this option defines the expected duration in minutes for a Frame Chase clip that you create during on-the-fly or open-ended capture (when no IN and OUT marks are set in the Capture tool).</td>
</tr>
<tr>
<td></td>
<td>This option applies only to capture-on-the-fly and capture from an IN point without an OUT point. Capture from an IN point to an OUT point overrides this option. Change this option only if you intend to capture on-the-fly for longer than 30 minutes. Your Avid editing application captures for only the specified number of minutes, so be careful not to underestimate.</td>
</tr>
</tbody>
</table>
During capture, clip is updated in Interplay

When this option is selected, Frame Chase capture is enabled. An initial check-in takes place 10 seconds after a capture begins.

Subsequent Interplay updates occur at intervals defined by the Update Interval option. Select an update interval from the menu to determine how frequently updates to Interplay occur during a Frame Chase capture.

In most circumstances you should keep the update interval low (1 minute or 2 minutes). This ensures that information added during capture (for example, comments or markers) is available as quickly as possible.

For more information, see “Enabling Frame Chase Capture” on page 248.

Switch to emptiest drive when \( n \) minutes left

When this option is selected, your Avid editing application switches to another storage drive when the specified amount of time remains.

---

### Capture Settings: DV & HDV Options Tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DV&amp;HDV Scene Extraction</td>
<td>When this option is selected, you can automatically generate subclips and markers based on time-of-day (TOD) information contained in the DV video format. For more information, see “DV and HDV Scene Extraction” on page 294.</td>
</tr>
<tr>
<td></td>
<td>• Add Markers: Creates marker marks where the TOD information breaks occur while capturing.</td>
</tr>
<tr>
<td></td>
<td>• Create Subclips: Creates subclip marks where the TOD information breaks occur while capturing.</td>
</tr>
<tr>
<td></td>
<td>• Both: Creates markers and subclips where the TOD information breaks occur while capturing.</td>
</tr>
<tr>
<td>Enable detection of small timecode breaks</td>
<td>When this option is selected, batch capture is more accurate for footage captured over 1394 due to undetected small timecode breaks.</td>
</tr>
</tbody>
</table>

### Capture Settings: Keys Tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Function Key Commands (while capturing/logging)</td>
<td>Changes the commands that are mapped to the function keys on your keyboard. These mappings apply to Capture mode only.</td>
</tr>
<tr>
<td>Timed Subclip</td>
<td>Defines a preset duration for subclips created while capturing.</td>
</tr>
</tbody>
</table>
Cloud Playback Settings

The following table describes the options available in the Cloud Playback Settings dialog box.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disk Cache</td>
<td>This option displays the default location of the CloudCache folder holding prefetched media files. You can change the default location by clicking Browse and navigating to a new location on your local system.</td>
</tr>
<tr>
<td>Disk Cache Size</td>
<td>This text box displays the maximum size of the CloudCache folder. You can modify the cache size by entering a new number in the text box. The default cache size is 2 GB.</td>
</tr>
<tr>
<td>Quality</td>
<td>You can set the playback quality for remote media to Low (the default) or High. Use the High setting only when you have a high-capacity connection to your Interplay system — for example, when you have an Ethernet connection to Interplay.</td>
</tr>
<tr>
<td>Clear Local Caches</td>
<td>This option allows you to manually delete the CloudCache folder and its contents.</td>
</tr>
</tbody>
</table>

Cloud Upload Settings

The following table describes the options available in the Cloud Upload Settings dialog box.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Upload Quality</td>
<td>This option allows you to select media settings for upload. You can specify settings for uploading high resolution media using the High Quality option.</td>
</tr>
</tbody>
</table>

Only one proxy format is currently available for remote media upload to Interplay.

- Proxy (H.264 video | MP2 Audio) — Uploads media at the default proxy resolution.
- High — Uploads media using the video resolution and audio format specified in the High Quality settings.
- Proxy then High — Uploads media first using the default proxy resolution, and then uploads media as a background process using the High Quality settings.
### Option Description

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>High Quality</strong></td>
<td>This option is available if you select either the High or the Proxy then High option for your upload quality.</td>
</tr>
<tr>
<td><strong>Video</strong></td>
<td>- Select Same as Source (when possible) if you want to upload video with no resolution change from the source video clip. If the source resolution is not available, the upload uses the resolution selected in the Resolution menu.</td>
</tr>
<tr>
<td><strong>Audio</strong></td>
<td>- Select Same as Source (when possible) if you want to upload audio without converting the sample rate or change from the source audio clip. If the source format is not available, the upload uses the default format.</td>
</tr>
<tr>
<td><strong>Handles</strong></td>
<td>This option specifies the length of handles on the incoming and outgoing sides of the clip. Type the number of frames you want to use as handles for uploaded clips in the Handles: nn Frames text box. Handles refer to material outside the In and Out points that you can use for dissolves and trims with the uploaded master clips. The default is 30.</td>
</tr>
<tr>
<td><strong>Local Volume</strong></td>
<td>This option allows you to specify the location where the upload operation creates media files before uploading them to Interplay.</td>
</tr>
<tr>
<td><strong>Priority</strong></td>
<td>You can use the Priority option to set the priority for your upload operation. The upload queue is sorted by priority so that high priority jobs are uploaded first. You can also change the priority of a specific clip or upload job in the Upload Queue window.</td>
</tr>
<tr>
<td><strong>Destination</strong></td>
<td>The option allows you to specify the destination used for the upload operation.</td>
</tr>
<tr>
<td></td>
<td>- Workspace — Type the name of the destination ISIS workspace used for the upload. You do not need to be connected to ISIS for the upload to complete successfully, but you must specify a workspace where ISIS saves the uploaded media files.</td>
</tr>
<tr>
<td></td>
<td>- Interplay Folder — The Interplay folder is set in the Interplay Folder Settings dialog box. The remote upload operation checks in the media files to this folder. See “Interplay Folder Settings” on page 1509 for more information.</td>
</tr>
</tbody>
</table>
The Communication (Serial) Ports tool lets you view the current configuration of the serial interface at any time during editing. You can also use it to reconfigure the ports without closing your Avid editing application or shutting down the computer.

### Option Description

**Insert color transformations automatically in the source settings upon AMA link**
Applies any color transformations already specified in the source settings. Do not select this option if you want to work with the original media files. See “Setting the Color Properties of Acquired Media” in the Help.

**Use CDL values from ASC_SOP and ASC_SAT bin columns when available**
Primary color grading can be performed as one of the pre-post functions on dailies systems and then passed on to the offline editing system. If you are editing with MXF media, these colors are already applied. However, if you want to use the original media, you can select this option to read the CDL values associated with the media and apply them to the master clips.

**Install LUT**
Click to browse for a LUT file associated with your media.

## Communication (Serial) Ports Tool Settings

The Communication (Serial) Ports tool lets you view the current configuration of the serial interface at any time during editing. You can also use it to reconfigure the ports without closing your Avid editing application or shutting down the computer.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Play and Capture</td>
<td>Sets a port for an edit controller that uses the Sony serial control protocol. For more information, see “Remote Play, Capture, and Punch-In” on page 285.</td>
</tr>
</tbody>
</table>
# Composer Settings

## Composer Settings: Window Tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Display at Top</td>
<td>- <strong>Off</strong> — When this option is selected, your Avid editing application turns off the information display above the monitors.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Always Display One Row of Data</strong> — When this option is selected, your Avid editing application displays one row of tracking, duration, and clip or sequence title information above the Source and Record monitors.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Always Display Two Rows of Data</strong> — When this option is selected, your Avid editing application displays a second row of information above the first row. The second row includes Fast Menu icons, duration information, and, when applicable, ganging and multicamera icons.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Flow Data Dynamically</strong> — When this option is selected, your Avid editing application adjusts the display of information above the monitors as you resize them.</td>
</tr>
<tr>
<td>Button Display at Bottom</td>
<td>- <strong>Off</strong> — When this option is selected, your Avid editing application turns off the display of buttons under the Source and Record monitors.</td>
</tr>
<tr>
<td></td>
<td>- <strong>One Row</strong> — When this option is selected, your Avid editing application displays only the top row of Monitor command buttons.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Two Rows</strong> — When this option is selected, your Avid editing application displays a second row of buttons under the Source and Record monitors and includes mode buttons in the lower center of Source/Record mode beneath the Splice-in and Overwrite buttons.</td>
</tr>
<tr>
<td>Center Duration</td>
<td>When this option is selected, your Avid editing application displays duration data (Mark In/Out) for the material in the Source or Record monitor, depending on which monitor is active.</td>
</tr>
<tr>
<td>Tick Marks in Position Bars</td>
<td>When this option is selected, your Avid editing application switches the display of tick marks (duration indicators) that appear incrementally along the position bars located directly beneath the Source and Record monitors. When this option is deselected, the tick marks are invisible.</td>
</tr>
</tbody>
</table>
### Composer Settings: Edit Tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Color Framing                 | When this option is selected, color framing indicator lights display above the Overwrite and Splice-in buttons. Deselect this option if you are not performing an online edit with material captured from 1-inch, reel-to-reel tapes. This option is deselected by default. When this option is deselected, you might have to make adjustments during online editing if your edits interrupt the color-sync, signals-per-frame fields in the sequence. The following field options are available:  
  • 4 field: For NTSC video.  
  • 8 field: For PAL video.  
The green color framing indicator lights (similar to LEDs) above the Overwrite and Splice-in buttons are off when the color-sync signal is not in phase for that frame. Steady green lights indicate a frame that is properly phased.  
If the green light is off, find the proper color phasing when editing by trimming the IN to OUT points by a frame or two until the light comes on and stays on.  
For more information on color framing, see “Tracking Color Frame Shifts” on page 727. |
| Sync Point Editing (Overwrites) | When this option is selected, your Avid editing application overwrites material onto your sequence so that a particular point in the source material is in sync with a particular point in the sequence.                                                                 |
| Single Mark Editing           | When this option is selected, you can mark an IN or OUT point in the Source monitor and then perform a splice, overwrite, or replace edit. Your Avid editing application uses the current location of the position indicator as the corresponding OUT or IN point.                                                                 |
| Phantom Marks                 | When this option is selected, your Avid editing application provides visual guidance when you set fewer than four IN or OUT points while editing. Phantom marks (shaded IN or OUT mark icons) indicate the remaining edit points calculated by your Avid editing application to complete the edit. For more information, see “Working with Phantom Marks” on page 627.                                                                 |
| Auto-create New Tracks        | When this option is selected, whenever you edit material into the Timeline, your Avid editing application automatically creates any new tracks in the sequence that match existing tracks in the source material. This option is selected by default.  
Note, if you do not have any tracks in your Timeline and you have this option deselected, new tracks will be created. However if you have at least one track, for example, v2, but your source material is patched on an empty v1, a new track will not be created. This also applies to audio tracks. |
### Composer Settings

**Composer Settings: FF/REW Tab**

The options in the FF/REW tab control how the position indicator moves when you use the Fast Forward and Rewind buttons in your Avid editing application monitors. These buttons behave differently from the equivalent buttons on a tape deck. When a sequence is loaded in a monitor, the Fast Forward or Rewind button causes a jump (forward or backward) to the next edit that is common to all selected tracks in the Timeline. When a clip is loaded in a monitor, the Fast Forward or Rewind button causes a jump to the beginning or end of the clip.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto-enable Source Tracks</td>
<td>When this option is selected, whenever you load new source material into the Source monitor, your Avid editing application automatically enables all existing source tracks. This option is selected by default.</td>
</tr>
<tr>
<td>Copy Source Markers</td>
<td>When this option is selected, if you have markers in a clip in the Source monitor, your Avid editing application copies the markers when you edit the clip into the Record monitor. This option is selected by default.</td>
</tr>
<tr>
<td>Undo Only Record Events</td>
<td>When this option is selected, you can limit the Undo command to undo only record actions. For more information, see “Undoing or Redoing Edits” on page 590.</td>
</tr>
<tr>
<td>Activate Record Monitor After Edit</td>
<td>When this option is selected, the Record monitor will be active after you perform an edit. If the option is not enabled, whichever monitor was selected before you made an edit will be the active monitor after the edit. This option is not enabled by default.</td>
</tr>
<tr>
<td>Show Composer Markers</td>
<td>With this option, you can choose whether or not markers appear in the Composer window.</td>
</tr>
<tr>
<td>Show Spanned Markers</td>
<td>With this option, you can choose whether or not spanned markers appear in the Composer window. You can also select which colored markers appear in the Composer window.</td>
</tr>
</tbody>
</table>

### Option Description

**Stop at Head Frames**

When this option is selected, the position indicator stops at the first frame (head frame) of the clip on the selected track.

This option is the default setting. Each time you use either the Fast Forward and Rewind button, the position indicator moves to the next consecutive head frame.

**Stop at Tail Frames**

When this option is selected, the position indicator stops at the last frame (tail frame) of the clip on the selected track.
Stop at Markers When this option is selected, the position indicator moves to the next consecutive frame containing a marker. For more information on using markers, see “Using Markers” on page 550.

Ignore Track Selectors When this option is selected, your Avid editing application ignores the selected tracks and cues directly to the start (head) frame of the next edit, regardless of the track on which it occurs.

The position indicator’s final location depends on whether the Stop at Head Frames and Stop at Tail Frames options are selected.

### Composer Settings: MultiCam Tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Split Mode Play</td>
<td>Controls split mode play:</td>
</tr>
<tr>
<td></td>
<td>• Quad or Nine Split: Allows playback in the Source monitor of all camera angles in either quad split view or nine split view.</td>
</tr>
<tr>
<td></td>
<td>• Fullscreen: Allows playback in the Source monitor of real-time effects for the active camera angle, which displays in full-monitor size.</td>
</tr>
<tr>
<td>MultiCam Mode</td>
<td>Controls client monitor display with MultiCam:</td>
</tr>
<tr>
<td>Client Monitor</td>
<td>• Off: Disables the client monitor during playback of group clips and multigroup clips.</td>
</tr>
<tr>
<td></td>
<td>• Quad or Nine Split: Allows the client monitor to display group clips and multigroup clips during playback.</td>
</tr>
<tr>
<td></td>
<td>• Linecut: Allows a linecut (a playback of the edited multicamera sequence) to display in the client monitor.</td>
</tr>
</tbody>
</table>

The client monitor displays only SD multicamera linecuts. You can view playback of HD multicamera sequences in the Source monitor only.
Controller Settings

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Controller</td>
<td>Defines the controller to use. Select one of the following:</td>
</tr>
<tr>
<td></td>
<td>• No Controller</td>
</tr>
<tr>
<td></td>
<td>• JL Cooper MCS3 Controller</td>
</tr>
<tr>
<td></td>
<td>• 002 Controller</td>
</tr>
<tr>
<td></td>
<td>• Command</td>
</tr>
<tr>
<td>Port</td>
<td>Defines the port you use to connect your controller.</td>
</tr>
<tr>
<td>Edit Settings</td>
<td>If you have selected a port and controller, select this option to map the controller functions.</td>
</tr>
<tr>
<td>Gain Controller</td>
<td>Defines a port for a fader or a mixer to record audio gain information. The options on this menu differ depending on the ports you have configured on your Avid editing application.</td>
</tr>
</tbody>
</table>

Correction Settings

For more information, see “Customizing Color Correction Mode Settings” in the Help.
### Correction Settings: Features Tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Saved Color Labels</td>
<td>Controls how custom colors are named in bins:</td>
</tr>
<tr>
<td></td>
<td>• None: When this option is selected, your Avid editing application does not supply a name.</td>
</tr>
<tr>
<td></td>
<td>• RGB: When this option is selected, your Avid editing application uses the 8-bit values for the red, green, and blue components as the name.</td>
</tr>
<tr>
<td></td>
<td>• Name: When this option is selected, your Avid editing application uses the name from the standard HTML color scheme that most closely matches the color you are saving.</td>
</tr>
<tr>
<td></td>
<td>• Name and RGB: When this option is selected, your Avid editing application uses both the Name and the RGB information as the name. This is the default option.</td>
</tr>
<tr>
<td></td>
<td>For information on saving custom colors, see “Assigning Colors to Objects in a Bin” on page 357.</td>
</tr>
<tr>
<td>Eyedropper 3 x 3 Averaging</td>
<td>When this option is selected, your Avid editing application calculates the color value to pick by averaging the values of a 3 x 3 sample of pixels centered on the eyedropper’s position. This is often useful for picking up a color accurately by sight because it compensates for shifts in color value from one pixel to another. When this option is deselected, your Avid editing application selects the color value of the exact pixel at the eyedropper’s position.</td>
</tr>
<tr>
<td>Show Eyedropper Info</td>
<td>When this option is selected, the numerical RGB values appear on the color swatches in the Color Match controls.</td>
</tr>
<tr>
<td>Eyedropper Picks from Anywhere in Application</td>
<td>When this option is selected, you can pick colors from anywhere in your Avid editing application, not only from video images in the Source/Record monitor, using the Color Match eyedroppers.</td>
</tr>
</tbody>
</table>
Correction Settings: AutoCorrect Tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>When applying Color correction from the Effect Palette, perform the following operations:</td>
<td>Defines the first, second, and third automatic color correction that your Avid editing application makes when you apply the Color Correction effect from the Effect Palette:</td>
</tr>
<tr>
<td>- Nothing: Makes no adjustment. For example, if you only want to make two automatic corrections when you drag the Color Correction effect from the Effect Palette, set the Third Correction menu in the AutoCorrect tab to Nothing.</td>
<td></td>
</tr>
<tr>
<td>- HSL Auto Balance: Makes adjustments to the three ChromaWheels to balance the colors in the image. This is the equivalent of clicking the Auto Balance button in the Hue Offsets subdividing tab of the HSL tab.</td>
<td></td>
</tr>
<tr>
<td>- HSL Auto Black: Adjusts the Setup slider in the Hue Offsets subdividing tab of the HSL tab to make the darkest areas of the image as dark as possible. This is the equivalent of clicking the Auto Black button in the Hue Offsets subdividing tab of the HSL tab.</td>
<td></td>
</tr>
<tr>
<td>- HSL Auto Contrast: Adjusts the Gain and Setup sliders in the Hue Offsets subdividing tab of the HSL tab to maximize the tonal range in the image. This is the equivalent of clicking the Auto Contrast button in the Hue Offsets subdividing tab of the HSL tab.</td>
<td></td>
</tr>
<tr>
<td>- HSL Auto White: Adjusts the Gain slider in the Hue Offsets subdividing tab of the HSL tab to make the brightest areas of the image as bright as possible. This is the equivalent of clicking the Auto White button in the Hue Offsets subdividing tab of the HSL tab.</td>
<td></td>
</tr>
<tr>
<td>- Curves Auto Balance: Makes adjustments to the Red, Green, and Blue curves to balance the colors in the image. This is the equivalent of clicking the Auto Balance button in the Curves tab.</td>
<td></td>
</tr>
<tr>
<td>- Curves Auto Contrast: Makes an adjustment to the Master curve to maximize the tonal range in the image. This is the equivalent of clicking the Auto Contrast button in the Curves tab.</td>
<td></td>
</tr>
</tbody>
</table>

Deck Configuration Settings

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration name</td>
<td>Type a name for the configuration.</td>
</tr>
<tr>
<td>Add channel</td>
<td>Click to add a new channel box. Opens the Channel dialog box.</td>
</tr>
</tbody>
</table>
You can access the Deck Settings dialog box in any of the following ways:

- Click the Add Deck button in the Deck Configuration dialog box.
- In the deck controller section of the Capture tool, click the Deck Selection menu, and select Adjust Deck.
- Double-click the deck name in the Deck Settings dialog box.

**Deck Settings**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add deck</td>
<td>Click to add a deck or DV device. Opens the Deck Settings dialog box. For information on the Deck Settings options, see “Deck Settings” on page 1461.</td>
</tr>
<tr>
<td>Delete</td>
<td>Click to delete a deck or DV device.</td>
</tr>
<tr>
<td>Auto-configure</td>
<td>When this option is selected, and with a deck or DV device already connected to your Avid editing application, your Avid editing application bypasses the Deck Settings dialog box and automatically configures a deck or DV device with the default settings. Because some DV devices do not respond to the Auto-configure command, Auto-configure selects only the generic device settings for a DV device.</td>
</tr>
<tr>
<td>Verify configuration against actual decks</td>
<td>When this option is selected, your Avid editing application checks the deck configuration against the devices physically connected to the system.</td>
</tr>
</tbody>
</table>

**Option**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Defines a custom name for the tape deck. The default name matches the deck type.</td>
</tr>
<tr>
<td>Description</td>
<td>Defines notes about the deck.</td>
</tr>
<tr>
<td>Notes</td>
<td>Displays configuration information, supplied by Avid, about the deck or DV device you have selected. Not all decks or devices include this information. You can supply your own information in the Description field, and then save the configuration.</td>
</tr>
<tr>
<td>Device</td>
<td>Defines the device manufacturer and model.</td>
</tr>
<tr>
<td>Address</td>
<td>For VLXi use only. See your VLXi documentation. If you are using direct serial port deck control, this option is unavailable.</td>
</tr>
</tbody>
</table>
### Show Preferences Settings

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show</td>
<td>Filters the devices that display in the Device menu:</td>
</tr>
<tr>
<td></td>
<td>- All Devices: Displays all devices by manufacturer and model.</td>
</tr>
<tr>
<td></td>
<td>- Decks: Displays only decks by manufacturer and model.</td>
</tr>
<tr>
<td></td>
<td>- Transcoders: Displays only transcoders by manufacturer and model.</td>
</tr>
</tbody>
</table>

### Preroll

Defines how many seconds the tape rolls before capture or digital cut starts. The default is based on the type of videotape recorder (VTR).

### Fast Cue

Speeds up long searches if your decks can read timecode in fast forward or rewind mode. Select one of the following options:

- **Switch to ff/rew (seconds):** \( n \): When this option is selected, your Avid editing application switches to fast forward or rewind if the target timecode is beyond the specified number of seconds from your current location on the tape.

  By default, the deck switches to fast forward or rewind to reach a target timecode that is more than 60 seconds away.

  If your deck shuttles very quickly, you can increase this number so that your Avid editing application uses fast cue only for long searches.

- **Switch to Search (seconds):** \( n \): When this option is selected, your Avid editing application switches out of fast forward or rewind when it is within the specified number of seconds of the target timecode. By default, your Avid editing application switches to search mode when it is 60 seconds from the target timecode.

---

### Option Description

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>When the deck contains no tape or drop frame cannot be detected set timecode to</td>
<td>Sets the timecode format (Drop Frame or Non-drop Frame) for logging clips when no tape is in the deck or when your Avid editing application cannot detect drop frame or non-drop frame. When a tape is in the deck, your Avid editing application automatically uses the existing timecode format on the tape. For more information, see “Understanding Timecode” on page 192.</td>
</tr>
</tbody>
</table>
### Deck Preferences Settings

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow assemble edit &amp; crash record for digital cut</td>
<td>When this option is selected, you can use the assemble-edit and crash-record features in the Digital Cut tool, along with the assemble-editing and manual recording capabilities of your record deck. Select this option to record frame-accurate digital cuts quickly and without striping entire tapes in advance while using the assemble edit feature. Select this option also if you want to operate the deck manually. For more information about digital cuts and assemble editing, see “Generating Output” on page 1054. For information about crash recording, see “Crash Recording Through Remote Deck Control” on page 1085.</td>
</tr>
<tr>
<td>Stop key pauses deck</td>
<td>Defines the function of the Stop key (space bar) on the keyboard. Select this option to map the space bar to the Pause button on the deck. Deselect this option to map the space bar to the Stop button. If the videotape heads are down in “Stop key pauses deck” mode, pressing the space bar brings up the heads and pauses the deck. The Stop button in the Capture tool always stops the decks.</td>
</tr>
<tr>
<td>Shuttle holds speed</td>
<td>When this option is selected, the Shuttle button continues shuttling at a constant speed instead of stopping when you release it.</td>
</tr>
<tr>
<td>Stop any paused decks when quitting</td>
<td>When this option is selected, any paused decks stop when you quit your Avid editing application. Selecting this option saves wear on the deck heads.</td>
</tr>
<tr>
<td>Poll deck during digital cut</td>
<td>When this option is selected, your Avid editing application checks the deck for the current timecode and displays it in the timecode window of the deck controller. If you see degraded image quality on your digital cut (particularly visible as noise during black), deselect this option and record the digital cut again. When this option is deselected, the Record button does not flash and the timecode display in the deck controller does not update for the duration of the digital cut.</td>
</tr>
</tbody>
</table>
| Host-1394 DV Capture Offset & Digital Cut Offset (when Host 1394 capture is available) | This group of options varies depending on your DV input/output configuration.  
- Capture Offset (frames): Defines the number of frames by which you want to offset while you capture. For more information, see “Understanding DV Capture Offset” on page 243.  
- Overlay Recommended Digital Cut Offset: Defines a digital cut delay. For more information, see “Understanding DV Digital Cut Delay” on page 1098. |
| Digital Cut Offset (when Host 1394 capture is not available) |                                                                                                                                             |
| Relax coincidence point detection           | This option is off by default. Depending on the deck, device control hardware or system you are using, marking an In point in the Capture Tool and performing a capture can result in a “coincidence point detection error.” If you select this option, the editing application is less strict on finding the coincidence point. Note, relaxing the detection can allow captures to succeed but has a greater possibility of capturing from the wrong in-point. |
Desktop Play Delay

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frames</td>
<td>Click the Desktop Play Delay Frames slider to increase or decrease the amount of frame offset. You might need to readjust the frames a few times to find the correct offset. For more information, see “Adjusting the Play Delay Offset” on page 528.</td>
</tr>
</tbody>
</table>

Dynamic Relink Settings

Dynamic Relink is available only on Avid editing systems that have the Avid Interplay Media Indexer installed.

<table>
<thead>
<tr>
<th>Dialog Box Area</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top area</td>
<td>Enable Dynamic Relink</td>
<td>Turns the dynamic relink feature on or off. When this option is selected, your Avid editing application performs a dynamic relink whenever you load clips into the source monitor or the Timeline. When this option is deselected, no settings are available. When you select this option again, your Avid editing application restores the previous settings.</td>
</tr>
<tr>
<td>Allow Mixed Frame Rate Media</td>
<td>Lets you use dynamic relink with mixed rate clips. When this option is selected, your Avid editing application tries to link your clips to media with the appropriate frame rate. If it cannot find any media with a compatible frame rate, your Avid editing application uses the lowest and nearest resolution to your project frame rate. For more information, see “Using Dynamic Relink with Mixed Rate Clips” on page 1354.</td>
<td></td>
</tr>
<tr>
<td>Override Working Settings with Target Settings</td>
<td>Lets you perform a dynamic relink to the target settings. When this option is selected, the working settings are not available but the target settings remain active and modifiable. In the Timeline and monitors, you see media that matches the target settings. For more information, see “Dynamically Relinking to the Target Settings” on page 1353.</td>
<td></td>
</tr>
</tbody>
</table>
### Dynamic Relink Settings

#### Dialog Box Area | Option | Description (Continued)
--- | --- | ---
Working settings tab and Target settings tab | If no match is found | Defines the action to take if no media is available that matches the working or target settings. You can select one option as a working setting and a different option as a target setting. Select one of the following:
- Keep Existing Media: Your Avid editing application displays the media to which the clips are currently linked.
- Relink to Offline: Your Avid editing application displays a “Media Offline” slide in the monitors. Relinking to offline does not delete existing media.
- Use Closest Media: Your Avid editing application displays the media that most closely matches the working or target settings. For example, this might be useful when you are editing progressive media into a sequence that contains both progressive and interlaced media.

For information about enabling a visual display of which media is available, see “Displaying Whether Media Is Available for Dynamic Relinking” on page 1356.

Video Parameters | Target format | (Target settings only) Defines the project format for your target settings, which determines the resolutions that are available in the Dynamic Relink target settings. You can set this format independently of the format set in the Format tab of the Project window.

Relink Method | | Defines how your Avid editing application dynamically relinks to video material. Select one of the following: Most Recent (the latest media files created), Highest Quality, Most Compressed, or Specific Resolution.
# Dynamic Relink Settings

<table>
<thead>
<tr>
<th>Dialog Box Area</th>
<th>Option</th>
<th>Description (Continued)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Relink if quality</td>
<td>Available when Specific Resolution is the Relink method. Defines a relational operator and a resolution to compare against. Select one of the following relational operators:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Greater than or equal to: If the selected resolution is not available, your Avid editing application uses the nearest resolution that is better (more pixels, less compression) than the requested one and that has the closest video format (image size, field topness). If none of the available resolutions satisfy these criteria, the clip displays as specified in the “If no match is found” list: Keep Existing Media, Relink to Offline, or Use Closest Media.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Equal to: If the selected resolution is not available, the clip displays as specified in the “If no match is found” list.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Less than or equal to: If the selected resolution is not available, your Avid editing application uses the nearest resolution that is less (fewer pixels, more compression) than the requested one and that has the closest video format (image size, field topness). If none of the available resolutions satisfy these criteria, the clip displays as specified in the “If no match is found” list.</td>
</tr>
<tr>
<td></td>
<td>Preferred media format</td>
<td>Defines your preferred media type as either AMA or native media. When “Use Closest Media” is selected and Prefer AMA media is selected, the system will try to relink to AMA media first. If AMA media is not found, it will try and relink to the native media. If Prefer native media is selected, the system will try and relink to native media first.</td>
</tr>
<tr>
<td>Audio Parameters</td>
<td>Relink method</td>
<td>Defines the relink option for relinking to audio material. Select one of the following: Most Recent (the latest media files created), Highest Sample Rate, Highest Bit Depth, Compressed, or Specific Quality.</td>
</tr>
</tbody>
</table>

> Compressed audio through the Avid Encoder IPV is always 48 kHz and 16 bit. No other selections are available.
The Effect Editor settings and the commands in the Effect Editor shortcut menu are similar but not identical.

<table>
<thead>
<tr>
<th>Dialog Box Area</th>
<th>Option</th>
<th>Description (Continued)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Relink if sample rate and bit depth</td>
<td>The relational operators on the left for sample rate and bit depth are similar to the relational operators for the Video parameter “Relink if quality” menu. However, the two menus have an additional entry, “Any,” which lets you use one criteria and ignore the other. For example, you could select sample rate equal to 44.1 kHz and bit depth to “Any.” The corresponding menus on the right contain values appropriate to the corresponding quality parameter. The sample rate and bit depth relational operators work as a Boolean AND operation (that is, the intersection of all constraints). These are not available if you select “Any.”</td>
<td></td>
</tr>
<tr>
<td>Compression</td>
<td>Lets you choose “uncompressed only” or “any,” which lets you use one criteria and ignore the other. Your Avid editing application chooses the best media available.</td>
<td></td>
</tr>
<tr>
<td>Preferred media type</td>
<td>Defines your first choice of media format: PCM (MXF) or Any (OMF or MXF).</td>
<td></td>
</tr>
</tbody>
</table>

**Effect Editor Settings**

The Effect Editor settings and the commands in the Effect Editor shortcut menu are similar but not identical.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Indent Rows</td>
<td>When this option is selected, parameter rows are indented from the parameter group row, and any parameter subgroups are indented again. When this option is deselected, the left edges of parameter rows line up with the parameter group row.</td>
</tr>
<tr>
<td>Large Text</td>
<td>When this option is selected, text in the Effect Editor appears in 12-point size. When this option is deselected, text in the Effect Editor appears in the default size, 10 points (Windows) or 9 points (Macintosh).</td>
</tr>
<tr>
<td>Thumbwheels</td>
<td>When this option is deselected, variable controls in the Effect Editor appear as the default sliders. When this option is selected, variable controls appear as thumbwheels. For information on using thumbwheels, see “Changing a Parameter with a Slider in the Effect Editor” in the Help.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Real Time Update</td>
<td>When this option is selected, your Avid editing application updates the rendered effect image in real time. Because the update can be slow for complex effects, you have the option to deselect real-time updating.</td>
</tr>
<tr>
<td>Set Position To Keyframe</td>
<td>When this option is selected, your Avid editing application moves the position indicator to the keyframe when you click a keyframe indicator. When this option is deselected, the position indicator does not move when you click a keyframe indicator. Deselecting this option lets you align a keyframe to the position indicator. For more information, see &quot;Aligning Advanced Keyframes&quot; in the Help.</td>
</tr>
<tr>
<td>Update Position While Playing</td>
<td>When this option is selected, the position indicator in the Effect Editor moves while you play the effect. Because this option can cause video underrun problems in complex real-time effects, it is deselected by default.</td>
</tr>
<tr>
<td>Show Add Keyframe Mode Menu</td>
<td>When this option is selected, the Add Keyframe Mode menu (or the Delete Keyframe Mode menu) appears when you use the Add Keyframe button to add (or delete) keyframes. For more information, see &quot;Keyframe Mode Menu Commands&quot; in the Help.</td>
</tr>
<tr>
<td></td>
<td>When this option is deselected, the Add Keyframe button performs the default command from the following list (Add Keyframe button commands), without displaying the Add Keyframe Mode menu or the Delete Keyframe Mode menu.</td>
</tr>
<tr>
<td>Add Keyframe button commands</td>
<td>Defines the default command for the Add Keyframe button.</td>
</tr>
<tr>
<td>• Add Keyframe To Active Parameter</td>
<td>When Show Add Keyframe Mode Menu is deselected, clicking the Add Keyframe button once performs the default command.</td>
</tr>
<tr>
<td>• Add Keyframes To Active Group</td>
<td>When Show Add Keyframe Mode Menu is selected, clicking the Add Keyframe button twice performs the default command. (The first click displays the Add Keyframe Mode menu, at which point you can select another command.)</td>
</tr>
<tr>
<td>• Add Keyframes To Open Groups</td>
<td>For a description of each command, see “Keyframe Mode Menu Commands” in the Help.</td>
</tr>
<tr>
<td>• Add Keyframes To Enabled Groups</td>
<td><em>The Add Keyframe Mode menu and the Delete Keyframe Mode menu mirror one another. When you change one, you change both.</em></td>
</tr>
<tr>
<td>• Add Keyframes To Open Graphs</td>
<td></td>
</tr>
<tr>
<td>• Add Keyframes To All Parameters</td>
<td></td>
</tr>
</tbody>
</table>
E-mail Settings

The Email Settings dialog box lets you configure your Avid editing application so that it can notify you by e-mail when any of the following operations completes:

- Render
- Export
- Consolidate or Transcode

*Some mobile telephone services can deliver e-mail as a text message or notify you by text message when an e-mail has been received. If your service includes this feature, consider using it as a convenient way to receive your notifications.*

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server Settings</td>
<td>Use the options in this area to define the server settings that your Avid editing application uses to communicate with your e-mail account and send e-mail notifications. Check the documentation for your e-mail application, or talk to your internet service provider or information technology department, to obtain the information you need to define these settings correctly. Your e-mail account must use the SMTP protocol for outgoing mail.</td>
</tr>
<tr>
<td>SMTP Server</td>
<td>Defines the SMTP (outgoing mail) server address for your e-mail account. Typically, this address has one of the following formats: smtp.service_name.com or smtp.mail.service_name.com.</td>
</tr>
<tr>
<td>Port</td>
<td>Defines the port that the SMTP server uses. The default value, 25, is used by several common e-mail services, but your server might require a different port number.</td>
</tr>
<tr>
<td>Authenticate with username/password</td>
<td>When this option is selected, your Avid editing application includes username and password information to authenticate any e-mail it sends. Type the username and password for your e-mail account in the Username and Password text boxes. Some e-mail services require authentication as a security measure.</td>
</tr>
<tr>
<td>Store password after closing project</td>
<td>When this option is selected, your Avid editing application saves the password in the Password text box when the current project closes. This eliminates the need to re-enter the password each time you open a project.</td>
</tr>
<tr>
<td>Use SSL</td>
<td>When this option is selected, your Avid editing application uses the Secure Sockets Layer (SSL) security protocol when sending e-mail notifications. Some e-mail services require this as a security measure.</td>
</tr>
</tbody>
</table>
### Export Settings

**Common Export Settings**

**Standard Formats for Export**

The following table describes the standard Export file formats available in the Export As menu of the Export Settings dialog box.

You can also Export to P2 cards or XDCAM disks. For more information, see “Export Settings: P2” on page 1493 and “Export Settings: XDCAM” on page 1494.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Name</td>
<td>Defines the name that appears in the From header field of an e-mail your Avid editing application sends.</td>
</tr>
<tr>
<td>From Address</td>
<td>Defines the e-mail address for the account that your Avid editing application uses to send the e-mail.</td>
</tr>
<tr>
<td>To Address</td>
<td>Defines the e-mail address to which your Avid editing application sends the e-mail.</td>
</tr>
</tbody>
</table>
| Send Email Events | When you select one or more options, your Avid editing application sends an e-mail notification when the following operation completes:  
  • Render Complete  
  • Export Complete  
  • Consolidate or Transcode Complete  
  You must have the Server Settings and Email Settings options configured correctly, and the Enable Sending of Email option selected. |

Master Email Control

Enable Sending of Email  
When this option is selected, your Avid editing application is able to send email notifications.

Send Test Email  
Click this button to send a test email using the current Server Settings and Email Settings options.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OMFI 1.0</td>
<td>When this option is selected, your Avid editing application exports a standard OMFI composition for transfer to a third-party workstation that supports OMFI. You can choose to export composition only, or embed the video and audio, or both. For more information, see “Guidelines for Exporting OMFI and AAF Files” on page 1033.</td>
</tr>
<tr>
<td>OMFI 2.0</td>
<td>★★★★★</td>
</tr>
<tr>
<td>AAF</td>
<td>When this option is selected, your application creates an Advanced Authoring Format (AAF) file. You can choose to export composition only, or embed the video and audio, or both. For more information, see “Guidelines for Exporting OMFI and AAF Files” on page 1033.</td>
</tr>
<tr>
<td>AFE (Windows only)</td>
<td>When this option is selected, your Avid editing application exports as AFE. This format is compatible with systems such as Avid DS. For more information, see “Exporting Projects and Bins Using AFE Files (Windows Only)” on page 1036.</td>
</tr>
<tr>
<td>QuickTime Reference</td>
<td>When this option is selected, your Avid editing application creates a QuickTime reference movie. A QuickTime reference movie contains pointers (links) to movie files. This is similar to exporting as composition only. You can also export LongGOP QuickTime Reference movies with this option. For more information, see “Exporting QuickTime Movies” on page 1038.</td>
</tr>
<tr>
<td>HDV</td>
<td>When this option is selected, your Avid editing application creates a transport stream. For more information, see “Exporting an HDV Transport Stream” on page 1620.</td>
</tr>
<tr>
<td>XDCAM MXF OP1a Video Format</td>
<td>Lists all XDCAM codecs supported by your project type.</td>
</tr>
<tr>
<td></td>
<td>Audio Bit Depth: Defines bit depth, based on the sample rates supported by your project type. You can use this option if your sequence has a mix of sample rates and you need to create a single sample rate. (You set the project rate in the Audio Project Settings dialog box.</td>
</tr>
<tr>
<td></td>
<td>Aspect Ratio: Defines an image size for the video you want to export. The available aspect ratios depend on what your project type and device support. This lets you control the display format without modifying the source file.</td>
</tr>
<tr>
<td>DV Stream</td>
<td>When this option is selected, your Avid editing application creates a standard DV stream. The DV Stream format is often used for distribution on a CD-ROM or over the Web. Use this option when exporting video that will be combined or processed with other DV-formatted media. This option requires a video track.</td>
</tr>
</tbody>
</table>

The DV Stream format appears after you install QuickTime. If you want to use QuickTime for exporting sequences, download the latest version of QuickTime from the Apple® Web site at: www.apple.com/.
### Export Settings

#### Option Description

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>QuickTime Movie</td>
<td>When this option is selected, your Avid editing application creates a self-contained QuickTime movie. For more information, see “Exporting QuickTime Movies” on page 1038. If you install additional QuickTime Export formats, they appear in the menu with tildes (~) before their names. This indicates they are not qualified or supported by Avid.</td>
</tr>
<tr>
<td>AVI</td>
<td>When this option is selected, your application exports an AVI file through QuickTime or other compression tools. For more information, see “Export Settings: AVI Through QuickTime” on page 1484.</td>
</tr>
<tr>
<td>Windows Media (Windows only)</td>
<td>When this option is selected, your Avid editing application exports your sequence as native Windows Media. You can export your media using one of the Avid-supplied templates or using a custom audio and video template. For more information, see “Exporting as Windows Media (Windows Only)” on page 1043.</td>
</tr>
<tr>
<td>Audio</td>
<td>When this option is selected, your Avid editing application exports audio tracks in the WAVE format, SD II (Macintosh only), or AIFF-C audio format. For more information, see “Export Settings: Audio” on page 1489.</td>
</tr>
<tr>
<td>Graphic</td>
<td>When this option is selected, your Avid editing application exports a single frame, a series of frames, or a file type that supports multiple frames as a graphic file. Select a file type from the menu. For information about supported file types, see “File Format Specifications” on page 1540.</td>
</tr>
<tr>
<td>Avid Log Exchange</td>
<td>When this option is selected, your Avid editing application exports the selected bin as a shot log file that complies with Avid Log Exchange (ALE) specifications. ALE and tab-delimited files include information for master clips and subclips only. Information for other objects, such as group clips, sequences, and precomputes, is not included.</td>
</tr>
<tr>
<td>Tab Delimited</td>
<td>When this option is selected, your Avid editing application exports the selected bin as a shot log file in the form of a tab-delimited ASCII text file.</td>
</tr>
</tbody>
</table>

#### Use Marks and Use Enabled Tracks Options

The following table describes options that determine which material in the selected clip or sequence your Avid editing application exports.
### Export Settings: OMFI, AAF, and AFE

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Export As:</td>
<td>Defines the export format:</td>
</tr>
<tr>
<td></td>
<td>- AAF: Select this option if the application to which you are exporting supports AAF</td>
</tr>
<tr>
<td></td>
<td>- OMF 1.0: Select this option if the application to which you are exporting does not support OMFI Version 2.0</td>
</tr>
<tr>
<td></td>
<td>- OMF 2.0: Select this option if the application to which you are exporting supports OMFI Version 2.0. If you are not sure, select OMF 1.0.</td>
</tr>
<tr>
<td></td>
<td>- AFE (Windows only): Select this option if the application to which you are exporting supports AFE</td>
</tr>
<tr>
<td></td>
<td>There are no options available to you when you select AFE. Your Avid editing application uses the default settings.</td>
</tr>
<tr>
<td>Use Marks, Use Enabled Tracks</td>
<td>See “Use Marks and Use Enabled Tracks Options” on page 1472.</td>
</tr>
<tr>
<td>AAF Edit Protocol</td>
<td>When you select this option, exported AAF files are AAF Edit Protocol compliant. The AAF Edit Protocol specification supports interchange of metadata that describes edit decisions, audio and visual effects, and embedded non-AAF files. This option only appears when Export As is set to AAF.</td>
</tr>
<tr>
<td></td>
<td>AAF Edit Protocol exported files can exceed the 2GB size limit. AAF Edit Protocol compliant files are not compatible with Pro Tools v7.1 and earlier.</td>
</tr>
<tr>
<td>Include All Video/Data Tracks</td>
<td>When you select this option, the Video Details tab appears, and your Avid editing application includes all video and data tracks from the sequence in the AAF or OMFI file.</td>
</tr>
<tr>
<td>in Sequence</td>
<td></td>
</tr>
<tr>
<td>Include All Audio Tracks in</td>
<td>When you select this option, the Audio Details tab appears, and your Avid editing application includes all audio tracks from the sequence in the AAF or the OMFI file.</td>
</tr>
<tr>
<td>Sequence</td>
<td></td>
</tr>
</tbody>
</table>
The following options appear in the Video Details tab, the Audio Details tab, or both, depending on the export method:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Export Method:</td>
<td>Defines an export method. Other options change depending on which method you choose. This option appears in both the Video Details tab and the Audio Details tab.</td>
</tr>
<tr>
<td></td>
<td>• Link to (Don’t Export) Media: Select this option when you want to export an AAF or an OMFI composition with links to the media in its current location. Your Avid editing application does not embed media in the file or export media.</td>
</tr>
<tr>
<td></td>
<td>• Copy All Media: Select this option when you want to copy media to another drive or folder and export an AAF or an OMFI composition</td>
</tr>
<tr>
<td></td>
<td>• Consolidate Media: Select this option when you want to export an AAF or an OMFI composition with links to media that you have consolidated. For more information, see “Consolidating Media” on page 477.</td>
</tr>
<tr>
<td></td>
<td>Use the Handle Length: ( nn ) Frames text box to enter the number of frames you want to use as handles for consolidated clips. Handles refer to material outside the IN and OUT points that is used for dissolves and trims with the new, shorter master clips. The default is 60.</td>
</tr>
<tr>
<td>Export Method:</td>
<td>Creates a new video mixdown track for the sequence. For more information, see “Performing a Video Mixdown” in the Help.</td>
</tr>
<tr>
<td>Video Mixdown</td>
<td>• Mixdown with Video Edits: Creates a mixdown compatible with Avid Pro Tools v7.2 or later</td>
</tr>
<tr>
<td></td>
<td>• Mixdown without Video Edits: Creates a mixdown compatible with all Avid Pro Tools versions</td>
</tr>
<tr>
<td>Render Video Effects</td>
<td>When you select this option, your Avid editing application renders video effects during export.</td>
</tr>
<tr>
<td>Transcode Video to:</td>
<td>Defines the resolution to which you want to transcode the video to during export.</td>
</tr>
<tr>
<td>Include Rendered Audio Effects</td>
<td>When you select this option, your Avid editing application includes rendered audio effects during export.</td>
</tr>
<tr>
<td>Render All Audio Effects</td>
<td>When you select this option, your Avid editing application renders all audio effects during export.</td>
</tr>
<tr>
<td>Remove Track Effects</td>
<td>Selecting this option removes all audio track effects — for example, Audio Track effects — during export. This option is selected by default.</td>
</tr>
<tr>
<td>Split Tracks to Mono</td>
<td>Selecting this option splits all multichannel audio tracks to separate mono tracks. For more information, see “Splitting Multichannel Tracks to Mono Tracks” on page 840. This option is selected by default.</td>
</tr>
</tbody>
</table>
Add Audio Mixdown Track(s)

When you select this option, your Avid editing application adds an audio mixdown track. Select the type of track you want, either Mono or Stereo. For more information about audio mixing, see “Using Live Mix Mode” on page 826.

Convert Audio Sample Rate to:

Defines the audio sample rate for the export. Select this option if your sequence has a mix of sample rates and you need to create a single sample rate. (You set the project rate in the Audio Project Settings window. For more information, see “Audio Multiple Mix Settings” on page 1444.) You can also use this option to change the sample rate if the application to which you are exporting does not support the current sample rate.

Depending on your system, the following suboptions are available: Project rate, 32 kHz, 44.1 kHz, 48 kHz, 88.2 kHz, 96 kHz.

Convert Audio Bit Depth to:

Defines the audio bit rate for the export. Select this option if your sequence has a mix of bit depths and you need to create a single bit depth. (You set the project bit depth in the Audio Project Settings window. For more information see “Audio Multiple Mix Settings” on page 1444.) You can also use this option to change the bit depth if the application to which you are exporting does not support the current bit depth.

The following suboptions are available: Project rate, 16 bit, and 24 bit.

Convert Audio File Format to:

Defines the audio format for the export. If your sequence has a mix of audio file formats, and you want to embed media, you must choose a single audio file format. (You set the project format in the Audio Project Settings window. For more information, see “Audio Multiple Mix Settings” on page 1444.) This choice is optional if you want to consolidate and link media.

The following suboptions are available:

- Project rate: Select this option to use the rate that matches the project format
- WAVE: Select this option to link to or embed audio tracks in the WAVE format (.WAV file name extension). Most Windows applications that support sound use WAVE files. QuickTime also supports the WAVE format.
- AIFF-C: Select AIFF-C to link to or embed audio tracks in the industry-standard AIFF-C format. Note that your Avid editing application does not compress audio media.
- PCM: This is the only audio file format available for AAF export

The following options appear in the Media Destinations area for Video and Audio, depending on the export methods:

Media Drive

Defines a destination media drive for newly created or copied media.

When Use Media Creation Settings is selected, your Avid editing application uses the drive you selected in the Media Creation dialog box. If you deselect Use Media Creation Settings, you can select a different destination drive.
**Export Settings: QuickTime Reference Options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use Marks, Use Enabled Tracks</td>
<td>See “Use Marks and Use Enabled Tracks Options” on page 1472.</td>
</tr>
<tr>
<td>Fast Draft Defaults</td>
<td>When this option is selected, export is faster. This option automatically selects Flatten Video Tracks and Fill Spaces with Black, and automatically deselects Render All Video Effects and Premix Audio Tracks.</td>
</tr>
<tr>
<td>Digital Mastering Defaults</td>
<td>When this option is selected, your Avid editing application renders all video effects and premixes audio tracks before exporting the file. This option automatically selects Flatten Video Tracks, Fill Spaces with Black, Render All Video Effects, and Premix Audio Tracks.</td>
</tr>
<tr>
<td>Flatten Video Tracks</td>
<td>When this option is selected, your Avid editing application exports the composition as one video track. When this option is deselected, your Avid editing application generates one QuickTime video track for each video track in the composition, and you cannot select Fill Spaces with Black. Because most third-party applications do not understand multiple QuickTime video tracks, it is a good idea to select this option. This option is automatically selected if you select Fast Draft Defaults and Digital Mastering Defaults.</td>
</tr>
<tr>
<td>Fill Spaces with Black</td>
<td>When this option is selected, your Avid editing application fills blank spaces in video tracks with black in the QuickTime reference movie. Because QuickTime reference movies do not recognize blank spaces, it is a good idea to select this option. When this option is deselected, a QuickTime reference movie might interpret spaces in the video track as gray or as the background of the player. This option is automatically selected if you select Fast Draft Defaults and Digital Mastering Defaults.</td>
</tr>
<tr>
<td>Render All Video Effects</td>
<td>When this option is selected, your Avid editing application renders all unrendered video effects, including matte keys and titles, before export. When this option is deselected, your Avid editing application ignores any unrendered effects. This option is automatically selected if you select Digital Mastering Defaults.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Display Aspect Ratio</td>
<td>Defines an image size for the video you want to export: Native, 4:3, or 16:9. This lets you control the display format without modifying the source file. This option creates metadata that is stored with the QuickTime movie. Some applications, such as the QuickTime Player, can interpret this metadata and scale the image at display time. This option is useful for QuickTime reference movies because you do not modify the source files of referenced movies. For example, you can create two different QuickTime reference movies with different display aspect ratios that use the same referenced source files. The menu selections depend on how you open the Export Settings dialog box and whether you have done a prior export.</td>
</tr>
<tr>
<td>Mixdown Audio Tracks</td>
<td>When this option is selected, your Avid editing application mixes the audio tracks in the composition to stereo files that it creates at the same location as the movie. When this option is deselected, the Quick Time Reference movie references the original audio media. This option is selected automatically if you select Digital Mastering Defaults. If you select this option, you can also select an audio format, a sample rate, and a bit depth.</td>
</tr>
</tbody>
</table>
| Audio Format           | Defines the audio format. Select the format that is supported by the application into which you will be importing the QuickTime reference movie.  
  - WAVE: Compatible with Windows applications.  
  - AIFF-C: Compatible with many third-party applications, including Pro Tools.  
Select AIFF-C for all audio media files you plan to transfer directly to a Pro Tools or an AudioVision® system for sweetening. |
| Sample Rate            | Defines the audio sample rate for the export, either Project Rate, 32 kHz, 44.1 kHz, or 48 kHz.  
You can use this option if your sequence has a mix of sample rates and you need to create a single sample rate. (You set the project rate in the Audio Project Settings dialog box. For more information, see “Audio Project Settings for Capture” on page 207.) You can also use this option to change the sample rate if the application to which you are exporting does not support the current sample rate. |
| Bit Depth              | Defines the audio bit depth for the export, either 16 bit or 24 bit. |
| Use Network Media References | When this option is selected, the exported movie uses the machine and drive share name of the media drive in the QuickTime reference movie instead of a drive letter. Select this option when the media files referenced by the movie are accessed remotely over the network. If the media files are stored on the same drive as the QuickTime reference movie, you do not need to select this option. When this option is deselected, you cannot select Add Shares for Media Drives. |
Export Settings

Option | Description
--- | ---
Add Shares for Media Drives | When this option is selected, your Avid editing application creates a new drive share for referenced media files stored on unshared network drives. The drive share is hidden, so other users do not see the shared drive when browsing your computer. You do not need to select this option when media is stored on the same drive as the QuickTime reference movie.

Use Avid DV Codec | Deselect this option when you are working in a cooperative environment where one or more non-Avid systems also have access to the media. This option is selected by default. Select this option if the non-Avid systems have the Avid DV Codec.

Color Levels | Select this option to set the color to either RGB or 601/709.

Export Settings: QuickTime Movie Export Options

Option | Description
--- | ---
Use Marks, Use Enabled Tracks | See “Use Marks and Use Enabled Tracks Options” on page 1472.

Same as Source | When you select this option, your Avid editing application copies the media files directly with no resolution change. This method is fast and creates output that uses the same quality as your source files. This is the best method to use if you plan to process the video on another system, using a third-party application like After Effects® or media cleaner®.

Deselect the Use Avid DV Codec suboption when you are working in a cooperative environment where one or more non-Avid systems also have access to the media. This option is selected by default.

*If you export DV media from a 24p or 23.976 project using Same as Source, you must use the Avid DV Codec to ensure the QuickTime movies retain all of the progressive information. If you do not use the Avid DV Codec, your Avid editing application treats movies as interlaced sources when you re-import them.*

Custom | When you select this option, your Avid editing application decompresses the files, processes them, and compresses the files at the requested resolution and audio format. This method is slower and often loses quality. Use this option only if you have to directly export a clip or sequence in a particular file format.

Format Options | This option appears when you select Custom. It opens the Movie Settings dialog box to let you set further QuickTime options, including options for changing the codec (compressor/decompressor) used for compression. For more information, see “Export Settings: QuickTime Movie Settings” on page 1480.
### Export Settings

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video and Audio, Video Only,</td>
<td>Defines whether your Avid editing application exports video only, audio only, or both. Use Video Only, for example, if you want to add effects in a third-party application or to use only the video in a multimedia project. Use Audio Only, for example, if you want to use or enhance audio in a third-party application or you want to use the audio in a multimedia project.</td>
</tr>
<tr>
<td>Audio Only</td>
<td></td>
</tr>
<tr>
<td>Video Format</td>
<td>The following options might be available, depending on your other settings:</td>
</tr>
<tr>
<td></td>
<td>• Width x Height: Defines the size of the clip. You can type in values or select from the predefined values in the Fast menu. The values in the Fast menu suggest a typical use for each size, for example, 320 x 240 (Internet video, large). The Size to Fit suboption sizes to fit the specified width and height. The Crop/Pad suboption instructs your Avid editing application not to scale or resize the frames. If necessary, it adds black lines to the top and bottom of the frame to achieve the correct size.</td>
</tr>
<tr>
<td></td>
<td>• Color Levels: Sets the color to either RGB or 601/709.</td>
</tr>
<tr>
<td></td>
<td>• File Field Order: Defines which field is the upper field during export. For 23.976p, 24p, or 25p projects, these options do not appear, and all fields are automatically exported as progressive (still) frames. Use the Odd (Upper Field First) suboption if you are in a PAL project. Field 1 becomes the upper field (its lines become the odd-numbered lines) in the frame. Field 2's lines become the even-numbered lines. Use the Even (Lower Field First) suboption if you are in an NTSC project. Field 1 becomes the lower field (its lines become the even-numbered lines) in the frame. Field 2's lines become the odd-numbered lines. Use the Single Field suboption if you want the output file to consist of only Field 1. In this case, your Avid editing application resizes the single field of 243 lines for NTSC (288 lines for PAL) to fit the frame as specified in the width and height selection.</td>
</tr>
<tr>
<td>Audio Format</td>
<td>The following QT Audio Options are available for exporting audio:</td>
</tr>
<tr>
<td></td>
<td>• Mono</td>
</tr>
<tr>
<td></td>
<td>• Stereo</td>
</tr>
<tr>
<td></td>
<td>• 5.1</td>
</tr>
<tr>
<td></td>
<td>• 7.1</td>
</tr>
<tr>
<td></td>
<td>• Direct Out</td>
</tr>
</tbody>
</table>

*If you select Direct Out as your audio format, you should select Same as Source for your export option for media that includes surround sound audio. This allows you to export the track assignments in your source sequence accurately.*
Export Settings: QuickTime Movie Settings

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Preview</td>
<td>When this option is selected, your Avid editing application creates a preview of the QuickTime movie.</td>
</tr>
<tr>
<td>Display Aspect Ratio</td>
<td>Defines an image size for the video you want to export: Native, 4:3, or 16:9. This lets you control the display format without modifying the source file.</td>
</tr>
<tr>
<td></td>
<td>This option creates metadata data that is stored with the QuickTime movie. Some applications, such as the QuickTime Player, can interpret this metadata and scale the image at display time.</td>
</tr>
<tr>
<td></td>
<td>This option is useful for the Same as Source option because that option also preserves the original format. When you select Same as Source, the selections in the Display Aspect Ratio area are based on the resolution of the media you are exporting and the project type (NTSC or PAL).</td>
</tr>
<tr>
<td></td>
<td>When you select Custom, your Avid editing application calculates the Display Aspect Ratio selections from the values you enter for Width x Height in the Video Format tab.</td>
</tr>
</tbody>
</table>

Video Settings opens the Standard Video Compression Settings dialog box. For more information, see “Export Settings: QuickTime Compression Settings” on page 1481.

Filter opens the Choose Video Filter dialog box, which lets you apply a single effect filter during an export.

Size opens the Export Size Settings dialog box. QuickTime lets you set a size, but Avid recommends you set the size in the Width and Height text boxes of the Export Settings dialog box. Both settings have the same effect, and the QuickTime size setting overrides the Avid size setting.

Sound Settings opens the Sound Settings dialog box, which lets you select a sound compression setting for your export, along with other options.
Export Settings: QuickTime Compression Settings

The Standard Video Compression Settings dialog box provides access to a wide range of QuickTime video codecs. The codecs available from the Compression Type list might vary depending on your computer’s configuration and your operating system. Other options in the dialog box vary depending on the codec you select from the Compression Type list. If you have an Internet connection, you can get help on using the options in this dialog box from the QuickTime web site by pressing the ? button in the bottom left corner of the dialog box.

The list of codecs includes Avid codecs, which create encapsulated media files for export of high-resolution files that are readable within QuickTime applications. You must install the Avid codec you use to export the file on the system running the QuickTime application for the application to read the exported file. For more information, see “Installing or Copying the Avid Codecs for QuickTime on Other Systems” on page 1041.

When you select an Avid codec and then click the Options button, the Codec Configuration dialog box lets you configure further options. For Color Levels or Color Input, select the color levels of the source media. If you are exporting from an Avid editing system, use ITU-R 601 (SD) or 709 (HD).

The following table describes the Avid codecs available in the Standard Video Compression Settings dialog.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Prepare for Internet Streaming | • Fast Start: The movie can begin playing over the Internet without having to download completely first. This method of playing movies over the Internet is referred to as progressive download or HTTP streaming. It does not require a streaming video server.  
• Fast Start - Compressed Header: This option is a better choice for progressive downloading. It works the same as Fast Start, but compresses the header information. The header is the portion of the file that allows the movie to start playing before the entire movie is downloaded. Compressing the header allows it to download faster. This is important for large movies (movies that are longer than several minutes).  
• Hinted Streaming: Select this option if you are putting the exported file on a streaming video server. The file does not stream without a hint track for each track in the movie. Hint tracks allow the streaming video server to split the file into packets for the streaming. A file with hinted streaming also plays as a progressive download. However, it will probably play more slowly than a Fast Start movie because it contains additional information and is therefore larger. For additional options, click Track Hinter Settings to open the RTP (Real Time Protocol) Track Settings dialog box. For more information, see your QuickTime documentation. |
Export Settings

<table>
<thead>
<tr>
<th>Codec</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Avid 1:1x</td>
<td>For high quality, 8-bit, lossless resolution (in which no picture information is lost). Available for use with MXF media files. Meridien-based systems cannot use this format. Current Avid editing systems, including Avid DS, can use this format. It uses 4:2:2 sampling.</td>
</tr>
<tr>
<td>Avid DNxHD™ Codec</td>
<td>For DNxHD encoding with 8-bit and 10-bit resolutions. Available for use with MXF media files. Meridien-based systems cannot use this format. Current Avid editing systems, including Avid DS, can use this format.</td>
</tr>
<tr>
<td>Avid DV</td>
<td>For compression compatible with Avid Xpress DV and Avid NewsCutter products or with Avid Meridien products with the DV/MPEG option.</td>
</tr>
<tr>
<td>Avid DV100 Codec</td>
<td>For DVCPRO HD encoding. Meridien-based systems cannot use this format. Current Avid editing systems, including Avid DS, can use this format. It uses 4:2:2 sampling.</td>
</tr>
<tr>
<td>Avid Meridien</td>
<td>For compression compatible with Avid Meridien-based products.</td>
</tr>
<tr>
<td>Compressed</td>
<td></td>
</tr>
<tr>
<td>Avid Meridien</td>
<td>For 1:1 resolution used in Avid Meridien-based products.</td>
</tr>
<tr>
<td>Uncompressed</td>
<td></td>
</tr>
<tr>
<td>Avid MPEG2 50 mbit</td>
<td>For MPEG-2 IMX 50,40,30 encoding, an interframe compression used in Sony IMX VTRs and cameras. It uses 4:2:2 sampling.</td>
</tr>
<tr>
<td>Avid Packed Codec</td>
<td>For high quality, 10-bit, lossless resolution (in which no picture information is lost). Available for use with MXF media files. Meridien-based systems cannot use this format. Current Avid editing systems, including Avid DS, can use this format. It uses 4:2:2 sampling.</td>
</tr>
<tr>
<td>Avid RGB Packed Codec</td>
<td>For high quality, 10-bit, lossless resolution (in which no picture information is lost). Available for use with MXF media files. Meridien-based systems cannot use this format. Current Avid editing systems, including Avid DS, can use this format. It uses 4:4:4 sampling.</td>
</tr>
</tbody>
</table>

Export Settings: HDV

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use Marks, Use Enabled Tracks</td>
<td>See “Use Marks and Use Enabled Tracks Options” on page 1472.</td>
</tr>
<tr>
<td>Video Quality</td>
<td>Defines the video quality, either Draft, Better, or Best. The higher the quality, the longer the time required to complete the export. Draft is fastest, while Best takes the longest time to complete but has the best quality. If you have a slower system, you might want to see if the Better or Draft options provide acceptable quality.</td>
</tr>
</tbody>
</table>
Export Settings: DV Stream

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Stream Type</strong></td>
<td>Defines the transport stream type:</td>
</tr>
<tr>
<td></td>
<td>• Transport Stream: Use this option for both video and audio, for example, when exporting to other devices.</td>
</tr>
<tr>
<td></td>
<td>• Elementary Streams: Use this option for either video only or audio only.</td>
</tr>
<tr>
<td><strong>Use Marks, Use Enabled Tracks</strong></td>
<td>See “Use Marks and Use Enabled Tracks Options” on page 1472.</td>
</tr>
<tr>
<td><strong>Format Options</strong></td>
<td>Opens the DV Export Settings dialog box, which lets you select the DV format, video format, and audio format options you want.</td>
</tr>
<tr>
<td></td>
<td>If you select DV as the DV format, you can choose to provide locked or unlocked audio.</td>
</tr>
<tr>
<td></td>
<td>For compatibility with DV cameras that require unlocked audio, deselect Locked.</td>
</tr>
<tr>
<td></td>
<td>If you select DVCPRO as the DV format, audio is always locked and the Locked option is grayed out. Also, the audio rate is always 48 kHz and</td>
</tr>
<tr>
<td></td>
<td>the Audio Rate menu is grayed out.</td>
</tr>
<tr>
<td><strong>Video and Audio</strong>, <strong>Video Only</strong>,</td>
<td>Defines whether your Avid editing application exports video only, audio only, or both.</td>
</tr>
<tr>
<td><strong>Audio Only</strong></td>
<td>Use Video Only, for example, if you want to add effects in a third-party application or to use only the video in a multimedia project. Use Audio Only, for example, if you want to use or enhance audio in a third-party application or you want to use the audio in a multimedia project.</td>
</tr>
<tr>
<td><strong>Video Format</strong></td>
<td>• Color Levels: Sets the color to either RGB or 601/709.</td>
</tr>
<tr>
<td></td>
<td>• File Field Order: Defines which field is the upper field during export. For 23.976p, 24p, or 25p projects, these options do not appear, and all fields are automatically exported as progressive (still) frames.</td>
</tr>
<tr>
<td></td>
<td>Use the Odd (Upper Field First) suboption if you are in a PAL project. Field 1 becomes the upper field (its lines become the odd-numbered lines) in the frame. Field 2's lines become the even-numbered lines.</td>
</tr>
<tr>
<td></td>
<td>Use the Even (Lower Field First) suboption if you are in an NTSC project. Field 1 becomes the lower field (its lines become the even-numbered lines) in the frame. Field 2's lines become the odd-numbered lines.</td>
</tr>
<tr>
<td></td>
<td>Use the Single Field suboption if you want the output file to consist of only Field 1. In this case, your Avid editing application resizes the single field of 243 lines for NTSC (288 lines for PAL) to fit the frame as specified in the width and height selection.</td>
</tr>
</tbody>
</table>
## Export Settings: AVI Through QuickTime

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use Marks, Use Enabled Tracks</td>
<td>See “Use Marks and Use Enabled Tracks Options” on page 1472.</td>
</tr>
<tr>
<td>Video and Audio, Video Only, Audio Only</td>
<td>Defines whether your Avid editing application exports video only, audio only, or both. Use Video Only, for example, if you want to add effects in a third-party application or to use only the video in a multimedia project. Use Audio Only, for example, if you want to use or enhance audio in a third-party application or you want to use the audio in a multimedia project.</td>
</tr>
</tbody>
</table>
| Video Format                        | - Color Levels: Sets the color to either RGB or 601/709.  
- File Field Order: Defines which field is the upper field during export. For 23.976p, 24p, or 25p projects, these options do not appear, and all fields are automatically exported as progressive (still) frames.  
  Use the Odd (Upper Field First) suboption if you are in a PAL project. Field 1 becomes the upper field (its lines become the odd-numbered lines) in the frame. Field 2's lines become the even-numbered lines.  
  Use the Even (Lower Field First) suboption if you are in an NTSC project. Field 1 becomes the lower field (its lines become the even-numbered lines) in the frame. Field 2's lines become the odd-numbered lines.  
  Use the Single Field suboption if you want the output file to consist of only Field 1. In this case, your Avid editing application resizes the single field of 243 lines for NTSC (288 lines for PAL) to fit the frame as specified in the width and height selection. |

## Export Settings: AVI Video Compression

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Compressor     | - Cinepak Codec by Radius: For export at low resolution where high quality is not an issue, such as presentations or educational uses, or for small-screen-size playback from CD-ROM or hard drive. This codec uses a compression algorithm optimized for CD-ROM playback.  
  Click Configure to open the Cinepak for Windows 32 configuration dialog box. You can then choose to compress to color or to black and white.  
- Apple’s QuickTime Codecs include: DV - PAL, DV/DVCPRO - NTSC and DVCPRO - PAL |
| Compression Quality slider | Adjusts compression quality for certain codecs.                                                                                                    |
### Export Settings: Windows Media (Windows Only)

#### Windows Media Legacy Template

The following table describes options available when you select Windows Media Legacy Template from the Windows Media menu in the Export Settings dialog box.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use Marks, Use Enabled Tracks</td>
<td>See “Use Marks and Use Enabled Tracks Options” on page 1472.</td>
</tr>
<tr>
<td>Version</td>
<td>Lets you select one of the available (v8, v7, or v4) Windows Media versions.</td>
</tr>
<tr>
<td>Templates</td>
<td>Lets you choose one of the Avid supplied Windows Media templates. For more information, see “Exporting as Windows Media (Windows Only)” on page 1043.</td>
</tr>
</tbody>
</table>

#### Existing Windows Media Custom Profile

The following table describes options available when you select Windows Media Custom Profile from the Windows Media menu in the Export Settings dialog box.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use Marks, Use Enabled Tracks</td>
<td>See “Use Marks and Use Enabled Tracks Options” on page 1472.</td>
</tr>
<tr>
<td>Set</td>
<td>Lets you browse to find an existing .prx file on your system. For more information, see “Exporting as Windows Media (Windows Only)” on page 1043.</td>
</tr>
</tbody>
</table>

#### Windows Media Video Settings

The following table describes options available when you select Windows Media from the Windows Media menu in the Export Settings dialog box and then select a video track.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Key Frame</td>
<td>When this option is selected, your Avid editing application uses keyframes as a reference for subsequent frames. Enter a numeric value to specify the frequency of the keyframes.</td>
</tr>
<tr>
<td>Limit Data Rate</td>
<td>Defines a limit to the data rate for the compressed file, in kilobytes per second.</td>
</tr>
</tbody>
</table>

**Key Frame**

*Every n frames*

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Limit Data Rate</td>
<td>Defines a limit to the data rate for the compressed file, in kilobytes per second.</td>
</tr>
<tr>
<td><strong>Option</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>----------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Use Marks, Use Enabled Tracks</td>
<td>See “Use Marks and Use Enabled Tracks Options” on page 1472.</td>
</tr>
<tr>
<td>Width, Height, FPS</td>
<td>Set the width, height, and frame-per-second (fps) rate of the clips for export.</td>
</tr>
<tr>
<td>Video Type</td>
<td>Defines the video type, either Progressive or Interlaced.</td>
</tr>
<tr>
<td>Pixel Aspect Ratio</td>
<td>When this option is selected, your Avid editing application scales the video. This lets you control the display format without modifying the source file.</td>
</tr>
<tr>
<td>Uncompressed</td>
<td>When this option is selected, your Avid editing application creates a high-quality export in which no picture information is lost. This option does not compress the file and can result in very large files.</td>
</tr>
<tr>
<td>Codec (not available when you select Uncompressed.)</td>
<td>Choose one of the following codecs:</td>
</tr>
<tr>
<td></td>
<td>• Windows Media MPEG-4 Video V3: This codec creates high-quality video for streaming, download, and play. Enables playback of interlaced content on televisions.</td>
</tr>
<tr>
<td></td>
<td>• ISO MPEG-4 Video V1: This codec delivers DVD (MPEG-2) quality video at lower data rates and smaller file sizes.</td>
</tr>
<tr>
<td></td>
<td>• Windows Media Video V7: This codec enables Windows Media Player 7 to view encoded video content without first having to download the latest codecs. This is the best choice when the encoding computer cannot support the performance requirements of the newer Windows Media Video codecs.</td>
</tr>
<tr>
<td></td>
<td>• Windows Media Screen V7: This codec is specially optimized for use for screen captures and some animations.</td>
</tr>
<tr>
<td></td>
<td>• Windows Media Video 9 Screen: This codec is optimized for screen captures. This codec is ideal for delivering demos or demonstrating computer use for training. Windows Media Video 9 Screen delivers better handling of bitmap images and screen motion, even on relatively slow CPUs.</td>
</tr>
<tr>
<td></td>
<td>• Windows Media Video 9: This codec offers improved quality over Windows Media Video 8, with the highest gains seen at the higher bit rates, and provides improved interlaced support.</td>
</tr>
<tr>
<td></td>
<td>• Windows Media Video V8: This codec supports a wide variety of network bandwidths, and deinterlaces interlaced content before encoding.</td>
</tr>
<tr>
<td></td>
<td>• Windows Media Video 9 Advanced Profile: Use this profile to deliver either progressive or interlaced content at data rates as low as one-third that of the MPEG-2 codec but with the same quality as MPEG-2.</td>
</tr>
</tbody>
</table>
### Windows Media Audio Settings

The following table describes options available when you select Windows Media from the Windows Media menu in the Export Settings dialog box and then select an audio track.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use Marks, Use Enabled Tracks</td>
<td>See “Use Marks and Use Enabled Tracks Options” on page 1472.</td>
</tr>
<tr>
<td>Uncompressed</td>
<td>When this option is selected, your Avid editing application creates a high-quality export in which no picture information is lost. This option does not compress the file and can result in very large files.</td>
</tr>
</tbody>
</table>
## Export Settings

### Option Description

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Codec (not available when you select Uncompressed.)</td>
<td>Select one of the following codecs:</td>
</tr>
<tr>
<td></td>
<td>- Windows Media Audio 9.1: This codec provides improvement in compression over the Windows Media 8 Audio codec and supports VBR audio encoding.</td>
</tr>
<tr>
<td></td>
<td>- ACELP.net: In some instances, the Sipro Labs ACELP codec appears in the list of codecs, for example, if you import a profile that was created by using Windows Media Encoder version 7.1. If this occurs, Avid recommends that you use the Windows Media Audio 9 Voice codec instead.</td>
</tr>
<tr>
<td></td>
<td>- Windows Media Audio 9 Voice: This codec provides superior quality for audio content with a voice emphasis and provides for mixed-mode encoding of voice and music. It is intended for playback at bit rates at 20 Kbps or lower.</td>
</tr>
<tr>
<td></td>
<td>- Windows Media Audio 9.1 Professional: This codec supports a full surround-sound experience and dynamic range control. It is intended for data rates of 128 to 768 Kbps.</td>
</tr>
<tr>
<td></td>
<td>- Windows Media Audio 9.1 Lossless: This codec provides lossless encoding of audio content. It supports multichannel audio encoding and dynamic range control.</td>
</tr>
<tr>
<td>Passes (not available when you select Uncompressed)</td>
<td>Defines the number of encoding passes, either 1 or 2. With 1 Pass encoding, the content passes through the encoder once, and compression is applied as the content is encountered. With 2 Pass encoding, the content is analyzed during the first pass, and then encoded in the second pass based on the data gathered in the first pass. 2 Pass encoding might result in better quality but takes longer.</td>
</tr>
<tr>
<td>VBR (not available when you select Uncompressed)</td>
<td>Variable Bit Rate. When you select this option, the formats available are VBR formats. If you deselect this option, the formats available are CBR formats.</td>
</tr>
<tr>
<td>Format (These options change when you select VBR.)</td>
<td>You can encode audio and video content at either a constant bit rate (CBR) or a variable bit rate (VBR). Use CBR if you plan to stream the content. Use VBR when you plan to distribute the content for downloading and playing either locally or on a device that has a constrained reading speed such as a CD or DVD player. Choose from one of the format options.</td>
</tr>
<tr>
<td>Buffer Size</td>
<td>Defines the number of seconds that you want content to be stored before encoding begins. A larger buffer results in better quality content, but requires more memory. When you encode content, the encoding process is delayed by the amount of time specified in the buffer. The content is also delayed by the same amount of time when streaming to a player.</td>
</tr>
<tr>
<td>Language</td>
<td>Select from the list of available languages.</td>
</tr>
</tbody>
</table>
Export Settings: Audio

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use Marks, Use Enabled Tracks</td>
<td>See “Use Marks and Use Enabled Tracks Options” on page 1472.</td>
</tr>
<tr>
<td>Mono, Stereo</td>
<td>Use this option to export audio tracks in either mono or stereo.</td>
</tr>
<tr>
<td>Sample Rate</td>
<td>Defines an audio sample rate, either Project rate, 32 kHz, 44.1 kHz, 48 kHz, 88.2 kHz, or 96 kHz. You can use this option if your sequence has a mix of sample rates and you need to create a single sample rate. (You set the project rate in the Audio Project Settings dialog box. For more information, see “Audio Project Settings for Capture” on page 207.) You can also use this option to change the sample rate if the application to which you are exporting does not support the current sample rate.</td>
</tr>
<tr>
<td>Bit Depth</td>
<td>Defines the bit depth, either Project bit depth, 16 bit, or 24 bit.</td>
</tr>
<tr>
<td>Audio Format</td>
<td>Defines the audio format:</td>
</tr>
<tr>
<td></td>
<td>• Project: When this option is selected, your Avid editing application exports the audio format that you selected as the project default in the Audio Project Settings: Main tab.</td>
</tr>
<tr>
<td></td>
<td>• WAVE: Select this option to export audio tracks in the WAVE format (.wav file name extension). Nearly all Windows applications that support sound use WAVE files. QuickTime also supports the WAVE format.</td>
</tr>
<tr>
<td></td>
<td>• AIFF-C: Select this option to export audio tracks in the industry-standard AIFF-C format, which is compatible with many third-party sound editing and multimedia applications.</td>
</tr>
<tr>
<td></td>
<td>• SDII (Macintosh only): Select this option to export audio tracks in the Sound Designer II format, which is compatible with Pro Tools and other third-party applications.</td>
</tr>
</tbody>
</table>

If you export with the Project option selected and PCM (MXF) selected in the Audio Project Settings: Main tab, a WAVE file is exported.

Export Settings: Graphic

The following table describes options available in Export Settings: Graphic.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use Marks, Use Enabled Tracks</td>
<td>See “Use Marks and Use Enabled Tracks Options” on page 1472.</td>
</tr>
</tbody>
</table>
Export Settings

Export Settings: Graphic Format

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graphic Format</td>
<td>Defines a graphic format for export. The Format Options button lets you set export parameters. For more information on available graphic formats, see “Export Settings: Graphic Format” on page 1490.</td>
</tr>
<tr>
<td>Width x Height</td>
<td>Defines the size of the clip. Click the Fast Menu button, and select from a list of standard dimensions.</td>
</tr>
<tr>
<td></td>
<td>The Size to Fit suboption sizes to fit the specified width and height. The Crop/Pad suboption instructs your Avid editing application not to scale or resize the frames. If necessary, it adds black lines to the top and bottom of the frame to achieve the correct size.</td>
</tr>
<tr>
<td>Color Levels</td>
<td>This option lets you set color to either RGB or 601/709.</td>
</tr>
<tr>
<td>Sequential Files</td>
<td>When this option is selected, your Avid editing application produces a series of still images, numbered sequentially. The fps rate of the source file determines the number of still image files that are produced.</td>
</tr>
<tr>
<td></td>
<td>Select Markers only to produce images only for those frames that contain markers.</td>
</tr>
<tr>
<td></td>
<td>• Topmost Image: When this option is selected, if you have multiple tracks, and a marker is on a lower track but is obscured by a higher track clip, the highest available track will be used in the sequential list over the lower track.</td>
</tr>
<tr>
<td></td>
<td>• Use Comments: When this option is selected, the marker comment will be used as the name for the saved graphic.</td>
</tr>
<tr>
<td>File Field Order</td>
<td>Defines which field is the upper field during export. For 23.976p, 24p, or 25p projects, these options do not appear, and all fields are automatically exported as progressive (still) frames.</td>
</tr>
<tr>
<td></td>
<td>• Use the Odd (Upper Field First) suboption if you are in a PAL project. Field 1 becomes the upper field (its lines become the odd-numbered lines) in the frame. Field 2's lines become the even-numbered lines.</td>
</tr>
<tr>
<td></td>
<td>• Use the Even (Lower Field First) suboption if you are in an NTSC project. Field 1 becomes the lower field (its lines become the even-numbered lines) in the frame. Field 2's lines become the odd-numbered lines.</td>
</tr>
<tr>
<td></td>
<td>• Use the Single Field suboption if you want the output file to consist of only Field 1. In this case, your Avid editing application resizes the single field of 243 lines for NTSC (288 lines for PAL) to fit the frame as specified in the width and height selection.</td>
</tr>
</tbody>
</table>

Export Settings: Graphic Format

<table>
<thead>
<tr>
<th>Format</th>
<th>Options and Other Notes (if applicable)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alias™</td>
<td></td>
</tr>
</tbody>
</table>

1490
<table>
<thead>
<tr>
<th>Format</th>
<th>Options and Other Notes (if applicable)</th>
</tr>
</thead>
<tbody>
<tr>
<td>BMP</td>
<td>Windows: Creates files that are compatible with systems running the Windows operating system. OS/2: Creates files that are compatible with systems running the IBM® OS/2® operating system.</td>
</tr>
<tr>
<td>Chyron®</td>
<td>Blackpoint (Windows) or Black Point (Macintosh): Lets you adjust a film exposure value that corresponds to filming a 2% black card. Values can be between 0 and 1022. The default value of 0 is adequate for most uses.</td>
</tr>
<tr>
<td>Cineon™</td>
<td>Whitepoint (Windows) or White Point (Macintosh): Lets you adjust a film exposure value that corresponds to filming a 90% white card. Values can be between 1 and 1023. If the files came from and will be transferred back to a Cineon™ system, use a white point of 1023. The default value of 685 is appropriate if the final destination is not a Cineon system — for example, a video display.</td>
</tr>
<tr>
<td></td>
<td>Gamma: Defines an adjustment to correct for any gamma inconsistencies in the output display. Values can range from 0.01 to 100.0. The default value is 1.0. Use a value of 1.0 for images to display on a PC monitor, 0.59 for a Silicon Graphics® or a Macintosh monitor, and 0.45 for ITU-R 601 (CCIR 601) video.</td>
</tr>
<tr>
<td>ERIMovie</td>
<td>Pack 24 bits: Controls whether the image data is packed into 24-bit color depth (compressed) or is saved as 32-bit (raw) color depth.</td>
</tr>
<tr>
<td>Framestore</td>
<td>Your Avid editing application supports both compressed and uncompressed Framestore formats.</td>
</tr>
<tr>
<td>IFF</td>
<td></td>
</tr>
<tr>
<td>JPEG</td>
<td>Quality: Controls the output file size and quality. Higher values produce better images but larger file sizes, while lower values reduce the image quality but result in smaller file sizes.</td>
</tr>
<tr>
<td></td>
<td>Baseline: Selected by default. To see if this option is required, see the documentation for your JPEG-supported applications.</td>
</tr>
<tr>
<td></td>
<td>Progressive: Lets you save progressive JPEG files, which divide the file into a series of scans of the image that increase in quality. Each scan progressively improves the recognizability of the image. Progressive JPEG files are only recognized by applications with progressive JPEG support, such as some Web browsers.</td>
</tr>
<tr>
<td>OMF</td>
<td>NTSC/PAL: Appears when you select a compression ratio that lets you select either NTSC or PAL. When you select an option, the system displays the required image size and the default frame rate.</td>
</tr>
<tr>
<td></td>
<td>Compression: Controls the compression ratio and, therefore, the size of the file. You can choose from all the compression ratio options used by your Avid editing application when recapturing. For more information on Avid compression ratios, see “Resolutions and Storage Requirements” on page 1557.</td>
</tr>
<tr>
<td>PCX™</td>
<td></td>
</tr>
<tr>
<td>Format</td>
<td>Options and Other Notes (if applicable)</td>
</tr>
<tr>
<td>--------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Photoshop</td>
<td><strong>Color Depth:</strong> The 8 bits suboption saves 8-bit files. The 16 bits suboption saves 16-bit files. The Automatic suboption saves the image in the same depth as the original loaded image.</td>
</tr>
<tr>
<td></td>
<td><strong>Compression:</strong> Controls the size of the file on disk. Disabling this option creates larger files on disk.</td>
</tr>
<tr>
<td>PICS</td>
<td>This option is available on Macintosh only. It creates a Macintosh QuickDraw picture encapsulated in IFF format.</td>
</tr>
<tr>
<td>PICT</td>
<td>Create MacBinary header: This option, available on Windows only, creates a file with a MacBinary header. MacBinary is a file format for representing all the information in a Macintosh file in one binary file. It is a compact file format, useful for storing a Macintosh file on a non-Macintosh system for later retrieval. Use a file expander utility to decode a MacBinary file once it is back on a Macintosh system.</td>
</tr>
<tr>
<td>Pixar®</td>
<td></td>
</tr>
<tr>
<td>PNG</td>
<td><strong>Color Depth:</strong> The 8 bits suboption saves 8-bit files. The 16 bits suboption saves 16-bit files. The Automatic suboption saves the image in the same depth as the original loaded image.</td>
</tr>
<tr>
<td></td>
<td><strong>Interlaced:</strong> lets you save the file for progressive display, similar to progressive JPEG files. As the file is transmitted, the recognizability of the image improves. Interlaced PNG files are only recognized by applications with interlaced PNG support, such as some Web browsers.</td>
</tr>
<tr>
<td>QRT</td>
<td></td>
</tr>
<tr>
<td>Rendition</td>
<td></td>
</tr>
<tr>
<td>SGI®</td>
<td>The 8 bits option saves 8-bit files. The 16 bits option saves 16-bit files. The Automatic option saves the image in the same depth as the original loaded image.</td>
</tr>
<tr>
<td>Softimage</td>
<td></td>
</tr>
<tr>
<td>SunRaster™</td>
<td></td>
</tr>
<tr>
<td>TARGA®</td>
<td><strong>Color Depth:</strong> The 5-bit option saves data in Targa 16 format. The 8-bit option saves data in Targa 24/32 format.</td>
</tr>
<tr>
<td></td>
<td><strong>Compression:</strong> Controls the size of the file on disk. Disabling compression creates larger files on disk.</td>
</tr>
</tbody>
</table>
**Export Settings**

**TIFF**
- **Color Depth**: The 8 bits suboption saves 8-bit files. The 16 bits suboption saves 16-bit files. The Automatic suboption saves the image in the same depth as the original loaded image.
- **Compression**: Controls the size of the file on disk. With None, i RLE (run length encoded) produces relatively small and fairly portable files. JPEG
  - None: Image data is not compressed and can produce large file sizes.
  - RLE (run length encoded): Produces relatively small and portable files.
  - JPEG: Produces files that can vary in size, depending on the quality you set using the JPEG Quality slider. The higher the quality setting, the larger the file size.
  - **JPEG Quality**: Adjusts the image quality of the JPEG file on a sliding scale from 0 to 100. The higher the value, the higher the image quality of the JPEG file.

**Wavefront**
- **Format Type**: Defines one of two output file formats supported by Wavefront (either RLA or RLB).
- **Color Depth**: The 8 bits suboption saves 8-bit files. The 16 bits suboption saves 16-bit files. The Automatic suboption saves the image in the same depth as the original loaded image.
- **Gamma**: Defines an adjustment to correct for gamma differences between Macintosh and Windows output display. This option is intended for cross-platform applications that require adjustment. To see if you need to adjust this value, check the documentation for your Wavefront application. Usually, you can use the default setting.

**XWindows**

**YUV**
- **Format**: Controls the video format of saved images. If set to NTSC, NTSC video format (720 x 486) is used. If set to PAL, PAL video format (720 x 576) is used. Images are either padded with black or cropped.
- **Smooth YUV**: Enhances the fidelity of images saved in YUV color space (if originating in RGB color space).

---

**Export Settings: P2**

To open the P2 Export Setting dialog box, select Output > Export to Device > P2. For more information, see “Exporting Your Clip or Sequence to a P2 Card” on page 1052.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use Marks, Use Enabled Tracks</td>
<td>See “Use Marks and Use Enabled Tracks Options” on page 1472.</td>
</tr>
<tr>
<td>P2 Device</td>
<td>Defines the connected P2 device to which you want to export.</td>
</tr>
<tr>
<td>Video Format</td>
<td>Defines a video format. You can upconvert or downconvert.</td>
</tr>
</tbody>
</table>
Export Settings: XDCAM

To open the XDCAM Export Setting dialog box, select Output > Export to Device > XDCAM. For more information, see “Exporting Media to XDCAM Devices” on page 1045.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use Marks, Use Enabled Tracks</td>
<td>See “Use Marks and Use Enabled Tracks Options” on page 1472.</td>
</tr>
<tr>
<td>Target XDCAM Disk</td>
<td>Defines the connected XDCAM disk to which you want to export.</td>
</tr>
<tr>
<td>Video Format</td>
<td>Defines a video format. You can upconvert or downconvert.</td>
</tr>
<tr>
<td>Bit Depth</td>
<td>Defines the audio bit depth, either 16 bit or 24 bit.</td>
</tr>
</tbody>
</table>

Film and 24P Settings

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit Play Rate</td>
<td>Defines the edit play rate for your project. Options differ for PAL and NTSC projects.</td>
</tr>
<tr>
<td>Master Default Film Type</td>
<td>Defines the film type. Select an option to meet your production lab standards and the film type for your master.</td>
</tr>
<tr>
<td>Master Default Edge Type</td>
<td>Defines the edge type for the master display in bins and cut lists.</td>
</tr>
<tr>
<td>Ink Number Default Film Type</td>
<td>Defines the ink number film type. Select an option to meet your production lab standards and film type.</td>
</tr>
<tr>
<td>Ink Number Default Edge Type</td>
<td>Defines the edge type for the ink number display in bins and cut lists.</td>
</tr>
<tr>
<td>Auxiliary Ink Default Film Type</td>
<td>Defines the film type for a second ink number (this is useful for tracking additional information for different film gauges). The choices are the same as for Ink Number Default Film Type.</td>
</tr>
</tbody>
</table>
Full Screen Playback Settings

For information on using Full Screen Play, see “Playing Video to a Full-Screen Monitor” on page 527.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auxiliary Ink Default Edge Type</td>
<td>Defines the format for the auxiliary ink number edge type. The choices are the same as for Ink Number Default Edge Type.</td>
</tr>
</tbody>
</table>
| Video Pulldown Cadence (NTSC only) | Defines how your Avid editing application handles pulldown:  
  - Video Rate, no pulldown: For 24-fps footage transferred MOS (without sound) to 30 fps by speeding up the film and using audio brought into your Avid system separately at 100% of the actual speed.  
  - Standard 2:3:2:3 pulldown: For 24-fps footage transferred to 30 fps using Standard Pulldown with the audio synchronized to the picture.  
  - Advanced 2:3:3:2 pulldown: For 24-fps footage recorded to 60 fields (NTSC) using Advanced Pulldown with the audio synchronized to the picture. |
| Audio Transfer Rate (PAL only) | Defines the transfer rate for audio in 24p PAL film projects. The choices are:  
  - Film Rate (100%): For 24-fps film footage transferred MOS to 25 fps by speeding up film with the audio coming in separately at 100% of the actual speed.  
  - Video Rate (100%+): For 24-fps film footage transferred to 25 fps by speeding up the film with the audio synchronized to the video picture. |
| Audio Source Tape TC Rate (NTSC only) | Defines the source audio rate, either 30fps or 29.97 fps.                                                                                                                                                   |
| Set Pulldown Phase of Timecode (NTSC only) | Defines a default pulldown phase for a 23.976p or 24p NTSC project.                                                                                                                                       |

It is important to keep the audio transfer rate constant for the project.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scaling</td>
<td>Determines how images are scaled for full-screen playback:</td>
</tr>
<tr>
<td></td>
<td>• Project: Uses the actual project type and aspect ratio to determine the scaling.</td>
</tr>
<tr>
<td></td>
<td>• 4x3 (Standard): If you are editing an HD project that contains a lot of SD material that is stretched to fit the 16x9 aspect ratio, you might want to select this scaling option, letting you restore its original aspect ratio.</td>
</tr>
<tr>
<td></td>
<td>• 16x9 (Widescreen): If you are in a 4x3 SD project, working with actual wide-screen material (such as 16x9 material captured by a DV Camcorder), you can select this option to display the material as 16x9 wide-screen.</td>
</tr>
<tr>
<td></td>
<td>• Raw Pixel: This option lets you see the frame in the full screen window, pixel for pixel, with no scaling. If the image is larger, it is scaled to fit the screen. This is only useful when viewing SD in which pixels are non-square. Raw Pixel Aspect ratio is slightly wider than 4x3.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| S3D View     | Mix: Displays a 50/50 blend of both the left and right eye images.  
Difference: Displays a blend of both left and right eyes, and highlights the difference between the two. Embossed areas show the differences, while gray pixels represent no differences.  
Frame Compatible: Displays both the left and right eye images as dictated by the project settings (side/side or over/under).  
Mono: Displays only one of the stereoscopic images.  
  • Left: Displays only the left eye image.  
  • Right: Displays only the right eye image.  
  • Leading eye: Displays only the image set as the leading eye on the stereoscopic clip.  
Anaglyph: Displays a blended image with pixels for each eye corresponding to one of the following color options:  
  • Red-Cyan: Uses red for the left eye and cyan for the right.  
  • Green-Magenta: Uses green for the left eye and magenta for the right.  
  • Amber-Blue: Uses amber for the left eye and blue for the right.  
B/W-Anaglyph: Displays a monochrome image with color highlights only where there are differences in the left and right eye. The pixels in each eye image can be mapped to the following color options:  
  • B/W Red-Cyan: Shows differences in red and cyan for the left and right eyes respectively.  
  • B/W Green-Magenta: Shows differences in green and magenta for the left and right eyes respectively.  
Checkerboard: When this option is selected, your Avid editing application displays the left and the right images simultaneously for stereoscopic viewing. The term “checkerboard” refers to the way in which blocks of the left and right images are displayed for stereoscopic viewing. Blocks are approximately n x n pixels in size.  
Compare: Compares the left and right eye images using a diagonal split screen. You can set the comparison mode to 25, 50, or 75%. |

Full Screen Playback Settings
### Option | Description
--- | ---
S3D Overlay | Displays the disparity guides on the viewer so that you can see the depth budget limits when adjusting the separation between your stereo 3D images. The guides for Parallax are based on the project’s S3D settings (set from the Project window, Settings tab).

Parallax Near: Displays green guides that show the limits for objects that will appear in front of the screen plane.

Parallax Far: Displays blue guides that show the limits for objects that will appear in front of the screen plane.

Parallax Near/Far: Displays both guides (green and blue) that show the limits for objects that will appear in front and behind the screen plane.

Target Mask | Allows you to set the mask area in the viewers:
- No Mask: Does not display masked region.
- Gray Mask: Displays masked region with a translucent gray to allow you to view the full image.
- Black Mask: Blacks out the masked region to display the image as it would appear when output.

Full Screen | This option is selected by default.
When this option is deselected, the video displays with as little scaling as possible. Your Avid editing application tries to display the image at its native height, and then matches the width to the height using the Aspect Ratio selection from above.

Deselecting Full Screen and working in Draft quality (green/yellow) mode or Best Performance (yellow/yellow) mode can also improve performance with some older video cards that have limited pixel shader processing power.

Display Both Fields | Select this option when your Avid editing application is connected to an interlaced display.
If a progressive display (for example, an LCD monitor) is connected to the graphic card's video output and you select this option, toothcombing appears in interlaced images.

Flip on Vertical Sync | If your graphics board can render the frame of video before the vertical retrace, enabling this option removes the tearing seen on the Full Screen Play monitor. (Vertical retrace is the action within the monitor that turns the monitor beam off when moving it from the lower right corner of the monitor to the upper left.) If the board is unable to render the frame, you might see a stutter. The size of the video frame, the throughput of the board, and the speed of the bus that the graphics board runs affect the ability of the board to complete the render in time. This option is deselected by default.

Expand Luminance For Computer Displays | When this option is selected, the video image is represented more accurately when using Full Screen Play on a standard computer monitor. If you are driving a studio quality monitor through either component, DVI or HDMI inputs you might want to run with this option deselected. This option is deselected by default.
### General Settings

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current Monitor Position</td>
<td>Defines which monitor displays the full screen playback. Drag the entire Full Screen Playback Settings dialog box to the desired monitor, and then click Select Monitor. (Macintosh only) If two or more graphics cards are installed, choose a monitor that is connected to the primary graphics adapter.</td>
</tr>
<tr>
<td>Project Format</td>
<td>Displays the format currently selected for the project.</td>
</tr>
<tr>
<td>Temporary File Directory</td>
<td>When you use drag and drop Export or an export that creates an intermediate movie file, your Avid editing application must store the intermediate file, which can be as large as the final export. By default, the Temporary File Directory is located in the same directory as your Avid editing application. To improve efficiency or to avoid DISK_FULL errors when exporting, you can specify a different directory for these temporary files. The ideal setting for this field is to type in a directory on the drive to which you are exporting, or simply one with plenty of free space.</td>
</tr>
<tr>
<td>Default Starting TC</td>
<td>Defines the timecode value you want your Avid editing application to use as the default starting timecode for each new sequence. For more information, see “Understanding Timecode” on page 192.</td>
</tr>
<tr>
<td>Default Starting EC</td>
<td>Defines the edgecode value you want your Avid editing application to use as the default starting edgecode for each new sequence.</td>
</tr>
<tr>
<td>Effect Apertures</td>
<td>Controls the number of horizontal lines of an image that your Avid editing application uses to create an effect.</td>
</tr>
<tr>
<td></td>
<td>• DV25: Select this option when you are using DV media exclusively. For more information, see “Setting Effect Aperture Options” in the Help.</td>
</tr>
<tr>
<td></td>
<td>• ITU 601 (default): Select this option when you are using uncompressed media or mixed resolutions.</td>
</tr>
<tr>
<td>NTSC Has Setup</td>
<td>This option allows systems using NTSC-EIAJ to use the correct color mapping. NTSC-EIAJ users should not select this option. All other users should select this option.</td>
</tr>
</tbody>
</table>
**Grid Settings**

**Grid Settings: Coordinates Tab**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Scale Mode            | Lets you work with a grid that indicates boundaries for a format other than the one in which you are working. This is useful when you are creating graphics (like titles) that must remain safe in other formats. Select one of the following options depending on the current and target formats you need. When you do not specifically need a grid that represents another format, use the Normal option, which is the default.  
  - Normal  
  - 4:3 Inside 16:9 Monitor  
  - 4:3 Outside 16:9 Monitor  
  - 1.66 Inside 4:3  
  - 1.77 Inside 4:3  
  - 1.85 Inside 4:3  

| Increments            | Lets you control grid increments.  
  - Fields: Sets the number of tick marks along the grid axes as well as the number of visible grid points. The default value is 12.  
  - Sub Fields: Sets the number of divisions between visible grid points for the snap-to-grid feature. Setting Sub Fields to 1 snaps objects to visible points only. A value of 2 provides 1/2-field jumps. A value of 4 (the default value) provides 1/4-field jumps, and so on. Setting Sub Fields to 0 turns off the snap-to-grid feature. |

| Source Scan Size      | For film projects, where an optical house scans film for the addition of visual effects. The default values are 720 x 486 pixels. |
Grid Settings: Display Tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source Grid Adjustments</td>
<td>Lets you shrink or offset the grid.</td>
</tr>
<tr>
<td>Hor. Offset and Vert. Offset:</td>
<td>These options move the grid on the image either horizontally or vertically, and are intended mainly for film projects.</td>
</tr>
<tr>
<td>Inset:</td>
<td>This option shrinks the grid proportionally.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Selects a different grid for each standard film type. For video projects, use the Square grid type. The grid for the Academy option includes a safety margin on the left that is used for adding the optical sound track. The following options are available: Square, Standard Film, Academy, Super 35, Anamorphic.</td>
</tr>
<tr>
<td>Color</td>
<td>Defines a color for the grid axes and the grid points.</td>
</tr>
<tr>
<td>Show Safe Title</td>
<td>Displays the safe title area. Create video titles within this area to ensure that they are viewable on a regular television screen.</td>
</tr>
<tr>
<td>Show Safe Action</td>
<td>Displays the safe action area for video display. This box is self-adjusting for different project formats.</td>
</tr>
<tr>
<td>Show 14x9 Zone</td>
<td>Select one or more of these options to display the grid you want.</td>
</tr>
<tr>
<td>Show 1.66 Aspect</td>
<td></td>
</tr>
<tr>
<td>Show 1.85 Aspect</td>
<td></td>
</tr>
<tr>
<td>Show 1.77 Aspect</td>
<td></td>
</tr>
<tr>
<td>Show Axes</td>
<td>Displays the grid axes.</td>
</tr>
<tr>
<td>Show Tick Marks</td>
<td>Shows tick marks along the axes. Use the Fields option to set the number of tick marks.</td>
</tr>
<tr>
<td>Show Thirds</td>
<td>Divides the screen into three sections. This is especially useful if you are creating titles for the lower third of the screen.</td>
</tr>
<tr>
<td>Show Points</td>
<td>Shows the grid points. Use the Fields option to set the number of grid points.</td>
</tr>
<tr>
<td>Show Position Info</td>
<td>Displays the position coordinates of any point in the Effect Preview or Record monitor. Your Avid editing application uses compass coordinates and X, Y coordinates. For compass coordinates, (0, 0) is the center of the axes. For X, Y coordinates, (0, 0) is the top left corner of the monitor. X values increase to the right, and Y values increase as you move down. For more information, see “Displaying Position Coordinates” in the Help.</td>
</tr>
</tbody>
</table>
Import Settings

Import Settings: Image Tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image Size Adjustment</td>
<td>Controls the dimensions of imported images. The following options are available:</td>
</tr>
<tr>
<td></td>
<td>* Image sized for current format: Select this option if the image is properly sized and formatted for the current project format, or to maintain field data when you import two-field media that follows exact NTSC or PAL dimensions. Your Avid editing application converts the existing pixel dimensions, if necessary, so that the image fills the screen. HD projects use the ITU-R 709 color space instead of ITU-R 601. This is the default option. If the aspect ratio of the original frames does not match the aspect ratio your Avid editing application is using, the imported frames might appear distorted. For best full-screen resolution in SD projects of files created in a square-pixel environment, use 648 x 486 (NTSC), 648 x 480 (NTSC DV) or 768 x 576 (PAL). To create a single resolution for both NTSC and PAL, use 720 x 540.</td>
</tr>
<tr>
<td></td>
<td>* Crop/Pad for DV scan line difference: Select this option to compensate for the six missing scan lines in NTSC DV. If you select a 486-line resolution and are importing a 720x480 graphic or animation, your Avid editing application pads the frame out by six lines. If, on the other hand, you select the DV25 resolution and are importing a full-frame 720x486 graphic or movie, your Avid editing application crops the top four and bottom two scan lines out of the image.</td>
</tr>
<tr>
<td></td>
<td>* Do not resize smaller images: Select this option to import graphic files that have a smaller size than the full-raster SD or HD frame. You typically use this option for either temporary web graphics (in either SD or HD) or to bring SD-formatted graphics into an HD project without blowing them up and losing quality.</td>
</tr>
<tr>
<td></td>
<td>* Resize image to fit format raster: Select this option to resize both smaller and larger images to fit the full-raster SD or HD frame. Your Avid editing application maintains the file’s aspect ratio.</td>
</tr>
</tbody>
</table>
### Field Ordering in File

Controls the field ordering (sometimes referred to as field dominance) of the media you are importing. For 23.976p, 24p, or 25p projects, these options do not appear, and all fields are automatically imported as progressive (still) frames.

When the field ordering (or spatial field position) of the imported media matches the field ordering of the project format, no special processing is required. For more information, see “Field Ordering in Graphic Imports and Exports” on page 1554.

This option does not apply to OMFI imports when the import resolution matches the OMFI file.

The following options are available:

- **Ordered for current format:** Select this option when the file you are importing is correctly field ordered for the video format being used (for example, Even or lower ordered for NTSC, Odd or upper ordered for 1080i HD). This is the default option.
- **Odd (Upper Field First) ordered:** Select this option if the file is odd ordered and you are importing it into an even ordered format, for example, when you are importing PAL DV into PAL.
- **Even (Lower Field First) ordered:** Select this option if the file is even ordered and you are importing it into an odd ordered format, for example, when you are importing NTSC into 1080i HD.

### File Pixel to Video Mapping

Controls how your Avid editing application handles color in the imported images. The following options are available:

- **Computer RGB (0–255):** Select this option if the file you are importing uses RGB graphics levels. Most computer-generated graphics use RGB graphics levels. The RGB color values are remapped to ITU-R 601 (formerly CCIR 601) or ITU-R 709 video color values appropriate for your Avid editing application.

- **Computer RGB, dither image colors:** Select this option if the file you are importing uses complex color effects, such as a gradation, and you are importing at a high resolution (2:1). Do not use this option to reimport an image that you have already imported with dithering.

- **601 SD or 709 HD (16–235):** Select this option if the file you are importing uses video levels based on the ITU-R 601 (formerly CCIR 601) or ITU-R 709 (HD) standard. These graphics include Avid color bars or images that include superblack (zero black) for keying purposes.
Import Settings

Alpha Channel

Controls how your Avid editing application handles the alpha channel in imported images. The following options are available:

- Invert on import (white = opaque): Select this option to reverse the black and white elements of the alpha channel if they differ from the matte key requirements of your Avid editing application. Avid applications use a white background, a black foreground, and a gray transparency blend between the two.
- Do not invert (black = opaque): Select this option to import the image, using the existing alpha channel information.
- Ignore: Select this option to import an image that contains alpha channel transparency information as one opaque graphic. The imported graphic appears as a single master clip in the bin.

If an image contains an embedded alpha channel but your Avid editing application does not support alpha channel import for the file type, select this option to import the image successfully. For information on alpha channel support, see “Import Specifications for Supported Graphics File Formats” on page 1540.

Dilate Fill

This option bleeds the fill just a bit along the edges where transparent alpha meets non-transparent alpha.

It is useful when importing graphics files containing alpha that have abrupt transitions between transparent and opaque. It can help prevent black/gray pixels from seeping into the fill.

Frame Import Duration

Defines the duration of the single frame your Avid editing application creates from the import. The default is 10 seconds. This option does not apply to importing sequential image files because each file represents one frame of the clip, so the total number of files determines the total duration.

Importing an image with alpha channel creates a matte key effect as a single frame, with no associated media file.

Importing as a single frame takes less time and requires less storage than importing as a media file. However, a single frame has limited real-time playback capabilities, particularly at high resolutions, because your Avid editing application loads the frame into memory and handles it in real time, rather than playing it back from a disk.

Autodetect Sequentially Numbered Files

When this option is selected, your Avid editing application recognizes that a sequence of connected files is present and automatically imports the whole sequence.

When this option is deselected, your Avid editing application does not automatically import a whole sequence of files that have sequential extensions. You can then select any single file for import.

You can import sequential files for any of the supported still-image formats. For information on preparing a sequence of image files, see “Specifications for Animation Files” on page 1545.
### Import Settings: OMFI/AAF Tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolution</td>
<td>When this option is selected, your Avid editing application maintains the source file’s resolution. Your Avid editing application disregards the resolution setting in the Select Files to Import dialog box as well as the resolution set in the Import tab of the Media Creation dialog box.</td>
</tr>
<tr>
<td>Resolution</td>
<td>When this option is selected, your Avid editing application disregards the source file resolution and uses the current import resolution setting.</td>
</tr>
<tr>
<td>Ask me to set the resolution for each file that is different from the current import resolution setting.</td>
<td>When this option is selected, your Avid editing application displays a query about resolution selection for each imported file when the resolution of the source file is different from the current import resolution setting.</td>
</tr>
</tbody>
</table>

### Import Settings: Shot Log Tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maintain events as logged.</td>
<td>When this option is selected, your Avid editing application maintains all events as originally logged.</td>
</tr>
<tr>
<td>Combine events based on scene and automatically create subclips.</td>
<td>When this option is selected, your Avid editing application combines all the events for a scene into a single master clip and then links the master clip to subclips that represent the original events for that scene. To use this option, you must have scene numbers logged in a scene column in the bin.</td>
</tr>
<tr>
<td>Combine events based on camera roll and automatically create subclips.</td>
<td>When this option is selected, your Avid editing application combines all the events from a camera roll into a single master clip and then links the master clip to subclips that represent the original events for that camera roll. To use this option, you must have camera roll numbers logged in a camera roll column in the bin for a film project.</td>
</tr>
<tr>
<td>Merge events with known sources and automatically create subclips.</td>
<td>When this option is selected, your Avid editing application creates subclips for events that are merged or relinked to their source clips upon import. Use this option if you have already entered master clips in a bin for each camera roll or master scene, and have subsequently logged all the events related to those clips for import.</td>
</tr>
<tr>
<td>You must select the clips that you want to merge before selecting this option.</td>
<td></td>
</tr>
<tr>
<td>Merge events with known master clips.</td>
<td>When this option is selected, your Avid editing application merges information in the shot log onto selected master clips based on the matching tape name. Use this option if you have already logged (or captured) master clips in a bin for each take.</td>
</tr>
<tr>
<td>You must select the clips that you want to merge before selecting this option.</td>
<td></td>
</tr>
</tbody>
</table>
## Import Settings: Audio Tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multichannel Audio</td>
<td>Allows you to map source audio channels to multichannel or mono tracks in your imported clips. Click Edit to open the Set Multichannel Audio dialog box and specify mono or audio tracks for a maximum of 16 audio channels. For more information, see “Importing with Multichannel Audio” on page 305.</td>
</tr>
<tr>
<td>Sample rate convert source sample rate to</td>
<td>Controls sample rate conversion during audio import.</td>
</tr>
<tr>
<td>project sample rate</td>
<td>When this option is selected, your Avid editing application converts incoming media to the sample rate of the current project. This option is selected by default.</td>
</tr>
<tr>
<td></td>
<td>When this option is deselected, your Avid editing application imports audio media at the source sample rate. If your Avid editing application does not support the source sample rate, it autoconverts the audio media to the current project sample rate.</td>
</tr>
<tr>
<td></td>
<td>If you select this option, the “Do not convert sources with pullup or pulldown rates” option is available. Select this option to skip the conversion of incoming media marked with pullup or pulldown sample rates to the sample rate of the current project. The length and pitch of the imported files are changed by plus or minus .1%. Deselect this option to convert audio media with pullup or pulldown source sample rates to the project sample rate. Length and duration do not change for the imported audio files. This option is selected by default.</td>
</tr>
<tr>
<td></td>
<td>For more information, see “Sample Rate Conversion and Audio Import” on page 309.</td>
</tr>
<tr>
<td>Convert source bit depth to project bit</td>
<td>Controls bit depth conversion during audio import.</td>
</tr>
<tr>
<td>depth</td>
<td>When this option is selected, your Avid editing application converts the incoming media to the bit depth of the current project (deselected by default).</td>
</tr>
<tr>
<td></td>
<td>When this option is deselected, your Avid editing application imports audio media at the source bit depth. If your Avid editing application does not support the source bit depth, it autoconverts the audio media to the current project bit depth.</td>
</tr>
<tr>
<td>Apply attenuation/gain effect on import</td>
<td>When this option is selected, your Avid editing application applies attenuation/gain effects made to clips prior to import. If you apply gain from the Clip menu after you have adjusted the gain before import, the pre-import gain is ignored. For example, if you apply -6 dB before import, and then apply another -6 dB to the clip, the clip remains at -6 db and not -12 db.</td>
</tr>
<tr>
<td></td>
<td>Select the CD only option if you only want to apply attenuation/gain to all of the music files on a CD.</td>
</tr>
<tr>
<td>Automatically center pan monophonic clips</td>
<td>When this option is selected, your Avid editing application adds a center pan effect to all monophonic clips on import.</td>
</tr>
</tbody>
</table>
### Import Settings: XDCAM Tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Force import of both Proxy &amp; High-resolution</td>
<td>When this option is selected, your Avid editing application imports both proxy and high-resolution versions of the selected file or files. When this option is deselected, your Avid editing application imports only the selected files (proxy or high-resolution). Your Avid editing application imports proxy files first.</td>
</tr>
<tr>
<td>Only import clips with Good Shot Flag</td>
<td>When this option is selected, your Avid editing application restricts XDCAM imports to only those clips described with the OK or KP (keep) flag. You can flag clips with these and other descriptive values in the Sony proxy browser software.</td>
</tr>
<tr>
<td>Batch import High-resolution Video</td>
<td>When this option is selected, your Avid editing application uses the Batch Import function to import high-resolution media from the XDCAM device and automatically conform it with the low-resolution proxy media. Type the number of frames you want to use as handles for batch imported clips in the Handle Length: ( nn ) Frames text box. Handles refer to material outside the IN and OUT points that you can use for dissolves and trims with the new, shorter master clips. The default is 30.</td>
</tr>
<tr>
<td>Automatically import Proxies when disk is inserted</td>
<td>When this option is selected, your Avid editing application imports all proxy media stored on the XDCAM disc when you insert the disc in the XDCAM device. Deselect this option if you want to import only selected media files.</td>
</tr>
<tr>
<td>Import Essence Marks as Markers</td>
<td>When this option is selected, your Avid editing application imports XDCAM Essence Marks as markers that you can display in the Source/Record monitor or in the Markers Window.</td>
</tr>
</tbody>
</table>
### Interface Settings

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Convert Proxy Audio to Project Rate during Import</td>
<td>When this option is selected, your Avid editing application converts the sample rate for proxy media (8 kHz) to the project rate when you import the media. This option is selected by default.</td>
</tr>
<tr>
<td>Import Audio Channels</td>
<td>Defines the maximum number of audio channels to import: 2, 4, 6, or 8. For example, if a file has 8 channels of audio, you can select 8 to import all 8 channels or you can select 2 to import only the first 2 channels of audio.</td>
</tr>
</tbody>
</table>

### Option Description

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interface Brightness</td>
<td>Controls the brightness of the user interface.</td>
</tr>
<tr>
<td>Preview</td>
<td>Displays a preview of the foreground color as you move the Interface Brightness slider.</td>
</tr>
<tr>
<td>Highlight Color</td>
<td>Lets you select the color of button highlighting from available presets.</td>
</tr>
<tr>
<td>Default Timeline V Tracks</td>
<td>Selecting this option sets the color of all Timeline video tracks to the default. If you change the track color for a video track, this option changes to deselected.</td>
</tr>
<tr>
<td>Default Timeline A Tracks</td>
<td>Selecting this option sets the color of all Timeline audio tracks to the default. If you change the track color for an audio track, this option changes to deselected.</td>
</tr>
<tr>
<td>Default Timeline TC Tracks</td>
<td>Selecting this option sets the color of the Timeline timecode track to the default. If you change the track color for the timecode track, this option changes to deselected.</td>
</tr>
<tr>
<td>Allow Custom Bin Backgrounds</td>
<td>When you select this option, you can set custom background colors for bins.</td>
</tr>
<tr>
<td>Show Labels in Tool Palette</td>
<td>When this option is selected, your Avid editing application displays text labels with the icons on the Tool palette. This option is selected by default.</td>
</tr>
<tr>
<td>Show ToolTips</td>
<td>When this option is selected, your application displays labels for buttons and icons when you position the mouse pointer over them. This option is selected by default. You can also turn ToolTips on and off from the Help menu.</td>
</tr>
<tr>
<td>Delay (n) seconds before showing</td>
<td>Controls the length of the delay before tooltip labels display. This lets you move the mouse pointer across the interface without displaying the labels on items between the starting point and the destination of the mouse pointer.</td>
</tr>
</tbody>
</table>
You need to configure your Avid editing application before you can interact with the asset manager. For more information, see the *Avid Interplay Installation Guide*.

### Interplay Folder Settings

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interplay Root Folder for this Project</td>
<td>Defines the default directory for your workgroup project (where the asset manager checks in media assets).</td>
</tr>
</tbody>
</table>
Keyboard Settings

The following illustration displays the default keyboard settings.
To view the name of a button in the Keyboard settings window, move the mouse pointer over the button. To get help for the button, right-click and select What’s This?

For information on mapping buttons, see “Mapping User-Selectable Buttons” on page 131.

When you open the Keyboard palette from the Settings list and select Map Foreign Keyboard, you can map user-selectable buttons to the keyboard. If the Windows operating system is set to French or German regional settings, and you click the center of the Enter key in the Keyboard palette, foreign keyboard mapping mode turns off. To return to foreign keyboard mapping mode, Select Standard, and then select Map Foreign Keyboard again.

Marquee Title Settings

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create New Title using</td>
<td>Controls which Title tool your Avid editing application uses when you select Clip &gt; New Title or Tools &gt; Title Tool:</td>
</tr>
<tr>
<td></td>
<td>• Marquee: Your Avid editing application always opens Marquee.</td>
</tr>
<tr>
<td></td>
<td>• Title Tool: Your Avid editing application always opens the classic Title Tool.</td>
</tr>
<tr>
<td></td>
<td>• Ask me: Your Avid editing application displays the New Title dialog box. You can then select either Marquee or the Title Tool. This is the default setting.</td>
</tr>
</tbody>
</table>
Media Creation Settings

For more information about options in the Media Creation Settings dialog box, see “Selecting Video Resolutions and Media Drives” on page 176.

Media Creation Settings: Drive Filtering & Indexing Tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Promote Title Tool titles to Marquee</td>
<td>Controls whether your Avid editing application promotes classic Title Tool titles to Marquee when you open the title for editing from a bin or from within a sequence:</td>
</tr>
<tr>
<td></td>
<td>• Yes: Your Avid editing application always promotes a Title Tool title to a Marquee title. For more information, see “Promoting Title Tool Titles to Marquee” in the Marquee Help.</td>
</tr>
<tr>
<td></td>
<td>• No: Your Avid editing application never promotes a Title Tool title to a Marquee title.</td>
</tr>
<tr>
<td></td>
<td>• Ask me: Your Avid editing application displays the Edit Title dialog box. You can then choose whether to promote the title to Marquee. This is the default setting.</td>
</tr>
<tr>
<td>Backup Title on Promote</td>
<td>When this option is selected, your Avid editing application creates a backup Title Tool version of any title that it promotes to Marquee. The backup copy is a fast-saved (unrendered) title with [TT] added to the name of the backup copy to differentiate it from the newly created Marquee version.</td>
</tr>
</tbody>
</table>

Option | Description                                                                                                                                                                                                                                                                                                                                                                                                                                                                 |
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter Network Drives Based on Resolution</td>
<td>Removes as a storage choice network drives that cannot support the selected resolution or cannot play back the selected resolution.</td>
</tr>
<tr>
<td>Filter Out System Drive</td>
<td>Removes as a storage choice the drive on which the operating system resides.</td>
</tr>
<tr>
<td>Filter Out Launch Drive</td>
<td>Removes as a storage choice the drive on which your Avid editing application resides.</td>
</tr>
<tr>
<td>Auto-index local drives as they come online</td>
<td>Enables automatic indexing of local drives by the Media Indexer, a background service that keeps track of the media files in storage locations that you identify. Auto-indexing uses filtering selections on the left side of the tab, so that if you select “Filter Out System Drive,” any media on that drive is not indexed. For more information about configuring the Media Indexer, see the Avid Interplay Software Installation Guide.</td>
</tr>
<tr>
<td>Manual Storage Scan</td>
<td>Enables immediate indexing of local drives by the Media Indexer. If the Auto-index option is deselected, you can click this button to index local drives and folders. You can then use the Interplay Service Configuration tool to remove specific drives or folders.</td>
</tr>
</tbody>
</table>
Media Creation Settings

Media Creation Settings: Common Options in Capture, Titles, Import, Mixdown & Transcode, Motion Effects, and Render Tabs

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>On indexing failure</td>
<td>Determines how your Avid editing application reports indexing failure messages. For information on using the Console, see “Using The Console Window” on page 134.</td>
</tr>
</tbody>
</table>

Media Creation Settings: Additional Options for Capture Tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video Resolution</td>
<td>Select a resolution.</td>
</tr>
<tr>
<td>Apply to All</td>
<td>Applies your chosen resolution to all the Media Creation dialog box tabs, and to any other place in your Avid editing application where you select a resolution.</td>
</tr>
<tr>
<td></td>
<td><em>The resolution options are not available in the Motion Effects tab.</em></td>
</tr>
<tr>
<td></td>
<td><em>Your Avid editing application always renders an effect at the highest resolution used in the effect source clips.</em></td>
</tr>
<tr>
<td>Video/Audio Drive</td>
<td>Defines the drives your Avid editing application uses to store video and audio media. In the Titles tab, only a Video Drive option is available.</td>
</tr>
<tr>
<td>Apply to All</td>
<td>Applies your chosen video and audio drives to all the Media Creation dialog box tabs, and to any other place in your Avid editing application where you select drives.</td>
</tr>
<tr>
<td></td>
<td><em>The DID and SDID information captured with the data clip displays in the bin.</em></td>
</tr>
</tbody>
</table>

Media Creation Settings: Additional Options for Capture Tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Slot</td>
<td>Displays slot number 1-4.</td>
</tr>
<tr>
<td>Data Type</td>
<td>Defines the type of ancillary data you want to assign to a particular slot.</td>
</tr>
<tr>
<td>DID and SSID</td>
<td>Displays the DID and SDID number values for the ancillary data packets that your Avid editing application captures and preserves by default.</td>
</tr>
<tr>
<td>Enable</td>
<td>Lets the system capture the ancillary data selected to the slot on the system.</td>
</tr>
<tr>
<td>Ancillary Data Mode</td>
<td>This option varies depending on your Avid input/output hardware:</td>
</tr>
<tr>
<td>Setting (Avid Nitris DX or Avid Mojo DX)</td>
<td>(Avid Nitris DX or Avid Mojo DX only) Choose between SMPTE 436M or Legacy. To capture to a data track, select SMPTE 436M or to capture ancillary data to a DNxHD video file, select Legacy</td>
</tr>
</tbody>
</table>
### Media Creation Settings: Additional Options for Render Tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Same as Source</td>
<td>When this option is selected, your Avid editing application renders the effect using the resolution of the clip or clips used to create the effect. If an effect is created from clips that use different resolutions, your Avid editing application uses the highest quality resolution.</td>
</tr>
<tr>
<td>Effects Processing</td>
<td>Controls the resolution (bit depth) used for effects processing. The following options are available:</td>
</tr>
<tr>
<td></td>
<td>• 8-bit: Select this option when rendering time is more important than image quality. Also use this option if you are mainly working with effects that don’t support 16-bit precision.</td>
</tr>
<tr>
<td></td>
<td>• 16-bit: Select this option for the best overall image quality. Use this option if you use 10-bit resolutions, use many levels of nested effects, or want the best color fidelity for rendered effects.</td>
</tr>
<tr>
<td></td>
<td>• Automatic: Select this option if you want the media source to determine the effects resolution. This is the default.</td>
</tr>
<tr>
<td>Save after Render</td>
<td>When this option is selected, your Avid editing application saves open bins after you perform a render operation.</td>
</tr>
<tr>
<td>AMA Source Scaling/Quality</td>
<td>Sets the playback quality for AMA plug-ins that support adjustable playback quality (e.g. RED, Sony HDCAM-SR, Sony RAW, AVCHD, and ARRI RAW). You can choose Full, Half (Best Quality), Half (Good Quality), Quarter, Eighth, Sixteenth.</td>
</tr>
</tbody>
</table>

### Media Creation Settings: Media Type Tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video File Format</td>
<td>Defines the video file format, either Open Media Format (OMF) or Material Exchange Format (MXF). This option applies to video format menus in the Capture tool, the Consolidate/Transcode dialog box, and other places in your Avid editing application. For more information, see “File Format Specifications” on page 1540.</td>
</tr>
</tbody>
</table>

*If your project uses an HD resolution, you cannot select OMF as a file format. MXF is selected by default.*
**Media Services Settings (Windows Only)**

The Media Services Settings dialog box lets you connect to a Media Services Broker. You use the services provided by Avid Interplay Media Services Broker in an Avid Interplay environment where dedicated computers automate time-consuming operations. For more information, see the *Avid Interplay Media Services Setup and User’s Guide*.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Media Services are available</td>
<td>Ensures that you are connected to the Media Services Broker. Deselect this option to disconnect without losing your setting information.</td>
</tr>
<tr>
<td>Broker</td>
<td>Defines the Broker name as it appears in the Media Services Broker application window, for example: http:\myBrokerPC:8080</td>
</tr>
<tr>
<td></td>
<td>Consult your Media Services Broker administrator for this information.</td>
</tr>
<tr>
<td>Username</td>
<td>Defines your Media Services Broker username.</td>
</tr>
<tr>
<td>Password</td>
<td>Defines your Media Services Broker account password.</td>
</tr>
<tr>
<td>Shared Storage</td>
<td>Defines the directory where you intend to save QuickTime reference movies that the service creates. You can click the Browse button to locate the directory.</td>
</tr>
<tr>
<td>Notify me of job completion by email</td>
<td>When this option is selected, you are notified by email when jobs complete.</td>
</tr>
<tr>
<td>Email address</td>
<td>If you select “Notify me of job completion by email,” type your e-mail address.</td>
</tr>
<tr>
<td></td>
<td><em>You can also check the Avid Interplay Media Services Broker Jobs window to see the status of your job.</em></td>
</tr>
</tbody>
</table>

**Mouse Settings**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scroll Wheel Behavior —</td>
<td>Controls the speed of scrolling with the mouse wheel within your Avid editing application — Normal, Moderate, or Fast. For more information, see “Using the Mouse Scroll Wheel for Navigating” on page 62.</td>
</tr>
<tr>
<td>Vertical Scroll Speed</td>
<td></td>
</tr>
<tr>
<td>Mouse Button Assignments</td>
<td>Assigns functions to three additional mouse buttons. Drag buttons from the Command Palette. For more information, see “Customizing Mouse Functions” on page 62.</td>
</tr>
</tbody>
</table>
NRCS Settings
(Media Composer | NewsCutter Option)

For more information about options in the NRCS Settings dialog box, see “Configuring the NRCS Tool” on page 1162.

NRCS Settings: NRCS Tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server</td>
<td>Defines the name of the server.</td>
</tr>
<tr>
<td>Server menu</td>
<td>Defines the type of NRCS server (iNEWS or ENPS) you want to connect to. The second tab in the NRCS Settings dialog box changes to match the selection.</td>
</tr>
<tr>
<td>Default User Name (iNEWS only)</td>
<td>Defines a default iNEWS user name.</td>
</tr>
<tr>
<td>Logout when NRCS Tool is closed</td>
<td>When this option is selected, your Avid editing application terminates the connection to the server every time you close the NRCS tool.</td>
</tr>
<tr>
<td>Automatic update from server</td>
<td>When this option is selected, iNEWS updates the information in the NRCS tool periodically. Enter a time interval in the Update interval text box to set the time interval between updates. The default interval is 1 minute.</td>
</tr>
</tbody>
</table>

NRCS Settings: iNEWS Tab (iNEWS Only)

The following table describes the options in the iNEWS tab.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Message-of-the-Day</td>
<td>When this option is selected, a Message-of-the-Day (MOTD) displays. Select either Every Connection (to see the message on every connection) or First Connection (to see the message only on the first connection of the day).</td>
</tr>
<tr>
<td>Message-of-the-Day Directory</td>
<td>Defines the name of the MOTD directory if it is not the default directory on the server (SYSTEM.MESSAGE).</td>
</tr>
<tr>
<td>Mail Directory</td>
<td>Defines the name of the folder where you want your mail saved.</td>
</tr>
</tbody>
</table>
### NRCS Settings (Media Composer | NewsCutter Option)

#### NRCS Settings: ENPS Tab (ENPS Only)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Create Sequence” Data</td>
<td>When you use the Build Sequence button a to create a sequence from a story, the new sequence uses the specified Duration (tape-time), Name (title), and TapeID (video-id) from the iNEWS story fields setting. If you want to use another iNEWS field for the metadata, type the name of the story field in the appropriate text box. Type the default time you want for new sequences in the Default Value text box. If the heading in the Story Form is empty or is zero, you can set a default value for the duration of the new sequence.</td>
</tr>
<tr>
<td>Browser Fields</td>
<td>When this option is selected, the Labels text boxes list the column headings available for display in the Directory panel of the NRCS tool. If you want to change the default label, type a new name in the appropriate text box.</td>
</tr>
</tbody>
</table>
NRCS Settings: Post to Web Tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include Closed Caption (green) text</td>
<td>Converts all text marked as Closed Caption to plain text.</td>
</tr>
<tr>
<td>Add paragraph tags (&lt;p&gt;) at the start of new lines</td>
<td>Converts line breaks into paragraph breaks, so each line is displayed as a separate paragraph on the Web page.</td>
</tr>
</tbody>
</table>

> Web formatting ignores line breaks that are the result of the text wrapping within the Story text box. It converts only those line breaks created when the user enters a new line.

Convert story to lowercase

The following options are available:

- **Always**: Converts all stories to lowercase characters, even if the source script contains both uppercase and lowercase text.
- **Only if story is all UPPERCASE**: Converts only those stories with no lowercase characters.

Passthrough Mix Tool

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Passthrough Mix Tool</td>
<td>See “Using the Passthrough Mix Tool” on page 215.</td>
</tr>
</tbody>
</table>

PortServer Settings

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto-connect to LANshare at Launch</td>
<td>Your Avid editing application recognizes LANshare workspaces when it starts.</td>
</tr>
<tr>
<td>Connect/Disconnect</td>
<td>Starts or terminates the connection.</td>
</tr>
</tbody>
</table>
Remote Play and Capture Settings

Remote Play and Capture lets you use your Avid editing application like a videotape recorder (VTR) or edit controller, giving you access to some of the features of an external editing suite through your Avid editing application interface.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mode</td>
<td>When Remote Capture is selected, your Avid editing application captures the media being sent to it immediately without setting up parameters like IN and OUT points. Select this option when you want to perform a quick capture. This mode is also known as crash record. Remote Capture supports record and stop with the controller. When Remote Play is selected, you can control sequences via an edit controller. Remote Play supports play, cue, and stop. When Remote Punch-In is selected, you can perform a quick audio punch-in. Remote Punch-In allows your Avid editing application to record the audio being sent to it immediately without setting up all parameters, such as OUT points. Remote Punch-In supports play, cue, record, and stop with an external controller.</td>
</tr>
<tr>
<td>Device Code</td>
<td>Defines the device code that identifies the VTR to emulate. The edit controller adjusts to this choice. The default value is a Sony PVW-2800, which performs all the common play and capture functions. You do not need to change this option unless your edit controller does not recognize the VTR or you want to emulate a specific VTR.</td>
</tr>
<tr>
<td>Runup (frames)</td>
<td>This option is only available with Remote Play. Defines the time (measured in frames) it takes the deck to start playing from a cued position. The default value is 1 frame. When the runup times of two video devices are similar, it is easier for the edit controller to synchronize the devices during preroll. If your Avid VTR does not sync up as often as you want, try adjusting this value so the two devices attain full speed at nearly the same time.</td>
</tr>
<tr>
<td>Inhibit preloading when cueing by single frame.</td>
<td>This option is only available with Remote Play and Remote Punch-In. Avid recommends that you do not inhibit preloading under normal circumstances. Preloading occurs by default in your Avid editing application. It improves playback performance by preparing the digital media for playback each time you cue a new frame. When this option is selected, your Avid editing application matches the behavior of a tape deck when you step through footage frame by frame. Avid recommends this option only for projects that require quick cueing of one frame after another, for example, when you are using your Avid editing application to present a sequence of still images as in a slide presentation.</td>
</tr>
</tbody>
</table>
### Render Settings

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Image Interpolation</strong></td>
<td>This option allows you to choose filtering quality vs. speed.</td>
</tr>
<tr>
<td></td>
<td>• Advanced (Polyphase) is the highest quality option, but is the most demanding. Images will appear sharpest with this option.</td>
</tr>
<tr>
<td></td>
<td>• Standard (Bilinear) trades some quality for better performance.</td>
</tr>
<tr>
<td></td>
<td>• Draft (Nearest Neighbor) is a low quality option that requires very little processing and is fastest.</td>
</tr>
<tr>
<td><strong>Timewarps Render Using</strong></td>
<td>Determines the processing method when your Avid editing application render or rerenders Timewarp effects.</td>
</tr>
<tr>
<td></td>
<td>The Original Preference, Duplicated Field, Both Fields, Interpolated Field, and VTR-Style options are the same as those for Motion Effects Render Using (see the preceding descriptions).</td>
</tr>
<tr>
<td></td>
<td>The Blended Interpolated and Blended VTR options are also available. These options add pixel blending to the Interpolated Field or VTR-Style techniques. Your Avid editing application blends, or averages, pixels from the original frames or fields to create intermediate frames or fields. For example, at 25% speed, your Avid editing application creates three blended images between outgoing Image A and incoming Image B. The first blended image weights the pixels from Image A at 75% and Image B at 25%, the second weights the pixels from Image A at 50% and Image B at 50%, and the third weights the pixels from Image A at 25% and Image B at 75%. Objects in motion from Image A to Image B appear to fade out of Image A and fade in to Image B.</td>
</tr>
<tr>
<td></td>
<td>Timewarp effects that render using Blended Interpolated or Blended VTR render less quickly than Interpolated Field or VTR-Style.</td>
</tr>
</tbody>
</table>
Motion Effects Render Using

Determine the processing method when your Avid editing application renders existing motion effects. The following options are available:

- Original Preference: Effects render as whatever type they were when originally created.
- Duplicated Field: Displays a single field in the effect. For two-field media, this drops one field of the image, resulting in a lower quality image. For single-field media, this is usually the best choice because of its speed (the other options do not improve effect quality for single-field media).

With JFIF resolutions, this option causes the effect to render in the shortest amount of time. With DV and MPEG resolutions, the effect renders approximately as quickly as it would if you select Both Fields as the rendering option.

You can use this option to remove unwanted field motion in interlaced material brought into a progressive project.

- Both Fields: Displays both fields in the effect. For example, the first two frames of a half-speed (50%) slow-motion effect repeat the original Frame 1 (both fields) twice. This option is good for shots without inter-field motion, NTSC or PAL film-to-tape transfers, and still shots. With footage that includes inter-field motion, this option might result in minor shifting or bumping of the image because it disturbs the original order of fields: a Field 1 appears both before and after the corresponding Field 2.

The effect renders relatively quickly. For best results with this option, use evenly divisible frame rates.

- Interpolated Field: Creates a second field for the effect by combining scan line pairs from the first field in the original media. This option calculates the motion effect at the field level rather than the frame level. Because your Avid editing application considers all fields and does not disturb the original order of fields, the smoothest effect results.

Effects that render using this option take the longest amount of time to render.

- VTR-Style: Creates a second field for the effect by shifting selected video fields of the original media by a full scan line. High-quality professional video decks use a similar technique when playing footage at less than normal speed. This option also creates the motion effect at the field level rather than the frame level. However, because pixels are not filtered, the final image is sharper than that created by the Interpolated Field option. The image might jitter slightly at certain speeds.

Effects that render using this option take longer to render than effects created using either Duplicated Field or Both Fields, and a similar time to those created using Interpolated Field.
Render Completion Sound

- None: Disables the rendering completion sound. This is the default.
- System Beep: Sets the rendering completion sound to match the sound set for your operating system.
- Render Sound: Sets the rendering completion sound to a customized sound. On Macintosh systems, several customized sound choices are available.

Use frame blending in Motion Adapters.

When clips of a different frame rate than the sequence are dropped on the timeline, a motion adapter is automatically applied. Motion Adapter effects allow mixed rate clips to play at the project’s frame rate and to have the correct field motion.

The frame blending setting will give you some flexibility with mixed-rate media by offering a choice between temporal smoothness and spatial smoothness. It controls whether or not any new motion adapters use the Blended Interpolated render option.

When this option is selected, the Blended Interpolated mode is used. The behavior is the same as previous versions of Media Composer, and uses Blended Interpolated for most motion adapters. When it is not selected, the Interpolated Field mode is used for interlaced clips, and Both Fields mode is used for progressive clips.

Changing this setting does not have any effect on existing motion adapters. If you want to apply this to an existing motion adapter, you will need to reload the cross-rate source clips into the source viewer after changing the setting.

---

### S3D Settings

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unit System</td>
<td>Choose between Imperial or Metric units of measure.</td>
</tr>
<tr>
<td>Viewing Distance</td>
<td>Enter the average distance between the audience and the screen.</td>
</tr>
<tr>
<td>Screen Width</td>
<td>Enter the width of the screen for which the final output will be delivered.</td>
</tr>
<tr>
<td>Raster Resolution</td>
<td>Enter the resolution at which the final output will be projected.</td>
</tr>
<tr>
<td>Eye Separation</td>
<td>Set the average intra-ocular distance between human eyes (the default is 6.35 cm).</td>
</tr>
</tbody>
</table>
**Safe Colors Settings**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Depth Limit Near</td>
<td>Enter the depth budget available in front of the screen. This is always a negative value.</td>
</tr>
<tr>
<td>Depth Limit Far</td>
<td>Enter the depth budget available behind the screen. This is always a positive value.</td>
</tr>
<tr>
<td>Parallax Near</td>
<td>This distance is automatically calculated. If you set the drop-down button to manual, you may override the calculated setting.</td>
</tr>
<tr>
<td>Parallax Far</td>
<td>This distance is automatically calculated. If you set the drop-down button to manual, you may override the calculated setting.</td>
</tr>
</tbody>
</table>

**Option** | **Description**
---|---
Composite | Defines safe color values for the composite video signal.
Luminance | Defines safe color values based on brightness.
RGB Gamut | Defines safe color values based on color range.
Units buttons | Define the units of measurement for the three types of safe color values.
The following options are available for the Luminance and RGB Gamut menus:
• 8 Bit: Measures the adjustment on a scale from 0 to 255.
*The RGB value for a color in the Color Correction tool is not identical to the RGB value for the same color in a graphics application such as Adobe Photoshop. For example, the 8-bit RGB values for reference black and reference white are 16 and 235 respectively.*
• %: Measures the adjustment on a percentage scale from 0 to 100.
• IRE: Measures the adjustment in IRE units.
• mVolts: Measures the adjustment in millivolts.
For the Composite Units menu, only the IRE and the mVolts (millivolts) options are available.
Actions buttons Define how your Avid editing application implements the safe color settings. The top menu controls both the Composite and the Luminance limit types. The bottom menu controls the RGB Gamut limit type. The following options are available:

- Ignore: Your Avid editing application does not limit based on these settings. This is the default setting.
- Warn: Your Avid editing application provides warnings when an image exceeds these limits. For more information on safe color warnings, see “Understanding Safe Color Warnings” in the Help.

### Script Settings

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Font</td>
<td>Defines the font for imported scripts.</td>
</tr>
<tr>
<td>Size</td>
<td>Defines the font size. The default is 12 points.</td>
</tr>
<tr>
<td>Left Margin (pixels)</td>
<td>Defines the left margin size. The default is 40 pixels.</td>
</tr>
<tr>
<td>Take Coloring</td>
<td>Defines the color that your Avid editing application applies to takes.</td>
</tr>
<tr>
<td>Show Frames</td>
<td>When this option is selected, your Avid editing application shows frames in take slates.</td>
</tr>
<tr>
<td>Show All Takes</td>
<td>When this option is selected, your Avid editing application shows all takes in each slate. When this option is deselected, your Avid editing application displays only one take per slate.</td>
</tr>
<tr>
<td>Interpolate Position</td>
<td>When this option is selected, you can click in a take line within a script, and the image in the Source monitor updates to the approximate position in the take where you have clicked. If you deselect this option, the Source monitor does not respond when you click in a take line.</td>
</tr>
<tr>
<td>Hold Slates Onscreen</td>
<td>When this option is selected, slates stay on the screen when you scroll through a script in the Script window. Each slate remains on the screen as long as the take lines to which it is linked remain on the screen.</td>
</tr>
</tbody>
</table>
Sound Card Configuration Settings (Windows Only)

Sound Card Configuration Settings are only available in software-only configurations.

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record/Input list</td>
<td>Lists the input sources available with the audio hardware installed on your system.</td>
</tr>
<tr>
<td>Playback/Output list</td>
<td>Maps input sources to the output sources available with the audio hardware installed on your system. The options available on your system determine which sources are listed as sub-options. Select &lt;No Match&gt; if you do not want an input source mapped to an output source.</td>
</tr>
<tr>
<td>Override Source menu</td>
<td>Lets you override settings made by your Avid editing application and accept the default settings of the Windows Master Volume control. The options available on your system determine which sources are listed as sub-options.</td>
</tr>
<tr>
<td>Use Windows Mixer</td>
<td>When this option is selected, all options in the dialog box are deselected, and your Avid editing application allows the Windows mixer to map input sources to output sources.</td>
</tr>
<tr>
<td>Audio device name</td>
<td>Lists the sound card installed on your system.</td>
</tr>
</tbody>
</table>

Timeline Settings

Timeline Settings: Display Tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Toolbar</td>
<td>When this option is selected, the Timeline top toolbar displays.</td>
</tr>
<tr>
<td>Show Marked Region</td>
<td>When this option is selected, the region from the IN point to the OUT point is highlighted in the Timeline. This option modifies the behavior of the Replace Edit function. When this option is selected, Replace Edit obeys IN and OUT marks in the Timeline. When this option is deselected, Replace Edit ignores IN and OUT marks in the Timeline. For more information, see “Performing a Replace Edit” on page 593.</td>
</tr>
<tr>
<td>Show Marked Waveforms</td>
<td>When this option is selected, your Avid editing application draws waveforms between an IN point and an OUT point instead of over the entire composition.</td>
</tr>
</tbody>
</table>
### Timeline Settings

**Option** | **Description**
---|---
Highlight Suggested Render Areas After Playback | When this option is selected, thin colored indicator lines display in the Timecode track of the Timeline. These lines provide information about the real-time effects in your sequence. For more information, see “Real-Time Playback of Video Effects” in the Help.

Show Position Bar | When this option is selected, the Timeline shows the blue position bar.

Show Effect Contents | When this option is selected, your Avid editing application displays effect information in the Timeline.

Double-Click to Show Nesting | When this option is selected, your Avid editing application lets you double-click segments in the Timeline to display the nested effects.

Show Four-Frame Display | When this option is selected, your Avid editing application shows the head and tail of incoming or outgoing frames of video when you drag a segment.

Use Fast Scrub | When this option is selected, your Avid editing application responds faster and more smoothly when you drag the position indicator through the Timeline (scrub). However, markers such as the start-of-clip and end-of-clip marks, sawtooth marks for IN and OUT points, and markers do not display, and some effects do not display completely in HD projects.

When this option is deselected, all markers and HD effects display. This is the default option.

Movement During Play | Select one option to control the movement of the Timeline while you play a sequence:
- Page — moves the Timeline section by section as the position indicator reaches the end of the visible Timeline.
- Scroll — moves the Timeline while keeping the position indicator stationary.
- None — keeps the Timeline stationary as the position indicator moves, even after the indicator goes beyond the end of the visible Timeline.

---

**Timeline Settings: Edit Tab**

**Option** | **Description**
---|---
Start Filler Duration | Defines a default duration for the filler added at the start of a sequence. For more information, see “Adding Filler” on page 587.

Find Flash Frames Shorter Than n frames | Defines the maximum number of flash frames you want your Avid editing application to detect. The default is 10, which tells your Avid editing application to detect clips with 9 frames or fewer. For more information, see “Finding Black Holes and Flash Frames” on page 728.
<table>
<thead>
<tr>
<th><strong>Option</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto-Patching</td>
<td>When this option is selected, your Avid editing application automatically patches the enabled source tracks to the tracks enabled in the Timeline sequence.</td>
</tr>
<tr>
<td>Auto-Monitoring</td>
<td>When this option is selected, your Avid editing application monitors the track you patch. This option is selected by default.</td>
</tr>
<tr>
<td>Segment Drag Sync locks</td>
<td>When this option is selected and you click the Sync Lock buttons in the Track Selector panel, your Avid editing application maintains audio and video synchronization when you drag clips in Segment mode. Your Avid editing application adds filler where necessary. For more information, see “Maintaining Sync with Segment Edits” on page 695.</td>
</tr>
<tr>
<td>Default Snap-To Edit</td>
<td>When this option is selected, clips snap to an existing transition endpoint when you drag them from a bin to the Timeline. When this option is deselected, clips move freely to any position on the track.</td>
</tr>
<tr>
<td>Default Sync Locks On</td>
<td>Enables sync locks on all video and audio tracks as the default Timeline setting.</td>
</tr>
<tr>
<td>Select Filler with Segment Tools</td>
<td>This option allows you to choose whether or not you want filler to be selected when using the Segment Tools.</td>
</tr>
<tr>
<td>Clicking the TC Track or ruler Disables Smart Tools</td>
<td>Allows you to disable all edit tools in the Smart tool on the Timeline palette by clicking either the Timeline ruler or the Timecode track.</td>
</tr>
<tr>
<td>Only One Segment Tool Can Be Enabled At A Time</td>
<td>Prevents both segment tools from being enabled at once.</td>
</tr>
<tr>
<td>Default Segment Tool</td>
<td>Specifies which segment tool — Segment Insert or Segment Overwrite — is enabled by default when you select segments for segment editing with no segment tools active on the Timeline palette.</td>
</tr>
<tr>
<td>New Sequences</td>
<td>Defines the number of video and audio tracks that display in the Timeline for new sequences. You can select a maximum of 24 video tracks and 24 audio tracks.</td>
</tr>
<tr>
<td>Lassoing transitions enters:</td>
<td><strong>Trim Mode</strong>: Select this option if you want the editing application to enter Trim Mode when lassoing transitions.</td>
</tr>
<tr>
<td></td>
<td><strong>Segment Mode</strong>: Select this option if you want the editing application to enter Segment Mode when lassoing transitions. This works only when the Keyframe Selection Tool is deselected.</td>
</tr>
</tbody>
</table>
Transfer Settings

The Transfer Settings dialog box appears only if your system is part of an Avid Interplay environment and you have configured Avid Interplay Transfer. For more information, see the *Avid Interplay Transfer Setup and User’s Guide*.

Settings Tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standalone/Incoming Requests</td>
<td>• Refuse all Requests — Select this option if you do not want to receive files from another workgroup.</td>
</tr>
<tr>
<td></td>
<td>• User Dialog To Accept/Refuse — Select this option if you want accept files from another workgroup, and then select one of the following dialog box options:</td>
</tr>
<tr>
<td></td>
<td>Accept/Refuse Dialog Behavior:</td>
</tr>
<tr>
<td></td>
<td>• Wait for User Action (No Timeout) — You receive a message request for a transfer. You must click OK for the transfer to occur.</td>
</tr>
<tr>
<td></td>
<td>• Accept after Timeout — The system automatically accepts the file after the timeout.</td>
</tr>
<tr>
<td></td>
<td>• Refuse after Timeout — The system does not accept the file after the timeout. You can specify the timeout period by typing the number of seconds in the Timeout (seconds) text box.</td>
</tr>
<tr>
<td>Status Window</td>
<td>Update Frequency (seconds): ([n]) — Type the number of seconds that you want the status window to update after in the text box.</td>
</tr>
<tr>
<td></td>
<td>Bring up window if error occurs — Select this option if you want errors to display.</td>
</tr>
</tbody>
</table>
Transfer Settings

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Send to Playback</td>
<td>• Highlight mixed-resolution items — This option allows you to identify any mixed-resolution sequences before you try to send them to playback.</td>
</tr>
<tr>
<td></td>
<td>Output Audio Mix</td>
</tr>
<tr>
<td></td>
<td>• Direct channel output — Select this option if you do not want to perform a mixdown on audio tracks before sending them to playback.</td>
</tr>
<tr>
<td></td>
<td>• Stereo Output — Select this option to mix all the tracks to a stereo pair, using pan controls to split the tracks.</td>
</tr>
<tr>
<td></td>
<td>• Multiple Mixes — Select this option if you want to assign audio tracks to specific output channels for the send to playback operation. Click Edit to open the Multiple Mixes dialog box, which allows you to map audio tracks to output channels. For more information, see “Mapping Audio Tracks to Output Channels” on page 1316.</td>
</tr>
<tr>
<td></td>
<td>Transcode</td>
</tr>
<tr>
<td></td>
<td>• Transcode before sending to playback — This option allows for the transcoding of clips before performing a send to playback operation.</td>
</tr>
<tr>
<td></td>
<td>• Minimum resolution warning threshold — allows you to specify the lowest resolution allowed to transcode before a warning message is displayed. The warning is on by default. If you do not want the warning to appear, deselect this option.</td>
</tr>
<tr>
<td>Tape ID character limit</td>
<td>Allows you to specify a Tape ID character limit during Send to Playback. Certain playback systems truncate Tape ID names that are too long. This option allows you to set the Tape ID name length.</td>
</tr>
</tbody>
</table>

**TMClient.ini Tab**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>My Workgroup</td>
<td>• Server — In a workgroup environment, type the Interplay Transfer server computer name. (This can be any name you give your workgroup.) In a standalone environment, type the computer name of the local system (this computer).</td>
</tr>
<tr>
<td></td>
<td>• Workgroup — In a workgroup environment, type the name of your workgroup. In a standalone environment, type the name you want to see in the Transfer menu.</td>
</tr>
<tr>
<td></td>
<td><em>If you want to edit the names of any of the Interplay Transfer servers or workstations listed in the Other Workgroups area, select the name, click Edit, and make the changes.</em></td>
</tr>
</tbody>
</table>
Trim Settings

Trim Settings: Play Loop Tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preroll</td>
<td>Defines a preroll value for a playback loop.</td>
</tr>
<tr>
<td>Postroll</td>
<td>Defines a postroll value for a playback loop.</td>
</tr>
<tr>
<td>Intermission</td>
<td>Defines a transition effect duration for a playback loop.</td>
</tr>
</tbody>
</table>

Trim Settings: Features Tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Never use Small Trim mode</td>
<td>When this option is selected, your Avid editing application enters Big Trim mode when you perform any operation that activates Trim mode. Big Trim mode replaces the Source and Record monitors with displays of outgoing and incoming frames.</td>
</tr>
<tr>
<td>“Go to Transition” uses Small</td>
<td>When this option is selected, your Avid editing application enters Small Trim mode only when you click the Go to Previous or Go to Next button.</td>
</tr>
<tr>
<td>Trim mode</td>
<td></td>
</tr>
<tr>
<td>Always use Small Trim mode</td>
<td>When this option is selected, your Avid editing application enters Small Trim mode when you perform any operation that activates Trim mode. Small Trim mode leaves the Source monitor display, Information Row displays, user tool palettes, and some Monitor menu functions intact. This option lets you continue to perform basic editing functions.</td>
</tr>
<tr>
<td>Auto focus when entering Trim</td>
<td>When this option is selected, your Avid editing application enlarges the Timeline at the transition selected for trimming if you enter trim mode with no trim editing tools selected on the Timeline palette.</td>
</tr>
<tr>
<td>mode</td>
<td></td>
</tr>
</tbody>
</table>
Video Display Settings

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Render On-the-Fly</td>
<td>When this option is selected, your Avid editing application displays the results of effects as soon as you create them. This might slow down the editing of the sequence.</td>
</tr>
<tr>
<td>Dual Image Play</td>
<td>When this option is selected, your Avid editing application enables dual-image play (dual-roller trim) while trimming. Outgoing and incoming frames display in real time while you trim your edit (adding or removing the same number of frames on both sides of a transition).</td>
</tr>
<tr>
<td>J-K-L Trim</td>
<td>When the J-K-L Trim option is selected, you can use the J-K-L keys in Trim mode. For more information, see “Trimming with the J-K-L Keys” on page 746.</td>
</tr>
</tbody>
</table>

**Video Display Settings**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DV Output Setting</td>
<td>The following options are available:</td>
</tr>
<tr>
<td></td>
<td>• Output to DV Device: Select this option if you have connected a DV device to a software-only system.</td>
</tr>
<tr>
<td></td>
<td>• Format: This option is available only if you have Output to DV Device selected and a device connected. Select the compressed format to send to the DV device.</td>
</tr>
<tr>
<td></td>
<td>• Realtime Encoding: This option is available only if you are in an SD project with Output to DV Device selected and a device connected. Lets you enable or disable real-time effects for better performance. For more information, see “Playing Back to a DV Device” on page 541.</td>
</tr>
<tr>
<td>Desktop Play Delay</td>
<td>Defines a frame offset in the Composer monitor so that the media on the desktop and the media in the DV device play simultaneously. For more information, see “Adjusting the Play Delay Offset” on page 528.</td>
</tr>
<tr>
<td>Open GL® Hardware Preview DVE effects with:</td>
<td>Defines the Open GL processing method. Select either the Open GL board for your video display, or Software OpenGL if you do not have an OpenGL video board. For more information, see “Options for Controlling Real-Time Effects Playback” in the Help.</td>
</tr>
<tr>
<td>Enable Confidence View</td>
<td>When this option is selected, you can view incoming media in the Record monitor while you are capturing. Deselect this option for better performance.</td>
</tr>
</tbody>
</table>
### Video Input Tool Settings

For information on how to use the Video Input Tool settings, see “Preparing to Capture Video” on page 221.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input menu</td>
<td>Defines the video input for SD projects: Composite, Component, S-Video, or SDI. For HD projects, the menu displays HD-SDI. For SD or HD projects, if you are capturing DV media through a 1394 port on your system, the menu displays Host-1394. For more information, see “Capturing Directly from a DV Device” on page 243.</td>
</tr>
</tbody>
</table>
| Waveform Monitor and Vectorscope Monitor buttons | Opens or hides the Waveform monitor and the Vectorscope monitor.  

> *Your Avid editing application supports the SMPTE/EBU component standard for 625 timing and Betacam component levels for 525 timing. Your Avid editing application does not support the MII component video standard.*  

| Sliders | Let you change the value for each setting. |
Specific options apply to different projects, resolutions, and Avid input/output hardware. You might not see all of the following options in your Avid editing application. The Video Output tool is not available in software-only versions of Avid editing applications.

### Video Output Tool Settings: Options Tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Sync Lock          | Locks your output connection to the reference or an internal signal on the Avid input/output hardware. Your Avid editing application detects the type of Avid input/output hardware you have and displays the appropriate options from the following:  
  • Internal  
  • Reference  
  • REF 1  
  • REF 2  
  • TriLevel (on some models, your Avid editing application detects TriLevel Sync automatically so it does not appear as an option)  
  • Loop through                                                                                                                                                                                                                                                                 |
| HDMI Color Space   | Defines the color standard (either YCbCr or RGB) to use for your HDMI (High-Definition Multimedia Interface) output. You must have HDMI-compatible Avid input/output hardware attached to your system. If you are working in the YUV color space, the RGB option appears as Convert to RGB. If you are working in the RGB color space, crossconvert is not supported |
### Option (Continued) Description

| HDMI Format | SDInterlaced
|-------------|-------------
|             | SDProgressive
|             | HD

**Crossconvert** Defines a format to output an HD format from an HD sequence with a compatible frame rate. The options are specific formats (choices depend on the format of the sequence) or OFF.

**Downconvert** Defines how downconverted SD video is resized. The options are Anamorphic, Letterbox, Center Cut, or OFF.

#### Component Format

**VBI (DV resolutions unsupported)** Controls whether your Avid editing application preserves or blanks 5 lines above each field in NTSC and 8 lines above each field for PAL when you display a sequence or perform a digital cut. These lines store encoded information such as closed captioning, edgecodes or key numbers for film projects, or various interactive or enhanced TV codes.

- **Blank**: Your Avid editing application blanks the VBI (vertical blanking interval) information and lets you turn off its display. Your Avid editing application fills the vertical blanking interval with video black (RGB: 16, 16, 16). This is the default option.

- **Preserve**: Your Avid editing application preserves the VBI information for a digital cut (does not change the output signal).

If your facility uses VBI information, you add the VBI information to the video before you capture the footage. Your Avid editing application automatically captures VBI information when you capture footage.

You cannot preserve VBI information for DV or HD resolutions. You can only preserve VBI information for JFIF, uncompressed, and MPEG IMX resolutions.

You should only preserve vertical blanking information if you have a specific need for it. For more information see “Vertical Blanking Information” on page 1119.

Your Avid editing application saves the VBI value from session to session. You can change the value at any time before you perform a digital cut.

**Test Patterns** Lets you choose a test pattern for calibrating during output.

**S3D View** Set the display or output mode for your stereoscopic 3D sequence.

**Follow Project** Outputs at the project format settings.

**Mix** Outputs a 50/50 blend of both the left and right eye images.
<table>
<thead>
<tr>
<th>Option (Continued)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Difference</td>
<td>Outputs a blend of both left and right eyes, and highlights the difference between the two. Embossed areas show the differences, while gray pixels represent no differences.</td>
</tr>
<tr>
<td>Frame Compatible</td>
<td>Outputs both the left and right eye images as dictated by the project settings (side/side or over/under).</td>
</tr>
<tr>
<td>Full Frame</td>
<td>Outputs both the left and right eye at full resolution.</td>
</tr>
<tr>
<td>Mono</td>
<td>Outputs only one of the stereoscopic images.</td>
</tr>
<tr>
<td>Left</td>
<td>Outputs only the left eye image.</td>
</tr>
<tr>
<td>Right</td>
<td>Outputs only the right eye image.</td>
</tr>
<tr>
<td>Leading eye</td>
<td>Outputs only the image set as the leading eye on the stereoscopic clip.</td>
</tr>
<tr>
<td>Mono-Anaglyph</td>
<td>Outputs the image in grayscale with color highlights only where there are differences in the left and right eye. The pixels in each eye image can be mapped to the following color options:</td>
</tr>
<tr>
<td>Mono Red-Cyan</td>
<td>Uses red for the left eye and cyan for the right.</td>
</tr>
<tr>
<td>Mono Green-Magenta</td>
<td>Uses green for the left eye and magenta for the right.</td>
</tr>
<tr>
<td>Anaglyph</td>
<td>Outputs the image with the selected color highlights only where there are differences in the left and right eye. The pixels in each eye image can be mapped to any of the following color options:</td>
</tr>
<tr>
<td>Red-Cyan</td>
<td>Uses red for the left eye and cyan for the right.</td>
</tr>
<tr>
<td>Green-Magenta</td>
<td>Uses green for the left eye and magenta for the right.</td>
</tr>
<tr>
<td>Amber-Blue</td>
<td>Uses amber for the left eye and blue for the right.</td>
</tr>
<tr>
<td>Checkerboard</td>
<td>When this option is selected, your Avid editing application outputs the left and the right images simultaneously for stereoscopic viewing. The term “checkerboard” refers to the way in which blocks of the left and right images are displayed for stereoscopic viewing. You can set the block size accordingly.</td>
</tr>
<tr>
<td>Compare</td>
<td>Outputs a comparison between the left and right eye images using a diagonal split screen. You can set the comparison mode to 25, 50, or 75%.</td>
</tr>
<tr>
<td>Follow S/R</td>
<td>Outputs at the settings in the source/record monitors.</td>
</tr>
<tr>
<td>S3D Overlay</td>
<td>Outputs with disparity guides over the image.</td>
</tr>
<tr>
<td>Off</td>
<td>Does not display any disparity guides.</td>
</tr>
</tbody>
</table>
**Video Output Tool Settings**

The following options display disparity guides on the viewer so that you can see the depth budget limits when adjusting the separation between your stereo 3D images. The guides for Parallax are based on the project’s S3D settings (set from the Project window, Settings tab).

**Parallax Near**
Displays green guides that show the limits for objects that will appear in front of the screen plane.

**Parallax Far**
Displays blue guides that show the limits for objects that will appear behind the screen plane.

**Parallax Near/Far**
Displays both guides (green and blue) that show the limits for objects that will appear in front and behind the screen plane.

**Settings menu**
Lets you save the settings for an individual tape each time you calibrate bars.

<table>
<thead>
<tr>
<th><strong>Option (Continued)</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Output menu</strong></td>
<td>Lets you select either Component, Composite, S Video. On some systems, all outputs on the input/output hardware are active. Select an analog signal from the Output menu to calibrate for output. For more information, see “Calibrating for Video Output” on page 1059.</td>
</tr>
<tr>
<td><strong>H Phase</strong></td>
<td>Lets you adjust the horizontal blanking interval used to synchronize the timing of two or more video signals. Available on some systems for the S Video, Component, or Composite output.</td>
</tr>
<tr>
<td><strong>Hue</strong></td>
<td>Lets you adjust an attribution of color perception based on varying proportions of red, green, and blue in the video signal (also known as color phase). Available for S Video or Composite output.</td>
</tr>
<tr>
<td><strong>Sat</strong></td>
<td>Lets you adjust saturation, a measurement of chrominance or the intensity of color in the video signal. Available for S Video or Composite output.</td>
</tr>
<tr>
<td><strong>SC Phase</strong></td>
<td>Lets you adjust the subcarrier phase (the color-burst portion of a signal used to synchronize the timing of two or more video signals). Available for S Video or Composite output.</td>
</tr>
<tr>
<td><strong>Setup</strong></td>
<td>Lets you set the relative lightness and darkness of images. Available for S Video, Component, or Composite output.</td>
</tr>
<tr>
<td><strong>Gain</strong></td>
<td>Lets you adjust the variation of the lightest or brightest in comparison to the darkest portions of the image. Available for S Video or Composite output.</td>
</tr>
</tbody>
</table>

**Video Output Tool Settings: SD Cal Tab**

<table>
<thead>
<tr>
<th><strong>Option</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Output menu</strong></td>
<td>Lets you select either Component, Composite, S Video. On some systems, all outputs on the input/output hardware are active. Select an analog signal from the Output menu to calibrate for output. For more information, see “Calibrating for Video Output” on page 1059.</td>
</tr>
<tr>
<td><strong>H Phase</strong></td>
<td>Lets you adjust the horizontal blanking interval used to synchronize the timing of two or more video signals. Available on some systems for the S Video, Component, or Composite output.</td>
</tr>
<tr>
<td><strong>Hue</strong></td>
<td>Lets you adjust an attribution of color perception based on varying proportions of red, green, and blue in the video signal (also known as color phase). Available for S Video or Composite output.</td>
</tr>
<tr>
<td><strong>Sat</strong></td>
<td>Lets you adjust saturation, a measurement of chrominance or the intensity of color in the video signal. Available for S Video or Composite output.</td>
</tr>
<tr>
<td><strong>SC Phase</strong></td>
<td>Lets you adjust the subcarrier phase (the color-burst portion of a signal used to synchronize the timing of two or more video signals). Available for S Video or Composite output.</td>
</tr>
<tr>
<td><strong>Setup</strong></td>
<td>Lets you set the relative lightness and darkness of images. Available for S Video, Component, or Composite output.</td>
</tr>
<tr>
<td><strong>Gain</strong></td>
<td>Lets you adjust the variation of the lightest or brightest in comparison to the darkest portions of the image. Available for S Video or Composite output.</td>
</tr>
</tbody>
</table>
Video Output Tool Settings

### Option (Continued) Description

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Y Gain, RY Gain, BY Gain, Pr Gain, Pb Gain | Available for Component output only in some Avid input/output hardware configurations.  
- Y Gain: Lets you adjust Y Gain, a measurement of luma (Y) in the video signal that is the whitest point in the visible picture. Use color bars to set the white level.  
- RY Gain: Lets you adjust the red (R) minus luminance (Y) color-difference signal of an analog component system in the SMPTE NTSC video standard. The signal consists of the following base equation for red (R), green (G), and blue (B) components: \( R - Y = -0.587G - 0.114B + 0.701R \).  
- BY Gain: Lets you adjust the blue (B) minus luminance (Y) color-difference signal of an analog component system in the SMPTE NTSC video standard. The signal consists of the following base equation for red (R), green (G), and blue (B) components: \( B - Y = -0.587G + 0.886B - 0.299R \) * gain value.  
- Pr Gain: Lets you adjust the gain of the Pr color-difference signal (a scaled version of the RY signal) of an analog component system.  
- Pb Gain: Lets you adjust the gain of the Pb color-difference signal (a scaled version of the BY signal) of an analog component system. |
| System Phase | In some Avid input/output hardware configurations, lets you modulate the timing of the output signal and a reference signal. Available for S Video, Component, or Composite output. |
| SubPixel HPhase | Provides a fine adjustment of Horizontal phase. Available for S Video, Component, or Composite output. |
| Settings menu | Lets you save the settings for an individual tape each time you calibrate bars. Available for S Video, Component, or Composite output. |

### Video Output Tool Settings: HD Cal Tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output menu</td>
<td>Lets you select an HD component output, either Convert to HD Component RGB or HD Component YPbPr.</td>
</tr>
<tr>
<td>Gain</td>
<td>Lets you adjust a measurement of luma (Y) in the video signal that is the whitest point in the visible picture. Use color bars to set the white level. Available on some systems for HD Component RGB or HD Component YPbPr output.</td>
</tr>
</tbody>
</table>
## Video Satellite Settings

For information on the use of these settings, see the Video Satellite Guide provided by Avid.

<table>
<thead>
<tr>
<th>Option (Continued)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>B Gain</td>
<td>In some Avid input/output hardware configurations, lets you adjust the blue (B) minus luminance (Y) color-difference signal of an analog component system in the SMPTE NTSC video standard. Available for HD Component RGB (on some systems) or HD Component YPbPr output.</td>
</tr>
<tr>
<td>Pb Gain</td>
<td>In some Avid input/output hardware configurations, lets you adjust the gain of the Pb color difference output, scaled from BY using the BT. 709 color space in HD component systems. Available for HD Component YPbPr output.</td>
</tr>
<tr>
<td>R Gain</td>
<td>In some Avid input/output hardware configurations, lets you adjust the red (R) minus luminance (Y) color-difference signal of an analog component system in the SMPTE NTSC video standard. The signal consists of the following base equation for red (R), green (G), and blue (B) components: R–Y = −0.587G − 0.114B + 0.701R. Available for HD Component RGB or HD Component YPbPr output.</td>
</tr>
<tr>
<td>Pr Gain</td>
<td>In some Avid input/output hardware configurations, lets you adjust the gain of the Pr color-difference signal (a scaled version of the RY signal) of an analog component system. Available for component output only.</td>
</tr>
<tr>
<td>H Phase</td>
<td>Lets you adjust the horizontal blanking interval used to synchronize the timing of two or more video signals. Available on some systems for S Video, Component, or Composite output.</td>
</tr>
<tr>
<td>System Phase</td>
<td>Lets you modulate the timing of the output signal and a reference signal. Available for HD Component RGB or HD Component YPbPr output.</td>
</tr>
<tr>
<td>Settings menu</td>
<td>Lets you save the settings for an individual tape each time you calibrate bars.</td>
</tr>
</tbody>
</table>
## Workspace Linking Settings

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Link Timeline Mode Buttons to a Workspace:</td>
<td>Lets you link the mode buttons in the Timeline palette to a workspace. Clicking a linked mode button (Source/Record mode, Effects mode, Color Correction mode) opens the linked workspace.</td>
</tr>
</tbody>
</table>
This chapter contains specifications and notes that are useful when you are importing or exporting specific file formats.

- Specifications for Graphics (Image) Files
- Specifications for Animation Files
- Specifications for Importing OMFI Files
- Working with BWF Files
- Field Ordering in Graphic Imports and Exports

For more information on importing and exporting, see “Importing Files” on page 297, “Import Settings” on page 1502, “Exporting Frames, Clips, or Sequences” on page 1019, and “Export Settings” on page 1470.

Specifications for Graphics (Image) Files

Import Specifications for Supported Graphics File Formats

The following table contains specifications for the graphics file formats that your Avid editing application can import.

Bit depth refers to the color-depth resolution of the image. 2-bit images display in black and white. 8-bit images display in 256 colors. 16-bit images display in thousands of colors. 24-bit images display in millions of colors. 32-bit images display in millions of colors with an alpha channel.

An alpha channel determines regions of transparency in the picture when it is keyed over a background. An alpha channel must be straight and not premultiplied. Your Avid editing application does not properly import premultiplied alphas.
<table>
<thead>
<tr>
<th>Format and Default File Name Extension</th>
<th>Bit Depth Support</th>
<th>Alpha Channel Support</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alias (.als)</td>
<td>24-bit color, 8-bit grayscale</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>BMP (.bmp)</td>
<td>1-, 4-, 8-, and 24-bit</td>
<td>No</td>
<td>Four-bit BMP files saved with RLE compression are not supported. Photoshop does not support four-channel BMP files.</td>
</tr>
<tr>
<td>Chyron (.chr)</td>
<td>32-bit</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Cineon (.cin)</td>
<td>10-bit (logarithmic)</td>
<td>Not applicable</td>
<td></td>
</tr>
<tr>
<td>Framestore (.fs)</td>
<td>24-bit</td>
<td>No</td>
<td>Pixel aspect information saves with image data. When importing files generated from Video Toaster, select Force to Fit Screen.</td>
</tr>
<tr>
<td>IFF (.iff)</td>
<td>1-bit to 24-bit color; 1-bit to 8-bit grayscale; 64-color EHB; 4096-color HAM; 262,144-color HAM8; SHAM; A-HAM; A-RES</td>
<td>1-bit alpha only</td>
<td>Pixel aspect information saves with image data.</td>
</tr>
<tr>
<td>JPEG (.jpg)</td>
<td>24-bit color, 8-bit grayscale</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>OMFI (.omf)</td>
<td>See “Specifications for Importing OMFI Files” on page 1547.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PCX (.pcx)</td>
<td>Color-mapped and 24-bit color</td>
<td>Not applicable</td>
<td>PCX files with 1-bit color depth or odd-numbered pixel widths are not supported.</td>
</tr>
<tr>
<td>Photo CD (Macintosh only)</td>
<td>Not applicable</td>
<td>You must install QuickTime software and a compatible QuickTime driver for Photo CD to import Photo CD files. Most Photo CD files are high resolution. If a photo has a portrait orientation, the image is automatically rotated upon import. Use a paint or image-processing program to crop or resize the image before importing.</td>
<td></td>
</tr>
</tbody>
</table>
### Specifications for Graphics (Image) Files

<table>
<thead>
<tr>
<th>Format and Default File Name Extension</th>
<th>Bit Depth Support</th>
<th>Alpha Channel Support</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Photoshop (.psd)</td>
<td>RGB 8-bits/channel, RGB16 bits/channel, grayscale, indexed color, and duotone variations</td>
<td>Yes</td>
<td>Your Avid editing application can import multilayered graphics. For more information, see “Photoshop Graphics Import” on page 311. Duotone files are loaded as grayscale. Multichannel (greater than four channels) files and CMYK files are not supported.</td>
</tr>
<tr>
<td>PICT (.pic)</td>
<td>2-, 4-, 8-, 16-, and 32-bit</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Pixar (.pxr)</td>
<td>24-bit, 36-bit</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>PNG (.png)</td>
<td>1-bit to 32-bit</td>
<td>Yes</td>
<td>Transparent areas in a PNG file are interpreted as an alpha channel on import.</td>
</tr>
<tr>
<td>QRT (.dbw)</td>
<td>24-bit</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>Rendition (.6rn)</td>
<td>32-bit</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>SGI (.rgb)</td>
<td>8-bit or 16-bit grayscale; 8-bit grayscale plus 8-bit alpha channel; 24- and 48-bit color; 24-bit color plus 8-bit alpha channel; 64-bit (16 bits per component)</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Softimage (.pic)</td>
<td>24-bit plus 8-bit alpha</td>
<td>Yes</td>
<td>Pixel aspect information saves with the image. (Windows only) Double-clicking a Softimage file starts the application associated with PICT files because they use the same file name extension. Avoid double-clicking Softimage files to view them.</td>
</tr>
<tr>
<td>Sun Raster (.sun)</td>
<td>1-, 8-, or 24-bit</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>Targa (.tga)</td>
<td>8-, 15-, 16-, or 24-bit; 32-bit</td>
<td>Yes</td>
<td></td>
</tr>
</tbody>
</table>
Preparing Graphics Files for Import

Your Avid editing application can import graphics files that have a wide range of specifications. If necessary, you can make adjustments during the import process. However, graphics files that conform to basic specifications make the import process easier and more efficient. The following table summarizes the requirements for graphics files that you import into your Avid editing application.

<table>
<thead>
<tr>
<th>Format and Default File Name Extension</th>
<th>Bit Depth Support</th>
<th>Alpha Channel Support</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>TIFF (.tif)</td>
<td>8-bit color-mapped; 8-bit or 16-bit grayscale; 24- and 48-bit color; 24-bit color plus 8-bit alpha; 36-bit color plus 12-bit alpha; 42-bit color plus 14-bit alpha; 48-bit color plus 16-bit alpha</td>
<td>Yes</td>
<td>Multichannel (greater than four channels) files, Group 3-compressed (fax) files, CMYK files with extra channels and JPEG-compressed files are not supported. Four-channel files from Avid Matador™ are imported as three-channel files.</td>
</tr>
<tr>
<td>Wavefront (.rla)</td>
<td>32-bit and 64-bit</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>XWindows (.xwd)</td>
<td>1-, 2-, 4-, 8-, 16-, 24-, and 32-bit</td>
<td>No</td>
<td>Pixel aspect information (based on the video format) saves with image data. When importing, select Force to Fit Screen.</td>
</tr>
<tr>
<td>YUV (.yuv)</td>
<td>24-bit</td>
<td>No</td>
<td></td>
</tr>
</tbody>
</table>

Preparing Graphics Files for Import

Your Avid editing application can import graphics files that have a wide range of specifications. If necessary, you can make adjustments during the import process. However, graphics files that conform to basic specifications make the import process easier and more efficient. The following table summarizes the requirements for graphics files that you import into your Avid editing application.

<table>
<thead>
<tr>
<th>Aspect</th>
<th>Requirement</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frame size (4:3)</td>
<td>Square pixels: 648 x 486 (NTSC) 640 x 480 (NTSC DV) 768 x 576 (PAL)</td>
<td>These are the preferred sizes for NTSC and PAL. You can also use 720 x 540, in some situations, for both NTSC and PAL. Your Avid editing application stores these as non-square pixels. For more information, see “Frame Size for Imported Graphics” on page 1545.</td>
</tr>
<tr>
<td>Frame size (16:9)</td>
<td>Square pixels: 864 x 486 (NTSC anamorphic) 1024 x 576 (PAL anamorphic) 1280 x 720 (HD) 1920 x 1080 (HD)</td>
<td>Preferred sizes. SD media is stored by your Avid editing application as non-square pixels.</td>
</tr>
<tr>
<td>Alpha channel</td>
<td>White foreground (transparent), black background (opaque)</td>
<td>This is the standard for graphics, animation, and compositing packages. The graphics must have the alpha channel inverted on import.</td>
</tr>
</tbody>
</table>
### Specifications for Graphics (Image) Files

Before you import a graphics file, you can also use third-party image-editing software to make adjustments such as the following:

- Create the file in the appropriate size, resolution, and bit depth.
- Crop or color-correct an image.
- Eliminate jagged edges in an image by using the image-editing application’s anti-aliasing or high-quality option.
- Add transparency (to some formats) by adding an alpha channel.
- In some cases, convert an image file that does not support an alpha channel to a format that does, in order to add transparency.

You can import and key the image over video by using key effects within your Avid editing application. However, importing an image with an existing alpha channel provides the best results.

For more information, see the documentation for your image-editing software.

---

<table>
<thead>
<tr>
<th>Aspect</th>
<th>Requirement</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color mode</td>
<td>RGB</td>
<td>Other formats, including CMYK, can cause import errors. ITU-R 601 is used for SD and ITU-R 709 is used for HD. In HD projects, your Avid editing application automatically converts the media.</td>
</tr>
<tr>
<td></td>
<td>ITU-R 601</td>
<td></td>
</tr>
<tr>
<td></td>
<td>ITU-R 709</td>
<td></td>
</tr>
<tr>
<td>File format</td>
<td>Various</td>
<td>Your Avid editing application accepts many file formats for input. TIFF (.tif), PICT (.pct), and PNG (.png) are commonly used formats. See “Import Specifications for Supported Graphics File Formats” on page 1540.</td>
</tr>
</tbody>
</table>
| File field order| Odd (Upper field first) Even (Lower field first) | For interlaced media, your Avid editing application uses the following order:
  - NTSC (601 and DV): lower field first
  - PAL 601: upper field first
  - PAL DV: lower field first
  - HD Interlaced: upper field first
  If the field order of the graphic is not correct, select the field order of the graphic during import and your Avid editing application will reverse the fields appropriately.
  Field order does not apply to progressive media. See “Field Ordering in Graphic Imports and Exports” on page 1554. |
Frame Size for Imported Graphics

The table in this topic shows the frame sizes to use when creating and importing graphics and sequences. The table includes sizes for both square and non-square pixels.

Computer displays, most graphic and animation programs, and most HD video formats use square pixels. Standard-definition (SD) digital video does not use square pixels. The ITU-R 601 standard specifies a 720-pixel width for both NTSC and PAL. However, because NTSC and PAL each has a different number of scan lines (486 for NTSC, 576 for PAL), digital video pixels are stretched vertically for NTSC and horizontally for PAL. These stretched pixels are referred to as non-square pixels.

Your Avid editing application stores SD video and DVCpro HD video as non-square pixels and stores other HD video as square pixels.

Some graphics programs can render a graphic or animation in either square or non-square pixels. In general, you should render standard-definition animations and composites in non-square pixels, but export static graphics in square pixels (your Avid editing application converts these into non-square pixels during the import process).

The numbers in the following table describe the recommended width and height, in pixels, to create a source image that displays full-screen after import. An image with smaller dimensions takes up less of the screen or is distorted, while an image that exceeds these dimensions might appear distorted, depending on your choices when importing. For more information, see “Import Settings: Image Tab” on page 1502.

<table>
<thead>
<tr>
<th>Frame Size (4:3)</th>
<th>Square Pixels</th>
<th>Non-square Pixels</th>
</tr>
</thead>
<tbody>
<tr>
<td>648 x 486 (NTSC)</td>
<td>720 x 486 (NTSC)</td>
<td></td>
</tr>
<tr>
<td>640 x 480 (NTSC DV)</td>
<td>720 x 480 (NTSC DV)</td>
<td></td>
</tr>
<tr>
<td>768 x 576 (PAL)</td>
<td>720 x 576 (PAL)</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Frame Size (16:9)</th>
<th>Square Pixels</th>
<th>Non-square Pixels</th>
</tr>
</thead>
<tbody>
<tr>
<td>864 x 486 (NTSC anamorphic)</td>
<td>720 x 486 (NTSC)</td>
<td></td>
</tr>
<tr>
<td>1024 x 576 (PAL anamorphic)</td>
<td>720 x 576 (PAL)</td>
<td></td>
</tr>
<tr>
<td>1280 x 720 (HD)</td>
<td>Not applicable</td>
<td></td>
</tr>
<tr>
<td>1920 x 1080 (HD)</td>
<td>Not applicable</td>
<td></td>
</tr>
</tbody>
</table>

Specifications for Animation Files

This topic describes the animation file formats that your Avid editing application supports.
In addition to the specific formats described in the table below, your Avid editing application also supports sequences of image files. You must name image file sequences appropriately for your Avid editing application to handle them correctly on import. Name each file in the sequence NameN.ext, with Name identifying the animation, N indicating the file order, and .ext indicating the file type (for example, Image1.jpg, Image2.jpg, Image3.jpg). The numbering can start at any number except 0, or use any numbering format (for example, Image010.jpg, Image012.jpg, or Imagef28.jpg, Imagef29.jpg).

Your Avid editing application imports the file at the frame rate that is set in the project. Set the appropriate frame rate for the project when you export from a third-party application.

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ERIMovie</td>
<td>ERIMovie files use the .mov or .eri file name extensions. QuickTime for Windows also uses the .mov file name extension. However, QuickTime does not support ERIMovie, and double-clicking an ERIMovie file causes an error.</td>
</tr>
<tr>
<td></td>
<td><strong>There is no player for ERIMovie on Windows or Macintosh platforms. The mview program supports ERIMovie on Silicon Graphics systems.</strong></td>
</tr>
<tr>
<td>PICS (Macintosh only)</td>
<td>A PICS file is a sequence of PICT images. Many applications that handle multiple image formats on the Macintosh platform also support PICS files. You can only store uncompressed data in PICS format. PICS export does not allow PICS containers larger than 16 MB.</td>
</tr>
<tr>
<td>QuickTime</td>
<td>QuickTime files use the .mov file name extension. After you import a QuickTime file, the file maintains the .mov file name extension, which is visible in a bin. The .mov file name extension is the default for export. Avid QuickTime codecs enable you to fast import and export QuickTime files. To use the codecs in a third-party application, see “Exporting from a Third-Party QuickTime or AVI Application” on page 1042. To take advantage of the speed of Avid QuickTime codecs, you must export the files from the QuickTime application at the appropriate frame size for the project you plan to import to in your Avid editing application.</td>
</tr>
<tr>
<td>AVI (Audio Video Interleave) (Windows Only)</td>
<td>AVI files use the .avi file name extension. After you import an AVI file, it maintains the .avi file name extension, which is visible in a bin. The .avi file name extension is the default for export. Avid AVI files can be quite large, especially at high video resolutions, and require adequate storage and transfer capabilities.</td>
</tr>
</tbody>
</table>
## Specifications for Importing OMFI Files

OMFI was developed by Avid Technology, Inc. and many industry and standards partners for the interchange of digital media data between platforms and applications. For information about creating an OMFI file on a non-Avid application, see the documentation for the application.

The information in the following table applies to importing OMFI files.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Frame or Edit rate| You must import sequences and clips to projects that have the same edit rate (29.97 fps or 23.976 fps for NTSC, 25 fps for PAL, 24 fps for film). If the edit rates do not match, you receive an error message.  

*Your Avid editing application cannot import an OMFI audio file that was produced with an edit rate equal to the audio sampling rate. If you try to import such a file you receive an “Unrecognized file type” error message. Create the source file with an edit rate at the project edit rate (29.97 fps, 25 fps, 24 fps, or 23.976 fps).*  

<table>
<thead>
<tr>
<th>Resolution</th>
<th>For optimum import speed and quality, export or render the file from the source application at the resolution you want, and then import the file into your Avid editing application at that resolution. For more information, see “Import Settings: OMFI/AAF Tab” on page 1505.</th>
</tr>
</thead>
</table>
| OMFI version      | Avid editing applications recognize and support OMFI 1.0 composition and media files and OMFI 2.0 composition files.  
The following OMFI 2.0 effects are supported generally:  
* Video effects: dissolves, wipes, freeze frame, film pulldown, slow motion, fade to black  
* Audio effects: pan and volume, audio dissolves  
You can import other effects from other Avid applications.                                                                 |
| Film pulldown     | To import audio media, set the pulldown switch to 1.0.                                                                                                                                                                                                                          |
| Audio sample rate | Audio media imports at the sample rate that is set in your Avid editing application.                                                                                                                                                                                               |
|                   | *Avid editing applications cannot import an OMFI audio file that was produced with an edit rate equal to the audio sampling rate. If you try to import such a file you receive an “Unrecognized file type” error message. Set the edit rate to the project edit rate (29.97 fps, 25 fps, 24 fps, or 23.976 fps).* |
| File transfer     | If you transfer an OMFI file over a network, transfer it as a binary file.                                                                                                                                                                                                       |
| Reimporting Avid media files | If you import OMFI files that contain media you exported from the same system, you need to delete the original media. Otherwise, the new media does not overwrite the original media. To learn how to find related media files for a sequence, see “Finding a Related Media File” on page 493. |
Working with BWF Files

Avid editing applications support any BWF files that adhere to the BWF specification.

The following information from BWF information always appears in bin columns.

<table>
<thead>
<tr>
<th>Bin Column</th>
<th>BWF Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clip name</td>
<td>Imported file name. If scene and take information is provided, the clip name is created as scene/take.</td>
</tr>
<tr>
<td>Tape ID</td>
<td>Imported file name.</td>
</tr>
<tr>
<td>Start</td>
<td>The start timecode specified in the file.</td>
</tr>
<tr>
<td>Shoot date</td>
<td>The origination date specified in the file.</td>
</tr>
<tr>
<td>Tape Name</td>
<td>If there is no tape name specified in the file, a name is created by concatenating the origination date and the imported file name.</td>
</tr>
</tbody>
</table>

You can use Avid-specific coding to add additional information. Currently, the following vendors have products that can provide this additional information:

- Aaton
- Zaxcom
- Nagra
- Fostex

Avid editing applications support 24-bit audio data, and up to 16 tracks in a single file. You can use the AutoSync™ feature to sync these tracks. You can also use AutoSync to sync picture and sound.

Preparing Custom BWF Information

Additional BWF information that can display in bin columns must be coded in a particular format. The recording device must provide this information in the BWF Description field, using keyword/value pairs with the following format:

uKEYWORD=data[CR/LF]
Working with BWF Files

For example, the keyword/value pair `uSCENE=1A[CR/LF]` displays “1A” in the Scene column of the bin into which you import it.

The following table describes how to code BWF information for particular bin columns:

<table>
<thead>
<tr>
<th>Bin Column</th>
<th>BWF Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comments (editable text field that appears in the bin script view)</td>
<td>uNOTE=x, where x is text.</td>
</tr>
<tr>
<td>Scene</td>
<td>uSCENE=x, where x is text.</td>
</tr>
<tr>
<td>Take</td>
<td>uTAKE=x, where x is text.</td>
</tr>
<tr>
<td>Tape Name</td>
<td>uTAPE=x, where x is text.</td>
</tr>
<tr>
<td></td>
<td>If no tape name is specified, a name is created by concatenating the origination date and the file name.</td>
</tr>
<tr>
<td>TRK1 through TRK8</td>
<td>uTRKn=x where n is the track number, and x is text.</td>
</tr>
<tr>
<td>User Bits (custom column)</td>
<td>uUBITS=$hhhhhhhh where hhhhhhhhh is the 32-bit hexadecimal encoded user bits.</td>
</tr>
</tbody>
</table>

If you want to assign a file to a particular track number, the file name must end in _n, -n, or a space followed by n (where n is the track number). For example, a file named Orchestra_1.bwf would create the audio on track A1.

To bypass the frame rate dialog box during import, you can specify the frame rate using either of the following syntaxes:

- `uFRAMERATE=nnDF`
- `uFRAMERATE=nnND`
In these examples, \( nn \) is the frame rate (25, 29.97, or 30), DF is drop-frame, and ND is non-drop-frame.

**Importing, Syncing, and Reimporting BWF Files**

You can import BWF files into an Avid editing application approximately 10 to 12 times faster than capturing in real time. The files maintain pure digital quality for all audio post processing. For basic information on importing audio files, see “Importing Media Files” on page 301.

During import of NTSC BWF files, if no frame rate is specified in the file, a dialog box appears and asks if the conversion should use 29.97 fps or 30 fps, and drop-frame or non-drop-frame. Your choices depend on how the audio was recorded.

After you capture video, use the AutoSync feature to sync picture and sound or multiple tracks of sound. If you are using BWF files from a 24-fps shoot in a PAL project, you must use the PAL Method 2 approach, in which picture and sound are captured separately. If you are working in a PAL 24p project, you need to take an extra step to make sure the picture and sound are correctly synced.

You can reimport BWF files in the same way as you reimport other audio files. You can also batch capture from a source tape, because the clips are associated with a tape name. For more information on reimporting and batch capturing, see “Reimporting Files” on page 334 and “Batch Capturing from Logged Clips” on page 250.

**To import and sync BWF files:**

1. Create a project, based on the source footage.
2. Import the log file, and capture the video footage.
3. Import the BWF file into the same bin in which you captured the video footage.
4. For 24p PAL projects, you need to create a new bin column:
   a. Highlight the Start timecode column.
   b. Select Edit > Duplicate.
   c. From the list of columns, select Aux TC 24 and click OK.
   d. In the dialog box, click Convert.
   e. Display the Auxiliary TC1 column.
   f. Highlight the Aux TC 24 column, and copy it to the Auxiliary TC1 column.

Use Auxiliary TC 1 only as a sync point reference for AutoSync. Do not use it for data tracking or EDL generation.
Use the Aux TC24 column to generate a 24-frame EDL for audio only. Use the Film TC column to generate a 24-frame EDL for video only. This timecode field represents the video timecode of a HD downconvert to standard definition video.

5. Ensure all entries in the Shoot Date column use the same syntax.

Currently, some BWF files use the format 2009/10/03 as the Shoot Date while some ALE files use 2009-10-03. This field is used as part of the AutoSync process to guarantee the uniqueness of the timecode. To fix this problem, do one of the following:

- Manually change the format of one set of clips to match the other.
- If you do need the information, create a custom column with a different name, select Edit > Duplicate to copy the information into the custom column, and delete the Shoot Date column.

6. Highlight the picture and audio clips and select Bin > AutoSync.

7. For 24p PAL projects, use Auxiliary TC1 as a sync point. For other projects, use the Start timecode.

Your Avid editing application creates new subclips with synced picture and sound, which are ready for editing.

**Importing Multichannel Broadcast Wave (BWF) Files**

You can import multichannel, monophonic BWF files into your Avid editing application as a single master clip. For example, when you import an eight-track recording, an eight-track master clip is created with a sequential file name based on the track order (filename_1.wav is associated with track A1, filename_2.wav is associated with track A2, filename_3.wav is associated with track A3).

**To import a BWF file as a single master clip:**

1. In the Settings list of the Project window, double-click Import.

   The Import Settings dialog box opens.

2. Click the Audio tab, and then select Autodetect Broadcast Wave Monophonic Groups.

   This option is the default.

3. Click OK.

4. Click the bin into which you want to import the file.

5. Select File > Import.

   The Select files to Import dialog box opens.

6. Locate the files and select only one .wav file in the group.

   You do not need to select multiple files. As long as you select just one of the .wav files in the group, all the files import.
7. Click Open.

The file imports and a new master clip appears in the bin with all audio tracks associated with the new master clip.

*Your Avid editing application might skip some audio track labels (A1, A2, A3) because there is no file for that track.*

For more information about importing, see “Importing Files” on page 297.

**iXML Metadata in Broadcast Wave and AIFF Files**

The editing application contains a WaveAIFF AMA plug-in that can read AIFF and WAV with uncompressed 16-bit or 24-bit audio up to 24 channels. If the BWAV or AIFF contains iXML metadata, it is preserved and carried with the master clip in the Bin. This information is also exported in the AAF where it can be available to Pro Tools.

**To AMA Link to a Broadcast Wave or AIFF File:**

1. Right click a bin and select AMA link.

   The Open Dialog box opens.

2. Navigate to the location where the BWAV or AIFF files reside and select the files you want to link to.

3. From the files of Type menu, choose WaveAiff.

4. Click Open.

   The clips appear in the bin. A link appears next to the clips. The audio track settings are based on the AMA settings.

   If the file contains iXML metadata and Broadcast Wave metadata, relevant data is entered into the appropriate bin columns. If there is a conflict between the Broadcast Wave data and the iXML metadata, the iXML metadata will be used.

   The interpretation of audio start time for Broadcast Wave and iXML files requires file frame rate information. The file’s frame rate is determined in this priority order:

   - If the frame rate is given in the iXML data, it has highest priority.
   - If the frame rate is in the Avid extension to the BWAV, it has next highest priority.
   - Otherwise, the Audio Start Time Option in the Link Options tab of the AMA Settings is used.

   The audio start time appears in the Sound TC column. If the audio TC rate is different from the project TC rate, the frame rate appears in the Soundroll column. The Sound TC is re-interpreted in the current project's frame rate to become the clip’s start timecode.
Difference between Importing BWAV or AMA Linking to a BWAV with WaveAIFF Plug-In

The following describes the differences between importing a BWAV file or AMA linking to a BWAV file using the WaveAIFF Plug-In.

- The import process does not read iXML metadata. Performing an AMA Link using the WaveAIFF plug-in will read iXML metadata.
- If the BWAV files contains an iXML tape name, this will appear as the “Sound Roll” and will override the BWAV specification of “Tape.”
- Import will automatically group multiple mono clips based on file name patterns. AMA linked files will not.
- The AMA linked version of the clip may sometimes be one frame shorter than the imported version. This is because import is able to pad the end of the file with silence to fill out a shortage of audio samples in the last video frame.
- During the import process, you are prompted to select the TC rate and the Sound TC and start time are displayed. During the WaveAIFF AMA linking process, you are not prompted to select the TC rate. The file TC rate comes from a setting (if not present in the file itself), and the Sound TC and TC rate used are displayed in bin columns.
Field Ordering in Graphic Imports and Exports

Graphic images consist of one or more image files, each of which contains a full frame. These frames contain fields (formed from the odd-numbered and even-numbered lines of the image frame) that have three basic arrangements:

- Progressive or still frame: The upper and lower fields in the frame originated at the same instant of time, or are coherent with each other, as shown in the following illustration. Dashed lines = Field 1 (.1), Solid lines = Field 2 (.2), and the arrow represents time.

- Upper field is first: The upper field in the frame (odd-numbered lines, when the frame lines are numbered starting from 1) occurs temporally before the lower field, as shown in the following illustration. This arrangement is termed “upper field first” (or “lower field second”).

- Lower field is first: The lower field in the frame (even-numbered lines) occurs temporally first, as shown in the following illustration. This arrangement is termed “lower field first” (or “upper field second”).
Preventing a Spatial Field Mismatch on Import

The following table shows the proper spatial field position for each of the common interlaced video formats in Avid editing applications.

In the following table, Odd Field or Even Field specifies whether the temporally first field in the frame has the odd or even numbered lines, starting from 1.

<table>
<thead>
<tr>
<th>Avid Video Format</th>
<th>Upper/Lower Field Spatial Setting</th>
<th>Field Setting for Import and Export</th>
</tr>
</thead>
<tbody>
<tr>
<td>AVR NTSC</td>
<td>Upper field is first.</td>
<td>Odd Field</td>
</tr>
<tr>
<td>AVR PAL</td>
<td>Upper field is first.</td>
<td>Odd Field</td>
</tr>
<tr>
<td>Other NTSC</td>
<td>Lower field is first.</td>
<td>Even Field</td>
</tr>
<tr>
<td>Other PAL</td>
<td>Upper field is first.</td>
<td>Odd Field</td>
</tr>
</tbody>
</table>

Graphics applications such as Adobe After Effects let you select either spatial relation for the fields when you render a sequence of interlaced fields. Use the settings in the preceding table to ensure that the import is correct.

If the spatial positions of the two fields are reversed (for example, the upper field should be a lower field), your Avid editing application cannot complete the import without correcting the spatial relationship. In this spatial mismatch situation, Avid applications convert the upper field to a lower field by deleting the top line of the upper field and replicating the bottom line. The field is thus converted to a lower field relative to the other field.

When you export to DVD for TV playback, Avid recommends that you transcode any clips that do not match the field ordering of the majority of the clips. If you do not do this, the field ordering is reversed during playback.

Spatial Field Relationship on Export

The default export operation is automatically carried out as shown in the preceding table. The fields are properly interleaved in the export frames (one frame per file).

If your Avid editing application corrects an import with a spatial mismatch as described in the preceding section, you might want to prevent a shift up or down by a line when you export. The Export Settings dialog box lets you select the spatial arrangement that is the opposite of what is otherwise recommended. You should rarely need to use this option.
24p and 25p Import and Export

The spatial field selection options do not apply for 24p and 25p projects because the frames in these projects are already in progressive or still-image form.

Field Dominance

Editing in Avid applications is frame based. All timecode is expressed in frame numbers, and all cuts are at frame boundaries. A raw video stream has no concept of frames (ignoring color framing) until the frame unit is defined. Defining the dominant field for the system defines the “frameness” of the video stream, as shown in the following illustration.

Left: the dotted lines represent the limits of a field-1 dominant frame. Right: the dotted lines represent the limits of a field-2 dominant frame.

Avid editing applications all use field 1 as the dominant field. This means that the first field temporally in the edit frame is always field 1 and the second frame is always field 2. Cuts will always precede field 1.

Fields in Video

In the video signal, fields have a temporal position that is unambiguously and uniquely tied to the details of the video signal, regardless of whether the signal is analog or digital (SDI). This means that you should work around a field spatial mismatch by correcting the spatial relation between the two fields rather than the temporal position. In some cases, you can modify the field dominance of the input image files, but this results in the loss of two fields, and is more difficult to carry out than either the workaround provided in Avid editing applications or rerendering properly to the other spatial relationship.
This chapter describes the different resolutions available in your Avid editing application and lists their specifications. It also explains how to estimate the drive space you need to store your captured media:

- Compression and Avid Editing Applications
- Monitor Display Resolutions
- Resolution Specifications
- Support for Uncompressed HD Media
- Mixing Resolutions
- Resolution Groups and Image Quality
- Estimating Drive Space Requirements
- Storage Requirements
- Considerations for Managing Storage

The resolutions available in your Avid editing application depend on its model and options.

Compression and Avid Editing Applications

Avid editing applications support both compressed and uncompressed resolutions.

When an Avid editing application captures and stores compressed video, the compression techniques affect the size of the resulting files and the resolution of the images they contain. The less the data is compressed, the higher the image resolution, and the more drive space the file requires.

Large media files at high resolutions can use very large amounts of drive space. When you are choosing an image resolution for your project, you need to balance your requirements in terms of image quality with your available drive resources. For detailed guidelines on estimating space requirements, see “Storage Requirements” on page 1575.

You can use lower resolutions when your work does not require very high image quality (for example, in offline work, or in CD-ROM or Web authoring projects), and higher resolutions when you need excellent image quality. You can also mix different resolutions within the same
project as long as those resolutions are compatible with one another. (see “Mixing Resolutions” on page 1573).

Avid editing applications also support the capture and storage of video that is not processed by a data compression scheme:

- Uncompressed video (1:1) is available as standard definition (conforming to the ITU-R 601 standard) or as high definition (conforming to the ITU-R 292M standard). The image quality of uncompressed video is very high, but uncompressed files require very large amounts of drive space. For more information, see “Support for Uncompressed HD Media” on page 1573.
- DV (digital video) is a compressed media format. SMPTE standards specify how to take 601 video and convert it to a compressed format. When capturing through a 1394 connection, your Avid editing application records DV media in its native format, and does not compress it further.

## Monitor Display Resolutions

The display resolution for the monitors in your Avid editing application varies depending on the video format, as described in the following table.

<table>
<thead>
<tr>
<th>Video Format</th>
<th>Active video displayed (in pixels)</th>
<th>Stored video not displayed</th>
</tr>
</thead>
<tbody>
<tr>
<td>NTSC JFIF (ITU-R 601)</td>
<td>720 x 486 non-square</td>
<td>10 lines of blanking or varietal interval timecode (VITC) per frame (5 lines per field)</td>
</tr>
<tr>
<td>NTSC 1:1 (Uncompressed)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NTSC MPEG IMX</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NTSC DV 25 and DV 50</td>
<td>720 x 480 non-square</td>
<td>None</td>
</tr>
<tr>
<td>PAL JFIF (ITU-R 601)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PAL 1:1 (Uncompressed)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PAL MPEG IMX</td>
<td></td>
<td></td>
</tr>
<tr>
<td>HD 720</td>
<td>1280 x 720 square</td>
<td>None</td>
</tr>
<tr>
<td>HD 1080</td>
<td>1920 x 1080 square</td>
<td>None</td>
</tr>
</tbody>
</table>

*For more information on blanking or VITC, see “Vertical Blanking Information” on page 1119.*
Resolution Specifications

Avid editing applications provide you with a range of resolutions, both compressed and uncompressed, that you can use at various stages of your project. You can also mix certain resolutions within a sequence. The tables in the following topics list specifications for the various resolutions.

For information on resolutions to use when importing graphics or sequences from a third-party application, see “Frame Size for Imported Graphics” on page 1545. For information on drive striping requirements for different resolutions, go to the Avid online Knowledge Base at www.avid.com/onlinesupport and search for “Drive Striping Tables.”

The resolutions available on your Avid editing application might vary from this list, depending on the model and the hardware used in your system.

Symphony Option supports single-field resolutions (s resolutions) and multicam resolutions (m resolutions) for capture, render and play. You cannot create titles or import in these resolutions.

Higher than HD Formats Supported by Media Composer

The editing application supports higher than HD formats. For information on working with Higher than HD formats see the Avid High-Resolution Workflows Guide.

Resolution Specifications: HD

Your Avid editing application supports the capture, editing, and output of high-definition (HD) media in Avid DNxHD™, Avid DNxHD444, DVCPRO HD, (for Macintosh only) Apple® ProRes 422 and Apple ProRes 4444 resolutions. For information on support for 1:1 (uncompressed) HD media, see “Support for Uncompressed HD Media” on page 1573.

Avid DNxHD encoding technology delivers mastering-quality 8-bit or 10-bit HD media at standard-definition (SD) data rates and file sizes.

Avid editing applications support editing and playback of J2K media. You can import, playback, transcode, and consolidate these resolutions. All J2K resolutions are encoded with variable bit-rate (VBR) encoding to meet a target, average bit-rate. Depending upon video content, the actual average rate will vary. The range of the bit-rate can be from 120 to 250.

The following table provides information about HD resolutions for interlaced and progressive media. HD resolutions are available only in MXF format. Unless otherwise specified in the resolution name, all resolutions are in the YCbCr color space. Avid DNxHD444 resolutions only appear when the HD project’s Color Space is set to RGB 709 (1080p projects only).
## Resolution Specifications

<table>
<thead>
<tr>
<th>Resolution</th>
<th>Bits</th>
<th>Project Format</th>
<th>Frame Size</th>
<th>Frames/sec</th>
<th>Megabits per second (Mb/sec)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1:1 10-bit HD</td>
<td>10</td>
<td>720p/23.976</td>
<td>1280 x 720</td>
<td>23.976</td>
<td>442</td>
</tr>
<tr>
<td>1:1 HD</td>
<td>8</td>
<td>10</td>
<td></td>
<td></td>
<td>354</td>
</tr>
<tr>
<td>DNxHD 90 X</td>
<td>10</td>
<td>90</td>
<td></td>
<td></td>
<td>90</td>
</tr>
<tr>
<td>DNxHD 90</td>
<td>8</td>
<td>90</td>
<td></td>
<td></td>
<td>60</td>
</tr>
<tr>
<td>DNxHD 60</td>
<td>8</td>
<td>60</td>
<td></td>
<td></td>
<td>40</td>
</tr>
<tr>
<td>DNxHD 40</td>
<td>8</td>
<td>40</td>
<td></td>
<td></td>
<td>100</td>
</tr>
<tr>
<td>DVCPRO HD</td>
<td>8</td>
<td>100</td>
<td></td>
<td></td>
<td>50</td>
</tr>
<tr>
<td>XDCAM HD 50</td>
<td>8</td>
<td>50</td>
<td></td>
<td></td>
<td>100</td>
</tr>
<tr>
<td>AVC-Intra 100</td>
<td>10</td>
<td>10</td>
<td></td>
<td></td>
<td>100</td>
</tr>
<tr>
<td>Apple ProRes 422 MXF</td>
<td>10</td>
<td>960 x720</td>
<td></td>
<td></td>
<td>50</td>
</tr>
<tr>
<td>Apple ProRes 422 HQ MXF</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>50</td>
</tr>
<tr>
<td>Apple ProRes 422 LT MXF</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>50</td>
</tr>
<tr>
<td>Apple ProRes 422 Proxy MXF</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>50</td>
</tr>
<tr>
<td>Apple ProRes 4444</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>100</td>
</tr>
<tr>
<td>J2K 720p</td>
<td>10</td>
<td>10</td>
<td></td>
<td></td>
<td>100</td>
</tr>
<tr>
<td>AVC-Intra 50</td>
<td>10</td>
<td>10</td>
<td></td>
<td></td>
<td>100</td>
</tr>
<tr>
<td>1:1 10-bit HD</td>
<td>10</td>
<td>720p/25</td>
<td>1280 x 720</td>
<td>25.00</td>
<td>440</td>
</tr>
<tr>
<td>1:1 HD</td>
<td>8</td>
<td>8</td>
<td></td>
<td></td>
<td>352</td>
</tr>
<tr>
<td>DNxHD 90 X</td>
<td>10</td>
<td>90</td>
<td></td>
<td></td>
<td>90</td>
</tr>
<tr>
<td>DNxHD 90</td>
<td>8</td>
<td>90</td>
<td></td>
<td></td>
<td>60</td>
</tr>
<tr>
<td>DNxHD 60</td>
<td>8</td>
<td>60</td>
<td></td>
<td></td>
<td>45</td>
</tr>
<tr>
<td>DNxHD 45</td>
<td>8</td>
<td>45</td>
<td></td>
<td></td>
<td>55</td>
</tr>
<tr>
<td>DVCPRO HD</td>
<td>8</td>
<td>55</td>
<td></td>
<td></td>
<td>50</td>
</tr>
<tr>
<td>XDCAM HD 50</td>
<td>8</td>
<td>50</td>
<td></td>
<td></td>
<td>100</td>
</tr>
<tr>
<td>AVC-Intra 100</td>
<td>10</td>
<td>10</td>
<td></td>
<td></td>
<td>100</td>
</tr>
<tr>
<td>Apple ProRes 422 MXF</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>61</td>
</tr>
<tr>
<td>Apple ProRes 422 HQ MXF</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>92</td>
</tr>
<tr>
<td>Apple ProRes 422 LT MXF</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>42</td>
</tr>
<tr>
<td>Apple ProRes 422 Proxy MXF</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>19</td>
</tr>
<tr>
<td>Apple ProRes 4444</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>138</td>
</tr>
<tr>
<td>J2K 720p</td>
<td>10</td>
<td>10</td>
<td></td>
<td></td>
<td>65</td>
</tr>
<tr>
<td>AVC-Intra 50</td>
<td>10</td>
<td>960 x720</td>
<td></td>
<td></td>
<td>50</td>
</tr>
<tr>
<td>Resolution</td>
<td>Bits</td>
<td>Project Format</td>
<td>Frame Size</td>
<td>Frames/sec</td>
<td>Megabits per second (Mb/sec)</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>------</td>
<td>----------------</td>
<td>------------</td>
<td>------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td>1:1 10-bit HD</td>
<td>10</td>
<td>720p/29.97</td>
<td>1280 x 720</td>
<td>29.97</td>
<td>527</td>
</tr>
<tr>
<td>1:1 HD</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td>422</td>
</tr>
<tr>
<td>DNxHD 110 X</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>110</td>
</tr>
<tr>
<td>DNxHD 110</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td>110</td>
</tr>
<tr>
<td>DNxHD 70</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td>70</td>
</tr>
<tr>
<td>DNxHD 50</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td>50</td>
</tr>
<tr>
<td>DVCPRO HD</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td>55</td>
</tr>
<tr>
<td>XDCAM HD 50</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td>50</td>
</tr>
<tr>
<td>AVC-Intra 100</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>100</td>
</tr>
<tr>
<td>Apple ProRes 422 MXF</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>73</td>
</tr>
<tr>
<td>Apple ProRes 422 HQ MXF</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>110</td>
</tr>
<tr>
<td>Apple ProRes 422 LT MXF</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>51</td>
</tr>
<tr>
<td>Apple ProRes 422 Proxy MXF</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>23</td>
</tr>
<tr>
<td>Apple ProRes 4444</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>165</td>
</tr>
<tr>
<td>J2K 720p</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>75</td>
</tr>
<tr>
<td>1:1 10-bit HD</td>
<td>10</td>
<td>720p/50</td>
<td>1280 x 720</td>
<td>50</td>
<td>879</td>
</tr>
<tr>
<td>1:1 HD</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td>704</td>
</tr>
<tr>
<td>DNxHD 185 X</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>175</td>
</tr>
<tr>
<td>DNxHD 185</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td>175</td>
</tr>
<tr>
<td>DNxHD 120</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td>115</td>
</tr>
<tr>
<td>DNxHD 85</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td>85</td>
</tr>
<tr>
<td>DVCPRO HD</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td>110</td>
</tr>
<tr>
<td>XDCAM HD 50</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td>50</td>
</tr>
<tr>
<td>AVC-Intra 100</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>100</td>
</tr>
<tr>
<td>Apple ProRes 422 MXF</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>122</td>
</tr>
<tr>
<td>Apple ProRes 422 HQ MXF</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>184</td>
</tr>
<tr>
<td>Apple ProRes 422 LT MXF</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>84</td>
</tr>
<tr>
<td>Apple ProRes 422 Proxy MXF</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>38</td>
</tr>
<tr>
<td>Apple ProRes 4444</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>275</td>
</tr>
<tr>
<td>J2K 720p</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>125</td>
</tr>
<tr>
<td>AVC-Intra 50</td>
<td>10</td>
<td>960 x 720</td>
<td></td>
<td></td>
<td>50</td>
</tr>
<tr>
<td>Resolution</td>
<td>Bits</td>
<td>Project Format</td>
<td>Frame Size</td>
<td>Frames/sec</td>
<td>Megabits per second (Mb/sec)</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>------</td>
<td>-------------------------</td>
<td>--------------</td>
<td>------------</td>
<td>------------------------------</td>
</tr>
<tr>
<td>1:1 10-bit HD</td>
<td>10</td>
<td>720p/59.94</td>
<td>1280 x 720</td>
<td>59.94</td>
<td>1105</td>
</tr>
<tr>
<td>1:1 HD</td>
<td>8</td>
<td>1280 x 720</td>
<td>59.94</td>
<td>1105</td>
<td>884</td>
</tr>
<tr>
<td>DNxHD 220 X</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DNxHD 220</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DNxHD 145</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DNxHD 100</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DVCPRO HD</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>XDCAM HD 50</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>AVC-Intra 100</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Apple ProRes 422 MXF</td>
<td>10</td>
<td>1280 x 720</td>
<td>59.94</td>
<td>1105</td>
<td>147</td>
</tr>
<tr>
<td>Apple ProRes 422 HQ MXF</td>
<td>10</td>
<td>1280 x 720</td>
<td>59.94</td>
<td>1105</td>
<td>220</td>
</tr>
<tr>
<td>Apple ProRes 422 LT MXF</td>
<td>10</td>
<td>1280 x 720</td>
<td>59.94</td>
<td>1105</td>
<td>145</td>
</tr>
<tr>
<td>Apple ProRes 422 Proxy MXF</td>
<td>10</td>
<td>1280 x 720</td>
<td>59.94</td>
<td>1105</td>
<td>100</td>
</tr>
<tr>
<td>Apple ProRes 4444</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>J2K 720p</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>AVC-Intra 50</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1:1 10-bit RGB HD</td>
<td>10</td>
<td>1080p/23.976</td>
<td>1920 x 1080</td>
<td>23.976</td>
<td>1591</td>
</tr>
<tr>
<td>1:1 10-bit HD</td>
<td>10</td>
<td>1920 x 1080</td>
<td>23.976</td>
<td></td>
<td>994</td>
</tr>
<tr>
<td>1:1 HD</td>
<td>8</td>
<td>1920 x 1080</td>
<td>23.976</td>
<td></td>
<td>795</td>
</tr>
<tr>
<td>DNxHD 175 X</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DNxHD 175</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DNxHD 115</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DNxHD 80</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DNxHD 36</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DNxHD444 350 X</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>AVC-Intra 100</td>
<td>10</td>
<td>1920 x 1080</td>
<td>23.976</td>
<td></td>
<td></td>
</tr>
<tr>
<td>XAVC Intra 100</td>
<td>10</td>
<td>1920 x 1080</td>
<td>23.976</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Apple ProRes 422 MXF</td>
<td>10</td>
<td>1920 x 1080</td>
<td>23.976</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Apple ProRes 422 HQ MXF</td>
<td>10</td>
<td>1920 x 1080</td>
<td>23.976</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Apple ProRes 422 LT MXF</td>
<td>10</td>
<td>1920 x 1080</td>
<td>23.976</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Apple ProRes 422 Proxy MXF</td>
<td>10</td>
<td>1920 x 1080</td>
<td>23.976</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Apple ProRes 4444</td>
<td>10</td>
<td>1920 x 1080</td>
<td>23.976</td>
<td></td>
<td></td>
</tr>
<tr>
<td>J2K 1080p</td>
<td>10</td>
<td>1440x1080</td>
<td>23.976</td>
<td></td>
<td></td>
</tr>
<tr>
<td>AVC-Intra 50</td>
<td>10</td>
<td>1440x1080</td>
<td>23.976</td>
<td></td>
<td></td>
</tr>
<tr>
<td>XAVC Intra 50</td>
<td>10</td>
<td>1440x1080</td>
<td>23.976</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Resolution Specifications

<table>
<thead>
<tr>
<th>Resolution</th>
<th>Bits</th>
<th>Project Format</th>
<th>Frame Size</th>
<th>Frames/sec</th>
<th>Megabits per second (Mb/sec)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1:1 10-bit RGB HD</td>
<td>10</td>
<td>1080p/24</td>
<td>1920 x 1080</td>
<td>24.00</td>
<td>1593</td>
</tr>
<tr>
<td>1:1 10-bit HD</td>
<td>10</td>
<td>1080p/25</td>
<td>1920 x 1080</td>
<td>25.00</td>
<td>1659</td>
</tr>
<tr>
<td>1:1 HD</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td>829</td>
</tr>
<tr>
<td>DNxHD 175 X</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>175</td>
</tr>
<tr>
<td>DNxHD 175</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td>175</td>
</tr>
<tr>
<td>DNxHD 115</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td>115</td>
</tr>
<tr>
<td>DNxHD 80</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td>80</td>
</tr>
<tr>
<td>DNxHD 36</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td>8</td>
</tr>
<tr>
<td>DNxHD 185 X</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>185</td>
</tr>
<tr>
<td>DNxHD 185</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td>185</td>
</tr>
<tr>
<td>DNxHD 120</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td>125</td>
</tr>
<tr>
<td>DNxHD 36</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td>8</td>
</tr>
<tr>
<td>DNxHD 444 365 X</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>365</td>
</tr>
<tr>
<td>AVC-Intra 100</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>100</td>
</tr>
<tr>
<td>XAVC Intra 100</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>100</td>
</tr>
<tr>
<td>Apple ProRes 422 MXF</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>122</td>
</tr>
<tr>
<td>Apple ProRes 422 HQ MXF</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>184</td>
</tr>
<tr>
<td>Apple ProRes 422 LT MXF</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>85</td>
</tr>
<tr>
<td>Apple ProRes 422 Proxy MXF</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>38</td>
</tr>
<tr>
<td>Apple ProRes 4444</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>275</td>
</tr>
<tr>
<td>J2K 1080p</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>125</td>
</tr>
</tbody>
</table>
### Resolution Specifications

<table>
<thead>
<tr>
<th>Resolution</th>
<th>Bits</th>
<th>Project Format</th>
<th>Frame Size</th>
<th>Frames/sec</th>
<th>Megabits per second (Mb/sec)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1:1 10-bit RGB HD</td>
<td>10</td>
<td>1080p/29.97</td>
<td>1920 x 1080</td>
<td>29.97</td>
<td>1989</td>
</tr>
<tr>
<td>1:1 10-bit HD</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1:1 HD</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td>994</td>
</tr>
<tr>
<td>DNxHD 220 X</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DNxHD 220</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td>220</td>
</tr>
<tr>
<td>DNxHD 145</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td>145</td>
</tr>
<tr>
<td>DNxHD 100</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td>100</td>
</tr>
<tr>
<td>DNxHD 45</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td>45</td>
</tr>
<tr>
<td>XDCAM HD 50</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td>50</td>
</tr>
<tr>
<td>AVC-Intra 100</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>100</td>
</tr>
<tr>
<td>XAVC Intra 100</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>100</td>
</tr>
<tr>
<td>DNxHD444 440 X</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>440</td>
</tr>
<tr>
<td>Apple ProRes 422 MXF</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>147</td>
</tr>
<tr>
<td>Apple ProRes 422 HQ MXF</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>220</td>
</tr>
<tr>
<td>Apple ProRes 422 LT MXF</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>102</td>
</tr>
<tr>
<td>Apple ProRes 422 Proxy MXF</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>45</td>
</tr>
<tr>
<td>Apple ProRes 4444</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>330</td>
</tr>
<tr>
<td>J2K 1080p</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>150</td>
</tr>
<tr>
<td>1:1 10-bit RGB HD</td>
<td>10</td>
<td>1080i/50</td>
<td>1920 x 1080</td>
<td>25.00</td>
<td>1659</td>
</tr>
<tr>
<td>1:1 10-bit HD</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>1037</td>
</tr>
<tr>
<td>1:1 HD</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td>829</td>
</tr>
<tr>
<td>DNxHD 185 X</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>185</td>
</tr>
<tr>
<td>DNxHD 185</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td>185</td>
</tr>
<tr>
<td>DNxHD 120</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td>120</td>
</tr>
<tr>
<td>DNxHD 85</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td>85</td>
</tr>
<tr>
<td>DVCPro HD</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td>100</td>
</tr>
<tr>
<td>XDCAM HD 50</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td>50</td>
</tr>
<tr>
<td>AVC-Intra 100</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>100</td>
</tr>
<tr>
<td>XAVC Intra 100</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>100</td>
</tr>
<tr>
<td>Apple ProRes 422 MXF</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>122</td>
</tr>
<tr>
<td>Apple ProRes 422 HQ MXF</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>184</td>
</tr>
<tr>
<td>Apple ProRes 422 LT MXF</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>85</td>
</tr>
<tr>
<td>Apple ProRes 422 Proxy MXF</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>38</td>
</tr>
<tr>
<td>Apple ProRes 4444</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>275</td>
</tr>
<tr>
<td>J2K 1080i</td>
<td>10</td>
<td>1440x1080</td>
<td></td>
<td></td>
<td>125</td>
</tr>
<tr>
<td>AVC-Intra 50</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>50</td>
</tr>
<tr>
<td>XAVC Intra 50</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>50</td>
</tr>
<tr>
<td>DNxHD TR-120</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td>120</td>
</tr>
</tbody>
</table>
The data rate (bandwidth) for Avid DNxHD resolutions is calculated per second for each frame rate. For example, DNxHD 220 has a compressed data rate of 220 Mb/sec at 29.97 fps. DNxHD 185, which is an equivalent resolution, has a compressed data rate of 185 Mb/sec at 25 fps.

A good guideline for selecting a resolution is to use the Avid DNxHD resolution that matches the megabit data rate of the acquisition format. For HDCAM-originated material, for example, select DNxHD 145, which closely matches the data rate of HDCAM but provides better mastering results and uses significantly less storage. The following table compares Avid HD formats to the HDCAM format.

<table>
<thead>
<tr>
<th>Resolution</th>
<th>Bits</th>
<th>Project Format</th>
<th>Frame Size</th>
<th>Frames/sec</th>
<th>Megabits per second (Mb/sec)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1:1 10-bit RGB HD</td>
<td>10</td>
<td>1080i/59.94</td>
<td>1920 x 1080</td>
<td>29.97</td>
<td>1989</td>
</tr>
<tr>
<td>1:1 10-bit HD</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>1243</td>
</tr>
<tr>
<td>1:1 HD</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td>994</td>
</tr>
<tr>
<td>DNxHD 220 X</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>220</td>
</tr>
<tr>
<td>DNxHD 220</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td>220</td>
</tr>
<tr>
<td>DNxHD 145</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td>145</td>
</tr>
<tr>
<td>DNxHD 100</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td>100</td>
</tr>
<tr>
<td>DVCPRO HD</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td>100</td>
</tr>
<tr>
<td>XDCAM HD 50</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td>50</td>
</tr>
<tr>
<td>AVC-Intra 100</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>100</td>
</tr>
<tr>
<td>XAVC Intra 100</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>100</td>
</tr>
<tr>
<td>Apple ProRes 422 MXF</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>147</td>
</tr>
<tr>
<td>Apple ProRes 422 HQ MXF</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>220</td>
</tr>
<tr>
<td>Apple ProRes 422 LT MXF</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>102</td>
</tr>
<tr>
<td>Apple ProRes 422 Proxy MXF</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>45</td>
</tr>
<tr>
<td>Apple ProRes 4444</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>330</td>
</tr>
<tr>
<td>J2K 1080i</td>
<td>10</td>
<td>1440x1080</td>
<td></td>
<td></td>
<td>150</td>
</tr>
<tr>
<td>AVC-Intra 50</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>50</td>
</tr>
<tr>
<td>XAVC Intra 50</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>50</td>
</tr>
<tr>
<td>DNxHD TR-145</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td>145</td>
</tr>
</tbody>
</table>

The data rate (bandwidth) for Avid DNxHD resolutions is calculated per second for each frame rate. For example, DNxHD 220 has a compressed data rate of 220 Mb/sec at 29.97 fps. DNxHD 185, which is an equivalent resolution, has a compressed data rate of 185 Mb/sec at 25 fps.

A good guideline for selecting a resolution is to use the Avid DNxHD resolution that matches the megabit data rate of the acquisition format. For HDCAM-originated material, for example, select DNxHD 145, which closely matches the data rate of HDCAM but provides better mastering results and uses significantly less storage. The following table compares Avid HD formats to the HDCAM format.
Resolution Specifications SD: J2K

Avid editing applications support editing and playback of J2K media. You can import, playback, transcode, and consolidate these resolutions. All J2K resolutions are encoded with variable bit-rate (VBR) encoding to meet a target, average bit-rate. Depending upon video content, the actual average rate will vary.

The following table provides J2K specifications by project type.

<table>
<thead>
<tr>
<th>Resolution</th>
<th>Bits</th>
<th>Project Format</th>
<th>Frame Size</th>
<th>Frames/sec</th>
<th>Megabits per second (Mb/sec)</th>
</tr>
</thead>
<tbody>
<tr>
<td>J2K NTSCi</td>
<td>10</td>
<td>30i</td>
<td>720 x 486</td>
<td>30</td>
<td>50</td>
</tr>
<tr>
<td>J2K PALi</td>
<td>10</td>
<td>25i</td>
<td>720 x 592</td>
<td>25</td>
<td>50</td>
</tr>
<tr>
<td>J2K NTSCp</td>
<td>10</td>
<td>30p</td>
<td>720 x 486</td>
<td>30</td>
<td>50</td>
</tr>
</tbody>
</table>

Resolution Specifications: AVC-Intra with AVC-I Codec Module

The following information applies if you have the Nitris DX with the AVC-I codec module installed. The codec module provides real-time encoding to the AVC-intra compression format, using the 10-bit high definition H.264 intra-frame codec.

This module allows for real-time baseband capture with the Nitris DX and allows real-time performance for most rendering and mixdown operations.

When you start your Avid editing application, it detects the presence of the AVC-I codec module. It will use the module for capture, render and mixdown. If the module is not present, the editing application uses the software codec to perform these operations. Although, baseband capture of AVC-I is supported only with the hardware codec module.

The following table provides AVC-Intra (with AVC-I Codec Module) specifications by project type.

<table>
<thead>
<tr>
<th>Project</th>
<th>Edit Rate</th>
<th>Resolution Name</th>
<th>MB/Sec</th>
<th>Raster Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>1080i</td>
<td>59.94</td>
<td>AVC-Intra 50</td>
<td>50MBit</td>
<td>1440x1080</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AVC-Intra 100</td>
<td>100MBit</td>
<td>1920x1080</td>
</tr>
<tr>
<td>1080i</td>
<td>50</td>
<td>AVC-Intra 50</td>
<td>50MBit</td>
<td>1440x1080</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AVC-Intra 100</td>
<td>100MBit</td>
<td>1920x1080</td>
</tr>
<tr>
<td>1080p</td>
<td>29.97</td>
<td>AVC-Intra 50</td>
<td>50MBit</td>
<td>1440x1080</td>
</tr>
</tbody>
</table>
Resolution Specifications: JFIF Interlaced

Avid JFIF resolutions use a simple notation \((x:l)\) to identify the level of compression. The value of \(x\) indicates the level of compression that is applied to the image data. For example, a 3:1 compression ratio compresses the original data to one-third of its uncompressed size.

A lower compression ratio (a lower number to the left of the colon) results in better image quality but requires more drive space to store the captured media. A lower compression ratio might also require drive striping to keep up with the high volume of data.

The following table provides information about the Avid resolutions for interlaced media (30i NTSC and 25i PAL projects). Field size does not include blanking or VITC lines.

<table>
<thead>
<tr>
<th>Project</th>
<th>Edit Rate</th>
<th>Resolution Name</th>
<th>MB/Sec</th>
<th>Raster Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>1080p</td>
<td>23.976</td>
<td>AVC-Intra 100</td>
<td>100MBit</td>
<td>1920x1080</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AVC-Intra 50</td>
<td>50MBit</td>
<td>1440x1080</td>
</tr>
<tr>
<td>1080p</td>
<td>25</td>
<td>AVC-Intra 100</td>
<td>100MBit</td>
<td>1920x1080</td>
</tr>
<tr>
<td>720p</td>
<td>59.94</td>
<td>AVC-Intra 50</td>
<td>50MBit</td>
<td>960x720</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AVC-Intra 100</td>
<td>100MBit</td>
<td>1280x720</td>
</tr>
<tr>
<td>720p</td>
<td>50</td>
<td>AVC-Intra 50</td>
<td>50MBit</td>
<td>960x720</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AVC-Intra 100</td>
<td>100MBit</td>
<td>1280x720</td>
</tr>
</tbody>
</table>

Resolution Specifications: JFIF Interlaced

Avid JFIF resolutions use a simple notation \((x:l)\) to identify the level of compression. The value of \(x\) indicates the level of compression that is applied to the image data. For example, a 3:1 compression ratio compresses the original data to one-third of its uncompressed size.

A lower compression ratio (a lower number to the left of the colon) results in better image quality but requires more drive space to store the captured media. A lower compression ratio might also require drive striping to keep up with the high volume of data.

The following table provides information about the Avid resolutions for interlaced media (30i NTSC and 25i PAL projects). Field size does not include blanking or VITC lines.

<table>
<thead>
<tr>
<th>Resolution</th>
<th>Field Size (Visible Pixels)</th>
<th>Fields Per Frame</th>
<th>Quality</th>
</tr>
</thead>
<tbody>
<tr>
<td>15:1s</td>
<td>352 x 243 (NTSC) 352 x 288 (PAL)</td>
<td>1</td>
<td>Offline — provides maximum storage with enough image detail to make basic editing decisions (you can check lip sync on a medium shot).</td>
</tr>
<tr>
<td>4:1s</td>
<td>352 x 243 (NTSC) 352 x 288 (PAL)</td>
<td>1</td>
<td>Offline — a good storage resolution combined with a good offline image quality.</td>
</tr>
<tr>
<td>2:1s</td>
<td>352 x 243 (NTSC) 352 x 288 (PAL)</td>
<td>1</td>
<td>Online — provides enough detail for finishing multimedia jobs such as CD-ROM and Web authoring.</td>
</tr>
<tr>
<td>20:1</td>
<td>720 x 486 (NTSC) 720 x 576 (PAL)</td>
<td>2</td>
<td>Offline — useful for mixing storage-efficient offline footage with online-quality resolutions.</td>
</tr>
</tbody>
</table>
Symphony Option supports single-field resolutions (s resolutions) and multicam resolutions (m resolutions) for capture, render and play. You cannot create titles or import in these resolutions.

Resolution Specifications: JFIF Progressive

The following table provides information about the Avid resolutions for progressive media (24p NTSC and 24p PAL projects). Frame size does not include blanking or VITC lines.
Resolution Specifications: Multicam

Both interlaced and progressive projects support multicamera resolutions (m resolutions). You cannot mix m resolutions with resolutions in other families. The capture of a multicamera resolution in a video project results in single-field compressed media that is resized horizontally to 288 pixels wide. Playback decompresses and resizes to 720 pixels wide. The resulting single field plays back the same as s resolution media, where one field per frame time is presented to the video out device. Frame size does not include blanking or VITC lines.

M resolutions were recommended for Multicam in Meridien-based Avid editing applications. They remain available in current Avid editing applications for compatibility reasons, but are not recommended for use.

Symphony Option supports single-field resolutions (s resolutions) and multicam resolutions (m resolutions) for capture, render and play. You cannot create titles or import in these resolutions.

<table>
<thead>
<tr>
<th>Resolution</th>
<th>Frame Size (Pixels)</th>
<th>Quality</th>
</tr>
</thead>
<tbody>
<tr>
<td>10:1m interlaced</td>
<td>720 x 486 (NTSC) 720 x 576 (PAL)</td>
<td>Offline</td>
</tr>
<tr>
<td>8:1m progressive</td>
<td>720 x 486 (NTSC) 720 x 576 (PAL)</td>
<td>Offline</td>
</tr>
<tr>
<td>4:1m interlaced</td>
<td>720 x 486 (NTSC) 720 x 576 (PAL)</td>
<td>Online</td>
</tr>
<tr>
<td>3:1m progressive</td>
<td>720 x 486 (NTSC) 720 x 576 (PAL)</td>
<td>Online</td>
</tr>
</tbody>
</table>

Resolution Specifications: Digital Video (DV)

Digital video (DV) is an international standard created by a consortium of 10 companies to serve as a consumer digital video format. Avid editing applications support three DV resolutions: DV 25, DV 50, and DVCPRO HD.
DV, originally known as DVC (Digital Video Cassette), uses a 1/4-inch tape to record very high quality digital video. The video is sampled at the same rate as D1, D5, or Digital Betacam video (720 pixels per scan line). The color information in DV 25 is sampled at the D1 rate of 4:1:1 in 525-line (NTSC) and 4:2:0 in 625-line (PAL) formats. DV 50 is defined as 720 x 480, 50-megabit-per-second (Mb/s) 4:2:2 DV. DVCPRO HD is an HD format (DVCPRO HD), which is available in both 720p and 1080i resolutions, at 100 Mb/sec.

The following table provides DV resolution specifications for Avid editing applications with the DV/MPEG option or the HD option.

<table>
<thead>
<tr>
<th>Resolution</th>
<th>Frame Size</th>
<th>Color Sampling</th>
<th>Megabits per second (Mb/sec)</th>
</tr>
</thead>
<tbody>
<tr>
<td>DV 25 411 interlaced</td>
<td>720 x 480 (NTSC)</td>
<td>4:1:1</td>
<td>25</td>
</tr>
<tr>
<td></td>
<td>720 x 576 (PAL)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DV 25p 411 progressive</td>
<td>720 x 480 (NTSC)</td>
<td>4:1:1</td>
<td>25</td>
</tr>
<tr>
<td></td>
<td>720 x 576 (PAL)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DV 25 420 interlaced</td>
<td>720 x 576 (PAL)</td>
<td>4:2:0</td>
<td>25</td>
</tr>
<tr>
<td>DV 50 interlaced</td>
<td>720 x 480 (NTSC)</td>
<td>4:2:2</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td>720 x 576 (PAL)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DV 50p progressive</td>
<td>720 x 480 (NTSC)</td>
<td>4:2:2</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td>720 x 576 (PAL)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DVCPRO HD (720p)</td>
<td>1280 x 720</td>
<td>4:2:2</td>
<td>100</td>
</tr>
<tr>
<td>DVCPRO HD (1080i)</td>
<td>1920 x 1080</td>
<td>4:2:2</td>
<td>100</td>
</tr>
</tbody>
</table>

**Resolution Specifications: MPEG**

MPEG resolutions are specifically intended to support the SMPTE Type D-10 bit stream produced and recorded by devices such as Sony MPEG IMX VTRs. They use 4:2:2 sampling. The following table provides MPEG resolution specifications. Frame size does not include blanking or VITC lines.

<table>
<thead>
<tr>
<th>Resolution</th>
<th>Frame Size (Visible pixels)</th>
<th>Megabits per second (Mb/sec)</th>
</tr>
</thead>
<tbody>
<tr>
<td>MPEG 30</td>
<td>720 x 480 (NTSC) 720 x 576 (PAL)</td>
<td>30</td>
</tr>
<tr>
<td>MPEG 40</td>
<td>720 x 480 (NTSC) 720 x 576 (PAL)</td>
<td>40</td>
</tr>
</tbody>
</table>
Resolution Specifications SD: Apple ProRes

Avid editing applications support editing and playback of Apple ProRes media encoded using the Apple ProRes MXF codec. You can import, playback, transcode, and consolidate Apple ProRes MXF resolutions.

The following table provides Apple ProRes MXF specifications by project type.

<table>
<thead>
<tr>
<th>Resolution</th>
<th>Bits</th>
<th>Project Format</th>
<th>Frame Size</th>
<th>Frames/sec</th>
<th>Megabits per second (Mb/sec)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apple ProRes 422 MXF</td>
<td>10</td>
<td>23.976pNTSC</td>
<td>720 x 486</td>
<td>23.976</td>
<td>24</td>
</tr>
<tr>
<td>Apple ProRes 422 HQ MXF</td>
<td>10</td>
<td>23.976pNTSC</td>
<td>720 x 486</td>
<td>23.976</td>
<td>50</td>
</tr>
<tr>
<td>Apple ProRes 422 LT MXF</td>
<td>10</td>
<td>23.976pNTSC</td>
<td>720 x 486</td>
<td>23.976</td>
<td>23</td>
</tr>
<tr>
<td>Apple ProRes 422 Proxy MXF</td>
<td>10</td>
<td>23.976pNTSC</td>
<td>720 x 486</td>
<td>23.976</td>
<td>10</td>
</tr>
<tr>
<td>Apple ProRes 4444</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>75</td>
</tr>
<tr>
<td>Apple ProRes 422 MXF</td>
<td>10</td>
<td>24pPAL</td>
<td>720 x 576</td>
<td>24</td>
<td>41</td>
</tr>
<tr>
<td>Apple ProRes 422 HQ MXF</td>
<td>10</td>
<td>24pPAL</td>
<td>720 x 576</td>
<td>24</td>
<td>61</td>
</tr>
<tr>
<td>Apple ProRes 422 LT MXF</td>
<td>10</td>
<td>24pPAL</td>
<td>720 x 576</td>
<td>24</td>
<td>28</td>
</tr>
<tr>
<td>Apple ProRes 422 Proxy MXF</td>
<td>10</td>
<td>24pPAL</td>
<td>720 x 576</td>
<td>24</td>
<td>12</td>
</tr>
<tr>
<td>Apple ProRes 4444</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>92</td>
</tr>
<tr>
<td>Apple ProRes 422 MXF</td>
<td>10</td>
<td>24pNTSC</td>
<td>720 x 486</td>
<td>24</td>
<td>24</td>
</tr>
<tr>
<td>Apple ProRes 422 HQ MXF</td>
<td>10</td>
<td>24pNTSC</td>
<td>720 x 486</td>
<td>24</td>
<td>50</td>
</tr>
<tr>
<td>Apple ProRes 422 LT MXF</td>
<td>10</td>
<td>24pNTSC</td>
<td>720 x 486</td>
<td>24</td>
<td>23</td>
</tr>
<tr>
<td>Apple ProRes 422 Proxy MXF</td>
<td>10</td>
<td>24pNTSC</td>
<td>720 x 486</td>
<td>24</td>
<td>10</td>
</tr>
<tr>
<td>Apple ProRes 4444</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>75</td>
</tr>
<tr>
<td>Apple ProRes 422 MXF</td>
<td>10</td>
<td>25iPAL</td>
<td>720 x 576</td>
<td>25</td>
<td>41</td>
</tr>
<tr>
<td>Apple ProRes 422 HQ MXF</td>
<td>10</td>
<td>25iPAL</td>
<td>720 x 576</td>
<td>25</td>
<td>61</td>
</tr>
<tr>
<td>Apple ProRes 422 LT MXF</td>
<td>10</td>
<td>25iPAL</td>
<td>720 x 576</td>
<td>25</td>
<td>28</td>
</tr>
<tr>
<td>Apple ProRes 422 Proxy MXF</td>
<td>10</td>
<td>25iPAL</td>
<td>720 x 576</td>
<td>25</td>
<td>12</td>
</tr>
<tr>
<td>Apple ProRes 4444</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>92</td>
</tr>
</tbody>
</table>

Proxy Resolutions

The following proxy resolutions are available for all media creation except Capture.
<table>
<thead>
<tr>
<th>Project</th>
<th>Proxy Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>1080i50</td>
<td>H.264 800Kbps Proxy</td>
</tr>
<tr>
<td></td>
<td>H.264 2.0Mbps Proxy</td>
</tr>
<tr>
<td>1080i59</td>
<td>H.264 800Kbps Proxy</td>
</tr>
<tr>
<td></td>
<td>H.264 2.0Mbps Proxy</td>
</tr>
<tr>
<td>1080p23</td>
<td>H.264 800Kbps Proxy</td>
</tr>
<tr>
<td>1080p24</td>
<td>H.264 800Kbps Proxy</td>
</tr>
<tr>
<td>1080p25</td>
<td>H.264 800Kbps Proxy</td>
</tr>
<tr>
<td>1080p29</td>
<td>H.264 800Kbps Proxy</td>
</tr>
<tr>
<td>23pNTSC</td>
<td>H.264 800Kbps Proxy</td>
</tr>
<tr>
<td>24pNTSC</td>
<td>H.264 800Kbps Proxy</td>
</tr>
<tr>
<td>24pPAL</td>
<td>H.264 800Kbps Proxy</td>
</tr>
<tr>
<td>25iPAL</td>
<td>AVCIBP-BLL2.0</td>
</tr>
<tr>
<td></td>
<td>H.264 800Kbps Proxy</td>
</tr>
<tr>
<td></td>
<td>H.264 1500Kbps Proxy</td>
</tr>
<tr>
<td>25pPAL</td>
<td>H.264 800Kbps Proxy</td>
</tr>
<tr>
<td>30iNTSC</td>
<td>AVCIBP-BLL2.0</td>
</tr>
<tr>
<td></td>
<td>H.264 800Kbps Proxy</td>
</tr>
<tr>
<td></td>
<td>H.264 1500Kbps Proxy</td>
</tr>
<tr>
<td>720p23</td>
<td>H.264 800Kbps Proxy</td>
</tr>
<tr>
<td>720p25</td>
<td>H.264 800Kbps Proxy</td>
</tr>
<tr>
<td>720p29</td>
<td>H.264 800Kbps Proxy</td>
</tr>
<tr>
<td>720p50</td>
<td>H.264 800Kbps Proxy</td>
</tr>
<tr>
<td></td>
<td>H.264 2.0Mbps Proxy</td>
</tr>
<tr>
<td></td>
<td>AVCIBP-BLL3.0</td>
</tr>
<tr>
<td>720p59</td>
<td>H.264 800Kbps Proxy</td>
</tr>
<tr>
<td></td>
<td>H.264 2.0Mbps Proxy</td>
</tr>
<tr>
<td></td>
<td>AVCIBP-BLL3.0</td>
</tr>
</tbody>
</table>
Support for Uncompressed HD Media

Depending on your Avid input/output hardware, your Avid editing applications let you play, edit, import, render, transcode, and export a single-stream of real-time uncompressed (1:1) HD media. However, only Avid Nitris DX supports capture of uncompressed HD media.

To make uncompressed HD media available on a system that cannot capture it directly, capture the media on an Avid editing application that supports capture of uncompressed HD media, and then share the media through shared storage, a network, or removable media.

The following guidelines and limitations apply to handling uncompressed HD media on systems that do not support capture of uncompressed HD media:

- You can play uncompressed HD media using the Best Performance (yellow) and Draft Quality (yellow/green) video quality settings. Playback of uncompressed HD media through the Avid input/output hardware as Full Quality (green) is not supported.
  
  You can view and play uncompressed HD media in Full Quality mode in the Source and Record monitors (and in full-screen playback if available), but you might notice skipped frames during playback. Media plays as black in a Client monitor.

- 10-bit uncompressed HD media plays back as 8-bit preview.

- You can play and edit uncompressed HD media in HDV projects, but you cannot create uncompressed HD media.

- For information on drive requirements for uncompressed HD media, see the drive striping tables for your Avid editing application at Avid’s online Knowledge Base. Go to www.avid.com/onlinesupport and search for “Drive Striping Tables.”

Mixing Resolutions

Mixing resolutions in a sequence saves time and effort in a variety of circumstances:

- You can do most of your work at a resolution that can play back real-time effects, capturing only the most complex shots and graphics at a high-quality, single-stream resolution.

- For storage and playback efficiency, you can capture complex footage at the draft-quality online resolution and edit it along with other online resolutions.

- You can avoid some recapturing by importing complex graphics at a high-quality resolution and by capturing the remaining footage at draft quality during the offline phase.

- You can exchange material between projects with a minimum of recapturing.

- You can develop material among workstations at different resolutions and bring the material together for a final cut without recapturing.
Resolution Groups and Image Quality

In general, a lower compression ratio means higher image quality. However, the resolution group itself (single-field, two-field, progressive, or uncompressed) is also a factor in the quality of the final image.

Single-field resolutions work with smaller amounts of original image data than two-field or progressive resolutions. They use only half the image width of two-field resolutions, and they use only one of the two fields in the standard video signal.

For example, there is a 2:1 resolution for both single-field and two-field resolutions. In both cases, the image data is compressed to one-half of its original size. However, the image quality of these two resolutions is different. The single-field 2:1 resolution has lower image quality because it processes only one-quarter of the original image data used by the two-field 2:1 resolution.

Estimating Drive Space Requirements

You should plan the use of drive volumes in advance, especially when you capture many tapes. You need to select a resolution that provides adequate picture quality for your project. However, you might be limited by the amount of media drive space available. Before you capture, estimate your media drive space requirements.

To estimate media drive space requirements:

1. Use the appropriate resolution specifications table.

   See “Resolution Specifications” on page 1559 and the information in your media drive documentation to select a resolution that is compatible with the drive and striping capacity on your system.

2. Open the Capture tool, select a resolution and target drive or drives, and note the time remaining on the selected drives.

   For more information, see “Selecting the Target Drives” on page 204.

3. Get a total duration for all the clips you plan to capture.

   Use the Console and the Get Bin Info commands, as described in “Using The Console Window” on page 134.

4. Use the estimated storage requirements table to estimate your drive space requirements based on the resolution and the number of audio tracks.

5. Compare the gigabytes available on your drives with the storage requirements table.
If your needs are greater than your drive space, select a lower resolution and recalculate.
The information in the storage tables is approximate, so it’s a good idea to slightly overestimate the amount of drive space you require.

### Storage Requirements

The following topics provide estimated drive space requirements for the various resolutions. They show figures for estimated minutes per gigabyte and also figures for the drive space required for certain amounts of material.

“Estimating Drive Space Requirements” on page 1574 contains recommendations for achieving efficient storage for your digital media. It explains how playback performance is affected by the way you set up the storage drives and target them when you capture.

### Estimated Storage Requirements: HD

This table does not include estimated storage requirements for audio.

<table>
<thead>
<tr>
<th>Resolution</th>
<th>Bits</th>
<th>Project Format</th>
<th>Drive Space Needed for 1 Hour of Media (GB)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1:1 10-bit HD</td>
<td>10</td>
<td>720p/23.976</td>
<td>185</td>
</tr>
<tr>
<td>1:1 HD</td>
<td>8</td>
<td></td>
<td>148</td>
</tr>
<tr>
<td>DNxHD 90 X</td>
<td>10</td>
<td></td>
<td>37</td>
</tr>
<tr>
<td>DNxHD 90</td>
<td>8</td>
<td></td>
<td>37</td>
</tr>
<tr>
<td>DNxHD 60</td>
<td>8</td>
<td></td>
<td>24</td>
</tr>
<tr>
<td>DVCPRO HD</td>
<td>8</td>
<td></td>
<td>48</td>
</tr>
<tr>
<td>XDCAM HD 50</td>
<td>8</td>
<td></td>
<td>22</td>
</tr>
<tr>
<td>AVC-Intra 100</td>
<td>10</td>
<td></td>
<td>24</td>
</tr>
<tr>
<td>Apple ProRes 422 MXF</td>
<td>10</td>
<td></td>
<td>26</td>
</tr>
<tr>
<td>Apple ProRes 422 HQ MXF</td>
<td>10</td>
<td></td>
<td>40</td>
</tr>
<tr>
<td>Apple ProRes 422 LT MXF</td>
<td>10</td>
<td></td>
<td>18</td>
</tr>
<tr>
<td>Apple ProRes 422 Proxy MXF</td>
<td>10</td>
<td></td>
<td>8</td>
</tr>
<tr>
<td>Apple ProRes 4444</td>
<td>10</td>
<td></td>
<td>59</td>
</tr>
<tr>
<td>AVC-Intra 50</td>
<td>10</td>
<td></td>
<td>12</td>
</tr>
<tr>
<td>Resolution</td>
<td>Bits</td>
<td>Project Format</td>
<td>Drive Space Needed for 1 Hour of Media (GB)</td>
</tr>
<tr>
<td>-------------------</td>
<td>------</td>
<td>----------------</td>
<td>-------------------------------------------</td>
</tr>
<tr>
<td>1:1 10-bit HD</td>
<td>10</td>
<td>720p/25</td>
<td>198</td>
</tr>
<tr>
<td>1:1 HD</td>
<td>8</td>
<td>720p/25</td>
<td>158</td>
</tr>
<tr>
<td>DNxHD 90 X</td>
<td>10</td>
<td>720p/29.97</td>
<td>41</td>
</tr>
<tr>
<td>DNxHD 90</td>
<td>8</td>
<td>720p/25</td>
<td>41</td>
</tr>
<tr>
<td>DNxHD 60</td>
<td>8</td>
<td>720p/25</td>
<td>27</td>
</tr>
<tr>
<td>DVCPRO HD</td>
<td>8</td>
<td>720p/25</td>
<td>25</td>
</tr>
<tr>
<td>XDCAM HD 50</td>
<td>8</td>
<td>720p/25</td>
<td>22</td>
</tr>
<tr>
<td>AVC-Intra 100</td>
<td>10</td>
<td>720p/25</td>
<td>24</td>
</tr>
<tr>
<td>Apple ProRes 422 MXF</td>
<td>10</td>
<td>720p/25</td>
<td>28</td>
</tr>
<tr>
<td>Apple ProRes 422 HQ MXF</td>
<td>10</td>
<td>720p/25</td>
<td>41</td>
</tr>
<tr>
<td>Apple ProRes 422 LT MXF</td>
<td>10</td>
<td>720p/25</td>
<td>19</td>
</tr>
<tr>
<td>Apple ProRes 422 Proxy MXF</td>
<td>10</td>
<td>720p/25</td>
<td>9</td>
</tr>
<tr>
<td>Apple ProRes 4444</td>
<td>10</td>
<td>720p/25</td>
<td>62</td>
</tr>
<tr>
<td>AVC-Intra 50</td>
<td>10</td>
<td>720p/25</td>
<td>12</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Resolution</th>
<th>Bits</th>
<th>Project Format</th>
<th>Drive Space Needed for 1 Hour of Media (GB)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1:1 10-bit HD</td>
<td>10</td>
<td>720p/29.97</td>
<td>237</td>
</tr>
<tr>
<td>1:1 HD</td>
<td>8</td>
<td>720p/29.97</td>
<td>190</td>
</tr>
<tr>
<td>DNxHD 110 X</td>
<td>10</td>
<td>720p/29.97</td>
<td>50</td>
</tr>
<tr>
<td>DNxHD 110</td>
<td>8</td>
<td>720p/29.97</td>
<td>50</td>
</tr>
<tr>
<td>DNxHD 70</td>
<td>8</td>
<td>720p/29.97</td>
<td>32</td>
</tr>
<tr>
<td>DVCPRO HD</td>
<td>8</td>
<td>720p/29.97</td>
<td>25</td>
</tr>
<tr>
<td>XDCAM HD 50</td>
<td>8</td>
<td>720p/29.97</td>
<td>22</td>
</tr>
<tr>
<td>AVC-Intra 100</td>
<td>10</td>
<td>720p/29.97</td>
<td>24</td>
</tr>
<tr>
<td>Apple ProRes 422 MXF</td>
<td>10</td>
<td>720p/29.97</td>
<td>33</td>
</tr>
<tr>
<td>Apple ProRes 422 HQ MXF</td>
<td>10</td>
<td>720p/29.97</td>
<td>49</td>
</tr>
<tr>
<td>Apple ProRes 422 LT MXF</td>
<td>10</td>
<td>720p/29.97</td>
<td>23</td>
</tr>
<tr>
<td>Apple ProRes 422 Proxy MXF</td>
<td>10</td>
<td>720p/29.97</td>
<td>10</td>
</tr>
<tr>
<td>Apple ProRes 4444</td>
<td>10</td>
<td>720p/29.97</td>
<td>74</td>
</tr>
<tr>
<td>AVC-Intra 50</td>
<td>10</td>
<td>720p/29.97</td>
<td>12</td>
</tr>
<tr>
<td>Resolution</td>
<td>Bits</td>
<td>Project Format</td>
<td>Drive Space Needed for 1 Hour of Media (GB)</td>
</tr>
<tr>
<td>--------------------</td>
<td>------</td>
<td>------------------</td>
<td>--------------------------------------------</td>
</tr>
<tr>
<td>1:1 10-bit HD</td>
<td>10</td>
<td>720p/50</td>
<td>396</td>
</tr>
<tr>
<td>1:1 HD</td>
<td>8</td>
<td></td>
<td>317</td>
</tr>
<tr>
<td>DNxHD 175 X</td>
<td>10</td>
<td></td>
<td>79</td>
</tr>
<tr>
<td>DNxHD 175</td>
<td>8</td>
<td></td>
<td>79</td>
</tr>
<tr>
<td>DNxHD 115</td>
<td>8</td>
<td></td>
<td>52</td>
</tr>
<tr>
<td>DVCPro HD</td>
<td>8</td>
<td></td>
<td>50</td>
</tr>
<tr>
<td>XDCAM HD 50</td>
<td>8</td>
<td></td>
<td>22</td>
</tr>
<tr>
<td>AVC-Intra 100</td>
<td>10</td>
<td></td>
<td>48</td>
</tr>
<tr>
<td>Apple ProRes 422 MXF</td>
<td>10</td>
<td></td>
<td>55</td>
</tr>
<tr>
<td>Apple ProRes 422 HQ MXF</td>
<td>10</td>
<td></td>
<td>83</td>
</tr>
<tr>
<td>Apple ProRes 422 LT MXF</td>
<td>10</td>
<td></td>
<td>38</td>
</tr>
<tr>
<td>Apple ProRes 422 Proxy MXF</td>
<td>10</td>
<td></td>
<td>17</td>
</tr>
<tr>
<td>Apple ProRes 4444</td>
<td>10</td>
<td></td>
<td>124</td>
</tr>
<tr>
<td>AVC-Intra 50</td>
<td>10</td>
<td></td>
<td>24</td>
</tr>
<tr>
<td>1:1 10-bit HD</td>
<td>10</td>
<td>720p/59.94</td>
<td>232</td>
</tr>
<tr>
<td>1:1 HD</td>
<td>8</td>
<td></td>
<td>185</td>
</tr>
<tr>
<td>DNxHD 220 X</td>
<td>10</td>
<td></td>
<td>92</td>
</tr>
<tr>
<td>DNxHD 220</td>
<td>8</td>
<td></td>
<td>92</td>
</tr>
<tr>
<td>DNxHD 145</td>
<td>8</td>
<td></td>
<td>61</td>
</tr>
<tr>
<td>DVCPro HD</td>
<td>8</td>
<td></td>
<td>48</td>
</tr>
<tr>
<td>XDCAM HD 50</td>
<td>8</td>
<td></td>
<td>22</td>
</tr>
<tr>
<td>AVC-Intra 100</td>
<td>10</td>
<td></td>
<td>48</td>
</tr>
<tr>
<td>Apple ProRes 422 MXF</td>
<td>10</td>
<td></td>
<td>66</td>
</tr>
<tr>
<td>Apple ProRes 422 HQ MXF</td>
<td>10</td>
<td></td>
<td>99</td>
</tr>
<tr>
<td>Apple ProRes 422 LT MXF</td>
<td>10</td>
<td></td>
<td>46</td>
</tr>
<tr>
<td>Apple ProRes 422 Proxy MXF</td>
<td>10</td>
<td></td>
<td>20</td>
</tr>
<tr>
<td>Apple ProRes 4444</td>
<td>10</td>
<td></td>
<td>148</td>
</tr>
<tr>
<td>AVC-Intra 50</td>
<td>10</td>
<td></td>
<td>24</td>
</tr>
<tr>
<td>Resolution</td>
<td>Bits</td>
<td>Project Format</td>
<td>Drive Space Needed for 1 Hour of Media (GB)</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>------</td>
<td>----------------</td>
<td>-------------------------------------------</td>
</tr>
<tr>
<td>1:1 10-bit RGB HD</td>
<td>10</td>
<td>1080p/23.976</td>
<td>716</td>
</tr>
<tr>
<td>1:1 10-bit HD</td>
<td>10</td>
<td></td>
<td>417</td>
</tr>
<tr>
<td>1:1 HD</td>
<td>8</td>
<td></td>
<td>333</td>
</tr>
<tr>
<td>DNxHD 175 X</td>
<td>10</td>
<td></td>
<td>74</td>
</tr>
<tr>
<td>DNxHD 175</td>
<td>8</td>
<td></td>
<td>74</td>
</tr>
<tr>
<td>DNxHD 115</td>
<td>8</td>
<td></td>
<td>49</td>
</tr>
<tr>
<td>DNxHD 36</td>
<td>8</td>
<td></td>
<td>15</td>
</tr>
<tr>
<td>DNxHD444 440 X</td>
<td>10</td>
<td></td>
<td>148</td>
</tr>
<tr>
<td>AVC-Intra 100</td>
<td>10</td>
<td></td>
<td>48</td>
</tr>
<tr>
<td>Apple ProRes 422 MXF</td>
<td>10</td>
<td></td>
<td>53</td>
</tr>
<tr>
<td>Apple ProRes 422 HQ MXF</td>
<td>10</td>
<td></td>
<td>79</td>
</tr>
<tr>
<td>Apple ProRes 422 LT MXF</td>
<td>10</td>
<td></td>
<td>37</td>
</tr>
<tr>
<td>Apple ProRes 422 Proxy MXF</td>
<td>10</td>
<td></td>
<td>16</td>
</tr>
<tr>
<td>Apple ProRes 4444</td>
<td>10</td>
<td></td>
<td>119</td>
</tr>
<tr>
<td>AVC-Intra 50</td>
<td>10</td>
<td></td>
<td>24</td>
</tr>
<tr>
<td>1:1 10-bit RGB HD</td>
<td>10</td>
<td>1080p/24</td>
<td>717</td>
</tr>
<tr>
<td>1:1 10-bit HD</td>
<td>10</td>
<td></td>
<td>417</td>
</tr>
<tr>
<td>1:1 HD</td>
<td>8</td>
<td></td>
<td>334</td>
</tr>
<tr>
<td>DNxHD 175 X</td>
<td>10</td>
<td></td>
<td>74</td>
</tr>
<tr>
<td>DNxHD 175</td>
<td>8</td>
<td></td>
<td>74</td>
</tr>
<tr>
<td>DNxHD 115</td>
<td>8</td>
<td></td>
<td>49</td>
</tr>
<tr>
<td>DNxHD 36</td>
<td>8</td>
<td></td>
<td>15</td>
</tr>
<tr>
<td>DNxHD444 440 X</td>
<td>10</td>
<td></td>
<td>148</td>
</tr>
<tr>
<td>AVC-Intra 100</td>
<td>10</td>
<td></td>
<td>48</td>
</tr>
<tr>
<td>Apple ProRes 422 MXF</td>
<td>10</td>
<td></td>
<td>53</td>
</tr>
<tr>
<td>Apple ProRes 422 HQ MXF</td>
<td>10</td>
<td></td>
<td>79</td>
</tr>
<tr>
<td>Apple ProRes 422 LT MXF</td>
<td>10</td>
<td></td>
<td>37</td>
</tr>
<tr>
<td>Apple ProRes 422 Proxy MXF</td>
<td>10</td>
<td></td>
<td>16</td>
</tr>
<tr>
<td>Apple ProRes 4444</td>
<td>10</td>
<td></td>
<td>119</td>
</tr>
<tr>
<td>AVC-Intra 50</td>
<td>10</td>
<td></td>
<td>24</td>
</tr>
<tr>
<td>Resolution</td>
<td>Bits</td>
<td>Project Format</td>
<td>Drive Space Needed for 1 Hour of Media (GB)</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>------</td>
<td>----------------</td>
<td>--------------------------------------------</td>
</tr>
<tr>
<td>1:1 10-bit RGB HD</td>
<td>10</td>
<td>1080p/25</td>
<td>746</td>
</tr>
<tr>
<td>1:1 10-bit HD</td>
<td>10</td>
<td></td>
<td>435</td>
</tr>
<tr>
<td>1:1 HD</td>
<td>8</td>
<td></td>
<td>348</td>
</tr>
<tr>
<td>DNxHD 185 X</td>
<td>10</td>
<td></td>
<td>77</td>
</tr>
<tr>
<td>DNxHD 185</td>
<td>8</td>
<td></td>
<td>77</td>
</tr>
<tr>
<td>DNxHD 120</td>
<td>8</td>
<td></td>
<td>51</td>
</tr>
<tr>
<td>DNxHD 36</td>
<td>8</td>
<td></td>
<td>15</td>
</tr>
<tr>
<td>DNxHD444 440 X</td>
<td>10</td>
<td></td>
<td>155</td>
</tr>
<tr>
<td>AVC-Intra 100</td>
<td>10</td>
<td></td>
<td>48</td>
</tr>
<tr>
<td>Apple ProRes 422 MXF</td>
<td>10</td>
<td></td>
<td>55</td>
</tr>
<tr>
<td>Apple ProRes 422 HQ MXF</td>
<td>10</td>
<td></td>
<td>83</td>
</tr>
<tr>
<td>Apple ProRes 422 LT MXF</td>
<td>10</td>
<td></td>
<td>38</td>
</tr>
<tr>
<td>Apple ProRes 422 Proxy MXF</td>
<td>10</td>
<td></td>
<td>17</td>
</tr>
<tr>
<td>Apple ProRes 4444</td>
<td>10</td>
<td></td>
<td>124</td>
</tr>
<tr>
<td>AVC-Intra 50</td>
<td>10</td>
<td></td>
<td>24</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Resolution</th>
<th>Bits</th>
<th>Project Format</th>
<th>Drive Space Needed for 1 Hour of Media (GB)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1:1 10-bit RGB HD</td>
<td>10</td>
<td>1080i/50</td>
<td>746</td>
</tr>
<tr>
<td>1:1 10-bit HD</td>
<td>10</td>
<td></td>
<td>435</td>
</tr>
<tr>
<td>1:1 HD</td>
<td>8</td>
<td></td>
<td>348</td>
</tr>
<tr>
<td>DNxHD 185 X</td>
<td>10</td>
<td></td>
<td>77</td>
</tr>
<tr>
<td>DNxHD 185</td>
<td>8</td>
<td></td>
<td>77</td>
</tr>
<tr>
<td>DNxHD 120</td>
<td>8</td>
<td></td>
<td>51</td>
</tr>
<tr>
<td>DVCPRO HD</td>
<td>8</td>
<td></td>
<td>48</td>
</tr>
<tr>
<td>XDCAM HD 50</td>
<td>8</td>
<td></td>
<td>22</td>
</tr>
<tr>
<td>AVC-Intra 100</td>
<td>10</td>
<td></td>
<td>48</td>
</tr>
<tr>
<td>Apple ProRes 422 MXF</td>
<td>10</td>
<td></td>
<td>110</td>
</tr>
<tr>
<td>Apple ProRes 422 HQ MXF</td>
<td>10</td>
<td></td>
<td>165</td>
</tr>
<tr>
<td>Apple ProRes 422 LT MXF</td>
<td>10</td>
<td></td>
<td>77</td>
</tr>
<tr>
<td>Apple ProRes 422 Proxy MXF</td>
<td>10</td>
<td></td>
<td>34</td>
</tr>
<tr>
<td>Apple ProRes 4444</td>
<td>10</td>
<td></td>
<td>248</td>
</tr>
<tr>
<td>AVC-Intra 50</td>
<td>10</td>
<td></td>
<td>24</td>
</tr>
</tbody>
</table>
## Estimated Storage Requirements: JFIF Interlaced

<table>
<thead>
<tr>
<th>Resolution</th>
<th>Bits</th>
<th>Project Format</th>
<th>Drive Space Needed for 1 Hour of Media (GB)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1:1 10-bit RGB HD</td>
<td>10</td>
<td>1080i/59.94</td>
<td>895</td>
</tr>
<tr>
<td>1:1 10-bit HD</td>
<td>10</td>
<td></td>
<td>521</td>
</tr>
<tr>
<td>1:1 HD</td>
<td>8</td>
<td></td>
<td>417</td>
</tr>
<tr>
<td>DNxHD 220 X</td>
<td>10</td>
<td></td>
<td>92</td>
</tr>
<tr>
<td>DNxHD 220</td>
<td>8</td>
<td></td>
<td>92</td>
</tr>
<tr>
<td>DNxHD 145</td>
<td>8</td>
<td></td>
<td>61</td>
</tr>
<tr>
<td>DVC PRO HD</td>
<td>8</td>
<td></td>
<td>48</td>
</tr>
<tr>
<td>XDCAM HD 50</td>
<td>8</td>
<td></td>
<td>22</td>
</tr>
<tr>
<td>AVC-Intra 100</td>
<td>10</td>
<td></td>
<td>48</td>
</tr>
<tr>
<td>Apple ProRes 422 MXF</td>
<td>10</td>
<td></td>
<td>132</td>
</tr>
<tr>
<td>Apple ProRes 422 HQ MXF</td>
<td>10</td>
<td></td>
<td>198</td>
</tr>
<tr>
<td>Apple ProRes 422 LT MXF</td>
<td>10</td>
<td></td>
<td>92</td>
</tr>
<tr>
<td>Apple ProRes 422 Proxy MXF</td>
<td>10</td>
<td></td>
<td>41</td>
</tr>
<tr>
<td>Apple ProRes 4444</td>
<td>10</td>
<td></td>
<td>297</td>
</tr>
<tr>
<td>AVC-Intra 50</td>
<td>10</td>
<td></td>
<td>24</td>
</tr>
</tbody>
</table>

### Drive Space Needed for Media

<table>
<thead>
<tr>
<th>Resolution</th>
<th>Audio Tracks</th>
<th>Minutes Per Gigabyte</th>
<th>Drive Space Needed for 1 Minute of Media</th>
<th>Drive Space Needed for 10 Minutes of Media</th>
<th>Drive Space Needed for 30 Minutes of Media</th>
</tr>
</thead>
<tbody>
<tr>
<td>15:1s</td>
<td>0</td>
<td>48.5</td>
<td>20.6 MB</td>
<td>206 MB</td>
<td>618 MB</td>
</tr>
<tr>
<td>1</td>
<td>38.6</td>
<td>25.9 MB</td>
<td>259 MB</td>
<td>777 MB</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>32.1</td>
<td>31.2 MB</td>
<td>312 MB</td>
<td>936 MB</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>28.2</td>
<td>35.5 MB</td>
<td>355 MB</td>
<td>1.07 GB</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>24.5</td>
<td>40.8 MB</td>
<td>408 MB</td>
<td>1.22 GB</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>16.1</td>
<td>62.0 MB</td>
<td>620 MB</td>
<td>1.86 GB</td>
<td></td>
</tr>
<tr>
<td>4:1s</td>
<td>0</td>
<td>11.6</td>
<td>85.8 MB</td>
<td>858 MB</td>
<td>2.57 GB</td>
</tr>
<tr>
<td>1</td>
<td>11.0</td>
<td>91.1 MB</td>
<td>911 MB</td>
<td>2.73 GB</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>10.5</td>
<td>95.4 MB</td>
<td>954 MB</td>
<td>2.86 GB</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>9.9</td>
<td>101 MB</td>
<td>1.01 GB</td>
<td>3.03 GB</td>
<td></td>
</tr>
<tr>
<td>Resolution</td>
<td>Audio Tracks</td>
<td>Minutes Per Gigabyte</td>
<td>Drive Space Needed for 1 Minute of Media</td>
<td>Drive Space Needed for 10 Minutes of Media</td>
<td>Drive Space Needed for 30 Minutes of Media</td>
</tr>
<tr>
<td>------------</td>
<td>--------------</td>
<td>----------------------</td>
<td>------------------------------------------</td>
<td>-------------------------------------------</td>
<td>---------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>9.4</td>
<td>106 MB</td>
<td>1.06 GB</td>
<td>3.18 GB</td>
</tr>
<tr>
<td></td>
<td>8</td>
<td>7.9</td>
<td>127 MB</td>
<td>1.27 GB</td>
<td>3.81 GB</td>
</tr>
<tr>
<td>2:1s</td>
<td>0</td>
<td>5.8</td>
<td>172 MB</td>
<td>1.72 GB</td>
<td>5.16 GB</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>5.7</td>
<td>177 MB</td>
<td>1.77 GB</td>
<td>5.28 GB</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>5.5</td>
<td>182 MB</td>
<td>1.82 GB</td>
<td>5.46 GB</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>5.4</td>
<td>187 MB</td>
<td>1.87 GB</td>
<td>5.61 GB</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>5.2</td>
<td>193 MB</td>
<td>1.93 GB</td>
<td>5.79 GB</td>
</tr>
<tr>
<td></td>
<td>8</td>
<td>4.7</td>
<td>214 MB</td>
<td>2.14 GB</td>
<td>6.42 GB</td>
</tr>
<tr>
<td>20:1</td>
<td>0</td>
<td>16.6</td>
<td>60.1 MB</td>
<td>601 MB</td>
<td>1.80 GB</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>15.3</td>
<td>65.4 MB</td>
<td>654 MB</td>
<td>1.96 GB</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>14.1</td>
<td>70.7 MB</td>
<td>707 MB</td>
<td>2.12 GB</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>13.2</td>
<td>76.0 MB</td>
<td>760 MB</td>
<td>2.28 GB</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>12.3</td>
<td>81.3 MB</td>
<td>813 MB</td>
<td>2.44 GB</td>
</tr>
<tr>
<td></td>
<td>8</td>
<td>9.8</td>
<td>103 MB</td>
<td>1.03 GB</td>
<td>3.09 GB</td>
</tr>
<tr>
<td>10:1</td>
<td>0</td>
<td>8.3</td>
<td>120 MB</td>
<td>1.20 GB</td>
<td>3.60 GB</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>7.9</td>
<td>126 MB</td>
<td>1.26 GB</td>
<td>3.78 GB</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>7.6</td>
<td>131 MB</td>
<td>1.31 GB</td>
<td>3.93 GB</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>7.3</td>
<td>136 MB</td>
<td>1.36 GB</td>
<td>4.08 GB</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>7.2</td>
<td>140 MB</td>
<td>1.40 GB</td>
<td>4.20 GB</td>
</tr>
<tr>
<td></td>
<td>8</td>
<td>6.2</td>
<td>161 MB</td>
<td>1.61 GB</td>
<td>4.83 GB</td>
</tr>
<tr>
<td>3:1</td>
<td>0</td>
<td>2.9</td>
<td>344 MB</td>
<td>3.44 GB</td>
<td>10.32 GB</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>2.9</td>
<td>349 MB</td>
<td>3.49 GB</td>
<td>10.47 GB</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>2.8</td>
<td>354 MB</td>
<td>3.54 GB</td>
<td>10.62 GB</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>2.8</td>
<td>360 MB</td>
<td>3.60 GB</td>
<td>10.80 GB</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>2.7</td>
<td>365 MB</td>
<td>3.65 GB</td>
<td>10.95 GB</td>
</tr>
</tbody>
</table>
## Storage Requirements

<table>
<thead>
<tr>
<th>Resolution</th>
<th>Audio Tracks</th>
<th>Minutes Per Gigabyte</th>
<th>Drive Space Needed for 1 Minute of Media</th>
<th>Drive Space Needed for 10 Minutes of Media</th>
<th>Drive Space Needed for 30 Minutes of Media</th>
</tr>
</thead>
<tbody>
<tr>
<td>2:1</td>
<td>8</td>
<td>2.6</td>
<td>386 MB</td>
<td>3.86 GB</td>
<td>11.58 GB</td>
</tr>
<tr>
<td></td>
<td>0</td>
<td>1.9</td>
<td>516 MB</td>
<td>5.16 GB</td>
<td>15.48 GB</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>1.9</td>
<td>521 MB</td>
<td>5.21 GB</td>
<td>15.63 GB</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>1.9</td>
<td>526 MB</td>
<td>5.26 GB</td>
<td>15.78 GB</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>1.9</td>
<td>531 MB</td>
<td>5.31 GB</td>
<td>15.94 GB</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>1.9</td>
<td>537 MB</td>
<td>5.37 GB</td>
<td>16.11 GB</td>
</tr>
<tr>
<td></td>
<td>8</td>
<td>1.8</td>
<td>558 MB</td>
<td>5.58 GB</td>
<td>16.74 GB</td>
</tr>
<tr>
<td>1:1 SD (Uncompressed)</td>
<td>0</td>
<td>0.8</td>
<td>1.22 GB</td>
<td>12.2 GB</td>
<td>36.6 GB</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>0.8</td>
<td>1.23 GB</td>
<td>12.3 GB</td>
<td>36.9 GB</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>0.8</td>
<td>1.23 GB</td>
<td>12.3 GB</td>
<td>36.9 GB</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>0.8</td>
<td>1.24 GB</td>
<td>12.4 GB</td>
<td>37.2 GB</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>0.8</td>
<td>1.24 GB</td>
<td>12.4 GB</td>
<td>37.2 GB</td>
</tr>
<tr>
<td></td>
<td>8</td>
<td>0.8</td>
<td>1.26 GB</td>
<td>12.6 GB</td>
<td>37.8 GB</td>
</tr>
<tr>
<td>1:1 10b SD (10-bit Uncompressed)</td>
<td>0</td>
<td>0.6</td>
<td>1.53 GB</td>
<td>15.3 GB</td>
<td>45.9 GB</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>0.6</td>
<td>1.54 GB</td>
<td>15.4 GB</td>
<td>46.2 GB</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>0.6</td>
<td>1.54 GB</td>
<td>15.4 GB</td>
<td>46.2 GB</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>0.6</td>
<td>1.55 GB</td>
<td>15.5 GB</td>
<td>46.5 GB</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>0.6</td>
<td>1.55 GB</td>
<td>15.5 GB</td>
<td>46.5 GB</td>
</tr>
<tr>
<td></td>
<td>8</td>
<td>0.6</td>
<td>1.58 GB</td>
<td>15.8 GB</td>
<td>47.4 GB</td>
</tr>
</tbody>
</table>
# Estimated Storage Requirements: JFIF Progressive

<table>
<thead>
<tr>
<th>Resolution</th>
<th>Audio Tracks</th>
<th>Minutes Per Gigabyte</th>
<th>Drive Space Needed for 1 Minute of Media</th>
<th>Drive Space Needed for 10 Minutes of Media</th>
<th>Drive Space Needed for 30 Minutes of Media</th>
</tr>
</thead>
<tbody>
<tr>
<td>35:1</td>
<td>0</td>
<td>36.4 (NTSC)</td>
<td>27.5 MB</td>
<td>275 MB</td>
<td>824 MB</td>
</tr>
<tr>
<td></td>
<td></td>
<td>30.3 (PAL)</td>
<td>33.0 MB</td>
<td>330 MB</td>
<td>990 MB</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>30.5 (NTSC)</td>
<td>32.8 MB</td>
<td>328 MB</td>
<td>983 MB</td>
</tr>
<tr>
<td></td>
<td></td>
<td>26.1 (PAL)</td>
<td>38.3 MB</td>
<td>383 MB</td>
<td>1.14 GB</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>26.3 (NTSC)</td>
<td>38.1 MB</td>
<td>381 MB</td>
<td>1.14 GB</td>
</tr>
<tr>
<td></td>
<td></td>
<td>22.9 (PAL)</td>
<td>43.6 MB</td>
<td>436 MB</td>
<td>1.30 GB</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>23.1 (NTSC)</td>
<td>43.4 MB</td>
<td>434 MB</td>
<td>1.30 GB</td>
</tr>
<tr>
<td></td>
<td></td>
<td>20.4 (PAL)</td>
<td>48.9 MB</td>
<td>489 MB</td>
<td>1.47 GB</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>20.5 (NTSC)</td>
<td>48.7 MB</td>
<td>487 MB</td>
<td>1.46 GB</td>
</tr>
<tr>
<td></td>
<td></td>
<td>18.4 (PAL)</td>
<td>54.2 MB</td>
<td>542 MB</td>
<td>1.63 GB</td>
</tr>
<tr>
<td></td>
<td>8</td>
<td>14.3 (NTSC)</td>
<td>69.9 MB</td>
<td>699 MB</td>
<td>2.10 GB</td>
</tr>
<tr>
<td></td>
<td></td>
<td>13.3 (PAL)</td>
<td>75.4 MB</td>
<td>754 MB</td>
<td>2.26 GB</td>
</tr>
<tr>
<td>28:1</td>
<td>0</td>
<td>29.1 (NTSC)</td>
<td>34.4 MB</td>
<td>344 MB</td>
<td>1.03 GB</td>
</tr>
<tr>
<td></td>
<td></td>
<td>24.3 (PAL)</td>
<td>41.2 MB</td>
<td>412 MB</td>
<td>1.23 GB</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>25.2 (NTSC)</td>
<td>39.7 MB</td>
<td>397 MB</td>
<td>1.19 GB</td>
</tr>
<tr>
<td></td>
<td></td>
<td>21.5 (PAL)</td>
<td>46.5 MB</td>
<td>465 MB</td>
<td>1.39 GB</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>22.2 (NTSC)</td>
<td>45.0 MB</td>
<td>450 MB</td>
<td>1.35 GB</td>
</tr>
<tr>
<td></td>
<td></td>
<td>19.3 (PAL)</td>
<td>51.8 MB</td>
<td>518 MB</td>
<td>1.55 GB</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>19.9 (NTSC)</td>
<td>50.3 MB</td>
<td>503 MB</td>
<td>1.51 GB</td>
</tr>
<tr>
<td></td>
<td></td>
<td>17.5 (PAL)</td>
<td>57.1 MB</td>
<td>571 MB</td>
<td>1.71 GB</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>18.0 (NTSC)</td>
<td>55.6 MB</td>
<td>557 MB</td>
<td>1.67 GB</td>
</tr>
<tr>
<td></td>
<td></td>
<td>16.0 (PAL)</td>
<td>62.4 MB</td>
<td>624 MB</td>
<td>1.87 GB</td>
</tr>
<tr>
<td></td>
<td>8</td>
<td>13.0 (NTSC)</td>
<td>76.8 MB</td>
<td>768 MB</td>
<td>2.30 GB</td>
</tr>
<tr>
<td></td>
<td></td>
<td>12.0 (PAL)</td>
<td>83.6 MB</td>
<td>836 MB</td>
<td>2.51 GB</td>
</tr>
<tr>
<td>14:1</td>
<td>0</td>
<td>14.6 (NTSC)</td>
<td>68.5 MB</td>
<td>685 MB</td>
<td>2.05 GB</td>
</tr>
<tr>
<td></td>
<td></td>
<td>12.1 (PAL)</td>
<td>82.6 MB</td>
<td>826 MB</td>
<td>2.48 GB</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>13.6 (NTSC)</td>
<td>73.8 MB</td>
<td>738 MB</td>
<td>2.21 GB</td>
</tr>
<tr>
<td></td>
<td></td>
<td>11.4 (PAL)</td>
<td>87.9 MB</td>
<td>879 MB</td>
<td>2.64 GB</td>
</tr>
<tr>
<td>Resolution</td>
<td>Audio Tracks</td>
<td>Minutes Per Gigabyte</td>
<td>Drive Space Needed for 1 Minute of Media</td>
<td>Drive Space Needed for 10 Minutes of Media</td>
<td>Drive Space Needed for 30 Minutes of Media</td>
</tr>
<tr>
<td>------------</td>
<td>--------------</td>
<td>-----------------------</td>
<td>------------------------------------------</td>
<td>------------------------------------------</td>
<td>------------------------------------------</td>
</tr>
<tr>
<td>2</td>
<td>12.6 (NTSC)</td>
<td>79.1 MB</td>
<td>791 MB</td>
<td>2.37 GB</td>
<td></td>
</tr>
<tr>
<td></td>
<td>10.7 (PAL)</td>
<td>93.2 MB</td>
<td>932 MB</td>
<td>2.80 GB</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>11.8 (NTSC)</td>
<td>84.4 MB</td>
<td>844 MB</td>
<td>2.53 GB</td>
<td></td>
</tr>
<tr>
<td></td>
<td>10.1 (PAL)</td>
<td>98.5 MB</td>
<td>985 MB</td>
<td>2.96 GB</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>11.1 (NTSC)</td>
<td>89.7 MB</td>
<td>897 MB</td>
<td>2.69 GB</td>
<td></td>
</tr>
<tr>
<td></td>
<td>9.6 (PAL)</td>
<td>103 MB</td>
<td>1.04 GB</td>
<td>3.12 GB</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>9.0 (NTSC)</td>
<td>111 MB</td>
<td>1.11 GB</td>
<td>3.33 GB</td>
<td></td>
</tr>
<tr>
<td></td>
<td>8.0 (PAL)</td>
<td>125 MB</td>
<td>1.25 GB</td>
<td>3.75 GB</td>
<td></td>
</tr>
<tr>
<td>3:1</td>
<td>0</td>
<td>3.6 (NTSC)</td>
<td>278 MB</td>
<td>2.78 GB</td>
<td>8.33 GB</td>
</tr>
<tr>
<td></td>
<td>3.0 (PAL)</td>
<td>333 MB</td>
<td>3.33 GB</td>
<td>10.0 GB</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>3.5 (NTSC)</td>
<td>283 MB</td>
<td>2.83 GB</td>
<td>8.49 GB</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3.0 (PAL)</td>
<td>339 MB</td>
<td>3.39 GB</td>
<td>10.2 GB</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>3.5 (NTSC)</td>
<td>288 MB</td>
<td>2.88 GB</td>
<td>8.65 GB</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2.9 (PAL)</td>
<td>344 MB</td>
<td>3.44 GB</td>
<td>10.3 GB</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>3.4 (NTSC)</td>
<td>294 MB</td>
<td>2.94 GB</td>
<td>8.81 GB</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2.9 (PAL)</td>
<td>349 MB</td>
<td>3.49 GB</td>
<td>10.5 GB</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>3.3 (NTSC)</td>
<td>299 MB</td>
<td>2.99 GB</td>
<td>8.97 GB</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2.8 (PAL)</td>
<td>355 MB</td>
<td>3.55 GB</td>
<td>10.6 GB</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>3.1 (NTSC)</td>
<td>320 MB</td>
<td>3.20 GB</td>
<td>9.61 GB</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2.7 (PAL)</td>
<td>376 MB</td>
<td>3.76 GB</td>
<td>11.3 GB</td>
<td></td>
</tr>
<tr>
<td>2:1</td>
<td>0</td>
<td>2.4 (NTSC)</td>
<td>417 MB</td>
<td>4.17 GB</td>
<td>12.5 GB</td>
</tr>
<tr>
<td></td>
<td>2.0 (PAL)</td>
<td>500 MB</td>
<td>5.00 GB</td>
<td>15.0 GB</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>2.4 (NTSC)</td>
<td>422 MB</td>
<td>4.22 GB</td>
<td>12.7 GB</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2.0 (PAL)</td>
<td>505 MB</td>
<td>5.05 GB</td>
<td>15.2 GB</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>2.3 (NTSC)</td>
<td>427 MB</td>
<td>4.27 GB</td>
<td>12.8 GB</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2.0 (PAL)</td>
<td>510 MB</td>
<td>5.11 GB</td>
<td>15.3 GB</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>2.3 (NTSC)</td>
<td>433 MB</td>
<td>4.33 GB</td>
<td>13.0 GB</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1.9 (PAL)</td>
<td>516 MB</td>
<td>5.16 GB</td>
<td>15.5 GB</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>2.3 (NTSC)</td>
<td>438 MB</td>
<td>4.38 GB</td>
<td>13.1 GB</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1.9 (PAL)</td>
<td>521 MB</td>
<td>5.21 GB</td>
<td>15.6 GB</td>
<td></td>
</tr>
</tbody>
</table>
### Storage Requirements

This table does not include estimated storage requirements for audio.

<table>
<thead>
<tr>
<th>Resolution</th>
<th>Audio Tracks</th>
<th>Minutes Per Gigabyte</th>
<th>Drive Space Needed for 1 Minute of Media</th>
<th>Drive Space Needed for 10 Minutes of Media</th>
<th>Drive Space Needed for 30 Minutes of Media</th>
</tr>
</thead>
<tbody>
<tr>
<td>1:1 SD</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(Uncompressed)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>2.2 (NTSC)</td>
<td>1.00 GB</td>
<td>10.0 GB</td>
<td>30.0 GB</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1.8 (PAL)</td>
<td>1.15 GB</td>
<td>11.5 GB</td>
<td>34.5 GB</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>1.0 (NTSC)</td>
<td>1.01 GB</td>
<td>10.1 GB</td>
<td>30.3 GB</td>
<td></td>
</tr>
<tr>
<td></td>
<td>0.9 (PAL)</td>
<td>1.15 GB</td>
<td>11.5 GB</td>
<td>34.6 GB</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>1.0 (NTSC)</td>
<td>1.01 GB</td>
<td>10.1 GB</td>
<td>30.3 GB</td>
<td></td>
</tr>
<tr>
<td></td>
<td>0.9 (PAL)</td>
<td>1.16 GB</td>
<td>11.6 GB</td>
<td>34.8 GB</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>1.0 (NTSC)</td>
<td>1.02 GB</td>
<td>10.2 GB</td>
<td>30.6 GB</td>
<td></td>
</tr>
<tr>
<td></td>
<td>0.9 (PAL)</td>
<td>1.17 GB</td>
<td>11.7 GB</td>
<td>35.1 GB</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>1.0 (NTSC)</td>
<td>1.02 GB</td>
<td>10.2 GB</td>
<td>30.6 GB</td>
<td></td>
</tr>
<tr>
<td></td>
<td>0.9 (PAL)</td>
<td>11.7 GB</td>
<td>11.7 GB</td>
<td>35.1 GB</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>1.0 (NTSC)</td>
<td>1.04 GB</td>
<td>10.4 GB</td>
<td>31.3 GB</td>
<td></td>
</tr>
<tr>
<td></td>
<td>0.8 (PAL)</td>
<td>1.19 GB</td>
<td>11.9 GB</td>
<td>35.8 GB</td>
<td></td>
</tr>
<tr>
<td>1:1 10b SD</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(10-bit Uncompressed)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0</td>
<td>0.8 (NTSC)</td>
<td>1.25 GB</td>
<td>12.5 GB</td>
<td>37.5 GB</td>
<td></td>
</tr>
<tr>
<td></td>
<td>0.7 (PAL)</td>
<td>1.44 GB</td>
<td>14.4 GB</td>
<td>43.2 GB</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>0.8 (NTSC)</td>
<td>1.26 GB</td>
<td>1.26 GB</td>
<td>37.9 GB</td>
<td></td>
</tr>
<tr>
<td></td>
<td>0.7 (PAL)</td>
<td>1.44 GB</td>
<td>14.4 GB</td>
<td>43.2 GB</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>0.8 (NTSC)</td>
<td>1.26 GB</td>
<td>12.6 GB</td>
<td>37.8 GB</td>
<td></td>
</tr>
<tr>
<td></td>
<td>0.7 (PAL)</td>
<td>1.45 GB</td>
<td>14.5 GB</td>
<td>43.5 GB</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>0.8 (NTSC)</td>
<td>1.28 GB</td>
<td>12.8 GB</td>
<td>38.4 GB</td>
<td></td>
</tr>
<tr>
<td></td>
<td>0.7 (PAL)</td>
<td>1.46 GB</td>
<td>14.6 GB</td>
<td>43.8 GB</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>0.8 (NTSC)</td>
<td>1.28 GB</td>
<td>12.8 GB</td>
<td>38.4 GB</td>
<td></td>
</tr>
<tr>
<td></td>
<td>0.7 (PAL)</td>
<td>1.46 GB</td>
<td>14.6 GB</td>
<td>43.8 GB</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>0.8 (NTSC)</td>
<td>1.30 GB</td>
<td>13.0 GB</td>
<td>39.0 GB</td>
<td></td>
</tr>
<tr>
<td></td>
<td>0.7 (PAL)</td>
<td>1.49 GB</td>
<td>14.9 GB</td>
<td>44.7 GB</td>
<td></td>
</tr>
</tbody>
</table>

**Estimated Storage Requirements: DV**

This table does not include estimated storage requirements for audio.
Estimated Storage Requirements: MPEG

This table does not include estimated storage requirements for audio.

<table>
<thead>
<tr>
<th>Resolution (NTSC and PAL)</th>
<th>Minutes Per Gigabyte</th>
<th>Drive Space Needed for 1 Minute of Media</th>
<th>Drive Space Needed for 10 Minutes of Media</th>
<th>Drive Space Needed for 30 Minutes of Media</th>
</tr>
</thead>
<tbody>
<tr>
<td>DV 25</td>
<td>5.0</td>
<td>200 MB</td>
<td>2.0 GB</td>
<td>6.0 GB</td>
</tr>
<tr>
<td>DV 50</td>
<td>2.5</td>
<td>400 MB</td>
<td>4.0 GB</td>
<td>12.0 GB</td>
</tr>
<tr>
<td>DVCPRO HD</td>
<td>1.2</td>
<td>800 MB</td>
<td>8.0 GB</td>
<td>24.0 GB</td>
</tr>
<tr>
<td>MPEG 30</td>
<td>4.7</td>
<td>210 MB</td>
<td>2.1 GB</td>
<td>6.3 GB</td>
</tr>
<tr>
<td>MPEG 40</td>
<td>3.6</td>
<td>280 MB</td>
<td>2.8 GB</td>
<td>8.4 GB</td>
</tr>
<tr>
<td>MPEG 50</td>
<td>2.9</td>
<td>350 MB</td>
<td>3.5 GB</td>
<td>10.5 GB</td>
</tr>
</tbody>
</table>

Considerations for Managing Storage

Maximizing Drive Space

If your media drive space is limited or you are capturing a large amount of source material, follow these suggestions to maximize your usage of the media drive space:

- Capture only the audio channels required for the edit.
- Log in advance. Batch capture only the footage required for the edit.
- Capture at a lower resolution for editing. Recapture only the clips included in the final cut at a higher resolution.

For more information on batch capturing and recapturing, see “Batch Capturing from Logged Clips” on page 250.
Managing Storage to Improve Playback Performance

The way you set up the media drives and target them when you capture can affect playback performance. Here are some suggestions for working with complex video images at high resolution, multiple video layers, or multicamera material:

- For more effective playback of multiple streams of video at higher resolutions, stripe the media drives. Some resolutions require drive striping; see the drive striping tables for your Avid editing application at Avid’s online Knowledge Base. Go to www.avid.com/onlinesupport and search for “Drive Striping Tables.”

- For more effective playback of multiple streams of video at higher resolutions without drive striping, distribute the video tracks as evenly as possible among available drives, and target separate drives for audio and video.

- Try to target one volume per reel.
Avid editing applications support HD and high-resolution media (2K and above). A full list of the video formats supported for capture, linking, editing, rendering and output is available on the Avid web site—refer to “Avid Editing Systems Supported Formats” on the Avid Knowledge Base.

Depending on the model of your Avid editing application and on your Avid input/output hardware, some of these resolutions might not be available for capture in their uncompressed form. For more information, see “Support for Uncompressed HD Media” on page 1573.

This chapter covers the various film and HD workflows that require the acquisition, editing and output of high-resolution media.

- Delivery Methods for Cinema and Television
- HD Workflow: Video-Based Television
- Producing Graphics for Broadcast
- (Media Composer | Symphony Option) Using HD Universal Mastering
- Working with HDV
- Understanding HDV
- HDV Workflow
- Capturing and Importing HDV
- Playing Back HDV Media
- Outputting HDV

**Delivery Methods for Cinema and Television**

Media originates either from film or video cameras in the form of digital high-resolution files, film reel, or video tape. This media can be converted into different formats for the post-production process and final delivery. Avid applications provide support for universal mastering which means that you can edit once and deliver to multiple film, HD and SD formats.
Based on delivery format requirements, you need to determine the best format for acquisition of the media. It’s best to begin with the highest resolution and quality source, and then “down-rez” to the required output format.

**Cinema (High-Resolution input and output)**

Feature film or documentary release to theaters demands high-resolution, high-quality source material and output to film. It is important to acquire the media at the highest possible resolution at a film rate of 24/25fps, and aspect ratio of 16:9. This media can be converted to lower-res proxies during the editing process, and then finished and output at high-res for recording back to film.

**HD Television (High Definition video broadcast, Blu-Ray disc)**

High-definition television (HDTV) is a digital broadcasting technology that delivers a larger, clearer, more detailed picture than standard definition television (SDTV). HDTV uses a 16:9 aspect ratio in place of the standard definition 4:3 ratio, and requires output to HD video format.

With digital television formats expanding the options for content distribution, there is renewed interest in the oldest format in the industry: 24-fps film. Through a telecine transfer and the capturing process, Avid editing applications capture and store film frames as 24-fps to maintain the quality options.

Many production companies even use film-resolution media from digital cameras (such as RED) as the primary source and then down-rez to HD for final delivery.

**SD Television (Standard Definition video broadcast, DVD)**

Standard definition television broadcast and DVD distribution usually requires output to NTSC or PAL video formats.

---

**Transferring Film to Tape**

You have your film rolls from the day’s shooting, and you’re ready to edit on your Avid system. To capture that footage into the system, you first need to transfer the film to videotape. This process uses a special film projector called a telecine, which is usually part of a production system that includes audiotape recorders, a controller, and other equipment. The steps in the process will differ, depending on whether you include audio and whether the transfer produces NTSC or PAL videotapes.

This section provides some guidelines to ensure that the film shoot and transfer process is well-planned for the Avid editing session.
# Film Shoot Specifications

Use the guidelines in the following table to help you plan for film shoots that will be edited on an Avid.

<table>
<thead>
<tr>
<th>Element</th>
<th>Supported Formats</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Film type</td>
<td>16mm</td>
<td>Use Standard 16mm or Super 16mm. Super 16’s aspect ratio closely matches 16:9.</td>
</tr>
<tr>
<td></td>
<td>35mm: 2, 3, 4, 8, and 12 perf</td>
<td>16mm, 35mm 4 perf, and 35mm 3 perf are supported as projects in the Avid system. The remaining formats are supported through ink numbers and auxiliary ink numbers. For more information, see “Film and 24P Settings” on page 1494.</td>
</tr>
<tr>
<td></td>
<td>65mm: 5, 8, 10, and 15 perf</td>
<td></td>
</tr>
<tr>
<td>Film wind</td>
<td>B-wind</td>
<td>Always use camera rolls with key numbers in ascending order.</td>
</tr>
<tr>
<td>Audio media</td>
<td>BWF file-based recorders</td>
<td>Use to record digital audio.</td>
</tr>
<tr>
<td>Audio timecodes</td>
<td>30-fps drop-frame or non-drop-frame</td>
<td>Use for NTSC transfer projects, and for generating audio EDLs.</td>
</tr>
<tr>
<td></td>
<td>25-fps timecode</td>
<td>Use for PAL transfer projects, and for generating audio EDLs in the PAL format.</td>
</tr>
<tr>
<td>Audio sync to in-camera timecode</td>
<td>(Arri® 24-fps timecode)</td>
<td>Use for automatic syncing of sound with picture in the Avid system.</td>
</tr>
<tr>
<td>Sync methods</td>
<td>Clapsticks</td>
<td>Use for manual syncing of sound with picture.</td>
</tr>
<tr>
<td></td>
<td>Electronic slate (smart slate)</td>
<td>Use for semiautomatic syncing.</td>
</tr>
<tr>
<td></td>
<td>In-camera timecode, with audio sync</td>
<td>Use for automatic, “slateless” syncing in the telecine.</td>
</tr>
<tr>
<td>Slate information</td>
<td>Camera roll, scene and take, shoot date, sound-roll ID</td>
<td>Mark sound-roll ID as a backup.</td>
</tr>
<tr>
<td>Sound-roll cues</td>
<td>Sound-roll ID, date, start and end time-of-day timecode</td>
<td>Include verbal time-of-day cues as a backup.</td>
</tr>
</tbody>
</table>
Film-to-Tape Transfer Guidelines

Observe the following general guidelines when transferring film to tape:

- Instruct the telecine facility to record timecode on the address track.
- Instruct the facility to use only a telecine transfer process when transferring to NTSC videotape. Do not use a film chain or any other transfer device.
- PAL transfers do not require pulldown, so you can use either a telecine or a film chain. However, quality is much better on a telecine.
- Transfer all of the project’s source film footage to disk or tape by using either the NTSC or PAL method.

- For NTSC projects, you can mix footage transferred at 24 fps (23.976 fps) or 30 fps (29.97 fps), and mix sound transferred at 1.0 or 0.99. Do not mix 24-fps and 30-fps transfers on the same transfer tape.
- For PAL projects, you cannot mix audio that has been transferred at 4.1 percent speedup (PAL Method 1) with audio that has not been sped up (PAL Method 2).

PAL film-to-tape transfers that use pulldown are not currently supported in Avid editing applications.

<table>
<thead>
<tr>
<th>Project Format</th>
<th>Source footage</th>
<th>During the telecine process</th>
</tr>
</thead>
<tbody>
<tr>
<td>SD 24 fps</td>
<td>To create ITU-R 601 video, the telecine process adds 2:3 pulldown to film footage to create an NTSC videotape, or uses 4.1% speedup for PAL videotape.</td>
<td></td>
</tr>
<tr>
<td>25 fps</td>
<td>The telecine process transfers 25-fps film footage at 1:1 (no pulldown). The sound recording can be synchronized as part of the telecine transfer.</td>
<td></td>
</tr>
<tr>
<td>23.976 fps</td>
<td>The telecine process syncs audio and transfers film footage at 1:1 (no pulldown).</td>
<td></td>
</tr>
</tbody>
</table>

For NTSC output, this method slows the audio by 4 percent. If you plan to output to both NTSC and PAL, you might want to shoot at 24 fps and use 24p instead of 25p.
Transferring Film to Tape

Film-to-Tape Transfer Quality Options and Production Aids

The quality of the film-to-tape transfers depends upon several options for the telecine transfer. The following table describes common transfer-quality options available from a telecine facility:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>One-light</td>
<td>This transfer involves a single setting of color correction values, resulting in the simplest, fastest, and least-costly type of transfer. One-light transfers are often used during offline stages of editing.</td>
</tr>
<tr>
<td>Best-light</td>
<td>This transfer involves optimum settings of the color-grade controls, but without scene-by-scene color correction. Best-light transfers are an intermediate level in terms of both quality and cost.</td>
</tr>
<tr>
<td>Timed (scene-by-scene)</td>
<td>This transfer involves color correcting each scene or shot during transfer. Timed transfers are the most expensive and time consuming. This option sets up the proper black and white levels so that you can perform a tape-to-tape color correction from the source tapes, if needed.</td>
</tr>
</tbody>
</table>

You can use the film-tape-film-tape feature to perform two separate telecine processes for a project:

- Perform a one-light or best-light transfer to obtain the most material for the initial edits.
- After editing is complete, perform a timed, fully color-corrected transfer of the clips that will be used in the final cut.

For more information on the film-tape-film-tape option, see “Relinking Clips by Key Number” on page 289.
After you perform the final telecine operation, you can capture at a finishing resolution, such as 1:1 (uncompressed).

The transfer facility might have available one or more of the production aids described in the following table, which you can include in your film-to-tape transfer:

<table>
<thead>
<tr>
<th>Aid</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatic logging</td>
<td>Whenever possible, you should instruct the facility to log tracking information directly into a computer database program. Logs generated automatically are more accurate than manual logs and can be imported easily into the Avid editing system. A log file typically indicates the relative timecode, key numbers, and pullin (“A” frames) for each clip that will be captured.</td>
</tr>
<tr>
<td>A keypunch at the head of each camera roll</td>
<td>Ask the lab or transfer house to keypunch the head of each camera roll at the zero frame and give you a list of the corresponding key numbers. After you have captured, you can match this list with your captured material to check for potential transfer errors.</td>
</tr>
<tr>
<td>Burn-in code</td>
<td>If the transfer facility is equipped with a timecode or film-code character generator, you can instruct the facility to display or “burn-in” tracking codes on the videotape transfer. Burn-in code provides visual feedback for logging and tracking footage.</td>
</tr>
<tr>
<td><strong>Burn-in code cannot be removed from the image and should be used only for the offline stage of a project.</strong></td>
<td></td>
</tr>
<tr>
<td>16:9 wide screen format</td>
<td>Your Avid editing application supports the 16:9 wide-screen display format. You can either shoot your footage by using a 16:9 lens, or transfer the footage anamorphically to display a larger area of the film aspect ratio during offline and online editing. Also, this aspect ratio lets you create media that takes advantage of 16:9 monitors that conform to SDTV and HDTV standards.</td>
</tr>
</tbody>
</table>

**Transfer of 24-fps Film to NTSC Video**

For an NTSC transfer, the telecine converts your film footage into video running at 29.97 fps. The video can then be captured and edited at 24 fps in the Avid editing system. This approach ensures that all your edits correspond to true film frames so you see an accurate representation of the finished film.

*If you transfer sound along with picture, your Avid editing application captures audio at the slowed-down speed. Then during editing and playback, your Avid editing application speeds up the play rate by 0.1 percent to play in sync with the 24-fps video. Audio plays at 44100 Hz (44.1 kHz) or 48000 Hz (48 kHz).*
**Transferring Film to Video**

Film runs at 24 fps, and NTSC video runs at 30 fps. The difference in frame rates between film and video prevents a direct frame-to-frame transfer. To compensate, the telecine process creates an extra six frames every second (the difference between 24 and 30). This method of creating extra frames is known as *pulldown*.

At the same time, the telecine slightly reduces the film’s running speed to 23.976 fps. NTSC video, the broadcast standard used in the United States, Japan, and other countries, plays at an actual rate of 29.97 fps, although it is usually referred to as 30 fps. An accurate conversion requires exact adherence to the 4:5 ratio, but this ratio breaks down when you compare 24 fps to 29.97 fps. To achieve a true 4:5 ratio, the film frame rate is slowed down to 23.976 fps. The telecine process makes this correction automatically, slowing NTSC video 0.1 percent from the original film speed, so that the video plays at 99.9 percent of its original speed.

The following table describes the film to video ratio:

<table>
<thead>
<tr>
<th>Film</th>
<th>Video</th>
</tr>
</thead>
<tbody>
<tr>
<td>24 fps</td>
<td>30 fps</td>
</tr>
<tr>
<td>4 frames</td>
<td>5 frames (10 fields)</td>
</tr>
<tr>
<td>23.976 fps (0.999 x 24)</td>
<td>29.97 fps (0.999 x 30)</td>
</tr>
</tbody>
</table>

During the capture process, your Avid editing application reverses the pulldown procedure to capture the film footage at 24 fps. It removes the extra fields added by the pulldown process to create full-frame, 24p media. The capture process captures video and audio at the slowed-down speed (0.999).

**Maintaining Synchronized Sound**

In most cases, the sound for your production has been recorded on a digital audio system, such as a BWF file-based recorder. You need to synchronize the sound with the picture and make sure they are in sync in your Avid editing application. You can take one of three basic paths:

- Transfer only the picture through the telecine process to HD videotape, capture picture from tape and sound from BWF, and sync them in your Avid editing application.
- Transfer the original sound recording to mag track, sync the mag track to the film work print, and transfer both to videotape through a telecine process.
- Sync the original sound recordings to picture during the telecine process, and transfer both to videotape.

If the telecine transfers sound along with picture, the sound intended to be slowed down for telecine is usually recorded at 48.048 kHz, so that it ends up being 48 kHz.
Transfer of 24-fps Film to PAL Video

If you use a PAL transfer, the film-to-video process takes place in two stages:

- Transfer the film to videotape by speeding up the film rate during the telecine process.
- Capture the transferred videotape into the Avid system at the sped-up rate.

There are two approaches to synchronizing sound, which are often referred to as PAL Method 1 and PAL Method 2.

**PAL Method 1**

With PAL Method 1, you synchronize sound with picture during the telecine process.

As with an NTSC film-to-tape transfer, the telecine process creates two video fields for each film frame. However, because the film rate of 24 fps is close to the PAL video rate of 25 fps, most PAL film-to-tape transfers involve simply speeding up the frame rate. This speedup changes the frame rate from 24 to 25 (an increase of 4.1 percent). There is no pulldown that creates extra fields.

Some PAL film-to-tape transfers use pulldown. This method is not currently supported in Avid editing applications.

With PAL Method 1, there are two ways to sync sound with picture in the telecine process:

- Transfer the original sound recording to mag track, sync the mag track to the film work print, and transfer both to videotape through a telecine process.
- Sync the original sound recordings to picture during the telecine process, and transfer both to videotape.

In either case, the telecine process speeds up sound at the same rate as picture: 4.1 percent.

After you receive the PAL transfer tapes, the next step is capturing the footage in a 24p PAL project. During the capturing process, your Avid editing application captures the material at the PAL rate of 25 fps, capturing every picture frame. It stores the two video fields as a single progressive frame, which you edit at 24 fps.

You must capture audio along with video at the PAL rate of 25 fps if you want to use audio that was transferred along with picture during the telecine process. You set the Audio Transfer rate as Video Rate (100+%) in the New Project dialog box. For more information, see “Audio Transfer Options for 24p PAL Projects” on page 1596.
You have the option of playing back the footage at 24 fps or 25 fps. If you select 24 fps, the system slows both the picture and the sound by 4.1 percent for playback. This approach lets you edit at the original film rate, but the slowdown creates a limitation for audio. Because you capture the audio at a rate faster than playback, some audio samples are duplicated during playback, and sound quality is compromised.

Select the Edit Play Rate option in the Film and 24p Settings dialog box. For more information, see “Film and 24P Settings” on page 1494 and “Filtering the Settings List” on page 1422.

If you select 25 fps, there is a different limitation with audio. Because you are playing back at the sped-up rate (4.1 percent), the audio pitch rises slightly. This is usually acceptable for broadcast, so PAL Method 1 is primarily used for PAL television broadcast.

**PAL Method 2**

With PAL Method 2, you capture sound and picture separately using the same telecine process for picture (create a video frame of two fields for each film frame, speed up rate by 4.1 percent). The difference is that you do not synchronize sound as part of the telecine process.

Some PAL film-to-tape transfers use pulldown. This method is not currently supported in Avid editing applications.

Here’s an example where you have your picture-only videotapes (at the rate of 25 fps) and your source recording tapes. To capture at 24 fps, you need to follow a two-step process:

1. Capture the picture to create 24p media.
2. Capture the sound at the film rate of 24 fps.

When you created the project, you set the Audio Transfer rate as Film Rate (100%) in the New Project dialog box. For more information, see “Audio Transfer Options for 24p PAL Projects” on page 1596.

In most cases, you will choose to edit at 24 fps. The sound maintains source quality (44.1 kHz and 48 kHz) and plays in sync with 24-fps video.

**Audio Transfer Options for 24p PAL Projects**

When you create a 24p PAL project, you must specify the appropriate audio transfer rate for the project. (This is not necessary for a 25p PAL project because there is no film speedup during the transfer.) The New Project dialog box provides Audio Transfer options that lets you select either Film Rate or Video Rate. This value is project specific and should not be changed after you create the project unless you have a specific element that you need to transfer at a different rate.

The Audio Transfer options are also located in the Film and 24p Settings dialog box and can be changed after the project is created. See “Film and 24P Settings” on page 1494.
The Info tab in the Project window lets you view the audio transfer rate you selected when you created the project. The actual audio transfer rate might be different from the display if you used the Film and 24p Settings dialog box to change the audio transfer rate.

The following table describes the Audio Transfer options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Film Rate (100%)</td>
<td>Select this option when your 24-fps film footage has been transferred MOS (roughly translated as “without sound”) to 25 fps by speeding up the film, and the audio comes in separately at 100 percent of the actual speed (PAL Method 2).</td>
</tr>
<tr>
<td>Video Rate (100%+)</td>
<td>Select this option when your 24-fps film footage has been transferred to 25 fps by speeding up the film, and the audio is synchronized to the video picture. This means that the audio speed is increased by 4.1 percent (PAL Method 1).</td>
</tr>
</tbody>
</table>

**Viewing Video Dailies**

The video dailies method relies on videotape transfers from negative for screening, transferring, and creating conformed cuts during editing.

The advantage of working with video dailies and film negative is that you can avoid the cost of work print until the finishing stages, or altogether. The disadvantage is you are limited to the aspect ratio, resolution, and contrast range of video previews. For this reason, video dailies are preferred for television projects, but you can also use this method to economize on a feature film production.

The illustration below describes the video dailies method:
You can use this workflow for video footage shot at 720p/23.976, 720p/59.94 or 1080p/29.97. In these cases, however, you cannot simply change the project format (step 6). Instead, you need to create a new project that matches the source footage, open the bin or bins from the NTSC 30i project, change the sequence format, decompose, and batch capture.

The following illustration shows an offline/online workflow using an HD video source for HDTV:
To create a video-based HDTV program:

1. Use an HD VTR to downconvert the source tape to 30i NTSC, 25i PAL, or 25p PAL.

2. Open a project that is suitable for HD finishing.

   When you start the online session, you can create a new project in the final format, or use the original project and change the project format. If your project requires final mastering in HD, use the corresponding SD project for offline editing. For more information, see “Offline Formats for HD” on page 1140.

3. Capture your material. Edit, apply effects, and create a final sequence.

   Avid HD editing applications support direct device control at 24 fps, enabling you to capture true 24-fps timecode from HD decks. When you are capturing 23.976-fps or 24-fps material in HD, the Capture tool displays 24-fps timecode for the Mark IN and Mark OUT points. After you capture a clip, the Start and End timecodes are also shown as 24-fps timecode.

4. (Option) Export an OMFI or AAF file to a Pro Tools digital audio workstation to create a final audio mix.

   For more information, see “Transferring Audio Files” on page 1156.

5. If you started the project in a different format, change the project format to the corresponding HD online format — see “Changing the Project Format” on page 1604.
6. Duplicate the final sequence, and then modify the format of the sequence to create a new sequence in the corresponding HD format — see “Changing the Sequence Format” on page 1605.

7. Decompose the new HD sequence and batch capture from the source tape.

8. (Option) Import the final audio mix.

9. Finish the sequence by batch capturing graphics, recreating title media and reviewing the program for effects that need fine-tuning.
   Use the original offline sequence for reference.

10. Render all effects and output a master tape.

**Producing Graphics for Broadcast**

An important part of the HDTV workflow is to produce graphics, such as bumpers and promos that are created in graphics programs for HDTV broadcast.

To create a graphics-based HDTV program:

1. Create files on a graphics workstation, using either 1280x720 for 720p or 1920x1080 for 1080i.

2. Export the files to a location that the Avid editing system can access.

3. Create a 720p or 1080i project, import the files, edit, and finish.

4. Create a broadcast master tape in the desired format. Cross-convert to output an alternative format.

**Creating a Film-Based Project**

When you create a project that uses footage coming either from film reel or high-resolution digital files (2K+), the options that you choose for your project should be determined by:

- The acquisition format (high-res digital files, 16mm or 35 mm film, HD video)
- The audio rate (film speed of 48 kHz, or video speed of 48.048 kHz)
- The finishing and output requirements of the project

**To create a new film-based project:**

1. Start your Avid editing application.

2. In the Select Project dialog box, select the folder in which you want to create the project: Private, Shared, or External.

3. Click New Project.
4. Type the name of your new project in the text box.

5. Click the Format menu and select the most appropriate project type. The format you choose must take into consideration both the frame rate at which the film was shot, as well as the final delivery format for the production.

<table>
<thead>
<tr>
<th>Format</th>
<th>Source</th>
<th>Output</th>
</tr>
</thead>
<tbody>
<tr>
<td>24p NTSC</td>
<td>Film-based or other 24-fps footage transferred to Standard Definition NTSC videotape.</td>
<td>Film, HD Broadcast, Video</td>
</tr>
<tr>
<td>23.976 NTSC</td>
<td>Film transferred at 23.976 or footage shot at 23.976. Audio remains synchronized with video throughout with no conversion required.</td>
<td>HD Broadcast, NTSC Video</td>
</tr>
<tr>
<td></td>
<td>In addition, chose this option if the production was shot with a DV (digital video) camera.</td>
<td></td>
</tr>
<tr>
<td>24p PAL</td>
<td>Film-based or other 24-fps footage transferred to PAL videotape. Ideal for a dual system production.</td>
<td>Film, HD Broadcast, PAL Broadcast, PAL Video</td>
</tr>
<tr>
<td>25p PAL</td>
<td>Film-based material or other 25-fps footage shot at 25 fps transferred to PAL video.</td>
<td>Film, HD Broadcast, PAL Broadcast, PAL Video</td>
</tr>
<tr>
<td>1080p/23.976</td>
<td>High-resolution files coming from digital film cameras such as RED, film transferred to HD videotape at 23.976 fps, or HD-originated 23.976-fps footage. This is the most commonly used HD project in NTSC-based countries.</td>
<td>Film, HD Broadcast, NTSC Broadcast</td>
</tr>
<tr>
<td>1080p/24</td>
<td>High-resolution files coming from digital film cameras such as RED, or HD-video originated production (shot at 24 fps). This format is also used if you’re working on older Avid systems that do not support the 23.976 frame rate.</td>
<td>Film, HD Broadcast</td>
</tr>
<tr>
<td>1080p/25</td>
<td>High-resolution files coming from digital film cameras such as RED, or HD-video originated production (shot at 25 fps). This is the most commonly used HD project in PAL-based countries.</td>
<td>Film, HD Broadcast, PAL Broadcast</td>
</tr>
<tr>
<td>1080i/59.94</td>
<td>High-resolution interlaced files (shot at 59.94 fps).</td>
<td>HD Broadcast, NTSC Broadcast</td>
</tr>
<tr>
<td>1080i/50</td>
<td>High-resolution interlaced files (shot at 50 fps).</td>
<td>HD Broadcast, PAL Broadcast</td>
</tr>
</tbody>
</table>
Further options might change depending on the format that you chose.

6. Select Film if your source material originated on film reel.
   
   This will give you access to film options such as Perf Slip and Film and 24p settings.

7. Set the following additional option(s), where applicable:

<table>
<thead>
<tr>
<th>Option</th>
<th>SD (NTSC/PAL)</th>
<th>HD and Film</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aspect Ratio</td>
<td>Select either 4:3 or 16:9</td>
<td>Only uses the 16:9 aspect ratio.</td>
</tr>
<tr>
<td>Raster Dimension</td>
<td>N/A</td>
<td>The Raster Dimension menu appears only for HD projects on a supported system.</td>
</tr>
<tr>
<td>Color Space</td>
<td>N/A</td>
<td>Select RGB 709 to retain the best color quality from the film shoot.</td>
</tr>
<tr>
<td>Film Gauge</td>
<td>Available for 23.976p, 24p, 25p, 720p, and 1080p film projects. If you are using source material originating on film reel, click the Film button and select a format for film gauge tracking from the Default Film Type menu.</td>
<td></td>
</tr>
<tr>
<td>Audio Transfer Rate</td>
<td>Available for 25i PAL, 30i NTSC, 720p, and 1080i Matchback projects only. If you are using source material from film reel, select Matchback, then click the Film button and select a format for film gauge tracking from the Default Film Type menu. The Matchback item appears only if your Avid editing application includes the Matchback option</td>
<td></td>
</tr>
</tbody>
</table>

8. Click OK.
   
   Your Avid editing application creates the new project files and folder, and then returns to the Select Project dialog box. The project name is highlighted in the Projects list.

9. Double-click the project name in the Projects list to open the project or click OK with the project name highlighted.

   The Project window, the Composer window, and the Timeline open with the User settings loaded. The title bar of the Project window contains the project name and the user profile selected in the Select Project dialog box.

10. (Option) If your project uses a film project type, set film preferences immediately after you create the project.
Before you capture or output film reel footage, refer to the following topics—“Selecting a Project Format during Capture” on page 1603 and “Selecting a Project Format during Output” on page 1603.

**Selecting a Project Format during Capture**

Before you capture film reel footage into your editing system, make sure you select the correct project format. The following table explains how the Avid system creates the digitized media from your source footage.

<table>
<thead>
<tr>
<th>Project Format</th>
<th>Source footage</th>
<th>During the capture process</th>
</tr>
</thead>
<tbody>
<tr>
<td>SD 24 fps</td>
<td>The Avid system removes the 2:3 pulldown and creates 24p media.</td>
<td></td>
</tr>
<tr>
<td>SD 25 fps</td>
<td>Use a 25p deck if you need to downconvert HDTV to ITU-R 601 video. The deck does not need to add pulldown or speed up the audio since the footage will remain at 25 fps. The Avid system creates 25p media.</td>
<td></td>
</tr>
<tr>
<td>SD 23.976 fps</td>
<td>Use a 24p deck if you need to downconvert HDTV to ITU-R 601 SD video. The deck adds 2:3 pulldown for video but maintains audio at 48 kHz. The Avid system removes both normal (2:3:2:3) and advanced (2:3:3:2) pulldown types. It maintains audio at 48 kHz, and creates 23.976p media.</td>
<td></td>
</tr>
<tr>
<td>HD</td>
<td>All HD footage is captured in its native format. If you need to downconvert HD media to an SD format, then refer to the appropriate SD rows above.</td>
<td></td>
</tr>
</tbody>
</table>

**Selecting a Project Format during Output**

Before you output your sequences, make sure you select the correct project format. The following table explains how the Avid system handles the digitized media during the output process.

<table>
<thead>
<tr>
<th>Project Format</th>
<th>Source footage</th>
<th>During the output process</th>
</tr>
</thead>
<tbody>
<tr>
<td>SD 24 fps</td>
<td>For NTSC and PAL, the system reinserts the pulldown or re-creates the speedup.</td>
<td></td>
</tr>
<tr>
<td>SD 25 fps</td>
<td>For NTSC, the system inserts 2:3 pulldown and slows down the audio by 4%. No adjustment is needed for PAL.</td>
<td></td>
</tr>
</tbody>
</table>
Changing formats is especially useful if you are working with downconverted HD material in an offline-to-online workflow. Each HD format has an equivalent SD format that you can use for offline editing.

For details, see “Offline Formats for HD” on page 1140.

The Format tab in the Project window lets you change the format of the project to another format that shares the same frame rate. On systems with supported Avid input/output hardware, you can also change the raster dimension to improve performance as you edit HD projects.

### Table: Changing the Project Format

<table>
<thead>
<tr>
<th>Project Format</th>
<th>Source footage</th>
<th>During the output process</th>
</tr>
</thead>
<tbody>
<tr>
<td>HD 23.976 fps</td>
<td>For NTSC video, Symphony Option system reinserts pulldown.</td>
<td></td>
</tr>
<tr>
<td>HD 24 fps</td>
<td>Creates a 24p EDL for use in an online suite.</td>
<td></td>
</tr>
<tr>
<td>HD 25 fps</td>
<td>Creates a 25p EDL for use in an online suite.</td>
<td></td>
</tr>
<tr>
<td>HD 23.976 fps</td>
<td>Creates a 24p EDL for use in an online suite. Use the Digital Cut tool to output a 1080p/23.976 master tape. Then convert the master tape to 720p/59.94 or 1080i/59.94 for broadcast. Optionally, use your Avid editing application to crossconvert to 720p/59.94 or 1080i/59.94 for preview or reference. The HD VTR can also create 1080i/50 for PAL broadcast.</td>
<td></td>
</tr>
<tr>
<td>Film 24 fps</td>
<td>For conforming film, it creates a 24p cut list.</td>
<td></td>
</tr>
<tr>
<td>Film 25 fps</td>
<td>For film, it creates a 25p cut list.</td>
<td></td>
</tr>
<tr>
<td>Film 23.976 fps</td>
<td>For conforming film, it creates a 24p cut list.</td>
<td></td>
</tr>
</tbody>
</table>
When you change the project format, the following changes take place:

- The hardware changes to support input and output for the new project.
- The available resolutions and, for some configurations, raster dimensions change to those of the new project.
- Any new sequences you create use the format of the new project.

If necessary, you can then modify the format of an existing sequence, see “Changing the Sequence Format” on page 1605.

To change the project format:

1. Click the Format tab on the Project window.
2. Select the corresponding format for your workflow.
3. If available, click the Raster Dimension menu and select a raster size.

For information on raster types and raster sizes, see

**Changing the Sequence Format**

When your Avid editing application creates a sequence, it uses the format of the current project.
You may not always need to change the edit rate of the sequence. For example, you can change an NTSC 30i sequence to 1080i/59.94 or to 720p/59.94. In other cases, you do change the edit rate, and the modified sequence uses motion adapter effects and contains other adjustments necessary to allow the sequence to play at the new edit rate.

There are special workflows for converting a 23.976p NTSC sequences. See “(Media Composer | Symphony Option) Converting a 24p NTSC Sequence to 1080p/23.976” on page 1607 and “Converting a 23.976p NTSC Sequence to 720p/23.976” on page 1608.

To modify the format of a sequence:

1. (Option) Duplicate the sequence.
2. Select the sequence you want to modify.
3. Select Clip > Modify.
4. Select Set Format from the top list.
5. Select the format to which you want to convert from the Format menu.
6. Click OK.

A message box tells you whether the sequence has been duplicated or modified.

Your Avid editing application changes the format of the sequence. In cases where timecode needs to be converted, your Avid editing application creates a new sequence and unlinks the media. No media is converted. For more information, see “Understanding Options for Modifying the Sequence Format”

You can check the format of the sequence in the Format column of the bin. This column displays the format of a clip or sequence as determined by the project type, such as 30i NTSC or 1080i/59.94. This is especially useful if you have both SD and HD clips in the same bin.
The most efficient offline format for a project that needs to be delivered as 1080p/23.976 is 23.976p (NTSC). In some cases, however, you might need to edit the offline sequence at 24 fps — for example, if the offline system does not support 23.976p NTSC projects. To convert a 24p NTSC sequence to 1080p/23.976p, you need to take an intermediate step and first convert it to 23.976p NTSC.

Several limitations apply to this conversion:

- Audio captured without pulldown (60 Hz) needs to be recaptured with pulldown (NTSC reference at 59.94 Hz).
- Media for the new 23.976p sequences and clips is offline. Sequences and clips cannot be linked to the original 24p media.
- You need to batch capture and import media. In most cases, you would do this after converting the sequence to 1080p/23.976.

The last two limitations also apply to other sequence conversions that create new sequences.

To convert a 24p NTSC sequence to 1080p/23.976:

1. On the HD online system, open a 1080p/23.976p project or create a new one.
2. Switch the project format to 23.976p NTSC.
3. Open the bin that contains the original 24p sequence and select the sequence.
4. Select Clip > Modify.
5. Select Set Format from the top list and select 23.976 NTSC from the Format menu.
6. Click OK.
   - Your Avid editing application creates a new sequence labeled with the extension 23.976 fps.
7. Switch the project format back to 1080p/23.976p project.
8. Select the new 23.976p sequence.
9. Select Clip > Modify.
10. Select Set Format from the top list and select 1080p/23.976 from the Format menu.
11. Click OK.
12. Batch capture, import graphics, and finish the sequence.
Converting a 23.976p NTSC Sequence to 720p/23.976

Because the source edit rates are different for these formats, you cannot simply change the project and sequence format. The following sequence is based on source material shot or transferred to 720p/23.976 and edited offline in a 23.976p NTSC project.

To convert a 23.976p NTSC sequence to 720p/23.976:

1. In the 23.976p NTSC project, duplicate the final sequence and move it to a new bin.
2. Decompose the sequence.
3. Select the master clips and export them as a shot log file.
4. Create a 720p/23.976p HD project.
5. Import the shot log file into a bin.
6. Batch capture the clips.
7. Open the SD bin containing the duplicated sequence.
8. Relink the SD sequence to the new HD clips.

See “Relinking Media Files” on page 494.

Editing at 60 fps

The project type 720p/59.94 uses a screen resolution of 1280 x 720 at a frame rate of 60 frames per second. Editing at 60 fps is similar to editing at 24 fps because both resolutions are progressive — they use full frames instead of interlaced fields. Note the following:

- Single-frame step commands move at 1/60th of a second. Single-field step commands are deactivated; if you click a button, your Avid editing application beeps.
- Draft Quality plays back at 30 fps. Full Quality plays back at 60 fps.
- You can mark IN and OUT points at 1/60th of a second increments.
- You can trim at 1/60th of a second increments.
- Transition effects default to one-second duration (60 frames).
- Deck control for capture and digital cut is limited to 30 fps. A message box warns you if you try to mark an odd timecode value (such as 01:00:00:03).

1080i/50 and 1080i/59.94 are interlaced resolutions that you edit at 25 frames per second and 30 frames per second.
Displaying 24p and 25p Media

This section applies to you only if you are working with Standard Definition (SD) formats.

When your Avid editing application captures video that has been transferred from film (or video shot at 24 fps), it creates 24p media. It creates this media by capturing the video fields, by dropping extra pulldown fields (NTSC transfers only), by combining (deinterlacing) two fields for each film frame (A1+A2, B1+B2, and so on), and by storing the fields together as a full frame. The system always stores media as a fully reconstructed, progressive frame. It is the construction of this full frame that gives you the flexibility to create multiformat output.

You typically use 25p media when capturing film or video shot at 25 fps. In this case, the system also stores the media as a fully reconstructed, progressive frame. The difference is that there is no need for pulldown fields because there is a 1:1 correspondence between the source tape and the captured frames.

Displaying Media While Editing

When you click the Play button while editing a clip or a sequence (sometimes referred to as Edit Play), the system separates (interlaces) the progressive frames into fields and does the following:

• On the Source, Record, Playback, or pop-up monitor, your Avid editing application displays the footage at 23.976 fps, 24 fps, or 25 fps, depending on your project and editing preference.

Choose your preference for playback in the Film and 24p Settings dialog box. For more information, see “Filtering the Settings List” on page 1422.

• On an NTSC monitor, the system does one of two things:
  - If playing at 23.976 fps (audio pulldown ON), the system performs a 2:3 pulldown that replicates the telecine pulldown, and displays the interlaced media at 29.97 fps.
  - If playing at 24 fps (audio pulldown OFF), the system performs a 2:3 pulldown, drops every 1000th frame in the Client monitor, and displays the interlaced media at 29.97 fps.

• On a PAL monitor, the system does one of two things:
  - If playing at 24 fps, the system duplicates two fields per second to display the interlaced media at 25 fps.
  - If playing at 25 fps, the system performs a 4.1 percent speedup, maintains 1:1 transfer of film frames to video frames, and displays the interlaced media at 25 fps.

For 25p projects, 25 fps is the only playback rate. The playback rate is 1:1 with no speed change.
Displaying Media During a Digital Cut

The Digital Cut tool lets you output multiple formats at various play rates, all from 24p and 25p media. When you click the Play Digital Cut button, the system displays the sequence as described in “Displaying Media While Editing” above, depending on your selection in the Digital Cut tool.

For more information, see “Selecting Output and Timecode Formats for 23.976p, 24p, and 25p Projects” on page 1089.

Outputting a Sequence

You can output your sequence at HD by first transcoding it to an HD resolution. You can then output it by performing a Digital Cut or an export to file. Avid editing systems support output to tape, write-back to the original device, or export to common industry-standard formats.

Some media formats cannot be output to their native format. Refer to the Avid Editing Systems—Supported Formats compatibility guide in the Avid Knowledge Base.

(Media Composer | Symphony Option) Using HD Universal Mastering

Universal Mastering is the ability to generate many different types of output from a single sequence and project and from the same 24p, 25p, or 23.976p media. HD Universal Mastering allows 1080p high-definition sequences edited at one frame rate to be played back in real time at a different frame rate and with audio conversion that matches the video conversion.

HD Universal Mastering applies only to sequences created in a 1080p project format, and the audio quality is best if you are working with 48 kHz audio.

If you create a sequence in one frame rate (for example, 24 fps), you can then output the sequence at an alternate frame rate (for example, 25 fps). This modifies the duration of the sequence to roughly 96% of its original length.

HD Universal Mastering preserves synchronization with the converted video by remastering audio at a different sample rate to generate replacement audio tracks from previously mixed-down audio clips. Once replacement audio tracks have been generated, you can edit them into a new sequence, or edit them into the original sequence as alternative tracks, and then use the Digital Cut tool to output the sequence.

With Nitris DX, when you downconvert a 1080p/24 project to NTSC, there is no need to resample the audio.
The following frame rates are supported for HD Universal Mastering of sequences (sample rates are included as examples of remastered audio):

<table>
<thead>
<tr>
<th>Original Frame Rate</th>
<th>Mastered Frame Rate</th>
<th>Original Sample Rate</th>
<th>Mastered Sample Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>23.976 fps</td>
<td>24 fps</td>
<td>48000</td>
<td>47952</td>
</tr>
<tr>
<td>23.976 fps</td>
<td>25 fps</td>
<td>48000</td>
<td>46034</td>
</tr>
<tr>
<td>24 fps</td>
<td>23.976 fps</td>
<td>48000</td>
<td>48048</td>
</tr>
<tr>
<td>24 fps</td>
<td>25 fps</td>
<td>48000</td>
<td>46080</td>
</tr>
<tr>
<td>25 fps</td>
<td>24 fps</td>
<td>48000</td>
<td>50000</td>
</tr>
<tr>
<td>25 fps</td>
<td>23.976 fps</td>
<td>48000</td>
<td>50050</td>
</tr>
</tbody>
</table>

( Media Composer | Symphony Option) Converting Audio for HD Universal Mastering

Before you output your sequence with HD Universal Mastering, you need to convert the audio tracks so that they match the frame rate of the video tracks.

*With Nitris DX, when you downconvert a 1080p/24 project to NTSC, there is no need to resample the audio.*

**To prepare audio tracks for HD Universal Mastering:**

1. Load a sequence in the Record monitor or the Timeline.
2. Click the Track buttons in the Track Selector panel in the Timeline to select the audio tracks you want to mix down.
3. Perform an audio mixdown.
   
   For more information on how to mix down audio, see “Mixing Down Audio Tracks” on page 836.
   
   The audio is mixed down, and your Avid editing application displays the new master clip in the bin.
4. Select the mixed-down audio clip in the bin, and do one of the following:
   
   » Select Clip > Change Sample Rate.
   
   » Right-click the clip and select Change Sample Rate.
The Change Sample Rate dialog box opens.

![Change Sample Rate Dialog Box](image)

5. Click the Sample Rate menu, and select the appropriate conversion option:
   - 23.97fps -> 24fps for Universal Mastering
   - 24fps -> 25fps for Universal Mastering
   - 24fps -> 23.97fps for Universal Mastering
   - 25fps -> 23.97fps for Universal Mastering
   - 25fps -> 24fps for Universal Mastering
   - 23.97fps -> 25fps for Universal Mastering

6. (Option) Click the Quality menu and select one of the following conversion quality options:
   - High
   - Medium
   - Low

   *Avid recommends you accept the default Quality setting of High. Selecting a lower Quality setting might lead to degraded audio quality in your media output.*

7. (Option) Select the Delete Original Media option if you want the system to delete the original media automatically after the conversion process is complete.

8. (Option) Click the Target Drive menu and select a drive for the new media files different from the drive setting in the Audio Project settings. For more information on Audio Project settings, see “Audio Project Settings for Capture” on page 207.

   Make sure that you choose a target drive with enough storage space for the generated media files and the ability to play back media.

9. Click OK.

10. Select Clip > New Audio Track twice to create two new audio tracks in the Timeline.
11. Use the Track Selector buttons to select only the two new audio tracks.
12. Mark an IN point on the first frame of the sequence.
13. Make sure the position indicator in the Timeline is on the first frame of the sequence.
14. Click the Overwrite button to add the converted audio to original sequence.

(OpenComposer | Symphony Option) Performing a Digital Cut with HD Universal Mastering

Once you have mixed down your audio tracks and added the new audio clip to your sequence, you can output your sequence at a new frame rate by performing a digital cut.

You can perform several types of cross-conversion or downconversion digital cuts from 1080 projects by selecting from the Output Format menu in the Digital Cut tool. These digital cuts are frame-accurate and allow for standard deck control.

The output formats available to you vary depending on the project format and on your Avid input/output hardware. The following table describes the available options.

<table>
<thead>
<tr>
<th>Project Format</th>
<th>Output Formats</th>
</tr>
</thead>
<tbody>
<tr>
<td>1080p23.976</td>
<td>1080p23.976</td>
</tr>
<tr>
<td></td>
<td>1080p24</td>
</tr>
<tr>
<td></td>
<td>1080p25/PAL</td>
</tr>
<tr>
<td></td>
<td>1080i59.94/NTSC</td>
</tr>
<tr>
<td>1080p24</td>
<td>1080p24</td>
</tr>
<tr>
<td></td>
<td>1080p23.976</td>
</tr>
<tr>
<td></td>
<td>1080p25/PAL</td>
</tr>
<tr>
<td></td>
<td>1080i59.94/NTSC</td>
</tr>
<tr>
<td>1080p25</td>
<td>1080p25 PAL</td>
</tr>
<tr>
<td></td>
<td>1080p23.976</td>
</tr>
<tr>
<td></td>
<td>1080p24</td>
</tr>
<tr>
<td></td>
<td>1080i59.94 NTSC</td>
</tr>
<tr>
<td>1080i50</td>
<td>1080i50</td>
</tr>
<tr>
<td></td>
<td>PAL 25i</td>
</tr>
<tr>
<td>1080i59.94</td>
<td>1080i59.94</td>
</tr>
<tr>
<td></td>
<td>NTSC 30i</td>
</tr>
</tbody>
</table>

When you make downconvert output format selections, you can select further options, such as an SD downconvert resize or, for NTSC, a timecode format.
To output a digital cut in this way, you must have a deck that can record the output you want to create available and configured, and you must select that deck in the Digital Cut tool. In the current version of your Avid editing application, you can select any deck template that is valid for a digital cut from the current project. You must also ensure that the sync source you are using matches the output format you want to create.

**To perform a digital cut with HD Universal Mastering:**

1. Make sure your sequence is loaded in the Source monitor.
2. Select Output > Digital Cut.
   
   The Digital Cut tool opens.

3. Select the video tracks you want represented in the digital cut by using the Sequence Track buttons.

4. If appropriate, deselect all audio tracks except the converted tracks by using the Sequence Track buttons.

   For more information, see “(Media Composer | Symphony Option) Converting Audio for HD Universal Mastering” on page 1611. “Converting Audio for HD Universal Mastering” in the Help for the Media Composer family.

5. Click Output Format, and select the appropriate frame rate option:

   For more information, see the table above this procedure.

6. (Option) Click SD Downconvert, and select the appropriate resize option.

   The options available depend on the selected Output Format option. For more information on SD Downconvert, see “Video Output Tool Settings: HD Cal Tab” on page 1537.

7. (Option) If you are performing an NTSC downconvert, select the appropriate timecode format information in the RS-422Output and LTC Output menus.

   For more information, see “Selecting the Timecode Format for Output” on page 1093.

8. Select the appropriate options for your digital cut.

   In particular, make sure that you select an appropriate deck configuration for the output format you have selected.

   For more information on using the Digital Cut tool, see “Using the Digital Cut Tool” on page 1079.

9. Click the Play Digital Cut button.

   Your Avid editing application cues the record deck, then plays and records the sequence at the remastered frame rate. The playback appears in the Record monitor and in the Client monitor. Once the digital cut completes (or is aborted), the input/output hardware resets to the original project frame rate.

   If you select a deck or tape for your digital cut that is set for a frame rate different from the current sequence format, a message reminds you to switch the genlock signal to match the selected output rate and indicates the genlock changes that best match the output. Also, there might be a slight delay in playback as the input/output hardware adjusts the frame rate.

**Working with HDV**

Avid editing applications provide the following High Definition Video (HDV) project types. For HDV projects on supported systems, you should select an appropriate raster size. (Some project types are not available for some Avid input/output hardware configurations.)

- 720p/23.976
- 720p/25
Understanding HDV

HDV is a low-cost prosumer format that lets you record HD video onto standard DV videocassettes. This is achieved through the use of interframe compression, where a given frame in the video stream can be composed of information from adjacent frames. Frames are grouped into a sequence called a “Group of Pictures,” or GOP. Long-GOP (also known as IPB encoding) refers to the structure of HDV media.

A GOP contains several different types of compressed frames:

- I frames, which are compressed frames that do not depend on any frames around them. I frames anchor the beginning of the GOP.
- P (predictive) frames and B (bidirectional) frames, which depend on the frames around them.

Interframe compression is more efficient than frame-based schemes (such as DV 25), allowing high-bandwidth HD images to be contained on media designed for standard definition (SD). However, HDV is more difficult to edit since frames are not independent of one another. Avid provides a workflow that lets you edit natively with HDV-compressed video without requiring a transcode to frame-based media, and without limiting where you make your cuts.
Your Avid editing application uses a technique called long-GOP splicing when encoding an HDV MPEG-2 sequence for export. For more information, see “Long-GOP Splicing for HDV Encoding” on page 1620.

HDV uses MPEG-2 video encoding and MPEG-1 audio encoding. 1080i records at about 25Mbps and 720p records at about 19Mbps. Sony provides HDV cameras that record at 1080i/59.94 and 1080i/50. JVC® cameras record at 720p/29.97 and 720p/23.976.

In some 1080i formats on qualified systems, you can reduce the data rate of the video before compression by setting the video display (raster) to resize horizontally from 1920 x 1080 pixels to 1440 x 1080 pixels or to 1280 x 1080 pixels. In contrast, 720p projects use the standard HDV raster size of 1280 x 720. A special resolution, DNxHD-TR (for Thin Raster), improves the performance of 1080 HDV editing. This resolution matches the 1080i HDV raster size, reducing artifacts that would come from repeated compressions when rendering effects and graphics.

**HDV Workflow**

A basic workflow for an HDV project is as follows:

1. Select one of the following Avid project types depending on the format in which your HDV camera records and the project types available for your input/output hardware:
   - 720p/23.976
   - 720p/25
   - 720p/29.97
   - 720p/50
   - 720p/59.94
   - 1080i/50
   - 1080i/59.94
2. Click the Raster Dimension menu, and select the appropriate raster size.
3. Do one of the following:
   - Capture HDV material.
   - Import an HDV file.
   The media is brought in as one video track and two 48-kHz audio tracks.
4. Edit the material.
Capturing and Importing HDV

You can import an HDV transport stream file (.m2t). Transport streams combine video and audio for transmission through an IEEE-1394 port. Your Avid editing application separates the transport stream after import or capture into the video and audio for editing.

After import or capture, the master clips in your Avid editing application contain HDV long-GOP MPEG-2 video in MXF format and 2 channels of uncompressed 48 kHz 16-bit audio.

To capture HDV material use a 1394 port on the computer (Host 1394).

Sony 1080i HDV cameras mark accurate timecode so you can use them for batch capturing. The JVC 720p/29.97 HDV camera restarts timecode every time your system starts to capture, so you cannot batch capture HDV material with a JVC 720p/29.97 HDV camera.

For more information, see “Capturing Directly from a DV Device” on page 243.

To import HDV media, you must import an HDV transport stream. You cannot import transport stream types other than HDV.

The file name extension .m2t does not indicate if the transport stream contains HDV media.

To capture HDV material:
1. Set up an HDV project, depending on the format in which your HDV camera records.
2. Select Tools > Capture.
   Your Avid editing application automatically selects the correct resolution for native HDV.
3. Select other options, and start to capture.
   For more information about capturing, see “Capturing Media” on page 232.

To import an HDV transport stream:
1. Select File > Import.
   The Import As dialog box opens.
2. Select Files of Type > HDV files (*.m2t).
3. Select the target drive (no other import options are needed).
4. Click Open.

Your Avid editing application copies the media in a fast import as native HDV.

**Playing Back HDV Media**

Depending on your input/output hardware, there might be some limitations when you play back HDV media. With a DV device connected in IEEE-1394 mode, you can play back to the DV device in Draft Quality and Best Performance quality only. With no device connected, you can play back as Full Quality and use the full-screen playback monitor. You can play back to the DV device as Full Quality only if you first transcode the material to DNxHD or DNxHD-TR. For more information, see the table in “Outputting HDV” on page 1619.

In a 1080i HDV project you can play back through some Avid input/output hardware configurations by changing the project type.

If you have a system with Avid Nitris DX or Avid Mojo DX input/output hardware, you do not need to transcode your HDV media or change your project type for playback.

**To play back HDV media:**

- In the Project window, click the Format tab. From the Project Type menu, select a project type as follows.

<table>
<thead>
<tr>
<th>For 1080i/50 projects</th>
<th>Select 25i PAL</th>
</tr>
</thead>
<tbody>
<tr>
<td>For 1080i/59.94 projects,</td>
<td>Select 30i NTSC</td>
</tr>
</tbody>
</table>

  The media is downconverted and plays in SD with an anamorphic squeeze.

**Outputting HDV**

To output HDV, you need to use a transport stream. You can use an existing transport stream or create a new one. To create a digital cut to go out to other devices, you need to first render and transcode the sequence.

You cannot render to an HDV resolution. However, you can render or transcode the HDV sequence to an HD compressed format (see “Outputting HDV through Avid Input/Output Hardware” on page 1620). The following table provides information on which resolutions are used for rendering and transcoding in each project type when you select an HDV raster dimension.
Long-GOP Splicing for HDV Encoding

Your Avid editing application uses a technique called long-GOP splicing when encoding an HDV MPEG-2 sequence for export. Your Avid editing application uses splicing to reconstruct only the edited sections of the media, such as cut points, transitions, and segments that contain effects. Other areas of the sequence are copied intact. The result is faster encoding at higher quality.

Outputting HDV through Avid Input/Output Hardware

You can use Avid input/output hardware to output a sequence created with HDV media, but you must transcode the sequence and then use the standard Digital Cut tool.

To perform a digital cut on a system using Avid input/output hardware:

1. Select the sequence or marked section.
2. Transcode the sequence as described in “Outputting HDV” on page 1619.
3. Select Output > Digital Cut
4. Proceed as with any digital cut.

See “Using the Digital Cut Tool” on page 1079.

Exporting an HDV Transport Stream

You can export an HDV transport stream for use in other applications.

---

### HDV Project Type Renders or Transcodes to

<table>
<thead>
<tr>
<th>HDV Project Type</th>
<th>Renders or Transcodes to</th>
</tr>
</thead>
<tbody>
<tr>
<td>720p/23.976</td>
<td>DNxHD 60, DNxHD 90, DNxHD 90x, DVCPro HD</td>
</tr>
<tr>
<td>720p/25</td>
<td>DNxHD 60, DNxHD 90, DNxHD 90x, DVCPro HD</td>
</tr>
<tr>
<td>720p/29.97</td>
<td>DNxHD 75, DNxHD 110, DVCPro HD</td>
</tr>
<tr>
<td>720p/50</td>
<td>DNxHD 120, DNxHD 185, DNxHD 185x, DVCPro HD</td>
</tr>
<tr>
<td>1080i/50</td>
<td>DNxHD–TR 120</td>
</tr>
<tr>
<td>1080i/59.94</td>
<td>DNxHD–TR 145</td>
</tr>
</tbody>
</table>

For more complete information on rendering and transcoding, see “Basics of Effects Rendering” in the Help and “Using the Transcode Command” on page 483.
To export an HDV transport stream:
1. Select the sequence or marked section.
2. Select Export in the Settings tab of the Project window.
   The Export Settings dialog box opens.
3. Select Export As > HDV.
4. Select Use Marks and Use Enabled Tracks as desired.
   See “Export Settings: HDV” on page 1482.
5. Click OK.
   You can also export to other formats, such as QuickTime movie, or use the Send To function
to send the sequence to an application such as Sorenson Squeeze. You can also export to
Windows Media 9 for finishing to HD-DVD.

To export to other formats:
- Export the sequence or use the Send To function as usual.
  See “Exporting With the Export Command or the Drag-and-Drop Method” on page 1028 or
  “Exporting With the Send To Templates” on page 1022.

Exporting HDV as Windows Media

Use the following samples as a guide when exporting an HDV sequence as Windows Media for
use on the Web or for use in DVD authoring:

To export HDV as Windows Media for use on the Web:
1. Select the sequence or clips you want to export.
2. Select File > Export.
   The Export As dialog box opens.
3. Click the Options button.
   The Export Settings dialog box opens.
4. Select Export As > Windows Media.
5. Set the following:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Width</td>
<td>720</td>
</tr>
<tr>
<td>Height</td>
<td>540</td>
</tr>
<tr>
<td>FPS</td>
<td>60</td>
</tr>
</tbody>
</table>
Outputting HDV

6. Click Save to export the sequence.
7. In the Export As dialog box, select the destination folder for the file.
8. Click Save.
   The sequence is exported using the selected settings.

To export HDV as Windows Media for use in DVD authoring:
1. Select the sequence or clips you want to export.
2. Select File > Export.
   The Export As dialog box opens.
3. Click the Options button.
   The Export Settings dialog box opens.
4. Select Export As > Windows Media.
5. Set the following:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video Type</td>
<td>Progressive</td>
</tr>
<tr>
<td>Pixel Aspect Ratio</td>
<td>16:9</td>
</tr>
<tr>
<td>Codec</td>
<td>Windows Media 9</td>
</tr>
<tr>
<td>VBR</td>
<td>Enabled and set to Quality</td>
</tr>
<tr>
<td>Audio Settings</td>
<td>Leave set at defaults</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Width</td>
<td>1440</td>
</tr>
<tr>
<td>Height</td>
<td>1080</td>
</tr>
<tr>
<td>FPS</td>
<td>60</td>
</tr>
<tr>
<td>Video Type</td>
<td>Progressive</td>
</tr>
<tr>
<td>Pixel Aspect Ratio</td>
<td>16:9</td>
</tr>
<tr>
<td>Codec</td>
<td>Windows Media 9</td>
</tr>
<tr>
<td>VBR</td>
<td>Enabled and set to Quality</td>
</tr>
<tr>
<td>Audio Settings</td>
<td>Leave set at defaults</td>
</tr>
</tbody>
</table>
6. Click Save to export the sequence.
7. In the Export As dialog box, select the destination folder for the file.
8. Click Save.

The sequence is exported using the selected settings.

**Finishing HDV on Avid DS**

The following procedure outlines the steps to take if you want to finish an HDV sequence on an Avid DS system.

**To finish an HDV sequence on an Avid DS system:**

1. When in a 1080i/59.94 HDV project, transcode your sequence to DNxHD 145.
2. Export as an AFE.
3. Import the AFE file to Avid DS v7.6 QFE 3 or later.

**Raster Dimensions**

Some earlier versions of Avid editing applications allowed you to create projects based on some device-specific HD compression formats, including 1080i 59.94 HDV and 1080i 50 HDV. Some versions allowed you to set specific raster types for your HD projects — for example, DVCPro HD. When you open existing projects that use these formats, current Avid editing applications preserve the raster size (the dimensions of the video frame displayed in the monitor) for your project and list the raster as an option in the Raster Dimension menu.

New HD projects on systems with supported configurations allow you to directly select the raster size used for playback and editing. This allows your Avid editing application to support HD compression formats that use anamorphically-scaled, nonstandard HD raster sizes. These formats include those compatible with a variety of professional HD devices and standards.

Using the Raster Dimension selection lets you improve the playback of your HD sequences without having to transcode the video to an Avid DNxHD resolution.

When you select an HD project format in the New Project dialog box, a Raster Dimension menu appears allowing you to select from the formats available for the selected project type. This lets you play back your sequence in the native raster size for certain HD formats. When you output your final HD sequence, your Avid editing application resizes the sequence to the standard raster size for your project.

*Standard raster sizes for 1080i/1080p and 720p projects are 1920 x 1080 and 1280 x 720, respectively. All other rasters are called “thin rasters” because the horizontal resolution is lower than the standard rasters.*
The format you select to work in also determines which HD compression is used by your Avid editing application. For example, if your HD project format is 1080i 59.94 and you select a raster dimension of 1440 x 1080, the Video Resolution menu in the Media Creation settings dialog box displays the following options:

- DNxHD-TR 145 MXF
- XDCAM HD 17.5Mbits MXF
- HDV 1080i MXF
- XDCAM HD 35Mbits MXF

You can open an existing HD project (for example, a 1080i 50 HDV project) created either with an earlier version of an Avid editing application or with a version that does not support Raster Dimension selection. You can also create a new project using Raster Dimension selection that has the same size used in an existing project. Use the following guidelines when switching between existing and new project types.

<table>
<thead>
<tr>
<th>Existing Project Type</th>
<th>New Project Type</th>
<th>Raster Dimension</th>
</tr>
</thead>
<tbody>
<tr>
<td>1080i 50</td>
<td>1080i 50</td>
<td>1920 x 1080</td>
</tr>
<tr>
<td>1080i 50 HDV</td>
<td>1080i 50</td>
<td>1440 x 1080</td>
</tr>
<tr>
<td>1080p 23.976</td>
<td>1080p 23.976</td>
<td>1920 x 1080</td>
</tr>
<tr>
<td>720p 29.97 HDV</td>
<td>720p 29.97</td>
<td>1280 x 720</td>
</tr>
</tbody>
</table>

If you open a new HD project on an Avid editing application that does not support all Raster Dimension options, the project switches to the standard raster (see “Raster Sizes” on page 1624). In this case, you do not receive the performance benefit of using the native raster size. When you move to an environment where other rasters are supported, you can manually switch your project to a specific raster.

## Raster Sizes

The following tables list the raster dimensions available for each compression format and project type. You should select a format depending on your workflow and playback mode. (For information on video quality playback modes, see “Video Quality Options for Playback” on page 543.)
## Availability of Raster Dimensions for Full Quality Playback

<table>
<thead>
<tr>
<th>Project type</th>
<th>1280 x 720</th>
<th>960 x 720</th>
<th>1920 x 1080</th>
<th>1440 x 1080</th>
<th>1280 x 1080</th>
</tr>
</thead>
<tbody>
<tr>
<td>720p 23.976</td>
<td>Yes (standard) Yes No No No</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>720p 25</td>
<td>Yes (standard) Yes No No No</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>720p 29.97</td>
<td>Yes (standard) No No No No</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>720p 50</td>
<td>Yes (standard) Yes No No No</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>720p 59.94</td>
<td>Yes (standard) Yes No No No</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1080p 23.976</td>
<td>No No Yes (standard) Yes No</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1080p 24</td>
<td>No No Yes (standard) No No</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1080p 25</td>
<td>No No Yes (standard) No No</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1080p 29.97</td>
<td>No No Yes (standard) No No</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1080i 50</td>
<td>No No Yes (standard) Yes No</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1080i 59.94</td>
<td>No No Yes (standard) Yes Yes</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
37 Dual Link HD RGB Support

The Avid editing applications with Nitris DX support RGB HD dual link. If you have a Nitris DX-based system, you can capture, monitor, and output projects in HD-RGB using the two HD SDI connections to handle the high-bandwidth resolutions.

- **RGB Dual Link does not support Universal Mastering. Universal Mastering is available in the YCbCr 709 Color Space only.**
- **Crossconvert is not supported with RGB Dual Link SDI.**
- **RGB media requires high bandwidth. For effective playback of multiple streams of video at higher resolutions, you should distribute the video tracks as evenly as possible among available drives, and target separate drives for audio and video.**

See the following topics:

- HD RGB Capture
- HD RGB Playback to High Resolution Monitor
- HD RGB Digital Cut

**HD RGB Capture**

**To setup:**

1. Connect the Nitris DX to a dual link compliant camera or deck. Use the HD-SDI A IN and HD-SDI B IN connectors for dual ingest HD-RGB capture.
2. Open the Capture Tool window.
3. Select the RGB resolution.
4. See “Capturing Media” on page 232 for details on performing a capture.

**HD RGB Playback to High Resolution Monitor**

**To setup:**

1. Connect the Nitris DX to a dual link high resolution monitor. Use the HD-SDI B IN and OUT connectors for dual ingest HD-RGB capture and output on the editing application connected to a Nitris DX.
2. Click the Format tab in the Project window.
3. Click the Color Space menu and select RGB.
4. Set the Video Quality button to Full Quality 10-bit.
   
   You can now playback video to the high resolution monitor.

**HD RGB Digital Cut**

**To setup:**

1. Connect the Nitris DX to a dual link compatible deck. Use the HD-SDI B IN and OUT connectors for dual ingest HD-RGB output on an editing system connected to a Nitris DX.
2. Open the Video Output Tool.
3. Select the HD RGB Dual Link SDI resolution.
International Character Support (ICS) in Avid Editing Applications

This chapter provides information on international character support (ICS) in your Avid editing application.

- Choosing a Locale on an English Language Operating System
- Using a Local Language Operating System (Windows Only)
- Non-English Character Support (Macintosh)
- Non-English Character Support (Windows)
- Using Foreign Keyboard Mapping (Windows)
- Considerations for International Character Support

* Avid Interplay applications also support ICS. For more information, see the Interplay Help and the Interplay ReadMe.

Choosing a Locale on an English Language Operating System

You can display and input international characters within the English language version of your operating system by choosing a locale for another language. This method is common on Windows systems, and it is the only option on Mac OS® X systems.

You need to instruct your operating system to display the appropriate language in menus and dialog boxes and specify the language you want to use for keyboard layouts by following the instructions for your operating system in either “Non-English Character Support (Macintosh)” on page 1629 or “Non-English Character Support (Windows)” on page 1632.

On Windows systems only, if you are using a language other than English, French, Italian, German, or Spanish, you might need to adjust the mapping for the keyboard so the keys in the Keyboard palette match the keys on your physical keyboard. See “Using Foreign Keyboard Mapping (Windows)” on page 1636.
Using a Local Language Operating System (Windows Only)

On Windows systems only, you can display and input characters in languages other than English by installing the local language version of the operating system and working within that operating system.

Interplay applications are not qualified on systems running local language operating systems.

When you start your Avid editing application for the first time, it automatically creates a keyboard setting for that language. You can view the keyboard mapping by clicking the appropriate Keyboard setting in the Settings list.

If you are using a language other than English, French, Italian, German, or Spanish, you might need to adjust the mapping for the keyboard so the keys in the Keyboard palette match the keys on your physical keyboard. For more information, see “Using Foreign Keyboard Mapping (Windows)” on page 1636.

You can also work with international characters within the English language version of the Windows operating system. For more information, see “Choosing a Locale on an English Language Operating System” on page 1628.

Non-English Character Support (Macintosh)

To enable international character support on Mac OS X systems, you need to specify the language for menus and dialog boxes in the System Preferences > Language & Text window. You must make sure that the operating system lists your language at the top of the language list in the Language tab and that you specify your region in the Formats tab. You can also add the language in which you want keyboard layouts and input methods to function.

To set the language in the Language & Text window:

1. Select Apple menu > System Preferences > Language & Text.

The Language & Text window opens to the Language tab.
2. In the Languages list, click the language you want, and drag it to the top of the list. If you do not see the language you want in the list, click Edit List, select the language, and click OK.

3. (Option) Click the Text tab and select other options.

4. Click the Formats tab, and then click the Region menu and select your region.
If you do not see your region, select “Show all regions” and then click the Region menu again.

5. Click the Close button.

6. Logout and log back in to enable the changed settings.

For more information about the Language & Text window, see Mac Help by clicking the question mark icon in the window.

To add your language’s keyboard layout, input method, and character set palette to the operating system’s Input menu (Flag icon):

1. Select Apple menu > System Preferences > Language & Text.
   The Language & Text window opens to the Language tab.

2. Click the Input Sources tab.
3. Select the language or languages in which you want to type.

4. Select “Show input menu in menu bar.”

5. Click the Close button.

6. In the Finder title bar, click the Flag icon and select the input language. You can also select a character set palette.

   The Flag icon changes depending on which input language you select.

7. Restart your system.

**Non-English Character Support (Windows)**

On Windows systems only, you can specify a non-English keyboard layout and text entry format for the language in which you want to type. The operating system itself does not need to be in the same language as that in which you are typing.

For more information, see “Using Foreign Keyboard Mapping (Windows)” on page 1636 and your Windows documentation.
To specify a language in which to type (Windows 7):

1. (Option) Attach a regional keyboard to your system.
2. Click the Start button, and select Control Panel.
3. Do one of the following:
   - If the View by menu is set to Category, in the Clock, Language, and Region area, click “Change display language.”
   - If the View by menu is set to Large icons or to Small icons, click Region and Languages. The Region and Language dialog box opens.
4. Click the Formats tab, and then click the Format menu and select a language.
5. Click the Location tab, and then click the Current location menu and select your location.
6. Click the Keyboards and Languages tab.
7. If necessary, click “Install/uninstall languages” and follow the prompts to install supplemental languages.

8. Click “Change keyboards.”

The Text Services and Input Languages dialog box opens.
9. In the “Installed services” area in the General tab, select a language and a keyboard layout for that language.

10. If the language you want is not in the list, click Add, select an input language and a keyboard layout for the language, and then click OK.

11. In the “Default input language” area, select an input language. You must select a language in the Installed Services area (step 9) before it appears in the Default input Language list.

12. Click OK to close the Text Services and Input Languages dialog box.

13. Click the Administrative tab, and click the Change system locale button and select your language.

! It is important to select your language in the “Language for non-Unicode programs” area. Do not skip this step.

14. Click OK to close the Region and Language dialog box. A keyboard icon appears in the taskbar to let you switch keyboard layouts.

15. Restart your system.
Using Foreign Keyboard Mapping (Windows)

On Windows systems, when you start your Avid editing application under a new locale, your Avid editing application automatically creates a Keyboard setting for your language. You can view the keyboard layout by clicking the appropriate Keyboard setting in the Settings list.

The default Avid keyboard layouts for English, French, or German map correctly to the characters on the physical keyboard. If you are using another language, the display in the Keyboard palette might not match your physical keyboard layout. You can use the Foreign Keyboard Mapping button in the Keyboard palette to display the correct character in the Keyboard palette.

Avid supports the international English keyboard for Spanish and Italian. The default keyboard setting for Spanish and Italian is an English keyboard. If you use a Spanish or Italian keyboard, use keyboard mapping to match the physical keyboard to the Keyboard setting layout.

To set the keyboard mapping for a key:

1. In the Settings list of the Project window, double-click Keyboard.
   The Keyboard palette opens.
2. Compare the layout to your physical keyboard.
   If some of the letters do not match, you can change the characters displayed in the Keyboard palette.
3. Click the Foreign Keyboard Mapping button.
4. Click the key that you want to change in the Keyboard palette.
   The key changes to white.
5. Press the corresponding key on your keyboard.
   The image in the Keyboard palette changes to match your keyboard, and the mapped key changes to blue.

Each language has a certain number of keys that do not map to functions in your Avid editing application. These are referred to as “dead” keys. You cannot map functions to these dead keys. If you try to do so, your Avid editing application displays an error message.

Considerations for International Character Support

This topic provides recommendations, tips, and information on limitations for using international character support in your Avid editing application.
Use One Locale When Sharing Files

Make sure that your projects do not contain characters from more than one locale. File sharing might not work correctly. See “Choosing a Locale on an English Language Operating System” on page 1628.

In an Interplay workgroup, all clients and applications must use the same locale, either English or one other locale.

Entering ASCII Characters in Double-Byte Systems

If you are working on a double-byte operating system, you should use single-byte ASCII characters to name bins, projects, tapes, or other Avid elements. If you use double-byte characters, they might appear with extra space between them and the names might not be recognizable by other systems.

Operating systems that use a double-byte character system usually allow the user to choose between single-byte ASCII or double-byte ASCII characters. If you have a choice, use single-byte characters when entering ASCII text.

Characters to Avoid When Naming Avid Elements

Do not use the Japanese yen symbol in the ASCII character set. Your Avid editing application converts the symbol to a backslash, and this can cause problems with pathnames.

Do not use the Y-acute and Y-diaeresis characters. Your Avid editing application does not recognize the Y-acute character, and it can cause problems with file recognition. Your Avid editing application might not display the Y-diaeresis character correctly.

When you name a Mac OS X computer, use single-byte ASCII characters without spaces. Your Avid editing application uses the name in .pmr files (in the OMFI MediaFiles folder), and non-ASCII characters and spaces can cause problems with .pmr files.

If you plan to move projects between Macintosh and Windows systems, avoid using characters that are not in both the MacRoman and Latin1 (ANSI) character sets. Search the Avid Knowledge Base for “MacRoman” to access documents that list the characters you should avoid. You might have to set your Web browser to display characters in Unicode format to see all the characters in these documents correctly. For example, in Internet Explorer 7, select View > Encoding > Unicode (UTF-8).

Traditional Chinese Big 5 Character Set

When using Traditional Chinese, set the Input Method Editor (IME) to use the Traditional Chinese Big 5 character set.
Considerations for International Character Support

(Windows) When setting the Input Locale in the Regional Options dialog box, click IME Settings and select the bottom option, which translates to “Only show Big 5 characters.”

(Macintosh) When you select Traditional Chinese in the System Preferences > Language & Text window, your system displays a menu with several options. Select Big 5.

**Rebuilding the asifont.map File (Windows Only)**

If you cannot display Chinese or Japanese characters in your Avid editing application, you might need to regenerate the asifont.map file under the Japanese or Chinese locale. If you install your Avid editing application after you set up your system for international character support, you should not need to rebuild the asifont.map file.

To rebuild the asifont.map file, do one of the following:

- Navigate to Program Files\Avid\application name, locate the asifont.map file, and delete it. Ensure you are in the Japanese or Chinese locale and restart your Avid editing application.
- Uninstall your Avid editing application and then reinstall it under the Japanese or Chinese locale.

Note that your system uses the current locale to create the asifont.map file appropriate for that locale.

**Creating Vertical Text**

To create a title with vertical lettering, such as on Japanese and Chinese Windows systems, use the Marquee title tool, and use one of the fonts with an “@” symbol at the beginning of its name. You can create a style or template for this kind of text box to make the titles easier to create.

1. Create a Text Box, then exit Text mode.
2. Select a font with an @ sign at the start of the name for the text box.
3. In the Transform pane, rotate the box by setting rotate Z to -90.
4. Enter Text mode, and type in your text.
   The text appears moving down vertically.

**Additional Tips and Limitations for Working with International Characters**

- You must install your Avid editing application after you set up your system for international character support.

- If you export files from a FIGS (French, Italian, German, or Spanish) operating system that contain certain diacritical marks (for example, a capital A, I, or E with circumflex), they might not import or display correctly on an English operating system. When you attempt to import the file, your system displays the following error message:
  “File: [File name and location] not found.”
Considerations for International Character Support

followed by:

“EXCEPTION: SYS ERROR, status: 2, msg: The system cannot find the file specified.”

To work around this limitation, retype the file name (with the same diacritical marks if desired) and then import it from the English OS.

• If you use New Change input (Traditional Chinese), you cannot use certain key combinations to form Chinese characters in user, project, bin, clip, and sequence names. When you press Enter to execute these key combinations, a question mark appears in the text. The following are examples of non-functional combinations: R + Y, S + D, R + J, F + U, Q + U + Q + U.

• You might see problems with certain combinations of Japanese and Roman characters in user names.

  Avoid mixing Roman and Chinese or Japanese characters in user names. Your system might generate error messages or extra user names with incorrect text strings.

  In an Interplay workgroup environment, use Roman characters for user names. Avid Interplay workgroups do not support Chinese and Japanese user names.

• Do not use fonts that have an “@” sign at the start of the font name when naming Avid elements. These fonts are intended for text that displays vertically. Letters or characters might appear on their side in elements such as bin and clip names.
Open I/O Support

With the Media Composer family of products, Avid has implemented a Hardware SDK allowing 3rd party vendors to develop plug-ins for their hardware I/O devices. The plug-ins will enable 3rd party I/O hardware to interact with the Avid editing applications. Currently, the 3rd party vendors who have access to develop plug-ins for their hardware in order to work with Avid editing software are AJA, Matrox, Blackmagic Design, Motu and Bluefish444.

The 3rd party I/O hardware can be configured through a software control panel developed by the 3rd party vendor. Functionality, such as output type for capture, input type for different connectors, up convert, downconvert, crossconvert, hardware reference clocking, HD progressive frame type, etc. can be controlled by the 3rd party control panel.

It is important for you to install the editing application first and then install the 3rd party plug-ins. The plug-in will not install properly if the editing application is not already installed.

Note the following when working with the 3rd party Open I/O devices:

• The Video Input and Video Output items on the Tools menu are replaced with a Hardware Setup menu item. Choosing the Hardware Setup option opens the 3rd party Control Panel.
• The Video Input and Video Output settings in the Project window will launch the 3rd party Control Panel.
• The “Cp” and Video Tool buttons in the Capture Tool will open the 3rd party Control Panel.
• The “Cp” button in the Hardware tab of the Audio Project Settings will open the 3rd party Control Panel.

Open I/O Limitations

With this release, the 3rd party hardware plug-ins will not be able to support the entire feature set of the editing application and therefore will not support the following in the Avid editing application:

• Ancillary Data
• LTC Input and Output
• Stereoscopic Full Frame Capture and Output
- Utilize any Hardware Codec Modules
- Universal Mastering (Frame & Signal Convert to a Different Format)
Index

Numerics

1 Pass encoding 1485
1:1 video
defined 1557
1080p/23.976 projects
converting NTSC sequence from 24p 1607
1394
capturing HDV through 1618
capturing through 243, 243
connecting devices 193
1394 button
playback to DV device with 541
selecting DV device with 243
selecting output device with 1055
setting video quality with 544
16:9 display
format (Composer settings) 1454
16:9 format 172, 1589
16-channel audio
enabling 1074
2 Pass encoding 1485
2:3 pulldown
transferring film to video with 1594
23.976p projects
converting NTSC sequence to 720p/23.976 1608
24-fps film
transferring to NTSC video 1593
transferring to PAL video 1595
24-fps timecode
logging additional 165
24p and 25p projects
creating 1600
displaying media while editing 1609
displaying timecodes in 366
indicating the destination timecode rate 1094
output formats 1089, 1089, 1089
timecode for output 1093
24p media
capturing without pulldown 284
stored and displayed 1609
24p projects
converting NTSC sequence to 1080p/23.976 1607
25p media
stored and displayed 1609
3 x 3 averaging
setting eyedropper option 1458
3-perf support 1117
4-perf support 1117
5.1 audio 779
60 fps
editing 720p project 1608
7.1 audio 779
720p/23.976 projects
converting NTSC sequence from 23.976p 1608
8-bit units 1523

A

AAF (Advanced Authoring Format) files
described 1033
exporting 1033
methods for exporting 1033
AAF export
exporting to Pro Tools 1033
Aborting
Frame Chase captures 249
Accepting transfers 1312
Active Palette option (Command palette) 133
Adaptive deinterlacing 597
Add Alt Key button (Command palette, Other tab) 129
Add Channel button (Deck Configuration dialog box) 188
Add Comments command (Clip Name menu) 612
Index

Add Control Key button (Command palette, Other tab) 129
Add Deck button (Deck Configuration dialog box) 188
Add Dissolve button
  See Quick Transition button
Add Edit button 813
  for maintaining sync 620
  for MultiCamera editing 1385
Add Edit function
  for maintaining sync 620
  using 722
Add Filler at Start command (Clip menu) 587
Add Keyframe button
  commands 1467
Add Marker button 550
Add New Column dialog box (Interplay Window) 1248
Add Option Key button (Command palette, Other tab) 129
Add Page button (Script window) 642
Add Scene button (Script window) 642
Add Scene/Page dialog box 642
Adding
  bin columns 363
  clip names during capturing 234
  color indicators (Script window) 652
  comments during capturing 234
  comments during editing 612
  edits 722
  filler during trimming 751
  filler to a sequence 587
  markers while editing 550
  memory mark 153
  new tracks 715
  off-screen indicators (Script window) 651
  page and scene numbers in the Script window 642
  Production cues (NRCS tool) 1177
  script marks 653
  takes in the Script window 649
Adjust Auto Volume/Pan command (Audio Mixer Tool Fast menu) 820
Adjust Deck command (Deck Selection menu in Capture tool) 196
Adjust Deck command (Deck Selection menu in Digital Cut tool) 1081
Adjust Pan/Vols command (Audio Mixer Tool Fast menu) 808
Adjusting
  audio buffer size 787
  audio input levels 214
  chrominance and luminance settings for video output 1061
  margins in the Script window 637
  Motion Adapter effect 597
  offset between audio and video playback 528
  output 1072
  pan in the Audio Mixer tool 797
  pan, using an external fader or mixer 871
  take lines in the Script window 649
  video levels 221
  video levels for tapes without color bars 230
  volume and pan in Timeline 813
  volume in the Audio Mixer tool 797
  volume, using an external fader or mixer 871
adjustments 810
Advanced keyframes
  Add Keyframe button commands 1467
  Indent Rows command 1467
  Large Text command 1467
  Real-Time Update option 1467
  Set Position To Keyframe command 1467
  Show Add Keyframe Mode Menu command 1467
  Sliders option 1467
  Thumbwheels option 1467
  Update Position While Playing command 1467
AFE
  exporting as 1022
AFE files
  described 1036
  exporting projects and bins 1036
Affinity model
  described 1335
AIFF-C file format 209
  option in Audio Project settings 1438
AIR Chorus RTAS plug-in 947
AIR Distortion RTAS plug-in 948
AIR Dynamic Delay RTAS plug-in 949
AIR Enhancer RTAS plug-in 951
AIR Ensemble RTAS plug-in 952
AIR Filter Gate RTAS plug-in 952
AIR Flanger RTAS plug-in 953
AIR Frequency Shifter RTAS plug-in 956
AIR Fuzz-Wah RTAS plug-in 957
AIR Kill EQ RTAS plug-in 958
AIR Lo Fi RTAS plug-in 958
AIR Multi-Chorus RTAS plug-in 961
AIR Multi-Delay RTAS plug-in 962
AIR Non-Linear Reverb RTAS plug-in 963
AIR Phaser RTAS plug-in 964
AIR Reverb RTAS plug-in 966
AIR Spring Reverb RTAS plug-in 968
AIR Stereo Width RTAS plug-in 969
AIR Talkbox RTAS plug-in 970
AIR Vintage Filter RTAS plug-in 972
Alias
 starting Avid editing application from 66
Alias file format
 import specifications for 1541
Align Selected to Grid command (Bin menu) 346
Align to Grid command (Bin menu) 346, 362
Aligning columns in a bin 362
Alpha channel
 adding to a graphics image 1540
 defined 1540
 support in graphics formats 1540
Alpha channel, options in Import settings 1502
Alternate Edit button 710
Alternate edits
 creating 710
Alternate source capture 263
AMA
 ancillary data 1128
 virtual volumes 424, 424
AMA settings
 described 1433
Ancillary data
 AMA 1128
 Data Track method 1124
 Legacy Method 1131
Ancillary data and AMA
 workflow 465
Animation file formats
 described 1545
Animation files
 importing 1545
Annotate feature 234
Anti-aliased images 1540
Application display
 updating 1254
Application sets
 Avid Artist Series controllers 917, 917, 920, 922
Applications command (Macintosh Go menu) 66
Applying
 target settings for dynamic relink 1349
 working settings for dynamic relink 1349
Archive to Videotape dialog box 504
Archiving
 with MultiRez 1327
Archiving, media files 503
Arrow keys
 stepping with 538
As List command (View menu in Macintosh Finder) 85
ASCII characters, in double-byte systems 1636
ASCII file format
 importing Avid logs 146
ASCII text files
 importing to a Script window 637
A-side (outgoing frames)
 in trims 736, 746
ASIO driver configuration 886
Aspect Ratio options (Import settings) 1502
Assemble-edit recording 1076
 enabling in Deck Preferences 1077
Assembling a rough cut
 in the Script window 660
Asset Manager
 specifying settings 468
Asset manager
 accessing assets 1236
 automatically checking in assets 1235
 Avid Unity media network 1214
 capturing media 1263
 checking in to 1232
 checking out from 1229
 connecting to 1214
 logging in 1214
 remote assets 1204
 settings for 468
 using 468
 using drag-and-drop method to check in assets 1232
 using menu command to check in assets 1232
Asset types, selecting 1253
Associated sequences
 described 1188
 linking a sequence to a story 1185
 locating sequences 1188
 locating stories 1188
Attic folder
 described 93
Index

See Avid Attic folder

Attributes
  searching remote assets for 1262

Audio
  16-channel output 1074
  5.1 779
  7.1 779
  adjusting pan defaults 812
  adjusting volume 777
  adjusting volume in Audio Mixer tool 797
  adjusting volume in Timeline 813
  adjusting volume while playing 810
  and digital cuts 1096
  Auto VO 863
  buffer size adjustment 787
  centering pan 812
  converting for HD Universal Mastering 1611
  creating leader 629
  crossfading 831, 1438
  digital scrub, described 768
  digital scrub, performing 771
  digital, capturing in film projects 203
  dipping 831
  dissolves 831, 1438
  editing workflow 796
  embedded, and sample rate conversion 1074
  fading 831, 1438
  file format, selecting 209
  file formats (Audio Project settings) 1438
  fine-tuning transitions 813, 831
  HD Universal Mastering 1610
  HDMI 779, 786
  identifying sample rates 776
  input levels, adjusting 1438, 1438
  input, adjusting levels 214
  input, selecting source 210
  keyboard shortcuts for keyframing 821
  levels, adjusting 798
  Live Mix mode 826
  locked 1438
  mapping output channels 1438
  marking clips 549
  Master volume 1438
  media for shoots 1589
  mixing down 836
  monitoring tracks 708
  multichannel 762
  muting 777
  number of tracks supported 703
  output 786
  output options 1438
  output, calibrating 1069
  output, calibrating global levels 1070
  output, calibration tone for 1069
  output, monitoring global levels 1069
  output, preparing for 1069
  output, settings options 1072
  overview of tools 760
  pain and gain automation display 772
  pan, adjusting in Audio Mixer tool 797
  Project settings, adjusting 207
  Project settings, audio file formats 209
  Project settings, overview 207
  quality matching for 1371
  remastering 1611
  requirements for film transfers 201
  resyncing subclips 549
  sample rate conversion during capture 208
  sample rate, changing for a clip or sequence 835
  sample rate, conversion overview 835
  sample rate, selecting 208
  scrub, defined 768
  scrub, performing smooth 770
  scrub, selecting tracks for 769
  scrub, solo tracks 767
  selecting mix modes 1438
  settings, adjusting 207
  settings, Default Pan options 812
  settings, Digital Scrub options 770
  solo feature, in Trim mode 740
  solo feature, monitoring one track 708
  sound card configuration 210
  Sound Designer II, support for 1157
  Sound Designer II, transferring files 1157
  splitting stereo tracks to mono 717, 840
  subframe sync adjustment 626
  surround sound 779
  sync, on output 1055
  time compression 936
  timecode for shoots 1589
  tools, accessing 760
  tracks, adjusting in Audio Mixer tool 798
  tracks, soloing 767
  transfer options 1595
transferring to Digidesign Pro Tools 1156
using leader to maintain sync 618
voice-over 854, 854
volume, adjusting in Audio Mixer tool 798
volume, adjusting in Timeline 815
waveform plots 773
Audio Data commands (Timeline Fast menu) 773, 815, 818
Audio effects
rendering order 795
Audio EQ 813
Audio EQ (Equalization)
adjusting while playing 854
removing 849
saving 847
templates 851, 851
Audio EQ command (Tools menu) 760, 842
Audio EQ tool
examples of usage 849
Fast menu options 846
features of 842
opening 842
saving effects with 847
Audio File format
displaying in bins 763, 779
options 1438
Audio file sample size 1438
Audio hardware calibration 217
Audio hardware options
project settings 1438
Audio IN and OUT points
removing 549
Audio input levels
adjusting 1438, 1438
calibrating for audio I/O device 217
calibrating with a tone generator 217
Audio Mark IN button 549
Audio Mark OUT button 549
Audio Meter menu button 777
Audio Mixdown command (Special menu) 836
Audio Mixdown dialog box 836
Audio Mixer command (Tools menu) 760, 797, 798, 818
Audio Mixer tool
adjusting clip gain and pan on a single track 798
adjusting levels by typing values 793
adjusting volume and pan on multiple tracks 798
Clip Gain and Pan mode 797
controls, described 789
Live Mix mode 826
Live Mix mode Fast menu commands 828
opening 789
resizing 793
selecting modes 789
setting default mode 789
showing and hiding sliders 793
sliders for Live Mix mode 828
sliders, for volume automation and pan 818
switching from Live Mix mode to other modes 828
track selection behavior 794
Volume Automation and Pan controls, described 817
Volume Automation and Pan Fast menu commands 820
Audio output
calibrating with an external meter 217
Audio output options
project settings 1438
Audio peak levels
checking 221
Audio Project Settings
Dolby E Safe settings 274
Audio Project settings
audio file formats 1438
described 1438
Effects tab 1438
Hardware tab 1438
Main tab 1438
Output tab 1438
saving 1438
Audio Project Settings dialog box 1072
Audio Punch-In tool
described 856
removing extra filler 1438
scenarios for using 859
using a GPI device with 890
Audio Punch-in tool
using 859
audio sample clock 1438
Audio sample rate
options 1438
Audio settings
described 1437
Audio Settings dialog box
Index

adjusting digital scrub parameters 770
Audio Source Tape TC Rate (Film and 24p Settings dialog box) 185

Audio sync
for capture 173
Audio timecode 761

Audio tone media
creating 214

Audio tool
Calibrate mode 217, 217, 217
digital scale 213
input levels, adjusting 214
opening 212
volume unit scale 213

Audio Tool command (Tools menu) 798, 1069, 1070, 1076

Audio Track Monitor button (Track Selector panel)
selecting tracks for scrubbing with 769

Audio tracks
making tracks inactive 767
selection in Timeline and in Audio Mixer tool 794
splitting stereo tracks to mono 717, 840

Audio transfer
Info tab 1595

Audio Transfer Rate (Film and 24p Settings dialog box) 185

Audio Volume Automation
configuring USB-to-MIDI software 882

Audio-only output 1096

AudioSuite command (Tools menu) 760

AudioSuite plug-ins
applying 932
Bomb Factory BF76 973
Compressor/Limiter III (Dynamics III) 981
core plug-ins 944
creating new master clips with 936
DC Offset Removal 986
DeEsser III (Dynamics III) 986
described
dialog box 934
Duplicate 990
D-Verb 985
EQ 992
Expander/Gate III (Dynamics III) 995

Fast menu 935
Funk Logic Masterizer 997
Gain 997
installing 925
Invert 998
limitations 942
Lo-Fi 998
Normalize 1004
Pitch Shift 1004, 1006
Recti-Fi 1007
rendering 936
Reverse 1008
Sci-Fi 1009
Signal Generator 1011
supported 944
Time Compression Expansion 1012
Time Shift 1014, 1610, 1611
Trim 1017
troubleshooting 942

Authoring a DVD in Avid DVD by Sonic 1022
Auto Pan command (Timeline Fast menu) 815, 818
Auto VO 863
Auto Volume command (Timeline Fast menu) 815, 818

Autocapturing 240
See also Batch capturing
See also Capturing
See also Recapturing

Auto-configure command (Deck Selection menu in Capture tool) 196
Auto-configure command (Deck Selection menu in Digital Cut tool) 1081

Auto-create New Tracks option (Composer settings) 1454

Auto-enable Source Tracks option (Composer settings) 1454

Auto-indexing
by Media Indexer 1512

Automatic opening of projects 76

Automounting workspaces
ISIS v2.0 and later 1226

Auto-Save
function 93
options (Bin settings) 1444

AutoSync command (Bin menu) 623

Autosync feature
syncing clips 622

Auxiliary timecode
Index

entering 165
AVCHD
  workflow 445
AVI file format
  brief description 1545
AVI files
  methods for exporting 1484
Avid
  online support 51
  training services 51
Avid Artist Control
  application sets 917
Avid Artist Mix
  application sets 922
Avid Artist Series controller
  application sets 917
  customization 909
  described 897
  editing media 916
  Ethernet connections 900
  EuControl 897
  EuControl settings 904
  grouping faders 914
  IP addresses 901
  Jog mode 912
  latch mode 916
  recording volume automation and pan 914
  Shuttle ring 912
  soft keys 909
  volume automation and pan 913
Avid Artist Transport
  application sets 920
Avid Asset Manager 1155
Avid assets
  accessing assets 1236
  automatically checking in to asset manager 1235
  checking in and checking out 1232
  checking in to asset manager 1232
  checking out from asset manager 1229
  checking out from Interplay database 1232
  defined 1204
  local bins 1210
  permissions 1243
  reservations 1242
  restrictions 1243
Avid Attic files setting (Bin settings) 1444
Avid Attic folder
  described 93
  retrieving files from 82
Avid Calculator tool 133
Avid clients 1162
Avid Clipboard
  See Clipboard
Avid Codecs for QuickTime
  copying to another system 1041
  described 1038
  installing 1041
Avid DNA command (Device submenu of Special menu) 544, 1055
Avid DNA hardware
  sync sources 1055
Avid DS
  conform and transfer to 1139
  exporting to 1022
  finishing HDV on 1623
Avid DV Codec, exporting with 1476, 1478
Avid editing application
  backing up Title Tool titles when promoting to Marquee 1511
  location on system (Macintosh) 66
  location on system (Windows) 66
  quitting 79
  starting (Macintosh) 66
  starting (Windows) 66
Avid Interplay
  See Interplay
Avid Interplay Administrator
  Editor Database Settings 1235
Avid Interplay Archive
  Services 1053
Avid Interplay Engine 468
Avid Interplay ProEncode
  Services 1053
Avid Interplay Transcode
  Services 1053
Avid Interplay Transfer
  using 468
Avid Interplay Window
  See Interplay Window
Avid logs
  See also Shot log files
  See Shot log files
  clip data in 142
  creating 137
Index

custom Titles in 139
data entries in 142
formatting guidelines 137
global Titles in 138
importing ASCII file format 146
sample created with text editor 144
 specifications 137
standard Titles in 139
Avid MCXpress for Windows NT
importing files from 1547
Avid Media Store 1390
 login 1393
 searching 1395
Avid MediaFiles folder
backing up 493
transferring media 1158
Avid Plugin Store 1415
Avid Projects folder
 described 72
 location 72
 renaming 80
Avid Unity 1155
 environment 468
 LANshare 469
 mapping workspaces on a network 1518
 sending sequences to Pro Tools 1022
 sharing bins and projects 118
 transferring projects 1157
 unmounting and mounting 470
 using Zone 3 connection with Avid Unity ISIS 470
Avid Unity ISIS Client Manager
 v2.0 and later 1226
Avid Unity PortServer Pro 469
Avid Unity workspaces 118
Avid Users folder
 described 72
 location 72
 renaming 80
Avid-controlled deck
 logging 148
AvidFontSub.avt file 1151

changing in bins 356
Background consolidate and transcode 486
Background Queue Window 487
Backing up
 automatically to Avid Attic folder 82
 media files 493
 Title Tool titles when promoting to Marquee 1511
Backtiming edits 719
Backup options (Bin settings) 1444
Bandwidths in Audio EQ tool 842
Bars and tone
 preparing for capturing 316
 recording to tape 1076
Batch capture
 alternate source 263
Batch Capture command (Clip menu) 251, 262, 1329
Batch capturing
 See also Autocapturing
 See also Capturing
 See also Recapturing
 from logged clips 250
 multiple resolutions 1329
 options 251
 preparing for 251
 procedure 251
 unattended 251
Batch Import command (Clip menu) 334, 1331
Batch Import dialog box 336, 1331
Batch importing
 multiple resolutions 1331
 procedure 334
 XDCAM media 329
Best Performance command (Video Quality menu) 543
Best-light transfers
defined 1589
Big Trim mode
described 732
switching with Small Trim mode 734
Bin columns
 copying information 366
 Field Motion 599
Bin display 383
Bin editing
 in Segment mode 701
 using the keyboard 701
Bin Fast menu
described 351
Loop Selected Clips command 530
opening 351

Bin headings
modifying data in 368
setting audio format in 763, 779

Bin settings
Auto-Save options 1444
Avid Attic files setting 1444
backup options 1444
described 1444

Bin views
customizing 344
saving 344
types of 344

Bins
adding columns 363
adding text in Script view 348
aligning columns 362
aligning frames in 346
auto-save function 93
Bin View menu 344
changing background color 356
changing fonts 109
closing 90
creating 89
creating a storyboard 382
creating rough cuts in 589
defined 88
deleting 92
deleting columns 362
deleting items 354
display views 341
displaying audio formats in 763, 779
displaying film columns in 159
displaying in Project window 88
displaying objects in 383
editing from, in Segment mode 701
exporting as AFE files 1036
extra text fields 271
finding 575
finding from the Script window 658
Frame view 346
headings for MultiRez 1363
highlights for mixed resolutions 383
Info display 102
information in the Console 134
list of, viewing 89
listing timecodes in 366
locking items in 358
logging directly into 147
moving columns 362
opening 90
playing clips in Script view 348
printing 390
rearranging clips in Frame view 346
rearranging clips in Script view 348
remote assets 1210
renaming 90
retrieving backup of 82
saving automatically 93
saving manually 93
Script view 348
selecting offline items 359
selecting sources 361
selecting unreferenced clips 361
setting Reformat value 605
shared, locking and unlocking 121
shared, performance suggestions 122
sharing on Avid Unity 118
showing and hiding columns 341
tabs 350
targeting for capturing 203
Text view 341
using system backup to save 81
Bins tab (Project window) 89
Bit depth
defined 1540
Black burst sync
for output 1055
HD formats 1056
Black holes 728
Black level
adjusting for input 223
adjusting for output 1061
Black segment
See Filler
Blank button (Command palette, Other tab) 129
Blue bar
See Position indicator
Blue-only feature 1061
BMP file format
additional export options 1490
import specifications for 1541
Bomb Factory BF76 AudioSuite plug-in 973
Browse button (Select Project dialog box) 76
Browsing
for projects 76
Browsing
for projects 76
B-side (incoming frames)
in trims 736, 746
Buffer size
audio, adjusting 787
Build Sequence button (NRCS tool) 1168, 1181
Burn-in code 1589
Buttons
Add Alt Key (Command palette, Other tab) 129
Add Control Key (Command palette, Other tab) 129
Add Marker 550, 552, 553
Add Page (Script window) 642
Add Scene (Script window) 642
Alternate Edit 710
assigning workspaces to 115
Blank (Command palette, Other tab) 129
Build Sequence (NRCS tool) 1168, 1181
Disconnect (NRCS tool) 1168
displaying second row in the Source/Record monitor 517
Edit mode (NRCS tool) 1175
Edit/Save (NRCS tool) 1168
extra fields 271
Gang 620
Go to Next Marker 559
Go to Previous Marker 559
in the Avid Artist Series controllers 907
mapping 131
Mark Markers 558
Next In Group 1383
Nine Split 1377
Play (Script window) 649
Post To Web (NRCS tool) 1189
Previous In Group 1383
Quad Split 1377
Save Story (NRCS tool) 1168
Send Mail (NRCS tool) 1168
Set Color (Script window) 652
Set Offscreen (Script window) 651
Slip Left 755
Slip Left 1 Perf 627, 627
Slip Right 755
Slip Right 1 Perf 627, 627
Tail 721
Toggle Source/Record in Timeline 679
Top 721
Transition Corner Display 757
Buttons,
Add Option Key (Command palette, Other tab) 129
Buttons, user-selectable
Add Edit 722
Add Script Mark 653
Find Script 658
Mark Markers 558
Next In Group 1383
Nine Split 1377
Previous In Group 1383
Quad Split 1377
BWF (Broadcast Wave Format) files
bin columns for 1548
custom information 1548
importing and syncing 1550
reimporting 1550
support for 1548
BY Gain slider
adjusting for video input 223
adjusting for video output 1061
Bypass volume settings 810, 1438
Bypassing
pan settings 812
volume settings 810
C
Calculator command (Tools menu) 133
Calculator tool 133
Calibrate command (Peak Hold Menu button) 217, 217, 217
Calibrate Hardware Sliders command (Audio Mixer Tool Fast menu) 820
Calibrating
global output levels for audio 1070
phase controls 1066
video input 223
video output using test patterns 1064
video output, basic procedures 1061
video output, methods described 1059
calibrating
audio 217
calibrating audio output 217
Calibration tone
audio output 1069
creating media for 214
CamCutter files
  importing 318
Camera roll keypunch 1589
Camera setups
  in the lined script 631
Camroll data 158
Capture command (Tools menu, Toolset menus) 194, 1263
Capture command (Tools menu) 148
Capture in Progress slide in monitors 247
Capture mode
  entering 194
Capture Settings
  DV Options tab 1446
Capture settings
  Batch tab 1446
  described 1446
  DV Options 294
  Edit options 282
  Edit tab 1446
  General tab 1446
  Keys tab 265, 1446
  MXF Media Files tab 1446
  OMF Media Files tab 1446
Capture Tool
  Dolby E Safe button 275
Capture tool
  Interplay Folders option 1263
  logging with 148
  resizing 251
  resolution, selecting 203
  setting Pulldown switch 201
  setting up 194
  subclip status in 267
  timed recording 281
capture video and audio 1438
Capturing
  See also Autocapturing
  See also Batch capturing
  See also Recapturing
  across control track breaks 251
  across timecode breaks 182
  adding clip names during 234
  adding comments (annotating) during 234
  ancillary data 1135
  audio 201
audio sample rate conversion 208
bad frames 1446
bars and tone 316
Capture Tool setup 194
creating subclips during 267
detecting locked sync signal 201
digital audio in film projects 203
Dolby E media 273, 275
DV 50, DVCPRO HD, or HDV 243
DV media 243
establishing sync for 173
establishing sync for audio-only input 174
film transfers, minimum information for 158
Frame Chase, aborting 249
Frame Chase, overview 247
Frame Chase, requirements and guidelines 249
Frame Chase, settings 248
Frame Chase, unavailable resolutions 249
Frame Chase, update interval 248
from a mark IN to a mark OUT 236
from a non-Avid-controlled deck 241
from consumer grade decks 223
from music CDs 245
hardware considerations 172
HDV 1618
Interplay Folders option 1263
LTC timecode 278
media to remote projects 1263
multiple resolutions 1329
on-the-fly 237
preparations check list 230
preparing decks 196
preparing for video input 221
resolution selection 203
setting custom preroll 206
setting only one mark 237
settings for 176
single video frame (General Capture Settings) 1446
source track selection 198
storage guidelines 1575
sync requirements 172
tape selection 197
targeting bins 203
targeting drives for 204
to multiple media files 183
to the Timeline 282
using time-of-day timecode 242
video transferred without pulldown 284
while logging 233
with external timecode 278

CCIR
See ITU-R 601
CCIR video levels, Import settings 1502
Center Duration option (Composer settings) 1454
Center Pan command (Clip menu) 812
Change Sample Rate command (Clip menu) 835
Change Scene/Page dialog box 642
Changing
background color in bins 356
default pulldown frame 1097
text in the Script window 639
fonts in user interface 109
frames identifying a clip 346
frames sizes in bins 346
interface components color 107
page and scene numbers in the Script window 642
representative frame in takes 649
resolution by transcoding 483
track color in the Timeline 671
user profiles 105
Channel selection buttons (Capture tool) 198
Characters, avoiding when naming elements 1636
Check Decks command (Deck Selection menu in Capture tool) 196
Check Decks command (Deck Selection menu in Digital Cut tool) 1081
Check In All Open Bins To Interplay command (Bin menu) 1232
Check In Bin To Interplay command (Bin menu) 1232
Check lists
capture preparations 230
preparing hardware before capturing 172
Checking in
Avid assets 1232
confirmation message 1218
Checking out
Avid assets 1232
Choosing
a locale (Windows) 1628
Choosing a locale (Macintosh) 1629
Choosing a locale (Windows) 1628
Chrominance settings
adjusting for video input 223
adjusting for video output 1061
Chunking 1446
Chyron file format
import format for 1541
Cineon file format
additional Export options 1490
import specification for 1541
Clear Both Marks button 545
Clear button (Project window) 103
Clear IN Mark button 545
Clear Monitor command (Clip Name menu in Source monitor) 532
Clear OUT Mark button 545
Clearing
clicks from monitors 532
marks 545
Client Manager
v2.0 and later 1226
Client monitor
connecting 524
playing video to 524
selecting setting 526
viewing 16:9 format 172
Clip colors
assigning source colors 357
for MultiRez 1357
viewing in bins 357
Clip data
in Avid logs 142
Clip Frames command (Timeline Fast menu) 665
Clip Gain and Pan mode (Audio Mixer tool) 797
Clip Gain effect, adjusting volume while playing 810
Clip Info dialog box 584
Clip information
displaying in the Info window 522
displaying, in a Script window 637
summary 508, 577
clip information
effect summary 508, 577
Clip Name menu
clearing clips with 532
switching between clips with 531
Clip parameters
QuickTime 460
RED 452
Clip tag (Post to Web) 1195
Clip Text command (Timeline Fast menu) 665
Clipboard
copying to 609
described 610
preserving contents 610
recovering material from 610
Clipboard Contents command (Clip Name menu) 610
Clipboard Monitor command (Tools menu) 610
Clips
See also Master clips
See also Subclips
assigning local colors in the Timeline 671
assigning source colors in bins 357
audio, marking 549
autosyncing 622
batch capturing 251
changing identifying frame 346
changing resolution by transcoding 483
clearing from monitors 532
copying 352, 353
creating group clips 1375
creating multigroup clips 1377
creating multiple resolutions 1329
deleting 354
deleting MultiRez 1365
deleting unreferenced 492
displaying information about 522
displaying source colors in bins 357
duplicating 352
exporting 1028
finding from the Script window 658
finding names 569
finding with Match Frame 573
in-progress, capture overview 247
in-progress, duration of 247
in-progress, editing overview 1238
in-progress, editing workflow 1238
in-progress, limitations 1239
in-progress, sending sequences to playback 1238
linking to script 644
loading 1254
loading into monitors 530
locating master clip from subclip 576
locking in a bin 358
marking 547
marking IN and OUT points 545
mixed rate 594
moving 352
playing in a loop 530
playing in Script view 348
playing using buttons 535
rearranging in bin Frame view 346
rearranging in bin Script view 348
relinking by key number 289
remote editing 1289
renaming in Interplay Window 1254
searching for 569
selecting 351
sifting 383
switching between 531
Timeline display colors 667
tracking duration 519
transferring 1320
Close Bin command (File menu) 90
Close Project command (File menu) 76
Closed Caption
marking text for (NRCS tool) 1176
Closed captioning and Vertical Blanking Interval 1059, 1119, 1533
Closing
bins 90
projects 76
the Script window 637
Codec
DV25 software 1446
Codecs
Avid for QuickTime 1038
Avid for use with other applications 1042
copying Avid 1041
DV 1476, 1478
DV25 243
Coincidence Wait mode 281
Color
assigning local colors in the Timeline 671
assigning source color in bins 357
changing in interface 107
frame shifts 727
Color bars
adjusting video levels for tapes without 230
in Dupe Detection 723
recording bars and tone 1076
types of 223
Color column
adding to bins 357
Color correction
conforming Symphony Nitris sequences to Media Composer or Avid Xpress Pro 1154
settings 1458
templates, for transferring corrections between Avid applications 1154
Color frame shifts 727
Color Framing options (Composer settings) defined 1454
Color indicators (script integration) adding to takes 652 described 633
Color Match control 3 x 3 averaging of pixels, setting 1458
Color Match eyedropper 1458
Color submenu (Script menu) 652
Colors local and source, displaying in Timeline 667
Color-sync signal phase 1454
Column headings for MultiRez 1363
setting audio format in 763, 779
Column Titles in Avid log file 139
Columns adding (Interplay Window) 1248
bins 271
changing size in Research panel (Interplay Window) 1248
creating (Interplay Window) 1248
display options in Interplay Window 1247
enlarging and reducing in Research panel (Interplay Window) 1248
hiding (Interplay Window) 1248
moving (Interplay Window) 1248
See Bins
Command Palette Track buttons 705
Command palette activating commands from 133
assigning functions to mouse buttons 62 described 129
mapping buttons 131
mapping buttons to fader controllers 868
mapping menu commands 132
Command Palette command (Tools menu) 62
Command|8 controller 136
Commands
See listings by menu command name
Comments adding during capturing 234
adding to Research panel (Interplay Window) 1254
adding to sequence clips 612
displaying in Timeline 612
Committing multicamera edits 1388
Communication (Serial) Ports Tool settings described 1452, 1453
Composer settings 16:9 Monitors 1454
Auto-create New Tracks 1454
Auto-enable Source Tracks 1454
Center Duration option 1454
Color Framing options defined 1454
Copy Source Locators option 1454
described 1419
Digital Scrub Parameters option 1454
Edit tab 1454
Fast Forward options 1454
FF/REW tab 1454
First (lower) Row of Info 1454
First Row of Buttons 1454
Ignore Track Selectors 1454
MultiCam tab 1454
Phantom Marks 1454
Second Row of Buttons 1454
Second Row of Info 1454
setting Color Framing options 727
Single Mark Editing 1454
Single-Mark Editing option 594
Stop at Head Frames 1454
Stop at Locators 1454
Stop at Tail Frames 1454
Sync Point Editing option 1454
Tick Marks in Position Bars 1454
Undo Only Record Events 590, 1454
Window tab 1454
Composer window customizing 515
resizing 516
Compression defined 1557
Index

in relation to drive space 1557
in relation to image quality 1557

Compression ratios
See also Video resolutions
mixing 1573

Compression ratios (JFIF)
defined 1567

Configuring
Command|8 873
decks 188, 188
Digi 002 873

Conforming
workflow 1145

Connect
as a client 1162

Connecting
DV devices 193

Console command (Tools menu) 134
displaying drive space statistics using 101

Console window 134, 221
checking peak audio levels with 221
described 134
displaying bin information in 134
displaying system information 134
logging capturing errors to 267
network drives 134
printing marker information from 565

Consolidate/Transcode command (Clip menu) 479, 483

Consolidate/Transcode dialog box
options 483

Consolidating media files
background consolidate 486
described 477
master clips 477
options 483
options for 479
procedure 479
sequences 477
subclips 477

Consumer level audio
selecting an XLR adaptor 1075

Consumer-grade video deck
capturing from 223
limitations when capturing 227

Context menus 61

Control track
using for preroll 182

Control track breaks
capturing across 251

Controller settings 827
Avid Artist Series controller 899
described 1458

Controller Settings dialog box 827, 873

Controllers
Command|8 136
configuring 136
Digi 002 136
MCS3 136

Converting
audio sample rates 835

Coordinates
displaying, in monitors 1500

Copy Source Locators options (Composer settings)
1454

Copy to Clipboard button 609

Copying
clips and sequences 352, 353
information between bin columns 366
markers from source clips 558
Panasonic P2 files 399
remote assets 1244, 1254
segments in Timeline 700
text from the Info window 522
text in the Script window 639
to Clipboard 609

Copying XDCAM files 326

Core AudioSuite plug-ins 944
CoreAudio driver configuration 888

Correction Mode settings
Features tab 1458

Correction settings
AutoCorrect tab 1458
described 1458

Crash recording 1085

Create Subclip icon (Composer window) 547
Create Subsequence icon (Composer window) 549

Creating
a folder in a project 92
Avid log files 137
bins 89
folders in projects 91
group clips 1375
multigroup clips 1377
overlap edits 749
Index

- projects 1600
- rough cuts 589
- subclips 547
- subclips during capturing 267
- subsequences 549
- tone media 214
- user profiles 105
- Web page 1189

Criterion menu (Custom Sift dialog box) 383
Crossconverted sequences
  outputting 1066
Crossconverting HD
  for output 1066
Crossfading audio 831, 1438
Custom colors
  options for naming 1458
Custom preroll
  selecting 206
Custom Profile Audio Settings 1485
Custom property
  value for 1250
Custom Sift
  command (Bin menu) 383
  dialog box 383
Custom Titles
  in Avid logs 139
Customizing
  appearance of user interface 107
  bin views 344
  Composer window 515
  timecode 584
  Timeline 663
  Trim mode 732
Cutaways
  marking with markers 550
Cutting
  segments from Timeline 700
  text in the Script window 639
Cycle Picture/Sound button 705
Cycle Trim Sides button 736
Cycling
  tracks 705

D
D1 VTR
  calibrating input from 221

  recording to 1061
DAT
  See Digital audiotape (DAT)
Data entries
  in Avid log file 142
Data Track
  adding 1125
  ancillary data 1124
  capturing 1135
Data track
  Data mixdown 1135
  exporting 1136
Databases
  checking out Avid assets 1232
DC Offset Removal AudioSuite plug-in 986
Deck
  pausing while logging 152
Deck Configuration settings
  Add Channel options 188
  adjusting 188
  Deck settings 1461
  deleting elements in 192
  described 1460
Deck controller 127
  in Digital Cut tool 1081
Deck Preferences dialog box
  enabling assemble-edit recording 1077
Deck Preferences settings
  described 1462
  for assemble-edit recording 1077
Deck Selection menu (Capture tool) 196
Deck Selection menu (Digital Cut tool) 1081
Deck settings
  described 1461
  Fast Cue option 1461
  options 1461
  Preroll option 1461
Deck Settings options (Deck Configuration settings)
  1461
Deck templates 1460
Decks
  capturing from consumer-grade 223
  capturing from non-Avid-controlled 241
  configuring 188
  for digital cut 1081
  limitations on consumer-grade 227
  logging with Avid-controlled 148
logging with non-Avid-controlled 153
selecting 196
templates for 188
using the keyboard to control decks 270
Decompose command (Bin menu) 258
Decompose command (Clip menu) 258
Decomposing
described 256
Expert Decompose feature 256
including or excluding material 260
mixed-rate sequences 256
selecting target formats 260
sequences 256
DeEsser III (Dynamics III) AudioSuite plug-in 986
Default function buttons
Avid Artist Series controller 907
Default Pan options (Audio settings) 812
Default pulldown frame
changing the 1097
Default settings
restoring 1427
Default Setup command (Timeline Fast menu) 681
Defining
units of measurement 1523
Deinterlacing 1609
Delay, DV digital cut 1098
Delete command (Edit menu)
deleting columns 362
removing items from bins with 354
removing media files with 475
Delete Current Layout command (Interplay Window
Layout menu) 1256
Delete dialog box 354
Delete Take command (Script menu) 646
Deleting
add edits (match frames) 722
bin columns 362
Bins 92
clips and sequences 354
columns 362
deck configurations 192
markers 559, 561, 563
media files in bins 354
media files with Media tool 475
MultiRez clips 1365
page and scene numbers in the Script window 642
Production cues (NRCS tool) 1177
projects 78
remote assets 1244
script marks 657
segments, in Segment mode 698
settings 1426
slates in the Script window 646
stories (NRCS tool) 1174
takes in the Script window 649
text in the Script window 639
tracks 715
unreferenced clips 492
user profiles 105
volume automation and pan keyframes 815
deleting clips 425
Deleting folders 1254
Desktop Play Delay dialog box 528
Destination bins
selecting 203
Destination drives
selecting 204
Destination timecode rate 1094
Details command (View menu in Windows Explorer) 82
Device Code option (Remote Play and Capture settings)
1519
Device commands (Special menu) 243, 541, 1055
Dialog
in the lined script 631
Dialog boxes
Add Scene/Page 642
Archive to Videotape 504
audio export settings 1489
Change Scene/Page 642
Controller Settings 873
Custom Sift 383
Delete (script integration) 642, 649
Export Settings 1470
Film and 24p Settings (transfer settings) 185
General settings (for capturing) 184
Group Clips 1375
Left Margin 637
Modify Pulldown Phase 163
Restore from Videotape 507
Script Settings 637
Select Tape 148
Send To 1022, 1026
Set Bin Display 383
Set Font 109, 639
Index

Sync Selection 623
Tape Lengths 504
View Name (bin) 344

Digi 002 818
configuring 873
Digi 002 controller 136
DigiDelivery, exporting to 1022
Digidesign
exporting to 1022
Digidesign AudioSuite plug-ins
See AudioSuite plug-ins
Digidesign Pro Tools
transferring audio files to 1156
Digital audio
capturing in film projects 203
scrub, compared to smooth audio scrub 768
scrub, described 768
scrub, performing 771
Digital Audio Scrub options (Audio settings) 770
Digital audiotape (DAT)
capturing from 172, 201
Digital bars and tone
preparing 316
Digital Betacam VTR
calibrating input from 221
recording to 1061
Digital cut
cross-conversion and downconversion 1613
HDV 1619
outputting transcoded HDV sequence 1620
passthrough pausing during 1099
universal mastering 1613
Digital Cut command (Output menu) 1081, 1082, 1086
Digital cut delay, DV 1098
Digital Cut tool
24p and 25p output formats 1089, 1089, 1089
deck controller in 1081
selecting decks from 1081
using 1079
Digital cuts
audio-only 1096
custom preroll for 1082
previewing 1081
record options 1082
recording 1079
recording using Local mode 1086
recording using Remote mode 1082
rendering effects for 1078
Digital file names for film frames 380
Digital scale (Audio tool) 213
Digital Scrub Parameters option (Composer settings) 1454
Dipping
audio 831
Directory panel
changing fonts 1258
deleting folders in 1254
deleting stories 1174
making shortcuts 1173
opening a story 1172
removing shortcuts 1173
saving stories 1188
using 1172
Directory panel (Interplay Window)
See Media Directory panel
Disabling available resolutions 178
Disconnect button (NRCS tool) 1168
Disconnecting from the iNEWS server (NRCS tool) 1203
Displaying
audio pan and gain automation 772
audio waveforms 773
bin column headings 368
changing fonts 1258
column headings (Interplay Window) 1248
marker comments 559
sync breaks 614
take numbers in slates 649
tracking information 518
Displaying 24p and 25p media
during a digital cut 1609
while editing 1609
Displaying film columns 159
Dissolve effects
audio 831
Skip Existing Transition Effects option 831
Dissolve Icons command (Timeline Fast menu) 665
DNA/1394 button
playback to DV device with 541
selecting DV device with 243
selecting output device with 1055
setting video quality with 544
DNxHD Native command (Video Quality menu) 543
DNxHD resolutions
DNxHD-TR
  rendering HDV media to 1619
Dock
  Macintosh, using 61
Dolby E 273, 274, 275
Dominance
  described 1556
Dominance, Import settings options 1502
Double-byte systems, ASCII characters in 1636
Downconverted sequences
  outputting 1066
Downconverting HD
  for output 1066
downloading plugins 1415
downloading stock footage 1411
Draft Quality command (Video Quality menu) 543
Drag-and-drop method
  exporting files with 1028
  importing files 333
Dragging
  IN and OUT points 545
   marks 545
Drive filtering
  in networked workflows 125
  setting 180
Drive Filtering and Indexing tab 1512
Drive space
  managing to improve playback performance 1586
  maximizing use of 1586
  planning 1575
  statistics 101
Drive striping
  in relation to resolutions 1559
Drives
  See also Media drives
  filtering 125, 180
  saving work on 81
  selecting 176
  selecting for capturing 204
  striped for capturing 172
  striping 173
Drop-frame timecode
  described 192
  output 1093
  simultaneous output with non-drop-frame 1094,
  1094
Dropped frames
  avoiding during output 1078
  during digital cut 1082, 1086
Dual Link HD RGB
  support for 1626
Dual-image play during trims 748
Dual-roller trim
  playback 748
Dupe checking 1526
Dupe Detection 723
Dupe Detection Handles option (Timeline settings) 1526
Duplicate AudioSuite plug-in 990
Duplicate command (Edit menu)
  creating new import settings with 298
  duplicating clips and sequences with 352
  duplicating settings 1425
Duplicating
  assets when dragging from the Interplay Window 1231
  clips and sequences 352
  settings 1425
Duration tracking 519
DV
  capturing 243
  capturing, overview 243
  devices, connecting 193
  devices, selecting 243
  devices, selecting for output 1055
  DV 25 software codec 243
  DV 25, capturing 243
  playing back 541
DV audio pattern 1438
DV capture offset
  described 243
DV Codec 1476, 1478
DV digital cut delay
  described 1098
  procedure for 1098
DV resolutions
  Avid DV Codec for QuickTime 1038
  described 1569
  specifications 1569
  storage requirements 1585
DV Scene Extraction
Index

described 294
setting up 294
DV Stream files
exporting 1470
options 1470
DVCPro HD resolution
raster type 1623
DVD
exporting to 1022, 1022
DVD authoring, exporting to 1022
DVD One Step
exporting to 1022
D-Verb AudioSuite plug-in 985
Dynamic relink
applying target settings 1349
applying working settings 1349
described 1338
displaying available media 1356
limitations 1348
Media Composer Cloud 1302
quality matching 1369
to target settings 1353
Dynamic Relink Settings command (MultiRez menu in Timeline) 1348
Dynamic Relink Settings dialog box
opening 1348
options 1464
settings for quality matching 1369

E

Edit controller
with Remote Play, Capture, and Punch-In 285
Edit mode
entering (NRCS tool) 1175
Edit Review button 745
Edit/Save button (NRCS tool) 1168, 1175
Editcam files
importing 318
Editing
adding new tracks during 715
deleting tracks during 715
directly from a bin 701
in Heads and Heads Tails views 720
multicamera material 1374
proxy media (XDCAM) 328
remote 1284
Segment Mode, guidelines 688
stories (NRCS tool) 1175
sync breaks, avoiding 614
Sync Point 621
types of selective camera cutting (MultiCamera) 1388
with film track 726
with the Script window 659
Editor Database Settings 1235
Edits
adding (match-framing) 722
backtiming 719
copied to Clipboard 609
extending 750
Extract 609
Insert 591
Lift 609
Overwrite 592
Replace 593
replace clips 710
reviewing 745
rough cut 589
single-mark 594
Splice-in 591
undoing or redoing 590
Effect Editor Settings
described 1467
Effect templates
using with mixed rate clips 601
Effects
Audio EQ 842
finding information about 508, 577
location 508, 577
nesting described 703
rendering AudioSuite plug-in 936
rendering, for digital cut 1078
Ejecting drives
See Unmounting drives
Ejecting tapes with a button or key 273
Eleven plug-in
Input LED 991
Output 991
Embedded audio and sample rate conversion 1074
Empty Trash command (Bin display Fast menu) 93
Enable Clip Coloring command (MultiRez menu in Timeline) 1357
Enable Confidence View
video display setting 1531
Enable Track buttons (Digital Cut tool) 1079
End key 538
Enlarge Frame command (Edit menu) 346, 646
Enlarge Track command (Edit menu) 667
Enlarging
  frames in the bin 346
  tracks in the Timeline 667
ENPS
  server 1162
ENPS server
  configuring (NRCS tool) 1163
Entering
  additional film data 158
  frames-per-second rates for PAL transfers 164
  ink numbers 166
  key numbers 164
  optional timecodes 165
  pulldown of the sync point 160
  Segment mode 689
  Source/Record mode 583
  Trim mode 743
EQ AudioSuite plug-ins 992
EQ effects
  adjusting while playing 854
  applying 842
  removing 849
  templates for 851
ERIMovie file format
  additional export options 1490
  brief description 1545
Errors
  logged during capturing 267
  viewing capturing errors in the Console window 267
  viewing log of, in the Console window 134
Essence Marks 327
Estimating drive space requirements 1574
EuControl
  configuration 904
  installation 897
Existing Windows Media Custom Profile 1485
Exit command (File menu) 79
Exiting
  Trim mode 743
Expander/Gate III (Dynamics III) AudioSuite plug-in 995
Expert Decompose
  activating 258
  described 256
  target format reference 256
  using 260
ExpertRender
  using, for digital cut 1078
ExpertRender In/Out command (Clip menu) 1078
Export as dialog box 1028
Export command (File menu) 1028, 1036
Export Settings
  described 1470
Export settings
  Audio 1489
  AVI 1484
  AVI Video Compression 1484
  DV Stream 1483
  Graphic 1489, 1493
  Graphic Format 1490
  OMFI, AAF, and AFE 1473
  QuickTime Compression settings 1481
  QuickTime Movie Export options 1478
  QuickTime Movie settings 1480
  QuickTime Reference options 1476
  Video Compression options 1155
  video compression options 1484
  Windows Media Export options 1485
  XDCAM 1494
Export Settings dialog box 1032
Export Settings dialog box options 1470
Export settings, video compression options 1484
Exporting
  AAF files 1033
  audio tracks 1489
  AVI files 1484
  bins as AFE files 1036
  clips 1028
  data track 1136
  DV Stream files 1470
  frames 1028
  from a third-party QuickTime or AVI application 1042
  graphic files 1489
  OMFI files 1033
  preparing sequences for 1021
  procedure for 1028
  projects as AFE files 1036
  QuickTime movies 1038
Index

QuickTime movies procedure 1038
QuickTime reference movie 1038
reasons for 1020
sequences 1028
settings for, creating 1032
shot log files 166
TARGA files 1490
to Avid DS 1022
to Avid DVD by Sonic 1022, 1022
to DigiDelivery 1022
to Digidesign Pro Tools 1022
to DVD 1022, 1022
to HDV settings 1482
to Sorenson Squeeze 1022
to third-party applications 1026
user profiles 105
using drag-and-drop method 1028
Wavefront files 1490
Windows Media 1043
with Avid Codecs for QuickTime, described 1038
with Avid Codecs for QuickTime, procedure for 1038
XDCAM 1045, 1045
YUV files 1490
Exporting files
with Avid DV Codec 1476, 1478
Exporting sequences to P2 card 1052
Extend button 750
Extending
edits 750
External devices
turning off 79
turning on 59
External display monitor
connecting 524
selecting setting 526
viewing with 524
External drive
See Media drive
External fader controller
adjusting pan with 871
adjusting volume with 871
connecting to a system 867
troubleshooting connections 884
using 870, 877
External timecode 278
capturing with 278
Extra text fields 271
Extract button 609
Extracting material 609
Eyedropper
 3 x 3 averaging of pixels, setting 1458
  Color Match 1458
F

F5 button, refreshing with 1254
Factory preset buttons
  in Video Input tool 223
  in Video Output tool 1060
Fader controller
  external, adjusting pan with 871
  external, adjusting volume with 871
  external, using 870, 877
  recording audio volume 870
Fader controllers
described 865
  external, adjusting pan with 818
  external, adjusting volume with 818
  Live Mix mode 827
Fading
  audio 831
Fading audio 1438
Fast command (Vertical Scroll Speed menu in Mouse Settings dialog box) 62
Fast Cue option (Deck settings) 1461
Fast Forward button
described 535
  moving between audio keyframes with 821
Fast Forward options (Composer settings) 1454
Fast menus
  Settings display in the Project window 1422
Field dominance
described 1556
Field dominance, Import Settings options 1502
Field Motion bin column 599
Field Motion clip attribute
  overriding 599
Field motion types
  mixing and matching 594
Field ordering
described 1554
FieldPak
  importing files from 318
Field-stepping
   mixed rate clips in draft qualities 601
File formats
   animation 1545
File management 467
File names
   for Avid Projects folder 72
   for Avid Users folder 72
Files
   batch import 336
   exporting using drag-and-drop method 1028
   exporting, procedure for 1028
   exporting, reasons for 1020
   guidelines for moving 1141
   importing 301
   importing, guidelines 298
   importing, using drag-and-drop method 333
   reimporting 334
   specifications for importing graphics 1540, 1540
   specifications for importing OMFI 1547
Fill Sorted command (Bin menu) 346
Fill Window command (Bin menu) 346
Filler
   adding during trimming 751
   adding to a sequence 587
   setting duration of 587
Film
   columns, displaying 159
   data, entering 158
   information, logging 158
   minimum information for capturing 158
   projects, capturing digital audio for 203
   scene workflow 379
   selecting options 1600
   shoot specifications 1589
   timecodes, entering 165
   transferring to NTSC 1593
   transferring to PAL 1595
Film and 24P settings
   described 1494
Film and 24p settings
   for transfer 185
   pulldown phase 155, 155
Film speed
   slowing to 23.976 fps 1594
Film timecode
   logging additional 165
Film track, editing with 726
Film Type for shoots 1589
Film Wind for shoots 1589
FilmScribe
   frame numbers in cut lists 380
Film-to-tape transfer
   audio requirements for NTSC 201
   guidelines for 1589
   options for 1589
Filter Automation Pan command (Audio Mixer Tool Fast menu) 820
Filter Volume Automation command (Audio Mixer Tool Fast menu) 820
Filtering
   drives 180
   filtering drives 125
Find Bin button 575, 576
   in the Script window 658
Find Black Holes command (Clip menu) 728
Find command (Edit menu) 569, 642
Find Flash Frames command (Clip menu) 728
Find Frame button 577
Find Next Mismatched or Unavailable Clip command
   (MultiRez menu in Timeline) 1361
Find Script button 658
Find window 569
Finding
   bins from a monitor 575
   black holes 728
   clip names 569
   clips 569
   flash frames 728
   frames, with the Find command 569
   frames, with timecode offset 567
   marker text 569
   related media files 493
   script from marked takes 658
   text in the Script window 642
Finding bins
   from the Script window 658
Finding markers 556
FireWire
   capturing through 243, 243
   connecting devices 193
   selecting channel type 188
First (lower) Row of Info option (Composer settings) 1454
Index

First Row of Buttons option (Composer settings) 1454
Flash frames 728
Flat View command (Bin display Fast menu) 91
Focus button (Timeline) 685, 745
Focusing
  Timeline 685
Folders
  Avid Projects 72
  Avid Users 72
  creating in projects 92
  deleting 1254
  navigating to from a selected asset 1255
Font Replacement command (Object menu) 1151
Fonts
  changing in the Script window 639
  changing in user interface 109
  replacing title fonts 1151
Fonts, changing 1258
Footage
  finding 566
  loading into monitors 530
  marking 545
  marking IN and OUT 545
  subcataloging 545
  viewing in monitors 514
  viewing in Timeline 514
  viewing, overview 514
Foreign keyboard mapping 1636
Format display in the Project window described 1604
Format elements
  preparing leader for tracks 629
Format tab (Project window) 97
Four-frame display
  described 694
  suppressing 695
Frame Chase
  capture settings 248
  capture, aborting 249
  capture, overview 247
  capture, requirements and guidelines 249
  capture, update interval 248
  clip duration 247
  editing workflow 1238
  editing, limitations 1239
  editing, overview 1238
  sending sequences to playback 1238
  unavailable resolutions 249
  Frame Chase editing 1355
    limitations 1239
  Frame count numbers 380
    tracking with ink numbers and file names 364, 364
  Frame offset 567
  Frame rates
    mixing and matching 594
  Frame view (bin display)
    arranging 346
    described 346
    in the Media tool 472
  Frame-accurate recording 1075
  Frame-based counting 380
  Frame-by-frame movement in Timeline 687
  Frames
    aligning in bins 346
    changing frame identifying a clip 346
    changing size in bins 346
    changing size in Research panel (Interplay Window) 1248
    enlarging or reducing in Research panel (Interplay Window) 1248
    exporting 1028
    finding on source tape 577
    finding with Match Frame 573
    finding with timecode offset 567
    rearranging in bin Frame view 346
    rearranging in bin Script view 348
  Frames-per-second rates for PAL transfers 164
  Framestore file format
    import specifications for 1541
  Frequencies (audio), adjusting 842
  FTFT (film-tape-film-tape) feature described 289
  Full Quality 10-bit command (Video Quality menu) 543
  Full Quality command (Video Quality menu) 543
  Full Screen Playback
    enabling 527
    settings 1495
  Full Screen Playback command (Special menu) 527
  Full Size Video command (Composer window context menu) 516
  Full-Monitor Display 1377, 1377
  Full-screen image size defined 1540
  Full-screen Timeline 674
Index

Function key commands (Capture Settings) 265
Funk Logic Mastererizer AudioSuite plug-in 981, 997

G
Gain
  viewing gain values 775
Gain AudioSuite plug-in 997
Gang button 620
Ganging
  footage in monitors 620
General settings
  described 1499
General Settings dialog box 184
General-purpose interface (GPI) device
  configuring with VLAN-VLXi controller 893
  trigger signals 891, 892
  using 890
    using with V-LAN VLXi controller 892
Get Bin Info command (File menu) 134
Get Clip Info command (File menu) 584
Get Info command (Macintosh Finder File menu) 1160
Get Position Info command (File menu) 134
GFCAM
  workflow 447, 449
Global settings
  Import 298
Global Titles
  in Avid log file 138
Go To Capture Mode command (Bin menu) 194, 240, 262
Go To Page command (Script menu) 642
Go To Scene command (Script menu) 642
GOP (Group of Pictures)
  described 1616
GPI settings
  creating 894
  deleting 894
  editing 894
Graphics (image) files
  exporting 1489
  field ordering in 1554
  import specifications 1540, 1540
  preparing for import of 1540
  recommended field settings 1555
Grid
  Safe Action setting 1500
  Safe Title setting 1500
Grid settings
  Coordinates tab 1500
described 1500
  Display tab 1500
Group clips
  command (Bin menu) 1375
  creating 1375
dialog box options 1375
  Video Quality settings 1382
Group menu 1386
Grouped clips
  frame rate limitations 601
Grouping
  multiple tracks on an Avid Artist Series controller 914
Grouping procedures 1375
Guidelines
  for film-to-tape transfers 1589
  for logging 147
  for moving files 1141
  for naming tapes 147
guitar amp simulators 1008

H
Halt Digital Cut button (Digital Cut tool)
  stopping Digital Cut preview with 1081
  stopping Digital Cut with 1082, 1086
Hard subclips 267
Hardware
  check list for capturing 172
  turning off 79
  turning on 59
Hardware command (Tools menu) 135
Hardware tool
  displaying information 102
  using 135
HD
  Component signal, adjusting output 1066
crossconverting and downconverting 1066
  offline SD project formats for 1140
  Raster Type selection for projects 75
  sync options 1056
HD media
  offline formats for 1604
HD SDI embedded audio
Index

and sample rate conversion 1074
HD Universal Mastering
  converting audio 1611
  described 1610
  frame rates 1610
HDMI 779, 786
HDTV
  aspect ratio 1588
  broadcast graphics workflow 1600
  supported formats
    using 16:9 format for 172
    video-based workflow 1598
HDV
  capturing 1618
  capturing through IEEE port 1618
  described 1616
  exporting to HDV settings 1482
  exporting transport stream 1620, 1620
  finishing on Avid DS Nitris 1623
  importing 1618
  Long GOP splicing 1620
  outputting digital cut by transcoding 1620
  raster type 1623
  rendering 1619
  transcoding 1619
Head frames 1179
Headings (Interplay Window)
  adding 1248
  creating 1248
Headings command (Bin menu) 341, 357
Heads and Heads Tails views
  in the Timeline 720
Hide Video command (Composer window context menu) 516
Hiding
  bin column headings 368
  bin columns 341
  column headings (Interplay Window) 1248
  slate frames 646
  Timeline top toolbar 680
High shelf in Audio EQ tool 842
High-definition television
  See HDTV
Hinted streaming, exporting as 1480
Histogram
  QuickTime 463, 463
  RED 425, 425
Holding slates on screen 646
Home command (Windows menu) 674
Home key 538
House sync
  for output 1055
Hue slider
  adjusting for video input 223
  adjusting for video output 1061
Hyperclip tag (Post to Web) 1197

ICS
  choosing a locale for (Macintosh) 1629
  choosing a locale for (Windows) 1628, 1628
  recommendations and restrictions 1636
  using to display and input characters 1628
IEEE 1394 command (Device submenu of Special menu) 541, 544, 1055
IEEE-1394
  capturing through 243, 243
  connecting devices 193
IFF file format
  import specifications for 1541
Ignore Track Selectors options (Composer settings) 1454
Image files
  sequenced, naming for import 1545
Image quality
  for interlaced resolutions 1567
Import command (File menu) 168, 301
Import Options section (Batch Import dialog box) 336
Import Settings
  XDCAM tab 1507
Import settings
  alpha channel options 1502
  aspect ratio options 1502
  Audio tab 1506
  CCIR video levels 1502
  described 1502
  dominance options 1502
  Image tab 1502
  modifying 298
  OMFI tab 1505
  overview 298
  RGB graphics levels 1502
  Shot graphics levels 1502
  Shot Log tab 1505
importing

a script 637
animation files 1545
converting sample rates 309
files, basic procedure 301
files, batch import 336
files, batch importing multiple resolutions 1331
files, guidelines 298
files, preparing for 298
files, settings for 298
HDV transport stream file 1618
sample rate conversion options 310
shot log files 168
statistics files 100
test patterns 316
XDCAM media 319, 320, 325, 326
importing clips and media from P2 card 332, 332
importing files
EditCam 318
Photoshop files 311
preparing for 1540
specifications for graphics files 1540, 1540
specifications for OMFI files 1547
XDCAM 320, 326
IMX resolutions
See MPEG resolutions
IN and OUT points
dragging 545
marking 545
moving 545
using to define segment relationships 1458
In/Out buttons (Audio tool) 213
Indent Rows command 1467
Indicating off-screen dialog 651
iNEWS server
configuring (NRCS tool) 1163
disconnecting from (NRCS tool) 1203
setting up (NRCS tool) 1163
Info display (Project window)
described 102
displaying Hardware 102
displaying Memory 102
Info window
opening from a monitor 522
opening from a Script window 637
Inhibit Preloading option (Remote Play and Capture settings) 1519
Ink numbers
displaying frame count numbers 364, 364
entering 166
In-progress clips
capturing, overview 247
duration 247
editing overview 1238
editing workflow 1238
limitations 1239, 1239
sending sequences to playback 1238
Input
audio 210
Input Gain 1438, 1438
Input Level slider 1438, 1438
Insert edits 591
Insert-edit recording 1076
with pulldown 1095
Installing
Avid Codecs for QuickTime 1041
Installing AudioSuite plug-ins 925
Interactive screenings in Script window 659
Interface settings
described 1508
General tab 1508
Interface settings (Appearance tab)
changing color of 107
changing text font and size 109
described 107
Interlaced clips
mixing with progressive 594
Interlaced resolutions
specifications for 1567
storage requirements for 1580
Internal command (Sync Lock menu in Video Output tool) 1055
International character support (ICS)
taking advantage of 1628
International operating system 1629
Interplay
Media tool with 473
Interplay Asset Manager 1155
Interplay Assist
restrictions through 1243
Index

Interplay environment
  relinking in 1356
Interplay Folder Settings 1509
Interplay Folder settings
  described 1509
Interplay Folder Settings dialog box 1214, 1286
Interplay Folders option (Capture tool) 1263
Interplay Host, specifying settings 468
Interplay Login dialog box 1217
Interplay Media Indexer
  managing Media tool display 473
Interplay Media Services 1053
Interplay Root Folder
  checking in assets 1232
  specifying Media Composer Cloud settings 1286
  specifying settings 1214
Interplay Server
  specifying settings 1214
Interplay Server settings
  described 1509
Interplay Server Settings dialog box 1214
Interplay settings 1214
Interplay Transfer 1155
Interplay User
  specifying Media Composer Cloud settings 1286
  specifying settings 1214
Interplay User settings
  described 1509
Interplay User Settings dialog box 1214, 1217, 1286
Interplay User, specifying settings 468
Interplay Window
  checking in assets to the Interplay Root Folder 1232
  column display options 1247
  connecting to database 1214
  creating new columns 1248
  defined 1204
  described 1241
  Interplay folders 1204
  local bins 1204
  Media Directory panel 1241
  Media Search tab 1241
  modifying the display 1246
  opening 1217
  permissions 1243
  Research panel 1241
  searching 1260
  sorting columns 1248
  workgroup projects 1210
Interplay window
  Property Merge dialog box 1255
Interplay Window command (Tools menu) 1217, 1229,
  1232, 1236, 1263
Interpolating position
  for script integration 646
Invert AudioSuite plug-in 998
ITU-R 292M
  video standards 1557
ITU-R 601
  video standards 1557

J

JFIF interlaced media
  specifications 1567
  storage requirements 1580
JFIF progressive media
  specifications 1568
  storage requirements 1583
J-K-L keys
  audio scrub with 770
  changing representative frame in bin 346
  playing and shuttling footage with 539
  trimming 746
  trimming on-the-fly with 746
J-K-L keys (Three-Button Play) 746
JL Cooper
  Media Control Station3 136
Jog mode
  Avid Artist Series controller 912
Jogging
  mouse 540
JPEG file format
  additional Export options for 1490
  import specifications for 1541

K

Key numbers
  entering 164
  formats for 164
  relinking clips by 289
Keyboard
  controlling decks from 270
  mapping buttons to 131
mappings for playback control 538
Keyboard shortcuts
    audio keyframing 821
    Volume Automation and Pan 821
Keyframes
    adjusting pan for individual 871
    adjusting volume for individual 871
    audio, keyboard shortcuts 821
Keykode format 164
Keypunch
    camera roll 1589

L

Labroll data 158
Language
    non-English keyboard mapping 1636
    non-English, typing in 1632
    specifying in Get Info dialog box (Macintosh) 1629
Language, setting (Macintosh) 1629
LANshare 469
Large Text command 1467
Lassoing
    objects 351
    segments 689
latch mode (Avid Artist Series controllers) 916
Launch 66
Launching
    Avid editing application (Macintosh) 66
Layer effects, preserving 314
Layout (Interplay Window)
    changing 1256
    custom 1256
    deleting 1256
    saving 1256
Layout button (Interplay Window) 1246
L-cut edit (Overlap edit)
    described 749
    for audio clips 549
Leader
    creating 629
    for managing sync breaks 618
Left Arrow key
    moving through footage with 538
Left Margin command (Script menu) 637
Left Margin dialog box 637

Less Detail command (Timeline Fast menu) 665
 Lift button 609
Lifting material 609
Limitations
    for adjusting volume 811
Line slider (Waveform monitor) 223
Linear timecode
    See LTC (longitudinal timecode)
Linecut option (MultiCamera) 1384
Lined script 631
Linked clips
    described 1190
Linking clips to script 644
Live Mix mode 826
    Audio Mixer Tool controls 828
    Audio Mixer tool Fast menu commands 828
    entering 827
    example 829
    external controllers 827
    switching to other Audio Mixer modes 828
Load Filler command (Clip Name menu) 587
Load Media Database command (File menu) 490
Loaded cues
    adding 1178
    displaying head frames 1179
    using 1178
Loading
    filler 587
    footage 530
    media databases 490
    takes from the Script window 649, 657
Loading clips 1254
Local colors
    assigning in the Timeline 671
    displaying in Timeline 667
Local language operating system, using 1629
Locales, using characters from only one 1636
Lock Bin Selection command (Clip menu) 358
Lock icon (Track Selector panel) 713
Lock Tracks command (Clip menu) 714
Locking and unlocking
    bin items 358
    shared bins 121
    tracks 713, 714
Lo-Fi AudioSuite plug-in 998
Log files
    importing from film-to-tape transfer systems 344
Index

See Shot log files
Logging 137, 168
  additional timecodes 165
  automatic, during film transfer 1589
  automatically with DV 294
  bypassing by autocapturing 240
  directly into a bin, with a non-Avid-controlled deck 153
  directly into a bin, with an Avid-controlled deck 148
  errors during capturing 267
  errors to the Console window 134
  film information 158
  guidelines for 147
  pausing deck while 152
  preroll 147
  timecode 147
  while capturing 233
logging in to the Avid Media Store 1393
Logs
  See Shot log files
Long GOP splicing 1620
Loop Selected Clips command (Bin Fast menu) 530
Low shelf in Audio EQ Tool 842
LTC (longitudinal timecode)
  capturing with 278
  establishing sync for output 1057
  output for 24p and 25p projects 1093
  output for downstream encoding 1094, 1094
  reading user bits in 761
Luminance settings
  adjusting for video input 223
  adjusting for video output 1065
  table of 1065
  video input 223

M

Macintosh Dock, using 61
Macintosh systems
  limitations with NTFS drives 1160
Mail
  configuring directory for NRCS tool 1163
  receiving (NRCS tool) 1202
  sending (NRCS tool) 1201, 1201
Maintaining synchronized sound 1594
Make New
  using template 1026
Make Subclip button 547
Managing
  media files 467
Mapping
  buttons 131
  buttons to Timeline top toolbar 680
  menu commands 132
Margins
  script, adjusting in Script window 637
Mark Clip button 547
  marking clips in Segment Mode 699, 701, 701
Mark IN button 545
Mark In Time option (Digital Cut tool) 1082
Mark Markers button 558
Mark OUT button 545
Mark-and-park editing
  See Single-mark editing
Marker edit entry window 558
Marker icon
  changing color of 558, 561
Marker window
  selecting marker items 561
Markers
  adding while capturing 269
  adding while editing 552, 553, 555
  copying from source clips 558
  creating automatically with DV 294
  deleting 559, 561, 563
  displaying comments 559
  displaying in the Timeline 673
  editing 558
  Essence Marks (XDCAM) 327
  finding 556
  finding text of 569
  for managing sync breaks 619
  limitations with mixed-rate clips 601
  marking an area with 558
  moving to next or previous 559
  printing 565
  selecting in Markers window 561
  using 550
Markers window
  deleting markers from 561
  displaying frames in 561
  displaying MetaSync information 561
  displaying timecode or footage column in 561
  exporting 562
importing 562
printing 565
sorting markers in 561, 561
Marking
audio clips 549
clip 547
footage 545
IN and OUT points 545
segments 547
segments in Segment mode 699, 701, 701
text as Closed Caption (NRCS tool) 1176
text as machine control (NRCS tool) 1176
text as normal (NRCS tool) 1177
text as Presenter Instructions (NRCS tool) 1176
with markers 550, 558
Marking tape location
using Mark Memory button 153
Marks
clearing 545
IN and OUT points 545
phantom 627
Marquee Title Settings
described 1511
Master clips
See also Clips
See also Subclips
consolidating 477
copying 352, 353
creating new, with AudioSuite 936
deleting 354
duplicating 352
importing from P2 card 332, 332
locating from subclips 576
locking 358
moving 352
recapturing 254
searching remote assets 1262
selecting 351
sifting 383
Master shot, in the lined script 631
Master Volume button 777
Masters
delivery requirements 1140
Match Frame
described 573
reverse 575
tracks 575
Match Frame button 573, 576
Match Frame feature
for MultiCamera editing 1388
Match Frame Track command (Timeline context menu) 575
Match framing (adding edits) 722
Matchback option
described 1117
limitations 1117
Matching
frames 573
Maximizing drive space 1586
Mbox
audio devices compared 879
configuring 880
passthrough monitoring 881
MCS3 controller 136
Media
importing from P2 card 332, 332
Media Composer Cloud
accessing clips 1289
configuration 1285
described 1284
downloading media 1305
dynamic relink 1302
logging in 1286
settings 1286
supported project types 1310
syncing sequences 1300
Upload Queue Window 1303
uploading media 1293, 1295
workflow 1284
Media Composer Cloud Upload Settings dialog box 1295
Media creation
restricting resolutions for 178
Media Creation command (Tools menu) 176, 180, 301, 334
Media Creation dialog box
setting file format for import 301
Media Creation settings
Capture tab 1513, 1513
described 1512
Drive Filtering and Indexing tab 1512
Import tab 1513, 1513
Media Type tab 1514
Mixdown & Transcode tab 1513, 1513
Index

- Render tab 1514
  - Titles tab 1513, 1513

Media databases
  - loading 490
  - refreshing directories 491

Media Directory panel
  - creating shortcuts 1246
    - described 1241
  - removing shortcuts 1246

Media drives
  - See also Drives
  - selecting 176
  - targeting 204

Media drives, unmounting 471

Media files
  - archiving 503
  - backing up 493
  - capturing to multiple 183
  - consolidating, described 477
  - consolidating, options for 479
  - consolidating, procedure 479
  - deleting in bins 354
  - deleting unreferenced clips 492
  - deleting using Media tool 475
  - finding related 493
  - managing in a workgroup environment 468
  - managing, overview 467
  - manipulating with the Media tool 471
  - restoring from videotape 507
  - unlinking 502

Media Files Capture settings 183

Media Indexer
  - auto-indexing local drives 1512
    - described 1327

Media Search tab
  - Interplay Window 1241
    - searching in Interplay Window 1260

Media Services Broker 1515

Media Services Settings 1053

Media Services settings
  - described 1515

Media Store 1390

Media tool
  - deleting files 475
    - in an Interplay environment 473
  - opening 473
  - summary of features 472

Media Tool command (Tools menu) 473

MediaCentral UX Messages window
  - described 1264
  - sending messages 1267
  - viewing messages 1265

Memory information 102

Memory marks
  - adding 153

Memory usage
  - system 103

Memory window
  - for checking system performance 613
  - for viewing memory 102

Menu commands
  - Add Comments (Clip Name menu) 612
  - Align to Grid (Bin menu) 362
  - Audio EQ (Tools menu) 842
  - AutoSync (Bin menu) 623
  - Calculator (Tools menu) 133
  - Calibrate (Peak Hold Menu button) 217, 217, 217
  - Capture Tools (Tools menu) 148
  - Color (Script menu) 652
  - Console (Tools menu) 134, 134, 221
  - Custom Sift (Bin menu) 383
  - Delete (Edit menu) columns 362
  - Delete Take (Script menu) 646
  - Duplicate (Edit menu) 1425
  - Enlarge Frame (Edit menu) 646
  - Export (File menu) 1036
  - Find (Edit menu) 642
  - Find Black Holes (Clip menu) 728
  - Find Flash Frames (Clip menu) 728
  - Get Bin Info (File menu) 134
  - Get Position Info (File menu) 134
  - Go To Page (Script menu) 642
  - Go To Scene (Script menu) 642
  - Group Clips (Bin menu) 1375
  - Hardware (Tools menu) 135
  - Home (Windows menu) 674
  - Left Margin (Script menu) 637
  - Lock Bin Selection (Clip menu) 358
  - mapping 132
  - Mount All (File menu) 471
  - New Deck Controller (Tools menu) 127
  - New Script (File menu) 637
  - Page Setup (File menu) 390
  - Print Bin (File menu) 390
Index

Print Frame (File menu) 390
Print Timeline (File menu) 729
Reduce Frame (Edit menu) 646
Remote Play and Capture (Clip menu) 288
Remote Play and Capture (Special menu) 286, 287
Reveal File (File menu) 493
Select All (Edit menu) 251
Select Media Relatives (Bin menu) 360
Select Offline Items (Bin menu) 359
Select Sources (Bin menu) 361
Select Unreferenced Clips (Bin menu) 361
Set Bin Display (Bin menu) 383
Set Font (Edit menu) 639
Show All Takes (Script menu) 646
Show Every Frame (Timeline Fast menu) 726
Show Frames (Script menu) 646
Show Track (Timeline Fast menu) 726
Unlock Bin Selection (Clip menu) 358
Unmount (File menu) 471
Video Input Tool (Tools menu) 221, 223
View Type (Timeline Fast menu) 720
Message-of-the-Day options (NRCS tool) configuring 1163
MetaSync information
  in Markers window 561
MII component video standard
  unsupported 1532, 1532
Millivolts (mVolts) 1523
Mix Mode Selection 1438
Mixed rate clips
  defined 594
  field-stepping in draft qualities 601
  identifying in Timeline 597
  limitations with XDCAM AMA media 601
  summary of user interface 595
  transcoding 601
  using dynamic relink with 1354
  using effect templates with 601
Mixed resolutions
  highlighting in bins 383
Mixed-rate clips
  limitations with markers 601
Mixed-rate sequences
  decomposing 256
Mixer
  adjusting pan with 871
  adjusting volume with 871
  using 870, 877
Mixing
  video resolutions 1573
Mixing and matching
  field motion types 594
  frame rates 594
Mixing and monitoring audio 212
Mixing down audio 836
Mode option (Remote Play and Capture settings) 1519
Moderate command (Vertical Scroll Speed menu in Mouse Settings dialog box) 62
Modify command
  changing sequence format 1605
Modify Pulldown Phase dialog box 163
Modifying
  data in bin headings 368
  Import settings 298
  pan values 797
  settings 1421
  the pulldown phase after capturing 292
Monitor resolutions
  NTSC, PAL, HD 1558
Monitoring
  audio output global levels 1069
  icons (Track Selector panel) 708
  tracks 708
Monitors
  Capture in Progress slide 247
  clearing clips from 532
  displaying sequence information 522
  ganging footage in 620
  hiding video in 516
  loading footage 530
  resizing 516
  resizing Record 516
Mono option (audio) 836
More Detail command (Timeline Fast menu) 665
Motion Adapter effect
  adjusting 597
  field-stepping in draft qualities 601
  promoting to Timewarp 597
Motion Adapter effects
  defined 595
  refreshing in sequences 608
Motion effects
  rendering options 1522
Motion mode indicator (Timeline) 687
Index

Mount All command (File menu) 471
Mounting workspaces
   ISIS v2.0 and later 1226
Mouse
   assigning functions to buttons 62
   jogging and shuttling with 540
   playback with 540
   setting up the scroll wheel 62
   settings 62
   using scroll wheel 62
Mouse Jog button 540
Mouse Settings
   described 1515
Mouse Settings dialog box 62
Mouse Shuttle button 540
Mouse support for multicamera editing 1384
Movement in Timeline, controlling 687
Moving
   bin columns 362
   clips and sequences 352
   files, guidelines for 1141
   frames in the bin 346
   IN and OUT points 545
   remote assets 1244, 1254
   script marks 657
   settings between systems 1158
   slates in the Script window 646
   through clips 535
   tracks in the Timeline 667
Moving settings
   between settings files 1427
MPEG resolutions
   described 1570
   specifications
   storage requirements for 1586
Multi-angle View menus 1387
MultiCamera
   editing 1374
   Full-Monitor Display 1377
   Nine Split Source view 1377
   Quad Split Source view 1377
MultiCamera mode
   committing edits 1388
   described 1377
   Group menu 1386
   grouping 1375
   linecut option 1384
   Multi-angle menus 1387
   MultiCamera Nine Split Edit 1377
   MultiCamera Quad Split Edit 1377
   Nine Split Source view 1377
   Quad Split Source view 1377
   selective cutting in 1388
   switching camera angles in 1383, 1384
   techniques 1383
   video quality 1382
Multicamera resolutions
   specifications 1569
Multi-channel audio
   and Direct Out mode 1316
Multichannel audio 762
Multigroup clips
   creating 1377
Multilayered files, importing 314
Multilevel sorting of columns 343
Multiple text fields 271
Multiple tracks 703
MultiRez
   bin and column headings for 1363
   clip coloring for 1357
   deleting clips 1365
   described 1327
   examples 1357
   partially online clips, consolidating and deleting
     original media 1368
   partially online clips, restoring from an archive
     1342, 1368
   partially online clips, viewing source in Timeline
     1367
   quality matching 1369
   Send to Playback command with 1356
Multirez
   clip coloring examples 1359
MultiRez button (Timeline)
   enabling dynamic relink 1348
   showing available media 1356
   summary of right-click menu commands from 1361
Mute button 777
Muting audio 777
mVolt (millivolt) units 1523
MXF
   Media Files tab 183
   Media Files Tab (Capture Settings dialog box) 1446
   workflow 464
MXF file format 176
  choosing at target audio format for transcode 479
  choosing target audio format for transcoding 483
  transcoding to OMF 483

N
Nagra
capturing from 201
Naming tapes 147
Narration, recording voice-over 854, 854
Navigating
to a folder from a selected asset 1255
Navigation buttons
  Avid Artist Series controller 907
NCSID option (NRCS tool)
  configuring 1163
Nested effects 703
Nesting
  tracks 703
Network drives
  accessing from Console window 134
Network drives command 134
New Audio Track command (Clip menu) 586, 715
New Bin button (Project window) 89
New Bin command (File menu) 89
New Deck Controller command (Tools menu) 127
New Folder command (Bin display Fast menu) 91
New Meta Track command (Clip menu) 715
New Project button (Select Project dialog box) 1600
New Script command (File menu) 637
New sequence
  setting up 583
New Sequence command (Clip menu) 583
New Video Track command (Clip menu) 586, 715
Next In Group button 1383
Nine Split button 1377, 1377
Nine Split Source view 1377, 1377
Non-Avid-controlled deck
  capturing from 241
  logging with a 153
Non-drop-frame timecode
  described 192
  output 1093
  simultaneous output with drop-frame 1094, 1094
Non-English character support (Macintosh) 1629
Non-English characters
  recommendations and restrictions 1636
  using only one locale 1636
Non-English keyboard layout 1632
Non-square pixels 1540
Normal command (Vertical Scroll Speed menu in
  Mouse Settings dialog box) 62
Normalize AudioSuite plug-in 1004
NRCS Settings
  ENPS tab 1517
  iNEWS tab 1516
  NRCS tab 1516
  Post to Web tab 1518
NRCS tool
  adding loaded cues 1178
  adding production cues 1177
  adjusting story timing 1186
  associated sequences 1185, 1188
  building a sequence from a story 1181
  deleting a story 1174
  deleting production cues 1177
  disconnecting from the server 1203
  editing stories 1175
  elements of, described 1168
  ENPS tab options 1163
  entering Edit mode 1175
  finding read time of a story 1180
  formatting text 1177
  head frames 1179
  linked clips 1190
  loaded cues 1178
  Logging out option 1163
  Mail Directory options 1163
  making shortcuts to directories 1173
  marking text as Closed Caption 1176
  marking text as machine control 1176
  marking text as normal 1177
  marking text as Presenter Instructions 1176
  Message-of-the-Day options 1163
  NCSID option 1163
  opening a story 1172
  overview 1161
  Page column 1172
  Post to Web feature 1189, 1192, 1199
  processing scripts 1189
  rearranging text 1175
  receiving mail 1202
  removing shortcuts to directories 1173
saving a story 1188
saving changes to a story 1188
sending mail 1201
starting 1167
Status column 1172
story lock 1175
user interface reference 1168
using loaded cues 1178
using the Directory panel 1172
VideoID column 1172
WPM rate 1180
NTFS drives
   limitations on Macintosh systems 1160
NTSC (National Television System Committee) video
capturing audio from 201
creating Avid log files for 146
logging and capturing 233
luminance values 1065
transferring 24-fps film to 1593
waveform values 223
NTSC Has Setup option 184
NTSC Has Setup option (General Settings dialog box) 1059
NTSC-EIAJ format
   setting 184
   video output calibration 1059
   waveform values 223
Numeric keypad support for multicamera editing 1384

O

Offline editing
   detecting color-frame shifts during 727
detecting duplicate frames during 723
SD formats for HD masters 1140
Offline items
   selecting in bins 359
Off-screen dialog
   in the lined script 631
   indicating in the Script window 651
Off-screen indicators (script integration)
   adding to takes 651
described 633
Offset between audio and video playback, adjusting 528
Offset, DV Capture 243
OMF
   capturing media files 183
   Media Files tab 183
   Media Files tab (Capture Settings dialog box) 1446
   OMF file format 176
      preparing to export a sequence as 1021
      transcoding to MXF 483
   OMF Interchange files
      additional export options for 1490
described 1033
      exporting 1033
      import specifications 1541, 1547
      methods for exporting 1033
   OMF MediaFiles folder
      backing up 493
      transferring media 1158
   One-light transfers 1589
   Online support 51
   Open Bin command (File menu) 82, 85, 90
   Open Selected Bins command (File menu) 90
   Opening
      Audio Mixer tool 789
      Audio tool 212
      Bin Fast menu 351
      bins 90
      Media tool 473
      projects 76
      projects automatically 76
      settings 96
      shared projects 120
      startup project 76
      stories (NRCS tool) 1172
      the Script window 637
   Optical connection
      project settings 1438
   Optimizing
      playback 543
   Orphans
      See Offline items
   Other Bins folder (Project window) 90
   OUT points
      See IN and OUT points
Output
   assemble-edit recording 1077
   audio 786, 1096, 1438
   audio settings options 1072
   audio, preparing for 1069
   crash recording 1085
crossconverted sequences 1066
crossconverting and downconverting HD 1066
Digital Cut, overview 1079
downconverted sequences 1066
establishing sync for 1055
factory preset buttons 1060
generating 1054
longitudinal timecode (LTC) 1057
mapping audio channels 1438
masters, delivery requirements 1140
multiformat 1089, 1089, 1089
optical 1438
options 1054
preparing for 1054
rendering effects before 1078
selecting analog video signal 1059
selecting device for 1055
video calibration for NTSC-EIAJ 1059
video, adjusting luminance settings 1065
video, basic calibration 1061
video, calibrating 1059
Output formats
for 24p and 25p projects 1089, 1089, 1089
Output Gain 1438
Output timecodes
displaying in bins 366
Output to DV Device command (Video Quality menu) 541
Overlap edits
audio 549
creating 749
using extend edits 750
Override Working Settings with Target Settings command (MultiRez menu in Timeline) 1353
Overriding
Field Motion clip attribute 599
Overwrite button
overwrite edits with 592
Overwrite edits 592

P
P2
spanned clips 419
P2 card
importing clips from 332, 332
writing sequences to 1052
Page and scene numbers (Script window) adding 642
changing 642
deleting 642
searching for 642
Page column (NRCS tool) 1172
Page Setup command (File menu) 390
PAL (Phase Alternating Line) video frames-per-second rates for transfers 164
logging and capturing 233
luminance values 1065
transferring film to 1595
waveform values 223
PAL Method 1
described 1595
PAL Method 2
described 1595
Pan
adjusting for individual keyframes 871
adjusting in Audio Mixer tool 820
adjusting in audio tracks 798
adjustment, bypassing 812
centering 812
default settings 812
modifying values 797
viewing automation pan values 775
Pan and gain automation display (Timeline) 772
Pan automation 813
Panasonic P2
exporting sequences to 1052
importing master clips 332, 332
transferring files 399
workflow 442, 446
Parametric midrange in Audio EQtool 842
Partially online clips
consolidating and deleting original media 1368
restoring from an archive 1342, 1368
viewing source in Timeline 1367
Passthrough
described 1099
Passthrough Mix tool
using 215
Pasting
See Copying
text in the Script window 639
Patching
tracks 709
when capturing to the Timeline 282
Index

Pause button 535
PCX file format
  import specifications for 1541
Peak Hold menu (Audio tool) 213
Performing
digital audio scrub 771
Phantom marks 627
Phantom Marks options (Composer settings) 1454
Phase controls
  adjusting for output 1066
Photo CD file format
  import specifications for 1541
Photoshop file format
  additional export options for 1490
  import specifications for 1542
Photoshop files
  importing multilayered 311
  importing single-layer 314
PICS file format
  brief description 1545
PICT file format
  additional export options for 1490
  import specifications for 1542
PICT files
  of bars, importing 316
Picture quality
  ensuring by calibrating input levels 223
Pin button (Interplay Window) 1258, 1263
Pitch Shift AudioSuite plug-in 1004, 1006
Pixar file format
  import specifications for 1542
Pixel aspect ratio 1540
Pixels
  square and non-square for import 1540
Play button 535
Play button (Script window) 649
Play Calibration Tone command (Peak Hold menu in
  Audio tool) 1069, 1070, 1076
Play Delay, adjusting 528
Play Digital Cut button (Digital Cut tool) 1082, 1086
Play IN to OUT button 612
Play Loop button 745
Play Reverse button 535
Play Standby button 535
Playback
  changing speed of 539
  controlling with position bars and indicator 533
  full screen 527
  improving performance of 613
  improving performance of (storage management)
    1586
  limitations on multicamera media 1383
  loop, starting 612
  loop, trim during 749
  optimizing 543
  with audio scrub 768
  with DV devices 541
Playback control
  using keyboard 538
Playback devices
  transferring files to 1320
Playing
  clips and sequences using buttons 535
  clips in a loop 530
  takes from the Script window 649
Plug-in effects
  dialog box 934
  Digidesign AudioSuite described
    Fast menu 935
Plugin store 1415
plugin store 1415
Plug-ins
  See AudioSuite plug-ins
plugins
  downloading 1415
PNG file format
  additional export options for 1490
  import specifications for 1542
PortServer Pro 469
PortServer Settings
  described 1518
Position bar
  described 533
  in Timeline 683
Position bar in Timeline 685
Position indicator
  in Timeline 683
  using 533
Position indicator lights (Volume Automation and Pan)
  794
Post to Web
  Clip tag 1195
  creating a Web page 1189
Index

Postroll
- in Trim mode playback loop 745

Power schemes (Windows) 194

Power-r Dither plug-in 1006

Preferences
- fonts 1258

Premultiplied alpha 1540

Preparing
- for batch capturing 251
- for importing files 298
- for output 1054
- for video input 221
- hardware before capturing 172
- record tapes 1075
- sequences for export 1021
- shot log files with text editors 146

Preroll
- custom for capturing 206
- custom for digital cut 1082
- in Trim mode playback loop 745
- logging 147
- method for setting 182
- using control track for 182

Preroll option (Deck settings) 1461

Presenter Instructions (NRCS tool)
- marking text 1176

Preserving
- clipboard contents 610

Preset buttons
- in Video Input tool 223

Preset buttons (Video tools) 1060

Prestriped tapes 1076

Preview Digital Cut button (Digital Cut tool) 1081

Previewing
- a digital cut 1081

Previous In Group button 1383

Print Bin command (File menu) 390

Print Frame command (File menu) 390

Print Timeline command (File menu) 729

Printing
- bins 390
- markers 565
- statistics 98
- the Timeline 729

Pro Tools
- AAF export to 1033
- exporting to 1022
- HD Native configuration 885

Production cues (NRCS tool)
- adding 1177
- deleting 1177

ProEncode
- Post to Web 1199

Profiles
- Windows media .prx files 1485

Profiles, user
- changing 105
- creating 105
- deleting 105
- described 104
- exporting 105
- updating 105

Progressive clips
- mixing with interlaced 594

Progressive resolutions
- storage requirements for 1583

Project settings
- audio transfer 1595
- described 1419
- displaying 1422

Project window
- Bins tab 89
- displaying bins 88
- displaying settings 1419
- Format display, using 1604
- Format tab 97
- Info display 102
- Info tab, using 1595
- Other Bins folder 90
- overview of elements 87
- Settings tab 96
- Trash 93

Projects
- browsing for 76
Index

changing formats 1604
changing name 80
closing 76
creating folders within 92
creating new 1600
creating shortcuts in Interplay Window 1246
deleting 78
exporting as AFE files 1036
files, restoring from backup 81
film, capturing digital audio 203
Media Composer Cloud 1310
opening 76
opening automatically 76
relinking media files for 502
remote assets 1210
remote editing 1310
removing shortcuts in Interplay Window 1246
saving 81
shared, opening 120
sharing on Avid Unity 118
startup 76
types 75
video, using script integration in 633
workgroup project settings 1210
Projects folder
See Avid Projects folder
Promoting
  Motion Adapter effect to Timewarp 597
  Title Tool titles, back up option 1511
Properties
  selecting from a custom list 1250
Property Merge dialog box (Interplay window) 1255
Proxy editing
described 1327
Proxy media
editing 328
importing 323, 325
XDCAM 323, 1045
Pulldown
capturing without 284
converting sample rates on import 309
described 1594
finding at the sync point 160
output for downstream encoding 1094, 1094
Pulldown frame
  changing the default 1097
Pulldown phase
modifying after capturing 292
modifying before capturing 163
option in Film and 24p Settings dialog box 155, 155
Pulldown switch (Capture tool)
  setting 201
Pullin
  changing 1097
Pullin frame
  modifying 292
Pullout column 1097
Pullup
  converting sample rates on import 309
purchasing stock footage 1390, 1410
Q
  QRT file format
    import specifications for 1542
  Quad Split button 1377
  Quad Split display 1377
  Quad Split Source view 1377
  Quality matching
    audio 1371
    example 1373
    for dynamic relink 1369
    video format 1371
    video resolutions 1371
  Quality of film-to-tape transfer 1589
  Quick Record mode 276
  Quick Transition button
    fading audio with 831
  Quick Trim mode 732
  QuickTime
    Avid codecs for 1038
    clip parameters 460
    Histogram 463, 463
    source settings 460
    workflow 458
  QuickTime files 1545
  QuickTime movie export 1480
  QuickTime Movie files
    exporting with Avid DV Codec 1478
  QuickTime movies
    exporting 1038
    methods for exporting 1038
  QuickTime Reference Movie files
    exporting with Avid DV Codec 1476
QuickTime reference movies
  exporting 1038
Quitting
  Avid editing application 79

R

Raster sizes 1624
Raster types
  described 1623
  DVCPro HD 1623
  HDV 1623
  raster sizes 1624
  Standard 1623
  XDCAM HD 1623
Ratcheting
  play speed 539
Read Audio Timecode
  command (Special menu) 761
Read Audio Timecode dialog box 761
Read time, finding (NRCS tool) 1180
Real Time Update option 1467
Realtime Encoding command (Video Quality menu) 541
Rearranging
  clips in bin Frame view 346
  clips in bin Script view 348
Recapturing
  See also Autocapturing
  See also Batch capturing
  See also Capturing
  master clips and subclips 254
  mixed-rate sequences 254
  overview 254
  sequences 254
  using Decompose 256, 258
  without Decompose 262
Receiving mail (NRCS tool) 1202
Record Deck Time option (Digital Cut tool) 1082
Record monitor
  described 515
  displaying information in 522
  resizing 516
Record tool
  extra text fields 271
  quick record 276
Recording
  assemble-edit 1077
  digital cuts 1079
  digital cuts, using Local mode 1086
  digital cuts, using Remote mode 1082
  preparing tapes 1075
  volume automation information 818
Recording voice-over narration 854, 854
Recovering
  material from clipboard 610
Recti-Fi AudioSuite plug-in 1007
RED
  clip parameters 452
  Histogram 425, 425
  source settings 452, 456
  transcoding clip 451
Redo command (Edit menu) 590
Redoing
  edits 590
Reduce Frame command (Edit menu) 346, 646
Reduce Track command (Edit menu) 667
Reducing
  frames in the bin 346
  tracks in the Timeline 667
Reference command (Sync Lock menu in Video Output tool) 1055
Reformat attribute 603, 605, 606
Reformatting
  clips and sequences 603
  Reformat options 606
  setting Reformat value 605
Refresh All button, refreshing application with 1254
Refresh button, refreshing the Research panel with 1254
Refresh Media Directories command (File menu) 491
Refreshing
  Motion Adapter effects 608
Regional keyboard support 1632
Reimporting
  files, overview 334
  files, procedure 334
Reimporting imported files 329
Relationships for color correction
  defining with IN and OUT points 1458
Relink dialog box
  in an Interplay environment 1356
Relinking
  by resolution 499
  clips by key number 289
Index

consolidated clips 501  
dynamic relink 1338  
in an Interplay environment 1356  
moved projects 502  
selected clips 500  

Remote assets  
See also Interplay Window  
accessing assets 1236  
automatically checking in to asset manager 1235  
Avid assets 1204  
capturing to asset manager 1263  
checking in all open bins 1232  
checking in bin contents 1232  
checking in to asset manager 1232  
checking out assets by updating 1236  
checking out from asset manager 1229  
checking out from Interplay database 1232  
copying 1244, 1254  
deleting 1244  
finding 1260  
moving 1244, 1254  
permissions 1243  
reservations 1241, 1242  
restrictions 1241, 1243  
searching 1260  
updating in local bin 1236  
using drag-and-drop method to check in 1232  
using menu command to check in 1232  

Remote Capture 1519  
enabling 286  

Remote editing  
accessing clips 1289  
clips 1289  
described 1284  
downloading media 1305  
logging in 1286  
playback limitations 1290  
supported project types 1310  
syncing sequences 1300  
Upload Queue Window 1303  
uploading media 1293, 1295  

Remote Play  
enabling 287  

Remote Play and Capture  
command (Clip menu) 288  
command (Special menu) 286, 287  
Device Code option 1519  

Inhibit Preloading option 1519  
Mode type option 1519  
Runup option 1519  
setting ports for 1519  
Remote Play and Capture settings  
described 1519  
Remote Sync Sequence 1293  
Removable media  
saving work on 81  
Removable storage, sending to Pro Tools on 1022  
Remove Auto Volume/Pan command (Audio Mixer Tool Fast menu) 820  
Remove Automation Pan command (Audio Mixer Tool Fast menu) 820  
Remove Clip Gain command (Audio Mixer Tool Fast menu) 808  
Remove Pan command (Audio Mixer Tool Fast menu) 808  
Remove Pan/Vols command (Audio Mixer Tool Fast menu) 808  
Remove Volume Automation command (Audio Mixer Tool Fast menu) 820  

Removing  
add edits (match frames) 722  
audio EQ effects 849  
audio IN and OUT points 549  
color indicators (Script window) 652  
deck configuration elements 192  
off-screen indicators (Script window) 651  
text from the Script window 639  

Renaming  
bins 90  
clips in Interplay Window 1254  
settings 1425  

Render On-the-Fly option (Trim settings) 1530  
Render order for audio effects 795  
Render settings  
described 1522  

Rendering  
AudioSuite plug-in effects 936  
motion effects 1522  

Rendition file format  
import specifications for 1542  
Replace Edit button 593  
Replace edits 593  
Replacing  
deck configuration elements 192  

1683
Index

Timeline views 681
  title fonts 1151
Replacing edits 710
  reports
    stock footage 1409
Res (Resolution) menu (Capture tool) 203
Research panel
  changing fonts 1258
  refreshing 1254
Research panel (Interplay Window)
  adding columns 1248
  changing the custom layout 1256
  closing tabs 1258
  comments 1254
  creating new columns 1248
  deleting a saved layout 1256
  described 1241
  displaying multiple tabs 1256
  hiding columns 1248
  Media Search tab 1260
  modifying the display 1246
  moving columns 1248
  sorting columns 1248
Research Panel tabs 1258
Reservations 1241, 1242
Reset Peak button (Audio tool) 213
Resizing
  Audio Mixer tool 793
  Capture tool 251
  Composer window 516
  Record monitors 516
  slates in the Script window 646
  Source and Record monitors 516
Resolution groups
  image quality and 1574
Resolution Tracking command (Clip Color submenu in Timeline Fast menu) 1357
Resolutions
  relinking by 499
  See also Screen resolutions
  See also Video resolutions
Response
  system, with external monitor 524
Restore Default Patch command (Special menu) 709
Restore from Videotape dialog box 507
Restoring
  default settings 1427
  default Timeline view 681
  files from backup 81
  media files from videotape 507
Restricting available resolutions tape 178
Restrictions 1241, 1243
Results window 569
Retrieving
  files 82
  Reveal File command (File menu) 493
  Reverse AudioSuite plug-in 1008
  Reverse Match Frame button 575
  Reverse Selection command (Bin menu) 351, 492
Reviewing
  edits 745
  trim edits 745
Revising
  scripts 659
Rewind button 535
  moving between audio keyframes with 821
RGB graphics levels, Import settings 1502
RGB values
  reference black and white 1523
Right Arrow key
  moving through footage with 538
Right-click menus 61
Rollers
  See Trim mode
Rough cut
  assembling, in the Script window 660
Rough cuts
  creating 589
RS422 output 1093
RTAS
  copying plug-ins 930
  editing plug-ins 928
  inserting plug-ins 926
  moving plug-ins 930
  ordering plug-ins on a track 930
  removing inserts 931
  using RTAS effect templates 931
RTAS plug-ins
  AIR Chorus 947
  AIR Distortion 948
  AIR Dynamic Delay 949
  AIR Enhancer 951
  AIR Ensemble 952
  AIR Filter Gate 952
Index

AIR Flanger 953
AIR Frequency Shifter 956
AIR Fuzz-Wah 957
AIR Kill EQ 958
AIR Lo Fi 958
AIR Multi-Chorus 961
AIR Multi-Delay 962
AIR Non-Linear Reverb 963
AIR Phaser 964
AIR Reverb 966
AIR Spring Reverb 968
AIR Stereo Width 969
AIR Talkbox 970
AIR Vintage Filter 972

Rundowns
working with 1322

Runup option (Remote Play and Capture settings) 1519

RY Gain slider
adjusting for video input 223
adjusting for video output 1061

S

Safe Action option (Grid settings) 1500

Safe Colors
defining units of measurement for 1523
Safe Colors settings
described 1523

Safe Title option (Grid settings) 1500

Sample Plot command (Timeline Fast menu) 776

Sample rate
audio, converting during capture 208
changing conversion quality 1438, 1438
converting 1438
converting on import 309
displaying mismatched 1438
mixing 1438
options 1438
options for import 310

Sample rates
audio, changing 835
audio, conversion overview 835
conversion for embedded audio 1074
identifying by color 776

SansAmp PSA-1 plug-in 1008
amp simulation 1008
cabinet simulation 1008
equalization 1009
harmonic generation 1008
lo-fi textures 1009
tube sounds 1009

Sat slider
adjusting for video input 223
adjusting for video output 1061

Satellite mode
timed capturing 281

Save All command (File menu) 93
Save As command (Timeline View menu) 681
Save Bin command (File menu) 93, 93
Save Layout As command (Interplay Window Layout menu) 1256

Save Story button (NRCS tool) 1168

Saving
audio EQ effects 847
bins automatically 93
bins, manually 93
changes to a story (NRCS tool) 1188
custom bin views 344
projects and bins 81
the Script window 637
Timeline views 681
work to drives or removable media 81

Saving settings
in Video Input tool 228

SC phase
adjusting for output 1061

Scale bar (Timeline) 685

Scanning for tapes 148, 241

Scene and page numbers (Script window)
adding 642
changing 642
deleting 642
searching for 642

Scene data 158

Schedule, satellite feed 281

Schedules
working with 1322

Sci-Fi AudioSuite plug-in 1009

Screen resolutions
NTSC, PAL, HD 1558

Screenings
interactive, in Script window 659

Script box in Script view 348

Script integration
Index

described 633
elements of 633
for video projects 633
holding slates on screen 646
importing a script for 637
in Script window 651
in slates 633
in takes 651
interpolating position for 646
lining conventions in 631
using color indicators 652
using off-screen indicators 651
using script marks 653
workflow 633, 659
Script Mark button 653
Script marks
  adding 653
  adding during automatic screening 655
  deleting 657
  described 633
  manually placing 653
  moving 657
  using 653
  using for playback 657
  using to find script 658
Script range, splicing 660
Script settings
  described 1524
  using 637
Script Settings dialog box 637
Script text
  changing font of 639
  cutting, copying, and pasting 639
  removing 639
  selecting 639
Script view (bin display)
  adding text 348
  described 348
  in the Media tool 472
  playing clips in 348
Script window
  adding color indicators 652
  adding page and scene numbers 642
  adding takes 649
  adjusting margins 637
  adjusting take lines 649
  changing fonts 639
changing scene or page numbers 642
cutting, copying, and pasting text in 639
deleting slates 646
deleting takes 649
displaying clip and sequence information 637
displaying take numbers 649
editing with 659
exploring 637
finding bins from 658
finding clips from 658
hiding slate frames in 646
holding slates on screen in 646
indicating off-screen dialog in 651
interactive screening in 659
linking clips to 644
loading takes from 649
moving slates in 646
opening, closing, and saving 637
playing takes from 649
removing text in 639
resizing slates in 646
screening and marking in 655
searching through 642, 642
selecting slates 646
selecting text 639
splicing a range of script from 660
Scripts
  importing into the Script windows 637
  linking clips to 644
  Post to Web options 1189
  processing for Web 1189
  revising 659
Scroll bar in Timeline 683
Scroll bar/position bar in Timeline 683
Scroll wheel
  mouse, using 62
  setting up 62
Scrubbing
  audio 768
  displaying markers during 1525
SDI embedded audio
  and sample rate conversion 1074
Search tab (Interplay Window) 1241
Searches
  Category attribute 1262
  Interplay Window 1260
  keeping open 1263
Index

Index

performing 1260
remote assets attributes 1262
saving 1263
Text attribute 1262
Time attribute 1262
Types attribute 1262
Searching
for page and scene numbers in the Script window 642
in the Script window 642, 642
searching for stock footage clips 1395
searching through the Avid Media Store 1395
Second row of buttons 517
Second Row of Buttons option (Composer settings) 1454
Second Row of Info option (Composer settings) 1454
Segment Drag Sync Locks option (Timeline settings) 695
Segment Mode
ing editing guidelines 688
Segment mode
adding comments 612
deleting segments 698
editing from a bin in 701
four-frame display, described 694
four-frame display, suppressing 695
in the Timeline 701
marking segments 699, 701, 701
Segment Drag Sync Locks option 695
using 675, 688
workflow 675, 688
Segment Mode buttons 689
Segments
copying and pasting in Timeline 700
cutting from Timeline 700
deleting in Segment mode 698
lassoing 689
marking 547
marking in Segment mode 699, 701, 701
moving in sync 695
selecting 689
Select All command (Edit menu) 251
Select All Tracks command (Edit menu) 705
Select Media Relatives command (Bin menu) 360
Select Offline Items command (Bin menu) 359
Select Project dialog box 73
Select Sources command (Bin menu) 361, 492
Select Tape dialog box 148
returning to previous 197
Select Unreferenced Clips command (Bin menu) 361
Selected Clips section (Batch Import dialog box) 336
Selecting
audio file format 209
audio sample rate 208
clips and sequences 351
custom preroll 206
deck configuration settings 188
decks for capturing 196
drives for capturing 204
DV device 243
media drives 176
offline items in bins 359
segments in Timeline 689
settings before capturing 176
slates in the Script window 646
sources in the bin 361
takes in Script window 649
tapes for capturing 197
text in the Script window 639
tracks 705
tracks for capturing 198
tracks, for audio scrub 769
tracks, for audio scrub (soloing) 767
transitions for trimming 739
transitions in Trim mode 739
trim sides 736, 746
unreferenced clips in the bin 361
video resolutions 176
Send Mail button (NRCS tool) 1168
Send To
DigiDelivery 1022
Digidesign Pro Tools 1022
DVD 1022, 1022
DVD authoring 1022
DVD One Step 1022
Sorenson Squeeze 1022
using predefined templates 1022
Send To dialog box 1022, 1026
Send to Playback
from an Avid editing system 1271
Send to Playback command
with MultiRez 1356
Sending mail (NRCS tool) 1201
Sequence Info dialog box 584
Sequence information
displaying, in a Script window 637
summary 508, 577
sequence information
effect summary 508, 577
Sequence Time option (Digital Cut tool) 1082
Sequence Track buttons (Digital Cut tool) 1079
Sequenced image files 1545
Sequences
adding comments to 612
adding tracks to 586
associating with NRCS stories (NRCS tool) 1185
building from a story (NRCS tool) 1181
changing audio sample rate for 835
changing resolution by transcoding 483
changing start timecode for 584
consolidating 477
copying 352, 353
creating new 583
crossconverted, outputting 1066
decomposing 256, 258
deleting 354
displaying information about 522, 584
downconverted, outputting 1066
duplicating 352
exporting 1028
finding original bin for 576
locating by association 1188
locking in a bin 358
making the first edit in 588
marking IN and OUT points in 545
modifying formats 1354
moving 352
output options for 1054
playback loop in 612
playback performance tips for 613
playing 612
playing using buttons 535
preparing for export 1021
recapturing 254
recapturing without Decompose 262
refreshing Motion Adapter effects 608
renaming 584
replacing grouped clips 1388
reviewing 612
rough cut 589
searching for 569
searching remote assets 1262
selecting 351
setting up 583
sifting 383
transcoding 483
writing to P2 card 1052
Serial digital input
calibrating 221
Serial digital output
calibrating 1061
Serial port output 1093
Servo-lock 276
Set Bin Background command (Edit menu) 356
Set Bin Display command (Bin menu) 383
Set Bin Display dialog box 383
Set Calibration Tone command (Peak Hold menu in Audio tool) 1069
Set Color button (Script window) 652
Set Font command (Edit menu) 639
dialog box 109, 639
Set Font command (Edit menu) 109
Set Level commands (Audio Mixer Tool Fast menu) 808
Set Live Mix as Automation command (Audio Mixer Tool Fast menu) 828
Set Live Mix to Automation command (Audio Mixer Tool Fast menu) 828
Set Live Mix to Default command (Audio Mixer Tool Fast menu) 828
Set Offscreen button (Script window) 651
Set Pan commands (Audio Mixer Tool Fast menu) 808
Set Position To Keyframe command 1467
Set Type Filter dialog box 1253
Setting a language (Macintosh) 1629
Setting the bin display 383
Settings
AMA 1433
asset manager 468
Audio 1437
Audio export 1489
audio pan defaults 812
Audio Project 207, 1438
Audio Project, DV audio pattern 1438
audio transfer 1595
Bin 1444
Capture 1446
Communication (Serial) Ports Tool 1452, 1453
Index

Controller 827, 1458
copying between files 1427
Correction 1458
Deck 1461
Deck Configuration 1460
deck configuration 188
Deck Preferences 1462
default 1427
deleting 1426
described 1419
displaying project 1422
duplicating 1425
DV Stream export 1470
dynamic relinking 1464
Effect Editor 1467
Export 1470
Film and 24p 1494
for configuring asset manager 468
Frame Chase capture 248
Full Screen Playback 1495
General 1499
GPI 894
Grid 1500
import 298, 1502
in Video Input tool 228
Interface 1508
interface (Appearance tab) 107
Interplay Folder 1509
Interplay Server 1509
Interplay User 1509
location of 72
Marquee Title 1511
Media Creation 1512
Media Files Capture 183
Media Services 1053, 1515
modifying 1421
Mouse 62, 1515
moving between settings files 1427
moving between systems 1158
multiple, working with 1419
NRCS 1189
OMFI export 1473
opening 96
overview of 1419
PortServer 1518
project described 1419
Remote Play and Capture 1519
renaming 1425
Render 1522
restoring defaults 1427
Safe Colors 1523
Script 1524
selecting before capturing 176
site described 1419
sound card configuration 210
Sphere Playback 1451
Sphere Upload 1451
tab 1419
Timeline 1525
timeline, showing toolbar 680
Trim 1530
Trim, basic information 735
user 1419
user, linking to workspaces 113
using site 1429
Video Display 1531
Video display 526
Video Input Tool 1532
Video Output Tool 1533
viewing 1421
settings
Sound Card Configuration 1525
Settings list 1312, 1419
Composer 1419
Controller settings 868, 899
Settings Options
GPI 895
Settings tab (Project window) 96
SGI file format
additional export options for 1490
import specifications for 1542
Shared volume segmentation (chunking) 1446
Shortcut menus 61
Shortcuts
creating in Media Directory panel 1246
making (NRCS tool) 1173
removing (NRCS tool) 1173
removing from Media Directory panel 1246
Shot log files
Avid log file specifications 137
exporting 166
importing 168
preparing text editors for 146
Shot logs
See Shot log files
Show Add Keyframe Mode Menu command 1467
Show All Takes command (Script menu) 646
Show Entire Sequence command (Timeline Fast menu) 665
Show Every Frame command (Timeline Fast menu) 665, 726
Show Frames command (Script menu) 646
Show Markers command (Timeline Fast menu) 673
Show Mismatched Render Ranges command (MultiRez menu in Timeline) 1361
Show Mismatches command (MultiRez menu in Timeline) 1356
Show Position Bar option (Timeline settings) 685
Show Target Availability command (MultiRez menu in Timeline) 1356
Show Track submenu (Timeline Fast menu) 726
Showing
  bin columns 341
  Timeline top toolbar 680
Shutting down the system 79
Shuttle ring
  Avid Artist Series controller 912
Shuttling
  J-K-L key method 539
  mouse 540
  with J-K-L keys 746
Sifting clips and sequences 383
Signal Generator AudioSuite plug-in 1011
Signal sequences
  GPI 891
Signal, servo-lock 276
Single Mark Editing option (Composer settings) 1454
Single track monitoring
  See Solo track monitoring
Single/Dual Drive Mode button (Capture tool) 204
Single-field step 535
Single-mark editing 594
Single-Mark Editing option (Composer settings) 594
Site settings
  described 1419
  moving between systems 1158
  using 1429
Sixteen by nine (16:9) format 1589
Skip Existing Transition Effects option 831
Slate information for shoots 1589
Slates (script integration)  creating 644
deleting 646
described 633
hiding frames in 646
holding on screen 646
moving 646
resizing 646
selecting 646
showing one take in 646
Sliders option 1467
Slip Left 1 Perf button 627, 627
Slip Left button 755
Slip Right 1 Perf button 627, 627
Slip Right button 755
Slipping and sliding shots
  in Source/Record mode 755
  in Trim mode 753
Slowing film speed 1594
Small Trim mode
  described 732
  switching with Big Trim mode 734
Smart tool
  disabling 674
Smooth audio scrub
  compared to digital audio scrub 768
  performing 770
SMPT bars 1061
SMPT/EBU component standard
  support 1532, 1532
Snapping
  to transitions in Timeline 687
Soft Keys (Avid Artist Series controllers) 909
Softimage file format
  import specifications for 1542
Software DV25 codec 1446
Solo track monitoring
  in Timeline 708
  in Trim mode 740
Soloing
  audio tracks 767
  tracks 708
  tracks, advantages of 706
Sonic
  authoring DVDs in 1022
  burning DVD in one step 1022
Index

Sony XDCAM
  workflow 321
Sony XDCAM and XDCAM EX
  workflow 436
Sony XDCAM low-resolution
  workflow 438
Sorenson Squeeze
  exporting to 1022
Sorting
  clips 343
  columns (Interplay Window) 1248
  columns, multilevel 343
Sorting transfers 1325
Sound Card Configuration settings 1525
  configuring sound cards 210
Sound Designer II audio
  support for 1157
  transferring 1157
Sound roll
  cues for shoots 1589
  entering data for 158
Sound timecode
  logging additional 165
Source and Record monitors
  resizing 516
Source colors
  assigning in bins 357
  displaying in Timeline 667
Source material
  displaying in the Timeline 679
  loading into monitors 530
Source monitor
  described 515
Source settings
  QuickTime 460
  RED 452, 456
Source Settings Histogram 425, 463
Source tapes
  selecting for capturing 197
Source tracks
  selecting for capturing 198
Source/Record Editing command (Toolsets menu) 516
Source/Record mode
  customizing window settings 515
  entering 583
  slipping shots in 755
Source/Record Mode button 583
Sources
  selecting in the bin 361
  spanned clips
    P2 419
SPE
  See Sync Point Editing
Specifications
  Avid log 137
  for film shoots 1589
  graphics file import 1540, 1540
  OMF file import 1547
Sphere Playback settings
  described 1451
Sphere Upload settings
  described 1451
Splice-in button
  insert edits with 591
  making basic edit with 588
Splice-in edits 591
Splicing a script range 660
Split edits (Overlap edits)
  audio 549
  creating 749
  using extend edits 750
Square pixels 1540
Squeeze
  exporting to 1022
Standard definition television (SDTV)
Standard Titles
  in Avid log files 139
Start timecode
  changing 584
Starting
  Avid editing application (Windows) 66
Startup project
  opening 76
Statistics
  displaying drive space 101
  printing 98
  viewing 98
Statistics file
  described 98
Statistics files
  importing 100
Status column (NRCS tool) 1172
Step Backward buttons 535
Step Backward One Field button 535
Step Forward buttons 535
Step Forward One Field button 535
Stepping
  J-K-L key method 539
  mouse control of 540
  single-field 535
  with buttons 535
  with J-K-L keys 746
Stereo option (audio) 836
stock footage 1390
  downloading 1411
  purchasing 1410
stock footage clips
  about 1395
stock footage report 1409
Stop at Head Frames options (Composer settings) 1454
Stop at Locators options (Composer settings) 1454
Stop at Tail Frames options (Composer settings) 1454
Stop button 535
Storage
  estimating drive space requirements for 1574
  managing to improve playback performance 1586
  maximizing 1586
  planning 1575
Storage estimates
  in minutes per gigabyte 1575
Storage requirements
  DNxHD 1575
  DV resolutions 1585
  JFIF interlaced 1580
  JFIF progressive 1583
  MPEG resolutions 1586
Stories
  adjusting timing (NRCS tool) 1186
  associating sequences with (NRCS tool) 1185
  building a sequence (NRCS tool) 1181
  deleting (NRCS tool) 1174
  editing (NRCS tool) 1175
  finding read time (NRCS tool) 1180
  saving (NRCS tool) 1188
  saving changes to (NRCS tool) 1188
Storing 24p and 25p media 1609
Story body
  changing fonts 1258
Story lock (NRCS tool) 1175
Story panel (NRCS tool)
  adding production cues 1177
Story tag (Post to Web) 1193
Story timing
  adjusting (NRCS tool) 1186
  adjusting with time markers (NRCS tool) 1186
  adjusting with time pad (NRCS tool) 1186
Storyboard
  creating from a bin 382
Storyboard editing from the Script window 660
Stream Limit
  video display setting 1531
Striped drives
  capturing 172
  online information for 173
Striping
  record tapes 1076
Subcataloging
  footage 545
Subclip status (Capture tool) 267
Subclips
  See also Clips
  See also Master clips
  audio sync for 24p and 25p 549
  consolidating 477
  copying 352, 353
  creating 547
  creating automatically with DV 294
  creating during capturing 267
  deleting 354
  duplicating 352
  handles 547
  locating a master clip from 576
  moving 352
  recapturing 254
  searching remote assets 1262
  selecting 351
  sifting 383
Subframe sync adjustment 626
Subsequences
  creating 549
Substituting
  title fonts 1151
SunRaster file format
  import specifications for 1542
Surround sound 786
surround sound 779
S-Video deck
  capturing from 223
Index

limitations when capturing 227
Swap Cam Bank button 1377
Switching multicamera angles 1383, 1384
Sync
  autosyncing 622
  breaks, avoiding when editing 614
  breaks, defined 614
  breaks, displaying 614
  breaks, fixing 616
  detecting locked signal when capturing 201
  establishing for audio-only input 174
  establishing for capture 173
  establishing for output 1055
  for capturing video 172
  issues with Client monitor 524
  maintaining during segment move 695
  maintaining during trim 751
  maintaining with Add Edit 620
  maintaining with leader 618
  maintaining with markers 619
  methods for shoots 1589
  options for HD formats 1056
  perforation level 626
  subframe level 626
  trimming 740
    trimming with sync-locked tracks 751
  video input 223
Sync Breaks command (Timeline Fast menu) 616
Sync Lock All button (Track Selector panel) 751
Sync Lock button (Track Selector panel) 751
Sync Lock icon (Track Selector panel) 713
Sync Lock menu (Video Output tool) 173, 1055
Sync locking tracks in the Timeline 713, 714
Sync mode 1438
Sync point
  finding the pulldown at 160
Sync Point Editing (SPE) 621
Sync Point Editing option (Composer settings) 1454
Sync Selection dialog box 623
Synchronized sound
  maintaining 1594
Synchronizing
  video and audio subclips 622
Sync-locked tracks 617
System information
  displaying 134
System memory usage 103

T
Tabs
  bins 350
Tail button 721
Tail command
  performing a quick edit with 721
Takes (script integration)
  adding 649
  adjusting lines in 649
  applying color indicators 652
  applying off-screen indicators to 651
  changing representative frame for 649
  deleting 649
  described 633
  displaying numbers for 649
  loading 649
  loading from script marks 657
  playing 649
  removing color indicators 652
  removing off-screen indicators 651
  selecting 649
  showing one per slate 646
Tape deck
  See Decks
Tape Lengths dialog box 504
Tape name
  finding 148
Tapes
  ejecting 273
  managing names for MultiRez 1333
  preparing for output 1076
  preparing for recording output 1075
  recording digital cut to 1079
  recording to 1075
  recording tone and bars to 1076
  returning to previous tape 197
  See Videotape
  striping requirements for 1076
TARGA file format
  additional Export options 1490
  import specifications for 1542
Target bin
  selecting 203
Target Drive menu (Capture tool) 204
Target settings for dynamic relink
  applying 1349
described 1338
relinking to 1353

Taskbar 60

Telecine
importing log file from 344
transfer quality 1589

Templates
Clip tag 1195
Hyperclip tag 1197
placeholders 1197
Post to Web 1192
Story tag 1193
Text tag 1194
using placeholders 1192
Videoformat tag 1196

Test patterns
for calibrating video output 1064

Test patterns, importing 316

Text
adding in bin Script view 348
copying (NRCS tool) 1175
cutting (NRCS tool) 1175
deleting (NRCS tool) 1175
formatting (NRCS tool) 1177
marking as Closed Caption (NRCS tool) 1176
marking as machine control (NRCS tool) 1176
marking as normal (NRCS tool) 1177
marking as Presenter Instructions (NRCS tool) 1176
pasting (NRCS tool) 1175
rearranging (NRCS tool) 1175

Text editors
creating Avid logs with 137
for Avid logs 146

Text fields in the Record tool 271

Text in the Script window
changing font of 639
cutting, copying, and pasting 639
linking clips to 644
removing 639
searching through 642, 642
selecting 639

Text tag (Post to Web) 1194

Text view (bin display)
described 341
in the Media tool 472

Three-button play (J-K-L keys) 539, 746
Three-point editing

with phantom marks 627
Thumbwheels option 1467
Tick Marks in Position Bars option (Composer settings) 1454

TIFF file format
additional Export options 1490
import specifications for 1543

Time Compression Expansion AudioSuite plug-in 1012
using to change media length 936

Time markers
adjusting story timing (NRCS tool) 1186

Time pad
adjusting story timing (NRCS tool) 1186

Time Shift AudioSuite plug-in 1014

Timecode
breaks, capturing across 182
changing 584
default starting 1499
display options for 24p and 25p projects 366
drop-frame and non-drop-frame described 192
entering 165
entering additional 165
external, capturing with 278
finding frames with 567
formats for entering SMPTE standard 567
indicating the destination rate 1094
logging drop-frame and non-drop-frame 147
selecting format for output 1093
time-of-day, capturing with 242

Timecode window 523

Timecodes
display options in the Timecode window 523
Timed (scene-by-scene) transfers 1589

Timed Record option 281

Timeline
adding new tracks to 715
adjusting volume in 815
assigning local colors to 671
capturing to 282
changing background color in 671
clip coloring for MultiRez 1357
controlling movement in 687
copying and pasting in 700
creating views 681
customizing 663, 665
cutting in 700
deleting tracks in 715
Index

disabling Smart too 674
displaying clip colors 667
displaying comments 612
displaying detail 685
displaying markers 673
Dupe Detection Handles option 1526
dupe detection in 723
editing with film track in 726
examples of custom views 663
finding clip text in 569
focusing 685
full-screen view of 674
Heads and Heads Tails views of 720
identifying audio sample rate 776
identifying mixed rate clips 597
IN to OUT highlighting in 719
locking tracks in 713, 714
monitoring tracks 708
motion mode indicator 687
moving tracks 667
nesting in 703
paging option 673
patching tracks 709
position bar, switching to 685
position indicator in 683
printing 729
removing add edits in 722
resizing 674
saving 681
scale bar 685
scroll bar in 683
scroll bar/position bar in 683
scrolling option 673
Segment mode 675, 688
selecting segments 689
selecting tracks 705
setting the scroll bar 683
settings, Start Filler Duration option 587
soloing audio tracks 767
soloing tracks 708
source material, displaying 679
top toolbar 680
Track Control panel 678, 765
track selection behavior 794
Track Selector panel 703
viewing footage 514
views, replacing 681
views, restoring default 681
views, saving 681
volume automation keyframes in 815
window, summary of elements 683
working with multiple tracks 703
zooming in and out of 685
Timeline palette
trimming 732, 735
Timeline settings
described 1525
Display tab 1525
Edit tab 1526
Features tab 1530
Play Loop tab 1530
Time-of-Day Information, using to log 294
Time-of-day timecode
capturing with 242
external source 278
Time-remaining display (Capture tool) 204
Timewarp effect
field-stepping in draft qualities 601
Tips
logging 147
playback performance 613
Title tool
backing up titles when promoting to Marquee 1511
Toggle Source/Record in Timeline button (Timeline)
610, 679
tone generator
calibrating audio 217
Tone media
creating 214
recording to tape 1076
Tool palette
displaying text labels 529
using 529
Toolbar, top Timeline 680
Tools
Audio EQ 842
Audio Mixer 789
Audio Punch-In 856
Audio Punch-in 859
Calculator 133
Capture 194
Console 134
Deck Controller 127
Hardware 135
Index

Media 473
Video Input 221
Video Output 1061
Top button 721
Top command
performing a quick edit with 721
Total Conform 1139
Track buttons
Command Palette 705
Track color, changing in Timeline 671
Track Control panel
components 678, 765
displaying 678, 766
hiding 678, 766
making tracks inactive 767
Track effects
copying RTAS plug-ins 930
ingesting RTAS plug-ins 928
inserting RTAS plug-ins 926
moving RTAS plug-ins 930
ordering RTAS plug-ins on a track 930
removing RTAS plug-ins 931
using RTAS effect templates 931
Track Hinter settings, for hinted streaming export 1480
Track Panel command (Timeline Fast menu) 665
Track Selector panel
Lock icon 713
Sync Lock icon 713
user preferences for 586
using 703
Track Solo and Track Mute buttons (Volume Automation and Pan) 794
Tracking color-frame shifts 727
Tracking frames with frame numbers 364, 364
Tracking information
clip duration 519
displaying 518
options 519
Tracking Information menu
displaying 518
Tracks
adding 715
audio, adjusting in Audio Mixer tool 798
audio, mixing down 836
cycling through 705
deleting in Segment mode 715
deleting with Media tool 475
enlarging and reducing 667
grouping on an Avid Artist Series controller 914
locking 713, 714
matchframing 575
monitoring 708
moving in the Timeline 667
number supported 703
patching 709
preferences for creating and enabling 586
selecting 705
selecting for audio scrub 769
selecting for audio scrub (soloing) 767
selecting for capturing 198
setting up for a new sequence 586
soloing 708
soloing, advantages of 706
csync locking 713, 714
trimming with sync-locked 751
Training services 51
Transcode
RED clip 451
Transcoding
Background Queue Window 487
background transcoding 486, 489
mixed-rate clips 601
options for 483
procedure for 483
Transcoding HDV 1619
Transfer settings
in an Avid editing application 1312
Transferring
audio files to Digidesign Pro Tools 1156
projects between systems 1158
settings between systems 1158
Sound Designer II audio files 1157
through AFE 1036
Transferring files
from within an Avid application 1320
to a playback device 1320
Transferring film to tape
aids to 1589
in NTSC format 1593
in PAL format 1595
quality options 1589
without sound (PAL) 1595
Transfers
method of accepting incoming 1312
setting up the Avid editing system for 1312
sorting 1325
Transition Corner Display 757
Transition effects
  audio, fine-tuning 831
  Skip Existing Transition Effects option 831
Transitions
  selecting additional for trimming 739
  selecting for trimming 739
  trimming 757
Transparency
  adding to a graphics image 1540
Transport stream
  creating 1619
Trash
  emptying 93
  moving bins from 93, 93
  viewing contents of 93
Tri-level command (Sync Lock menu in Video Output
  tool) 1055
Tri-level sync
  for output 1055
  HD formats 1056
Trim
  settings, basic information 735
  slip and slide procedures 753
Trim A-side button 736
Trim AudioSuite plug-in 1017
Trim B-side button 736
Trim mode
  basic trimming procedure 744
  Big, described 732
  Big, switching with Small Trim mode 734
  customizing 732
  described 732
  Dual-image playback 748
  entering 743
  exiting 743
  options (Trim settings) 1530
  playing transition loop parameters 745
  Quick, described 732
  reviewing edits 745
  selecting several transitions 739
  selecting single transitions 739
  selecting trim sides 736
  selecting video tracks 738
  Small, described 732
Small, switching with Big Trim mode 734
  trimming on-the-fly 746
  using the Transition Corner Display 757
Trim Mode button (Timeline) 739
Trim settings
  described 1530
  Render On-the-Fly option 1530
  Trim Mode options 1530
Trimming
  adding filler during 751
  basic procedure 744
  during a playback loop 749
  J-K-L keys 746
  maintaining sync during 751
  on-the-fly 746
  reviewing 745
  selecting sides 736, 746
  single roller trim 740, 742
  Timeline palette 732
  trim states 735
  two heads or tails 739
  video tracks 738
  with sync-locked tracks 751
Troubleshooting 51
  vertical blanking interval information problems
    1122
Turning off equipment 79
Turnover points in the Audio EQ tool 842
Two-field media
  and field dominance 1556
  and field ordering 1554
Two-field mode indicators 535

U
U-matic deck
  capturing from 223
  limitations when capturing 227
Unattended batch capturing 251
Uncompressed video
  defined 1557
Undo command (Edit menu) 590
Undo Only Record Events option (Composer settings)
  590, 1454
Undo/Redo List command (Edit menu) 590
Undoing and redoing
  edits 590
Units of measurement
   defining for Safe Colors feature 1523
Unity 1155
   LANshare 469
   PortServer Pro 469
   See Avid Unity
   Zone 3 configuration in Avid Unity ISIS 470
Universal Mastering 1089
   See also HD Universal Mastering
   HD sequences 1610
Universal mastering
   digital cut 1613
Unlinking 499
   Unlinking media files 502
Unlock Bin Selection command (Clip menu) 358
Unlock Tracks command (Clip menu) 714
Unlocking and locking
   bin items 358
   tracks 713, 714
Unmount command (File menu) 471
Unmounting drives 470
Unreferenced clips
   deleting 492
   selecting in the bin 361
Update from Interplay command (Bin menu, Bin Fast menu) 1236
Update from Interplay command (Bin menu) 1238
Update Media Status command (MultiRez menu in Timeline) 1361
Update Position While Playing command 1467
Updating
   remote assets 1236
   user profiles 105
   writable properties (Interplay window) 1255
Upload Queue Window 1295
Upload Queue Window dialog box 1303
Usage information
   viewing 98
USB-to-MIDI converter
   configuring software 882
   testing installation 883
   troubleshooting connections 884
User
   changing folder name 80
   selecting another 1424
User bits in LTC
   reading 761
User files
   restoring from backup 81
User interface
   customizing appearance 107
User profiles
   changing 105
   creating 105
   deleting 105
   described 104
   exporting 105
   items created by system 72
   updating 105
User settings
   described 1419
   linking with workspaces 113
   selecting a user from 1424
Users folder
   See Avid Users folder
User-selectable buttons
   Add Marker 555

V

Variable-speed play 539, 746
Varicam
   support for Panasonic camera 296
VBI (Vertical Blanking Interval) 1119, 1533
   preserving information 1059
Vectorscope monitor
   using 223
Vertical Blanking Interval
   and effects 1121
   and video quality 1122
   line ranges in 1119
   preserving information 1119, 1533
VHS decks
   capturing from 223
   limitations when capturing 227
Video
   creating leader 629
   display settings, selecting 526
   hiding in monitors 516
   input, adjusting chrominance settings for 223
   input, adjusting luminance settings 223
   input, calibrating 223
   input, preparing for 223
   input, sync for 223
leader, using to maintain sync 618
monitoring tracks 708
number of supported tracks 703
output, calibration 1059
output, calibration for NTSC-EIAJ 1059
resolutions, dynamic relinking 1371
resolutions, selecting 176
resolutions, selecting in the Capture tool 203
soloing 708
trimming tracks 738
Video compression
defined 1557
Video Compression options (Export settings) 1155, 1484
Video decks
See Decks
Video Display settings
described 1531
Video Display Settings command (Video Quality menu) 544
Video Display Settings dialog box 526
Video Effect Safe Mode button (Digital Cut tool) 1082, 1086
Video Input menu (Video Input tool) 223
Video Input tool
Line slider 223
saving settings in 228
Vectorscope monitor 223
Waveform monitor 223
Video Input Tool command (Tools menu) 221, 223
Video Input Tool settings
described 1532
Video levels
adjusting without color bars 230
Video Mixdown
AAF export to Pro Tools 1033
Video Output tool
options display 1061
Sync Lock menu 1055
using preset buttons in 1060
Video Output Tool command (Tools menu) 1055, 1059, 1061, 1066, 1076
Video Output Tool settings
described 1533
HD tab 1537
SD tab 1533, 1536
Video projects
using script integration in 633
Video quality
settings with multicamera and group clips 1382
Video Quality Menu button 543
Video resolutions
availability for Frame Chase capture 249
disabling 178
drive striping requirements 1559
guidelines for use 1557
mixing 1573
specifications 1559
storage in minutes per gigabyte 1575
storage requirements for 1574
Video test patterns 1064
Videoformat tag (Post to Web) 1196
VideoID column (NRCS tool) 1172
Videotape
archiving media files with 503
capturing bars and tone from 316
guidelines for naming 147
restoring media files from 507
Videotape decks
See Decks
Videotapes
See Tapes
View mode (NRCS tool)
editing in 1174
View Name dialog box (bin) 344
View Type command (Timeline Fast menu) 720
View, bin
customizing 344
saving 344
types of 344
View, Timeline
Heads and Heads Tails 720
Viewing
bins, list of 89
footage, in monitors 514
footage, in Timeline 514
footage, overview 514
statistics 98
usage information 98
Virtual volumes
AMA 424, 424
VITC (Vertical Interval Timecode)
for downstream encoding 1094, 1094
in a bin 368
V-LAN VLXi 188
V-LAN VLXi controller
  configuring with general-purpose interface (GPI) device 893
  using with general-purpose interface (GPI) device 892
Voice-over narration 854, 854
  creating 855
Volume
  adjusting for individual keyframes 871
  adjusting in the Audio Mixer tool 798
  bypassing adjustments 1438
  in Timeline 815
  limitations for adjusting 811
  meters, in the Timeline 815
  recording audio volume 818
  while playing an effect 810, 813
Volume automation 813
Volume Automation and Pan 813
  adjusting gain with sliders 815
  Audio Mixer Fast menu commands 820
  Audio Mixer tool sliders 818
  controls in Audio Mixer tool, described 817
  deleting keyframes in 815
  enalbing and adding keyframes in 815
  fader controller or mixer, testing 883
  keyboard shortcuts 821
  recording 818
  Track Solo and Track Mute buttons 794
Volume control 777
Volume unit scale (Audio tool) 213
Volume Automation and Pan
  moving keyframes in 815
VTR
  See Decks
VTR Emulation
  See Remote Play and Capture

W

WAVE file format 209
  option in Audio Project settings 1438
Waveform monitor
  calibrating input 223
Waveform plots
  options in the Timeline Fast menu 773
Wavefront file format
  additional Export options 1490
  import specifications for 1543
Web page
  creating 1189
Web templates
  Clip tag 1195
  formatting stories 1192
  HTML tags 1192
  Hyperclip tag 1197
  placeholders 1197
  Story tag 1193
  Text tag 1194
  using placeholders 1192
  Videoformat tag 1196
Wide-screen format (16:9) 172
Windows
  changing fonts 109
  Composer 515
  Interplay 1217
  Marker edit entry 558
  Project 87
Windows Media
  exporting as 1043
Windows Media Legacy Template 1485, 1485
Windows Media Options Video settings 1485
Windows power schemes 194
Windows taskbar 60
Word processor
  creating Avid logs with 137
Workflows
  ancillary data and AMA 465
  audio editing 796
  AVCHD 445
  conforming and transferring projects 1145
  editing a sequence 55
  editing overview 52
  film scene 379
  GFCAM 447, 449
  graphics for HDTV 1600
  MXF 464
  outputting a sequence 57
  Panasonic P2 442, 446
  preparing to edit 54
  QuickTime 458
  script integration 633
  Segment mode 675, 688
  Sony XDCAM 321
Index

Sony XDCAM and XDCAM EX 436
Sony XDCAM low-resolution 438
starting a project 53
video-based HDTV 1598
Workgroup environment
working with Avid Interplay 468
working with media files 468
Workgroup settings 1214
Workgroups
configuring Interplay Server settings 1214
configuring Interplay settings 1214
logging in 1214
project settings 1210
projects with remote assets 1210
working with Avid assets 1243
working with remote assets 1204
Working settings for dynamic relink
applying 1349
described 1338
Workspace settings 1539
Workspaces
assigning to buttons 115
Avid Unity 118
described 111
linking to user settings 113
mounting, ISIS v2.0 and later 1226
WPM rate (NRCS tool)
finding 1180
Wrap Around command (Timeline Fast menu) 665
Writable Interplay properties 1255
Writable P2 device 1052

X

XDCAM
batch import 329
copying files 326
editing 328, 332
Essence Marks 327
exporting 1045, 1045
high-resolution media 329, 332
import options 319, 320, 326
importing proxy media 323, 325
markers 327
proxy media 328, 1045
resolutions 1045
workflow 1045

XDCAM HD 1623
XDCAM raster type 1623
XDCAM AMA media
limitations with mixed rate clips 601
XLR adaptor
for consumer level audio 1075
XWindows file format
import specifications for 1543

Y

YUV file format
additional Export options for 1490
import specifications for 1543

Z

Zoom Back command (Timeline Fast menu) 685
Zoom In command (Timeline Fast menu) 685

WPM rate (NRCS tool)
finding 1180
Wrap Around command (Timeline Fast menu) 665
Writable Interplay properties 1255
Writable P2 device 1052

XDCAM
batch import 329
copying files 326
editing 328, 332
Essence Marks 327
exporting 1045, 1045
high-resolution media 329, 332
import options 319, 320, 326
importing proxy media 323, 325
markers 327
proxy media 328, 1045
resolutions 1045
workflow 1045